Rome IT Service Management

Last updated: October 12, 2021
Table of Contents

**IT Service Management**................................................................. 1
  Script includes and customization...................................................... 7
  Machine learning solutions for IT Service Management........................ 8
    Request Predictive Intelligence for Incident Management.................. 8
    Request Predictive Intelligence for Major Incident Management......... 10
  Predictive Intelligence for Incident Management.............................. 12
  Request Predictive Intelligence for Incident................................... 18
**Asset Management**........................................................................ 21
  Mobile app for Hardware Asset Management....................................... 22
  Asset and CI management.................................................................... 27
  Asset classes....................................................................................... 40
  Create fixed assets.............................................................................. 44
  Consumables life cycle................................................................--------- 47
  Create pre-allocated assets.................................................................. 51
  Stockrooms........................................................................................... 54
  Transfer orders for Asset Management............................................... 60
  Create a transfer order for Asset Management.................................... 65
  Perform bulk updates for transfer order lines...................................... 69
  Transfer order line asset tracking...................................................... 70
  Example Asset Management process.................................................. 72
  CSDM framework for HAM................................................................. 73
**ITSM Software Asset Management**.................................................. 73
  Organization Management..................................................................... 213
  Installed with Model Management...................................................... 214
  Installed with Asset Management...................................................... 220
  Domain separation and Asset Management......................................... 233
  Quick start test for Asset Management............................................... 235
  Contract Management.......................................................................... 235
  Procurement........................................................................................ 271
  Product Catalog.................................................................................. 304
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benchmarks</td>
<td>336</td>
</tr>
<tr>
<td>Benchmarks overview</td>
<td>336</td>
</tr>
<tr>
<td>Benchmarks roles</td>
<td>342</td>
</tr>
<tr>
<td>Enable Benchmarks</td>
<td>344</td>
</tr>
<tr>
<td>Benchmark KPIs</td>
<td>346</td>
</tr>
<tr>
<td>Benchmarks dashboard</td>
<td>367</td>
</tr>
<tr>
<td>Benchmarks troubleshooting</td>
<td>376</td>
</tr>
<tr>
<td>Domain separation and Benchmarks</td>
<td>377</td>
</tr>
<tr>
<td>Change Management</td>
<td>378</td>
</tr>
<tr>
<td>Change types</td>
<td>379</td>
</tr>
<tr>
<td>Upgrade Change Management</td>
<td>380</td>
</tr>
<tr>
<td>Change Management plugins</td>
<td>381</td>
</tr>
<tr>
<td>Configure Change Management</td>
<td>432</td>
</tr>
<tr>
<td>Create a change request</td>
<td>485</td>
</tr>
<tr>
<td>Unauthorized change request</td>
<td>496</td>
</tr>
<tr>
<td>Process a change request</td>
<td>501</td>
</tr>
<tr>
<td>Standard change catalog</td>
<td>516</td>
</tr>
<tr>
<td>Change schedules</td>
<td>523</td>
</tr>
<tr>
<td>Change success score</td>
<td>536</td>
</tr>
<tr>
<td>Predictive Intelligence for Change Management</td>
<td>542</td>
</tr>
<tr>
<td>Analyze change request risk and impact</td>
<td>547</td>
</tr>
<tr>
<td>Conflict detection</td>
<td>559</td>
</tr>
<tr>
<td>Change approval policies</td>
<td>579</td>
</tr>
<tr>
<td>Change Advisory Board (CAB) workbench</td>
<td>590</td>
</tr>
<tr>
<td>Change management integrations</td>
<td>616</td>
</tr>
<tr>
<td>Mobile experience for Change Management</td>
<td>622</td>
</tr>
<tr>
<td>Domain separation and Change Management</td>
<td>624</td>
</tr>
<tr>
<td>Change Management Analytics and Reporting Solutions</td>
<td>627</td>
</tr>
<tr>
<td>Change Management troubleshooting properties</td>
<td>644</td>
</tr>
<tr>
<td>Quick start tests for Change Management</td>
<td>645</td>
</tr>
<tr>
<td>Coaching</td>
<td>649</td>
</tr>
<tr>
<td>Request Coaching</td>
<td>651</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Coaching roles</td>
<td>652</td>
</tr>
<tr>
<td>Coaching overview</td>
<td>653</td>
</tr>
<tr>
<td>Setting up Coaching and surveys</td>
<td>657</td>
</tr>
<tr>
<td>Coaching your trainee</td>
<td>665</td>
</tr>
<tr>
<td>Training your agents using Coaching With Learning</td>
<td>672</td>
</tr>
<tr>
<td>Managing your coaching assessments</td>
<td>675</td>
</tr>
<tr>
<td>Coaching reference</td>
<td>677</td>
</tr>
<tr>
<td>Quick start tests for Coaching</td>
<td>690</td>
</tr>
<tr>
<td>Continual Improvement Management</td>
<td>691</td>
</tr>
<tr>
<td>Request Continual Improvement Management</td>
<td>693</td>
</tr>
<tr>
<td>Continual Improvement Management overview</td>
<td>695</td>
</tr>
<tr>
<td>Continual Improvement Management roles</td>
<td>701</td>
</tr>
<tr>
<td>Monitor and plan improvements</td>
<td>705</td>
</tr>
<tr>
<td>View improvement reports</td>
<td>709</td>
</tr>
<tr>
<td>Requesting improvements</td>
<td>711</td>
</tr>
<tr>
<td>Managing improvements</td>
<td>715</td>
</tr>
<tr>
<td>Continual Improvement Management reference</td>
<td>735</td>
</tr>
<tr>
<td>Continual Improvements dashboard</td>
<td>772</td>
</tr>
<tr>
<td>Expense Line</td>
<td>775</td>
</tr>
<tr>
<td>Components installed with Expense Line</td>
<td>776</td>
</tr>
<tr>
<td>View an expense</td>
<td>779</td>
</tr>
<tr>
<td>Expense lines and expense allocations</td>
<td>780</td>
</tr>
<tr>
<td>Domain separation and Expense Line</td>
<td>786</td>
</tr>
<tr>
<td>ITSM Virtual Agent</td>
<td>786</td>
</tr>
<tr>
<td>Set up ITSM Virtual Agent</td>
<td>795</td>
</tr>
<tr>
<td>ITSM Virtual Agent conversation flows</td>
<td>796</td>
</tr>
<tr>
<td>Manage Office 365 Group conversation flow</td>
<td>858</td>
</tr>
<tr>
<td>Manage Microsoft Active Directory Distribution List conversation flow</td>
<td>869</td>
</tr>
<tr>
<td>Manage local admin access</td>
<td>880</td>
</tr>
<tr>
<td>Incident Auto Resolution for ITSM Virtual Agent</td>
<td>884</td>
</tr>
<tr>
<td>Actionable Notifications for ITSM Virtual Agent</td>
<td>886</td>
</tr>
<tr>
<td>Password Management for ITSM Virtual Agent</td>
<td>930</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Virtual Machine Management for ITSM Virtual Agent</td>
<td>933</td>
</tr>
<tr>
<td>Meeting management for ITSM Virtual Agent</td>
<td>964</td>
</tr>
<tr>
<td>Manage Citrix sessions</td>
<td>978</td>
</tr>
<tr>
<td>ITSM Virtual Agent Lite</td>
<td>981</td>
</tr>
<tr>
<td>Set up ITSM Virtual Agent Lite</td>
<td>982</td>
</tr>
<tr>
<td>ITSM Virtual Agent Lite conversation flows</td>
<td>983</td>
</tr>
<tr>
<td>Walk-up Experience</td>
<td>983</td>
</tr>
<tr>
<td>Understanding Walk-up Experience</td>
<td>984</td>
</tr>
<tr>
<td>Domain separation and the Walk-up Experience application</td>
<td>990</td>
</tr>
<tr>
<td>Walk-up Experience portal security and access</td>
<td>993</td>
</tr>
<tr>
<td>Walk-up Experience administration</td>
<td>994</td>
</tr>
<tr>
<td>Badge Reader Integration for Walk-up Experience</td>
<td>1036</td>
</tr>
<tr>
<td>Walk-up Experience Microsoft Office 365 calendar integration</td>
<td>1054</td>
</tr>
<tr>
<td>Walk-up Experience queue and interaction management</td>
<td>1057</td>
</tr>
<tr>
<td>Walk-up Experience dashboard overview</td>
<td>1071</td>
</tr>
<tr>
<td>Walk-up Experience on Now® Mobile</td>
<td>1073</td>
</tr>
<tr>
<td>Configure day-level appointment booking</td>
<td>1078</td>
</tr>
<tr>
<td>ITSM Agent Workspace</td>
<td>1079</td>
</tr>
<tr>
<td>Exploring ITSM Agent Workspace</td>
<td>1081</td>
</tr>
<tr>
<td>Setting up ITSM Agent Workspace</td>
<td>1087</td>
</tr>
<tr>
<td>Using ITSM Agent Workspace</td>
<td>1094</td>
</tr>
<tr>
<td>Workforce Optimization for ITSM</td>
<td>1153</td>
</tr>
<tr>
<td>Exploring Workforce Optimization for ITSM</td>
<td>1159</td>
</tr>
<tr>
<td>Setting up Workforce Optimization for ITSM</td>
<td>1175</td>
</tr>
<tr>
<td>Using Workforce Optimization for ITSM</td>
<td>1228</td>
</tr>
<tr>
<td>Incident Communications Management</td>
<td>1288</td>
</tr>
<tr>
<td>Incident Communications Management plugins</td>
<td>1289</td>
</tr>
<tr>
<td>Incident communication plan state model (new)</td>
<td>1291</td>
</tr>
<tr>
<td>Working with Incident Communications Management</td>
<td>1294</td>
</tr>
<tr>
<td>Incident Communications Management integrations</td>
<td>1314</td>
</tr>
<tr>
<td>Domain separation and Incident Communications Management....</td>
<td>1314</td>
</tr>
<tr>
<td>Incident Management</td>
<td>1315</td>
</tr>
<tr>
<td>Service Owner Workspace</td>
<td>1779</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Exploring Service Owner Workspace</td>
<td>1780</td>
</tr>
<tr>
<td>Setting up Service Owner Workspace</td>
<td>1789</td>
</tr>
<tr>
<td>Using Service Owner Workspace</td>
<td>1810</td>
</tr>
<tr>
<td>Service Builder</td>
<td>1823</td>
</tr>
<tr>
<td>Roles installed with Service Builder</td>
<td>1826</td>
</tr>
<tr>
<td>Create a service</td>
<td>1827</td>
</tr>
<tr>
<td>Create a service offering</td>
<td>1829</td>
</tr>
<tr>
<td>Service Level Management</td>
<td>1833</td>
</tr>
<tr>
<td>Service Level Management concepts</td>
<td>1834</td>
</tr>
<tr>
<td>Define a service contract</td>
<td>1836</td>
</tr>
<tr>
<td>Service Level Management plugins</td>
<td>1838</td>
</tr>
<tr>
<td>Configure Service Level Agreement (SLA)</td>
<td>1851</td>
</tr>
<tr>
<td>Service Level Agreement (SLA) breakdown definitions</td>
<td>1884</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Vendor Management Workspace</td>
<td>2100</td>
</tr>
<tr>
<td>Explore Vendor Management Workspace</td>
<td>2102</td>
</tr>
<tr>
<td>Set up the Vendor Management Workspace application</td>
<td>2108</td>
</tr>
<tr>
<td>Use Vendor Management Workspace</td>
<td>2139</td>
</tr>
<tr>
<td>Vendor Manager Workspace - Legacy</td>
<td>2146</td>
</tr>
<tr>
<td>Explore Vendor Manager Workspace</td>
<td>2148</td>
</tr>
<tr>
<td>Set up Vendor Manager Workspace</td>
<td>2161</td>
</tr>
<tr>
<td>Use Vendor Manager Workspace</td>
<td>2189</td>
</tr>
<tr>
<td>Domain separation and in Vendor Manager Workspace</td>
<td>2199</td>
</tr>
<tr>
<td>Quick start tests for Vendor Manager Workspace</td>
<td>2202</td>
</tr>
<tr>
<td>Vendor Performance - Legacy</td>
<td>2203</td>
</tr>
<tr>
<td>Configuring Vendor Performance</td>
<td>2205</td>
</tr>
<tr>
<td>Activate Vendor Performance</td>
<td>2222</td>
</tr>
<tr>
<td>Use the Vendor Performance Overview</td>
<td>2225</td>
</tr>
<tr>
<td>Vendor scorecards</td>
<td>2227</td>
</tr>
<tr>
<td>Scorecard ratings</td>
<td>2232</td>
</tr>
<tr>
<td>Vendor decision matrixes</td>
<td>2241</td>
</tr>
<tr>
<td>Using vendor bubble charts</td>
<td>2244</td>
</tr>
<tr>
<td>Vendor ticketing</td>
<td>2248</td>
</tr>
<tr>
<td>Domain separation and Vendor Performance</td>
<td>2269</td>
</tr>
<tr>
<td>ITSM Predictive Intelligence Workbench</td>
<td>2270</td>
</tr>
<tr>
<td>ITSM Predictive Intelligence Workbench administration</td>
<td>2272</td>
</tr>
<tr>
<td>Predictive Intelligence Workbench pretrained use cases</td>
<td>2282</td>
</tr>
<tr>
<td>Predictive Intelligence Workbench integration and customization</td>
<td>2283</td>
</tr>
<tr>
<td>ITSM Predictive Intelligence Workbench implementation</td>
<td>2283</td>
</tr>
<tr>
<td>Manage ITSM Predictive Intelligence Workbench use cases</td>
<td>2357</td>
</tr>
<tr>
<td>ITSM Predictive Intelligence Workbench dashboard</td>
<td>2358</td>
</tr>
<tr>
<td>Performance Analytics ITSM Dashboards</td>
<td>2364</td>
</tr>
<tr>
<td>IT Executive dashboard</td>
<td>2365</td>
</tr>
<tr>
<td>IT Manager dashboard</td>
<td>2369</td>
</tr>
<tr>
<td>IT Agent dashboard</td>
<td>2379</td>
</tr>
<tr>
<td>ITSM Mobile Agent</td>
<td>2383</td>
</tr>
</tbody>
</table>
Get started with ITSM Mobile agent................................................................. 2384
My work.................................................................................................................. 2384
On-Call Scheduling.............................................................................................. 2441
My Team................................................................................................................ 2442
Major incidents...................................................................................................... 2453
Domain Separation for ITSM Mobile Agent.................................................... 2477
Enable Push notification categories for ITSM Mobile Agent......................... 2479
Configurable actionable notifications for ITSM Mobile Agent....................... 2481
Collaboration Services for ITSM Mobile Agent............................................... 2490
Settings................................................................................................................ 2491

Index.................................................................................................................... a
**IT Service Management**

The IT Service Management (ITSM) solution provides scalable workflows to manage and deliver IT services to your users all through a single cloud-based platform. The ITSM solution can help increase your agents’ productivity, resolve issues quickly, and improve user satisfaction. Also, powered by platform native AI, you can quickly accelerate technology changes and view recommended actions for incoming tickets or requests and drive self-service and automation through enterprise chatbot technology. The NOW Platform also provides users access to ITSM via mobile or web-portal interfaces.

**Transform the impact, speed, and delivery of IT services**

The Now Platform was built for the cloud and has its own shared data model, AI, and workflow automation that are leveraged by many IT applications. The combination of the ServiceNow platform and applications helps you increase
productivity by automatically identifying and resolving issues, which reduces the negative business impacts of unplanned, non-strategic work.

View and download the full infocard for a highlight of ITSM features.

| Enhance the service experience | Automate support for common requests with virtual agents powered by natural language understanding (NLU). Engage users with natural, human conversation to provide consistent good customer service experiences. |
| Consolidate IT services | Rapidly consolidate existing tools to a single system of action in the cloud. |
| Improve IT productivity | Use machine learning algorithms and virtual agents to automate routine tasks and increase the productivity of agents. |
| Gain visibility into processes and services | Get full visibility into any process or service with built-in dashboards and analytics providing real-time, actionable information to improve service quality. |
| Provide mobile connectivity | Enable employees to find answers and get work done from a modern mobile application. |
Enhance the service experience

Automate routine agent interactions and increase the speed of resolution from the Employee Center portal. With supervised machine learning, you can automate incident categorization and assignment and eliminate bottlenecks created by manual incident triaging. Meet increasing demands without further adding staff and empower existing IT staff to focus on more meaningful work. For more information on the Employee Center portal and the features, see Employee Center and Employee Center Release Notes.

Consolidate IT services

Reduce the number of separate tools your company uses to provide a consistent service experience regardless of the issue or the request.
Consolidating IT services enables you to better manage and allocate resources and track performance. You can have a single reliable source of information where performance is monitored in real time and data is easy to capture and report.

**Improve IT productivity**

Accelerate resolution with built-in machine learning. Chatbots provide immediate resolution to common questions. With ITSM Virtual Agent in action, you can have employees with 24*7 support service. Service desk agents can take advantage of machine-learning automation to resolve incidents and recommend resolutions for agents based on similar incidents solved in the past.
Gain visibility into processes and services

Make smarter decisions with real-time analytics across the entire IT value chain. Get new insights into service performance using data trends and forecasts. With Performance Analytics, you can anticipate trends based on current conditions and past performance and identify areas where automation can increase efficiency.

Provide mobile connectivity

Stay connected and access information in real time using the ITSM mobile agent. You can access work assigned to you or your group, receive push
notifications, and approve or reject change requests and requested items. The ITSM mobile agent is available on the iOS platform from the Apple App Store or on the Android platform from the Google Play Store.

**Edge Encryption for ITSM Virtual Agent within ITSM**

Edge encryption provides you with direct control over your data security. Encryption and key management are performed on your intranet between your browser and your ServiceNow instance.

See [Understanding Edge Encryption](#).

Because edge encryption is enabled on a proxy server on your side of the network, there is significant planning, network administration and management, and setup required.

See [Planning for Edge Encryption](#).

To install edge encryption, see [Edge Encryption installation](#).

To configure edge encryption, see [Edge Encryption configuration](#).

ℹ️ **Note:** There are limitations when using edge encryption. See [Edge Encryption limitations](#).

**Get started**

- Set up the service management module for a modern ITSM experience. To learn more, see [Customer Success Center](#).

- Learn about the different ITSM packages that work for your business on the [ServiceNow Products website](#).

- Take an ITSM course to manage and deliver services to your users. To sign up, go to [ServiceNow training and certification](#).

- Read the product documentation, beginning with [IT Service Management](#).

**Applications and features**

- Machine learning solutions for IT Service Management
- Workforce Optimization for ITSM
- Asset Management
- Contract Management
- Procurement
- Product Catalog
- Benchmarks
- Change Management
• Coaching
• Continual Improvement Management
• Expense Line
• ITSM Virtual Agent
• Walk-up Experience
• ITSM Agent Workspace
• ITSM Predictive Intelligence Workbench
• Incident Communications Management
• Incident Management
• On-call scheduling
• Problem Management
• Release Management
• Request Management
• Service Catalog
• Service Desk
• Service Portfolio Management
• Service Owner Workspace
• Site Reliability Operations
• Site Reliability Metrics
• Task Outage
• Collaboration services
• Vendor Management Workspace
• ITSM Analytics and Reporting Solutions
• ITSM Mobile Agent
• ITSM Integration with Microsoft Teams
• Universal Request
• Universal Task

Script includes and customization

Many Script Includes are provided by default with the ITSM products. You can call existing script includes from a script or create your own script includes.
You can find script includes by navigating to **Self Service > System Definition** or **Self Service > System UI**. To get the latest features and problem fixes without breaking the existing functionality during an upgrade, remember the following points:

To modify or customize an existing script include:

- Do not use the script includes that are suffixed by SNC. Those script includes are read-only and must not be customized. For example, the following script include must not be customized.

```javascript
var ChangeProcessSNC = Class.create();
ChangeProcessSNC.prototype = {
  // SNC functions
  type: ""
}
```

- Do not override methods that start with an underscore. Those methods indicate that the functions are private.

You can override the functions of the non-SNC script includes that extend the SNC scripts. For example, the following script include can be overridden.

```javascript
var ChangeProcess = Class.create();
ChangeProcess.prototype = Object.extendsObject(ChangeProcessSNC,
{  // Customer overridden functions  type: "ChangeProcess" });
```

**Machine learning solutions for IT Service Management**

Machine learning in IT service management helps to enhance business scalability and improve business operations for organizations.

Businesses face a challenge with growing volumes of data, in extracting meaningful information from a huge set of raw data, and in deriving meaningful business insights. Machine learning can serve as a solution to a variety of business complexities as its algorithm is built using historical data. It helps avoid duplicate and inaccurate data being entered into the database and enables businesses to compute and process information much faster.

**Request Predictive Intelligence for Incident Management**

Activate Predictive Intelligence for Incident Management by requesting the Predictive Intelligence for Incident Management plugin (com.snc.incident.ml_solution) through the Now Support Service Catalog.
Before you begin

- Predictive Intelligence for Incident Management requires a separate subscription from the rest of the Now Platform.

To purchase a subscription, contact your ServiceNow account manager. When you purchase a subscription, certain plugins are activated automatically. If a plugin doesn’t appear in the instance, submit a request via the Now Support Service Catalog.

Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.

3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. On the form, fill in the fields.
Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Enter:</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

5. Click **Submit**.

**Request Predictive Intelligence for Major Incident Management**

Activate Predictive Intelligence for Major Incident Management by requesting the Predictive Intelligence for Major Incident Management plugin (com.snc.incident.mim.ml_solution) through the Now Support Service Catalog.
Before you begin

- Predictive Intelligence for Major Incident Management requires a separate subscription from the rest of the Now Platform.

To purchase a subscription, contact your ServiceNow account manager. When you purchase a subscription, certain plugins are activated automatically. If a plugin doesn’t appear in the instance, submit a request via the Now Support Service Catalog.

Role required: admin

About this task
The following plugins are installed with Predictive Intelligence for Major Incident Management:

- Incident Management - Major Incident Management (com.snc.incident.mim)
- Predictive Intelligence for Incident Management (com.snc.incident.ml_solution)

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.

3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.
4. On the form, fill in the fields.

### Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Enter:</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments. |

5. Click **Submit**.

**Predictive Intelligence for Incident Management**

Use your instance records to build Incident Management-specific solutions.
Solution definitions

These solution definitions are available as templates on instances where both Predictive Intelligence and Incident Management are active. Create your own solution definition records to customize the behavior.

Solution Definitions for Incident Management

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Assignment</td>
<td>Classification</td>
<td>Predicts the Assignment group field from the Short description.</td>
</tr>
<tr>
<td>Incident Categorization</td>
<td>Classification</td>
<td>Predicts the Category field from the Short description.</td>
</tr>
<tr>
<td>Incident Service</td>
<td>Classification</td>
<td>Predicts the Service field from the Short description.</td>
</tr>
<tr>
<td>Incident Configuration Item</td>
<td>Classification</td>
<td>Predicts the Configuration item field from the Short description.</td>
</tr>
<tr>
<td>Major Incident Detection</td>
<td>Similarity</td>
<td>Recommends similar active major incidents which the current incident can be linked to. Recommends similar incidents to propose a major incident.</td>
</tr>
<tr>
<td>Similar Incidents (Major Incident Workbench)</td>
<td>Similarity</td>
<td>Recommends similar incidents that are not linked as child incidents to a major incident.</td>
</tr>
<tr>
<td>Similar Incidents</td>
<td>Similarity</td>
<td>Recommends similar incidents to help with incident investigation and resolution processes.</td>
</tr>
</tbody>
</table>
### Solution Definitions for Incident Management (continued)

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Similar Open Incidents</td>
<td>Similarity</td>
<td>Recommends similar open incidents that the current incident can be linked to.</td>
</tr>
<tr>
<td>Similar Resolved Incidents</td>
<td>Similarity</td>
<td>Recommends similar resolved incidents to help with incident investigation and resolution processes.</td>
</tr>
<tr>
<td>Estimated time to resolve</td>
<td>Regression</td>
<td>Predicts the estimated time to resolve an Incident.</td>
</tr>
</tbody>
</table>

Solution definitions and the required plugins are as follows:

### Solution definitions and plugins

<table>
<thead>
<tr>
<th>Solution definition</th>
<th>Plugins</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Incident Assignment</td>
<td>The plugins com.glide.platform_ml and com.snc.incident.ml_solution must be active.</td>
</tr>
<tr>
<td>• Incident Categorization</td>
<td></td>
</tr>
<tr>
<td>• Incident Service</td>
<td></td>
</tr>
<tr>
<td>• Incident Configuration Item</td>
<td></td>
</tr>
<tr>
<td>Similar Incidents (MIM)</td>
<td>The plugins com.glide.platform_ml and com.snc.incident.mim.ml_solution must be active.</td>
</tr>
<tr>
<td>Major Incident Recommendation</td>
<td>The plugins com.snc.contextual_search_ml and com.snc.incident.mim.ml_solution must be active.</td>
</tr>
<tr>
<td>• Similar Open Incidents</td>
<td>The plugins com.snc.contextual_search_ml and com.snc.incident.mim.ml_solution must be active.</td>
</tr>
<tr>
<td>• Similar Resolved Incidents</td>
<td></td>
</tr>
<tr>
<td>• Similar Incidents</td>
<td></td>
</tr>
<tr>
<td>• Similar Knowledge Articles</td>
<td></td>
</tr>
</tbody>
</table>
For more information on classification and similarity solution, refer to Create solution definition and Create similarity solution.

**Business rules for classification solutions**

These business rules apply only to the Incident Assignment and Incident Categorization solution definitions and are available only on instances where both Predictive Intelligence and Incident Management are active. Create your own business rules on the Incident table to customize prediction and reporting behaviors.

**Business rules for Incident Management**

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Prediction Results</td>
<td>Incident</td>
<td>Updates the solution precision and coverage statistics. Runs when an incident record is closed.</td>
</tr>
<tr>
<td>Incident Based Prediction (Service &amp; CI)</td>
<td>Incident</td>
<td>Generates prediction results for active Incident Management solutions. Shows prediction results in an information message to users with the itil role. Runs when an incident record is inserted. Only updates the output field with a predicted value if it has not been already filled.</td>
</tr>
</tbody>
</table>
# Business rules for Incident Management (continued)

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The rule is based on the following conditions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• First priority is given to the manually entered value in the <strong>Service</strong> and the <strong>Configuration item</strong> field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Second priority is given to the predicted value of the <strong>Service</strong> field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the values of the <strong>Configuration item</strong> and <strong>Service</strong> fields do not match and the <strong>Configuration item</strong> field value was manually entered, then the <strong>Configuration item</strong> field value is considered and the <strong>Service</strong> field value is discarded. Otherwise, the <strong>Service</strong> field value is considered.</td>
</tr>
</tbody>
</table>

If the classification is successful, a notification is displayed regarding
### Business rules for Incident Management (continued)

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>the classified Service and CI. If there is conflict between predicted CI with existing or predicted Service, then a notification is displayed regarding the conflict with predicted CI. If there is conflict between existing CI with predicted Service, then a notification is displayed regarding the conflict with predicted Service.</td>
</tr>
</tbody>
</table>

**Note:**

By default, the validation of CI and Service is disabled. Contact a ServiceNow personnel to enable it.

### Upgrade Information

If your instance is running on the Kingston release and you are upgrading to the Rome release:

- In a global domain environment, use the new solutionNames array variable which requires that you explicitly provide the solutions that are called by the business rule.

- In a domain-separated environment, such as an MSP environment, refer to the commented code in the business rule template for easy customization.

- The business rule template now calls the applyPredictionForSolution() method to predict regardless of any changes to the default value.

### Maintaining prediction accuracy

You can manage prediction drift by retraining, modifying, or creating new solutions to reflect changes in your business conditions. Test and modify your
business rule over time to ensure it works as desired across multiple consumption points and user Personas.

**Request Predictive Intelligence for Incident**

To activate Predictive Intelligence for Incident, request the Predictive Intelligence for Incident plugin (com.snc.incident.ml) through the Now Support Customer Service system. This plugin activates related plugins if they are not already active.

**Before you begin**
Role required: admin

**About this task**
The Predictive Intelligence for Incident plugin activates these related plugins if they are not already active.

### Plugins for Predictive Intelligence for Incident

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
| Predictive Intelligence for Contextual Search [com.snc.contextual_search_ml] | Enables customers to leverage machine-learning algorithms for searching with Contextual Search. For example: Similar Open Incidents.  
Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details. |

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.
5. Select Actions > Activate Plugin.
6. On the form, fill in the fields.

### Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the <strong>Reason/Comments</strong> field.</td>
</tr>
</tbody>
</table>

*Note:* Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

7. Click **Submit**.

**Related reference**

List of plugins (Rome)

**Predictive Intelligence for Incident**

Use your instance records to build Incident Management-specific solutions.

**Solution definitions**

The solution definitions are available when you have the Predictive Intelligence for Incident plugin (com.snc.incident.ml) activated in your system.

These solution definitions are available as templates on instances where both Predictive Intelligence and Incident Management are active. Create your own solution definition records to customize the behavior.

**Solution Definitions for Incident Management**

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Similar Open Problems</td>
<td>Similarity</td>
<td>Recommends similar open problems that the current incident can be linked to. By default, the similarity is inactive.</td>
</tr>
</tbody>
</table>
Solution Definitions for Incident Management (continued)

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Similar Open Change Requests</td>
<td>Similarity</td>
<td>Recommends similar open change requests that the current incident can be linked to as a request for change. By default, the similarity is inactive.</td>
</tr>
</tbody>
</table>

For more information on similarity solution, refer Create similarity solution.

Asset Management

The ServiceNow® Asset Management application integrates the physical, technological, contractual, and financial aspects of information technology assets.

Asset management business practices have a common set of goals.

• Control inventory that is purchased and used.
• Reduce the cost of purchasing and managing assets.
• Select the proper tools for managing assets.
• Manage the asset life cycle from planning to disposal.
• Achieve compliance with relevant standards and regulations.
• Improve IT service to end users.
• Create standards and processes for managing assets.

Most successful ITAM programs involve various people and departments, including IT, finance, services, and end users.

Asset Management and the Configuration Management Database (CMDB) are related, but have different goals. Asset Management focuses on the financial tracking of company property. Configuration management focuses on building and maintaining elements that create an available network of services.

Related information

Domain separation and Asset Management
Mobile app for Hardware Asset Management

Use the Now® Mobile and Agent mobile apps to manage your assets.

Agent Mobile app

Use the Agent Mobile app to create assets, look up assets, and receive assets from a purchase order.

Create an asset

Use the Agent Mobile app to create an asset record by scanning the asset.

Before you begin

Role required: asset
Procedure

1. Navigate to **Asset** and tap **Create Asset**.

2. Scan the asset serial number or asset tag, then tap **Search**. An asset record is displayed if the asset already exists in your ServiceNow instance. This is to ensure you don't create duplicate asset records.

3. If no existing asset record is found, tap the action icon in the upper right and select **Create Asset**.

4. Scan or enter values for the **Asset Tag**, **Serial Number**, **Model**, and **Stockroom** fields.

5. Tap **Submit** to create the asset.
Asset lookup
Search for an asset record in your ServiceNow instance by scanning the asset.

Before you begin
Role required: asset

Procedure
1. Navigate to Asset and tap Asset lookup.
2. Scan the asset tag, then tap Search.
3. An asset record is displayed if the asset exists in your ServiceNow instance.

Receive assets from a purchase order
Scan assets from a purchase order (PO) to verify that you received all assets from the order.

Before you begin
Role required: procurement_admin or procurement_user

Procedure
1. Navigate to Procurement and tap POs Next 30 Days.
2. Select a purchase order.
3. Tap Related list.
4. Tap the PO Line Items asset that you ordered and swipe Receive to receive the asset.
5. If you only need to receive a single purchase, on the Receive form, scan the QR code for either the asset tag or serial number.

6. If you need to receive multiple purchases, on the Receive form, tap **Scan next item**. Continue tapping **Scan next item** until you’ve scanned all of your purchases.

7. Tap **Submit**.

**Results**
The purchase order is marked as received.

**Now Mobile app**
Use the Now Mobile app to view the assets that are assigned to you, to report any issues with your assets, and to remotely receive new assets. Create incidents to report any issues with your assets to your IT department.

The Now Mobile app provides different services for tasks and requests.
Welcome to mobile!

Complete tasks, track requests, and discover powerful workplace support at your fingertips.

- My Tasks: 0
- My Requests: 0
- My Assets: 9
To view all the assets that are assigned to you, navigate to **My Items > My Assets > Hardware**. The tab shows the assets that are in transit or in use. You can create an incident for an asset that is in use.

When you are away from your office, you can remotely receive an asset that is in transit. Scan the QR code for the asset tag so that you can automatically notify the IT department that you have received the asset.

**Asset and CI management**

Asset and configuration item (CI) management refers to creating assets, setting appropriate states and substates, synchronizing assets and CIs, managing consumables, and retiring assets.

**Relationship between asset and CI**

It is important to manage the relationship between assets and associated CIs. Assets are tracked with the Asset Management application, which focuses on the financial aspects of owning property. Configuration items are stored in the CMDB, which is used to track items and make them available to users.

When an asset has a corresponding configuration item, the asset record and the configuration item record are kept synchronized with two business rules.

- **Update CI fields on change** (on the Asset [alm_asset] table)
- **Update Asset fields on change** (on the Configuration Item [cmdb_ci] table)

**Note:** Assets and CIs can be synchronized only if they are logically mapped.

**Asset-CI mapping and synchronization**

The State field of asset record and Status field of CI record are synchronized so that changes made on one form trigger the same update on the corresponding form, ensuring consistent reporting.

**Note:** The Now Platform synchronizes updates between assets and configuration items only if the asset and configuration item are pointed toward each other.

The following diagram illustrates the concept of Asset-CI mapping and synchronization.
This synchronization and mapping is based on the following factors:

- Asset state and CI status are not mapped on one-to-one basis; rather they are mapped to the most logical counterpart on the other table. For example, for a hardware asset set to state **In Stock - Pending disposal**, the corresponding CI is set to **In Disposition** with no substate.

- This synchronization happens between the asset’s State field and the following CI fields:
  - Install Status field: Install Status does not have a sub status and must be used for non-hardware CIs.
  - Hardware Status and Sub status field: Hardware Status is visible only for Hardware CI.

- Drive changes by updating the state on the Asset form. The Asset-CI synchronization can be driven in the following ways:
  - Asset to CI synchronization: Change to the asset’s status updates the logically mapped CI’s Install Status or Hardware Status and sub status.
  - CI to Asset: Change to the CI’s activate Status or Hardware Status updates the logically mapped asset’s states and sub states.
• For a CMDB hardware CI, if both Hardware Status and Install Status is updated, the Hardware Status change is considered for mapping the corresponding state of the asset.

• CI’s Install Status and Hardware Status work independently, so the two fields aren’t related. CI’s Hardware Status change does not change CI’s Install Status and vice versa. To avoid confusion, keeping both status for CMDB CI Hardware is not recommended.

**List of the fields that get synced between Asset and CI**

When modifying any of following fields on the asset or CI record, the same field on the corresponding record is automatically updated (with the exception of the **Cost** field, which is informational-only on the CI record).

Following is a list of fields that are synched.

- Asset tag
- Assigned
- Assigned to
- Checked in
- Checked out
- Company
- Cost (synchs in only one direction: asset to CI)
- Cost center
- Delivery date
- Department
- Due in
- Due
- GL account
- Install date
- Invoice number
- Justification
- Lease id
- Location
- Managed by
- Model
• Order date
• Order received
• Ordered
• Owned by
• PO number
• Purchase date
• Purchased
• Serial number
• Support group
• Supported by
• Vendor
• Warranty expiration

Asset and CI creation properties

_glide.create_alm_asset.async_

The system property _glide.create_alm_asset.async_ controls whether assets are created immediately when a configuration item (CI) is created, or are created after a delay. A delay in asset creation allows large numbers of CIs to be created quickly. When this property is set to _true_, assets are created by the _Asset – Create asset delayed sync_ scheduled job that runs every 15 minutes. View the status of the scheduled job in the Asset Job Log table [asset_job_log]. To view assets waiting to be created and asset creation errors, navigate to _Asset > Administration > Asset Creation Queue_. To reprocess an error, update the state from _Error_ to _Ready_. The next time the scheduled job runs, it reattempts to create the asset.

When the _glide.create_alm_asset.async_ property is set to _false_, assets are created immediately from CIs.

ℹ️ **Note:** The default value of this property is _false_ if you upgrade to Rome from Orlando or earlier. Before updating this property, review your processes that depend on an asset value present on a CI and make any necessary changes to account for delayed asset creation.

_glide.asset.create_ci_with_ire_
The system property `glide.asset.create_ci_with_ire` enables CIs to be created from assets using the ServiceNow® Configuration Management Database (CMDB) Identification and Reconciliation engine (IRE). This property affects CI classes that have an identification rule on serial number and have no dependent relationships with other CI classes.

**Note:** CI classes that are extended from the hardware CI class `[cmdb_ci_hardware]` are also created from assets using the IRE, but are not controlled by this property.

CIs created with the IRE are named using the format `Serial number - Model name` and the source is `SNAssetManagement`. The `Serial number` field is mandatory on assets with model categories that correspond to these CI classes. Asset creation fails if its serial number is present on an existing CI or asset. The `Serial number` field is also required to receive purchase order line items for model categories that correspond to these CI classes. The `Serial number` field is not mandatory to create pre-allocated assets, but the serial number must be provided when the asset is allocated.

**Note:** The default value of this property is `false` if you upgrade to Rome from Orlando or earlier. Before updating this property, review customizations on the `Serial number` field and any integrations or flows that use an existing serial number to create an asset.

**Create assets**

You can create hardware, software license, consumable, license, software entitlement, and facility assets.

**Before you begin**

Role required: asset

**Procedure**

1. Navigate to **Asset > Portfolios > All Assets**.
2. Select the type of asset you want to create.
3. Click **New**.
4. Fill in the fields.
### Asset record fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the asset as it appears in record lists. Automatically set when asset is created, based on Asset Tag and Model fields.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model grouping of the asset. Based on the model category selected, the asset can be linked to a configuration item.</td>
</tr>
<tr>
<td>Model</td>
<td>Specific product model of the asset.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>CI automatically created when this asset is created. The name that appears in this field is based on Serial number and Model. Point to the reference icon to see the configuration item details inherited from the asset record.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Number of items this asset represents. An asset always has a quantity of one unless one or more of these points are true.</td>
</tr>
<tr>
<td></td>
<td>• It is a consumable. Quantity is unrestricted because consumables are tracked in groups.</td>
</tr>
<tr>
<td></td>
<td>• It is pre-allocated. Quantity is unrestricted when Model category and Model are defined and Substate is set to Pre-allocated.</td>
</tr>
</tbody>
</table>

**General**

Not all fields are available for each type of asset.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset tag</td>
<td>Alphanumeric information assigned by your organization to help track the asset.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the asset, such as On order or In use.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Person using or primarily responsible for this item. This field is visible when the asset state is In Use.</td>
</tr>
<tr>
<td>Managed by</td>
<td>Person who maintains the asset. This can be different from the person in the Owned by field.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Person who has financial ownership of the asset. This can be different from the person in the Managed by field.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset of the asset. For example, a monitor or peripheral can have a workstation as their parent asset. When a parent link is defined, the fields related to assignment and state of the child assets is set to read-only and are</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>populated based on the parent assignment and state fields. For more information, see Creating Bundled Models.</td>
</tr>
<tr>
<td>Class</td>
<td>Asset group, for example, base, hardware, license, or consumable.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the asset that would be helpful for others to know.</td>
</tr>
<tr>
<td>Serial number</td>
<td>Serial number of this asset.</td>
</tr>
<tr>
<td>Substate</td>
<td>Current substate of the asset. The available substate settings depend on the state selected. For example, the Retired state contains the Substate options Disposed, Sold, Donated, and Vendor credit.</td>
</tr>
<tr>
<td>Location</td>
<td>Current physical location of the asset.</td>
</tr>
<tr>
<td>Department</td>
<td>Department to which the asset belongs.</td>
</tr>
<tr>
<td>Company</td>
<td>Company or organization to which this asset belongs.</td>
</tr>
<tr>
<td>Assigned</td>
<td>Date on which the asset was assigned to a user.</td>
</tr>
<tr>
<td>Installed</td>
<td>Date on which the asset was installed.</td>
</tr>
<tr>
<td>Financial</td>
<td>The Financial section is only available for hardware, software entitlement, and facility assets.</td>
</tr>
<tr>
<td>Request line</td>
<td>Requested item to which the asset is linked.</td>
</tr>
<tr>
<td>Invoice number</td>
<td>Invoice under which the asset was billed.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price at which the asset was purchased.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor from which the asset was purchased. For assets automatically created from purchase orders in Procurement, the default value of the Vendor field is the vendor specified on the purchase order.</td>
</tr>
<tr>
<td>Opened</td>
<td>Date on which the requested item record was opened. The system automatically populates the field when a request line is specified.</td>
</tr>
<tr>
<td>GL account</td>
<td>General ledger account number with which the asset is associated.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cost center</td>
<td>Group financially responsible for the asset.</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>How the asset was acquired. Base system choices are <strong>Purchase</strong>, <strong>Lease</strong>, <strong>Rental</strong>, and <strong>Loan</strong>.</td>
</tr>
<tr>
<td></td>
<td>For assets automatically created from purchase orders in Procurement, the default value is <strong>Purchase</strong></td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Capex</strong>: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Opex</strong>: Operational expenditure is an on-going expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Disposal</td>
<td>A unique number assigned to the asset disposal order.</td>
</tr>
<tr>
<td>Disposal order number</td>
<td>Note: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal vendor</td>
<td>The vendor assigned to carry out the asset disposal order.</td>
</tr>
<tr>
<td>Disposal order ID</td>
<td>Note: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal date</td>
<td>Order number assigned by the vendor assigned to carry out the asset disposal order.</td>
</tr>
<tr>
<td>Disposal reason</td>
<td>The date when the asset disposal order process is completed.</td>
</tr>
<tr>
<td>Beneficiary</td>
<td>Text explaining why the asset is being retired.</td>
</tr>
<tr>
<td></td>
<td>Note: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resale price</td>
<td>Value of the asset when it is retired. For example, if the asset is donated, the value used when reporting taxes.</td>
</tr>
<tr>
<td>Scheduled retirement</td>
<td>Scheduled date on which the asset is retired.</td>
</tr>
<tr>
<td>Retired date</td>
<td>Actual date on which the asset was retired.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>The Depreciation section is only available for hardware and facility assets.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>Depreciation method that is applied. Base system choices are Declining Balance and Straight Line. The depreciation value is defaulted from the associated Model.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>Date on which the specified depreciation method begins.</td>
</tr>
<tr>
<td>Salvage value</td>
<td>Estimated value of an asset at the end of its useful life. This value must be less than or equal to the Cost of the asset.</td>
</tr>
<tr>
<td>Residual date</td>
<td>Number of days that have passed since the Depreciation effective date.</td>
</tr>
<tr>
<td>Residual value</td>
<td>Value in the Cost field with the depreciation method applied.</td>
</tr>
<tr>
<td>Deprecated amount</td>
<td>Amount the asset has depreciated.</td>
</tr>
<tr>
<td>Contracts</td>
<td>The Contract section is only available for hardware, software entitlement, or facility assets.</td>
</tr>
<tr>
<td>Lease contract</td>
<td>Name of the lease contract that applies to the asset.</td>
</tr>
<tr>
<td>Warranty expiration</td>
<td>Expiration date of the asset warranty.</td>
</tr>
<tr>
<td>Support group</td>
<td>Group managing the contract covering the asset.</td>
</tr>
<tr>
<td>Supported by</td>
<td>Person managing the contract covering the asset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Work notes</td>
<td>Work notes are updated for the following cases:</td>
</tr>
<tr>
<td></td>
<td>• Updates to <strong>Assigned To, Managed To State, Substate</strong>, and <strong>Reserved</strong> fields of asset. The columns for these fields are audited by default and any update is recorded in the work notes.</td>
</tr>
<tr>
<td></td>
<td>• Work notes for hardware and software assets are updated when asset is received by a purchase order and transfer order. These work notes help in tracking life cycle of the asset.</td>
</tr>
</tbody>
</table>

**Related links**

<table>
<thead>
<tr>
<th>Calculate Depreciation</th>
<th>Click to calculate the depreciation amount and residual value.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Assets Only</td>
<td>Click to delete the assets and not the associated CI.</td>
</tr>
</tbody>
</table>

**Related lists**

<table>
<thead>
<tr>
<th>Assets</th>
<th>Assets that are related to the asset you created.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense lines</td>
<td>Expense line associated with the asset</td>
</tr>
</tbody>
</table>

5. Click Submit.

**Retire assets**

You can retire an asset at any time.

**Before you begin**

Role required: asset

**About this task**

After you change the state of an asset to **Retired**, the **Substate** field is active. When you retire an asset, the status of related CIs also changes to **Retired**. Selecting a substate is not required, but can be helpful for tracking and reporting.

**Procedure**

1. Navigate to **Asset > Portfolios > All Assets**.

2. In **State**, select **Retired**.
3. **Optional:** In **Substate**, select **Disposed, Sold, Donated,** or **Vendor Credit.**

4. **Click Update.**

### Delete assets

You can delete an asset at any time.

**Before you begin**

> Note: If an asset is a part of an asset bundle, the asset cannot be deleted.

**Role required:** asset

**About this task**

A confirmation must be accepted before the asset and components are permanently deleted. If a CI and asset are linked, deleting one also deletes the other.

Only delete an asset to clean up errors. For tracking purposes, the correct method for managing an asset that is no longer in use is to change the state of the asset to **Retired.**

**Procedure**

1. Navigate to **Asset > Portfolios > All Assets.**
2. Select the check box to the left of the asset **Name.**
3. In the **Actions** choice list below the list, select **Delete.**

### Map asset and CI fields

When you map the asset and CI fields, synchronization happens both ways. Changes to either the asset or CI record are updated to the logically mapped record. You can synchronize custom mappings and mappings provided with the base instance.

**Before you begin**

**Role required:** admin or asset

> Note: If you upgraded from a prior release and customized the **AssetAndCISynchronizer** script include before the upgrade, you must overwrite the customization and then recreate the custom mappings.
About this task
You can conditionally map the fields for synchronization. For example, you can map the Location field only for a hardware asset and not for a software asset. So when an asset is updated, the Location field is synchronized only for the hardware asset.

Procedure
1. Navigate to Asset > Administration > Asset-CI Field Mapping and click New.
2. From the Asset field list, select the field. This list refers to the alm_asset table.
3. From the Configuration Item field list, select the logically associated field. This list refers to the cmdb_ci table.
4. To create conditions for the mapping, click the Advanced view related link.
   • To specify conditions for synchronizing the asset field with the CI field, use the Asset mapping condition builder.
   • To specify conditions for synchronizing the CI field with the asset field, use the Configuration Item mapping condition builder.
5. Select the Active check box to activate the mapping.
6. Click Submit.

Map asset state and CI install status
Map the asset State and Substate fields to the CI Install Status field. The Substatus field of the CI Install Status field should not be used for hardware CIs. Asset synchronization does not update this field when hardware assets are updated. When you create the mapping, you can set the synchronization direction from the asset, CI, or both.

Before you begin
Role required: admin or asset

⚠️ Note: If you upgraded from a prior release and customized the AssetAndCISynchronizer script include before the upgrade, you must overwrite the customization and then recreate the custom mappings.

Procedure
1. Navigate to Asset > Administration > Asset-CI Install Status Mapping. By default, only custom mappings display. The list of mappings uses the filter condition of [Out of the box] [is] [False].
2. Click **New**.

3. From the **Asset State** list, select the state you want to map.

4. **Optional:** If available, select a substate from the **Asset Substate** list.
   Some of the asset states do not have a substate.

5. From the **Configuration Item Status** list, select the logically associated CI status you want to map.

6. From the **Sync direction** list, select the direction you want to drive the synchronization.

7. Select the **Active** check box to activate the mapping.

8. Click **Submit**.

---

**Map asset state and CI hardware status**

Map the asset **State** and **Substate** fields to the **CI Install Status** field. Don't use the **Substatus** field on hardware CIs because the CI synchronization does not update the field when assets are updated. When you create the mapping, you can set the synchronization direction from the asset, CI, or both.

**Before you begin**

Role required: admin or asset

ℹ️ **Note:** If you upgraded from a prior release and you've customized the `AssetAndCISynchronizer` script before the upgrade, overwrite the customization and then recreate the custom mappings.

**About this task**

The **Install Status** and **Hardware Status** fields of a CI are independent of each other. There is no correlation between them. A change to the **Hardware Status** field does not change the **CI Install Status** field and vice versa.

**Procedure**

1. Navigate to **Asset > Administration > Asset-CI Hardware Status Mapping**.
   By default, only custom mappings display. The list of mappings uses the filter condition of `[Out of the box] [is] [False]`.

2. Click **New**.

3. From the **Asset state** list, select the state you want to map.

4. **Optional:** If available, select a substate from the **Asset substate** list.
   Some of the asset states do not have a substate.
5. From the **Configuration Item status** list, select the logically associated CI state you want to map.

6. **Optional:** If available, select a substate from the **Configuration Item substatus** list. Some of the CI statuses do not have a substatus.

7. From the **Sync direction** list, select the direction you want to drive the synchronization.

8. Select the **Active** check box to activate the mapping.

9. Click **Submit**.

---

### Asset classes

The default asset classes are Hardware, Software License, and Consumable. These general classes can be used to manage various assets.

If the general classes that are provided aren’t appropriate for a specific group of assets, consider creating a new asset class. For example, a fleet of cars could be tracked in a custom asset class named Vehicle. Before creating new asset classes, analyze business needs to see if the general classes can be used. Managing a lot of asset classes can be difficult to maintain.

Built-in functionality allows you to use asset classes for financial tracking, in a model bundle, and as a pre-allocated asset.

---

### Create an asset class

Creating a new asset class requires defining a new table and creating a corresponding application and module, then adding the new asset class to new or existing model categories. The default asset classes are Hardware, Software License, and Consumable. These general classes can be used to manage a variety of assets.

**Before you begin**

Role required: asset or category_manager

**About this task**

If the general classes are not appropriate for a specific group of assets, consider creating a new asset class. For example, a fleet of cars could be tracked in a custom asset class named Vehicle. Before creating new asset classes, analyze business needs to see if the general classes can be used. A large number of asset classes can be difficult to maintain.
Built-in functionality allows you to use asset classes for financial tracking, in a model bundle, and as a pre-allocated asset.

Ensure that the model categories contain models. Use the Table form to extend an existing table.

**Procedure**

1. Navigate to **System Definition > Tables & Columns > Create Table** and fill out the Table form fields with information on the new table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Display name of table that can be localized.</td>
</tr>
<tr>
<td>Name</td>
<td>Internal name of table that cannot be changed later.</td>
</tr>
<tr>
<td>Extends table</td>
<td>Table that new table inherit fields from.</td>
</tr>
<tr>
<td>Application</td>
<td>Application that uses the record.</td>
</tr>
<tr>
<td>Create module</td>
<td>Check box for creating a module.</td>
</tr>
<tr>
<td>Create mobile module</td>
<td>Check box for creating a mobile module.</td>
</tr>
<tr>
<td>Add module to menu</td>
<td>Menu that module will display.</td>
</tr>
<tr>
<td>New menu name</td>
<td>New menu name.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.

3. Navigate to the new application (for example, **Asset > Vehicle**) and click **New**.

4. Configure the form to include **Model**, **Model Category**, and **Quantity**.

5. Create a model category and add the asset class you created to the **Asset class** field.

6. Create new models and add them to the model category.

**What to do next**

Now that the model category (associated with the new asset class) and the models are created, manage the models as assets. For example, use the model in a bundle.
Add depreciation to an asset

Depreciation is the reduction in value of an asset over time.

Before you begin
Role required: asset

About this task
A depreciation schedule can be added to hardware assets. Based on the information specified in the asset record, the ServiceNow platform calculates the depreciation amount daily using the Calculating Depreciation scheduled job.

The Now Platform calculates the read-only Residual date and Residual value fields based on the Cost, Depreciation, and Depreciation effective date fields. For example, if the asset Cost is $1000.00, the Straight Line depreciation method is selected, and exactly two years have passed, the Residual value would be $500.00.

When an asset is in In Use state, the asset form populates Depreciation effective date.

For more information about fixed assets and depreciation, see Using Depreciation with Fixed Assets.

Procedure
1. Navigate to Asset > Portfolios > Hardware Assets.
2. Select an asset.
3. Fill in the Depreciation, Depreciation effective date, Salvage Value, and Covered by fixed asset fields as described in Create assets.
   Consider these points.
   • If the depreciation effective date is in the future, depreciation is 0 and the current, residual value is the original purchase price. The system does not begin to calculate depreciation until the effective date is reached.
   • The salvage value must be less than or equal to the asset cost. If a salvage value greater than the cost is entered, a warning message appears and the record cannot be saved.
4. Right-click the header and click Save.
5. Click Calculate Depreciation.
   The Residual date, Residual value, and Depreciated amount fields are automatically calculated.
Create license assets

You can manage your organization’s software license assets.

Before you begin
Role required: sam

About this task
Examples include a license to use a single copy of a desktop software program and an enterprise license to install a software program on multiple computers.

Procedure
1. Navigate to Asset > Portfolios > License Assets and click New.
2. In the Rights field, type the number of entitlements to be granted by this license.
3. Complete the form as described in Create assets.

Set asset states and substates

Asset states and corresponding substates can be used to accurately track assets at a detailed level.

Before you begin
Role required: asset

About this task
Good asset information helps with reporting, controlling assets, and lowering costs. For example, recording missing items using the State and Substates fields enables you to run reports and analyze the information. You can use this information to lower costs.

Tip: Generally, state values should not be modified and should remain as-is. If the state values are supported and defined by the process, you can modify substates.

Procedure
1. Navigate to Asset > Portfolios > All Assets.
2. Select an asset.
3. Edit the State and Substate fields.
### Asset states and substates definitions

<table>
<thead>
<tr>
<th>State</th>
<th>Available substates</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>On order</td>
<td>None</td>
<td>Asset is ordered but not received.</td>
</tr>
<tr>
<td>In stock</td>
<td>Available, Reserved, Defective, Pending repair, Pending install, Pending disposal, Pending transfer, Pre-allocated</td>
<td>Asset is stored in a stockroom. Substate indicates if it is possible or if you should put the asset into use.</td>
</tr>
<tr>
<td>In transit</td>
<td>Available, Reserved, Defective, Pending install, Pending disposal, Pre-allocated</td>
<td>Asset being transported.</td>
</tr>
<tr>
<td>In use</td>
<td>None</td>
<td>Asset is in use. This option is available for both consumables and non-consumables, but you should only use this option for consumables.</td>
</tr>
<tr>
<td>In maintenance</td>
<td>None</td>
<td>Asset being repaired or undergoing maintenance.</td>
</tr>
<tr>
<td>Retired</td>
<td>Disposed, Sold, Donated, Vendor credit</td>
<td>Set the asset to a Retired state when the asset has reached the end of life. Only delete asset records if they were created erroneously.</td>
</tr>
<tr>
<td>Missing</td>
<td>Lost, Stolen</td>
<td>An asset that is missing or lost.</td>
</tr>
</tbody>
</table>

### Create fixed assets

Fixed assets are containers that can hold multiple assets. Fixed assets are commonly tracked at the corporate level by a finance or accounting department, but may contain IT assets such as hardware and software.

The **Fixed Asset** option in the Cost application shows the IT assets related to a fixed asset record. This link can help IT stay coordinated with the corporate asset system. Users with the financial_mgmt_admin and financial_mgmt_user roles can create fixed assets. After creating a fixed asset and adding assets, the residual value can be automatically calculated.
To create a fixed asset:
1. Navigate to Cost > Fixed Assets.
2. Click New.
3. Enter a name for the fixed asset.
4. Click Submit.

To add assets to a fixed asset:
1. Navigate to Cost > Fixed Assets.
2. Click a fixed asset.
3. In the Covered assets related list, click Edit.
4. In the Collection list, double-click an asset to add it to the Covers Assets List.
5. Click Save.

To sum the residual values of all assets in a fixed asset:
1. Navigate to Cost > Fixed Assets.
2. Click a fixed asset.
3. Click Sum Residual Value.

The ServiceNow platform calculates the Residual Value, Total cost, and Total depreciation based on information in the Financial and Depreciation sections on the individual asset records.

Use depreciation with fixed assets

You can calculate depreciation for a fixed asset using a choice of depreciation schedules. Calculating depreciation for a fixed asset can help IT coordinate with the corporate fixed asset system to report correct valuation and book value.

Before you begin
Role required: financial_mgmt_admin or financial_mgmt

About this task
When creating a new depreciation schedule, select the Declining Balance or Straight Line depreciation Category. The two categories depreciate an asset by the same overall amount during the asset life cycle, but do so on different schedules.
• **Declining Balance**: depreciates an asset by a greater amount in earlier accounting periods than in later periods.

• **Straight Line**: depreciates an asset by an equal amount each accounting period.

The following example shows depreciated value on a $10,000.00 asset over five years using the two different methods.

### Using depreciation with fixed assets

<table>
<thead>
<tr>
<th>Year</th>
<th>Declining balance</th>
<th>Straight line</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$5000.00</td>
<td>$8000.00</td>
</tr>
<tr>
<td>2</td>
<td>$2500.00</td>
<td>$6000.00</td>
</tr>
<tr>
<td>3</td>
<td>$1250.00</td>
<td>$4000.00</td>
</tr>
<tr>
<td>4</td>
<td>$625.00</td>
<td>$2000.00</td>
</tr>
<tr>
<td>5</td>
<td>$0</td>
<td>$0</td>
</tr>
</tbody>
</table>

### Procedure

1. To view a depreciation schedule, navigate to **Financial Management > Depreciation** and click the **Category**.
2. To create a new depreciation schedule, click **New**.
3. Enter a **Name**.
4. Select a **Category**.
5. Add a **Script** to calculate depreciation value.

### Example depreciation schedule script

```
var gdt_dd = new GlideDateTime(asset.depreciation_date).getDate();
answer = (new AssetDepreciation()).calcSLCost(1, asset.cost, gdt_dd);
```
6. Click **Submit**.
   The depreciation schedule is now available in the **Depreciation** field on the asset record.

**Consumables life cycle**

Consumables are assets that are not tracked individually, but as a group of the same model.

The group of consumables has one or more of the following traits.

- Same location
- Same state
- Consumed by the same asset, typically as accessories or parts

Some common consumable assets include mouse devices, computer keyboards, and pencils. The base ServiceNow system includes the **Consumable** model category. The first step in working with models is to create a model within the model category for an individual consumable asset. Items such as keyboards and mouse devices are often tracked as consumables. Consumables cannot be pre-allocated.

Consumable assets are stored in the Consumable [alm_consumable] table. Consumables follow a slightly different life cycle from other assets.

**Stages of consumables**

The consumable lifecycle stages are as follows.

- On order
- In stock
- In transit
- Consumed
- In maintenance
- Retired
- Missing

**View consumable assets**

Consumables are tracked as a group of the same model, but you can view individual consumables in the consumable model record.
Before you begin
Role required: model_manager

Procedure
1. Navigate to **Product Catalog** > **Product Model** > **Consumable Models**.
2. Open a consumable model record.
3. View individual consumables in the **Consumables** related list.

Create consumable assets
Create a consumable to track an asset as a group of the same model.

Before you begin
Role required: asset

Procedure
1. Navigate to **Asset** > **Portfolios** > **Consumables** and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the asset.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model category that controls if an asset is linked to a CI.</td>
</tr>
<tr>
<td>Model</td>
<td>Product model of the asset.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Amount of items the asset represents.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>State of the asset.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset. When a parent asset is defined, the <strong>Assignment</strong> and <strong>State</strong> fields of the child asset are automatically populated based on the <strong>Assignment</strong> and <strong>State</strong> fields of the parent asset and are read-only.</td>
</tr>
<tr>
<td>Class</td>
<td>Type of asset. The system automatically sets the <strong>Class</strong> to <strong>Consumable</strong>.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure. Choose from the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Capex</strong>: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Opex</strong>: Operational expenditure is an on-going expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Substate</td>
<td>Substate of the asset.</td>
</tr>
<tr>
<td>Location</td>
<td>Location of the asset.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price that the asset was purchased for.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>Cost center financially responsible for the asset.</td>
</tr>
<tr>
<td>Disposal</td>
<td></td>
</tr>
<tr>
<td>Disposal order number</td>
<td>A unique number assigned to the asset disposal order.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal vendor</td>
<td>The vendor assigned to carry out the asset disposal order.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Vendor disposal order ID</td>
<td>Order number assigned by the vendor assigned to carry out the asset disposal order.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal date</td>
<td>The date when the asset disposal order process is completed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal reason</td>
<td>Text explaining why the asset is being retired.</td>
</tr>
<tr>
<td>Beneficiary</td>
<td>Organization that receives the asset when it is retired.</td>
</tr>
<tr>
<td>Resale price</td>
<td>Value of the asset when it is retired. For example, if the asset is donated, the value used when reporting taxes.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled retirement</td>
<td>Scheduled date on which the asset is retired.</td>
</tr>
<tr>
<td>Retired date</td>
<td>Actual date on which the asset was retired.</td>
</tr>
<tr>
<td>Activities</td>
<td></td>
</tr>
<tr>
<td>Work Notes</td>
<td>Work notes related to the asset.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.

### Consume consumable assets

To consume consumable assets, they must have a state of **In Stock** and a substate of **Available**.

**Before you begin**
Role required: asset

**Procedure**

1. Navigate to **Asset > Portfolios > Consumables**.

2. Click the **Display Name** of a consumable asset with a state of **In Stock** and a substate of **Available**.

3. Click **Consume**.

4. Enter the **Quantity** to consume.

5. In **Asset**, click the lookup icon and select the asset associated with the consumable.

   **Example**
   For example, a mouse tracked as a consumable asset can be associated with a non-consumable asset such as a computer.

6. In **User**, click the lookup icon and select a user associated with the consumable.

7. Click **OK**.

   On the **Consumable** form, the **Quantity** field shows the reduced number. The Consumables list contains two records for the consumable in the specific stockroom: one with a state and substate of **In Stock** and **Available** (if you did not consume the entire quantity), and one with a state of **Consumed**. If a consumable is not in the process of being transferred to a different
stockroom and information in the data record is the same, similar records merge automatically. After a consumable is consumed, the record remains in the system for reporting purposes.

Create pre-allocated assets
A pre-allocated asset physically exists, but is not yet a financial liability.

Before you begin
Role required: asset

About this task
Pre-allocated assets are often assets that the vendor still owns, but has agreed to store in a customer stockroom for just-in-time procurement. For example, a pre-allocated asset could be a pallet of 100 computers ready to be allocated. Allocating the asset generates a configuration item (if required by the category) and enables you to assign the asset. Pre-allocated assets can be components of another asset that is already in use. For example, pre-installed, pre-allocated servers can be set up in server racks next to production servers, but the pre-allocated servers only become a financial liability after they are turned on. The pre-allocated option can only be used for assets, not consumables or licenses. Pre-allocated assets cannot be comprised of bundles.

Note: Warranties are not usually active until an item is installed. Therefore, until an asset is allocated and assigned, it is not under warranty.

Procedure
1. Navigate to Asset > Portfolios > All Assets and create a new record (see table for field descriptions).

Note: Category must have the Allow pre-allocated option selected.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the asset.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model category that controls whether or not an asset is linked to a CI.</td>
</tr>
<tr>
<td>Model</td>
<td>Product model of the asset.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Number of item the asset represents.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>State of the asset.</td>
</tr>
<tr>
<td>Stockroom</td>
<td>Stockroom of the asset. This field is only available if the State field is set to <strong>in stock</strong>.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset. When a parent asset is defined, the <strong>Assignment</strong> and <strong>State</strong> fields of the child asset are automatically populated based on the <strong>Assignment</strong> and <strong>State</strong> fields of the parent asset and are read-only.</td>
</tr>
<tr>
<td>Class</td>
<td>Type of asset. The system automatically sets the <strong>Class</strong> to <strong>Consumable</strong>.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Capex</strong>: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Opex</strong>: Operational expenditure is an on-going expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Substate</td>
<td>Substate of the asset.</td>
</tr>
<tr>
<td>Location</td>
<td>Location of the asset.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price that the asset was purchased for.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>Cost center financially responsible for the asset.</td>
</tr>
<tr>
<td>Activities</td>
<td></td>
</tr>
<tr>
<td>Work Notes</td>
<td>Work notes related to the asset.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.

**Allocate a pre-allocated asset**

Assets can be allocated from pre-allocated asset records, which creates new asset records and reduces the **Quantity** in the original pre-allocated asset record.

**Before you begin**

Role required: asset
About this task
Allocating an asset makes it a financial liability. After all pre-allocated assets have been allocated, the pre-allocated asset record is removed from the asset list.

Procedure
1. Navigate to Asset > Portfolios > All Assets.
2. Find the row containing the asset to allocate. You may want to filter the Substate column to show only Pre-allocated assets.
3. Click the reference icon in the row containing the asset to allocate.
4. Click Allocate at the bottom of the form.

Note: If the glide.asset.create_ci_with_ire property is set to true, a form appears when you click Allocate. On the form, fill in the Asset tag, Serial number, and Reserved for fields, then click OK.

Results
The system creates and navigates to a new asset record, which has the same model and parent information as the pre-allocated asset. The new asset has a Quantity of one, while the pre-allocated asset’s Quantity is reduced by one.

Split a pre-allocated asset
You can split a pre-allocated asset to create a group that can be moved to a different stockroom.

Before you begin
Role required: asset

About this task
For example, a group of 100 pre-allocated computers is in Stockroom A. Split the group into two groups of 50 and move one group to Stockroom B. Allocate the computers from the two different stockrooms.

Procedure
1. Navigate to Asset > Portfolios > All Assets.
2. Find the row containing the asset to split. You may want to filter the Substate column to show only Pre-allocated assets.
3. Click the reference icon in the row containing the asset to split. The asset record is displayed.
4. Click **Split**.

5. Enter a **Quantity to Split** and click **OK**.
   The pre-allocated asset is split into two groups and the **Quantity** field on each record indicates the number in each group.

**Stockrooms**

Stockrooms are places to which assets are assigned.

When stock is low on a particular asset, stock rules can either notify an asset manager or automatically transfer inventory from one stockroom to another.

Stockrooms are separate, standalone entities in the Asset Management application.

**Create a stockroom**

You can create a stockroom.

**About this task**

Role required: asset or inventory_user

**Procedure**

1. Navigate to **Inventory > Stock > Stockrooms** and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name and identifier of the stockroom.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group that primarily uses the stockroom.</td>
</tr>
<tr>
<td>External</td>
<td>Whether this stockroom is managed internally (check box is cleared) or is managed externally by a third party (check box is selected).</td>
</tr>
<tr>
<td>Location</td>
<td>Physical location of the stockroom.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of stockroom, such as Field Agent or On site.</td>
</tr>
<tr>
<td>Manager</td>
<td>Person in charge of the stockroom. Receives restocking notifications and requests for the stockroom’s stock rules.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.
Delete a stockroom with assets
You can delete a stockroom. If the stock room has assets, you must remove the assets from the stockroom first.

Before you begin
Role required: inventory_admin

Procedure
1. Navigate to Asset > All Assets.
2. Personalize the list to add the Stockroom column.
3. Filter the list to show only the assets in the stockroom that you want to delete.
4. Change or remove the stockroom for all of the asset records.
5. After removing assets from the stockroom you want to delete, continue with the instructions for deleting a stockroom with no assets.

Delete a stockroom with no assets
You can delete a stockroom that has no assets.

Before you begin
Role required: inventory_admin

Procedure
1. Navigate to Inventory > Stock > Stockrooms.
2. Select the check box beside the stockroom Name.
3. In the Actions choice list below the list, select Delete.

Stockroom types
Stockroom types are categories of stockrooms.

The stockroom type has two significant characteristics.

• Priority: indicates the order of stockrooms the parts should be sourced from.
  For example, if a personal stockroom (priority 2) contains the required part, the personal stockroom receives priority over the Central Stockroom (priority 7) because the part in the personal stockroom does not require delivery.
• **Shipment Required**: informs the system if a transfer order needs to be created when the part is sourced from a stockroom of the given type. For example, a part in a personal stockroom does not require shipment, so no transfer order is needed.

### Stockroom types defined in the base system

<table>
<thead>
<tr>
<th>Value</th>
<th>Name</th>
<th>Priority</th>
<th>Shipment Required</th>
<th>Description</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>on_site</td>
<td>On Site</td>
<td>1</td>
<td>False</td>
<td>Stockroom at the customer site.</td>
<td>Close to the users and does not require shipping.</td>
</tr>
<tr>
<td>field_agent</td>
<td>Field Agent</td>
<td>2</td>
<td>False</td>
<td>Virtual, personal stockroom linked with a field service agent (FSA) directly, used for delivery.</td>
<td>Mainly used to indicate to the system that the part has been delivered and is with the FSA.</td>
</tr>
<tr>
<td>fs1</td>
<td>FSL</td>
<td>4</td>
<td>True</td>
<td>Forward Shipping Location.</td>
<td>Small stockrooms where the parts can typically be shipped via overnight delivery.</td>
</tr>
<tr>
<td>pudo</td>
<td>PUDO</td>
<td>5</td>
<td>True</td>
<td>Pick Up/ Drop out location.</td>
<td>This type is sometimes called a by-box. Can be a postal box that can receive new and returned parts. Often in close proximity to major customer sites.</td>
</tr>
<tr>
<td>stockroom</td>
<td>Stockroom</td>
<td>6</td>
<td>True</td>
<td></td>
<td>A regional stockroom.</td>
</tr>
</tbody>
</table>
Stockroom types defined in the base system (continued)

<table>
<thead>
<tr>
<th>Value</th>
<th>Name</th>
<th>Priority</th>
<th>Shipment Required</th>
<th>Description</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>central_stockroom</td>
<td>Central Stockroom</td>
<td>7</td>
<td>True</td>
<td>A central stockroom, usually a big facility from which most parts are shipped.</td>
<td></td>
</tr>
</tbody>
</table>

Create a new stockroom type

If you need stockroom types that are not included in the base system, you can create a custom stockroom type.

Before you begin
Role required: inventory_admin

About this task
Check the priority level of the stockroom types provided in the base instance to ensure that you assign the correct priority level to any new stockroom types you create. You can also modify the stockroom types included in the base system.

Procedure

1. Navigate to Inventory > Stock > Stockroom Types and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name of the stockroom type.</td>
</tr>
<tr>
<td>Description</td>
<td>General information about the stockroom type.</td>
</tr>
<tr>
<td>External stockroom</td>
<td>Whether stockrooms of this type are managed internally (check box cleared) or managed externally by a third party (check box selected).</td>
</tr>
<tr>
<td>Priority</td>
<td>Level of precedence for this type of stockroom.</td>
</tr>
<tr>
<td>Shipment required</td>
<td>Option that determines if stockrooms of this type require shipment by default.</td>
</tr>
<tr>
<td>Value</td>
<td>Internal identifier of the stockroom type.</td>
</tr>
</tbody>
</table>

2. Click Submit.
Stock rules

Stock rules are defined criteria stating that when inventory of a particular asset in a particular stockroom reaches a specified threshold, a certain number should either be transferred from another stockroom or ordered from a vendor.

For example, a specific model of computer keyboard reaches an inventory of 10 in a particular stockroom and, because a stock rule is in place, a transfer order is automatically created to transfer 50 from a different stockroom. Because there can be multiple assets of a model within a stockroom, stock rules enable you to check all assets fitting the criteria and view a total count.

There are two restocking options:

• An email can be sent to the stockroom manager (user identified in the Manager field on the stockroom record) to place a vendor order. A task is automatically created for the stockroom manager or, if Procurement is active, a purchase order and a purchase order line item are created.

• A transfer order can be generated automatically to restock the item from another stockroom.

Stock rules consider existing transfer orders and do not create additional transfer orders if replenishment is already in progress.

A scheduled job named Stock Rule Runner runs once per day to create the restocking transfer orders, send email messages to stockroom managers, and create tasks for stockroom managers.

ℹ️ Note: If restocking is in progress, the system does not create duplicate email messages or duplicate transfer orders.

If Procurement is active when the scheduled job is run, a purchase order and a purchase order line item are automatically created.

ℹ️ Note: You must have procurement_user role to access the purchase order and purchase order line item.

Create a stock rule

You can create a stock rule to control what happens when inventory of a particular asset in a particular stockroom reaches a specified threshold.

About this task

Role required: inventory_admin
Procedure

1. Navigate to Inventory > Stock > Stock Rules and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model</td>
<td>Product model to which the rule applies.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Quantity that the stock must reach to trigger restocking. For example, enter a threshold of 10 for a laptop computer that should be restocked when inventory drops below 10 in the specified stockroom.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If a stock rule is created for a hardware or software model reaches the threshold limit, a notification is sent to the stockroom manager and a stock order request is automatically created.</td>
</tr>
<tr>
<td>Restocking option</td>
<td>Location where additional supplies should come from.</td>
</tr>
<tr>
<td></td>
<td>If Procurement is not active, then restocking option is Stockroom only. Otherwise, select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Stockroom:</strong> creates a transfer order to obtain the asset from another stockroom.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Vendor:</strong> sends an email to the stockroom manager to order from a vendor. In addition to the email notification, a purchase order and purchase order line item are created.</td>
</tr>
<tr>
<td>Active</td>
<td>Whether this stock rule active (check box is selected). Clearing this check box prevents the stock rule from restocking automatically.</td>
</tr>
<tr>
<td>Stockroom</td>
<td>Current physical location of the asset.</td>
</tr>
<tr>
<td>Order size</td>
<td>Minimum order quantity for stockroom transfers or vendor purchases. ServiceNow calculates the smallest multiple of the order size needed to restock the item above the threshold. For example, there are 3 laptops in stock with a threshold of 10 and the Stockroom option selected. If the order size is set to 4, the system creates a transfer order for 8 laptops to exceed the threshold and satisfy the rule (3 in stock + 8 ordered = 11). When restocking from a vendor, ServiceNow sends an email to the...</td>
</tr>
</tbody>
</table>
2. Click **Submit**.

**Transfer orders for Asset Management**

Transfer orders move assets between company stockrooms. The Asset Management application enables asset managers to create transfer orders for moving assets between company stockrooms. Consumable assets and non-consumable assets can be transferred as follows:

- If an asset is consumable, it can be transferred and the quantity can be greater than one. Consumable parts are tracked by the system qualitatively.
- If an asset is non-consumable, it must be transferred as a single entity with a quantity of one. Non-consumable parts correspond to assets defined in the system.

**Transfer order lines**

Transfer Order Lines is a new module under Inventory with Template Tasks and Template Subtasks as the sub modules. Transfer order lines allow the transfer of multiple assets on one transfer order. Actions such as shipment preparation can take place at the transfer order line level. Pre-allocated assets can be included in a transfer order line, but can only be transferred in their full quantity. A business rule prevents the same asset from being transferred on two different transfer orders at the same time.

ℹ️ **Note:** The Transfer Order and the Transfer Order Line workflows have moved from the Procurement plugin to the Asset Management plugin. The Transfer Order Line workflow runs only if no other workflows are matched or running on a specific record.

**Transfer order line tasks**

When you create a transfer order line, based on the model category specified in the asset, a transfer order line task is automatically created. Transfer order line tasks are created to move transfer order lines from one stage to the other. Transfer order line tasks also help you to track service levels and the time frame needed to complete a transfer order.

Default template tasks are available with the Asset Management application. The template tasks are based on model categories. Default template tasks cannot be deleted or modified. If required, you can also create your own...
customized template tasks. For more information, see Create a customized template task. When you create a transfer order line and select an asset, that asset corresponds to a model category. If a customized template task exists for that model category then that template task is added to the transfer order line as a transfer order line task. If no customized template task match is found for the asset you selected, then the default template task is added as a transfer order line task.

Closing a transfer order line task completes the task and creates the next task in the process. For example, once you close the Ready for fulfillment task, the state for this task appears as Closed Complete and a new task is opened for the next stage, Ready for Shipment. This process continues till you close all the tasks required for completing the transfer order line. As you close a task and as a task moves from one stage to the next, the asset gets automatically updated too. For example, when the transfer order line moves from Ready to Fulfillment to Prepare for Shipment, the asset's status also moves from available to reserved.

### Note:
If you skip a transfer order line task and select Closed Skipped, the asset is not updated automatically. Once the asset is received or delivered, you can make the update manually.

### Note:
If you are upgrading from any previous release to the New York release, and you have an open transfer order line that is still being processed, all the transfer order line tasks associated with that transfer order line are simultaneously created and displayed in the transfer order line form layout. Based on the stage of the transfer order line, the tasks that still need to be processed will be open; all the other tasks that have already been completed will be closed. Based on the order, if you close a later transfer order line task, all the previous tasks, which are currently open, automatically will be Closed Skipped.

### Transfer order line subtasks
To further add granularity and efficiency to the process, you can also create subtasks for each transfer order line task. Each transfer order line task can have multiple subtasks. For example, before preparing for shipment, for a computer, you may want to create subtasks for imaging the computer or adding additional software. If subtasks have been defined for a particular transfer order line task, then the subtasks are automatically added to the transfer order line task. Once all the subtasks are closed, the transfer order line task is automatically closed. For more information, see Create a template subtask.
Transfer assets using transfer orders

Transfer assets from one location to the other by moving the assets through the transfer order process. You create a transfer order and move it from its initial Draft status to the final Received status.

Before you begin
Role required: inventory_user.

Procedure

1. Navigate to Inventory > Transfer Orders > Create Transfer Order.
2. Select values from the From Stockroom and To Stockroom lists.
   
   Note: If you select the same stockroom for both fields, the transfer order automatically moves from Draft to Received as soon as a transfer order line is added.
3. Select a date and time from the Delivery by date date picker.
4. Click Submit.
5. Open the transfer order.
6. Next to Transfer Order Lines, click New.
7. Select a model for the transfer order line.
8. If the model is a consumable, specify a quantity in Quantity Requested.
9. Click Submit. If necessary, add more transfer order lines.
   After creating transfer order lines, the transfer order and all of the transfer order lines are in the draft stage. While a transfer order or a transfer order line is in the draft stage, it can be deleted.
   
   Note: When an asset is part of a transfer order set to Draft, the asset record updates to show the asset as reserved. No one else can request or transfer the asset while it is reserved.

When you create a transfer order line, based on the model category specified in the asset, a transfer order line task is automatically created. The transfer order line task helps you to progress through the various stages of the transfer order line. Each transfer order line task represents a particular stage in the transfer process. As you close a task, a new task is created and the transfer process moves to the next stage.

10. Open the transfer order line task and click Close Task.

   The transfer order line task is completed and a new transfer order line task is opened.
11. Keep closing each task till you reach the last stage (Received). Once you close the task for the Received stage, the transfer order line is completed and closed. All transfer order lines and the transfer order are marked **Delivered**.

**Summary of transfer order line tasks**

As assets move through the transfer process, the stage of a transfer order is always based on the individual transfer order lines tasks.

<table>
<thead>
<tr>
<th>Transfer order line tasks</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>When a transfer order line is created.</td>
</tr>
<tr>
<td>Requested</td>
<td>This is the first task created for the transfer order line.</td>
</tr>
<tr>
<td>Shipment Preparation</td>
<td>Once the <strong>Requested</strong> task is closed, this task is created. This tasks deals with preparing the transfer order line for shipment. Three new fields are added to the Shipment Preparation task: <strong>Vendor</strong>, <strong>Ship date</strong>, and <strong>Tracking Number</strong>.</td>
</tr>
<tr>
<td>In Transit</td>
<td>Once the <strong>Shipment Preparation</strong> task is closed, this task is created.</td>
</tr>
<tr>
<td>Received</td>
<td>Once the <strong>In Transit</strong> task is closed, this task is created.</td>
</tr>
<tr>
<td>Delivered</td>
<td>Once the <strong>Received</strong> task is closed, this task is created. Once you close the <strong>Delivered</strong> task, the transfer order line is completed.</td>
</tr>
</tbody>
</table>

**Delete a transfer order**

You can delete a transfer order only if the transfer order is still in the draft stage.

**Before you begin**

Role required: inventory_user

**Procedure**

1. Navigate to **Inventory Management > Transfer Orders > Transfer Orders**
2. Select the check box beside a transfer order.
3. From the Actions on selected rows menu at the bottom of the list, click **Delete**.
   
   Alternatively, you can cancel a transfer order or a transfer order line while it is in **Requested** or **Shipment Preparation** stage.

**Related information**

- Delete a transfer order line
- Return items received in a transfer order

**Delete a transfer order line**

You can delete a transfer order line only if it's still in the draft stage.

**Before you begin**

Role required: inventory_user.

**Procedure**

1. Open a transfer order.
2. Select the check box beside a transfer order line.
3. From the Actions on selected rows menu at the bottom of the list, click **Delete**.
   
   Alternatively, you can cancel a transfer order or a transfer order line while it is in **Requested** or **Shipment Preparation** stage.

**Related information**

- Delete a transfer order
- Return items received in a transfer order

**Return items received in a transfer order**

When you receive a transfer order and if there is a problem with all or some of the items, you can return the transfer order.

**Before you begin**

Role required: inventory_user.

**About this task**

Items in a transfer order must be received before they can be returned.
Procedure

1. Navigate to **Inventory Management > Transfer Orders**.
2. Select a transfer order that is in the **Received** stage.
3. Click the transfer order line **Number** of the item to return.
4. Click **Return**.
5. Enter a quantity to return.
6. Enter a reason for the return.
7. Select the **Defective** check box to return items that are broken.
   
   Defective items are returned to the stockroom from which they were delivered, but are not added to available stock. Instead, they are tracked in the separate category named "Defective" so they cannot be requested or transferred again.
8. Click **OK**.
9. Click **Update**.
   
   A new transfer order line is automatically created.

   A new corresponding parent transfer order is also automatically created with the new transfer order line on it.
10. If you are returning a consumable, navigate to the transfer order line record and click the model name to open the model record.
    
    The model record shows which stockrooms contain the model. The one defective model is listed.

    **Note:** The defective model is still at the stockroom to which it was delivered. The defective model needs to be transferred back to the stockroom where it originated.
11. Move the new transfer order through the regular transfer order process.
    
    Items are automatically returned to the stockroom from which they were delivered. A transfer order line item that has been returned cannot be delivered at a later time.

    If you return another defective model from the same, original order, the two defective returns are merged into one line item.

Create a transfer order for **Asset Management**

Create a transfer order in order to transfer assets from one location to the other.
Before you begin
Role required: inventory_user.

Procedure
1. Navigate to Inventory Management > Transfer Orders > Create Transfer Order.
2. Click the From stockroom list to select a stockroom from which the item(s) is to be shipped.
3. Click the To stockroom list to select a stockroom where the item(s) is to be shipped.
4. Click Submit.
   Once the transfer order is created, you can create transfer order lines to specify the items that the transfer order comprises of. See Create a transfer order line.

Create a transfer order line
Transfer order lines specify the exact items that comprise a transfer order.

Before you begin
Role required: inventory_user.

About this task
A transfer order can contain one or more transfer order lines. Under a single transfer order, all transfer order lines will have the same From location and To location. Each line contains an asset to transfer and the quantity to transfer. The item to transfer is identified by asset name and model name. A transfer order line can involve one quantity of a non-consumable asset or multiple quantities of a consumable asset. A bundled model can be transferred.

Procedure
After creating a transfer order, click New in the Transfer Order Lines related list and fill in the fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Internal unique number identifying the transfer order line.</td>
</tr>
<tr>
<td>Transfer Order</td>
<td>The transfer order to which the transfer order line belongs.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Model</td>
<td>Model of the items requested by the transfer order line. For example, a printer. If the Asset field is filled out first, the Model field is automatically filled in with the model corresponding to the asset.</td>
</tr>
<tr>
<td>Quantity requested</td>
<td>Number of items requested by the transfer order line. For example, 3 computers are requested to be transferred.</td>
</tr>
<tr>
<td>Quantity received</td>
<td>Number of items already received. For example, 3 keyboards are transferred, 2 are received.</td>
</tr>
<tr>
<td>Stage</td>
<td>Current stage of the transfer order. Transfer order lines can only be created when a transfer order is in Draft stage.</td>
</tr>
<tr>
<td>Request line</td>
<td>Requested item to associate with the transfer order line.</td>
</tr>
<tr>
<td>Asset</td>
<td>Asset requested by the transfer order line. For example, a specific printer. The asset can filter on stockrooms.</td>
</tr>
<tr>
<td>Quantity remaining</td>
<td>Number of items yet to be received. For example, 3 keyboards had been requested, 2 are received, 1 is remaining.</td>
</tr>
<tr>
<td>Quantity returned</td>
<td>Number of items that already needed to be returned.</td>
</tr>
</tbody>
</table>

Create a customized template task

Create customized template tasks to configure your specific task workflow for transfer order lines. Default template tasks are available with the Asset Management application. You cannot modify or delete a default template task.

Before you begin
Role required: inventory_user.

About this task
Template tasks help you progress through the various stages of the transfer order line. Custom template tasks are stored in the Custom Template Task [alm_custom_template_task] table. The template tasks are based on model categories. For example, when you create a customized template task for the Application model category, whenever a transfer order line is created for the Application model category, the template tasks associated with the Application model category are used as transfer order line tasks. When you create customized template tasks, make a copy of the workflow and update the workflow accordingly. For example, if instead of five flows, you need four flows, then delete the flow that you do not need from the workflow.
**Note:** Two template tasks cannot be created if they are based on the same model category, same order number and the same stage. The model category, the order, and the stage have to be unique for each template task. For example, you cannot create two template tasks for Prepare for Shipment, based on the Application model category, order number 200, and the stage as Requested. If you try to create an identical template task as mentioned in the example, an error message appears.

**Procedure**

1. Navigate to **Inventory > Transfer Order Lines > Template Tasks**.
   All the default template tasks that are available with the Asset Management application are listed.

2. Click **New**.
   You can also customize a template task by copying a default template task. Click **Copy Default Template** and select a model category.

3. Fill out the form fields (as shown in the table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task name</td>
<td>Name of the template task</td>
</tr>
<tr>
<td>Model category</td>
<td>The model category that this template task is based on.</td>
</tr>
<tr>
<td>Order</td>
<td>the order in which the template task is added to the transfer order line.</td>
</tr>
<tr>
<td>Short description</td>
<td>a brief description about this template task.</td>
</tr>
<tr>
<td>Next stage</td>
<td>the stage that this template task gets executed.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Create a template subtask**

Create template subtasks to add granularity to the transfer order line tasks. For example, before preparing for shipment, for a computer, you may want to create sub tasks for imaging the computer or adding additional software.

**Before you begin**
Role required: inventory_user.
About this task

The template subtasks that you create are stored in the Template Subtask [alm_template_subtask] table. When a transfer order line task is created and if subtasks are defined for that transfer order line task, then the subtasks are automatically added to the transfer order line task.

Procedure

1. Navigate to **Inventory > Transfer Order Lines > Template Subtasks**.
2. Click **New** and fill out the form fields (as shown in the table).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>A brief description of the subtask.</td>
</tr>
<tr>
<td>Subtask name</td>
<td>A name for the subtask.</td>
</tr>
<tr>
<td>Task</td>
<td>The task that this subtask is associated to.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

Perform bulk updates for transfer order lines

Update tasks for multiple transfer order lines at one go to streamline the transfer order process.

Before you begin

Transfer order lines allow the transfer of multiple assets on a transfer order. When you create a transfer order line, a transfer order line task is automatically created. Transfer order line tasks are created to move transfer order lines from one stage to the other. Each transfer order line can have multiple tasks such as **Requested**, **Shipment Preparation**, **In Transit**. For information on the stages of a transfer order line task, see **Summary of transfer order line tasks**.

Role required: inventory_user

Procedure

1. Navigate to **Inventory > Transfer Order**.
2. Click **Bulk Update** next to the Transfer Order Lines related list. The Bulk Update - Transfer Order Line dialog box appears.
3. In the **Select a stage** field, select the stage that you want to move this task to. All transfer order lines, along with the asset display names, that are in the selected stage appear in the **Available** box.
4. In the **Assigned to** field, select the person you want to assign this task to. The **Assigned to** field defaults to the logged in user.

5. Select the transfer order lines in the **Available** box and move them to the **Selected** box.
   When you click on the transfer order lines, you can view the model and asset display names for hardware and consumable assets. For consumable assets, you can view additional details such as quantity requested and quantity received.

6. Click **Update**.
   All the selected transfer order line tasks and associated sub tasks for the selected stage are closed and the next task in the process is created. For example, all the transfer order line tasks in the **Requested** stage are closed and the next task in the process, **Shipment Preparation**, is created.

7. Return to the Bulk Update - Transfer Order Line dialog box to continue this process until you close all the tasks required for completing the transfer order line.

**Transfer order line asset tracking**

As transfer order line actions are triggered, the stock information and states of any affected assets are updated. Consumables and non-consumables are tracked differently.

When an asset is included in a transfer order line, the following takes place:

- A substate field on the asset form changes to reflect the transfer order line states

- The Active TO option on the asset form is automatically selected to show that the asset is part of a transfer order and cannot be added to multiple transfer orders

- The asset is removed from the pool of available assets and changed to a state of **In Stock Pending Transfer**

**Related information**

- Delete a transfer order
- Delete a transfer order line
- Return items received in a transfer order
Transfer order line asset tracking of non-consumables

When transfer order line stages change for non-consumables, it affects asset substates.

<table>
<thead>
<tr>
<th>Transfer order line stage</th>
<th>Affect on asset substate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>Asset moves to <strong>In Stock &gt; Pending Transfer</strong> (from the current stockroom). If the asset is a consumable, the quantity can be edited.</td>
</tr>
<tr>
<td>Requested</td>
<td>Asset stays in <strong>In Stock &gt; Pending Transfer</strong>.</td>
</tr>
<tr>
<td>Shipment Preparation</td>
<td>Asset stays in <strong>In Stock &gt; Pending transfer</strong>.</td>
</tr>
<tr>
<td>In Transit</td>
<td>Asset moves to <strong>In Transit &gt; Reserved</strong>.</td>
</tr>
<tr>
<td>Received</td>
<td>Asset moves to <strong>In Stock &gt; Available</strong> (in the destination stockroom).</td>
</tr>
</tbody>
</table>

Related information

- Delete a transfer order
- Delete a transfer order line
- Return items received in a transfer order

Transfer order line asset tracking consumables

When a consumable is added to a transfer order line, the stock for the consumable is split into two records and the transfer order links to the newly created stock line.

For example:

1. Stockroom A has ten keyboards in stock.
2. A transfer order line named TOL1 transfers three keyboards from stockroom A to stockroom B.
3. The stock of ten keyboards in A is split into two records: seven shown as **In stock > Available** and three shown as **In Stock > Pending Transfer**.
4. Another transfer order is created with a transfer order line named TOL2 that transfers two keyboards from stockroom A to stockroom B.
5. The seven remaining keyboards are split into another two lines: five **In stock > Available** and two **In stock > Pending Transfer**.

† **Note:** The three **In Stock > Pending Transfer** and the two **In Stock > Pending Transfer** are not merged together because they are not part of the same transfer order line and not necessarily from the same person.

6. As TOL2 for two keyboards moves from **Draft** to **Requested** to **Shipment Preparation**, TOL1 for the three keyboards remains **In Stock > Pending Transfer**.

7. When TOL1 for the three keyboards moves to the **In Transit** stage, the three keyboards are changed to the **In Transit > Reserved** stage. The same happens for TOL2 with two keyboards.

8. When TOL1 is **Received**, the three keyboards move to **In stock > Available** in stockroom B.

9. When TOL2 is received in stockroom B, the two keyboards move to **In stock > Available** and are merged with the three keyboards that are also **In Stock > Available** in B.

10. At the end, stockroom B shows five keyboards are **In Stock > Available**.

**Related information**
- Delete a transfer order
- Delete a transfer order line
- Return items received in a transfer order

**Example Asset Management process**

The best method for managing assets depends on business needs and how your business is organized.

**About this task**

These steps are one possible process for getting started with Asset Management.

**Procedure**

1. Identify assets in your system. A key component of asset management is the initial and ongoing inventory or discovery of what you own. The ServiceNow platform provides the following options for asset discovery.
   - The separate, robust Discovery tool.
   - For organizations that want to use the discovery technologies they have deployed already, such as SMS, Tally NetCensus, LanDesk, or others,
ServiceNow can support integration to those technologies via web services. Scanned data can be mapped directly into the Configuration Management Database (CMDB).

2. Clean up information in the CMDB. Remove information that is obsolete or invalid. Ensure that all remaining information is accurate and complete. Add any necessary information.

3. Create categories of asset models such as computers, servers, printers, and software.

4. Create asset models. Models are specific versions or various configurations of an asset, such as a MacBook Pro 17”.

5. Create individual assets, such as hardware, consumables, and software licenses. If you used a discovery tool, you may already have many assets identified accurately.

6. Manage assets by counting software licenses, viewing assets that are in stock, setting asset states and substates, and analyzing unallocated software.

**CSDM framework for HAM**

Common Service Data Model (CSDM) is a standard and consistent set of terms and definitions to adopt across all ServiceNow products on the Now Platform.

Using CSDM standard and consistent set of terms and definitions helps to effectively track assets through their life cycle transitions. Starting from the Rome release, CSDM will be implemented in phase wise in HAM. To know more about CSDM, see Common Service Data Model.

To set up CSDM environment for HAM, see Set up the CSDM environment.

ℹ️ **Note:** It is optional to adopt CSDM. You can either adopt CSDM or continue using the existing model.

**ITSM Software Asset Management**

The software asset management features of the ITSM suite can be activated using one of the plugins in the feature table.

ℹ️ **Note:** These features support IT service management processes related to software assets.

For the Software Asset Management product (requires a separate subscription), see Software Asset Management.
Note: The Software Asset Management product is a standalone application supporting advanced use cases for software asset management.

### ITSM Software Asset Management feature plugins

<table>
<thead>
<tr>
<th>Release</th>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
| • Activation: Kingston  
• Introduced: Kingston | Software Asset Management Foundation plugin | Manage your software assets using manual normalization and reconciliation to determine software compliance. |
| • Activation: Jakarta and earlier  
• Introduced: Berlin | Software Asset Management plugin | Manage your software licenses. |

Note: Customers who have the Software Asset Management plugin enabled on a release prior to Kingston can continue to use the Software Asset Management plugin.

### Software Asset Management plugin

The Software Asset Management plugin activates the ITSM Software Asset Management feature provided with the Asset Management application.

A strong software asset management (SAM) program can help an organization reduce software costs, improve compliance, and simplify or develop processes for employee software requests. SAM programs can also help control inventory through accurate databases, which in turn helps identify organizational software needs, identify unused software that can be deleted, as well as reduce or consolidate the number of software vendors used.
**Software Asset Management plugin Overview module**

The Software Asset Management plugin Overview module is a homepage that displays various software asset management reports.

**Use the Software Asset Management plugin Overview module**

The Overview module is a homepage that displays charts and graphs to help you manage software assets in the organization.

To use the Software Asset Management plugin Overview module, navigate to **Software Asset Management > Overview**. Click an element within a report to see more information or add and move widgets as needed.

The overview shows the following compliance types:

- **Immediate Compliance**: number of licenses that should be purchased in order to be compliant immediately. Compliance is based on grouping. When tracking software licenses at a high level without any grouping, you are more likely to be compliant. With grouping, you are more likely to be out of...
compliance. For example, if grouping regionally by location, your organization can be globally compliant, but regionally non-compliant.

- Planned Compliance: based on the number of licenses you plan to allocate and the number installed.

The graphs show important statistics about the software being tracked, including software that has been entitled but is not being used and the total number of unallocated licenses.

**Software Asset Management plugin roles**

Software Asset Management plugin adds the following user role.

### Roles

<table>
<thead>
<tr>
<th>Role Title</th>
<th>Contains Role Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam</td>
<td>inventory_user, category_manager, contract_manager, financial_mgmt_user</td>
<td>Can create, edit, change, and manage software licenses.</td>
</tr>
</tbody>
</table>

Users with the sam or admin role can view the overview page and refresh, add, delete, and rearrange reports and other widgets.

**Installed with Software Asset Management plugin**

A number of tables, properties, user roles, script includes, client scripts, UI policies, and business rules are installed with Software Asset Management plugin.

Activating Software Asset Management plugin adds these components.

Demo data is available with Software Asset Management plugin.

**Tables**

Software Asset Management plugin adds the following tables.

### Software Asset Management plugin tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Definition [cmdb_processor_definition]</td>
<td>Describes a computer in terms of the attributes IBM uses for its PVU licensing</td>
</tr>
</tbody>
</table>
## Software Asset Management plugin tables (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Mapping [sam_processor_mapping]</td>
<td>Encodes the information specified by the IBM <a href="https://www.ibm.com">Table of Processor Value Units per core</a> and is used in matching a computer's processor definition to a PVU cost for that computer. Each row in this table is a mapping between a set of processors and the associated PVU cost (per core).</td>
</tr>
<tr>
<td>Software Counter [sam_sw_counter]</td>
<td>Configures license counting options for software models.</td>
</tr>
</tbody>
</table>
| Software Counter Compliance Violations [sam_sw_counter_violation] | Stores records of software counter compliance issues that are due to violations other than installs exceeding rights, such as:  
• Maximum CPU/user count exceeded, based on model limits.  
• Maximum or minimum rights rules not followed, based on model limits.  
• Options installed on a server with a license that does not support options (Oracle). |
| Software Counter Detail [sam_sw_counter_detail] | Reconciles a software installation or usage with its corresponding software license and entitlement. The software counting logic automatically generates and maintains these records. |
| Software Counter History [sam_sw_counter_history] | Stores read-only copies of software counter records, which the system generates automatically each time a software counter finishes counting licenses. |
| Software Counter Result [sam_sw_counter_result] | Records all software counter results. Organizes the results based on the Grouping field (such as Company, |

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Software Asset Management plugin tables (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Counter Summary [sam_sw_counter_summary]</td>
<td>Department, or Location) on the Software Counter record.</td>
</tr>
<tr>
<td>Software Discovery Model [cmdb_sam_sw_discovery_model]</td>
<td>Aggregates all the software counter details for a given allocation state, a given group, and a given software counter. The software counting logic automatically generates and maintains these records.</td>
</tr>
<tr>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Stores a unique and definitive list of all software found by a discovery tool.</td>
</tr>
<tr>
<td>Software Usage [cmdb_sam_sw_usage]</td>
<td>Associates software discovery models and the hardware on which they are installed.</td>
</tr>
</tbody>
</table>

Properties

Software Asset Management plugin adds the following system properties.

Software Asset Management plugin properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam.install_deletion_deadline</td>
<td>Defines the number of days after which a software install is deleted if not discovered with the configuration item. Use a value that is greater than the number of days between consecutive discovery runs.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 7</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties [sys_properties] table</td>
</tr>
</tbody>
</table>
User roles
Software Asset Management plugin adds the following user roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam</td>
<td>inventory_user</td>
<td>Can create, edit, change, and manage software licenses. Can edit the Software model field on a Discovery model. Can approve a model. Has full control of the <strong>Software Asset Management plugin</strong> feature. Controls the Software Asset Management plugin IBM PVU Process Pack, if activated.</td>
</tr>
<tr>
<td></td>
<td>contract_manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>category_manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>financial_mgmt_user</td>
<td></td>
</tr>
</tbody>
</table>

Script includes
Software Asset Management plugin adds the following script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DiscoveryModelMatcher</td>
<td>Matches a discovery model with a software product model.</td>
</tr>
<tr>
<td>ProcessorDefinitionsUtils</td>
<td>Contains utilities for managing the Processor Definition [cmdb_processor_definition] table.</td>
</tr>
<tr>
<td>ProcessorValueUnitsUtils</td>
<td>Contains logic that determines the IBM PVU pricing associated with a given processor. Also generates an event when a processor mapping is not found.</td>
</tr>
<tr>
<td>SAMMigration</td>
<td>Deprecated. Used by the fix job that migrates software license management data to Software Asset Management plugin.</td>
</tr>
<tr>
<td>SAMSuiteEngine</td>
<td>Contains functions for handling suite inference on software installations.</td>
</tr>
<tr>
<td>SAMUtil</td>
<td>Generates models and counters for Software Asset Management plugin.</td>
</tr>
</tbody>
</table>

Client scripts
Software Asset Management plugin adds the following client scripts.
Software Asset Management plugin client scripts

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean up Counter</td>
<td>Software Counter [sam_sw_counter]</td>
<td>Ensures integrity between the various counting options of a software counter.</td>
</tr>
<tr>
<td>Deactivate automatched checkbox</td>
<td>Software Discovery Model [cmdb_sam_sw_discovery_model]</td>
<td>Deactivates the automatically matched check box when a user edits the software model.</td>
</tr>
<tr>
<td>Notify if counter in progress</td>
<td>Software Counter [sam_sw_counter]</td>
<td>Displays a message if the counter is currently running.</td>
</tr>
</tbody>
</table>

UI policies

Software Asset Management plugin adds the following UI policies.

Software Asset Management plugin UI policies

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enforce Installs per license</td>
<td>Software Counter [sam_sw_counter]</td>
<td>Makes the Installs per license field mandatory when the software counter License type is By number of users.</td>
</tr>
<tr>
<td>Handle custom counts</td>
<td>License Calculation [sam_sw_license_calculation]</td>
<td>Displays the fields for entitlement type and valuation script when Count by is set to custom.</td>
</tr>
<tr>
<td>Hide condition fields</td>
<td>Software Counter [sam_sw_counter]</td>
<td>Hides the Software usage condition field if the license calculation query table is set to Software install and hides the Software install condition field if the license calculation query table is set to Software usage.</td>
</tr>
<tr>
<td>Hide query table</td>
<td>Software Counter [sam_sw_counter]</td>
<td>Hides the Query table field on the Software Counter form.</td>
</tr>
</tbody>
</table>
Business rules

Software Asset Management plugin adds the following business rules.

### Software Asset Management plugin business rules

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>assign processor</td>
<td>Computer [cmdb_ci_computer]</td>
<td>Attempts to match a processor with a processor definition.</td>
</tr>
<tr>
<td>Build Primary Key</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Sets the primary key for the record to the serial number on the [cmdb_sam_sw_install] table. If the serial number is empty, the rule creates one based on the publisher, display name, product ID, version, and revision.</td>
</tr>
<tr>
<td>Build Primary Key</td>
<td>Software Usage [cmdb_sam_sw_usage]</td>
<td>Creates the primary key for the record from the publisher, name, product ID, and version number on the [cmdb_sam_sw_usage] table.</td>
</tr>
<tr>
<td>Check for software suite</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Checks if the current software install is part of a software suite.</td>
</tr>
<tr>
<td>Check for suite omission</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Checks if the current software install should be omitted from any suites.</td>
</tr>
<tr>
<td>Clean up Cache</td>
<td>Software License [alm_license]</td>
<td>Removes the cache for the counter of the software license record when a software license is deleted.</td>
</tr>
<tr>
<td>Clean up software normalization</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Deletes the discovery model if the discovery model is changed and it is not used by other</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Clear install and usage records</td>
<td>Software Counter Summary [sam_sw_counter_summary]</td>
<td>Uncaches all related install and usage records when a software counter summary is deleted.</td>
</tr>
<tr>
<td>Clear normalized flag</td>
<td>Software Usage [cmdb_sam_sw_usage]</td>
<td>Clears normalized flag on certain field changes.</td>
</tr>
<tr>
<td>Clear normalized flag</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Clears the is_normal check box when a field value is changed from a normalized value.</td>
</tr>
<tr>
<td>CPU/Core count change</td>
<td>Computer [cmdb_ci_computer]</td>
<td>Clears the Cached check box on related software installs when the CPU count or CPU core count changes.</td>
</tr>
<tr>
<td>Create a Software Normalization</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Links the record to the discovery model with that primary key on the [cmdb_sam_sw_install] table if the primary key changes. The business rule creates a discovery model if none exist for that primary key.</td>
</tr>
<tr>
<td>Create a Software Normalization</td>
<td>Software Usage [cmdb_sam_sw_usage]</td>
<td>Links the record to the discovery model with that primary key on the [cmdb_sam_sw_usage] table if the primary key changes. The business rule creates a discovery model if none exist for that primary key.</td>
</tr>
</tbody>
</table>
### Software Asset Management plugin business rules (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete cached count results</td>
<td>Software License [alm_license]</td>
<td>Marks the software counter results to be recounted when one or more fields on a license have changed. This script runs after a change to a field that a counter can be grouped on, such as location, department, company, cost_center, entitlement_condition, or assigned_condition. If one or more of these fields changes, then the script sets the Recount field to true on any cached counter results matching the previous value. When the counter runs, the results with Recount set to true are treated as non-cached results and are recounted. For example, if Location on a license was Americas and changes to EMEA, cached results for Americas will have Recount set to true for the next count.</td>
</tr>
</tbody>
</table>
| Delete Cached row entry                    | License Entitlement [alm_entitlement]| When an entitlement is deleted:  
- Deletes all related software counter details.  
- Clears the Cached check box on the related software install.                                                                                     |
| Drop counter Cache                        | Software Counter [sam_sw_counter]   | Clears the Cached check box for the software counter if the grouping,                                                                                                                                       |
### Software Asset Management plugin business rules (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flag counter to reprocess</td>
<td>Software Upgrade and Downgrades</td>
<td>Clears the Cached check box for all related software counters if the upgrade parent or downgrade child values are changed or deleted.</td>
</tr>
<tr>
<td>Flag counter to reprocess</td>
<td>Software Suite</td>
<td>Clears the Cached check box for all related software counters if the suite parent or suite child values are changed or deleted.</td>
</tr>
<tr>
<td>invalidate sw install cache</td>
<td>Computer</td>
<td>Uncaches all install and usage records referencing a computer when the computer's processor field is changed.</td>
</tr>
<tr>
<td>Limit license metric</td>
<td>License</td>
<td>Limits software licenses to a single license metric value.</td>
</tr>
<tr>
<td>Limit license metric combinations</td>
<td>Hardware</td>
<td>Rejects license metric combinations of the same type, such as CAL (user) and CAL (devices).</td>
</tr>
<tr>
<td>Link to Model</td>
<td>Software Discovery Model</td>
<td>Finds and sets the model field to the model that best corresponds to the record when a software discovery model is created.</td>
</tr>
<tr>
<td>Mark install for suite omission</td>
<td>License Entitlement</td>
<td>Searches for any matching installs and marks them for suite omission.</td>
</tr>
</tbody>
</table>
### Software Asset Management plugin business rules (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One and only one default mapping</td>
<td>Processor Mapping [sam_processor_mapping]</td>
<td>Ensures only one default mapping by resetting the last resort flag for modified records and setting it to false for new records.</td>
</tr>
<tr>
<td>Process cache reset</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Resets the install of any counter information when it becomes uncached.</td>
</tr>
<tr>
<td>Process suite component deletion</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Updates all other members of an install's suite if the install is deleted.</td>
</tr>
<tr>
<td>rebind processor definitions</td>
<td>Processor Mapping [sam_processor_mapping]</td>
<td>Refreshes processor definitions when a processor mapping changes.</td>
</tr>
<tr>
<td>Rebuild Cache</td>
<td>Software Discovery Model [cmdb_sam_sw_discovery_model]</td>
<td>Clears the Cached field on the software counter if the associated software model is modified on the software discovery model record.</td>
</tr>
<tr>
<td>Rebuild inferred suite and cached</td>
<td>Software Discovery Model [cmdb_sam_sw_discovery_model]</td>
<td>Clears the cached flag and inferred suite field on records referencing this discovery model, when the matched model changes.</td>
</tr>
<tr>
<td>Remove cached flag</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Clears the corresponding cached software counter details if a software installation is deleted or if the configuration item on which it is installed changes.</td>
</tr>
<tr>
<td>Remove cached flag</td>
<td>Software Usage [cmdb_sam_sw_usage]</td>
<td>Clears the corresponding cached software counter details if a software usage record is deleted or if the configuration item on which it is installed changes.</td>
</tr>
</tbody>
</table>
## Software Asset Management plugin business rules (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove caches from detail</td>
<td>Software Counter Detail [sam_sw_counter_detail]</td>
<td>Clears the Cached check box on the related entitlement, installation, and usage records if they exist.</td>
</tr>
<tr>
<td>Reset counter info on suite change</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Uncaches and resets counter information on the install if its inferred suite changes.</td>
</tr>
<tr>
<td>Reset Installs per License</td>
<td>Software Counter [sam_sw_counter]</td>
<td>Clears the Installations per license fields if the counter license type is not per user.</td>
</tr>
<tr>
<td>Retrieve PVU Mapping</td>
<td>Processor Definition [cmdb_processor_definition]</td>
<td>Finds a matching processor mapping based on the information of the processor definition.</td>
</tr>
<tr>
<td>SAM: Core Process</td>
<td>Global [global]</td>
<td>Not used for any processing.</td>
</tr>
<tr>
<td>Set Display name</td>
<td>Software Counter Result [sam_sw_counter_result]</td>
<td>Sets the display name of the counter result to the counter name with the grouping type.</td>
</tr>
<tr>
<td>Set normalized fields</td>
<td>Software Usage [cmdb_sam_sw_usage]</td>
<td>Sets normalized fields on insert to be copies of discovered fields.</td>
</tr>
<tr>
<td>Set normalized fields</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>Copies the given values as their normalized values when a software install is inserted.</td>
</tr>
<tr>
<td>Sync Software Package</td>
<td>Software Discovery Model [cmdb_sam_sw_discovery_model]</td>
<td>Creates a row in the package table to reflect the configuration item from which the software is accessed changes.</td>
</tr>
</tbody>
</table>
Software Asset Management plugin business rules (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>the row in the discovery model table.</td>
</tr>
<tr>
<td>Update Cache</td>
<td>Software Installation</td>
<td>Updates all corresponding cached software counter details if usage metrics for</td>
</tr>
<tr>
<td></td>
<td>[cmdb_sam_sw_install]</td>
<td>this installation change.</td>
</tr>
<tr>
<td>Update Cache</td>
<td>Software Usage</td>
<td>Updates all corresponding cached software counter details if usage metrics</td>
</tr>
<tr>
<td></td>
<td>[cmdb_sam_sw_usage]</td>
<td>for this software usage change.</td>
</tr>
</tbody>
</table>

References

Software Asset Management plugin adds the following references.

Software Asset Management plugin references

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Activating the Software Asset Management plugin IBM PVU Process Pack after</td>
</tr>
<tr>
<td>Definition</td>
<td>activating Software Asset Management plugin adds a reference to the</td>
</tr>
<tr>
<td></td>
<td>processor definition to the Hardware [cmdb_ci_hardware] table.</td>
</tr>
</tbody>
</table>

Software Asset Management plugin setup process

To get started with Software Asset Management plugin, you need to identify and discover software owned, create software models, create license records, and configure software counters.

To get started with Software Asset Management plugin:

- **Identify Software Owned.** The following methods identify the software your organization owns:
  - Use Discovery to identify currently owned software and begin working with Software Asset Management plugin.
  - Identify and add the software manually or with a third-party tool.
- **Make the Configuration Management Database (CMDB) Accurate**
Clean up information in CMDB. At first, focus on your top 10-20 software vendors.

- **Create Software Models**
  Create software models for all of the software your organization wants to monitor. Software models can also be imported from another source such as a Discovery application, an existing data set of software licenses, or a third-party source.

- **Create Software License Records**
  Create software license records for all of the software your organization owns. This information can also be based on information from a purchasing source or imported as a spreadsheet.

- **Configure Software Counters**
  Configure software counters to view your organization’s software compliance levels for all of your software.

**Determine where software is installed**

When determining where software is installed, there are a few points to keep in mind.

- The software instance no longer contains discovered information. The information previously went to the Software Instance [cmdb_software_instance] table, but now goes to the Software Installation [cmdb_sam_sw_install] table. Because the table has changed, you must change your transform maps to point to the new table.

- Models identified by a discovery tool are linked to software models.

- Use grouping to obtain more specific information from a software counter.

- Software installations link a computer with a software model (via a discovery model).

A discovery tool places the data it obtains into the Software Installation [cmdb_sam_sw_install] table. All of the information can be seen in the Software Installations list and the individual Software Installation forms. When a record is created, the system analyzes the Discovery Model table and identifies five key points.

- Publisher
- Display name
- Prod ID
Find software on the network

After using a discovery tool, you can find a definitive list of all the software found on the network.

Before you begin
Role required: sam

About this task

Note: A user with the Asset role can delete software installations, but it is not recommended. As an alternative, archive software installation information.

Procedure

1. Navigate to Software Asset > Discovery > Discovery Models.
   A software administrator can, for example, look at the list and see that Adobe Acrobat 9.0, 9.2, 9.3, and 9.5 were found. Then, the administrator can edit software discovery models so all the dot versions are considered version 9.0 when doing reconciliation.

2. Click a Display Name in a row.
   All installations that map to an individual software discovery model are displayed.
   All fields on the form are read-only.

Software installation fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the software installation as it appears in record lists.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software.</td>
</tr>
<tr>
<td>Discovery model</td>
<td>Software discovery model that represents the installed software.</td>
</tr>
<tr>
<td>Prod id</td>
<td>Number created by the publisher to identify the software.</td>
</tr>
<tr>
<td>Install location</td>
<td>Path under which the software is installed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Install date</td>
<td>Date on which the software was installed.</td>
</tr>
<tr>
<td>Revision</td>
<td>Revision of the software.</td>
</tr>
<tr>
<td>Instance key</td>
<td>Encrypted credentials for the software installation.</td>
</tr>
<tr>
<td>Installed on</td>
<td>Hardware on which the software is installed.</td>
</tr>
<tr>
<td>Uninstall string</td>
<td>Identifier used to uninstall the software.</td>
</tr>
<tr>
<td>ISO serial number</td>
<td>ISO number of the software.</td>
</tr>
<tr>
<td>Foreground</td>
<td>Duration of foreground usage of the software.</td>
</tr>
<tr>
<td>Background</td>
<td>Duration of background usage of the software.</td>
</tr>
<tr>
<td>Last scanned</td>
<td>Date and time on which the software was last discovered on this hardware.</td>
</tr>
<tr>
<td>Last used</td>
<td>Date and time on which the software was last used on this hardware.</td>
</tr>
<tr>
<td>Counted by</td>
<td>The counter summary name that the installation is counted on.</td>
</tr>
<tr>
<td>Entitlement</td>
<td>Entitlement that is associated with the software installation.</td>
</tr>
<tr>
<td>Inferred suite</td>
<td>Software suite inferred by the inference parameters.</td>
</tr>
<tr>
<td>Valuation</td>
<td>Indicates the number of rights the install has.</td>
</tr>
<tr>
<td>Cached</td>
<td>If checked, the license installation has already been counted.</td>
</tr>
<tr>
<td>Omit from suites</td>
<td>If checked, the license is ignored for any suite calculations.</td>
</tr>
</tbody>
</table>

### Note:
Third-party discovery tools can use software normalization to more effectively manage the software installation database. Software normalization allows you to standardize your software installation data, such as the display name, publisher, revision, and version. You can personalize the software installation form to include these normalization fields. For more information, see [Personalizing forms](#).
What to do next
For more information on forms see Configure a form.

Scan software installations with the system scheduler
Software Asset Management plugin adds a scheduled job for scanning software installations named **SAM License Counters** in **System Scheduler > Scheduled Jobs**.

The **SAM License Counters** job occurs at 2:00am (local time) every morning. The job queries the Software Installation [cmdb_sam_sw_install] table and captures any installations that have not been scanned in the past 7 days. The job runs a join query on hardware that has been scanned within the last day and software installations that have not been scanned in the last 7 days. These software installations are then removed.

Software licenses
Software licenses are based on defined models in the Software Asset Management plugin feature.

You can create the models to organize software licenses in any way that makes sense for your organization. Common methods of defining models and licenses include by department or by region.

Licenses can be associated with a contract. For more information, see the **Contract Management** application.

Licensing types
Different types of licenses are available in the ServiceNow Software Asset Management plugin feature as listed below.

- By CPU
  - By CPU cores
  - By number of CPUs
- By number of points
  - Per installation - IBM PVU
- By user
  - Number of installs per user
  - Per named user
- By utilization
  - Usage (CPU)
  - Usage (User)
• By workstation
  Per workstation

**Supported license models**

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual</td>
<td>Given to individuals.</td>
</tr>
<tr>
<td>Bulk allocated</td>
<td>Allocated to users via entitlements.</td>
</tr>
<tr>
<td>Bulk not allocated</td>
<td>Given to users with details, such as who has a license or where the license is located, not tracked.</td>
</tr>
</tbody>
</table>

**License management**

The Software Asset Management plugin feature allows asset managers to track and organize the number of licenses available to the organization.

Software licenses are based on models that you create to organize software licenses in meaningful ways. Different license calculation types determine how software is counted.

Software licenses can also be associated with a contract which enables a company to cover software licenses for multiple assets or users. You can manage and track software contracts using the Contract Management application.

**Add a new software license**

You can add a new software license using the Software Asset Management plugin feature.

**About this task**
Role required: sam

**Procedure**

1. Navigate to Software Asset > Software Licenses.
2. Click New.
3. Complete the form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Read-only. Name of the software license. Created automatically.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model category for the software license. <strong>Software License</strong> is selected by default.</td>
</tr>
<tr>
<td>Model</td>
<td>Software model of the license you are matching to. For example, Microsoft Excel.</td>
</tr>
<tr>
<td>Rights</td>
<td>Number of entitlements to be granted by this license. If an enterprise contract is attached to the license, the Rights field does not display.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Asset tag</td>
<td>Number from the asset tag. The tag contains the serial number and bar code for tracking the software license.</td>
</tr>
<tr>
<td>State</td>
<td>Current status of the software license, such as <strong>On order</strong> or <strong>In use</strong>.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User currently assigned to this software license.</td>
</tr>
<tr>
<td>Managed by</td>
<td>User or department that maintains the software license. Can be different than the owner. For example, a specified user can own a software license, but the IT department manages it.</td>
</tr>
<tr>
<td>Owned by</td>
<td>User or department with financial ownership of the software license. Can be different than the manager.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset of the software license, if any. For example, the parent asset of Microsoft Word software is often the Microsoft Office suite.</td>
</tr>
<tr>
<td>Class</td>
<td>[Read-only] Automatically created as Software License.</td>
</tr>
<tr>
<td>License metric</td>
<td>[Optional] A single metric which the software license is counted against.</td>
</tr>
<tr>
<td>Serial number</td>
<td>Unique number assigned for identification.</td>
</tr>
<tr>
<td>Substate</td>
<td>More details about the software license stage. The available substate settings depend on the <strong>State</strong> selected. For example, if you select the <strong>Retired</strong> state, the substate options available are <strong>Disposed</strong>, <strong>Sold</strong>, <strong>Donated</strong>, and <strong>Vendor credit</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Location</td>
<td>Where the license will be used. For example, a specific site, country, or region.</td>
</tr>
<tr>
<td>Department</td>
<td>Department of the person <strong>Assigned to</strong> this software license.</td>
</tr>
<tr>
<td>Company</td>
<td>Company that created the software.</td>
</tr>
<tr>
<td>Assigned</td>
<td>Date on which the software license was assigned.</td>
</tr>
<tr>
<td>Installed</td>
<td>Date on which the software license was installed.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the software license that would be helpful for others to know.</td>
</tr>
</tbody>
</table>

For information about the fields in the **Financial** and **Contracts** sections of the form, see **Create assets**.

4. Click **Submit**.

**Create and manage an enterprise license**

Enterprise licenses are typically for large customers and provide some flexibility, an agreed upon discount price, and a mechanism for easy administration.

**About this task**

Use the Contract Management application to set a software license as enterprise or subscription.

**Procedure**

1. Navigate to **Contract > Software Licenses**.
2. Click **New**.
3. Select a **License type** of **Enterprise**.
4. Fill in as many of the remaining fields on the Contract form as you can, and click **Submit**.
5. Reopen the contract.
6. In the Assets Covered related list, click **New**.
7. In **Asset**, select the software covered by the contract.
8. In **Date added**, select the date the software license was added to the contract. The date can be in the past, the present, or the future.
9. (Optional) In **Date removed**, select the date asset was, or will be, removed from the contract.
10. Click Submit.

11. Navigate to Software Asset > Reconciliation > Software Counters.

12. Click the software you specified.

13. Click Count Licenses.

The licenses are listed under Software Counter Results. The licenses display as 0, but you are not out of compliance because you have an enterprise license with an enterprise contract. Once an enterprise contract is associated with software, all users are entitled when the licenses are counted.

Note: In the Software Licenses list, enterprise licenses display 0 in the Rights column. The concept of rights is not used with enterprise licenses.

Create and manage a subscription license

You can create subscription licenses, and manage the information as it changes.

Before you begin

Role required: contract_manager

Procedure

1. Navigate to Contract > Software License and click New.

2. Select a License type of Subscription.

3. Complete the Contract form, right-click the header, and select Save.

4. In the Assets Covered related list, click New.

5. In Asset, select the software covered by the contract.

6. In Date added, select the date the software license was added to the contract. The date can be in the past, the present, or the future.

7. Optional: In Date removed, select the date asset was, or will be, removed from the contract.

8. Click Submit.


10. Click the software specified in step 6.

11. Click Count Licenses.

The licenses are listed under Software Counter Results.
Software license entitlements for Software Asset Management plugin

Software entitlements enable you to define the people or machines to which a specific, purchased software license is assigned.

Before you begin
Role required: asset

About this task
Asset managers allocate a license to entitle a user or machine to use the license. For example, a company purchases a software license for 100 rights. The software entitlement specifies the 100 employees or machines that are rightfully assigned a license. If the ServiceNow Discovery tool is used and it finds the software installed on 200 machines, the asset manager can identify the employees or computers that have the software installed without a license. The asset manager can ask users to remove the software from their computers.

Built-in rules prevent entitling more licenses than have been purchased.
License entitlements use specific software license asset tags. In addition to the mandatory asset tag, an individual person and a specific configuration item can be assigned.

The benefits of using software entitlements include the following.

- If the overall license entitlement is exceeded, the asset manager can rapidly address the problem and return to compliant status by either removing unauthorized software or ordering more licenses.
- If the license entitlement is not being used completely, the asset manager can respond by lowering the number of licenses purchased in the future.

Procedure

1. Navigate to Asset > Software > Asset License Entitlements and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name used in record lists.</td>
</tr>
<tr>
<td>Allocated to</td>
<td>The configuration item consuming the license token.</td>
</tr>
<tr>
<td>Licensed by</td>
<td>License granting this token.</td>
</tr>
<tr>
<td>Cached</td>
<td>Internal flag set and used by software counters logic.</td>
</tr>
</tbody>
</table>

2. Click Submit.
Create an entitlement for Software Asset Management plugin

You create software entitlements for both CIs and users from the same License Entitlement form.

About this task
You can create these entitlements from Asset Management. Navigate to one of these locations and click New:

- **Asset > Software > Asset License Entitlements**
- **Asset > Software > User License Entitlements**

Procedure
1. Navigate to **Software Asset > Software Licenses**.
2. Click an **Asset tag**.
3. Click **Add Entitlement** and complete the License Entitlement form using the fields in the table.
4. Click **Submit**.
   The view returns to the Software License form.
5. Set an optional condition in the **Allocated conditions** section.
   The configuration items given this license must meet the specified conditions. For example, you might set a condition that allocates this software license to CIs in a certain department only.
6. Click **Update**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name used in record lists.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User of the entitlement token.</td>
</tr>
<tr>
<td>Allocated to</td>
<td>The configuration item consuming the license token.</td>
</tr>
<tr>
<td>Licensed by</td>
<td>License granting this token.</td>
</tr>
<tr>
<td>Cached</td>
<td>Internal flag set and used by software counters.</td>
</tr>
</tbody>
</table>

Create a software user license entitlement

You can entitle a user to use one of your software licenses.
Before you begin
Role required: asset

Procedure
1. Navigate to **Asset > Software > User License Entitlements** and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Read-only. Name used in record lists.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User of the entitlement token.</td>
</tr>
<tr>
<td>Licensed by</td>
<td>License granting this token.</td>
</tr>
<tr>
<td>Cached</td>
<td>Read-only. Internal flag set and used by software counters logic.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.

Entitle a license to a configuration item
You can entitle a license to a configuration item, such as a computer or server, or a location, such as a city or building.

Before you begin
Role required: sam

Procedure
1. Navigate to **Software Asset > Software Licenses**.
2. Click an **Asset tag**, or click **New** to create a new software license.
3. In the **Asset Entitlements** related list, perform one of the following actions.
   - Double-click in **Allocated to** to entitle the license to a specific configuration item, such as a computer or server.
   - Double-click in **Location** to entitle the license to a specific location, such as a city or building.
4. **Optional**: Set the **Allocated conditions** condition to the configuration items given this license must meet the specified conditions.
Example
For example, only configuration items in a certain department can be allocated this software license.

5. Click **Update**.

Entitle a license to a user or location
You can entitle a license to an individual user.

Before you begin
Role required: sam

Procedure
1. Navigate to **Software Asset > Software Licenses**.
2. Click an **Asset tag**, or click **New** to create a new software license.
3. In the **User Entitlements** related list, perform one of the following actions.
   - Double-click in **Assigned to** to entitle the license to a specific user.
   - Double-click in **Location** to entitle the license to a specific location, such as a city or building.
4. **Optional**: Set the **Assigned to condition** to require that every user given this license meets the specified conditions.

Example
Only people in a certain region can be assigned this software license

5. Click **Update**.

License upgrade and downgrade
The concept of upgrading and downgrading licenses is built into the Software Asset Management plugin feature.

This is helpful when reconciling licenses. Downgrading a license is the process of purchasing a license, but using an earlier version. Upgrading a license occurs when a newer version of a license is not purchased, but you are allowed to use the newer version. Downgrading is more common than upgrading.

Any version defined as a downgrade child that does not have entitlements and a license can be counted as an installation of the upgrade parent. Use this method to avoid having to uninstall unlicensed versions of software running in your environment. When you define an unlicensed version as a downgrade child of a licensed version, the system creates a software model record for the...
unlicensed version with an upgrade path to the licensed version. If you delete the downgrade child from the licensed version's record, it is automatically deleted from the Software Model record for the unlicensed version.

Note: If the downgrade child has either a license or an entitlement, it must also have a counter, which counts all installations of the downgrade child against its own license.

For example, you have licenses for the software model Microsoft Word 2010, but no licenses or entitlements for Word 2007. Discovery finds installations of Word 2007 being used in your organization. Rather than force users to uninstall all instances of this unlicensed version, you decide to count installations of Word 2007 against your Word 2010 license. To do this, you configure Word 2007 as a downgrade child in the Word 2010 Software Model record. A Software Model record is automatically created for Word 2007 which specifies Word 2010 as the upgrade parent.

If a software version has a downgrade child or an upgrade version that can be counted against the parent, the number of installs counted is restricted to the number of available rights of the parent. For example, Microsoft Word 2010 has a downgrade to Word 2007. Both versions have an active counter. Microsoft Word 2010 finds all entitled copies of Word 2007, and also takes out of compliance any installs from that downgrade counter until the available downgrade rights are used. However, if Microsoft Word 2010 only has 100 rights, then the maximum number of rights to be taken from the downgrade counter is 100.

You can set the start and end dates for a software upgrade parent and downgrade child to be valid. The software counter counts the upgrade and downgrade licenses within the selected dates. If the software counter runs outside of the date range, the upgrade and downgrade licenses are not counted.

Note: If an upgrade parent or downgrade child is set on the software model, it applies to all licenses of that model. If set on the software license, it applies specifically to that license.

Upgrade a license

You can upgrade a software license using one of two methods: from a software license record or from a software model record.

Before you begin
Role required: sam
Procedure

1. Complete the following steps to identify an upgrade parent from a software license record.

   a. Navigate to **Software Asset > Software Licenses** and select a software license.

   b. Click the **Software Upgrade and Downgrade** tab and click **New**.

   c. Complete the form.

<table>
<thead>
<tr>
<th>Software Upgrade and Downgrades form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>------------------------</td>
</tr>
<tr>
<td>License</td>
</tr>
<tr>
<td>Downgrade Child</td>
</tr>
<tr>
<td>Upgrade parent</td>
</tr>
<tr>
<td>Start date</td>
</tr>
<tr>
<td>End date</td>
</tr>
</tbody>
</table>

   d. Click **Submit**.
   The software upgrade displays in the Software Upgrade and Downgrades section.

   e. Select the software upgrade check box and click **Update**.
   The software license is updated in the Software License list.

2. Complete the following steps to identify an upgrade parent from a software model record.

   a. Navigate to **Software Asset > Software Models**.

   b. Select a model.

   c. In the **Upgrade** section, double-click under the **Upgrade parent** column heading.

   d. Select a software model from the list.
e. Click the green check mark and click **Update**. The Software Model form is updated.

**Downgrade a license**

You can downgrade a software license using one of two methods: from a software model record or from a software license record.

**Before you begin**

Role required: sam

**About this task**

⚠ **Note:** Downgrade children set on the software license applies specifically to that license. If a downgrade child is set on the software model, it applies to all licenses of that model.

**Procedure**

1. Complete the following steps to downgrade a license from a software model record.
   a. Navigate to **Software Asset > Software Models**.
   b. Select a model.
   c. In the **Downgrade** section, double-click under the **Downgrade child** column heading.
   d. Select a software model from the list.
   e. Click the green check mark.

2. Complete the following steps to downgrade a license from a software license record.
   a. Navigate to **Software Asset > Software Licenses**.
   b. Select a license.
   c. Click **New** in the Software Upgrade and Downgrades related list.
   d. Select a software model from the list.
   e. Select the **Start** and **End** dates.
   f. Click **Submit**.

**Identify a downgrade child from a software license record**

How to identify a downgrade child from a Software License record.
Procedure

1. Navigate to **Software Asset > Software Licenses**.
2. Select a license.
3. Click **New** in the **Software Upgrade and Downgrades** related list.
4. Select a software model from the list.
5. Select the Start and End dates.
6. Click **Submit**.

   **Note:** Downgrade children set on the software license applies specifically to that license. If a downgrade child is set on the software model, it applies to all licenses of that model.

**View a list of unallocated software licenses**

Managing software licenses includes knowing what licenses are owned by your organization, but are not allocated.

**Before you begin**

Role required: sam

**About this task**

You can allocate the licenses to users or devices. If no one needs the unallocated licenses, this can be noted so that fewer licenses are purchased in the future.

**Procedure**

1. Navigate to **Asset > Software > Unallocated Licenses**.
2. View the **Software Counter Details** list (**Unallocated License** view).
   The **Valuation** column lists the number of unallocated licenses for the given software model.
3. Click a name in the **Model** column for detailed information about a specific license.
   View the **Software Model** list in the **Unallocated License** view.

**Merge a software license**

If you have multiple software licenses that are linked to the same model, you can merge these individual licenses into one new consolidated license.
About this task
To be merged, the individual licenses must meet the following requirements:

• The licenses cannot already be merged into another consolidated license.
• The information in the following fields must match for each license:
  ◦ Model
  ◦ Allocated condition
  ◦ Assigned condition
  ◦ Company
  ◦ Location
  ◦ Department
  ◦ Cost center
  ◦ State
• The licenses must have the same set of software upgrades and downgrades and the same set of assets covered. To verify this information, go to Software Asset > Software Licenses and select a license.
  ◦ For upgrades and downgrades, go to the Software Upgrade and Downgrades related list.
  ◦ For assets covered, go to the Assets Covered embedded list in the Contracts related list.

If a license can be merged, Merge with similar licenses appears under Related Links on the Software License form.

To merge a license:

Procedure
1. Open a license.
2. Click the Merge with similar licenses link.
   Displays a dialog box with a message stating that the merge process is irreversible and that license keys are not merged.
3. Click OK.
   All qualifying licenses, including the current license, are merged into a new consolidated license. An informational message appears until the user is redirected to the newly merged license.
   All qualifying licenses are merged into a new consolidated license unless they can be matched to an existing consolidated license. If they are merged into
a new consolidated license, the Asset tag field is cleared. After merging, the merged license is marked as Is merged license (field = true) and the Merged into field is set to this license for the consolidated licenses.

ℹ️ Note: Licenses that are marked as merged are not counted.

For the consolidated licenses:

- The number of rights are summed up into a new count.
- The asset and user entitlements are transferred to the new license.
- The expense lines and assets on contract rate cards are transferred to the new license.
- The set of software upgrades and downgrades, as well as the set of assets covered, are copied to the new license.
- The cost of each individual license is summed up into the new license using the system base currency.
- A history of the consolidated licenses and where they went is maintained.

### Related information

License management

### Manage software models

Software Asset Management plugin uses software models to manage licenses, specifically in software counters and license restrictions, and to track upgrade and downgrade licenses.

#### Before you begin

Role required: sam or model_manager

#### About this task

Create software models for all of the software your organization wants to monitor. Software models can also be imported from another source such as the Discovery application.

ℹ️ Note: Software does not create configuration items. If the discovery tool you use supports and finds ISO information, details such as ISO ID and ISO serial number are added to the Software Model form for compliance purposes.
Procedure

1. Navigate to Software Asset > Software Models.
   Users with the model_manager role can navigate to Product Catalog > Product Model > Software Models, but cannot administer all aspects of software models.

2. Click New.

3. Complete the form.

Software model fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>[Read-only] Name of the model. A system property called glide.cmdb_model.display_name.shorten controls how software model display names are generated. Administrators can configure the property.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>The company that built the model.</td>
</tr>
<tr>
<td>Name</td>
<td>The manufacturer-assigned name of the model or an abstract name specified by the model manager, such as Field Agent Laptop.</td>
</tr>
<tr>
<td>Edition</td>
<td>The edition of the software model, such as Professional.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the model.</td>
</tr>
<tr>
<td>Model categories</td>
<td>[Read-only] The category the model is assigned to. The system automatically sets the value to Software License. This field is a glide list.</td>
</tr>
<tr>
<td>Asset tracking strategy</td>
<td>The process the model should be tracked by. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• Leave to Category: model is transparent and the asset class is defined solely by the category.</td>
</tr>
<tr>
<td></td>
<td>• Create Consumable Asset: model forces the asset class to be consumable, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td></td>
<td>• Don't create assets: model blocks asset instantiation, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>The method for purchasing the model. Options are Both, Buy, and Lease.</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost a single unit of the model.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>The depreciation scheme for the model.</td>
</tr>
<tr>
<td>Model number</td>
<td>The specific model number assigned to the item by the manufacturer.</td>
</tr>
<tr>
<td>Barcode</td>
<td>The barcode number assigned to the model. Barcodes are usually assigned by the manufacturer.</td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the model. Options are In Production, Retired, and Sold.</td>
</tr>
<tr>
<td>Certified</td>
<td>The option that determines whether the model is approved for use.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the model that would be helpful for others to know.</td>
</tr>
<tr>
<td>License</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>The exact version of the software. For example, Version 2.</td>
</tr>
<tr>
<td>Major</td>
<td>The ISO major version number of the software.</td>
</tr>
<tr>
<td>Minor</td>
<td>The ISO minor version number of the software.</td>
</tr>
<tr>
<td>Build</td>
<td>The build number of the software.</td>
</tr>
<tr>
<td>Software category</td>
<td>A category name for grouping software with similar characteristics.</td>
</tr>
<tr>
<td>Single or multi license</td>
<td>Defines whether this model uses a single license or multiple licenses.</td>
</tr>
<tr>
<td>Maximum socket count</td>
<td>Maximum number of CPU sockets that a computer must have for the software to be installed.</td>
</tr>
<tr>
<td>License type</td>
<td>The tracking type for the license. For example, by number of users, per workstation, per installation with IBM PVU or per Oracle processors. If you select the By number of users option, you can create a software counter and specify the number of installations per license.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Activation status</td>
<td>The activation state of the software model. Options are <strong>None</strong> and <strong>Activated</strong>.</td>
</tr>
<tr>
<td>ISO id</td>
<td>The unique ISO identification number of the software product.</td>
</tr>
<tr>
<td>ISO serial number</td>
<td>The serial number issued by ISO for the software.</td>
</tr>
<tr>
<td>Application model</td>
<td>Application associated with this software.</td>
</tr>
<tr>
<td>Rights</td>
<td>Number of licenses granted to this software.</td>
</tr>
<tr>
<td>Minimum users</td>
<td>Minimum number of user licenses required for this software.</td>
</tr>
<tr>
<td>Maximum users</td>
<td>Maximum number of user licenses required for this software.</td>
</tr>
<tr>
<td>Suite Components</td>
<td></td>
</tr>
<tr>
<td>Inference percent</td>
<td>The percentage of suite components that need to be present on a system to count as a suite. Used for suite management. If the inference percent is set to 60% and a discovery tool finds three of the products on the system, the software is flagged for possible purchase as a suite.</td>
</tr>
<tr>
<td>Components</td>
<td>The child product or products of the suite. For example, Microsoft Word and Microsoft Excel are child products of Microsoft Office.</td>
</tr>
<tr>
<td>Suite Parents</td>
<td></td>
</tr>
<tr>
<td>Parents</td>
<td>The parent suites to which the software is assigned. For example, the parent suite for several common Microsoft products is a version of Microsoft Office.</td>
</tr>
<tr>
<td>Upgrade</td>
<td></td>
</tr>
<tr>
<td>Upgrades</td>
<td>An alternative version license to which you have rights. For example, if you purchase version 4 of a software product shortly before version 5 is released, your version 4 license may include a free upgrade to version 5 when it is released.</td>
</tr>
<tr>
<td>Downgrade</td>
<td></td>
</tr>
<tr>
<td>Downgrades</td>
<td>An alternative version license to which you have rights. For example, if you purchase version 4 of a software product,</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>your version 4 license may include downgrade rights to version 3.</td>
<td></td>
</tr>
<tr>
<td>Licenses</td>
<td>The software licenses that should be created automatically from this model.</td>
</tr>
<tr>
<td><strong>Note:</strong> This embedded list shows all assets created from this model, whether or not they are software licenses, in versions prior to this release.</td>
<td></td>
</tr>
<tr>
<td>Catalog Item</td>
<td></td>
</tr>
<tr>
<td>Product Catalog</td>
<td>The information about the model as it appears in the product catalog and service catalog. Information only appears if the model has been published to the product catalog.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the software model as it appears in the product catalog.</td>
</tr>
<tr>
<td>Picture</td>
<td>An image of the software logo.</td>
</tr>
</tbody>
</table>

Any software licenses you create and assign to the new model are displayed in the **Licenses** embedded list on the Software Model form.

**Create and manage software suites**

Software uses the concept of suites instead of bundles.

A software suite is a group of related software offered as one unit. An example is the Microsoft Office Professional suite of office productivity software tools that includes Powerpoint, Word, Excel, Outlook, and Access. In Software Asset Management plugin, create suites and add components to the suite so the licenses your organization owns are counted accurately.

For any software model, you have the option to specify whether the model is a suite (parent) or a component (child). A software model can be a component in multiple suites. For example, Microsoft Word is a component in Microsoft Office Standard and Microsoft Office Professional. Although you can set a single software model as both a suite and a component, software is not typically sold as nested suites.

Use the **Inference percent** and **Inference mandatory** options for even greater control of suites.
• **Inference percent**: specifies what percentage of the components in the suite must be installed for the software to be identified as a suite.

• **Inference mandatory**: enforces that a specific component in a suite must be installed to infer that the suite is installed.

For example, specify the **Inference percent** as 80% and set the **Inference mandatory** option to **true** on Microsoft Access. These settings specify that Microsoft Access must be installed, along with 3 out of 4 other products (Microsoft Word, Microsoft Excel, Microsoft PowerPoint, and Microsoft Outlook) to infer that Microsoft Office Professional is installed.

To make the new software model record a parent record in a suite:

1. Open a software model record.
2. In the Suite Components section, double-click an empty row under **Suite child**.
3. Add the software to include in the suite.
4. [Optional] Set the **Inference mandatory** option to **true** if the software must be installed to count the model as a suite.

5. Repeat as necessary.

To make the new software record a child item:

1. Open a software model record.
2. In the Suite Parents section, double-click an empty row under **Suite parent**.
3. Add the suite to which this software model should belong.
4. Repeat as necessary.

**Note:** When a change is made to a suite, a scheduled job called **Calculate suites [Software Suite Model]** is created. The job runs instantly, calculates any suites, and then deletes itself. The calculations are stored in the cmdb_sam_sw_install table under inferred suite.

**License calculations**

Software license calculations count the number of licenses that exist in your network environment.

Users with the sam role can choose to count software licenses using a variety of license calculation types, such as counting by the number of users, the number of workstations, the number of CPUs, and others. For example, you can count the number of Adobe Acrobat 9.0 licenses based on the number of users that have the software installed in the organization.
Calculate software licenses

Software calculations use license calculation types to determine how software licenses are counted in your organization.

You can use the default license types provided in the base system or create new ones. To view the default types, navigate to Software Asset > Reconciliation > License Calculations and select a type. All fields in the default records are read-only.

License calculation details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the license type.</td>
</tr>
<tr>
<td>Query table</td>
<td>The table that is being used for data. Possible values are Software install and Software usage.</td>
</tr>
<tr>
<td>Count by</td>
<td>The calculation type by which the license calculation type counts software licenses.</td>
</tr>
</tbody>
</table>

License calculation types

Certain default license calculation types are available. These license types cannot be deleted.

License calculation types

<table>
<thead>
<tr>
<th>Category</th>
<th>License type</th>
</tr>
</thead>
<tbody>
<tr>
<td>By CPU</td>
<td>• By CPU cores: The counter adds up the total license rights for all software license records of this model. The CPU Core Count field on the hardware configuration item determines the number of rights consumed by any software installation located on the configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.</td>
</tr>
<tr>
<td></td>
<td>• By number of CPUs: The counter adds up the total license rights for all software license records of this model. The CPU Count field on the hardware configuration item determines the number of rights consumed by any software installation located on the configuration item. For that installation, the</td>
</tr>
</tbody>
</table>
## License calculation types (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>License type</th>
</tr>
</thead>
<tbody>
<tr>
<td>By number of points</td>
<td>counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.</td>
</tr>
<tr>
<td>• <strong>Per installation - IBM PVU</strong>: The counter adds up the total license rights for all software license records of this model. The installation count for every hardware configuration item that has IBM PVU software is a point calculation. The CPU type determines the PVU per-core multiplier based on the IBM PVU mapping table. The total number of cores on the configuration item is multiplied with this per-core multiplier to determine how many rights are used by an installation on this configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.</td>
<td></td>
</tr>
<tr>
<td>By Client Access License (CAL)</td>
<td>This license type is present but does not work until the Software Asset Management plugin IBM PVU Process Pack is active.</td>
</tr>
<tr>
<td>• <strong>CAL (Device)</strong>: The counter adds up the total license rights for all software license records of this model. Usage is counted as one installation for every unique configuration item (device). For each installation, the counter checks for a valid entitlement record on any of the software license records. The Software Usage [ast_usage] table is used for counting.</td>
<td></td>
</tr>
<tr>
<td>• <strong>CAL (User)</strong>: The counter adds up the total license rights for all software license records of this model. Usage is counted as one installation for every unique user. For that installation, the counter checks for a valid entitlement record on any of the software license records. The Software Usage [ast_usage] table is used for counting.</td>
<td></td>
</tr>
<tr>
<td>By user</td>
<td>• <strong>Number of installs per user</strong>: The counter adds up the total license rights for all software license records of this model. It counts an installation when one software installation matches the discovery models that are mapped to this software model for any hardware used by a user. It counts up to the specified amount. For that installation, the counter checks for a valid entitlement record on any of the software license</td>
</tr>
</tbody>
</table>
### License calculation types (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>License type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>records. Applies to software installation data and hardware configuration items.</td>
</tr>
<tr>
<td></td>
<td><strong>Per named user</strong>: The counter adds up the total license rights for all software license records of this model. It counts an installation when there is at least one software installation that matches the discovery models that are mapped to this software model for any hardware used by a unique user. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.</td>
</tr>
<tr>
<td></td>
<td><strong>No license needed (User)</strong>: The counter adds up the total number of users of this model. It counts an installation when there is at least one software installation that matches the discovery models that are mapped to this software model for any hardware used by a unique user. It applies to software installation data and hardware configuration items. This license type is used for software installations where no license is required, such as open source applications.</td>
</tr>
</tbody>
</table>

To compare **Number of installs per user** and **Per named user**:

- **Number of installs per user** counts the number of installs the user has and assigns license cost based on installs per license. For example, UserA has three installs. One license is used by each install, for a total of three licenses.

- For **Per named user**, there is no install limit for a particular user. For example, UserB, who has three installs, needs only one license for the three installs.

<table>
<thead>
<tr>
<th>By utilization</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Usage (CPU)</strong>: The counter adds up the total license rights for all software license records of this model. The counter looks at all of the software usage data mapped to any of the discovery model records of the counter's software model. It counts one installation for every unique configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software usage data.</td>
</tr>
<tr>
<td></td>
<td><strong>Usage (User)</strong>: The counter adds up the total license rights for all software license records of this model. The counter looks at all of the software usage data mapped to any of the discovery model records of the counter's software model. It counts one installation for every unique configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software usage data.</td>
</tr>
</tbody>
</table>
### License calculation types (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>License type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>of the software usage data mapped to any of the discovery model records of the counter’s software model. It counts one installation for every unique user Accessed From hardware configuration item. For that installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software usage data.</td>
</tr>
<tr>
<td>By workstation</td>
<td>• <strong>Per workstation</strong>: The counter adds up the total number of license rights for all software license records of this model. It counts an installation when there is at least one software installation on a hardware configuration item that matches the discovery models that are mapped to this software model. For each installation, the counter checks for a valid entitlement record on any of the software license records. Applies to software installation data and hardware configuration items.</td>
</tr>
<tr>
<td></td>
<td>• <strong>No license needed (Workstation)</strong> This license type is used for software installations where no license is required, such as open source applications.</td>
</tr>
<tr>
<td>By Oracle install</td>
<td>• <strong>Oracle Named User</strong>: Oracle licensing scheme that counts by the number of unique users.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Oracle Named User Plus</strong>: Oracle licensing scheme that counts by the number of unique users and accounts.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Oracle Processor</strong>: Oracle licensing scheme that counts by the number of processors on a server.</td>
</tr>
</tbody>
</table>

This category and its license types are available when the Oracle Process Pack is activated.

### Create a custom license type

Custom license types allow you to create a license type with special conditions.

**Before you begin**  
Role required: sam

**About this task**  
A custom script can provide detailed information about the number of rights a software install or usage consumes.
Procedure

1. Navigate to **Software Asset > Reconciliation > License Calculations**.
2. Click **New**.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the software license type.</td>
</tr>
<tr>
<td>Query table</td>
<td>The value that is used for queries. This can be either <strong>Software install</strong> to count the number of installations or <strong>Software usage</strong> to count the number of times the software is used.</td>
</tr>
<tr>
<td>Count by</td>
<td>The calculation type by which the license type counts software licenses. Make sure this value is set to <strong>Custom</strong> to create a new calculation type.</td>
</tr>
<tr>
<td>Entitlement type</td>
<td>The entitlement type of the license, either <strong>Workstation</strong> or <strong>User</strong>. This field is available only when the <strong>Count by</strong> field is set to <strong>Custom</strong>.</td>
</tr>
<tr>
<td>Script</td>
<td>The script used for custom license types. This field is available only when the <strong>Count by</strong> field is set to <strong>Custom</strong>.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

Create the script

By default, the **Script** field in the Software License Calculation form contains information about available variables and an example script.

You can use the example as the basis of the custom script or replace the example entirely.

You can use the following variables in the custom script.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>found</td>
<td>Contains a GlideRecord of the software install or software usage record currently being evaluated.</td>
</tr>
</tbody>
</table>
Custom script variables (continued)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>workstation</td>
<td>Contains a GlideRecord of the workstation referenced by the found record.</td>
</tr>
<tr>
<td>user</td>
<td>Contains a GlideRecord of the user referenced by the found record. Can be null if no user is assigned.</td>
</tr>
<tr>
<td>counter_id</td>
<td>Contains the sys_id of the counter running the script.</td>
</tr>
<tr>
<td>query_table</td>
<td>Identifies the table currently being queried, either Software Installation or Software Usage.</td>
</tr>
<tr>
<td>valuation</td>
<td>Identifies the value in rights that is given to this software install or software usage record.</td>
</tr>
</tbody>
</table>

The following functions are available as part of the SAMUtil script include and can be used in custom scripts.

ℹ️ Note: All of these functions utilize and depend on the variables mentioned above.

### Custom script functions

<table>
<thead>
<tr>
<th>Functions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>getWorkstationInstallsOrUsages</td>
<td>Returns a list of other installs on the given workstation.</td>
</tr>
<tr>
<td>getUserInstallsOrUsages</td>
<td>Returns a list of all other installs belonging to the user.</td>
</tr>
<tr>
<td>createCounterViolation</td>
<td>Returns insert a counter violation for the current counter with the given cause.</td>
</tr>
</tbody>
</table>

Example:

The following script uses the number of rights equal to the number of CPU sockets on the machine the script is installed on. The `workstation` variable is used to identify any workstation that is in the development environment. If such a workstation is found, the script then assigns a `valuation` equal to the number of CPU sockets on the machine. Otherwise, if the workstation is not in the development environment, then no rights are assigned.
**Software discovery models**

Software discovery models can be used to help normalize the software you own by analyzing and classifying models to reduce duplication.

Software discovery models are stored in the Software Discovery Model [cmdb_sam_sw_discovery_model] table. There is a distinct difference between software models and software discovery models.

- A software model is a specific version or configuration of software.
- A software discovery model is a model created when Discovery runs and identifies software.

Software discovery models cannot be created manually. The ServiceNow platform uses any of the following field combinations to match the new software discovery model to an existing software model.

- **Display Name, Publisher, and Version**
- **Display Name** and **Version** if the **Publisher** field is empty
- **Display Name** only if the **Publisher** and **Version** fields are empty

When analyzing version numbers, the ServiceNow platform always searches for an exact match first, but rounds down to a major version number if an exact match is not found. For example, if no match is found for version number 8.0.4, but version 8.0 is found, then version 8.0 is used in the **Software model** field.
**Edit a software discovery model**

You can only edit the Software model field and Approved check box on the Software Discovery Models form.

**Before you begin**

Role required: sam

**About this task**

If the information automatically added to the Software model field is incorrect, you can change to an existing model or create a new one.

None of the software discovery model records are approved when they are created. You must approve them manually after you have reviewed them for accuracy or normalized them. If the automatically generated software model is correct, approve the model.

**Procedure**

1. Navigate to Software Asset > Reconciliation > Discovery models.
2. Click an entry in the Publisher column.
3. Select Approved.

**SAM approval**

![SAM approval screenshot]

**Automatically match to an existing model**

The automatic matching feature allows you to match a software discovery model to an existing software model.

**Before you begin**

Role required: sam
Procedure

1. Navigate to Software Asset > Reconciliation > Discovery models and open a model.
2. Clear the Software model field.
3. Click an entry in the Publisher column.
4. Click Match model.
   The system searches for the best match from existing models. If a match is found, the system automatically adds the name to the Software model field and selects the Automatically matched check box. If a match is not found, a No match found message is displayed, and two related links appear, allowing you to create a new model. No change occurs if the system has already made a match.
5. If no match is found, create a new model.
   If a model is already matched, then the automatic matching feature does not run.
   The automatic matching feature can also be used when you insert a new discovery model record or if you modify and update an existing discovery model. If automatic matching is run, all software installations and usages that reference the discovery model will have their Inferred suite and Cached fields cleared.
   For more information on software installation and usage records, see Determine where software is installed.

Create new models

If the automatically generated software model is not correct or if the system cannot find a match from existing models, you can create a new model.

Before you begin
Role required: sam

Procedure

1. Navigate to Software Asset > Reconciliation > Discovery models and open a model.
2. Clear the Software model field.
3. Save the record.
   Two related links appear for creating software models.
4. Select one of these related links to create a new model, which are available only if no Software model is specified.
• **Create Software Model**: Creates a new software model for this record if a suitable one does not already exist. You can create a new software model for multiple records in the Discovery Models list view. Select one or more records and then click the link in the **Actions** choice list.

• **Create Software Model and Counter**: Creates a new software model and a new software counter for this record. The system creates the software model automatically using the value in the **Display name** field, and then opens a new Software Counter form. In the Discovery Model list view, you can select multiple records and choose this option from the **Actions** choice list.

5. Complete the form.

### Model fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>[Read-only] Name of the discovery model as it appears in record lists.</td>
</tr>
<tr>
<td>Publisher</td>
<td>[Read-only] Publisher of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>[Read-only] Specific version of the software.</td>
</tr>
<tr>
<td>Revision</td>
<td>[Read-only] Revision number of the software.</td>
</tr>
<tr>
<td>Software model</td>
<td>Software product model to which the discovery model maps. Click the reference lookup icon and use the lookup list to find the software model to associate with this software discovery model.</td>
</tr>
<tr>
<td>Prod id</td>
<td>[Read-only] Product ID code for the software, as reported through the discovery process.</td>
</tr>
<tr>
<td>Automatically matched</td>
<td>[Read-only] Check box that indicates whether the discovery tool used the <strong>Display Name</strong>, <strong>Publisher</strong>, and <strong>Version</strong> fields to determine the <strong>Software model</strong>.</td>
</tr>
<tr>
<td>Approved</td>
<td>Check box that indicates whether the mapping to software model has been reviewed and approved.</td>
</tr>
<tr>
<td>Low confidence</td>
<td>[Read-only] Check box that indicates whether the automatically matched software model is not a close match. If selected, and if after reviewing the item it is determined that it's the correct software model, click <strong>Confirm Mapping</strong> to match the discovery model to the software model.</td>
</tr>
</tbody>
</table>

6. Select **Approved**.
7. Click Submit.

Software License Compliance Checker

The Software License Compliance Checker is a fast way to see if the software licenses used in your organization are compliant based on number of rights purchased and number of installations.

For example, if there are 100 licenses for a software program, the Software License Compliance Checker can show if the software has been installed more than 100 times. The Compliance Checker uses information found by a discovery tool such as Discovery or third-party technologies, to analyze the software installed on your network.

Use the Software License Compliance Checker

You can check software license compliance.

About this task
Role required: sam

Procedure
1. Navigate to Software Asset > System > Check License Compliance.
2. Click Proceed.
   Your organization's network is analyzed for name, software model, rights, installs, license type, and active status.
3. View the results.
   The Software Counters list is color coded.
• Green - in compliance
• Orange - within 5% of being out of compliance
• Red - not compliant

Software Counters list

Use counters for software license reconciliation

Software counters reconcile software rights with software installations to verify compliance.

For asset managers, software counters answer the question: Is my number of installations equal to or lower than the number of rights purchased? Counters are useful for software that must be tracked; some software may not need to be tracked closely. Grouping—such as location, company, department, cost center, entitlement workstation and entitlement user—or no grouping can be used with software counters.

In addition to software counters, Software Asset Management plugin offers usage counters that track a license based on use by a workstation or user.

The software counter cache is used to increase the speed of counting software licenses. If there is a large number of software license records, the first time software is counted takes several minutes. After the first count, only changes are processed so the procedure is faster.

Get started with software counters

A good way to see how software counters work is to use the demo data provided with Software Asset Management plugin.

Load the demo data on a non-production instance.
Using the demo data, try some of the procedures on this page, such as Use the Software Counter and View a Usage Counter Result.

To use software counters with your own information, follow the steps in the Software Asset Management plugin setup process. ServiceNow Discovery does not populate the Software Usage (cmdb_sam_sw_usage) table. Use a third party tool such as Microsoft’s System Center Configuration Manager to add information about software assets to the Software Usage table.

**Schedule a software count**

How to schedule a software count.

**About this task**

The SAM License Counters scheduled job scans your instance for software installations. The SAM License Counters job occurs at 2:00am local time every morning. The job queries the Software Installation [cmdb_sam_sw_install] table and captures any installations that have not been scanned in the past 7 days. The job runs a join query on hardware that has been scanned within the last day and software installations that have not been scanned in the last 7 days.

The SAM License Counters scheduled job runs all software counters at once.

To refresh the cache manually for a specific counter:

**Procedure**

1. Navigate to Software Asset > Reconciliation > Software Counters.
2. Select a counter whose cache you want to refresh.
3. Right-click in the header bar of the Software Counter record and select **Rebuild SAM Cache** from the context menu.

### Use the software counter

Use a software counter to count the licenses for a specific version of software and receive summary or detailed results.

When a software counter runs for the first time, it can take several minutes to process records. The license counts are cached so that on subsequent runs, the counter processes only changed records, both those from Discovery or altered entitlements, making it faster. The Software Counter form contains check boxes to enable faster counting through the use of quick counters. For more information on using quick counters, see *Setting Up Quick Counters*.

Use a software counter to count the licenses for a specific version of software and receive summary or detailed results. For example, an asset manager can look at summary information to discover which departments are not in compliance. Then, department managers can look at detailed information to determine the people or individual computers that are not in compliance.

Software counters return results by **Licensing Type**:

- **Entitled in use**: Number of people who have been allocated a license and installed the software.
- **Entitled not in use**: Number of people who have been allocated a license but did not install the software.
- **Not entitled**: Number of people using an unauthorized copy of the software.
- **Not allocated**: Number of licenses not assigned.

**Note**: For information about the scheduled job that runs all counters each day or the steps to run all counters manually, see Scheduling Software Counts.

The Software Counters list is color coded:
- Green - in compliance
- Orange - within 5% of being out of compliance
- Red - not compliant

SAM software license compliance check

Create a software counter

How to create a software counter.

**About this task**
Depending on the license type you select for a counter, multiple installations can count as a single license, such as when using the per user license type. This licensing concept is used on occasion by companies like Microsoft and Adobe. It grants users the right to install software on multiple machines if those users already have rights to install the software.

**Note**: You can create new counters from Discovery model records or from the list view.

To manage multiple versions of software from a single licensing perspective for the parent software model:
• The downgrade child software models that are licensed under the parent software model should all be related to a the single parent software model.

• The downgrade child software models should not have any software counters associated with them.

• The software counter should be associated only with the licensed parent software model, otherwise misleading results for the counter will be reported.

To create a software counter:

Procedure

1. Navigate to Software Asset > Reconciliation > Software Counters.
2. Click New.
3. Fill in the fields on the Software Counter form (see table).
4. Click Submit.
5. Reopen the new counter and click Count Licenses.
6. Reload the form to view the counter results.

**Software counter form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>[Required] Enter the name of the software counter as it appears in record lists.</td>
</tr>
<tr>
<td>Software model</td>
<td>[Required] Click the reference lookup icon and select the software model for which the counter will check compliance.</td>
</tr>
<tr>
<td>Contract</td>
<td>Select the contract that you want to use to limit the license. Used for enterprise and subscription-based licenses. Also restricts how counters retrieve licenses for the given counter. If left empty, all licenses for the model are counted.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to have the scheduler run the counter.</td>
</tr>
<tr>
<td>Rights Owned</td>
<td>[Read-Only] Displays a summation if a contract is specified. The total sum is the license rights provided by all the licenses for the software model (of the counter) under the specified contract. If no contract is specified, this field is a count of all licenses of this model.</td>
</tr>
<tr>
<td>Rights Used</td>
<td>[Read-Only] Displays the number of rights used by all installs, whether a contract is specified or not.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Immediate compliance</td>
<td>[Read-Only] Displays the number of additional rights needed to achieve compliance based on installations.</td>
</tr>
</tbody>
</table>

**Parameters**

**Grouping**

Select the field for grouping data:

- Location: group by the geographic location set in the license record.
- Company: group by the company set in the license record.
- Department: group by the department set in the license record.
- Cost Center: group by the cost center set in the license record.
- Entitlement (CPU): group by the condition defined in the Allocated condition field of the license record.
- Entitlement (User): group by the condition defined in the Assigned condition field of the license record.

The software counter results also displays counts for licenses that do not match the grouping parameter.

**Enforce to**

[Required] Select the level of adherence to the license:

- License: counts all existing entitlements for the installations or usage you are analyzing regardless of the grouping parameter selected.
- Strict: counts the license and entitlement as valid only if the license also matches the grouping category. For example, a license is assigned to a specific location, such as Americas. With strict enforcement enabled, the user and the machine on which the license is installed must be in the Americas group. If the person and their license assigned to the Americas group moves to the United Kingdom, the license is still valid, but strict enforcement flags the user as unauthorized to use that license. The license will be counted as valid, but will also show up as not entitled in the summary.

**Verify entitlements**

Select the check box to view the software entitlement details for the software counter. Results include the number of installations of all types: not entitled, entitled in use, entitled not in use, and not allocated. For more information, see Setting Up Quick Counters.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate details</td>
<td>Select the check box to generate the details of the entitlement records. For more information, see Setting Up Quick Counters.</td>
</tr>
<tr>
<td>License type</td>
<td>[Required] Select the method for counting licenses. For example, Per named user or Per workstation. For more information, see License Calculation Types.</td>
</tr>
<tr>
<td>Installs per license</td>
<td>Enter the number of installations allowed (one or more) per license for each user if the License type is set to By number of users. You can allow more than two installations per license. For all other license types this field is set to 1 install per license.</td>
</tr>
<tr>
<td>Cached</td>
<td>[Read-Only] Shows whether this option is selected. If selected, only changed information is counted, reducing the amount of time it takes to count the licenses.</td>
</tr>
<tr>
<td>License condition</td>
<td>Specify the condition a license should satisfy in order to be counted.</td>
</tr>
<tr>
<td>Software install condition</td>
<td>Specify the condition an install record should satisfy in order to be counted. This field appears depending on the value of the License type field.</td>
</tr>
<tr>
<td>Software usage condition</td>
<td>Specify the condition a usage record should satisfy in order to be counted. This field appears depending on the value of the License type field.</td>
</tr>
</tbody>
</table>

Related Lists

<table>
<thead>
<tr>
<th>Software Counter Results</th>
<th>Displays all results for this software counter.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Counter Compliance Violations</td>
<td>Displays all records of compliance violations for this software counter.</td>
</tr>
<tr>
<td>Software Counter Histories</td>
<td>Displays all software counter history records for this software counter. Each time a count is completed, the system</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>automatically generates a software counter history record, which is a read-only copy of the software counter record.</td>
</tr>
</tbody>
</table>

**Note:** A message is displayed at top of the software counter form indicating if a license count is in progress. Reload the form to view the counter results.

**Set up quick counters**

Quick counter settings can help speed up the software counting process.

The following check boxes are available in the Parameters section of the Software Counter form:

- **Verify entitlements:** When this check box is selected, the software counter will generate entitlement details in the software counter summaries, displaying the number of entitlements in use and entitlements not in use. If the check box is cleared, the software counter will display *Entitlement not known* with a count of total installs. The counter will not check for entitlements.

- **Generate details:** When this check box is selected, the software counter will generate software counter details for each software counter result type. If the check box is cleared, no details will be available.

Clearing these check boxes in addition to setting the Grouping parameter to None will enable software counters to run more quickly.

**View a software counter result**

Software counter results provide detailed information about each grouping.

**About this task**

To view software counter results:
Procedure

1. On the Software Counter form, click a name in the Software Counter Results related list.

2. View the Software Counter Result form (see table).
   All fields on the form are read-only.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software counter</td>
<td>Name of the software counter whose results are displayed.</td>
</tr>
<tr>
<td>Grouping</td>
<td>Grouping this software belongs to.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parent</td>
<td>Name of the parent software, if one exists, assigned to this software.</td>
</tr>
<tr>
<td>Rights</td>
<td>Number of rights available in the group.</td>
</tr>
<tr>
<td>Installs</td>
<td>Number of rights used by installations of the software in the group.</td>
</tr>
<tr>
<td>Immediate compliance</td>
<td>Number of additional rights needed for the group to achieve compliance based on installations.</td>
</tr>
<tr>
<td>Planned compliance</td>
<td>Number of additional rights needed for the group to achieve compliance based on installations and number of unused entitlements available.</td>
</tr>
<tr>
<td>Usage Section</td>
<td></td>
</tr>
<tr>
<td>Foreground</td>
<td>Total duration of foreground usage of the software, based on all the installations for the group.</td>
</tr>
<tr>
<td>Background</td>
<td>Total duration of background usage of the software, based on all the installations for the group.</td>
</tr>
<tr>
<td>Times used</td>
<td>Total number of times the software was used, based on software usage records for the group.</td>
</tr>
<tr>
<td>Duration</td>
<td>Total duration of software usage, based on software usage records for the group. (Not the sum of Foreground and Background.)</td>
</tr>
<tr>
<td>Related List</td>
<td></td>
</tr>
<tr>
<td>Summary</td>
<td>Breakdown of software counter results by type. Click a type to view a detailed summary.</td>
</tr>
</tbody>
</table>

**View a software counter summary**

Software counter summaries provide information about each software counter type.

**About this task**

To view a software counter summary:

**Procedure**

1. On the Software Counter Result form, click a type in the **Summary** related list.
2. View the Software Counter Summary form (see table).
All fields on the form are read-only.

**SAM software counter results**

![Software counter summary](image)

**Software counter summary**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software counter result</td>
<td>Name of the software counter result for which the summary is displayed.</td>
</tr>
<tr>
<td>Count as</td>
<td>The software model being counted.</td>
</tr>
<tr>
<td>Rights</td>
<td>Number of rights that have been used.</td>
</tr>
<tr>
<td>Valuation</td>
<td>How software is counted during the reconciliation process.</td>
</tr>
<tr>
<td>Software counter</td>
<td>Name of the software counter.</td>
</tr>
<tr>
<td>Summary</td>
<td>Check box that indicates whether the form displays summary information (selected) or detailed information (cleared).</td>
</tr>
<tr>
<td>Type</td>
<td>Type of license counted.</td>
</tr>
<tr>
<td>Usage Section</td>
<td></td>
</tr>
<tr>
<td>Foreground</td>
<td>Total duration of foreground usage of the software, based on all the installations for the grouping.</td>
</tr>
<tr>
<td>Background</td>
<td>Total duration of background usage of the software, based on all the installations for the grouping.</td>
</tr>
<tr>
<td>Times used</td>
<td>Total number of times the software was used, based on software usage records for the grouping.</td>
</tr>
<tr>
<td>Duration</td>
<td>Total duration of software usage, based on software usage records for the group. (Not the sum of Foreground and Background.)</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Related List</td>
<td></td>
</tr>
<tr>
<td>Software Counter Details</td>
<td>Shows every entitlement, software install, and software usage for the software. The related list also shows the Workstation and User, if applicable, for each software counter detail. A software asset manager can, for example, identify people who are using the license but are not entitled. The software can then be uninstalled from machines that are not in compliance or people can be entitled a license to meet compliance rules. Click a type to view the software counter detail.</td>
</tr>
</tbody>
</table>

**View software counter detail**

Software counter details provide information about a specific software counter summary.

**About this task**

To view a software counter detail:

**Procedure**

1. On the Software Counter Summary form, click a type in the **Software Counter Details** related list.

2. View the Software Counter Detail form (see table). All fields on the form are read-only.

![Software counter detail form](image)

**Software counter detail form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Type of the counter detail.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Software install</td>
<td>Name of the related software install record, if applicable. This field is blank if the type is Entitled not in use or Not allocated.</td>
</tr>
<tr>
<td>Software usage</td>
<td>Name of the related software usage record, if applicable.</td>
</tr>
<tr>
<td>Software counter</td>
<td>Name of the related software counter.</td>
</tr>
<tr>
<td>Software counter summary</td>
<td>Name of the related software counter summary.</td>
</tr>
<tr>
<td>Valuation</td>
<td>A valuation of 1 indicates that the license right is being used. A valuation of 0 indicates that the license right is part of a software suite, or that the license allows more than one installation per right. The 0 indicates that this installation does not count against the license.</td>
</tr>
<tr>
<td>Entitlement</td>
<td>Name of the related software license entitlement, if applicable. This field is blank if the type is Not entitled or Not allocated.</td>
</tr>
<tr>
<td>Software license</td>
<td>Name of the related software license, if applicable. This field is blank if the type is Not entitled.</td>
</tr>
</tbody>
</table>

**Usage Section**
- Foreground: Total duration of foreground usage of the software, based on the related software install record.
- Background: Total duration of background usage of the software, based on the related software install record.
- Times used: Total number of times the software was used, based on the related software usage record.
- Duration: Total duration of foreground and background software usage, based on the related software usage record.

**View a usage counter result**
A usage counter tracks a license based on how often the license is actually used either by a workstation or a user.
About this task

A usage counter tracks a license based on how often the license is actually used either by a workstation or a user. For example, an asset manager can use a usage counter to determine who is actually using the software they have been entitled. If an individual is not using the software at all or very infrequently, the software can be uninstalled and given to an individual who will use it more often. If you have a way of capturing information, for example a proxy server or gateway, you can capture the IP address and the name of the user accessing the license. The captured data can be added directly into the Software Usages list.

Procedure

1. Navigate to Software Asset > Discovery > Software Usages.
2. Click the Display Name in the row containing the software and user to check.
3. View the Software Usage form (see table).

All fields on the form are read-only.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the software usage record.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software.</td>
</tr>
<tr>
<td>Discovery model</td>
<td>Software discovery model associated with the installed software.</td>
</tr>
<tr>
<td>Primary key</td>
<td>Unique identifier for table row.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Usage</td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>User who accessed the software.</td>
</tr>
<tr>
<td>Accessed from</td>
<td>Hardware configuration item from which the software was accessed.</td>
</tr>
<tr>
<td>Last scanned</td>
<td>Date and time when the software was last discovered on this hardware.</td>
</tr>
<tr>
<td>Duration</td>
<td>Duration of all usage.</td>
</tr>
<tr>
<td>Times used</td>
<td>Number of times the software was accessed from this hardware.</td>
</tr>
<tr>
<td>Last used</td>
<td>Date and time when the software was last used on this hardware.</td>
</tr>
<tr>
<td>Software counter</td>
<td>The software counter summary record in the Software Counter Summary table on which this usage is counted.</td>
</tr>
<tr>
<td>Counted by</td>
<td></td>
</tr>
<tr>
<td>Entitlement</td>
<td>The entitlement rights of the software.</td>
</tr>
<tr>
<td>Valuation</td>
<td>Number of license rights used by this software usage.</td>
</tr>
<tr>
<td>Cached</td>
<td>If selected, indicates that a software count has already been cached.</td>
</tr>
</tbody>
</table>

**IBM PVU Process Pack**

Processor Value Unit (PVU) is a unit of measurement defined by IBM to determine software licensing costs based on processor or server model.

A processor is defined as each core on a socket. Each software package has a price defined as number of points or PVUs per core. For a complete explanation of IBM PVU licensing for distributed software, see Processor Value Unit (PVU) licensing for Distributed Software on the IBM website.

In the Now Platform, the concept of PVU is used in the Software Asset Management plugin IBM PVU Process Pack, which is an add-on to the Software Asset Management plugin feature. It provides the ability to manage software licensed under the IBM Processor Value Units licensing model.

The Software Asset Management plugin Processor Definition Extension is automatically activated when the Software Asset Management plugin IBM PVU Process Pack is activated. It provides data model support for processor
definitions and is required by all Software Asset Management plugin process packs.

⚠️ Note: Oracle and Microsoft also use the concept of PVU, but have slightly different definitions.

Activate the IBM PVU Process Pack

The Software Asset Management plugin - IBM PVU Process Pack (com.snc.sam.ibmpvu.pp) plugin must be activated by ServiceNow personnel.

Before you begin
Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, click the Take me to the Hi Service Portal Active a Plugin Service Catalog link to access the Now Support Service Portal Service Catalog.
4. On the form, fill in the fields.

Activate Plugin Request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

⚠️ Note: Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are</td>
</tr>
<tr>
<td></td>
<td>activating the plugin. For example, if you need the plugin activated at</td>
</tr>
<tr>
<td></td>
<td>a specific time instead of during one of the default activation windows,</td>
</tr>
<tr>
<td></td>
<td>specify that in the comments.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Requirements to associate a software installation to PVU mapping**

Meeting recommended requirements ensures that you receive the highest quality results with PVU mapping.

**Procedure**

1. Use a discovery tool, such as ServiceNow Discovery, to identify hardware and populate the configuration management database (CMDB) with the configuration items you want to manage with IBM PVU licensing.

2. Use a discovery tool, such as ServiceNow Discovery, to identify software installations. Check that the added CPU information is correct.

3. **Activate** the Software Asset Management plugin - IBM PVU Process Pack plugin. This also activates the Software Asset Management plugin if it is not already active.

4. **Refresh processor definitions**.

5. Ensure that the **software models** you want to manage with IBM PVU licensing have the correct license type: **Per installation - IBM PVU**.

6. **Create software counters** to calculate IBM PVU licenses.

7. **Count licenses** to determine compliance with IBM PVU guidelines.

**IBM PVU mapping preparation**

Most IBM PVU mapping and license checking in the ServiceNow platform is managed automatically.

For the automatic calculations to be as accurate as possible, it is important that configuration item and software model information be accurate.

The important fields describing the processor on the configuration item form are:
This CPU data is often added accurately when the CMDB is populated with information. If the fields contain incorrect information, manually edit the fields on the configuration item form.

The mapping between the configuration item form fields and processor definition fields is as follows.

### Preparing for IBM PVU mapping

<table>
<thead>
<tr>
<th>Configuration Item Form Field</th>
<th>Processor Definition Form Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU type</td>
<td>Processor name, Server model number, and Processor model number</td>
<td>Combination of processor name, server model number, and processor model number. The CPU type field is created as part of the general process described in Populating the CMDB. Some discovery tools fill in the CPU name instead of CPU type. If the CPU type field is empty, the CPU name field is used for mapping instead. (You can configure the form to display the CPU name, if needed.) If the CPU type field and the CPU name field are both empty, no mapping is done.</td>
</tr>
</tbody>
</table>
Preparing for IBM PVU mapping (continued)

<table>
<thead>
<tr>
<th>Configuration Item Form Field</th>
<th>Processor Definition Form Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU count</td>
<td>Number of sockets</td>
<td>Number of sockets.</td>
</tr>
<tr>
<td>CPU core count</td>
<td>Cores per socket</td>
<td>Cores per socket</td>
</tr>
</tbody>
</table>

The key field on the Software Model form is **License type**. For any software licenses you want to track with IBM PVU, open the corresponding software model form and select the **Per installation - IBM PVU** license type.

**PVU software model**

![PVU software model](image)

**Refresh processor definitions for Software Asset Management plugin**

After activating the Software Asset Management plugin IBM PVU Process Pack, use the Refresh Processor Definitions module in the Software Asset Management
plugin feature to create process definitions for existing computers in the Computer [cmdb_ci_computer] table.

Before you begin
Role required: sam

About this task
After this step, business rules in SAM update the Processor Definition [CMDB_processor_definition] table automatically when changes are made to computers or when new computers are added. You should not need to use the Refresh Processor Definitions module a second time, but it is always available if you make significant changes to the Computer [cmdb_ci_computer] table.

Procedure
1. Navigate to Software Asset > System > Refresh Processor Definitions.
2. Click Proceed.

Processor definitions
Processor definitions are automatically derived from the information in the configuration item form for an item such as a computer or server.

To view a processor definition, navigate to Software Asset > Reconciliation > Processor Definitions and click an item.

The following read-only fields are listed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the processor as it should appear in the processor list.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Company that built the processor.</td>
</tr>
</tbody>
</table>
## Processor definitions (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server model number</td>
<td>Number assigned to the model by the server manufacturer.</td>
</tr>
<tr>
<td>Number of sockets</td>
<td>Number of dies on the computer motherboard. The number of CPUs per die is specified by <strong>Cores per socket</strong>.</td>
</tr>
<tr>
<td>IBM PVU Mapping</td>
<td>The IBM PVU mapping to which this processor is associated. The information in this field is automatically calculated from the server model number, number of sockets, processor name, and processor model number, based on the rules defined in the IBM PVU Table.</td>
</tr>
<tr>
<td>Processor name</td>
<td>Name assigned to the processor by the manufacturer.</td>
</tr>
<tr>
<td>Processor model number</td>
<td>Number assigned to the model by the processor manufacturer.</td>
</tr>
<tr>
<td>Cores per socket</td>
<td>Number of cores (functional unit needed to execute programs) on each physical connection (socket) on the motherboard.</td>
</tr>
<tr>
<td>Match level</td>
<td>Accuracy level of the association between processor and PVU mapping. Automatically set when association is inferred.</td>
</tr>
</tbody>
</table>

## View IBM PVU mappings

Every rule listed in the IBM PVU Table is represented by one PVU mapping record in the Software Asset Management plugin feature.

### Before you begin

**Role required:** sam

### About this task

For example, in the IBM PVU Table there is one line with processor name POWER5 QCM and in IBM PVU mappings there is a line representing POWER5 QCM.
PVU mappings list

Procedure
1. Navigate to Software Asset > Reconciliation > IBM PVU Mappings.
2. Click a Short Description for detailed information about the mapping.

The fields are for information only and cannot be edited.

IBM PVU mappings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor names</td>
<td>Names of running processors. Processor names are separated by commas.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Model-based condition</td>
<td>Regular expression used to determine whether the server model number of a computer's processor definition matches that of the PVU entry.</td>
</tr>
<tr>
<td>Socket-based condition</td>
<td>Regular expression used to determine whether the number of sockets of a computer's processor definition matches that of the PVU entry.</td>
</tr>
<tr>
<td>Short description</td>
<td>A short description of this PVU mapping.</td>
</tr>
<tr>
<td>PVUs per core</td>
<td>Number of processor value units consumed (according to the IBM PVU chart) by each core.</td>
</tr>
<tr>
<td>Max cores</td>
<td>Maximum number of cores on the processor family, as shown in the IBM PVU Table (rightmost column under cores per socket).</td>
</tr>
<tr>
<td>Rule publication date</td>
<td>Date published by IBM on the PVU Rules table.</td>
</tr>
</tbody>
</table>

**Use software counters to calculate IBM PVU licenses**

To calculate IBM PVU licenses, you can create a software counter with the IBM PVU license type. For a given PVU software package, you only need to create the counter once and then it can be reused.

**Before you begin**

Role required: sam

**About this task**

Processor definitions are searched as licenses are counted. If a processor definition is found, but no PVU mapping link exists for the processor, the system automatically does the following to obtain a PVU mapping link.

- Pre-filtering based on processor name.
- Advanced filtering based on PVU mapping records' condition field.
- If no exact match is found, the most expensive mapping is used to increase the chance of being compliant.

**Procedure**

1. Navigate to *Software Asset > Reconciliation > Software Counters*.
2. Click *New*. 

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
3. Enter a **Name**.

4. Select a **Software Model**.

5. Select a level of adherence to the license in the **Enforce to** field.

6. For **License type**, select **Per Installation - IBM PVU**.

7. Add information to other fields as necessary.

8. Right-click the header bar and select **Save**.

9. Click **Count licenses**.
10. In the **Software Counter Results** list, drill down to obtain summary and detailed information.

![Software Counter Results](image)

**Installed with Software Asset Management plugin IBM PVU Process Pack**

The following tables, fields, script includes, and business rules are installed with Software Asset Management plugin IBM PVU process pack.

**Tables**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Definition</td>
<td>Each row in this table describes a computer in terms of the attributes IBM uses for its PVU licensing model. A row can be associated with one or more (if they are all identical in terms of the attributes used for PVU licensing) discovered computers.</td>
</tr>
</tbody>
</table>
Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibm_pvu_mapping</td>
<td>Hardware [cmdb_ci_hardware]</td>
<td>PVU rule that applies to the software installation. Used for IBM PVU-based license counting.</td>
</tr>
<tr>
<td>ibm_pvu_mapping</td>
<td>Software Installation [cmdb_sam_sw_install]</td>
<td>PVU rule that applies to the software installation. Used for IBM PVU-based license counting.</td>
</tr>
</tbody>
</table>

Script includes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProcessorDefinitionsUtils</td>
<td>Contains utilities for managing the Processor Definition [cmdb_processor_definition] table.</td>
</tr>
<tr>
<td>ProcessorValueUnitsUtils</td>
<td>Contains logic that determines the IBM PVU pricing associated with a given processor.</td>
</tr>
</tbody>
</table>

Business rules

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>One and only one default mapping [sam_ibm_pvu_mapping]</td>
<td>Ensures only one default mapping by resetting the last resort flag for modified records and setting it to false for new records.</td>
</tr>
</tbody>
</table>

Software contracts

A software contract is a binding agreement between the owner of a software product and a buyer. The contract enables the buyer to use the software legally.

In the base system, you can manage and track software contracts with the Contract Management application. When you create a new software contract, you can specify that the contract is an enterprise or subscription license.
Create software contracts

You can create a binding agreement that enables the buyer to legally use the software.

Before you begin
Role required: contract_manager

Procedure
1. Navigate to Contract > Software License.
2. Click New.
3. Complete the form.
4. Add the software license to the contract.
   Be sure to use the Software License option. The License Bundle and Software License Contracts options are deprecated.

Related information
   Contract Management

Oracle process pack

The Oracle process pack is an add-on to Software Asset Management plugin that provides the ability to manage software licensed under the Oracle licensing model.

Administrators can use this feature to perform the following functions.
• Identify the software packs installed on Oracle database servers.
• See the software packs that are currently in use.
• List which options are installed and in use.

Oracle software counter

There are two distinct ways of counting Oracle software. Be sure that your Oracle models are set up accurately.

Note: Oracle license calculation types are available in the Software Counter form after you activate the Oracle process pack.

Oracle software that uses the Oracle Processor license calculation type counts by the number of processors on a server. This license calculation type must exist in the Software Installation [cmdb_sam_sw_install] table. A software installation record must be inserted with a discovery model that matches the correct
Oracle software. For an install to be counted by an Oracle processor counter, the Installed on field on the Software Installation form should reference a configuration item with a Metric type of Oracle Processor.

Oracle software that uses the Oracle Named User or Oracle Named User Plus license calculation types count by number of unique users or number of unique users plus devices. This license calculation type must exist in the Software Usage [cmdb_sam_sw_usage] table. A software installation record must be inserted with a discovery model that matches the correct Oracle software. For a usage to be counted by an Oracle New User or Oracle New User Plus counter, the Target host field on the Software Usage [cmdb_sam_sw_usage] table should reference a configuration item with a Metric type of Oracle NU or Oracle NUP.

Oracle software models
In order to count Oracle software licenses, you must create software models for your Oracle software.

For more information, see Manage software models.

Request the Software Asset Management plugin Oracle Process Pack

The Software Asset Management plugin - Oracle Process Pack (com.snc.sam.oracle.pp) plugin must be activated by ServiceNow personnel.

Before you begin
Role required: admin

About this task
The Software Asset Management plugin plugin activates all related plugins.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

![Activate Plugin](image)

3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the form, fill in the fields.

**Activate Plugin request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>
Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

**Reason/Comments**

Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.

7. Click **Submit**.

**Related reference**

List of plugins (Rome)

**Installed with the Oracle Process Pack**

Activating the Oracle Process Pack plugin adds certain components.

The information from this table appears in the Software Counter Compliance Violations section of the Software Model form.

**Software counter compliance violations table**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Counter Compliance Violations [sam_sw_counterViolation]</td>
<td>Used to store counter violations that are due to violations other than installs exceeding rights, such as:</td>
</tr>
</tbody>
</table>
### Software counter compliance violations table (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
|       | • Maximum CPU/user count exceeded (based on model limits)  
|       | • Maximum or minimum rights rules not followed (based on model limits)  
|       | • Option installed on a server with a non-option-supporting license (Oracle) |

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software counter [counter]</td>
<td>Software Counter Compliance Violations [sam_sw_counter_violation]</td>
<td>References the software counter that this violation belongs to. (Reference field to Software Counter table [sam_sw_counter].)</td>
</tr>
<tr>
<td>Is an option (is_option)</td>
<td>Software Model [cmdb_software_product_model]</td>
<td>Indicates if the software model is an option or pack for some other software, such as Active Data Guard or Data Mining options for Oracle Enterprise Edition. This field only appears if the manufacturer is Oracle.</td>
</tr>
<tr>
<td>License metric (metric_type)</td>
<td>Software License [alm_license]</td>
<td>A glide list reference to the License Calculation [cmdb_sw_license_calculation] table. This list contains all of the license calculations that apply to this license and identifies the preferred metric types to use when running software counters.</td>
</tr>
</tbody>
</table>
The Oracle Process Pack adds the following license calculation types.

### Oracle license calculation types

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Named User</td>
<td>Oracle licensing scheme that counts by the number of unique users.</td>
</tr>
<tr>
<td>Oracle Named User Plus</td>
<td>Oracle licensing scheme that counts by the number of unique users and devices.</td>
</tr>
<tr>
<td>Oracle Processor</td>
<td>Oracle licensing scheme that counts by the number of processors on a server.</td>
</tr>
</tbody>
</table>

### Create an Oracle software license

To use the Oracle process pack, you must create an Oracle software license.

**Before you begin**

Role required: sam

**Procedure**

1. Navigate to **Software Asset > Software Licenses**.
2. Click **New**.
3. Select **Software License** in the **Model category** field.
4. Select an Oracle model in the **Model** field.
The Oracle models in this list are created by the user. For more information, see Manage software models.

5. Ensure that the License metric field specifies the correct license calculation type.

6. Fill in the remaining fields, as appropriate.

7. Click Submit.

Validate the requirements to associate a software installation to Oracle mapping

Meeting recommended requirements ensures that you receive the highest quality results with Oracle mapping.

Procedure

1. Use a discovery tool (such as ServiceNow Discovery) to identify software installations. Check that the added CPU information is correct.

2. Activate the Software Asset Management plugin - Oracle Process Pack plugin. This also activates the Software Asset Management plugin if it is not already active.

3. Refresh processor definitions by navigating to Software Asset > System and clicking Refresh Processor Definitions.

4. Ensure that the software models you want to manage with Oracle licensing are set up accurately. See Creating a software model.

5. Create a software license for your Oracle software. Ensure that the license is given the correct license metric. The License metric (metric_type) field on the Software License table is a reference field to the License Calculation table.

6. Create a software counter to calculate Oracle licenses with the matching license type.

7. Count licenses to determine compliance with Oracle guidelines.

Run the Oracle software counter

Running the Oracle software counter is a requirement to associate a software installation to Oracle mapping.

Before you begin
Role required: sam
Procedure
1. Navigate to Software Asset > Reconciliation > Software Counters.
2. Click the name of the counter.
3. Click Count Licenses.
   You can view different types of software counter results.

Software Asset Management Foundation plugin
The Software Asset Management Foundation plugin activates the ITSM Software Asset Management feature provided with the Asset Management application.

For documentation on the full fledged Software Asset Management product (also known as Software Asset Management professional), see Software Asset Management.

Software Asset Management Foundation plugin systematically tracks, evaluates, and manages software licenses and compliance. Functionality consists of these main features.

<table>
<thead>
<tr>
<th>Feature area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard</td>
<td>The Software Asset Management Foundation dashboard shows software installation results for your environment in the form of statistics and charts.</td>
</tr>
<tr>
<td>Licensing</td>
<td>Software models created for all installed software products are used to tie software installations (software being used) with entitlements (software owned). Entitlements define license details and are assigned to software models.</td>
</tr>
<tr>
<td>Discovery and normalization</td>
<td>A discovery process, such as ServiceNow Discovery or Microsoft SCCM, can be used to discover the software installed in your environment.</td>
</tr>
<tr>
<td></td>
<td>An Out Of the Box (OOB) Normalization library contains publisher and product content. Custom products can be created if a software product does not exist in the Software Library. Discovered software can be manually normalized for reconciliation.</td>
</tr>
<tr>
<td>Reconciliation</td>
<td>The reconciliation process calculates the compliance status of software products.</td>
</tr>
</tbody>
</table>
## Exploring Software Asset Management Foundation plugin

Starting with the Rome release, we have enhanced the Software Asset Management Foundation plugin application’s user interface to make it more user-friendly and intuitive, allowing you to better manage your software installations.

You can use the new Software Asset Management Foundation plugin user interface, referred to as Software Asset Workspace or continue using the classic Software Asset Management Foundation plugin framework.

The Software Asset Management Foundation plugin application’s core functionality remains the same in both the user interfaces.

### Using the Software Asset Workspace

Once you request and activate the Software Asset Management Foundation plugin (com.snc.software_asset_management) plugin, you need to activate the Software Asset Workspace (com.sn_sam_workspace) plugin too.

**Note:** Once you activate the workspace plugin, you cannot revert to the classic Software Asset Management Foundation plugin application.

For detailed information on configuring and using the Software Asset workspace, refer to Configuring Software Asset Management Foundation plugin workspace and Using Software Asset Management Foundation plugin workspace.

### Using the classic Software Asset Management Foundation plugin application

To continue using the classic Software Asset Management Foundation plugin application, just activate the Software Asset Management Foundation plugin (com.snc.software_asset_management) plugin.

If you later decide to use the Software Asset Workspace, you need to activate the Software Asset Workspace (com.sn_sam_workspace) plugin.

For detailed information on configuring and using the classic Software Asset Management Foundation plugin application, refer to Configuring Software Asset Management Foundation plugin classic and Using Software Asset Management Foundation plugin classic.
Software Asset Management Foundation plugin roles

Software Asset Management Foundation plugin adds the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sam_admin</td>
<td>Inherits the sam_user role and has permission to run reconciliation and manage reclamation rules.</td>
</tr>
<tr>
<td>sam_user</td>
<td>Able to access all features except administrative.</td>
</tr>
</tbody>
</table>

Users with the sam_user or sam_admin role can view and refresh the overview page.

Software Asset Management Foundation plugin software discovery and normalization

ServiceNow Discovery is used to automatically populate the Software Installations table so the software can be manually normalized and reconciled.

The discovery process consists of automatically discovering software used at your organization, which can be done either using ServiceNow Discovery, or using SCCM integration.

For more information, see Collect software data with either SCCM or Discovery and Discovery with Software Asset Management.

Note: To use Discovery, the Discovery plugin must be activated.

Discovery uses patterns in the discovery process that can be created or customized. The base system contains a wide range of patterns that cover most industry standard network devices and applications. Software Asset Management Foundation plugin automatically leverages SQL Server, Exchange Server, and Oracle Database Server specifically, but other patterns can be customized for use by Software Asset Management Foundation plugin, if needed.

Discovered software is stored in the Software Installations [cmdb_sam_sw_install] table.
**Note:** If you are already running Discovery but have not used a version of ITSM Software Asset Management previously, run the Migrate Software Asset Management Foundation plugin software installations script to copy records from the [cmdb_ci_spkg] table to the [cmdb_sam_sw_install] table, so that any previously discovered software installs are utilized by Software Asset Management Foundation plugin.

When software install records are written to the Software Installations table, a business rule verifies whether the unique combination of the discovered publisher, discovered product, and discovered version already exist in the Discovery Model table.

- If so, the reference to the discovery model is set in the Software Installations table.
- If not, a new record is created in the Discovery Model table, and that discovery model reference is set in the Software Installations table.

After discovery, you can manually normalize the software discovery model for reconciliation. Normalization status can have two different results:

### Normalization status

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manually Normalized</td>
<td>A discovery model is manually normalized when key fields in the discovery model are filled in manually.</td>
</tr>
<tr>
<td>New</td>
<td>The software discovery model has not yet been manually normalized.</td>
</tr>
</tbody>
</table>

**Software Asset Management Foundation plugin discovery models and software installations**

Software discovery models are automatically created during discovery so you can manually normalize the software installed in your environment.

Software discovery models are stored in the Software Discovery Model [cmdb_sam_sw_discovery_model] table.

There is a difference between software models and software discovery models.

- A software model is a specific version or configuration of software that is purchased and/or available to users.
- A software discovery model is a model created when a version of software is discovered in a network environment.
Multiple software discovery models can be associated to one software model. For example, a software model can be defined as follows:

- Publisher = X
- Product = Y
- Version = Starts with 10

If there are two separate installs of this product (version 10.1 and version 10.2), two discovery models are created. One of the discovery models has the discovered version set to 10.1, and the other discovery model has the discovered version set to 10.2. The reconciliation process associates both of these discovery models to the same software model since they both meet the version criterion of *Starts with 10*.

**Discovery Models**

Software discovery models cannot be created manually. The following field combination, called the primary key, is used to match new software installations to a new or existing software discovery model.

Primary key: **Publisher, Display Name, and Version**

⚠️ **Note:** When analyzing version numbers, an exact match is always searched for first, but rounds down to a major version number when an exact match is not found.

For example, if no match is found for version number 8.0.4, but version 8.0 is found, then version 8.0 is used in the Software model field.

**Discovery Models form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the discovery model as it appears in record lists. This value is generated automatically using the discovered publisher, discovered product, and discovered version.</td>
</tr>
<tr>
<td>Normalization status</td>
<td>Status of the normalization process:</td>
</tr>
<tr>
<td></td>
<td>• Manually Normalized</td>
</tr>
<tr>
<td></td>
<td>• New</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software.</td>
</tr>
<tr>
<td>Product</td>
<td>Product name of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software product.</td>
</tr>
</tbody>
</table>
## Discovery Models form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discovered publisher</td>
<td>Discovered publisher of the software.</td>
</tr>
<tr>
<td>Discovered product</td>
<td>Discovered name of the software.</td>
</tr>
<tr>
<td>Discovered version</td>
<td>Discovered version of the software.</td>
</tr>
</tbody>
</table>

### Additional Information

#### Product type

- **Child**: A subcomponent of main software (not licensable).
- **Driver**: A software product that controls a device.
- **Licensable**: A software product that is licensable.
- **Not Licensable**: A software product that is not licensable.
- **Patch**: A software product designed to update, fix, or improve an existing computer program.
- **Unknown**: Not discovered.

For unknown product types, the product type can be changed to another value.

When the product type is changed, the normalization status of the discovery model is updated to Manually Normalized.

The reconciliation process only considers software discovery models that are licensable.

#### Platform

- **Windows**
- **Mac**
- **Unix**

#### Language

- **Dutch**
- **English**
- **French**
- **German**
### Discovery Models form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Italian</td>
<td>Additional languages are generated if discovered.</td>
</tr>
<tr>
<td>Spanish</td>
<td></td>
</tr>
</tbody>
</table>

**Edition**
Edition of the software.

**Full version**
Full version of the software.

ℹ️ **Note:** If a normalized discovery model has a missing version, edition, language, or platform value, those field values can be set by the user. Once a new value is set, the normalization status changes from New to Manually Normalized.

### Software Installations

The Software Installations list contains the software installed in your organization and is automatically populated by discovery.

Installed software is placed in the Software Installation [cmdb_sam_sw_install] table by Discovery, and a primary key is built (using Publisher, Display Name, and Version fields).

Discovery automatically matches the discovered software installation with a new or existing software discovery model using the primary key.

### Software Installations form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name.</td>
<td>Name of the software installation as it appears in the record lists. Can be a combination of the discovered product name and edition.</td>
</tr>
<tr>
<td>Discovery model</td>
<td>Software discovery model that represents the installed software.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software.</td>
</tr>
<tr>
<td>Edition Override</td>
<td>Override of the software edition setting.</td>
</tr>
</tbody>
</table>
Software Installations form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If the edition for the software was not discovered, you can edit this field to set the edition, if known, so reconciliation can be performed successfully. For more information, see <a href="#">Manually override SAM Foundation edition value in classic</a>.</td>
</tr>
<tr>
<td>Installation</td>
<td></td>
</tr>
<tr>
<td>Prod id</td>
<td>Unique ID for the product assigned by the manufacturer. Found through discovery.</td>
</tr>
<tr>
<td>Install location</td>
<td>Path under which the software is installed.</td>
</tr>
<tr>
<td>Install date</td>
<td>Date that the software was installed.</td>
</tr>
<tr>
<td>Revision</td>
<td>Revision of the software.</td>
</tr>
<tr>
<td>Instance key</td>
<td>Unique ID for the instantiation of the software. Automatically generated when the software is installed.</td>
</tr>
<tr>
<td>Installed on</td>
<td>Hardware on which the software is installed.</td>
</tr>
<tr>
<td>Uninstall string</td>
<td>Identifier used to uninstall the software.</td>
</tr>
<tr>
<td>ISO serial number</td>
<td>ISO number of the software.</td>
</tr>
<tr>
<td>Reconciliation</td>
<td></td>
</tr>
<tr>
<td>Entitlement</td>
<td>The entitlement found to use with this installation.</td>
</tr>
<tr>
<td>Inferred suite</td>
<td>The inferred suite model this installation belongs to.</td>
</tr>
<tr>
<td>Omit from suites</td>
<td>Check box for not counting the software install as a component of a suite during reconciliation.</td>
</tr>
</tbody>
</table>
Software Asset Management Foundation plugin software reconciliation for compliance

Automated license reconciliation keeps license positions accurate and up to date without manual calculations. Reconciliation runs weekly or on demand. Reconciliation is a scheduled job that is run at a specified frequency (default is weekly). It can also be run on demand for specific or all publishers.

When reconciliation is run, a list of reconciliation results is created that shows the compliance status of software products with respect to discovery and entitlements. Users with the sam_user role can view reconciliation results.

Remediation options include rights not in use, rights not allocated, rights needed, reclaimable rights, and unlicensed rights.

Setting up Software Asset Management Foundation plugin

Set up Software Asset Management Foundation plugin before configuration.

Before you begin
Role required: sam_admin

About this task
Once you have requested Software Asset Management Foundation plugin and it has been activated from ServiceNow personnel, complete these steps to set up Software Asset Management Foundation plugin before you begin to use it.

Procedure

1. Determine whether you are currently running the ITSM Software Asset Management feature of Asset Management using the Software Asset Management plugin.
   Check the list of plugins to see if the Software Asset Management (com.snc.software_asset_management) plugin is active.
   • If so, complete the Software Asset Management Foundation plugin migration procedure.
     This step automatically converts and adds new tables, forms and lists, fields and values, and disables deprecated functionality. It also contains manual procedures for you to complete for successful migration.
   • If not, proceed to the next step.

2. Determine whether Discovery is activated.
   Check the list of plugins to see if the Discovery plugin is active.
• If so, run the Migrate Software Asset Management Foundation plugin software installations script.

This step copies records from the [cmdb_ci_spkg] table to the [cmdb_sam_sw_install] table, so that any previously discovered software installs are utilized by the Software Asset Management Foundation plugin.

• If not, activate and configure Discovery.

For more information, see Discovery.

3. Proceed to Get started with Software Asset Management Foundation plugin to begin using the Software Asset Management Foundation plugin in your environment.

Request Software Asset Management Foundation plugin

The Software Asset Management Foundation (com.snc.sams) plugin must be activated by ServiceNow personnel. This plugin includes demo data.

Before you begin
Role required: admin

About this task
There are two ways to request a plugin:

• Access the Now Support Service Catalog directly by clicking Service Catalog > Activate Plugin on Now Support.

• Access the Now Support Service Catalog through the All Applications page on your instance by following these steps.

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.
5. Select Actions > Activate Plugin.
6. On the form, fill in the fields.

### Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
|  | Note: Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.
| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.

7. Click Submit.

Manage a SAM Foundation software suite

Create a suite and add the corresponding components to the suite so the rights that your organization owns are counted accurately during reconciliation.

A software suite is a group of related software offered as one unit. An example is the Microsoft Office Professional suite of office productivity software tools that includes PowerPoint, Word, Excel, Outlook, and Access.

For any software model, you have the option to specify whether the model is a suite (parent) or a component (child). A software model can be a component in multiple suites. For example, Microsoft Word is a component in Microsoft Office Standard and Microsoft Office Professional. Although you can set a single software model as both a suite and a component, software is not typically sold as nested suites.

Use the Inference percent and Mandatory fields when the suite parent is not defined in the install table.

- **Inference percent**: Specifies what percentage of the components in the suite must be installed for the software to be identified as a suite.

- **Mandatory**: Enforces whether a specific component in a suite must be installed to infer that the suite is installed. Choices are: Optional, Always Mandatory, Mandatory Group.
For example, say you specify the Inference percent as 80% and set the Mandatory field to Always Mandatory on Microsoft Access. These settings specify that Microsoft Access must be installed, along with three out of four other products (Microsoft Word, Microsoft Excel, Microsoft PowerPoint, and Microsoft Outlook) to infer that Microsoft Office Professional is installed on a device.

When a suite parent is detected during reconciliation, the suite components do not count for the individual license.

ℹ️ Note: Users with the model_manager role can navigate to Product Catalog > Product Model > Software Models, but cannot administer all aspects of software models.

Customize a Discovery pattern for Software Asset Management Foundation plugin

Software Asset Management Foundation plugin automatically leverages SQL Server, Exchange, and Oracle Database Discovery patterns, but you can perform steps for Software Asset Management Foundation plugin to utilize additional Discovery patterns, if needed.

Before you begin
Role required: sam_admin

About this task
Discovery uses a series of scripts and operations (probes, sensors, and patterns) with the base system to collect data, process it, and update the CMDB. Although Software Asset Management Foundation plugin is already set up to utilize three common patterns (SQL Server, Exchange, and Oracle Database), you can perform a configuration procedure to include additional patterns.

This customization automatically copies the records from the discovered pattern to the Software Installation [cmdb_sam_sw_install] table so Software Asset Management Foundation plugin can utilize this data for reconciliation.

For more information on pattern customization, see Pattern customization.

Procedure

1. Configure a post processing step in the discovery pattern.

   a. Navigate to Pattern Designer > Discovery Patterns.

   b. Open the pattern record from which you would like to collect data for Software Asset Management (for example, the discovery pattern for MySQL).
c. Select and copy the **Class Name** field value. You will need to paste this class name value into a record field in the Software Installation Name Mapping `[cmdb_sam_sw_name_mapping]` table as part of this configuration procedure.

d. Click the **Pre/Post Processing** related link.

e. In the Sync Installed Software section, select the desired software from the list to add it (for example, MySQL). Data discovered relating to the software you select is automatically copied into the Software Installation `[cmdb_sam_sw_install]` table as part of the discovery process.

f. Click **Update**.

2. Add the pattern data to a new record in the Software Installation Name Mapping `[cmdb_sam_sw_name_mapping]` table.

   a. Create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class name</td>
<td>Class name of the discovery pattern. Paste the value that you copied from the class field in discovery pattern.</td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the product (for example, Oracle).</td>
</tr>
<tr>
<td>Product</td>
<td>Product name (for example, MySQL).</td>
</tr>
</tbody>
</table>

b. Click **Submit**.

When discovery is run, the records for the software product relating to the customized discovery pattern are utilized by Software Asset Management. No further configuration is needed unless you know the software product consists of an edition that is not being discovered automatically.
What to do next
If the software product has an edition that is not being discovered, Manually override SAM Foundation edition value in classic so the software can be successfully reconciled.

Get started with Software Asset Management Foundation plugin
Get started with Software Asset Management Foundation plugin to optimize management of software installations in your environment.

Before you begin
Role required: sam_admin

About this task
After you have Setting up Software Asset Management Foundation plugin, get started by completing these steps for basic configuration.

Procedure
1. Create a software model for common software, such as Microsoft Office 2013.
2. Create a basic per-user or per-device entitlement for the software.
3. After discovery of software installed, run reconciliation to reconcile software rights owned against software installed, with respect to discovery and software entitlements.
4. View reconciliation results that show the compliance status of your software products.

What to do next
Depending on the compliance status of your software installations, you can choose to optimize your environment further.

Configuring Software Asset Management Foundation plugin workspace
Once you have finished setting up the Software Asset Management Foundation plugin application, you need to configure the Software Asset Workspace.

If you have multiple entitlements, you can import them at one go using a Microsoft Excel spreadsheet template.

If software models haven’t automatically been created, you need to manually create software models. For information on creating software models, see Create a Software Asset Management Foundation software model in workspace
Import Software Asset Management Foundation entitlements

You can import multiple entitlements at one go in the Software Asset Workspace.

About this task
The entitlement import records are stored in the Entitlement import [samp_bulk_import] table. You can leverage the Activity center in the Software asset overview landing page to view import errors and the import status.

Role required: admin

Procedure

1. Navigate to Software asset > Software Asset Workspace.
2. Click Export.
   Export dialog box appears.
3. Select Excel from the File Type list and download a alm_license (.xlsx) spreadsheet template.
   You can add software entitlement fields to the template to include additional fields in your import. Add each field as a new column in the template. The column name must match the field label exactly. You can include base system software entitlement fields as well as your custom software entitlement fields.
4. Click Create entitlement.
   Create new entitlement dialog box appears.
5. Select Import multiple entitlements from an Excel file.
6. Enter the entitlement details in the template and click Attach File to upload the spreadsheet.
   Once the file is uploaded, the name of the file appears and the Description field is automatically populated. You can change the description to make it more specific.
7. Click Import. A confirmation message appears informing you that the import of entitlements is in progress.
   Once you attach and import a spreadsheet, an import record is created that retains the history of the upload for you to view later.
8. Open the entitlement import record to check for any errors.
9. If any errors occur, click Review import errors to open the Entitlement import error list view.
   Only records whose error status is Needs review are listed by default.
10. You can check the status of the import record using either of the two ways:
• Click **Status** on the confirmation message to take you to the License operations view. All the entitlement import records appear in the License operations view.

• Click the import error notification in the Activity center in Software asset overview to open the import record. The import errors list view appears filtered by the **Needs review** error status.

11. Click the **Entitlements** tab to view the list of entitlements that got successfully created.

**Create a Software Asset Management Foundation entitlement in workspace**

Create entitlements in the Software Asset Workspace to enter your license details and allocate purchased software rights to users or devices.

**About this task**

These instructions are for using the standard form for creating software entitlements one at a time. If you already have software entitlement details entered in a spreadsheet, you can also Import them using the bulk import functionality.

When you start creating the entitlement it is in the build status. Once you publish the entitlement, the status changes to in use and makes the entitlement eligible to be included in the reconciliation process.

sam_admin or sam_user

**Procedure**

1. Navigate to **Software asset > Software Asset Workspace.**

2. Click **New** to open the Create new entitlement dialog box.

3. Select **Fill out the details in a standard form** and then click **Next**.

4. In the Create New Software Entitlement page, fill in the fields.

   For a detailed description of the fields, see **Create a Software Asset Management Foundation plugin entitlement in classic.**

**Create a Software Asset Management Foundation software model in workspace**

Create a software model in the Software Asset Workspace to add product details that are used to connect software rights you purchased with software installations discovered on your system.

**Before you begin**

Role required: sam_user, sam_admin, or model_manager
Procedure

1. Navigate to Software asset > Software Asset Workspace.
2. Click License operations view on the left hand bar.
3. Under Licensing, click software models.
4. Click New.
5. On the form, fill in the fields.

**Software Model form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>[Read-only] Name of the model. The system property glide.cmdb_model.display_name.shorten controls how software model display names are generated. System administrators can configure this property. Default format is publisher + product + version + edition.</td>
</tr>
</tbody>
</table>
| Publisher     | Publisher of the software. You can use the lookup list provided.  
|               | **Note:** Publisher is a reference to the company [core_company]. Only companies you are using internally are shown.  
<p>|               | If the publisher and product do not exist, you can Add a Software Asset Management Foundation plugin custom license metric. |
| Product       | Software product name. The same lookup list provided on the Software Discovery Models form.                                                   |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> If the relationship between the software publisher [samp_sw_publisher] and company [core_company] is not correct, products for that publisher may not be shown.</td>
<td></td>
</tr>
<tr>
<td>Product classification</td>
<td>The official UNSPSC classification of the product.</td>
</tr>
<tr>
<td>Product type</td>
<td>• Child: A subcomponent of main software (not licensable).</td>
</tr>
<tr>
<td></td>
<td>• Driver: A software product that controls a device.</td>
</tr>
<tr>
<td></td>
<td>• Licensable: A software product that is licensable.</td>
</tr>
<tr>
<td></td>
<td>• Not Licensable: A software product that is not licensable.</td>
</tr>
<tr>
<td></td>
<td>• Patch: A software product designed to update, fix, or improve an existing computer program.</td>
</tr>
<tr>
<td></td>
<td>• Unknown: Not discovered.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the model.</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost of a single unit of the software.</td>
</tr>
<tr>
<td>Next version</td>
<td>Reference to another software model of the same manufacturer which represents the next version of the product.</td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the model. Options are <strong>In Production</strong>, <strong>Retired</strong>, and <strong>Sold</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Certified</td>
<td>Check box for indicating the software model has been approved for use.</td>
</tr>
<tr>
<td>Discovery Mapping</td>
<td></td>
</tr>
<tr>
<td>Version condition</td>
<td>Condition qualifier for the <strong>Version</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• starts with</td>
</tr>
<tr>
<td></td>
<td>• is</td>
</tr>
<tr>
<td></td>
<td>• is anything</td>
</tr>
<tr>
<td></td>
<td>Default is <strong>is anything</strong>.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software product.</td>
</tr>
<tr>
<td></td>
<td>Required if version condition value is <strong>starts with</strong> or <strong>is</strong>.</td>
</tr>
<tr>
<td>Edition condition</td>
<td>Condition qualifier for the <strong>Edition</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• starts with</td>
</tr>
<tr>
<td></td>
<td>• is</td>
</tr>
<tr>
<td></td>
<td>• is anything</td>
</tr>
<tr>
<td></td>
<td>Default is <strong>is anything</strong>.</td>
</tr>
<tr>
<td>Edition</td>
<td>Edition of the software product to use when searching for the normalized</td>
</tr>
<tr>
<td></td>
<td>discovery model.</td>
</tr>
<tr>
<td></td>
<td>Required if edition condition value is <strong>starts with</strong> or <strong>is</strong>.</td>
</tr>
<tr>
<td>Platform</td>
<td>Platform of the software product to use when searching for the normalized</td>
</tr>
<tr>
<td></td>
<td>discovery model.</td>
</tr>
<tr>
<td></td>
<td>Default is <strong>--Anything--</strong> for Windows, Mac, Unix.</td>
</tr>
<tr>
<td>Language</td>
<td>Language of the software product to use when searching for the normalized</td>
</tr>
<tr>
<td></td>
<td>discovery model, which is populated once it has been normalized or added</td>
</tr>
<tr>
<td></td>
<td>manually.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default is --Anything--.</td>
<td></td>
</tr>
<tr>
<td>Software installation condition</td>
<td>Only software installations that meet this software discovery map condition are counted during reconciliation. If needed, specify a subset of software installations that should be counted during reconciliation.</td>
</tr>
<tr>
<td>Product Catalog</td>
<td></td>
</tr>
<tr>
<td>Catalog Item</td>
<td>The information about the model as it appears in the product catalog and service catalog. Information only appears if the model has been published to the product catalog.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the software model as it appears in the product catalog.</td>
</tr>
<tr>
<td>Picture</td>
<td>An image of the software logo can be added. This logo appears in the Service Catalog if the software model is published.</td>
</tr>
</tbody>
</table>

The Suite Components and Suite Parents related lists consist of parent and child configuration.

⚠ **Note:** If you've added a discovery map to your product details, predefined suites are used and suite components are created automatically for known suite parent.

6. To publish the software model to the product catalog, under Related Links, click Publish to Software Catalog and select a category for the software model. The values set in the Product Catalog related list are published.

7. To show the list of discovery models that match the software publisher and product fields of the software model, under Related Links, click Show Matching Discovery Models. The Discovery Models list is opened in a new browser tab for your reference.
8. To perform additional configuration, select the new software model record in the Software Models list.

a. In the Software Model Lifecycles related list, create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>[Read-only] Name of software model.</td>
</tr>
</tbody>
</table>
| Lifecycle type      | • Internal
                     • Publisher                                                                   |
| Lifecycle phase     | • Pre Release
                     • General Availability
                     Date the software became generally available to the market.
                     • Upgrade
                     Only shown when the **Lifecycle type** field is Internal.
                     • End of Life
                     Date the software was no longer supported by the publisher.
                     • End of Support
                     • End of Extended Support                                                   |
| Source              | [Read-only] Internal (for new records created manually), or ServiceNow (when created automatically). |
| Description         | Description of the software model lifecycle.                                 |
| Phase start date    | Date the lifecycle phase starts.                                             |
| Phase end date      | Date the lifecycle phase ends.                                               |
| Risk                | • Very High
                     • High                                                                      |
b. Create a Software Asset Management Foundation plugin entitlement in classic.

c. View Software Asset Management Foundation plugin software model results in classic. The latest software model results are shown in the Software Model Results related list.

d. In the Metric Attributes related list, click a metric attribute to set the attribute value field (see table for field descriptions). The Metric Attributes related list contains metric values set in Create a Software Asset Management Foundation plugin entitlement in classic and is used for reconciliation (metric group, license metric, and software model combination).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>Software model associated with the metric attributes.</td>
</tr>
<tr>
<td>Metric group</td>
<td>Grouping for the software metric (Common).</td>
</tr>
<tr>
<td>License metric</td>
<td>The license metric that the software license is counted against when reconciliation is run (per user, per device, for example).</td>
</tr>
<tr>
<td>Description</td>
<td>Attribute type description that is based on license metric value.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Attribute type for reconciling entitlements license metric.</td>
</tr>
<tr>
<td></td>
<td>• Maximum active OSEs per server</td>
</tr>
<tr>
<td></td>
<td>• Maximum installs per OSE</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Maximum installs per right: For Per User, Per Device, Per Named User, and Per Named Device.</td>
<td></td>
</tr>
<tr>
<td>• Maximum processors per right</td>
<td></td>
</tr>
<tr>
<td>• Minimum users per processor</td>
<td></td>
</tr>
<tr>
<td>• Minimum cores per processor</td>
<td></td>
</tr>
<tr>
<td>• Minimum cores per server</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Attribute value</th>
<th>Value of the attribute (integer).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute value is unlimited</td>
<td>Check box for setting the attribute as unlimited.</td>
</tr>
</tbody>
</table>

e. Create a vendor catalog item.

**Configuring Software Asset Management Foundation plugin classic**

Configure Software Asset Management Foundation plugin if you prefer to continue using the classic version.

**Create a Software Asset Management Foundation plugin entitlement in classic**

Software entitlements enable you to define license details that are matched to software models.

**Before you begin**

Role required: sam_user

**About this task**

Software entitlements are stored in the Software Entitlement [alm_license] table.

**Note:** Entitlements are assigned to Create a Software Asset Management Foundation plugin software model in classic, which are different than software discovery models.
Procedure

1. Navigate to **Software Asset > Licensing > Software Entitlements** and create a new record (see table for field descriptions).

## Software Entitlement form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Automatically generated name based on asset tag and model.</td>
</tr>
<tr>
<td>Asset tag</td>
<td>Specify the serial number and the bar code for tracking the asset.</td>
</tr>
<tr>
<td>Software model</td>
<td>Select the software model to match the entitlement.</td>
</tr>
<tr>
<td>License type</td>
<td>Specify the license type. Whether the rights grant full access to the software or if they are being upgraded from a previous version of the software.</td>
</tr>
<tr>
<td></td>
<td>- Full: The rights grant full access to the software.</td>
</tr>
<tr>
<td></td>
<td>- Upgrade: The rights are being upgraded from a previous version of the software.</td>
</tr>
<tr>
<td></td>
<td>When upgrade is selected, the Upgraded Entitlements related list is shown, which is used to specify the entitlements you are upgrading from.</td>
</tr>
<tr>
<td></td>
<td>This field becomes read-only after the form has been submitted.</td>
</tr>
<tr>
<td>License duration</td>
<td>Length of time the license is valid. Default value is Perpetual.</td>
</tr>
<tr>
<td></td>
<td>- Perpetual: Duration is continuous.</td>
</tr>
<tr>
<td></td>
<td>- Subscription: Duration is for a specified length of time.</td>
</tr>
<tr>
<td></td>
<td>Duration dates:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>◦ Start date: Required.</td>
</tr>
<tr>
<td></td>
<td>◦ End date: If empty, subscription does not expire.</td>
</tr>
<tr>
<td></td>
<td>State is automatically set to In Use when current date is between start and end dates.</td>
</tr>
<tr>
<td></td>
<td>State is automatically set to Retired when current date is past the end date and active rights is 0.</td>
</tr>
<tr>
<td></td>
<td>State is automatically set to On Order when the start date is in the future and active rights is 0.</td>
</tr>
<tr>
<td>Metric group</td>
<td>Select the metric group for the software. Each metric group has a set of license metrics that are specific to the publisher.</td>
</tr>
<tr>
<td></td>
<td>• Common</td>
</tr>
<tr>
<td></td>
<td>• Custom</td>
</tr>
<tr>
<td>License metric</td>
<td>Select the license metric for the license group that the software license is counted against when reconciliation is run.</td>
</tr>
<tr>
<td></td>
<td>Point to the reference field icon to view the license calculation.</td>
</tr>
<tr>
<td></td>
<td>• Common:</td>
</tr>
<tr>
<td></td>
<td>◦ Per Device: Licenses a device for a number of installations of software.</td>
</tr>
<tr>
<td></td>
<td>◦ Per Named Device: Licenses a specific device for a number of installations of software.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>◦ Per Named User:</td>
<td>Licenses a specific user for a number of installations of software.</td>
</tr>
<tr>
<td>◦ Per User:</td>
<td>Licenses a user for a number of installations of software.</td>
</tr>
<tr>
<td>◦ Custom:</td>
<td>Custom license metrics configured, if any.</td>
</tr>
<tr>
<td>Agreement type</td>
<td>Select the agreement type.</td>
</tr>
<tr>
<td>◦ Generic</td>
<td></td>
</tr>
<tr>
<td>◦ Enterprise Level Agreement (ELA)</td>
<td></td>
</tr>
<tr>
<td>Purchased rights</td>
<td>Specify the number of rights that you are purchasing.</td>
</tr>
<tr>
<td></td>
<td>The number of purchased rights for the new entitlement gets set in the Active rights field.</td>
</tr>
<tr>
<td>Active rights</td>
<td>[Read-only] Specifies the number of entitlements to be granted for this license.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If an enterprise contract is attached to the license, the Active rights field is not shown.</td>
</tr>
<tr>
<td>Allocations available</td>
<td>[Read-only] Specifies the number of user or device allocations that have not been created for an entitlement.</td>
</tr>
<tr>
<td></td>
<td>Allocations available = (number of active rights) - (sum of all allocation quantities)</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Serial number</td>
<td>Unique number assigned for identification of the asset.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Owned by</td>
<td>User or department with financial ownership of the asset. Can be different than the manager.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the asset. Values include On order, In stock, In transit, In use, Consumed, In maintenance, Retired, and Missing.</td>
</tr>
<tr>
<td></td>
<td>If the state is Retired, the <strong>Active rights</strong> field is set to 0.</td>
</tr>
<tr>
<td>Substate</td>
<td>More details about the software license stage. The available substate settings depend on the <strong>State</strong> selected.</td>
</tr>
<tr>
<td></td>
<td>For example, if you select the <strong>Retired</strong> state, the substate options available are <strong>Disposed</strong>, <strong>Sold</strong>, <strong>Donated</strong>, and <strong>Vendor credit</strong>.</td>
</tr>
<tr>
<td>Company</td>
<td>Company to which this asset belongs.</td>
</tr>
<tr>
<td>Location</td>
<td>Where the license is used. For example, a specific site, country, or region.</td>
</tr>
<tr>
<td>Department</td>
<td>Department of the person <strong>Assigned to</strong> this software license.</td>
</tr>
<tr>
<td>Financial</td>
<td></td>
</tr>
<tr>
<td>Cost</td>
<td>Cost of the software.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Required for total cost and savings calculations on the <strong>Software Asset Management Foundation dashboard</strong>.</td>
</tr>
<tr>
<td></td>
<td>For additional field descriptions, see <strong>Create assets</strong> in Asset Management.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Entitlement</td>
<td>The entitlement from which rights are upgrading. Multiple upgrade entitlements are supported. You can upgrade previously owned rights for a particular version of software to a newer version (for example, Office Professional Plus 2013 to Office Professional Plus 2016).</td>
</tr>
<tr>
<td>Number of rights</td>
<td>Number of rights to upgrade.</td>
</tr>
</tbody>
</table>

The Contracts related list contains contract details.

The User or Device Allocations related list contains entitlement allocations.

Note: This related list is only shown when the License Metric field is Per User or Per Device.

The Activities related list contains work notes for the asset.

2. To perform additional configuration, select the new software entitlement record in the Software Entitlements list.

a. To set upgrade and downgrade entitlements, in the Downgrades/Upgrades related list, create a new record to specify which software models to which you have upgrade or downgrade rights (see table for field descriptions). This allows you to set entitlement to previous or future versions of software (for example, the purchase of Office Professional Plus 2016 rights entitles you to Office Professional Plus 2013 as well).
### Downgrades/Upgrades form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software entitlement</td>
<td>Software entitlement with which the upgrade/downgrade is associated.</td>
</tr>
<tr>
<td>Software model</td>
<td>Software model of the entitlement.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of the upgrade/downgrade.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date of the upgrade/downgrade.</td>
</tr>
<tr>
<td>End date</td>
<td>End date of the upgrade/downgrade.</td>
</tr>
</tbody>
</table>

b. To set up cost-tracking details, configure Expense Lines.

c. To manage license keys, in the License Keys related list, create a new record to specify the licenses keys allocated to entitlements (see table for field descriptions).

### License Key form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is allocated</td>
<td>Check box indicating that the license key has been allocated.</td>
</tr>
<tr>
<td>License key</td>
<td>License key value. Must be unique per entitlement.</td>
</tr>
<tr>
<td>Software entitlement</td>
<td>Software entitlement associated with the license key.</td>
</tr>
</tbody>
</table>

Create a Software Asset Management Foundation plugin entitlement allocation in classic

A user or device allocation can be added to a software entitlement to specify a user or device to which rights have been allocated.

**Before you begin**
Role required: sam_user
About this task

User allocations are stored in the User Allocations [alm_entitlement_user] table. Device allocations are stored in the Device Allocations [alm_entitlement_asset] table.

Note: The total of all allocation quantities cannot exceed the total number of rights for the entitlement.

Procedure

1. Navigate to Software Asset > Licensing > Software Entitlements and open the software entitlement record to add allocations to.

2. Click the applicable allocations related list (User Allocations or Device Allocations) to configure (see table for field descriptions).

Note: The allocations related list that is shown pertains to the license metric that you chose. Only one related list for allocations is shown.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Allocations</strong></td>
<td></td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user to which the license is allocated.</td>
</tr>
<tr>
<td>Software Model</td>
<td>Automatically set based on entitlements software model.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity of rights allocated to this user. Default is 1. Multiple rights come into play in the case where many rights are needed to fully license a device or user, such as with per core.</td>
</tr>
<tr>
<td>License Key</td>
<td>License key of the software.</td>
</tr>
<tr>
<td><strong>Device Allocations</strong></td>
<td></td>
</tr>
<tr>
<td>Assigned to</td>
<td>The device to which the license is allocated.</td>
</tr>
<tr>
<td>Software Model</td>
<td>Automatically set based on entitlements software model.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Quantity of licenses allocated to this user. Default is 1.</td>
</tr>
</tbody>
</table>
Create a Software Asset Management Foundation plugin software model in classic

Software models are used to connect purchased software rights with discovered software installations. Additionally, software models can be used to manage suites of software as well as to publish requestable software to the Service Catalog.

Before you begin
Role required: sam_user or model_manager

About this task
Manage software available and tie software installations (software being used) with entitlements (software owned) using software models. Create software models for all software to be monitored.

Note: Users with the model_manager role can navigate to Product Catalog > Product Model > Software Models, but cannot administer all aspects of software models.

Predefined suites are used so suite components are automatically created for known suite parent software models. Discovery maps indicate whether a suite is defined for the product.

You can also track a software model lifecycle phase for use with the Technology Portfolio Management.

Procedure

1. Navigate to Software Asset > Licensing > Software Models and create a new record (see table for field descriptions).

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>model display names</td>
<td>model display names are generated. System administrators can configure this property. Default format is publisher + product + version + edition.</td>
<td></td>
</tr>
<tr>
<td>Publisher</td>
<td>Publisher of the software. You can use the lookup list provided. Publisher is a reference to the company [core_company]. Only companies you are using internally are shown. If the publisher and product do not exist, you can Add a Software Asset Management Foundation plugin custom license metric.</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td>Software product name. The same lookup list provided on the Software Discovery Models form.</td>
<td>If the relationship between the software publisher [samp_sw_publisher] and company [core_company] is not correct, products for that publisher may not be shown.</td>
</tr>
<tr>
<td>Product classification</td>
<td>The official UNSPSC classification of the product.</td>
<td></td>
</tr>
<tr>
<td>Product type</td>
<td>• Child: A subcomponent of main software (not licensable). • Driver: A software product that controls a device. • Licensable: A software product that is licensable. • Not Licensable: A software product that is not licensable. • Patch: A software product designed to update, fix, or improve an existing computer program. • Unknown: Not discovered.</td>
<td></td>
</tr>
<tr>
<td>General</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the model.</td>
<td></td>
</tr>
<tr>
<td>Cost</td>
<td>The cost of a single unit of the software.</td>
<td></td>
</tr>
<tr>
<td>Next version</td>
<td>Reference to another software model of the same manufacturer which represents the next version of the product.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the model. Options are <strong>In Production</strong>, <strong>Retired</strong>, and <strong>Sold</strong>.</td>
<td></td>
</tr>
<tr>
<td>Certified</td>
<td>Check box for indicating the software model has been approved for use.</td>
<td></td>
</tr>
<tr>
<td>Discovery Mapping</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Version condition</td>
<td>Condition qualifier for the <strong>Version</strong> field.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• starts with</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• is anything</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default is <strong>is anything</strong>.</td>
<td></td>
</tr>
<tr>
<td>Version</td>
<td>Version of the software product.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Required if version condition value is <strong>starts with</strong> or <strong>is</strong>.</td>
<td></td>
</tr>
<tr>
<td>Edition condition</td>
<td>Condition qualifier for the <strong>Edition</strong> field.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• starts with</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• is anything</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default is <strong>is anything</strong>.</td>
<td></td>
</tr>
<tr>
<td>Edition</td>
<td>Edition of the software product to use when searching for the normalized discovery model.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Required if edition condition value is <strong>starts with</strong> or <strong>is</strong>.</td>
<td></td>
</tr>
<tr>
<td>Platform</td>
<td>Platform of the software product to use when searching for the normalized discovery model.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default is <strong>--Anything--</strong> for Windows, Mac, Unix.</td>
<td></td>
</tr>
<tr>
<td>Language</td>
<td>Language of the software product to use when searching for the normalized discovery model, which is populated once it has been normalized or added manually.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default is <strong>--Anything--</strong>.</td>
<td></td>
</tr>
<tr>
<td>Software installation condition</td>
<td>Only software installations that meet this software discovery map condition are counted during reconciliation.</td>
<td></td>
</tr>
</tbody>
</table>
If needed, specify a subset of software installations that should be counted during reconciliation.

**Product Catalog**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog Item</td>
<td>The information about the model as it appears in the product catalog and service catalog.</td>
</tr>
<tr>
<td></td>
<td>Information only appears if the model has been published to the product catalog.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the software model as it appears in the product catalog.</td>
</tr>
<tr>
<td>Picture</td>
<td>An image of the software logo can be added. This logo appears in the Service Catalog if the software model is published.</td>
</tr>
</tbody>
</table>

The Suite Components and Suite Parents related lists consist of parent and child configuration.

2. To publish the software model to the product catalog, under Related Links, click **Publish to Software Catalog** and select a category for the software model. The values set in the Product Catalog related list are published.

3. To show the list of discovery models that match the software publisher and product fields of the software model, under Related Links, click **Show Matching Discovery Models**. The Discovery Models list is opened in a new browser tab for your reference.

4. To perform additional configuration, select the new software model record in the Software Models list.
   
   a. In the Software Model Lifecycles related list, create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th><strong>Software Model Lifecycle form</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Software model</td>
</tr>
<tr>
<td>Lifecycle type</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>----------------------------</td>
</tr>
</tbody>
</table>
| Lifecycle phase           | • Pre Release  
  Date the software became generally available to the market.  
  • General Availability  
  • Upgrade  
  Only shown when the **Lifecycle type** field is Internal.  
  • End of Life  
  Date the software was no longer supported by the publisher.  
  • End of Support  
  • End of Extended Support |
| Source                    | [Read-only] Internal (for new records created manually), or ServiceNow (when created automatically).                                          |
| Description               | Description of the software model lifecycle.                                                                                               |
| Phase start date          | Date the lifecycle phase starts.                                                                                                                                                                    |
| Phase end date            | Date the lifecycle phase ends.                                                                                                                                                                      |
| Risk                      | • Very High  
  • High  
  • Moderate  
  • Low  
  • None                                                                                                                                         |

**b. Create a Software Asset Management Foundation plugin entitlement in classic.**

c. **View Software Asset Management Foundation plugin software model results in classic.** The latest software model results are shown in the Software Model Results related list.
d. In the Metric Attributes related list, click a metric attribute to set the attribute value field (see table for field descriptions).

The Metric Attributes related list contains metric values set in software entitlements and is used for reconciliation (metric group, license metric, and software model combination).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software model</td>
<td>Software model associated with the metric attributes.</td>
</tr>
<tr>
<td>Metric group</td>
<td>Grouping for the software metric (Common).</td>
</tr>
<tr>
<td>License metric</td>
<td>The license metric that the software license is counted against when reconciliation is run (per user, per device, for example).</td>
</tr>
<tr>
<td>Description</td>
<td>Attribute type description that is based on license metric value.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Attribute type for reconciling entitlements license metric.</td>
</tr>
<tr>
<td></td>
<td>• Maximum active OSEs per server</td>
</tr>
<tr>
<td></td>
<td>• Maximum installs per OSE</td>
</tr>
<tr>
<td></td>
<td>• Maximum installs per right: For Per User, Per Device, Per Named User, and Per Named Device.</td>
</tr>
<tr>
<td></td>
<td>• Maximum processors per right</td>
</tr>
<tr>
<td></td>
<td>• Minimum users per processor</td>
</tr>
<tr>
<td></td>
<td>• Minimum cores per processor</td>
</tr>
<tr>
<td></td>
<td>• Minimum cores per server</td>
</tr>
<tr>
<td>Attribute value</td>
<td>Value of the attribute (integer).</td>
</tr>
<tr>
<td>Attribute value is unlimited</td>
<td>Check box for setting the attribute as unlimited.</td>
</tr>
</tbody>
</table>

e. Create a vendor catalog item.
Manually normalize a SAM Foundation software discovery model in classic

You can edit a software discovery model to manually normalize discovered software on the Software Discovery Models form so that it can be reconciled.

Before you begin
Role required: sam_user

About this task
If the information automatically added to the software discovery model is incomplete, you can add the missing fields to manually normalize the software discovery model.

Procedure
1. Navigate to Software Asset > Discovery > Discovery models and open a discovery model record.
2. Fill in the Publisher, Product, and Version fields, as appropriate.
3. Click Normalize.
   The normalization status is set to Manually Normalized.

Manually override SAM Foundation edition value in classic

When the edition of a software install is not automatically discovered, you can specify the edition on the Software Installation form with the correct value (if known) so the software can be successfully reconciled.

Before you begin
Role required: sam_admin

About this task
For reconciliation to run successfully, the publisher, product, version, and edition fields of the software must be set. When the edition is not discovered automatically (edition value is not included as part of the Display name field) but you know the edition, you can manually set it to the correct value (Enterprise, for example).

Once the edition value is set, the discovery model for the software install is automatically reset. If the appropriate discovery model does not exist, a new one is created.

Note: Not all software products consist of an edition. Of the software products consisting of an edition, not all edition values are automatically discoverable.
Procedure

1. Navigate to **Software Asset > Discovery > Software Installations** and open the software installation record for which to set the edition value.

2. Fill in the **Edition override** field, as appropriate.

   - **Note:** The **Edition override** field is a free-form field (no lookup list) therefore, since this field is used as a key, the value entered must be exact.

3. Click **Update**.

   The software installation is associated to different discovery model containing the edition value as part of the primary key. If the appropriate discovery model does not exist, a new one is created.

Using **Software Asset Management Foundation plugin workspace**

Use the Software Asset Workspace, the intuitive and streamlined user interface of the Software Asset Management Foundation plugin application.

The Software Asset Management Foundation plugin views let you create entitlements, software models, run and review reconciliation results, give visibility into your software assets, and provides access to analytics via dashboards.

The Software Asset workspace contains the following views:

- Software asset overview: the landing page of the Software Asset Workspace. You can create entitlements, run reconciliation, view key metrics and get time sensitive alerts and notifications regarding your software assets.

- License usage: You can view the compliance status of all your publishers, review reconciliation results, and view and run reports.

- License operations: lists all the entitlements, software models, import entitlement errors, discovery models.

**Software asset overview for Software Asset Management Foundation plugin dashboard**

Enhance your Software Asset Management Foundation plugin experience by using the modernized and user-friendly software asset overview dashboard. The software asset overview is a simplified and intuitive environment that helps you use the application more effectively by reducing complexity.

Use the software asset overview view to:
• Gain insights into key metrics such as compliance trends and true-up costs.
• Execute routine tasks such as running reconciliation or creating entitlements.

Click any widget to view detailed information. All the widgets are updated whenever a new reconciliation result is available.

### Software asset overview dashboard

<table>
<thead>
<tr>
<th>Report</th>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishers out of</td>
<td>Product Results</td>
<td>Number of publishers that have at least one software model out of compliance.</td>
</tr>
<tr>
<td>compliance</td>
<td>[samp_product_result]</td>
<td>Click the report to view the results in the License usage view.</td>
</tr>
<tr>
<td>Products out of</td>
<td>Product Results</td>
<td>Number of products that have at least one software model out of compliance.</td>
</tr>
<tr>
<td>compliance</td>
<td>[samp_product_result]</td>
<td>Click the report to view the results in the License usage view.</td>
</tr>
<tr>
<td>Total true-up Cost</td>
<td>Product Results</td>
<td>Cost to be compliant based on the average</td>
</tr>
<tr>
<td></td>
<td>[samp_product_result]</td>
<td></td>
</tr>
</tbody>
</table>
License usage view for Software Asset Management Foundation plugin

Use the license usage view as a single plane to understand the license position of all software products, remediate non compliance, and view reconciliation results.

The License usage view lets your organizations license usage trends and helps forecast the needs of your organization by trending the number of licenses required against the number of licenses purchased. Stay in compliance by purchasing additional rights before software consumption surpasses the number of rights owned.

You can access the License usage view by navigating to Software asset > Software Asset Workspace > License usage.

Use the License usage view to:

- filter by domain and compliance status.
- sort by True-up cost, over-licensed amount, and potential savings.
- run reconciliation and view its results.
- be informed about the last reconciliation run.
- view and export reports.

Run Software Asset Management Foundation plugin software reconciliation in workspace

Reconciliation is run as a scheduled job (default is weekly), but you can also run reconciliation manually to reconcile software products in the Software Asset Workspace environment on-demand.
Before you begin
Reconciliation is run for products that have software entitlements or software installs. Grouping and subgrouping are supported so you can narrow the compliance results.

When running reconciliation manually, allow enough time for the process to complete. For faster results, narrow the scope by selecting specific publishers.

Role required: sam_user or sam_admin

Procedure
1. Navigate to the Run Reconciliation dialog box from either of the two ways:
   - Software asset > Software asset workspace > Run Reconciliation
   - Software asset > Software Asset Workspace > License wokbench > Run Reconciliation
2. Select a particular publisher for which compliance should be calculated. You can also select all publishers.
3. To narrow results further, select a group or subgroup.
   Available group and subgroup values include None, Country, Department, Company, Region, and Cost Center.
4. Click Run Reconciliation.
   The reconciliation process may take some amount of time to complete. Once reconciliation is complete, the reconciliation results are shown in the Reconciliation tab.

Reconciliation results

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique identifying number that is generated during the reconciliation process.</td>
</tr>
<tr>
<td>Last reconciled</td>
<td>Date of last reconciliation run.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the reconciliation.</td>
</tr>
<tr>
<td></td>
<td>• Completed</td>
</tr>
<tr>
<td></td>
<td>• In Progress</td>
</tr>
<tr>
<td></td>
<td>• Failed</td>
</tr>
<tr>
<td>Ran for</td>
<td>All publishers, or specific publishers.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishers</td>
<td>Only shown if publishers were specified on which to run reconciliation.</td>
</tr>
<tr>
<td>Group</td>
<td>Group specified on which to run reconciliation. Values include None, Country, Department, Company, Region, and Cost Center.</td>
</tr>
<tr>
<td>Subgroup</td>
<td>Subgroup specified on which to run reconciliation. Values include None, Country, Department, Company, Region, and Cost Center.</td>
</tr>
<tr>
<td>Progress</td>
<td>Percent complete and progress bar for the reconciliation run.</td>
</tr>
<tr>
<td>Progress summary</td>
<td>Specific step within the reconciliation process.</td>
</tr>
</tbody>
</table>

**Note:** This list column is not shown by default. You can personalize your list column settings to add it, if desired.

| Updated        | The date and time when the particular reconciliation process was completed.                                                                |

**License Operation view for Software Asset Management Foundation plugin**

Use the License operations view in the Software Asset Workspace to view all your licenses and discovery models that are managed by the Software Asset Management Foundation plugin application.

View all details related to entitlements and software models in the License operations view. You can also create, edit, and delete entitlements and software models.

You can access the License operations view by navigating to **Software asset > Software Asset Workspace > License operations.**

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
License operations

The License operations view also lets you view:

- all the discovered software for your engineering applications.
- engineering license servers.
- discovery models.
- license consumption.

**View discovery models in workspace**

View a list of all the discovered software for your engineering applications in the Software Asset Workspace.

**Before you begin**

Role required: sam_admin or sam_user

**Procedure**

1. Navigate to Software Asset > Software Asset Workspace > License Operations
2. Click Discovered engineering license from the Discovery list view.
3. You can click a record to view additional details. This takes you to the Company page in the classic view.

**Using Software Asset Management Foundation plugin classic**

Using Software Asset Management Foundation plugin classic.

**Software Asset Management Foundation dashboard**

View compliance and true-up cost trend charts on the Software Asset Management Foundation dashboard.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The Software Asset Management Foundation dashboard is accessed by navigating to Software Asset > Overview. Click an element within a report to see more information, or add and move widgets as needed.

Results are updated daily, or whenever a new reconciliation result is available, and can be refreshed by clicking the Refresh icon for each result. You can also save charts in PNG or JPG formats.

The source for overview data is the Product Result [samp_product_result] table.

![Software Asset Management Foundation dashboard](image)

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publishers out of Compliance</td>
<td>Number of publishers that have at least one software model out of compliance.</td>
</tr>
<tr>
<td>Products out of Compliance</td>
<td>Number of products that have at least one software model out of compliance.</td>
</tr>
<tr>
<td>Total True-up Cost</td>
<td>Cost to be compliant based on the average prices in entitlements for the rights.</td>
</tr>
<tr>
<td>Top 10 Products by True-up Cost</td>
<td>Top 10 products graphed in order of true-up cost.</td>
</tr>
</tbody>
</table>
Run Software Asset Management Foundation plugin software reconciliation in classic

Reconciliation is run as a scheduled job (default is weekly), but you can also run reconciliation manually to reconcile software products in your environment on demand.

**Before you begin**
Role required: sam_admin

**About this task**
Reconciliation is run for products that have entitlements.

When running reconciliation manually, allow enough time for the process to complete. For faster results, narrow the scope by selecting specific publishers.

**Procedure**

1. Navigate to **Software Asset > Reconciliation > Run Reconciliation** and select a publisher for which compliance should be calculated, or select all publishers.

2. Click **Continue**.
   The reconciliation process may take an extended amount of time to complete.
   The Reconciliation Results list is shown.

View Software Asset Management Foundation plugin software model results in classic

View compliance information for software model results from the Product Results list after reconciliation is run.

**Before you begin**
Role required: sam_user

**About this task**
You can view License Metric Results, Remediation Options, and Unlicensed Installs related lists for a software model result from a Product Result record.

For example, if the status of a product result shows that it is not compliant, you can drill down on the product result to view software model details, such as the number of unlicensed installs and the true-up cost to become compliant. Further, you can drill down on the software model result to view the license metric result, which is based on the entitlements for the product.

License metric result information includes rights owned and rights used as well as the license allocation breakdown so you can determine your options to become compliant. The Remediation Options related list shows the number
of rights needed and calculates the cost of those rights for you, based on the license metric.

**Procedure**

1. Navigate to **Software Asset > Reconciliation > Product Results** and open a record to view product results details.

2. In the Software Model Results related list, open a record to view the details (see table for field descriptions).

<table>
<thead>
<tr>
<th>Software Model Results form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Software model</td>
<td>Software model associated with the product. Drill down on the software model to see the software model result.</td>
</tr>
<tr>
<td>Product result</td>
<td>Unique product result number generated during the reconciliation process.</td>
</tr>
<tr>
<td>Latest</td>
<td>Indicates whether this software model result is from the most recent reconciliation run.</td>
</tr>
</tbody>
</table>
| Status                      | Status of the software model.  
|                             | • Compliant  
|                             | • Not Compliant |
| Agreement type              | • Common: Generic, Enterprise License Agreement (ELA) |
|                             | **Note:** If the agreement type is Enterprise Level Agreement, the **Status** is Compliant even if there are unlicensed installations. |
| Unlicensed installs         | Number of unlicensed software installations that are not covered by any entitlements. |
| True-up cost                | Estimated cost of remediating non-compliance based on the least number of rights needed (rights
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td><strong>needed * average price per right from entitlements). The lowest cost from Purchase Rights remediation options.</strong></td>
</tr>
<tr>
<td>Over-licensed amount</td>
<td><strong>Estimated cost of rights not being used. The sum of the Over Licensed amount from the True-up value costs.</strong></td>
</tr>
<tr>
<td>License Metric Results</td>
<td><strong>License metric</strong> (License metric that the software license is counted against when reconciliation is run).</td>
</tr>
<tr>
<td>License metric</td>
<td></td>
</tr>
<tr>
<td>Software model result</td>
<td><strong>Software model with which the result is associated.</strong></td>
</tr>
<tr>
<td>Rights owned</td>
<td><strong>Sum of all active rights from entitlements that share a license metric.</strong></td>
</tr>
<tr>
<td>Rights used</td>
<td><strong>Sum of rights used during reconciliation (allocated + not allocated and installed).</strong></td>
</tr>
<tr>
<td>Unused rights</td>
<td><strong>Sum of rights not used during reconciliation (rights owned - rights used).</strong></td>
</tr>
<tr>
<td>Over-licensed amount</td>
<td><strong>Estimated cost of unused rights.</strong></td>
</tr>
<tr>
<td>Right Allocations</td>
<td><strong>Allocated in use</strong> (Rights that are allocated and are used to license installations).</td>
</tr>
<tr>
<td>Allocated in use</td>
<td></td>
</tr>
<tr>
<td>Not allocated in use</td>
<td><strong>Number of rights that are used to license installations, but not allocated.</strong></td>
</tr>
<tr>
<td></td>
<td>When this value is greater than 0, two remediation options (Create Allocations and Remove Unallocated Installs) are automatically created for each unique license metric in the software model that meets this</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Allocating Not in Use</td>
<td>Rights that are allocated but are not being used to license any installations.</td>
</tr>
<tr>
<td>Note: Allocating Not in Use</td>
<td>Reflects rights that are wasted because the user or device for which these rights have been allocated do not have the software installed.</td>
</tr>
<tr>
<td></td>
<td>When this value is greater than 0, a Remove Allocations remediation option is automatically created for each unique license metric in the software model that meets this requirement.</td>
</tr>
<tr>
<td>Not Allocated</td>
<td>Number of rights that have not been allocated (rights owned - allocated regardless of whether installed or not).</td>
</tr>
<tr>
<td>Allocations Needed</td>
<td>Number of allocations needed for compliance. Only used for Per Named User and Per Named Device license metrics.</td>
</tr>
<tr>
<td>Remediation Options</td>
<td></td>
</tr>
<tr>
<td>Remediation action</td>
<td>Action to take to for compliance.</td>
</tr>
<tr>
<td></td>
<td>• Purchase Rights</td>
</tr>
<tr>
<td>Affects Compliance</td>
<td>Specifies whether compliance is affected by the remediation option.</td>
</tr>
<tr>
<td>License Metric</td>
<td>Specific license metric of the software model result.</td>
</tr>
<tr>
<td>Software Model Result</td>
<td>Specific software model result pertaining to the remediation option.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the remediation option.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• New (blue)</td>
<td></td>
</tr>
<tr>
<td>• Complete (green)</td>
<td></td>
</tr>
<tr>
<td>• Void (red)</td>
<td></td>
</tr>
<tr>
<td>• In Progress (yellow)</td>
<td>In Progress state indicates that removal candidates were created for the installs.</td>
</tr>
<tr>
<td>Rights needed</td>
<td>• <strong>Purchase Rights</strong> shows Rights needed.</td>
</tr>
<tr>
<td>Actionable rights</td>
<td>Total rights affected by the action.</td>
</tr>
<tr>
<td>True-up cost</td>
<td>Estimated cost of remediating non-compliance based on the least number of rights needed.</td>
</tr>
</tbody>
</table>

The Unlicensed Installs related list contains the software installations that are unlicensed.

**Software Asset Management Foundation plugin Administration**

Software Asset Management Foundation plugin administration tasks include adding custom product records, creating custom license metrics, and setting properties. You can also refresh processor definitions, and migrate software installations.

The sam_admin role is required to configure administrative tasks. However, the sam_user role can view and read configurations.

**Add a Software Asset Management Foundation plugin custom software product**

You can add a custom product if a software product does not exist in the Software Library. Custom products enable you to normalize and account for homegrown software, or software that is not yet part of the Software Library.

**Before you begin**

Role required: sam_admin

**About this task**

The product and publisher combination is used during discovery model normalization. If the custom product already exists, a message is shown.
Procedure

Navigate to **Software Asset > Administration > Custom Software Products** and create a new record (see table for field descriptions).

### Custom Software Product form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>Publisher of the custom software product. If it does not exist, a new one can be created on the Publisher field Companies lookup list.</td>
</tr>
<tr>
<td>Product</td>
<td>Name of the custom software product.</td>
</tr>
<tr>
<td>Product type</td>
<td>Product type of the custom software product.</td>
</tr>
<tr>
<td></td>
<td>• Child: A subcomponent of main software (not licensable).</td>
</tr>
<tr>
<td></td>
<td>• Driver: A software product that controls a device.</td>
</tr>
<tr>
<td></td>
<td>• Licensable: A software product that is licensable.</td>
</tr>
<tr>
<td></td>
<td>• Not Licensable: A software product that is not licensable.</td>
</tr>
<tr>
<td></td>
<td>• Patch: A software product designed to update, fix, or improve an existing computer program.</td>
</tr>
<tr>
<td></td>
<td>• Unknown: A software product that is unknown.</td>
</tr>
<tr>
<td>Product classification</td>
<td>Official UNSPSC classification.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for activating the rule.</td>
</tr>
</tbody>
</table>

**Add a Software Asset Management Foundation plugin custom license metric**

You can add a custom license metric to modify the default reconciliation process.

**Before you begin**

Role required to read the custom metric script: sam_admin
About this task
Custom license metrics can be created to define specific software calculations not included in the predefined license metrics list. Custom license metrics are useful so reconciliation can calculate rights per user or device for certain software products and bundles of lesser-known software publishers.

For example, you can create a custom metric to avoid over counting installs for products that are part of an unrecognized bundle.

Custom metrics can be disabled using the custom license metric property. This feature is enabled by default.

Procedure

Navigate to **Software Asset > Administration > Custom License Metrics** and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License metric</td>
<td>Name of the custom license metric. This name is shown in the <strong>License Metric</strong> field of software entitlements, and in the license metric results for the software model.</td>
</tr>
<tr>
<td>Metric group</td>
<td>[Read-only] Custom license metric.</td>
</tr>
<tr>
<td>Allocation type</td>
<td>Allocation type of the metric license, per device or per user.</td>
</tr>
<tr>
<td></td>
<td>• Device</td>
</tr>
<tr>
<td></td>
<td>• User</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the custom license metric.</td>
</tr>
<tr>
<td>Reconciliation order - allocated</td>
<td>Reconciliation metric rank priority for allocated licenses. Lower rank value takes precedence.</td>
</tr>
<tr>
<td>Reconciliation order - unallocated</td>
<td>Reconciliation metric rank priority for unallocated licenses. Lower rank value takes precedence.</td>
</tr>
</tbody>
</table>

Calculation
**Field** | **Description**
--- | ---
Calculation Script | The calculation method for the license metric is script. Specify the reconciliation script.

**Migrate Software Asset Management Foundation plugin software installations**

If you are using Discovery, run this script after installing Software Asset Management Foundation plugin to copy previously discovered software installation records from the [cmdb_software_instance] table to the [cmdb_sam_sw_install] table, which is used by Software Asset Management Foundation plugin to store software installation records.

**Before you begin**
Role required: sam_admin

**About this task**
If you are running Discovery and have used a version of ITSM Software Asset Management previously, there is no need to run this script. Additionally, if the [cmdb_sam_sw_install] table is already populated with software installation records, this script is disabled. You can run Discovery again to repopulate the table.

When running the Migrate Software Installs script, allow enough time for the process to complete.

**Procedure**
Navigate to Software Asset > Administration > Migrate Software Installs and click Proceed.
The Software Installations list is shown. If the data has already been migrated, a message is shown.

**Software Asset Management Foundation plugin properties**
You can set default reconciliation properties such as reconciliation run with custom license metrics, and reconciliation debugging settings.

These properties are available for Software Asset Management Foundation plugin.
To access these properties, navigate to Software Asset > Administration > Properties.
### Properties for Software Asset Management Foundation plugin

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run reconciliation with all available custom license metrics</td>
<td>Enable custom license metrics when running reconciliation. If you have a custom license metric configured, it is not applied when this property is set to No.</td>
</tr>
<tr>
<td>com.snc.samp.recon.enablecustommetrics</td>
<td>• Type: Reconciliation&lt;br&gt;• Default value: Yes</td>
</tr>
<tr>
<td>Enable debugging of reconciliation results</td>
<td>Enable debugging of reconciliation results to troubleshoot a result.</td>
</tr>
<tr>
<td>com.snc.samp.debug</td>
<td>• Type: Reconciliation&lt;br&gt;• Default value: No</td>
</tr>
</tbody>
</table>

### Software Asset Management Foundation plugin migration

Migrate from the Software Asset Management plugin to the Software Asset Management Foundation plugin to take advantage of more powerful features. Manual actions by the customer are required after plugin activation.

After automatic changes are performed during plugin activation, successful migration from the Software Asset Management (com.snc.software_asset_management) plugin to the Software Asset Management Foundation (com.snc.sams) plugin requires a manual procedure to be performed by the customer.

Customizations to forms and lists may need to be manually overwritten by the customer after plugin activation. In addition, certain fields in software models, software entitlements, user/device allocations forms require manual configuration by the customer after plugin activation.
Automatic changes
The Software Asset Management Foundation (com.snc.sams) plugin performs these automatic changes:

- Tables
  - Table labels renamed
    
    | Table                  | Original Label      | New Label           |
    |------------------------|---------------------|---------------------|
    | [alm_license]          | Software License    | Software Entitlement|
    | [alm_entitlement_user] | User Entitlement    | User Allocations    |
    | [alm_entitlement_asset]| Device Entitlement  | Device Allocations  |

  - Adds new tables and script includes.
  - Adds any string value in the Software Entitlements License key field to the License Key [samp_sw_license_key] table

- Field names and values
  - Inference mandatory field
    
    For software models that have suite components (to bundle software models), the Inference mandatory field value in the Software Suite [cmdb_m2m_suite_model] table is transferred to a new Mandatory field
  
    - Rights field
      
      The Software Entitlements (formerly Software Licenses) Rights field value in the License Entitlements [alm_entitlement] table is transferred to a new Purchased rights field, and name changed from Rights to Active rights
  
    - The Software model field for a software entitlement allocation (Software Entitlement [alm_license] table) is automatically set to the software model on the entitlement (License Entitlements [alm_entitlement] table)
  
    - The quantity for a software entitlement allocation (License Entitlements [alm_entitlement] table) is set to 1 unless there are multiple allocations
      
      If there are multiple software entitlement allocations for the same user or device, the allocations are aggregated into one record, the quantity is set to the count of aggregated records, and duplicate allocations are not allowed

- Forms and lists
  
  Software Models, Entitlements (formerly Software License), Discovery Models, and Software Installations form and list layouts are modified to fit the new application
**Note:** Any customizations to these forms and lists must be manually overwritten after plugin activation.

- **Functionality**

  **Functionality disabled**

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License and software counters</td>
<td>The scheduled job trigger for SAM License Counters is changed to None so that it is deactivated, and software counters are disabled.</td>
</tr>
<tr>
<td>Auto-match functionality</td>
<td>The auto-match functionality, which attempts to match a discovery model to a corresponding software model, is deactivated.</td>
</tr>
<tr>
<td>Navigation menu</td>
<td>The navigation menu for the Software Asset Management plugin is deactivated and renamed.</td>
</tr>
<tr>
<td>Business rules</td>
<td>Legacy business rules applied to discovery models are disabled.</td>
</tr>
</tbody>
</table>

**Overwrite customizations for Software Asset Management Foundation plugin migration**

When migrating from the Software Asset Management plugin to the Software Asset Management Foundation plugin, further actions are required by the customer after plugin activation to ensure successful migration of customized forms and lists.

**Before you begin**

Role required: admin

**About this task**

If these lists and forms have been customized before the migration, they may have been skipped during plugin activation and, in that case, require further action.

- Software Entitlements (formerly Software Licenses)
- Software Allocations (formerly Software Entitlements)
- Software Models
• Discovery Models
• Software Installations

You can review plugin activation changes in the Upgrade History module to determine what changes have automatically been skipped so you can resolve the skipped update, if needed.

Certain fields added by the migration also must be configured to take advantage of the new features offered.

**Procedure**

1. Navigate to **System Diagnostics > Upgrade History**.

2. Identify the records that correspond to the upgrade history for the activation of the Software Asset Management Foundation plugin. The records in System Upgrades list that represent plugin activation contain the value **n/a** in the **From** field, and plugin name in the **To** field (such as com.snc.samp, com.snc.samp.core, com.snc.sam.core, com.glide.data_services_canonicalization.client, com.snc.asset_management, com.snc.model, com.snc.procurement). You can determine the list of related plugins based on the time stamp of when the Software Asset Management plugin was activated by sorting on the **Upgrade started** column.

3. Open a Software Asset Management Foundation plugin upgrade record that has changes skipped.

4. In the **Upgrade Details** related list, open an Upgraded Details record, and then click **Resolve Conflicts** to view a side-by-side comparison of the base system file with the customized file.

5. Click **Revert to Base System** to overwrite the skipped change if it applies to form or list customization, and note down the changes. Repeat these steps for all upgrade entries with skipped changes relating to customizations.

6. In Software Asset Management Foundation plugin configuration, manually reconfigure your original form and list customizations.

7. In Software Asset Management Foundation plugin configuration, set new field values (added as part of the automatic changes performed by plugin activation) to take advantage of the new features offered.
a. Navigate to **Software Asset > Licensing > Software Models**.
   - Select the software product in the **Product** reference field.
   - Select a discovery map, or clear the **Discovery Map** field and set the discovery conditions to find all discovery models that correspond to the software model.

b. Navigate to **Software Asset > Licensing > Software Entitlements** (formerly Software Licenses).
   - Navigate to **Software Asset > Licensing > Software Entitlements** (formerly Software Licenses).
   - Select the **License Metric** that the software license is counted against when reconciliation is run.
   - Define the upgrade and downgrade scenarios covered by certain rights.

c. In the **User Allocations** and **Device Allocations** related lists (formerly User/Device Entitlements), verify that the number of allocated rights are not more than rights owned.
   - If so, delete allocations so that the number of allocations does not exceed the number of rights owned.

8. If you have entitlements that require management of license keys, you can create multiple license keys associated to the same entitlement, as well as allocate these license keys to a user or device.

**Organization Management**

The Organization Management application provides an easy way to perform such asset management tasks as updating users and adding vendors.

It includes managing your vendors and manufacturers, as well as managing locations.

**Create a new vendor or manufacturer**

You can create a new vendor, which is a company that sells assets or services that your organization purchases. You can also create a new manufacturer, which is a company that builds assets that your organization purchases.

**Before you begin**

Role required: user_admin and asset
Procedure

1. Navigate to one of the following:
   - Organization > Vendors
   - Organization > Manufacturers
   - Organization > Companies

2. Click New and create a new record.

3. Complete the form and select either Manufacturer or Vendor.

   Note: A company can be considered both a vendor and a manufacturer.

4. Click Submit.

Locations module

The Locations module is the Asset view of the Location table [cmn_location].

In addition to the physical specifics for the location, the Asset view includes the Stock room designation and a list of configuration items (CI) in stock at that location.

Installed with Model Management

Several types of components are installed with Model Management. Demo data is available with Model Management.

Business rules installed with Model Management

Model Management uses a number of business rules.
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort action if no license type</td>
<td>[cmdb_software_product_model]</td>
<td>Ensures that a license type (not a license type group that cannot be handled by counters) has been selected.</td>
</tr>
<tr>
<td>Calculate display name</td>
<td>Product Model [cmdb_model]</td>
<td>Sets the <strong>Display name</strong> field when any of the following field values change: <strong>Manufacturer, Name, Version, Edition</strong>. The display name differs depending on whether the <strong>glide.cmdb_model.display_name.shorten</strong> property is set to <strong>true</strong> or <strong>false</strong>.</td>
</tr>
<tr>
<td>Date validation</td>
<td>[cmdb_m2m_downgrade_model]</td>
<td>Ensures that the <strong>Start date</strong> is before the <strong>End date</strong>.</td>
</tr>
<tr>
<td>Enforce CI Rules</td>
<td>[cmdb_model_category]</td>
<td>Ensures that categories that track assets as consumables or software licenses do not have a CI class.</td>
</tr>
<tr>
<td>Flag parent as bundle on creation</td>
<td>[cmdb_m2m_model_component]</td>
<td>Flags a model that has components as a bundle.</td>
</tr>
<tr>
<td>License Type - Fullname</td>
<td>[cmdb_sw_license_calculation]</td>
<td>Computes the full name of the license type.</td>
</tr>
<tr>
<td>License validation</td>
<td>Software Upgrade and Downgrades [cmdb_m2m_downgrade_model]</td>
<td>Prevents software upgrades and downgrades from being duplicated and prevents having duplicate upgrades and downgrades for the same license where duplication also involves having the same dates. Also ensures that both the <strong>Upgrade parent</strong> and <strong>Downgrade child</strong> fields are mandatory and that if the <strong>License</strong> field is not empty, either <strong>Upgrade parent</strong> or <strong>Downgrade child</strong> must be equal to the <strong>license.model</strong>.</td>
</tr>
<tr>
<td>Protect cmdb_ci_class</td>
<td>[cmdb_model_category]</td>
<td>Prevents CI class from being changed after creation.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Protect cmdb_ci_class on insert</td>
<td>[cmdb_model_category]</td>
<td>Prevents creation of a category if another category already exists for the chosen CI class.</td>
</tr>
<tr>
<td>Protect Contract</td>
<td>[cmdb_model_category]</td>
<td>Prevents changes to the Contract model category record.</td>
</tr>
<tr>
<td>Set parent's main component link</td>
<td>[cmdb_m2m_model_component]</td>
<td>Populates a read-only reference from the bundle to the component when a bundle component is selected as the main component.</td>
</tr>
<tr>
<td>Unflag parent on last delete</td>
<td>[cmdb_m2m_model_component]</td>
<td>Removes the bundle flag from a model when the last component is deleted from the bundle.</td>
</tr>
<tr>
<td>Update model category</td>
<td>[cmdb_ci]</td>
<td>Updates the model categories for the associated model if the model is not already associated with the CI's model category.</td>
</tr>
<tr>
<td>Validate record before creation</td>
<td>[cmdb_m2m_model_component]</td>
<td>Ensures that a component is not already in a bundle when an attempt is made to add the component to a bundle.</td>
</tr>
</tbody>
</table>

**Client scripts installed with Model Management**

Model Management includes a number of client scripts.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear models not matching license</td>
<td>[cmdb_m2m_downgrade_model]</td>
<td>Clears the Upgrade parent and Downgrade child fields when the License field is changed to a license and neither the upgrade or downgrade fields match the license model.</td>
</tr>
<tr>
<td>Constraints based on asset class</td>
<td>[cmdb_model_category]</td>
<td>Enables or disables bundling options based</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>Hide sections when needed</td>
<td>[cmdb_model]</td>
<td>Shows and hides sections according to what is relevant for a given model.</td>
</tr>
<tr>
<td>model_category change</td>
<td>[cmdb_model]</td>
<td>Ensures compatibility of classes between the several categories referenced</td>
</tr>
<tr>
<td>Populate downgrade from license</td>
<td>[cmdb_m2m_downgrade_model]</td>
<td>Sets the downgrade child to the software model on the referenced license</td>
</tr>
<tr>
<td>Populate upgrade from license</td>
<td>[cmdb_m2m_downgrade_model]</td>
<td>Sets the upgrade parent to the software model on the referenced license when</td>
</tr>
<tr>
<td>Properties installed with Model Management</td>
<td>glide.cmdb_model.display_name.shorten</td>
<td>When set to true, generates shorter display names for models by eliminating duplication of the manufacturer name. Consider the following model, for which</td>
</tr>
</tbody>
</table>
The **Display name** field is set as follows, based on the property setting.

- false: Display name is Spotify Spotify Premium
- true: Display name is Spotify Premium

For software models, the edition and version are also included in the name, if they are specified.

- Type: true | false
- Default value: false
- Location: System Properties [sys_properties] table

---

### Script includes installed with Model Management

Model Management includes script includes.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ModelAndCategoryFilters</td>
<td>Refines reference qualifiers for models and model categories based on class.</td>
</tr>
<tr>
<td>ModelCategoryCheck</td>
<td>Ensures compatibility of classes between the several categories referenced by the same model.</td>
</tr>
</tbody>
</table>

---

### Tables installed with Model Management

Model Management includes numerous tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Model</td>
<td>Stores models used to describe software application products.</td>
</tr>
<tr>
<td>[cmdb_application_product_model]</td>
<td></td>
</tr>
<tr>
<td>Consumable Model</td>
<td>Describes consumable product models.</td>
</tr>
<tr>
<td>[cmdb_consumable_product_model]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Contract Model [cmdb_contract_product_model]</td>
<td>Stores all contract models.</td>
</tr>
<tr>
<td>Depreciation [cmdb_depreciation]</td>
<td>Stores asset depreciation patterns.</td>
</tr>
<tr>
<td>Hardware Model [cmdb_hardware_product_model]</td>
<td>Describes hardware product models.</td>
</tr>
<tr>
<td>Model Category [cmdb_model_category]</td>
<td>Defines groups of assets, consumables, product bundles, and configuration items.</td>
</tr>
<tr>
<td>Model Compatibility [cmdb_m2m_model_compatibility]</td>
<td>Stores many-to-many relationship between two models signifying their compatibility with one another.</td>
</tr>
<tr>
<td>Model Component [cmdb_m2m_model_component]</td>
<td>Stores many-to-many relationship between two models signifying that they form a bundle.</td>
</tr>
<tr>
<td>Product model [cmdb_model]</td>
<td>Describes all kinds of product models.</td>
</tr>
<tr>
<td>Software License Calculation [cmdb_sw_license_calculation]</td>
<td>Defines commonly used software licensing patterns.</td>
</tr>
<tr>
<td>Software Model [cmdb_software_product_model]</td>
<td>Describes software product models.</td>
</tr>
<tr>
<td>Software Suite [cmdb_m2m_suite_model]</td>
<td>Stores many-to-many relationship between two models that defines elements of a software suite.</td>
</tr>
<tr>
<td>Software Upgrade and Downgrades [cmdb_m2m_downgrade_model]</td>
<td>Stores many-to-many relationship between two models signifying that being licensed for one model grants rights to the other as well.</td>
</tr>
</tbody>
</table>

**UI policies installed with Model Management**

Model Management includes UI policies.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Hide unverified | Model Category [cmdb_model_category] | Shows the **Enforce CI verification** field if the **Asset**
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>class and CI class fields are not empty.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lock fields for Contract and Work</td>
<td>Model Category [cmdb_model_category]</td>
<td>Sets all fields on the Model Category form to read-only if the Name is Contract or, Work Order or Work Task.</td>
</tr>
<tr>
<td>Lock fields for Contract</td>
<td>Protect model category</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Product Model [cmdb_model]</td>
<td>Makes the Model categories field mandatory and read-only if it contains any of the following values: Software License, Contract, Work Order, Work Task.</td>
</tr>
<tr>
<td></td>
<td>Show is an option if Oracle</td>
<td>Software Model [cmdb_software_product_model]</td>
</tr>
</tbody>
</table>

**User roles installed with Model Management**

Model Management includes user roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>category_manager</td>
<td>model manager</td>
<td>Can create, edit, and delete model categories.</td>
</tr>
<tr>
<td>model_manager</td>
<td>none</td>
<td>Can create new CMDB models. The model manager role can control the base models and any model extensions that are not hardware, software, or consumables. Hardware and consumable models are controlled by the asset manager (asset) role. Software models are controlled by the software asset manager (sam) role.</td>
</tr>
</tbody>
</table>
Installed with Asset Management

A number of tables, user roles, UI policies, script includes, client scripts, and business rules are installed with Asset Management.

Demo data is available with asset management. The demo data provides information such as users, specific assets, and individual stockrooms.

Tables

Asset Management includes the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset [alm_asset]</td>
<td>Stores general, financial, and contractual information about assets.</td>
</tr>
<tr>
<td>Asset Entitlement [alm_entitlement_asset]</td>
<td>Enables ServiceNow to categorize the Asset Entitlement table and enforce how entitlements behave.</td>
</tr>
<tr>
<td>Consumable [alm_consumable]</td>
<td>Stores data about consumable assets (previously known as parts).</td>
</tr>
<tr>
<td>Default Stockroom [alm_user_stockroom]</td>
<td>Stores the relationship between a user and their default stockroom.</td>
</tr>
<tr>
<td>Fixed Assets [alm_fixed_assets]</td>
<td>Stores fixed assets, which are containers that can hold multiple assets.</td>
</tr>
<tr>
<td>Fixed asset to asset [m2m_fixed_asset_to_asset]</td>
<td>Stores associations between fixed assets and assets.</td>
</tr>
<tr>
<td>Hardware [alm_hardware]</td>
<td>Stores general, financial, and contractual information about hardware assets.</td>
</tr>
<tr>
<td>License Entitlement [alm_entitlement]</td>
<td>Stores entitlements that permit users or machines to use a software license.</td>
</tr>
<tr>
<td>Software License [alm_license]</td>
<td>Stores general, financial, and contractual information about software license assets.</td>
</tr>
<tr>
<td>Stock Rule [alm_stock_rule]</td>
<td>Transfers stock or sends an email message to the asset manager when a specified asset drops below a set threshold.</td>
</tr>
<tr>
<td>Stockroom [alm_stockroom]</td>
<td>Stores information about stockrooms.</td>
</tr>
</tbody>
</table>
## Asset Management tables (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stockroom Model [alm_m2m_stockroom_model]</td>
<td>Tracks all models that have ever been stocked in a stockroom. This table is automatically populated.</td>
</tr>
<tr>
<td>Stockroom Type [alm_stockroom_type]</td>
<td>Stores general information about stockroom types.</td>
</tr>
<tr>
<td>Transfer Order [alm_transfer_order]</td>
<td>Contains data about transfer orders, including the state and stockrooms.</td>
</tr>
<tr>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Contains data about individual assets being shipped with a transfer order.</td>
</tr>
<tr>
<td>User Entitlement [alm_entitlement_user]</td>
<td>Enables ServiceNow to categorize the User Entitlement table and enforce how entitlements behave.</td>
</tr>
</tbody>
</table>

### User roles

Asset Management includes the following user roles.

## Asset Management user roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>asset (Asset Manager)</td>
<td>category manager, contract manager, financial mgmt user, inventory user</td>
<td>Can manage hardware and consumable assets ([alm_hardware] and [alm_consumable]). Asset manager cannot edit asset records that are created and updated automatically, but can read and delete the asset records when needed. Can create requests. Can create and delete stock information.</td>
</tr>
<tr>
<td>inventory_admin</td>
<td>inventory user</td>
<td>Can create and delete stock information. Can edit stock rules, stockrooms, and stockroom types.</td>
</tr>
<tr>
<td>inventory_user</td>
<td>none</td>
<td>Can access stock information. Can create and manage transfer orders.</td>
</tr>
<tr>
<td>sam</td>
<td>contract manager,</td>
<td>Can create, edit, change, and manage software licenses. Can edit the Software model</td>
</tr>
</tbody>
</table>
Asset Management user roles (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
</table>

UI policies

Asset Management includes the following UI policies.

Asset Management UI policies

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide asset tag and serial num</td>
<td>[alm_asset]</td>
<td>Hides the asset tag when the asset is pre-allocated and the quantity is greater than 1.</td>
</tr>
<tr>
<td>Hide/show parent stockroom on Stockroom Replenish</td>
<td>[alm_stock_rule]</td>
<td>Shows the Parent stockroom field only when the Restocking option field is set to Stockroom.</td>
</tr>
<tr>
<td>Make allocated to and assigned to mandatory.</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Makes the Allocated to and Assigned to fields mandatory.</td>
</tr>
<tr>
<td>Make substatus read-only when not required</td>
<td>[alm_asset]</td>
<td>Sets the Substatus to read-only if the State is On order, In use, Consumed, or In maintenance.</td>
</tr>
<tr>
<td>Model bundle field hidden but present for UI Policy conditions purposes</td>
<td>[alm_asset]</td>
<td>Hides the Model Bundle field. Exists on page only for use by UI policies and client scripts.</td>
</tr>
<tr>
<td>Pre-allocated constraints</td>
<td>[alm_asset]</td>
<td>Hides unneeded fields and related lists when the asset is pre-allocated.</td>
</tr>
<tr>
<td>Quantity readonly until model and category qualify</td>
<td>[alm_asset]</td>
<td>Sets the Quantity field to read-only for assets that are not consumable, software, or pre-allocated. Quantity is</td>
</tr>
</tbody>
</table>
Asset Management UI policies (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>the asset and are not bundle</td>
<td></td>
<td>also read-only if the model or model category fields are empty.</td>
</tr>
<tr>
<td>Show 'Assigned to'</td>
<td>[alm_asset]</td>
<td>Shows the Assigned to field if the State field is not On order, In stock, or In transit.</td>
</tr>
<tr>
<td>Show 'Reserved for'</td>
<td>[alm_asset]</td>
<td>Shows the Reserved for field if the State field is On order, In stock, or In transit.</td>
</tr>
</tbody>
</table>
| Show 'Stockroom' | [alm_asset] | Shows the Stockroom field if either of the following conditions is true:  
  - The State field is In stock and Substate is not Pre-allocated.  
  - The Substate is Pre-allocated and Parent is empty. |

Script includes

Asset Management includes the following script includes.

Asset Management script includes

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AssetAndCI</td>
<td>Code for creating and managing the relationship between asset and CI records.</td>
</tr>
<tr>
<td>AssetAndCISynchronizer</td>
<td>Synchronization code between asset and CI records.</td>
</tr>
<tr>
<td>AssetUtils</td>
<td>Utility functions for asset management. Also checks if a license can be merged and then merges licenses if requirements are met.</td>
</tr>
<tr>
<td>AssetUtilsAJAX</td>
<td>AJAX based utility functions for asset management. Call the AssetUtils script include from a client-side UI action.</td>
</tr>
<tr>
<td>Consumables</td>
<td>Code to modify (for example, consume, split, and merge) consumables.</td>
</tr>
<tr>
<td>FixedAssetUtils</td>
<td>Methods for rolling up fixed asset costs.</td>
</tr>
<tr>
<td>PortalFilters</td>
<td>Filters used in the My Assets portal.</td>
</tr>
</tbody>
</table>
Asset Management script includes (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PreAllocatedAssets</td>
<td>Code to modify pre-allocated assets.</td>
</tr>
<tr>
<td>StockRuleFilters</td>
<td>Reference qualifier code for filtering options on reference fields on stock rules.</td>
</tr>
<tr>
<td>StockRuleTransfer</td>
<td>Transfer order creation code for when stock rules are triggered.</td>
</tr>
<tr>
<td>TransferOrderDateTimeAjax</td>
<td>Date comparison utility for transfer orders.</td>
</tr>
<tr>
<td>TransferOrderFilters</td>
<td>Reference qualifier code for reference field filtering options on transfer orders.</td>
</tr>
<tr>
<td>TransferOrderFinder</td>
<td>Finds an appropriate transfer order to put a transfer order line into.</td>
</tr>
<tr>
<td>TransferOrderHelper</td>
<td>Function that checks if a transfer order has multiple transfer order lines.</td>
</tr>
<tr>
<td>TransferOrderLineFilters</td>
<td>Reference qualifier code for reference field filtering options on transfer order lines.</td>
</tr>
<tr>
<td>TransferOrderReceiver</td>
<td>Code for receiving a transfer order line.</td>
</tr>
<tr>
<td>TransferOrderReturn</td>
<td>Code for returning a transfer order line.</td>
</tr>
<tr>
<td>TransferOrderStageHandler</td>
<td>Code for changing transfer order stages and transfer order line stages.</td>
</tr>
<tr>
<td>TransferOrderStageHelper</td>
<td>Helper method to get numeric stages for transfer orders and transfer order lines.</td>
</tr>
</tbody>
</table>

Client scripts
Asset Management includes the following client scripts.

Asset Management client scripts

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correct substatus</td>
<td>[alm_asset]</td>
<td>Updates the Substatus field when the Status field is modified.</td>
</tr>
<tr>
<td>Ensure no negative quantity</td>
<td>[alm_asset]</td>
<td>Clears the Quantity field when set to less than 1.</td>
</tr>
</tbody>
</table>
### Asset Management client scripts (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error on pre-allocated substatus</td>
<td>[alm_consumable]</td>
<td>Prevents Substatus field from being set to Pre-allocated for consumable assets. Also displays an error message.</td>
</tr>
<tr>
<td>Error on pre-allocated substatus</td>
<td>[alm_license]</td>
<td>Prevents Substatus field from being set to Pre-allocated for license assets. Also displays an error message.</td>
</tr>
<tr>
<td>Null out allocated_to</td>
<td>[alm_entitlement]</td>
<td>Does the following when the Assigned to field is set:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Clears the Allocated to field and makes it not mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Makes the Assigned to field mandatory.</td>
</tr>
<tr>
<td>Null out assigned_to</td>
<td>[alm_entitlement]</td>
<td>Does the following when the Allocated to field is set:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Clears the Assigned to field and makes it not mandatory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Makes the Allocated to field mandatory.</td>
</tr>
<tr>
<td>Salvage must be less than cost</td>
<td>[alm_asset]</td>
<td>Displays a warning if a salvage value greater than the cost of an asset is entered.</td>
</tr>
<tr>
<td>Set Cost of the Asset</td>
<td>[alm_asset]</td>
<td>Populates the Cost field when the Model field is set.</td>
</tr>
<tr>
<td>Set Loc/CC/Dep/Com from assigned to</td>
<td>[alm_asset]</td>
<td>Populates the Location, Cost center, Department, and Company fields when the Assigned to field is set.</td>
</tr>
<tr>
<td>Set Location from stockroom</td>
<td>[alm_asset]</td>
<td>Populates the Location field when the Stockroom field is set.</td>
</tr>
<tr>
<td>Update From Location</td>
<td>[alm_transfer_order]</td>
<td>Populates the From location field when the From stockroom field is set.</td>
</tr>
</tbody>
</table>
### Business rules

Asset Management includes the following business rules.

#### Asset Management business rules

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocated more licenses than rights</td>
<td>Software License [alm_license]</td>
<td>Prevents creation or update of a license if the number of licenses allocated is larger than the total rights.</td>
</tr>
</tbody>
</table>
## Asset Management business rules (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Retirement</td>
<td>Asset [alm_asset]</td>
<td>Clears the Assigned to, Stockroom, and Reserved for fields and sets the retirement date to the current time when the asset is retired.</td>
</tr>
</tbody>
</table>
| Automatically Change TOL State             | Transfer Order Line [alm_transfer_order_line] | If a transfer order has the same From stockroom and To stockroom and it is a personal stockroom, this business rule:  
• Sets the transfer order line Stage to Delivered.  
• Sets the asset Substate to Reserved.  
If a transfer order has the same From stockroom and To stockroom and it is not a personal stockroom, this business rule:  
• Sets the transfer order Stage to Received.  
• Sets the asset Substate to Pending transfer. |
| Build bundle components on Insert          | Asset [alm_asset]            | Creates assets for the components related to a bundle if the model of the created asset is a bundle.                                                                                                         |
| Clear Assigned To on update                | Asset [alm_asset]            | Clears the Assigned to field if the State field changes to On order, In stock, or In transit.                                                                                                               |
| Clear fields irrelevant for preallocated   | Asset [alm_asset]            | Clears the value of fields that are irrelevant for pre-allocated assets.                                                                                                                                    |
| Create Asset on insert                    | Configuration Items [cmdb_ci]| Creates a corresponding asset when a new configuration item with no asset is created.                                                                                                                     |
## Asset Management business rules (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create asset on model change</td>
<td>Configuration Items [cmdb_ci]</td>
<td>Creates a new associated asset when the Model ID field changes.</td>
</tr>
<tr>
<td>Create CI on insert</td>
<td>Asset [alm_asset]</td>
<td>Creates a corresponding configuration item when a new asset with no configuration item is created.</td>
</tr>
<tr>
<td>Create Stockroom Model Relation</td>
<td>Asset [alm_asset]</td>
<td>Creates a record (if none already exists) in the Stockroom Model table indicating the stockroom that holds the model when an asset is created or updated.</td>
</tr>
<tr>
<td>Delete all Transfer Order Lines</td>
<td>Transfer Order [alm_transfer_order]</td>
<td>Deletes all related transfer order lines when a transfer order is deleted.</td>
</tr>
<tr>
<td>Ensure Entitlements do not exceed rights</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Checks that the total number of entitlements for the related license does not exceed the number of rights given by the license when an entitlement is created.</td>
</tr>
<tr>
<td>GenerateAssets</td>
<td>Model Categories [cmdb_model_category]</td>
<td>Executes a scheduled script job to create assets for configuration items.</td>
</tr>
<tr>
<td>Inherit information from parent</td>
<td>Asset [alm_asset]</td>
<td>Assigns some parent values to the asset when assigning a new parent to an asset.</td>
</tr>
<tr>
<td>Managed Stockroom for Vendor</td>
<td>Stock Rule [alm_stock_rule]</td>
<td>Validates that a vendor replenishing stock rule has a stockroom selected and the stockroom has an associated manager with a valid email address.</td>
</tr>
<tr>
<td>Mandate allocated to or assigned to</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Makes a value in either the Allocated to field or the Assigned to field mandatory.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Merge Records</td>
<td>Consumable [alm_consumable]</td>
<td>Merges consumables that have matching fields and are not in Transit into one record containing the total count.</td>
</tr>
<tr>
<td>Null out asset on insert and stay</td>
<td>Configuration Items [cmdb_ci]</td>
<td>Clears the Asset field on insert if the field contains an asset that has a CI.</td>
</tr>
<tr>
<td>Null out Ci on insert and stay</td>
<td>Asset [alm_asset]</td>
<td>Nulls out the asset field so a new asset is created for the Ci if an insert is performed on an existing Ci.</td>
</tr>
<tr>
<td>Populate reserved for field</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>If the transfer order line has an associated request line, this business rule populates the associated asset’s Reserved for field with the appropriate information from the request line.</td>
</tr>
<tr>
<td>Push Status to Asset/Consumable</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Modifies the corresponding asset to reflect the current state of transit when a transfer order line moves to another state.</td>
</tr>
<tr>
<td>Release Asset on TOL cancel/delete</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Places the corresponding asset back into stock and unsources the part requirement when a transfer order line in the draft state is canceled or deleted.</td>
</tr>
<tr>
<td>Rollup TOL cancellation to TO</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Signals to the corresponding transfer order that the transfer order line has been canceled.</td>
</tr>
<tr>
<td>Salvage value must be less than cost</td>
<td>Asset [alm_asset]</td>
<td>Prevents saving an asset record if the salvage value is greater than the cost.</td>
</tr>
<tr>
<td>Sanity check on pre-allocated</td>
<td>Asset [alm_asset]</td>
<td>Prevents creation or update of pre-allocated assets if they do not</td>
</tr>
</tbody>
</table>
### Asset Management business rules (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Class</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Sets the class for this entitlement depending on if the entitlement is assigned or allocated.</td>
</tr>
<tr>
<td>Set Transfer Order Type</td>
<td>Transfer Order [alm_transfer_order]</td>
<td>Sets the type of the transfer order depending on whether there is a related service order or work order task.</td>
</tr>
<tr>
<td>Sync model category</td>
<td>Product Models [cmdb_model]</td>
<td>When the model category changes, this business rule creates assets if they did not previously exist for configuration items associated with the model.</td>
</tr>
<tr>
<td>Transfer Order Stockroom Rules</td>
<td>Transfer Order [alm_transfer_order]</td>
<td>Prevents the From stockroom field from being changed if the transfer order has multiple transfer order lines.</td>
</tr>
<tr>
<td>Transition reserved to assigned</td>
<td>Asset [alm_asset]</td>
<td>Populates the Assigned to field with the value from the Reserved for field when the asset is in the appropriate state.</td>
</tr>
<tr>
<td>Trickle information down to components</td>
<td>Asset [alm_asset]</td>
<td>Updates components of an asset to reflect any changes that have been made to the asset record.</td>
</tr>
<tr>
<td>Update Asset fields on change</td>
<td>Configuration Items [cmdb_ci]</td>
<td>Synchronizes fields so changes made on the Configuration Item form trigger the same update on the corresponding Asset form, ensuring consistent reporting. ServiceNow recommends updating statuses on the Asset form.</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update CI fields on change</td>
<td>Asset [alm_asset]</td>
<td>Synchronizes fields so changes made on the Asset form trigger the same update on the corresponding Configuration Item form, ensuring consistent reporting.</td>
</tr>
<tr>
<td>Update location as needed</td>
<td>Asset [alm_asset]</td>
<td>Updates the location of the asset, if the asset is set to a new stockroom or assigned to a new user.</td>
</tr>
<tr>
<td>Validate Field Agent Type</td>
<td>Stockroom [alm_stockroom]</td>
<td>Ensures you do not create a stockroom of type Field Agent without Work Management or Field Service Management activated. Allows for only one personal stockroom per user.</td>
</tr>
<tr>
<td>Validate TOL and check availability</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Validates changes made to the transfer order line and checks availability of the assets to be transferred in the specified stockroom.</td>
</tr>
<tr>
<td>Validate transfer order</td>
<td>Transfer Order [alm_transfer_order]</td>
<td>Validates that the Delivery by date is not earlier than the current date.</td>
</tr>
<tr>
<td>Validate Unique Users</td>
<td>Default Stockroom [alm_user_stockroom]</td>
<td>Prevents the creation of multiple records with the same user.</td>
</tr>
<tr>
<td>Verify Entitlement (Allocated)</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Ensures that the allocation of the entitlement follows the allocation condition on the license, if a condition exists.</td>
</tr>
<tr>
<td>Verify Entitlement (Assigned)</td>
<td>License Entitlement [alm_entitlement]</td>
<td>Ensures that the assignee of the entitlement follows the assignment condition on the license, if a condition exists.</td>
</tr>
<tr>
<td>Verify Entitlements (Allocated)</td>
<td>Software License [alm_license]</td>
<td>Ensures that the allocations of all the license's entitlements follow</td>
</tr>
</tbody>
</table>
Asset Management business rules (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify Entitlements (Assigned)</td>
<td>Software License [alm_license]</td>
<td>Ensures that the assignees of all the license's entitlements follow the assignment condition on the license, if a condition exists.</td>
</tr>
<tr>
<td>Verify Not Field Agent</td>
<td>Default Stockroom [alm_user_stockroom]</td>
<td>Verifies that the selected default stockroom is not of the Field Agent type.</td>
</tr>
</tbody>
</table>

Domain separation and Asset Management

Domain separation is supported in Asset Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Basic

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

Related information

Domain separation for service providers
Domain separation and lifecycle reports

There are certain domain separation aspects to consider when running software lifecycle reports.

Overview

In a domain-separated environment, the software lifecycle report is generated at the level at which the Service Provider (SP) is managing compliance for their customers’ environment. Typically, the level at which reconciliation is run indicates such compliance, and the software lifecycle report is generated at the same level.

The following table shows how the reconciliation should behave. In this example:

- The SP is managing Cisco’s software asset management (SAM) program at the Cisco corporate level. That means the lifecycle report must run at the Cisco corporate level.
- The SP is managing Walmart’s SAM program for each Walmart division (US and Mexico). That means the lifecycle report must run at the Walmart division level.

Here is the SP hierarchy:

- Cisco Corporate
  - Cisco USA
  - Cisco Mexico
- Walmart Corporate
  - Walmart USA
  - Walmart Mexico

<table>
<thead>
<tr>
<th>Domain settings (reconciliation/norma</th>
<th>Compliance reporting</th>
<th>Lifecycle report level</th>
</tr>
</thead>
<tbody>
<tr>
<td>lization)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TOP/Cisco</td>
<td>True</td>
<td>Yes</td>
</tr>
<tr>
<td>TOP/Cisco/US</td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>TOP/Cisco/Mexico</td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>TOP/Cisco/Germany</td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>TOP/Walmart</td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>TOP/Walmart/US</td>
<td>True</td>
<td>Yes</td>
</tr>
<tr>
<td>TOP/Walmart/Mexico</td>
<td>True</td>
<td>Yes</td>
</tr>
</tbody>
</table>
If the SP sets up software models for Cisco corporate as well as Cisco Mexico, even though their intent is to manage compliance for Cisco at the Cisco Corporate level, the lifecycle report may show duplicate lifecycle records with the same install count.

### Lifecycle report

<table>
<thead>
<tr>
<th>Model domain</th>
<th>Software Model</th>
<th>Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco</td>
<td>SQL Server 2012</td>
<td>Cisco</td>
</tr>
<tr>
<td>Cisco Mexico</td>
<td>SQL Server 2012</td>
<td>Cisco</td>
</tr>
<tr>
<td>Walmart USA</td>
<td>SQL Server 2012</td>
<td></td>
</tr>
<tr>
<td>Walmart Mexico</td>
<td>SQL Server 2012</td>
<td></td>
</tr>
</tbody>
</table>

To learn more about software lifecycles, see Create software models in Software Asset Management classic. To learn about domain separation path setup, see Domain separation setup and administration.

### Quick start test for Asset Management

Validate that Asset Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

**Asset Management**

Asset Management quick start tests requires the Asset Management plugin (com.snc.asset_management).

### Asset Management test

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Sourcing - Consume local asset stock</td>
<td>Validates the consume local asset stock flow.</td>
<td>Rome</td>
</tr>
</tbody>
</table>

**Related information**

Quick start tests
Contract Management

Manage and track contracts with the ServiceNow® Contract Management application.

A contract is a binding agreement between two parties. In the ServiceNow platform, contracts contain detailed information such as the following:

- Contract number
- Contract start and end dates
- Active status
- Terms and conditions statements
- Documents
- Renewal information
- Financial terms

Contract Management is active by default. If the Cost Management plugin is activated, the Contract Management application integrates with the Cost Management plugin to associate contracts with costs and determine the total cost of ownership. You can track recurring expenses with expense lines. An administrator can activate the Cost Management plugin.

If you are using the Software Asset Management plugin, use the Software Licenses option.

Related information
- Create a new expense line
- Terms and conditions
- Software Asset Management

Use the Contract Management Overview module

You can view information about your contract status in the Contract Management Overview module. It displays various contract management reports.

Before you begin
Role required: asset, contract_manager

About this task
Because the Contract Management Overview module is a type of homepage, you can add, delete, and rearrange reports on the page.
Procedure

1. Navigate to **Contract > Overview**.
2. Click elements within the reports to obtain more information.

**Example**

For example, click any of the colored bars in the **Contract Expenditure by Type** bar chart to see detailed information.

Components installed with Contract Management

Several types of components are installed with Contract Management.

Demo data is available.

Tables installed with Contract Management

Tables are added with Contract Management.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Covered [clm_m2m_contract_asset]</td>
<td>Lists the assets covered by a contract. An asset can be covered by multiple contracts and a contract can have multiple assets.</td>
</tr>
<tr>
<td>Asset Covered [clm_m2m_rate_card_asset]</td>
<td>Lists the rate cards that apply to an asset.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Condition [clm_condition_checker]</td>
<td>Lists the conditions and values for each condition checker.</td>
</tr>
<tr>
<td>Condition Checks [clm_condition_check]</td>
<td>Stores conditions and values that modify specified condition fields.</td>
</tr>
<tr>
<td>Contract History [clm_contract_history]</td>
<td>Stores a copy of the contract when the start date, end date, or terms and conditions change.</td>
</tr>
<tr>
<td>Terms and Conditions [clm_terms_and_conditions]</td>
<td>Lists the terms and conditions used by contracts.</td>
</tr>
<tr>
<td>Terms and Conditions [clm_m2m_contract_and_terms]</td>
<td>Lists all terms and conditions available for use with contracts.</td>
</tr>
<tr>
<td>Users Covered [clm_m2m_contract_user]</td>
<td>Lists the users covered by contracts.</td>
</tr>
</tbody>
</table>

**User roles installed with Contract Management**

A user role is added with Contract Management.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>contract_manager</td>
<td>financial_mgmt_user</td>
<td>Manages the contract life cycle. Can create, edit, and delete contracts.</td>
</tr>
</tbody>
</table>

**Script includes installed with Contract Management**

Script includes are added with Contract Management.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConditionChecks</td>
<td>Checks for matching conditions, such as for contract expirations and license compliance, defined in the Condition Checks [clm_condition_check] table.</td>
</tr>
<tr>
<td>ContractManagementUtils</td>
<td>Utilities that manage contract management actions, such as state transitions.</td>
</tr>
</tbody>
</table>
### Client scripts installed with Contract Management

Client scripts are added with Contract Management.

<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Tax Cost - Base cost</td>
<td>Contract [ast_contract]</td>
<td>Calculates the <strong>Tax cost</strong> field and the <strong>Total cost</strong> field on the Contract form when the <strong>Payment amount</strong> field changes.</td>
</tr>
<tr>
<td>Calculate Tax Cost - Sales tax</td>
<td>Contract [ast_contract]</td>
<td>Calculates the <strong>Tax cost</strong> field and the <strong>Total cost</strong> field on the Contract form when the <strong>Sales tax</strong> field changes.</td>
</tr>
<tr>
<td>Calculate Tax Cost - Tax rate</td>
<td>Contract [ast_contract]</td>
<td>Calculates the <strong>Tax cost</strong> field and the <strong>Total cost</strong> field on the Contract form when the <strong>Tax rate</strong> field changes.</td>
</tr>
<tr>
<td>Ensure discount is valid percent</td>
<td>Contract [ast_contract]</td>
<td>Ensures that the <strong>Discount</strong> field does not contain a value less than zero or greater than 99.</td>
</tr>
<tr>
<td>Renew Cost Adjustment</td>
<td>Contract [ast_contract]</td>
<td>Sets the <strong>Percentage</strong> field on the Contract form to zero if the user sets a dollar amount for the cost adjustment.</td>
</tr>
<tr>
<td>Renew Cost Percentage</td>
<td>Contract [ast_contract]</td>
<td>Sets the <strong>Amount</strong> field on the Contract form to zero if the user enters a percentage for the cost adjustment.</td>
</tr>
<tr>
<td>Tax exempt/rate</td>
<td>Contract [ast_contract]</td>
<td>Changes all tax-related fields on the Contract form to read-only if the <strong>Tax Exempt</strong> check box is selected.</td>
</tr>
<tr>
<td>Tax rate/exempt</td>
<td>Contract [ast_contract]</td>
<td>Changes all tax-related fields on the Contract form to writeable if the <strong>Sales Tax</strong> check box is selected.</td>
</tr>
</tbody>
</table>

### Business rules installed with Contract Management

Business rules are added with Contract Management.
<table>
<thead>
<tr>
<th>Name</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate projected costs (Reports)</td>
<td>Contract [ast_contract]</td>
<td>Calculates the projected monthly and annual costs for a contract when costs or payment schedule changes.</td>
</tr>
<tr>
<td>Calculate totals with tax</td>
<td>Contract [ast_contract]</td>
<td>Calculates the <strong>Tax cost</strong> and <strong>Total cost</strong> fields for a contract when the contract is created or updated.</td>
</tr>
<tr>
<td>Contract history</td>
<td>Contract [ast_contract]</td>
<td>Stores history when the start, end, or terms and conditions of a contract change.</td>
</tr>
<tr>
<td>Create approval record</td>
<td>Contract [ast_contract]</td>
<td>Updates contract <strong>Terms and Conditions</strong> and starts the contract approval workflow when a contract is sent for review.</td>
</tr>
<tr>
<td>Flag terms and conditions</td>
<td>Terms and Conditions [clm_m2m_contract_and_terms]</td>
<td>Sets the <strong>Use</strong> flag on a Terms and Conditions record to <strong>true</strong> after the record is associated with a contract or to <strong>false</strong> after the record is disassociated from a contract.</td>
</tr>
<tr>
<td>Activate count for manual licenses</td>
<td>Software License Instance [ast_license_software_instance]</td>
<td>Calculates and updates the number of computers a particular license is installed on when a software license instance is created or deleted.</td>
</tr>
<tr>
<td>Manage contract lifecycle</td>
<td>Contract [ast_contract]</td>
<td>This business rule:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updates the end date of a contract when a contract extension has been approved.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Renews the contract, updating its start date, end date, and base cost (if cost adjustments must be applied) when a contract renewal</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Post outage to news</td>
<td>Service [cmdb_ci_service]</td>
<td>Posts a news article on the knowledge table when there is an outage.</td>
</tr>
<tr>
<td>Update contract cost per asset</td>
<td>Asset Covered [clm_m2m_contract_asset]</td>
<td>Updates the cost per unit value based on the total cost and number of assets associated to the contract.</td>
</tr>
<tr>
<td>Update contract lifetime cost</td>
<td>Contract Rate Card [fm_contract_rate_card]</td>
<td>Calculates the lifetime cost of the contract by calculating the sum of the contract expense lines.</td>
</tr>
<tr>
<td>Updates after contract dates change</td>
<td>Contract [ast_contract]</td>
<td>Updates the <strong>Date added</strong> and <strong>Date removed</strong> fields for all assets and users associated with a contract if the contract end date changes.</td>
</tr>
<tr>
<td>Updates after rate card dates change</td>
<td>Contract Rate Card [fm_contract_rate_card]</td>
<td>Updates the related contract assets and users linked to the rate card when the end date is changed.</td>
</tr>
<tr>
<td>Verify contract’s start and end dates</td>
<td>Contract [ast_contract]</td>
<td>Validates contract start and end dates and contract renewal start and end dates.</td>
</tr>
<tr>
<td>Verify purchase agreement</td>
<td>Contract [ast_contract]</td>
<td>For contracts with the contract model <strong>Purchase Agreement</strong>, the business rule validates that the <strong>Discount</strong> field does not</td>
</tr>
<tr>
<td>Name</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>discount</td>
<td>price</td>
<td>contain a value less than zero or greater than 99.</td>
</tr>
</tbody>
</table>

**Contract Management use**

Users with the contract_manager role can use the Contract Management application to create various types of contracts, such as leases, warranties, maintenance, and service.

You can add the following information to contracts.

- Assets covered by the contract
- Users covered by the contract
- Terms and conditions associated with the contract
- Other documents related to the contract

Track the various stages of a contract from draft to closure by viewing contract history and running reports. Adjust, extend, and renew active contracts.

**Contract life cycle**

From creation until closure, contracts follow a life cycle that determines which fields can be edited.

When a contract is in **Draft** state, almost all fields on the contract record can be edited. After a contract moves past the **Draft** state, certain date, renewal, extension, and financial fields become read-only. The **State** field and **Substate** field are always read-only.

A scheduled job named **Contract Compliance Checks** runs on the Contract [ast_contract] table automatically each night. For more information about the scheduled job, see **Use Condition Check Definitions**. The scheduled job performs the following actions:

- Changes the contract state to **Active** if the contract is approved and reaches the specified start date.
- Renews the contract if the contract is approved for renewal and reaches the specified start date.
- Changes the contract state to **Expired** if the contract state is **Active** and reaches the end date.

Expense lines are only generated from contracts that are active or expired.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Contract states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draft</td>
<td>User adds information about the contract and specifies an approver.</td>
</tr>
<tr>
<td>Active</td>
<td>Contract was approved and has reached the specified start date.</td>
</tr>
<tr>
<td>Expired</td>
<td>Contract reached the specified end date. Expired contracts with an active renewal workflow that are waiting for approval have a substate of <strong>Awaiting Review</strong>. Expired contracts with an active renewal workflow where the renewal was approved, but the renewal date has not yet passed, have a substate of <strong>Renewal Approved</strong>. Expired contracts with no active renewal or extension pending workflow have an empty substate.</td>
</tr>
<tr>
<td>Canceled</td>
<td>Contract was discontinued and is no longer active.</td>
</tr>
</tbody>
</table>

In addition to a state, a contract can also have a substate.

### Contract substates

<table>
<thead>
<tr>
<th>Substate</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Awaiting Review</td>
<td>Contract is being prepared for review.</td>
</tr>
<tr>
<td>Under Review</td>
<td>Contract sent to the approver and the approver is reviewing the contract.</td>
</tr>
<tr>
<td>Approved</td>
<td>Contract reviewed and accepted by the approver.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Contract reviewed and declined by the approver.</td>
</tr>
<tr>
<td>Renewal Approved</td>
<td>Contract renewal approved the approver.</td>
</tr>
<tr>
<td>Renewal Rejected</td>
<td>Contract renewal rejected by the approver.</td>
</tr>
<tr>
<td>Extension Approved</td>
<td>Contract extension approved by the approver.</td>
</tr>
<tr>
<td>Extension Rejected</td>
<td>Contract extension rejected by the approver.</td>
</tr>
<tr>
<td>None</td>
<td>No substate is specified.</td>
</tr>
</tbody>
</table>
Contracts
A contract is a binding agreement between two parties.
In the Now Platform, contracts contain detailed information such as contract number, start and end dates, active status, terms and conditions statements, documents, renewal information, and financial terms.
Working with contracts includes the following tasks and processes.

Create a contract
You can create various contract models for leases, maintenance, or warranties.

Before you begin
Role required: contract_manager or admin

About this task
If a contract has one or more associated rate cards, the fields on the Contract form cannot be edited.

Procedure
1. Navigate to Contract and select the type of contract, such as Insurance, Maintenance, or Service, or select All.
2. Click New.
3. Complete the form.
   Not all fields appear on all contract type forms.

Contract form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique number identifying the contract record.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor responsible for the contract. This field is required when the contract model selected is NDA or Purchase Agreement.</td>
</tr>
<tr>
<td>Contract model</td>
<td>Model the contract is assigned to. For example Lease, Maintenance, Warranty, or Service Contract.</td>
</tr>
<tr>
<td>Commitment</td>
<td>Amount committed to spend with this vendor during this time period, from the start to the end of the contract.</td>
</tr>
<tr>
<td>Discount</td>
<td>Discount the vendor has agreed to provide.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Contract number</td>
<td>Number assigned to the contract by the vendor (required).</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the contract: <strong>Draft</strong>, <strong>Active</strong>, <strong>Expired</strong>, or <strong>Canceled</strong>.</td>
</tr>
<tr>
<td>Substate</td>
<td>Current substate of the contract. For example, <strong>Awaiting Review</strong>, <strong>Under Review</strong>, <strong>Approved</strong>, or <strong>Rejected</strong>.</td>
</tr>
<tr>
<td>License quantity entitled</td>
<td>Number of licenses included in the contract. This field is available for <strong>Maintenance</strong> and <strong>Software License</strong> contracts.</td>
</tr>
<tr>
<td>Parent contract</td>
<td>Parent contract of the new contract, if applicable. You can select a parent contract from the contract lookup list.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the contract.</td>
</tr>
<tr>
<td>General section</td>
<td></td>
</tr>
<tr>
<td>Starts</td>
<td>Date on which the contract takes effect. This field is required if the contract model is <strong>Purchase Agreement</strong> or <strong>NDA</strong>.</td>
</tr>
<tr>
<td>Ends</td>
<td>Date on which the contract expires. Leave the end date blank to create an open-ended contract. This field is required if the contract model is <strong>Purchase Agreement</strong> or <strong>NDA</strong>.</td>
</tr>
<tr>
<td>PO Number</td>
<td>Purchase order number assigned to the contract.</td>
</tr>
<tr>
<td>Vendor account</td>
<td>Vendor account associated with the contract.</td>
</tr>
<tr>
<td>Agreement type</td>
<td>Agreement type of license: <strong>Enterprise</strong>, <strong>SaaS</strong>, or <strong>Subscription</strong>. This field is available for <strong>Maintenance</strong> and <strong>Software License</strong> contracts.</td>
</tr>
<tr>
<td>Application model</td>
<td>Application model associated with the contract.</td>
</tr>
<tr>
<td>Location</td>
<td>Location covered by the contract.</td>
</tr>
<tr>
<td>Contract administrator</td>
<td>Person responsible for managing the contract and interacting with the vendor.</td>
</tr>
<tr>
<td>Approver</td>
<td>User who approves or rejects the contract. List is filtered to only show users with the ITIL role.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the contract.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Renewal/Extension section</td>
<td></td>
</tr>
<tr>
<td>Automatically renew/extend</td>
<td>Indicates if the contract can be renewed at the end of its term.</td>
</tr>
<tr>
<td>Options</td>
<td>Duration of the contract renewal or extension. For example, 1 year.</td>
</tr>
<tr>
<td>Renewal/Extension date</td>
<td>Date on which the contract renewal or extension takes effect.</td>
</tr>
<tr>
<td>Renewal/Extension end date</td>
<td>Date on which the contract renewal or extension ends.</td>
</tr>
<tr>
<td>Renewal/Extension contact</td>
<td>Individual who works for the vendor and is responsible for renewing the contract.</td>
</tr>
<tr>
<td>Cost adjustment type</td>
<td>Type of cost adjustment applied to the contract: Fixed, Manual, or CPI (consumer price index).</td>
</tr>
<tr>
<td>Cost adjustment amount</td>
<td>Numerical increase or decrease in price of contract. To indicate a decrease in price, enter a negative number. Either a Cost adjustment or Cost adjustment percentage can be specified, but not both.</td>
</tr>
<tr>
<td>Cost adjustment percentage</td>
<td>Percentage increase or decrease in price of contract. To indicate a decrease in price, enter a negative percentage. Either a Cost adjustment or Cost adjustment percentage can be specified, but not both.</td>
</tr>
<tr>
<td>Financial section</td>
<td></td>
</tr>
<tr>
<td>Cost center</td>
<td>Cost center that is financially responsible for the asset.</td>
</tr>
<tr>
<td>Tax exempt</td>
<td>Indicates if the contract is exempt from tax.</td>
</tr>
<tr>
<td>Sales tax</td>
<td>Indicates whether or not sales tax is applied to the total cost.</td>
</tr>
<tr>
<td>Effective tax rate</td>
<td>Effective tax rate to apply to the total cost, if applicable. Effective tax rate is usually the average tax rate charged.</td>
</tr>
<tr>
<td>Has rate card</td>
<td>Check box to indicate whether the contract has an associated rate card.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Invoice payment terms</td>
<td>Terms that explain how to pay the contract. For example, <strong>Net Monthly Account</strong> or <strong>Net 30</strong>.</td>
</tr>
<tr>
<td>Payment schedule</td>
<td>Schedule that defines when to make payments. For example, <strong>Monthly</strong> or <strong>Annually</strong>.</td>
</tr>
<tr>
<td>Payment amount</td>
<td>Amount which has been paid on the contract to date.</td>
</tr>
<tr>
<td>Tax cost</td>
<td>Total cost of the tax.</td>
</tr>
<tr>
<td>Total cost</td>
<td>Final cost of the contract after adjustments have been applied. If a contract has one or more rate cards, this field shows the combined value of all rate cards.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and click **Save**.

5. Continue entering information in the additional sections and related lists that appear.

**Contract form fields and related lists**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terms and Conditions section</td>
<td></td>
</tr>
<tr>
<td>Terms and conditions</td>
<td>Specific legal information in the contract.</td>
</tr>
<tr>
<td>Related lists</td>
<td></td>
</tr>
<tr>
<td>Assets Covered</td>
<td>Lists all assets covered by this contract.</td>
</tr>
<tr>
<td>Users Covered</td>
<td>Lists all users covered by this contract.</td>
</tr>
<tr>
<td>Contract used by</td>
<td>Lists all configuration items (CI) used in this contract.</td>
</tr>
<tr>
<td>Terms and Conditions</td>
<td>Lists all terms and conditions of this contract.</td>
</tr>
<tr>
<td>Expense Lines</td>
<td>Lists all expense lines in this contract.</td>
</tr>
<tr>
<td>Contract History</td>
<td>Displays the changes to the start and end dates of this contract and changes to the terms and conditions.</td>
</tr>
<tr>
<td>Approval History</td>
<td>Lists all approvals for this contract.</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>Lists all service offerings from this vendor.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Activate Service Portfolio Management to see this related list. | Service Commitments for Contracts
Lists all service commitments for this vendor's offerings. Activate Service Portfolio Management to see this related list.

6. Perform one of the following actions.
- Click **Update** to save and exit the contract.
- Click **Submit for Review** to send notification to the approver.

**Related reference**
- Service Portfolio Management

**Related information**
- Models
  - Define Service Portfolio Management service commitments

**Create a software maintenance contract example**

One common use case for the Contract Management application is creating a contract to track maintenance payments for enterprise software. You can use this example to learn how to create a software maintenance contract.

**Before you begin**
Role required: contract_manager or admin

**About this task**
The goal of this example is to create a contract that shows the total amount of maintenance that must be paid for the software application, independent of different license purchases made over time. The Software Asset Management plugin must be activated to use this example.

**Procedure**
1. Create an **application model**, adding a **Name** and specifying **Software License** in **Model categories**.
2. Create a **software model**, adding a **Name** and **Model Number**, and selecting the application model created in step 1.
3. Follow the steps in **Add a software entitlement** to create a new software entitlement, selecting the software model created in step 2.
4. Navigate to **Contract > Contracts > Maintenance**.
5. Click **New** and enter the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agreement Type</td>
<td>Select <strong>Enterprise</strong>.</td>
</tr>
<tr>
<td>Application Model</td>
<td>Select the application model created in step 1.</td>
</tr>
</tbody>
</table>

6. Right-click the form header and click **Save**. A number of related lists and sections appear.

7. In the **Asset Covered** related list, click **New** and enter the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>Select the software license created in step 3.</td>
</tr>
<tr>
<td>Date added</td>
<td>Enter the value.</td>
</tr>
</tbody>
</table>

8. Click **Submit**.

9. Continue completing the form with the following information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment schedule</td>
<td>Select <strong>Annually</strong>.</td>
</tr>
<tr>
<td>Payment amount</td>
<td>Enter the value.</td>
</tr>
</tbody>
</table>

10. Complete the other fields as appropriate.

11. Click **Update**.

12. Submit the contract for review.

**Related information**

- **Software Asset Management**

**Add an asset to a contract**
You can associate contracts with specific assets, including software licenses.

**Before you begin**
Role required: contract_manager or admin
About this task
Linking a contract with assets clarifies what the contract legally covers.

Procedure
1. Navigate to **Contract Management > Contract > All**.
2. Select a contract.
3. In the **Assets Covered** related list, click **New**.
4. In **Asset**, select a specific asset that is covered by the contract.
5. In **Date added**, select the date the asset was added to the contract. The date can be in the past, the present, or the future.
6. **Optional:** In **Date removed**, select the date the asset was, or will be, removed from the contract. Specifying **Date added** and **Date removed** is useful for reporting.
7. Click **Submit**.

Add a user to a contract
A contract can cover specific users. For example, you may use a contract to hire a group of temporary workers.

**Before you begin**
Role required: contract_manager or admin

Procedure
1. Navigate to **Contract Management > Contract > All**.
2. Select a contract.
3. In the **Users Covered** related list, click **New**.
4. In **User**, select a specific user covered by the contract.
5. In **Date added**, select the date the user was added to the contract. The date can be in the past, the present, or the future.
6. **Optional:** In **Date removed**, select the date the user was, or will be, removed from the contract. Specifying **Date added** and **Date removed** can be useful for reporting.
7. Click **Submit**.
Add a configuration item to a contract

Contracts can be associated with specific configuration items. You can link a contract with configuration items to clarify what the contract legally covers.

Before you begin
Role required: contract_manager or admin

Procedure
2. Select a contract.
3. Optional: In the Contract used by related list, click New to create a new configuration item.
4. In the Contract used by related list, click Edit.
5. In the Collection configuration items list on the left, double-click a configuration item name.
The item is added to the Contract used by List on the right.
6. Click Save.

Add a document to a contract

Contracts can be associated with documents. Linking a contract to related documents helps keep all relevant information about a contract together and easily accessible.

Before you begin
The Managed Documents plugin must be activated.
Role required: contract_manager or admin

Procedure
2. Select a contract.
3. In the Documents related list, click Edit.
   All documents stored in the Managed Documents application appear in the Collection list. If the Collection list is long, create a filter of Type is Contract and click Run filter.
4. In the Collection list, double-click a document.
The item is added to the Documents List.
5. Click Save.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Adjust a contract

After creating a contract, you can change the start date, end date, or payment amount for a contract.

Before you begin
Role required: contract_manager or admin

About this task
To adjust a contract, the State should be Active. If the end date of a contract changes, the end date of any associated assets changes to match the new end date.

Procedure
1. Navigate to Contract > Contracts > All.
2. Select a contract in Active state.
3. Click Adjust.
4. Complete the form (see table for field descriptions).

Adjust the contract values form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Start Date</td>
<td>Date on which the contract takes effect.</td>
</tr>
<tr>
<td>Contract End Date</td>
<td>Date on which the contract expires.</td>
</tr>
<tr>
<td>Contract Payment Amount</td>
<td>Total amount paid for the contract. If the contract has one or more rate cards, this field shows the total of all rate card base costs.</td>
</tr>
</tbody>
</table>

5. Click Apply changes.

Renew a contract

After you have created a contract or the contract has expired, you can renew the contract.

Before you begin
Role required: contract_manager or admin
About this task
Contract information and history is retained when a contract is renewed. If the end date of the contract changes, the end date of any associated assets changes to match. You can renew a contract that meets the following conditions.

- **State** is **Active** or **Expired**
- **Substate** is **None** or **Rejected**

Procedure
1. Navigate to Contract > Contracts > All.
2. Select a contract in **Active** or **Expired** state.
3. Click **Renew**.
4. Complete the form.

**Contract renewal fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Renewal Contact</td>
<td>Individual who works for the vendor and is responsible for renewing the contract.</td>
</tr>
<tr>
<td>Renewal Start Date</td>
<td>Date on which the renewed contract takes effect.</td>
</tr>
<tr>
<td>Renewal Option</td>
<td>Length of time for the renewal, in years.</td>
</tr>
<tr>
<td>Renewal End Date</td>
<td>Date on which the renewed contract expires.</td>
</tr>
<tr>
<td>Cost Adjustment Type</td>
<td>Type of cost adjustment applied to the renewed contract: <strong>None</strong>, <strong>Fixed</strong>, <strong>Manual</strong>, or <strong>CPI</strong>.</td>
</tr>
<tr>
<td>Approver</td>
<td>User who approves or rejects the contract.</td>
</tr>
<tr>
<td>Cost Adjustment</td>
<td>Numerical increase or decrease in price of the renewed contract. To indicate a decrease in price, enter a negative number. A <strong>Cost Adjustment</strong> or <strong>Cost Adjustment Percentage</strong> can be specified, but not both.</td>
</tr>
<tr>
<td>Cost Adjustment Percentage</td>
<td>Percentage increase or decrease in price of the renewed contract. To indicate a decrease in price, enter a negative number.</td>
</tr>
<tr>
<td>Field</td>
<td>Descriptions</td>
</tr>
<tr>
<td>-------</td>
<td>--------------</td>
</tr>
<tr>
<td></td>
<td>percentage. A <strong>Cost Adjustment</strong> or <strong>Cost Adjustment Percentage</strong> can be specified, but not both.</td>
</tr>
</tbody>
</table>

5. Perform one of the following steps.
   - To save all entered data and change the substate to **Under Review**, click **Submit for Review**. The contract is sent to the specified **Approver**.
   - To save all entered data and change the substate to **Awaiting Review**, click **Save But Do Not Submit**. The **Renew** button is available to submit the renewed contract for review later.

6. Change any information on the **Contract** form, as necessary.
7. Click **Update**.

**What to do next**
If you selected the **Save But Do Not Submit** option, ensure that you click **Renew** when you are ready to submit the contract renewal for approval.

**Cancel a contract**
You can cancel a contract when the **State** is **Active**.

**Before you begin**
Role required: contract_manager or admin

**About this task**
After a contract is canceled, the following process occurs.
- The contract **State** changes to **Canceled**.
- Condition checkers are changed to inactive.
- **Renew** and **Extend** buttons become inactive.
- Contract rate cards become inactive.

**Procedure**
1. Navigate to **Contract > Contracts > All**.
2. Select a contract.
3. Click **Cancel Contract**.
4. Click **Yes** to confirm contract cancellation.
Verify contract administrator assignment for notification

An event runs automatically each night to send reminders to contract administrators about contract expiration dates so they can renew or renegotiate the contract. You can verify that the right contract administrator is assigned to the contract.

Before you begin
Role required: contract_manager or admin

About this task
When the contract.expiration event runs on the Contract [ast.contract] table each night, an email message is sent to the person identified as the contract administrator. This email is sent at the following times.

• 90 days ahead of the contract expiration date
• 60 days ahead of the contract expiration date
• 30 days ahead of the contract expiration date
• On the contract expiration date

A user with the admin role can edit the contract.expiration condition check that processes contract notifications.

Procedure
1. Navigate to Contract > Contracts > All.
2. Select a contract.
3. Check that the Contract administrator field contains the correct name. A single name can be specified.

Related information
Condition check definitions
Email and SMS notifications

Send the contract for approval
You can send a contract that is in Draft state for approval.

Before you begin
Role required: contract_manager or admin
About this task

Note: Contract approval is only applicable if you are manually adding your contract approvals in the Now Platform. If you have already approved your contracts, you are not required to use this option.

Procedure

1. Navigate to Contract > Contracts > All.
2. Select a contract in Draft state.
3. Select an Approver for the contract.
4. Click Submit For Review.
   An email message is sent to the selected approver and the contract Substate changes to Under Review.

Approve or reject a contract

If you are the contract manager, you can approve or reject a contract.

Before you begin
Role required: contract_manager or admin

Procedure

1. Navigate to Contract > My Approvals.
2. Select a contract in Requested state.
3. Perform one of the following tasks.
   • To approve the contract, click Approve. The contract Substate changes to Approved.
   • To reject the contract, Click Reject and enter a rejection reason in the Comments field. The contract Substate changes to Rejected.
4. Click Update.
   • A contract with the state set to Draft and a start date set in the future is kept in Draft until the start date is reached. If the contract has a Substate of Approved, the system changes the State to Active and removes the Substate value.
   • When a contract with a State of Draft and a Start Date set to a date in the past is approved, the contract State is automatically set to Active and Substate is left blank.
View approval history on contracts
You can view the approval history for a contract in the Approval History related list on the Contract form.

Before you begin
Role required: workflow_admin or admin

About this task
After a contract is sent to an approver for review, the approver name cannot be changed. If the approver rejects a contract, the same approver or a different approver can be specified before the contract is sent for approval again. Once the contract has been reviewed and approved, approval history records are automatically listed in the Approval History related list on the Contract form.

Procedure
1. Navigate to Contract and select a record.
2. Click the Approval History related list.
3. Click a record to view approval details.

Terms and conditions
You can add terms and conditions to a contract to keep all documentation that is relevant to a contract in one location.

The terms and conditions can be searched and used in reports. If multiple terms and conditions records are added to a single contract, set an order for the records so they appear in a specific sequence. The terms and conditions fields become read-only after a contract is sent for approval.

Users with the contract_manager role can read contract history and add terms and conditions.

There are three procedures involved in adding terms and conditions to a contract:

Create a terms and conditions record
You can create a terms and conditions record to add to a contract.

Before you begin
Role required: contract_manager or admin
Procedure

1. Navigate to **Contract > Contracts > Terms & Conditions** and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique ID used for the terms and conditions. This field is automatically generated.</td>
</tr>
<tr>
<td>Name</td>
<td>Name for the terms and conditions.</td>
</tr>
<tr>
<td>Contract</td>
<td>Link to the contract.</td>
</tr>
<tr>
<td>Used</td>
<td>Check box to indicate if the terms and conditions are associated with contract.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the terms and conditions.</td>
</tr>
</tbody>
</table>

2. Click **Submit**.

**Add terms and conditions to a contract**

After you create a terms and conditions record, add the record to a contract.

**Before you begin**

Role required: contract_manager or admin

Procedure

1. Navigate to **Contract > Contracts > All**.
2. Select a contract.
3. In the **Terms and Conditions** section, double-click **Insert a new row**.
4. Click the reference lookup icon and select a terms and conditions record from the list.

5. **Optional**: Enter a number in **Order** to specify the sequence in which the record should appear in the terms and condition document.

**Note**: If you attempt to enter a duplicate terms and conditions record for a contract and save the record, an error message appears and the new duplicate record is not added.
Build a terms and conditions document within a contract

After adding one or more terms and conditions records to a contract, you can build a terms and conditions document within the contract.

Before you begin
Role required: contract_manager or admin

About this task
The terms and conditions records are added in the sequence specified in the Order field.

Procedure
2. Select a contract.
3. Ensure that one or more terms and conditions records have been added to the Terms and Conditions section.
4. In Related Links, click Build Terms and Conditions. All records from the Terms and Conditions related list are added to the Terms and Conditions section of the contract record.

Build terms and conditions controls

5. Click Update.
Create a contract rate card
You can create rate cards to track contract expenses. Rate cards help to record and allocate costs.

Before you begin
You must activate Cost Management to use rate cards.
Role required: financial_mgmt_user, asset, or contract_manager

About this task
A contract rate card provides detailed price information for a contract and enables you to generate expense lines for recurring expenses automatically. There can be multiple rate cards for the same contract.

Consider the following case: an organization has a contract with a third-party company, which oversees technical operations in the organization’s data centers. The contract costs to use a specific server model in the New York data center are different from using the same server model in the Madrid data center. There are two rate cards to detail these costs separately.

Procedure
2. Select a contract.
3. In the Contract Rate Cards related list, click New.
4. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The contract rate card number.</td>
</tr>
<tr>
<td>Contract</td>
<td>The internal contract number.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The contract rate card type. Categorizing rate cards can be useful for reporting. Select Grow Business, Run Business, or Transform Business.</td>
</tr>
<tr>
<td>Name</td>
<td>A descriptive name for the contract rate card.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that indicates whether the rate card is available for use.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the contract rate card.</td>
</tr>
<tr>
<td>Start date</td>
<td>The date on which the contract rate card becomes active. Expense lines are generated for costs incurred beginning on</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field | Description
---|---
End date | The date on which the contract rate card becomes inactive. No expense lines are generated for costs incurred after the end date. For financial calculations to work, the date cannot be after the end date of the contract. The date is automatically set to the end date of the contract if no value is entered and the contract has an end date.

Interval | The amount of time between rate card charges. For example, *Monthly*, *Quarterly*, or *Annually*.

Cost center | The cost center financially responsible for the rate card.

Last processed | The most recent date on which the rate card was charged.

Next process | The next date on which the rate card will be charged.

Description | Detailed information about the rate card.

Sales tax | Check box that indicates whether to apply sales tax to the total cost.

Tax rate | The effective tax rate to apply to the total cost. Tax rate is usually the average tax rate charged.

Distribute cost | The method for distributing the amount listed in *Base cost* and generating expense lines.

Value | Type of value to use when *Allocate and distribute cost based on value* is selected in the *Distribute cost* field.

Base cost | The amount that must be paid before taxes.

Tax cost | The total cost of the tax.

Total cost | The final cost of the rate card after adjustments, such as taxes, have been applied.

---

5. Click **Submit**.

### Related information

**Allocating expenses**

**Use business services with expenses**

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Create a new expense line

Typically, expense lines are automatically generated based on assets or users, but you can create a new expense line manually if needed.

Before you begin
Role required: asset or contract_manager

Procedure
2. Select a contract.
3. In the Expense Lines related list, click New.
4. Complete the form.

Expense line table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the expense line.</td>
</tr>
<tr>
<td>Date</td>
<td>The date on which the expense line was created.</td>
</tr>
<tr>
<td>Rate Card</td>
<td>The identification number of the rate card to which the expense line is associated.</td>
</tr>
<tr>
<td>Rate type</td>
<td>The rate type that is considered during the expense line generation. This field is read-only.</td>
</tr>
<tr>
<td>Source ID</td>
<td>The identification number of the item associated with the expense line. If this field is filled in, corresponding information is automatically added to the Source fields on this form.</td>
</tr>
<tr>
<td>Amount</td>
<td>The monetary value of the item specified in the Source ID field. Enter a negative value to indicate a credit.</td>
</tr>
<tr>
<td>Process date</td>
<td>The date the expense line is processed.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Check box that indicates whether the expense line is on another expense line.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the expense line, either Pending or Processed.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The expense line category: Grow Business, Run Business, or Transform Business. Categorizing expense lines can be useful for reporting.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the expense line.</td>
</tr>
<tr>
<td>Asset</td>
<td>The identification number of the asset associated with the expense line, if any.</td>
</tr>
<tr>
<td>Fixed asset</td>
<td>Fixed asset that contains the asset in this expense line. A fixed asset is a container that holds one or more individual assets, including hardware or software assets. The system auto-populates this field with the appropriate fixed asset if the named Asset is contained within that fixed asset.</td>
</tr>
<tr>
<td>Contract</td>
<td>The identification number (not the contract number) of the contract associated with the Asset, if any.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user associated with the Asset, if any.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>The name of the configuration item associated with the expense line, if any.</td>
</tr>
<tr>
<td>Task</td>
<td>The identification number of the task associated with the expense line, if any.</td>
</tr>
<tr>
<td>Cost center</td>
<td>The cost center financially responsible for the item identified in Source ID, if any.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Generating expense lines based on assets or users

An expense line is an expense amount at a given point in time and the record that incurred or generated the expense. You can generate expense lines based on assets or users assigned to the contract.

Before you begin
Role required: financial_mgmt_user, asset, or contract_manager

About this task
Generating expense lines is a three-step procedure.

Add a user or asset to a contract
You can add a user or asset to a contract to generate expense lines.

Before you begin
Role required: financial_mgmt_user, asset, or contract_manager
Procedure

1. Navigate to **Contract Management > Contract > All.**
2. Create a new contract or select an existing contract.
3. In the **Assets Covered** or **Users Covered** related list, click **New.**
4. Specify an **Asset** or **User**.
5. Specify a **Date Added**.
6. Click **Submit**.
7. **Optional:** Repeat the previous steps to add more assets or users to the contract.

Create a rate card and assign a user or asset

You can assign a user or asset when you create a rate card. You can only assign the user or asset that is assigned to the contract.

**Before you begin**
Role required: financial_mgmt_user, asset, or contract_manager

Procedure

1. Navigate to **Contract Management > Contract > All.**
2. Select a contract with an assigned user or asset.
3. In the **Contract Rate Cards** related list, click **New.**
4. Specify a **Start date.**
   For financial calculations to work, the date cannot be before the start date of the contract.
5. Right-click the header bar and select **Save.**
6. In the **Asset Covered** or **Rate Card Users** related list, click **New.**
7. Select the **Asset** or **User** who is assigned to the contract.
   Only assets and users associated with the parent contract are listed.
8. Specify a **Date Added.**
9. Click **Submit.**

Configure rate card expense generation

After assets or users are added to the rate card, you can use the **Distribute cost** field in the Financial section of the contract to generate rate card expenses.
Before you begin
Role required: financial_mgmt_user, asset, or contract_manager

Procedure
1. Navigate to Contract > Contracts > All.
2. Select the contract to generate expenses.
3. In the Contract Rate Card related list, select a rate card.
4. In Distribute cost, select one of the following options to distribute the amount listed in Base cost.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split expense lines evenly across assets</td>
<td>Select Allocate and distribute cost per asset.</td>
</tr>
<tr>
<td>Split expense lines across assets based on asset value</td>
<td>For example, with a $100 Base cost and two assets, two expense lines for $50 are created.</td>
</tr>
<tr>
<td>Split expense lines evenly across users</td>
<td>Select Allocate and distribute cost based on value:.</td>
</tr>
<tr>
<td>Allocate the cost to the contract instead of the individual assets</td>
<td>For example, if you select the Cost option with a $100.00 Base cost, one asset worth $70, and one asset worth $30, two expense lines are created, one for $70 and one for $30.</td>
</tr>
</tbody>
</table>
5. Click **Update**. Expense lines are automatically generated by a scheduled job for costs incurred between the rate card **Start date** and **End date**. The scheduled job, **Process FM Costs**, runs on the Contract [ast_contract] table once per day. Expense lines are only generated from contracts with the **Active** or **Expired** state. You may want to generate expense lines for expired contracts to track previous expenses.

**Related information**

**Contract life cycle**

**View contract expense lines**

Use the **Expense Lines** related list to view and audit all the expenses recorded for a given contract.

**Before you begin**
Role required: financial_mgmt_user, asset, or contract_manager

**Procedure**

1. Navigate to **Contract > Contracts > All**.
2. Select a contract.
3. Select the **Expense Lines** related list.
4. Select an expense line record to view. Information such as expense line details, total cost of the contract, and the contract current value is listed.

**Monitor a contract**

You can monitor contracts by viewing contract history and creating contract reports.

**Before you begin**
Role required: asset or contract_manager

**About this task**

If changes are made to a contract start date, end date, or terms and conditions, a copy of the contract is automatically saved and placed in contract history. This is useful for tracking changes to a contract and keeping an audit trail. Configure the **Contract History** related list to include columns for creation and update so you can easily see who edited the contract.
Procedure
1. Navigate to **Contract > Contracts > All**.
2. Select a contract.
3. View the **Contract History** related list and perform one of the following actions.
   - If earlier versions of the contract exist, click a date in the **Contract Starts** column to view a version.
   - If an earlier version of the contract does not exist, change the contract’s **Start date** or **End date**. Right-click in the header bar and select **Save**. In the **Contract History** related list, click a date in the **Contract Starts** column to view the earlier version.

Run a contract report
A variety of contract reports are available to help track and manage contracts.

**Before you begin**
role required: contract_manager or admin

**Procedure**
1. Navigate to **Reports > View / Run**.
2. Select one of the following reports to run.

**Contract reports**

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Contracts by Cost Per Unit</td>
<td>All active contracts grouped in ascending order by average cost per unit.</td>
</tr>
<tr>
<td>Active Contracts by Lifetime Cost</td>
<td>All active contracts with an associated rate card grouped in ascending order by total cost. Total cost is measured from the beginning of the contract to the report run date.</td>
</tr>
<tr>
<td>Active Contracts by Monthly Cost</td>
<td>All active contracts grouped in ascending order by cost per month.</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active Contracts by Vendor</td>
<td>All active contracts alphabetically by vendor.</td>
</tr>
<tr>
<td>Active Contracts by Yearly Cost</td>
<td>All active contracts grouped in ascending order by cost per year.</td>
</tr>
<tr>
<td>All Contracts by State</td>
<td>Contracts grouped by state, such as Draft, Active, or Expired, in bar chart format</td>
</tr>
<tr>
<td>Asset Contracts by Type</td>
<td>All active contracts for assets grouped by type, in pie chart format.</td>
</tr>
<tr>
<td>Asset Contracts List</td>
<td>All active contracts for assets by contract number.</td>
</tr>
<tr>
<td>Contract Expenditure by Type</td>
<td>Total contract expenses by type, such as lease, maintenance, or warranty, in bar chart format.</td>
</tr>
<tr>
<td>Contract Expenditure by Vendor</td>
<td>Total costs of all contracts associated with a specific vendor, in bar chart format.</td>
</tr>
<tr>
<td>Contract Pipeline Report</td>
<td>All contracts with a state of Draft, Active, or Expired and a substate of Awaiting Review or Under Review, in bar chart format.</td>
</tr>
<tr>
<td>Expiring Contracts</td>
<td>All contracts expiring in the next 90 days.</td>
</tr>
</tbody>
</table>

**Condition check definitions**

Condition check definitions enable you to define logical conditions that indicate when to change a specific field value in a record.

A scheduled job, called Contract Compliance Checks, evaluates these condition check definitions nightly by running the condition checker. Use this condition checker to check start dates and end dates and to set expiration levels for contracts.
For example, a contract has a start date of March 1st. When the condition checker runs on March 1st, it verifies that the contract Substate is Approved and sets the contract State to Active based on the Start Date field.

The nightly condition checker sets the appropriate expiration level for active contracts based on the contract End Date. The expiration level can be viewed in the Contracts list. Knowing the expiration level can help contract managers renew or extend a contract before it expires.

**Define a condition check**

You can define a condition check to change values in a contract when the Contract Compliance Checks scheduled job runs each night.

**Before you begin**
Role required: contract_manager or admin

**Procedure**

1. Navigate to **Contract > Administration > Condition Check Definitions**.
2. Click **New**.
3. Complete the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table to which the condition applies. For a contract check definition, select Contract [ast.contract].</td>
</tr>
<tr>
<td>Category</td>
<td>The category for the condition check. Select <strong>Contract</strong> or <strong>None</strong>. The category is used for organizing information and reporting.</td>
</tr>
<tr>
<td>Condition field</td>
<td>The field to be updated, typically <strong>Expiration level</strong> or <strong>State</strong>.</td>
</tr>
<tr>
<td>Event name</td>
<td>The name for the event to be fired when this condition changes the value of the field. Create a name using this syntax: <code>&lt;table_name&gt;.&lt;condition_field&gt;</code>, for example, contract.validation.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the conditions are evaluated.</td>
</tr>
</tbody>
</table>

4. Right-click the header bar and click **Save**. The **Conditions** related list appears.
5. In the **Conditions** related list, click **New**.
6. Complete the form.

### Conditions fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The value the field is set to, if the expiration conditions are met.</td>
</tr>
<tr>
<td>Condition check</td>
<td>The associated condition check.</td>
</tr>
<tr>
<td>Table</td>
<td>The table associated with the condition check.</td>
</tr>
<tr>
<td>Event name</td>
<td>The name of the event this condition triggers.</td>
</tr>
<tr>
<td>Expiration Condition</td>
<td>The condition that must be true for the <strong>Condition check</strong> field to be set to this value (the <strong>Name</strong>). Add as many conditions as are needed.</td>
</tr>
<tr>
<td>Compliant state</td>
<td>System field. Do not use.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which the conditions are evaluated. The first condition that is found to match, where the Expiration Condition is true, is used, and no others are checked.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.
   The Condition Checks form reopens with the new condition listed in the related list.

8. **Optional**: Continue adding conditions as needed, following the steps above.

### Domain separation and Contract Management

Domain separation is unsupported in Contract Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: No support**

- The domain field may exist on data tables but there is no business logic to manage the data.
- This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.
## Related information

**Domain separation for service providers**

## Procurement

Procurement managers can use the ServiceNow® Procurement application to create purchase orders and to obtain items for fulfilling service catalog requests. Procurement offers the ability to perform the following functions.

- Track service catalog requests
- Create and manage purchase orders
- Create and manage transfer orders
- Receive assets

## Procurement roles

The Procurement application uses the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>procurement_admin</td>
<td>procurement_user</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog. Can refresh, add, delete, and rearrange gauges in the Procurement Overview module.</td>
</tr>
<tr>
<td>procurement_user</td>
<td>financial_mgmt_user,</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>and refresh gauges in the Procurement Overview module.</td>
</tr>
</tbody>
</table>

**Procurement workflows**

Procurement uses the following workflows.

- In the Service Catalog Request workflow, items ordered from the service catalog that cost over one thousand dollars require approval.

  ![Service catalog request workflow](image)

- In the Source Request workflow, catalog tasks are created so that a procurement manager can source the item by creating a transfer order or purchase order.

  ![Source request workflow](image)

These workflows are provided in the base system. You can edit these workflows in the graphical Workflow Editor or create a workflow to better fit your organization’s procurement needs.

**Related information**

Workflows
Use the Procurement Overview module

Use the gauges on the Procurement Overview homepage to help you track and manage requests, purchase orders, and other important aspects of the procurement process.

Before you begin
Role required: procurement_admin or procurement_user

Procedure
1. Navigate to Procurement > Overview.
2. Click elements within the gauges to obtain more information.
   - Example
     For example, click a request number to view the request record.

Activate Procurement

You can activate the Procurement plugin that provides core procurement capabilities.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the Procurement plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.
   - Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Procurement

Several types of components are installed with Procurement.
Demo data is available with Procurement. The demo data provides sample requests, purchase orders, purchase order line items, and receiving slips.

**Business rules installed with Procurement**

Procurement plugin adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust remaining quantity</td>
<td>Purchase order line items</td>
<td>Calculates the remaining quantity of items ordered on a purchase order line items by subtracting the amount received from the amount ordered.</td>
</tr>
<tr>
<td></td>
<td>[proc_po_item]</td>
<td></td>
</tr>
<tr>
<td>Can request be sourced</td>
<td>Request [sc_request]</td>
<td>Checks if a request can be sourced.</td>
</tr>
<tr>
<td>Cancel Procurement Orders</td>
<td>Request [sc_request]</td>
<td>Cancels all unreceived purchase orders and unshipped transfer order lines associated with the request's items if the request state changes to Closed Cancelled.</td>
</tr>
<tr>
<td>Check if req item is sourced</td>
<td>Requested Item [sc_req_item]</td>
<td>Sets the Sourced field on the parent request to true if all requested items have been sourced.</td>
</tr>
<tr>
<td>Check if request is sourceable</td>
<td>Requested Item [sc_req_item]</td>
<td>Checks if the request associated with a requested item can be sourced (obtained from a transfer order or by creating a purchase order to a vendor).</td>
</tr>
<tr>
<td>Create Assets</td>
<td>Receiving Slip Line [proc_rec_slip_item]</td>
<td>If the purchase order line item is available, creates the assets for a receiving slip line when the slip line assets are received.</td>
</tr>
<tr>
<td>Handle roll up states and assets removal</td>
<td>Purchase order line items [proc_po_item]</td>
<td>Manages purchase order line items if they are canceled or received. If a purchase order line is canceled, this business rule deletes any pre-created assets. This business rule also checks the status of other purchase order lines that share the same purchase order and assets.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>if necessary, updates the status of the purchase order. For example, when the last purchase order line is received, the status of the purchase order changes to <strong>Received</strong>.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Redirect TOL to existing TO-Procurement</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Attaches a transfer order line to an existing transfer order if the transfer order is in the <strong>Draft</strong> stage and has the same <strong>From stockroom</strong> and <strong>To stockroom</strong> values as the transfer order line.</td>
</tr>
<tr>
<td>Shipping Cost Changes</td>
<td>Purchase Order [proc_po]</td>
<td>Recalculates the total cost of the purchase order if the shipping rate changes.</td>
</tr>
<tr>
<td>State Change</td>
<td>Transfer Order Line [alm_transfer_order_line]</td>
<td>Marks the requested item as <strong>Received</strong> if the state of the associated transfer order line changes to <strong>Received</strong>.</td>
</tr>
<tr>
<td>State Change</td>
<td>Purchase order line items [proc_po_item]</td>
<td>Sets the time at which the purchase order line item is ordered and updates the original requested item when the purchase order line item is received.</td>
</tr>
<tr>
<td>State Change PO</td>
<td>Purchase Order [proc_po]</td>
<td>Changes the purchase order line item status when the status of the associated purchase order changes.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Purchase order line items [proc_po_item]</td>
<td>Calculates the total order cost based on the cost of individual items and the quantity ordered. When you receive a purchase order line item, this business rule also takes the following steps.</td>
</tr>
<tr>
<td>• Populates the <strong>List price</strong> field with the value from the <strong>Cost</strong> field unless you enter a different value.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Calculates the <strong>Total list price</strong> field value by multiplying the <strong>List price</strong> and <strong>Ordered quantity</strong> values.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update expected</td>
<td>Purchase order line items</td>
<td>Sets the <strong>Expected delivery date</strong> for purchase orders to the latest purchase order line <strong>Expected delivery date</strong>.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>delivery date for PO</td>
<td>[proc_po_item]</td>
<td></td>
</tr>
<tr>
<td>Update expected delivery date for POLs</td>
<td>Purchase Order [proc_po]</td>
<td>Sets the <strong>Expected delivery date</strong> of associated purchase order lines to the purchase order's <strong>Expected delivery date</strong> if at least one of the following conditions is true.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The purchase order line has no expected delivery date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The purchase order line's expected delivery date is later than the purchase order's expected delivery date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The purchase order line's expected delivery date is the same as the purchase order's previous delivery date.</td>
</tr>
<tr>
<td>Update Ordered Date</td>
<td>Purchase Order [proc_po]</td>
<td>Sets the <strong>Ordered date</strong> field to the date and time at which the status of the purchase order is set to <strong>Ordered</strong>.</td>
</tr>
<tr>
<td>Update PO</td>
<td>Purchase order line items [proc_po_item]</td>
<td>Updates the purchase order if the cost of any purchase order line item changes.</td>
</tr>
<tr>
<td>Update Purchase Order Line Receiving Slip Line</td>
<td>Receiving Slip Line [proc_rec_slip_item]</td>
<td>Updates the <strong>Quantity received</strong> field on the associated purchase order line item when a receiving slip item is received.</td>
</tr>
<tr>
<td>Update Request Item CI</td>
<td>Hardware [alm_hardware]</td>
<td>Sets the <strong>Configuration item</strong> field on the catalog task and requested item to the related hardware CI created during the procurement process.</td>
</tr>
</tbody>
</table>

**Related information**

**Business rules**

**Client scripts installed with Procurement**

Procurement plugin adds the following client scripts.
<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide request item if request is not empty</td>
<td>Catalog Task [sc_task]</td>
<td>Displays the task’s Request item and the request item’s Requested for value if the task is associated with a requested item and not directly with a request. Otherwise, if the task is associated with a request, the client script displays the Request and the request’s Requested for value.</td>
</tr>
<tr>
<td>Purchase Order Line Mandatory</td>
<td>Receiving Slip Line [proc_rec_slip_item]</td>
<td>Changes the Purchase Order Line field on the Receiving Slip Line form to mandatory if the associated receiving slip has a listed purchase order.</td>
</tr>
</tbody>
</table>

### Related information

#### Client scripts

**Script includes installed with Procurement**

Procurement plugin adds the following script include.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProcurementUtils</td>
<td>Provides utilities for Procurement.</td>
</tr>
</tbody>
</table>

**Tables installed with Procurement**

Procurement plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase Order [proc_po]</td>
<td>Stores information about items ordered, cost of items ordered, and users that require the items for orders placed with a vendor.</td>
</tr>
<tr>
<td>Purchase order line items [proc_po_item]</td>
<td>Stores information about items and quantity ordered on purchases orders.</td>
</tr>
<tr>
<td>Receiving Slip [proc_rec_slip]</td>
<td>Stores receiving information for items ordered with a purchase order. Can reference multiple receiving slip lines.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Receiving Slip Line [proc_rec_slip_item]</td>
<td>Stores receiving information for items ordered on a specific purchase order line, such as the items ordered, quantity ordered, and who ordered them.</td>
</tr>
</tbody>
</table>

**User roles installed with Procurement**

Procurement plugin adds the following user roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>procurement_admin</td>
<td>procurement_user</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog. Can refresh, add, delete, and rearrange gauges in the Procurement Overview module.</td>
</tr>
<tr>
<td>procurement_user</td>
<td>financial_mgmt_user, model_manager</td>
<td>Can create purchase orders without a request. Can view requests and requested items. Can view transfer orders. Can create a purchase order or transfer order when sourcing items for a request. Can view the vendor catalog. Can view and refresh gauges in the Procurement Overview module.</td>
</tr>
</tbody>
</table>

**Request items source**

A request from the service catalog can contain multiple items that must be obtained or sourced.

The following diagram illustrates the different methods for sourcing items.
Methods of sourcing requested items

Note: Only items with an assigned model can be sourced. Sourcing bundles is not supported.

Local stockroom for sourcing requests
You can source a request by using assets from the requester's local stockroom. If stock is available in the local stockroom, the asset is reserved and follows the fulfillment task to source the request. If stock in the local stockroom is unavailable, you can get the assets transferred from other stockrooms or create a purchase order.

Purchase order for sourcing requested items
Items not in a stockroom can be ordered with a purchase order and delivered to a destination stockroom. In the same purchase order, you can order multiple items.
You can choose to create the hardware asset and reserve it for a user after creating the purchase order. You can also do the same after you receive the items. For software items, you cannot pre-create the assets and assign them before they are received.

**Transfer order for sourcing requested hardware items**

To source requested hardware items, create a transfer order. You can choose to transfer the hardware assets from:

- One source stock room to multiple destination stockrooms.
- In case, if one source stock room doesn’t have sufficient stock, you can specify multiple stockrooms so that items can be transferred to single or multiple destination stockrooms.

**Add assignment for sourcing requested software items**

To source software items, add assignments wherein, you must assign rights of the software license. You can assign rights to a user or device so that they are entitled to use the software.

**Related information**

- Manage transfer orders
- Track a request from the service catalog
- Models
- Bundled models

**Create a purchase order from a request**

You can create a purchase order directly from a request. This enables procurement managers to obtain items and fulfill requests from the Service Catalog. You can create multiple purchase orders from a request.

**Before you begin**

Role required: procurement_admin or procurement_user

**Procedure**

1. Navigate to **Procurement > Requests > Requests**.
2. Click the **Number** of a request that has been approved but not sourced. Look in the **Request State** and **Sourced** columns.
3. In the **Catalog Tasks** related list, click a **Number**.
4. Click **Source Request**. The Source Request screen is displayed with a list of all the requested items.
5. Click **Add Purchase Order** in the requested item section.

6. In the **Vendor** list, select the vendor from which the requested item or items should be delivered.

7. In the **Out of Stock** field, verify if the value is **false**. If the vendor doesn't have stock, the field value will be **true**.

8. In the **Quantity** field, specify the quantity you want to order.

9. In the **Destination Stockroom** list, select the destination to which the requested item or items should be delivered.

10. **Optional:** Select the **Consolidate PO** check box to combine the listed items with existing purchase orders. When you check Consolidate Purchase Orders, all items sourced from the same vendor on the same request are placed on the same purchase order. When you select a vendor, the system automatically searches for purchase orders that have been created for the same request, have the same **Vendor** selected, and have the **Requested** status. If the system finds a match, all items are placed on the same purchase order and can be ordered together. If the system does not find a match, a new purchase order is created. For example, if you are purchasing 25 phones from Apple and an open purchase order already exists for Apple, the 25 phones are added to the open purchase order. If there are no open purchase orders for the selected vendors, new purchase orders are created. Items ordered from the same vendor are grouped together. Different items are shown on separate lines on the purchase order.

11. Click **Submit**. The catalog task reopens and you see a message that the purchase order was created. When you view the request, the **Sourced** check box is selected.

Create a transfer order from a request

You can create a transfer order directly from a request to source hardware items and consumables from stockrooms.

**Before you begin**

Role required: procurement_admin or procurement_user

**Procedure**

1. Navigate to **Procurement > Requests > Requests**.

2. Click the request **Number** of a request that has been approved but not sourced. Check the **Request State** and **Sourced** columns.
3. In the **Catalog Tasks** related list, click a **Number**.

4. Click **Source Request**.
   The Source Request screen appears with a list of all the requested items.

5. Click **Add Transfer Order** in the requested hardware item section.

6. In the **Source Stockroom** list, select a stockroom from which the hardware item should be sourced.

7. The **In Stock** column, displays the total stock available with the selected source stockroom.

8. In the **Transfer Quantity** field, specify the quantity you want to transfer.

9. In the **Destination Stockroom** list, select the destination to which the requested item or items should be delivered.

10. Click **Submit**.
    A transfer order is created to move the item or items from the **Source Stockroom** location to the **Destination Stockroom** location. When you view the request, the **Sourced** check box is selected.

**Related information**

**Manage transfer orders**

**Source requests from local stockrooms**
Get visibility into local stockrooms at the time of sourcing requests.

**Before you begin**
You can source a request by using assets from the requester's local stockroom. If stock is available in the local stockroom, the asset is reserved and follows the fulfillment task to source the request. If stock in the local stockroom is unavailable, you can get the assets transferred from other stockrooms or create a purchase order.

The Flow Designer application is used to create the Asset Local Stock subflow to take you through the process of using assets from your local stockroom to source your request. As the subflow takes you through the various stages, the asset details are automatically updated. You can open the Asset Local Stock subflow to view the status of the stages in the subflow.

**Note**: Use decision tables to customize the Asset Local Stock subflow. For more details, see Hardware Asset Management flow customization.

Role required:
• procurement_user or procurement_admin
• inventory_user or inventory_admin

Procedure
1. Log in with credentials for the role of procurement_user or procurement_admin.
2. Navigate to Service Catalog and click Hardware.
3. Select the hardware item you want to source and click Order Now. Your request is submitted and the Order Status form layout appears.
4. Click the request number.
5. On the Request form layout, click the Catalog Tasks related list to view the sourcing task for the request.
6. Open the sourcing task and click Source Request.

7. On the Source Request form layout, click Consume if stock is available in your local stockroom. If stock is not available in your local stockroom, click Transfer or Purchase to source the request via a transfer order or a purchase order. If you create a transfer order and want the local stockroom to be included in the list of stockrooms to choose from, the admin needs to turn on the glide.asset.procurement.sourcing.local_stock_transfer property.
8. Click Source Stockroom to select the local stock room from where you want to source the assets.
9. Click Reserved for to specify a user for whom you want to source the request for.
10. Click Submit. A consume asset task is created. An asset is selected from the stockroom and is reserved for the user who you selected in the Reserved for list. The state of the selected asset moves to in stock and the substate to reserved.
11. Log in with credentials for the role of inventory_admin or inventory_user.

12. Click the Requested Items related list and then click the request item.

13. Click the Asset Tasks related list and then click a task to select and assign an asset to the sourcing task.

The Consume Asset Task form layout appears in the Asset Tasks module. Based on the type of asset (hardware or consumable) that is being sourced, fields in the form layout may differ. The Assets Tasks module lists all the asset task records.

14. Make the changes you need and then close the task when you are done.

- For hardware assets: Assets are auto assigned to sourcing tasks but you can change an asset by clicking the **Asset** list. Once you are done, click **Close Task**.

- For consumable assets: the model for the asset appears on the form layout instead of the asset. Click **Close Task** or **Consume and Close**. If you click, **Consume and Close**, the reserved asset is automatically picked up and assigned to the user. If you click **Close Task**, you need to go to the Consumable form layout and assign an asset to the user manually.

**Add an assignment from a request**

You can add assignments directly from a request to source rights from software licenses.

**Before you begin**

Role required: procurement_admin or procurement_user

**Procedure**

1. Navigate to **Procurement > Requests > Requests**.

2. Click the request **Number** of a request that has been approved but not sourced.

   Check the **Request State** and **Sourced** columns.

3. In the **Catalog Tasks** related list, click a **Number**.

4. Click **Source Request**.

   The Source Request screen is displayed with a list of all the requested items.

5. Click **Add assignments** in the requested software item section.

6. In the **License Name** list, select a license from which the software rights should be sourced.
7. The **Available Rights** column, displays the total rights available with the selected license.

8. In the **Rights** field, specify the rights you want to assign.

9. From the **Type** list, select whether to assign the rights to a user or device.

10. In the **Assigned\Allocated** list, select the user or device to whom the requested item should be assigned.

11. Click **Submit**.

   An assignment is created to assign rights from the **License Name** location to the **Assigned\Allocated** user or device. When you view the request, the **Sourced** check box is selected.

12. If Software Asset Management is active, you are prompted to run the software counter. It is recommended that you run the counter, to ensure that you are in compliance.

13. Click **OK**.

   For auditing, the **Assigned Licences** related list in the Request form will provide the details of all the assignments done as part of this request.

**Procurement purchase order management for assets**

Accurate purchase order information is important for invoice tracking, receiving, and reporting in the ServiceNow platform.

The Procurement application enables users with an appropriate procurement role to manage purchase order information for assets. It also provides direct access to service catalog requests. You can create purchase orders and transfer orders directly from requests.

Before using the Procurement application, create assignment groups for catalog tasks. Assignment groups are sets of users, filtered by location, who can perform catalog tasks.

**Related information**

- Manage transfer orders
- Create a group

**Track a request from the service catalog**

The Procurement application lets you track a request that was ordered from the service catalog.

**Before you begin**

Role required: procurement_admin or procurement_user
About this task
When a user places an order from the service catalog, a request record is created to track the order. Each ordered item becomes a requested item that is listed on the request record. For example, a single request for one laptop, two monitors, and one keyboard creates the following records.

Request REQ00000001: 4 items
• Requested Item RITM00000001: 1 laptop
• Requested Item RITM00000002: 2 monitors
• Requested Item RITM00000003: 1 keyboard

Procedure
1. Navigate to Procurement > Requests > Requests.
2. Click a request Number.
   The Requested Items related list displays the items that were ordered. You can view the requested item, or view associated Purchase Orders, Transfer Orders, and Assignments on other related lists. A catalog task is automatically generated for each requested item to identify the source of the item, whether it must be purchased or transferred from a stockroom.

Cancel a request from the service catalog
You can cancel a request from the service catalog if, for example, the item is no longer needed or the request was not approved.

Before you begin
Role required: catalog_admin, procurement_admin, or procurement_user

About this task
When a service catalog request is canceled, the following actions occur automatically.

• Associated purchase orders that have not been received are canceled.
• All procurement tasks are canceled.
• Associated transfer orders are canceled, if all transfer order lines related to the transfer order are also associated with the service catalog request and the transfer order lines have all been canceled. If the transfer order contains transfer order lines that are not related to the service catalog request and those lines have not been canceled, the transfer order is not canceled.

Associated transfer order lines that are in the In Transit or Delivered stages are not canceled.
Procedure

1. Navigate to **Procurement > Requests > Requests**.
2. Click a request **Number**.
3. Click **Cancel Request**.

View and edit a catalog task

Catalog tasks are used to source items and fulfill requests. You can view and edit catalog tasks from a request.

**Before you begin**

**Role required:** procurement_admin or procurement_user

**About this task**

If a request requires approval, a catalog task is created automatically when the request is approved. If a request does not require approval, a catalog task is created automatically when the request is created.

ℹ️ **Note:** If a request contains one requested item and the item has no model specified, a catalog task is not created automatically. If a request has multiple requested items and only some of them have a model specified, catalog tasks are created automatically, but only for the requested items with a model.

Procedure

1. Navigate to **Procurement > Requests > Tasks**.
2. Open a catalog task.
3. Edit the fields as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the catalog task.</td>
</tr>
<tr>
<td>Request</td>
<td>The number of the request to which the catalog task is associated. The information in this field is derived from the <strong>Number</strong> field on the Request form.</td>
</tr>
<tr>
<td>Request item</td>
<td>The number of the requested item to which the catalog task is associated. The information in this field is derived from the <strong>Number</strong> field on the Requested Item form.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Requested for</td>
<td>The name of the person for whom the associated item was requested. The information in this field is derived from the Request or Request Item field.</td>
</tr>
<tr>
<td>Due date</td>
<td>The date by which the catalog task should be completed.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>The configuration item associated with the Request Item.</td>
</tr>
<tr>
<td>Approval</td>
<td>The status of catalog task approval: Not Yet Requested, Requested, Approved, or Rejected.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the catalog task: Pending, Open, Work in Progress, Closed Complete, Closed Incomplete, or Closed Skipped.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group from which an individual is selected to complete the catalog task.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The individual assigned to complete the catalog task, selected from the Assignment group.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>The list of users to receive email notifications when the work notes on the catalog task are updated.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the catalog task.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the catalog task.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how the catalog task is resolved.</td>
</tr>
<tr>
<td>Additional comments</td>
<td>Additional information about the catalog task that might be helpful for others to know. This is a customer-visible field.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Related information**

**Models**

**Create a purchase order**

You can create a purchase order. Purchase orders specify assets to order from a single vendor.

**Before you begin**

Role required: procurement_admin or procurement_user
About this task
For example, an organization can create a purchase order to buy 20 laptop computers or 10 servers. Information on a purchase order enables physical and financial tracking of the assets that were ordered.

You can also use a transfer order if an asset is already owned by an organization. A transfer order is used to internally transfer assets from one stockroom to another instead of purchasing the assets. For example, a company stockroom in New York has five laptops that are needed in Boston. You create a transfer order to move the laptops from the New York stockroom to the Boston stockroom.

After you create a purchase order, the Receiving Slip related list is available on the Purchase Order form. A receiving slip is created manually or automatically when the item is received. The Receiving Slip related list shows all receiving slips related to the purchase order. After a receiving slip is added to a purchase order, all fields on the purchase order record become read-only.

Procedure
1. Navigate to Procurement > Orders > Purchase Orders.
2. Click New.
3. Complete the form.

Purchase order fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the purchase order.</td>
</tr>
<tr>
<td>Due by</td>
<td>The date by which the purchase order Total cost must be paid.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The supplier to which the purchase order was issued.</td>
</tr>
<tr>
<td>Ship to</td>
<td>The stockroom to which items on the purchase order should be shipped.</td>
</tr>
<tr>
<td>PO date</td>
<td>The date on which the purchase order was created.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the purchase order: Canceled, Ordered, Received, Requested, or Suspended.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user to whom the purchase order is assigned.</td>
</tr>
<tr>
<td>Bill to</td>
<td>The location responsible for paying the purchase order Total cost.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the purchase order.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>General section</td>
<td></td>
</tr>
<tr>
<td>Shipping</td>
<td>The delivery method to be used when shipping the items on the purchase order.</td>
</tr>
<tr>
<td>Terms</td>
<td>The purchase order payment terms: <strong>Credit</strong>, <strong>Net 30 days</strong>, or <strong>Net 90 days</strong>.</td>
</tr>
<tr>
<td>Ship rate</td>
<td>The amount that must be paid for the delivery method specified in the Shipping field.</td>
</tr>
<tr>
<td>Total cost</td>
<td>The sum of all item costs on the purchase order and the shipping costs.</td>
</tr>
<tr>
<td>Description</td>
<td>A full description of the purchase order contents.</td>
</tr>
<tr>
<td>Details section</td>
<td></td>
</tr>
<tr>
<td>Initial request</td>
<td>The record number of the request that requires the items on the purchase order.</td>
</tr>
<tr>
<td>Requested by</td>
<td>The user requesting the items on the purchase order.</td>
</tr>
<tr>
<td>Requested</td>
<td>The date the user in the Requested by field requested the items on the purchase order.</td>
</tr>
<tr>
<td>Ordered</td>
<td>The date and time the Order button is clicked on the Purchase Order form.</td>
</tr>
<tr>
<td>Expected delivery</td>
<td>The date the items associated with the purchase order are expected to arrive in the stockroom identified in the Ship to field. This field cannot be edited when the purchase order has a Status of Received or Canceled. (For more information about this field, see Purchase order expected delivery date.)</td>
</tr>
<tr>
<td>Received</td>
<td>The date and time at which the purchase order status changed to Received.</td>
</tr>
<tr>
<td>Contract</td>
<td>The record number of the contract with the vendor from which the items on the purchase order are ordered.</td>
</tr>
<tr>
<td>Department</td>
<td>The department responsible for paying for the purchase order.</td>
</tr>
<tr>
<td>Budget number</td>
<td>The budget number associated with the purchase order.</td>
</tr>
</tbody>
</table>
4. Click Submit.

What to do next
Add purchase order line items to specify what you are ordering from this vendor.

Related information
  Manage transfer orders

Create a purchase order line item
After you save a new purchase order, you create purchase order line item records to specify the individual items to order.

Before you begin
Role required: procurement_admin or procurement_user

Procedure
1. Navigate to Procurement > Orders > Purchase Orders.
2. Open a purchase order.
3. In the Purchase order line items related list, click New.
4. Complete the form.

Purchase order line item fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the purchase order line item.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The supplier from which this product should be ordered.</td>
</tr>
<tr>
<td>Product Model</td>
<td>The model of the purchase order line item.</td>
</tr>
<tr>
<td>Product Catalog</td>
<td>The product catalog category to which the product model is assigned. For example, Hardware, Software, or Supplies.</td>
</tr>
<tr>
<td>Part number</td>
<td>The identification number assigned to the product model.</td>
</tr>
<tr>
<td>Request line</td>
<td>The identification number of the requested item record associated with this purchase order line item.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ordered</td>
<td>The date and time at which this purchase order line item was ordered.</td>
</tr>
<tr>
<td>Expected delivery</td>
<td>The date the purchase order line item is expected to arrive in the stockroom identified in the <strong>Ship to</strong> field on the purchase order record. This field is automatically filled with the value in the <strong>Expected delivery</strong> field on the purchase order record. This field can be edited when the purchase order line item has a <strong>Status</strong> of <strong>Requested</strong>. For more information about this field, see <strong>Purchase order expected delivery date</strong>.</td>
</tr>
<tr>
<td>Received</td>
<td>The date and time at which the purchase order line item status was changed to <strong>Received</strong>.</td>
</tr>
<tr>
<td>Purchase order</td>
<td>The purchase order record number associated with this purchase order line item.</td>
</tr>
<tr>
<td>Rights per license pack</td>
<td>Rights associated with each pack that is purchased for Microsoft Per Core or Microsoft Per Core with CAL licenses.</td>
</tr>
<tr>
<td>Number of packs</td>
<td>Number of packs for Microsoft Per Core or Microsoft Per Core with CAL licenses.</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the purchase order line item: <strong>Canceled</strong>, <strong>Ordered</strong>, <strong>Pending Delivery</strong>, <strong>Received</strong>, or <strong>Requested</strong>.</td>
</tr>
<tr>
<td>Ordered quantity</td>
<td>The number of product models that were ordered.</td>
</tr>
<tr>
<td>Received quantity</td>
<td>The number of product models that were shipped and received. The vendor may have sent multiple shipments. The received quantity can be larger or smaller than the <strong>Ordered</strong> quantity. For example, you may have ordered five laptops but the vendor sent six.</td>
</tr>
<tr>
<td>Remaining quantity</td>
<td>The number of product models that still need to be received to fulfill the <strong>Ordered</strong> quantity.</td>
</tr>
</tbody>
</table>
| List price          | The price at which the item retails, not including discounts. If the system creates the purchase order from the service catalog ordering process, the purchase order line item inherits the list price from the associated vendor catalog item. If the vendor catalog item does not have a list price value and you have not
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost</td>
<td>The cost of a single product model, including discounts. If the system creates the purchase order from the service catalog ordering process, the purchase order line item inherits the cost from the associated vendor catalog item <strong>Vendor Price</strong>.</td>
</tr>
<tr>
<td>Total cost</td>
<td>The cost of a single product model multiplied by the value specified in <strong>Quantity</strong>.</td>
</tr>
<tr>
<td>Stock Order</td>
<td>Read only and selected if the related request is using the bulk stock order workflow.</td>
</tr>
<tr>
<td>Short description</td>
<td>A few words or short phrase describing the purchase order line item.</td>
</tr>
</tbody>
</table>

5. Click **Submit**. The purchase order reopens with the line item listed. The purchase order and line item are in **Requested** status.

6. **Optional:** Continue adding purchase order line items for this vendor, as needed.

7. After you initiate the order with the vendor and are ready to show that the order was placed, click **Order**. The status of the purchase order and line items change to **Ordered**.

**Related information**

**Vendor catalog items**

**Purchase order status**

Purchase orders follow a specific life cycle. The **Status** field on the purchase order record is always read-only.

**Purchase order status**

- **Requested**
- **Ordered**
- **Pending Delivery**
- **Received**
## Status life cycle

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested</td>
<td>The status is <strong>Requested</strong> when you create a purchase order.</td>
</tr>
<tr>
<td>Ordered</td>
<td>The status changes to <strong>Ordered</strong> when you add purchase order line items, and click <strong>Order</strong>.</td>
</tr>
<tr>
<td>Pending Delivery</td>
<td>When you create assets before receiving them as a purchase order line item, the status of purchase orders and purchase order line items changes to <strong>Pending Delivery</strong> status.</td>
</tr>
<tr>
<td>Received</td>
<td>When ordered assets arrive in the specified stockroom and you click <strong>Receive</strong>, the status of purchase orders and purchase order line items changes to <strong>Received</strong>.</td>
</tr>
<tr>
<td>Canceled</td>
<td>You can cancel a purchase order if its status is <strong>Requested</strong>, <strong>Ordered</strong>, or <strong>Pending Delivery</strong>. For more information, see <strong>Cancel a purchase order</strong>.</td>
</tr>
</tbody>
</table>

## Purchase order expected delivery date

The purchase order record and the purchase order line item record both contain the **Expected delivery** date field.

The **Expected delivery** field can be edited on both records. Editing the field on one record can change the field on the other record.

- If you add an expected delivery date to the purchase order and the expected delivery date field on the purchase order line item is blank, the date on the purchase order is added automatically to the purchase order line item.
- If you add an expected delivery date on the purchase order line item and the expected delivery date field on the purchase order is blank, the date on the purchase order line item is added automatically to the purchase order.
- If the purchase order and the purchase order line item have the same expected delivery date and you change the date on the purchase order, the date is changed automatically on the purchase order line item.
- If you change the date on the purchase order line item to a date that is later than the one specified on the purchase order, the date on the purchase order is changed to the new date. The expected delivery date of a purchase order
line item cannot be later than the expected delivery date on the associated purchase order.

- If you change the date on the purchase order line item to a date that is earlier than the date specified on the purchase order, the date on the purchase order remains the same.

**Cancel a purchase order**

You can cancel purchase orders with a status of **Requested**, **Ordered**, or **Pending Delivery**.

**Before you begin**

Role required: procurement_admin or procurement_user

**About this task**

Purchase order line items can also be canceled from a purchase order.

**Procedure**

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order to cancel.
3. Click **Cancel**.
   - All associated purchase order line items that have not been received are canceled. Any assets created for the purchase order are deleted.

**Cancel a purchase order line item**

You can cancel a purchase order line items with a status of **Requested**, **Ordered**, or **Pending Delivery**.

**Before you begin**

Role required: procurement_admin or procurement_user

**About this task**

Keep the following in mind when you cancel a purchase order line item.

- When a purchase order line item is canceled, if all other line items are also canceled, the purchase order is canceled.
- After a purchase order line item is canceled, it can be reordered if the associated purchase order has not been canceled or received.
• If you cancel a purchase order line item for which assets were created, the assets are deleted from the system and removed from the purchase order.
• If you reorder the same purchase order line item, the assets are recreated for that line if the line has a status of **Pending Delivery**.

**Procedure**

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order.
3. In the **Purchase order line items** related list, select a line item to cancel.
4. Click **Cancel**.

**Reorder a purchase order**

You can reorder a purchase order that was canceled.

**Before you begin**

Role required: procurement_admin or procurement_user

**Procedure**

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order with a status of **Canceled**.
3. Click **Order**.
   - The status changes to **Ordered** for the purchase order and all associated purchase order line items.

**Reorder a purchase order line item**

You can reorder a purchase order line item that was canceled.

**Before you begin**

Role required: procurement_admin or procurement_user

**Procedure**

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Open a purchase order.
3. In the **Purchase order line items** related list, select a line item with a status of **Canceled**.
4. Click **Order**.
The purchase order line item **Status** field changes based on the **Status** field of the associated purchase order. For example, if the purchase order has a status of **Pending Delivery**, the purchase order line item status changes to **Pending Delivery** and the assets for the purchase order line item are created automatically.

**Create an asset and reserve it for the requester**

In the procurement process, hardware assets can be created before the assets are delivered. Creating the asset before they’re delivered allows you to create the asset record with an asset tag and serial number early in the process and reserve the asset for the user who requested it. The receiver can only select the assets to be received as assets are pre-created.

**Before you begin**

Role required: procurement_admin or procurement_user

**About this task**

Some requests must be approved before items on the request can be sourced. In the base system, requests over $1,000 require approval. To change the $1,000 approval threshold and other workflow attributes, edit the Service Catalog Request workflow.

When the asset state is **In stock**, the **Reserved for** field is maintained as the asset is received and placed in a stockroom. When the asset state changes to **In use**, the **Reserved for** field is relabeled **Assigned to**. If there is a name in the **Reserved for** field, the name is retained when the field is relabeled. A user with the asset role can change the name in the **Assigned to** field. Changing the name is helpful, for example, if an IT technician orders 10 laptops and must assign them to individual users.

⚠️ **Note:** If assets are not created prior to delivery, they are automatically created from line items when purchase orders are received. Also you can enter the asset details and receive them when the purchase orders are received.

**Procedure**

1. Navigate to **Procurement > Requests > Tasks**.
2. Open a task with a **State** of **Open** and a **Short description** of **Source Request Items**.
3. Click **Source Request**.
• If the request is already fulfilled or the items in the request are not sourceable, the **Source Request** button is hidden.

• If the requested item does not have an assigned model, the item is not listed on the Source the Request dialog box.

• Any items on the purchase order that have a remaining quantity of 0 are not listed on the Source the Request dialog box.

4. Select a **Destination Stockroom**.

5. Select the **Create PO** option for one or more listed items.

6. For each item requiring a purchase order, select a **Vendor**.

7. Click **OK**.

8. Navigate to **Procurement > Orders > Purchase Orders**.

9. Open the purchase order you just created. If you created a purchase order for more than one item, multiple purchase orders may have been created; select one of them.

10. Click **Order**. After items are ordered, no additional purchase order line items can be added to the purchase order. The status of all purchase order line items changes to **Ordered**.

11. Click the **Create hardware assets prior to delivery** related link to automatically create hardware assets for all purchase order line items. Hardware assets are listed in the **Assets** related list. Click an asset in the list to view the asset record. Except for consumables, the **Reserved for** field contains the name of the user who made the original request.

You can also create assets for individual purchase order line items. On a purchase order, go to the **Purchase order line items** related list and click a specific purchase order line item number. Then, click the **Create hardware assets prior to delivery** related link. Only the hardware assets included on the purchase order line item are created.

**Related information**

- Set asset states and substates
- Models

**Receive assets**

Assets can be received and added to the system when they are delivered to a stockroom.
Users with an appropriate procurement role can receive assets. If one purchase order contains multiple purchase order lines, the lines can be received at different times. This is useful if items arrive at the stockroom in different shipments. The purchase order status does not change to **Received** until all purchase order lines are received.

As an alternative to receiving assets when they arrive, you can create assets before they arrive and reserve them for the requester.

**Receive an asset**

When assets are received and delivered to a stockroom, they are added to the system.

**Before you begin**

Role required: procurement_admin or procurement_user

**About this task**

When you receive assets:

- If you have not pre-created hardware assets, you can enter asset details and reserve them for users.
- You can over receive an order wherein, the received quantity can be higher than the ordered quantity.
- If you have ordered multiple items with different receiving stockrooms, you can receive them at the time.

**Procedure**

1. Navigate to **Procurement > Orders > Purchase Orders**.
2. Select a purchase order with a **Status** of **Ordered** or **Pending Delivery**.
3. Click **Receive**. The Receive Purchase Order screen appears with the list of the products ordered.
4. Select the **Received** check box for the line items you are receiving.
5. To receive software assets:
   
   a. Edit the **Receiving Stockroom** if the items arrived at a different stockroom than the one specified on the purchase order.
   
   b. Edit the **Receiving Quantity** if the number of items delivered does not match the number ordered.
c. Edit the **Unit Cost** if the price changed between the time the item was ordered and the time it arrived at the stockroom. Enter a number; the number can include decimals.

d. Click **Capture Asset tags** to enter asset details. You cannot enter details for assets more than the received rights.

e. The **Capture Asset Tag** dialog box, click **Insert a new row**.

f. Enter the asset tag, serial number, rights, and License key

6. To receive hardware assets and consumables:

a. Edit the **Receiving Stockroom** if the items arrived at a different stockroom than the one specified on the purchase order.

    ✉️ **Note:** The asset bundle when received creates the asset bundle with the status as **Bundle**. You need to add the individual assets under the asset bundle.

b. Edit the **Receiving Quantity** if the number of items delivered does not match the number ordered.

c. Click the **Reserve** toggle button to reserve the item.

    When a reserved item is received, the **State** and **Substate** fields on the corresponding asset record are automatically set to **In stock** and **Reserved**, respectively. If the **Reserve** button is not clicked for an item, the **State** and **Substate** fields on the corresponding asset record are set to **In stock** and **Available**.

    ✉️ **Note:** You cannot reserve consumables.

d. From the **Reserved for** list select a user you want reserve the asset for.

    If a name was specified in the **Requested for** field on the Purchase order line item form, the name is added automatically but can be changed.

    You can add multiple users in the **Capture Asset tags** dialog box.

e. Click **Capture Asset tags** to enter asset details. You cannot enter details for assets more than the received quantity. You can also reserve assets for a user.

    ✉️ **Note:** If you have pre-created the assets, you must select the ones you want to receive.
f. On the **Capture Asset Tag** dialog box, click **Insert a new row**.

g. Enter the asset tag and serial number.

h. From the **Reserved for** list, select the user for whom the item was ordered. If a name was specified in the **Requested for** field on the Purchase order line item form, the name is added automatically but you can change it.

i. Edit the **Unit Cost** if the price changed between the time the item was ordered and the time it arrived at the stockroom. Enter a number; the number can include decimals.

7. Click **Submit**.
   A confirmation message displays with the details of assets received.

8. Click **OK**.
   A receiving slip is automatically created and can be viewed in the **Receiving Slips** related list. If items on a purchase order are received at different times, a new receiving slip is created each time any item on the purchase order is received. For example, if 30 laptop computers were ordered and arrived in three separate shipments, three receiving slips are created.

   Different assets are created for each hardware item. If there is software, one single asset is created for each license if you don’t split the rights. And for consumables, if an asset exists, it is updated, or new assets are created.

### Create a receiving slip

Receiving slips are created automatically during the process of receiving assets. You can also create receiving slips manually.

**Before you begin**

Role required: procurement_admin or procurement_user

**About this task**

After a receiving slip has been created for a purchase order, all fields on the purchase order record are changed to read-only.

**Procedure**

1. Navigate to **Procurement > Receiving > Receiving Slips**.
2. Click **New**.
A **Number** is assigned automatically. The current date and time is added automatically to the **Received** field.

3. Select a **Purchase Order**.
   Only purchase orders with a status of **Ordered**, **Pending Delivery**, or **Requested** are listed in the selection window. The **Vendor** column lists the vendor specified on the purchase order. The **Ship to** column lists the destination stockroom specified on the purchase order.

4. Select a **Receiving Stockroom**.

5. Click **Submit**.

**What to do next**
Add a receiving slip line to the receiving slip to identify the items from the purchase order that were received.

**Create a receiving slip line**
When assets arrive at a stockroom and you receive them, a receiving slip is created on the purchase order. You create a receiving slip line to identify the specific assets and quantities that were received.

**Before you begin**
Role required: procurement_admin or procurement_user

**About this task**
If the asset already exists, the asset record is updated when you save the receiving slip line. If the asset does not already exist, a new hardware or software asset record is created. The **Model category** and **Configuration item** fields are automatically filled in on the new asset record based on information in the request, purchase order, or receiving slip. If **Asset Tag** and **Serial Number** information exists, it is not overwritten.

**Procedure**
1. Navigate to **Procurement > Receiving > Receiving Slips** and open a receiving slip.

2. In the **Receiving Slip Lines** related list, click **New**. The following fields are completed automatically.
   - A **Number** is assigned.
   - In **Received**, the current date and time are added.
   - In **Received by**, the currently logged in user is added.
3. In **Purchase Order Line**, click the reference lookup icon and select a purchase order line. The **Purchase Order Line** field is mandatory if the parent receiving slip has an associated purchase order. Only purchase order lines that are associated with the same purchase order linked to the parent receiving slip are available to select.

4. In **Quantity**, enter the number of items received. For example, five items were ordered, but only two are being received.

5. **Optional:** Edit the **Received by**, **Requested for**, and **Unit cost** fields, as needed.

6. **Click** **Submit**. After you create a receiving slip line, the **Receiving stockroom** field on the Receiving Slip record becomes read-only.

**Consumable assets**

A consumable asset is one that is purchased in quantity and distributed. It is assigned to the consumable model category, and the asset record tracks the quantity that is available and total cost. When consumable assets are received, they are merged into an existing consumable record, if available.

For the records to merge, the consumable cannot be listed on an active transfer order and the **Model**, **Location**, **Model Category**, **Stockroom**, **Status**, and **Substatus** fields on the asset record must match.

If consumables are merged into an existing consumable record, the cost of the additional consumables received is added to that of the existing consumables in the record. For example, if 50 computer keyboards arrive and 20 keyboards of the same model exists in the receiving stockroom, the two records are merged showing 70 keyboards in the stockroom with a combined total cost.

If no matching consumable record exists in the receiving stockroom, a record is created. After the consumables are received, the quantity is updated, but individual consumables are no longer tracked within the Procurement application and are not displayed on receiving slip lines.

**Domain separation and Procurement**

Domain separation is supported in Procurement processing. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Standard**

The support level is Standard but has some exceptions or special conditions.
• Includes **Basic** level

• Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must be able to configure minimum viable product (MVP) business logic and data parameters. This configuration is done per tenant, as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see [Application support for domain separation](#).

**How domain separation works in Procurement**

To create or edit Purchase Orders (POs) or PO line items that distinguish the domain, customers must be working in the proper domain. When adjusting any configuration, you should be in the domain where you’re doing the work. Use the domain picker to choose the correct domain to work in.

**Related information**

- Domain separation for service providers

**Product Catalog**

The product catalog is a set of information about individual models. Models are specific versions or various configurations of an asset. Asset managers use the product catalog as a centralized repository for model information.

A detailed and well-maintained product catalog can coordinate with service catalog, asset, procurement, request, contract, and vendor information.

Models published to the product catalog are automatically published to the Service Catalog. The service catalog includes information about goods (models) and services. If the model is available from multiple vendors, a model can be listed more than once. Models are included with the Asset Management application.

Keep the following in mind when working with the product catalog.

• A product catalog item can be linked to multiple vendor catalog items or to a single model.

• A model can only have one product catalog item.

• A vendor catalog item can only have a single product catalog item.
Related information

Asset and CI management

Components installed with Product Catalog

The following components are installed with the Product Catalog plugin.

Demo data is available with the product catalog. The demo data provides various models, model categories, product catalog items, vendor catalog items, and vendors.

Tables installed with Product Catalog

Product Catalog plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call [new_call]</td>
<td>The base table for Product Catalog that contains all call information.</td>
</tr>
<tr>
<td>Hardware Catalog [pc_hardware_cat_item]</td>
<td>Stores all hardware catalog items that have been published from the Product Model [cmdb_model] base table. Extends the Product Catalog Item [pc_product_cat_item] table.</td>
</tr>
<tr>
<td>Product Catalog Item [pc_product_cat_item]</td>
<td>Stores all information for the product catalog. This table extends the Catalog Item [sc_cat_item] table.</td>
</tr>
<tr>
<td>Software Catalog [pc_software_cat_item]</td>
<td>Stores all software catalog items that have been published from the Product Model [cmdb_model] base table. Extends the Product Catalog Item [pc_product_cat_item] table.</td>
</tr>
<tr>
<td>Vendor Catalog Item [pc_vendor_cat_item]</td>
<td>Stores all vendor catalog item information.</td>
</tr>
</tbody>
</table>

Roles installed with Product Catalog

Product Catalog plugin adds the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>model_manager</td>
<td>Can create CMDB models.</td>
<td>none</td>
</tr>
</tbody>
</table>
### Role Description

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>category_manager</td>
<td>Can do everything that model managers can do and can administer model categories.</td>
<td>model_manager</td>
</tr>
</tbody>
</table>

### Script includes installed with Product Catalog

Product Catalog plugin adds the following script include.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProductCatalogUtils</td>
<td>Utilities for creating and maintaining product catalog items derived from vendor catalog items and models.</td>
</tr>
</tbody>
</table>

### Client scripts installed with Product Catalog

Product Catalog plugin adds the following client script.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Script contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Model Fields</td>
<td>[pc_vendor_cat_item]</td>
<td>Adds the description and price, if they do not exist, when a vendor catalog item is added to the product catalog.</td>
</tr>
</tbody>
</table>

### Related information

#### Client scripts

### Business rules installed with Product Catalog

Product Catalog plugin adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear model</td>
<td>[pc_product_cat_item]</td>
<td>Clears the link on a model when the link is cleared from the product catalog.</td>
</tr>
<tr>
<td>Create child product</td>
<td>[cmdb_hardware_product_model]</td>
<td>Creates entries in the product catalog for all items in a bundled model when the bundled model is created.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>catalog entries</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sync to Product catalog item</td>
<td>[pc_vendor_cat_item]</td>
<td>Updates the corresponding field in the product catalog when a field is updated.</td>
</tr>
<tr>
<td>Sync to Product catalog item</td>
<td>[cmdb_model]</td>
<td>Updates the corresponding field in the product catalog when a field is updated.</td>
</tr>
</tbody>
</table>

**Related information**

**Business rules**

**Models**

Models are specific versions or various configurations of an asset. Models are used for managing and tracking assets through various ServiceNow platform asset applications, including Product Catalog, Asset Management, and Procurement.

Model definitions can be based on vendor-provided criteria, for example, the manufacturer name Apple MacBook Pro, or on a custom abstraction, for example, Graphic Designer Workstation. All model information is located in the Product Catalog application.

A model can be in one or more model categories. For example, a laptop can be a computer and a server. Model definitions specify whether the model creates an asset, a configuration item, or both. On a hardware model record, compatible hardware models can be added.

Unless otherwise noted, working with product models requires the model_manager role. This role is contained by other roles, such as sam, category_manager, and asset.

**Creating models**

Models are created in the Product Catalog > Product Model > All Models module.

See Model form fields for a list of the fields that appear on all models, regardless of the type of model.
Related information

Asset Management
Procurement

Model form fields

There are fields on the Model form that apply to all types of models.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the model. A system property called <code>glide.cmdb_model.display_name.shorten</code> controls how software model display names are generated.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>The company that built the model.</td>
</tr>
<tr>
<td>Name</td>
<td>The manufacturer-assigned name of the model or abstract name specified by the model manager, such as Field Agent Laptop.</td>
</tr>
<tr>
<td>Edition</td>
<td>The edition of the software model, such as Professional.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the model.</td>
</tr>
<tr>
<td>Model categories</td>
<td>The categories to which the model is assigned. This field is a glide list and cannot be used to create reports.</td>
</tr>
<tr>
<td>Asset tracking</td>
<td>The process by which the model can be tracked. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• Leave to Category: model is transparent and the category defines the asset class.</td>
</tr>
<tr>
<td></td>
<td>• Create Consumable Asset: model forces the asset class to be consumable, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td></td>
<td>• Don't create assets: model blocks asset instantiation, regardless of what the category defines as the asset class.</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>The method for purchasing the model. Options are Both, Buy, or Lease.</td>
</tr>
<tr>
<td>Cost</td>
<td>The cost of a single unit of the model.</td>
</tr>
<tr>
<td>Depreciation</td>
<td>The depreciation scheme for the model.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Salvage value</td>
<td>The estimated value that an asset realizes upon its sale at the end of its useful life. This value must be less than or equal to the cost of the asset.</td>
</tr>
<tr>
<td>Model number</td>
<td>The specific model number assigned to the item by the manufacturer.</td>
</tr>
<tr>
<td>Barcode</td>
<td>The barcode number assigned to the model. Barcodes are assigned by the manufacturer.</td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the model. Options are <strong>In Production</strong>, <strong>Retired</strong>, and <strong>Sold</strong>.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Capex</strong>: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Opex</strong>: Operational expenditure is an on-going expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Certified</td>
<td>The option that determines whether the model is approved for use.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the model that would be helpful for others to know.</td>
</tr>
<tr>
<td>Assets</td>
<td>The assets created from this model. This creation can have any combination of assets and configuration items. For example, with a single hardware model you can have assets and no configuration items, configuration items and no assets, or have both.</td>
</tr>
<tr>
<td>Configuration Items</td>
<td>The configuration items created from this model. Can have any combination of assets and configuration items.</td>
</tr>
<tr>
<td>Product Catalog</td>
<td>The information about the model as it appears in the product catalog and service catalog. Information only appears if the model has been published to the product catalog.</td>
</tr>
</tbody>
</table>

**Create hardware models**

Use hardware models to track equipment assets such as servers and racks. You can create a new hardware model.
Before you begin
Role required: model_manager

Procedure
1. Navigate to Product Catalog > Product Model > Hardware Models.
2. Click New.
3. Complete the form.
   For general field descriptions, see Model form fields. The hardware model fields listed are found in the Information section of the form.

   Model form fields for hardware models

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power (watts)</td>
<td>The electrical power, in watts.</td>
</tr>
<tr>
<td>Height (U)</td>
<td>The total height of the hardware item, in inches.</td>
</tr>
<tr>
<td>Flow Rate (cfm)</td>
<td>The flow rate of the hardware model, expressed in cubic feet per minute.</td>
</tr>
<tr>
<td>Sound Power (bels)</td>
<td>The noise measurement, in bels (1 bel=10 decibels).</td>
</tr>
<tr>
<td>Weight (lbs)</td>
<td>The total weight, in pounds.</td>
</tr>
</tbody>
</table>

4. Click Update.

Add compatible models to a hardware model
On a hardware model record, you can add compatible hardware models, giving you a good method for tracking hardware assets that can work together.

Before you begin
Role required: model_manager

About this task
ℹ️ Note: Hardware models included in bundled models cannot be added as compatibles.

Procedure
1. Navigate to Product Catalog > Product Model > Hardware Models.
2. Click a hardware model Name.
3. Click Add Compatible.
4. Select a compatible model.
5. Click Submit.
   The selected model is listed in the **Compatibles** related list.

**Related information**
- Models
- Bundled models

**Add substitute models to a hardware model**
On a hardware model record, you can add substitutes to track what hardware models can be substituted for another hardware model.

**Before you begin**
Role required: model_manager

**About this task**
For example, a 19” monitor can be a valid substitute for a 17” monitor. Note that substitutions are directional so, in this case, a 17” monitor is not a substitution for a 19” monitor. Information about valid substitute models is useful when you select models while creating transfer orders.

When you select substitute models, note the following conditions.
- Substitute models can be used with work management transfer orders.
  Substitute models are not used in procurement part sourcing.
- Hardware models included in bundled models cannot be added as substitutes.

**Procedure**
1. Navigate to **Product Catalog > Product Model > Hardware Models**.
2. Click a hardware model **Name**.
3. Click **Add Substitution**.
4. In the **Collection** list on the left, double-click a hardware model.
   The hardware model is added to the **List** on the right.
5. Click **Save**.
   The model is listed in the **Substitutes** related list.
Related information

Models
Bundled models
Manage transfer orders
Procurement

Create consumable models
Consumables are items that are tracked as a group, not individually. An example of consumable items is computer keyboards.

Before you begin
Role required: model_manager

Procedure
1. Navigate to Product Catalog > Product Model > Consumable Models.
2. Click New.
3. Complete the form.
   For general field descriptions, see Model form fields. There are no fields specific to consumable models.
   Any consumable assets you create and assign to the new model are displayed in the Consumables related list on the model record.
4. Click Submit.

Create a service model
Create a service model for all the services your organization wants to monitor.

Before you begin
Role required: model_manager

About this task
A service model is a class of product models to define Software as a Service (SaaS) products. It defines the service and contains the different attributes, choices, and components that can be configured to a customer’s specifications.

Service models have a specific model category called Application Service, which links a service model to the Application Service CI class.

There are two ways of creating a service model.
Procedure

1. Perform one of the following actions.
   • Navigate to **Product Catalog > Product Models > Service Models > New**.
   • Navigate to **Product Catalog > Product Models > All Models > New > Service**.

2. Fill out the fields on the form.

   **Service Model form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the service model.</td>
</tr>
<tr>
<td>Model categories</td>
<td>By default, the model category is <strong>Application Service</strong>.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the service model. A service model can be <strong>In Production</strong>, <strong>Retired</strong>, or <strong>Sold</strong>.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description for the service model.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Bundled models**

A bundled model is a single model comprised of individual models. For example, a laptop, printer, keyboard, and mouse can be combined into a single bundled model. If you assign any one asset from the bundled model to an individual, that person receives all the components in the bundle.

Bundled model is a template to define the kind of assets that would be a part of asset bundles. To maintain the integrity between asset bundles and bundled models, select the **Bundle assets** check box in the Product Model form layout. Once you select the check box, the status of the bundled model defaults to **Build**. While the status is in build, you can add make changes to the bundled model. Once you change the status to **In Production**, no changes can be made to the bundled model. Now that the bundled model is read-only, you can create asset bundles out of this bundled model. You can change the status of the bundled model back to **Build** only if there are no asset bundles associated with the bundled model.
Note: The Bundle assets check box functionality is available only with the Hardware Asset Management licensable application. Hardware Asset Management is available in the ServiceNow Store. To view more information on the asset bundle functionality, see asset bundles.

Bundled models can be abstract or concrete.

**Abstract**

Permits use of one model in multiple bundles. The abstract bundle is created as a container. One asset in the bundle is specified as the main component. Model categories define which assets can be included in a bundle. Model categories also define what can be the main component of a bundle.

Add a main component to make it easier to track the bundle components. For example, create an abstract bundle adding a computer as the main component and a mouse and keyboard as additional components. When the bundle is assigned to a user, the asset record for the computer shows the computer, mouse, and keyboard all assigned to the user. Abstract bundles are used more often than concrete bundles.

**Concrete**

Is a fixed bundle where the main component is an asset. Specify the main component and the other components to create an exact bundle. Concrete bundles do not allow for a many-to-many relationship with models.

Keep the following tips in mind when creating and using bundled models.

- Bundles can be nested inside bundles.
- Any type of model can be used in a bundle.
- When a parent link is defined, the fields related to assignment and state of the child assets are read-only. They are populated based on the parent's assignment and state fields.
- If you make a change to the parent bundle, the children in the bundle are affected. For example, if you assign a bundle to an individual, all child asset records show that same individual as the person assigned.
- You cannot pre-allocate bundles.
- In a bundle, consumables are consumed and assets are set to the same state as the main component.
- Only the bundle, not individual components, can be part of a transfer order.
• You control what can go into a bundle through the model category. For example, the model category **Servers** could be set to never allow servers in bundles.

• To create a collection of software, you must create a suite instead of a bundled model.

• A software license cannot be the main component of a bundle.

To create an abstract model, set the model category to **Bundle** and add the components. To create a concrete model, create a model in the **Product Catalog > Product Model > Bundled Models** module and add components.

**Related information**
- Create pre-allocated assets
- Consume consumable assets
- Model categories

**Add model components to a bundle**
Add model components to a model as needed, for example, when you upgrade a bundle to include additional assets.

**Before you begin**
Role required: model_manager and asset

**Procedure**
1. Navigate to **Product Catalog > Product Model > Bundled Models**.
2. Open a bundle record.
3. In the **Model Components** related list, click **New**.
4. Select the **Model category** of the component, such as **Computer**.
5. Select the **Component**, such as **Apple Computer MacBook Pro 17**".
6. Select the **Is main component** check box if this component is the one that other components are attached to.
7. Click **Submit**.
8. Repeat steps 3–7 to add more components to the bundle.
Any components you add to the bundled model are displayed in the **Model Components** related list.

---

### Bundled model components

The Bundled model components section displays the details of the bundled model, including the display name, manufacturer, and model number. The image shows a table with columns for display name, manufacturer, model number, model categories, asset tracking strategy, acquisition method, cost, depreciation, and comments.

#### General Information

- **Display name**: Developer workstation bundle
- **Manufacturer**: developername

#### Model categories

- **Model number**: DMB-001
- **Model name**: Developer workstation bundle
- **Model number**: DMB-001
- **Owner**: developername
- **Status**: In Production

---

### Related Links

- **Publish to Hardware Catalog**

---

### Related information

#### Models

---

### Remove model components from a bundle

Remove a component from a bundled model, for example, when you want to replace it with a different component.

#### Before you begin

Role required: model_manager

---

### About this task

No component history is retained. If you remove a component from a bundled model, no record is saved showing that the component was ever part of a bundle.
Procedure
1. Navigate to Product Catalog > Product Model > Bundled Models.
2. Open a bundle record.
3. In the Model Components related list, select the component you want to remove.
4. In the Actions choice list below the list, select Delete.
5. Click OK.

Publish bundled models to product catalog
You can publish bundled models to the product catalog to make the bundled models available in the service catalog.

Before you begin
Role required: catalog_admin

Procedure
1. Navigate to Product Catalog > Product Models > Bundled Models.
2. Open a product model.
3. In Related Links, click Publish to product catalog.
4. Select a category.
5. Click OK.

Software models
Software models are created as part of the asset management process. You can create product models for software from the product catalog, but you cannot administer all aspects of the software models.

Software models are used in software counters.

Create application models
You can create application models that can be managed and tracked within a Scrum development process.

Before you begin
Role required: model_manager
Procedure

1. Navigate to Product Catalog > Product Model > Application Models.
2. Click New.
3. Complete the form.
   For general field descriptions, see Model form fields. There are no fields specific to application models.
4. Click Submit.

Related information

Agile Development

Work order models

When work management is activated, the ServiceNow platform adds the Work Order Models and Work Task Models modules to the product catalog.

Users with the wm_admin role can define new model records, which can be used as templates to create work orders for common procedures.

Models created for VMware support and Amazon EC2

When you activate Orchestration for VMware or Amazon EC2, the system creates a model (vmware instance or ec2 instance) automatically.

When the virtual machine is terminated, the asset state changes to Retired.

Add skills to a model

You can associate skills with any model. Creating associations between skills and models is helpful if you are using work management and want to assign tasks to agents based on their skills with specific models.

Before you begin

Role required: skill_admin or model_manager

Procedure

1. Navigate to Product Catalog > Product Model > All Models.
2. Open a product model.
3. In the Skills related list, click Edit.
4. Add items from the Collection list to the Skills List.
5. Click Save.
Publish models to the hardware or software catalog

You can publish models to the hardware or software catalog to make the models available in the service catalog.

Before you begin
Role required: catalog_admin

Procedure
1. Navigate to Product Catalog > Product Model > All Models.
2. Open a product model.
3. In Related Links, click Publish to Hardware or Publish to Software Catalog.
4. Select a category.
5. Click OK.

Delete models
If a model is no longer needed, you can delete it as long as no assets or configuration items use the model.

Before you begin
Role required: model_manager

Procedure
1. Navigate to Product Catalog > Product Model > All Models.
2. Select the check box beside the product model.
3. From the Actions choice list below the list, select Delete.
4. Click OK.

Vendor catalog items
The vendor catalog is a list of goods available from different vendors.

An accurate and complete vendor catalog can make it easier to keep items in stock at the best possible price.

You can link multiple vendor catalog items to a single product catalog item, which allows you to track information about a single item at different vendors.

For example, for an iPhone 5 product catalog item, you can create separate vendor catalog items from Apple and from Amazon. Select the vendor with the
best price when you source an item. Users need the model_manager role to work with vendor catalog items.

**Synchronize information**

Certain information is synchronized between models, product catalog items, and vendor catalog items.

When working with models, product catalog items, and vendor catalog items, keep the following in mind:

- Changes to model record update vendor catalog items automatically only if the vendor catalog items are published, not linked.
- If a model is linked to a vendor catalog item, any changes to the model do not update the vendor catalog item.
- After publishing a vendor catalog item or model to the hardware or software catalog, some fields become read-only on the vendor catalog item or product catalog item record. Information can only be updated on the model record.

List of synchronized fields:

- Description
- Short description
- Name
- Product ID
- Price
- Vendor
- Specs
- Features
- Model
- UPC
- Model number
- Cost
- Manufacturer

**Create a vendor catalog item**

Create a vendor catalog item to associate product models with a vendor.
Before you begin
Role required: model_manager

Procedure
1. Navigate to **Product Catalog > Catalog Definition > Vendor Items**.
2. Click **New**.
3. Complete the form.

### Vendor Catalog Item fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the item is built from information in the <strong>Product Model</strong>, <strong>Vendor</strong>, and <strong>Product ID</strong> fields.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The supplier that provides the item.</td>
</tr>
<tr>
<td>Product model</td>
<td>The specific version or configuration of the item.</td>
</tr>
<tr>
<td>Out of stock</td>
<td>The option that indicates whether the item is unavailable for order. This field is important if you are sourcing request items. Clear this check box if the item is available to order.</td>
</tr>
<tr>
<td>Product ID</td>
<td>The item identification number assigned by your organization.</td>
</tr>
<tr>
<td>List price</td>
<td>The price at which the item retails, excluding vendor discounts.</td>
</tr>
<tr>
<td>Vendor price</td>
<td>The price at which the item is available in the vendor catalog. If the vendor offers a discount, the vendor price reflects the discounted price.</td>
</tr>
<tr>
<td>Rank tier</td>
<td>Displays the overall ranking for this vendor's products and services, such as Valued Partner or Tactical Supplier. Rank tier expresses your organization's opinion of this vendor's performance. It can be used to decide if the vendor's products should be promoted or discontinued. Users with the vendor_manager role can edit this field.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the item.</td>
</tr>
<tr>
<td>General section</td>
<td></td>
</tr>
<tr>
<td>Product catalog item</td>
<td>Name of the product catalog item, if the item has been added to the product catalog. Leave this field empty if you</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>are going to link a vendor catalog item to the hardware catalog.</td>
</tr>
<tr>
<td>UPC</td>
<td>The barcode number used to uniquely identify and track items for sale.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to list the item in the vendor catalog. Clear this check box to hide the item in the vendor catalog.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the item.</td>
</tr>
<tr>
<td>Information section</td>
<td></td>
</tr>
<tr>
<td>Specifications</td>
<td>Facts about the item such as size, weight, version, or speed.</td>
</tr>
<tr>
<td>Features</td>
<td>Distinct properties or distinguishing characteristics of the item.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Link an item to the hardware catalog**

After you create a vendor catalog item, link the item to the hardware catalog for viewing.

**Before you begin**

Role required: model_manager

**About this task**

To see the **Link to Hardware Catalog Item** related link on the Vendor Catalog Item form, add a hardware model or a consumable model to the **Product Model** field, and leave the **Product Catalog Item** field blank.

**Procedure**

1. Navigate to **Product Catalog > Catalog Definition > Vendor Items**.
2. Open a vendor catalog item.
3. In **Related Links**, click **Link to Hardware Catalog Item**.
4. Select a **Catalog Item**.
5. Click **OK**.

The page refreshes to the selected hardware catalog item. The vendor catalog item is listed in the **Vendor Catalog Items** related list.
Link an item to the software catalog
After you create a vendor catalog item, link the item to the software catalog for viewing.

Before you begin
Role required: model_manager

About this task
To see the Link to Software Catalog Item related link on the Vendor Catalog Item form, add a software model or a consumable model to the Product Model field, and leave the Product Catalog Item field blank.

Procedure
1. Navigate to Product Catalog > Catalog Definition > Vendor Items.
2. Open a vendor catalog item.
3. In Related Links, click Link to Software Catalog Item.
4. Select a Catalog Item.
5. Click OK.
The page refreshes to the selected software catalog item. The vendor catalog item is listed in the Vendor Catalog Items related list.

Publish an item to the hardware catalog
After you create a hardware item for the vendor catalog, publish it to the hardware catalog for viewing. The hardware catalog is a section within the service catalog.

Before you begin
Role required: catalog_admin

About this task
To see the Publish to Hardware Catalog Item related link on the Vendor Catalog Item form, add a hardware model or a consumable model to the Product Model field, and leave the Product Catalog Item field blank.

After you publish a vendor catalog item to the hardware catalog, the Publish to Hardware Catalog related link is no longer available. Any changes made on the vendor catalog item record are synchronized with the information in the hardware catalog.
Procedure
1. Navigate to **Product Catalog > Catalog Definition > Vendor Items**.
2. Open a vendor catalog item.
3. In **Related Links**, click **Publish to Hardware Catalog**.
4. Select a **Category**.
5. Click **OK**.
   The Hardware Catalog form opens and the item is listed in the **Vendor catalog Items** related list.

**Publish an item to the software catalog**

After you create a software item for the vendor catalog, publish it to the software catalog for viewing. The software catalog is a section within the service catalog.

**Before you begin**
Role required: catalog_admin

**About this task**
To see the **Publish to Software Catalog Item** related link on the Vendor Catalog Item form, add a software model or a consumable model to the **Product Model** field, and leave the **Product Catalog Item** field blank.

After you publish a vendor catalog item to the software catalog, the **Publish to Software Catalog** related link is no longer available. Any changes made on the vendor catalog item record are synchronized with the information in the software catalog.

Procedure
1. Navigate to **Product Catalog > Catalog Definition > Vendor Items**.
2. Open a vendor catalog item.
3. In **Related Links**, click **Publish to Software Catalog**.
4. Select a **Category**.
5. Click **OK**.
   The Software Catalog form opens and the item is listed in the **Vendor catalog Items** related list.

**View a vendor list**
You can view a list of vendors from the product catalog.
Before you begin
Role required: model_manager

About this task
The list includes every company that has the Vendor option selected on its record.

Procedure
1. Navigate to Product Catalog > Catalog Definition > Vendors.
2. Click any vendor Name for more information.

Product catalog items
Product catalog items are hardware and software that you can track and offer in the service catalog.
The product catalog is an extension of the Service Catalog that contains a list of available Models. Users with the catalog_admin role can create, activate, and deactivate product catalog items.

Create a product catalog item
Create hardware and software product catalog items to include in the product catalog and the service catalog.

Before you begin
Role required: catalog_admin

About this task
You must activate the items separately before they appear in the product catalog or service catalog.

Procedure
1. Navigate to Product Catalog > Catalog Definition > Hardware and Software Items.
2. Click New.
3. Complete the form.
   Some of the fields listed do not appear until you save the product catalog item.
### Product catalog item fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the item as you want it displayed in the product catalog.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>The catalog this item is listed in.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The vendor that supplies the item. If the item is purchased from multiple vendors, use the vendor catalog and leave this field empty.</td>
</tr>
<tr>
<td>Rank tier</td>
<td>The overall ranking for the selected vendor's products and services. This field is only visible in a Product Catalog Item record when the CI class is <strong>Hardware Catalog</strong> or <strong>Software Catalog</strong>.</td>
</tr>
<tr>
<td>Model</td>
<td>The specific version or configuration of the item.</td>
</tr>
<tr>
<td>Product ID</td>
<td>The item identification number assigned by your organization.</td>
</tr>
<tr>
<td>Price</td>
<td>The price at which the item is available in the product catalog. Enter a numerical value and select the appropriate currency.</td>
</tr>
<tr>
<td>Recurring price</td>
<td>The item's recurring price. For example, a subscription to a mobile phone contract could cost $500.00, with an $30.00 monthly recurring price.</td>
</tr>
<tr>
<td>Recurring price frequency</td>
<td>The interval at which the recurring price is accrued.</td>
</tr>
<tr>
<td>List Price</td>
<td>The price at which the item retails. This field is only visible when the <strong>Class</strong> is <strong>Hardware Catalog</strong> or <strong>Software Catalog</strong>.</td>
</tr>
<tr>
<td>Cost</td>
<td>The price at which the item was purchased from the vendor. The cost could be less than the <strong>List Price</strong> if your organization received a discount from the vendor. This field is only visible in a product catalog item record when the CI class is <strong>Hardware Catalog</strong> or <strong>Software Catalog</strong>.</td>
</tr>
<tr>
<td>Omit price in cart</td>
<td>When selected, hides the price when the item is displayed in the service catalog. Clear the check box to show the price in the service catalog. This field is only visible in a product catalog item record when the CI class is <strong>Hardware Catalog</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workflow</td>
<td>Workflow associated with this item.</td>
</tr>
<tr>
<td>Execution plan</td>
<td>The execution plan associated with this item.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the item.</td>
</tr>
<tr>
<td>Ordered item link</td>
<td>The list of links containing more information about items. The links can be reused across multiple items.</td>
</tr>
<tr>
<td>Class</td>
<td>The catalog item class this item belongs to. Select <strong>Hardware Catalog</strong> or <strong>Software Catalog</strong>. This field is visible by default. When you save the record as a hardware or software catalog item, the form is retitled Hardware Catalog or Software, respectively.</td>
</tr>
</tbody>
</table>

**General section**

- **Category**: The named group of items to which the item belongs.
- **Delivery time**: The amount of time it takes to deliver the item, starting from when it is ordered from the product catalog.
- **UPC**: The barcode number used to identify and track items.
- **Description**: A detailed description of the item. The description is displayed in the product catalog listing.

**Product Information section**

- **Cost**: The price at which the item was purchased from the vendor. This field is only visible when the **Class** is **Software Catalog**.
- **Specifications**: Facts about the item, such as size, weight, version, or speed.
- **Features**: Distinct properties or distinguishing characteristics of the item.

**Images section**

- **Icon**: A small image that appears next to the name when the item is displayed in the service catalog. Supported file types are jpg, png, bmp, gif, and jpeg.
- **Picture**: An image showing the item. Supported file types are jpg, png, bmp, gif, and jpeg.

**Related lists**
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Includes</td>
<td>More catalog items provided with this item. This related list is for informational purposes only.</td>
</tr>
<tr>
<td>Variables</td>
<td>Service catalog variables associated with this item. A service catalog variable captures and passes on information about choices a customer makes when ordering an item from the service catalog.</td>
</tr>
<tr>
<td>Vendor Catalog Items</td>
<td>Vendor catalog items associated with this item. Vendor catalog items allow you to track information about this item by its specifications for each vendor.</td>
</tr>
</tbody>
</table>

**Example**

Hardware catalog item record with an icon and picture of the item.

4. **Optional:** Click **Try It** to preview the item as it appears in the service catalog.
5. Click **Submit** or **Update**.
Related information

Create a vendor catalog item
Create an execution plan
Service catalog variables

Activate a product catalog item
Activate a product catalog item to make it available in the product catalog and the service catalog.

Before you begin
Role required: catalog_admin

About this task
You can activate the item from either the list view or the record.

Procedure
1. Navigate to Product Catalog > Catalog Definition > Hardware and Software Items.
2. Complete one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate one or more items from the list view</td>
<td>Select the check box next to one or more items in the record list and click Activate below the list.</td>
</tr>
<tr>
<td>Activate from the record</td>
<td>Click Activate under Related Links.</td>
</tr>
</tbody>
</table>

Deactivate a product catalog item
Deactivate a product catalog item to remove it from the product catalog and the service catalog.

Before you begin
Role required: catalog_admin

About this task
You can deactivate the item from either the list view or the record.
Procedure

1. Navigate to **Product Catalog > Catalog Definition > Hardware and Software Items**.

2. Complete one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deactivate from the list view</td>
<td>Select the check box next to one or more items in the record list and click Deactivate below the list.</td>
</tr>
<tr>
<td>Deactivate from the record</td>
<td>Click Deactivate under Related Links.</td>
</tr>
</tbody>
</table>

Model categories

Model categories associate CI classes with asset classes. Model categories are part of the Product Catalog application.

The model category configuration determines if the ServiceNow platform creates an asset from a CI, and, if so, what class of asset. Asset classes in the base system are **Hardware**, **Software License**, and **Consumable**. You can associate a model category to many models and a model to many model categories. For example, a specific model of a computer can be a **Computer** and a **Server**.
Models diagram

Related information

CMDB classifications
Create an asset class

View model categories

Default model categories are included with product catalog. You can view a list of default categories and the categories that you created.

Before you begin
Role required: model_manager

Procedure

1. Navigate to Product Catalog > Product Model > Model Categories.
2. Open a model category to view its details.

Create model categories

You can add custom model categories for your instance.

Before you begin
Role required: model_manager
About this task
When you create model categories, keep the following in mind:

• The base system provides a model category for each CI class in the CMDB. As you create `cmdb_ci` classes, create a corresponding row in the model category table for the model table to be used.

• If you select an Asset class on any existing model category, the system automatically creates assets for all configuration items associated with the model category, if configured to do so. If an asset is not created automatically, you can create the asset manually. After an asset class is selected for a model category, the asset class cannot be changed.

• The Allow pre-allocated, Allow in bundle, and Allow as main options are only available if an asset class is specified for the model category.

• If you select Consumable or Software License for the asset class, the Allow in bundle option is available, but not Allow pre-allocation or Allow as main.

• When a CI is created from a model category that requires asset tracking, the system automatically creates an asset record for the asset class specified in the model category. It then links that asset record to the CI. If a model is specified, the model category of the CI is determined by a combination of the CI class and the list of categories supported by the model. Asset tracking is specified on the model record.

• When an asset is created from a model category that requires CI tracking, the system automatically creates a CI record of the class specified by the category and links it to the asset.

• The Model Categories list (Product Catalog > Product Model > Model Categories) shows all the CI classes and what asset class is generated on the asset side.

Procedure
1. Navigate to Product Catalog > Product Model > Model Categories and click New.
2. Complete the form.

<table>
<thead>
<tr>
<th>Model Category fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>CI class</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>------------------</td>
</tr>
</tbody>
</table>
| Asset class      | Default options and any new asset classes you have created. Setting the asset class triggers the creation of assets depending on the model category selected. You can add an asset class to the model category later, but can't be changed after it is added. If you select **Consumable** or **Software License**, the CI class field becomes read-only because consumables and software licenses do not create CIs. If you specify a CI class and then select **Consumable** or **Software License**, the CI class field is changed to **None** automatically.  
  • Asset: An item that can be tracked individually.  
  • Consumable: An asset not tracked individually, such as keyboards.  
  • Hardware: A physical piece of computer equipment, such as a laptop or server.  
  • Software License: A legal statement defining the uses of software, such as the number of installations allowed or the terms of distribution. |
| Allow pre-allocation | Add and track items in this category as pre-allocated assets.                                                                                                                                                   |
| Allow in bundle  | Use items in this category in bundles.                                                                                                                                                                         |
| Allow as main    | Use items in this category as the main component in a bundle.                                                                                                                                                 |
| Enforce CI verification | Prevents the system from automatically creating assets in a specific model category when CIs are added manually or found with Discovery. This option enables an administrator to review and verify new CIs before adding them as assets. |

3. Click **Submit**.

**Related reference**

**Discovery**

**Create assets manually**

The Now Platform does not create an asset automatically under certain conditions. You can create an asset manually as needed.
Before you begin
Role required: model_manager

About this task
The conditions under which an asset is not automatically created include the following.

- **Forced CI verification:** If you select the Enforce CI verification check box in the Model Category form, the system does not create an asset automatically when a CI is created or discovered. When Enforce CI verification is enabled, newly created CIs do not trigger an automatic creation of an asset. Instead, these newly created CIs have their Requires verification field automatically set to true, which displays the following UI actions for the CI:
  - **Create Asset:** Creates an asset and sets Requires verification to false.
  - **Merge CI:** Merges duplicates of a CI. This action is useful if an asset for the CI was created in a separate process, which created an associated CI. Then a second CI was created either manually or via the discovery source - and the duplicate CIs did not properly coalesce.

- **Configuration errors:** In rare cases, the system can fail to create the asset automatically. This failure can occur if you assign the model and model category to the CI in the wrong sequence.

Follow these steps to create an asset manually.

**Procedure**

1. Navigate to **Product Catalog > Product Model > Model Categories**.
2. Open a model category that has no assigned CI class.
3. Click **Create Assets**.
   This action creates assets from all CIs deferred for verification in this model category. This option is only available for users with the admin role.

**Edit model categories**

All default model categories can be edited, except for the Contract model category. You can edit any custom model categories that you created at any time.

Before you begin
Role required: model_manager
Procedure
1. Navigate to Product Catalog > Product Model > Model Categories.
2. Open a model category record.
3. Make changes to the model, as appropriate.
4. Click Update.

Delete model categories
If a model category is no longer needed, you can delete it.

Before you begin
Role required: model_manager

About this task
Only model categories that are not referenced by any models can be deleted.

Procedure
1. Navigate to Product Catalog > Product Model > Model Categories.
2. Select the check box beside the model category Name.
3. From the Actions on Selected Rows menu below the list, click Delete.
4. Click Delete.

Domain separation and Product Catalog
Domain separation is supported in the Product Catalog. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Standard
• Includes Basic level support.
• Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
• The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.
Sample use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

How domain separation works in Product Catalog

The domain owner’s employees and tenants can use the same processes if the work is done in the correct domain. When adjusting any configuration, you should be in the domain where you’re doing the work. Use the domain picker to select the correct domain to work in.

Related information

Domain separation for service providers

Benchmarks

The ServiceNow® Benchmarks application gives you instant visibility into your key performance indicators (KPIs) and trends, as well as comparative insight relative to industry averages of your peers. You can contrast the performance of your organization with recognized industry standards, view a side-by-side comparison of performance with global benchmarks, and implement recommendations for improved performance.

This video provides you with an overview of Benchmarks. Benchmarks Overview

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Benchmarks overview&lt;br&gt;• Benchmark KPIs&lt;br&gt;• Domain separation and Benchmarks</td>
<td>• Enable Benchmarks&lt;br&gt;• Enable a benchmark KPI</td>
<td>• Link or customize a benchmark KPI&lt;br&gt;• Drill down within benchmark KPI data</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Benchmarks dashboard&lt;br&gt;• View benchmark KPI data&lt;br&gt;• Benchmarks KPI performance trend and recommendations&lt;br&gt;• ITSM dashboards</td>
<td>• Benchmarks troubleshooting&lt;br&gt;• Ask or answer questions in the Benchmarks forum&lt;br&gt;• Search the Known Error Portal for known error articles&lt;br&gt;• Contact Customer Service and Support</td>
</tr>
</tbody>
</table>
Benchmarks overview

The ServiceNow Benchmarks application securely collects daily data on your instance and then aggregates the data into monthly global benchmark reports.

Performance Analytics collects daily data on customer instances. The data from the previous month is uploaded at the beginning of the following month via a scheduled job. If there are any errors, there are multiple retries.

This video provides an overview of how you can get started with Benchmarks.

Getting started with Benchmarks

During the month the data is uploaded, the data is aggregated and monthly results (your instance results, global results, and your ranking) are downloaded to the customer instance mid month. Monthly recommendation candidates are provided that you can implement to help improve your KPI performance. An email notification is sent when the global data is available.

ServiceNow has over two thousand customers that have opted into the Benchmarks program. All ServiceNow customers are allowed to participate in the Benchmarks program by opting in from their ServiceNow production instance, except:

• Express customers
• Federal customers
• Customers with on-premise instances

⚠️ Note: You must have a production instance to opt into the Benchmarks program.

Managed Service Providers (MSPs) and MSP-managed instances are supported and have exclusive access to global MSP aggregate score data. All instances will support Global Industry, Number of users, and geographical Region benchmarks that can be downloaded for comparison in the Benchmarks dashboard, but these benchmarks are not calculated using MSP data.

Changing KPI configuration within the month requires one to two months of data collection before your monthly values reflect that change.

⚠️ Note: The Benchmark Scheduler (bm.schedular) user is added with Benchmarks. It is required for Benchmarks data collection.

Key features

• 26 available KPIs (20 ITSM, 3 ITOM, 3 Security Operations).
• Ability to change KPI definitions to match customizations.
• Benchmarks dashboard in Service Portal (mobile friendly).
- Ability to download KPI reports.
- Filter data by industry, number of users, or geographical region.
- Email notification when new aggregate monthly data is available.
- Percentile ranking to indicate your standing within your participating peer group.
- Recommendation candidates with guided setup to help improve KPI performance.
- Product category-based roles to limit data access.
- Integration with Performance Analytics for daily data collection and drill-down on KPI data.

### Benefits

<table>
<thead>
<tr>
<th>Benefit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global anonymity</td>
<td>Viewers in your organization have access benchmarks for your organization, however the global benchmarks are anonymous and do not include any company information.</td>
</tr>
</tbody>
</table>
### Benefits (continued)

<table>
<thead>
<tr>
<th>Benefit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Industry comparison</td>
<td>Using the <strong>Compare with</strong> drop-down menu in the Benchmarks dashboard, you can filter the benchmarks results by industry, ServiceNow user size, or geographical region to make the results more relevant to your organization.</td>
</tr>
<tr>
<td></td>
<td>• Industry is determined based on the standard industry code in the account record for the company.</td>
</tr>
<tr>
<td></td>
<td>• Number of users is determined by the number of ServiceNow active users within the company, so you can compare your company to similar-sized ServiceNow implementations to gain insight about your company.</td>
</tr>
<tr>
<td></td>
<td>• Region is determined based on the <strong>Region</strong> field in the company table.</td>
</tr>
<tr>
<td></td>
<td>Industry and company size categories are combined when necessary to ensure that the number of customers in each category is large enough to protect the anonymity of each company.</td>
</tr>
<tr>
<td></td>
<td>If a filter category contains fewer than 20 participants, the corresponding data is shown in the <strong>Other</strong> category.</td>
</tr>
<tr>
<td>Trends</td>
<td>You can see the results of all published KPIs as well as the previous six months of history.</td>
</tr>
<tr>
<td></td>
<td>You can then use the trend data to measure and report on service delivery progress over a period of time to determine what is working well and what needs improvement.</td>
</tr>
<tr>
<td>Recommendations</td>
<td>Data is analyzed and recommendation candidates are provided to help improve the performance of your KPIs.</td>
</tr>
</tbody>
</table>
### Benefits (continued)

<table>
<thead>
<tr>
<th>Benefit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All recommendations are dynamic and are updated monthly, based on data from the previous month.</td>
<td></td>
</tr>
<tr>
<td>Reports</td>
<td>Benchmarks reports get refreshed monthly, which can be downloaded in PDF format. An email notification is sent to the customer when new data is available.</td>
</tr>
</tbody>
</table>

### Email notification

Users with the Benchmarks admin (sn_bm_client.benchmark_admin) and Benchmarks data viewer (sn_bm_client.benchmark_data_viewer) roles automatically receive email notification regarding availability of monthly scores, historical data recalculation, and new KPIs. You must have system admin (admin) role to modify the email recipient list.

- An email containing notification information is sent when the monthly global data is available. Monthly results (your instance results, and global results) are downloaded to the customer instance mid month.
  - Subject: New Monthly Benchmarks report is available now
  - Body: ServiceNow Benchmarks has been updated with <month> data. You can see the updated Benchmarks by viewing the Benchmarks Dashboard [Benchmarks Dashboard Portal link].

- An email containing notification information is sent when historical data for the past six months is recalculated.
  - Subject: Historical Global Benchmarks scores have been refreshed
  - Body: The global Benchmarks scores of last 6 months have been recalculated with improved data quality. You can see the updated Benchmarks by visiting Benchmarks Dashboard [Benchmark Dashboard Portal Link].

- An email containing notification information is sent when an updated KPI version is introduced (with some fixes, for example).
  - Subject: One or more Benchmarks KPI versions have changed
  - Body: The latest Benchmarks scores have a new version of following KPIs with improved data quality.
<KPI name>

You can see the updated Benchmarks by visiting Benchmarks Dashboard
< Benchmark Dashboard Portal Link>

Benchmarks notification emails are accessed using the System Settings > Notifications navigation menu.

**Benchmarks data transfer**

Your Benchmarks score data is automatically uploaded to ServiceNow on the 3rd day of the month. Global scores are automatically downloaded to your instance on the 11th day of the month.

You can manually upload or download scores beyond those days of the month (on demand) by executing the Benchmarks scores scheduled jobs through the System Definition > Scheduled Jobs navigation item.

- Upload the benchmark scores (automatically runs on the first day of the month)
- Download the benchmark scores (automatically runs on the ninth day of the month)

These on-demand scheduled jobs are useful if, for any reason, there was a failure in the automatic upload or download scores process and it is after the cutoff dates. You can also run a scheduled job to generate six months of historical data.

**KPI categories**

<table>
<thead>
<tr>
<th>ITSM KPIs</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>% of high priority incidents resolved</td>
</tr>
<tr>
<td></td>
<td>% of incidents resolved on first assignment</td>
</tr>
<tr>
<td></td>
<td>% of incidents resolved within SLA</td>
</tr>
<tr>
<td></td>
<td>% of reopened incidents</td>
</tr>
<tr>
<td></td>
<td>Average time to resolve a high priority incident</td>
</tr>
<tr>
<td></td>
<td>Average time to resolve an incident</td>
</tr>
<tr>
<td></td>
<td>Number of incidents created per user</td>
</tr>
<tr>
<td>Problem</td>
<td>% of high priority problems</td>
</tr>
<tr>
<td></td>
<td>% of incidents resolved by problem</td>
</tr>
</tbody>
</table>
### ITSM KPIs (continued)

<table>
<thead>
<tr>
<th>Change</th>
<th></th>
<th>Service Catalog</th>
<th></th>
<th>Knowledge</th>
<th></th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average time to close a problem</td>
<td>% of emergency changes</td>
<td>% of closed requests with breached SLAs</td>
<td>Average time to fulfill a request</td>
<td>% of incidents resolved using KB articles</td>
<td>Number of requests created per user</td>
<td>Average customer satisfaction</td>
</tr>
<tr>
<td>% of failed changes</td>
<td></td>
<td></td>
<td></td>
<td>Number of knowledge article views per user</td>
<td></td>
<td>Number of requesters per fulfiller</td>
</tr>
<tr>
<td>Average time to close a change</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### ITOM KPIs

<table>
<thead>
<tr>
<th>CMDB</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>% of duplicate CIs</td>
<td></td>
</tr>
<tr>
<td>% of non-compliant CIs</td>
<td></td>
</tr>
<tr>
<td>% of stale CIs</td>
<td></td>
</tr>
</tbody>
</table>

### Security Operations

<table>
<thead>
<tr>
<th>Security Incident Response</th>
<th>% of critical and high priority security incidents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vulnerability Response</td>
<td>Average critical vulnerability age</td>
</tr>
<tr>
<td></td>
<td>Average vulnerability age</td>
</tr>
</tbody>
</table>

### Benchmarks roles

These roles are introduced with Benchmarks.

An overview of the Benchmarks feature in ServiceNow, including opting in, setting up Benchmarks, reading the KPI dashboard, reading KPI cards, recommendations and implementing them.
<table>
<thead>
<tr>
<th>Role</th>
<th>Capabilities</th>
<th>Roles inherited</th>
</tr>
</thead>
</table>
| sn_bm_client.benchmark_admin | • Set up Benchmarks from an instance  
| | • Opt in or out of the Benchmarks program  
| | • Enable, disable, or modify indicators (including changing Performance Analytics indicator source, script, and conditions for those KPIs not requiring application-specific roles)  
| | • Receive email notification when new aggregate monthly data is available  
| | • All functions of the Benchmarks viewer and Benchmarks recommendations roles | |
| sn_bm_client.benchmark_data_viewer | • View full benchmark reports in Service Portal  
| | • View data visualizations and drill-downs for analyzing trends (not PA scorecards)  
| | • Download visualizations  
| | • View industry category or size comparisons | |
## Enable Benchmarks

You must opt in to Benchmarks to participate in Benchmarks data collection. However, you can opt out at any time.

### Before you begin

To keep the Benchmarks comparison data clean, you can opt in to Benchmarks only from your production instance.

Role required: `sn_bm_client.benchmark_admin`

### About this task

Once you have manually opted into Benchmarks, enable and configure benchmark KPIs. From the Benchmarks dashboard, you can view the Benchmarks KPI data, performance trends, and indicator scorecards.

> **Note:** Service Portal must be installed to view the Benchmarks dashboard.

Six months of global data is available after opting in. If available, the corresponding data for your instance is also included.

> **Note:** Past data for your instance is only available for Benchmarks users upgrading from a previous release.
Procedure
1. To opt in to Benchmarks:

<table>
<thead>
<tr>
<th>Using</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guided setup</td>
<td>a. Navigate to Continual Improvement &gt; Administration &gt; Guided Setup.</td>
</tr>
<tr>
<td></td>
<td>b. Go to the Enable Benchmarks section and click Configure.</td>
</tr>
<tr>
<td>Application navigator</td>
<td>Go to Benchmarks &gt; Setup.</td>
</tr>
</tbody>
</table>

2. Click Opt-In Agreement and read the agreement.
3. After reading the agreement, click Done.
4. Select the Yes, I have read and accept the Opt-In Agreement check box, and then click Opt-In. The opt-in confirmation screen appears.

What to do next
Enable and configure your KPIs.

Opt out of Benchmarks
You can opt out of Benchmarks at any time. If you opt out, your company usage data is no longer included in the Benchmarks data set, and you no longer see aggregate metrics.

Before you begin
Role required: sn_bm_client.benchmark_admin

About this task
When you opt out of the Benchmarks forum, it means that you no longer have access to benchmarking information for your organization. Your usage data is also removed from the Benchmarks data set going forward. However, your company can rejoin the Benchmarks program at any time.

Note: It may take up to two monthly refresh cycles for the request to be processed.

Procedure
1. Navigate to Benchmarks > Setup.
2. Click Opt-out of ServiceNow Benchmarks.
3. Click **Opt-Out**.

4. **Optional:** To send your feedback, provide the relevant information and click **Send**. Otherwise click **Cancel** to skip the survey.

We'd Love Your Opinion

Thank you. Your request is in process.

Please take a moment to tell us why you are opting out.

- I am not interested in measuring my organization’s performance against our peers.
- I don’t think the published data and KPIs are relevant to me.
- I don’t want to share anonymized usage data in the benchmarking dataset.
- Other (please explain below)

Details

The opt-out confirmation is shown. You can opt back in at any time.

**Benchmark KPIs**

You can enable or disable a benchmark KPI, and customize KPI conditions. Integration with Performance Analytics provides daily data collection and drill-down capabilities on KPI data.

Benchmarks offers ITSM, ITOM, and Security Operations KPIs.

**Note:** Upgrading Benchmarks does not change KPI status or configuration from the previous release. New KPIs are enabled by default.

Benchmarks uses anonymous, aggregated usage data from customers who have opted in to calculate global and industry benchmarks. The KPIs in the Benchmarks application are performance analytics indicators that only collect the usage count data, for example, the total number of incidents in a month, based on the monthly aggregates. During data collection, the Benchmarks
application does not consider any other details such as description of incidents, or information about requests, changes, or applications.

To calculate monthly values, the Benchmarks data is aggregated at the top level, such as:

- Global, which applies to all participating customers
- Industry Category
- User Size, which is based on active ServiceNow user count
- Three geo regions

The participating customer count for each cohort bucket in Industry Category, User Size, and Three geo regions aggregates are large enough to calculate monthly benchmarks values and to maintain full anonymity. To further ensure data anonymity, the Benchmarks user interface allows you to use only one filter at a time.

**ITSM KPIs**

<table>
<thead>
<tr>
<th>Incident</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of high priority incidents resolved</td>
<td>[Number of priority 0 (P0) and priority 1 (P1) incidents resolved during the month] / [Total number of incidents resolved during the same month]</td>
</tr>
<tr>
<td><strong>Note:</strong> In some environments, KPIs involving resolved incidents may require further configuration to retrieve resolved incident data.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The definition of P0 and P1 incidents is likely to vary per participant. Your P0 and P1 incidents may or may not be similar to the incidents of others. For comparison, the metrics provided in this report represent the average of all participants.
<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of incidents resolved on first assignment</td>
<td>[Number of incidents resolved on first assignment during the month] / [Total number of incidents resolved during the same month] • <strong>First assignment</strong> is when the <strong>Reassignment Count</strong> field is 0 for the incident.</td>
</tr>
<tr>
<td>% of incidents resolved within SLA</td>
<td>[Number of incidents with met SLAs resolved during the month] / [Total number of incidents resolved during the same month] • <strong>Met SLAs</strong> are calculated from the task_sla table for incidents resolved during the month.</td>
</tr>
<tr>
<td>% of reopened incidents</td>
<td>[Number of incidents resolved during the month that were reopened] / [Total number of incidents resolved during the same month] • <strong>Reopened</strong> is when the <strong>Reopen Count</strong> field is greater than 0 for the incident.</td>
</tr>
<tr>
<td>Average time to resolve a high priority incident</td>
<td>[Sum of the duration of all high priority incidents resolved during the month] / [Total number of high priority incidents resolved during the same month] • <strong>Duration</strong> is the length of time from creation to resolution. • <strong>High priority</strong> incidents include priority 0 (P0) and priority 1 (P1).</td>
</tr>
<tr>
<td>Average time to resolve an incident</td>
<td>[Sum of the duration of all incidents resolved during the month] / [Total number of incidents resolved during the same month]</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Incident (continued)

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Duration</strong></td>
<td>• <strong>Duration</strong> is the length of time from creation to resolution.</td>
</tr>
<tr>
<td>Number of incidents created per user</td>
<td>Number of incidents per user created during the month.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Global</strong> value is the average of all participating customers per user.</td>
</tr>
</tbody>
</table>

Problem

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of high priority problems</td>
<td>[Number of high priority problems closed during the month] /</td>
</tr>
<tr>
<td></td>
<td>[Total number of problems closed during the same month]</td>
</tr>
<tr>
<td></td>
<td>• <strong>High priority</strong> problems include priority 0 (P0) and priority 1 (P1).</td>
</tr>
<tr>
<td>% of incidents resolved by problem</td>
<td>[Number of incidents resolved during the month that are associated with a problem] /</td>
</tr>
<tr>
<td></td>
<td>[Total number of incidents resolved during the same month]</td>
</tr>
<tr>
<td>Average time to close a problem</td>
<td>[Sum of the duration of all problems closed during the month] /</td>
</tr>
<tr>
<td></td>
<td>[Total number of problems closed during the same month]</td>
</tr>
<tr>
<td></td>
<td>• <strong>Duration</strong> is the length of time from creating to closure.</td>
</tr>
</tbody>
</table>

Change

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of emergency changes</td>
<td>[Number of emergency changes closed during the month] /</td>
</tr>
</tbody>
</table>
### Change (continued)

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KPI</td>
<td>Description</td>
</tr>
<tr>
<td>Change</td>
<td>[Total number of all changes closed during the same month]</td>
</tr>
<tr>
<td></td>
<td>• <strong>All changes</strong> include standard, normal, and emergency.</td>
</tr>
<tr>
<td>% of failed changes</td>
<td>[Number of unsuccessful changes during the month] /</td>
</tr>
<tr>
<td></td>
<td>[Total number of all changes closed during the same month]</td>
</tr>
<tr>
<td>Average time to close a change</td>
<td>[Sum of the duration of all changes closed during the month] /</td>
</tr>
<tr>
<td></td>
<td>[Total number of all changes closed during the same month]</td>
</tr>
<tr>
<td></td>
<td>• <strong>Duration</strong> is the length of time from creating to closure.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All changes</strong> include standard, normal, and emergency.</td>
</tr>
</tbody>
</table>

### Service Catalog

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of closed requests with breached SLAs</td>
<td>[Number of closed requests with breached SLAs during the month] /</td>
</tr>
<tr>
<td></td>
<td>[Total number of closed requests during the same month]</td>
</tr>
<tr>
<td></td>
<td>• <strong>Breached SLAs</strong> are calculated from the task_sla table for requests closed during the month.</td>
</tr>
<tr>
<td>Average time to fulfill a request</td>
<td>[Sum of the duration for Service Catalog requests fulfilled during the month] /</td>
</tr>
<tr>
<td></td>
<td>[Total number of Service Catalog requests fulfilled in the same month]</td>
</tr>
</tbody>
</table>
Service Catalog (continued)

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>• <em>Duration</em> is the length of time from creation to closure.</td>
</tr>
<tr>
<td></td>
<td>• <em>Number of Service Catalog requests fulfilled</em> is the count of the number of records in the sc_req_item table which were closed within a month.</td>
</tr>
<tr>
<td>Number of requests created per user</td>
<td>Number of requests per user created during the month.</td>
</tr>
</tbody>
</table>

Knowledge

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of incidents resolved using KB articles</td>
<td>[Number of incidents with KB articles resolved during the month] /</td>
</tr>
<tr>
<td></td>
<td>[Total number of incidents resolved during the same month]</td>
</tr>
<tr>
<td>Number of knowledge articles views per user</td>
<td>Number of knowledge article views per user during the month.</td>
</tr>
<tr>
<td></td>
<td>• <em>Knowledge base views</em> are generated from the sys_view_count table.</td>
</tr>
<tr>
<td></td>
<td>• <em>Global</em> value is the average of all participating customers per user.</td>
</tr>
</tbody>
</table>

Other

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average customer satisfaction</td>
<td>[Sum of normalized metric values of all survey instances taken during the month] /</td>
</tr>
<tr>
<td></td>
<td>[Total number of survey instances taken during the same month]</td>
</tr>
</tbody>
</table>
### Other (continued)

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Table: metric_results.</td>
</tr>
<tr>
<td></td>
<td>• Survey: Customer Satisfaction Survey.</td>
</tr>
<tr>
<td></td>
<td>• Metric value is normalized as per category weights.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This KPI uses the base system Customer Satisfaction Survey. If you are using a different survey to collect user feedback, you can customize the KPI definition.</td>
</tr>
<tr>
<td>Number of requests per fulfills</td>
<td>[Number of active requester (non-ITIL) users during the month] / [Total number of active ITIL users during the same month]</td>
</tr>
</tbody>
</table>

### ITOM KPIs

#### CMDB

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of duplicate CIs</td>
<td>[Number of duplicate CIs during the month] / [Total number of CIs during the same month]</td>
</tr>
<tr>
<td>KPI</td>
<td>Description</td>
</tr>
<tr>
<td>-----</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **Duplicate** CIs | are calculated using the `cmdb_health_scorecard` table.  

**Note:** The definition of duplicate CIs is likely to vary per participant. Your duplicate CIs definition may or may not be similar to the definitions of others. For comparison, the metrics provided in this report represent the average of all participants. |
| % of non-compliant CIs | ![Formula](\frac{\text{Number of CI audit failures during the month}}{\text{Total number of CIs audited during the same month}})  

**Note:** The definition of CI compliance audits is likely to vary per participant. Your CI compliance audit definition may or may not be similar to the definitions of others. For comparison, the metrics provided in this report represent the average of all participants. |
| % of stale CIs | ![Formula](\frac{\text{Number of stale CIs during the month}}{\text{Total number of CIs during the same month}}) |
CMDB (continued)

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Stale</strong> CIs are calculated using the cmdb_health_scorecard table.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The definition of stale CIs is likely to vary per participant. Your stale CIs definition may or may not be similar to the definitions of others. For comparison, the metrics provided in this report represent the average of all participants.

## Security Operations KPIs

### Security Incident Response

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
</table>
| % of critical and high priority security incidents | \[
\frac{\text{Number of critical and high priority security incidents created during the month}}{\text{Total number of all security incidents created during the same month}}
\] |

### Vulnerability Response

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
</table>
| Average critical vulnerability age | \[
\frac{\text{Summed age of critical vulnerable items}}{\text{Number of critical vulnerable items}}
\] |
| Average vulnerability age | \[
\frac{\text{Summed age of vulnerable items}}{\text{Number of vulnerable items}}
\] |
| Average vulnerability per asset | \[
\frac{\text{Sum of active vulnerable items}}{\text{Total number of scanned configuration items}}
\] |
Vulnerability Response (continued)

<table>
<thead>
<tr>
<th>KPI</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VI mean time to remediate (MTTR)</td>
<td>[Sum of duration of closed vulnerable items] / [Total number of closed</td>
</tr>
<tr>
<td></td>
<td>vulnerable items displayed as a 30-day running average]</td>
</tr>
<tr>
<td>% of remediation efficiency</td>
<td>[Number of vulnerable items items closed during a month] / [Number of</td>
</tr>
<tr>
<td></td>
<td>new or reopened vulnerable items in the same month]</td>
</tr>
</tbody>
</table>

Enable a benchmark KPI

Enable KPIs to use in your data reporting.

**Before you begin**
Role required to enable a KPI: sn_bm_client.benchmark_admin
Role required to assign roles to a KPI category: admin

**About this task**
KPIs are grouped within categories (for example, ITSM, ITOM, Security Operations). You can assign roles to certain categories so that the corresponding KPI data is limited to authorized groups.

**Procedure**
1. Navigate to **Benchmarks** > **Administration** > **Setup**.
2. To enable or disable a KPI, click the KPI slider.
3. To view more information about a KPI, click the KPI.
   - Additional information includes description, formula, conditions, and tables from which the data is collected.
4. Click **Save**.
   - Allow one to two months for aggregate monthly data to accurately reflect changes made to KPI status.
5. **Optional:** To limit access of benchmark data to specific categories, assign roles to a KPI category.

**Note:** In some environments, resolved incident KPIs may require further configuration to retrieve resolved incident data.
a. Navigate to **Benchmarks > Administration > Category** and select a KPI category.

b. To add a role, click **View Roles**.

⚠️ **Note:** You must have the admin role to assign roles to categories.

### Configure resolved incident Benchmarks KPIs

The source for the KPIs containing resolved incident data is the `resolved_at` field in the Incident [incident] table, which may not exist in some environments. In this case, additional configuration is required to use these KPIs.

**Before you begin**

⚠️ **Note:** If you have never tracked resolved incidents in your environment before, install the Incident Resolution Fields (com.snc.incident_resolution_fields) plugin, which automatically adds the `resolved_at` field to the Incident table. No further steps are required.

Role required: sn_bm_client.benchmark_admin

**About this task**

If you are receiving errors in the Benchmarks Data Collection job log for resolved incident KPIs because you are using a custom (user-created) field to track resolved incidents, the following procedure is required for successful data retrieval using these Benchmarks KPIs.

- % of high priority incidents resolved
- % of incidents resolved on first assignment
- % of incidents resolved within SLA
- % of reopened incidents
- Average time to resolve a high priority incident
- Average time to resolve an incident
- Number of incidents created per user

Configure the KPI conditions and script to use your custom field (instead of the default `resolved_at` field) for resolved incident Benchmarks KPIs.
Procedure

1. Configure the Benchmark.Incidents.Resolved indicator source condition with your custom field.
   a. Navigate to Performance Analytics > Sources > Indicator Sources.
   b. Select the Benchmark.Incidents.Resolved indicator source and enter edit mode.
   c. In the Conditions section, select your custom field from the list (custom field names are typically preceded by \_u\_).
   d. Click Update.

2. Configure the Benchmark.Incident.ResolvedTime.Hours script with your custom field name.
   a. Navigate to Performance Analytics > Automation > Scripts.
   b. Select the Benchmark.Incident.ResolveTime.Hours script and enter edit mode.
   c. Replace the resolved\_at field name occurrence within the script with the name of your custom field (custom field names are typically preceded by \_u\_).
   d. Click Update.

3. Verify that you are no longer receiving errors in the Benchmarks Data Collection job log.

Link or customize a benchmark KPI

You can customize KPI conditions to fit the needs of your organization better.

Before you begin

The Benchmarks admin role does not provide application-specific roles. Therefore, although a Benchmarks admin can access a KPI through the Benchmarks application, changes to KPI conditions require the role specific to the KPI application.

For example, a Benchmarks admin cannot modify conditions for the knowledge base KPI (Knowledge Use [kb\_use] table), SLA KPI (Task SLA [task\_sla] table), ITOM KPIs (CMDB Health Scorecard [cmdb\_health\_scorecard] table), or Security Operations KPIs (Vulnerable Item [sn\_vul\_vulnerable\_item], Security Incident [sn\_si\_incident] tables) from within Benchmarks without specific access granted to those tables (knowledge\_admin, sla\_admin, asset, sn\_si\_special\_access roles).

Role required: sn\_bm\_client.benchmark\_admin
About this task
Customizing KPI conditions is useful to adjust the criteria to more accurately represent the data that your company is interested in.

For example, if your implementation does not use priority 1 incidents, you can change the criteria for high priority KPIs from 1 to 0, which returns more accurate data for your organization.

⚠ Note: It takes one to two months for aggregate monthly data to accurately reflect changes made to KPI conditions. For example, changes made within the month include a combination of data:

• Data for the previous condition (up until the date the condition was changed)
• Data for the new condition from that date forward

For further analysis, you can link a Performance Analytics indicator that you are already using to the corresponding Benchmarks indicator to see breakdowns, in addition to individual scores, when drilling down on KPI data.

For example, link **Number of resolved incidents by first assigned group** to **Benchmark: Number of incidents resolved on first assignment** to view breakdown values by priority, assignment group, and category.

⚠ Note: Individual scores are shown by default but you must have Performance Analytics to use linking to show breakdowns.
Procedure

1. Navigate to **Benchmarks > Setup** and click a KPI to access the KPI conditions.

   **Total time to resolve high priority incidents**
   
   Conditions: Preview
   
   All of these conditions must be met:
   
   - **Priority**: less than is 1 - Critical
   
   OR
   
   New Criteria
   
   Advanced
   
   **Number of high priority incidents resolved**
   
   Conditions: Preview
   
   All of these conditions must be met:
   
   - **Priority**: less than is 1 - Critical
   
   OR
   
   New Criteria
   
   Advanced
   
   Save Update

2. Change the conditions, as appropriate.

3. To link a Performance Analytics indicator to a Benchmarks indicator, follow the procedure in **Link an automated indicator to a benchmark**.

### Performance Analytics KPI to Benchmarks KPI link

<table>
<thead>
<tr>
<th>Benchmarks KPI</th>
<th>Formula</th>
<th>Performance Analytics KPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of active users</td>
<td>--</td>
<td>Benchmark: Number of active users</td>
</tr>
<tr>
<td>Total time to close changes</td>
<td>--</td>
<td>Benchmark: Total time to close changes</td>
</tr>
<tr>
<td>% of failed changes</td>
<td>[Number of unsuccessful changes during the month] / [Total number of all changes closed during the same month]</td>
<td>Benchmark: % of failed changes</td>
</tr>
<tr>
<td>Number of unsuccessful changes</td>
<td>--</td>
<td>Benchmark: Number of unsuccessful changes</td>
</tr>
<tr>
<td>Benchmarks KPI</td>
<td>Formula</td>
<td>Performance Analytics KPI</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Number of changes closed</td>
<td>--</td>
<td>Benchmark: Number of changes closed</td>
</tr>
<tr>
<td>% of emergency changes</td>
<td>[Number of emergency changes closed during the month] /</td>
<td>Benchmark: % of emergency changes</td>
</tr>
<tr>
<td></td>
<td>[Total number of all changes closed during the same month]</td>
<td></td>
</tr>
<tr>
<td>Number of emergency changes closed</td>
<td>--</td>
<td>Benchmark: Number of emergency changes closed</td>
</tr>
<tr>
<td>Average time to close a change</td>
<td>[Benchmark: Total time to close changes] /</td>
<td>Benchmark: Average time to close a change</td>
</tr>
<tr>
<td></td>
<td>[[Benchmark: Number of changes closed]]</td>
<td></td>
</tr>
<tr>
<td>% of stale CIs</td>
<td>Monthly average.</td>
<td>Benchmark: % of stale cis</td>
</tr>
<tr>
<td>% of duplicate CIs</td>
<td>Monthly average.</td>
<td>Benchmark: % of duplicate cis</td>
</tr>
<tr>
<td>% of non-compliant CIs</td>
<td>Monthly average.</td>
<td>Benchmark: % of non-compliant cis</td>
</tr>
<tr>
<td>Average time to resolve a high priority incident</td>
<td>[[Benchmark: Total time to resolve high priority incidents]]/ [Benchmark: Number of high priority incidents resolved]</td>
<td>Benchmark: Average time to resolve a high priority incident</td>
</tr>
<tr>
<td>% of incidents resolved within SLA</td>
<td>(((Benchmark: Number of resolved incidents with SLAs]) -</td>
<td>Benchmark: % of incidents resolved within SLA</td>
</tr>
<tr>
<td></td>
<td>[Benchmark: Number of resolved incidents with breached SLAs]) /</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[[Benchmark: Number of resolved incidents with SLAs]] * 100</td>
<td></td>
</tr>
<tr>
<td>Benchmarks KPI</td>
<td>Formula</td>
<td>Performance Analytics KPI</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Total number of incidents resolved by problem</td>
<td>--</td>
<td>Benchmark: Total number of incidents resolved by problem</td>
</tr>
<tr>
<td>Number of incidents closed that were re-opened</td>
<td>--</td>
<td>Benchmark: Number of incidents closed that were re-opened</td>
</tr>
<tr>
<td>Number of high priority incidents</td>
<td>--</td>
<td>Benchmark: Number of high priority incidents resolved</td>
</tr>
<tr>
<td>Average time to resolve an incident</td>
<td>[[Benchmark: Total time to resolve an incident]] / [[Benchmark: Number of incidents resolved]]</td>
<td>Benchmark: Average time to resolve an incident</td>
</tr>
<tr>
<td>Number of resolved incidents with SLAs</td>
<td>--</td>
<td>Benchmark: Number of resolved incidents with SLAs</td>
</tr>
<tr>
<td>Number of incidents created per user</td>
<td>[[Benchmark: Number of incidents created / By month SUM]] / [[Benchmark: Number of active users / By month AVG]]</td>
<td>Benchmark: Number of incidents created per user</td>
</tr>
<tr>
<td>Total time to resolve high priority incidents</td>
<td>--</td>
<td>Benchmark: Total time to resolve high priority incidents</td>
</tr>
<tr>
<td>% of high priority incidents</td>
<td>[[Benchmark: Number of high priority incidents resolved]] / [[Benchmark: Number of incidents resolved]] * 100</td>
<td>Benchmark: % of high priority incidents</td>
</tr>
<tr>
<td>Number of incidents created</td>
<td>--</td>
<td>Benchmark: Number of incidents created</td>
</tr>
<tr>
<td>Benchmarks KPI</td>
<td>Formula</td>
<td>Performance Analytics KPI</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------</td>
</tr>
<tr>
<td>Number of incidents resolved with attached KB articles</td>
<td>--</td>
<td>Benchmark: Number of incidents resolved with attached KB articles</td>
</tr>
<tr>
<td>Number of resolved incidents with breached SLAs</td>
<td>--</td>
<td>Benchmark: Number of resolved incidents with breached SLAs</td>
</tr>
<tr>
<td>Total number of incidents</td>
<td>--</td>
<td>Benchmark: Number of incidents resolved</td>
</tr>
<tr>
<td>Number of incidents resolved on first assignment</td>
<td>--</td>
<td>Benchmark: Number of incidents resolved on first assignment</td>
</tr>
<tr>
<td>% of incidents resolved on first assignment</td>
<td>[[[Benchmark: Total time to resolve an incident]] / [[Benchmark: Number of incidents resolved]]</td>
<td>Benchmark: % of incidents resolved on first assignment</td>
</tr>
<tr>
<td>Total time to resolve incidents</td>
<td>--</td>
<td>Benchmark: Total time to resolve an incident</td>
</tr>
<tr>
<td>% of reopened incidents</td>
<td>[[[Benchmark: Number of incidents closed that were re-opened]] / [[Benchmark: Number of incidents closed]] * 100</td>
<td>Benchmark: % of reopened incidents</td>
</tr>
<tr>
<td>Number of incidents closed</td>
<td>--</td>
<td>Benchmark: Number of incidents closed</td>
</tr>
<tr>
<td>Number of knowledge article views</td>
<td>--</td>
<td>Benchmark: Number of knowledge article views</td>
</tr>
<tr>
<td>Number of knowledge base views per user</td>
<td>[[[Benchmark: Number of knowledge article views / By month SUM]]/[[Benchmark: Number of active users / By month AVG]]</td>
<td>Benchmark: Number of knowledge base views per user</td>
</tr>
<tr>
<td>% of incidents resolved using KB articles</td>
<td>[[[Benchmark: Number of incidents resolved with attached KB articles]] /</td>
<td>Benchmark: % of incidents resolved using KB articles</td>
</tr>
<tr>
<td>Benchmarks KPI</td>
<td>Formula</td>
<td>Performance Analytics KPI</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Number of survey instances</td>
<td>--</td>
<td>Benchmark: Number of survey instances</td>
</tr>
<tr>
<td>Number of active ITIL users</td>
<td>--</td>
<td>Benchmark: Number of active ITIL users</td>
</tr>
<tr>
<td>Normalized customer satisfaction</td>
<td>--</td>
<td>Benchmark: Normalized customer satisfaction</td>
</tr>
<tr>
<td>Average customer satisfaction</td>
<td>$\frac{[[\text{Benchmark: Number of survey instances}]]}{[[\text{Benchmark: Number of survey instances}]]}$</td>
<td>Benchmark: Average customer satisfaction</td>
</tr>
<tr>
<td>Number of requesters per fulfiller</td>
<td>$\frac{[[\text{Benchmark: Number of active users}] - [[\text{Benchmark: Number of active ITIL users}]}}{[[\text{Benchmark: Number of active ITIL users}]$</td>
<td>Benchmark: Number of requesters per fulfiller</td>
</tr>
<tr>
<td>% of high priority problems</td>
<td>$\frac{[[\text{Benchmark: Number of high priority problems closed}]}}{[[\text{Benchmark: Number of problems closed}] * 100}$</td>
<td>Benchmark: % of high priority problems</td>
</tr>
<tr>
<td>Total time to close problems</td>
<td>--</td>
<td>Benchmark: Total time to close problems</td>
</tr>
<tr>
<td>% of incidents resolved by problem</td>
<td>$\frac{[[\text{Benchmark: Total number of incidents resolved by problem}]}}{[[\text{Benchmark: Number of incidents resolved}] * 100}$</td>
<td>Benchmark: % of incidents resolved by problem</td>
</tr>
<tr>
<td>Benchmarks KPI</td>
<td>Formula</td>
<td>Performance Analytics KPI</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>--------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Number of high priority problems closed</td>
<td>--</td>
<td>Benchmark: Number of high priority problems closed</td>
</tr>
<tr>
<td>Number of problems closed</td>
<td>--</td>
<td>Benchmark: Number of problems closed</td>
</tr>
</tbody>
</table>
| Average time to close a problem                  | \[
|                                               | \[Benchmark: Total time to close problems\] / \[
|                                               | \[Benchmark: Number of problems closed\]\]       | Benchmark: Average time to close a problem       |
| % of critical and high priority security incidents| ([([Benchmark: Number of Critical and High Priority Security Incidents]) / ([Benchmark: Number of Security Incidents]) * 100] | Benchmark: % of critical and high priority security incidents |
| Number of critical and high priority security incidents | --                                               | Benchmark: Number of Critical and High Priority Security Incidents |
| Number of security incidents                    | --                                               | Benchmark: Number of Security Incidents         |
| Number of requests created                       | --                                               | Benchmark: Number of requests created           |
| Number of requests closed                        | --                                               | Benchmark: Number of requests closed             |
| Average time to fulfil a request                 | \[
|                                               | \[Benchmark: Total time to fulfil requests\]/ \[
|                                               | \[Benchmark: Number of requests closed\]\]       | Benchmark: Average time to fulfil a request       |
| Number of closed requests with SLAs              | --                                               | Benchmark: Number of closed requests with SLAs   |
| Number of requests created per user              | \[
<p>|                                               | [Benchmark: Number of requests created / By month SUM]] | Benchmark: Number of requests created per user   |</p>
<table>
<thead>
<tr>
<th><strong>Benchmarks KPI</strong></th>
<th><strong>Formula</strong></th>
<th><strong>Performance Analytics KPI</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of closed requests with breached SLAs</td>
<td>--</td>
<td>Benchmark: Number of closed requests with breached SLAs</td>
</tr>
<tr>
<td>Total time to fulfil requests</td>
<td>--</td>
<td>Benchmark: Total time to fulfil requests</td>
</tr>
<tr>
<td>% of closed requests with breached SLAs</td>
<td>[\text{Benchmark: Number of closed requests with breached SLAs}] / [\text{Benchmark: Number of closed requests with SLAs}] * 100</td>
<td>Benchmark: % of closed requests with breached SLAs</td>
</tr>
<tr>
<td>Number of critical vulnerability items</td>
<td>--</td>
<td>Benchmark: Number of critical vulnerability items</td>
</tr>
<tr>
<td>Number of vulnerability items</td>
<td>--</td>
<td>Benchmark: Number of vulnerability items</td>
</tr>
<tr>
<td>Average vulnerability age</td>
<td>[\text{Benchmark: Summed age of vulnerable items}] / [\text{Benchmark: Number of vulnerability items}]</td>
<td>Benchmark: Average age of vulnerable items</td>
</tr>
<tr>
<td>Average critical vulnerability age</td>
<td>[\text{Benchmark: Summed age of critical vulnerable items}] / [\text{Benchmark: Number of critical vulnerability items}]</td>
<td>Benchmark: Average age of critical vulnerable items</td>
</tr>
<tr>
<td>Summed age of critical vulnerable items</td>
<td>--</td>
<td>Benchmark: Summed age of critical vulnerable items</td>
</tr>
<tr>
<td>Summed age of vulnerable items</td>
<td>--</td>
<td>Benchmark: Summed age of vulnerable items</td>
</tr>
</tbody>
</table>
Use Benchmarks data for value management analysis

Manually collect historical Benchmarks data to analyze the benefits of year-over-year growth when you use the ServiceNow Benchmarks application.

Before you begin
Role required: sn_bm_client.benchmark_admin, pa_data_collector, or admin

About this task
If you want to analyze year-over-year performance, you must collect at least 24 months of Benchmarks data. Use the sn_bm_client.months_copy_historical_pa_bm system property to set the number of months from the current month for which you want to collect Benchmarks historical data.

Procedure
1. Set up Benchmarks historical data collection.

   a. Navigate to Performance Analytics > Data Collection > Jobs.

   b. Select the Benchmarks Historical Data Collection job.

   c. In the Relative start field, enter the period of time for which you want to collect the data.

   d. In the Relative start interval field, select the length of the time period to collect the data. Recommended interval is 24 months.

   e. Click Execute.
      For detailed information on scheduling a data collection job, refer to Create or schedule a data collection job.

2. Upload the collected data to the centralized Benchmarks instance.

   a. In the Benchmarks Historical Data Collection job, navigate to the Job Logs related list.

   b. Make sure that the state for the historical data collection job is Collected. This state indicates that all data for the job has successfully run and all data has been gathered for the set time period.

   c. Navigate to System Definition > Scheduled Jobs.
d. Select the **Copy historical scores from PA to Benchmarks table**.

e. Click **Execute Now**.

   The data is automatically sent for value management analysis. Connect with your account representative to receive the report and discuss the benefits for your organization's value management.

### Benchmarks dashboard

The Benchmarks dashboard shows KPI data, performance trends, and indicator scorecards.

The Benchmarks KPI dashboard view, which shows all KPIs, is launched in Service Portal.

Features include:

- Ability to show KPIs in either list or card view.
- Downloadable reports of KPI list and all charts in PDF format.
- Ability to filter data by type of industry, number of users, MSPs, or geographic region (the filter is retained when switching between KPI view and trend view).

#### Note:
Only Managed Service Providers (MSP) can view the global MSP aggregate score data.

- Color-coded KPI data (the favorable comparison results for your instance are in green, while red favors global data).
- Monthly change percentage calculation of your instance from the previous month.
- Ability to view six months of historical KPI data.
- Ability to display time values in hours or days (using the `sn_bm_client.dashboard_display_unit` system property).

#### Note:
Service Portal must be installed to view the Benchmarks dashboard.
**Percentile rank**

The exact standing of the KPI for your company within your participating peer group is indicated by percentile rank. A KPI percentile rank of 90% indicates that your instance standing for that KPI is greater than 90% of the instances participating in that group.

⚠️ **Note:** A high percentile rank does not always indicate a desirable result. For certain KPIs a higher ranking is preferred (% of incidents resolved using KB articles), but for others it is not (% of emergency changes). The meaning of your percentile ranking should be interpreted based on the direction of the KPI being analyzed.

<table>
<thead>
<tr>
<th>KPI</th>
<th>Minimize</th>
<th>Maximize</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td></td>
<td></td>
</tr>
<tr>
<td>% of high priority incidents resolved</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>% of incidents resolved on first assignment</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>% of incidents resolved within SLA</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>% of reopened incidents</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Average time to resolve a high priority incident</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Average time to resolve an incident</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>KPI</th>
<th>Minimize</th>
<th>Maximize</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of incidents created per user</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td></td>
<td></td>
</tr>
<tr>
<td>% of high priority problems</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>% of incidents resolved by problem</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Average time to close a problem</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Change</td>
<td></td>
<td></td>
</tr>
<tr>
<td>% of emergency changes</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>% of failed changes</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Average time to close a change</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Service Catalog</td>
<td></td>
<td></td>
</tr>
<tr>
<td>% of closed requests with breached SLAs</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Average time to fulfill a request</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Number of requests created per user</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Knowledge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>% of incidents resolved using KB articles</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Number of knowledge article views per user</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Other</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average customer satisfaction</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>KPI</td>
<td>Direction (Percentile rank goal)</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>----------------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Minimize</td>
<td>Maximize</td>
</tr>
<tr>
<td>Number of requesters per fulfiller</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>CMDB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>% of duplicate CIs</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>% of non-compliant CIs</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>% of stale CIs</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Security Incident Response</td>
<td></td>
<td></td>
</tr>
<tr>
<td>% of critical and high priority security incidents</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Vulnerability Response</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average critical vulnerability age</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Average vulnerability age</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

**ITSM dashboards**

ITSM dashboards are a central place for ITSM users to monitor ongoing ITSM operations. These dashboards contain data visualizations to help you improve your business processes and practices.

Access the dashboards under **Self-Service > Dashboards**. To view detailed information, hover over any report graphic.

**Note:** The Performance Analytics ITSM DashboardsThe ITSM Analytics and Reporting Solutions are required to view these dashboards. The Performance Analytics - Content Pack - ITSM Dashboards (com.snc.pa.itsm_dashboards) plugin must be activated.

For more information, see Analytics and Reporting Solutions.
<table>
<thead>
<tr>
<th>Dashboard</th>
<th>Description</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Manager</td>
<td>Overview reports and IT service analysis reports</td>
<td>• Incident Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• SLA Manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_admin</td>
</tr>
<tr>
<td>IT Agent</td>
<td>Agent work and agent group work reports, and prioritized workload</td>
<td>• itil</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• itil_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_admin</td>
</tr>
<tr>
<td>IT Executive</td>
<td>Customer service, performance, and risk map reports</td>
<td>• itil</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• itil_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_admin</td>
</tr>
</tbody>
</table>

**View benchmark KPI data**

Benchmarks KPI data is shown in Service Portal. Data includes values for your company instance, and for global data.

**Before you begin**

Role required: sn_bm_client.benchmark_data_viewer

**Procedure**

1. Navigate to **Benchmarks > Dashboard**.
2. In the **KPI category** list, select IT Service Management, IT Operations Management, or Security Operations.
3. To view the corresponding group of KPIs, click a tab.

   **Note:** If the data seems incomplete or incorrect, you can investigate the KPI definition and conditions in **Performance Analytics > Sources > Indicator Sources**.

4. To filter results, select either an industry, number of users, or region in the **Compare with**: list.
   The data is automatically updated when you select a filter.

   **Note:** If a filter category contains fewer than 20 participants, the corresponding data is shown in the **Other** category.

5. For choice of view, click either the list icon or the card-view icon.
In card view, clicking a KPI shows the six-month KPI performance trend chart on the card.

6. To download a report to a PDF file, click the arrow icon ( ).

**What to do next**
Click a KPI to view *Benchmarks KPI performance trend and recommendations*.

**Benchmarks KPI performance trend and recommendations**
The Benchmarks KPI performance chart trend view shows your KPI performance comparison with global data, and provides recommendations to implement for improved performance of your KPI.

The KPI Performance Trends chart section is shown only for users with the Benchmarks viewer role (sn_bm_client.benchmark_data_viewer).

**KPI Performance Trends chart**

Your 6-month monthly data is mapped against global data, and your percentile rank indicating your standing within the participating peer group is shown.

Functionality of the performance trend chart view includes:
• Switching between KPIs in the same category using the KPI list.
• Viewing your instance and global data for a certain month by hovering over a point on the graph.
• Accessing the Performance Analytics scorecard for a data point in your instance.
• Downloading KPI chart reports.
• Filtering data by type of industry, number of users, or geographic region.

Recommendations

The Recommendations section is shown only for users with the Benchmarks recommendation role (sn_bm_client.benchmark_recommendation_viewer).

Recommendation candidates are provided in the performance trend view to help improve the performance of your KPIs. All recommendations are dynamic and are updated monthly, based on data analyzed from the previous month. Recommendation candidates are listed by rank.

⚠️ Note: Some KPI recommendations that use guided setup require system admin permission. Work with your system administrator to implement these recommendations.
Actions are available for each recommendation candidate. Based on the action, recommendations get filtered into the appropriate group tab (Implemented or Saved). Closing out the recommendation removes the recommendation candidate from the list.

- **Get Started**: Executes Guided Setup, if available, otherwise opens documentation containing information regarding the improvement.

- **Mark as Implemented**: Moves the recommendation candidate to the Implemented tab. This action is no longer available when a CIM improvement initiative is associated with the recommendation candidate.

- **Save for Later**: Moves the recommendation candidate to the Saved tab to be implemented at a later time.

- **Improvement Initiative** section:
  - **Create Improvement Initiative**: Creates a CIM improvement initiative, which contains phases and tasks to improve the KPI. Once the CIM improvement initiative is created, the recommendation candidate is moved to Saved tab.
  
  CIM fields automatically populated:
Short description: Recommendation candidate name.

Description: Recommendation candidate content and action URL.

- **Select Improvement Initiative**: Associates an existing CIM improvement initiative. The state of the recommendation candidate is set to the state of the associated CIM improvement initiative.

  🔄 **Note**: CIM **Short description** and **Description** fields are populated automatically from the recommendation candidate content only when the CIM improvement initiative is initially created from a recommendation candidate, not when associating afterward.

- **Improvement Initiative** related link: Links to the associated CIM improvement initiative. Click the related link to view the CIM improvement initiative in Continual Improvement Management.

- **Remove Improvement Initiative**: Removes the associated CIM improvement initiative from the item in the Recommendations list.

  When the CIM improvement initiative is closed, the recommendation candidate is moved to the Implemented tab. If the CIM improvement initiative is canceled, the recommendation candidate remains in the Saved tab. The associated CIM improvement initiative can always be removed, and another can be selected.

**Tabs for recommendation candidates:**

**Recommendations**

- Lists all recommendation candidates based on the analysis of the monthly data. This list gets refreshed monthly.

**Implemented**

- Lists all recommendation candidates that you have implemented. Recommendation candidates that were implemented the previous month include tracking information on the trend chart so you can determine the impact of the change. Hovering over the implementation point shows the recommendation implemented.

  🔄 **Note**: Recommendation candidates implemented in the current month do not have tracking data points on the chart until the following month.

**Saved**

- Lists all recommendation candidates that have been saved to implement later.
Drill down within benchmark KPI data
You can drill down within benchmark KPI data for further analysis within Performance Analytics.

Before you begin
Note: When drilling down on a benchmark value, Benchmarks viewers must have the pa_viewer role to view Performance Analytics scorecards.

Role required: sn_bm_client.benchmark_admin or sn_bm_client.benchmark_data_viewer with pa_viewer role

About this task
You can drill down on a benchmark value from the KPI performance trends chart to view individual data that makes up that value. For example, you may want to drill down and investigate data that is presented as a value in red (lower performance) on the chart.

Note: You can only drill down within KPI data from the KPI performance trends chart. You can only drill down on scores generated using Performance Analytics.

Procedure
1. Navigate to Benchmarks > Dashboard.
2. To view the KPI definition and performance trend, click a KPI.
3. To drill down further into the Performance Analytics scorecard, click a value in your benchmark data on the performance trends chart.

Note: For additional analysis on Chart, Scores, Comments, or More info, see Performance Analytics.

Benchmarks troubleshooting
Troubleshooting actions can help resolve common issues when setting up or running Benchmarks.

Data Error Scenarios

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Reason</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No data in dashboard after opting in.</td>
<td>The download REST API for six months failed or there is a connection failure.</td>
<td>Verify in the sysevent table that sn_bm_client.download.scores.6months event is processed.</td>
</tr>
</tbody>
</table>
### Data Error Scenarios (continued)

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Reason</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No instance data is shown in the dashboard for the last month.</td>
<td>PA data collection or scorecards API failure.</td>
<td>Make sure the condition in the indicator source, script field in the indicator, and additional conditions in the indicator are correct.</td>
</tr>
<tr>
<td>No global data in dashboard for the last month.</td>
<td>The download REST API failed or there is a connection failure.</td>
<td>Verify in the sysevent table that sn_bm_client.download.scores event is processed.</td>
</tr>
<tr>
<td>Opt-in process fails.</td>
<td>Authentication failed or the instance type is not supported.</td>
<td>Contact Customer Service and Support team.</td>
</tr>
<tr>
<td>Incorrect or no KPI data in the Benchmarks dashboard.</td>
<td>KPI condition configuration.</td>
<td>Verify the KPI definition and conditions in Performance Analytics &gt; Sources &gt; Indicator Sources.</td>
</tr>
<tr>
<td>No data in Percentile Rank list view.</td>
<td>Percentile Rank shows N/A if you are viewing an industry that you are not a part of.</td>
<td>View the industry in which your scores are included.</td>
</tr>
</tbody>
</table>

### Domain separation and Benchmarks

Domain separation is unsupported in the Benchmarks application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

#### Support level: No support

- The domain field may exist on data tables but there is no business logic to manage the data.
- This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.
Related information

Domain separation for service providers

Change Management

The ServiceNow® Change Management application provides a systematic approach to control the life cycle of all changes, facilitating beneficial changes to be made with minimum disruption to IT services.

ServiceNow Change Management integrates with the Vulnerability response plugin to introduce extra functionality within Change Management.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade to Rome</td>
<td>Change Management plugins</td>
<td>Configure ability to copy a change request</td>
</tr>
<tr>
<td>Change types</td>
<td>Change Management properties</td>
<td>Configure standard change catalog properties</td>
</tr>
<tr>
<td>State model and transitions</td>
<td>Configure Change Management</td>
<td>Create blackout and maintenance schedules in Change Management</td>
</tr>
<tr>
<td>Standard change catalog</td>
<td></td>
<td>Add a new change request type</td>
</tr>
<tr>
<td>Domain separation and Change Management</td>
<td></td>
<td>Risk assessment</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Migrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a change request</td>
<td>Developer training</td>
<td>Upgrade Change Management</td>
</tr>
<tr>
<td>Associated CIs on a change request</td>
<td>Developer documentation</td>
<td></td>
</tr>
<tr>
<td>Process a change request</td>
<td>Installed with Change Management - Core</td>
<td></td>
</tr>
<tr>
<td>Analyze change request risk and impact</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Advisory Board (CAB) workbench</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Change types

Change Management supports the three types of service changes ITIL describes — standard, emergency, and normal. The change type determines which state model is invoked and the change process that must be followed.

Watch this eight-minute video for an overview of Change Management in ITSM. Introduction to change management; types of change; creating and working change requests; improving efficiency through standard changes.

Standard change

A standard change is a pre-authorized change that is low risk, relatively common and follows a specified procedure or work instruction.

A standard change is one that is frequently implemented, has repeatable implementation steps, and has a proven history of success. As Standard changes are pre-approved, they follow a stream lined process in which group level or peer approval and CAB authorization steps are not required.

Approved standard change requests can be predefined in a catalog of templates to make accessing and requesting a standard change more efficient. This ability also enables the Change Management team to control the changes that are authorized as standard.

Emergency change

A change that must be implemented as soon as possible, for example to resolve a major incident or implement a security patch. This change is of such a high priority that it bypasses group and peer review and approval and goes straight to the Authorization state for approval by the CAB approval group.

Emergency changes cover the following types of emergencies:
• Fix on fail or retroactive situations where the impact to service has already been experienced.
• Fail or fail situations where the impact to service is imminent if action is not taken.

These changes do not follow the complete life cycle of a normal change due to the speed with which they must be authorized. Therefore, they progress directly to the Authorize state for approval from the CAB Approval group.

During an emergency change, there are chances that an unplanned CI change activity occurs. During such a case, an unauthorized change request is created and sent for approvals. For more information, see Unauthorized change request.

**Normal change**

Any service change that is not a standard change or an emergency change.

Normal change requests follow a prescriptive process which requires two levels of approval before being implemented, reviewed, and closed. These changes require a full range of assessments and authorizations such as peer or technical approval, change management, and Change Advisory Board (CAB) authorization, to ensure completeness, accuracy, and the least possible disruption to service. These changes are most often scheduled outside of defined change blackout windows or during defined maintenance windows. The normal type is used to implement beneficial change for any change to a service that is not a standard or emergency change.

**Related information**

Add a new change request type

**Upgrade Change Management**

Follow these instructions to upgrade your Change Management system.

**Before you begin**

Prior to Geneva, Change Request installed the Conflict Detection, Best Practice Change Risk Calculator, Change Risk Assessment, and Bulk CI Changes plugins by default.

For new instances from Geneva onwards, the Standard change catalog, State Model, and Mass updates CI plugins are also installed by default.
If you are upgrading from a release prior to Geneva, you can choose to activate Change Management core, State Model, Standard change catalog, and Mass updates CI plugins. The State Model, and Standard change catalog plugins are dependent on the Change Management core plugin. Hence, activating either the State model or the Standard change catalog plugins results in the activation of the Change Management core plugin.

Also consider the following consequences of activating Change Management core and the subsequent changes you might need to make to best suit your organization’s requirements:

- The previous change types are updated from routine, comprehensive, and emergency to standard, normal, and emergency respectively. Analyze customizations that you may have performed that reference old change type values since they are affected and require updating.

  Note: When Change management core is activated, the change types are updated.

If you already upgraded from a release prior to Geneva, you must perform the following tasks after you activate Change management core to ensure that change types and customizations are updated.

- If you had created newer change types in addition to the default change types, then you must customize them based on the new change types being introduced.
- Modify the customizations that are affected to use the new change type values.
- A new ACL, `change_request.type`, prevents users from updating the change type. If you allow any roles to update the type of a change request, for example, from Normal to Emergency, modify the ACL. Remove nobody from the Requires role list and add the roles allowed to update the change type.
- If you had the Bulk CI plugin installed, then install the Mass updates CI plugin for enhanced user experience and alignment with the new plugins.

**Change Management plugins**

You can activate one or more of the Change Management plugins if they are not already active. Some plugins include demo data.

Many of the following Change Management plugins are activated in the base system. Others can be activated when you are ready to use them. The Change Management plugins that are inactive in the base system include the following.
• Change Management mass update CI
  (com.snc.change_management.mass_update_ci)
• Change Management risk assessment
  (com.snc.change_management.risk_assessment)
• Best practice - bulk CI changes (com.snc.bestpractice.bulkchange)

You can activate one or more of the following Change Management plugins.

**Request ITSM Roles- Change Management**

Request the ITSM Roles plugin (com.snc.itsm.roles) to activate the ITSM Roles — Change Management plugin (com.snc.itsm.roles.change_management) to gain more control over the access that different change agents, technicians, and managers have within your Change Management process.

**Before you begin**
Role required: admin

**About this task**
The ITSM Roles plugin (com.snc.itsm.roles) includes an additional security model. The security model provides more granular roles across ITSM applications as well as within them, allowing you flexibility in setting up access controls. The ITSM Roles plugin is available by default in new instances. Users upgrading from Madrid or earlier versions must request the plugin.

### Plugins for ITSM Roles

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Stakeholder [com.snc_business_stakeholder]</td>
<td>business_stakeholder</td>
</tr>
</tbody>
</table>

  **Note:** The business_stakeholder role contains the sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.

<table>
<thead>
<tr>
<th>ITSM Roles — Incident Management [com.snc.itsm.roles.incident_management]</th>
<th>• sn_incident_read</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• sn_incident_write</td>
</tr>
</tbody>
</table>
Plugins for ITSM Roles (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
</table>
| ITSM Roles — Problem Management [com.snc.itsm.roles.problem_management] | • sn_problem_read  
• sn_problem_write                                                      |
| ITSM Roles — Change Management [com.snc.itsm.roles.change_management]  | • sn_change_read  
• sn_change_write                                                      |
| ITSM Roles — Request Management [com.snc.service_management.roles.request_management] | • sn_request_read  
• sn_request_write  
**Note:** As there are future updates expected for the sn_request_read role, do not assign it to users without the business_stakeholder role. |

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and subproduction instances, generally within a few days.

If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

**Note:** Activate the ITSM Roles plugin on a subproduction environment and test the functionality before requesting activation in the production environment. For assistance, contact the ServiceNow Professional Services team.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the form, fill in the fields.

### Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>
Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

**Components installed with ITSM Roles - Change Management**

Several user roles are installed with the activation of the ITSM Roles — Change Management plugin (com.snc.it.sm.roles.change_management). Security ACLs to support the security model for Change Management and related functionality are also installed.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see [Find components installed with an application](#).

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change read [sn_change_read]</td>
<td>Read access to the Change Management application and related records.</td>
<td>• dependency_views</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A user with the sn_change_read role can view all change requests as well as the CAB workbench.</td>
<td>• view_changer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• cmdb_read</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• app_service_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• cmdb_query_builder_read</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------------------</td>
</tr>
</tbody>
</table>
| Change write [sn_change_write] | Write access to the Change Management application and related records.     | • sn_change_read
                                   |                                                                                       | • template_editor
                                                   |                                                                                       | • cmdb_query_builder

### Activate Business Stakeholder

Activate the Business Stakeholder plugin (com.snc.business_stakeholder) if you have an admin role. This plugin installs the Business Stakeholder role. Users with this role can view and approve records at all ITSM product levels.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

**Related reference**

List of plugins (Rome)

**Installed with Business Stakeholder**

The Business Stakeholder plugin (com.snc.business_stakeholder) installs the Business Stakeholder role when activated.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see [Find components installed with an application](#).
Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Business Stakeholder [business_stakeholder] | Users with this role can view and approve records within all products of ITSM. | • pa_viewer.business_stakeholder  
• approver_user.business_stakeholder  
• cmdb_read.business_stakeholder |

⚠️ Note: The business_stakeholder role contains the following ITSM roles sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.

Activate Change Management - State Model

You can activate the Change Management - State Model plugin (com.snc.change_management.state_model) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**
Role required: admin

**About this task**
State Model activates the following related plugin if it is not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Core [com.snc.change_management]</td>
<td>Change management is used to create and manage change requests. Once this is activated, the values for the Type field on the change request are updated.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**What to do next**
If you upgraded from a release prior to Geneva, you must **update old state labels to new state labels**.

**Related information**
- List of plugins (Rome)

**Update change request states**
If you upgraded from a release prior to Geneva, you must update old state labels to new state labels after you activate the Change Management state model.

**About this task**
State values for current change records are not modified when you activate the Change Management state model. However, your current change records display the new state labels in the state field.

<table>
<thead>
<tr>
<th>State value</th>
<th>New state label</th>
<th>Old state label</th>
</tr>
</thead>
<tbody>
<tr>
<td>-5</td>
<td>New</td>
<td>Pending</td>
</tr>
<tr>
<td>-4</td>
<td>Assess</td>
<td>(Not used)</td>
</tr>
<tr>
<td>-3</td>
<td>Authorize</td>
<td>(Not used)</td>
</tr>
<tr>
<td>-2</td>
<td>Scheduled</td>
<td>(Not used)</td>
</tr>
<tr>
<td>-1</td>
<td>Implement</td>
<td>(Not used)</td>
</tr>
<tr>
<td>0</td>
<td>Review</td>
<td>(Not used)</td>
</tr>
<tr>
<td>1</td>
<td>(Not used)</td>
<td>Open</td>
</tr>
<tr>
<td>2</td>
<td>(Not used)</td>
<td>Work in Progress</td>
</tr>
<tr>
<td>3</td>
<td>Closed</td>
<td>Closed Complete</td>
</tr>
<tr>
<td>4</td>
<td>Canceled</td>
<td>Closed Incomplete</td>
</tr>
</tbody>
</table>
For example, records with a state value of -5 have the **Pending** state label before the Change Management state model is activated. After the state model is activated, these records retain the state value of -5 but have the **New** label. To use your organization's required change management process with the state model, you must update state values to the new labels in your existing change records as appropriate, either manually or by script.

You must also update any reports that run queries based on old state labels to reflect the new state labels.

**Procedure**

1. To automatically update the state field values from old state labels to new state labels, customize and then run the following sample script:

```java
/updateStates();

function updateStates() {

    function hasApprovers(changeGr) {
        var approverGr = new GlideRecord("sysapproval_approver");
        approverGr.addQuery('sysapproval', changeGr.getUniqueValue());
        approverGr.query();
        return approverGr.getRowCount() > 0;
    }

    function hasRunningWorkflows(changeGr) {
        var workflow = new Workflow();
        var workflowGr = workflow.getRunningFlows(changeGr);
        var hasRunningFlows = workflowGr.getRowCount() > 0;
        return hasRunningFlows;
    }

    // Old State Model
    var PENDING = '-5';
    var OPEN = '1';
    var CLOSED_COMPLETE = '3';
    var CLOSED_INCOMPLETE = '4';
    var CLOSED_SKIPPED = '7';

    // New State Model
```
2. Verify that the state labels have changed in existing change request records.
Installed with Change Management - State Model
Several types of components are installed with the Change Management - State Model.

Table modified with Change Management - State Model
Change Management - State Model modifies the list view of the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Request</td>
<td>Sets the column order in the list of change requests.</td>
</tr>
<tr>
<td>[change_request]</td>
<td></td>
</tr>
</tbody>
</table>

Activate Change Management - Collision Detector
You can activate the Change Management - Collision Detector plugin (com.snc.change.collision) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   ! Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information
List of plugins (Rome)
Installed with Change Management - Collision Detector

Several types of components are installed with Change Management - Collision Detector.

Tables installed with Change Management - Collision Detector

Change Management - Collision Detector adds or modifies the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change request [change_request]</td>
<td>Specifies the background color of the <strong>Conflict status</strong> message based on whether there is a conflict.</td>
</tr>
<tr>
<td>Blackout Schedule [cmn_schedule_blackout]</td>
<td>Represents a blackout schedule</td>
</tr>
<tr>
<td>Condition Schedule [cmn_schedule_condition]</td>
<td>Represents a schedule condition</td>
</tr>
<tr>
<td>Conflict [conflict]</td>
<td>Represents conflicts found during the detection process.</td>
</tr>
<tr>
<td>Maintenance Schedule [cmn_schedule_maintenance]</td>
<td>Represents a maintenance schedule</td>
</tr>
</tbody>
</table>

Activate Best Practice - Change Risk Calculator

The Best Practice - Change Risk Calculator plugin (com.snc.bestpractice.change_risk) is active by default in the base system. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

> **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

**What to do next**
You can define risk and impact conditions for your change records.

**Related information**
- **List of plugins (Rome)**

**Installed with Best Practice - Change Risk Calculator**
Several types of components are installed with the Best Practice - Change Risk Calculator.

**Tables installed with Best Practice - Change Risk Calculator**
Best Practice - Change Risk Calculator adds the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk Conditions [risk_conditions]</td>
<td>Represents the risk conditions, such as <strong>Insufficient lead time</strong> or <strong>Critical service affected</strong>.</td>
</tr>
</tbody>
</table>

**Activate Change Management - Change Schedule**
You can activate the Change Management - Change Schedule plugin (com.snc.change_management.soc) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**
Role required: admin

**About this task**
The Change Management - Change Schedule plugin (com.snc.change_management.soc) activates these related plugins if they are not already active.
Plugins for Change Management - Change Schedule

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Change Schedule foundation [com.snc.change_management.soc.foundation]</td>
<td>This plugin contains six change schedules to help users. Enabling this plugin automatically enables Change Management – Change Schedules Version 1.0.0.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.
   
   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related reference

List of plugins (Rome)

Installed with Change Management - Change Schedule

Several types of components are installed with the Change Management - Change Schedule.

Plugins installed with Change Management - Change Schedule

Plugins are added with activation of Change Management - Change Schedule.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Change Schedule</td>
<td>com.snc.change_management.soc</td>
<td>This plugin is the core Change Schedules plugin which</td>
</tr>
<tr>
<td>Plugin</td>
<td>ID</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change Management - Change Schedule foundation</td>
<td>com.snc.change_management.soc.foundation</td>
<td>This plugin contains six change schedules to help users. Enabling this plugin automatically enables Change Management - Change Schedules Version 1.0.0.</td>
</tr>
</tbody>
</table>

**Roles installed with Change Management - Change Schedule**

Roles are added with activation of Change Management - Change Schedule.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_chg_soc.change_soc_admin]</td>
<td>This role has full administrative rights to Change Schedule pages.</td>
</tr>
</tbody>
</table>

**Tables installed with Change Management - Change Schedule**

Tables are added with activation of Change Management - Change Schedule.

Change Management - Change Schedule adds the following tables.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style Rule [chg_soc_style_rule]</td>
<td>Define a default style rule that is applied to all Change Schedule definitions for each Change record displayed on the page</td>
</tr>
<tr>
<td>Style Rule [chg_soc_definition_style_rule]</td>
<td>Define a style rule for each Change record displayed on the Change Schedule page</td>
</tr>
<tr>
<td>Style Rule [chg_soc_def_child_style_rule]</td>
<td>Define a style rule for each related record displayed on the Change Schedule page</td>
</tr>
<tr>
<td>Change Schedule Definition [chg_soc_definition]</td>
<td>Define a Change Schedule page</td>
</tr>
<tr>
<td>Change Schedule Definition Core [chg_soc_definition_child]</td>
<td>Define related records for each Change record that is presented on the Change Schedule page</td>
</tr>
</tbody>
</table>

**Properties installed with Change Management - Change Schedule**

Properties are added with activation of Change Management - Change Schedule.

Change schedules are loaded on the timeline page on the client side in batches of 20. You can load a maximum of 1000 records. These numbers can be modified using the following properties from the System Properties [sys_properties] table. To open the System Property table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_chg_soc.change_soc_initial_limit</td>
<td>Define the number of change_request records to display on load of the Change Schedule.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 40</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property [sys_properties] table</td>
</tr>
<tr>
<td>Property</td>
<td>Usage</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_chg_soc.change_soc_scroll_load_limit</td>
<td>Define the number of change_request records to display as the Change Schedule is scrolled.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 20</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property [sys_properties] table</td>
</tr>
<tr>
<td>sn_chg_soc.change_soc_total_limit</td>
<td>Define the total number of change_request records that can be displayed on a Change Schedule.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 1000</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property [sys_properties] table</td>
</tr>
<tr>
<td>sn_chg_soc.landing_page.pinned_notification</td>
<td>Show a message when pin or unpin a change schedule.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: String</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property [sys_properties] table</td>
</tr>
<tr>
<td>sn_chg_soc.schedule_window_days</td>
<td>Define the number of days to be factored before and after the respective start/end of a change_request record when displaying blackout and maintenance window spans on the Change Schedule page.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 30</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: System Property [sys_properties] table</td>
</tr>
</tbody>
</table>
Business rules installed with Change Management - Change Schedule

Business rules are added with activation of Change Management - Change Schedule.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create default style rule</td>
<td>Related Definition [chg_soc_definition_child]</td>
<td>Defines a standard style rule with a high order for the related records.</td>
</tr>
<tr>
<td>Different start and end fields</td>
<td>Change Schedule Definition [chg_soc_definition]</td>
<td>Ensures that the start and end fields are different by aborting an insert or save when this is the case.</td>
</tr>
<tr>
<td>Flush share lists when ShareWith is none</td>
<td>Change Schedule Definition [chg_soc_definition]</td>
<td>Empties shared with lists when share with none is set.</td>
</tr>
<tr>
<td>Flush shareWith to match empty lists</td>
<td>Change Schedule Definition [chg_soc_definition]</td>
<td>Ensures shared with is updated to reflect the selected share options such as groups, roles, users.</td>
</tr>
</tbody>
</table>
| Update style field            | Style Rule Core [chg_soc_style_rule_core] | Updates the stylesheet defined in the style field when one of the conditions is met:  
  • Label color changes  
  • Label weight changes  
  • Event color changes  
  Providing Advanced is not true. |

UI policies installed with Change Management - Change Schedule

UI policies are added with activation of Change Management - Change Schedule.

<table>
<thead>
<tr>
<th>UI Policy</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show maintenance color</td>
<td>Change Schedule Definition</td>
<td>Only show the maintenance color field if Show maintenance has been enabled.</td>
</tr>
<tr>
<td>UI Policy</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Switch between Basic and Advanced</td>
<td>Style Rule Core [chg_soc_style_rule_core]</td>
<td>Only show label and event options if the style rule advanced option is false. When advanced is specified only the style field is presented.</td>
</tr>
<tr>
<td>Hide share users, groups and roles if share with everyone</td>
<td>Change Schedule Definition [chg_soc_definition]</td>
<td>If sharing with everyone then the other share options are hidden.</td>
</tr>
<tr>
<td>Show blackout color</td>
<td>Change Schedule Definition [chg_soc_definition]</td>
<td>Only show the Blackout color field if Show blackout has been enabled.</td>
</tr>
<tr>
<td>Hide table name</td>
<td>Style Rule Core [chg_soc_style_rule_core]</td>
<td>Condition builder requires a table field to be present on the form, but it is not necessary to present this so it is hidden.</td>
</tr>
<tr>
<td>Hide table name</td>
<td>Change Schedule Definition [chg_soc_definition]</td>
<td>Condition builder requires a table field to be present on the form, but it is not necessary to present this so it is hidden.</td>
</tr>
</tbody>
</table>

**Script includes installed with Change Management - Change Schedule**

Script includes are added with activation of Change Management - Change Schedule.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SoC</td>
<td>Base class that provides utilities and constants for Change Schedules</td>
</tr>
<tr>
<td>SoCChangeRequest</td>
<td>Extends SoCChangeRequestSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCChangeRequestSNC</td>
<td>Provides utilities for the change_request table</td>
</tr>
<tr>
<td>SoCDefinition</td>
<td>Extends SoCDefinitionSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>Script Include</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SoCDefinitionSNC</td>
<td>Provides utilities for the chg_soc_definition table</td>
</tr>
<tr>
<td>SoCDefinitionChild</td>
<td>Extends SoCDefinitionChildSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCDefinitionChildSNC</td>
<td>Provides utilities for the chg_soc_child_def table</td>
</tr>
<tr>
<td>SoCDefinitionChildStyleRule</td>
<td>Extends SoCDefinitionChildStyleRuleSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCDefinitionChildStyleRuleSNC</td>
<td>Provides utilities for the chg_soc_def_child_style_rule table</td>
</tr>
<tr>
<td>SoCDefinitionStyleRule</td>
<td>Extends SoCDefinitionStyleRuleSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCDefinitionStyleRuleSNC</td>
<td>Provides utilities for the chg_soc_definition_style_rule table</td>
</tr>
<tr>
<td>SoCLandingModelBuilder</td>
<td>Extends SoCLandingModelBuilderSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCLandingModelBuilderSNC</td>
<td>Builds the change schedule definition model used by the Change Schedule landing page</td>
</tr>
<tr>
<td>SoCModelBuilder</td>
<td>Extends SoCModelBuilderSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>SoCModelBuilderSNC</td>
<td>Builds the change schedule model used by the change schedule page</td>
</tr>
<tr>
<td>SoCRefFieldsList</td>
<td>Field choice list processor. Return the fields on the current table which reference the parent table</td>
</tr>
<tr>
<td>SoCRefTablesList</td>
<td>Field Choice List Processor. Return the tables referencing the provided table name.</td>
</tr>
<tr>
<td>SoCStyleRule</td>
<td>Extends SoCStyleRuleSNC and can be used to overwrite functionality defined therein</td>
</tr>
<tr>
<td>Script Include</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>SoCStyleRuleSNC</td>
<td>Provides utilities for style rules</td>
</tr>
</tbody>
</table>

**UI scripts installed with Change Management - Change Schedule**

UI scripts are added with activation of Change Management - Change Schedule.

<table>
<thead>
<tr>
<th>UI Scripts</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_chg_soc.change_soc</td>
<td>Angular module for the change schedule, which includes all of the angular applications dependencies</td>
</tr>
<tr>
<td>sn_chg_soc.change_soc_filter</td>
<td>Angular module for text filtering on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.config</td>
<td>Angular module for the configuration panel on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.context_menu</td>
<td>Angular module for the context menu on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.data</td>
<td>Angular module for the data model on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.duration</td>
<td>Angular module for a duration calculation utility</td>
</tr>
<tr>
<td>sn_chg_soc.filter_control</td>
<td>Angular module implementation of the filter widget</td>
</tr>
<tr>
<td>sn_chg_soc.filter_widget</td>
<td>Angular module that provides a filter control similar to a condition builder</td>
</tr>
<tr>
<td>sn_chg_soc.gantt</td>
<td>Angular module that maintains instances of gantt objects and handles the definition of the gantt scale</td>
</tr>
<tr>
<td>sn_chg_soc.keyboard</td>
<td>Angular module for the keyboard panel on the change schedule page</td>
</tr>
<tr>
<td>UI Scripts</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_chg_soc.landing.app</td>
<td>Angular module for the change schedule landing page, which includes all of the angular applications dependencies</td>
</tr>
<tr>
<td>sn_chg_soc.landing_accessibility</td>
<td>Angular module for accessibility support on the change schedule landing page</td>
</tr>
<tr>
<td>sn_chg_soc.landing_card</td>
<td>Angular module defines a directive for a change schedule definition card</td>
</tr>
<tr>
<td>sn_chg_soc.landing_decoration</td>
<td>Angular module defines a directive that provides styling</td>
</tr>
<tr>
<td>sn_chg_soc.landing_notifications</td>
<td>Angular module for displaying notifications</td>
</tr>
<tr>
<td>sn_chg_soc.landing_page_header</td>
<td>Angular module provides header for change schedule landing page</td>
</tr>
<tr>
<td>sn_chg_soc.landing_sort</td>
<td>Angular module provides utility for sorting cards on the change schedule landing page</td>
</tr>
<tr>
<td>sn_chg_soc.landing_splash_screens</td>
<td>Angular module provides splash screen when no change schedule definitions are present in a tab on the change schedule landing page</td>
</tr>
<tr>
<td>sn_chg_soc.landing_tabs</td>
<td>Angular module provides tabs for the change schedule landing page</td>
</tr>
<tr>
<td>sn_chg_soc.landing_wizard</td>
<td>Angular module defines the creation of a new change schedule definition from the landing page</td>
</tr>
<tr>
<td>sn_chg_soc.loading</td>
<td>Angular module defines when the change schedule page is loading by listening to requests</td>
</tr>
<tr>
<td>sn_chg_soc.mousedown</td>
<td>Angular module that makes a button execute multiple times when holding mouse down</td>
</tr>
<tr>
<td>UI Scripts</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_chg_soc.notification</td>
<td>Angular module used to display messages on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.popover</td>
<td>Angular module used for accessibility support for the popover that is displayed on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.share</td>
<td>Angular module for the share panel on the change schedule page</td>
</tr>
<tr>
<td>sn_chg_soc.sn.app_itsm.now.iscroll</td>
<td>Angular module that supports scrolling to load more content on the change schedule landing page</td>
</tr>
<tr>
<td>sn_chg_soc.snCreateNewInvite</td>
<td>Angular module for the share panel component that adds elements to the shared with field for the change schedule</td>
</tr>
<tr>
<td>sn_chg_soc.sn_soc_now.scheduleService</td>
<td>Angular module for the change schedule landing page that is used to retrieve change schedule definitions from the server</td>
</tr>
<tr>
<td>sn_chg_soc.style</td>
<td>Angular module for the style panel on the change schedule page</td>
</tr>
</tbody>
</table>

**Activate Change Management - Risk Assessment**

You can activate the Change Management - Risk Assessment plugin (com.snc.change_management.risk_assessment) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**About this task**

Change Management - Risk Assessment activates these related plugins if they are not already active.
Plugins for Change Management - Risk Assessment

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment Components [com.snc.assessment]</td>
<td>Provides the core components required for legacy surveys.</td>
</tr>
<tr>
<td>Assessment Designer [com.glide.assessment_designer]</td>
<td>Provides an interface to create and edit the Change Risk Assessment form that is required to collect user information on risk of the change request.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: `Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**What to do next**

You can **define risk assessment** conditions for change requests.

**Related reference**

- Change Management properties

**Related information**

- Risk conditions and calculation
- List of Rome plugins
Activate Change Management - Standard Change Catalog

You can activate the Change Management - Standard Change Catalog plugin (com.snc.change_management.standard_change_catalog) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**
Role required: admin

**About this task**
Standard Change Catalog activates the following related plugin if it is not already active.

### Plugin for Standard Change Catalog

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Core [com.snc.change_management]</td>
<td>Change management is used to create and manage change requests. Once this is activated, it updates the values for the Type field on the change request.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

⚠️ **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears:

   Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Related reference**

- Change Management properties

**Related information**

- Standard change catalog
- List of Rome plugins
Installed with Change Management - Standard Change Catalog

Several types of components are installed with Change Management - Standard Change Catalog.

Tables installed with Change Management - Standard Change Catalog

Change Management - Standard Change Catalog adds or modifies the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change request [change_request]</td>
<td>Adds the standard change template version to the table</td>
</tr>
<tr>
<td>Standard change producer version [std_change_producer_version]</td>
<td>Contains the record producer and change proposal for the standard change with the current version of the template. It also includes the number and percentage of successful and unsuccessful change requests created from the proposal.</td>
</tr>
<tr>
<td>Standard change properties [std_change_properties]</td>
<td>List of standard change catalog properties.</td>
</tr>
<tr>
<td>Standard change proposal [std_change_proposal]</td>
<td>List of standard change proposals.</td>
</tr>
<tr>
<td>Standard change record producer [std_change_record_producer]</td>
<td>List of standard change record producers.</td>
</tr>
<tr>
<td>Standard change template [std_change_template]</td>
<td>List of standard change templates.</td>
</tr>
</tbody>
</table>

Activate Change Management - Change Success Score

You can activate the Change Management - Change Success Score (com.snc.change_management.change_success_score) plugin if you have the admin role. This plugin activates related plugins if they are not already active.

Before you begin
Role required: admin
About this task
The Change Management - Change Success Score (com.snc.change_management.change_success_score) plugin activates these related plugins if they are not already active.

Plugins for Change Management - Change Success Score

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Change Success Score Foundation</td>
<td>Adds the Change Success Score icon to the change form, loads default rating records, and installs the basic configurations that are needed to use the change success score feature.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
**Related reference**

List of plugins (Rome)

**Components installed with Change Management - Change Success Score**

Several types of components are installed with activation of the Change Management - Change Success Score (com.snc.change_management.change_success_score) plugin, including tables and scheduled jobs.

**Scheduled jobs installed**

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change success score metrics (Daily)</td>
<td>Collects individual metrics for changes completed and incidents raised the previous day. This job runs on a daily basis at 02.00 UTC. When this job is completed, the Daily change success score script action is executed. This action triggers the calculation of the adjustment formula indicators, and store the new score in the metric table.</td>
</tr>
<tr>
<td>Change success score for today</td>
<td>Reads scores from metric table and calculates the daily averages for the past 30 days.</td>
</tr>
<tr>
<td>Change success score metrics (Historical data)</td>
<td>Gathers individual metrics daily for the past 30 days. This result overrides what is already stored in PA, that is not more than 30 days old. When this job is completed, the Historical change success scores script action is executed. The functionality of this script action is similar to that of the Daily change success score. Additionally, creating a new historic metric record for each day of the past 30 days.</td>
</tr>
<tr>
<td>Change success score (Historical data)</td>
<td>Reads scores from the metric table and calculates the daily average for the past 30 days.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
Note:

Historical calculations are useful you decide to change the overall formula or multipliers for individual metrics later on. You can run Change success score metrics (Historical data) to recalculate metrics and score for the past 30 days creating a new history record.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Success Score Rating</td>
<td>Defines the record that associates a rating choice and color with a Change Success Score range, such as, 0 to 499.</td>
</tr>
</tbody>
</table>

Activate Best Practice - Bulk CI Changes

You can activate the Best Practice - Bulk CI Changes plugin (com.snc.bestpractice.bulkchange) if you have the admin role. This plugin activates related plugins if they are not already active.

Before you begin
Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

What to do next
You can now configure Change Management.
Related reference
Change Management properties
Related information
Bulk CI Changes and Mass Update CI
List of Rome plugins

Installed with Best Practice- Bulk CI Changes
Several types of components are installed with the Best Practice- Bulk CI Changes.

Tables modified with Best Practice - Bulk CI Changes
Best Practice - Bulk CI Changes modifies the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change request</td>
<td>Add the <strong>CI class</strong> and <strong>Proposed change</strong> fields to the table.</td>
</tr>
<tr>
<td>[change_request]</td>
<td></td>
</tr>
<tr>
<td>Affected CIs</td>
<td>Adds a reference qualifier to filter the <strong>Affected CI</strong> related list lookup to the CI class defined in the change request.</td>
</tr>
<tr>
<td>[task_ci]</td>
<td></td>
</tr>
</tbody>
</table>

Activate Change Management - Mass Update CI
You can activate the Change Management - Mass Update CI plugin (com.snc.change_management.mass_update_ci) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task

Plugins for Change Management - Mass Update CI

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - State model</td>
<td>State model is used to move and track change requests through several states.</td>
</tr>
<tr>
<td>[com.snc.change_management.state_model]</td>
<td></td>
</tr>
<tr>
<td>Best Practice - Bulk CI Changes</td>
<td>Best Practice - Bulk CI Changes enables you to</td>
</tr>
</tbody>
</table>
Plugins for Change Management - Mass Update CI (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[com.snc.bestpractice.bulkchange]</td>
<td>record a single change proposal that are linked to all affected CIs.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   - **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information

- List of plugins (Rome)

Installed with Change Management - Mass Update CI

Several types of components are installed with the Change Management - Mass update CI.

Table modified with Change Management - Mass Update CI

Change Management - Mass Update CI updates the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Request [change_request]</td>
<td>Adds the <strong>Mass Update CI Class</strong> (is_bulk) field to the table to use when the change performs a mass update of configuration items.</td>
</tr>
</tbody>
</table>
Activate Change Management-Approval policy

You can activate the Change Management-Approval policy plugin (com.sn_chg_pol_appr) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Components installed with Change Management-Approval policy

Several types of components are installed with activation of the Change Management-Approval policy plugin, that includes tables.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Approval Policy</td>
<td>Extends the Change Policy table.</td>
</tr>
<tr>
<td>[chg_policy_approval]</td>
<td></td>
</tr>
</tbody>
</table>

Activate Change Management - CAB Workbench

You can activate the Change Management - CAB Workbench plugin (com.snc.change_management.cab) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.
Before you begin
Role required: admin

About this task

Plugins for CAB workbench

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal [com.glide.service-portal]</td>
<td>Service Portal provides an alternative user experience to the standard platform UI. It is easy to configure, customize, and extend, similar to what users are used to in other consumer products.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information

List of plugins (Rome)

Installed with Change Management - CAB Workbench
Several types of components are installed with Change Management - CAB Workbench.

Tables installed with Change Management - CAB Workbench
Change Management - CAB Workbench adds the following tables.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mtg Agenda Item</td>
<td>Parent table for CAB Agenda Item table.</td>
</tr>
<tr>
<td>[mtg_agenda_item]</td>
<td></td>
</tr>
<tr>
<td>CAB Agenda Item</td>
<td>Contains list of CAB agenda items.</td>
</tr>
<tr>
<td>[cab_agenda_item]</td>
<td></td>
</tr>
<tr>
<td>CAB Attendee</td>
<td>Contains list of CAB attendees.</td>
</tr>
<tr>
<td>[cab_attendee]</td>
<td></td>
</tr>
<tr>
<td>Mtg Definition</td>
<td>Parent table for CAB Definitions table.</td>
</tr>
<tr>
<td>[mtg_definition]</td>
<td></td>
</tr>
<tr>
<td>CAB Definition</td>
<td>Contains list of CAB definitions.</td>
</tr>
<tr>
<td>[cab_definition]</td>
<td></td>
</tr>
<tr>
<td>Mtg Meeting</td>
<td>Parent table for CAB Meeting table.</td>
</tr>
<tr>
<td>[mtg_meeting]</td>
<td></td>
</tr>
<tr>
<td>CAB Meeting</td>
<td>Contains list of CAB meetings without completion information.</td>
</tr>
<tr>
<td>[cab_meeting]</td>
<td></td>
</tr>
<tr>
<td>Mtg Runtime State</td>
<td>Parent table for CAB Runtime State</td>
</tr>
<tr>
<td>[mtg_runtime_state]</td>
<td></td>
</tr>
<tr>
<td>CAB Runtime State</td>
<td>Contains list of CAB meeting runtime states.</td>
</tr>
<tr>
<td>[cab_runtime_state]</td>
<td></td>
</tr>
</tbody>
</table>

### Activate Change Management ATF Tests

You can activate the Change Management - ATF Tests plugin (com.snc.change_management.atf) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**About this task**

Change Management - ATF Tests (com.snc.change_management.atf) loads ATF tests when the Change Management - State Model plugin is active.
Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information
List of plugins (Rome)

Activate Change Management - Core
You can activate the Change Management - Core plugin (com.snc.change_management) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
What to do next
You can activate one or more of the following plugins:

- State model (com.snc.change_management.state_model)
- Change Management - Collision Detector (com.snc.change.collision)
- Best practice - change risk calculator (com.snc.bestpractice.change_risk)
- Change risk assessment (com.snc.change_management.risk_assessment)
- Standard change catalog (com.snc.change_management.standard_change_catalog)
- Best practice - bulk CI changes (com.snc.bestpractice.bulkchange)
- Mass update CI (com.snc.change_management.mass_update_ci)
- CAB workbench (com.snc.change_management.cab)

You can now configure Change Management.

Related information
List of plugins (Rome)

Installed with Change Management - Core
Several types of components are installed with the Change Management - Core.

Tables installed with Change Management core
Change Management - Core modifies the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task CI</td>
<td>Adds Manual Proposed Change (manual_proposed_change) field if the proposed change has been made manually rather than through the Mass Update CI feature</td>
</tr>
</tbody>
</table>

Request Change Management - Incident Intelligence
To activate Change Management capability that uses Predictive Intelligence to identify incidents that may have been caused by change, request the Change Management - Incident Intelligence plugin (com.snc.change_management.ml.icbc) through the Now Support Customer Service system.

Before you begin
Role required: maint
About this task
The Change Management - Incident Intelligence (com.snc.change_management.ml.icbc) plugin activates these related plugins if they are not already active.

Plugins for Change Management - Incident Intelligence plugin

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Predictive Intelligence Core [com.snc.change_management.ml]</td>
<td>Enables you to use Predictive Intelligence in Change Management.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.
3. On **Now Support**, select the redirect link to access the Now Support Service Portal Service Catalog.
4. Select your instance.
5. Select Actions > Activate Plugin.
6. On the form, fill in the fields.

**Activate Plugin request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

**Related reference**

- List of plugins (Rome)

**Components installed with Change Management - Incident Intelligence**

Several types of components are installed with activation of the Change Management - Incident Intelligence plugin that includes tables.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.
Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incidents Caused By Change Solution [chg_ml_prop_icbc_solution]</td>
<td>Solution definitions configured for the Incidents Caused by Change feature</td>
</tr>
<tr>
<td>Incidents Caused By Change Properties [chg_ml_prop_icbc]</td>
<td>Properties used to configure the Incident Caused by Change Predictive Intelligence feature.</td>
</tr>
</tbody>
</table>

Request Change Management - Risk Assessment

To activate Change Management capability to predict change risk using Predictive Intelligence, request the Change Management - Risk Intelligence plugin (com.snc.change_management.ml.risk) through the Now Support Customer Service system.

Before you begin
Role required: maint

About this task
The Change Management - Risk Intelligence (com.snc.change_management.ml.risk) plugin activates these related plugins if they are not already active.

Plugins for Change Management - Risk Intelligence plugin

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Predictive Intelligence Core [com.snc.change_management.ml]</td>
<td>Enables you to use Predictive Intelligence in Change Management.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the form, fill in the fields.

### Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>
Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

**Related reference**

List of plugins (Rome)

**Components installed with Change Management - Risk Intelligence**

Several types of components are installed with activation of the Change Management - Risk Intelligence plugin, that includes tables.

> **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see [Find components installed with an application](#).

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk Categorization Solution [chg_ml_prop_risk_solution_cat]</td>
<td>Categorization of the solution definitions configured for the Risk Intelligence feature. Used when the feature is configured to employ a Categorization type Solution Definition.</td>
</tr>
<tr>
<td>Risk Similarity Solution [chg_ml_prop_risk_solution_sim]</td>
<td>Similarity solution definitions configured for the Risk Intelligence feature. Used when the</td>
</tr>
</tbody>
</table>
### Request Change Management - Standard Change Template Intelligence

To activate Change Management capability that uses Predictive Intelligence to identify change clusters and propose standard change templates, request the Change Management - Standard Change Template Intelligence plugin (com.snc.change_management.ml.sctp) through the Now Support Customer Service system.

**Before you begin**

Role required: maint

**About this task**

The Change Management - Standard Change Template Intelligence plugin (com.snc.change_management.ml.sctp) plugin activates these related plugins if they are not already active.

#### Plugins for Change Management - Standard Change Template Intelligence plugin

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Predictive Intelligence Core [com.snc.change_management.ml]</td>
<td>Enables you to use Predictive Intelligence in Change Management.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>
Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

**Related reference**

List of plugins (Rome)

**Components installed with Change Management - Standard Change Template Intelligence**

Several types of components are installed with activation of the Change Management - Standard Change Template Intelligence plugin that includes tables.

1. **Note**: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
### Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Change Template Candidate</td>
<td>Standard Change Template Candidates identified by the Predictive Intelligence feature.</td>
</tr>
<tr>
<td>[std_change_template_candidate]</td>
<td></td>
</tr>
<tr>
<td>[chg_ml_prop_sctp_solution]</td>
<td></td>
</tr>
</tbody>
</table>

### Request Change Management - Case Intelligence

To activate Change Management capability that uses Predictive Intelligence to identify similar cases that may have been caused by change, request the Change Management - Case Intelligence plugin (com.snc.change_management.ml.ccbc) through the Now Support Customer Service system.

**Before you begin**

Role required: maint

**About this task**

The Change Management - Case Intelligence (com.snc.change_management.ml.ccbc) plugin activates these related plugins if they are not already active.

### Plugins for Change Management - Case Intelligence plugin

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Management - Predictive Intelligence Core</td>
<td>Enables you to use Predictive Intelligence in Change Management.</td>
</tr>
<tr>
<td>[com.snc.change_management.ml]</td>
<td></td>
</tr>
</tbody>
</table>

### Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the form, fill in the fields.

Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note: Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.</td>
<td></td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

7. Click Submit.

Related reference
List of plugins (Rome)

**Change Management - Predictive Intelligence Core**

To activate Change Management predictive intelligent features, the Change Management - Predictive Intelligence Core plugin (com.snc.change_management.ml) is required and is automatically installed along with other through Change Management Predictive Intelligence plugins that are requested using the Now Support Customer Service system.

**Before you begin**
Role required: maint

**About this task**
The Change Management - Predictive Intelligence Core plugin (com.snc.change_management.ml) plugin activates these related plugins if they are not already active.
Plugins for Change Management - Predictive Intelligence Core plugin

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predictive Intelligence [com.glide.platform_ml]</td>
<td>Using Predictive Intelligence you can create, train, and test solutions so that you can quickly understand the basic functionality of how a machine-learning solution works.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.
3. On **Now Support**, select the redirect link to access the Now Support Service Portal Service Catalog.
4. Select your instance.
5. Select **Actions > Activate Plugin**.
6. On the form, fill in the fields.
### Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td></td>
<td>❓ <strong>Note</strong>: Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the <strong>Reason/Comments</strong> field.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

**Related reference**

**List of plugins (Rome)**

**Components installed with Change Management - Predictive Intelligence Core**

Several types of components are installed with activation of the Change Management - Predictive Intelligence Core plugin that includes tables. These tables can be utilized only after the other Change Management Predictive Intelligence plugins are activated.

❖ **Note**: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.
Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Similarity Boosters [chg_ml_similarity_boosters]</td>
<td>Provides boosting capabilities for similarity based solutions.</td>
</tr>
</tbody>
</table>

Activate Change Management- Change Flows

You can activate the Change Management - Change Model Foundation Data (com.snc.change_management.chnage_model.foundaion) plugin if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
Activate Change Management- Change Velocity dashboard

You can activate the Performance Analytics - Content Pack - Change Management (com.snc.pa.change) and Process Optimization (com.sn_process_optimization) plugins if you have the admin role. These plugins include demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.
   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Activate Change Management - Change Models

You can activate the Change Management - Change Model Foundation Data plugin (com.snc.change_management.change_model.foundation) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Configure Change Management

You can configure various aspects of Change Management based on the specific requirements of your organization.

**Before you begin**

Role required: admin or change_manager

**Procedure**

Configure one or more of the following aspects of Change Management.

**Use guided setup to implement Change Management**

The ITSM guided setup provides a sequence of tasks that help you configure Change Management on your ServiceNow instance. To open ITSM guided setup, navigate to **Guided Setup > ITSM Guided Setup**. For more information about using the guided setup interface, see **Using guided setup**.

### Change Management properties

Administrators can use change properties to configure Change Management behavior.

Navigate to **Change > Administration > Change Properties** to view and edit these properties.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.approval_engine.change_task</td>
<td>Change request tasks approval engine.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: process_guide</td>
</tr>
<tr>
<td>glide.ui.risk_calculate_rule</td>
<td>Change risk calculation</td>
</tr>
</tbody>
</table>
## Change Management properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.change_request.enable_copy</td>
<td>Enable copy change feature.</td>
</tr>
<tr>
<td>com.snc.change_request.copy.attributes</td>
<td>List of attributes (comma-separated).</td>
</tr>
<tr>
<td>com.snc.change_request.copy.rl.change_task.attributes</td>
<td>List of attributes (comma-separated).</td>
</tr>
<tr>
<td>com.snc.change_request.copy.rl.task_ci.attributes</td>
<td>List of attributes (comma-separated).</td>
</tr>
<tr>
<td>com.snc.change_request.attach.enable_copy</td>
<td>Copy attachments from the originating change.</td>
</tr>
<tr>
<td>com.snc.change_request.copy.rl.task_cmdb_ci_service.attributes</td>
<td>List of attributes (comma-separated).</td>
</tr>
<tr>
<td>com.snc.task.refresh_impacted_services</td>
<td>List of all the Task types where Refresh Impacted Services action is enabled.</td>
</tr>
<tr>
<td>change.refresh_impacted.include_affected_cis</td>
<td>Lists the impacted CIs or Services with any service supported by a configuration item identified in the Affected CI related list.</td>
</tr>
</tbody>
</table>
### Change Management properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.change_management.enforce_data_requirements</td>
<td>Enforce change requests on business services, which includes updates made through the change request form, Workflow, REST/SOAP, JavaScript, and GlideRecord updates. This property ensures that any data modification on the change request has the same data restrictions. In the User Interface, when this property is true, it enables additional server-side restrictions to the UI Policy and Client Script controls that already exist.</td>
</tr>
<tr>
<td>com.snc.task.populate_service_offering</td>
<td>Populates the service offering related list from the impacted service list.</td>
</tr>
<tr>
<td>com.snc.change_request.enable_unauthorized</td>
<td>Enables the creation of unauthorized change requests when the event &quot;ci.change.unplanned&quot; is raised.</td>
</tr>
<tr>
<td>com.snc.change_request.event.state_updated.enabled</td>
<td>Generates the <code>sn_change.state.updated</code> event when the state of the change request is updated.</td>
</tr>
<tr>
<td>com.snc.change_request.event.state_updated.states</td>
<td>Enter the change request state field values, each separated by a comma to generate the <code>sn_change.state.updated</code> event. This happens when any of the state value changes, for example, -5, -3, 0. You can leave the property empty to generate the <code>sn_change.state.updated</code> event for all state changes. For more information, see State model and transitions. Note: For this property to take effect, property <code>com.snc.change_request.event.state_updated.enabled</code> must be set to true.</td>
</tr>
</tbody>
</table>

### Change Management properties for Discovery integration

If your organization is subscribed to Discovery, integration with Discovery is automatically enabled. With this integration, any configuration item (CI) with an IP address that is part of a change request process can be maintained automatically. When Discovery is activated, the following three new properties become available.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.change_request.auto.discovery         | Trigger Discovery for the Affected CIs automatically, manually or not at all.  
  • Type: Choice list  
  • Values: Off, Both, Automatic, Manual  
  • Default value: Off |
| com.snc.change_request.disco.auto.state       | Defines which Change Request states Discovery will be automatically triggered.  
  • Type: String  
  • Default value: Review |
| com.snc.change_request.disco.manual.state    | Defines which Change Request states allow Discovery to be manually triggered.  
  • Type: String  
  • Default value: Implement, Review |

**Change Management properties available from sys_properties table**

The following properties are available for further configuration. To list them, enter `sys_properties.list` in the navigator text box and filter for `com.snc.change_request`.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.change_request.copy.related_lists     | Related lists (comma-separated) that will be copied from the originating task.  
  • Type: string  
  • Default value: `task_ci,task_cmdb_ci_service,change_task` |
| com.snc.change_request.rl.change_task.attach.enable_copy | Copy attachments from originating task. |

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.change_management.policy.approval.log</td>
<td>The debug logging property that provides the detailed logging information of the workflow activity when using Approval Policies.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type: true</td>
<td>false</td>
</tr>
<tr>
<td>Default value: true</td>
<td></td>
</tr>
</tbody>
</table>

### Configure ability to copy a change request

You can configure the ability to copy a change request record and its details using system properties.

**Before you begin**
Role required: admin

**About this task**
You can configure the following functionality.
- Disable the ability to copy a change request.
- Disable the ability to copy attachments.
- Determine the components of the source change request that are copied.

**Procedure**

1. Navigate to **Change > Administration > Change Properties**.
   Some properties are found by entering `sys_properties.list` in the application navigator, as noted.

2. Set the following properties as desired.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable the ability to copy a change request</td>
<td>Set <strong>Enable Copy Change feature</strong> (com.snc.change_request.enable_copy) to <code>false</code>.</td>
</tr>
<tr>
<td>Disable the ability to copy an attachment</td>
<td>Set <strong>Copy attachments from originating change</strong> (com.snc.change_request.attach.enable_copy) to <code>false</code>.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Disable the ability to copy the attachments from the change task</td>
<td>This system property is located in the [sys_properties] table. Set the <strong>Enable copying of attachments from the originating change’s related change tasks</strong> (<code>com.snc.change_request.rl.change_task.attach.enable_copy</code>) system property to <code>false</code>. Note: If the ability to copy attachments is enabled, the attachment appears on the copy of the change request only after it is saved.</td>
</tr>
<tr>
<td>Configure attributes to be copied</td>
<td>Edit the list of values in <strong>List of attributes (comma-separated)</strong> that will be copied from the originating change (<code>com.snc.change_request.copy.attributes</code>) to remove or add more attributes. For example, to prevent the <strong>Assigned to</strong> attribute from being copied, remove the <code>assigned_to</code> value from the list of attributes in the property text box.</td>
</tr>
</tbody>
</table>
| Configure related lists to be copied                   | This system property is located in the [sys_properties] table. The following related lists are copied by default:  
  - **Affected CIs**  
  - **Impacted Services/CIs**  
  - **Change Tasks**  
  Edit the list of values in **Related lists (comma-separated)** that will be copied from the originating change (`com.snc.change_request.copy.related_lists`) . For example, if you do not want to copy the **Change Tasks** related list, remove the `change_task` value from
Option | Description
--- | ---
 | the list of related lists in the property text box.

**Note:** You can configure this property to control the copy functionality of the **Affected CIs**, **Impacted Services/CIs**, and **Change Tasks** related lists. You cannot add any other related list to this property.

These system properties are located in the [sys_properties] table. Navigate to the appropriate system property for one of the default related lists to configure the attributes to copy.

<table>
<thead>
<tr>
<th>Related list</th>
<th>System property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Tasks</td>
<td>com.snc.change_request.copy.rl.change_task.attributes</td>
</tr>
<tr>
<td>Affected CIs</td>
<td>com.snc.change_request.copy.rl.task_ci.attributes</td>
</tr>
<tr>
<td>Impacted Services/CIs</td>
<td>com.snc.change_request.copy.rl.task_cmdb_ci_service.attributes</td>
</tr>
</tbody>
</table>

3. Complete the following steps to further customize the ability to copy a change request by modifying a script include.

   a. Navigate to **System Definition > Script Includes**.

   b. Modify the **ChangeUtils** script include.

**Example**
For example, the ability to copy a change request is not available by default for standard changes. However, you can provide your own implementation of the `isCopyRulesValid` function in the **ChangeUtils** script include to override the default.
Related information

Copy a change request

Create a change request template

You can create a template that can be used to create change requests with pre-defined supporting tasks. Templates simplify the process of submitting new records by populating fields automatically.

Before you begin

The administrator must configure the form layout to add these fields: **Next Related Template, Next Related Child Template, Link element.**

Role required: admin

About this task

There are two change request template configuration items.

- **Change_request**: This object does not have a link element, because it is at root level.
- **Change_task**: This task object is one level below root level, so it uses the parent table as a link element.

Procedure

1. Navigate to **System Definition > Templates**.
2. Click **New**.
3. Complete the form as described in **Create a template using the Template form**.
4. Complete the remaining fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Related Template</td>
<td>A template at the same hierarchical level as the current template (sibling). Use this field on a child template to specify an extra child template under the same parent template. For example, you can use child templates to create multiple change tasks for a change request template and specify sibling child templates. This field is not supported on top-level templates.</td>
</tr>
<tr>
<td>Next Related</td>
<td>A template at the hierarchical level below the current template (child).</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child Template</td>
<td>You can assign a child template to a child template.</td>
</tr>
<tr>
<td>Link element</td>
<td>Specifies a link to a record created from a child template to the record created from the parent template. The template script chooses the first valid reference field that can link to the parent record when this field is left blank.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Create a change request assignment rule**

You can define assignment rules to automate the process of assigning change requests to the appropriate group or individual.

**Before you begin**

Role required: admin

**About this task**

You can define an assignment rule either for the change request or for the change tasks that are generated for change requests. In the following example, you create an assignment rule to assign change requests for configuration items in the database class to the **Database** group.

**Procedure**

1. Navigate to **System Policy > Assignment**, and then click **New**.
2. Enter the name: **Database Change**.
3. In the Applies To form section, select the table **Change Request** [change_request] and add a condition `[Configuration Item.Class] [is] [Database]`.
4. In the Assign To section, select the group **Database**.
5. Click **Submit**.

**What to do next**

To test the assignment rule, navigate to **Change > Create New** and enter a Normal change. Complete the form, selecting **bond_trade_ny**, or another CI in the database class, in the **Configuration Item** field.

Save the change and see that it was automatically assigned to the **Database** group.
Add a new change request type

You can add a new change type to your change process. There are several processes involved with adding a change type. These processes include managing script includes and workflows.

Before you begin
Role required: admin

About this task
In addition to the three types of change available by default, you can add new change types based on your organization requirements. For example, you can create a change type Expedited for changes that you require to be processed immediately.

Procedure
1. Complete the following steps to add a new choice to the Type field.
   a. Open an existing change request.
   b. Right-click the Type field and select Show Choice List.
   c. Click New and fill in the following fields.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the Change Request table.</td>
</tr>
</tbody>
</table>
2. Complete the following steps to add the new change type to the change request interceptor.

a. Navigate to **System Definition > Interceptors**.

b. Open the **Change Request** interceptor.

c. Click **New** in the **Answers** related list.

d. Complete the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Change Request</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name for the new change type. For example, <strong>Direct to Expedited</strong></td>
</tr>
<tr>
<td>User Prompt</td>
<td>Enter a description that is displayed to the end user when they click <strong>Create New</strong> under <strong>Change</strong>.</td>
</tr>
<tr>
<td>Target URL</td>
<td>Set the appropriate target URL. For example, <code>change_request.do?sys_id=-1&amp;sysparm_query=type=expedited</code>.</td>
</tr>
<tr>
<td>Order</td>
<td>Set the appropriate order level for the change type. For example, 400.</td>
</tr>
</tbody>
</table>
e. Submit the form.

3. Complete the following steps to create the script include for the new change type.

a. Navigate to System Definition > Script Includes.

b. Search for a change type script include on which to base the workflow for the new change type. For example, to base it on Emergency change type, search for ChangeRequestStateModelSNC_emergency and open the script include.

c. Copy the script of the ChangeRequestStateModelSNC_emergency script include from the Script field.

d. Navigate to System Definition > Script Includes and click New.

e. Name the new script include to match the value of the new type. For example, ChangeRequestStateModelCust_expedited.

f. Paste the copied script in the Script field of the new script include.

g. Update any references in the pasted script include from ChangeRequestStateModelSNC_emergency to ChangeRequestStateModelCust_expedited.
h. Click **Submit**.

**Note:** An existing script include contains the implementation for all the *moving* and *canMove* functions. The *moving* function is used to pre-populate any fields that are required for the new state. The *canMove* function is used to check for any additional requirements and to validate whether a task can move to the next state.

4. Complete the following steps to create the script include to define state transitions and control the transitioning between states for the new change type.

a. Navigate to **System Definition > Script Includes**.

b. Search for change type script include on which to base the transitioning controls for the new change type on. For example, to base it on Emergency change type, search for `ChangeRequestStateModel_emergency` and open the script include.

c. Update the name of the script include to match the value of the new type. For example, `ChangeRequestStateModel_expedited`.

d. Update the reference to the base script include for the new change type. Change the extended Object in line 2 to the base script include name. For example, `ChangeRequestStateModelCust_expedited`, so the reference is similar to the following string.

   ```javascript
   ChangeRequestStateModel_expedited.prototype =
   Object.extendsObject(ChangeRequestStateModelCust_expedited, { // CUSTOM CODE, type:"ChangeRequestStateModelCust_expedited"});
   ```

e. Click **Insert and Stay** create a copy of the script include `ChangeRequestStateModel_emergency` with the new name `ChangeRequestStateModel_expedited`.

5. Complete the following steps to modify the script include that controls the transition between states using one of the defined models for the new change type. The base method is overridden so that the new state model for the new change type can be utilized.

a. Navigate to **System Definition > Script Includes**.

b. Search for and open the `ChangeRequestStateHandler` script include, which controls the transitioning between states using one of the defined models.
c. Create a property to reference the new change request type value. For example, `EXPEDITED: "expedited"`.

d. Override the base method `_resetModel` to be able to include the new model. For example, if the change request type is `expedited`, then the new state model `ChangeRequestStateModel_expedited` is included. Example code with changes highlighted in bold:

```javascript
var ChangeRequestStateHandler = Class.create();

// All references to statehandler constants should be through this class
ChangeRequestStateHandler

ChangeRequestStateHandler.DRAFT = ChangeRequestStateHandlerSNC.DRAFT;
ChangeRequestStateHandler.ASSESS = ChangeRequestStateHandlerSNC.ASSESS;
ChangeRequestStateHandler.AUTHORIZE = ChangeRequestStateHandlerSNC.AUTHORIZE;
ChangeRequestStateHandler.SCHEDULED = ChangeRequestStateHandlerSNC.SCHEDULED;
ChangeRequestStateHandler.IMPLEMENT = ChangeRequestStateHandlerSNC.IMPLEMENT;
ChangeRequestStateHandler.REVIEW = ChangeRequestStateHandlerSNC.REVIEW;
ChangeRequestStateHandler.CLOSED = ChangeRequestStateHandlerSNC.CLOSED;
ChangeRequestStateHandler.CANCELED = ChangeRequestStateHandlerSNC.CANCELED;

ChangeRequestStateHandler.prototype =
Object.extendsObject(ChangeRequestStateHandlerSNC, {

  EXPEDITED: "expedited",
  initialize: function(changeRequestGr) {
    ChangeRequestStateHandlerSNC.prototype.initialize.call(this,
    changeRequestGr);
  },

  _resetModel: function() {
    this._model = null;
    var type = this._gr.getValue('type') + "";

    if (type == this.NORMAL || type == this.STANDARD || type ==
        this.EMERGENCY)
      ChangeRequestStateHandlerSNC.prototype._resetModel.call(this);
    else if (type == this.EXPEDITED)
      this._model = new ChangeRequestStateModel_expedited(this._gr);
    },

  type:"ChangeRequestStateHandler"
});
```

e. Save the script include.
6. Complete the following steps to create a workflow for the new change request type.
   
a. Navigate to *Workflow > Workflow Editor*.
   
b. Open an existing change request workflow. For example, *Change Request – Emergency*.
   
c. Select *Copy* from the *Actions* menu to copy the workflow and name the new workflow. For example, *Change Request – Expedited*.
   
d. Select *Properties* from the *Actions* menu to update the condition under which the new workflow executes. For example, `[Type] [is] [Expedited]` in the condition.
   
e. Open the matching change tasks workflow that is called by the main workflow. For example, *Change Request - Emergency change tasks*.
   
f. Select *Copy* from the *Actions* menu to copy the workflow and name the new workflow. For example, *Change Request - Expedited change tasks*.
   
g. Select *Publish* from the *Actions* menu to publish the new change tasks workflow and make it available for use.
   
h. Go back to the first workflow you created and update the Workflow activity to reference the new change tasks workflow. For example, *Change Request - Expedited change tasks*.
   
i. Select *Publish* from the *Actions* menu to publish the new workflow and make it available for use.

**Related information**

*Change types*

*Add a state to the state model*

**Extend or disable multiple CI association**

The ability to associate multiple CIs to a task can be extended to other types of tasks. You can also disable multiple CI association from the related lists on change request records.

**Before you begin**

Role required: admin
Procedure

1. Enter `sys_properties.list` in the navigation filter to open the System Property [sys_properties] table.

2. Open the **List of all the task types where user wants to associate CIs using a List (com.snc.task.associate_ci)** system property. The value of this property is set to `change_request`, `incident` by default to enable association of multiple CIs to change requests.

3. To enable multiple CI association to other types of task, add the required table as a value. For example, to enable multiple CI association for problem records, add `problem` as a value, separated by a comma.

4. Click **Update** to save and update the property.

5. Optional: Complete the following steps to disable multiple CI association for the Change Request form.

   a. Remove the `change_request` value from the **List of all the task types where user wants to associate CIs using a List (com.snc.task.associate_ci)** system property.

   b. Navigate to **System UI > List control**.

   c. Perform one or both of the following tasks to disable multiple CI association for the related lists.

<table>
<thead>
<tr>
<th>Associated CIs</th>
<th>Open the entry with the <code>task_ci.task</code> related list and clear the <strong>Omit edit</strong> check box.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impacted Services/CIs</td>
<td>Open the entry with the <code>task_cmdb_ci_service.task</code> related list and clear the <strong>Omit edit</strong> check box.</td>
</tr>
</tbody>
</table>

State model and transitions

Change Management offers a state model to move and track change requests through several states.

**Example of state transitions for a normal change request**

![Example of state transitions for a normal change request](image)
The following table provides a list of all the states that a change request can progress through. Email notifications can be sent to the user who requested the change when it progresses to the following states: **Scheduled**, **Implement**, **Review**, and **Canceled**.

### Change states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
<th>State value</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Change request is not yet submitted for review and authorization. A change requester can save a change request as many times as necessary while building out the details of the change prior to submission.</td>
<td>-5</td>
</tr>
<tr>
<td>Assess</td>
<td>Peer review and technical approval of the change details are performed during this state.</td>
<td>-4</td>
</tr>
<tr>
<td>Authorize</td>
<td>Change Management and the CAB schedule the change and provide final authorization to proceed.</td>
<td>-3</td>
</tr>
<tr>
<td>Scheduled</td>
<td>The change is fully scheduled and authorized, and is waiting for the planned start date. An email notification is sent to the user who requested the change.</td>
<td>-2</td>
</tr>
<tr>
<td>Implement</td>
<td>The planned start date has approached and the actual work to implement the change is being conducted. An email notification is sent to the user, who requested the change.</td>
<td>-1</td>
</tr>
<tr>
<td>Review</td>
<td>The work has been completed. The change requester determines whether the change was successful. A post-implementation review can be conducted during this state. An email notification is sent to the user who requested the change.</td>
<td>0</td>
</tr>
<tr>
<td><strong>Note:</strong> You cannot cancel the change request if it is in the Review state.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Closed</td>
<td>All review work is complete. The change is closed with no further action required.</td>
<td>3</td>
</tr>
<tr>
<td>Canceled</td>
<td>A change can be canceled at any point when it is no longer required. However, a change cannot be canceled from a <strong>Closed</strong> state. An email notification is sent to the user who requested the change.</td>
<td>4</td>
</tr>
</tbody>
</table>
Normal, standard, and emergency changes progress through states in different ways.

<table>
<thead>
<tr>
<th></th>
<th>New</th>
<th>Assess</th>
<th>Authorize</th>
<th>Scheduled</th>
<th>Implement</th>
<th>Review</th>
<th>Closed</th>
<th>Canceled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Standard</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Emergency</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**State progress for different changes**

- Normal changes progress through all states.
- Standard changes are considered to be pre-authorized, so they bypass the Assess and Authorize states that trigger approval records. Approving these changes progress the change to the next appropriate state. Rejecting these changes send them back to New state.
- Emergency changes are similar to standard changes, except that they must be authorized.

**Revert a change request to a New change**

Change Management allows the Emergency and Normal change types to be reverted to the new state which is the first approval state using the Revert to New action from the Context Menu. This action is performed if the approval was requested and the submitter recognizes that not all configuration item in the scope of the change is included before submitting for approval.

- To modify the Normal change request to the New state, modify the state of a change request from Assess state to New state by clicking Revert to New from the Context menu.
- To modify the Emergency change request to the New state, modify the state of a change request from Authorized state to New state by clicking Revert to New from the Context menu.

**Note:** When you revert to New from the Assess state or the Authorized state, the workflow is restarted and all pending approvals are cancelled.
Modify change request type

- A new ACL for change_request.type has been added that allows modification of the Type field in change request when the change request is in a New state and no approvals have been generated yet for it.

- In case of Standard change request, you can modify the type of the change request from Standard to Normal or Emergency, if the state of a change request is New.

- In case of Normal or Emergency change request, you can modify the type of the change request from Normal to Emergency or vice versa if the state of a change request is New.

- If a Normal or Emergency change request is rejected, the state of the change request is set to New. As the state of the change request is New, you can modify the type of the change request again. For example, if your Emergency change request is rejected on the grounds that the change request is Normal, you can modify the Type of the change request to Normal and resubmit the change request.

Disabled Cancel change action

- The Cancel option for a change request in the Review state is disabled. This restricts cancelling the request when the work is complete and is waiting for review.

State progression for normal, standard, and emergency changes

Each change request model progresses through a number of state values in a specific order.

<table>
<thead>
<tr>
<th>Normal change state progression</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>1. New</td>
</tr>
<tr>
<td>2. Assess</td>
</tr>
<tr>
<td>3. Authorize</td>
</tr>
<tr>
<td>4. Scheduled</td>
</tr>
<tr>
<td>5. Implement</td>
</tr>
<tr>
<td>6. Review</td>
</tr>
<tr>
<td>7. Closed</td>
</tr>
</tbody>
</table>
### Standard change state progression

<table>
<thead>
<tr>
<th>State</th>
<th>Can be canceled?</th>
<th>Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. New</td>
<td>Yes</td>
<td>Standard change state model</td>
</tr>
<tr>
<td>2. Scheduled</td>
<td>Yes</td>
<td>Canceled</td>
</tr>
<tr>
<td>3. Implement</td>
<td>Yes</td>
<td>Review</td>
</tr>
<tr>
<td>4. Review</td>
<td>Yes</td>
<td>Closed</td>
</tr>
<tr>
<td>5. Closed</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

### Emergency change state progression

<table>
<thead>
<tr>
<th>State</th>
<th>Can be canceled?</th>
<th>Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. New</td>
<td>Yes</td>
<td>Emergency change state model</td>
</tr>
<tr>
<td>2. Authorize</td>
<td>Yes</td>
<td>Canceled</td>
</tr>
<tr>
<td>3. Scheduled</td>
<td>Yes</td>
<td>Review</td>
</tr>
<tr>
<td>4. Implement</td>
<td>Yes</td>
<td>Closed</td>
</tr>
<tr>
<td>5. Review</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>6. Closed</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

### Add a state to the state model

You can add a new state to the existing state model for different change types based on the requirements of your organization.

**Before you begin**

Role required: script_include_admin, ui_policy_admin, ui_action_admin, or admin

**About this task**

The State model plugin is activated by default. For more information about base system states for change requests, see State model and transitions.
Procedure

1. Navigate to **Change > Create New** and complete the following steps to add a choice to the choice list.

   a. Right-click the **State** field and click **Configure dictionary**.

   b. In the **Choices** related list, run a filter for [Table] [is] [change_request].

   c. Click **New** and add the new state with the following information.
      - **Table**: Change Request [change_request]
      - **Label**: name of your new state
      - **Value**: numerical value that is not already assigned to an existing state choice
      - **Sequence**: number corresponding to the location for it to appear in the list of states. If you assign it the same sequence number as another choice, it appears below the other choice.

   d. Click **Submit**.

2. Navigate to **System definition > Script includes**.
   Script include records that contain **snc** in the name are read-only. As you complete the following steps, ensure that you are selecting the correct script include to modify. For example, modify **ChangeRequestStateHandler** not **ChangeRequestStateHandlerSNC**.

   - **Note**: Extended script includes (without **snc**) include all of the functionality of their SNC counterparts. If you modify a base script include (appended with **snc**), it is no longer updated during system upgrades.

3. Open the **ChangeRequestStateHandler** script to perform the following edits.
   - Update the **statehandler constants** section at the start of this script include to include values for the newly added state. For example:
     ```javascript
     ChangeRequestStateHandler.MY_NEW_STATE = "mynewstate";
     ```
   - Update the **STATE_NAMES** map at the end of the initialize function to include the numeric value for the newly added state. For example:
this.STATE_NAMES["-6"] = ChangeRequestStateHandler.MY_NEW_STATE;

Note: The STATE_NAMES map provides a mapping between the numeric values that are stored in the State field on a change request under a memorable name. This mapping enables the memorable name to be used in the state model script includes.

4. Edit the appropriate script include to incorporate the new states into the model for the relevant change request types. Each type of change request has a corresponding script include named ChangeRequestStateModel_<type> where <type> is the value of the change request type. For example, ChangeRequestStateModel_normal defines the state model for change requests with a type of normal. Each state model script include defines objects that specify the following information.

• Which states are available.
• The next state or states for each available state.
• Functions for each state transition to decide whether that transition is available (canMove) along with a function to be executed as part of moving to that state (moving).

The following example is from the ChangeRequestStateModel_normal script include.

5. Create a UI action to provide a button to progress the change request to the new state.
a. Use **Insert and Stay** to make a copy of one of the default UI actions, such as *implement*.

b. Update the following fields on the form.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Update to match the name of the new state.</td>
</tr>
<tr>
<td>Action name</td>
<td>Replace the state at the end of the name with the new state.</td>
</tr>
<tr>
<td>Hint</td>
<td>Update the text to refer to the new state.</td>
</tr>
<tr>
<td>Onclick</td>
<td>Rename the function to match the new state.</td>
</tr>
<tr>
<td>Condition</td>
<td>Update the call to the <code>isNext</code> function with the new state.</td>
</tr>
<tr>
<td>Script</td>
<td>• Update the function name to match the one specified in the <strong>Onclick</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• Update the line that starts with <code>ga.addParam(“sysparm_state_name”,…</code>, to enter the name of the new state as the second parameter of the <code>addParam</code> function.</td>
</tr>
<tr>
<td></td>
<td>• Update the line starts with <code>gsftSubmit</code> and modify the third parameter of this function call to match the value entered in the <strong>Action name</strong> field.</td>
</tr>
</tbody>
</table>

The following example uses the **Implement** UI action to show the values to update.
The ChangeRequestStateHandler script includes contains two functions that are used to determine if a UI action is displayed based on the current state of the change request.

- **isNext(stateName)**: This function only checks if the `stateName` passed as a parameter is available as a next state for the current state of the change request.

- **canMoveTo(stateName)**: This function performs the same check as the `isNext` function. However, it also checks the result of calling the appropriate `canMoveTo` function for the transition from the current state to the `stateName` passed as a parameter. This function is used if there are additional checks in the `canMove` functions such as checking that a field contains a particular value.

6. Complete the following steps to update the process flow configuration to incorporate the new change state.

   The process flow is displayed at the top of the Change Request form and is configured in various process flow records.
a. Navigate to System UI > Process Flow module and filter for [Table] [is] [change_request].

b. Open a record and use Insert and Stay to make a copy.

c. Update the following fields on the form.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Update to match the name of the new state.</td>
</tr>
<tr>
<td>Label</td>
<td>Update to match the name of the new state. This value is included in the process flow at the top of the Change Request form.</td>
</tr>
<tr>
<td>Order</td>
<td>Update this number so that the new state is in the correct sequence with the existing process flow records for other states.</td>
</tr>
<tr>
<td>Condition</td>
<td>Update the filter to match the new state.</td>
</tr>
</tbody>
</table>

d. Click Update.

What to do next
To ensure that the new state works as expected, review the default workflows. Add the new state to the workflow as necessary.

Review default workflows
Any modification to the state model may impact the default workflows for change requests.

Before you begin
Role required: admin
About this task
Each change type has a default workflow. To ensure that any change to the state model has not adversely impacted workflows, you must review each of the default workflows.

Procedure
Review the workflow for each ChangeRequestStateModel_<type> script include that has been modified.

<table>
<thead>
<tr>
<th>Change type</th>
<th>Script include name</th>
<th>Workflow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>ChangeRequestStateModel_normal</td>
<td>Change Request - Normal</td>
</tr>
<tr>
<td>Standard</td>
<td>ChangeRequestStateModel_standard</td>
<td>Change Request - Standard</td>
</tr>
<tr>
<td>Emergency</td>
<td>ChangeRequestStateModel_emergency</td>
<td>Change Request - Emergency</td>
</tr>
</tbody>
</table>

Modifications to the default workflow for each change type depend on where the new state is added in the sequences of states.

Configure state model transitions
You can use script includes or UI policies to configure state models and the criteria for moving change requests from one state to another.

Before you begin
Role required: script_include_admin, ui_policy_admin, or admin

Procedure
1. Complete the following steps to add state change criteria in a script include that enables a state transition.

   a. Navigate to System Definitions > Script Includes.

   b. Open the script include for the state transition model that you want to edit.
<table>
<thead>
<tr>
<th>State transition model</th>
<th>Script include</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>ChangeRequestStateModel_normal</td>
</tr>
<tr>
<td>Standard</td>
<td>ChangeRequestStateModel_standard</td>
</tr>
<tr>
<td>Emergency</td>
<td>ChangeRequestStateModel_emergency</td>
</tr>
</tbody>
</table>

c. Modify the appropriate method `canMove` method in the script include.

**Example**

For example, to add a condition for a normal change to transition from the New state to the Authorized state, modify the `draft.authorized.canMove()` method in the `ChangeRequestStateModel_normal` script include. In the script, the GlideRecord you are acting on can be referenced using the `this._gr` variable.

The `canMove` method is part of a structure that defines the transitions available to the change type. The `canMove` method is contained in the `currentState.nextState.canMove()` structure.

2. Complete the following steps to use a UI policy to add new criteria for state transitions.

a. Navigate to **System UI > UI Policies**.

b. Open a default UI policy to edit or click **New** to create a new policy.

The following are the default UI policies.

<table>
<thead>
<tr>
<th>UI Policy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>CAB fields for normal and emergency changes from the <strong>Authorize</strong> state and onwards.</td>
</tr>
<tr>
<td>Mandatory</td>
<td><strong>Assignment Group</strong> field.</td>
</tr>
<tr>
<td>Mandatory</td>
<td><strong>Close notes</strong> and <strong>Code</strong> fields when in the <strong>Closed</strong> state.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** In both of the mandatory UI policies, the state of the change request determines the mandatory fields. For **Show - CAB** fields, the type of change is also taken into account because standard changes do not require approval.

c. Complete and save the UI policy.
Modify the email notification for change request state changes

There is a change request email notification, which, if active, sends a notification to the user when the state progresses to Scheduled, Implement, Review, or Canceled. You can modify the change request notification to specify when to send it, who receives it, and what it contains.

Before you begin
Role required: admin

About this task
By default, the notification is sent to the user who originally requested the change. Notifications are not sent to the user who updated the state on the change request.

Procedure
1. Navigate to System Notification > Email > Notifications.
2. Locate and open Change request state change notification.
3. On the form, modify information in the following form sections: When to send, Who will receive, What it will contain.
   For more information about email notifications and the fields in the form, see Create an email notification.
4. Click Update.

Tutorial: add a new change management state
This tutorial provides an example of adding a new state to the existing state model.

Before you begin
Role required: admin

About this task
Consider the following scenario:
Based on your organization's requirements, you must add a new state, Complete, between the existing Implement and Review states. You must also add the ability to decide if the Review state is needed.

Perform the following steps:

Create a new choice
Create a new choice for the change request state.
Before you begin
Role required: admin

Procedure
1. Open the Change Request form.
2. Right-click the State field label and select Configure Choices. The Configuring State Choices slushbucket opens.
3. Enter the following information and click Add.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New item text</td>
<td>Enter Complete.</td>
</tr>
<tr>
<td>Numeric value</td>
<td>Enter -6.</td>
</tr>
<tr>
<td>Apply to table</td>
<td>Set to Change Request</td>
</tr>
</tbody>
</table>

The new state appears in the Selected slushbucket on the form.
4. Use the up and down arrows to move the new state between Implement and Review states.

5. Click Save. The new choice is created and the Change Request form reopens.
Create a custom field
Create a custom choice field to indicate whether a change request must go through the Review state.

Before you begin
Role required: admin

Procedure
1. Open the Change Request form.
2. Complete the following steps to create a new field on the Change Request form.
   a. Open the form context menu and select Configure > Form Layout.
   b. Enter the following values in the Create new field section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Needs Review</td>
</tr>
<tr>
<td>Type</td>
<td>Choice</td>
</tr>
</tbody>
</table>

   c. Click Add to add the new field to the slushbucket.
      The new field appears at the bottom of the Selected slushbucket.

   a. Use the up and down arrows next to the slushbucket to move the new field next to the Assigned to field.
b. Click **Save**.
   The Change Request form reopens with the **Needs review** field below the **Assigned to** field.

3. Complete the following steps to configure the choices for the **Needs review** field.

   a. Right-click the **Needs review** field label and select **Configure choices**.
      The **Configuring choices** form appears with empty slushbucket lists for **Available** and **Selected**.

   b. In the **Enter new item** field, add **Yes** and **No** choices and click **Add**.
      The choices appear in the **Selected** list.

   c. Click **Save**
      The Change Request form reopens. The **Needs review** choice list contains the **Yes** and **No** choices.

4. **Optional:** If the value in the **Needs review** field is **Yes**, **No**, or blank, configure the default by completing the following steps.

   a. Right-click the **Needs review** field label and select **Configure Dictionary**.

   b. In the **Choice List Specification** section, select **Dropdown with – None –** as the default **Choice**.

   c. Click **Update**.
      The Change Request form reopens. The **Needs review** field displays **-- None --**.

**Add a UI policy**
Add a UI policy to display the **Needs review** field for **Normal** change requests when it reaches the **Complete** state.

**Before you begin**
Role required: **admin**

**Procedure**
1. Open the **Change Request** form.
2. Open the form context menu and select **Configure > UI Policies**.
3. Click **New**.
4. Enter the following values on the **UI Policy** form.
5. Open the form context menu and select **Save** to create the UI Policy record and stay on the form. The **UI Policy Actions** related list appears.

6. Click **New** in the **UI Policy Actions** related list.

7. Enter the following values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field name</td>
<td>Needs review</td>
</tr>
<tr>
<td>Mandatory</td>
<td>True</td>
</tr>
<tr>
<td>Visible</td>
<td>True</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
8. Click **Submit** to create the UI Policy action and return to the **UI Policy** form.

Create an ACL

Create an access control rule (ACL) to prevent the **Needs review** field from being modified after it has been set.

**Before you begin**

Role required: admin with elevated security

**About this task**

The newly created UI Policy makes the **Needs review** field mandatory when a change request reaches the **Complete** state.

The subsequent configuration of the state model ensures that a value is required in the **Needs review** field before the change request can be saved in the **Complete** state. To prevent the **Needs review** value from being changed after it has been set, create a new access control level record (ACL) to make the field read-only.
Procedure

1. Open the **Change Request** form.
2. Open the form context menu and select **Configure > Security Rules**.
3. Elevate your security role in the user menu that opens when you click your name in the header.
   Only administrators with elevated security roles can add ACLs.
4. Click **New**.
5. Enter the following values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Record</td>
</tr>
<tr>
<td>Operation</td>
<td>Write</td>
</tr>
<tr>
<td>Name (first part)</td>
<td>Change Request</td>
</tr>
<tr>
<td>Name (second part)</td>
<td>Needs review</td>
</tr>
<tr>
<td>Condition</td>
<td>[State] [is] [Implement]</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

**Update the state handler script include**

Update the **ChangeRequestStateHandler** script include with the new **Complete** state.
Before you begin
Role required: admin

About this task
The ChangeRequestStateHandler script include defines the states available for the Change Request state model.

Procedure
1. Navigate to System Definition > Script Includes.
2. Open the ChangeRequestStateHandler script include and modify the script as follows.
   a. Add the following line to the top of the script in the Constants section:
      ```javascript
      ChangeRequestStateHandler.COMPLETE = "complete";
      ```
   b. Add the following line as the last line of the function in the Initialize function:
      ```javascript
      this.STATE_NAMES["-6"] = ChangeRequestStateHandler.COMPLETE;
      ```
3. Click Update.

Update the state model script include
Update the ChangeRequestStateModel_normal script include to add new functions for the Complete state.

Before you begin
Role required: admin
About this task

You update the `ChangeRequestStateModel_normal` with the following configuration.

• Add new `canMove` and `moving` functions for the **Complete** state. These functions can return a value of `true` since there are no special conditions for or extra actions to perform when moving to the **Complete** state.

• Modify the definition of the existing object for the **Implement** state to ensure that the next state is **Complete**.

• Add an object for the **Complete** state, which defines **Review** and **Closed** as the next two states.

  Note: The `canMove` functions for the transition to these states from **Complete** checks the **Needs review** custom field to determine the correct next state.

Procedure

1. Navigate to **System Definition > Script Includes**.

2. Open the `ChangeRequestStateModel_normal` script include and modify the script as follows.

   a. Add the following line at the end of the script include but before the line that starts with `type`:

```
toComplete_moving: function() { 
  return true;
},

  toComplete_canMove: function() { 
    return true;
},
```

   b. Modify the existing `implement` object to `toComplete`:

```
  implement: { 
    nextState: [ "complete" ],
```

3. Add the following new state object for complete.

```javascript
complete: {
    nextState : [ "review", "closed" ],

    review : {
        moving : function() {
            return this.toReview_moving();
        },

        canMove : function() {
            if (this._gr.getValue("u_needs_review") == "Yes")
                return true;
            return false;
        }
    },

    closed : {
        moving : function() {
            return this.toClosed_moving();
        },

        canMove : function() {
```
```javascript
if (this._gr.getValue("u_needs_review") == "No")
    return true;

return false;
}
},

canceled : {
    moving : function() {
        return this.toCanceled_moving();
    },
},

canMove : function() {
    return this.toCanceled_canMove();
}
},
```

4. Click **Update**.

Create a UI action

Create a UI action to display a button on a change request for the **Complete** state.

**Before you begin**

Role required: admin

**About this task**

The UI action must contain a condition that uses the state model script include to decide when the **Complete** button is displayed on the Change Request form. In this case, the **Complete** button is displayed only when the change has reached the **Implement** state.

**Procedure**

1. Open the **Change Request** form.
2. Open the form context menu and select **Configure > UI Actions**.
3. Locate and open the existing **Implement** UI action.
4. Open the form context menu and click **Insert and Stay** to create a duplicate record.
5. Modify the following fields with new values.
<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Complete.</td>
</tr>
<tr>
<td>Action name</td>
<td>state_model_move_to_complete.</td>
</tr>
<tr>
<td>Hint</td>
<td>Progresses change to Complete state.</td>
</tr>
<tr>
<td>Onclick</td>
<td>moveToComplete();</td>
</tr>
<tr>
<td>Condition</td>
<td>gs.hasRole('itil') &amp;&amp; new ChangeRequestStateHandler(current).isNext(&quot;complete&quot;)</td>
</tr>
</tbody>
</table>

**Script**

```javascript
function moveToComplete(){
    var ga = new GlideAjax("ChangeRequestStateHandlerAjax");

    ga.addParam("sysparm_name", "getStateValue");
    ga.addParam("sysparm_state_name", "complete");

    ga.getXMLAnswer(function(stateValue) {
        g_form.setValue("state", stateValue);
        gsftSubmit(null, g_form.getFormElement(), "state_model_move_to_complete");
    });
}

if (typeof window == 'undefined')
    setRedirect();

function setRedirect() {
    current.update();
}
```
6. Click **Update**.

**Create a process flow record**

Create and add a process flow record for the **Complete** state. The process flow formatter displays at the top of the Change Request form.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System UI > Process Flow**.
2. Open the **Normal Change – Implement state** record.
3. Open the form context menu and click **Insert and Stay** to create a duplicate record.
4. Modify the following fields with new values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Normal Change – Complete State</td>
</tr>
<tr>
<td>Label</td>
<td>Complete</td>
</tr>
<tr>
<td>Order</td>
<td>550</td>
</tr>
<tr>
<td>Condition</td>
<td>[State] [is] [Complete]</td>
</tr>
</tbody>
</table>
5. Click **Update**.

**Update the change request workflow**

Update the change request workflow to reflect the addition of the **Complete** state.

**Before you begin**
Role required: admin

**About this task**
The Change Request – Normal workflow for the **Normal** type change request must be updated to progress the change request to **Complete** instead of **Review**.

In case of a change request of type **Normal**, in the **Assess** state, any user from the **Assignment group** can approve the change request. When the value of **Risk** is **Moderate** or **High**, a CAB approval is initiated in the **Authorization** state. In case the **Risk** is **Low**, an approval from the CAB team is not required. Instead, the manager of the assignment group can approve the change request.

**Note:** If the manager of the assignment group also happens to be the user who had approved the change request in the **Assess** state, the **Authorize** state is skipped and the state of the change request is set to **Scheduled**.

The functionality is available only for the new customers.
Procedure
1. Navigate to Workflow > Workflow Editor.
2. Select Change Request – Normal from the list of workflows.
3. Select the Checkout option from the Context menu to create a new version of this workflow.
4. Open the Set Values activity that transitions to the End activity and modify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Move to Complete</td>
</tr>
<tr>
<td>Set these values</td>
<td>State = Complete</td>
</tr>
</tbody>
</table>

5. Click Update.
6. Open the **Wait for conditions** activity that transitions to the End activity and modify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Change moves to Complete</td>
</tr>
<tr>
<td>Set these values</td>
<td>[State] [is] [Complete]</td>
</tr>
</tbody>
</table>

7. Click **Update**.

8. Open the Workflow Actions menu and click **Publish**.

**Change Management workflows**

The Change Management processes for a change request are controlled by workflows defined for a specific change request type. You can use the graphical Workflow Editor to modify one of the default workflows, or to create additional change request workflows. For more information on using the Workflow editor, see **Workflow editor**. Change Management workflows support domain separation.
By default, seven change request workflows are provided.

### Default change workflows

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Request - Emergency</td>
<td>The workflow process that an emergency change request follows.</td>
</tr>
<tr>
<td>Change Request - Emergency change tasks</td>
<td>The child workflow process that handles the creation and management of the change tasks for the emergency change request workflow.</td>
</tr>
<tr>
<td>Change Request - Normal</td>
<td>The workflow process that a normal change request follow.</td>
</tr>
<tr>
<td>Change Request - Normal change tasks</td>
<td>The child workflow process that handles the creation and management of the change tasks for the normal change request workflow.</td>
</tr>
<tr>
<td>Change Request - Standard</td>
<td>The workflow process that a standard change request follow.</td>
</tr>
<tr>
<td>Change Request - Standard change tasks</td>
<td>The child workflow process that handles the creation and management of the change tasks for the standard change request workflow.</td>
</tr>
</tbody>
</table>

### Change flows

The Change Management Change flows provide a library of reusable actions and end-to-end implementations of the Change models provided in the base system.

You can use the ServiceNow® Flow Designer to create, operate, and troubleshoot flows. The Flow Designer is a single interface that provides:

- Natural language descriptions.
- Runtime information.
- Consolidated configuration.

By default, these Change flows are provided:
## Default Change flows

<table>
<thead>
<tr>
<th>Flow</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change - Cloud Infrastructure - Authorize</td>
<td>Process cloud infrastructure changes for approvals.</td>
</tr>
<tr>
<td>Change - Emergency - Authorize</td>
<td>Process an emergency change that is in authorize state and is not on hold.</td>
</tr>
<tr>
<td>Change - Emergency - Implement</td>
<td>Process an emergency change that is in the implement state.</td>
</tr>
<tr>
<td>Change - Emergency - Review</td>
<td>Process an emergency change in the review state.</td>
</tr>
<tr>
<td>Change - Implementation tasks</td>
<td>Process to create implementation and post implementation change tasks for change request and wait until completion.</td>
</tr>
<tr>
<td>Change - Normal - Assess</td>
<td>Process a normal change that is in the assess state and is not on hold.</td>
</tr>
<tr>
<td>Change - Normal - Authorize</td>
<td>Process a normal change that is in the authorize state and is not on hold.</td>
</tr>
<tr>
<td>Change - Normal - Implement</td>
<td>Process a normal change that is in the implement state.</td>
</tr>
<tr>
<td>Change - Standard</td>
<td>Process a normal change.</td>
</tr>
<tr>
<td>Change - Standard - Implement</td>
<td>Process a standard change that is in the implement state.</td>
</tr>
<tr>
<td>Change - Unauthorized - Authorize</td>
<td>Process an unauthorized change for approvals.</td>
</tr>
</tbody>
</table>

## Change Management Flow Designer actions

Use Flow Designer actions as building blocks to handle the Change models and types. The flow actions are available under the ITSM spoke in Flow Designer.

## Change Management flow actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply Change Approval Policy</td>
<td>Controls the approval process for a change request by creating user</td>
</tr>
</tbody>
</table>
### Change Management flow actions (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User and group approvals</td>
<td>and group approvals according to a change approval policy record. Multiple actions can be used in a flow, where each action references the same or different Change approval policies.</td>
</tr>
<tr>
<td>Cancel Change Tasks from Flow</td>
<td>Cancels all related pending and open change tasks that are created from a flow.</td>
</tr>
<tr>
<td>Check Change for User Approval</td>
<td>Checks if the specified user has already approved the change request.</td>
</tr>
<tr>
<td>Disregard change approvals</td>
<td>Sets all related pending approvals to no longer required.</td>
</tr>
<tr>
<td>Evaluate Change Model</td>
<td>Evaluates the change model associated with the change request.</td>
</tr>
</tbody>
</table>

### Use the Apply Change Approval Policy flow action

Apply your change approval policy in the Change Management Flow Designer action to control the approval process for a change request. You can create user and group approvals according to a change approval policy record.

**Before you begin**

Role required: admin

**About this task**

This flow action uses the Ask For Approval flow action to apply approvals that are derived from the Change approval policy. When approvals are being generated, the Ask For Approval action avoids generating more than one approval for the same user. For example, if the policy requires approval from two groups and both groups have the same user, then the shared user is notified only once for the approval.

**Procedure**

2. Select the flow that you want to apply the change approval policy to.
3. Select **Action** > **Installed Spokes** > **ITSM** > **Change** > **Apply Change Approval Policy**.

4. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Label</td>
<td>Unique label for the action.</td>
</tr>
<tr>
<td>Policy [Change Approval Policy]</td>
<td>Policy that you want to apply to your Change request.</td>
</tr>
<tr>
<td>Change Request</td>
<td>Source of the change request required by the policy. Select this field using the data pill picker icon ( ). Alternatively, you can select the change request from the Change Request list.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Due date for the approval policy. Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong>: The approval has no due date.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Approve</strong>: Automatically approve the approval policy on the due date.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reject</strong>: Automatically reject the approval policy on the due date.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Cancel</strong>: Automatically cancel the approval policy on the due date.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

### Change models

Change managers can use the Change models feature to conveniently tailor change activities and flows for specific use cases.

This feature is an extension to the existing IT Infrastructure Library (ITIL) OOB Change types and workflows. You can use it to transit to fit-for-purpose models and ServiceNow® Flow Designer without compromising on existing capabilities.

Change models enable you to define:
• Fit-for-purpose state models
• State transitions
• State transition conditions

By default, the following models are provided as examples for ITIL mode 1 and mode 2 processes. These models are available with the activation of the Change Management - Change Model Foundation Data (com.snc.change_management.change_model.foundation) plugin.

<table>
<thead>
<tr>
<th>Change model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Change model used for ITIL mode 1 Normal changes.</td>
</tr>
<tr>
<td>Emergency</td>
<td>Change model used for ITIL mode 1 Emergency changes.</td>
</tr>
<tr>
<td>Standard</td>
<td>Change model used for ITIL mode 1 Standard changes.</td>
</tr>
<tr>
<td>Change Registration</td>
<td>Change model used to capture change requests in an external system. There are no approvals associated with this model.</td>
</tr>
<tr>
<td>Cloud Infrastructure</td>
<td>Change model used for change requests that commission and decommission Cloud infrastructure services.</td>
</tr>
<tr>
<td>Site Reliability Ops</td>
<td>Change model used for site reliability operations.</td>
</tr>
<tr>
<td>Unauthorized Change</td>
<td>Change model used for change requests that are created from the unauthorized change events.</td>
</tr>
</tbody>
</table>

**Change Models properties**

Configure the Change Models properties to access the Change models capabilities when creating a Change request.

The following properties enable you to access the Change Models features. For upgrade users, these properties are set to **true**.
Enter `sys_properties.list` in the navigation filter and enter `*change_model` in the Search panel to view and edit the properties.

### Change Models Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.change_management.change_model.hide</td>
<td>Hides the Change models feature when the <code>com.snc.change_management.change_model.type_compatibility</code> property is enabled. When creating a new change, you do not have the option to choose a model, and the Model field is not available on the Change request form.</td>
</tr>
<tr>
<td>com.snc.change_management.change_model.manage_workflow</td>
<td>Enables Workflow management support for ChangeRequest API if the <code>com.snc.change_management.state.model</code> plugin is installed. This will call the 'deleteDefaultWorkflowContext' method to be called on specific state and type changes.</td>
</tr>
<tr>
<td>com.snc.change_management.change_model.type_compatibility</td>
<td>Enables Change Type Compatibility for Change models if the <code>com.snc.change_management.state.model</code> plugin is installed. When true allows changes to be created with both the type based workflow and Change models.</td>
</tr>
</tbody>
</table>

### Create a Change model

Depending on your requirements, you can create a Change model and configure the states and transitions for a specific use case.

**Before you begin**

Role required: change_manager

**Procedure**

1. Navigate to Change > Administration > Change Models.
2. Click New.
3. On the form, fill in the fields.
### Change Model form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the Change model.</td>
</tr>
<tr>
<td>Default Change Model</td>
<td>Option for enabling the Change model as a default model on the Change request form.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for enabling that this model is available for selection when creating a Change request.</td>
</tr>
<tr>
<td>Color</td>
<td>Color that appears on the left side of the Change model bar on the Models tab in the Change landing page.</td>
</tr>
<tr>
<td>Available in ‘Create New’</td>
<td>Option for enabling that this model is available for selection on the Models tab on the Change landing page. Also, the model will be available to select in the Model field on the Change request form.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the Change model.</td>
</tr>
<tr>
<td>Record Preset</td>
<td>Preset values for all changes using this model.</td>
</tr>
</tbody>
</table>

4. Click the form context menu icon (ALLERY) and select Save. The Model States context menu appears. You can select the states for your Change model.

5. Click New.

6. On the form, fill in the fields.

### Model State form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>State that you want to include in your model.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Initial State</td>
<td>Option to enable this state as the initial state for your model. This field is automatically selected when you add the first state to your model.</td>
</tr>
</tbody>
</table>

7. To save the state and return to the Change Model form, click **Submit**.

8. To add a transition between the states, click the display/hide hierarchical lists icon () for the model state that you want to apply the transition to. The Model State Transitions context menu appears.

9. Click **New**.

10. On the form, fill in the fields.

**Model State form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>State that the Change request is moving from.</td>
</tr>
<tr>
<td>To</td>
<td>State that the Change request is moving to.</td>
</tr>
<tr>
<td>Automatic Transition</td>
<td>Option for enabling automatic transition to the Change request when the defined conditions are met. Selecting this option also prevents you from manually selecting the <strong>State</strong> field on the Change request form.</td>
</tr>
</tbody>
</table>

11. Click the form context menu icon () and click **Save**. The Model State Transition Condition context menu appears.

12. Click **New**.

13. On the form, fill in the fields.

**Model State Transition Condition form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the condition.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State Transition</td>
<td>State that you're applying the transition condition to. This field is automatically set with the state that you're applying the condition to.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the condition.</td>
</tr>
<tr>
<td>Requires</td>
<td>Condition for your transition. You can select a pre-defined condition or select <strong>Transition Condition</strong> to define a condition. To create pre-defined conditions, see Create predefined conditions.</td>
</tr>
<tr>
<td>Condition (condition builder)</td>
<td>Condition on the Change request that must be fulfilled to enable the transition.</td>
</tr>
<tr>
<td>Condition (script)</td>
<td>Script that must be fulfilled to enable the transition. The script returns a value of <strong>True</strong> when passed.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to make the condition active.</td>
</tr>
</tbody>
</table>

14. Click **Submit**.

**Create predefined transition condition types**

Create predefined transition conditions to reuse the conditions for your Change models.

**Before you begin**

Role required: change_manager

**Procedure**

1. Navigate to **Application > Module > Change Model Condition Types**. A list of transition conditions for Change requests appears.

2. Click **New**.

3. On the form, fill in the fields.
## Model State form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the condition type. This name is displayed in the Requires field on the Model State Transition Condition form.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the condition type.</td>
</tr>
<tr>
<td>Condition Type</td>
<td>Type of condition that is either condition or script.</td>
</tr>
<tr>
<td>Table name</td>
<td>Table name that the condition is based on.</td>
</tr>
<tr>
<td>Condition (Condition builder)</td>
<td>Conditions that must be fulfilled for processing the transition.</td>
</tr>
<tr>
<td>Condition (Script)</td>
<td>Script that must be fulfilled for processing the transition. If passed, it returns a value of true.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

### Attach a process for Change model states

You can attach a process with defined conditions to the Change model states to enable state transitions.

This process can be done by using one of the following methods:

- Workflow: See Workflow.

Change flows for default Change models are available in Flow Designer. For more information on default Change flows, see Change flows.

### Evaluating a Change model

When your flow is completed, you can evaluate the Change model to process any automated transitions. In Flow Designer, the **Evaluate Change Model** action is used to evaluate the Change model.
When using Business Rules or Workflow, you can use the script to evaluate the Change model. For example, see the Change Registration: Auto State Change business rule on the change_request table.

You can also evaluate a Change model for a specific Change request using this event:

<table>
<thead>
<tr>
<th>Event name</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>change_model.evaluate</td>
<td>Change Request sys_id</td>
<td>Process that may affect the state of the Change request but doesn't change the Change request record.</td>
</tr>
</tbody>
</table>

Create a change request

A change request enables you to implement a controlled process for the addition, modification, or removal of approved and supported configuration items (CIs). A change request records the detailed information about the change, such as the reason of the change, the priority, the risk, the type of change, and the change category.

**Before you begin**

Role required: itil, admin, or sn_change_write

**About this task**

If you use conflict detection, the planned start and end dates and the configuration item (CI) are required.

**Procedure**

1. Create the change request with one of these options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Change module</td>
<td>You can create all three types of change from the Change module.</td>
</tr>
<tr>
<td></td>
<td><strong>a. Navigate to Change &gt; Create New.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>b. Select Normal, Emergency, or Standard changes.</strong></td>
</tr>
<tr>
<td></td>
<td>If you are an upgrade customer and willing to use change models, you must enable the change model properties.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>For information on change models and its properties, see Change models.</td>
<td></td>
</tr>
<tr>
<td>When you enable the change model properties, you see the following tabs when you navigate to Change &gt; Create New.</td>
<td></td>
</tr>
<tr>
<td>• Models: Shows all the available models available to select.</td>
<td></td>
</tr>
<tr>
<td>• Preapproved: List of preapproved models to select.</td>
<td></td>
</tr>
<tr>
<td>• Pinned: Models that you have pinned from the Models and Preapproved tabs.</td>
<td></td>
</tr>
<tr>
<td>• All: All models are available to select.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>From an incident or a problem</th>
<th>As a user with the sn_change_write role, you can create only normal or emergency changes from an incident or a problem.</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Open the incident or problem.</td>
<td></td>
</tr>
<tr>
<td>b. Right-click the form header and select Create Normal Change, Create Standard Change, or Create Emergency Change.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>From an existing change record</th>
<th>If the administrator enabled the change request copy option, you can create a new change by copying an existing change record.</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Open the change record that you want to copy.</td>
<td></td>
</tr>
<tr>
<td>b. Click Copy Change.</td>
<td></td>
</tr>
</tbody>
</table>

Note: If the create task workflow sets the create_from field in the [change_task] table to workflow, manually created tasks from the existing change record are copied.

2. On the form, fill in the fields.

Change Request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Change request number.</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Requested by</td>
<td>User who requested the change. This field is available in the Change Requests list view, so that you can see who requested a particular change.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the change, for example, Hardware, Network, Software.</td>
</tr>
<tr>
<td>Service</td>
<td>Business service that you want to make available for the change request.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you select a business service as the configuration item and that business service is also listed as the configuration item in any other active task, the active tasks icon (▃) appears. Click this icon to view the list of all the other active tasks that are affecting the business service. You can view the BSM map (dependency view) of the selected business service by clicking the dependency icon (▃).</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. You can choose to receive different levels of performance and features for a given service through service offerings. You must select a service to filter the available service offerings.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>CI that the change applies to. Change requests can be associated with any type of CI, including service offerings, providing detailed access to SLA and availability requirements. When you select a dynamic CI group, all the configuration items related to the selected dynamic group will be populated in the Affected CIs related list. In the Affected CIs related list, you can also manually add and delete the dynamic CI groups. When you add a dynamic CI group, all the related CIs are added, and</td>
</tr>
<tr>
<td>Field</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>when you remove a dynamic CI group, the related CIs are removed.</td>
</tr>
<tr>
<td></td>
<td>After selecting a CI, you can click the health dashboard icon ( 상태 ) to view the CI health details.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> By default, Service Offering is filtered out and CIs with Principal Class are selected. The Principal Class filter functionality is applicable to new customers starting the Paris release.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority is based on impact and urgency, and it identifies how quickly the service desk should address the task.</td>
</tr>
<tr>
<td>Risk</td>
<td>Risk level for the change.</td>
</tr>
<tr>
<td></td>
<td>The risk of a change can be defined manually as <strong>High</strong>, <strong>Moderate</strong>, or <strong>Low</strong>. You can also use <strong>Risk Calculation and Risk Assessment</strong> to drive the risk value of the change.</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact is a measure of the effect of an incident, problem, or change on business processes.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of change request. This field is read-only.</td>
</tr>
<tr>
<td>State</td>
<td>State of the change request. The default state is New.</td>
</tr>
<tr>
<td>Conflict status</td>
<td>Status that indicates whether there is a conflict for this change or the conflict is not run.</td>
</tr>
<tr>
<td>Conflict last run</td>
<td>Date and the time when the conflict was last run.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group who will work on the change request. The business rule <strong>Populate Assignment Group based on CI/so</strong> populates the <strong>Assignment group</strong> field based on the support group available for the CI or the service offering consecutively.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The business rule is triggered when a change request is created or updated and when the <strong>Assignment group</strong> and the <strong>Assigned to</strong> fields are empty.</td>
</tr>
<tr>
<td></td>
<td>If you want to override the default value, you need to create new properties and provide the field in the property value that must be used to populate the</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Field | Definition
--- | ---
**Assignment group** field. Create the properties in the following order of preference:
- `com.snc.change_request.ci_assignment_group.field_name`: Identifies which CI field populates the **Assignment group** field.
- `com.snc.change_request.service_offering_assignment_group.field_name`: Identifies which service offering field populates the **Assignment group** field.

*Note:* If you are an upgrade customer and want to install the ITSM CSDM Best Practices - Quebec plugin (com.snc.best_practise.itsm_csdm.quebec) on your instance, please contact Support.

<table>
<thead>
<tr>
<th>Assigned to</th>
<th>User that the change is assigned to. If an assignment rule applies, the change is automatically assigned to the appropriate user or group.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Summary of the change.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the change.</td>
</tr>
</tbody>
</table>

3. To plan the change, click the **Planning** tab and enter information. This information is critical for change approvers.

4. Click the **Schedule** tab.

- **a.** Enter as much information about the scheduled dates as you have. Some of the fields are available for normal or emergency changes only because standard changes are preapproved.

  *Note:* For normal or emergency changes, enter the planned start and end dates and actual start and end dates manually. Populate the actual start and end date fields during the Implement state as the assignee begins and completes the work.

- **b.** If the form is configured to show the **CAB required** check box, select it to indicate that CAB approval is required before implementation. The **CAB date** field in the change request is automatically updated with the date in the **Meeting start time** field of the CAB meeting form.

- **c.** If there is an unplanned CI activity, selecting the **Unauthorized** check box helps in determining if the change is an unauthorized change. For more information, see **Unauthorized change request**.
Note: This check box is available only for emergency change requests.

d. If the form is configured to show the CAB delegate field, select the user who attends the CAB meeting to describe the change.

e. In the CAB recommendation field, enter notes or recommendations related for the CAB meeting.

5. Click the Conflicts tab.

6. To detect change conflicts, click Check conflicts.

7. Right-click the form header and click Save.

8. Review entries in the related lists and modify the entries as appropriate.

### Default Change Request related lists

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affected CIs</td>
<td>List of CIs (from the CMDB) affected by the change. You can associate multiple affected CIs with a change.</td>
</tr>
<tr>
<td>Impacted services/CIs</td>
<td>List of CIs, such as business services or from other CI classes, that are impacted by the affected CI in the change. You can associate multiple impacted CIs with a change.</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>List of service offerings affected by the change. You can associate multiple service offerings with a change. This related list is available only when a service offering is selected. If there are service offerings associated to the Impacted Services, then refresh the Impacted services/CIs related list to view the offerings.</td>
</tr>
</tbody>
</table>

Note: If you have customized the default view of your form or related list prior to the Paris release, you cannot see the field or the related list by default. Modify the form to add them manually.

<table>
<thead>
<tr>
<th>Approvers</th>
<th>This list is automatically generated from the workflow. You can also view the Group of approvers assigned to the task.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Tasks</td>
<td>The list of tasks can be created from a workflow. The default workflow generates tasks in the Implementation state. You can also create a new change task. The Planned start date and Planned end date in task type Implementation must fall within the planned start and end dates specified in the change request.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Problems</td>
<td>If the change was generated from a problem, this list is generated automatically.</td>
</tr>
<tr>
<td>Incidents Fixed by Change</td>
<td>List of incidents that require the change for resolution.</td>
</tr>
<tr>
<td>Incidents Caused by Change</td>
<td>List of incidents caused by the implementation of the change.</td>
</tr>
<tr>
<td>CAB Agenda Items</td>
<td>List of agenda items and details of respective items. For example, the meeting start and end time, allocated time for the meeting, state of the meeting, and the decision made for that agenda item.</td>
</tr>
</tbody>
</table>

**Note:** The CAB Agenda Items related list is not shown on the form when the list is empty. This feature is available only for Jakarta instances.

9. When the change request is ready to move to the next state, click **Request Approval**.
The state is moved forward based on the type of change request:

- **Assess state:** Group level approval for a normal change request. Approval records are automatically generated based on the **Assignment group**. You can conduct peer and technical reviews of the proposed change.
- **Authorize state:** An emergency change request.
- **Scheduled state:** Pre-approved standard changes.

**Note:** To mail the change record, click the more options icon (⋮) in the content frame and select **Email**. Both the user who requested the change and the user who is assigned to the change are automatically populated in the list of recipients.

To view the calendar, click **View Calendar** in the title bar of the Change Request form.

**What to do next**
*Process a change request*
Create a change request from a CI

You can create a change request from a list of CIs, or add selected CIs from a list to a change record.

Before you begin
Role required: itil, admin, or sn_change_write

Procedure
1. Select a list of CIs. For example, navigate to Configuration > Servers > Unix.
2. Select one or more CIs from the list.
3. Select one of the following options from the Actions list.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to existing Change Request</td>
<td>Select this option to associate the CIs with an existing change request.</td>
</tr>
<tr>
<td>Add to new Change Request</td>
<td>Select this option to associate the CIs with a new change request.</td>
</tr>
</tbody>
</table>
Note: CIs with a Business Service CI class are added to the Impacted Services/CIs related list on the change request. The remaining CIs are added to the Affected CIs related list.

Depending on your selection, either an existing change requested is updated with the selected CIs or a new change request record is created with the selected CIs.

4. You can continue to create or modify the change record as required.

Request a standard change from the catalog

You can request a new standard change from the published standard change catalog templates.

Before you begin
Role required: itil, admin, or sn_change_write

Procedure

2. Select one of the following options depending on the type of standard change you want to request.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Standard Changes</td>
<td>Request a standard change to the network.</td>
</tr>
<tr>
<td>Server Standard Changes</td>
<td>Request a standard change for servers and attached storage.</td>
</tr>
</tbody>
</table>

3. Select a template from the Items section.

Example
For example, Add network switch to datacenter cabinet in the Network Standard Changes > Items section.
When you select the catalog item, a standard change is created. The Change Request form is displayed with values from the standard change template.

4. Complete the form with additional information you have.

Example
For example, add the Configuration item and the Assignment group.

5. Open the form context menu and click Save.
6. Complete any information in the related lists that apply to the standard change request.

7. Click **Update**.

**Copy a change request**

You can copy details of an active or canceled change request to a new change request.

**Before you begin**

Role required: itil, admin, or sn_change_write

**About this task**

The administrator configures which of the following items are copied to the new change request.

- The content that is copied.
- The attributes or fields and values that are copied. All non-copied attributes are reset to default values.
- The configured related tables that are copied.

ℹ️ **Note:** You cannot copy change details from a standard change.

New change tasks can be created when a change is copied. If your change record has associated workflows that create change tasks, then these change tasks may not be copied because the workflow creates them. Only manually created tasks are copied, if the workflow when creating the task sets the `created_from` field on the `change_task` table to `workflow`. The `created_from` field has a default value of `manual`.

**Procedure**

1. Navigate to the change request to be copied.

2. In the Context menu, right-click and then click **Copy Change** to copy change details.
   
   A preview of the new change record appears with values from the original source change record.

3. Edit values on the newly created change record, as appropriate.

4. Click **Submit** to create a new change request record.
What to do next
After an existing change request is copied and a new one created, it is sent for processing to the change manager. The change manager then reviews, approves, implements, and closes the change request as necessary. In addition, you can associate CIs to the newly created change request.

Related information
- Configure ability to copy a change request

Create a change task
You can create change tasks for a change request. A change task is a piece of work related to the change request. For example, there can be tasks to plan the change, implement the change, and test, and review the work.

Before you begin
Role required: itil, admin, or sn_change_write

About this task
Change tasks can be created manually or from a workflow. The Change Request form has a Change Tasks related list, which includes all manual and workflow change tasks. From this related list, you can edit existing tasks or create tasks. Workflow change tasks are generated automatically in Review task type.

Procedure
1. Navigate to Change > Open.
2. Select the change request to add a change task.
3. In the Change Tasks related list, click New.
4. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration item</td>
<td>The configuration item (CI) or service that the change task applies to.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>The date you plan to begin working on the task.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>The date the change task is planned to be completed.</td>
</tr>
<tr>
<td></td>
<td>If the task type is Implementation, the Planned start date and Planned end date values must fall within the planned start and end dates specified in the change request.</td>
</tr>
<tr>
<td>Name</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>The type of change task, <strong>Planning</strong>, <strong>Implementation</strong>, <strong>Testing</strong>, or <strong>Review</strong>. The default workflow generates tasks in type <strong>Review</strong>.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the change task:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Pending</strong>: Open and unassigned</td>
</tr>
<tr>
<td></td>
<td>• <strong>Open</strong>: Open and unassigned</td>
</tr>
<tr>
<td></td>
<td>• <strong>In progress</strong>: Open and actively being worked on</td>
</tr>
<tr>
<td></td>
<td>• <strong>Closed</strong>: Inactive and closed. Requires close code and close notes to be provided.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Canceled</strong></td>
</tr>
<tr>
<td>On hold</td>
<td>The <strong>On hold</strong> check box indicates whether the change task is on hold. Provide an <strong>On hold reason</strong> if a change task is placed on hold.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group that the change task is assigned to.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user that the change task is assigned to. If an assignment rule applies, the change task is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td>Short description</td>
<td>A summary of the task.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the task.</td>
</tr>
</tbody>
</table>

5. To enter work notes for the change task, click the **Notes** tab.
6. To enter notes on why the task was closed, click the **Closure Information** tab.
7. Click **Submit**.
   The change task is added to the change request. The assigned user receives a notification that a task was assigned to them.

**Unauthorized change request**

Understand how an unauthorized change activity on a configuration item (CI) is captured and managed, so that you can review and take timely action on this change.

As part of the ServiceNow® Service Mapping integration with ServiceNow® ITSM, the Change Management application receives an event notification when an unauthorized change activity is detected. As a result, an emergency
Unauthorized change request is created for the relevant CI. You can review and approve or reject the unauthorized change from the Change Management application.

**Note:** Unauthorized change requests are created only for the CIs that are part of the application services. Also, there is a flapper algorithm that uses a learning pattern to minimize false positives.

At times, the discovery process (horizontal or top-down discovery) identifies a change on a CI property that may not be an actual change by definition. This identification is due to a measurement error or just a different representation of the same value, such as case sensitivity. The learning pattern identifies the false positives (flapper changes) and prevents triggering the recomputation and time-line updates as an emergency change request is a critical action. You want to avoid false positives and report only real changes.

The learning pattern identifies the false positives as follows:

1. When a CI property associated with a service changes, the new value (CI and field pair) is logged in the flapper’s data table.
2. The system runs a nightly job and executes various algorithms on the data that is collected to identify patterns that point to false positives.
3. The system runs all the relevant strategy predicates for the changed CI fields with a confidence level greater than 90%. This step determines whether all the new values are false positives or not. If all the new values are false positives, then the change is ignored, and the model is not updated.

**Note:** If the CI is associated with an active change request, then this step is skipped.

An unauthorized change request is created when an unplanned CI change activity occurs, and the system triggers the following checks:

- The system checks to see if the CI is part of the allowed CI classes. If it is allowed, then the system checks to see if this specific CI has been flagged previously. If it was flagged and the previously created unauthorized change was within the notification ignore period, then no further action is taken. If not, then further checks are made to see whether this CI is associated to a change request that matches the condition stated in the properties. If not, then the change to the CI that was detected is flagged as unauthorized and a `ci.change.unplanned` event is raised.

- On receipt of the `ci.change.unplanned` event, the script checks to see if the `Enable event processing` field is `true`. If it is `true`, then an unauthorized change request is created. By default, this property is `false`. 

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The `ci.change.unplanned` event that is generated automatically triggers the creation of an Emergency type change request.

With the help of the following details that are pre-populated on the form, you can identify and review the unauthorized change:

- The **Unauthorized** option is selected. This option indicates that the change is an unauthorized change.
- The **Assignment group** field is populated with **Change Management**.
- The **Configuration item** field is populated with the item that the unauthorized change was made for.
- The **Description** field is populated with the information on the changed fields of the change request.

**Change Request form**

An email notification is sent to the Assignment group, CI Item managed by, Owned by, and Assigned to members for review and approval. However, if there are many CI changes and there are no open change requests created to include the CIs, the system creates unauthorized change requests on these CIs. When this event occurs, the members receive numerous unauthorized change notification emails. In such a case, you can choose to disable these notifications. For more information, see **Disable unauthorized change notification**.
Note: Email notifications are sent only when there is an unplanned change on the CI that is part of an application service (discovered or manual service).

After this change request is approved, the state changes to **Review** and the regular process is followed to close the request.

**Assign post-implementation review**

When a change is implemented without approval, post-implementation review is necessary to evaluate the risk and impact of the unauthorized change.

After the unauthorized change is approved, a change task is created with **State** field as **Review**. This change task is assigned to the Change Management group with the **Short description** field as **Post Implementation Review**. The assigned members who receive the notification can review and close the change task.

**Modify the unauthorized change setting**

As a change manager, you can clear the **Unauthorized** check box to convert the unauthorized change request to an emergency change request. When you clear the check box, enter the reason for this modification in the **Work notes** field.

If you are an ITIL user, clear the **Unauthorized** check box by creating an outage from the task record with the **Type** field specified as **Outage**. For more information, see Create an outage from a task.

Note: When there is an unauthorized change without an outage record associated, then the state flow moves from **Authorize** to **Review** and skips the schedule or implement state. The state changes because the implementation has already happened for this change.

**Disable the creation of an unauthorized change request**

You can choose to disable the generation of unauthorized change requests that you receive on any unauthorized change event. When a configuration item (CI) that is part of an application service is updated, the system identifies this update and verifies whether the updated CI is part of an open change request.

**Before you begin**

Role required: admin or change_manager

**About this task**

If the updated CI is not part of an open change request, then the system triggers a change request, and sends a notification. The Change Management application uses this event to create an unauthorized change. If there are many CI changes with no open change request created to include the CIs, then the
system creates unauthorized change requests on these CIs. When this event occurs, numerous unauthorized change requests are triggered, and notifications are sent to the members of the group. To avoid this situation, you can disable the Enable event processing property before you perform the updates. For more information on additional unauthorized change properties, see Unauthorized change properties.

**Note:** Enable the property when you finish your updates. If this property is disabled, unauthorized change requests are not created.

**Procedure**

1. Navigate to Change > Administration > Unauthorized Change Properties.
2. Clear the Enable event processing property check box.
3. Click Update.

**Results**
The creation of an unauthorized change request is disabled, and no notifications are sent.

**Unauthorized change properties**
Use the Unauthorized Change Properties page to enable or disable the unauthorized change capability, and to configure the criteria for additional unauthorized change properties.

From this properties page, you can control the capabilities, such as:

- Enabling or disabling the creation of unauthorized change requests when receiving the `ci.change.unplanned` event.
- Configuring the type of change requests, which are valid, and fall into the unauthorized change category.
- Configuring a quiet time, whereby, if there is a repeated change to a CI that has been flagged previously, another unauthorized change is not created within that time period.
- Configuring the interval frequency for detection.
- Including a CI class for the change request that must be monitored.

**Note:** Monitored CIs must be part of an application service.

Navigate to Change > Administration > Unauthorized Change Properties to view and edit the properties.
Unauthorized change properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable event processing</td>
<td>Enable the property to create unauthorized change events when an unplanned CI change (\text{ci.change.unplanned}) event is triggered.</td>
</tr>
<tr>
<td></td>
<td>• Default value: False</td>
</tr>
<tr>
<td>Notification ignores period</td>
<td>Enter the time duration until which you want to disable sending notifications or creating unauthorized changes for the same CI.</td>
</tr>
<tr>
<td></td>
<td>• Default value: 1 day</td>
</tr>
<tr>
<td>Change request query</td>
<td>Add the query conditions to define what change requests are valid and belong to the unauthorized change category. For example, you can add a condition to view all active change requests that are in the implement or review state for the given CI. If the conditions given are not met, then the change becomes an unauthorized change.</td>
</tr>
<tr>
<td>CI class inclusion</td>
<td>Choose the CI classes that you want to include and monitor for an unauthorized change to be created.</td>
</tr>
</tbody>
</table>

Process a change request

You can approve, implement, review, and close a change request.

Before you begin
As part of processing a change request, ensure that you have detected any change conflicts and performed risk assessment.

Role required: itil, admin, sn_change_write, or change_manager

Procedure
You can perform the following actions on a change request based on your role.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve or reject a change request</td>
<td>Open the approval record and click <strong>Approve</strong> to approve the change request or <strong>Reject</strong> to reject it. The change request changes to the <strong>Scheduled</strong> state if it is approved or to <strong>New</strong> state if it is rejected.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Implement a change request</td>
<td>Click <strong>Implement</strong> to put the change request into action. The change request state changes to <strong>Implement</strong>. The workflow creates two change tasks: <strong>Implement</strong> and <strong>Post-implementation testing</strong>. Review the change tasks and assign them to a user or group, as appropriate.</td>
</tr>
<tr>
<td>Review a change request</td>
<td>Click <strong>Review</strong> after reviewing the details on the change request. The change request is moved to the <strong>Review</strong> state. All open change tasks are set to <strong>Canceled</strong>.</td>
</tr>
<tr>
<td>Close a change request</td>
<td>Click <strong>Close</strong> after entering the <strong>Close code</strong> and <strong>Close notes</strong> in the <strong>Closure Information</strong> section. The change request is closed.</td>
</tr>
<tr>
<td>Cancel a change request</td>
<td>From the context menu, click <strong>Cancel Change</strong>. Provide a reason for canceling the change and click <strong>Save</strong>. The change request is canceled and the reason for canceling the change is added to the <strong>Work Notes</strong> field.</td>
</tr>
</tbody>
</table>

**Note:** Manually created change tasks are not automatically closed or cancelled when state is changed from Implement to Review. You must first close the change tasks and to close the change request.

Users with approval_user role, who approve change requests, do not have access to the change request itself. The following information are made available within the approval record to help these users make the right approval decision:

- ◦ Number Requested by
  ◦ Configuration Item Type
  ◦ Planned Start Date Risk
  ◦ Planned End Date Impact
You can also add approval history to the change request activity log. Click the activity filter icon and select **Approval history** from the list. When there is a change in the approval process, such as an approval, rejection, or comments, the activity log is updated.

**Related information**

Create a change request

**Associated CIs on a change request**

You can associate additional CIs or services to change requests through related lists on the Change Request form. You can also associate CIs with a change request from the dependency views map.

The **Affected CIs** and **Impacted Services/CIs** related lists enable you to manage CI changes.

When you first access a change request and work with these related lists, you can identify CIs across CI classes using configuration class. You can change the configuration class manually to filter the list and narrow the selection of CIs. For example, to filter for Linux servers only, select **Linux Servers** as the **Configuration Class**.

You can also create and save filters to provide quick access to common CI searches. The next time you access the change request, the **Configuration Class** field displays the last associated CI class. This automatic filter ensures that relevant CIs are displayed.

After identifying the CIs affected by a change request, you can add them to the **Affected CIs** related list on the change request. After saving affected CIs, you can open the form context menu and select the **Refresh Impacted Services** option. This option populates the **Impacted Services/CIs** related lists based on the primary CI i.e. the CI that is mentioned on the form.

The **Impacted Services/CIs** and **Service Offering** related lists represents a many-to-many relationship between the Task [task] and CMDB [cmdb_ci] tables. The
related list displays CIs, such as business services or other CI classes, and the offerings that are impacted. You can add this related list to any task form such as an incident or problem form. You can also enter the details of the impacted services and the service offerings manually, as required.

Note:

• The manually added CIs are not deleted each time the impacted services are refreshed. However, business services related to the CIs are displayed on the Impacted Services/CIs related list.

• Refresh Impacted Services was only available for Change Request table. From this release, it is available for tables that extend the Task table. The list of these tables is driven by the \texttt{com.snc.task.refresh_impacted_services} property. This UI action populates the Impacted Services/CIs related list based on the primary CI i.e. the CI that is mentioned on the form.

• The Impacted Services list includes application services discovered by Service Mapping.

Add affected CIs to change requests using dependency views

You can use dependency views to identify dependent CIs affected by a change request, and then add them to the Affected CIs related list.

Before you begin

Role required: itil, sn_change_write, or admin

About this task

When a change request is associated with a configuration item, the change record becomes accessible from dependency views. Services affected by the change request are easy to assess in dependency views.

If not visible, the administrator can configure the change request form to display the Affected CIs related list.

Procedure

1. In the change request, click the dependency views icon next to the Configuration item field.

Note: If there are critical change requests attached to a CI for a database, the map includes the business services that rely on that database. The database icon has a blinking glyph on the lower left edge that indicates any issues with the node.

The configuration item is displayed in the map with all dependent CIs.
2. Click the down arrow next to the CI to display a list of tasks and issues with the CI.
   The list may contain one or more change requests, and follow-on audit tasks. You can open each record from this list.

3. Click the task number to display the complete list of tasks attached to this CI. You can view the user assigned to the change and also open the record for more information.

4. To change the map configuration, select a format from the Layout field or use the filter panel to filter the map. The dependency views map highlights the affected CIs that depend on the database or other CI.

5. To add an affected CI to the change, click the arrow next to the highlighted node and select Add Affected CIs.

6. Reload the change request form. You can view the CI you added in the Affected CIs related list.

Related information
Dependency Views

Associate multiple CIs with a change request
You can associate multiple impacted or affected CIs with a single change request.

Before you begin
Role required: itil, change_manager, sn_change_write, or admin

About this task
Use the Configuration Item field in the change form when there is one primary CI that is the cause of the change. The configuration items displayed are only those CIs whose class is set as the Principal Class in Configuration > CI Class Manager.

In the Affected CIs related list, a new filter is added for the Principal Class. You can control this functionality by the system property com.snc.task.principal_class_filter. The property contains all the task types where the Principal Class filter is applied to.

When you create a change request, you can add multiple CIs to that change request using the Affected CIs or Impacted Services/CIs related lists in the change record. Affected CIs can be added only when the change request is in the New state.
Procedure

1. Navigate to Change > Open and select a change request record.
2. In either the Affected CIs or Impacted Services/CIs related list, click Add.

3. Select the appropriate CIs from the list of CIs displayed in the pop-up window. The pop-up window for the Affected CIs list is filtered for the configuration class of the last added CI. This automatic filter ensures that relevant CIs are displayed. You can change the class to list other CIs, if appropriate.

The Impacted Services/CIs pop-up window lists all CIs and provides standard filtering options. You can also save any filters you create to provide faster access to common CI searches.

4. Perform one of the following actions.
• Select the CIs to add and click **Add Selected** to add the selected CIs to the change request.
• Click **Add All** to add all the CIs in the list to the change request.

**Related information**

**Bulk CI Changes and Mass Update CI**

**Add an affected CI with a calculated application service**

From the change request form, you can add an affected CI that is associated with a calculated application service.

**Before you begin**

Role required: itil, sn_change_write, or admin

**Procedure**

1. Navigate to **Change > Open**.
2. Select a change request to add affected CIs to.
3. On the Change Request form, scroll to the Related Links section.
4. Click the **Affected CIs** tab and then click **Add** to add an affected CI to the change request.
5. Open the form context menu and click **Refresh Impacted Services**.
6. Click the **Impacted Services/CIs** tab to see any dynamic services that are associated with the affected CI and that are impacted by the change request.

**Use Bulk CI Changes and Mass Update CI**

After the Bulk CI Changes and Mass Update CI change management features are activated, you can use the proposed changes in a change request to apply the same update to a set of CIs for a specific CI class.

**Before you begin**

Role required: itil, sn_change_write, or admin

**About this task**

**Procedure**

1. Navigate to **Change > Create New** and select **Normal** or **Emergency** change.
2. Select the **Mass update CI class** check box.
The **Mass update CI class** tab or form section appears.

3. On the **Mass update CI class** tab, select the CI class to update. The dynamic CI group is not available for selection. When using mass update, a specific CI class must be selected and not a group that may have different CI classes. The parent CMDB [cmdb_ci] table is selected by default. Search for the class name, for example, enter **linux** or **email**.

   **Note:** If you have selected a dynamic CI group for the **Configuration item** field, the configuration items that are part of the dynamic group and belong to the selected CI class are updated. For example, if the dynamic CI group that you have selected consists of Linux servers, computers, and network switches, and you select Linux servers for the CI class with proposed changes, only the Linux servers in the dynamic group get updated.

4. Enter the proposed changes that you want to make to all the affected CIs. Each time that you select a field and value, another line appears. If you enter a proposed change in error, click the **X** beside the line to remove it.

5. Click **Submit**.

6. Open the change request you submitted.

7. In the Affected CIs related list, click **Add**. The Add Affected Configuration Items window that opens lists only the CIs in the selected CI class.

8. Select one or more CIs and click **Add Selected**, or click **Add All**. If you change the CI class after selecting affected CIs, the list is cleared when you save the record.

9. Continue with the change management process for this change request.

10. When the record reaches the Implement or Review states, click **Apply Proposed Changes**. A message appears informing you that the proposed changes were applied to all the affected CIs.

   **Note:** If you are using the Bulk CI Change without Mass Update CI feature, then the proposed changes are applied when the change request is closed.

**Related information**

- Bulk CI Changes and Mass Update CI
- Activate Best Practice - Bulk CI Changes
Activate Change Management - Mass Update CI
Create a change request

Place a change request on hold
You can put a change request on hold when it is not in the New, Canceled, or Closed state.

Before you begin
Roles required: itil, admin, sn_change_write, or change manager
The following plugins need to be activated to avail the synchronization of the On Hold functionality between change task and change request:

- Change Management Best Practice — madrid [com.snc.best_practice.change.madrid]
- Change Management — Core [com.snc.change_management]
- Change Management — State Model [com.snc.change_management.state_model]

About this task
Change tasks inherit some state conditions from the parent change request they are related to. When a change request is placed on hold, these conditions are applied to it:

- If the change is waiting for approval, the pending approvals are marked No Longer Required. When the change request is no longer On Hold, the pending approvals are reinstated and are Awaiting approval.
- The change can progress only to the Canceled state while it is On Hold.
- If a change request is canceled while it is On Hold, then its On Hold flag is set to false so the change cannot be canceled and still be On Hold.
- If the change request is set to On Hold, the value of the On Hold field for all the active change tasks for that change request is set to true and the On hold reason is copied from the change request to the change tasks.
- If you clear the On Hold check box in a change request, the On Hold field for all the active change tasks for that change request is set to false and the On hold reason is cleared from the change tasks.
- If the change request is canceled, all the active change tasks related to that change request are also canceled.
- A change request can only be closed when all the active change tasks related to that change request are closed or canceled otherwise a pop-up appears notifying that there are open change tasks that require to be closed.
• If there are existing change tasks that are manually placed on hold, those change tasks do not get overwritten when the change request is placed to the On Hold state. Similarly, when the change request is taken off the hold state, the change tasks that were placed on hold manually stays in the On Hold state.

Procedure
1. Navigate to Change > Open.
2. Open the specific change request.
3. Select the On Hold check box.
4. In the On hold reason field, enter the reason for placing the change request on hold.
5. Click Update.

Related information
State model and transitions
Create a change request

Perform bulk changes to CIs on a change request
You can perform bulk changes to CIs from the change request form.

Before you begin
Role required: admin
Best Practice - Bulk CI Changes is activated and the change request form is configured to perform bulk changes to CIs.

Procedure
1. On the change request form, select a CI class.
   If all required fields are completed, then the form is saved and submitted.
2. Click Add on the Affected CIs related list.
   The list in the pop-up window is filtered to list only CIs from the selected CI class.
3. Add the CIs that are involved in the change.
4. Enter the proposed changes in the **Proposed change** field. Whenever the **Proposed change** field is modified or affected CIs are added, the saved changes are applied to all affected CIs. In the illustrated examples, the assignment group and cost center values are applied to the KIOSK keyboard and scanner when the change request is completed.

5. Click **Update** to save and update the record. The resulting changes are listed at the top of the form. The following message displays on the form when CIs are listed in the **Affected CIs** related list.

   When the change request is in the **Implement** state, you can click **Apply Proposed Changes** in the form header to update the affected CIs. Otherwise, the changes are applied when the change request is closed.

**Bulk CI Changes and Mass Update CI**

The Best Practice - Bulk CI Changes plugin and the Change Management - Mass Update CI plugin enable users to apply the same update to a set of CIs for a specific CI class. The Change Management - Mass Update CI plugin extends
the Best Practice - Bulk CI Changes plugin and is intended to be used when the Change Management - State Model plugin is activated. The Best Practice - Bulk CI Changes plugin is intended to be used with the legacy state model that preceded the Change Management – State Model plugin introduced in the Geneva release.

To use these features, activate the Change Management - Mass Update CI plugin and the Best Practice - Bulk CI Changes plugin.

**Note:** This feature is available for normal and emergency changes only.

When you activate the Change Management - Mass Update CI plugin, the **Mass update CI class** check box appears on the Change Request form. When selected, the **Mass update CI class** tab appears and allows changes to be proposed against the configuration items that match that class associated with the affected CI’s related list in that change.

In the **Implement** state, the system generates the **Mass Update CI.xml** that allows to update the CI records. When the proposed change is saved, **Mass Update CI.xml** is added to the affected CIs. The update can then be applied when the change is in the **Implement** or **Review** state.

**Note:** You cannot add or delete a CI when the change request in the **In-progress** state and is not approved.

**Change Request form modifications for Bulk CI Changes**

If you prefer to use Best Practice - Bulk CI Changes without Mass Update CIs, the **CI class** and **Proposed change** fields must be added to the Change Request form. The administrator configures it as described in the following list:

- Add the **CI Class** and **Proposed Change** fields, if they are not already visible.
- Add the **Affected CIs** related list, if it is not already visible.
- Remove the **Configuration Item** field from the form because all CIs are tracked through the **Affected CIs** related list.

**Related information**

- Activate Best Practice - Bulk CI Changes
- Activate Change Management - Mass Update CI
- Associate multiple CIs with a change request
- State model and transitions
- Configure a form
Refresh impacted services and CIs for Change

The Impacted services and CIs related list refreshes its records and also the records listed in the Service Offerings and Business Applications related lists based on the affected CIs. You can identify the impacted services and CIs and take necessary action.

Before you begin
Role required: itil, change_manager, sn_change_write, or admin

About this task
Refreshing impacted Services on a change request form is executed in one of the following ways:

• Conflict detection: When a conflict detection is triggered, refreshing of impacted services may be initiated. The Automatically include business or application services related to CIs with conflicts in the Impacted CIs/Services related list property (change.conflict.populateimpactedcis) controls whether the Impacted Services/CIs related list should be refreshed or not. If this property is enabled, then a call is made to the ChangeUtils script include calling a refreshImpactedServices method for the current change request.

• Automatically when the change request moves from the new state: Impacted services are refreshed when the change request moves from the new state and when the Affected CIs related list is not modifiable.

• Manually when selecting the Refresh Impacted Services option from contextual menu.

Procedure

1. Navigate to Change > Open.

2. Open the change record for which you want to refresh the related lists those values are based on affected CIs.

3. Click the Additional actions icon and then select Refresh Impacted Services.

   The records in the Impacted Services/CIs, Business Applications, and Service Offerings related lists are updated according to this flow:
• If the `change.refresh_impacted.include_affected_cis` property is set to true, all the services from svc_ci_assoc table are retrieved. If the property is set to false, then services are retrieved from CIUtils script include.

• If the `change.conflict.populateimpactedcis` property is set to true, then additional services are retrieved from ChangeCollisionHelper and added to the list of services.

• If the Service Mapping plugin is active, then Application Services are retrieved. These are retrieved, whereby, the association type is **Runs On**, and the association child is one of the CIs in the affected list.

Once all these services are correlated, a new list is added, and the existing items in the related list are removed, where the `manually_added` flag is set to false. The list of services is then used to populate the Business Applications and Service Offerings if the properties are enabled.

**Refresh impacted services properties**

Use the refresh impacted services properties to enable or disable the refresh impacted services capability, and to configure the criteria for additional refresh impacted services properties.

By configuring these properties, you can control the capabilities, such as:

• Include the primary configuration item or all the items in the Affected CIs related list.

• Processing of refreshing the impacted services as an event.

• Populate Service Offerings and Business Applications from the Impacted Services related list.

The following properties can be found in sys_properties.list and on the Change properties page.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>change.refresh_impacted.include_affected_cis</td>
<td>When true, all the configuration items listed in the Affected CIs related list are checked. These configuration items are checked against the Application services mapping table (svc_ci_assoc) as this is a faster process, and also returns a more concise relationship picture.</td>
</tr>
</tbody>
</table>
### Refresh impacted services properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If the property is false, only the CI on the change form is used. This uses the method of traversing the cmdb tree structure to find the services.</td>
</tr>
<tr>
<td><code>change.conflict.populate_impacted_cis</code></td>
<td>If this property is set, then the ChangeCollisionHelper script include checks the configuration items that have been identified in the list of conflicts against the Application services mapping table (svc_ci_assoc) and also table (cmdb_ci_service) to check if there are any business services that are directly impacted.</td>
</tr>
</tbody>
</table>
| `com.snc.change_request.refresh_impacted.event` | • When true, the process of refreshing the impacted services is done through an event. This process is run in the background and you will be notified through a message in Notify that the process has been complete.  
• When false, this is run in your session. As this is not run in background, there is no notification on completion.  

**Note:** This property is available only from Rome. |
| `com.snc.change_request.populate_service_offering` | • When true, the Service Offerings related list is populated from the Impacted Services/CIs related list. 
• When false, the related list is not populated or amended in any way. |
Refresh impacted services properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.change_request.populate_business_application               | • When true, the Business Applications related list is populated from the Impacted Services/CIs related list.  
• When false, the related list is not populated or amended. |

**Standard change catalog**

Standard changes are pre-approved, low risk changes with a proven history of success. The standard change catalog contains the changes that have been approved by the Change Management application as standard changes.

Users with the ITIL role can view the list of available standard changes and submit change requests.

This video demonstrates how the standard change catalog works and how it enables change managers to manage change requests effectively. Standard Change Catalog

A property controls whether the selection of a standard change request from the catalog inserts the change request record into the database. An administrator can select the **Two step** check box in Standard Change Properties. This property requires the requester to click **Submit** to insert the change request record.

Standard changes are logically grouped under specific categories. The Change Management application uses a proposal process to control which changes become available in the standard change catalog.

The standard change catalog enables you to perform the following activities:

- Request, review, and approve standard change templates.
- Request preapproved standard changes.
- Determine access to standard change templates at the user level.

You can propose, modify, and retire standard change templates based on the requirements of your organization.

**Pre-approved standard changes**

Submitting a change request from a standard change template ensures that pre-approved information is automatically populated in the necessary fields. Standard changes are submitted more quickly and fulfillment can be expedited.
Note: You cannot mass-update a set of Configuration Items (CIs) in standard changes. However, you can propose individual changes.

Determine access to standard change templates at the user level
Standard change templates are logically grouped under specific categories. These categories are displayed to users based on user criteria such as user role, geographical location, and department.

Configure standard change catalog properties
Configure the standard change catalog through the standard change properties.

Before you begin
Role required: admin

Procedure
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td>Select the service catalog to add the generated standard change template to.</td>
</tr>
</tbody>
</table>
| Category    | Select the service catalog category to add the generated standard change template to. You can also choose the category or any child categories of the selected catalog.  

Note: This value is not set automatically on the Proposal form, but must be specified before it is approved.

<p>| Two step    | Check box to make the request of a standard change a two-step process. The process redirects the requester from a standard change template to a change request that can be reviewed before submitting. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mandatory ChangeRequest values</td>
<td>Specify a list of mandatory fields that require values when you propose a new standard change template or a modification to a standard change template. This configuration ensures that when a standard change request is created from a standard change template, one or more fields on the Change Request form contain preset values.</td>
</tr>
<tr>
<td>Default Change Request values</td>
<td>Specify default values for common fields on the Change Request form.</td>
</tr>
<tr>
<td>Restricted Change Request values</td>
<td>Specify the list of fields that end users are not allowed to provide any value for when making a proposal.</td>
</tr>
<tr>
<td>Note:</td>
<td>Ensure that internal columns, such as Updates, Updated, Updated by, Domain, Created, Created by are restricted.</td>
</tr>
<tr>
<td>Read-only fields</td>
<td>Specify the fields that end users are not allowed to provide any value for in the created standard change request.</td>
</tr>
<tr>
<td>Note:</td>
<td>This configuration ensures that for the specified fields, the values approved in the standard change template do not change when the standard change request is submitted.</td>
</tr>
<tr>
<td>Fields to copy</td>
<td>Specify the fields whose values are copied to the Propose a New Standard Change Template record producer from a non-standard change request.</td>
</tr>
<tr>
<td>Note:</td>
<td>If any fields not specified in this list have default values specified, the default values are copied to the record producer.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Change Task properties</strong></td>
<td></td>
</tr>
<tr>
<td>Mandatory Change Task fields</td>
<td>Specify a list of mandatory fields. Enter values for these fields when proposing a new change task template or modifying a change task template.</td>
</tr>
<tr>
<td>Default Change Task values</td>
<td>Specify default values for fields on the Change Task form when creating a change task template.</td>
</tr>
<tr>
<td>Restricted Change Task fields</td>
<td>Specify the list of change request fields that end users are not allowed to provide any value for when creating a change task template.</td>
</tr>
</tbody>
</table>
| Read-only Change Task fields | Specify the fields that end users are not allowed to alter any value for in the change task.  

*Note:* This configuration ensures that for the specified fields, the values approved in the change task template do not change when the change task is created. |
| Change Task Fields to copy | Specify the fields whose values are copied to one or more change task templates when proposing a new standard change template from an existing change request. |

3. Click **Update**.

**What to do next**

You can create a standard change catalog. By default, the basic Standard Change Proposal workflow sends approval records to members of the Change Management group and the members should verify and modify the records, as appropriate.

**Create a standard change task template**

You can create a change task template to add to a standard change proposal. If the standard change proposal is approved, the related change tasks are created when the standard change request is created.

**Before you begin**

Role required: itil, change_manager, or sn_change_write
Procedure

1. Navigate to **Standard Change > Open Proposals**.

   * **Note:** You can add standard change tasks to a standard change proposal only when the proposal is in the **New** state. Once you submit a standard change task for approval, you cannot add additional tasks.

2. Click the **Change Task Templates** tab, and then click **New**.

3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the change task.</td>
</tr>
<tr>
<td>Std change proposal</td>
<td>Name of the standard change proposal for which you want to create the change task template.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which change tasks are created in the change request. The <strong>Order</strong> field determines the order in which you add the change tasks to the change request when you select it from the standard change catalog.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the change task template.</td>
</tr>
<tr>
<td>Change Task values</td>
<td>Field values that are populated on the change task created as part of the standard change.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

   * **Note:** Standard change catalog templates are not supported on Service Portal.

**Propose a standard change template**

Propose a new standard change template when you identify a need while creating a change request. As an IT technician, you can propose a new change template for a change request that you frequently create. This new template is later sent for approval to the change management team, which reviews the request and approves the template as part of the approval process.

**Before you begin**

Role required: itil, admin
**Procedure**

1. You can propose a standard change template by navigating to Change > Standard Change > Standard Change Catalog > Template Management > Propose a new Standard Change Template and filling in the fields on the form.

   **Standard Change Proposal form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description of the standard change proposal template.</td>
</tr>
<tr>
<td>Category</td>
<td>Category under which the template is published. For example, Server Standard Changes.</td>
</tr>
<tr>
<td>Sample Change Requests</td>
<td>Change requests that are available as samples for the change that you propose. The Change Management team reviews the requests as a part of the approval process.</td>
</tr>
<tr>
<td>Change Request values</td>
<td>Text which appears as default text in the standard change proposal template.</td>
</tr>
</tbody>
</table>

2. Click **Save**. The proposal is created with the status **New**.

3. Click **Request Approval**. The proposal is created with the status **In Progress**.

4. **Optional**: You can create a standard change template from a change that exists by completing the following steps.

   a. Navigate to Change > Open and click the change whose information you want to use in the standard change template.

   b. Open the form context menu and click **Propose a Standard Change Template**.

   **Note:**

   * Any change tasks that are included with the change also get copied to the new standard change proposal. The fields copied from both the change and change tasks are defined in the **Standard Change Properties**.

   * By default, approval records are created for members of the Change Management group.
Alternatively, as a change manager, create and submit a standard change proposal that can be utilized as a template to draft a standard change request that occurs frequently and is of low risk. By default, the basic standard change proposal workflow sends approval records to members of the change management group where the members verify and modify the records, as appropriate. Navigate to Change > Standard Change > My Proposals. Click New, fill the form, and then click Submit.

Results
A new template record is created for use.

Attach files to a standard change template
Standard change templates copy any file attached to the template to a change request that the template creates. You can attach files, such as documents, spreadsheet, and images to a standard change proposal.

Before you begin
Role required: itil, admin

Procedure
2. Open the proposal to which you want to add the attachment to.
3. Click the icon to browse and select the file. The attached file appears at the top of the proposal.

   Note: You can add more than one file as an attachment.
4. Click Update and request approval for the proposal.

Results
Any attachment associated with a standard change proposal gets copied to the standard change template that is created when the proposal is approved. When that template is used to create a standard change, any attachment associated to it is also copied to those standard change requests.

Modify or retire a standard change template
You can modify and retire standard change templates based on your organization’s requirements.

Before you begin
Role required: admin, change_manager, sn_change_write or itil
**Procedure**

1. Navigate to **Change > Standard Change > All Templates**.

2. Select the template you want to modify or retire and perform one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Modify a standard change template</strong></td>
<td>a. Click <strong>Modify Template</strong> under <strong>Related Links</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Enter your modifications in the <strong>Modify a Standard Change Template</strong> form.</td>
</tr>
<tr>
<td><strong>Retire a standard change template</strong></td>
<td>a. Click <strong>Retire Template</strong> under <strong>Related Links</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Enter your business justification to retire the specific template in the <strong>Retire a Standard Change Template</strong> form.</td>
</tr>
</tbody>
</table>

3. Perform one of the following actions:
   - Click **Save**. The modifications are saved but not sent for approval.
   - Click **Request Approval**. The template is sent for approval to the change management team.

**Change schedules**

The Change Schedules landing page provides a view of schedules that are categorized under **Pinned Schedules, Your Schedules**, and **All Schedules**. The grouping of schedules provides easy access to your most required schedules and saves your time from searching through all the schedules in the system.

To access Change Schedules, navigate to **Change > Schedule > Change Schedules**.

ℹ️ **Note:** To view the Change Schedules page, you must activate Change Management - Change Schedule plugin (com.snc.change_management.soc).
You can find schedules arranged under three categories as follows:

- **Pinned Schedules**: Includes all change schedules you have previously chosen to pin for quick access.

- **Your Schedules**: Includes all change schedules you own or are a member of the group that owns the schedule.

- **All Schedules**: Includes all change schedules you have access to.

To pin a schedule, hover over the schedule tile and click the pin icon ( ). The schedule appears under Pinned Schedules. To unpin a tile, click the pin icon again.

**Note**: The Show an information message when a change schedule is pinned property in Change Properties controls whether you see an informational message confirming the pinning or unpinning of the schedule.

Click a tab to view a Change Schedule. For more information, refer Change schedules view.

**Change schedules view**

The Change Schedules module provides a Gantt or timeline view of change requests based on criteria defined within a Change Schedule Definition.
The change schedule provides detailed insight to change requests that are included based on the change schedule definition. The change requests can include change timing, duration, related change tasks, blackout periods, and maintenance windows for any given date, week or month.

To view the Change Schedules page, you must activate Change Management - Change Schedule plugin (com.snc.change_management.soc).

Change requests are represented by a span. The duration of the span is defined by the start and end date fields defined in the Change Schedule definition. The Change Schedules page allows conditions to be defined using the condition builder. The condition builder determines which change requests are displayed and sorted in a change schedule.

Note: To show the blackout and maintenance windows of the change in the calendar view, the **Affected CI** field for the change must be configured.

---

**Change Schedule timeline page**

<table>
<thead>
<tr>
<th>SI #</th>
<th>UI Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Context Menu | Option to do the following:  
• Create new schedule: You can create a new schedule from a simplified wizard.  
• Edit a schedule: Allows the modification of change schedules you own and any changes |
<table>
<thead>
<tr>
<th>SI #</th>
<th>UI Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>made are saved to the related Change Schedule Definition record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Copy a schedule: If you are the owner of the change schedule that you want to copy, then a copy of the change schedule is created. If you want to copy a change schedule that is owned by any other user, then you become the owner of the copied schedule and the new schedule is fully editable by you.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View schedule definition: You can view the change schedule definition and the related fields associated with it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Delete: Allows users, who own a change schedule, to delete the schedule.</td>
</tr>
</tbody>
</table>

**Note:**
- A user who only possesses the ITIL role and is not the owner of a change schedule can only create a schedule, copy a schedule, or view an existing schedule definition.
- You become the owner of any schedule that you create. The new schedule that you create appears in the Change Schedule page in a tile form under the **Your Schedules** tab.

2  Span styles  Defined span color based on conditions you specify. You can add new span styles by clicking **Add Span Styles**. You can also edit an existing style rule, apply filters to a style rule, or remove a style rule.

**Note:** By default, span styles are based on the Risk value of a change.
- Risk = High – Span style is Red
- Risk = Moderate – Span style is Orange
- Risk = Low – Span style is green
<table>
<thead>
<tr>
<th>SI #</th>
<th>UI Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Share</td>
<td>Schedules to be shared to other users by user name, group, or role. The share pane also provides a check box to share a change schedule with everybody. If change schedules are not shared with anyone, then only the owner, owner group, and administrator can see them. If a change schedule is shared with other users, an option is available to send an email notification to inform them of their access.</td>
</tr>
<tr>
<td>4</td>
<td>Configuration</td>
<td>Components of the change schedule including the configuration item, duration, or any related tasks can be hidden or exposed.</td>
</tr>
<tr>
<td>5</td>
<td>Keyboard shortcuts</td>
<td>List of available keyboard shortcuts to help you navigate quickly and to provide accessibility to users. The list of navigation shortcuts appears when you click</td>
</tr>
<tr>
<td>6</td>
<td>Zoom</td>
<td>Zoom levels to control change schedule zoom resolution. The range can vary from hours to a yearly view of change schedules.</td>
</tr>
<tr>
<td>7</td>
<td>Arrow keys</td>
<td>Option to navigate forward or back in time in the change schedule based on the current zoom level. Click <strong>Today</strong> to navigate back to the current day and time in a single click.</td>
</tr>
<tr>
<td>8</td>
<td>Change record</td>
<td>Summary of the change record when you click any span. Use <strong>Open Record</strong> in the header of the summary to open the change request in the form view. In the form, you can view the entire change request record.</td>
</tr>
</tbody>
</table>

**Note:** You can specify the fields that are displayed in this window. On the Change Schedule Definition form, under the **Record Summary** tab, specify required fields on **Left column fields** and **Right column fields**.
Note: Change schedules are loaded on the timeline page on the client side in batches of 20. You can load a maximum of 1000 records. These numbers can be modified by system administrator. For more information, refer the properties at Installed with Change Management - Change Schedule.

Create a change schedule from the Change Schedules page

You can create a change schedule to view all scheduled changes, change tasks, blackout periods, maintenance windows for any given date, week, month, or year.

Before you begin

- You have activated Change Management - Change Schedule plugin (com.snc.change_management.soc).
- Role required: itil, sn_chg_soc.change_soc_admin, sn_change_role, sn_change_write roles, sn_change_write, or admin

Note:

- A user with an ITIL role can create a Change Schedule definition and view the schedule definition that they have created.
- An admin or a change schedule administrator can read or edit all Change Schedule definitions.

Procedure

1. Navigate to Change > Schedules > Change Schedules and click New.
2. On the form, fill in the fields.

New Change Schedule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the change schedule.</td>
</tr>
<tr>
<td>Start date field</td>
<td>Field from the change request form that indicates the start date as an example planned start date.</td>
</tr>
<tr>
<td>End date field</td>
<td>Field from the change request form that indicates the end date as an example planned end date.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that determine which change requests display in the Change Schedule interface and the order in which those change requests are sorted.</td>
</tr>
</tbody>
</table>
3. Click **Submit**.
   The change schedule is displayed in the timeline view.

### Create a change schedule from the change schedule definition

You can define a change schedule from a change schedule definition record. Change schedule definitions help you to define the content that displays in the change summary popover, the users, groups or roles with whom a schedule is to be shared, and related span style colors.

**Before you begin**

- You have activated Change Management - Change Schedule plugin (com.snc.change_management.soc).
- Role required: itil, sn_chg_soc.change_soc_admin, sn_change_role, sn_change_write roles, sn_change_write, or admin

**About this task**

To create a new Change Schedule, specify the start and end date fields that you want to be represented in the user interface and also specify the conditions to determine which change requests to display.

**Procedure**

1. Navigate to **Change > Schedules > Change Schedule Definitions** and click **New**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Change Schedule Definition form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Name</td>
<td>Name of the change schedule.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to select if a schedule is active.</td>
</tr>
<tr>
<td>Changes</td>
<td></td>
</tr>
<tr>
<td>Start date field</td>
<td>Field from the change request form that determines the start date of the span.</td>
</tr>
<tr>
<td>End date field</td>
<td>Field from the change request form that determines the end date of the span.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions which determine which change requests display in the Change Schedule</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>interface and the order those change requests are sorted.</td>
<td>Record Summary</td>
</tr>
<tr>
<td>Left column fields</td>
<td>List of fields which appear on the left column of the record summary pop-up. The record summary pop-up appears when you click any span on the change schedule timeline.</td>
</tr>
<tr>
<td>Right column fields</td>
<td>List of fields that appear on the right of the window when you click any span on the change schedule timeline. The record summary pop-up appears when you click any span on the change schedule timeline.</td>
</tr>
<tr>
<td>Blackout and Maintenance</td>
<td></td>
</tr>
<tr>
<td>Show blackout window</td>
<td>Check box to select if blackout window associated to a change request appears in the change schedule timeline.</td>
</tr>
<tr>
<td>Blackout window color</td>
<td>Color to represent blackout window in the change schedule timeline.</td>
</tr>
<tr>
<td>Show maintenance window</td>
<td>Check box to select if maintenance window associated to a change request appears in the change schedule.</td>
</tr>
<tr>
<td>Maintenance window color</td>
<td>Color to represent maintenance window in the change schedule timeline.</td>
</tr>
<tr>
<td>Sharing</td>
<td></td>
</tr>
<tr>
<td>Share with</td>
<td>Option to share the schedule with everyone associated with the change or with specific users and groups.</td>
</tr>
<tr>
<td>Owner</td>
<td>Owner of the change schedule.</td>
</tr>
<tr>
<td>Group Owner</td>
<td>Group that owns a change schedule and has administrative rights to the change schedule.</td>
</tr>
<tr>
<td>Related Link</td>
<td></td>
</tr>
<tr>
<td>Show Schedule</td>
<td>Link to the change schedule that you have defined.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
</tbody>
</table>
### Add related tasks to a change schedule

Create related definitions to present related tasks for change requests in the change schedule. For example, to view the change tasks associated with a change request, you need to define a related definition. You can also add style rules specific to a related task.

#### Before you begin

- You have activated Change Management - Change Schedule plugin (com.snc.change_management.soc).
- Parent change schedule is defined.
- Role required: itil, sn_chg_soc.change_soc_admin, sn_change_role, sn_change_write roles, sn_change_write, or admin

#### Procedure

1. Navigate to Schedules > Change Schedule Definitions.
2. In the related list, click the Related Definition tab.
3. On the form, fill in the fields.

#### Related Definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the related definition.</td>
</tr>
<tr>
<td>Change schedule definition</td>
<td>Reference for the parent change schedule.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to select whether the child schedule is active.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Related Records</td>
<td>Choice list to select the table on which the Related Definition is based.</td>
</tr>
<tr>
<td>Table name</td>
<td></td>
</tr>
<tr>
<td>Reference field</td>
<td>Reference the Related Definition is based on, for example, change request.</td>
</tr>
<tr>
<td>Start date field</td>
<td>Start date field from the related record.</td>
</tr>
<tr>
<td>End date field</td>
<td>End date field from the related record.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions included in the change schedule and the associated ordering of the conditions.</td>
</tr>
</tbody>
</table>

**Record Summary**

<i>Note:** The record summary pop-up appears when you click any span on the change schedule timeline.

| Left column fields           | List of fields that appear on the left column of the record summary pop-up. The record summary pop-up appears when you click any span on the change schedule timeline. |
| Right column fields         | List of fields that appear on the right column of the record summary pop-up. The record summary pop-up appears when you click any span on the change schedule timeline. |

4. Click **Submit**.

**Style rules definition**

You can create a style span to specify the color for different events in a change schedule. Style spans in a schedule help to quickly identify characteristics of a change based on a field value from the Change Request.

Change Schedules includes several base styles to ensure every schedule has span styles to begin with. By default, Blackout Schedules are represented by
a gray color, Maintenance schedules are represented by a light blue color and change requests are represented by either red (risk = High), orange (risk = moderate), or green (risk = low).

To define style rules, you must activate Change Management - Change Schedule plugin (com.snc.change_management.soc).

You can define styles in multiple ways, such as from the Default Style Rules, Change Schedule definitions, or from the Span Style window in the Change Schedule timeline.

**Note:** All style rule tables extend the Style Rule Core table [chg_soc_style_rule_core].

### Define default style rules

You can define style rules from the Default Style Rules module when you want the style rules to be used by change schedules globally and not for any specific application.

**Before you begin**

Role required: itil, sn_chg_soc.change_soc_admin, sn_change_role, sn_change_write roles, sn_change_write, or admin

**Procedure**

1. Navigate to Change > Schedule > Default Style Rules.
2. On the Style Rule page, click New.
3. On the form, fill in the fields.

#### Style Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the style rule.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions which dictate the style rule. For example, risk = High = red.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to determine whether the style rule is active.</td>
</tr>
<tr>
<td>Styling</td>
<td></td>
</tr>
<tr>
<td>Advanced</td>
<td>Check box to write script to set the value of label color, label weight, and event color.</td>
</tr>
</tbody>
</table>
Define style rules from Change Schedule Definitions

You can define style rules from change schedule definitions when you want the style rules to be applied to the change schedule related to the change schedule definition.

**Before you begin**
Role required: itil, sn_chg_soc.change_soc_admin, sn_change_role, sn_change_write roles, sn_change_write, or admin

**Procedure**
1. Navigate to Change > Schedules > Change Schedule Definitions.
2. Open the definition for which you want to define or edit a style rule.
3. Click the Style Rules related list and click New.
4. On the form, fill in the fields.

**Style Rule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the style rule.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions which dictate the style rule. For example, risk = High = red.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to determine whether the style rule is active.</td>
</tr>
<tr>
<td>Styling</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check box to write a script to set the value of label color, label weight and event color. If you do not select the check box, the <strong>Label color</strong>, <strong>Label weight</strong>, and the <strong>Event color</strong> fields appear.</td>
</tr>
<tr>
<td>Label color</td>
<td>Color of the text that is displayed for each record on the timeline that matches the style rule.</td>
</tr>
<tr>
<td>Label weight</td>
<td>Thickness of the label such as normal or bold.</td>
</tr>
<tr>
<td>Event color</td>
<td>Color of the schedule span displayed for each record on the timeline that matches the style rule.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

ℹ️ **Note:** Style rules that you create from a change schedule definition take precedence over the style rules that exist in the base style rule table [chg_soc_style_rule].

### Define style rules from Change Schedules View

You can create style rules from the change schedules view when you want the style rules to be applied to the specific change schedule where it is defined.

**Before you begin**

Role required: sn_chg_soc.change_soc_admin, sn_change_role, sn_change_write, or admin

**Procedure**

1. Navigate to **Change > Schedule > Change Schedules**.

2. Click a tile to view the Change Schedule page.

3. Click the style icon ( 📅 ).

4. Do any one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create a new span style</strong></td>
<td>Click <strong>Add Span Style</strong></td>
</tr>
<tr>
<td><strong>Edit the name of an existing span style</strong></td>
<td>Click the name of the span style that you want to edit.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Edit all details of the span style</td>
<td>Click that appears to the right of the span style name and edit style rule name, span color, and filtering, as required.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Change success score**

Change success score uses team's historical data to provide an insight to the performance to make informed decisions.

**Note:** The Change success score feature is installed after you activate the Change Management - Change Success Score plugin that is available with the ITSM Professional subscription only. Please contact your account manager for more information.

Use the change success score to evaluate the team's success in handling prior change requests. The following are the key features offered by the change success score capability:

- The score is calculated daily based on the team's performance from yesterday.
- The score value enables you to determine how likely the team is to complete your change request without issues.
- The change success score indicator allows you to adjust the multipliers.
- The Change Success Score Dashboard helps you to compare individual team scores.
- The change score enables approvers to take decisions on the change request.
You can use the Change Success Score only after you activate the Change Management - Change Success Score (com.snc.change_management.change_success_score) plugin that automatically installs the Change Management - Change Success Score Foundation (com.snc.change_management.change_success_score.foundation) plugin.

When the Change Management - Change Success Score plugin is activated, a Change success score metrics (Daily) performance analytic (PA) job is added. The PA job is a daily job that collects the first set of change success scores until the next job run time, that is 02.00 UTC. After the first job run, a Change Success Score card icon appears next to the Assignment group field on the change request form. On click of this icon, you can view the score card details of the assignment group.
Change Success Score dashboard

Use this dashboard to see the trends in the resolution efficiency of the team over time based on the same parameters used to calculate overall score. To view the trends of all the assignment groups, clear the selected element.

For more information on the indicators, see Success score indicators.
Success score indicators

Change Success score contains Performance Analytics indicators for data collection. Indicators define a performance measurement taken at regular intervals of a business service, an activity, or organizational behavior. These performance measurements result in a series of indicator scores over time.

The following are the Change Success Score indicators that are used to collect data daily for the changes completed on the previous day.

Total Changes
The total number of change requests addressed during the time.

Successful changes
The number of successfully resolved change requests.

Unsuccessful changes
The number of change requests that was not resolved.

Successful changes with issues
The number of change requests that was resolved, but had other defects that were not addressed.

P1 incidents caused by change
The total number of P1 incidents that were reported as caused by one of the changes completed by the team.

P2 incidents caused by change
The total number of P2 incidents that were reported as caused by one of the changes completed by the team.

P3 incidents caused by change
The total number of P3 incidents that were reported as caused by one of the changes completed by the team.

For more information on the PA indicators, see Performance Analytics indicators

Success score calculation

To calculate the success score, formula indicators are provided. These indicators apply the multiplication operation to the data collected by the automated indicators to arrive at the final score.

You can view the Change success score formula indicators in Performance Analytics under the indicator group Change success score - multipliers.

Review the following table to understand the default multipliers used in success score calculation.
Default multipliers

<table>
<thead>
<tr>
<th>Automated indicator</th>
<th>Multiplier applied by formula indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Successful changes</td>
<td>3</td>
</tr>
<tr>
<td>Successful changes with issues</td>
<td>-2</td>
</tr>
<tr>
<td>Unsuccessful changes</td>
<td>-5</td>
</tr>
<tr>
<td>P1 incident caused by change</td>
<td>-10</td>
</tr>
<tr>
<td>P2 incident caused by change</td>
<td>-5</td>
</tr>
<tr>
<td>P3 incident caused by change</td>
<td>-2</td>
</tr>
</tbody>
</table>

Modify score calculation

Modify the multiplier values in the formula indicators to calculate the final success score.

Before you begin

Role required: admin

Procedure

1. Navigate to Performance Analytics > Indicator Groups > Change success score - multipliers.
2. Open the indicator that you want to modify.
3. In the formula, change the multiplier value.
4. Click **Update**.

**Success score rating**

Based on the change success score rating, a color and text is associated that is displayed as part of the Change Success Score card. By default, four success score ratings are available with a specific score range.

**Before you begin**

Role required: admin

The following default ratings available.

- Low
- Medium
- High
- Excellent

Each rating is associated with a default range and color.

The Change Success Score Ratings table is used to hold the records of the text and a color associated with the success score range.
You can choose to modify the score range, color, introduce, or modify new rating values. The values defined here can be viewed in the **Change Success Score card** on the change Request form.

![Change Success Score Card](image)

**Procedure**

1. Navigate to **Change > Administration > Change Success Score Ratings**.
2. Perform the given action based on your requirements.

<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add a new score range</td>
<td>Click <strong>New</strong> and fill in the range details and the color you want to associate and submit.</td>
</tr>
<tr>
<td>To modify the existing range</td>
<td>Open the rating, and click the <strong>here</strong> link in the record information message to modify the values.</td>
</tr>
</tbody>
</table>

3. Click **Update**.

**Predictive Intelligence for Change Management**

The Predictive Intelligence for Change Management capability uses machine-learning algorithms to suggest standard templates, identify similar incidents, and enhance risk assessment for the change.

Predictive Intelligence for Change Management delivers the following benefits:
• Enhanced change risk calculation using machine-learning algorithms to assess change risk.
• Uses Predictive Intelligence clustering capability to identify and suggest Standard Change templates to create a change.

Solution definitions for Predictive Intelligence for Change Management
The Solutions definitions for Predictive Intelligence for Change Management capability are available after you activate the following plugins:

• Change Management - Risk Intelligence plugin (com.snc.change_management.ml.risk)
• Change Management - Standard Change Template Intelligence plugin (com.snc.change_management.ml.sctp)

Note: Predictive intelligent for Change Management plugins can be requested through the Now Support Customer Service system.

For more information, see Change Management plugins.

Solution definitions for Change Management

<table>
<thead>
<tr>
<th>Solution definition</th>
<th>Solution type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk for proposed change</td>
<td>Similarity and Categorization</td>
<td>Provides insight into the potential risk of the change activity and facilitates intelligent approval decisions. The info message puts all the risk related information to easily compare the returned value. This prediction helps in reducing approval friction and time. For example, when risk = low, you can use Change Approval Policies to automatically approve this low risk activity.</td>
</tr>
</tbody>
</table>
Solution definitions for Change Management (continued)

<table>
<thead>
<tr>
<th>Solution definition</th>
<th>Solution type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard change candidates</td>
<td>Clustering</td>
<td>Analyzes and suggests opportunities for Standard Change proposal templates that can be used for automatically creating a change. This solution uses similarity and clustering solution type to identify the common fields in the records and make it a template.</td>
</tr>
</tbody>
</table>

Intelligent solutions configurations

Administrators can configure the Change Management Intelligent solutions properties to use predictive intelligence (PI) capabilities.

By configuring these properties, you enable the Change Management application to:

- Predict the risk of the proposed change.
- Use similarity and clustering to identify and suggest potential standard change templates.

Navigate to Change > Intelligent Solution Configuration to view and edit the properties.

Risk Intelligence Properties

<table>
<thead>
<tr>
<th>Risk Intelligence properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solution type [chg_ml_prop_risk.model_type]</td>
<td>The type of PI solutions used for risk prediction.</td>
</tr>
<tr>
<td></td>
<td>• Similarity: Uses machine-learning solution to collect and compare your existing records to new similar records. This solution type uses the following risk calculation method:</td>
</tr>
</tbody>
</table>
### Risk Intelligence properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>◦ Use count of records: Risk of the group that has highest count is used.</td>
</tr>
<tr>
<td></td>
<td>◦ Use confidence of records: Risk of the group that has highest total number of confidence is used. If the risk have same count or confidence, then the higher risk is considered.</td>
</tr>
<tr>
<td></td>
<td>• Classification: Uses machine-learning algorithms to set field values during record creation, such as setting the risk category based on previous data.</td>
</tr>
<tr>
<td>Predicted value usage [chg_ml_prop_risk.usage]</td>
<td>Determines how the predictive value must be used.</td>
</tr>
<tr>
<td></td>
<td>• View risk value</td>
</tr>
<tr>
<td></td>
<td>• Set risk value</td>
</tr>
<tr>
<td>Solution enabled [chg_ml_prop_risk.solution_enabled]</td>
<td>Identifies if the solution is enabled or not.</td>
</tr>
<tr>
<td>Threshold [chg_ml_prop_risk.classification_confidence_threshold]</td>
<td>The minimum confidence value for the risk threshold.</td>
</tr>
</tbody>
</table>

### Standard Change Proposal Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>

### Train the Risk Intelligence solution

Create Risk categorization or similarity solution definitions to use the predictive intelligence that helps in accessing change risk.
Before you begin
Ensure that Change Management - Risk Assessment (com.snc.change_management.ml.risk) plugin is activated.
Role required: admin

Procedure
1. Navigate to Change > Intelligent Solution Configuration > Risk Intelligence.
2. Select the Solution type.
   • If the Solution type is similarity, then you can see the default, Change Risk Similarity Definition solution.
   • If the Solution type is Classification, you can see the default, Change Risk solution.
3. Customize the given default solution. For more information, see Create and train a similarity solution and Create and train a classification solution.
4. Click Update.

Train the clustering solution for Standard change proposal
Train the Standard change proposal solution definition to use clustering capabilities to identify and suggest Standard Change templates to create a change.

Before you begin
Ensure that Change Management - Standard Change Template Intelligence (com.snc.change_management.ml.sctp) plugin is activated.
Role required: admin

Procedure
2. Customize the default solution definition to train the solution. By default, the Std Change Template Candidates is the solution definition provided. For more information on creating and training the solutions, see Create and train a clustering solution.
3. Click Update.
Analyze change request risk and impact

After you create a change request, you can assess and analyze the risk and impact involved in the change request. You can review any conflicts that are detected by reviewing the change request.

Analyze the risk of change and review detected conflicts in the following ways.

Risk conditions and calculation

Change Management features provide ways to calculate and assess the risk of change requests, and to identify and resolve conflicts.

Risk assessment and calculation assists you with understanding the urgency and impact of change requests. Conflict detection assists you with scheduling change requests for the least impact to stakeholders. This feature minimizes the risk and cost of rapid changes in your environment.

Risk Calculator property

The Best Practice - Change Risk Calculator plugin enables dynamic calculations of the risk and impact of a change. The administrator specifies how and when risk and impact rules are applied.

The Best Practice - Change Risk Calculator plugin bundles some risk calculations using configuration item (CI) attributes and time measures.

A change management system property determines the risk calculation method. In Change > Administration > Change Properties, the administrator selects one of the following methods.

<table>
<thead>
<tr>
<th>Change Risk calculation method</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>UI Action</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Change Risk calculation method (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• There are risk and impact conditions that apply to the current change record.</td>
</tr>
<tr>
<td></td>
<td>• The user has the admin or the itil role.</td>
</tr>
<tr>
<td>Business Rule</td>
<td>Enables conditions to be evaluated and applied dynamically through a business rule on the Change Request table.</td>
</tr>
<tr>
<td></td>
<td>The conditions are evaluated before a change request record is inserted or updated.</td>
</tr>
<tr>
<td></td>
<td>Users with the admin or the itil role or both can execute this business rule.</td>
</tr>
<tr>
<td>Note:</td>
<td>The Run Risk Calculation business rule replaces the Calculate Risk business rule when the Change Management - Risk Assessment plugin is activated.</td>
</tr>
<tr>
<td>None</td>
<td>Disables the processing of risk and impact rules.</td>
</tr>
</tbody>
</table>

Add or modify risk and impact conditions

You can define risk calculation rules on which the risk and impact of a change are calculated. Best Practice - Change Risk Calculator is activated by default in the base system.

Before you begin
Role required: itil_admin or admin

About this task
Risk Conditions are run against the change request based on their Order field from lowest to highest. The first Risk Condition that matches the change request record is applied. All subsequent risk conditions are then ignored whether they match or not. A risk calculation rule is defined with two elements.

- Conditions that can evaluate to true or false. You can use a condition builder or write a script.
- Risk and Impact field value settings when the conditions evaluate to true.

Procedure
1. Navigate to Change > Administration > Risk Conditions.
2. Click New, or click the risk condition to modify.
You can also edit risk conditions from within the Change Request form by opening the form context menu and clicking **Edit Risk Conditions**.

3. Complete or update the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a descriptive name for the rule</td>
</tr>
<tr>
<td>Risk Impact</td>
<td>Select a value for one of these fields. The selection determines which field to update based on this risk calculation.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to use the rule.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter the order in which this risk calculation is evaluated. Rules with lower numbers are evaluated first. If there are two or more rules with differing orders, the rule with the lowest order is evaluated and the others are ignored.</td>
</tr>
<tr>
<td>Use advanced condition</td>
<td>Select the check box to enter a script instead of using the condition builder.</td>
</tr>
<tr>
<td>Use script values</td>
<td>Select the check box to hide the <strong>Risk</strong> and <strong>Impact</strong> fields. The script specifies the risk and impact values.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of how this risk calculation is applied.</td>
</tr>
</tbody>
</table>

4. Specify the rule based on your selected rule method.

<table>
<thead>
<tr>
<th>Choice</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Use the condition builder to add conditions. It is hidden if you selected <strong>Use advanced condition</strong>.</td>
</tr>
<tr>
<td>Use advanced conditions</td>
<td>Write the script in the <strong>Advanced condition</strong> field using standard business rule syntax. The condition must set the global variable answer to <strong>true</strong> or <strong>false</strong>.</td>
</tr>
<tr>
<td>Use script values</td>
<td>Write the script in the <strong>Script values</strong> field. Specify the <strong>Risk</strong> and <strong>Impact</strong> values in the script.</td>
</tr>
</tbody>
</table>
The conditions are set using either the condition builder or an advanced condition script.

**Example**

In the following example, the *Advanced condition* script first determines whether the CI is a business service. If so, the script identifies whether the *Business criticality* value is **1 - most critical** or **2 - somewhat critical**. If it does, it sets the global variable *answer* to `true`.

When the *Advanced condition* script returns `true`, the script in the *Script values* field sets the change request *Impact* and *Risk* values based on the *Business criticality* value.
Risk assessment

There are two methods to calculate the risk of a change. The Best Practice - Change Risk Calculator is activated in the base system by default. Change Management - Risk Assessment is optional.

- Change Risk Calculator uses predefined properties and conditions to calculate a risk value.
- Change Management - Risk Assessment uses information provided by the end user to assess a risk value.

The two methods can be used individually or together, depending on your requirements. If the methods are used together, the highest risk value from both methods is always selected.

Note: If both Risk Assessment and Risk Calculator are active but you want to use only one method, remove conditions for the method you do not want to use.

If you activate Change Management - Risk Assessment, the administrator can add the Task Assessment > Task related list to the change request form, if necessary. The related list displays risk assessments associated with the change request.

Related information
- Perform risk assessment
- Define risk assessments

Define risk assessments

Change Management - Risk Assessment provides a flexible way to capture information from the end user to calculate the risk of the associated change request. You can define the risk assessment questions, thresholds, and conditions that calculate risk for any change request.
Before you begin
Change Management - Risk Assessment must be activated.
Role required: itil_admin

About this task
You can use a series of questions to capture the risk of a change. A different assessment of the questionnaire can be defined on the change record. The assessment uses a weighted score approach for each question. The composite weighted score derived from the answer of the end user is used to calculate risk. This score is based on the thresholds associated with the risk assessment.
Change Risk Assessment is an application built on Survey and Assessment V2 architecture. While it’s possible to configure multiple metric categories on this architecture, it is better not to do so to avoid errors.
You can configure multiple change Risk Assessment definitions each with one Metric Category, where the Metric Category filter is identical to the filter of the change Risk Assessment condition.

Procedure
1. Navigate to Change > Administration > Risk Assessments.
2. Click New.
3. Complete the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the risk assessment. This name is displayed to the end user.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the assessment: Draft or Published.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the risk assessment.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions which determines if a risk assessment is attached to the change. Typically, the first attachment that matches the conditions gets attached during evaluation. Therefore, ensure that the conditions result in the correct assessments being attached especially when defining multiple questionnaires.</td>
</tr>
</tbody>
</table>
4. Click the form context menu and select **Save**. The page refreshes with the **Assessment Categories** and **Assessment Thresholds** related lists. The **Assessment Categories** related list enables you to define the questions that the end user answers to assess the risk of a change request.

5. Complete the following steps to create an assessment question.

   **a.** In the **Assessment Categories** related list, click **New**.

   **b.** Complete the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the assessment category.</td>
</tr>
<tr>
<td>Create Stakeholders</td>
<td>If selected, automatically creates stakeholders for all assessable records linked to this category.</td>
</tr>
<tr>
<td>Weight</td>
<td>Value that represents importance of this category relative to other categories. The weight is multiplied to the score of the answer to calculate the weighted score.</td>
</tr>
<tr>
<td>Filter</td>
<td>Only assessable records that meet filter conditions are evaluated by metrics in this category.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the assessment category.</td>
</tr>
</tbody>
</table>

   **c.** Click **Submit**.

   **d.** Open the assessment category.

   **e.** In the related list, click **Assessment Metrics**.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
f. Complete the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the assessment metric.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the assessment metric.</td>
</tr>
<tr>
<td>Method</td>
<td>The method of gathering data for this metric.</td>
</tr>
<tr>
<td>Weight</td>
<td>Value that represents importance of this metric relative to other metrics.</td>
</tr>
<tr>
<td></td>
<td>The weight is multiplied to the score of the answer to calculate the weighted score.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of the question in the assessment.</td>
</tr>
<tr>
<td>Active</td>
<td>If selected, the metric is activated to be used for assessments and result calculations.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>If selected, makes a field mandatory in an assessment.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Question</td>
<td>Question that is displayed on the assessment.</td>
</tr>
<tr>
<td>Description</td>
<td>Tool tip text for the assessment.</td>
</tr>
<tr>
<td>Depends on</td>
<td>The condition that determines whether the metric is shown to the user or not.</td>
</tr>
<tr>
<td>Allow Additional Information</td>
<td>If selected, a text box appears for the user to enter additional information for the question.</td>
</tr>
<tr>
<td>Field Type</td>
<td></td>
</tr>
<tr>
<td>Data type</td>
<td>The data type of the answer that is given by a user for a question.</td>
</tr>
</tbody>
</table>

**Note:** Depending on the data type that you select, additional fields may appear.

g. Click Submit.

h. In the **Assessment Threshold** related list, click New.
i. Complete the form, as appropriate.

### Change risk assessment threshold

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk Assessment</td>
<td>The assessment name for which assessment threshold is applied.</td>
</tr>
<tr>
<td>Risk</td>
<td>Risk value applied on the change request.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Risk value can be overridden by risk conditions.</td>
</tr>
<tr>
<td>Application</td>
<td>The name of the application that contains the record.</td>
</tr>
<tr>
<td>Score greater than</td>
<td>The threshold against which the composite score is compared and evaluated.</td>
</tr>
</tbody>
</table>

j. Click **Submit**.

**Note:** You can create or edit the assessment questionnaire through the Assessment Designer module or by clicking **Edit in Assessment Designer** related link.

For example, after you define the risk assessment, this is how the risk assessment score is calculated and set.

- **asmt_metric_result** stores the score set.

- The weight is calculated as $\text{sum (asmt_metric_result.normalized_value)}$ where $\text{asmt_metric_result.normalized_value = actual_value * weight}$.

- The risk calculated as $\text{sum(actual_value * weight)} > \text{threshold}$. For example, if the result is 7 and moderate threshold is 6 risk is moderate.

### Perform risk assessment

You can perform risk assessment of existing change requests after the risk assessment criteria are defined. After assessing the risk, you can view the risk assessment responses in the change request.

### Before you begin

Role required: itil, sn_change_write, or admin
About this task
Verify that the Risk Assessment related list is configured on the Change Request form. If it is not configured, an administrator can add the Task Assessment > Task related list.
The Risk Assessment related link is available only when the change request meets the risk assessment condition and risk assessment category condition, the change request type is Normal or Emergency, and the State is New, Assess, or Authorized. On clicking the Risk Assessment related link, the Change Risk Assessment form appears if you have not assessed the risk for this change request before. When you submit the form, these three things appear at the top of the change request form:

- **Risk assessment evaluated**: The estimation of risk after it is assessed against the Change Risk Assessment form and the criteria set for assessment for the change request.
- **Risk Condition applied**: The result of the risk calculated against pre-defined risk conditions.
- **Risk set to**: The final weight of risk based on risk assessment and risk calculation.

**Note**: If you have filled the Change Risk Assessment form earlier but clicked Risk Assessment related list again, a pop-up window appears informing that you have already completed the risk assessment for the change request and confirms whether you want to edit the existing risk assessment. Click Yes to fill the Change Risk Assessment form again. Click No to use the existing risk assessment to calculate risk.

Procedure
1. Open a change request.
2. Click the Risk Assessment related link.
   The Change Risk Assessment form appears.
3. Answer the questions and click Submit.
   After submitting the risk assessment, click the Risk Calculation related link to calculate the risk. The result of risk assessment, risk calculation, and the value that appears in the Risk field of the change request form appears.
Users with survey_admin or survey_reader role can navigate to Legacy Surveys > Survey Responses and filter by Instance. Survey instances are individual assessments distinguished by the date and time when they are taken.

Related information
Risk assessment

Legacy change risk assessment migration
Users can migrate legacy change risk assessments to versions compatible with the new Change Risk Assessment table schema and logic.

Before you begin
Role required: itil_admin
Few points to remember:

• Customers with Change Management - Risk Assessment [Legacy] (com.snc.change.risk_assessment) plugin already installed on their instances should only follow this task.

• The Change Management - Risk Assessment [Legacy] (com.snc.change.risk_assessment) plugin cannot be installed for customers who are on Kingston and later releases.

• Migration guidance and best practice suggests that the migration should be performed on a development instance and not on a production instance.

• The development instance must have the new Change Management - Risk Assessment [com.snc.change_management.risk_assessment] plugin installed.

• All migration work must be captured in an update set, moved to a test instance, and then tested before moving them to a production instance.

About this task
The following legacy risk assessment components are migrated:

• Risk assessment definition, questions, and question choices.

• For multiple assessment conditions, the migration might result in the following one or more than one risk assessment records:
If all the multiple assessment conditions are on the same table, then the migration results in only one risk assessment.

If the multiple assessment conditions are on different tables, then the migration creates as many risk assessments as they pertain to different tables.

Procedure

1. Create an update set and set it as the current set. For more information, see . Create and select an update set as the current set.

2. Navigate to Change > Risk Assessment (legacy).

3. Open the legacy risk assessment that you want to migrate to a change risk assessment.

4. Click the Migrate to Risk Assessment related link.
   A message window appears stating that the assessment is migrated to a new change risk assessment.

   [Note: Migrating legacy risk assessment to a new change risk assessment does not modify the existing legacy assessment records.]

5. Click OK.

6. Repeat steps 4-5 for all the legacy risk assessment to be migrated.

What to do next

After all the legacy risk assessments are migrated, reach out to the support team to run the following scripts:

```bash
disable_legacy_change_risk_assessment.js
```

Capture the results in the update set created and later mark the update set as closed complete. For more information, see . Mark an update set complete.

[Note: The given procedure is a suggested practice. Alternatively, you can capture each migrated Change Risk Assessment in their own update set. You can also capture the results of disabling of the Change Management - Risk Assessment [Legacy] using disable_legacy_change_risk_assessment.js in a separate update set.]

Migrated risk assessment components

When you migrate a change risk assessment, the system maps records from legacy risk assessment to the new risk assessment tables.
To create a functional risk assessment on the assessment framework, the system converts risk assessment records to the most logical equivalent assessment risk records. This may mean multiple assessment risk records are created from one legacy risk record.

**Migrated components**

<table>
<thead>
<tr>
<th>Risk assessment components</th>
<th>Change risk assessment components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment Main [assessment_main]</td>
<td>Change Risk Assessment [change_risk_asmt]</td>
</tr>
<tr>
<td>Assessment Question [assessment_question]</td>
<td>Assessment category [asmt_metric_category]</td>
</tr>
<tr>
<td></td>
<td>Assessment Metric [asmt_metric]</td>
</tr>
<tr>
<td>Assessment Question Choice [assessment_question_choice]</td>
<td>Assessment metric definition [asmt_metric_definition]</td>
</tr>
<tr>
<td>Risk Assessment Thresholds [risk_assessment_threshold]</td>
<td>Assessment Thresholds [change_risk_asmt_threshold]</td>
</tr>
<tr>
<td>Assessment Conditions [assessment_conditions]</td>
<td>This is included in Change Management - Risk Assessment [com.snc.change.risk_assessment].</td>
</tr>
</tbody>
</table>

**Conflict detection**

Conflict detection identifies potential scheduling conflicts for a change request based on the configuration items (CIs), planned start date, and the planned end date in scope for the change. If a scheduling conflict exists, conflict detection also checks any related blackout or maintenance schedules and other active change requests to determine the scheduling conflict.

Conflict detection identifies conflicts for any of the following reasons:

- The CIs are already scheduled at the given date and time.
- A parent of the CI is already scheduled at the given date and time.
- A child of the CI is already scheduled at the given date and time.
- The CI is not in the maintenance window.
- A parent of the CI is not in the maintenance window.
- A child of the CI is not in the maintenance window.
- The CI is in a blackout window.
- A parent of the CI is in a blackout window.
• A child of the CI is in a blackout window.
• The assigned to person is already scheduled at the given date and time.

If conflicts are identified, the **Conflict status** field is updated to reflect a conflict and an error message directs you to the Conflict form section of the Change request record to review conflicts. When you create a change request and provide a CI, planned start date, and planned end date, or update any of these values, conflict detection is executed automatically.

You can choose to show or hide the conflict error message by using the **Enable/Disable Scheduling Conflict Message** menu item from the context menu. As an admin, you can configure the message display setting using the `change.conflict.show_conflict_message` property. For more information on the property, see **Conflict analysis properties**.

You can manually execute conflict detection. For more information, see **Detect conflicts manually and review conflict details**.

The Conflicts form section lists specific conflict details including the type of conflict, conflicting schedule, or conflicting change request. If a conflict must be resolved before requesting approval, modify the **Planned start date** and **Planned end date** fields in the Schedule form section.

### Conflict Calendar

You can also use the **Conflict Calendar** to visually display any scheduling conflicts identified. To reschedule the change request, click the change request record or drag the change request to another time within the calender.

### Configure conflict analysis properties

Configure Change Management conflict analysis properties to detect change conflicts. Use the relevant information to calculate conflicts for change requests and review and modify the change to eliminate conflicts.

**Before you begin**

Role required: admin

**About this task**

By default, not all properties are selected in the Change Management Conflict Analysis Properties page. Modify or customize conflict detection capabilities to meet the needs of your organization.
Procedure

1. Navigate to Change > Administration > Conflict Properties.
2. In the Change Management Conflict Analysis Properties page, enter the roles that have access to the conflict detection feature.
3. Configure the remaining customization properties as required.
4. Click Save.

Related reference

Conflict analysis properties

Conflict detection includes properties that determine how the conflict detection capability is executed. Identify conflicts based on the selected properties and the roles that have access to the feature.

These properties are available by navigating to Change > Administration > Conflict Properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A comma separated list of roles which have access to the conflict detection feature. Roles included here should have access to the underlying change_request record</td>
<td>change.conflict.role</td>
<td>The roles are entered exactly as they appear in User Administration &gt; Roles. For example, enter itil.</td>
</tr>
<tr>
<td>When checking for change request conflicts, check against blackout windows</td>
<td>change.conflict.blackout</td>
<td>To check if the change request falls within the blackout window, select Yes.</td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change</td>
<td>change.conflict.relatedchildblackout</td>
<td>To check if the change request of any of the child configuration items (CIs) falls within</td>
</tr>
</tbody>
</table>
## Change Management conflict analysis properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>falls within the child CIs' blackout window</td>
<td></td>
<td>the blackout window, select <strong>Yes</strong>.</td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls within the parent CIs' blackout window</td>
<td><strong>change.conflict.relatedparentblackout</strong></td>
<td>To check if the change request of the parent CI falls within the blackout window, select <strong>Yes</strong>.</td>
</tr>
<tr>
<td>When checking change request conflicts, check against changes already schedules for the same CI</td>
<td><strong>change.conflict.currentci</strong></td>
<td>To check if the change request is already scheduled against the given CI, select <strong>Yes</strong>.</td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls within the CIs' maintenance window</td>
<td><strong>change.conflict.currentwindow</strong></td>
<td>To check if the change request of the CI falls within the maintenance window, select <strong>Yes</strong>.</td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls within child CIs' maintenance window</td>
<td><strong>change.conflict.relatedchildwindow</strong></td>
<td>To check if the change request of any of the child CIs falls within the maintenance window, select <strong>Yes</strong>.</td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls within parent CIs' maintenance window</td>
<td><strong>change.conflict.relatedparentwindow</strong></td>
<td>To check if the change request of the parent CI falls within the maintenance window, select <strong>Yes</strong>.</td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls within the scheduled maintenance defined for the CI in the</td>
<td><strong>change.conflict.ci_maint_sched</strong></td>
<td>To check if the change request falls within the scheduled maintenance defined for the CI in the</td>
</tr>
</tbody>
</table>
## Change Management conflict analysis properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>schedule defined in the maintenance schedule reference field on the CI</td>
<td>maintenance schedule reference field, select Yes.</td>
<td></td>
</tr>
<tr>
<td>When checking change request conflicts, check whether the change falls within maintenance or blackout windows affecting related Application Services</td>
<td>change.conflict.relatedservices</td>
<td>To check if the change request that falls within the maintenance or blackout windows affects other related application services, such as the services created that include the CI scheduled for change or any other CI within that service, select Yes.</td>
</tr>
<tr>
<td>When checking change request conflicts, check whether other change</td>
<td>change.conflict.assigned_to</td>
<td>To check if any other change request is assigned to the same change request</td>
</tr>
</tbody>
</table>

Note: This action requires any business services identified to be converted to an application service. For more information, see Convert a business service to an application service. For information about application services, see Application services.
## Change Management conflict analysis properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>requests are already scheduled for the same assigned to user</td>
<td></td>
<td>For example, if you assign a change request to a user who is already scheduled to implement another change request at that date and time, a conflict error is displayed, select Yes.</td>
</tr>
</tbody>
</table>
| CI conflict check mode. Basic mode only checks the change requests CI. Advanced mode checks the entire Affected CIs related list (the change's CI will be automatically added to the related list) | change.conflict.mode | To check the conflict mode for a CI, select the appropriate CI conflict mode.  
- **Basic**: When selected, checks only change requests of the CI against the change request for the CI and all affected CIs.  
- **Advanced**: When enabled, checks both the CI for the current change request and affected CIs against other change requests for the CI and affected CIs.  |
<p>| Run conflict detection automatically after changes to Configuration item, Planned start date, Planned end date or | change.conflict.refresh.conflicts | refresh and run conflict detection automatically when any of the following field values are changed, select Yes.  |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
</table>
| State when a change request is updated | | • Configuration item  
• Planned start date  
• Planned end date  |
| Enable the scheduled change conflict checker | change.conflict.refresh.scheduled | To enable the schedule change conflict checker, select Yes. |
| Automatically include business or application services related to CIs with conflicts in the Impacted CI related list | change.conflict.populateimpactedcis | To automatically include and list all the business and application services with related CIs that have conflicts, select Yes. |
| Identify the most critical business or application service affected when a conflict is detected against a supporting configuration item | change.conflict.identifymostcritical | To identify the most affected business or application services that have a related conflicting CI, select Yes. |
| Define the number of days to be factored after the respective Planned start/end date of a Change record when searching for the next available time. This window is used to find all potentially conflicting Changes, the larger the window, the more Changes that need to be factored per search. Default value is 90 days; the value | change.conflict.next_available.schedule_window | To factor from the scheduled planned start date or end date of the change request to find the next available time, enter the number of days.  
• Type: Integer  
• The default value is 90 |
<table>
<thead>
<tr>
<th>Property</th>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
</table>
| must be a positive integer. | change.conflict.next_available.choice_limit | Enter the number of suggestions to calculate and display for the next available time.  
- Type: Integer  
- The default value is 25 |
| Define the number of suggestions to be calculated for the next available time field on a Change. The greater the value, the more time taken to calculate the next available times to implement the change. Default value is 25 suggestions; the value must be a positive integer. | change.conflict.log | Select any of the logging levels for the change conflict.  
- Emergency  
- Alert  
- Critical  
- Error  
- Warning  
- Notice  
- Info  
- Debug  
The default level is Notice. |
| Logging level for ChangeCheckConflict (default: Notice) | change.conflict.allow_contiguous_changes | This property is enabled by default. |
| Handle contiguous change request that has overlapping schedules that results in conflicts. | | |
Change Management conflict analysis properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Show message when scheduling conflict is detected. | change.conflict.show_conflict_message | Shows a message when scheduling conflict is detected. Choose any of the given options to configure the display of the conflict message.  
- **User Preference**: Displays a UI menu option where the user can toggle to show or hide the conflict message.  
- **Always**: Always displays the conflict message.  
- **Never**: The conflict message is not displayed unless the property is changed to either User Preference or Always.  
By default, User Preference is selected. |
| Consolidate conflicts so a conflict is only registered for each unique combination of conflict type and schedule or conflicting-change. | change.conflict.consolidated_conflicts | Displays only the conflicts that results from a unique combination of the conflict type and schedule or conflict type and conflicting-change.  
By default, the property is enabled. |
Create blackout and maintenance schedules in Change Management

Use the Blackout and Maintenance windows to schedule a change. Blackout windows specify times during which normal change activity should not be scheduled. Maintenance windows specify times during which change requests should be scheduled. For example, create a blackout schedule for code freezes at the end of the year.

Before you begin
Ensure that the Change Management - Collision Detector (com.snc.change.collision) plugin is activated.

Role required: itil_admin or admin

About this task
Conflict detection uses blackout and maintenance schedules to find potential scheduling conflicts for the configuration items (CIs) associated with a change request. When conflict detection runs, either automatically or by manual request, conflict detection determines if either type of defined schedule applies to the change request. If a potential conflict is identified, a warning message appears and conflicts are listed within the Conflict form section. View conflicts in the Conflict calendar.

? Note: To use the business service as the source for a blackout or maintenance schedule, the business service must be converted to an application service. For instructions, see Convert business services to application services. For information about application services, see Application services.

Procedure
1. Create a blackout or maintenance schedule.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create a blackout schedule | a. Navigate to Change > Schedules > Blackout Schedules.  
b. Click New. |
| Create a maintenance schedule | a. Navigate to Change > Schedules > Maintenance Schedules.  
b. Click New. |

2. On the form, fill in the fields.
# Blackout and Maintenance schedule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the schedule.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description about the schedule.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Time zone for the schedule.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Floating</strong> to evaluate planned start and end dates on the Change</td>
</tr>
<tr>
<td></td>
<td>Request form for the logged-in user.</td>
</tr>
<tr>
<td>Source</td>
<td>Source of the blackout or maintenance schedule. The available options are</td>
</tr>
<tr>
<td></td>
<td><strong>Service</strong>, <strong>Change Request</strong>, and <strong>CI Class</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When you select <strong>Service</strong> or <strong>Change Request</strong> from the Source</td>
</tr>
<tr>
<td></td>
<td>list, the <strong>Applies to</strong> field does not appear.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Applies to</strong> field appears if you select <strong>CI Class</strong> as the Source,</td>
</tr>
<tr>
<td></td>
<td>which in turn enables the selection of a <strong>CI Class</strong>.</td>
</tr>
<tr>
<td>Applies to</td>
<td>CI classification that the conflict detection is filtered on.</td>
</tr>
<tr>
<td></td>
<td>You can select a dynamic CI group so that all the configuration items in</td>
</tr>
<tr>
<td></td>
<td>that dynamic CI group will be taken into account for blackout and maintenance</td>
</tr>
<tr>
<td></td>
<td>when conflict detection is run.</td>
</tr>
<tr>
<td></td>
<td>The dynamic CI group is seen as the parent CI to all the CIs that are</td>
</tr>
<tr>
<td></td>
<td>within that group. If there are scheduling conflicts related to any of the</td>
</tr>
<tr>
<td></td>
<td>CIs in the dynamic group, the conflict will be shown in the conflicts table</td>
</tr>
<tr>
<td></td>
<td>of the dynamic CI group.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions to specify the CIs that the schedule applies to.</td>
</tr>
<tr>
<td></td>
<td>This field does not appear when the <strong>Applies to</strong> field is set to <strong>None</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Related fields used in conditions are not evaluated for blackout</td>
</tr>
<tr>
<td></td>
<td>or maintenance schedules.</td>
</tr>
</tbody>
</table>

3. Open the form context menu and click **Save**.
   A blackout or maintenance schedule is created and the Schedule Entries,
   Child Schedules, and Referenced By related lists appear in the change.
Note:
The Blackout Schedule [cmn_schedule_blackout] table extends the Condition Schedule [cmn_schedule_condition] table, which in turn extends the Schedule [cmn_schedule] table. The Blackout Schedule table inherits the domain properties from the Schedule table which has the Domain and Domain path columns.

Because the Blackout schedule table uses the same Child Schedule and Schedule Entry tables as the Schedule table uses, the domain support is identical. The domain_master attribute is used to derive the domain from a parent record. For more information, see Domain support for schedules.

4. Create one or more schedule entries by completing the following steps:

   a. In the Schedule Entries related list of the new maintenance schedule, click New.

   b. Enter a unique name and define the time during which you want to schedule the maintenance.
      For more information about the schedule entries field, see Schedule entry fields.

Results
A blackout or maintenance schedule is created.

What to do next
Associate the configuration item with the maintenance schedule that is used in the change request.

Related information
- Define a schedule
- Schedule entry fields
- Parent and child schedules

Assign a maintenance schedule to configuration items
You can review and determine the conflicts in a change schedule by assigning the maintenance schedules to configuration items (CI). After you assign a maintenance schedules to the CI, add the CI to the change request.

Before you begin
Role required: itil
About this task
When the configuration item with an assigned maintenance schedule is used in the change request, the conflict detection determines the schedule change outside the maintenance window and displays a conflict error message.

Procedure
1. Navigate to Configuration > Application Servers.
2. From the list of servers, select the server that you want to add the maintenance schedule to.
   - Note: If you don’t see the Maintenance schedule field on the record, click the personalize list icon (蜇) and modify the Personalize List settings to add this field.
3. Double-click the Maintenance schedule field and use the search icon to select a schedule and assign it to the server.

Results
The selected maintenance schedule is assigned to the server.

Configure a change request to monitor outside maintenance schedule conflicts
When a change request is configured to display the conflicts that are outside the maintenance schedule, conflict detection indicates whether the planned start and end dates occur outside the maintenance window or not. By reviewing the conflicts that are detected, you can modify the change schedule.

Before you begin
Role required: personalize_ui or admin

About this task
The Outside maintenance schedule check box is informational and the instance sets this value and disregards any changes that you make to this check box. The check box is selected by default if either of the following actions occur.

- The planned start and end dates in the change request with an associated configuration item (CI) are compared to the maintenance schedule and are determined to be outside the schedule.
- Affected CIs associated with the change request are checked against their assigned maintenance schedules, if any.
Note: Only the maintenance window for the primary CI or affected CIs is checked; the upstream and downstream items are not checked.

Procedure

1. Navigate to **Change > Open** and select an existing change request.
2. If the **Outside maintenance schedule** field does not appear, add the field to the form.
   a. Click the context menu icon and then click **Additional actions > Configure > Form Layout**.
   b. Move **Outside maintenance schedule** to the Selected list.
   c. Click **Save**.

Results

When you save a change request that is outside the maintenance schedule, a warning appears for each item (primary or affected). This warning also displays the planned dates that fall outside the maintenance window.

Conflict calendar

The conflict calendar graphically represents the potential scheduling conflicts for a change request. Conflicts are identified as active change requests, blackout schedules, and changes scheduled outside maintenance schedules. Use the **Scheduling Assistant** to resolve any schedule conflicts.

<table>
<thead>
<tr>
<th>SI #</th>
<th>UI Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>View Form</td>
<td>Returns you to the Change Request form.</td>
</tr>
<tr>
<td>SI #</td>
<td>UI Component</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2</td>
<td>Calendar</td>
<td>Enables you to choose a date. When you select a date, you can view the schedule details of that day.</td>
</tr>
<tr>
<td>3</td>
<td>Current day or month</td>
<td>Enables you to view the schedule of the current day or month when you click <strong>Today</strong>.</td>
</tr>
<tr>
<td>4</td>
<td>Navigating dates</td>
<td>Enables you to navigate to the previous day, the next day, or month, depending on the view type when you click the arrow buttons.</td>
</tr>
<tr>
<td>5</td>
<td>Scheduling Assistant</td>
<td>Enables you to choose from the list of available time slots to resolve conflicts. For more information on resolving conflicts, see <a href="#">Manage your change schedules and resolve conflicts</a>.</td>
</tr>
<tr>
<td>6</td>
<td>Day or Month view</td>
<td>Enables you to change the calendar view to a day view or month view.</td>
</tr>
<tr>
<td>7</td>
<td>Keyboard Shortcuts</td>
<td>Provides you with keyboard shortcuts for quick navigation.</td>
</tr>
<tr>
<td>8</td>
<td>Options</td>
<td>Enables you to control the view of the calendar, customize settings, or set the configuration filters using the <strong>Settings</strong> tab and the <strong>Configuration</strong> tab. From the configuration filters you can select and display the <strong>Assigned to</strong>, <strong>Assignment group</strong>, <strong>Configuration item</strong>, or <strong>Show all</strong> options in the Related Changes section. This section has the same value of the option selected for the current change.</td>
</tr>
<tr>
<td>9</td>
<td>Change request block</td>
<td>Enables you to view the details of the change request.</td>
</tr>
<tr>
<td>10</td>
<td>Related Changes</td>
<td>Helps you to detect other scheduled changes that potentially conflict with the change based on a schedule or assignment. For example, if the same person is assigned to two or more changes at the same date and time, you can visually see the conflict and update one of the scheduled changes, as appropriate.</td>
</tr>
</tbody>
</table>
Manage your change schedules and resolve conflicts

Prevent schedule conflicts by using the conflict calendar to manage your change schedule details, customize views, and resolve conflicts.

Before you begin
Role required: admin

Note: Users with the admin role must activate the Change Request Calendar (com.snc.change_request_calendar) plugin for the Conflict Calendar button to appear.

About this task
When there is a conflict, you can use Scheduling Assistant link in the change form to find the next available slot.

When there are no available slots for the next 90 days, then an actionable message is displayed with the reason why the assistant was not able to find a slot.
Alternatively, you can resolve conflicts by moving the change request to be within a maintenance window in the conflict calendar. The Conflict Calendar button appears in the header of the change form once the Planned start date, Planned end date, and the Configuration items fields are added and the record is saved.

Procedure
1. Navigate to Change > Open.
2. Open your required change request.
3. Click Conflict Calendar.
4. Click Scheduling Assistant.
   The scheduling assistant dialog box displays the next available times to choose to resolve the conflict. The number of days factored after the planned start and end dates and the number of suggestions calculated for the next available time are configured under Conflict properties. For more information, see Configure conflict analysis properties form.
5. Select the time from the available time slots.
6. Click Select Available Time.
   The planned start date and end date are updated with the new time, and the conflict is resolved.
7. To select another day from the calendar, click the calendar icon ( ) and select the date.

Results
The conflicts are reviewed and resolved.
Enable automatic change conflict detection

Automate conflict detection to run at specific intervals or when a change request is updated to immediately review the conflicts when the schedule dates are updated.

Before you begin
Prior to running conflict detection, consider the following scenarios unique to your organization.

CMDB list size and relationship complexities
If you have a large organization with a large CMDB, conflict detection can take longer to complete.

Inactive changes are not evaluated
Conflict detection does not evaluate inactive changes when determining conflicting changes.

Advanced mode conflict checking is disabled by default
When you upgrade the application, advanced mode conflict checking is disabled by default and affected CIs are not considered during conflict detection. To evaluate all the CIs, set the mode to Advanced.

Role required: change_manager or admin

Procedure
1. Navigate to Change > Administration > Conflict Properties.
2. Select one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Run conflict detection automatically after changes to Configuration item, Planned start date, Planned end date, or State when a change request is updated | When selected, runs conflict detection automatically when a change to one or more of the following fields on the change request record is saved:  
- Configuration item  
- Planned start date  
- Planned end date  
- State |
<p>| Enable the scheduled change conflict checker | When selected, runs the following conflict detection scheduled jobs at these intervals: |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Conflict Detection &lt; 1 Week Away</td>
<td>is scheduled every day.</td>
</tr>
<tr>
<td>Change Conflict Detection &lt; 1 Month Away</td>
<td>is scheduled every two days.</td>
</tr>
<tr>
<td>Change Conflict Detection &gt;=1 Month Away</td>
<td>is scheduled every seven days.</td>
</tr>
</tbody>
</table>

3. Click **Save**. You can view the conflicts on the **Conflicts** tab on the change request record.

**Detect conflicts manually and review conflict details**

Run conflict detection manually for a change request and cancel conflict detection before it completes. Review the conflicts detected either automatically or manually and resolve them by changing the schedules.

**Before you begin**

Before you can run conflict detection for a change request, the following fields must be completed in the change record.

- **Configuration item**, except in advanced mode. In advanced mode, the **Affected CIs** field is required instead.
- **Planned start date** of the change request.
- **Planned end date** of the change request.

For more information about running conflict detection automatically, see **Enable automatic change conflict detection**.

Prior to running conflict detection, consider the following scenarios unique to your organization.

**CMDB list size and relationship complexities**

If you have a large organization with a large CMDB, conflict detection can take longer to complete.

**Inactive changes are not evaluated**

Conflict detection does not evaluate inactive changes when determining conflicting changes.

**Advanced mode conflict checking is disabled by default**

When you upgrade the application, advanced mode conflict checking is disabled by default and affected CIs are not
considered during conflict detection. To evaluate all the CIs, set the mode to **Advanced**.

Role required: itil or sn_change_write

**Procedure**

1. Navigate to **Change > Open**.
2. From the list of change requests, open the desired change request.
3. Click the **Conflicts** tab or scroll to the bottom the form to find the **Conflicts** tab.
4. Click **Check Conflicts**.
   The Checking conflicts progress status pop-up window appears. To cancel without detecting conflicts, click **Close**.
5. When the conflict detection is completed, click **Close** in the pop-up window. Conflicts appear in the Conflicts Detected list on the **Conflicts** tab. The **Conflict status** and **Conflict last run** fields on the change request record are also updated.
6. In the Conflicts Detected list, review the list of conflicts that appear.

**Conflicts Detected List columns**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conflicting change</td>
<td>The change that is in conflict with the scheduled change, if any.</td>
</tr>
<tr>
<td>Affected CI</td>
<td>The affected CI associated with the change.</td>
</tr>
<tr>
<td>Last Checked</td>
<td>The last time the conflicts were checked. The <strong>Last Checked</strong> field is automatically updated.</td>
</tr>
<tr>
<td>Related CI</td>
<td>The parent CI or child CI of the current CI, if the CI has caused a conflict.</td>
</tr>
<tr>
<td>Schedule</td>
<td>The name of the maintenance window or blackout window that is causing the conflict, if any.</td>
</tr>
<tr>
<td>Type</td>
<td>The issue that caused the conflict.</td>
</tr>
<tr>
<td></td>
<td>• CI Already Scheduled</td>
</tr>
<tr>
<td></td>
<td>• Parent CI Already Scheduled</td>
</tr>
<tr>
<td></td>
<td>• Child CI Already Scheduled</td>
</tr>
<tr>
<td></td>
<td>• Not in Maintenance Window</td>
</tr>
<tr>
<td></td>
<td>• Parent Not In Maintenance Window</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Child Not In Maintenance Window</td>
<td></td>
</tr>
<tr>
<td>• Blackout</td>
<td></td>
</tr>
</tbody>
</table>

**Results**
You can review the conflicts and the affected CIs in the Conflicts Detected list and reschedule the change to resolve the conflicts.

**Cancel conflict detection manually**
Cancel any conflict detection jobs that are actively running for a change request if you want to make any modifications to the schedules. After modifying the schedules, you can rerun the check conflicts action again to identify potential conflicts.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to Change > Open.
2. Open the change request that you want to cancel conflict checking for.
3. Click the Conflicts tab.
4. Click Check Conflicts.
   The Checking conflicts progress status pop-up window appears.
5. To cancel conflict detection, click Cancel.
   The active conflict detection job is canceled and all conflicts displayed in the Conflicts section are cleared. The Conflict Status field displays a Not Run status.

   **Note:** If you set conflict detection to run automatically or on a scheduled basis, the future executions of conflict detection against the same change request record are not canceled.

**Change approval policies**
In Change approval policies, approval definitions are used to generate approvals according to your business requirements.

A change approval policy is a course of action that can be applied to a change request. It uses a set of variable inputs to evaluate the decisions that are associated with it. For each matching decision, the associated approval definition is applied.
An approval policy can contain multiple decisions allowing a single policy to handle every approval required for a change type. When a decision condition matches, the related approval definition is evaluated. If one or more decisions match, all the related approval definitions are evaluated. Change approval policies are based on Decision tables.

Use the Change Approval Policy workflow activity instead of the User and Group Approval workflow activities to manage the approvals at a particular stage of the workflow. For more information, see Change Approval Policy workflow activity.

⚠️ Note: To use the change approval policies after you upgrade:

1. Configure the approval policies as needed.
2. Replace the User and Group Approval activities with the Change Approval Policy activity in the workflow.

A change approval policy consists of three components:

- **Policy inputs**: The variable sources evaluated within the condition defined on a decision.
- **Decisions**: Based on the conditions, determines whether the associated Change approval definition applies.
- **Approval definitions**: Defines the type of approval that can applied.

Create approval definitions

Use approval definitions to define a set of criteria that are evaluated automatically before the policy is marked as approved.

Before you begin

In the approval definitions, you can define to determine

- If the approval is user or group based.
- If it should automatically approve or reject on behalf of a user.
- If a response to the approval is required.

Role required: change_manager or admin

⚠️ Note: Approval definitions can be applied only once if multiple applied decisions have the same approval definitions associated with them.
### Procedure

1. Navigate to **Change > Change Policy > Approval Definitions**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Indicates the name of the approval definition.</td>
</tr>
<tr>
<td>Mandatory</td>
<td>When checked, indicates if the Change Approval Policy must wait until there is a response from the approval generated by the definition.</td>
</tr>
<tr>
<td>Approval action</td>
<td>Allows you to choose the type of the approval record to be created.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Approve</strong>: Generates an approval record with the state set to <strong>Approved</strong>. Assign the user to associate with the record in the <strong>User</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reject</strong>: Generates an approval record with the state set to <strong>Rejected</strong>. Assign the user to associate with the record in the <strong>User</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Add a user approval</strong>: Adds an approval record for the user specified in the <strong>User</strong> field. If the approval is necessary before the policy is approved, select the <strong>Mandatory</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Add a group approval</strong>: Adds approval records for the members of the group listed in the <strong>Group</strong> field. If the approval is necessary before the policy is approved, select the <strong>Mandatory</strong> check box.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Approver source</td>
<td>Allows you to select the source of the user or group approver.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Wait for</td>
<td>Determines the approval timing.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

⚠️ Note: When adding users or groups to which you want to send the approval, specify the Approval Definition value as Approver Source.

4. Click Submit.
Create change approval policies

Use a change approval policy to define approvals that should be generated for your change.

Before you begin
Role required: admin or change manager

Procedure

2. Click New to create a new approval policy.
3. Enter the Name of the policy.
4. In the Execution field, select an option to determine the approach to execute your decision.
   - First decision that matches: Uses the first matching decision in the ascending order of the value defined in the Order column of the Decisions list. The associated approval definition is applied.
   - Run all decisions that match: Uses all matching decision and applies the associated approval definition.
5. Click Submit.
6. Select the policy you created.
7. Add your decisions to the policy and click Submit.

What to do next
To add additional policy inputs and decisions, see Create Policy inputs and Create Decision records. For more information, see Create a decision.

Create policy inputs

Policy inputs are variable sources that you can use while evaluating a decision to determine the approval action. You can create multiple policy inputs to evaluate the decision created, and also access the change request table and any table change request references.

Before you begin
Role required: admin or change manager

You can create multiple policy input types. By default, the change_request policy input of type Reference is available for all change types. This policy input provides access to the change request table and to any table change request references. For a normal change policy, an extra manager_approved
policy input of type *True/false* is available. For more information, see *Create a decision*.

To define additional policy inputs, perform the following steps:

**Procedure**

1. Navigate to *Change > Change Policy > Change Approval Policies*.
2. Create a change approval policy or open an existing policy. For more information, see *Create change approval policy*.
3. In the *Policy inputs* tab, click *New* to create a record. The *Name* and *Application* fields are auto-populated.
4. Click the reference lookup icon for the *Type* field and choose a *Type* value.
5. Enter a name in the *Label* field. The column name for the new record is populated in the *Column Name* field automatically.
6. Depending on the value of the *Type* field, you can configure the other parameters for the policy input.
7. Click *Submit*.

**What to do next**

After you create a policy input, reference it within a decision.

**Create Decision records**

Decision records contain the conditions that you can use to determine the change approval action. Create decisions using condition builder when creating change approval policies.

**Before you begin**

Role required: admin or change manager
You can create decisions to evaluate conditions that reference policy inputs and apply the associated approval definition. To create a decision, perform the following steps:

**Procedure**

1. Navigate to *Change > Change Policy > Change Approval Policies*.
2. Create a change approval policy or open an existing policy. For more information, see *Create change approval policy*.
3. In the *Policy inputs* tab, create a policy input or update an existing record. For more information, see *Create a decision*.
4. In the *Decisions* tab, open the default decision record.
5. Copy and modify the decision record configuration or click New to create a new decision record.

6. Provide a label in the Label field.

7. In the Answer field, select an approval definition.

8. Add any necessary filter conditions using the condition builder. These conditions determine the outcome of the policy. For example, to generate approvals at the Assess state that trigger an approval definition when risk is low, set the condition to `[Change request.state] [is] [Assess] AND [Change request.Risk] [is] [Low].`

9. Click Submit.

**Change Approval Policy workflow activity**

Use the Change Approval Policy workflow activity to control the approval process for a change request by creating user and group approvals according to a change approval policy record. Multiple activities can be used in a workflow, where each activity can reference the same or different Change Approval Policies.

Using the current change request and additional inputs defined in the Policy Input script field in the activity, you can evaluate the Change Approval Policy record, which applies the approval definitions from matching decisions.

⚠️ **Note:** This activity is only available when the workflow runs on a table that extends or is the [change_request] table.

**Results**

The activity assigns a result value according to the outcome of the applied policy. The possible result values are:

- Approved
- Rejected
- Canceled
- Skipped
- Finished

**Input variables**

Input variables determine the initial behavior of the activity.
Change Approval Policy activity input variables

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Policy</td>
<td>The Change Approval Policy that you want to apply to the change request.</td>
</tr>
<tr>
<td>Policy Input</td>
<td>Policy Inputs that are defined on the Change Approval Policy record. Set additional policy inputs here.</td>
</tr>
<tr>
<td>Finish condition</td>
<td>Determine if the activity should complete while pending approvals remain. Use this condition if the workflow is configured to handle restarting the Change Approval Policy activity. For example, when the Change Request goes on-hold.</td>
</tr>
</tbody>
</table>

Condition

The following conditions determine which transition runs after this activity.

Change Approval Policy activity conditions

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>Change request is approved when the criteria defined by applied Approval Definitions is met.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Any rejection from applied Approval Definitions will result in the Rejected outcome.</td>
</tr>
<tr>
<td>Error</td>
<td>The event or condition that generates an error.</td>
</tr>
<tr>
<td>Skipped</td>
<td>If this condition is not configured on the activity, then the Approved condition is used. This outcome occurs for the following scenarios:</td>
</tr>
<tr>
<td></td>
<td>• No decisions from the Change Approval Policy match</td>
</tr>
<tr>
<td></td>
<td>• No approvals can be generated from matched decisions</td>
</tr>
</tbody>
</table>

States

The workflow engine uses the activity state to perform the next logical action on the activity.
Change Approval Policy activity states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executing</td>
<td>The workflow engine starts the <code>execute</code> function of the activity.</td>
</tr>
<tr>
<td>Waiting</td>
<td>The workflow engine ignores the activity until a specific event to restart the activity is fired.</td>
</tr>
<tr>
<td>Finished</td>
<td>The activity finished running. See the result value for the outcome of the activity.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>This activity, or the workflow that contains this activity, was canceled.</td>
</tr>
<tr>
<td>Error</td>
<td>A JavaScript error occurred. Review the logs for error details.</td>
</tr>
</tbody>
</table>

Example

In this example, let us reference the Risk approvals activity in the **Change Request - Normal** workflow. In the workflow, the change approval policy factors if the assigned group's manager has already approved the Change Request.
You can use this activity to access the risk of the change request of a normal change policy. When this activity runs, the associated decisions executes the approvals that needs to be requested.
Use the **Policy Input** field to set up additional inputs. In the given example, the activity defines the manager_approved property and performs the query to check if an approved record exists for the approved group’s manager.

> **Note:** Ensure that the manager_approved policy input is defined in the Change Approval Policy record.

The **Finish condition** field is used to complete the activity by marking pending approvals as **No Longer Required**. In this workflow example, when the Change Request is put on-hold, the Change Approval Policy activity is completed and the workflow disregards the pending approvals before waiting for the Change Request to resume. When the on-hold state is released, the Change Approval Policy activity is restarted.

**Use the Change Approval Policy workflow activity**

Apply your Change Policy in your Change Request workflow to manage the approvals.

**Before you begin**
Role required: admin
Procedure

1. Navigate to Workflow Editor.
2. Open the change request workflow that you want to use in the Change Policy activity.
3. Drag and drop the Change Approval Policy activity from the Change Policy section in the Core activities tab.

**Note:** This activity is only available when the workflow runs on a table that extends or is the change_request table.

4. Configure the activity by specifying the Change Approval Policy in the workflow.
5. Configure the Policy input field to setup inputs that are defined on the associated Change Approval Policy record.
6. Configure the Finish condition if the workflow needs to handle a scenario where the activity needs to complete ahead of time because of a change in the Change Request. For example, when the change request is on-hold
7. Click Update.

Change Advisory Board (CAB) workbench

The Change Advisory Board (CAB) workbench enables a CAB manager to schedule, plan, and manage CAB meetings.

CAB meetings are typically intended to review and authorize change requests and review recently implemented changes. A standard agenda with the relevant change request details enables the CAB members to conduct risk and impact analysis prior to the CAB meeting.

Overview of the CAB Workbench. This video covers: What is the CAB Workbench, CAB Manager, Benefits of the CAB Workbench, Key Structures of the CAB Workbench.

The CAB workbench assists you in managing CAB meetings in the following ways:

**Define a schedule for CAB meetings**

Schedule a recurring series of CAB meetings for CAB members to assess the impact and risk of change requests prior to the meetings.

**Define CAB meeting attendees**

Define members who attend this CAB meeting series for each occurrence. For example, define the CAB board members or any delegates who can substitute if the CAB manager cannot attend.
Define CAB meeting agenda

Define filter criteria that determines which change requests are included in any occurrence of a CAB meeting. If a change request is included in an agenda, the change requester is notified of the CAB meeting in which the change request is discussed. The change requester can attend and present the reasons for the proposed change, and explain the intended outcomes and potential risks of the change.

View change calendar

Schedule changes by displaying existing planned changes in a change calendar in daily, weekly, and monthly view. The calendar view also lists maintenance windows and blackout schedules, if any.

Approve or reject a change request

Approve or reject a change request based on the decision taken in the CAB meeting.

View and record meeting notes

Record meeting notes from a specific CAB meeting and share these notes with other meeting attendees.

The CAB Definition (cab_definition) table inherits the domain properties from the Schedule (cmn_schedule) table which has the Domain and Domain path columns. As the CAB Definition table makes use of the same Child Schedule and Schedule Entry tables as the Schedule table, domain support is identical, where the domain_master attribute is used to derive Domain from a parent record. For more information, refer Domain support for schedules.

Create a CAB definition

A Change Advisory Board (CAB) definition is similar to a recurring meeting invitation. When you define a CAB definition, it determines the attributes that are associated with all CAB meetings generated from that definition.

Before you begin
Role required: sn_change_cab.cab_manager

About this task
Overview of planning and scheduling within the CAB Workbench module.

Procedure
1. Navigate to Change > Change Advisory Board > My CAB Definitions.
2. Click New.
3. On the CAB Definition form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the CAB definition.</td>
</tr>
<tr>
<td>CAB Manager</td>
<td>Name of the user who manages the CAB meetings.</td>
</tr>
<tr>
<td>Delegates</td>
<td>Delegate CAB members who can substitute as the CAB manager during the meeting.</td>
</tr>
<tr>
<td>Board Members</td>
<td>Board members who are expected to attend the CAB meeting, selected from the list of users.</td>
</tr>
<tr>
<td>Board Groups</td>
<td>Board groups who are expected to attend the CAB meeting, selected from the list of user groups.</td>
</tr>
<tr>
<td>Rolling Meeting Window</td>
<td>Number of days for which you want to create CAB meetings.</td>
</tr>
<tr>
<td>Note:</td>
<td>The CAB schedule and related schedules, if any, determine the number of CAB meetings that are created. For example, if you have a CAB schedule of once every week and you enter 28 days in the Rolling Meeting Window field, then three CAB meetings are created.</td>
</tr>
<tr>
<td>CAB Type</td>
<td>Type of CAB meeting this definition is used for.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Time zone for the CAB meeting.</td>
</tr>
<tr>
<td>Locations</td>
<td>One or more locations for your CAB meetings. For example, meeting rooms in different offices.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that specifies whether the CAB definition is active. Clear the check box to deactivate the CAB definition.</td>
</tr>
<tr>
<td>Conference Details</td>
<td>Information such as meeting links, passwords, and phone numbers.</td>
</tr>
<tr>
<td>Agenda Management</td>
<td>If selected, helps to choose a time range for the planned start and end date from Change Request additional condition instead of selecting specific dates based on meeting schedule.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note:</td>
<td>The same field is selected for all CAB meetings in the CAB definition unless individually overridden.</td>
</tr>
<tr>
<td>Notification lead time</td>
<td>The advanced notification on the number of agenda items that needs to be discussed.</td>
</tr>
<tr>
<td>Auto Add Agenda Decisions</td>
<td>Check box for capturing agenda decisions automatically on the meeting widget. The agenda decision is captured in the following format: (CAB Automation) - &lt;change request number&gt; - &lt;decision&gt; - &lt;CAB Manager name&gt; - &lt;time&gt;&lt;AM/PM&gt; &lt;timezone&gt;</td>
</tr>
<tr>
<td>Automatically Add Change Requests</td>
<td>Check box to define the types of change requests that are automatically added to the CAB meeting agenda.</td>
</tr>
<tr>
<td>Change Request Addition Conditions</td>
<td>Condition builder to specify which change requests are added to the CAB meeting agenda.</td>
</tr>
<tr>
<td>Add Filter Condition:</td>
<td>Click to add additional filter conditions, or click AND next to the existing filter condition.</td>
</tr>
<tr>
<td>Add “OR” Clause:</td>
<td>Click to display the results of multiple filter criteria in a single list.</td>
</tr>
<tr>
<td>Add Sort:</td>
<td>Click to define the order of the change requests in this CAB meeting agenda.</td>
</tr>
</tbody>
</table>
4. Open the form context menu and select **Save**.
The **Schedule Entries, Related Schedules**, and **CAB Meetings** related lists appear.

5. To set the meeting schedule for your CAB meeting series, complete the following steps:
You can add one or more schedule entries to a CAB definition to schedule the series of CAB meetings. These schedule entries let you set valid days and times for holding CAB meetings.

   **a.** In the **Schedule Entries** related list, click **New**.

   **b.** On the Schedule Entry fields form, fill in these fields.

   **Schedule Entry fields form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the schedule entry.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of schedule entry for the specified date and time duration, for example, appointment or meeting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Time off</strong>: Shown as planned time-off.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Appointment</strong>: Shown as appointment time.</td>
</tr>
</tbody>
</table>

---

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Meeting</strong>:</td>
<td>Shown as meeting time.</td>
</tr>
<tr>
<td>• <strong>Phone call</strong>:</td>
<td>Shown as time for making phone calls.</td>
</tr>
<tr>
<td>• <strong>Excluded</strong>:</td>
<td>The duration is excluded.</td>
</tr>
<tr>
<td>Show as</td>
<td>How the schedule entry is displayed on the CAB calendar, for example, busy or tentative.</td>
</tr>
<tr>
<td>When</td>
<td>Start and end date and time for the schedule entry.</td>
</tr>
<tr>
<td>All day</td>
<td>Check box to make the schedule entry active for the entire duration of the selected dates.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Time zone for the schedule entry. The time zone cannot be modified.</td>
</tr>
<tr>
<td>Repeats</td>
<td>Frequency with which the schedule entry repeats, for example, daily or weekly.</td>
</tr>
<tr>
<td></td>
<td>When you select Monthly, the Monthly type field appears. Enter the number of times in a month when the schedule entry repeats.</td>
</tr>
<tr>
<td></td>
<td>When you select Yearly, the Yearly type field appears. Select an option, as follows:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Day of the year</strong>: Chosen as the current day on which you define the schedule.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Floating</strong>: If you select this option, the following fields appear:</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Float week</strong>: The week of the month when the schedule entry repeats.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Float day</strong>: The day of that week when the schedule entry repeats.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>Month</strong>: The month when the schedule entry repeats.</td>
</tr>
<tr>
<td>Repeat every</td>
<td>If the schedule entry is selected to repeat, specifies how often it repeats. For example, if you select weekly repetitions, specify the frequency such as every week or every two weeks.</td>
</tr>
<tr>
<td></td>
<td>This field appears when you select the Weekly, Monthly, or Yearly options.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Repeat on</td>
<td>If the schedule entry is selected to repeat, then specify when it repeats. For example, if you select weekly repetitions, specify the days of the week when it repeats. This field appears when you select the <strong>Weekly</strong> option.</td>
</tr>
<tr>
<td>Repeat until</td>
<td>If the schedule entry is scheduled to repeat, specifies an end date until which the schedule entry is repeated.</td>
</tr>
</tbody>
</table>

c. To add the schedule entry to the CAB definition, click **Submit**.

d. **Optional:** To view the series of CAB meetings in a calendar view in a new browser window or tab, click the **Show Schedule** related link.

6. To set a related schedule for your CAB meeting series, complete the following steps:
   You can add one or more related schedules to a CAB definition. Related schedules enable you to set valid schedules for holding CAB meetings. For example, if you set the public holiday schedule as a related schedule, it ensures that no CAB meeting is scheduled on a public holiday.
   a. In the **Related Schedules** related list, click **Edit**.
   b. Select one or more related schedules and move them to the **Related Schedules List**.
   c. Click **Save**.
   d. **Optional:** On the **CAB Definition** form, click the **Show Schedule** related link to view the defined schedule in the calendar.

7. In the **Related Links** section, click **Refresh CAB Meetings**.
   The CAB meeting series created from CAB definitions inherit the criteria of the CAB definition.
   You can view the series of CAB meetings generated from the CAB definition in the **CAB Meetings** related list.

**What to do next**
You can modify CAB meeting details and send meeting requests to attendees. You can also manage agendas by reviewing or adding agenda items to each of the meetings.
Related information

OR conditions

View the CAB calendar

The CAB calendar provides an overview of your CAB meeting schedule to help with planning and managing CAB meetings.

Before you begin
Role required: itil, sn_change_cab.cab_manager, sn_change_read, sn_change_write, or admin

About this task
You can view the CAB calendar to view and attend specific meetings.

Procedure

1. Navigate to **Change > Change Advisory Board > CAB Workbench**.

2. You can perform the following actions from the CAB calendar.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the calendar</td>
<td>Click the options in the top right of the CAB calendar to display the calendar in daily, weekly, or monthly view.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View CAB meeting details at a glance</td>
<td>Click a specific CAB meeting to view details such as the CAB manager, meeting start time, and meeting end time.</td>
</tr>
<tr>
<td>Attend a specific CAB meeting</td>
<td>Click the meeting you want to attend and click <strong>Open</strong> to launch the meeting.</td>
</tr>
</tbody>
</table>

**Create a single CAB meeting occurrence**

Depending on your requirements, you can create an individual Change Advisory Board (CAB) meeting occurrence.

**Before you begin**

Role required: sn_change_cab.cab_manager

**Procedure**

1. Navigate to **Change > Change Advisory Board > My CAB Meetings**.
2. Click **New**.
3. On the CAB Meeting form, fill in the fields.

**CAB Meeting form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the CAB meeting.</td>
</tr>
<tr>
<td>CAB manager</td>
<td>Name of the user who manages the CAB meeting. The default is the user that is currently logged in.</td>
</tr>
<tr>
<td>Delegates</td>
<td>Delegate CAB members who can substitute as the CAB manager during the meeting.</td>
</tr>
<tr>
<td>Board groups</td>
<td></td>
</tr>
<tr>
<td>Board members</td>
<td></td>
</tr>
</tbody>
</table>
| State           | • **Pending**: Indicates that the meeting is yet to begin. It is the default state of the meeting.  
                   • **In progress**: Indicates that the meeting has begun and is in progress. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Complete</strong>: Indicates that the meeting has occurred and is finished.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Canceled</strong>: Indicates that the meeting has been canceled.</td>
</tr>
<tr>
<td>Note:</td>
<td>The system automatically updates the State field when the meeting starts and</td>
</tr>
<tr>
<td></td>
<td>ends from within the CAB workbench. There is no need to manually change this</td>
</tr>
<tr>
<td></td>
<td>field, unless, for example, the CAB manager wants to cancel a future meeting.</td>
</tr>
<tr>
<td></td>
<td>If the CAB workbench closes unexpectedly, the CAB manager must manually update</td>
</tr>
<tr>
<td></td>
<td>the State field.</td>
</tr>
<tr>
<td>Meeting start time</td>
<td>Start date and time for the meeting.</td>
</tr>
<tr>
<td>Note:</td>
<td>When you add an agenda item to a CAB meeting, the CAB date field in the change</td>
</tr>
<tr>
<td></td>
<td>request is automatically updated with this date.</td>
</tr>
<tr>
<td>Meeting end time</td>
<td>End date and time for the meeting.</td>
</tr>
<tr>
<td>Meeting Notes</td>
<td>Enter notes for the meeting, if any.</td>
</tr>
<tr>
<td>Locations</td>
<td>One or more locations for your CAB meetings. For example, meeting rooms in</td>
</tr>
<tr>
<td></td>
<td>different offices.</td>
</tr>
<tr>
<td>Conference Information</td>
<td></td>
</tr>
<tr>
<td>Conference details</td>
<td>Information such as meeting links, passwords, and phone numbers.</td>
</tr>
<tr>
<td>Agenda Management</td>
<td></td>
</tr>
<tr>
<td>Use filter criteria</td>
<td>If selected, helps to choose a time range for the planned start and end date</td>
</tr>
<tr>
<td>to drive Change</td>
<td>from Change Request additional condition instead of selecting specific dates</td>
</tr>
<tr>
<td>Request date range</td>
<td>based on meeting schedule.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you select the Use filter criteria to drive Change Request date range</td>
</tr>
<tr>
<td></td>
<td>field in a cab meeting, the Change Requests starting after field and the</td>
</tr>
<tr>
<td></td>
<td>Change Requests starting on or before field is disabled for the meeting,</td>
</tr>
<tr>
<td></td>
<td>and therefore ignored. The change request additional conditions drive the</td>
</tr>
<tr>
<td></td>
<td>date range.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change Requests starting after</td>
<td>Change requests that starts after this date and time should be added to the CAB meeting.</td>
</tr>
<tr>
<td>Change Requests starting on or</td>
<td>Change requests that starts on or before this date and time should be added to the CAB meeting.</td>
</tr>
<tr>
<td>Complete Pre-approved Changes</td>
<td>Check box to mark each pre-approved change request as <strong>Complete</strong> in the CAB meeting agenda.</td>
</tr>
<tr>
<td><strong>Note:</strong> Pre-approved changes are automatically marked as complete so that approvers do not have to review them. The pre-approved changes are visible in the CAB Workbench, and can be discussed if necessary.</td>
<td></td>
</tr>
<tr>
<td>Time per Agenda Item</td>
<td>The time, in minutes and seconds, allotted to discuss each change request on the agenda. The allotted time can be adjusted for agenda items before or during the meeting.</td>
</tr>
<tr>
<td>Notification lead time</td>
<td>The advanced notification on the number of agenda items that needs to be discussed.</td>
</tr>
<tr>
<td>Auto Add Agenda Decisions</td>
<td>Check box to capture agenda decisions automatically on the meeting widget. The agenda decision is captured in the following format:</td>
</tr>
<tr>
<td></td>
<td>(CAB Automation) - &lt;change request number&gt; - &lt;decision&gt; - &lt;CAB Manager name&gt; - &lt;time&gt;&lt;AM/PM&gt; &lt;timezone&gt;</td>
</tr>
</tbody>
</table>

4. Open the form context menu and select **Save**.  
   The **Agenda Items** and **Attendees** related lists appear.

**What to do next**
You can now add agenda items and attendees to the cab meeting.

**View CAB meeting details**
You can view the details of any past, scheduled, or in-progress CAB meeting.

**Before you begin**
Role required: itil, sn_change_cab.cab_manager, sn_change_read, sn_change_write, or admin
Procedure

1. Use one of the following ways to navigate to the CAB meeting:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| CAB meeting     | a. Navigate to Change > Change Advisory Board > All CAB Meetings and open the specific CAB meeting to view.  
                  | b. Click the Go to this meeting in CAB workbench related link.             |
                  | b. Click the meeting details you want to view from your calendar.          
                  | c. Click Open in the window that appears for the meeting.                 |

**Note:** You can only click Open if the meeting has an agenda.
The following information is available:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Time                | • Total time scheduled for the CAB meeting  
                     • Time covered until present for a CAB meeting in progress  
                     • Time spent discussing current agenda item  
                     • Time assigned to each agenda item |
| Agenda items        | List of agenda items for the CAB meeting. You can view all agenda items or filter the list for current, pending, and completed agenda items. |
| Calendar            | The blackout and maintenance windows are displayed on the change calendar. You can also view when the current agenda item is scheduled. You can view the calendar in a daily and weekly format. |
| Meeting Notes       | Meeting notes, if any, for a past CAB meeting. If you are the CAB manager, you can take notes during the meeting. |
| Attendees           | Details of attendees for the specific CAB meeting including the CAB board and delegates. |
| Conference Information | Conference details of the CAB meeting. |

2. If you are the CAB manager, or one of the CAB delegates who has chosen to host a specific CAB meeting, you can perform the following tasks:
<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the change request</td>
<td>Click the edit icon beside the Change, Planning, and Schedule tabs.</td>
</tr>
<tr>
<td>Start the meeting</td>
<td>Click Start meeting.</td>
</tr>
<tr>
<td>End the meeting</td>
<td>Click End meeting.</td>
</tr>
<tr>
<td>Pause the timer on the current agenda item</td>
<td>Click Pause on the Current Agenda Item widget.</td>
</tr>
<tr>
<td>Move to the next agenda item</td>
<td>Click Next after a decision is taken on the current agenda item.</td>
</tr>
<tr>
<td>Host the meeting</td>
<td>Click Attendees &gt; Host to become the host. You can host the meeting when you are a CAB manager or delegate.</td>
</tr>
<tr>
<td>Promote an agenda item</td>
<td>Click Promote under a change request name and title to promote it as the next agenda item for discussion.</td>
</tr>
<tr>
<td>Take meeting notes</td>
<td>Click Meeting Notes to take notes during the meeting. These notes can be shared with CAB attendees.</td>
</tr>
</tbody>
</table>

**Modify CAB meeting details**

You can modify the agenda items for a specific CAB meeting.

**Before you begin**

Role required: itil, sn_change_read, sn_change_write, or sn_change_cab.cab_manager

**About this task**

After you update the CAB board or change request conditions, refresh the CAB meeting to apply the updates. If you add new board members or attendees to the meeting, they are notified via email invitations after the meeting is refreshed.
Procedure

1. Navigate to the CAB meeting whose agenda you want to modify using one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open from the CAB meeting list</td>
<td>a. Navigate to Change &gt; Change Advisory Board &gt; All CAB meetings.</td>
</tr>
<tr>
<td></td>
<td>b. Select and open the CAB meeting to modify.</td>
</tr>
<tr>
<td>Open from the CAB definition list</td>
<td>a. Navigate to Change &gt; Change Advisory Board &gt; All CAB definitions.</td>
</tr>
<tr>
<td></td>
<td>b. Select and open the CAB definition to send out the meeting request.</td>
</tr>
<tr>
<td></td>
<td>c. Select and open the specific CAB meeting to modify.</td>
</tr>
</tbody>
</table>

2. Modify the CAB meeting agenda in the Agenda Management tab or form section, as appropriate.

**Agenda Management fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification lead time</td>
<td>The advanced notification on the number of agenda items that needs to be discussed.</td>
</tr>
<tr>
<td>Automatically Add Change Requests</td>
<td>Check box to define the types of change requests that are automatically added to the CAB meeting agenda.</td>
</tr>
<tr>
<td></td>
<td>When you select <strong>Automatically Add Change Requests</strong>, the <strong>Refresh CAB Meetings</strong> related link appears. If you click this link, search is performed for change requests that match the value in the <strong>Change Request Addition Conditions</strong> field. If there are any matching change requests, agenda items are created for them and added to the CAB agenda.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change Request Addition Conditions</td>
<td>Condition builder to specify which change requests are added to the CAB meeting agenda.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Add Filter Condition</strong>: Click to add additional filter conditions, or click <strong>AND</strong> next to the existing filter condition.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Add “OR” Clause</strong>: Click to display the results of multiple filter criteria in a single list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Add Sort</strong>: Click to define the order of the change requests in this CAB meeting agenda. The agenda order can be defined in CAB Definitions or CAB Meetings, and can be based on one or more fields.</td>
</tr>
<tr>
<td>Time per Agenda Item</td>
<td>The time, in minutes and seconds, allotted to discuss each change request on the agenda. The allotted time can be adjusted for agenda items before or during the meeting.</td>
</tr>
<tr>
<td>Complete Pre-approved Changes</td>
<td>Check box to mark each pre-approved change request as <strong>Complete</strong> in the CAB meeting agenda.</td>
</tr>
</tbody>
</table>
### Field Description

**Note:** Pre-approved changes are automatically marked as complete so that approvers do not have to review them. The pre-approved changes are visible in the CAB Workbench, and can be discussed if necessary.

3. From **Related Links**, you can perform any of the following tasks.

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh Agenda Items</td>
<td>The agenda items for the CAB meeting are refreshed. If you added or updated attendees, a confirmation message asks if the meeting request must be resent to these attendees.</td>
</tr>
<tr>
<td>Send meeting request to attendees</td>
<td>Click to manually resend the meeting request to the list of attendees.</td>
</tr>
<tr>
<td>Go to this meeting in CAB Workbench</td>
<td>Click to open the meeting in the CAB workbench. This link is available only when it is time for the CAB to begin.</td>
</tr>
<tr>
<td>Share notes</td>
<td>Share notes captured in the <strong>Meeting Notes</strong> field to the list of meeting attendees. <strong>Share Notes</strong> is only visible when the meeting is <strong>In Progress</strong> or <strong>Complete</strong>.</td>
</tr>
</tbody>
</table>

4. From related lists, you can perform any of the following tasks.

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agenda Items</td>
<td>Manually add agenda items. In the <strong>Allotted Time</strong> field, the CAB manager can override the default time for any agenda item.</td>
</tr>
<tr>
<td>Attendees</td>
<td>Manually add attendees to a CAB meeting.</td>
</tr>
</tbody>
</table>

5. Click **Update** to save your changes.
Related information

Send CAB meeting request to attendees
You can send CAB meeting invitations to attendees for each CAB meeting.

Before you begin
Role required: sn_change_cab.cab_manager

About this task
You can send meeting invitations from a CAB meeting only.

Procedure
1. Navigate to the CAB meeting for which you want to send out invitations using one of the following steps.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open from the CAB meeting list</td>
<td>a. Navigate to Change &gt; Change Advisory Board &gt; All CAB meetings.</td>
</tr>
<tr>
<td></td>
<td>b. Select and open the CAB meeting to modify.</td>
</tr>
<tr>
<td>Open from the CAB definition list</td>
<td>a. Navigate to Change &gt; Change Advisory Board &gt; All CAB definitions.</td>
</tr>
<tr>
<td></td>
<td>b. Select and open the CAB definition to send out the meeting request.</td>
</tr>
<tr>
<td></td>
<td>c. Select and open the specific CAB meeting to modify.</td>
</tr>
</tbody>
</table>

2. Click the **Send meeting request to attendees** related link.
   The CAB meeting invitation is sent to all listed attendees.

CAB meeting attendance using the CAB workbench
As an itil user, you can attend a Change Advisory Board (CAB) meeting, view the agenda items, and the change schedule. If you are an approver, you can approve a change request.

View the details of a CAB meeting and its agenda by navigating to **Change > Change Advisory Board > CAB Workbench**. From the calendar, you can view
the CAB meeting schedule for a day, week, or month. To view details of a meeting, click the meeting and then click **Open** in the pop-up window.

The following components describe the different activities that you can perform in the interface:

**CAB workbench**

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1     | View the timer that displays the total elapsed time, the meeting name, and the scheduled date and time of the meeting. The timer count starts from zero. The color code in the timer changes based on the overall percentage of time elapsed from the total duration of the meeting:  
  - 0% - 50%: Green  
  - 50% - 70%: Yellow  
  - 75% - 100%: Orange  
  - > 100%: Red  
  The text below the meeting name displays the total time allotted for the meeting. |
| 2     | View the current agenda item. The timer displays the amount of time spent discussing the current meeting agenda item. The form |
## CAB Workbench (continued)

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The <strong>level</strong> area displays the details of the current agenda item that you have selected. When the current agenda item changes, the details on the form and the calendar change accordingly. If you select an agenda item that is not the current agenda item, the form area displays the details of the selected agenda item. The form area does not display details of the current agenda item even when the current agenda item is changed to the next agenda item.</td>
</tr>
</tbody>
</table>

**Note:** If you are one of the approvers for the agenda item, the **Approve** and **Reject** buttons appear below the timer. You can click **Approve** or **Reject** as appropriate, enter your comments in the Confirmation pop-up window, and click **Approve** or **Reject**.

| 3 | Filter the agenda items that you want to view and click **Notify me** to receive a notification before the agenda item starts. Click the **Pending Agenda Items** list, and select the **All Agenda Items**, **My Agenda Items**, or **Approved Agenda Items** option. The list of agenda items appears under the filter condition list, in the order that the items appear in the agenda. |

| 4 | • **Meeting Notes**: Displays the document note entered by the host of the meeting.  
   • **Attendees**: Displays the list of attendees and also indicates whether the attendees are currently connected to the meeting.  
   • **Conference Information**: Displays any content that was stored in the **Conference Information** field from the related CAB meeting record. |

| 5 | View the details of a current change in the form view or in the calendar view.  
   **Show form**: Click the show form icon ([folder](#)) to display change details in the form view. The **Change**, **Planning**, and **Schedule** tabs provide information about the change request meeting, planning, and scheduling.  
   **Show calendar**: Click the show calendar icon ([calendar](#)) to display change details on the calendar form. You can select the day or
CAB workbench (continued)

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>the month that you want to view details of a change for. In a day view, you can click the settings icon ( ), and then click the configuration icon ( ) to set relevant filter conditions. If you turn on any of the configuration filter conditions, the related change records are displayed. The change records appear in the time slot of the day that the current change implementation is planned for. In the configuration settings, you can view other potential conflicts. The conflicts can be other change requests that are scheduled for implementation by the same assignee, assignment group, or for the same configuration item. The day and month view of the calendar displays the Blackout Schedule time, Maintenance Window, and the agenda item that is in progress. In the day view, the specific time slot of the planned blackout and maintenance window is highlighted. In the calendar view, the entire day is highlighted.</td>
</tr>
</tbody>
</table>

Note: For standard change proposals, the Change, Proposal, and Change Request Values tabs provide information on change request meeting, proposal, and change request values. The show form ( ) and the show calendar ( ) icons do not appear for standard change proposals.

Add new CAB meeting agenda items

You can add an agenda item to your CAB meeting to customize the agenda and make the meeting more effective.

Before you begin
Role required: admin

Procedure
1. Navigate to Change > Change Advisory Board > All CAB Meetings.
2. Click the CAB meeting record that you want to add an agenda item to.
3. On the Agenda Items context menu, click New.
4. On the form, fill in the fields.
## CAB Agenda Item form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting</td>
<td>Name of the meeting that you selected to add the agenda item.</td>
</tr>
<tr>
<td>Task</td>
<td>Lookup list to select the change request or standard change proposal.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The standard change proposal is available for selection only from Rome.</td>
</tr>
<tr>
<td>Order</td>
<td>Order that the agenda items will be reviewed during the CAB meeting.</td>
</tr>
<tr>
<td>Notification recipients</td>
<td>Recipients to receive the notification about the new agenda item.</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description of the task.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Detailed description of the task.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the agenda item.</td>
</tr>
<tr>
<td>Decision</td>
<td>Status of the agenda item.</td>
</tr>
<tr>
<td>Allotted Time</td>
<td>Allotted time for the agenda item in the meeting.</td>
</tr>
<tr>
<td>Elapsed Time</td>
<td>Time already spent on the agenda item.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

## CAB meeting management using the CAB workbench

As a Change Advisory Board (CAB) manager, you can view and manage details of a CAB meeting and its agenda items through the CAB workbench.

You can view the details of a CAB meeting and its agenda by navigating to **Change > Change Advisory Board > CAB Workbench**. The calendar offers a view of your CAB meeting schedules for the day, week, or month. To view your meeting details, click the meeting and then click **Open** in the pop-up calendar. To start a meeting, click **Start meeting**.
Note: If you click the first agenda item for the first time, a Confirmation window appears. If you want to start the meeting, click Yes, otherwise, click No.

Watch this six-minute video to learn more about CAB meeting management. This video provides an overview of planning and scheduling within the CAB Workbench module.

The details of the change request meeting appear.
The following table describes the CAB workbench components:

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1     | You can view the timer that displays the total elapsed time, the meeting name, and the scheduled date and time of the meeting. The timer count starts from zero. The color code in the timer changes based on the overall percentage elapsed from the total duration of the meeting:  
  - 0% - 50%: Green  
  - 50% - 70%: Yellow  
  - 75% - 100%: Orange  
  - < 100%: Red  
  The text below the meeting name displays the total time allotted for the meeting. |
| 2     | • Click **Pause** to pause an agenda item.  
  • Click **Next** if you want to skip an agenda item.  
  † **Note:** The agenda item is added in the list of All Agenda Items list.  
  • Click **Restore** if you again want the agenda item back in the Pending Agenda Items list.  
  † **Note:** The agenda item is added to the end of the Pending Agenda Items list.  
  • Click **Promote** to move the agenda item to the top of the list.  
  • Click **Demote** to append the current agenda item in the Pending Agenda Items list so that you can discuss the agenda item later.  
  † **Note:** The timer displays the amount of time spent discussing the current meeting agenda item.  
  • Click **End meeting** to end a meeting. |
<p>| 3     | You can filter the agenda items that you want to view. |</p>
<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
</table>
| • Click the **Pending Agenda Items** list, and select the **All Agenda Items, My Agenda Items, or Approved Agenda Items** option.  
  **Note:** The list of agenda items appears under the filter condition list, in the order that the items appear in the agenda.  
  • Click **Promote** if you want an agenda item to appear at the top of the agenda item list. |
| 4 | You can take meeting notes whether you are a host or a delegate. You can view the list of attendees and conference information.  
  • **Meeting Notes**: Enables the CAB manager and delegates to document notes for the overall meeting. The notes captured in the widget can be shared from the widget. The widget emails the contents to the list of attendees, which are automatically saved to the corresponding **Meeting Notes** field in the CAB Meeting record.  
  Any notes specific to a change request can be added directly to the change request. To add a note, use the editable view of the form under the edit icon in the upper left of the form widget.  
  **Note:** The agenda decisions made by the CAB and change approvers, such as whether the agenda item is approved or rejected or when CAB manager skips to another agenda item without making a decision, are automatically captured in the meeting notes widget. The agenda decisions are stored in the **Meeting Notes** field in the related CAB Meeting record.  
  • **Attendees**: Displays the list of attendees and indicates if the attendees are currently connected to the meeting via the green Presence icon. The list also displays the attendee’s response to the meeting invitation such as Accept, Tentative, Decline, or No response.  
  • **Conference Information**: Displays any content that was stored in the **Conference Information** field on the related CAB Meeting record. |
### CAB workbench (continued)

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>You can view the details of a current change in the form view or in the calendar view.</td>
</tr>
</tbody>
</table>

**Show form:** Click the show form icon 📝 to display change details in the form view. The **Change**, **Planning**, and **Schedule** tab provide information about the change request meeting, planning, and scheduling. You can edit the form view, by using the edit icon 🖊.

To customize the view, click the list contextual menu 📝 and then click **View > cab_workbench**. On the Change Request form, right-click and navigate to **Configure > Form Layout**. On the Configuring Change Request form, you can add fields and sections that you want to display in the form view.

**Show calendar:** Click the show calendar icon 📅 to display current change details on the calendar form. You can select the day or the month that you want to view meeting details for.

In the day view, click the settings icon 📦 and then click the configuration icon 🛡 to set relevant filter conditions. If you turn on any of the configuration filter conditions, the related change records are displayed. The change records appear in the time slot of the day that the current change implementation is planned for. In the configuration settings, you can view other potential conflicts. The conflicts can be other change requests that are scheduled for implementation by the same assignee, assignment group, or for the same configuration item.

The day and month view of the calendar displays the Blackout Schedule time, Maintenance Window, and the agenda item that is in progress. In the day view, the specific time slot of the planned blackout and maintenance window is highlighted. In the calendar view, the entire day is highlighted.
Change management integrations

You can integrate Change Management with other ServiceNow applications such as Discovery, Software Asset Management, and Hardware Asset Management.

The following topics provides information about integration of different applications with Change Management, prerequisites, and way to enable functionality of those integrated applications.

Change Management integration with ITOM Visibility

If your organization is subscribed to ITOM Discovery or ITOM Visibility, integration with these ITOM products is automatically enabled. With this integration, any configuration item (CI) with an IP address that is part of a change request process can be maintained automatically. Change request fulfillers can also manually request the discovery process for a CI.

Enabling integration

Depending on subscriptions purchased by your organization, you must install and configure the following plugins:

- For ITOM Discovery - the Discovery plugin (com.snc.discovery)
- For ITOM Visibility - the Discovery plugin (com.snc.discovery) and Service Mapping plugin (com.snc.service-mapping)

Integration with ITOM Discovery

When Discovery is activated, Change Management exposes three new properties within the Change Properties module (Change Management > Administration > Change Properties):

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configures how discovery is triggered for Affected CIs (automatically, manually or off)</td>
<td>Determines whether to trigger discovery for the affected CIs automatically, manually, both, or not at all. Type: Choice list Values: Off, Both, Automatic, Manual Default value: Off</td>
</tr>
</tbody>
</table>
## Change Management properties for Discovery (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> If the property below is set to Both, and you trigger discovery manually, then the automatic discovery will not be triggered for that change request.</td>
<td></td>
</tr>
<tr>
<td>List of Change Request states (comma-separated) where discovery can be triggered manually</td>
<td>Defines the change request state values to allow discovery to be manually initiated. For these defined state values, the Initiate Discovery related link is available.</td>
</tr>
<tr>
<td>Type: String</td>
<td>Default value: Implement, Review</td>
</tr>
<tr>
<td><strong>Note:</strong> If there are multiple languages used on the instance, then this property needs to be set to the internal state value for Review.</td>
<td></td>
</tr>
<tr>
<td>List of Change Request states (comma-separated) where discovery triggers automatically. E.g., when the Change Request's state changes to Review</td>
<td>Defines the change request state values for which discovery is automatically triggered. Discovery initiates when transitioning to the state values listed.</td>
</tr>
<tr>
<td>Type: String</td>
<td>Default values: Review</td>
</tr>
<tr>
<td><strong>Note:</strong> If there are multiple languages used on the instance, then this property needs to be set to the internal state value for Review.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** For the last two properties in the above table, if there are multiple languages used on the instance, then the property needs to be set to the internal value, which is 0, for Review.
In addition to the new properties, the **Discovery State** and the **Discovery last updated** fields get added to the **Affected CI** related list. **Discovery State** provides one of five status values and a corresponding icon to reflect that status:

- In Progress
- Completed Successfully
- Completed w/Warning
- Completed w/Error
- Cancelled

The **Discovery State** value is presented as a link to the corresponding Discovery log file. The **Discovery last updated** field contains a date and time stamp indicating the last time Discovery was executed.

If you have opted to manually initiate the Discovery module, or opted for both manual and automatic initiation, then the **Initiate Discovery** related link appears in the Related Links section when the state of the change request matches one of the defined states in the property. When Discovery is triggered, the values in the **Discovery State** and the **Discovery last updated** fields change.

### Integration with ITOM Visibility

You can view the changes in the context of application services. Service maps available in Service Mapping show changes to an application service as a whole and to the individual configuration items (CIs) comprising the service.

If the Now Platform is configured to validate changes, all changes are evaluated and rendered as valid or not. If a change is valid, its change record on the application service map is marked as approved. For more information about configuring the platform for change validation, see [Managing proposed changes](#).

The type of change mark depends on the nature of changes that it represents:
Light gray balloon (所在地)

Unapproved change that does not influence the application service behavior. For example, a change in a network path or adding a node to a cluster.

Dark gray balloon (所在地)

Unapproved change that changes the application service behavior.

Green balloon (所在地)

An approved change in deployments where the Now Platform is configured to validate changes.

Double balloon (所在地)

Multiple separate changes that happened a short time from each other.

Related information

- Discovery
  - View the change history of application services
  - View the change history of application services in Agent Workspace

Change Management integration with Software Asset Management

The Change Management integration with Software Asset Management (SAM) displays the projected licensing cost implication of a change.

This integration focuses on the projected license cost change when a change is proposed to one or more configuration item (CI) processor resources (CPU or CPU Core) running software licensed by the processor.

This integration requires the Software Asset Management Professional (com.snc.samp) and Change Management - License Change Projections (com.sn_samp_change) plugins.

**Note:** You need to request the activation of the Change management – License Change Projections plugin (com.sn_samp_change) through the HI Service Portal.

When a change request is in the **New** state, users can propose a change to the CPU or CPU Cores of a CI using **Propose Change** or **Mass Update CI**. Those proposed changes are captured in an XML field that is then passed to Software Asset Management when the change request transitions into its first approval.
state. Once Software Asset Management performs the projected licensing cost change, those results are displayed in a new form section called License change projection.

The License change projection form section displays the license projection change summary for every CI in scope for the change. The left side of the section displays fields relaying the current spend, projected spend, the spend change, and the number of impacted installations. On the right is a bar graph providing a visual representation of that information.

For a more detailed breakdown of the license change projections, a related list can be added to the Change Request form called CI Projection Summary. This related list provides a CI-by-CI breakdown of the license change projection summary information and provides easy access to the Software Asset Management CI Project Summary record and additional data.

**Related information**
- Managing proposed changes
- Bulk CI Changes and Mass Update CI
- Software Asset Management

**Change Management integration with Hardware Asset Management**

The Change Management integration with Hardware Asset Management helps in determining the asset action that must be performed on the configuration item (CI) that is associated with a hardware asset. Using this capability, change implementers can quickly update asset records directly from change and the Asset Manager can see current state on all assets that were updated by the change request.

This integration requires the Hardware Asset Management Professional (com.sn_hamp) plugin.

⚠️ **Note:** You must request the activation of the Hardware Asset Management Professional (com.sn_hamp) plugin from the ServiceNow® application store.

When the configuration items listed in the Affected CIs related list have an asset associated, then the **Asset action** field is populated.

You can choose an **Asset action** for the CI, from the Affected CI related list. This **Asset action** field provides three possible actions that can be selected which triggers an event.
• **Deploy**: When this action is selected, the `sn_hamp.asset.deploy` event is triggered.

• **Update/Repair**: No event is triggered for this action.

• **Retire**: When this action is selected, the `sn_hamp.asset.retire` event is triggered.

ℹ️ **Note:** The Asset action column can be added to the Affected CI related list if not already available.

When a change request is in the **Implement** state, the proposed asset action triggers the corresponding event. When the workflow is complete, the asset action updates the asset and the related records and progresses to the **Review** state.

ℹ️ **Note:** If the asset action is not selected, then the change request will not progress to the **Review** state.

For more information, see [Hardware Asset Management](https:// servicenow.com).

**Mobile experience for Change Management**

Manage your change tasks from anywhere using the Mobile Agent app mobile application. With this mobile application, you can stay connected and access the information in real time to complete your tasks.

As an ITSM agent or technician, you can use Mobile Agent app when connected online to accomplish the following task:

• Access the change tasks assigned to you or to your group.

• Add comments or work notes or reassign the change tasks.

• Receive push notifications for change tasks assigned or commented on.

• Approve or reject change requests, requests, and requested items.

Watch this three-minute video to learn about the Mobile Agent app for managing change tasks. This video demonstrates using the ServiceNow Agent mobile app for managing change tasks.

**Configure the Mobile Agent app mobile application**

Access Mobile Agent app on your mobile device to manage your change tasks.

**Before you begin**

Role required: itil or sn_change_write
About this task
The Mobile Agent app mobile application runs on the Studio mobile platform. Activate the ITSM Mobile Experience (com.sn_itsm_mobile) plugin to enable the ITSM mobile application on your device.

Procedure
1. In your mobile device, go to Apple App store if you are on an iOS platform or Google Play Store if you are on an Android platform.
2. Search for ServiceNow Agent.
3. Download and install the ServiceNow Agent application.

Getting started with Change Management mobile tasks
Access Mobile Agent app on your mobile device to manage change tasks.

Before you begin
Download ServiceNow Agent on an iOS platform from the Apple App Store or on an Android platform from Google Play Store. For more information, see Configure the Mobile Agent app mobile application.

Role required: itil or sn_change_write

Procedure
1. Open Mobile Agent app and tap the plus icon (+).
2. Add a ServiceNow instance by tapping the plus icon (+) and then entering the instance address. You do not need to include service-now.com at the end of the instance name.
3. Tap Change tasks to get started with managing your change tasks.

View change tasks
You can view the state, risk, and the schedule of the change tasks in the Mobile Agent app mobile application.

Before you begin
Role required: itil or sn_change_write

Procedure
1. Tap Change tasks to open the list of change tasks.
2. Tap the change task for a detailed view.
3. Tap any field with right arrow to view its details.
Add comments to your change tasks
You can add comments to a change task from the Mobile Agent app mobile application. For example, to add an insight about the change task or a discussion regarding the change task.

Before you begin
Role required: itil or sn_change_write

Procedure
1. Tap Change Tasks to open the list of change tasks.
2. Tap the change task to open the detailed view.
3. Tap Add comment to add your worknotes.

Resolve or close a change task
When you implement the change task, you can close the task from the Mobile Agent app mobile application.

Before you begin
Role required: itil or sn_change_write

Procedure
1. Tap Change tasks to open the list of change tasks.
2. From the list of change tasks, swipe left the change task that you want to close.
3. Tap Close task.

Domain separation and Change Management
Domain separation is supported in Change Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Basic
• Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.

• The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

Overview

Change Management provides a systematic approach to controlling the life cycle of all changes, facilitating beneficial changes with minimum disruption to IT services.

How domain separation works in Change Management

Change management involves the management of change requests. A change request allows you to implement a controlled process for the addition, modification, or removal of approved and supported configuration items (CIs). The request records the detailed information about the change, such as the reason for the change, the priority, the risk, the type of change, and the change category.

• A change request is an extension of a Task. Records are created in the domain of users creating the task they have in session.

• All change properties are global, meaning they are the same for every application that uses the [sys_properties] table properties. The table is not domain separated so any changes made impact all domains.

Domain separated tables

• Change Request [change_request]

Use case

• An ITIL user in the Acme domain logs in and creates a change request. The change request is created in the domain that the user has selected.
How domain separation works in Change Advisory Board (CAB) Workbench

• CAB meetings synchronize with the CAB Definition table if:
  ◦ the meeting was generated via a definition.
  or
  ◦ the meeting was created manually and has the CAB Definition field populated.

• CAB Meetings are created in the domain of the user if:
  ◦ the meeting is created manually without an associated CAB definition.

• Meeting records are not supported if in a different domain from the associated definition.

• All other CAB records have their domain master set to the associated CAB Meeting record.

Domain separated tables

• CAB Definition [cab_definition]
• CAB Meeting [cab_meeting]

Domain master tables (linked to domain of its associated cab_meeting)

• CAB Attendee [cab_attendee]
• CAB Agenda Item [cab_agenda_item]
• CAB Runtime State [cab_runtime_state]

Use cases

• A CAB manager creates a new CAB definition and generates 20 meetings while in the ACME domain. The result: Both the definition and meetings are created within the ACME domain.

• A CAB manager creates an ad-hoc CAB meeting from the related list on the CAB definition form. Result: The meeting is created in the domain of the CAB meeting.

• All other use cases behave in the same way as when domain separation is not enabled.
How domain separation works in Change Schedules (New feature)

- Change Schedule definitions encapsulate all the configuration options and related records used to display a given Change Schedule.
- Records are created in the domain of the current user.
- Ancillary records are created in the domain of the Change Schedule definition.

Domain separated tables

- Change Schedule Definition [chg_soc_definition]
- Related Definition [chg_soc_definition_child]
- Style Rule [chg_soc_definition_style_rule]
- Style Rule [chg_soc_style_rule]
- Style Rule chg_soc_def_child_style_rule]

Use cases

- An ITIL user in the ACME domain logs in and navigates to the Change Schedule landing page. The user can view the Change Schedules in both their current or global domain.

Related information

Domain separation for service providers

Change Management Analytics and Reporting Solutions

Analytics and Reporting Solutions and in-form analytics contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Analytics and Reporting Solutions

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can use Performance Analytics for your application with minimal setup. You can also create your own objects.

Important: Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.
Note: Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure Analytics and Reporting Solutions.

To enable the solutions for Change Management, an admin can navigate to Performance Analytics > Guided Setup. Click Get Started then scroll to the section for Change Management. The guided setup takes you through the entire setup and configuration process.

Inactive dashboards

Some dashboards in this content pack are inactive when installed. Complete configuration and run data collection jobs before you activate these dashboards. You can activate dashboards in Dashboard Properties, accessible from the context menu. You have to assign an owner to the dashboard to activate it. For more information about configuring Analytics and Reporting Solutions, see Configure Analytics and Reporting Solutions

Related information

Analytics and Reporting Solutions
Activate your Performance Analytics subscription

Change Premium dashboard

This dashboard uses Workbench widgets and other advanced Performance Analytics features to give you all the information about the Change process in one place.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Manager - Needs to break down the trends in change request resolution over time to spot areas that need attention</td>
<td>itil</td>
</tr>
</tbody>
</table>

Use case

Indicators

**Number of open changes**

The number of changes open at the end of the collection date. This calculation is the number of changes opened on or before the collection date and not closed by that date.

**Average age of open changes**
[[Summed age of open changes]] / [[Number of open changes]] / 24

**Average re-assignment of open changes**

[[Summed re-assignment of open changes]] / [[Number of open changes]]

**Average age of last update**

The average length of time since the last update made to a change.

**Number of new changes**

The number of new changes with a registration date on the data collection date.

**Change backlog growth**

The number of closed changes subtracted from the number of new changes.

**Number of closed changes**

The number of changes with a close date on the data collection date.

**% of urgent changes**

Percentage of urgent changes. Is a formula: Number of new changes classified as urgent / Number of new changes * 100

**Average close time of changes**

The average length of time in hours between when a change request is opened and closed.

**Average implementation time of closed changes**

The average length of time in hours between when a change request enters the Implementation state and when it is closed.

**Number of reassigned open changes**

The number of changes with a reassignment count of 1 or higher

**Number of unsuccessful changes**

The number of closed changes with a Close Code of "Unsuccessful"

The following indicators are not displayed on the dashboard but are used in formulas:

- Summed age of open changes
- Summed age of updated since of open changes
• Summed duration of closed changes
• Summed implementation time closed changes
• Summed re-assignment of open changes

Breakdowns
• Age
• Category
• Priority
• Risk
• State
• Assignment Group
• Type

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changes Opened Today</td>
<td>Single Score</td>
<td>Number of active changes opened on the day the dashboard is viewed.</td>
</tr>
<tr>
<td>Unassigned Changes</td>
<td>Single Score</td>
<td>Number of active changes that don't have an assignee.</td>
</tr>
<tr>
<td>Overdue Changes</td>
<td>Single Score</td>
<td>Number of changes that are in one of the following states: New, Assess, Authorize, or Scheduled and for which the planned start date is before the current date.</td>
</tr>
<tr>
<td>Changes On Hold</td>
<td>Single Score</td>
<td>Number of changes with the status On hold.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Conflicting Changes</td>
<td>Single Score</td>
<td>Number of changes with the status Conflict.</td>
</tr>
<tr>
<td>Rejected Changes</td>
<td>Single Score</td>
<td>Number of changes for which the approval status is Rejected.</td>
</tr>
<tr>
<td>Open Changes - Grouped</td>
<td>Horizontal Bar</td>
<td>Open changes grouped by Priority</td>
</tr>
<tr>
<td>Upcoming Changes (30 days) - Grouped</td>
<td>Horizontal Bar</td>
<td>Active changes for which the planned start date is in the past 30 days and for which the state is Scheduled.</td>
</tr>
<tr>
<td>Open Changes by Risk and Priority</td>
<td>Heatmap</td>
<td>Active changes sorted by risk on the Y-axis and priority on the X-axis. Cells are highlighted from white for low scores to dark blue for high scores.</td>
</tr>
<tr>
<td>Upcoming Changes (30 days) by Risk and Priority</td>
<td>Heatmap</td>
<td></td>
</tr>
<tr>
<td>Changes Opened per Month by Type</td>
<td>Column</td>
<td>All closed reports opened in the current calendar year. Grouped by type and trended by month opened.</td>
</tr>
<tr>
<td>Closed Changes per Month</td>
<td>Line</td>
<td>Number of closed changes per month expressed on a line chart.</td>
</tr>
</tbody>
</table>
Change Management dashboard

Use this dashboard to see the trends in change request resolution over time across different change request risks, ages, and priorities. Break down change requests over time according to the assignment groups you manage.

![Change Management dashboard](image)

### Basic change indicators

<table>
<thead>
<tr>
<th>Name</th>
<th>Apr 22</th>
<th>Apr 23</th>
<th>Apr 24</th>
<th>Apr 25</th>
<th>Apr 26</th>
<th>Apr 27</th>
<th>Score</th>
<th>Change</th>
<th>Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of open changes</td>
<td>222</td>
<td>203</td>
<td>187</td>
<td>206</td>
<td>211</td>
<td>190</td>
<td>203</td>
<td>18</td>
<td>up</td>
</tr>
<tr>
<td>Number of new changes</td>
<td>18</td>
<td>19</td>
<td>18</td>
<td>16</td>
<td>18</td>
<td>24</td>
<td>34</td>
<td>19</td>
<td>up</td>
</tr>
<tr>
<td>Number of closed changes</td>
<td>24</td>
<td>30</td>
<td>16</td>
<td>26</td>
<td>29</td>
<td>31</td>
<td>30</td>
<td>-1</td>
<td>down</td>
</tr>
<tr>
<td>Change backlog growth</td>
<td>5</td>
<td>10</td>
<td>16</td>
<td>12</td>
<td>17</td>
<td>9</td>
<td>11</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Manager - Needs to break down the trends in change request resolution over time to spot areas that need attention</td>
<td>itil</td>
</tr>
</tbody>
</table>

### Use case

**Change Management dashboard indicators**

**Number of open changes**

The number of changes open at the end of the collection date. The number of changes opened on or before the collection date and no close date or a close date after collection date.

**Number of new changes**
The number of new changes with a registration date on the data collection date.

**Number of new emergency changes**
The number of new changes where type=emergency

**Change backlog growth**
The number of closed changes subtracted from the number of new changes.

**Number of closed changes**
The number of changes with a close date on the data collection date.

**Average age of open changes**
The average amount of time a change has been open.

**% of urgent changes**
Percentage of urgent changes. Is a formula: Number of new changes classified as urgent / Number of new changes * 100

**Average close time of changes**
The average amount of time it has taken to close a change

The following indicators do not appear on the dashboard but are used in formulas:
- Summed age of open changes
- Summed duration of closed changes

**Breakdowns**
- Priority
- Age
- Assignment Group
- Risk
- Stage
- Type

**Open Changes Reports dashboard**
Use this dashboard to get an overview of the current status of open reports.
Open Changes List tab

Open Changes Pivot tab

Open Changes Heatmap
### Open Changes Heatmap tab

- **Open Changes List**
- **Open Changes Pivot**
- **Open Changes Heatmap**

#### Use case

#### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA.Source: Open changes - List</td>
<td>List</td>
<td>A list report of the unclosed changes opened on or before the current date. Columns include Number, Short description, Category, Priority, State, Assignment group and Assigned to.</td>
</tr>
<tr>
<td>PA.Source: Open changes - MPivot - Priority/State/Category</td>
<td>Pivot</td>
<td>Report that shows unclosed changes opened on or before the current date. The visualization shows</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>PA.Source: Open changes - Heatmap - Priority/Category</td>
<td>Heatmap</td>
<td>Heatmap report that shows unclosed changes opened on or before the current date. Larger values are highlighted in darker colors.</td>
</tr>
</tbody>
</table>

**Open Changes State Monitor dashboard**

This workbench dashboard enables you to view and assess all open changes separated into status brackets: New, Assessed, Authorized, Scheduled, Implemented, and Reviewed.

**Open Changes State Monitor tab**

<table>
<thead>
<tr>
<th>Status</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>0</td>
</tr>
<tr>
<td>Assess</td>
<td>3</td>
</tr>
<tr>
<td>Authorize</td>
<td>61</td>
</tr>
<tr>
<td>Scheduled</td>
<td>3</td>
</tr>
<tr>
<td>Implement</td>
<td>0</td>
</tr>
<tr>
<td>Review</td>
<td>0</td>
</tr>
</tbody>
</table>

- **Authorize**
  - Average age: 27
  - Average re-assignment times: 0.02
  - Average age of last update: 23.66

**End user and roles**

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>End user and goal</td>
<td>Required role</td>
<td>Benefits</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------</td>
<td>----------</td>
</tr>
</tbody>
</table>

**Use case**

**Indicators**

**Number of open changes**

The number of changes open at the end of the collection date. This calculation is the number of changes opened on or before the collection date and not closed by that date.

**Average age of open changes**

\[
\frac{\text{Summed age of open changes}}{\text{Number of open changes}} / 24
\]

**Average re-assignment of open changes**

\[
\frac{\text{Summed re-assignment of open changes}}{\text{Number of open changes}}
\]

**Average age of last update**

The average length of time since the last update made to a change.

**Breakdowns**

- Priority
- Risk
- Age
- Assignment Group

**Age of Open Changes Monitor dashboard**

This workbench dashboard enables you to view and assess all open changes separated into age brackets: less than one day, from 1-5 days, from 6-30 days, from 31-90 days, and over 90 days.
### End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Manager - Needs to break down the trends in change request resolution over time to spot areas that need attention</td>
<td>itil</td>
</tr>
</tbody>
</table>

### Use case

#### Indicators

**Number of open changes**

The number of changes open at the end of the collection date. This calculation is the number of changes opened on or before the collection date and not closed by that date.

**Average age of open changes**
Average re-assignment of open changes

\[
\frac{\text{[Summed re-assignment of open changes]}}{\text{[Number of open changes]}}
\]

Average age of last update

The average length of time since the last update made to a change.

Breakdowns

- Priority
- Risk
- Assignment Group
- State

Change Velocity dashboard

Use this dashboard to track the average duration of change requests in the last 30 days.

The Change Velocity dashboard is divided into the following tabs for effective usage. The ServiceNow® Performance Analytics capability in the Change Velocity dashboard provides the following benefits:

- The **Current Pipeline** tab provides insights into current change activity. The **Historical Pipeline** tab provides details on trends and patterns associated with the change management process flow. The **Process KPIs** tab represents a modern set of Change KPIs that are used to evaluate the change process.
The **Process Optimization** tab provides change activity assessments that are based on the state model. This capability is available only with an ITSM Enterprise subscription. For more information, see **Process Optimization**.

**End user and roles**

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change manager - Monitors the success and velocity of change request in the organization at the</td>
<td>change_manager</td>
</tr>
<tr>
<td>End user and goal</td>
<td>Required role</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>organization, team, and individual level.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** To access the Process Optimization tab, the change manager must be part of the Change Assignment group.

### Change Velocity dashboard indicators

#### Change Velocity

Average amount of time that changes have been waiting for approval in the last 30 days. To generate this data on the dashboard, you must run the Change velocity historical data collection job. For information on how to run this job see, Collect historical data.

#### Top Change Success Performers

Performance of assignment groups in processing the change request with the highest performer on the top. For information on how the performance score is calculated, see Success Score Calculation.

#### Average age of open changes

Average amount of time that the change request has been open.

#### Average close time of changes

Average amount of time that it has taken to close the change request.

#### Average implementation time of closed changes

Average amount of time between the start and close date of the change request.

### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Awaiting Cab Approval</td>
<td>Single score (42)</td>
<td>Number of changes awaiting CAB approval.</td>
</tr>
<tr>
<td>High Risk Changes</td>
<td>Single score (42)</td>
<td>Number of high risk changes starting today.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Awaiting Approvals</td>
<td>Single score (42)</td>
<td>Number of changes awaiting approval.</td>
</tr>
<tr>
<td>Model Breakdown</td>
<td>Pie ( )</td>
<td>Changes categorized based on the change model over the last 30 days.</td>
</tr>
<tr>
<td>Type Breakdown</td>
<td>Pie ( )</td>
<td>Changes categorized based on the change type in the last 30 days.</td>
</tr>
<tr>
<td>Open Changes by Category</td>
<td>Pie ( )</td>
<td>Number of open changes from each category.</td>
</tr>
<tr>
<td>Change Pipeline</td>
<td>Vertical bar ( )</td>
<td>Number of changes categorized based on their state.</td>
</tr>
<tr>
<td>Change Success</td>
<td>Pie ( )</td>
<td>Number of changes categorized based on their close code over the last 30 days.</td>
</tr>
<tr>
<td>Change Risk</td>
<td>Vertical bar ( )</td>
<td>Number of changes categorized based on the risk values.</td>
</tr>
<tr>
<td>High Risk Change List</td>
<td>List ( )</td>
<td>List of high risk changes starting today.</td>
</tr>
<tr>
<td>Highest Change Activity</td>
<td>Line ( )</td>
<td>Top 10 configuration items associated with changes in the last 3 months.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change Success</td>
<td>Line (        )</td>
<td>Changes that are successful, unsuccessful, and successful with issues expressed on a line chart.</td>
</tr>
<tr>
<td>Change Risk</td>
<td>Line (        )</td>
<td>Changes categorized based on the severity of risk.</td>
</tr>
<tr>
<td>Change Volume</td>
<td>Line (        )</td>
<td>Volume of changes in the last 6 months.</td>
</tr>
<tr>
<td>Unsuccessful Changes</td>
<td>List (        )</td>
<td>Number of unsuccessful changes in the last 7 days.</td>
</tr>
<tr>
<td>Emergency Changes</td>
<td>Line (        )</td>
<td>Number of emergency changes over the last 90 days.</td>
</tr>
<tr>
<td>Change Related Incidents</td>
<td>Line (        )</td>
<td>Number of closed incidents in last 90 days where they have related changes.</td>
</tr>
<tr>
<td>Unauthorized Changes</td>
<td>Line (        )</td>
<td>Number of unauthorized changes over the last 90 days.</td>
</tr>
<tr>
<td>Active Changes &gt; 7 days</td>
<td>Single score ( )</td>
<td>Number of active changes that were created more than seven days ago.</td>
</tr>
</tbody>
</table>

**Change Management troubleshooting properties**

Use the Change Management troubleshooting properties and change the value of the properties to get additional logging details for the feature.

The following properties are available for further configuration. To list them, enter `sys_properties.list` in the navigator text box.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>change.conflict.log</td>
<td>The logging property that controls logging level displayed for Change Management while detecting the change conflicts.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: notice</td>
</tr>
<tr>
<td>com.snc.change_management.cab.log</td>
<td>The logging property that controls the logging level displayed for Change Management when using the CAB functionality.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: info</td>
</tr>
<tr>
<td>com.snc.change_management.core.log</td>
<td>The logging property that controls level logging displayed for Change Management.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
<tr>
<td></td>
<td>• Default value: warn</td>
</tr>
<tr>
<td>com.snc.change_management.policy.approval.log</td>
<td>The debug logging property that provides the detailed logging information of the workflow activity when using Change Approval Policies.</td>
</tr>
<tr>
<td></td>
<td>• Type: choice list</td>
</tr>
</tbody>
</table>

**Quick start tests for Change Management**

Validate that Change Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.
Change Management quick start tests require activating the Change Management - ATF Tests plugin (com.snc.change_management.atf).

### CHG: Emergency Type Change Request test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency Type Change Request workflow</td>
<td>Process an emergency change request from new to closed.</td>
<td>Madrid</td>
</tr>
<tr>
<td>On Hold for Emergency type Change Request</td>
<td>Validate the approval state of an on-hold emergency change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Copy Change For Emergency type Change Request</td>
<td>Validate the state of a copied emergency change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Reject By Approver for Emergency type</td>
<td>Validate the state of a rejected emergency change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Revert to new for emergency type</td>
<td>Validate the state of an emergency change request after using the Revert to new UI action.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Convert Emergency to Normal type</td>
<td>Validate the conversion of an emergency change request to a normal change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Cancel Change Request For Emergency Type</td>
<td>Validate the state of a canceled emergency change request.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

### CHG: Normal Type Change Request test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Type Change Request Workflow</td>
<td>Process a normal change request from new to closed.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>
### CHG: Normal Type Change Request test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert Normal to Emergency type</td>
<td>Validate the conversion of a normal change request to an emergency change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Copy change on Normal Change Request</td>
<td>Validate the state of a copied normal change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>On hold for Normal type Change Request</td>
<td>Validate the approval state of an on-hold normal change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>State validation when Reject Normal type Change request by Approver.</td>
<td>Validate the state of a rejected normal change request.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Revert to New Functionality for Normal Type Change Request</td>
<td>Validate the state of a normal change request after using the Revert to new UI action.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Cancel Change Request For Normal type</td>
<td>Validate the state of a canceled normal change request.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

### CHG: Standard Change Proposal test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Change Proposal</td>
<td>Determine whether a user can successfully perform standard change proposal creation, approval, and template publishing processes.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

### CHG: Standard Type Change Request test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Change Request Workflow</td>
<td>Process a standard change request from new to closed.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Convert Standard to Emergency Change Request</td>
<td>Validate the conversion of a standard change request to an emergency change request.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>
### CHG: Standard Type Change Request test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert Standard to Normal Change Request</td>
<td>Validate the conversion of a standard change request to a normal change request.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

### CHG: Unauthorized Change Request and Outage test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unauthorized change request Workflow</td>
<td>Process a unauthorized change request from new to closed.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Create Outage of type planned outage from change request</td>
<td>Validate the creation of an outage of type planned outage from a change request.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Create Outage of type outage from change request</td>
<td>Validate the creation of an outage of type outage from a change request.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

### CHG: Risk Conditions with Best practice plugin test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moderate Risk with UI Action Property</td>
<td>Process a moderate risk with UI action property.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Low Risk with UI Action Property</td>
<td>Process a low risk with UI action property.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Leave Alone Risk with UI Action Property</td>
<td>Process a leave alone risk with UI action property.</td>
<td>Orlando</td>
</tr>
<tr>
<td>High Risk with UI Action Property</td>
<td>Process a high risk with UI action property.</td>
<td>Orlando</td>
</tr>
<tr>
<td>High Risk with Business Rule Property</td>
<td>Process a high risk with Business rule property.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Moderate Risk with Business Rule property</td>
<td>Process a moderate risk with Business rule property.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
CHG: Change Request against Conflict Sources test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change against Blackout window</td>
<td>Process a change request against a blackout window.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Check conflicts for CI Already Scheduled</td>
<td>Validate the conflicts for CI already scheduled.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Change against Conflict Sources</td>
<td>Validate the change request against conflict sources.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

CHG: Change Schedule Definition and Sharing test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Schedules Definitions on New</td>
<td>Process the creation of change schedules definitions from New button on Change Schedules landing page.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Share Panel On Change Schedules Definition</td>
<td>Validate the share panel on change schedules definition.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Share Change Schedule Definition</td>
<td>Validate the sharing of change schedules definitions.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Create Standard Change via Service Portal</td>
<td>Create Standard Change from Service Portal</td>
<td>Rome</td>
</tr>
</tbody>
</table>

Related information

Quick start tests

Coaching

The ServiceNow® Coaching application lets you facilitate the coaching of employees using coaching opportunities that you can configure for a critical moment in a process.

Coaching consistently improves employee performance and processes by providing real-time improvement feedback as well as automated contextual recommendations.
This 26-minute podcast includes a discussion of the Coaching application, the coaching process, virtual coaching, and building coaching into a workflow.

Podcast discussion of the Coaching application, the coaching process, and how the application can be used in an organization

When a coaching opportunity is triggered, an assessment is generated for a trainee. The coaching assessment then is assigned to a coach for training or, if the virtual coaching conditions are met, training content is automatically assigned to the trainee.

Coaching can be applied to any task-based process, such as Change Management, Customer Service Management or Incident Management. A non-task or custom table source can also be used for coaching, but you must configure a business rule.

To gain a general understanding of the application and how it is used, see Coaching overview.

Start coaching

To coach users to improve processes in your environment, select an activity.

1. Define a coaching moment
2. Assess a trainee
3. Work with your coach

Understand Coaching concepts

• Coaching overview
• Setting up Coaching and surveys
• Coaching your trainee
• Managing your coaching assessments
• Domain separation and Coaching
Get help from ServiceNow resources

- Ask or answer questions in the Coaching forum
- Search the Known Error Portal for known error articles
- Contact Customer Service and Support

Request Coaching

The Coaching (com.sn_coaching) plugin requires a separate subscription and must be activated by ServiceNow personnel.

Before you begin
Role required: admin

About this task
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Coaching plugins

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching (com.sn_coaching)</td>
<td>Activates the Coaching application. This plugin includes demo data and activates related plugins if they are not already active. The Coaching application is available with the ITSM Professional subscription only. Please contact your account manager for more information.</td>
</tr>
<tr>
<td>Coaching with Learning (sn_coach_lrn)</td>
<td>Activates the Coaching with Learning application and enables you to integrate the Learning module with the Coaching application.</td>
</tr>
<tr>
<td><img src="https://example.com" alt="Note" /> This is a ServiceNow Store plugin. You must install this plugin separately from the ServiceNow Store.</td>
<td></td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

---

## Coaching roles

Assign Coaching roles to specify what different users can see and do.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Roles inherited</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_coaching.trainee</td>
<td>Able to view coaching assessments to which they belong.</td>
<td>• skill_user</td>
</tr>
<tr>
<td>[Coaching trainee]</td>
<td>Able to add work notes in a coaching assessment by clicking Review Assessments.</td>
<td>• survey_reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_viewer</td>
</tr>
<tr>
<td>sn_coaching.coach</td>
<td>Able to read and write coaching assessments assigned to the coach group to which they belong.</td>
<td>• sn_coaching.trainee</td>
</tr>
<tr>
<td>[Coaching coach]</td>
<td>Able to assign a training and virtual coaches to a coaching opportunity.</td>
<td>• pa_viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_coaching.admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• survey_admin</td>
</tr>
</tbody>
</table>

**Note:** The Coaching coach is not able to create a new coaching opportunity.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Roles inherited</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_coaching.admin</td>
<td>Able to perform all functions.</td>
<td>• sn_coaching.coach</td>
</tr>
<tr>
<td>[Coaching admin]</td>
<td></td>
<td>• survey_admin</td>
</tr>
</tbody>
</table>
### Role Table

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Roles Inherited</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learning catalog group manager</td>
<td>Grants administrative rights to create, read, update learning catalogs based on groups.</td>
<td>• sn_lc.catalog_group_manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_lc.task_creator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_lc.content_writer</td>
</tr>
</tbody>
</table>

### Coaching overview

After you enable Coaching, you can set up roles and groups, define coaching opportunities, create training material, and start assessing and coaching employees. The Coach and Trainee dashboards provide useful overviews to manage and measure results.

#### Initial Coaching setup

Once you have enabled Coaching, set up the application by assigning user roles, configuring coaching opportunities and creating training content.

1. Set up Coaching roles and groups
2. Define trigger conditions for a coaching opportunity
3. Identify learning content and a virtual coach
4. Set up surveys

#### Workflow of Coaching roles

An employee with the Coaching trainee role is in need of coaching at a critical moment in a process.

An administrator with the Coaching admin role is in charge of setting up coaching opportunities, learning content, virtual coaches, and surveys used in the coaching process.

A manager, or coach, with the Coaching coach role is a subject matter expert of a process and is responsible for providing coaching to an employee, or trainee.

#### Coaching dashboards

Use Coaching dashboards to manage and measure results in a simplified view.

- Coaching Dashboard
- Trainee Dashboard
Identifying coaching opportunities
Coaching opportunities can be found in many tasks that occur throughout your environment.

- Writing better work notes when service desk escalates incidents to a second level.
- Correctly setting affected configuration items when the service desk works on incidents.
- Using the correct naming convention for admin in update sets.
- Coaching during the onboarding and the warranty period of a new application.
- Correctly reassigning a case to another user with pertinent information in comments.
- Engaging a user on closed records when non-positive feedback is received through surveys.
- Spot-checking a user on quality control.
- Helping to guide project managers in projects.
- Improving knowledge article quality when knowledge articles are attached to resolved incidents.

Common ITSM assessment triggers
You can define activities that occur when trainees work through an ITSM process, such as resolving an incident, as assessment triggers.

<table>
<thead>
<tr>
<th>Table</th>
<th>Assessment triggers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>Moment of first response</td>
</tr>
<tr>
<td></td>
<td>Categorization and prioritization</td>
</tr>
<tr>
<td></td>
<td>Reassignment</td>
</tr>
<tr>
<td></td>
<td>Proposal of solution to the customer</td>
</tr>
<tr>
<td>Problem</td>
<td>Definition of the Problem statement</td>
</tr>
<tr>
<td></td>
<td>Writing the Known Error</td>
</tr>
<tr>
<td></td>
<td>Writing the Workaround</td>
</tr>
<tr>
<td></td>
<td>Root Cause analysis</td>
</tr>
<tr>
<td></td>
<td>Root Cause confirmation</td>
</tr>
</tbody>
</table>
### Integration with other applications

Coaching opportunities, coaching assessments, and assigned training in Coaching are integrated with these applications.

- **Continual Improvement Management (CIM)**
  
  One example of a coaching opportunity with CIM would be to use improvement initiatives to set up external training tasks.

  - **Note:** The Continual Improvement Management (com.sn_cim) plugin must be active to create an improvement initiative. Continual Improvement Management requires a separate subscription and must be activated by ServiceNow personnel.

- **Skills Management**

  In a coaching assessment, you can assess trainee skills to identify gaps so the trainee can be coached to acquire new skills or to enhance their existing skill level.

- **Knowledge Management**

  You can assign knowledge articles as assigned training.

### Domain separation and Coaching

Domain separation is supported in Coaching. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Basic**
• Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.

• The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

Overview

All tables including Coaching Opportunity, Coaching Assessment, Virtual Coach, and Trainings support domain separation so the coach and Coaching admin can view records within the (tenant) domain to which they belong.

How domain separation works in Coaching

Domain separation is supported in Coaching with no setup or configuration required. You can create coaching opportunities and coaching assessments in separate domains, including the global domain.

Coaching assessments extend the platform Task [task] table.

When domain separation is implemented, coach and trainee users can view coaching assessments and trainings only in the domain assigned. The Domain and Domain Path columns are available for coaching opportunities, coaching assessments, virtual coaching, and trainings provided with the base system.

The Domain column contains the name of the domain to which the event or alert belongs, and the Domain Path column contains the unique domain identifier.

Note: If the domain column is not shown, click the Update Personalized List icon and add the required column. You can also add the domain path column, if desired.

Domain-separated tables

• Coaching Assessment [sn_coaching_assessment]
• Coaching Opportunity [sn_coaching_opportunity]
• Trainings [sn_coaching_recommendation]
• Assigned Training [sn_coaching_assessment_recommended_learning]
• Assigned Training [sn_coaching_opportunity_recommended_learning]
• Virtual Coach [sn_coaching_opportunity_virtual_coach_m2m]
• Virtual Coaching [sn_coaching_virtual_coach]

Use cases
• A Coaching admin that belongs to a parent domain creates a coaching opportunity at a parent domain level or at a child domain level. Coaching opportunities created at a parent level are available to view in all domains.
• A Coaching admin has access to multiple domains but wants to update content in a record within a specific domain. The domain specified in the record drives the functionality of that record and reference fields.
• A Coaching user that belongs to the Acme domain can view the coaching assessment task created in the Acme domain.
• A Coaching user wants to associate an assigned training for an integrated application in the Acme domain. The user must belong to the domain of the integrated application from which a record is associated.
• The trainee user of a parent domain can view a coaching assessment of the parent as well as of all child domains of that parent. A trainee user must belong to the Acme domain, its parent domain, or the global domain to view that coaching assessment.

Related information

Domain separation for service providers

Setting up Coaching and surveys
To take full advantage of Coaching, configure the Coaching application and set up surveys.

Setting up Coaching
Configure Coaching to start assessing and coaching trainees.
1. Set up Coaching roles and groups to identify Coaching users, coaches, and admins.
3. Identify training content that is provided as part of a training or virtual coaching.
4. Configure virtual coaches to add to a coaching opportunity.
5. Set up surveys to provide feedback on the coaching experience so you can make improvements.

**Setting up surveys**
You can obtain feedback for both the coach and the trainee by creating surveys that are accessed from a Coaching Assessment form that has been resolved or closed.

- Survey taken by trainee to provide feedback on the coach
- Survey taken by coach to provide feedback on the trainee

Access the Survey designer for Coaching by navigating to **Survey > Survey Designer**.
Access the Coaching Survey definitions by navigating to **Coaching > Coaching Surveys**.

**Coaching Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_coaching.kb_article_duration</td>
<td>Number of days to read the knowledge article. The admin (sn_wfo.admin) sets the number of days for the trainee to complete reading the article. The number of days is converted to the due date for the trainee to complete the training. It is calculated from the current date taking the trainee's time zone into consideration.</td>
</tr>
<tr>
<td>sn_coaching.exclude_weekends_on_training</td>
<td>Exclude weekends when the due date is set for trainees to complete training.</td>
</tr>
</tbody>
</table>
Define trigger conditions for a coaching opportunity

Use the Coaching Opportunity form to define a critical moment in a process on which a user can be coached. A coaching opportunity consists of the relationship between a process that can be improved, and coaches and trainees.

Before you begin
Role required: sn_coaching.admin

About this task
When the triggered conditions defined in a coaching opportunity are met, an assessment for that trainee is generated. The coaching assessment is then assigned to a coach for training, or is completed using automated virtual learning content.

You can add assigned trainings and virtual coach items to the related lists, if applicable, to complete the coaching opportunity.

You can create an improvement initiative in the Continual Improvement Management (CIM) application to set up external training tasks, for example, using the Create Improvement Initiative related link.

Note: The Continual Improvement Management (com.sn_cim) plugin must be active to create an improvement initiative. Continual Improvement Management requires a separate subscription and must be activated by a ServiceNow personnel.
Procedure

1. To create a coaching opportunity:

<table>
<thead>
<tr>
<th>Using</th>
<th>Do th</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guided setup</td>
<td>a. Navigate to Continual Improvement &gt; Administration &gt; Guided Setup.</td>
</tr>
<tr>
<td></td>
<td>b. Go to the Add a Coaching Opportunity section and click Configure.</td>
</tr>
<tr>
<td>Application navigator</td>
<td>Navigate to Coaching &gt; Coaching Opportunities.</td>
</tr>
</tbody>
</table>

2. Click New.

3. Fill in the fields on the Coaching Opportunity form.

   a. Select the table that contains the field for coaching in the Table field.

   b. Select the Trainee field from the source table.

   c. To limit the trainees for which a coaching assessment is generated, select a specific Trainee group.

   d. Select a coach or a group of coaches to assess and provide feedback to trainee assessments generated from this coaching opportunity.

      • To select a coach group, from the Coach group field, select the group of coaches.

      • To select the assignment group manager as the coach for the selected task record, enable the Specify coach user check box and select the coach user from the selected table.

   e. Add the condition for the critical moment in the Trigger fields.

      See Common ITSM assessment triggers for examples.

4. Fill in the fields in the Snapshot Settings tab.

   a. Select the Snapshot fields that contain the values to capture in the coaching assessment when an assessment is triggered.

   b. To use an advanced script, select the Advanced check box and add your script.

      See Scripts for more information on scripting.
5. Fill in the fields in the Frequency tab.

a. To limit the number of coaching assessments generated, set the Random sample (%) to a percentage of the total number. If you reduce the random sample size, you can prevent certain trainees from being excluded by specifying Users who should be coached on every opportunity. For example, you may want new employees to be coached every time.

b. Specify the Assessment duration after which the coaching assessment is set to Closed Complete state. You can disable automatic closure behavior by deactivating the close assessments after expiration scheduled job.

c. To Prevent duplicate assessments from being created for a trainee for the same coaching opportunity within a certain time period, select the check box. Specify the Time period within which duplicate assessments are not created.

6. Fill in the fields in the Surveys tab.

a. To select feedback surveys taken by trainees and coaches when the coaching assessment is in Resolved state, select a Survey taken by Coach and a Survey taken by Trainee.

7. Fill in the fields in the Related KPIs tab.

a. Select the primary KPI improved by the coaching opportunity in the Improvement KPI field.

b. Select the Strategic objective affected by the coaching opportunity in the Strategic objective field.

ℹ️ Note: You can set strategic objectives by navigating to Continual Improvement > Strategy Objectives.

**Example:** Coaching admin defines a trigger condition

<table>
<thead>
<tr>
<th>Coaching Opportunity form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Number</td>
</tr>
</tbody>
</table>
Coaching Opportunity form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Incident Process: Coaching on Incident Reassignment</td>
</tr>
<tr>
<td>Description</td>
<td>Coach a user on the reassignment process of an incident, including adding comments, CI, and category.</td>
</tr>
<tr>
<td>Table</td>
<td>Incident [incident]</td>
</tr>
<tr>
<td>Trainee</td>
<td>Assigned to</td>
</tr>
<tr>
<td>Trainee group</td>
<td>Trainee group</td>
</tr>
<tr>
<td>Coach group</td>
<td>Coach Group</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
<tr>
<td>Trigger</td>
<td>Option: Assigned to</td>
</tr>
<tr>
<td></td>
<td>Operator: changes</td>
</tr>
</tbody>
</table>

Coaching Opportunity tabs

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td></td>
</tr>
<tr>
<td>Random sample (%)</td>
<td>100</td>
</tr>
<tr>
<td>Assessment duration</td>
<td>5 days</td>
</tr>
<tr>
<td>Surveys</td>
<td></td>
</tr>
<tr>
<td>Survey taken by Coach</td>
<td>Trainee Assessment Survey (provided by coach)</td>
</tr>
<tr>
<td>Survey taken by Trainee</td>
<td>Coach Effectiveness Survey (provided by trainee)</td>
</tr>
<tr>
<td>Related KPIs</td>
<td></td>
</tr>
<tr>
<td>Improvement KPI</td>
<td>Number of reassigned open incidents</td>
</tr>
<tr>
<td>Strategic objective</td>
<td>Retrofit Staffing to include more global logistics</td>
</tr>
<tr>
<td>Snapshot Settings</td>
<td></td>
</tr>
</tbody>
</table>
Coaching Opportunity tabs (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snapshot fields</td>
<td>Resolution code, Resolution notes, Work notes</td>
</tr>
</tbody>
</table>

Related reference

Coaching field descriptions

Identify and associate training content with a virtual coach

Set virtual training conditions, containing training content, for automated coaching. Virtual training content is automatically attached to a coaching assessment when triggered.

Before you begin
Role required: sn_coaching.admin

About this task
Typical assigned training content includes micro trainings, best practices, tips, knowledge articles, videos, and community links.

You can access trainings by navigating to Coaching > Virtual Coach > Trainings.

Procedure
1. Navigate to Coaching > Virtual Coach > All and click New to create a record.
2. Select the Table from which a coaching opportunity is generating assessments.
3. Assign a training as the training content for the virtual coaching record.
   a. In the Training field, click the search icon and create a new record.
      You can also access trainings by navigating to Coaching > Virtual Coach > Trainings navigation module.
   b. Select the Learning category for reporting purposes.
   c. Add the training Content, which can include a message, a link, a video, or source code.
      Training content automatically is attached to the coaching assessment when the virtual coaching record conditions are met.
4. To use an advanced script, select the Advanced check box and add your script.
See **Scripts** for more information on scripting.

5. Add the condition that triggers the virtual coaching in the **Condition** field.
6. To set field values automatically, select **Autofill fields** and enter values.

**Example: Coaching admin sets up learning content**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CVC0000106</td>
</tr>
<tr>
<td>Short Description</td>
<td>Virtual Coach for the Incident Process</td>
</tr>
<tr>
<td>Table</td>
<td>Incident [Incident]</td>
</tr>
<tr>
<td>Training</td>
<td>CR0000106</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
<tr>
<td>Advanced</td>
<td>Cleared</td>
</tr>
<tr>
<td>Condition</td>
<td>• Assigned to changes</td>
</tr>
<tr>
<td></td>
<td>• Configuration item is empty</td>
</tr>
<tr>
<td>Autofill fields</td>
<td>• State Resolved</td>
</tr>
<tr>
<td></td>
<td>• Performance rating N/A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CR0000106</td>
</tr>
<tr>
<td>Title</td>
<td>Increase customer satisfaction by solving issues faster</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
<tr>
<td>Category</td>
<td>Customer Experience</td>
</tr>
<tr>
<td>Content</td>
<td>Watch this video to increase customer satisfaction by solving issues faster.</td>
</tr>
</tbody>
</table>

**Related reference**

Coaching field descriptions
Coaching your trainee

A manager, or coach, is a subject matter expert of a process and is responsible for providing coaching to an employee, or trainee. Use the Coach Dashboard to manage and measure the effectiveness of your coaching.

You can access the Coaching Dashboard from the Coaching navigation menu, or directly from the dashboard list. Click a report to view the detailed data.

⚠️ Note: You must have the Coaching coach role to view the Coach Dashboard.

Coaching begins once a trainee assessment has been assigned to you. Coaching assessments are triggered from a coaching opportunity that is set up by the coaching admin. Use coaching assessments to facilitate a dialog with your trainee, assign training content, and set a due date and other details.

The Coach Dashboard lets you manage the details and effect your coaching has on your trainees.

• Check the progress state of your coaching assessments.
• Analyze the number and types of follow-up actions necessary on your resolved coaching assessments.
• View the types of survey feedback from your trainees.
• View the number of your assessments that were resolved by the virtual coach.
• Check the performance rating of your trainees from your coaching.
• View the list of KPIs affected by your coaching.
• Verify the types of coaching opportunities that are being assigned to you (last 6 months).
Report Description

My Active Coaching Assessments Coaching assessments assigned to you that are in New, Work in Progress, and Resolved states.

Follow-up Action Needed Coaching assessments grouped by Followup Needed field.
- Recognize
- Needs Additional Coaching
- Needs Outside Training
- Referral to Manager
- Create Virtual Coach
- No Follow Up

My Coaching Survey Results Feedback results on coaching from trainees.

Resolved by Virtual Coach Coaching assessments resolved by virtual coaching.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Assess a trainee

Use a coaching assessment to review the work of a trainee and to provide training and feedback.

Before you begin
Role required: sn_coaching.coach

About this task
A trainee can view any field on the coaching assessment form and add comments to the Work notes field. A trainee can submit feedback for a coach using a survey when a coaching assessment is in resolved, closed complete, or closed incomplete state.

When an assessment is generated, all users in the Coach group receive a notification. Assessments are generated automatically (as the result of a coaching opportunity) or created manually. You can provide feedback for your trainees using a survey at any time during the coaching assessment.

You can create a coaching assessment from incidents, problems, change requests, or any other table that extends the task table. Enable the display of the Create Coaching Assessment button and create your assessments using that button. To enable display of the button:

• Configure the UI actions on the record.

• In the sn_coaching.CoachingExtensionPoint extension point, make sure the getCreateAssessmentUITables method is implemented to return the name of the tables.

Procedure
1. Navigate to Coaching > Coaching Assessment and select a coaching assessment in the Open state.

You can take a survey using the Start Survey button to provide feedback for the trainee at any point during the assessment. After you complete the survey, the score is calculated using the Calculate coaching survey score business
rule and is automatically populated in the Trainee Rating field. The trainee rating generates an assessment rating that is populated in the Assessment Rating field.

Note: Surveys are not available for assessments that are created manually.

2. Fill in the fields on the Coaching Assessment form.

a. Verify the Coach group, which is obtained from the coaching opportunity, is accurate.

b. Set the coaching assessment Coach field to a coach.

c. Set the Due date, after which time the coaching assessment is set to Closed Incomplete state. Use system properties to set due dates to complete training. For more information, refer to Coaching Properties. You can disable automatic closure behavior by deactivating the Close assessments after expiration scheduled job.

3. Fill in the fields in the Notes tab.

a. Add a Description to the coaching assessment.

b. Add Work notes to facilitate a dialog with the trainee.

4. Review the Snapshot content in the Snapshot tab and add your feedback in the Notes field.

5. Fill in the fields in the Feedback tab.

a. Set the Assessment rating based on the coaching experience. When you submit feedback for a trainee, the score in the Trainee Rating field, which is based on a scale of 1-10 is converted to a rating such as good or excellent. This rating displays in the Assessment rating field.

b. Set the Follow up action as part of coaching.

6. Review the skills applicable to the trainee in the Trainee Skillset related list. See Skills Management for more information.

7. Add assigned training content in the Assigned Trainings related list.

8. Review survey feedback for the trainee in the Survey Results related list.

9. When coaching is finished:
a. Add a **Summary** of the coaching experience as an overview of your assessment.

b. Set the coaching assessment to **Resolved**.

**Example: Coach assesses trainee**

Coaching Assessment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CAS0001004</td>
</tr>
<tr>
<td>Trainee</td>
<td>Trainee User 2</td>
</tr>
<tr>
<td>Record</td>
<td>Incident: INC0000055</td>
</tr>
<tr>
<td>Opportunity</td>
<td>COP0000109</td>
</tr>
<tr>
<td>State</td>
<td>Work in Progress</td>
</tr>
<tr>
<td>Coach group</td>
<td>Coach Group</td>
</tr>
<tr>
<td>Coach</td>
<td>Coach User 1</td>
</tr>
<tr>
<td>Due date</td>
<td>2018-10-25 05:18:59</td>
</tr>
</tbody>
</table>

Coaching Assessment tabs

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information for Review</td>
<td></td>
</tr>
<tr>
<td>Snapshot</td>
<td>• Configuration item: SAP Human Resources</td>
</tr>
<tr>
<td></td>
<td>• Additional comments:</td>
</tr>
<tr>
<td></td>
<td>2018-06-23 21:45:04 - ITIL User (Additional comments)</td>
</tr>
<tr>
<td></td>
<td>The SAP Human Resources application is not accessible.</td>
</tr>
<tr>
<td></td>
<td>• Work notes:</td>
</tr>
<tr>
<td></td>
<td>2018-06-23 21:45:04 - ITIL User (Work notes)</td>
</tr>
<tr>
<td></td>
<td>I cannot access this application so we may have an outage.</td>
</tr>
</tbody>
</table>
Coaching Assessment tabs (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feedback Rating</td>
<td>Excellent</td>
</tr>
<tr>
<td>Assessment rating</td>
<td>Recognize</td>
</tr>
<tr>
<td>Follow up</td>
<td>Recognize</td>
</tr>
<tr>
<td>Summary</td>
<td>Trainee showed great interest in learning the trainings and finished them ahead of due date.</td>
</tr>
</tbody>
</table>

Related reference

Coaching field descriptions

Assign skills after completing an assessment

Automatically assign skills to trainees for specific skill levels based on the training they have completed. For example, if a trainee completes training for learning Japanese at an expert level, then the skill level 'expert' can be assigned to the trainee.

Before you begin

Role required: sn_coaching.coach and sn_coaching.admin

About this task

You can associate skills with coaching opportunities, coaching assessments, or trainings. When a trainee completes a coaching assessment, you can automatically assign the skill the trainee has acquired during that coaching opportunity.

The coaching assessments generated from coaching opportunities award the skills to the trainee after the assessment is complete. If the assessment is configured to include assigned trainings, the skills associated with trainings are also added to the assessments.

Procedure

1. Perform any of the following actions:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associate skills with coaching opportunities</td>
<td>a. Navigate to Coaching &gt; Coaching Opportunities.</td>
</tr>
<tr>
<td></td>
<td>b. Select the record for which you want to associate a skill and skill level.</td>
</tr>
</tbody>
</table>
### Associate skills with coaching assessments

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>c. In the <strong>Skills Awarded on Assessment Completion</strong> related list, click <strong>New</strong>.</td>
<td></td>
</tr>
<tr>
<td>d. In the <strong>Skill</strong> field, click the lookup icon and select the skill to associate with this opportunity.</td>
<td></td>
</tr>
<tr>
<td>e. In the <strong>Skill level</strong> field, click the lookup icon and select the skill level for this opportunity.</td>
<td></td>
</tr>
</tbody>
</table>

| a. Navigate to **Coaching > Coaching Assessments** |
| b. Select the record for which you want to associate a skill and skill level. |
| c. In the **Skills Awarded by Assessment** related list, click **New**. |
| d. In the **Skill** field, click the lookup icon and select the skill to associate with this assessment. |
| e. In the **Skill level** field, click the lookup icon and select the skill level for this assessment. When the assessment is complete, the skill is automatically added for the trainee. |

### Associate skills with trainings

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>c. In the <strong>Skills Awarded on Assessment Completion</strong> related list, click <strong>New</strong>.</td>
<td></td>
</tr>
<tr>
<td>d. In the <strong>Skill</strong> field, click the lookup icon and select the skill to associate with this opportunity.</td>
<td></td>
</tr>
<tr>
<td>e. In the <strong>Skill level</strong> field, click the lookup icon and select the skill level for this opportunity.</td>
<td></td>
</tr>
</tbody>
</table>

| a. Navigate to **Coaching > Trainings** |
| b. Select the record for which you want to associate a skill and skill level. |
| c. In the **Skills Awarded on Assessment Completion** related list, click **New**. |
| d. In the **Skill** field, click the lookup icon and select the skill to associate with this training. |
| e. In the **Skill level** field, click the lookup icon and select the skill level for this training. |

2. **Click Submit.**

You can navigate to the **All Awarded Skills** related list in a **Coaching Assessments** record for a trainee to view all skills to be awarded for that trainee. The **Source** field displays whether the award came from an opportunity, assessment, or training.
Training your agents using Coaching With Learning

Use Coaching with Learning to train your agents with internal and external learning content. Organize similar content in catalogs. Assign learning tasks and track completion.

Important: Coaching With Learning is available when you enable the Coaching With Learning application from the ServiceNow® Store. To enable this application, see Request Coaching.

Organize related learning content

Create a catalog to organize related content into categories.

Before you begin

Role required: sn_lc.catalog_manager

Procedure

1. Navigate to Learning > Content > Learning Catalogs.
2. Create a catalog.
   a. Click New.
   b. In the Name field, enter a unique name for the catalog.
   c. In the Description field, enter a description for the catalog.
   d. Click Save.
   
   Note: The catalog is visible to all groups that you directly or additionally manage.
3. Add course items to the catalog.
   a. Click the Content related list.
   b. Click Add.
   c. In the Add Learning Courses pop-up window, select all course items you want to add to the catalog.
   d. Click Add. The course items are added to the catalog.
   
   Note: To remove any course item you have added, select the course item and click Remove.
4. Add a group to a catalog.
a. Click the **Applicable Groups** related list.
b. Click **New**.
c. In the **Group** field, select a group that you want to associate with the catalog.
d. Click **Save**.

**Add internal learning content**

Add internal courses so that agents can learn new content and enhance their skills set.

**Before you begin**
Role required: sn_lc.content_creator

**Procedure**

1. Navigate to **Learning > Content > Learning Content**.
2. Create an internal learning course.
   a. Click **New**.
   b. Fill in the following fields.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>Name of the course.</td>
</tr>
<tr>
<td><strong>Internal source</strong></td>
<td>Select the type of content for the course.</td>
</tr>
<tr>
<td></td>
<td>Here are the available types of courses:</td>
</tr>
<tr>
<td></td>
<td>• URL—Youtube, Vimeo, or any link for a video</td>
</tr>
<tr>
<td></td>
<td>• Knowledge article</td>
</tr>
<tr>
<td></td>
<td>• Free form</td>
</tr>
<tr>
<td><strong>Days to complete</strong></td>
<td>The number of days required to complete the course. Default value is set to 5.</td>
</tr>
<tr>
<td><strong>Estimated duration</strong></td>
<td>Length of time when the course has to be completed. For example, for a video, it is the duration of the video. For a KB article, the duration is estimated based on the length of the article.</td>
</tr>
</tbody>
</table>

3. Click **Save**.
4. Add a skill to the internal learning content.
a. Click the Associated skills related list.
b. Click New.
c. In the Skill field, select a skill you want to associate with the internal content.
d. In the Skill level field, select a skill level for the selected skill.
e. Click Save.

5. Add a learning task to the internal learning content.
   a. Click the Learning Tasks related list.
   b. Click New.
   c. In the Assigned to field, select a trainee to whom you want to assign the learning task.
   d. In the Catalog field, select the catalog to associate with the learning task.
   e. In the Due date field, click the calendar icon and select the date and time when you want trainee to complete the learning task.
   f. Click Save.

Add external learning content

Add courses from third-party applications such as Udemy, Pluralsight, or Cornerstone to enable your users to gain skills from external learning content.

Before you begin

Before you add external learning content, you must integrate Coaching with Learning with third-party learning management systems. For information on how to perform this integration, see Integrate Learning Core with third-party management systems.

The Learning Core application enables you to build a learning content repository by integrating with third-party Learning Management Systems, such as Cornerstone OnDemand, Udemy, PluralSight and Sumtotal. It allows you to configure learning catalogs that contain course items from both external learning systems and internal learning systems.

Role required: sn_lc.learning_admin

Procedure

1. Navigate to Learning > Content > External Content.
2. Select a course.
3. Click Go to course.
   You can review and learn the external course.
Complete a learning task

Enhance your skills set by completing learning tasks from internal or external learning content.

Before you begin
Role required: sn_lc.content_reader

Procedure
2. Select a learning task.
3. Complete the learning task.
4. Click Mark as Complete.

Managing your coaching assessments

Employees, or trainees, are assessed on work they have done that has triggered a coaching opportunity. Once assessed, the trainee is assigned training by the coach. Use the Trainee Dashboard to manage your assessments and track results.

You can access the Trainee Dashboard from the Coaching navigation menu, or directly from the dashboard list. Click a report to view the detailed data.

Note: You must have the Coaching trainee role to view your Trainee Dashboard.

Your training starts when your assessment has been assigned to a coach. Coaching assessments are triggered from a coaching opportunity set up by the coaching admin and are used to facilitate your learning, as well as providing a dialogue with your coach.

The Trainee Dashboard lets you manage your assessments and track results.

• Keep track of your active coaching assessments.
• Analyze how your assessments have been rated in the past.
• View the types of survey feedback from your coaches.
• Manage the full list of your coaching assessment details.
Work with your coach

Use your assessments to work with your coach, including assigned training and due dates. You can view your assessments and track your results using the Trainee Dashboard.

Before you begin
Role required: sn_coaching.trainee

About this task
You can provide feedback for your coach when the assessment is in resolved, closed complete, or closed incomplete state.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Active Training Assessments</td>
<td>Coaching assessments for you that are in <strong>New</strong>, <strong>Work in Progress</strong>, and <strong>Resolved</strong> states.</td>
</tr>
<tr>
<td>My Coaching History</td>
<td>Coaching feedback history (provided by the coach).</td>
</tr>
<tr>
<td>My Survey Results</td>
<td>Survey feedback results of the coach to the trainee.</td>
</tr>
<tr>
<td>My Assessment Details</td>
<td>List of active coaching assessments and trainings.</td>
</tr>
</tbody>
</table>
**Procedure**

1. Navigate to Coaching > Trainee Dashboard.

2. Select an active Coaching Assessment record from the My Assessment Details list to view feedback from your coach.

3. View the Notes from your coach for coaching instructions.

4. Complete any learning content in the Assigned Trainings related list before the Due date.

5. Add any Notes for your coach that are applicable to your progress or learning status.

6. To provide feedback for the coach, click Start Survey. The Provide Training Feedback form appears.

7. Complete the feedback and click Submit. The score for the survey is added to the Coach rating field.

8. To assess your survey results and other reports, navigate to Coaching > Trainee Dashboard.

**Example: Trainee works on a coaching assessment**

<table>
<thead>
<tr>
<th>Coaching Assessment form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Trainee</td>
</tr>
<tr>
<td>Record</td>
</tr>
<tr>
<td>Opportunity</td>
</tr>
<tr>
<td>State</td>
</tr>
<tr>
<td>Coach group</td>
</tr>
<tr>
<td>Coach</td>
</tr>
<tr>
<td>Due date</td>
</tr>
<tr>
<td>Resolved by Virtual Coach</td>
</tr>
</tbody>
</table>

**Related reference**

Coaching field descriptions
Coaching reference

Coaching reference content includes business rules and field descriptions.

Coaching on a non-task table

To provide coaching on a table source that does not extend the Task table, you must create a business rule to initiate the coaching process.

The business rule **Evaluate coaching opportunity on tasks** initiates coaching for tables that extend Task. You can copy this business rule and modify it for tables that do not extend the Task table.

### Coaching assessment flow states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>New coaching opportunity.</td>
</tr>
<tr>
<td>Work in Progress</td>
<td>Trainee is being coached.</td>
</tr>
<tr>
<td>Resolved</td>
<td>All learnings and coaching in the assessment have been completed successfully.</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>Assessment has been resolved and closed.</td>
</tr>
<tr>
<td>Closed Incomplete</td>
<td>Assessment has been closed but was not completed, typically because the coaching assessment Due date has expired.</td>
</tr>
</tbody>
</table>

**Form and list permissions**

<table>
<thead>
<tr>
<th>Element</th>
<th>Permissions</th>
</tr>
</thead>
</table>
| Coaching Opportunity  | • sn_coaching.admin: create, write, delete  
                           • sn_coaching.coach: read  
                           • sn_coaching.trainee: none |
| Coaching Assessment   | • sn_coaching.admin: create, write, delete  
                           • sn_coaching.coach: create, write own or group assessment  
                           • sn_coaching.trainee: read own assessment, write own assessment work notes |
| Training History      | • sn_coaching.admin: view  
                           • sn_coaching.coach: view  
                           • sn_coaching.trainee: none |
| Assigned Training     | • sn_coaching.admin: create, write, delete  
                           • sn_coaching.coach: create, write and delete own training action  
                           • sn_coaching.trainee: view |
<table>
<thead>
<tr>
<th>Element</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Training</td>
<td>• sn_coaching.admin: create, write, delete</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.coach: create, write and delete own training</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.trainee: view</td>
</tr>
<tr>
<td>Virtual Coachings</td>
<td>• sn_coaching.admin: create, write, delete</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.coach: read, and associate existing virtual coach to a coaching opportunity</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.trainee: none</td>
</tr>
<tr>
<td>Virtual Coach</td>
<td>• sn_coaching.admin: create, write, delete</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.coach: create, write and delete own virtual coaching</td>
</tr>
<tr>
<td></td>
<td>• sn_coaching.trainee: none</td>
</tr>
</tbody>
</table>

### Coaching Properties

#### Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.sn_coaching_assessment_activity:fields</td>
<td>Edit coaching assessment activities.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> string</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> assigned_to, cmdb_ci, state, impact, priority, opened_by, work_notes, comments, <em>Attachments</em>, assessment_of</td>
</tr>
<tr>
<td>sn_coaching.recommended_learning_deprecated</td>
<td>Coaching Recommended Trainings is being deprecated and replaced with the Learning Tasks and course items from Coaching with Learning.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> string</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> true</td>
</tr>
</tbody>
</table>
Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_coach.lrn.exclude_weekends_on_learning_task_due_date</td>
<td>Enable property to exclude weekends while setting the due date for learning tasks.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: true</td>
<td></td>
</tr>
</tbody>
</table>

Coaching field descriptions

Coaching field descriptions also include form related lists and actions.

Coaching Opportunity form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique (COP) number for the coaching opportunity.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name for the coaching opportunity.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the coaching opportunity.</td>
</tr>
<tr>
<td>Table</td>
<td>Table to use for the coaching opportunity.</td>
</tr>
<tr>
<td>Trainee</td>
<td>Field from the selected table that identifies the trainee.</td>
</tr>
<tr>
<td>Trainee group</td>
<td>Limit the trainees identified in the Trainee field to a group or groups of users.</td>
</tr>
<tr>
<td>Specify coach user</td>
<td>Check box to enable the Coach field.</td>
</tr>
<tr>
<td>Coach</td>
<td>Field from the selected table that identifies the coach.</td>
</tr>
<tr>
<td>Coach group</td>
<td>Group of coaches that assess and provide feedback to trainees.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the coaching opportunity. Clear the check box to disable.</td>
</tr>
<tr>
<td>Trigger</td>
<td>Event that triggers a coaching opportunity for the selected table. Conditions for opportunities are generally unique events, such as when an incident is reassigned.</td>
</tr>
</tbody>
</table>

**Frequency tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Random sample (%)</td>
<td>Percentage of the total assessments that get created. Use a random sample percentage to reduce the number of assessments that are created if too many events that meet the criteria for creating a coaching assessment occur.</td>
</tr>
<tr>
<td>Users who should be coached on every opportunity</td>
<td>Users that always get coached, regardless of random sample percentage. Because the specified users are exempted from the random sample percentage, a coaching assessment is always created when the assessment is triggered. Selected users might be new hires, for example, or others who require additional coaching.</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** Only shown if the Random sample (%) is less than 100.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment duration</td>
<td>Amount of time before the assessment is set to <strong>Closed Complete</strong> state.</td>
</tr>
<tr>
<td>Prevent duplicate assessment</td>
<td>Check box to prevent an assessment from being created within a specified</td>
</tr>
</tbody>
</table>
### Frequency tab (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within time period</td>
<td>Time period within which duplicate assessments are not created.</td>
</tr>
</tbody>
</table>

**Note:** This field appears only when **Prevent duplicate assessment** check box is selected.

### Surveys tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey taken by trainee</td>
<td>Survey selected for the trainee to provide additional feedback.</td>
</tr>
<tr>
<td>Survey taken by coach</td>
<td>Survey selected for the coach to provide additional feedback.</td>
</tr>
</tbody>
</table>

### Related KPIs tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improvement KPI</td>
<td>Primary KPI used to measure the success of the coaching opportunity.</td>
</tr>
<tr>
<td>Strategic objective</td>
<td>Strategic objective affected by the coaching opportunity.</td>
</tr>
</tbody>
</table>

### Snapshot Settings tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snapshot fields</td>
<td>Field values to show in the coaching assessment unless an advanced script is used.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check box to use a script to determine the content for the snapshot.</td>
</tr>
</tbody>
</table>
Snapshot Settings tab (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snapshot script</td>
<td>Script that defines the evaluation process applied to the selected table. Select the fields from the table for which you want to capture the values. For example, when analyzing the Incident table, use #{number} to display the record number (such as INC0010002) for the incident record that triggered the coaching opportunity.</td>
</tr>
</tbody>
</table>

Note: This field appears only if the Advanced check box is selected.

Coaching Assessment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique (CAS) number for the coaching assessment.</td>
</tr>
<tr>
<td>Trainee</td>
<td>Trainee user that triggered the assessment in the coaching opportunity.</td>
</tr>
<tr>
<td>Record</td>
<td>Record associated with the assessment triggered in coaching opportunity.</td>
</tr>
<tr>
<td>Opportunity</td>
<td>Coaching opportunity number associated with the coaching assessment.</td>
</tr>
<tr>
<td>State</td>
<td>State of the assessment.</td>
</tr>
<tr>
<td></td>
<td>• Open: New coaching opportunity.</td>
</tr>
<tr>
<td></td>
<td>• Work in Progress: Trainee is being coached.</td>
</tr>
<tr>
<td></td>
<td>• Resolved: All coaching and learnings have been provided to the trainee.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coach group</td>
<td>Group of coaches to which the assessment is assigned. Default value is populated from the coaching opportunity form.</td>
</tr>
<tr>
<td>Coach</td>
<td>Coach user performing the assessment. This field is typically set by the coach before performing the assessment, but can also be set by a member of the coach group or by the coaching admin.</td>
</tr>
<tr>
<td>Due date</td>
<td>Date the assessment is due. After this time, the assessment is set to <strong>Closed Incomplete</strong> state.</td>
</tr>
</tbody>
</table>

### Notes tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description of the assessment.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Notes about the assessment (journal field). Additional notes can be added as the coach and trainee engage in further dialogue.</td>
</tr>
</tbody>
</table>
### Snapshot tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Snapshot</td>
<td>Field contents of the task, action, or behavior captured at the time the coaching opportunity was triggered.</td>
</tr>
</tbody>
</table>

### Feedback tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Assessment rating | Value of the performance of the trainee for reporting and trend-tracking purposes.  
• Excellent  
• Good  
• Average  
• Poor  
• Unacceptable |
| Follow up Needed | Further action required, if any, to improve the performance of the trainee.  
• **Recognize**: Trainee needs recognition for good performance.  
• **Needs Additional Coaching**: Trainee needs additional feedback from the coach.  
• **Needs Outside Training**: Trainee needs additional training outside the scope of the coaching assessment.  
• **Referral to Manager**: Indicates a major issue with the trainee performance.  
• **Create Virtual Coach**  
• **No Follow Up** |
| Summary | Summary of the coaching assessment. |
## Coaching Assessment actions

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete Assessment</td>
<td>Set the coaching assessment to <strong>Closed Complete</strong> state.</td>
</tr>
<tr>
<td>Reopen Assessment</td>
<td>Change the coaching assessment state from <strong>Resolved</strong> or <strong>Closed Complete</strong> back to <strong>Work In Progress</strong> for additional action.</td>
</tr>
<tr>
<td></td>
<td>Either the coach or the trainee can reopen the coaching assessment.</td>
</tr>
<tr>
<td>Submit feedback</td>
<td>Feedback submitted by either a trainee or a coach from the survey form.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the coaching assessment from the Assessment Created by Opportunity list.</td>
</tr>
</tbody>
</table>

## Virtual Coaching form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Description of the virtual coaching (CVC) record.</td>
</tr>
<tr>
<td>Table</td>
<td>Table source of coaching opportunity events.</td>
</tr>
<tr>
<td>Training</td>
<td>Record that contains related training content.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to activate the virtual coaching. Clear the check box to disable.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check box to use a script to determine when the automation triggers.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Event that triggers a virtual coaching for the selected table.</td>
</tr>
</tbody>
</table>
Conditions for virtual coachings are generally unique events.

Script

Script that defines the evaluation process applied to the selected table. Select the fields from the table to capture the values for.

Note: Only shown if Advanced check box is selected.

Autofill fields

Fields to autofill under certain conditions.

Training form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique (CMC) number of the training.</td>
</tr>
<tr>
<td>Title</td>
<td>A short description for the training.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of learning content, which is used for reporting.</td>
</tr>
<tr>
<td></td>
<td>• Customer experience</td>
</tr>
<tr>
<td></td>
<td>• Best Practice Series</td>
</tr>
<tr>
<td></td>
<td>• Soft-Skill Communication</td>
</tr>
<tr>
<td></td>
<td>• Behavioral Coaching</td>
</tr>
<tr>
<td></td>
<td>• Product Support</td>
</tr>
<tr>
<td>Content</td>
<td>Content for assigned users to learn.</td>
</tr>
</tbody>
</table>

The Preview Message related list shows the learning content in the context of the trainee.

Coaching troubleshooting

Troubleshooting actions can help resolve common issues when setting up or running Coaching.
<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error after creating a coaching opportunity:</td>
<td>Create a business rule to initiate the coaching process for a non-task type table. Copy the Coaching Opportunity creator for Task business rule and modify it for tables that do not extend Task.</td>
</tr>
<tr>
<td>Do not automatically close a coaching assessment after the due date has passed.</td>
<td>Deactivate the Close assessments after expiration scheduled job in System Definition &gt; Scheduled Jobs.</td>
</tr>
<tr>
<td>Coaching assessment is not created.</td>
<td>These resolutions are applicable to a coaching assessment not being created:</td>
</tr>
<tr>
<td></td>
<td>• Add the trainee as a member of the trainee group.</td>
</tr>
<tr>
<td></td>
<td>• Clear the Prevent duplicate assessment check box if the trainee already has a coaching assessment for the same coaching opportunity.</td>
</tr>
<tr>
<td></td>
<td>• Include the trainee in the Users who should be coached on every opportunity list when the Random sample (%) is less than 100.</td>
</tr>
<tr>
<td>I need to override ACLs and trainings for the Assigned Training related list on the Coaching Opportunity and Coaching Assessment forms.</td>
<td>Implement Coaching extension points:</td>
</tr>
<tr>
<td></td>
<td>• CoachingExtensionPoint</td>
</tr>
<tr>
<td></td>
<td>• CoachingACLExtensionPoint</td>
</tr>
</tbody>
</table>

**Related information**

- Using extension points to extend application functionality
- Using scripted extension points in server-side scripts
- Using UI extension points in server-side UI macros
- Using client extension points in client-side UI scripting
Quick start tests for Coaching

Validate that Coaching still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Coaching quick start tests require activating the Coaching plugin (com.sn_coaching).

### Coaching test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching: Create an assessment manually when logged in as a coach.</td>
<td>As a coach, verify that you can create an assessment and assign it to trainees.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: Add skills to an opportunity and verify those skills awarded to trainee.</td>
<td>Add skills to a coaching opportunity and verify that those skills have been awarded to trainees after they complete an assessment.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: Complete an assessment as a virtual coach.</td>
<td>Verify that the virtual coach completes an assessment and provides feedback to the trainee when a virtual coach is attached to an opportunity.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: Add skills to an assessment and verify those skills awarded to trainee.</td>
<td>Add skills to a coaching assessment and verify that those skills have been awarded to trainees after they complete an assessment.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: Add skills to a recommendation and verify those skills awarded to trainee.</td>
<td>Add skills to a coaching recommendation and verify that those skills have been awarded</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
### Coaching test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>to trainees after they complete an assessment.</td>
<td></td>
</tr>
<tr>
<td>Coaching: Move assessments from one state to another when logged in as a coach.</td>
<td>As a coach, verify that you can move an assessment from one state to another.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: Attach a recommendation learning to an assessment.</td>
<td>Verify that a recommendation learning on an opportunity gets attached to an assessment when an assessment is generated.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: When a coaching opportunity is inactive, assessments are not generated.</td>
<td>Verify that when a coaching opportunity is in inactive state, it does not generate assessments.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Coaching: Submit Coaching survey as a Coach user.</td>
<td>Verify that coach can submit survey for a trainee.</td>
<td>Quebec</td>
</tr>
<tr>
<td>Coaching: Submit Coaching survey as a Trainee user.</td>
<td>Verify that trainee can submit survey for a coach.</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

### Related information

**Quick start tests**

### Continual Improvement Management

Use the ServiceNow® Continual Improvement Management (CIM) application to request improvement opportunities, and implement phases and tasks to meet performance goals, track progress, and measure success.

An improvement initiative consists of:
• Goals to measure success
• Phases to organize work effort
• Tasks with specific actions to complete

To learn more about how your ServiceNow instance supports Continual Improvement Management, see Continual Improvement Management overview for a general understanding of the application and how it is used.

Listen to this 24-minute podcast for a discussion of the Continual Improvement Management application. Discussion of CIM, challenges of managing continual improvement, spotting opportunities, and differences between CIM and change management and other applications.

Start an improvement
For continual improvement in your environment, select an activity.

1. Improvement initiative request
2. Improvement initiative implementation
3. Continual Improvements workbench

Understand Continual Improvement Management concepts
• Continual Improvement Management overview
• Requesting improvements
• Managing improvements
• Domain separation and Continual Improvement Management

Get help from ServiceNow resources
• Ask or answer questions in the Continual Improvement Management forum
• Search the Known Error Portal for known error articles
• Contact Customer Service and Support

Request Continual Improvement Management
The Continual Improvement Management (com.sn_cim) plugin requires a separate subscription and must be activated by ServiceNow personnel. This plugin includes demo data and activates related plugins if they are not already active. The Continual Improvement Management application is available with the ITSM Professional and CSM Professional subscription only. Contact your account manager for more information.

Before you begin
To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and subproduction instances, generally within a few days.

If you don’t have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.
Role required: none

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the form, fill in the fields.

**Activate Plugin request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

### Related information

**List of plugins (Rome)**

### Continual Improvement Management overview

Enable Continual Improvement Management (CIM) and then set up roles, groups, and integration properties to improve your organization's processes and functions. You can use the CIM workbench and dashboard to monitor, plan, and measure improvement success.

The video below gives you an overview of Continual Improvement Management application. Continual Improvement Management Overview

Continual Improvement Management is used to implement service, process, and function improvements. An improvement initiative contains goals to measure success, and phases that contain tasks with specific actions to complete the improvement.
Use the Continual Improvement Workbench to plan and manage improvements. Both tile and list views are supported.

The Continual Improvements dashboard shows progress and results in the form of statistics and charts using Performance Analytics.

To use guided setup to configure and set up Continual Improvement Management application, navigate to Continual Improvement > Administration > Guided Setup and click Configure in the Request CIM section.

Integration with other applications

As part of Continual Improvement Management integration with other applications, an improvement initiative can be created from within other applications, and conversely, records for other applications can be created from within an improvement initiative (or CIM task).

An improvement initiative can be created from these applications.

- Benchmarks
- Coaching
- Configuration Management Database (CMDB)
- Demand Management
- Governance, Risk, and Compliance (GRC)
- Idea Portal
- Incident Management
- Problem Management
- Process Optimization
• Survey Management
• Vendor Manager Workspace

As part of an improvement initiative or CIM task, these records can be created.
• Change record (Change Management)
• Coaching opportunity (Coaching)
• Demand record (Demand Management)
• Knowledge base article (Knowledge Management)
• Project (Project Management)
• Story record (Agile Development)

Initial CIM setup
Once Continual Improvement Management has been enabled, set up the application by assigning user roles and groups, and configuring integration properties.

• Assign user roles and groups.
  ◦ Improvement Manager role
  ◦ Improvement Coordinator role
  ◦ Approver group membership (CIM Approvers, default is empty)

• Configure properties for Continual Improvement Management integration with other applications.
  ◦ List of applications from which an improvement initiative can be created
  ◦ List of application task records that can be created from within an improvement initiative
Workflow of Continual Improvement Management roles

Improvement requests are submitted when an **Improvement Requester**, such as a help desk manager, process owner, or ITL user, for example, recognizes the need for an improvement anywhere within the company.

When an improvement request is submitted, the **Improvement Manager**, reviews the improvements, accepts, and assigns it to an Improvement Coordinator for implementation. The Improvement Manager also runs prioritization meetings with Improvement Coordinators and uses the workbench to monitor, manage, and plan overall progress.

After the improvement request is assigned, the **Improvement Coordinator** along with the Improvement manager, creates phases and tasks to complete the improvement. The Improvement Coordinator also meets with task owners to ensure that they are on track to meet the deadline.

When all work has been completed, the **Improvement Manager** reviews the improvement for closure, and uses the dashboard reports to measure the status and success of the request.

**Email notification**
Email notifications are sent when the state of the improvement request changes or when the target date is breached.
## Domain separation

**Domain separation** capability is supported in Continual Improvement Management with no setup or configuration required.

You can create improvements separately in a specific domain, or in the global domain.

### Domain separation and Continual Improvement Management

Domain separation in Continual Improvement Management is configured to apply to all features of the application. Separation of data is configured along with separation of logic and process. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

<table>
<thead>
<tr>
<th>Improvement action</th>
<th>Improvement Manager</th>
<th>Improvement Coordinator</th>
<th>Improvement Requester</th>
<th>Watch list</th>
<th>Task assignee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canceled</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Approved</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Closed</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Target review date is breached</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>CIM task assigned</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>CIM task closed</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
• Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.

• The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant/customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

Overview

When an improvement opportunity is discovered within your organization, you can implement the improvement in a structured manner using Continual Improvement Management with domain separation.

Once an improvement initiative is created, the Improvement Manager uses the Improvement Register to review and prioritize the improvement, and assigns improvement tasks. CIM task owners are responsible to fulfill assigned tasks to the desired outcome of that improvement. Both Improvement Register and CIM Task tables support domain separation so the Improvement Requester, task owners, Improvement Coordinator, and Improvement Manager can view only the improvement initiatives and related tasks within the (tenant) domain to which they belong.

How domain separation works in Continual Improvement Management

Domain separation is supported in Continual Improvement Management with no CIM setup or configuration required. Improvements can be created in separate domains, including the global domain.

Continual Improvement Management extends the platform Task [task] table.

When domain separation is implemented, CIM users can view and request improvements initiatives only in the domain assigned. Domain and Domain Path columns are available for two main CIM tables (Improvement Register and CIM Tasks) provided with the base system. The Domain column contains the name of the domain to which the event or alert belongs, and the Domain Path column contains the unique domain identifier.
Note: If the domain column is not shown, click the Update Personalized List icon and add the required column. You can also add the domain path column, if desired.

Use cases:

- An Improvement Requester that belongs to the Acme domain creates an improvement initiative and wants to view it.

  A user must belong to the Acme domain, its parent domain, or the global domain to view the improvement initiative.

- An Improvement Manager that belongs to a parent domain tries to view an improvement initiative in a child domain.

  The user of a parent domain can view improvement initiatives of the parent as well as all child domains of that parent.

- An Improvement Requester that belongs to Acme domain wants to create an improvement initiative on behalf of another user in the Acme domain.

  A user must belong to the same domain as the user for which the improvement initiative is created.

- An Improvement Requester wants to associate a record for an integrated application in the Acme domain.

  A user must belong to the domain of the integrated application from which a record is associated.

- An Improvement Manager has access to multiple domains, but wants to update a record with content within a specific domain.

  The domain specified for the current record drives the functionality of that record and reference fields.

Related information

Domain separation for service providers

Continual Improvement Management roles

Use Continual Improvement Management roles to specify what different users and user groups can see and do.
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Roles inherited</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cim.improvement_requester</td>
<td>Able to perform these application functions:</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>• Create improvement initiative</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View My CIM requests</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View Watched CIM requests</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View All CIM requests</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[Improvement Requester]</td>
<td></td>
</tr>
<tr>
<td>sn_cim.improvement_coordinator</td>
<td>Able to perform all functions for improvements to which they are assigned as Improvement Coordinator except:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create Enterprise Strategies</td>
<td>• sn_cim.improvement_requester</td>
</tr>
<tr>
<td></td>
<td>• Delete improvement</td>
<td>• app_service_user</td>
</tr>
<tr>
<td></td>
<td>Although able to perform Improvement Manager functions, an Improvement Coordinator can only</td>
<td>• certification</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• cmdb_query_builder</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• dependency_views</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• itil</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• knowledge</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_analyst</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_contributor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_power_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_target_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_threshold_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_bm_client.benchmark_data_viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_bm_client.benchmark_recommendation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>[Improvement Coordinator]</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
<td>Roles Inherited</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>perform those functions for improvements that they are assigned as Improvement Coordinator by the Improvement Manager.</td>
<td>Benchmarks data and recommendations can be viewed and an improvement initiative created from Benchmarks recommendations.</td>
</tr>
<tr>
<td></td>
<td>Primary responsibility is to coordinate improvements within their area of expertise (at the process or service level). Can access both Continual Improvement Workbench and dashboard.</td>
<td>• template_editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• view_changer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_coaching.admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• scrum_story_creator</td>
</tr>
<tr>
<td>sn_cim.improvement_manager [Improvement Manager]</td>
<td>Able to perform all application functions. The Improvement Manager is primarily responsible for all improvements, including initial acceptance of new improvement</td>
<td>• sn_cim.improvement_coordinator</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_process_optimization_viewer</td>
</tr>
</tbody>
</table>
Automatic assignment of the `sn_cim.improvement_requester` role

The `sn_cim.improvement_requester` role is automatically assigned to these roles upon Continual Improvement Management activation so these users can create an improvement request.

<table>
<thead>
<tr>
<th>Application</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITBM (only if ITBM plugins are active)</td>
<td></td>
</tr>
<tr>
<td>Agile Development</td>
<td>scrum_master</td>
</tr>
<tr>
<td>Demand Management</td>
<td>it_demand_manager</td>
</tr>
<tr>
<td>Portfolio Management</td>
<td>it_portfolio_manager</td>
</tr>
<tr>
<td>Program Management</td>
<td>it_program_manager</td>
</tr>
<tr>
<td>Project Management</td>
<td>it_project_manager</td>
</tr>
<tr>
<td>Test Management</td>
<td>tm_test_manager</td>
</tr>
<tr>
<td>ITSM</td>
<td></td>
</tr>
<tr>
<td>Benchmarks</td>
<td>• sn_bm_client.benchmark_admin</td>
</tr>
<tr>
<td></td>
<td>• sn_bm_client.benchmark_recommendation_view</td>
</tr>
<tr>
<td>Change Management</td>
<td>change_manager</td>
</tr>
<tr>
<td>Coaching</td>
<td>sn_coaching.admin</td>
</tr>
<tr>
<td>Incident Management</td>
<td>incident_manager</td>
</tr>
<tr>
<td>ITSM</td>
<td>itil</td>
</tr>
<tr>
<td>Application</td>
<td>Role</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Survey Management Assessments</td>
<td>• survey_admin</td>
</tr>
<tr>
<td></td>
<td>• survey_reader</td>
</tr>
<tr>
<td>Performance Analytics and Reporting</td>
<td></td>
</tr>
<tr>
<td>Performance Analytics</td>
<td>• pa_admin</td>
</tr>
<tr>
<td></td>
<td>• pa_power_user</td>
</tr>
<tr>
<td></td>
<td>• pa_viewer</td>
</tr>
</tbody>
</table>

**Monitor and plan improvements**

Use the Continual Improvement Workbench to monitor and plan improvements in a single view. The workbench shows tile and list views of improvements in progress, as well as listings under review, and in the backlog to help you plan your sprint.

**Before you begin**

Role required: sn_cim.improvement_manager, sn_cim.improvement_coordinator

**About this task**

The workbench is flexible graphical view that you can tailor to your needs, which is helpful for the Improvement Manager when running planning meetings and when doing a quick status update to other stakeholders. The tile-based drag-and-drop user interface makes it easy to monitor, plan, and approve improvements.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview tab</td>
<td>Shows two groups of improvements.</td>
</tr>
<tr>
<td></td>
<td>• Tiles in Implement and On Hold states.</td>
</tr>
<tr>
<td></td>
<td>• Listings in Review state.</td>
</tr>
<tr>
<td></td>
<td>This list can be customized in the Workbench Review list layout.</td>
</tr>
<tr>
<td></td>
<td>Use this section for daily monitoring and assessment of improvements</td>
</tr>
<tr>
<td></td>
<td>being implemented, as well as those</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Planning tab</td>
<td>Lists two groups of improvements.</td>
</tr>
<tr>
<td></td>
<td>• Listings in Implement and On Hold states.</td>
</tr>
<tr>
<td></td>
<td>• Listing for backlog (New, Accepted, Assess, and Approved states).</td>
</tr>
<tr>
<td></td>
<td>Use this section for ranking and prioritization of improvements in the Implement state, or in the backlog (improvement initiatives in Approved, Assess, Accepted, and New states, listed in that order).</td>
</tr>
</tbody>
</table>

Note: Configuration changes made to the Planning workbench are reset when the Planning workbench is reloaded.

Features:
• Tile layout (12 improvement tiles shown by default).
• Search by keyword.
• Sort by rank, priority, due date, or effort estimate.
• Status on tile (percentage complete, assignment, priority, and time left)
  Percentage complete is based on the number of completed tasks in each phase of the improvement. Percent complete values are shown per phase, and per improvement.
• Color-coded status badge on tile.

<table>
<thead>
<tr>
<th>Status badge</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete</td>
<td>All tasks have been completed (percent complete is 100%).</td>
</tr>
<tr>
<td>Overdue</td>
<td>Due date has passed.</td>
</tr>
<tr>
<td>Due soon</td>
<td>Less than 15% of duration left until the due date.</td>
</tr>
<tr>
<td>On Hold</td>
<td>Improvement has been placed on hold.</td>
</tr>
</tbody>
</table>

• Customize fields shown in workbench lists using the Workbench Review view.

Access the Workbench Review view from the List Controls menu (≡) of the Improvement Register ([List Controls > View > Workbench Review]).

⚠️ **Note:** Only the fields visible in the Improvement Register [Workbench Review] view are shown in the workbench overview section.

On the planning page, you can prioritize your backlog using an easy-to-use drag-and-drop interface, similar to sprint planning, where you have an active sprint and a list of backlog items. Move backlog items to the Work in Progress list, which is your active sprint.
Features:

- Color coding on **Planned end date** field (red, green)
- Search by keyword.
- Move items up or down a list.
- Group multiple items together.
- Drag and drop within and between lists.

**Note:** Moving an item, or group of items, from one list to another changes the state of the improvement.

For example, moving an item from Backlog to Work in Progress changes the state from **Approved** to **Implement**. Conversely, moving an item from Work in Progress back to the Backlog changes the state to **Approved**.

Only approved items can be moved from the Backlog list to the Implement list.

- Customize fields shown in workbench lists using the Workbench Planning view.

Access the Workbench Planning view from the List Controls menu (Ξ) of the Improvement Register (**List Controls > View > Workbench Planning**).

- Filter by priority, benefits, effort estimate, and CIM Coordinator.

**Note:** The filters are dynamic and show only the fields visible in the Workbench Planning view.
• Toggle the Filter menu and fields shown using the Configuration menu.

( )

Note: Only the fields visible in the Improvement Register [Workbench Planning] view are shown in the workbench planning section.

Procedure
1. Navigate to Continual Improvement > Workbench.
2. On the Overview tab, analyze the Work in Progress tiles to get an overall picture of the improvements in progress. Color-coded alert banners call out improvements that need attention. You can click on a tile to view the improvement.
3. Use the Planning tab to build the contents of your current sprint, according to capacity.
   a. Drag and drop items from the Backlog list to the Work in Progress list.
   b. Use the filters (Priority, Benefits, Effort Estimate, and CIM Coordinator) to narrow the data contained in the lists so you can focus on certain groups of improvements.
4. Use the Configuration menu to customize the columns shown in the Planning tab lists that is specific to your needs.

View improvement reports
Evaluate improvement results using the Continual Improvements dashboard overview and outcome analysis reports to determine how well the improvements are helping your company.

Before you begin
Role required: sn_cim.improvement_manager, sn_cim.improvement_coordinator

About this task
Reports and Spotlight list can be filtered by improvement priority, state, business process, business service, benefits, and CIM coordinator.
Overview:

- Report Description

  - Employee Engagement
    - Open improvement count from the last six months.
  - Total Initiatives
    - Improvement count by state.
  - Open Backlog
    - Number of open improvements.
  - Unassigned
    - Number of improvements without a CIM Coordinator assigned.

- Prioritized List Using Spotlight.

  To use Spotlight to help prioritize the improvement backlog, navigate to Continual Improvement > Administration > Spotlight Config.

  Improvements can be prioritized based on multiple weighted criteria so you can quickly identify the most important tasks. The Improvement Register list shows improvement ranking based on specific criteria (priority, benefits, and effort estimate).

Outcome Analysis:

- Outcomes Achieved - Last 6 Months
  - Report of closed improvement count in the last six months grouped by:
- Category
- Strategy
- Closure Code
- Type

- KPIs Completed in the Last 6 Months
  List of closed improvements in the last six months.

**Procedure**

1. Navigate to **Continual Improvement > Dashboard**.

2. On the Overview tab, use the filters (Priority, State, Business Process, Business Service, Benefits, and Coordinator) to narrow the data contained in the reports.
   You can click a report to view a list of improvements that make up that report.

3. On the Outcome Analysis tab, select a report from the **Group by** list to view improvement results by different attributes.
   You can click a report to view a list of improvements that make up that report.

4. Compare monthly reports to evaluate the impact improvements have on your company.

**Requesting improvements**

Identify improvement opportunities within your environment and create an improvement request to begin implementation.

You can request improvements either manually from Continual Improvement Management, or from an application that is integrated with Continual Improvement Management.

Continual Improvement Management integration with other applications lets you:

- Create an improvement initiative from within other applications
- Create a record for another application as part of an improvement initiative or CIM task

**Identifying improvement opportunities**

There are many different ways you can identify improvements in your organization. Improvement opportunities need not to be limited to the applications you use, your area of expertise, or your specific group.
You can identify improvement opportunities based on feedback from other groups.

**Process manager or process owner**
Reach out to the process manager or process owner to identify improvement suggestions for a process that is not working well.

**IT, development, and project management groups**
Reach out to the IT staff, development team, and project management staff for improvement suggestions, and provide the Improvement Requester role so they can submit an improvement request from within an integrated application with one click.

You can also identify improvement opportunities from within many different applications.

**Surveys**
Review customer feedback and complaints and send additional assessments soliciting customers for improvement opportunity suggestions.

**Performance Analytics**
Monitor process KPIs and internal process assessments in Performance Analytics reports to identify improvement opportunities.

**Benchmarks**
Compare KPI performance with Benchmarks baseline reports, and identify improvement opportunities in Benchmarks recommendations.

**Service**
Review undesirable trends in reports to identify improvement opportunities.

**Problem Management and Change Management**
Review Problem Management and Change Management trend reports to identify improvement opportunities.

**Risk and GRC Audits**
Review Risk registers and GRC Audit test failures to discover improvement opportunities.

**IT Service Management**
Review ITSM regularly to identify improvement opportunities for what is not working well.
Create an improvement request

Create an improvement request for improvement opportunities you identify in your environment. Once submitted, the improvement request is analyzed and implemented by the Improvement Manager and Improvement Coordinator.

Before you begin
Role required: sn_cim.improvement_requester

About this task

1. Create a CIM initiative
2. Accept a CIM initiative
3. Assess a CIM initiative
4. Approve a CIM initiative
5. Implement a CIM initiative
6. Review a CIM initiative
7. Close a CIM initiative

Procedure

1. Identify an opportunity for improvement.
   Any type of improvement identified in your company qualifies as the basis for an improvement request. For example, KPI performance, customer satisfaction, resources, processes, training, to name a few.

2. Determine your improvement goal.
   The improvement goal is the expected result to be achieved from the improvement.

3. Submit an improvement request.

   a. Navigate to Continual Improvement > Create New.
      A CIM phase is automatically created when you create the initiative, if the sn_cim.create_default_phase system property is enabled. For more information, see Properties installed with Continual Improvement Management.
b. Fill in the short description and the business justification, and click Submit. The improvement request is created and set to New for the Improvement Manager to accept or reject based on alignment with strategic objectives.

4. To track the status of your improvement request, navigate to Continual Improvement > My CIM Requests.

Example: Create improvement request

In the process of reviewing KPI performance in the Performance Analytics application, the incident manager noticed the Average time to resolve an incident KPI scorecard was too high (24 hours).

As part of the improvement identification process, the incident manager analyzed the KPI performance by comparing it with values from other companies using the Benchmarks application, determined an improvement was needed, and set a target goal.

**Improvement Initiative form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIM0000135 (set internally)</td>
</tr>
<tr>
<td>Business service</td>
<td>IT Services</td>
</tr>
<tr>
<td>Business process</td>
<td>Incident Management</td>
</tr>
<tr>
<td>Short description</td>
<td>(Required) Improve average time to resolve an incident by 25%</td>
</tr>
<tr>
<td>Business justification</td>
<td>Average time to resolve an incident time is bad compared to Industry average. I compared our value with global values from companies in the same industry using the Benchmarks application.</td>
</tr>
<tr>
<td>State</td>
<td>New</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low (default)</td>
</tr>
</tbody>
</table>

**Related reference**

Improvement field descriptions
Managing improvements

After an improvement is requested, the Improvement Manager reviews it, assigns an Improvement Coordinator, and monitors progress of all improvements to ensure value and success. The Improvement Coordinator works with the Improvement Manager to implement the improvement.

The Improvement Manager oversees, identifies, drives, and monitors the progress of all improvements.

The Improvement Coordinator manages the improvements to which they have been assigned by the Improvement Manager, and works with the CIM task owners to track task completion.

Note: Although both roles can cancel an improvement, only the Improvement Manager can delete an improvement, which removes it from the Improvement Register list.

Process flow

1. Create improvement initiative
2. Accept improvement initiative
3. Assess improvement initiative
4. Approve improvement initiative
5. Review improvement initiative
6. Close improvement initiative
7. Implement improvement initiative

1. The process flow starts with a new improvement request. A need for improvement is identified in the environment and a new improvement request is submitted by a user with the Improvement Requester role.

2. The Improvement Manager then verifies that the new improvement request aligns with at least one company strategic objective, and assigns an Improvement Coordinator before accepting the improvement as valid. The assigned Improvement Coordinator is notified that the improvement request has been accepted.

There is typically more than one Improvement Coordinator in a company since that role is responsible for implementing and tracking the progress of
assigned improvement initiatives at the task level, and there can be many tasks per improvement.

3. Once accepted, the Improvement Manager sets the remaining attributes on the Improvement Initiative form, and progresses it to be assessed for approval (by Approver group members).

4. During assessment, users in the approver group (shown in the Approvers related list) are notified of the approval request. One or all of the approver group members evaluate the improvement attributes and either approve or reject the improvement.

5. Once approved, the Improvement Coordinator and Improvement Manager work together (in regular implementation meetings, for example) to determine what work is needed to ready the improvement for implementation.

During implementation, the Improvement Coordinator creates and assigns phases and can create tasks directly from an initiative or from a phase to complete the improvement. The Improvement Coordinator works with the task owners (in regular task status meetings, for example) to track the progress of task completion. Records for other supported applications can also be created from within the improvement initiative or CIM task, if needed, and are typically shown in a related list in the improvement initiative or CIM task.

If, for some reason, implementation for the improvement has been halted, the Improvement Manager or Improvement Coordinator can place the improvement on hold. All CIM tasks that are not closed or canceled are also placed on hold. You can cancel a CIM initiative at any stage when the initiative is in progress. When you cancel an initiative, the initiative as well as the tasks associated with the initiative move to Closed Incomplete.

6. The Improvement Coordinator places the improvement under review when all CIM tasks in all CIM phases are verified 100% complete. The Improvement Manager reviews the improvement completeness and sets the improvement to closed.

**CIM task progress rollup calculation**

You can create a task directly from an initiative or from a phase. When a task is moved to the Closed Complete state, the progress of the CIM initiative is calculated based on the percentage of all tasks that are in Closed Complete state for that initiative. The duration of the task which is based on the planned end date is also taken into consideration when the progress of the CIM initiative is calculated. The longer the duration, the slower the progress. As you add new tasks to a phase or associate it directly with the CIM initiative, the percentage completion for the CIM initiative is updated accordingly.
The table below shows an example of how the CIM task progress rollup is calculated.

### Example CIM task progress rollup calculation

<table>
<thead>
<tr>
<th>Parent Record</th>
<th>Task</th>
<th>Task duration</th>
<th>State</th>
<th>Contribution to initiative progress (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIM Phase 1</td>
<td>Task 1</td>
<td>2 days</td>
<td>Closed Complete</td>
<td>20%</td>
</tr>
<tr>
<td>CIM Phase 1</td>
<td>Task 2</td>
<td>3 days</td>
<td>Closed Complete</td>
<td>30%</td>
</tr>
<tr>
<td>CIM Initiative</td>
<td>Task 3</td>
<td>2 days</td>
<td>Any state other than Closed Complete</td>
<td>50%</td>
</tr>
</tbody>
</table>

**Note:**
This task is directly associated with the CIM initiative.

### Alignment with company strategic objectives

You can ensure alignment with company goals by setting the Strategies field on the Improvement Initiative form to one or more company enterprise strategies from the Strategic Objectives lookup list so they are linked.

**Note:** Only the Improvement Manager can create a strategy.

Coordinating improvements with enterprise strategies of the company ensures the improvement contributes to the overall goals of the company.

Access enterprise strategies by navigating to Continual Improvement > Enterprise Strategies (or Organization > Enterprise Strategy).

### Improvement Register list

View, prioritize, and track improvements, related tasks, and phases from one Improvement Register list that includes all open and closed improvements in one list.
Embedded Performance Analytics scorecard

Use the Performance Analytics scorecard embedded in the Improvement Initiative form for continuous KPI monitoring, and to track the progress of the KPI improvement during the lifecycle of the improvement. The KPI scorecard is useful so you can monitor the incremental benefits of the KPI, or adjust CIM tasks and assignments to meet your improvement goal, if needed.

Embedded KPI scorecard

The improvement icon (roof) indicates the start and end dates that are tracked on the KPI scorecard chart.

Scorecards are also shown for any KPIs listed in Impacted KPIs related list on the Improvement Initiative form.
Accept an improvement

Accept and assign a new improvement request so it can be assessed for approval. You can reject the improvement request if it does not align with company strategic objectives.

Before you begin
Role required: sn_cim.improvement_manager, sn_cim.improvement_coordinator

About this task

1. Create a CIM request
2. Accept a CIM initiative
3. Assess CIM initiative
4. Approve an initiative
5. CIM initiative in progress
6. Review CIM initiative
7. Close CIM initiative

Precondition: Improvement Requester created an improvement request.

Procedure

1. Identify the new improvement request.
   a. Navigate to Continual Improvement > Open.
   b. In the Improvement Register list, open an improvement in the New state.
2. Align the improvement request with company strategic objectives, and assign an Improvement Coordinator.
   a. On the Improvement Initiative form, unlock the Strategies field to access your company strategic objectives, then click the lookup list.
   b. Select the enterprise strategy aligned with the improvement request.
Note: Only the Improvement Manager can create a strategy.

c. Click the CIM Coordinator lookup list and select an Improvement Coordinator to manage the improvement.

3. Complete the fields for business service, business process, priority, effort estimate, benefits, and why this improvement is important.

4. In the header bar, click Accept to progress the improvement request to the Assess state.
   Improvement Coordinator is notified of assignment.

5. Complete the content in the Goals, Details, and Schedule tabs on the Improvement Initiative form.

Example: Accept improvement request

In the process of reviewing KPI performance in the Performance Analytics application, the incident manager noticed the Average time to resolve an incident KPI scorecard was too high (24 hours).

As part of the acceptance process, the Improvement Manager determined that KPI performance improvement aligned with the Automation/Effort Reduction strategic objective, assigned the Improvement Coordinator that drives KPI improvements, and accepted the improvement request.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIM0000135 (set internally)</td>
</tr>
<tr>
<td>Business service</td>
<td>IT Services</td>
</tr>
<tr>
<td>Business Process</td>
<td>Incident Management</td>
</tr>
<tr>
<td>CIM Coordinator</td>
<td>Adela Cervantsz</td>
</tr>
<tr>
<td>Approver Group</td>
<td>CIM Approvers</td>
</tr>
<tr>
<td>Strategies</td>
<td>Automation/Effort Reduction</td>
</tr>
<tr>
<td>State</td>
<td>Accepted</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low</td>
</tr>
<tr>
<td>Effort estimate</td>
<td>Medium</td>
</tr>
<tr>
<td>Benefits</td>
<td>High</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
### Improvement Initiative form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent complete</td>
<td>0</td>
</tr>
<tr>
<td>Short description</td>
<td>Improve average time to resolve an incident by 25%</td>
</tr>
<tr>
<td>Business justification</td>
<td>Average time to resolve an incident time is bad compared to Industry average. I compared our value with global values from companies in the same industry using the Benchmarks application.</td>
</tr>
</tbody>
</table>

### Goals tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success measurement method</td>
<td>Automated: PA Indicator</td>
</tr>
<tr>
<td>Improvement KPI</td>
<td>Average close time of incidents</td>
</tr>
<tr>
<td>Breakdown</td>
<td>--</td>
</tr>
<tr>
<td>Aggregation</td>
<td>--</td>
</tr>
<tr>
<td>Base value</td>
<td>100</td>
</tr>
<tr>
<td>Percentage improvement</td>
<td>25</td>
</tr>
<tr>
<td>Target value</td>
<td>75</td>
</tr>
<tr>
<td>Target review date</td>
<td>2018-06-30</td>
</tr>
<tr>
<td>Expected outcomes</td>
<td>Improvement in average time to resolve an incident.</td>
</tr>
</tbody>
</table>

### Details tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested for</td>
<td>Mabel Weeden</td>
</tr>
<tr>
<td>Type</td>
<td>Process</td>
</tr>
<tr>
<td>Watch list</td>
<td>--</td>
</tr>
</tbody>
</table>
## Schedule tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned start date</td>
<td>2018-03-18</td>
</tr>
<tr>
<td>Planned end date</td>
<td>2018-06-19</td>
</tr>
<tr>
<td>Actual start date</td>
<td>2018-03-11</td>
</tr>
<tr>
<td>Actual end date</td>
<td>--</td>
</tr>
</tbody>
</table>

## Notes tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional comments (Customer visible)</td>
<td>--</td>
</tr>
<tr>
<td>Work notes</td>
<td>--</td>
</tr>
</tbody>
</table>

## Related reference

- Improvement field descriptions

## Prepare an improvement

Once the improvement is approved, you can create CIM phases, tasks, and identify impacted KPIs. The Improvement Coordinator for the improvement works with the Improvement Manager to plan implementation.

### Before you begin

**Role required:** sn_cim.improvement_manager, sn_cim.improvement_coordinator

### About this task

Plan your implementation as phases to keep track of your project milestones. Add tasks to the phase and monitor the progress for the milestones. You can also track your goals by creating tasks directly from the initiatives.
1. Create CIM initiative
2. Accept CIM initiative
3. Assess CIM initiative
4. Approve CIM initiative
5. Review CIM initiative
6. Close CIM initiative

Preconditions:

- Improvement Requester created the improvement request.
- Improvement Manager accepted and assigned the improvement request.
- Approver group member assessed and approved the improvement.

Procedure

1. Determine phases and tasks needed for the improvement.
   Improvement Manager and Improvement Coordinator meet to determine the tasks required to complete the improvement, and whether multiple phases are required.

2. Set up CIM phases to track CIM tasks.
   
   a. Navigate to Continual Improvement > Open and open the improvement in the In Progress state.
   
   b. In the CIM Phases related list, click New and fill in the description and planned end date.
   
   c. Right-click the form header and select Save.
   
   d. In the CIM Tasks related list, click New to create a CIM task.
   
   e. In the Parent field, select the a CIM Phase record to which you want to associate the CIM task.
   
   f. Set the CIM task attributes, including assignment, priority, state, planned end date, and short description.
   
   g. Click Submit.

3. Create and assign CIM tasks for an improvement.
a. In the CIM Tasks related list, click **New** to create a CIM task. By default, the CIM task is linked to the CIM initiative. To track the task within a phase, in the **Parent** field, select the a CIM Phase record to which you want to associate the CIM task.

b. Set the CIM task attributes, including assignment, priority, state, planned end date, and short description.

**Note:**
- When the planned end date for a CIM task is updated, the planned end date that the CIM initiative that the task is associated with also gets updated. When the state for a CIM task is moved to Work In Progress, the Actual Start Date field is automatically updated with the current date.
- When the task is assigned, the task assignee receives an email notification.

4. To create a separate application task for an integrated application, click the related link for that application task.

5. To monitor a KPI with the improvement, add a record to the Impacted KPIs tab.

6. Meet with CIM task owners to oversee status, monitor work completed, add or update tasks and phases, and track overall progress of the improvement to completion.

   a. Oversee the progress of CIM tasks with task owners on a regular basis until all tasks are presented as complete.

   b. On the Improvement Initiative form, verify that all tasks in the CIM Tasks related list are **Closed Complete**.
      The improvement coordinator and task assignee receive an email notification when the task is moved to **Close Incomplete**, **Closed Skipped**, or **Closed Complete** state.

   c. On the Improvement Initiative form, verify that all phases in the CIM Phases related list are 100% complete.

7. Click **Review** in the header bar to request the improvement be reviewed by the Improvement Manager for closure.
**Example: Implement improvement**

In the process of reviewing KPI performance in the Performance Analytics application, the incident manager noticed the *Average time to resolve an incident* KPI scorecard was too high (24 hours).

As part of the implementation process, the Improvement Manager and Improvement Coordinator determined the work required in the next three to six months to complete the improvement, with a target review date 3 months after start.

- Configured default CIM Phase 1 (added two CIM tasks), and created CIM Phase 2 (added two CIM tasks).
- Created a Change Management application task record (CHG0030001) associated with CIM Task 2 using the Create Change related link, and set the change record attributes.
- Added four KPIs to the Impacted KPIs tab to monitor with the improvement.

Improvement Coordinator met with CIM task owners regularly to oversee status and monitor work completed, and set the improvement status to review after all implementation was complete.

<table>
<thead>
<tr>
<th>CIM Phase 1: CIM Tasks 1 and 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Parent</td>
</tr>
<tr>
<td>Percent complete</td>
</tr>
<tr>
<td>Planned end date</td>
</tr>
<tr>
<td>Actual end date</td>
</tr>
<tr>
<td>Short description</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CIM Task 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Parent</td>
</tr>
<tr>
<td>Configuration item</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Implementing task</td>
</tr>
</tbody>
</table>
### CIM Phase 1: CIM Tasks 1 and 2 (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned to</td>
<td>Bernard Laboy</td>
</tr>
<tr>
<td>Improvement register</td>
<td>CIM0000135</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low</td>
</tr>
<tr>
<td>State</td>
<td>Open</td>
</tr>
<tr>
<td>Planned end date</td>
<td>2018-06-19</td>
</tr>
<tr>
<td>Short description</td>
<td>Improve % of incidents resolved by first assigned group by using self service and more automation</td>
</tr>
<tr>
<td>Work notes</td>
<td>--</td>
</tr>
<tr>
<td>CIM Task 2</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>CIMT0000119 (assigned internally)</td>
</tr>
<tr>
<td>Parent</td>
<td>CIMT0000116</td>
</tr>
<tr>
<td>Configuration item</td>
<td>--</td>
</tr>
<tr>
<td>Active</td>
<td>(Selected)</td>
</tr>
<tr>
<td>Implementing Task</td>
<td>CHG00300001</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Change Manager</td>
</tr>
<tr>
<td>Improvement register</td>
<td>CIM0000135</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low</td>
</tr>
<tr>
<td>State</td>
<td>Open</td>
</tr>
<tr>
<td>Planned end date</td>
<td>2018-06-19</td>
</tr>
<tr>
<td>Short description</td>
<td>Reduce the reassigned count by using ServiceNow Auto Categorization and Auto Assignment models</td>
</tr>
<tr>
<td>Work notes</td>
<td>--</td>
</tr>
</tbody>
</table>
### CIM Phase 2: CIM Tasks 1 and 2

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIMT0000120</td>
</tr>
<tr>
<td>Parent</td>
<td>CIM0000135</td>
</tr>
<tr>
<td>Percent complete</td>
<td>0</td>
</tr>
<tr>
<td>Planned end date</td>
<td>2018-06-19</td>
</tr>
<tr>
<td>Actual end date</td>
<td>--</td>
</tr>
<tr>
<td>Short description</td>
<td>Knowledge improvements and self-service improvements</td>
</tr>
<tr>
<td>CIM Task 1</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>CIMT0000121 (assigned internally)</td>
</tr>
<tr>
<td>Parent</td>
<td>CIMT0000120</td>
</tr>
<tr>
<td>Configuration item</td>
<td>--</td>
</tr>
<tr>
<td>Active</td>
<td>(Selected)</td>
</tr>
<tr>
<td>Implementing task</td>
<td>--</td>
</tr>
<tr>
<td>Assigned to</td>
<td>David Loo</td>
</tr>
<tr>
<td>Improvement register</td>
<td>CIM0000135</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low</td>
</tr>
<tr>
<td>State</td>
<td>Open</td>
</tr>
<tr>
<td>Planned end date</td>
<td>2018-06-19</td>
</tr>
<tr>
<td>Short description</td>
<td>Add new KB articles for common issues</td>
</tr>
<tr>
<td>Work notes</td>
<td>--</td>
</tr>
<tr>
<td>CIM Task 2</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>CIMT0000123 (assigned internally)</td>
</tr>
<tr>
<td>Parent</td>
<td>CIMT0000120</td>
</tr>
<tr>
<td>Configuration item</td>
<td>--</td>
</tr>
<tr>
<td>Active</td>
<td>(Selected)</td>
</tr>
<tr>
<td>Implementing task</td>
<td>--</td>
</tr>
</tbody>
</table>
### CIM Phase 2: CIM Tasks 1 and 2 (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned to</td>
<td>Adela Cervantsz</td>
</tr>
<tr>
<td>Improvement register</td>
<td>CIM00000135</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low</td>
</tr>
<tr>
<td>State</td>
<td>Open</td>
</tr>
<tr>
<td>Planned end date</td>
<td>2018-06-19</td>
</tr>
<tr>
<td>Short description</td>
<td>Provide training and enablement training for new apps</td>
</tr>
<tr>
<td>Work notes</td>
<td>--</td>
</tr>
</tbody>
</table>

### Change Request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CHG0030001 (set internally)</td>
</tr>
<tr>
<td>Requested by</td>
<td>Improvement Manager</td>
</tr>
<tr>
<td>Configuration item</td>
<td>--</td>
</tr>
<tr>
<td>Planned start date</td>
<td>2018-03-18</td>
</tr>
<tr>
<td>Planned end date</td>
<td>2018-06-19</td>
</tr>
<tr>
<td>Type</td>
<td>Normal</td>
</tr>
<tr>
<td>State</td>
<td>New</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low</td>
</tr>
<tr>
<td>Impact</td>
<td>3 - Low</td>
</tr>
<tr>
<td>Risk</td>
<td>Moderate</td>
</tr>
<tr>
<td>Short description</td>
<td>Reduce the reassigned count by using ServiceNow Auto Categorization and Auto Assignment models.</td>
</tr>
<tr>
<td>Description</td>
<td>--</td>
</tr>
</tbody>
</table>
### Impacted KPIs related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impacted KPI</td>
<td>• % of incidents resolved by first assigned group</td>
</tr>
<tr>
<td></td>
<td>• % of incidents resolved on same day opened</td>
</tr>
<tr>
<td></td>
<td>• % of incidents resolved without reassignment</td>
</tr>
<tr>
<td></td>
<td>• Average age open incidents</td>
</tr>
</tbody>
</table>

### Related reference

- Improvement field descriptions
- Improvement integration with other applications

### Assess an improvement for approval

Once accepted and set to assess, Approver group members evaluate the improvement for approval before implementation can begin.

### Before you begin

**Role required:** None (must be a member of the Approver group)

### About this task

1. Create a CIM request
2. Accept a CIM initiative
3. Assess a CIM initiative
4. Approve a CIM initiative
5. A CIM initiative in progress
6. Review a CIM initiative
7. Close a CIM initiative
Note: Only one Approver group member needs to approve the improvement before moving to the next state. To require additional approvers, configure the CIM Approval workflow in Flow Designer.

The default expiration period for approval requests is seven business days. Pending approval requests are automatically canceled after seven days but can be resubmitted for approval.

Preconditions:
- Incident manager created an improvement request.
- Improvement Manager accepted and assigned the improvement request.

By default, an improvement requires approval before it can progress to the Implement state. You can disable the approval requirement using the `sn_cim.need_approval` property. When disabled, the Approver group field and the Approvers related list on the Improvement Initiative form are not shown.

Procedure

1. Navigate to Self Service > My Approvals.
2. On the Approval form, scroll down to the Summary of Item being approved section and assess the details of the improvement, including alignment with strategic objectives (strategies), business service, business process, priority, effort estimate, benefits, and why this improvement is important.
3. Click Approve in the header bar to approve the improvement. The improvement is ready for implementation by the Improvement Manager and Improvement Coordinator.

   A default CIM phase (CIMT number) is automatically created.

Example: Approve an improvement

In the process of reviewing KPI performance in the Performance Analytics application, the incident manager noticed the Average time to resolve an incident KPI scorecard was too high (24 hours).

As part of the approval process, an Approver group member assessed the details of the improvement and approved it to begin implementation.

### Approval form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approver</td>
<td>Howard Johnson</td>
</tr>
<tr>
<td>State</td>
<td>Approved</td>
</tr>
</tbody>
</table>
**Approval form (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approving</td>
<td>CIM0000135</td>
</tr>
<tr>
<td>Comments</td>
<td>--</td>
</tr>
</tbody>
</table>

**Related reference**

Improvement field descriptions

**Review and close an improvement**

Once all tasks in each phase of the improvement have been completed, the Improvement Coordinator sets the improvement to review for the Improvement Manager to close.

**Before you begin**

Role required: sn_cim.improvement_manager, sn_cim.improvement_coordinator

**About this task**

1. Create CIM initiative
2. Accept CIM initiative
3. Assess CIM initiative
4. Approve a CIM initiative
5. Review a CIM initiative

Preconditions:

- Incident manager created an improvement request.
- Improvement Manager accepted and assigned the improvement request.
- Approver group member approved the improvement.
- Improvement Manager and Improvement Coordinator implemented the improvement.
Procedure

1. Review the improvement for closure.
   a. Navigate to Continual Improvement > Under Review.
   b. In the Improvement Register list, open the improvement in the Monitor/Review state.
   c. On the Improvement Initiative form, verify that all phases in the CIM Phases related list are 100% complete.

2. Verify the improvement has met the improvement goal.

3. Close the improvement.
   a. In the Closure Notes tab, set the closure code, achieved outcome category, and close notes.

   b. Click Close in the header bar to close the improvement. The improvement is no longer shown in the Open Improvement Register list.

Example: Close improvement

In the process of reviewing KPI performance in the Performance Analytics application, the Incident Manager noticed the Average time to resolve an incident KPI scorecard was too long (24 hours).

As part of the review process for Improve average time to resolve an incident by 25% improvement, the Improvement Manager verified the work for the improvement is complete (Improvement Initiative form and CIM Phases related list shows 100% complete).

The Improvement Manager also verified the improvement in two places before closing the improvement.

• Performance Analytics now shows that the Average time to resolve an incident KPI has a value of 16 hours, which is more improvement than the target value of 18 hours (18 hours is 25% faster than the previous average of 24 hours).

• Benchmarks application now shows that the company result for the Average time to resolve an incident KPI has a value of 16 hours, which is 2 hours better than the global industry average.
### CIM Phase 1: CIM Tasks 1 and 2

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIMT0000116 (assigned internally)</td>
</tr>
<tr>
<td>Percent complete</td>
<td>*100</td>
</tr>
<tr>
<td>Actual end date</td>
<td>*2018-03-14</td>
</tr>
<tr>
<td>Short description</td>
<td>Resolved incident and reassigned count improvements</td>
</tr>
</tbody>
</table>

#### CIM Task 1

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIMT0000118 (assigned internally)</td>
</tr>
<tr>
<td>Active</td>
<td>*(Not selected)</td>
</tr>
<tr>
<td>State</td>
<td>*Closed Complete</td>
</tr>
<tr>
<td>Short description</td>
<td>Improve % of incidents resolved by first assigned group by using self service and more automation</td>
</tr>
<tr>
<td>Work notes</td>
<td>*Self service and automation implemented to improve % of incidents resolved by first assigned group</td>
</tr>
</tbody>
</table>

#### CIM Task 2

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIMT0000119 (assigned internally)</td>
</tr>
<tr>
<td>Active</td>
<td>*(Not selected)</td>
</tr>
<tr>
<td>State</td>
<td>*Closed Complete</td>
</tr>
<tr>
<td>Short description</td>
<td>Reduce the reassigned count by using ServiceNow Auto Categorization and Auto Assignment models</td>
</tr>
<tr>
<td>Work notes</td>
<td>*Auto Categorization and Auto Assignment implemented to reduce reassigned count</td>
</tr>
</tbody>
</table>
## CIM Phase 2: CIM Tasks 1 and 2

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIMT0000120</td>
</tr>
<tr>
<td>Percent complete</td>
<td>*100</td>
</tr>
<tr>
<td>Actual end date</td>
<td>*2018-03-14</td>
</tr>
<tr>
<td>Short description</td>
<td>Knowledge improvements and self service improvements</td>
</tr>
</tbody>
</table>

### CIM Task 1

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIMT0000121 (assigned internally)</td>
</tr>
<tr>
<td>Active</td>
<td>*(Not selected)</td>
</tr>
<tr>
<td>State</td>
<td>*Closed Complete</td>
</tr>
<tr>
<td>Short description</td>
<td>Add new KB articles for common issues</td>
</tr>
<tr>
<td>Work notes</td>
<td>*These new KB articles were added</td>
</tr>
</tbody>
</table>

### CIM Task 2

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>CIMT0000123 (assigned internally)</td>
</tr>
<tr>
<td>Active</td>
<td>*(Not selected)</td>
</tr>
<tr>
<td>State</td>
<td>*Closed Complete</td>
</tr>
<tr>
<td>Short description</td>
<td>Provide training and enablement training for new apps</td>
</tr>
<tr>
<td>Work notes</td>
<td>*Provided training for these new apps</td>
</tr>
</tbody>
</table>

## Closure Notes tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closure code</td>
<td>*Successful</td>
</tr>
<tr>
<td>Achieved outcome category</td>
<td>*Customer Satisfaction</td>
</tr>
<tr>
<td>Closure notes</td>
<td>*All improvements verified, closing improvement initiative</td>
</tr>
</tbody>
</table>
Improvement Initiative form

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>*Closed Complete</td>
</tr>
<tr>
<td>Percent Complete</td>
<td>*100</td>
</tr>
</tbody>
</table>

**Related reference**

Improvement field descriptions
Improvement integration with other applications

**Continual Improvement Management reference**

Continual Improvement Management reference content including states and field descriptions.

**Improvement states**

The state of an improvement indicates the progress of the improvement in the process.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Improvement request is created either manually, or from within an integrated application by an Improvement Requester. Integrated applications include Benchmarks, CMDB, Coaching, Demand, GRC, Major Incident Management, Problem Management, and Survey Management. <strong>States list:</strong> • Accepted • Cancelled</td>
</tr>
</tbody>
</table>

List Controls menu (≡) options on the Improvement Initiative form: Copy Initiative.
<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
</table>
| Accepted  | Improvement request aligns with company strategic objectives and is considered valid by the Improvement Manager.-states list:  
Assess     | List Controls menu (≡) options on the Improvement Initiative form: Copy Initiative.                                                           |
|           | Canceled                                                                                                                                     |
|           | Improvement is not accepted (Reject action is selected by the Improvement Manager), or can be canceled directly in any state.                  |
|           |  
=i Note: Any CIM tasks created for the improvement are also canceled.                                                                        |
|           | List Controls menu (≡) options on the Improvement Initiative form: Copy Initiative.                                                            |
|           | Assess                                                                                                                                       |
|           | All improvement attributes are set by the Improvement Manager, including business process, business service, and success measurement details.   |
|           | The improvement is waiting to be assessed by an Approver group member for approval.                                                          |
|           | States list:  
Approved  | (only shown for an Approver group member)                                                                                                    |
<p>|           | Canceled                                                                                                                                     |</p>
<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved</td>
<td>The improvement is assessed and approved by an Approver group member and is ready for implementation.</td>
</tr>
<tr>
<td></td>
<td>The improvement is set to implement by the Improvement Manager.</td>
</tr>
<tr>
<td></td>
<td><strong>States</strong> list:</td>
</tr>
<tr>
<td></td>
<td>• Implement</td>
</tr>
<tr>
<td></td>
<td>• Canceled</td>
</tr>
<tr>
<td></td>
<td>• Assess (for reapproval)</td>
</tr>
<tr>
<td></td>
<td>If additional tasks were added, or if the target has changed, the improvement may need to go through approval again.</td>
</tr>
<tr>
<td>Implement</td>
<td>CIM task creation is completed by the Improvement Manager or Improvement Coordinator. CIM tasks are completed by the task owners.</td>
</tr>
<tr>
<td></td>
<td>The Improvement Coordinator determines either that the improvement is complete and sets it to review, or that progress is halted and places it on hold.</td>
</tr>
<tr>
<td></td>
<td><strong>States</strong> list:</td>
</tr>
<tr>
<td></td>
<td>List Controls menu (≡) options on the Improvement Initiative form:</td>
</tr>
<tr>
<td></td>
<td>• Copy Initiative</td>
</tr>
<tr>
<td></td>
<td>• Submit for Re-Approval</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor/Review</td>
<td></td>
</tr>
<tr>
<td>On Hold</td>
<td></td>
</tr>
<tr>
<td>Assess (for reapproval)</td>
<td></td>
</tr>
</tbody>
</table>

If additional tasks were added, or if the target has changed, the improvement may need to go through approval again.

List Controls menu (≡) options on the Improvement Initiative form:

- Copy Initiative
- Submit for Re-Approval

**On Hold**

Improvement is no longer in progress but may resume at a later date.

The Improvement Manager determines the outcome of the improvement including whether it should go back to implementation, or be closed or canceled.

**States list:**

- Implement
- Closed
- Canceled

**Note:** When an improvement is placed on hold, all active CIM tasks (not closed or canceled) are also placed on hold, but the state can be changed manually.

When the improvement is taken off hold, all active CIM tasks (not closed or canceled) are set to Open state (unless they were changed manually).
<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor/Review</td>
<td>All CIM tasks for the improvement are complete, improvements have been measured, and no further action is required by the task owners. The improvement is reviewed for closure by the Improvement Manager. States list: • Implement • Closed • Assess (for reapproval) If additional tasks were added, or if the target has changed, the improvement may need to go through approval again.</td>
</tr>
<tr>
<td>Closed</td>
<td>Improvement is complete and is added to the Closed Improvement Register list.</td>
</tr>
<tr>
<td>Delete</td>
<td>Improvement is removed from the Improvement Register list. Available in each state but only to the Improvement Manager.</td>
</tr>
</tbody>
</table>

**CIM task states**

An improvement contains one or more CIM tasks to complete the improvement. A CIM task is assigned to an owner to be responsible for the work specified.

The state of a CIM task indicates the level of progress for the task.
<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>State of a CIM task added before the improvement has been approved. If a CIM task is added after the improvement is approved, the CIM task is set to Pending state until the improvement is approved again. Once approved, the CIM task is set to Open state. If rejected, the CIM task remains in the Pending state.</td>
</tr>
<tr>
<td>Open</td>
<td>State of a new CIM task for an improvement that has been approved.</td>
</tr>
<tr>
<td>Work in Progress</td>
<td>State of a CIM task for which work has begun.</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>State of a closed CIM task that has been completed.</td>
</tr>
<tr>
<td>Closed Incomplete</td>
<td>State of a closed CIM task that has been closed but not fully completed.</td>
</tr>
<tr>
<td>Closed Skipped</td>
<td>State of a closed CIM task for which no work has been done.</td>
</tr>
<tr>
<td>On Hold</td>
<td>State of a CIM task for an improvement set to On Hold state. The state of a CIM task on hold can be manually changed to Open or Work In Progress states.</td>
</tr>
</tbody>
</table>
State | Description
--- | ---
Note: | When an improvement is placed on hold, all active CIM tasks (not closed or canceled) are also placed on hold, but the state can be changed manually. When the improvement is taken off hold, all active CIM tasks (not closed or canceled) are set to Open state (unless they were changed manually).

CIM approver states
Each improvement needs at least one approval to progress to the Implement state. The Approvers related list in the improvement contains a list of user approval records and the state of the approval.

The users in the Approvers related list belong to the Approver Group specified on the Improvement Initiative form. Once the improvement has been approved by an Approver Group member, approval from other members is no longer required to progress the improvement. However, other Approver Group members can still set their individual approval state.

To require additional approvers, configure the CIM Approval workflow in Flow Designer.

Improvement process flow

<table>
<thead>
<tr>
<th>Process flow</th>
<th>Role</th>
<th>Description</th>
<th>Next action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Improvement Initiative</td>
<td>Improvement Requester</td>
<td>The need is determined for an improvement and an improvement request is created.</td>
<td>Click Submit. Required: Short Description</td>
</tr>
<tr>
<td>New</td>
<td>Improvement Manager</td>
<td>Acceptance is determined by verifying that the improvement</td>
<td>Click Accept. Required:</td>
</tr>
<tr>
<td>Process flow</td>
<td>Role</td>
<td>Description</td>
<td>Next action</td>
</tr>
<tr>
<td>--------------</td>
<td>------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
|              |      | objective aligns to a company strategic objective, and an Improvement Coordinator is assigned. | • Improvement Coordinator  
• Strategies |
| Accepted     | Improvement Manager | Other attributes are set and the improvement request is ready to be assessed for approval (by Approver group members). | Click **Assess**.  
(Waiting for approval)  
Approver group members are notified.  
Required: Approver Group |
| Assessed     | CIM approver (member of the Approver group) CIM approver states | The improvement attributes are assessed for approval from the Approvers related list. | Click **Approved**. |
| Approved     | Improvement Manager or Improvement Coordinator | Improvement Coordinator and Improvement Manager work together to determine what is needed to ready the improvement for implementation. | Click **Implement**.  
**Actual start date** (Schedule tab) is automatically populated. |
| Implement    | Improvement Coordinator | Implementation of the improvement begins with the assigned task owners.  
Any problem, change, or | Click **Review** if implementation is complete.  
Click **On Hold** if the process has halted. |
<table>
<thead>
<tr>
<th>Process flow</th>
<th>Role</th>
<th>Description</th>
<th>Next action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>knowledge submission is shown in the corresponding related list.</td>
<td>Required: On Hold Reason</td>
</tr>
<tr>
<td>On Hold</td>
<td>Improvement Manager or Improvement Coordinator</td>
<td>Implementation for the improvement has halted (On Hold state) but the process flow remains in Implement.</td>
<td>Click Implement to continue the process. Click Close if no further work will be done.</td>
</tr>
<tr>
<td>Review</td>
<td>Improvement Manager</td>
<td>The improvement attributes are reviewed for completeness and efficacy for closure.</td>
<td>Click Close. Required: Closure Notes tab Actual end date is automatically populated.</td>
</tr>
</tbody>
</table>

**Improvement integration with other applications**

You can create an improvement request from within multiple integrated applications. You can also create many application tasks from within an improvement initiative. Set the Continual Improvement Management attributes property to determine which field values get copied to integrated application tasks.

Set Continual Improvement Management properties for integration with other applications.

As part of Continual Improvement Management integration with other applications, improvement requests can be created from within other applications and, conversely, records for other applications can be created from within an improvement initiative (or CIM task).

Multiple tasks from outside integrated applications can be linked to a single improvement initiative (or CIM task), and multiple CIM tasks can be linked to a single integrated application task for maximum flexibility when creating improvements.

An improvement initiative can be created from these applications.
As part of an improvement initiative, these records can be created.

- Demand record
- Project (optional)

- As part of a CIM task:
  - Change record
  - Coaching opportunity
  - Knowledge base article (optional)
  - Create a story

**Integration property**

You can set field values that get copied to the improvement request when the improvement request is created from within another application.

To access Continual Improvement Management properties, navigate to **Continual Improvement > Administration > Properties**.

ℹ️ **Note:** System admin role is required to set Continual Improvement Management properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of attributes (comma-separated)</td>
<td>Specifies the field values that are copied from the originating improvement initiative to the application task record (for example, demand, project, change record)</td>
</tr>
<tr>
<td>sn_cim.initiative_copy_attributes</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>created from the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td>• Short description (short_description)</td>
</tr>
<tr>
<td></td>
<td>• Description (description)</td>
</tr>
<tr>
<td></td>
<td>• Priority (priority)</td>
</tr>
<tr>
<td></td>
<td>• CIM estimate (cim_estimate)</td>
</tr>
<tr>
<td></td>
<td>• Benefit (benefit)</td>
</tr>
<tr>
<td></td>
<td>• Assigned to (assigned_to)</td>
</tr>
<tr>
<td></td>
<td>• Strategic objective (strategic_objective)</td>
</tr>
<tr>
<td></td>
<td>• Business process (business_process)</td>
</tr>
<tr>
<td></td>
<td>• Business service (business_service)</td>
</tr>
<tr>
<td></td>
<td>• Approver group (approver_group)</td>
</tr>
<tr>
<td></td>
<td>• Type (type)</td>
</tr>
</tbody>
</table>

Create Improvement Initiative related link

- **Benchmarks**
  When you create an improvement initiative from Benchmarks, the improvement is associated with the Benchmarks recommendation candidate, and the Benchmarks KPI is added to the improvement initiative.

<table>
<thead>
<tr>
<th>Benchmarks recommendation candidate</th>
<th>Improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td>◦ Create Improvement Initiative related link is added.</td>
<td>Benchmarks recommendation KPI is added to the Improvement KPI field on the Goals tab.</td>
</tr>
<tr>
<td>◦ Create Improvement Initiative related link is replaced by the CIM number related link once an improvement initiative is created.</td>
<td></td>
</tr>
</tbody>
</table>

- **Coaching**
  When you create an improvement initiative from Coaching, the Improvement Initiatives related list is added to the coaching opportunity, and the coaching opportunity details are added to the improvement initiative.
Coaching opportunity  Improvement initiative

- **Create Improvement Initiative** related link is added.
- Improvement Initiatives related list is added that contains the improvement initiative (CIM) record.

Coaching opportunity record to which the improvement initiative is linked is added to the **Source/Parent** field in the Details tab.

• **Configuration Management Database (CMDB)**

When you create an improvement initiative from CMDB, the Improvement Initiatives related list is added to the task, and the Remediate Duplicate Task details are added to the improvement initiative.

Remediate Duplicate Tasks record  Improvement initiative

- **Create Improvement Initiative** related link is added.
- Improvement Initiatives related list is added that contains the improvement initiative (CIM) record.

Remediate Duplicate Tasks record to which the improvement initiative is linked is added to the **Source/Parent** field in the Details tab.

• **Demand Management**

When you create an improvement initiative from Demand Management, the improvement initiative is associated with the demand record, and the demand details are added to the improvement initiative.

Demand record  Improvement initiative

- **Create Improvement Initiative** related link is added.
- Improvement initiative (CIM) record is set in the **Improvement** field.

Demand record to which the improvement initiative is linked is added to the **Source/Parent** field in the Details tab.

**Note:** When the improvement is closed, the demand record is set to complete.

• **Governance, Risk, and Compliance (GRC)**
When you create an improvement initiative from GRC, the improvement initiatives related list is added to the issue, and the issue details are added to the improvement initiative.

<table>
<thead>
<tr>
<th>Issue record</th>
<th>Improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td>◦ Create Improvement Initiative related link is added.</td>
<td>Issue record to which the improvement initiative is linked is added to the Source/Parent field on the Details tab.</td>
</tr>
<tr>
<td>◦ Improvement Initiatives related list is added that contains the improvement initiative (CIM) record.</td>
<td></td>
</tr>
</tbody>
</table>

• Incident Management
When you create an improvement initiative from Incident Management, the improvement initiative is associated with the incident record, and the incident details are added to the improvement initiative.

<table>
<thead>
<tr>
<th>Incident record</th>
<th>Improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Improvement Initiative</strong> related link is added.</td>
<td>Incident (INC) record is added to the Source/Parent field on the Details tab.</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/15" alt="Note" /> You must customize the Incident form to show the Improvement Initiatives related list that contains the improvement initiative (CIM) record.</td>
<td></td>
</tr>
</tbody>
</table>

• Problem Management
When you create an improvement initiative from Problem Management, the improvement is associated with the problem record, and the problem details are added to the improvement initiative.

<table>
<thead>
<tr>
<th>Problem record</th>
<th>Improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Improvement Initiative</strong> related link is added.</td>
<td>Problem (PRB) record is added to the Source/Parent field on the Details tab.</td>
</tr>
</tbody>
</table>
Problem record | Improvement initiative
---|---
*Note:* You must customize the Problem form to show the Improvement Initiatives related list that contains the improvement initiative (CIM) record.

<table>
<thead>
<tr>
<th>Problem record state</th>
<th>Improvement initiative state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>New</td>
</tr>
<tr>
<td>Pending change</td>
<td>In Progress</td>
</tr>
<tr>
<td>Closed/Resolved</td>
<td>Closed</td>
</tr>
</tbody>
</table>

- **Survey Management and Assessments**
  When you create an improvement initiative from Survey Management, the improvement is associated with the Survey, and the survey details are added to the improvement initiative. (Assessment Metric Type [Survey view] record)

<table>
<thead>
<tr>
<th>Survey definition record</th>
<th>Improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Improvement Initiative related link is added.</td>
<td>Survey definition (Assessment Metric Type [Survey view]) record is added to the <strong>Source/Parent</strong> field on the Details tab.</td>
</tr>
<tr>
<td>Improvement Initiatives related list is added that contains the improvement initiative (CIM) record.</td>
<td></td>
</tr>
</tbody>
</table>

**Related links in improvement initiatives**

- **Create Demand**
  When you create a demand record from an improvement initiative, the demand record is associated with the improvement initiative, and the Demands related list is added to the improvement initiative.
<table>
<thead>
<tr>
<th>Improvement initiative</th>
<th>Demand record</th>
</tr>
</thead>
<tbody>
<tr>
<td>◦ Create Demand related link is added.</td>
<td>◦ Continual Improvement Management is set in the Type field.</td>
</tr>
<tr>
<td>◦ Demands related list is added that contains the demand (DMND) record.</td>
<td>◦ Improvement initiative (CIM) record is set in the Improvement field.</td>
</tr>
</tbody>
</table>

**Create Project**
When you create a project record from an improvement initiative, the Projects related list is added to the improvement initiative.

<table>
<thead>
<tr>
<th>Improvement initiative</th>
<th>Project record</th>
</tr>
</thead>
<tbody>
<tr>
<td>◦ Create Project related link is added.</td>
<td>No change.</td>
</tr>
<tr>
<td>◦ Projects related list is added that contains the project (PRJ) record.</td>
<td></td>
</tr>
</tbody>
</table>

**Create PA Indicator** related link
Create a Performance Analytics automated indicator.

**Show Benchmarks** related link
Shows the benchmarks for the KPI specified in the Improvement Initiative form Improvement KPI field using the Benchmarks application.

### Related links in improvement initiative CIM tasks

tip Related links in CIM tasks are shown only when a CIM task is in Open, Work in Progress, or On Hold state.

**Create Change**
When you create a change (CHG) record from an improvement initiative CIM task, the change record is added to the Change Requests related list in the CIM task.

<table>
<thead>
<tr>
<th>Improvement initiative CIM task</th>
<th>Change record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change (CHG) record is added to the Change Requests related list.</td>
<td>No change.</td>
</tr>
<tr>
<td>Improvement initiative CIM task state</td>
<td>Change record state</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>New</td>
<td>New</td>
</tr>
<tr>
<td>In Progress</td>
<td>Implement</td>
</tr>
<tr>
<td>Closed</td>
<td>Closed</td>
</tr>
</tbody>
</table>

- **Create Coaching Opportunity**
  When you create a coaching opportunity from an improvement initiative CIM task, the coaching opportunity record is added to the Coaching Opportunities related list in the CIM task.

<table>
<thead>
<tr>
<th>Improvement initiative CIM task</th>
<th>Coaching opportunity record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching opportunity (COP)</td>
<td>No change.</td>
</tr>
<tr>
<td>record is added to the</td>
<td></td>
</tr>
<tr>
<td>Coaching Opportunities</td>
<td></td>
</tr>
<tr>
<td>related list.</td>
<td></td>
</tr>
</tbody>
</table>

- **Create Knowledge**
  When you create a Knowledge Management knowledge base article (KB) record from an improvement initiative CIM task, the KB article record is added to the Knowledge Articles related list in the CIM task.

<table>
<thead>
<tr>
<th>Improvement initiative CIM task</th>
<th>Knowledge base article record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge article record</td>
<td>No change.</td>
</tr>
<tr>
<td>is added to the Knowledge</td>
<td></td>
</tr>
<tr>
<td>Articles related list.</td>
<td></td>
</tr>
</tbody>
</table>

- **Create Story**
  When you create an Agile Management story record from an improvement initiative CIM task, the story record is added to the Stories related list in the CIM task.

<table>
<thead>
<tr>
<th>Improvement initiative CIM task</th>
<th>Story record</th>
</tr>
</thead>
<tbody>
<tr>
<td>The story (STRY) record is</td>
<td>No change.</td>
</tr>
<tr>
<td>added to the Stories</td>
<td></td>
</tr>
<tr>
<td>related list.</td>
<td></td>
</tr>
</tbody>
</table>
### Integration with other applications

<table>
<thead>
<tr>
<th>Application</th>
<th>Application record</th>
<th>Create improvement initiative</th>
<th>Create application record from improvement initiative</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audit Management</td>
<td>Issue record</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>IT Business Management</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agile Development</td>
<td>Story record</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Demand Management</td>
<td>Demand record</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Project Management</td>
<td>Project record</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>IT Operations Management</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CMDB</td>
<td>RemEDIATE Duplicate Task record</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>IT Service Management</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Benchmarks</td>
<td>Benchmarks recommendation</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Change Management</td>
<td>Change record</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Major Incident Management</td>
<td>Post incident review workbench</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Problem Management</td>
<td>Problem record</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Platform Capabilities</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Knowledge Management</td>
<td>Knowledge base article</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Survey Management</td>
<td>Survey</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>
Extension point

You can use the Continual Improvement Management integration extension point to define an application to be integrated.

Extend sn_cim.CIMIntegrationAPI extension point to integrate Continual Improvement Management with other applications.

Related information

- Using extension points to extend application functionality
- Using scripted extension points in server-side scripts
- Using UI extension points in server-side UI macros
- Using client extension points in client-side UI scripting

Improvement field descriptions

Improvement Initiative form and related field descriptions.

Improvement Initiative form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique CIM number.</td>
</tr>
<tr>
<td>Business service</td>
<td>CMDB Business service improved by the improvement initiative.</td>
</tr>
<tr>
<td>Service offering</td>
<td>Service offering associated with this improvement initiative.</td>
</tr>
<tr>
<td>Business process</td>
<td>Business process improved by the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td>When a business process is selected, the improvement area <strong>Type</strong> field on the Details tab is automatically set to Process.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CIM Coordinator</td>
<td>User primarily responsible for ensuring the completion of the improvement initiative. The CIM Coordinator must have the Improvement Coordinator role (sn_cim.improvement_coordinator).</td>
</tr>
<tr>
<td>Approver group</td>
<td>Group of users that have permission to approve the improvement initiative. CIM Approvers group is added with Continual Improvement Management. Default is empty.</td>
</tr>
<tr>
<td>Strategies</td>
<td>Strategic objectives impacted by the improvement initiative. Multiple strategic objectives can be selected. Strategic objectives can be added from the lookup list. The lookup list contains both Continual Improvement Management strategic objectives and business enterprise strategies to align with the improvement initiative. An enterprise strategy can be added from the navigation menu Continual Improvement &gt; Enterprise Strategies. Also accessible through Business Planner and Organization navigation menus. <strong>Note:</strong> If the improvement initiative does not align with a company strategic objective, you can click Reject in the header bar to reject the improvement initiative.</td>
</tr>
<tr>
<td>State</td>
<td>State of the improvement initiative. This field is read only. • New • Accepted • Assess • Approved • In Progress • On Hold • Review</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>On hold reason</td>
<td>Reason for putting the improvement initiative on hold. <strong>Note:</strong> This field is shown only when the state is on hold.</td>
</tr>
<tr>
<td></td>
<td>When an improvement initiative is placed on hold, all CIM tasks are also placed on hold, but the state can be changed manually.</td>
</tr>
<tr>
<td></td>
<td>When the improvement initiative is taken off hold, the CIM tasks are returned back to their previous state unless they were changed manually.</td>
</tr>
<tr>
<td>Priority</td>
<td>Sequence in which an incident or problem is to be worked on, based on impact and urgency.</td>
</tr>
<tr>
<td></td>
<td>• 1 - Critical</td>
</tr>
<tr>
<td></td>
<td>• 2 - High</td>
</tr>
<tr>
<td></td>
<td>• 3 - Moderate</td>
</tr>
<tr>
<td></td>
<td>• 4 - Low</td>
</tr>
<tr>
<td></td>
<td>• 5 - Planning</td>
</tr>
<tr>
<td>Effort estimate</td>
<td>Estimate of effort to complete all required tasks for the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td>• Small</td>
</tr>
<tr>
<td></td>
<td>• Medium</td>
</tr>
<tr>
<td></td>
<td>• Large</td>
</tr>
<tr>
<td></td>
<td>• Extra Large</td>
</tr>
<tr>
<td>Benefits</td>
<td>Expected level of benefits achieved by completing the improvement initiative.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Percentage of work completed. The percentage is based on the completed state of the CIM phases that belong to this improvement initiative. For example, if there are five CIM phases, each contributes to 20% completion.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief explanation of the improvement initiative.</td>
</tr>
<tr>
<td>Business justification</td>
<td>Description about the importance of the improvement and additional details that includes metrics or KPIs used to measure the success.</td>
</tr>
</tbody>
</table>

**Goals tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Success measurement method    | • Automated: PA Indicator: An improvement KPI.  
• Reports: Reports to track progress. Users who do not use performance analytics can add reports to track the initiatives.  
• Survey and Assessment: An Assessment metric type.  
• Manual: All other types.                                                                 |
| Improvement KPI               | Primary KPI used to measure the improvement of the improvement initiative. The Show Score Card icon launches the Performance Analytics score card for the improvement KPI. |
| Breakdown                     | The breakdown of the improvement KPI, if one exists.  
| **Note:** This field is shown only when the Success Measurement Method field is set to Automated: PA Indicator. |
| Element                       | The element of the KPI breakdown.  
| **Note:** This field is shown only when a breakdown is selected. |
| 2nd Breakdown                 | The second-level breakdown of the improvement KPI, if one exists.  
<p>| <strong>Note:</strong> This field is shown only after the first breakdown is selected. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2nd Element</td>
<td>The element of the second-level KPI breakdown.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only when a second-level breakdown is selected.</td>
</tr>
<tr>
<td>Time Series</td>
<td>Time series for the improvement KPI.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only when an improvement KPI is selected.</td>
</tr>
<tr>
<td>Survey &amp; Assessment</td>
<td>Assessment metric type associated with the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only for the Survey &amp; Assessment success measurement method.</td>
</tr>
<tr>
<td></td>
<td>If the improvement initiative was created from within the Survey Management application, this field is not automatically populated.</td>
</tr>
<tr>
<td>Base value</td>
<td>Base value of the success measurement method when the target is set.</td>
</tr>
<tr>
<td>Percentage improvement</td>
<td>Percent improvement target.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only when an improvement KPI is selected.</td>
</tr>
<tr>
<td></td>
<td>If the KPI is a percent type, then this field is calculated automatically (based on Base value and Target value fields).</td>
</tr>
<tr>
<td>Target value</td>
<td>Absolute target value.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For the Automated: PA Indicator success measurement method, if the KPI is not a percent type, then this field is calculated automatically (based on base value and percentage improvement).</td>
</tr>
<tr>
<td></td>
<td>If the target value is already set on the indicator, breakdown, element, and aggregation, this field is automatically set. However, you can override this value by specifying a percent in the Percent Improvement field.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
| Target review date | Date the goal should be achieved. |
| **Note:** For the Automated: PA Indicator success measurement method, even if the target date is already set on the indicator, breakdown, element, and aggregation, this field is not automatically set. |
| Expected outcomes | Tangible artifacts and updates expected by the improvement initiative (for example, updated process published in new template, work instructions, and FAQ published in knowledge base). |

### Details tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested for</td>
<td>User for which the improvement initiative was created.</td>
</tr>
<tr>
<td>Type</td>
<td>Area improved by the improvement initiative. One or many areas may be selected.</td>
</tr>
<tr>
<td>• People</td>
<td></td>
</tr>
<tr>
<td>• Process</td>
<td></td>
</tr>
<tr>
<td>• Technology</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> When a value is selected for the Business Process field, the <strong>Type</strong> field is automatically set to Process.</td>
<td></td>
</tr>
<tr>
<td>Watch list</td>
<td>Users notified when updates are made to the improvement initiative.</td>
</tr>
<tr>
<td>Parent initiative</td>
<td>Parent initiative associated with this child initiative.</td>
</tr>
<tr>
<td>When a parent initiative is selected, all associated child initiatives display in the Child Initiatives related list.</td>
<td></td>
</tr>
<tr>
<td>Source/Parent</td>
<td>Source or parent application from which the improvement initiative was created.</td>
</tr>
</tbody>
</table>
### Field Description

- **Coaching Opportunity (COP)**
  Coaching opportunity record to which the improvement initiative is linked.

- **CMDB**
  Remediate Duplicate Tasks record to which the improvement initiative is linked.

- **Demand (DMND)**
  Demand record to which the improvement initiative is linked.

- **GRC issue**
  Issue record to which the improvement initiative is linked.

- **Incident (INC)**
  Incident record to which the improvement initiative is linked.

- **Problem (PRB)**
  Problem record to which the improvement initiative is linked.

- **(Survey) Assessment Metric Type**
  Assessment metric type for the survey definition record to which the improvement initiative is linked.

**Note:** This field is shown only when an improvement initiative is created from Coaching, CMDB, Demand Management, GRC, Incident Management, Problem Management, or Survey Management applications.

### Schedule tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned start date</td>
<td>Expected start date. By default, this field displays the date and time when the CIM initiative was created.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned end date</td>
<td>Expected end date. By default, this field displays the date and time for the day after the planned start date.</td>
</tr>
<tr>
<td>Actual start date</td>
<td>The date and time when the progress on a new initiative starts.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>The date and time when the last task associated with an initiative is completed.</td>
</tr>
</tbody>
</table>

### Notes tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional comments (customer visible)</td>
<td>Check box to show additional comments that are visible to the customer.</td>
</tr>
<tr>
<td></td>
<td>If checked, the Additional comments (Customer visible) field content is shown.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Work notes relating to the improvement initiative.</td>
</tr>
<tr>
<td></td>
<td>🔄 Note: Required when submitting the improvement initiative for reapproval.</td>
</tr>
</tbody>
</table>

### Closure Notes tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closure code</td>
<td>• Successful: Goals met.</td>
</tr>
<tr>
<td></td>
<td>• Withdrawn: No longer needed/applicable.</td>
</tr>
<tr>
<td></td>
<td>• Unsuccessful: Goals not met.</td>
</tr>
<tr>
<td>Achieved outcome category</td>
<td>• Cost Reduction</td>
</tr>
<tr>
<td></td>
<td>• Revenue Generation</td>
</tr>
<tr>
<td></td>
<td>• Time Savings</td>
</tr>
<tr>
<td></td>
<td>• Customer Satisfaction</td>
</tr>
<tr>
<td></td>
<td>• Quality Improvement</td>
</tr>
</tbody>
</table>
### CIM Phases related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique CIMT phase number.</td>
</tr>
<tr>
<td>Parent</td>
<td>Improvement initiative to which the CIM phase belongs. There can be multiple CIM phases per improvement initiative. The CIM phase groups the tasks, sets a planned end date, and shows the percent complete for tracking purposes.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Percentage of work completed. Percentage is based on the completed state of the CIM tasks that belong to this CIM phase. For example, if there are five CIM tasks, each contributes to 20% completion.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Estimated phase end date.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>End date of the phase.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Short description of the phase.</td>
</tr>
<tr>
<td>Description</td>
<td>(Required) Full description of the phase.</td>
</tr>
</tbody>
</table>

### CIM Tasks related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique CIMT task number.</td>
</tr>
<tr>
<td>Parent</td>
<td>If the CIM task is tied to a CIM phase, the improvement phase number to which the CIM task belongs. A CIM task can only be tied to one CIM phase. You can also create a CIM task directly from a CIM initiative.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that indicates whether the task is active.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>User primarily responsible for completion of the task.</td>
</tr>
<tr>
<td>Improvement Initiative</td>
<td>Improvement initiative number to which the CIM task belongs.</td>
</tr>
<tr>
<td>Priority</td>
<td>Sequence in which an incident or problem is to be worked on, based on impact and urgency.</td>
</tr>
<tr>
<td></td>
<td>• 1 - Critical</td>
</tr>
<tr>
<td></td>
<td>• 2 - High</td>
</tr>
<tr>
<td></td>
<td>• 3 - Moderate</td>
</tr>
<tr>
<td></td>
<td>• 4 - Low</td>
</tr>
<tr>
<td></td>
<td>• 5 - Planning</td>
</tr>
<tr>
<td>State</td>
<td>State of the task.</td>
</tr>
<tr>
<td></td>
<td>• Pending</td>
</tr>
<tr>
<td></td>
<td>• Open</td>
</tr>
<tr>
<td></td>
<td>• Work In Process</td>
</tr>
<tr>
<td></td>
<td>• Closed Complete</td>
</tr>
<tr>
<td></td>
<td>• Closed Incomplete</td>
</tr>
<tr>
<td></td>
<td>• Closed Skipped</td>
</tr>
<tr>
<td></td>
<td>• On Hold</td>
</tr>
<tr>
<td>On Hold Reason</td>
<td>Reason for putting the CIM task on hold.</td>
</tr>
<tr>
<td></td>
<td><img src="https://example.com" alt="Note:" /> This field is shown only when the state is on hold.</td>
</tr>
<tr>
<td></td>
<td>When an improvement initiative is placed on hold, all CIM tasks are also placed on hold, but the state can be changed manually.</td>
</tr>
<tr>
<td></td>
<td>When the improvement initiative is taken off hold, the CIM tasks are returned back to their previous state (unless they were changed manually).</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Estimated end date of the task.</td>
</tr>
</tbody>
</table>
### Field Description
- **Short Description**: Short description of the task.
- **Description**: Full description of the task.
- **Work notes**: Work notes for the task.

## Impacted KPIs related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improvement Initiative</td>
<td>Improvement initiative number to which the impacted KPI belongs.</td>
</tr>
<tr>
<td>Impacted KPI</td>
<td>Other related KPIs (independent of the Improvement KPI) that are affected by changes made as a result of the improvement initiative.</td>
</tr>
<tr>
<td>Breakdown</td>
<td>The breakdown of the impacted KPI.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only when an impacted KPI is selected.</td>
</tr>
<tr>
<td>Element</td>
<td>The element of the KPI breakdown.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only when a breakdown is selected. Adam.</td>
</tr>
<tr>
<td>Breakdown Level 2</td>
<td>The second-level breakdown of the improvement KPI, if one exists. Adam.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only after the first breakdown is selected. Adam.</td>
</tr>
<tr>
<td>Element Level 2</td>
<td>The element of the second-level KPI breakdown.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is shown only when a second-level breakdown is selected.  Adam.</td>
</tr>
<tr>
<td>View Scorecard</td>
<td>Related link to view the scorecard for the KPI.</td>
</tr>
</tbody>
</table>

## Approvers related list

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>State of the approval.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
|               | • Not Yet Requested  
|               | • Requested  
|               | • Approved  
|               | • Rejected  
|               | • Canceled  
|               | • No Longer Required  |

**Approver**

User authorized to approve the improvement initiative.

Approvers are members of the group set in the **Approver Group** field on the Improvement Initiative form.

**Comments**

Comments for the approval improvement initiative.

**Created**

Date the improvement initiative was created.

### Components installed with Continual Improvement Management

Several types of components are installed with activation of the com.sn_cim plugin, including tables, user roles, and scheduled jobs.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

### Roles installed with Continual Improvement Management

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Roles inherited</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improvement Requester</td>
<td>Able to perform these application functions:</td>
<td>None</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Roles inherited</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Improvement Coordinator [sn_cim.improvement_coordinator] | Able to perform all functions for improvements to which they are assigned as Improvement Coordinator except:  
- Create Enterprise Strategies  
- Delete improvement  
Although able to perform Improvement Manager functions, an Improvement Coordinator can only perform those functions for improvements that they are assigned as  

- sn_cim.improvement_requester  
- app_service_user  
- certification  
- cmdb_query_builder  
- dependency_views  
- itil  
Problem/change/incident records can be added.  
- knowledge  
- pa_analyst  
- pa_contributor  
- pa_power_user  
Existing Performance Analytics indicators can be accessed, and new ones created.  
- pa_target_admin  
- pa_threshold_admin  
- pa_viewer  
- sn_bm_client.benchmark_data_viewer  
- sn_bm_client.benchmark_recommendation_viewer  
Benchmarks data and recommendations can be viewed and an improvement initiative can be created from Benchmarks recommendations.  
- template_editor | • Create improvement initiative  
• View My CIM requests  
• View Watched CIM requests  
• View All CIM requests |
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Roles inherited</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improvement Coordinator by the Improvement Manager.</td>
<td>Primary responsibility is to coordinate improvements within their area of expertise (at the process or service level). Can access both Continual Improvement Workbench and dashboard.</td>
<td>• view_changer&lt;br&gt;• sn_coaching.admin&lt;br&gt;• scrum_story_creator</td>
</tr>
<tr>
<td>Improvement Manager [sn_cim.improvement_manager]</td>
<td>Able to perform all application functions. The Improvement Manager is primarily responsible for all improvements, including initial acceptance of new improvement requests, assignment, and closure. The Improvement Manager is primarily responsible for all improvements, including initial acceptance of new improvement requests, assignment, and closure.</td>
<td>• sn_cim.improvement_coordinator&lt;br&gt;• sn_process_optimization_viewer</td>
</tr>
</tbody>
</table>
### Role title [name]

<table>
<thead>
<tr>
<th>Description</th>
<th>Roles inherited</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manager also monitors the overall progress of all improvements.</td>
<td></td>
</tr>
</tbody>
</table>

### Scheduled jobs installed with Continual Improvement Management

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[PA Continual Improvement]</td>
<td>Daily CIM data collection.</td>
</tr>
<tr>
<td>[PA Continual Improvement]</td>
<td>Historical CIM data collection.</td>
</tr>
</tbody>
</table>

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improvement Initiative [sn_cim_register]</td>
<td>Contains the all improvement initiatives.</td>
</tr>
<tr>
<td>CIM Task [sn_cim_task]</td>
<td>Contains the CIM tasks created for an improvement initiative.</td>
</tr>
<tr>
<td>Impacted KPIs [sn_cim_related_kpi]</td>
<td>Contains KPIs related to the CIM improvement initiative.</td>
</tr>
</tbody>
</table>

### Properties installed with Continual Improvement Management

To access Continual Improvement Management properties, navigate to Continual Improvement > Administration > Properties.

**Note:** System admin role is required to set Continual Improvement Management properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_cim.need_approval</td>
<td>Enables approval process for Continual Improvement initiatives. By default, an improvement requires approval before it can progress to the Implement state. When the check box is enabled, it</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>indicates that manual approval is required for the improvement to progress from Accepted state to Approved state.</td>
</tr>
<tr>
<td></td>
<td>• Type: Yes</td>
</tr>
<tr>
<td></td>
<td>• Default value: Yes</td>
</tr>
<tr>
<td>sn_cim.initiative_copy_attributes</td>
<td>When a copy of the improvement initiative is created, the list of attributes (field values) that will be copied to the new initiative.</td>
</tr>
<tr>
<td>sn_cim.create_default_phase</td>
<td>Enable the property to create the default phase when an improvement initiative is created.</td>
</tr>
<tr>
<td></td>
<td>• Type: Yes</td>
</tr>
<tr>
<td></td>
<td>• Default value: No</td>
</tr>
</tbody>
</table>

**Quick tests for Continual Improvement Management**

Validate the continued functionality of Continual Improvement Management during application development and after upgrades. Copy and configure these automated tests to identify customizations needing review. All test suites and tests should pass.

**:info:** To run CIM automated tests:

- The Continual Improvement Management Automated Tests (com.sn_cim_atf) plugin must be enabled.
- The `sn_cim.create_default_phase` system property must be enabled. For more information, see [Properties installed with Continual Improvement Management](#).

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIM Parent test suite</td>
<td>Parent test suite that contains multiple child test suites.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• CIM Inbound Integration</td>
<td>Note: There is no dependency between child test suites.</td>
</tr>
<tr>
<td>• CIM Outbound Integrations</td>
<td></td>
</tr>
<tr>
<td>• CIM Phase and Task</td>
<td></td>
</tr>
<tr>
<td>• CIM State Flow</td>
<td></td>
</tr>
<tr>
<td>CIM Inbound Integrations</td>
<td>Suite that contains tests to create an improvement initiative from inbound integration applications.</td>
</tr>
<tr>
<td>• Problem Management</td>
<td></td>
</tr>
<tr>
<td>• Incident Management</td>
<td></td>
</tr>
<tr>
<td>• Demand Management</td>
<td></td>
</tr>
<tr>
<td>• Coaching</td>
<td></td>
</tr>
<tr>
<td>• Survey Management</td>
<td></td>
</tr>
<tr>
<td>• Assessments</td>
<td></td>
</tr>
<tr>
<td>CIM Outbound Integrations</td>
<td>Suite that contains tests for all CIM outbound integrations.</td>
</tr>
<tr>
<td>• From an improvement initiative:</td>
<td></td>
</tr>
<tr>
<td>Create demand and create project.</td>
<td></td>
</tr>
<tr>
<td>• From an improvement initiative task:</td>
<td></td>
</tr>
<tr>
<td>Create knowledge article, change request,</td>
<td></td>
</tr>
<tr>
<td>coaching opportunity, and story.</td>
<td></td>
</tr>
<tr>
<td>CIM Phase and Task</td>
<td>Suite that contains tests for CIM phase and CIM task creation, roll-up tasks, roll up phases, and dates.</td>
</tr>
<tr>
<td>CIM State Flow</td>
<td>Suite that contains all CIM state-related tests.</td>
</tr>
<tr>
<td>CIM: Create a demand from an improvement</td>
<td>Tests that a user with the Improvement Manager role can create a demand from an improvement initiative.</td>
</tr>
<tr>
<td>initiative</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>CIM: Create a project from an improvement initiative</td>
<td>Tests that a user with Project manager and Improvement Manager roles can create a project from an improvement initiative.</td>
</tr>
<tr>
<td>CIM: Create a change request from an improvement initiative task</td>
<td>Tests that a user with the Improvement Manager role can create a change request from an improvement initiative task.</td>
</tr>
<tr>
<td>CIM: Create a coaching opportunity from an improvement initiative task</td>
<td>Tests that a user with Coaching admin and Improvement Manager roles can create a coaching opportunity from an improvement initiative task.</td>
</tr>
<tr>
<td>CIM: Create a knowledge article from an improvement initiative task</td>
<td>Tests that a user with Knowledge admin and Improvement Manager roles can create knowledge article from an improvement initiative task.</td>
</tr>
<tr>
<td>CIM: Create a story from an improvement initiative task</td>
<td>Tests that a user with Project manager and Improvement Manager roles can create a story from an improvement initiative task.</td>
</tr>
<tr>
<td>CIM: Create a task within a phase</td>
<td>Tests that a task can be created within a phase.</td>
</tr>
<tr>
<td>CIM: Improvement Coordinator creates a task and phase</td>
<td>Tests that a user with the Improvement Coordinator role can create a task and phase.</td>
</tr>
<tr>
<td>CIM: Improvement Coordinator state flow from Approved to Implement</td>
<td>Tests that a user with the Improvement Coordinator role can change an improvement initiative from Approved state to Implement state.</td>
</tr>
<tr>
<td>CIM: Improvement Manager creates a strategic objective</td>
<td>Tests that a user with the Improvement Manager role can create a strategic objective.</td>
</tr>
<tr>
<td>CIM: Improvement Manager creates a task and phase</td>
<td>Tests that a user with the Improvement Manager role can create a task and phase.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CIM: Improvement Manager deletes an improvement initiative</td>
<td>Tests that a user with the Improvement Manager role can delete an improvement initiative.</td>
</tr>
<tr>
<td>CIM: Improvement Requester cannot create a task or phase</td>
<td>Tests that a user with the Improvement Requester role cannot create a task or phase.</td>
</tr>
<tr>
<td>CIM: Improvement Requester creates an improvement initiative</td>
<td>Tests that a user with the Improvement Requester role can create an improvement initiative.</td>
</tr>
<tr>
<td>CIM: Inbound integration from Assessments</td>
<td>Tests that a user with the Survey administrator role can create an improvement initiative from an assessment.</td>
</tr>
<tr>
<td>CIM: Inbound integration from a coaching opportunity</td>
<td>Tests that a user with the Coaching admin role can create an improvement initiative from a coaching opportunity.</td>
</tr>
<tr>
<td>CIM: Inbound integration from Demand Management</td>
<td>Tests that a user with the Demand manager role can create an improvement initiative from a demand.</td>
</tr>
<tr>
<td>CIM: Inbound integration from Incident Management</td>
<td>Tests that a user with the itil role can create an improvement initiative from an incident.</td>
</tr>
<tr>
<td>CIM: Inbound integration from Problem Management</td>
<td>Tests that a user with the itil role can create an improvement initiative from a problem.</td>
</tr>
<tr>
<td>CIM: Inbound integration from Survey Management</td>
<td>Tests that a user with the Survey administrator role can create an improvement initiative from a survey.</td>
</tr>
<tr>
<td>CIM: Initiative reject approval state flow from Assess to Accepted</td>
<td>Tests when an improvement initiative in Assess state is rejected by an approver, the state reverts back to Accepted.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CIM: Initiative state flow from Implement to On Hold</td>
<td>Tests that an improvement initiative in Implement state can be changed to On Hold state.</td>
</tr>
<tr>
<td>CIM: Initiative state flow from New through Closed</td>
<td>Tests that an improvement initiative in New state can be progressed through states Accepted, Assess, Approved, Implement, Review, to Closed state.</td>
</tr>
<tr>
<td>CIM: Initiative state flow from On Hold to Implement</td>
<td>Tests that an improvement initiative in On Hold state can be changed to Implement state.</td>
</tr>
<tr>
<td>CIM: Initiative state flow from On Hold to Review</td>
<td>Tests that an improvement initiative in On Hold state can be changed to Review state.</td>
</tr>
<tr>
<td>CIM: Initiative state flow from Review to Implement</td>
<td>Tests that an improvement initiative in Review state can be changed to Implement state.</td>
</tr>
<tr>
<td>CIM: New phase planned end date check</td>
<td>Tests that the planned end date for a new phase is at least one day later than the planned start date of the improvement initiative.</td>
</tr>
<tr>
<td>CIM: Phase creation for a new improvement initiative</td>
<td>Tests that a phase is automatically created when an improvement initiative is created.</td>
</tr>
<tr>
<td>CIM: Planned end date always later than planned start date</td>
<td>Tests that the planned end date of the improvement initiative is not earlier than the planned start date of the improvement initiative.</td>
</tr>
<tr>
<td>CIM: Roll-up phase to improvement initiative value check</td>
<td>Tests that the phase-level roll-up value for the improvement initiative (percent complete) is accurate.</td>
</tr>
<tr>
<td>CIM: Roll-up tasks to phase value check</td>
<td>Tests that the task-level roll-up value for the phase (percent complete) is accurate.</td>
</tr>
<tr>
<td>CIM: Skip approval process flow</td>
<td>Tests that the approval process is skipped when the Enable approval process is enabled.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>CIM: Submit an initiative in Accepted state to Cancel</td>
<td>Tests that an improvement initiative in Accepted state can be submitted for Cancel action.</td>
</tr>
<tr>
<td>CIM: Submit an initiative in Approved state for Re-Approval</td>
<td>Tests that an improvement initiative in Approved state can be submitted for Re-Approval action.</td>
</tr>
<tr>
<td>CIM: Submit an initiative in Assess state for Revert to Accepted</td>
<td>Tests that an improvement initiative in Assess state can be submitted for Revert to Accepted action.</td>
</tr>
<tr>
<td>CIM: Submit an initiative in Implement state for Re-Approval</td>
<td>Tests that an improvement initiative in Implement state can be submitted for Re-Approval action.</td>
</tr>
</tbody>
</table>

**Related information**

**Quick start tests**

**Continual Improvements dashboard**

The Continual Improvements dashboard enables an Improvement Process Coordinator or Manager to determine which process to start next, how many initiatives they have underway at a given time, and what the employee participation is.

This dashboard is included in the Continual Improvements Management plugin.
End users and roles

<table>
<thead>
<tr>
<th>End user</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Improvement Process Coordinator: Needs to verify the status of their initiatives.</td>
<td>sn_cim.improvement_coordinator</td>
</tr>
<tr>
<td>Improvement Process Manager: Must be able to see the state of all improvement processes and assign employees where they are needed.</td>
<td>sn_cim.improvement_manager</td>
</tr>
</tbody>
</table>

Reports

The Continual Improvements dashboard includes the following reports:

<table>
<thead>
<tr>
<th>Report Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Engagement</td>
<td>Column</td>
<td>State is not Closed or Cancelled Trended by Created</td>
</tr>
<tr>
<td></td>
<td>Chart</td>
<td></td>
</tr>
<tr>
<td>Total Initiatives</td>
<td>Horizontal Bar</td>
<td>State is not Closed or Cancelled Grouped by State</td>
</tr>
<tr>
<td></td>
<td>Chart</td>
<td></td>
</tr>
<tr>
<td>Open Backlog</td>
<td>Single</td>
<td>State is not Closed or Cancelled</td>
</tr>
<tr>
<td></td>
<td>Score</td>
<td></td>
</tr>
<tr>
<td>Unassigned</td>
<td>Single</td>
<td>CIM Coordinator is empty and State is not Closed or Cancelled</td>
</tr>
<tr>
<td></td>
<td>Score</td>
<td></td>
</tr>
<tr>
<td>Prioritized List Using Spotlight</td>
<td>List</td>
<td>Name: Benefit High Query: benefit=high Weight: 50</td>
</tr>
<tr>
<td>Report Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Name: Benefit Low Query: benefit=low</td>
<td></td>
<td>Weight: 30</td>
</tr>
<tr>
<td>Name: Benefit Medium Query: benefit=medium</td>
<td></td>
<td>Weight: 40</td>
</tr>
<tr>
<td>Name: Effort Estimate Extra Large Query: cim_estimate=4</td>
<td></td>
<td>Weight: 50</td>
</tr>
<tr>
<td>Name: Effort Estimate Large Query: cim_estimate=3</td>
<td></td>
<td>Weight: 40</td>
</tr>
<tr>
<td>Name: Effort Estimate Medium Query: cim_estimate=2</td>
<td></td>
<td>Weight: 30</td>
</tr>
<tr>
<td>Name: Effort Estimate Small Query: cim_estimate=1</td>
<td></td>
<td>Weight: 20</td>
</tr>
<tr>
<td>Name: Priority 1 Query: priority=1</td>
<td></td>
<td>Weight: 50</td>
</tr>
<tr>
<td>Name: Priority 2 Query: priority=2</td>
<td></td>
<td>Weight: 40</td>
</tr>
<tr>
<td>Name: Priority 3 Query: priority=3</td>
<td></td>
<td>Weight: 30</td>
</tr>
<tr>
<td>Name: Priority 4 Query: priority=4</td>
<td></td>
<td>Weight: 20</td>
</tr>
<tr>
<td>Name: Priority 5 Query: priority=5</td>
<td></td>
<td>Weight: 10</td>
</tr>
</tbody>
</table>

**Expense Line**

Expense lines enable you to track costs and represent when a point-in-time expense incurred. Expense lines can be created manually or generated by the scheduled processing of recurring costs.

The Expense Line plugin is active for all instances. To use the Expense Allocations and Expense Allocation Rules modules, activate the Cost Management plugin.

The Now Platform generates expense lines automatically when you create an asset, and updates expense lines automatically when you revise the **Cost** or **Quantity** field on an asset record.

Users with the financial_mgmt_admin and financial_mgmt_user roles can work with expense lines.
Expense lines integrate closely with asset management, CMDB, cost management, and contract management, but can be used with any application. The **Source ID** field on an expense line record can be linked to any record in any table. This identifier allows expenses to be associated with a wide variety of items, such as a contract, an individual asset, a single configuration item, a software installation, a lease, a service contract, a user, or a group.

**Example expense line for an asset monthly lease**

![Expense line example](image)

**Related reference**
- Cost Management

**Related information**
- Asset Management
- Configuration Management Database
- Contract Management

**Components installed with Expense Line**
Several types of components are installed with the Expense Line plugin.

**Tables installed with Expense Line**
Tables are added with activation of Expense Line.
### Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expense Line</td>
<td>Stores information about expense lines, including a link to the associated rate card. Contains the status and next scheduled processing date for the expense line.</td>
</tr>
</tbody>
</table>

### Roles installed with Expense Line

Roles are added with activation of Expense Line.

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial admin</td>
<td>[financial_mgmt_user]</td>
<td>Can create, write, and delete allocation units, fixed assets, depreciation, rate cards, distribution costs, expense lines, and expense allocations.</td>
</tr>
<tr>
<td>Financial user</td>
<td>none</td>
<td>Can read allocation units and expense allocations. Can create, read, and write rate cards and expense lines. Can create, read, write, and delete fixed assets, depreciation, distribution costs.</td>
</tr>
</tbody>
</table>

### Script includes installed with Expense Line

Script includes are added with activation of Expense Line.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExpenseLine</td>
<td>Helps create expense line records.</td>
</tr>
<tr>
<td>ExpenseManagementUtils</td>
<td>Provides utilities for financial management modules.</td>
</tr>
<tr>
<td>ExpenseManagementUtilsAJAX</td>
<td>Provides AJAX utilities for expense lines.</td>
</tr>
</tbody>
</table>
Client scripts installed with Expense Line

Client scripts are added with activation of Expense Line.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Populate sources if inherited</td>
<td>[fm_expense_line]</td>
<td>Copies the source fields of the parent expense line to the current line on the Expense Line record if an expense line is inherited.</td>
</tr>
<tr>
<td>Populate source fields from asset</td>
<td>[fm_expense_line]</td>
<td>If the source asset changes, updates related source fields on the Expense Line record. For example, if the asset source field changes, the configuration item source field is updated, as well.</td>
</tr>
<tr>
<td>Populate source fields from ci</td>
<td>[fm_expense_line]</td>
<td>Updates related source fields if the source configuration item changes on the Expense Line record.</td>
</tr>
<tr>
<td>Populate source fields from contract</td>
<td>[fm_expense_line]</td>
<td>Updates related source fields if the source contract changes on the Expense Line record.</td>
</tr>
<tr>
<td>Populate source fields from task</td>
<td>[fm_expense_line]</td>
<td>Updates related source fields if the source task changes on the Expense Line record.</td>
</tr>
</tbody>
</table>

Business rules installed with Expense Line

Business rules are added with activation of Expense Line.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Expense Line</td>
<td>[alm_asset]</td>
<td>Automatically creates an expense line for a new asset based on asset cost unless the asset is a merged software license.</td>
</tr>
<tr>
<td>Set source</td>
<td>[fm_expense_line]</td>
<td>Sets the related source fields when the source ID changes. For example, when an asset</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>allocation fields</td>
<td></td>
<td>becomes the source ID, the asset source field and configuration item source field are automatically populated.</td>
</tr>
<tr>
<td>Update Costs</td>
<td>[alm_consumable]</td>
<td>Updates the cost of a consumable when quantity is reduced.</td>
</tr>
</tbody>
</table>

### Domain separation and Expense Line

Domain separation is unsupported in Expense Line processing. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: No support**

- The domain field may exist on data tables but there is no business logic to manage the data.
- This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.

**Related information**

- Domain separation for service providers

### View an expense

Expense lines can be used in various ways, for example, how to view expenses that are associated with a given contract.

**Before you begin**

Role required: asset or contract_manager

**About this task**

**Procedure**

1. Navigate to **Contract > Contract > All**.
2. Select a contract.
3. View the Expense Lines related list.
All the expense lines for the contract are listed. The total cost of the contract and its current value are also shown.

4. Select an expense line to view its details.

Expense lines and expense allocations

The Expense lines application tracks costs and record expenses incurred. Expense allocations let you associate expenses with items such as users, groups, or departments.

Expense lines are a key component of cost management because they can be generated from any application and are used to allocate expenses to business entities. Expense lines can be created manually or generated automatically when costs are created by scheduled processing.

Users with the financial_mgmt_admin and financial_mgmt_user roles can work with expense lines and expense allocation rules.

To use expense allocation rules, activate the Cost Management application.

Create an allocation rule

Expense allocation rules enable you to associate expenses with an item, such as a user, group, or department.

Before you begin
To use expense allocation rules, activate Cost Management.

Role required: admin, financial_mgmt_admin, or financial_mgmt_user

Procedure
1. Navigate to Cost > Administration > Expense Allocation Rules.
2. Click New.
3. Complete the form.

Allocation rule fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The allocation rule name.</td>
</tr>
<tr>
<td>Table</td>
<td>The table to which the allocation rule is associated.</td>
</tr>
<tr>
<td>Allocation field</td>
<td>The field on the table to populate with the expense allocation.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Inherited</td>
<td>Check box that indicates whether the expense allocation is inherited.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that indicates whether the expense allocation is available to use.</td>
</tr>
<tr>
<td>Percentage</td>
<td>The percentage of the expense line allocated to the table and field combination. Not available if the Advanced check box is selected.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The expense allocation category: <strong>Grow Business</strong>, <strong>Run Business</strong>, or <strong>Transform Business</strong>. Categorizing expense allocations can be useful for reporting.</td>
</tr>
<tr>
<td>Condition</td>
<td>The condition under which the expense allocation is applied. Not available if the Advanced check box is selected.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Check box that indicates whether to display the Script field.</td>
</tr>
<tr>
<td>Script</td>
<td>The script field that determines expense allocations. This field is only available if the Advanced check box is selected.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Related information**

- **Condition builder**

**Automatic expense line creation**

You can automatically create expense lines to facilitate the accurate reporting of expenses.

If enabled, the following processes generate expense lines automatically.

- **Active CI rate cards** are processed monthly to generate expense lines for each CI in the rate card. If a CI relationship is changed, existing expense lines are not affected. Changes are reflected in the next scheduled expense line.

- **Active distribution costs** are processed monthly to generate expense lines based on distribution rule targets.

- **Closed tasks on task rate cards** are processed to generate expense lines.

Expense lines can also be imported from external systems or generated from scripts. To generate an expense from a server-side script, use the ExpenseLine API.
Related information
Create or edit a CI relationship

Create expense lines manually
You can create expense lines at a single level or in a hierarchy to better organize expense information.

Before you begin
Role required: admin, financial_mgmt_admin, or financial_mgmt_user

About this task
Use a hierarchy if it makes sense for your organization. In the example below, the last two expense lines are a level under expense line number EXP0010001.

<table>
<thead>
<tr>
<th>Expense lines in a hierarchy</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXP0010001</td>
</tr>
<tr>
<td>EXP0010002</td>
</tr>
<tr>
<td>EXP0010003</td>
</tr>
<tr>
<td>EXP0010004</td>
</tr>
<tr>
<td>EXP0010005</td>
</tr>
<tr>
<td>EXP0010006</td>
</tr>
<tr>
<td>EXP0010007</td>
</tr>
<tr>
<td>EXP0010008</td>
</tr>
</tbody>
</table>

Procedure
1. Navigate to Costs > Expense Lines.
2. Open an expense line record, or click New to create a new expense line.
3. Complete the form.
### Expense line table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique number identifying the expense line.</td>
</tr>
<tr>
<td>Date</td>
<td>The date on which the expense line was created.</td>
</tr>
<tr>
<td>Rate Card</td>
<td>The identification number of the rate card to which the expense line is associated.</td>
</tr>
<tr>
<td>Rate type</td>
<td>The rate type that is considered during the expense line generation. This field is read-only.</td>
</tr>
<tr>
<td>Source ID</td>
<td>The identification number of the item associated with the expense line. If this field is filled in, corresponding information is automatically added to the Source fields on this form.</td>
</tr>
<tr>
<td>Amount</td>
<td>The monetary value of the item specified in the Source ID field. Enter a negative value to indicate a credit.</td>
</tr>
<tr>
<td>Process date</td>
<td>The date the expense line is processed.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Check box that indicates whether the expense line is on another expense line.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the expense line, either Pending or Processed.</td>
</tr>
<tr>
<td>Summary type</td>
<td>The expense line category: Grow Business, Run Business, or Transform Business. Categorizing expense lines can be useful for reporting.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the expense line.</td>
</tr>
<tr>
<td>Asset</td>
<td>The identification number of the asset associated with the expense line, if any.</td>
</tr>
<tr>
<td>Fixed asset</td>
<td>Fixed asset that contains the asset in this expense line. A fixed asset is a container that holds one or more individual assets, including hardware or software assets. The system auto-populates this field with the appropriate fixed asset if the named Asset is contained within that fixed asset.</td>
</tr>
<tr>
<td>Contract</td>
<td>The identification number (not the contract number) of the contract associated with the Asset, if any.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user associated with the Asset, if any.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>The name of the configuration item associated with the expense line, if any.</td>
</tr>
<tr>
<td>Task</td>
<td>The identification number of the task associated with the expense line, if any.</td>
</tr>
<tr>
<td>Cost center</td>
<td>The cost center financially responsible for the item identified in Source ID, if any.</td>
</tr>
</tbody>
</table>

**Related information**

Create fixed assets

**Delete an expense line**

Deleting an expense line also deletes all expense allocations that were generated from the expense line.

**Before you begin**
Role required: admin or financial_mgmt_admin

**About this task**
Deleting expense lines and allocations should be limited to an emergency case only when they were created incorrectly.

**Procedure**
1. Navigate to Costs > Expense Lines.
2. Select an expense line.
3. Click Delete.
4. In the confirmation message, click OK.

**Create a sample allocation rule**

You can create a sample expense allocation rule that allocates the cost of an incident to the department of the caller.

**Before you begin**
To use expense allocation rules, activate the Cost Management application.
Role required: admin, financial_mgmt_admin, or financial_mgmt_user
Procedure
1. Costs > Administration > Expense Allocation Rules
2. Click New.
3. In Name, enter Incident Caller Department.
4. In Table, select Incident.
5. In Allocation field, click the control, expand the Caller element, and select a department.
6. In Percentage, enter 100 to allocate all the expense to the caller's department.
7. Select the Active check box.
8. Click Submit.

After an incident expense line is created, the allocation rule processes the expense line and generates an expense allocation linking the expense and amount to the caller's department. The expense is stored in the Target field on the Expense Allocation record.

Related reference
Cost Management

Use a scripted allocation
Scripted allocations define custom allocation amounts and targets by executing a script.

Before you begin
Role required: admin, financial_mgmt_admin, or financial_mgmt_user

About this task
You can use scripted allocations to perform any of the following actions.
- Allocate an expense to all cost centers based on the current head count in the cost center.
- Query usage data to determine the allocation amount to assign to a target.
- Track the business users that are consuming business services.

Procedure
1. Navigate to Costs > Administration > Expense Allocation Rules.
2. Select an expense allocation rule.
3. Select the Advanced check box.
4. Use the following concepts to build the script
   - Query for target records and data to use for calculating the allocation amount.
   - Create allocation records using the ExpenseAllocation API. The following variables are available during the script processing:
     - `allocation`: expense allocation object used to create allocations.
     - `expense`: GlideRecord for the expense_line that is being processed.
     - `rule`: GlideRecord for this rule.

   To create an allocation record, use the allocation object already instantiated in the script scope:

   ```java
   allocation.createAllocation(targetGlideRecord, amount);
   ```

**Domain separation and Expense Line**

Domain separation is unsupported in Expense Line processing. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: No support**

- The domain field may exist on data tables but there is no business logic to manage the data.
- This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.

**Related information**

- Domain separation for service providers

**ITSM Virtual Agent**

Implement ITSM Virtual Agent to support and scale your IT organization by enabling a virtual agent to perform the less complicated, more common IT requests and incidents. ITSM Virtual Agent includes predefined conversations designed to help both your IT fulfillment professionals and users complete common tasks, such as resolve an incident, reset a password, and create an incident.
Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Understanding ITSM Virtual Agent

ITSM Virtual Agent enables your technicians to concentrate on more challenging, demanding user requests and incidents. ITSM Virtual Agent enhances the employee experience by addressing IT-related queries immediately. At any time during a virtual conversation, a user can request to interact with a live IT technician.

Several predefined ITSM Virtual Agent topic conversations, covering common IT interactions, are included with the base-system application. These conversations run in the web chat client and also in supported ITSM Virtual Agent messaging integrations.

Conversations represent dialogs between the virtual agent and the user to accomplish a specific goal. The information exchanged during the conversation flow, such as user inputs and virtual agent responses, enables the virtual agent to fulfill a request or help complete a task.

Listen to this 18-minute podcast for a discussion of the Virtual Agent and how it can streamline interactions between a company and its customers and employees.

Discussion of Virtual Agent, how the agent appears to users, how to build the agent into systems, natural language capability, and getting started with Virtual Agent.

For complete details about ITSM Virtual Agent, refer to Virtual Agent.

Natural Language Understanding

Implement Natural Language Understanding (NLU) for all your ITSM Virtual Agent topic conversation flows. ITSM Virtual Agent uses NLU to comprehend word meanings and recognize word contexts to better infer user or system actions.

You can decide whether you want ITSM Virtual Agent to use only keywords, which results in quicker time-to-value in the short term. Or, you can choose to use NLU, which results in a better employee experience with a virtual agent in the long term.

ITSM Virtual Agent and the ITSM NLU Model for Virtual Agent Conversations are available from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the
store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

The ITSM NLU Model for Virtual Agent Conversations provides numerous base system, pre-built NLU model system entities, NLU intent entities, NLU utterance entities, NLU entities, NLU intents, NLU utterances, and NLU vocabulary. NLU utterances exist in the ITSM NLU Model to provide greater precision in identifying user intents. Some utterance examples include:

• Escalate Ticket topic:
  ◦ raise incident INC0010023 ticket priority to higher level
  ◦ please can you raise the priority on my open ticket

• Check Outages and Service Degradations topics:
  ◦ are there currently any reported company wide issues
  ◦ is there an outage

• Email Setup topic
  ◦ I want to setup email on my mobile device
  ◦ How do I setup company email on my phone

Enable NLU on the ITSM Virtual Agent application and republish your existing conversations to optimize user experience with the NLU feature.

Refer to the following information for details regarding the NLU feature: Natural Language Understanding in Virtual Agent.

Edge Encryption for ITSM Virtual Agent

Edge encryption provides you with direct control over your data security. Encryption and key management are performed on your intranet between your browser and your ServiceNow instance. For details, refer to Edge Encryption for ITSM Virtual Agent within ITSM.

ITSM Virtual Agent topic categories and conversations

The ITSM Virtual Agent predefined topic conversations are contained in several topic categories, including:

<table>
<thead>
<tr>
<th>Topic category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITSM Fulfiller</td>
<td>Topic conversations specifically for ITSM professionals with the itil role, such as resolving an incident, creating a</td>
</tr>
<tr>
<td>Topic category</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ITSM IT Issues</td>
<td>Topic conversations for common IT-related issues, such as email setup, VPN connectivity, and conference room problems.</td>
</tr>
<tr>
<td>ITSM Self Service</td>
<td>Topic conversations enabling users to easily access IT-related information, such as password reset, verify assigned equipment, and search the Knowledge Base.</td>
</tr>
<tr>
<td>Setup Topics</td>
<td>Topic conversations, such as a standard welcome greeting and a conversation closing, related to initiating an ITSM Virtual Agent experience for your users. This includes a greeting, feedback, survey, and live agent support.</td>
</tr>
<tr>
<td>Small Talk Topics</td>
<td>Topics that you build to enable your virtual agent to engage in casual conversation with users. A small talk topic provides a response to a casual question that users might ask during a conversation, such as the time or date. A small talk topic can occur anytime within a conversation session and can be unrelated to the original conversation intent.</td>
</tr>
</tbody>
</table>

**Note:** After you publish a topic, the suffix *(Template)* appears after the topic name. Adding the suffix allows you to create custom topics using a similar naming convention.

The individual ITSM Virtual Agent predefined topic conversations include:

**ITSM Virtual Agent predefined Fulfiller category topic conversations**

- Identify Scheduled Changes
- Create Change Request
- Resolve Incident
• Create Problem
• Update Assigned Task
• Identify Available Change Windows
• Update Change Request

**ITSM Virtual Agent predefined IT Issues category topic conversations**

• Local Admin Access
• RSA Token
• Email Issues
• Manage Distribution List
• Manage Office 365 Group (Template)

ℹ️ **Note:** This topic is only available with the activation of the Microsoft Azure AD for IntegrationHub (com.sn.azure_ad.spoke) plugin.

• Repository Access
• Email Setup
• Meeting Room Issues
• Troubleshoot Slow Computer
• Guest WiFi Access
• Printer Issues
• VPN Connectivity

**ITSM Virtual Agent predefined Self Service category topic conversations**

• Submit a request
• Check IT Ticket Status
• Process Approval
• Get Password Reset Link
• My Assigned Equipment
• Service Disruptions
• Search Knowledge Base

ℹ️ **Note:** The Search Knowledge Base topic conversation uses the Contextual Search reusable topic block.
• Open IT Ticket

  Note: The Open IT Ticket topic conversation uses the Create Incident reusable topic block.

• Intelligent Open IT Ticket (Template)

• Escalate IT Ticket

• Walk-up Check-in

  Note: the Walk-up Check-in topic conversation is available when the Walk-up Experience plugin (com.snc.walkup) is activated.

• Report IT Issue

ITSM Virtual Agent predefined Setup Topics category conversations

• Greetings
• Anything Else Topic
• Live Agent Support
• Closing Conversation
• Personalized Greeting Topic
• Dynamic Greeting Topic
• Error Handling Topic
• Virtual Agent Feedback

  Note: The Virtual Agent Feedback topic conversation uses the Survey reusable topic block.

• Fallback Topic
• Search Fallback Topic
• Virtual Agent Capabilities
• Survey

Reusable ITSM Virtual Agent topic blocks
Create and reuse topic blocks to perform common functions in ITSM Virtual Agent conversations, such as creating an incident or performing a search. ITSM Virtual Agent provides the following predefined, reusable topic blocks and templates:
• Contextual Search: This topic block provides standardized contextual search functionality for your ITSM related topics, as well as your other business unit related topics, such as human resources and service management.

  ⚠ Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).

• Contextual Search (Template)

  ⚠ Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).

• Create Zoom Meeting Link (Template)

  ⚠ Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).

• Request Catalog Item

  ⚠ Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks). For detailed information about this topic block, including input and output parameters and descriptions, refer to Service Catalog topic blocks in Virtual Agent.

• Request Catalog Item (Template)

  ⚠ Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks). For detailed information about this topic block, including input and output parameters and descriptions, refer to Service Catalog topic blocks in Virtual Agent.

• Search Catalog Item

  ⚠ Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks). For detailed information about this topic block, including input and output parameters and descriptions, refer to Service Catalog topic blocks in Virtual Agent.

• Search Catalog Item (Template)

  ⚠ Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks). For detailed information about this topic block, including input and output parameters and descriptions, refer to Service Catalog topic blocks in Virtual Agent.
• Troubleshoot Cisco Webex (Template)

  Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).

• Troubleshoot Microsoft Teams (Template)

  Note: This topic block is available with the Service Management Virtual Agent Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).

• Transfer to Live Agent
• Create Incident
• Create Incident (Template)
• Survey
• Add Comments - Similar Incident: ITSM Virtual Agent uses the similarity analysis framework to prevent users from opening duplicate incidents. This topic block finds similar incidents and asks if the user wants to add comments to the similar incident.

Some topic blocks require input and output parameters:

**Contextual Search topic block parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input parameter: context</td>
<td>The sys_id of a Search Context (cxs_context_config) record. Defines what sources are included in the search, for example, knowledge base or community.</td>
</tr>
<tr>
<td>Input parameter: query</td>
<td>The search keyword entered by a user during a virtual agent conversation.</td>
</tr>
<tr>
<td>Input parameter: portal</td>
<td>The portal from which the conversation initiated. For example, a service portal or human resources portal. This is the URL suffix, for example, sp, esc, csm, and hr, from which the search result will open.</td>
</tr>
<tr>
<td>Input parameter: kb_knowledge_base</td>
<td>The sys_id of a Knowledge Base (kb_knowledge_base) record. Within context, search only these knowledge base articles.</td>
</tr>
<tr>
<td>Output parameter:</td>
<td>True if search results are found, otherwise false.</td>
</tr>
</tbody>
</table>
Contextual Search topic block parameters (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>results_returned</td>
<td></td>
</tr>
<tr>
<td>Output parameter:</td>
<td></td>
</tr>
<tr>
<td>results_helpful</td>
<td>True if user responds that search results are helpful, otherwise false.</td>
</tr>
</tbody>
</table>

Create Incident topic block parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input parameter: caller</td>
<td>The name of the user creating an Incident (incident) record.</td>
</tr>
<tr>
<td>Input parameter: short_description</td>
<td>The short description entered in the Incident (incident) record.</td>
</tr>
<tr>
<td>Input parameter: urgency</td>
<td>The urgency level indicated in the Incident (incident) record.</td>
</tr>
<tr>
<td>Input parameter: description</td>
<td>The description entered in the Incident (incident) record.</td>
</tr>
<tr>
<td>Output parameter: created_incident_sys_id</td>
<td>The return sys_id of a newly created incident.</td>
</tr>
</tbody>
</table>

The Topics page in Virtual Agent Designer features a sort tab called **Topic Blocks** for viewing just the reusable topic functions. For detailed information about ITSM Virtual Agent reusable topic blocks, refer to [Virtual Agent Designer, Reusable topic blocks](#) and [Predefined Virtual Agent topics, topic blocks, and NLU models](#).

**Pre-built clustering solution definition**

ITSM Virtual Agent delivers a pre-built clustering solution definition using the ServiceNow platform Predictive Intelligence clustering capability. Clustering solution definitions provide data that, over time, help you identify automation and topic conversation candidates for Virtual Agent.

For complete information regarding Predictive Intelligence and clustering solution definitions, refer to [Predictive Intelligence and Create and train a clustering solution](#).
ITSM Virtual Agent automatic notifications

The virtual agent proactively informs you about the status of your incidents and requests. Managers are alerted when they have approvals.

**ITSM Virtual Agent notification defined on the Task [task] table**

The Task type filter on the Task table enables automatic status notification when the value is **Incident** or **Requested item**. When the state of the incident or requested item task changes, a virtual agent message is sent to the user.

**ITSM Virtual Agent notification defined on the Approval [sysapproval_approver] table**

When an approval is submitted, an automatic virtual agent message is sent to the approver alerting them of the approval request.

**Set up ITSM Virtual Agent**

Administrators and users with the virtual_agent_admin role can create and publish conversation topics in Virtual Agent Designer.

**Before you begin**

Role required: admin or virtual_agent_admin

**About this task**

Virtual Agent must be activated before you can use the ITSM Virtual Agent topic conversations. Users with the admin or virtual_agent_admin role can activate Glide Virtual Agent [com.glide.cs.chatbot].

Install ITSM Virtual Agent and the ITSM NLU Model for Virtual Agent Conversations by requesting them from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Topics must be activated and published before your employees can use them. By default, the base system provides topics as inactive and unpublished. To view, duplicate, preview, or publish ITSM topics in the Virtual Agent Designer, refer to Virtual Agent Designer.

**Procedure**

1. Activate the Glide Virtual Agent plugin (com.glide.cs.chatbot).
2. Install ITSM Virtual Agent by requesting it from the ServiceNow Store.
3. Review the ITSM-related conversation topics in Virtual Agent Designer.

4. If you have decided to implement NLU, enable it in the Virtual Agent application.
   a. Navigate to Virtual Agent > General Settings.
   b. Click NLU Settings.
   c. Click the Enable NLU in Virtual Agent radio button to enable NLU.
      Note: To disable NLU, click the radio button.

5. To use any of the ITSM Virtual Agent conversation topics, publish them in Virtual Agent Designer so that your users can run the conversations in your Virtual Agent support client.
      Note: You cannot edit the provided topics. You can duplicate a provided topic and then edit it. You can also create additional topics. For complete details regarding activating and publishing conversation topics, refer to Virtual Agent Designer.

6. To test an active, published conversation topic, click the topic to test in Virtual Agent Designer and click Test. The Virtual Agent window opens and engages you to enter data, such as an IT issue or search for a knowledge base article.

**ITSM Virtual Agent conversation flows**

ITSM Virtual Agent includes several predefined topic conversations designed to help your users complete common IT-related tasks, such as resetting a password and creating an incident.

**ITSM Virtual Agent predefined Fulfiller category topic conversation flows**

**Identify Scheduled Changes**

Users with the itil role can find upcoming change requests for a specific configuration item (CI). To see the change requests, users must type in the name of the configuration item that contains the changes.

**Create Change Request**

Users with the itil role can create change requests using a client of choice, such as Slack. Users indicate the type of change request
(Normal, Standard, or Emergency). Change type definitions are provided by the virtual agent.

For normal and emergency change requests, the virtual agent prompts the user to enter the following criteria:

- Short description
- Justification
- Configuration item
- Assignment group
- Planned start date
- Planned end date

For standard change requests, the virtual agent sends a carousel link to a catalog of standard change items. After the user selects an item, the virtual agent provides a link to open the associated category page to request the change.

### Change Types

**Normal:** Changes without predefined plans that require approval and CAB authorization.

**Standard:** Select from available pre-approved change templates. These changes do not require approval.

**Emergency:** Unplanned changes necessary to restore service. These changes require CAB authorization only.

### What type of change is required?

- Normal
- Standard
- Emergency
- I don’t want to create a change request
Users with the ITIL role can resolve an incident through support chat by providing a close code, for example, **Solved (Permanently)** or **Solved (Workaround)**, and resolution notes.

You have one incident assigned:

<table>
<thead>
<tr>
<th>Incident</th>
<th>INC0010143</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Test</td>
</tr>
<tr>
<td>Priority</td>
<td>4 - Low</td>
</tr>
<tr>
<td>State</td>
<td>In progress</td>
</tr>
</tbody>
</table>

Do you want to resolve this incident?

Yes

Alright. Let's start by selecting a resolution code:

Solved (Permanently)

Please provide some resolution notes.

Just now

After some further investigation, I was able to resolve this incident.

Got it! Would you like to add an additional comment or a work note?

Neither

I've successfully resolved this incident!

Thanks for using our support chat! Have a great day!

Create Problem

Users with the ITIL role can create problem records. Users provide a description of the problem and specify the urgency and the
impact of the problem. Users must know and enter the associated problematic configuration item as well.

**Update Assigned Task**

Users with the itil role can update comments or work notes in assigned tasks. When a user wants to update a task, the virtual agent returns a list of all assigned tasks and asks which task the user wants to update. Users can select a single listed task to update or select All to load and update all assigned tasks. The virtual agent then asks if the user wants to add a comment, a work note, or both. Optionally, users can cancel the update.

**Identify Available Change Windows**

Users with the itil role can check the next available change window for a configuration item. For example, you can determine the next available change window for a specific asset assigned to a user, regarding maintenance or black-out calendars. Users must enter the configuration item to check, such as PROmonitor, and then select a planned start and end date and time.
Let’s start by searching for the configuration item whose availability you want to check:

ProMonitor

Alright, I’ve captured PROMonitor.

Do you want to select this CI?

Yes, select this CI

Now, give me a representative planned start and end date for a change so that I can see if there are any upcoming available windows that match your duration.

Let’s select a Planned start date and time:

Monday, December 31 2018, 7:50 pm

Now let’s select a Planned end date and time:

just now

Wednesday, January 2 2019, 7:50 pm

Unfortunately, there are no upcoming available change windows for your selected CI and planned duration.

Thanks for using our support chat! Have a great day!

Update Change Request
Users with the itil role can update the actual start and end time of a change, as well as move it to work in progress or closed states.

**ITSM Virtual Agent predefined IT Issues category topic conversation flows**

**Local Admin Access**

Users can request and gain admin rights and permission to install or access software and other admin-related items within your system.

Local admin access is commonly required to install software or make system changes. Do you want local admin access on your machine?

- Local admin permission granted for 2 hours.

**RSA Token**

Users can request an RSA token or report a problem with an RSA token. Users can also request help with the setup of an RSA token.

What do you need help with?

**How to install my RSA Token on Mac**

1. Start the "SecurID.app" in Applications > SecureID
2. To check if you have an old token choose OPTIONS > Manage Token > Delete Token.
3. Delete the existing token (if any).
4. Import the new token by double-clicking it. Do not rename the token.

**Email Issues**

Users can request help with email problems, such as issues sending and receiving email or problems with the email client.
Manage Distribution List

Users can create, delete, and manage a distribution list.

Note: This topic will be deprecated and replaced with Manage Microsoft Active Directory actions.

Manage Office 365 Group (Template)

Users can create, delete, and manage a distribution list. Users can add themselves or others to an existing distribution list. They can also remove themselves from a distribution list.

Note: This topic will be deprecated and replaced with Manage Office 365 Group conversation flow actions.

This topic is only available with the activation of the Microsoft Azure AD for IntegrationHub (com.sn.azure_ad.spoke) plugin.
complete details about this conversation flow, see Manage Office 365 Group conversation flow.

To set up Microsoft Azure AD for IntegrationHub, see Set up Microsoft Azure AD spoke.

**Windows 365 Cloud PC (Template)**

Users can request a Microsoft 365 Cloud PC for themselves through a Virtual Agent conversation. The admin must set the correct group with provisioning authority under the sys_property "sn_itsm_va.windows365_cloudpc_group".

This topic is only available with the activation of the Microsoft Azure AD for IntegrationHub (com.sn.azure_ad.spoke) plugin.

**Repository Access**

Users can request and gain access to a data repository manually, or choose from preloaded available repositories.
Email Setup

Users can request help with email access or setting up an email account accessible by computer or phone. Users can also request help with configuring email or setting up web mail.

Meeting Room Issues

Users can request help with meeting room issues, such as conferencing problems, sound issues, display, connectivity, sharing, and more.
Troubleshoot Slow Computer

Users can request help associated with a slow computer, such as low RAM.

Here are a few things you can try:
1) Verify you are connected to the internet.
2) Try closing and reopening the Remote Meeting client to see if it solves the issue.

Did these steps work for you?
- Yes
- No
Guest WiFi Access

Guests to your company can obtain WiFi access.

What type of machine are you having issues with?
Mac

Here are a few things you can try:
1) If you have not restarted your machine, do that before moving to the next steps. If that did not solve the issue, try the next step.
2) Open Activity Monitor on your Mac to check if there is a process using significant memory or CPU.
3) Try closing and reopening the applications consuming significant memory or CPU.
4) If it doesn’t work, restart your computer and try again.

Did these steps work for you?
Yes
Printer Issues

Users can request help with issues associated with a printer, such as a paper jam, printer not working, or connectivity problems.

Which type of issue are you experiencing?

Printer doesn't turn on

Here are a few things you can try:
1) Verify the printer is plugged into a power outlet.
2) Press the Power button for 5 seconds and check whether the printer turns on or off.
3) If the printer turned off, press the Power button again to turn the printer on.

Did these steps work for you?

Yes
No
Users can request help with connecting to VPN or setting up VPN to access business systems from remote locations.

**ITSM Virtual Agent predefined Self-Service category topic conversation flows**

**Submit a request**

The Submit a request topic conversation uses the following topic blocks:

- Search Catalog Item
- Request Catalog Item

Using the Submit a request topic conversation, users can submit a request by choosing from all available options. For example, when a user is requesting an item, the Virtual Agent prompts the user to enter a search keyword. After the user enters the keyword, the Virtual Agent responds with available choices in a carousel view.
When the user selects the required item, the following scenarios are possible:

- A user can submit a request in the conversation mode (by answering the questions in line). After the request submission, a URL, which opens up the ticket page, is provided.
  
  **Note:** In Now® Mobile, the URL opens the native screen.

- In all other cases, Virtual Agent provides a link for the user to submit the request in the Service Portal defined in the `sn_itsm_va.com.snc.itsm.virtualagent.portal_url` property.
  
  **Note:** Now Mobile opens the item in Mobile Employee Service Portal (mesp).

For information about Service Catalog topic blocks, see Service Catalog topic blocks in Virtual Agent.

**Check IT Ticket Status**

Users can check the status of active IT tickets (incidents or requests). When a user asks about a ticket status, the virtual agent responds with a list of all active tickets for that user. Each ticket includes a link
to the incident or request, the item, the status (Stage), and when it was updated.

Users can add comments and also ask to chat with a live agent.

Process Approval

Users with the itil role can access active approval requests. The virtual agent returns all active approvals as a list. Users click an approval to access the actual approval record to approve or reject.

Get Password Reset Link

Users can access a password reset link when system lockout occurs or when passwords are forgotten. When a user enters keywords related to password reset, the virtual agent provides a link to the password reset process. If a user is not authenticated in the system, the virtual agent requests the user's email address. If a user is not enrolled in Password Reset, the virtual agent provides a link to Password Enrollment.

Note: An admin must properly configure the password reset process with a valid verification type for this topic to work as described. For details, see Configure your Password Reset process.

My Assigned Equipment
Users can view a list of all assigned equipment, such as laptops, mobile phones, and monitors. Clicking an item link provides additional details about the asset. Users can also create an asset-related incident directly within the conversation. Opening an incident from this conversation initiates the **Open IT Ticket** conversation topic by using the **Create Incident** topic block.

```
You only have one assigned asset.
```

```
P1000104 - Apple iMac 27"
Asset tag       P1000104
Display name   P1000104 - Apple iMac 27"
Model category Computer
Vendor         Apple
Cost           $1,699.99
Scheduled retirement 2018-07-22
```

```
Thanks for using our support chat! Have a great day!
```

**Service Disruptions**

Users can access all known outage information. When a user asks if a particular system is down, the virtual agent returns a list of links displaying planned or non-planned outages and any system degradations. Users can click the links for more detailed information about a specific outage or degradation, as well as click **Show more** when additional outages are known.
Open IT Ticket

This conversation topic is refactored to use the reusable Create Incident topic block.

Users can open an incident or access relevant knowledge base articles to resolve an issue. After typing keywords, such as open ticket or incident, the virtual agent prompts the user to enter a short description of the issue. The virtual agent returns links to relevant knowledge base articles and asks if an article resolved the issue. If it did not, the virtual agent asks for the urgency of the issue and creates an incident, providing a link to the actual incident.
When creating an incident, if you also want to create an associated Universal Request and display the Universal Request card in Virtual Agent instead of the incident, the Universal Request plugin (com.snc.universal_request) must be active and the Create Universal Request with incident property (com.snc.create_universal_request_with_incident) must be set to Yes (the default is Yes).

Note: Locate the property within the Incident Properties module, in the Incident VA Conversation category. Users with the itil_admin role have read and write permissions.

Open IT Ticket 2.0 (Template)
This topic is recommended to create an IT incident. Users can leverage machine-learning algorithms with application logic for predicting similar open tickets. Prevent users from opening duplicate incidents by finding similar incidents and asking if the user wants to add comments to the similar incident.

This topic was formerly called "Intelligent Open IT Ticket (Template)." "Open IT Ticket (Template)" and "Report IT issue (Template)" have been deprecated and replaced with this topic. If you have been using any of these three templates directly prior to the ITSM Virtual Agent Conversations 5.6 version, the deprecated topic name will display in the portal and must be updated. To update to the new template, navigate to Virtual Agent Designer. Select the Open IT Ticket 2.0 (Template) topic and click Publish.

⚠️ **Note:** Requires activation of the Predictive Intelligence for Incident (com.snc.incident.ml) plugin, which requires a separate license.

**Escalate IT Ticket**

Users can raise the urgency of an IT ticket for a faster resolution. Escalating a ticket priority requires choosing the incident and verifying the escalation. Users must provide a justification to escalate the incident. The virtual agent escalates the incident to the next urgency level, for example, from low to medium, or from medium to high. If an incident is already at high-level urgency, the virtual agent alerts the user to this and asks if the user would like to add a comment to help expedite resolution.
Walk-up Check-in

Users can check into a ServiceNow® Walk-up Experience location and secure a place in the queue. Users can also schedule an appointment at a walk-up location.
**Note:** This topic conversation is available when the Walk-up Experience plugin (com.snc.walkup) is activated.

Sure, I can hold a place in line for you.

There are currently 2 locations. Please select one:

**San Diego Tech Lounge**

- Hours of operation: 8-5 weekdays excluding holidays
- Accepts online check-in: Yes

There's no waiting line right now. I can check you in right away!

Would you like to check in right now?

- Yes
- Schedule for later
- No, never mind

**Set OOO reply Exchange Online (Template)**

Users can set an automatic out-of-office reply for Microsoft Exchange Online using Virtual Agent. The user selects the start and end time using their current local time zone. This topic uses the Microsoft Exchange Online spoke.
The user can choose to enter a custom message.
Select when you want your out-of-office reply to start in your current local time.

just now

Thursday, March 25 2021, 12:39 pm

Select when you want it to end in your current local time.

just now

Saturday, March 27 2021, 12:40 pm

Ok, anyone who sends you a message between these dates will get this response:

I am out through 2021-03-27 00:10:00 (America/Los_Angeles time). I will get back to you when I return. Thanks!

Is this message alright?

Yes, it is fine

No, I want to change it

Please pick an option.
No, I want to change it.

Please type your message.

just now

I will be out of office due to a medical emergency.

I will be out of office due to a medical emergency.

Shall I set the above message?

Yes

Never mind, cancel

Please pick an option.
The user can also choose to cancel or restart the conversation.
Set OOO reply Exchange Server (Template)

Users can set an automatic out-of-office reply for Microsoft Exchange Server using Virtual Agent. The user selects the start and end time using their current local time zone. This topic uses the Microsoft Exchange Server spoke.
Hi, I'm your Virtual Agent. Let me know how I can help you today.

What's your issue or request? Or take a look at what I can help with.

Sure, I can help set an out-of-office message for you.

Let me check a few things first.
The user can choose to enter a custom message.
Select when you want your out-of-office reply to start in your current local time.

just now

Thursday, March 25 2021, 12:39 pm

Select when you want it to end in your current local time.

just now

Saturday, March 27 2021, 12:40 pm

Ok, anyone who sends you a message between these dates will get this response:

I am out through 2021-03-27 00:10:00 (America/Los_Angeles time). I will get back to you when I return. Thanks!

Is this message alright?

Yes, it is fine

No, I want to change it

Please pick an option.
No, I want to change it.

Please type your message.

just now

I will be out of office due to a medical emergency.

I will be out of office due to a medical emergency.

Shall I set the above message?

Yes

Never mind, cancel

Please pick an option.
The user can also choose to cancel or restart the conversation.
Troubleshooting Collaboration Software Issues

Users can use Virtual Agent to troubleshoot common issues with collaboration software, such as Cisco Webex, Zoom, and Microsoft Teams software. These Virtual Agent conversation flows point to topic blocks, which can be customized based on the customer's software environment. If the user is not satisfied with the static help content for the issue they are facing, then they can do an AI search or Contextual search. The type of search is dictated by the system property sn_itsm_va.fallback_search_option.
Below is a sample of troubleshooting options for Microsoft Teams.
Hardware Issues (Template)

Users can use Virtual Agent to troubleshoot common hardware issues.
Virtual Agent displays relevant KB articles and catalog items to the user.
The user can create an incident if the search results do not resolve the issue.
Book Conference Room OnPrem (Template)

Users can book a conference room in on-premises Microsoft Exchange Server using Virtual Agent. This topic uses the Microsoft Exchange Server spoke.
First, Virtual Agent prompts the user to select a city for the meeting. The city must be configured in the room resource.
Next, the user selects a meeting start date and time and the meeting duration. By default, the minimum time duration for a meeting is set to 30 minutes.
Then, the user selects an available meeting room. Room availability lookup is done in batches of 50 rooms and 5 rooms are displayed at a time, with pagination through the lookup results.
The user provides a meeting subject and chooses if a meeting invite is sent to attendees.
If sending the meeting invite to attendees, the user enters the email addresses of all attendees.
Virtual Agent provides the final meeting details and the user can confirm the conference room booking. Once the booking is confirmed, Virtual Agent submits the room request.
Book Conference Room EXO (Template)

Users can book a conference room in Microsoft Exchange Online using Virtual Agent. This topic uses the Microsoft Exchange Online spoke. First, the user selects a city for the meeting. The city must be configured in the room resource.
Next, the user selects the number of attendees and a meeting start date and time.
Then, the user selects a duration for the meeting. By default, the minimum duration for a meeting is set to 30 minutes.
Virtual Agent provides a list of available meeting rooms. Room availability lookup is done in batches of 10 rooms and 5 rooms are displayed at a time, with pagination through the lookup results.
The user finishes the booking by providing a meeting subject and choosing if a meeting invite is sent to attendees.
If sending the meeting invite to attendees, the user enters the email addresses of all attendees.
Virtual Agent provides the final meeting details and the user can confirm the conference room booking. Once the booking is confirmed, Virtual Agent submits the room request.
Create Zoom Meeting Link (Template)

Users can create a Zoom meeting link using Virtual Agent. The user enters the start time and subject for the meeting and Virtual Agent returns a link to the meeting. This topic block leverages the Zoom spoke (com.sn.zoom.spoke).
Hi, I'm your Virtual Agent. Let me know how I can help you today.

What's your issue or request? Or take a look at what I can help with.

Test topic for Zoom link

Please enter the start time for your meeting

Please pick an option.
Get Zoom Meeting Recording (Template)

Users can get a recording of a Zoom meeting that they hosted in Microsoft Exchange Online, using Virtual Agent. This topic leverages the Zoom spoke (com.sn.zoom.spoke) and the Microsoft Exchange Online spoke (com.sn.msexchange.spoke). Ensure that your email address is configured in the sys_user record and that the address matches the address in Microsoft Exchange Online and Zoom.
The user enters when the meeting took place and Virtual Agent returns a list of possible meetings.
The user selects the desired meeting and Virtual Agent sends a link to the recording. The user can also share the recording with the meeting invitees or to a list of emails. If the host shares the meeting link, recipients receive an email notification.

If the recording has a passcode enabled, the email includes the passcode.
Friday, February 12 2021

I found these meetings. Select the one you want recording for.

Let's meet at 10 pm (22:00 - 22:30)

Here's the link to the recording for that meeting:

Let's meet at 10 pm (00:00:35)

Want me to email this recording to anyone?

Yes, I'll give you their emails
Send to all meeting invitees
No, thanks

Please pick an option.
Create Microsoft Teams Meeting Link (Template)

Users can request a Microsoft Teams meeting link using Virtual Agent. This topic block can be included in other topics. By default, this topic block is in silent mode and the output messages are not displayed. Users must have an active Microsoft Teams Communications (com.sn.msteams.communications.spoke) plugin. The following example shows a test topic configured to invoke this topic block.
Hi, I'm your Virtual Agent. Let me know how I can help you today.

What's your issue or request? Or take a look at what I can help with.

Test topic to get MS teams meeting link

Enter the subject of the meeting.

Demo

Enter the subject of the meeting.

Demo

Use below link to join the meeting.

https://teams.microsoft.com/l/meetup-join/19%3ameeting_ZSGRhzDl0YmltnW0J2M500NDIjLTk3ZhtMmE5hIjE2NDZhYWJl%40thread.v2/0?context%7b%22Tid%22%3a%22a46df9b7-2c9b-49d5-8c5f-d1b3de4ba59f%22%2c%22Oid%22%3a%2210d8e3ba-21C2-4e73-84e4-64a5b1c046b%22%7d

Thank you for using our support chat.

Click here to start a new conversation
ITSM Virtual Agent predefined Setup Topic conversation flows

For complete details about Setup Topic conversations, see Setting up the Virtual Agent conversation framework.

Greetings

Users receive a greeting at the beginning of a conversation from a virtual agent.

Anything Else Topic

Users are asked if they want to continue with another request or task.

Live Agent Support

Users can request a live agent and view items that a live agent can assist with.

Closing Conversation

Users receive an ending message when the conversation is done.

Personalized Greeting Topic

Users are greeted by name at the beginning of a conversation.

Dynamic Greeting Topic

Users receive a dynamic, time-based greeting at the beginning of a conversation from a virtual agent. The greeting includes addressing the user by first name with the time of day, referencing any incident or request the user may have open, and mentioning outage information if an outage is occurring or planned. For example:

"Good morning, John. You currently have [x] incidents and [x] requests open. We are aware of [outage] with [service] that began at [start time]."

When the end time is known, the virtual agent includes the message:

"The [outage] is planned to end at [end time]."

Note: If there are no incidents, requests, or outages these messages do not display.

The dynamic greeting is followed by the standard greeting, which asks the user to enter information.

Error Handling Topic

Users see an error message when the virtual agent encounters a problem that it cannot resolve.
Virtual Agent Feedback

This conversation is refactored to use the reusable Survey topic block Survey.

Users can provide CSAT feedback on their virtual agent experience before the conversation ends.

This is a simple, reusable virtual agent survey topic enabling you to collect CSAT feedback on virtual agent within your organization. Users are asked to rate the experience by choosing a sentiment from an image carousel of three faces. Choices include a happy face, a neutral face, and a sad face. If the sad face is chosen, users are prompted to provide a comment about the poor experience.

Fallback Topic

Users see a message when the virtual agent cannot find a topic that matches a request or when it doesn’t understand an entry.

Search Fallback Topic

Dynamic topic that runs a search of knowledge base articles and catalog items when no existing conversation topics match the users query. Integrates with catalog and knowledge base search.

Virtual Agent Capabilities

Users can ask for assistance during the conversation and view a list of items that the virtual agent can assist with.

Survey

Users can provide insight into what they need prior to a conversation, as well as feedback on their conversational experience before the conversation ends.

Automatically route incoming conversations to the correct live-IT agent group. Reduce live-IT agent time by automating pre-chat data collection. By providing a pre-chat survey to users to find out what is needed, ITSM Virtual Agent can route the conversation to a proper live IT agent.

Deliver a survey through ITSM Virtual Agent, for both pre- and post-chat experiences.

Use the Pre-Chat survey and Post-Chat survey topics before starting or prior to completing an ITSM Virtual Agent conversation. Present surveys for data collection or to gather feedback on the experience.
Manage Office 365 Group conversation flow

ITSM Virtual Agent enables you to manage a Microsoft Office 365 Group using a prebuilt set of topics. With this conversation flow, you can add or remove users from an existing Microsoft Office 365 Group, create a Microsoft Office 365 Group, and more.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

How does the Microsoft Office 365 Group conversation flow work?

Natural Language Understanding (NLU) is used to identify and trigger the Microsoft Office 365 Group action that a user wants to perform. Integration is required with the Microsoft service via ServiceNow® IntegrationHub and ServiceNow® Flow Designer. Using the existing IntegrationHub Azure AD Spoke, the topics create a conversation that calls these actions to complete an end-to-end fulfillment of the request.

This topic is only available with the activation of the Microsoft Azure AD for IntegrationHub (com.sn.azure_ad.spoke) plugin.

Note: If the Microsoft Office 365 topics are duplicated in a different scope than ITSM VA Conversations, script logics can be affected and cause errors.

To set up Microsoft Azure AD for IntegrationHub, see Set up Microsoft Azure AD spoke.

Microsoft Office 365 Group conversation flow actions

You can perform the following actions with the Microsoft Office 365 Group conversation flow:

- Create Microsoft Office 365 Group
- Add User to Microsoft Office 365 Group
- Remove User from Microsoft Office 365 Group
- Add Owner to Microsoft Office 365 Group
- Remove Owner from Microsoft Office 365 Group
- Get Microsoft Office 365 Group Details
For details about each conversation flow action, see Manage Office 365 Group conversation flow actions.

**Manage Office 365 Group conversation flow actions**

ITSM Virtual Agent helps you manage Microsoft Office 365 Groups using actions in conversation flows.

**Create Office 365 Group**

Users can create a group in Microsoft Azure AD by providing the following information:

- Group privacy
- Group email alias
- Outlook display name
- Group description
- Owners and members (optional)

The current user is automatically added as the Group Owner, along with any other specified users.
What's your issue or request? Or take a look at what I can help with.

I can help you create a group.

Do you want it to be public or private?

Public

OK, type in the email alias you want for this group. It can only have letters, numbers, underscores, hyphens and periods.
What name do you want it listed as in the Outlook address book?

about a minute ago

Application development

Type in a brief description of APP-DEV.

Contains all members from application dev team
What name do you want it listed as in the Outlook address book?

about a minute ago

Application development

Type in a brief description of APP-DEV.

Contains all members from application dev team
OK, now I can add up to 20 people to the group as owners or members including you.

I'll add you as an owner. Would you like to add any other owners?

No, only add me

Do you want to add any members to this group?

about a minute ago

Not now
Add User to Microsoft Office 365 Group

Group owners can add themselves or other users to a Microsoft Azure AD group by providing the group name and the email address of one or more users to add.
Remove User from Microsoft Office 365 Group

Users can remove themselves from a Microsoft Azure AD group. Group owners can remove other users from a group. Provide the group name and user email addresses to remove.
Add Owner to Microsoft Office 365 Group

Group Owners can add other users as Group Owners by providing the group name and the user email addresses to add.
Remove Owner from Microsoft Office 365 Group

Group Owners can remove themselves or other Group Owners by providing the group name and the user email addresses to remove.
Get Microsoft Office 365 Group Details

Group members can get group details by providing the name or email of the group.
Manage Microsoft Active Directory Distribution List conversation flow

ITSM Virtual Agent helps admin users manage an on-premise Microsoft Active Directory distribution list using a prebuilt set of topics. With this conversation flow, you can add and remove users from a distribution list, create distribution lists, and show Distribution List details.
How does the Microsoft Active Directory Distribution List conversation flow work?

Natural Language Understanding (NLU) is used to identify and trigger the action that a user wants to perform. Integration is required with the Microsoft service via ServiceNow® IntegrationHub and ServiceNow® Flow Designer. Using the existing IntegrationHub Microsoft AD spoke, the topics create a conversation that calls these actions to complete an end-to-end fulfillment of the request.

This topic is only available with the activation of the Microsoft AD for IntegrationHub plugin.

To set up Microsoft AD Spoke for IntegrationHub, see Microsoft AD spoke.

ℹ️ Note: When duplicating the Microsoft Active Directory topic, it must be in the ITSM Virtual Agent scope.

**Microsoft Active Directory conversation flow actions**

You can perform the following actions with the Microsoft Active Directory Distribution List conversation flow:

- Add User to Microsoft Active Directory Group
- Remove User from Microsoft Active Directory Group
- Get Microsoft Active Directory Group Membership Details
- Create Microsoft Active Directory Distribution Group

For details about each conversation flow action, see Manage Microsoft Active Directory actions.

**Manage Microsoft Active Directory actions**

ITSM Virtual Agent helps you manage Microsoft Active Directory Distribution Lists using actions in conversation flows.

**Add User to Microsoft Active Directory Group**

Group owners can add themselves or other users to a Microsoft Active Directory Group Distribution List by providing the group name and the email address or username of one or more users to add.
Hi, I'm your Virtual Agent. Let me know how I can help you today.

What's your issue or request? Or take a look at what I can help with.

add user to ad group

I can help you add people to a group.

Let me check a few things first.

Type in the name of the group.

Click here to start a new conversation
Remove User from Microsoft Active Directory Group

Users can remove themselves from a Microsoft Active Directory Group Distribution List. Group owners can remove other users from a group. Provide the group name and username or email addresses to remove.
What's your issue or request? Or take a look at what I can help with.

about a minute ago

remove users from AD Group

I can help you remove people from a group.

Let me check a few things first.

Type in the name of the group.

Applications Dev

Click here to start a new conversation
Who would you like to be removed from this group?

OK, here's who I've removed from Applications Dev:

aman

Thank you for using our support chat.
Create Microsoft Active Directory Group

Users can create a Microsoft Active Directory Distribution List by providing the following information:

- Group name
- Group description
- Members (optional)

The current user is automatically added as the Group Owner. Distribution Lists are always public.
Hi, I'm your Virtual Agent. Let me know how I can help you today.

What's your issue or request? Or take a look at what I can help with.

I can help you create a distribution group.

Let me check a few things first.

Type in the name you want for this group.

Click here to start a new conversation
Now Support

Type in the name you want for this group.

Applications Dev

Give me a minute to check if it's available.

OK, that name is available.

Type in a brief description of Applications Dev

about a minute ago

Contains all members of applications dev team

OK, here are the details I have for this group.
Name: Applications Dev
Description: Contains all members of

Click here to start a new conversation
Show my Microsoft Active Directory Group Membership

Group members can see a list of the Microsoft Active Directory Distribution Lists of which they are currently a member or manager.
Hi, I'm your Virtual Agent. Let me know how I can help you today.

What's your issue or request? Or take a look at what I can help with.

Show My AD Group Membership (Template)

Sure, I can look up the groups you're a member or manager of.

Give me a minute to check on that for you.

Here are the groups that you're currently a member of.
AmanGr

Click here to start a new conversation
Manage local admin access

ITSM Virtual Agent provides users with local admin access through the Agent Client Collector (ACC). Users can gain temporary admin access to make software or system updates directly with Virtual Agent using the Local Admin Access – ACC (Template) conversation.
How does the Local Admin Access – ACC (Template) conversation flow work?

Natural Language Understanding (NLU) is used to identify and trigger the action that a user wants to perform. Using the Agent Client Collector Spoke (com.sn.acc.spoke / sn_acc_spoke) plugin, the Local Admin Access – ACC (Template) topic creates a conversation flow that calls the appropriate topic block to grant admin access. This prebuilt topic is read-only. Duplicate the topic in the ITSM Virtual Agent conversation scope and activate it to use the conversation flow. This conversation flow only provides admin access for Mac users; if the user selects another operating system, Virtual Agent provides relevant KB articles.

For more information about this conversation flow, see Local admin access conversation flow.

Set up local admin access

Administrators and users with the Virtual_agent_admin role can install and activate the Agent Client Collector Spoke plugin. Developers can update scripts and configure commands as needed for their organization.

Before you begin
Role required: admin or virtual_agent_admin

Procedure

1. Install the Agent Client Collector Spoke plugin on the instance according to the Agent Client Collector installation instructions.

2. Update the sudoers file of the Mac devices with the following entry. This process allows the servicenow user to run the grant_admin_access script in sudo mode and bypass password requirements.

```
_servicenow ALL=
SETENV: /
Library/Caches/servicenow/agent-client-collector/admin-access-mac/bin/grant_admin_access.sh *
Defaults:_servicenow !requiretty
Defaults exempt_group += _servicenow
```

3. Activate the Agent Client Collector plugin (admin-access-mac), after validating the attached payload with your internal IT team.

4. Configure the following commands as needed for your organization. See the corresponding description for the usage of the command.
• ACC Check Definition: `check-admin-access, grant-admin-access`

5. Duplicate and activate the Local Admin Access – ACC (Template) topic in the ITSM Virtual Agent scope. To view, duplicate, preview, or publish ITSM topics in the Virtual Agent Designer, refer to [Virtual Agent Designer](#).

**Local admin access conversation flow**

ITSM Virtual Agent grants users local admin access through the Agent Client Collector using the Local Admin Access – ACC (Template) conversation flow.

**Enable local admin access**

Virtual Agent grants admin access and removes the access for all users on the device after the designated time period (except users listed in `DEFAULT_ADMIN_USERS`).

When the user requests help with admin access, Virtual Agent asks the user to select on which device they would like admin privileges.
The user then selects the duration for which they would like admin access.

Virtual Agent grants admin rights on the selected device for the requested duration.
Incident Auto Resolution for ITSM Virtual Agent

Proactively deflect some of the most common ITSM incidents to ITSM Virtual Agent through Actionable Notifications. Initiate an ITSM Virtual Agent conversation with an end user after they submit an incident through a non-conversational service channel, if an existing ITSM Virtual Agent conversation can resolve the issue.

Understanding Incident Auto Resolution
Incident Auto Resolution enables ITSM Virtual Agent to proactively resolve incidents through a conversation on the user’s preferred chat channel. The Incident Auto Resolution flow follows these steps:

- When an end user creates an incident through a non-conversation service channel, such as ServiceNow® Service Portal or email, the machine learning model checks for a matching intent that has Incident Auto Resolution enabled.
• If a matching intent and topic are found, Virtual Agent sends an Actionable Notification to the end user on their existing chat channel. The user can accept or decline the Virtual Agent assistance.

• If the end user accepts the Virtual Agent assistance, the Incident Auto Resolution service invokes the matched ITSM Virtual Agent conversation to resolve the incident.

• When the conversation completes, the user can indicate if the conversation resolved the incident and can choose to keep the ticket open or to close it.

**When is an incident unassigned from Virtual Agent?**

An incident is unassigned from Virtual Agent for auto-resolution and routed to a human agent when any of the following conditions apply:

• The matched intent doesn't have a matching topic in the same domain as that of the incident.

• The matched topic doesn't have Incident Auto Resolution enabled.

• The end user has not subscribed to notifications.

• The end user declines, ignores, or abandons the Virtual Agent conversation.

• The end user responds to the Virtual Agent conversation that the matched topic didn't resolve the issue.

**ITSM Virtual Agent conversation flows for Incident Auto Resolution**

Users with the admin or virtual_agent_admin role can choose a subset of pre-built topics to be available for Incident Auto Resolution. The following ITSM Virtual Agent intents are supported:

• PrinterIssues

• VPNConnectivity

• HardwareIssues

• ResetPassword

These intents are currently the only supported intents for Incident Auto Resolution. Users with the admin or virtual_agent_admin role can create their own custom topics to use, instead of the included pre-built topics. These custom topics must have Incident Auto Resolution enabled and must be mapped to a supported intent from this list.

**Setting up Incident Auto Resolution for ITSM Virtual Agent**

Users with the admin or virtual_agent_admin role can activate the Glide Virtual Agent (com.glide.cs.chatbot) plugin. The Glide Virtual Agent
(com.glide.cs.chatbot) plugin activates the following aspects of Incident Auto Resolution:

- Auto Resolution Admin Configuration
- Auto Resolution Actionable Notifications
- Auto Resolution Virtual Agent Topic
- Auto Resolution Intent Analytics Dashboard

In addition, the Glide Virtual Agent (com.glide.cs.chatbot) plugin activates the Intent Discovery for Incident Auto Resolution APIs by pulling in the following related plugins:

- Proxy Agent to the ServiceNow Natural Language Understanding server (com.glide.nlu.intent.discovery)
- Predictive Intelligence (com.glide.platform_ml)

The ITSM Virtual Agent Conversations Store App activates the following aspects of Incident Auto Resolution:

- Incident Auto Resolution Configuration
- ITSM Incident Auto Resolution Topics

The Conversational Analytics Store App activates the Auto Resolution Conversation Analytics dashboard.

**Related information**

Using Virtual Agent for Incident Auto Resolution

**Actionable Notifications for ITSM Virtual Agent**

Send interactive messages to an employee through Virtual Agent, based on pending tasks or alerts. Deflect some of the most common ITSM incidents to ITSM Virtual Agent, reduce incident volume to Service Desk, and help employees discover ITSM Virtual Agent as a resolution channel.

**What are Actionable Notifications?**

Actionable Notifications are interactive messages that Virtual Agent sends to the end user when the user takes certain actions on non-conversational service channels. For example, Virtual Agent can send an Actionable Notification when an employee submits an incident through email or the ServiceNow® Service Portal, if there are any updates or actions needed from the employee. Employees can resolve the incident directly in the Virtual Agent conversation, without involving a live agent.
Admin or virtual_agent_admin users activate Actionable Notifications and the ITSM Virtual Agent Conversation topics.

To create your own custom Actionable Notifications, see Setting up Virtual Agent notifications.

**Actionable Notifications conversation flow**
The following Actionable Notifications conversation flows are available for ITSM Virtual Agent:

- Service Desk opened incident on behalf of user
- Knowledge Base article attached to incident
- Comment added to incident
- Incident resolved
- Comment added to Service Desk Requested Item
- Service Catalog item requested on behalf of requester
- Service Catalog requested item approval notification
- Service Catalog request approval notification
- Approval for change request - Show Details field not configured (Task extended table)
- Approval for change request - Show Details field configured (Task extended table)
- Approval for knowledge article - fields not configured (Non Task extended table)
- Approval for knowledge article - fields configured (Non Task extended table)
- Status (success/failure) of a virtual machine operation (start, stop, terminate, describe) requested through Virtual Agent

For details about each conversation flow, see Actionable Notifications conversation flow.

**Related information**

Incident Auto Resolution for Virtual Agent

**Set up Actionable Notifications for ITSM Virtual Agent**

Administrators and users with the virtual_agent_admin role can enable System Notifications, trigger Flow Designer flows for Actionable Notifications topics, and activate notifications in Virtual Agent.
Before you begin
Role required: admin or virtual_agent_admin

Procedure

1. Enable System Notifications.

   a. Navigate to System Notifications > Provider.

   b. Set the Active property to true for the conversations you want to activate.

2. Activate Flow Designer flows for specific Actionable Notifications ITSM Virtual Agent conversations. These topics are inactive by default. For complete details regarding activating flows, refer to Activate a flow. The following flows for Actionable Notifications must be activated if you want to use them with Actionable Notifications:

   • ITSM Actionable Notifications trigger flow - Incident commented
   • ITSM Actionable Notifications trigger flow - KB attached to incident
a. Select the flow you would like to activate in Flow Designer.

b. Click **Activate**.

3. Activate notifications in Virtual Agent.

   a. Navigate to **Collaboration > Chat Setup**.

   b. In the Chat Setup form, select **Enable notifications for all users**.

**Related information**

- Notifications in messaging applications
- Setting up Virtual Agent notifications

**Actionable Notifications conversation flow**

Notify employees of pending tasks and alerts with Actionable Notifications from ITSM Virtual Agent.
Actionable Notifications conversation flow for incidents

Service Desk opened incident on behalf of user

Callers receive an Actionable Notification whenever someone opens an incident on their behalf. The caller can choose to add a comment to the incident, resolve the incident, or skip the notification.

If the caller selects **Add Comment**, Virtual Agent provides a URL to the incident and the caller can enter comments directly into the chat.
If the caller selects **Resolve Incident**, Virtual Agent resolves the incident and provides the incident URL.
Knowledge Base article attached to the Incident

Callers receive an Actionable Notification from Virtual Agent when a Knowledge Base article is attached to their incident. The caller can choose to view the article, resolve the incident, or skip the notification.

**Note:** This flow must be activated in Flow Designer. See Set up Actionable Notifications for ITSM Virtual Agent.
If the caller chooses to view the article, Virtual Agent displays a snippet and a link to the complete article.
The caller can also give feedback and add comments to the incident.
Comment added to incident

Callers are notified whenever someone adds a comment to their incident. The caller can choose to view comments, resolve the incident, or skip the notification.

Note: This flow must be activated in Flow Designer. See Set up Actionable Notifications for ITSM Virtual Agent.
If the caller selects **View Comments**, Virtual Agent displays the three most recent comments on the incident.
After viewing the most recent comments, the caller can choose to add their own comments and images.
3 Minutes ago
KB was helpful, but I need more help to resolve the issue

Sreeja Reddy
5 Minutes ago
K80000015: How do I create and delete users?

Do you want to add anything to this?
Add Comment
Add Image
Add both
I'm done

Please pick an option.

8m ago

Ok, I've added these details to the incident.
Incident resolved

Callers receive an Actionable Notification whenever someone other than the caller resolves one of their incidents. The caller can choose to close the incident, mark the incident unresolved, or skip the notification.
If the caller chooses to mark the incident unresolved, Virtual Agent offers to add comments from the caller directly through the chat and reopens the incident.
If the caller chooses to close the incident, Virtual Agent closes the incident and provides the incident URL.
**Actionable Notifications conversation flow for Service Catalog**

**Service Catalog item requested on behalf of requester**

Virtual Agent sends an Actionable Notification to an end user when a Service Catalog request is opened on the user's behalf. The requester can choose to view request details, add comments directly in the chat, or skip the notification.
**Go to RI7M0010107**

<table>
<thead>
<tr>
<th>Item</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Executive Desktop</td>
<td></td>
</tr>
<tr>
<td>Requested for</td>
<td>Abel Tutor</td>
</tr>
<tr>
<td>Quantity</td>
<td>2</td>
</tr>
<tr>
<td>Price (ea.)</td>
<td>£1,337.2105</td>
</tr>
</tbody>
</table>

**Options:**
- **CPU Speed**
  - Intel Xeon Processor (2.66GHz 1.333GHz FSB)
  - Memory 1GB
  - Hard Drive 100GB
  - Operating System: Windows XP Professional
  - **Special Requirements**
    - Intel Xeon Processor (2.66GHz 1.333GHz FSB)
    - Intel Xeon Processor (3.00GHz 1.333GHz FSB) [add £49.92]
    - Intel Xeon Processor (3.73GHz 1.333GHz FSB) [add £224.65]

Please pick an option.
Requested for
Abel Tuter
Quantity
2
Price (ea.)
£1,337.2105

Options:
CPU Speed
Intel Xeon Processor (2.66GHz 1.333GHz FSB)
Memory 1GB
Hard Drive 100GB
Operating System
Windows XP Professional
Special Requirements
Intel Xeon Processor (2.66GHz 1.333GHz FSB)
Intel Xeon Processor (3.00GHz 1.333GHz FSB) [add £49.92]
Intel Xeon Processor (3.73GHz 1.333GHz FSB) [add £224.65]

Do you want to add anything to this?
Add Comment
I'm done

Please pick an option.
Service Catalog requested item approval notification

Virtual Agent sends an Actionable Notification to the approver of a request to expedite a response. The approver can choose to view the request details or skip the notification.
Approvers can approve or reject the request directly in the chat.
Approvers can add comments to rejected requests directly in the chat.
Service Catalog request approval notification

Virtual Agent sends an Actionable Notification to the approver of a request to expedite a response. The approver can choose to view the request details or skip the notification.
Approvers can approve or reject the request directly in the chat.
Approvers can also add comments to rejected requests directly in the chat.
Comment added to Service Catalog requested item

Virtual Agent sends an Actionable Notification to employees who have requested items when a new comment is added to the request. Requesters can choose to view the comment or skip the notification.
If the requester selects **View Comment**, Virtual Agent displays the three most recent comments and the requester can choose to add their own comment.
The requester enters a comment and Virtual Agent adds the new comment directly from the chat.
Virtual Agent sends an Actionable Notification to the approver when an approval for a change is requested. The approver can approve, reject, show details, or skip the notification.
The fields shown here are the default fields for any task table.
Approval for change request - Show Details field configured (Task extended table)

Virtual Agent sends an Actionable Notification when an approval for a change is requested. The approver can approve, reject, show details, or skip the notification.

The fields shown here are the fields configured in the _show_approval_details_ topic. These fields can be configured by an admin user.
Approval for knowledge article - fields not configured (Non Task extended table)

Virtual Agent sends an Actionable Notification when an approval for a knowledge article is requested. Users can approve, reject, show details, or skip the notification.
For non-task tables, when no fields are configured in the `_show_approval_details_` topic, a message appears which links to the record being reviewed.
Approval for knowledge article - fields configured (Non Task extended table)

Virtual Agent sends an Actionable Notification when an approval for a knowledge article is requested. Users can approve, reject, show details, or skip the notification.
The fields shown here are the fields configured in the `show_approval_details` topic. These fields can be configured by an admin user.
**Actionable Notifications for Incident Auto Resolution**

Incident Auto Resolution sends Actionable Notifications through Virtual Agent directly to the end user on their preferred chat channel. Virtual Agent sends an Actionable Notification when the machine learning model finds a topic with Incident Auto Resolution enabled that matches the user's intent and the user is subscribed to notifications. Actionable Notifications contain buttons that the user can select. Each button is mapped to an Incident Auto Resolution enabled topic. Based on the user's selections, different aspects of Incident Auto Resolution execute, according to the logic of the matched topic. For more information about Incident Auto Resolution, see [Incident Auto Resolution for ITSM Virtual Agent](#).

**VPN Connectivity (Template)**

Callers receive an Actionable Notification when an incident is created and the incident short description relates to VPN connectivity issues. The caller can choose to accept the Virtual Agent assistance, wait for a human agent, or skip the notification.
If the caller accepts the Virtual Agent assistance, the matched Incident Auto Resolution topic runs and Virtual Agent provides suggestions to resolve the issue.
After Virtual Agent provides suggestions to resolve the issue, the caller can indicate if these suggestions were successful and can choose to close the ticket or to leave it open. If the caller chooses to leave the ticket open, Virtual Agent assigns the ticket to a live agent.
1. Click the VPN client located at the top right corner of your desktop.
2. Click connect.
3. Enter your Active Directory username (first.lastname) and password. If you have a hard token, your password should be PIN + Token.

When you’re successfully connected, you’ll see a ‘house’ symbol when you’re connected internally and a ‘shield’ symbol when you’re connected externally.

Did these steps work for you?

Yes

If there’s anything else you need related to this ticket, I can keep it open

No, close it

Yes, keep it open

Please pick an option.
Printer Issues (Template)

Callers receive an Actionable Notification when an incident is created and the incident short description is related to printer issues. The caller can choose to accept the Virtual Agent assistance, wait for a human agent, or skip the notification.
If the caller accepts the Virtual Agent assistance, the matched Incident Auto Resolution topic runs and Virtual Agent provides suggestions to resolve the issue.
After Virtual Agent provides suggestions to resolve the issue, the caller can indicate if these suggestions were successful and can choose to close the ticket or to leave it open. If the caller chooses to leave the ticket open, Virtual Agent assigns the ticket to a live agent.
Great, if it turns out you need more help with it, we can leave the ticket open

Which type of issue are you experiencing?

just now

Printer is out of paper

Here are a few things you can try:
1) Check that all compartments are closed.
2) If you need to request more paper, move to the next step and open an IT ticket. Don’t forget to specify the name of the printer and the type of paper you need.

Did these steps work for you?

Yes

No

Please pick an option.
Password Management for ITSM Virtual Agent

End users can perform password reset, password change, and account unlock actions through Virtual Agent conversations.

Using Virtual Agent for password management

These topics use the Password Reset (com.glideapp.password_reset) plugin and the Install Password Reset Virtual Agent Conversations (com.snc.password_reset.virtual_agent) plugin. For more information about creating your password reset process, see Password Reset.

End users can initiate a password management conversation with Virtual Agent by entering the keywords Reset, Change, Unlock, or Password.
Users that are not logged in can perform the Reset Password and Unlock Account actions. Logged in users can perform the Change Password, Reset Password, and Unlock Password actions.

**Verification options for password reset in Virtual Agent conversations**
The following identity verification options are supported in Virtual Agent conversations. Custom verifications are not supported in Virtual Agent.

- Personal data verification: User provides specific pieces of personal data.
- Google Authenticator verification: User enters the generated code from the Google service Authenticator mobile app.
- SMS code verification: User enters the code received via mobile text message.
• Email code verification: User enters the code received via email.
• Security question verification: User enters the configured security question answers.

**Reset password conversation flow for Virtual Agent**
• Virtual Agent sends identity verification information to the end user, based on the password reset process configuration.
• If the user successfully verifies their identity with the given inputs, Virtual Agent provides the reset steps.
• Virtual Agent displays the password rules.
• The user enters a new password, adhering to the password rules.
• If the password does not meet the criteria, Virtual Agent prompts the user to reenter the password.
• Once the password meets the criteria, Virtual Agent resets the password.

**Change password conversation flow for Virtual Agent**
• Virtual Agent asks the user to input their current password.
• If the current password matches, the user can enter a new password.
• Virtual Agent displays the password rules.
• If the user provides a password that meets the password requirements, Virtual Agent updates the password.
• If the user does not enter a valid password, the user must reenter the password.

**Unlock account conversation flow for Virtual Agent**
• Virtual Agent sends identity verification information to the end user, based on the password reset process configuration.
• If the user successfully verifies their identity with the given inputs, Virtual Agent provides the verification information.
• Once the user has been identified and verified, Virtual Agent unlocks the user's account.

**Related information**
Configure Agent Chat in Service Portal
Virtual Machine Management for ITSM Virtual Agent

ITSM Virtual Agent helps you manage a Virtual Machine using conversation flows. This conversation flow enables you to start, stop, terminate, describe, and provision a Virtual Machine.

How do the virtual machine (VM) management conversation flows work?

Natural Language Understanding (NLU) is used to identify and trigger the action that a user wants to perform. Integration is required with the Microsoft service via ServiceNow® IntegrationHub and ServiceNow® Flow Designer. Using the Cloud Services (com.snc.cloud.mgm) plugin, the Manage Virtual Machine (Template) topic creates a conversation flow that calls the appropriate topic block to complete an end-to-end fulfillment of the request. These prebuilt topics are read-only. Duplicate the topic in the Virtual Machine Management for Virtual Agent scope and activate it to use the conversation flow. The user is required to have the sn_managevm_va.cai_vm_user role to perform these actions with virtual machines.

Manage virtual machine conversation flow actions

You can perform the following actions with the Manage Virtual Machine (Template) conversation flow:

- Start a Virtual Machine
- Stop a Virtual Machine
- Terminate a Virtual Machine
- Describe a Virtual Machine
- Provision a Virtual Machine

You can perform the following actions with the Cloud Access Interface (CAI) conversation flows for Virtual Agent:

- Start a Virtual Machine CAI (Template)
- Stop a Virtual Machine CAI (Template)
- Terminate a Virtual Machine CAI (Template)
- Describe a Virtual Machine CAI (Template)

For details about each action, see Virtual machine management actions for Virtual Agent.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Virtual machine management actions for ITSM Virtual Agent

ITSM Virtual Agent helps you manage a virtual machine (VM) using conversation flows. With this conversation flow, you can start, stop, terminate, describe, and provision a virtual machine.

Start a virtual machine (VM)
Users can start any assigned VM instance using the Manage Virtual Machine (Template) conversation flow with Virtual Agent. If the VM is already on or is in a state where it cannot be started, Virtual Agent notifies the user. The user can specify which VM to start, or Virtual Agent can provide a list of available VM instances and the user can select the desired VM to start.
Virtual Agent sends the user an Actionable Notification when the requested VM starts. The user can choose to see details, request additional instructions to log in to the virtual machine, or skip the notification. Virtual Agent also notifies the user if the operation was unsuccessful.
If the user requests additional login instructions, Virtual Agent provides these instructions and the user can confirm if the login was successful.
Stop a virtual machine (VM)

Users can stop any assigned VM instance using the Manage Virtual Machine (Template) conversation flow with Virtual Agent. If the VM is already off or is in a state where it cannot be stopped, Virtual Agent notifies the user. The user can specify which VM to stop, or Virtual Agent can provide a list of available VM instances and the user can select the desired VM to stop.

Steps for connecting to Linux VM:

1. Open the terminal on your local machine.
2. Use the following command in terminal and replace the PRIVATE_KEY and USERNAME you have for the virtual machine.

   ```
   ssh -i private_key.pub
   username@3.15.187.21
   ```
Virtual Agent sends the user an Actionable Notification once the requested virtual machine has stopped. The user can choose to see additional details or skip the notification.
Virtual Agent provides the requested VM details.
Virtual Agent also sends the user a notification if the operation is unsuccessful.
Terminate a virtual machine (VM)

Users can choose to terminate any assigned virtual machine instance using the Manage Virtual Machine (Template) conversation flow with Virtual Agent. If the VM is already terminated or is in a state where it cannot be terminated, Virtual Agent notifies the user. The user can specify which VM to terminate, or Virtual Agent can provide a list of available VM instances and the user can select the desired VM to terminate.
Virtual Agent provides the details of the requested VM to terminate.
Terminating a virtual machine is a permanent action. The user must confirm the operation to continue.
Virtual Agent sends the user an Actionable Notification when the requested virtual machine has been terminated.
Describe a virtual machine (VM)
Users can get details on any assigned VM instance using the Manage Virtual Machine (Template) conversation flow with Virtual Agent. Details include Provider, Region, Instance ID, and so on. The user can specify which VM to describe, or Virtual Agent can provide a list of available VM instances and the user can select the desired VM to describe.
Virtual Agent provides the requested virtual machine details. To get additional details, the user can click the link provided, which redirects to the.
Provision a virtual machine (VM)

Users can request a new VM through a Virtual Agent conversation. Virtual Agent sends a link to the Cloud User Portal to submit the catalog item. This topic requires an active Cloud Provisioning and Governance (com.snc.cloud.mgmt) plugin.
Users can select any available VM in the catalog assigned to them.
Sure, I can help you submit a request for a new virtual machine (VM) instance.

Here are the VMs available in the catalog that you can choose from.

Please pick an option.
If the user can't find the desired catalog item, the user can either go directly to the or end the conversation.

**Start Virtual Machine CAI (Template)**

Users can start any assigned virtual machine instance associated with their credentials set up by the system administrator. If AWS encounters an error, Virtual Agent asks the user to create an incident for further investigation.
Hi, I'm your Virtual Agent. Let me know how I can help you today.

What's your issue or request? Or take a look at what I can help with.

start vm

Sure, I can help you start your virtual machine instance.

Which cloud provider is your VM in?

AWS

A different cloud provider

Please pick an option.
Which region is your VM in?

us-west-1

Do you know the name of virtual machine instance?

No

Which of the virtual machine instance would you like me to start for you?

just now

Please pick an option.
Which of the virtual machine instance would you like me to start for you?

just now

i-0524fc6d49f30ef3b9
CustomTag: TestProvision, Name: test_vm_1

Select
Stop Virtual Machine CAI (Template)

Users can stop any assigned VM instance associated with the credentials set up by the system administrator. If AWS encounters an error, Virtual Agent asks the user to create an incident for further investigation.
Hi, I'm your Virtual Agent. Let me know how I can help you today.

What's your issue or request? Or take a look at what I can help with.

Sure, I can help you stop your virtual machine instance.

Which cloud provider is your VM in?

- AWS
- A different cloud provider

Please pick an option.
<table>
<thead>
<tr>
<th>Region</th>
</tr>
</thead>
<tbody>
<tr>
<td>ap-northeast-1</td>
</tr>
<tr>
<td>ap-northeast-2</td>
</tr>
<tr>
<td>ap-northeast-3</td>
</tr>
<tr>
<td>ap-south-1</td>
</tr>
<tr>
<td>ap-southeast-1</td>
</tr>
<tr>
<td>ap-southeast-2</td>
</tr>
<tr>
<td>ca-central-1</td>
</tr>
<tr>
<td>eu-central-1</td>
</tr>
<tr>
<td>eu-north-1</td>
</tr>
<tr>
<td>eu-west-1</td>
</tr>
<tr>
<td>eu-west-2</td>
</tr>
<tr>
<td>eu-west-3</td>
</tr>
<tr>
<td>sa-east-1</td>
</tr>
<tr>
<td>us-east-1</td>
</tr>
<tr>
<td>us-east-2</td>
</tr>
</tbody>
</table>

Please pick an option.
Enter the name of VM instance.

test

Virtual Machines found with name test

Tag2: Second Tag, Tag1: This is 1st Tag!, CustomTag: Test Provision, Name: test_vm

Please pick an option.
Describe Virtual Machine CAI (Template)

Users can see details of any assigned VM instance associated with the credential set up by the system administrator. If AWS encounters an error, Virtual Agent asks the user to create an incident for further investigation.
Sure, I can give you details on your virtual machine instance.

Which cloud provider is your VM in?

AWS

Which region is your VM in?

- ap-northeast-1
- ap-northeast-2
- ap-northeast-3
- ap-south-1
- ap-southeast-1
- ap-southeast-2

Please pick an option.
Do you know the name of virtual machine instance?

No

Which of the virtual machine instance would you like me to describe for you?

- i-0e0837fadbd9f8cad
  - Tag2: Second Tag, Tag1: This is 1st Tag!, CustomTag: TestProvision, Name: test_vm

Please pick an option.
Terminate Virtual Machine CAI (Template)

Users can terminate any assigned virtual machine instance associated with the credential set up by the system administrator. Because termination is a permanent action, Virtual Agent displays the VM details and asks for confirmation. If AWS encounters an error, Virtual Agent asks the user to create an incident for further investigation.
Sure, I can help you terminate your virtual machine instance.

Which cloud provider is your VM in?

AWS

Which region is your VM in?

us-west-1

Do you know the name of virtual machine instance?

Yes

Please pick an option.
Which of the virtual machine instance would you like me to terminate for you?

Instance ID: i-0e28a629e9df68098

Provider: AWS
Region: us-west-1
State: running
Type: t2.micro
Private IP: 172.31.15.204

Please pick an option.
Meeting management for ITSM Virtual Agent

Manage meetings using ITSM Virtual Agent. With this conversation flow, you can schedule, reschedule, and cancel meetings in Microsoft Exchange Online.

How does the Manage Meeting EXO (Template) conversation flow work?

Natural Language Understanding (NLU) is used to identify and trigger the action that a user wants to perform. Integration is required with the Microsoft service via ServiceNow® IntegrationHub and ServiceNow® Flow Designer. Using the Microsoft Exchange Online spoke, the topic creates a conversation that calls these actions to complete an end-to-end fulfillment of the request. This prebuilt topic is read-only. Duplicate the topic to use the conversation flow. Email addresses for meeting attendees must be configured in the sys_user record to be added to meeting invites.
This topic uses the Microsoft Exchange Online spoke. Users with the Zoom spoke (com.sn.zoom.spoke) can also add a Zoom meeting link to the invite.

ℹ️ **Note:** If the Microsoft Exchange Online topics are duplicated in a different scope than ITSM Virtual Agent conversations, script logics can be affected and cause errors. This topic must be duplicated in the ITSM scope.

**Manage Meeting EXO (Template) conversation flow actions**
You can perform the following actions with the Microsoft Exchange Online meeting management conversation flow:

- Schedule a meeting
- Reschedule a meeting
- Cancel a meeting

For more information about these actions, see Manage Microsoft Exchange Online Meeting Actions.

**Meeting management actions for Microsoft Exchange Online**

ITSM Virtual Agent helps you manage meetings in Microsoft Exchange Online using conversation flows. With the Manage Meeting EXO (Template) conversation flow, you can schedule, reschedule, and cancel a meeting.

**Schedule a meeting**

Users can schedule a meeting in Microsoft Exchange Online using ITSM Virtual Agent. The user can send a message to Virtual Agent requesting to schedule a meeting or can select the desired template and click **Set up Meeting**. The user inputs the email addresses for all attendees, the meeting time, and the meeting duration.
Virtual Agent provides a list of available meeting times, based on the calendars of the invitees.
Next, the user inputs the meeting subject and description.

If the user has the Zoom spoke (com.sn.zoom.spoke), Virtual Agent offers to add a Zoom link to the meeting invite. If the user has the Microsoft Teams Communication spoke, the user can choose to add the Zoom link or a Microsoft Teams link, based on the default collaboration software configured by the admin. The script variable for this configuration is `default_collaboration_software`.

Virtual Agent returns the meeting link (if applicable) and the meeting details.
The user can confirm if Virtual Agent should schedule the meeting. Once the user confirms, Virtual Agent sends the email invites and schedules the meeting.

Here are the details of the meeting:

- **Subject:** Sprint demo
- **Starts:** 2021-08-04 3 PM
- **Ends:** 2021-08-04 4 PM
- **Invitees:**
  - Aditya@sncplatform.onmicrosoft.com
  - nidhi.garg@sncplatform.onmicrosoft.com
- **Body:** Demo this Sprint actions

Should I go ahead and schedule the meeting?
The user can also schedule a meeting through Virtual Agent using the Microsoft Teams service.
Now Virtual Agent 6:59 pm
Hi, I'm your Virtual Agent. Let me know how I can help you today.

Updated

Hi Abraham, please enter your request or make a selection of what I can help with. You can type help any time when you need help.
Here are available topics I can help with.

Select an option

7:00 pm
Setup a meeting

Now Virtual Agent 7:00 pm Updated

You'd like help with Manage meetings EXO (Template). Is that right?

7:00 pm
Yes

Now Virtual Agent 7:00 pm
I can help you to set up a Zoom meeting.
Now Virtual Agent 6:54 pm
I can help you to set up a Zoom meeting.

### Book a meeting

**Attendees**
- Aditya@sncplatform.onmicrosoft.com, testuser@sncplatform.on

**Date**
- 10 Sep 2021

**Time**
- 6:30 AM

**Duration**
- 30 mins

**Subject**
- Sprint Demo

**Body**
- Enter agenda of meeting

**Online meeting**
- Don't need one

*Required Field

[Check details and schedule]
**Reschedule a meeting**

Users can reschedule a meeting in Microsoft Exchange Online using ITSM Virtual Agent. The user can send a message to Virtual Agent requesting to reschedule a meeting or can select the desired template and click **Reschedule Meeting**.
The user enters the original meeting date and Virtual Agent returns a list of potential meetings to reschedule. The user selects the desired meeting.
The user enters a new meeting time and Virtual Agent confirms that the meeting has been rescheduled. The user can reschedule additional meetings if desired.
Cancel a meeting

Users can cancel a meeting in Microsoft Exchange Online using ITSM Virtual Agent. The user can send a message to Virtual Agent requesting to cancel a meeting or can select the desired template and click **Cancel Meeting**.

The user enters the start and end date and time of the original meeting.
Virtual Agent returns a list of potential meetings to cancel and the user selects the desired meeting or can choose to cancel all meetings during the specified duration.
Virtual Agent cancels all specified meetings and sends the user a confirmation email.
Manage Citrix sessions

Users with the Citrix IT Service Management Connector app can reset a Citrix desktop or app session directly from an ITSM Virtual Agent conversation.

How does the Citrix Reset Session conversation flow work?

Natural Language Understanding (NLU) is used to identify and trigger the Citrix session reset that a user wants to perform. The user can choose to reset all sessions at once or an individual session. Integration is required with the Citrix IT Service Management Connector (x_cion_citrix_it_s). For more information about this integration, see the Citrix IT Service Management Connector.

Learn how the Citrix ITSM plug-in for ServiceNow can help your team easily deliver a first class experience to your end users, provide a new level of end user...
self-service, and free up valuable time for your IT team to focus on higher impact work.

**Citrix session conversation flow actions**
You can perform the following action with the Citrix session conversation flow:

- Reset Citrix session

**Citrix session actions for ITSM Virtual Agent**
Users can reset any Citrix desktop or app session using Virtual Agent conversation flows.

**Reset Citrix session**
Virtual Agent provides a list of possible sessions to reset, and the user can choose to reset an individual session or all sessions at once.
If the user does not have any sessions available to reset, Virtual Agent can open an Incident on behalf of the user.
ITSM Virtual Agent Lite

Access a pre-built subset of ITSM Virtual Agent features to quickly and easily implement a virtual agent for your end users. ITSM Virtual Agent Lite offers an introductory collection of conversation topics for IT support.

Understanding ITSM Virtual Agent Lite

ITSM Virtual Agent Lite enables you to use a limited version of Virtual Agent. The available keyword-based conversations run in the web chat client and also in the messaging integrations for Slack, Microsoft Teams, Workplace by Facebook, and Facebook Messenger.
ITSM Virtual Agent Lite topic category and conversations

Topic conversations run in the web chat client and also in supported ITSM Virtual Agent messaging integrations. Get familiar with virtual agent technology to improve your ITSM self-service experience with a streamlined conversational interface.

The ITSM Virtual Agent Lite pre-built, read-only topic conversation templates are contained in the ITSM Self Service Lite Virtual Agent Designer category. The following conversation topic templates are ready for you to publish for use:

• Check Ticket Status
• Report an Issue

Set up ITSM Virtual Agent Lite

Activate and quickly begin using several read-only, pre-built conversation topics for your most common ITSM self-service cases. Promptly engage your users with a virtual agent to check ticket status, search the knowledge base, and report and issue.

Before you begin
Role required: admin or virtual_agent_admin

About this task
Virtual Agent Lite, a subset of the Virtual Agent platform, is available with activation of the Glide Virtual Agent Lite (com.glide.cs.chatbot.lite) plugin. You do not need a subscription for Virtual Agent Lite. For details, see Activate Virtual Agent Lite.

Users with the admin or virtual_agent_admin role can activate the required plugins:

• Glide Virtual Agent Lite (com.glide.cs.chatbot.lite): Activates the lite version of Virtual Agent platform features and other necessary plugins.
• ITSM Virtual Agent Conversation Topics Lite (com.snc.itsm.virtualagent.lite): Activates read-only conversations topics for basic ITSM self service.

Note: The Service Management Virtual Agent Core (com.glideapp.sm_va_core) plugin is required and is automatically activated with ITSM Virtual Agent Conversation Topics Lite.
Procedure

1. Activate the Glide Virtual Agent Lite (com.glide.cs.chatbot.lite) plugin.
2. Activate the ITSM Virtual Agent Conversation Topics Lite (com.snc.itsm.virtualagent.lite) plugin to access the pre-built ITSM Virtual Agent Lite conversation topics.
3. Review the ITSM Self Service Lite read-only conversation topics in Virtual Agent Designer.
   a. Navigate to Virtual Agent > Designer.
   b. In the Category drop-down box, select ITSM Self Service Lite.
4. To activate and publish a conversation topic, click Inactive in the topic tile. The conversation topic template opens for review.
5. Click the Active radio button to activate the topic.

   Note: To deactivate a topic, click the radio button.
6. Click Publish to publish the topic for use.

   Note: For complete details regarding activating and publishing conversation topics, refer to Virtual Agent Designer.
7. To test an active, published conversation topic, click the topic to test in Virtual Agent Designer and click Test. The Virtual Agent window opens and engages you to enter data, such as an IT issue or search for a knowledge base article.

ITSM Virtual Agent Lite conversation flows

ITSM Virtual Agent Lite includes several pre-built, read-only topic conversations to quickly and easily implement a virtual agent for your end users.

ITSM Virtual Agent Lite topic conversation flows

Check Ticket Status
Users can check the status of active IT tickets (incidents or requests). When a user asks about a ticket status, the virtual agent responds with a list of all active tickets for that user. Each ticket includes a link to the incident or request, the item, the status (Stage), and when it was updated.

Report an Issue
Users can create incidents using a record producer.
Walk-up Experience

With the ServiceNow® Walk-up Experience application you can create and manage an onsite IT walk-up venue where requests and issues are fulfilled and solved by experienced IT technicians in person and in real time. You can configure Walk-up Experience to serve all users in your organization by using an inclusive branding, such as Tech Lounge, Service Center, Genius Bar, and more.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Paris</td>
<td>• Activate Walk-up Experience</td>
<td>• Configure the Walk-up Experience portal</td>
</tr>
<tr>
<td>• Understanding Walk-up Experience</td>
<td></td>
<td>• Create or modify Walk-up Experience notifications</td>
</tr>
<tr>
<td>• Utilizing a Walk-up Contact Channel for IT and Beyond (includes Whitepaper: Walk-up Experience)</td>
<td></td>
<td>• Create or modify Walk-up Experience schedules</td>
</tr>
<tr>
<td>• Domain separation and the Walk-up Experience application</td>
<td></td>
<td>• Create or modify a Walk-up Experience stockroom</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create or modify Walk-up Experience locations</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create or modify a Walk-up Experience customer satisfaction survey</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• View assigned Walk-up Experience locations</td>
<td>• Developer training</td>
<td>• Ask or answer questions in the Walk-up Experience community</td>
</tr>
<tr>
<td>• Manage Walk-up Experience interactions manually</td>
<td>• Developer documentation</td>
<td>• Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td>• View Walk-up Experience location stockroom and assets</td>
<td>• Installed with Walk-up Experience</td>
<td>• Contact Customer Service and Support</td>
</tr>
<tr>
<td>• Walk-up Experience dashboard overview</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Understanding Walk-up Experience

Walk-up Experience enables your IT organization to set up a contact channel to support both online check-in and onsite check-in to a pre-established walk-up service center.
What is Walk-up Experience?

Walk-up Experience aims to delight users and significantly improve their satisfaction with IT, as well as increasing productivity of both the technicians and users via fast in-person support.

Employees and business guests can get real-time, in-person help with their IT issues and equipment requests. Walk-up service centers specialize in supporting technology devices — smart phones, tablets, and laptops — as well as hardware repairs and requests, technology refreshes, and software upgrades.

The main purpose of a walk-up service center is to support and resolve the more common, everyday routine IT service desk functions, such as a request for a new mouse or keyboard, unlocking an account, or help setting up software on a mobile device. Common branding names for your walk-up center include, “Tech Lounge,” “Service Center,” or “Genius Bar.”

Who uses Walk-up Experience?

Everyone from the company CEO to visiting business guests can check in and get IT support at an established walk-up service center. Walk-up Experience is for anyone who would prefer to meet face-to-face with an experienced IT technician in a welcoming and supportive environment.

**Requesters**

Users access the Walk-up Experience application in several ways.

- Online and via mobile device:
  - Quickly check in online to the nearest available walk-up venue via a pre-built check-in widget on the Service Portal using your laptop, tablet, or mobile phone.
  - View hours of operation, the estimated wait time, and your position in the queue at the check-in location via the Walk-up Status widget on the Service Portal. You can also access the online Walk-up Experience check in from this widget.

**Note:** Geolocation interfaces with the Walk-up Experience application to automatically route you to the nearest walk-up queue. You can always change the location, if desired.

Geolocation uses browsers or mobile device coordinates to determine location. If geolocation is blocked on the browser, Walk-up Experience defaults to Latitude/Longitude criteria in the user profile or mobile device.
Note: The Walk-up Status widget must be configured to appear on the Service Portal.

- View upcoming walk-up appointments and current queue position by location using the Now® Mobile application Services tab on your mobile device. Tech Lounge visits appears if there is associated data. If no data exists, the section is hidden.

Note: Requires activation of the ServiceNow Mobile Request Native Application Screens and Applet Launcher plugin (com.glide.mobile-mobile-employee). See Mobile plugins and upgrades for more information. This plugin enables the Service Catalog functionality by default.

- Schedule appointments for support and receive appointment reminders, as well as cancel or reschedule appointments from links in the reminder or from the online check-in interface.
- Schedule only one appointment per walk-up location queue at a time.

Note: Even with a scheduled appointment, you can still check into a walk-up location queue online or in person onsite.

- Schedule appointments on behalf of others who need IT support, such as executives or direct reports.

Note: Configuration is necessary to make this available to the Appointment delegation group of users, such as executive assistants. This is configured in the Walk-up Location Queue ([wu_location_queue) table.

- Receive notifications via email or your mobile device when your request is assigned to an IT support fulfiller, when you are close to next in line to be helped, and when your walk-up request has been closed or abandoned, should you decide not to attend the queue.

- View your Walk-up Experience appointments in your primary calendar with Microsoft Office 365 Outlook calendar integration. When you make an appointment, modify it, or cancel it, your calendar is sent invites to an appointment and any updates.

Note: This feature is only available when Microsoft Office 365 Outlook is the hosted calendar service.
• Add your online Walk-up Experience appointment to a calendar of your choice with iCalendar. Click a link in the portal to download an iCalendar file containing appointment details, including appointment location.

• Onsite at the Walk-up Experience location:
  ◦ Check into a queue at the physical walk-up location by manually entering either your name or email or by scanning an employee badge.

  Note: The badge scanning feature requires activation and configuration. Refer to Badge Reader Integration for Walk-up Experience.

  ◦ Observe queue activities on a large monitor that displays both walk-in requesters and those with appointments.
  ◦ View the monitor displaying how many people are currently in the queue, guest positions in the queue, who is being helped, and estimated wait times.
  ◦ Hear an audio sound emitted from the onsite walk-up location large monitor when a new person moves to the top of the queue for service.
  ◦ Answer an available single-question survey which captures your user sentiment after a visit.

• After-hours support — Get support even when a walk-up queue is closed. An IT support phone number is displayed on the check-in device, along with a link to create an incident in real time.

Fulfillers

The IT organization uses the Walk-up Experience application to meet the demand of urgent IT issues and requests.

• Walk-up Experience IT technicians manage daily operations at the walk-up queue locations. They resolve IT-related issues, support mobile devices and laptops, and fulfill requests for software and hardware consumables.

• Technicians can accept and close Walk-up Experience interactions through the Agent Workspace interface. Agent Workspace contains a personal inbox where walk-up interactions, if configured in Advanced Work Assignment, are automatically pushed for assignment.
• Agents can manage all aspects of Walk-up Experience fulfillment using Agent Workspace. Based on their capacity, and if records are on-hold, they can work on multiple transactions at the same time and promote interactions to incidents or requests, or access associated stockroom consumables.

• Technicians can view and accept scheduled appointments in their Agent Workspace personal inbox. Appointments are routed to the inbox according to agent availability. Alternatively, agents can pick and choose appointments manually.

• If necessary, technicians can work with anyone in the queue at any time. Technicians can manually assign themselves to a walk-up interaction, by accepting the interaction from a list of unassigned interactions in Agent Workspace.

• Agents can use the Agent Assist feature to expedite incident resolution.

Managers

IT managers supervise the walk-up location technicians and oversee daily operations.

• Walk-up managers can observe and capture operational and performance data by monitoring the walk-up dashboard.

• Walk-up managers can use the application to increase IT customer satisfaction, ensure and confirm stockroom inventory is available, provide customer service in a timely manner, and report performance data to upper management.

Administrators

Configure and maintain walk-up related systems, such as the walk-up location branding and text, queue locations and schedules, appointments, advanced work assignments, and notifications, CSAT surveys, and associated stockrooms.

Access the pre-built Walk-up online check-in Experience widget for use in your Service Portal. Make minor label changes directly in the widget without the need to customize through code.

Enable Walk-up Experience Microsoft Office 365 calendar integration. When users make an appointment, modify it, or cancel it, the Outlook calendar is sent invites to an appointment and any updates. For more information about this feature, refer to Walk-up Experience Microsoft Office 365 calendar integration.
How do you benefit from Walk-up Experience?

Your entire organization benefits by using the application in the following ways:

**Improves employee access to IT professionals**

Employees access IT services in real time by visiting a walk-up location. Employees can also schedule appointments to visit the walk-up location at a convenient future time. This saves time for everyone and results in greater productivity. IT technicians get direct access to user devices so that employees can return to work faster.

**Tracks interactions and performance**

IT managers use the Walk-up Experience dashboard to analyze and understand the work IT technicians are performing to support the company.

**Integrates with other services**

Technicians can manage Walk-up Experience interactions from the Agent Workspace interface.

Walk-up technicians can create traditional incidents when issues cannot be resolved at the walk-up location directly in Agent Workspace.

If a requested item is not available at an associated stockroom, walk-up technicians can create a request by ordering from the Service Catalog directly in Agent Workspace.

CSAT surveys are available at the walk-up queue and emailed to walk-up customers after an interaction is closed to capture customer-service sentiments.

**Devices necessary to deliver Walk-up Experience**

The Walk-up Experience application depends on several types of devices to deliver functionality. Users can check into an online walk-up queue using a desktop or laptop computer, tablet, or mobile phone. Onsite walk-up location users can check into the queue by scanning an employee badge or with a provided, typically stationary, tablet. The following guidance describes what devices are needed and function best for each Walk-up Experience feature:
• Online check-in and appointment scheduling: Desktop or laptop computer, tablet, or mobile phone.

• Onsite check-in: Tablet is recommended, but also works on desktop.

• Onsite queue: Large flatscreen TV. This feature is designed for larger display devices, such as a TV monitor. It is not supported on a tablet.

• Onsite CSAT survey: Tablet is recommended, but also works on desktop.

• Onsite badge reader: Badge scanning integration. For complete details, refer to Badge Reader Integration for Walk-up Experience.

Note: To optimize the experience for Apple iOS-based tablet devices, save the opened Check-in and CSAT survey tabs to the homepage of the device. When clicked from the homepage, they will open in full screen.

Domain separation and the Walk-up Experience application

This is an overview of domain separation as it pertains to the Walk-up Experience application and how it relates to Service Portal pages, interaction queues, and configurations. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.

• The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.
Overview

Domain separation in the Walk-up Experience application is supported at the Basic level. However, the application depends on the Service Portal, which is not supported for domain separation. Domain separation pertains to the Walk-up Experience application in the following ways:

• Walk-up location queues support domain separation in order to define which end users can access each location queue.

• The Interaction table supports standard domain separation for data security. Interaction tickets are opened for a specific domain.

• Walk-up location queues and interactions support domain separation. Therefore, fulfillers also work within a domain-separated environment when addressing interaction tickets associated with a location queue.

• Management and administration configurations reside in the walk-up location queue records. Therefore, those configurations are available to the respective domain managers and admins.

• While the Service Portal pages are not domain separated, the Walk-up Experience application’s portal pages retrieve data within the user’s specific domain. Therefore, those pages can be reused across different service portals designed and configured for separate domains. The admins must build each portal themselves.

• The Domain field is available on the wu_location_queue table. Setting domain here ensures users only see queues that are part of their domains during online check-in.

• For Advanced Work Assignment routing to operate, each wu_location_queue must include a work item routing condition which explicitly adds a reference to the domain the queue is part of.

  Note: The appointment booking feature is not domain separated. Since Appointment [itil_appointment] table data is not domain separated, list views could reveal data across domains.

How domain separation works in the Walk-up Experience application

For this application to be the most effective, walk-up administrators should configure walk-up locations accordingly. This is done by configuring the wu_location_queue record to meet user needs, which affects the Requestor experience. Each domain configured to the location queue record has its own set of rules. The same applies to other tables within the Walk-up application as well.
Note: Elements of the Service Portal platform such as settings, portals and widgets cannot be domain separated. However, the data within the widgets displays based on how the domain is configured. The recommended approach is to set up separate portals for each MSP customer.

Below are the elements of the Service Portal that are used as part of the walk-up experience:

- Portal (Walk-up)
- Pages (walkup_online_checkin, walkup_queue_on_site, walkup_home, walkup_survey, walkup_check_in)
- Theme (Walk-up theme)
- Widgets (Online check-in experience, walk-up queue on site, walk-up check-in, walk-up exit survey, walk-up home, walk-up schedule)

To learn more, see Domain separation and Service Portal.

For data separation, the Walk-up Experience application uses the domain of the walk-up user (Requestor/Walkup login user) to determine in which domain the Requestor data should be placed.

- Requestors can check in only in locations for which they have visibility.
- Requestors are able to select the Reasons that belong only to their own domain.
- Interaction records are created in the Requestor’s domain.

For the Fulfiller side, the application uses the domain of the walk-up user (walk-up technician/manager/admin) to determine which records are visible.

- By domain separation rules, Fulfillers can work only on interactions that are visible to them.
- Fulfillers are able to configure only walk-up location records that belong to their domain, are in the global domain, or have the parent-child hierarchy.
- The same visibility rules apply for the Many to Many [wu_m2m_location_queue_reason] table that controls the mapping between a location and Reason.
- The walk-up contexts records also have domain separation support, thereby ensuring technicians are able to view detailed Requestor information only for the records that are visible by domain separation rules.
Domain-separated tables
As part of the Walk-up Experience, records in the following tables can be domain separated.

- Walk-up location queues [wu_location_queue]
- Walk-up reasons for visit [wu_reason]
- Walk-up reasons [wu_m2m_location_queue_reason]
- Walk-up contexts [wu_context]
- Interactions [interaction]

Related information
- Domain separation for service providers

Walk-up Experience portal security and access
Security is built into the application to prevent end-user facing devices at the Walk-up Experience onsite portal from offering elevated role privileges to users. The Walk-up Experience onsite portal is accessed by an account containing only the sn_walkup.walkup_login role.

Understanding Walk-up Experience portal security
Activate the Explicit Role (com.glide.explicit_roles) plugin to assign users security roles, either snc_internal or snc_external. This plugin was introduced in the Now Platform Paris release. With the Quebec release, for new installations, Walk-up Experience added a dependency on this plugin to explicitly set the Walk-up Experience user as an external user.

When upgrading Walk-up Experience installations prior to Rome, the Walk-up Experience user is assigned snc_internal instead of snc_external. This is because the Explicit Role plugin assigns all users, including Walk-up Experience users, to snc_internal. Walk-up Experience cannot remove snc_internal during upgrade. For new installations of Walk-up Experience, this process works automatically.

Note: Refer to Explicit Role plugin for details about the plugin and Explicit Roles for more information about this upgrade process.

Access to Walk-up Experience
Technicians opening up the onsite Walk-up location for business, or joining the support team during operation hours, access the user record account with sn_walkup.walkup_login role to log into the Walk-up Experience portal. Internal and external users can access the onsite Walk-up Experience portal via
a check-in device, typically a tablet, to enter a queue. Internal, authenticated users can also access an online queue check-in via desktop or mobile device.

**Important information for upgrading Walk-up Experience to Rome**

The Explicit Role (com.glide.explicit_roles) plugin was introduced in the Now Platform Paris release. When installed, users are assigned security roles, either snc_internal or snc_external. With the Rome release, Walk-up Experience has added a dependency on this plugin to explicitly set the Walk-up Experience user as an external user.

When upgrading Walk-up Experience to Rome, the Walk-up Experience user is assigned snc_internal instead of snc_external. This is because the Explicit Role plugin assigns all users, including the Walk-up Experience user, to snc_internal. Walk-up Experience cannot remove snc_internal during upgrade. For new installs of Walk-up Experience, this process works without issue because the Explicit Role plugin installs first, assigns all users to snc_internal, then the Walk-up Experience user account is created with the snc_external role already assigned.

ℹ️ **Note:** Refer to Explicit Role plugin for complete details about the plugin and Now Platform explicit roles.

After upgrading to Rome, you need to remove the snc_internal role from the Walk-up Experience user account, or any users created to log into the Walk-up Experience kiosk. Then you’ll need to add the snc_external role to the users. This process is not necessary for upgrades after Rome.

ℹ️ **Note:** Refer to Explicit Roles for complete details about this process.

**Walk-up Experience administration**

Walk-up Experience users with the sn_walkup.walkup_admin role and administrators can activate and configure the application to meet specific requirements.

You can configure appointments, decide when to send notifications to users, establish and configure physical queue locations and operating schedules, integrate with CSAT surveys, and associate stockrooms with queue locations. You can also customize your Walk-up Experience portal with a unique logo and branding.

**Activate Walk-up Experience**

You can activate the Walk-up Experience plugin (com.snc.walkup) if you have the admin role. This plugin includes demo data.
Before you begin
Role required: admin

About this task
The Walk-up Experience application is for prebuilt tech lounges. The application enables your IT organization to set up a walk-up contact channel to support online and onsite queue check-in.

The Interaction Logging, Routing, and Queuing (com.glide.interaction) plugin will activate with Walk-up Experience plugin (com.snc.walkup). The following plugins must also be activated in order to use the Walk-up Experience application:

- Asset Management (com.snc.asset_management)
- Service Portal (com.glide.service-portal)

To activate Walk-up Experience Badge Reader Integration and for more information about this feature, refer to Badge Reader Integration for Walk-up Experience.

Activate the Explicit Role (com.glide.explicit_roles) plugin to assign users security roles, either snc_internal or snc_external. This plugin was introduced in the Now Platform Paris release. With the Rome release, for new installations, Walk-up Experience has added a dependency on this plugin to explicitly set the Walk-up Experience user as an external user.

When upgrading existing Walk-up Experience installations to Rome, the Walk-up Experience user is assigned snc_internal instead of snc_external. This is because the Explicit Role plugin assigns all users, including Walk-up Experience users, to snc_internal. Walk-up Experience cannot remove snc_internal during upgrade. For new installations of Walk-up Experience, this process works automatically.

After upgrading to Rome, you’ll need to remove the snc_internal role from the Walk-up Experience user account, or from any users with the sn_walkup.walkup_login role created to log into the Walk-up Experience kiosk. Then you’ll need to add the snc_external role to the users. This process won’t be necessary for upgrades after Rome.

⚠ Note: Refer to Explicit Role plugin for details about the plugin and Explicit Roles for more information about this upgrade process.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

⚠️ **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: *Application installation is unavailable because another operation is running: Plugin Activation for* `<plugin name>`.

### Related information

- **List of plugins (Rome)**

### Installed with Walk-up Experience

Several types of components are installed with activation of the Walk-up Experience plugin, including tables and user roles.

⚠️ **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

### Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-up login [sn_walkup.walkup_login]</td>
<td>Used to log into the onsite Walk-up Experience portal when needed. For example, at the beginning of the work day for a technician.</td>
<td>None</td>
</tr>
</tbody>
</table>
### Roles installed (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note: This role is assigned to a user record for purposes of logging into the check-in device, typically a tablet, at the onsite Walk-up Experience portal. It is not an actual human being with an assigned role, but an account used to log into the onsite portal devices. The user record can be assigned only this role in order to access the onsite Walk-up Experience portal. The user record account cannot contain any other associated roles. For security reasons, the Walk-up Experience portal cannot be accessed using the admin role.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Walk-up technician [sn_walkup.walkup_technician] | Works at the Walk-up Experience location to fulfill customer demands, such as IT-related issues and requests. | • itil  
• interaction_agent  
• workspace_agent  
• awa_agent  
• sn_apptmnt_booking.appointment_booking_user |
## Roles installed (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Walk-up manager [sn_walkup.walkup_manager] | Manages the technicians at the Walk-up Experience location. Access the Walk-up Experience Dashboard to oversee and monitor operations and performance. | • itil  
• sn_walkup.walkup_technician  
• sn_apptmnt_booking.appointment_booking_manager |
| Walk-up administrator [sn_walkup.walkup_admin] | Administers and configures Walk-up Experience modules. | • itil  
• sn_walkup.walkup_manager  
• inventory_admin  
• schedule_admin  
• sp_admin  
• sn_apptmnt_booking.appointment_booking_admin  
• awa_admin |

## Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-up Reason for Visit [wu_reason]</td>
<td>Record used to define various common reasons why a user needs walk-up support.</td>
</tr>
<tr>
<td>Walk-up context [wu_context]</td>
<td>Record used to configure an online check-in channel for users to join a walk-up queue before physically arriving at the walk-up location. Identifies a walk-up user and the description of the associated interaction.</td>
</tr>
<tr>
<td>Walk-up Location Queue [wu_location_queue]</td>
<td>Record used to configure a walk-up location. Extends the Queue [awa_queue] table.</td>
</tr>
</tbody>
</table>
### Tables installed (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-up Reason [wu_m2m_location_queue_reason]</td>
<td>Record used to set the order a particular visit reason should be prioritized at a walk-up location.</td>
</tr>
<tr>
<td>Walk-up Appointment [wu_appointment]</td>
<td>Record used to configure scheduled appointments. Extends the Task [task] table.</td>
</tr>
</tbody>
</table>

### Quick start tests for Walk-up Experience

Validate that Walk-up Experience still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Walk-up Experience quick start tests require activating the Walk-up Experience plugin (com.snc.walkup) and loading demo data.

### Walk-up Experience - Tests test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a location</td>
<td>Ensure users with the Walk-up administrator [sn_walkup.walkup_admin] role can access all existing walk-up queues, create new queue locations, and configure queues appropriately.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Onsite checkin (ITIL User)</td>
<td>Verify that users with the ITIL role can check into an onsite queue location.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Onsite checkin (ESS User)</td>
<td>Verify that users with the ESS role can check into an onsite queue location.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
Walk-up Experience - Tests test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Onsite checkin (Guest)</td>
<td>Verify that guest users can check into an onsite queue location.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

Related information

Quick start tests

Walk-up Experience configuration

Customize your Walk-up Experience portal and configure appointments, notifications, walk-up venue locations, associated stockrooms, customer satisfaction surveys, and hours of operation to meet your required needs.

Walk-up Experience includes associated notifications to alert users when the location is closed or when an interaction is assigned to a technician. Pre-built customer satisfaction surveys capture user sentiment about the experience. Also included are several configurable tables for customizing your walk-up portal and service center experience. You can configure and specify the following features for your experience:

- Configure an online check-in channel for users to join a walk-up queue before physically arriving at the walk-up location.
- Access the pre-built Walk-up online check-in Experience widget for use in your Service Portal. Make minor label changes directly in the widget without the need to customize through code.
- Configure the physical walk-up location queue information to manage and administer the walk-up service center.
- Establish walk-up locations, set hours of operation, enable online check-in, determine assignment groups, associate stockrooms, as well as design the queue time display and position notification system.
- Configure reasons for visits to a walk-up queue by location.
- Add a logo and brand your portal and walk-up location to fit your style.
- Access location-specific branding elements, such as logo images, for walk-up queues. These configuration options are found in the Walk-up Location Queue [wu_location_queue] table.

The following applications are included in the Administration module of the Walk-up Experience navigation bar:
### Walk-up Experience administration applications

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portal Configurations</td>
<td>Create and modify custom Walk-up Experience online and on-site service portals.</td>
</tr>
<tr>
<td>Notifications</td>
<td>Access and configure alerts that keep users and fulfillers informed of events that concern them.</td>
</tr>
<tr>
<td>Appointment Configurations</td>
<td>Create service configurations for individual walk-up queue locations. You can configure schedules, number of appointments allowed per day, how far in the future users can book appointments, and more.</td>
</tr>
<tr>
<td>Walk-up Locations</td>
<td>Create walk-up location queues with custom schedules, assignment groups, average wait time, and more.</td>
</tr>
<tr>
<td>Schedules</td>
<td>View, create, or modify walk-up venue schedules, such as 8-5 weekdays, and associate them to the walk-up location queues.</td>
</tr>
<tr>
<td>Walk-up Stockrooms</td>
<td>Establish walk-up venue stockrooms by location and specify available consumables.</td>
</tr>
<tr>
<td>Surveys</td>
<td>Access customer satisfaction surveys and enable public access to the surveys, set survey trigger conditions, and view user responses.</td>
</tr>
</tbody>
</table>

### Configure the Walk-up Experience portal

Create engaging walk-up center service portals featuring your logo, portal theme, desired catalog, links to a knowledge base and social community, and more.

### Before you begin

Walk-up Experience includes a complete base-system Walk-up Portal with theme. The Walk-up Portal pages are meant to be used as built. You can create custom portal pages to meet your needs by copying the portal pages and associated widgets and making changes to the copies. You can configure both an online check-in portal and a physical check-in portal for your walk-up locations.

There are several ways to configure the Walk-up service portal:
• **Service Portal** application: Modular user interface framework for quick and easy building and customization of application portals.

• Service Portal Walk-up form: Requires CSS and HTML experience.

Role required: admin or sn_walkup.walkup_admin

**Procedure**

1. To configure the Walk-up service portal using the **Service Portal** application, navigate to **Service Portal > Service Portal Configuration**. The Service Portal configuration page opens.

2. To customize the base-system walk-up portal with your unique branding, title, logo, theme colors, layout, properties, widgets, and more, or to create a new walk-up portal, refer to **Service Portal** for detailed information.

3. Alternatively, to configure the Walk-up service portal using the Service Portal Walk-up form, navigate to **Walk-up Experience > Administration > Portal Configurations**. The Service Portals list opens.

4. In the Service Portals list, click **Walk-up** or search for it in the list header search box.

5. Click the form menu icon and select **Configure > Form Design**. The form designer opens.

6. In the form designer header drop-down list select or search for any of the configurable walk-up forms to customize your portal appearance.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-up context [wu_context]</td>
<td>Configure an online check-in channel for users to join a walk-up queue before physically arriving at the walk-up location. Identifies a walk-up user and the description of the associated interaction.</td>
</tr>
<tr>
<td>Walk-up Location Queue [wu_location_queue]</td>
<td>Configure the physical walk-up location interaction queue to manage and administer the service center. You can establish walk-up locations, set hours of operation, enable online check-in, determine assignment groups, associate stockrooms, as well</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Walk-up Reason [wu_m2m_location_queue_reason]</td>
<td>Define various common reasons why a user needs walk-up support.</td>
</tr>
<tr>
<td>Walk-up Reason for Visit [wu_reason]</td>
<td>Specify the order in which reasons for a visit should be prioritized at a walk-up location.</td>
</tr>
</tbody>
</table>

The associated form opens. To modify form content to meet your portal requirements, refer to Form configuration for detailed information.

**Enable Self-Service online check-in for Walk-up Experience**

Show or hide the Walk-up Experience online Walk-up Check-in module under Self-Service in the application navigator. You can enable or disable the module using the basic platform menu or module enablement process.

**Before you begin**
Role required: admin or sn_walkup.walkup_admin

**About this task**
The Walk-up Experience online Walk-up Check-in module is disabled (hidden) by default and does not appear under the Self-Service menu until enabled.

**Procedure**
1. Navigate to System Definition > Application Menus.
2. Click All in the conditions breadcrumbs to display both active and inactive application menus. This action removes the default filter condition.
3. Search by Title for the Self-Service application menu.
   Search yields the itil_self_service and mobile_self_service menu applications. You can enable (show) the Walk-up Check-in module for each menu application.
4. Click the Self-Service menu application with the Name: itil_self_service. The application menu Self-Service record opens and the Modules related list shows the modules that appear in the application navigator.
5. Search by Title for the Walk-up Check-in module.
6. Click Walk-up Check-in.
   The Walk-up Check-in module record opens.
7. In the Visibility tab, click Active to enable the Walk-up Check-in module. Active is true for the module. Alternatively, you can enable the module from the Applications Menus Self-Service Modules related list:
   a. Double-click the Active field beside the Walk-up Check-in module name in the Modules related list.
   b. Set Active to true (show) or false (hide).

8. Click Update.
   When you change application menus or modules, the application navigator automatically refreshes to display the changes.

9. To enable the Walk-up Check-in module to display under Self-Service on the mobile application, click Walk-up Check-in in the Mobile Modules related list.

10. Click the Active field to enable the module for mobile devices.

11. Click Update.

Configure Walk-up Experience online check-in icon to appear on Service Portal
Users can check in to a walk-up location online via the Service Portal. You can edit the Service Portal Home page to replace the general IT Get Help support icon link with the Walk-up Experience online check-in support icon link.

Before you begin
Service Portal for Enterprise Service Management (com.glide.service-portal.esm) must be activated.
Role required: admin and sp_admin

About this task
To replace the Get Help icon link with the Walk-up Check-in icon link on the Service Portal Home page, access Service Portal Designer. Alternatively, you can add a new container to the Service Portal for the Walk-up Check-in icon link, so that the Get Help icon link remains.
Procedure

1. Navigate to **Service Portal > Service Portal Configuration**.

2. Click the **Designer** tile on the configuration page. The Service Portal Designer opens.

3. Select the **Service Portal** index page to edit.

4. Ensure you are in edit mode by verifying that **Edit** is highlighted as active in the Service Portal Designer banner.

   In edit mode, you can add a new container for the Walk-up Check-in icon link or edit an existing container, depending on where you want to place the icon link.

5. To edit an existing container, select the **Get Help** icon link container.

6. Click the edit icon in the upper right corner.

   The **Get Help** icon link container form opens for editing.

7. Edit the form fields with the following data and presentation details:

<table>
<thead>
<tr>
<th>Fields</th>
<th>Configuration input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Select <strong>Page</strong> to embed the walkup_online_checkin page with widget on the icon link.</td>
</tr>
<tr>
<td>Page</td>
<td>Select <strong>walkup_online_checkin</strong>.</td>
</tr>
<tr>
<td>Presentation</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
### Fields | Configuration input
---|---
**Title** | Enter Walk-up Check-in.
**Short description** | Enter details about the icon link, that you want displayed, such as Check in to an IT walk-up location to make a request or report a problem.
**Bootstrap color** | Select Default.
**Bootstrap class name** | Enter a class name or leave this field empty.
**Glyph** | Select a glyph or you can select the empty glyph to bypass this field.
**Template** | Select Circle Icon.

8. Click **Save**.
   The Service Portal Home page opens in edit mode. The online Walk-up Check-in icon link with your selected glyph image and description displays in place of the former **Get Help** icon link.

![Service Portal Home page with Walk-up Check-in icon link](image)

9. Navigate to **Service Portal > Service Portal Home** to verify and test the newly created Walk-up Check-in icon link.

10. To add the Walk-up Check-in icon link to a new container, refer to **Create and edit a page using the Service Portal Designer**.

11. Edit the container form fields with the same data and presentation information as detailed above in the form configuration input descriptions and follow the remaining relevant steps.
Configure Walk-up Experience service channel
Configure the Walk-up Experience service channel to meet the needs of your walk-up agents and how they are assigned to and manage interactions in Agent Workspace.

Before you begin
Role required: admin or sn_walkup.walkup_admin

About this task
The Walk-up Experience service channel is viewed and configured through Advanced Work Assignment. You can modify default values and conditions as desired.

Procedure
1. Navigate to Advanced Work Assignment > Service Channels. The Service Channels list displays.
2. Select Walk-up to open the Walk-up Experience service channel.
3. Refer to Configure a service channel for detailed information regarding the Service Channel Walk-up form values and conditions. For more information regarding Advanced Work Assignment service channels, including configuring capacity and utilization, inbox layout, and overriding agent capacity for selected agents, refer to Service channels.

Create or modify Walk-up Experience notifications
Create and use Walk-up Experience notifications to keep requesters informed of queue events that concern them. The system can notify users by email, SMS text message, or push notification to a mobile device.

Before you begin
Role required: admin or sn_walkup.walkup_admin

About this task
Walk-up Experience includes several base-system notifications that you can use or customize to notify walk-up visitors about specific information and interactions, including:

<table>
<thead>
<tr>
<th>Walk-up Experience notifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification</td>
</tr>
<tr>
<td>Walk-up Abandoned</td>
</tr>
</tbody>
</table>
Walk-up Experience notifications

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-up Threshold</td>
<td>Notifies visitors when they are close to being next in line for support.</td>
</tr>
<tr>
<td>Notification</td>
<td></td>
</tr>
<tr>
<td>Walk-up Assigned</td>
<td>Notifies when an interaction is assigned to a technician.</td>
</tr>
<tr>
<td>Walk-up Closed</td>
<td>Notifies when a walk-up location is closed.</td>
</tr>
</tbody>
</table>

Notifications are

**Procedure**

1. To view Walk-up Experience notifications, navigate to **Walk-up Experience > Administration > Notifications**.
2. Click an available walk-up notification to view basic properties, as well as information about when to send it, who will receive it, and what the notification will contain. The walk-up notification form appears.
3. To modify a walk-up notification, edit any of the form fields.
4. To create a new walk-up email or push notification, click **New** and refer to Create an email notification or Create a push message. For complete information regarding using the System Notification application, refer to **Notifications**.

**Create or modify Walk-up Experience schedules**

Once you know the hours of operation for your Walk-up Experience location, you can either access the base-system default schedules or create new schedules to associate with your walk-up location.

**Before you begin**

Role required: admin or sn_walkup.walkup_admin

**Procedure**

1. To view and use a base-system default schedule in the Walk-up Experience application, navigate to **Walk-up Experience > Administration > Schedules**. The Schedules list opens. You can view all available base-system default schedules, such as **8-5 weekdays excluding holidays**.
2. To modify an existing base-system schedule, click the schedule name, otherwise click New to create a schedule if none of the default schedules apply for your walk-up location.

3. Complete the Schedule New record form or modify fields on an existing form. To complete this process and for detailed information on creating, modifying, and using schedules in the system, including a definition of all form fields, refer to Schedules.

**Walk-up Experience appointment booking**

With the Walk-up Experience appointment booking feature, walk-up users can view available appointment windows, make a selection, and book an appointment for a walk-up location using online Walk-up Check-in feature. Walk-up agents can also book appointments on behalf of customers.

Create time windows for walk-up queue locations enabling requesters to book service appointments.

The Appointment Booking plugin (com.snc.appointment_booking) must be activated to use the application. Appointment booking adds the Appointment Booking menu to the application navigator and the following modules:

- **Appointment Booking Configuration**: Use this module to create an appointment booking configuration for an application and then configurations for each service within that application.

- **Appointment Bookings**: Use this module to view a list of appointments that have been booked for services. This list includes the work orders associated with each appointment.

Appointment booking requires configuration at both the application level, in this case, Walk-up Experience, and at the walk-up queue service level, represented by the actual location of the walk-up queue.

The Walk-up Experience application configuration contains settings that apply to all of the service locations within the application that support appointment booking.

A service configuration is required for each of the walk-up queue locations within the application that offer scheduled appointments. A service configuration includes settings that apply only to that specific walk-up queue service location.

**Note:** Both the application configuration and the service configuration must be active to book appointments.
For detailed information about the **Appointment Booking** application, refer to Appointment booking.

**Walk-up Experience appointment booking administration**

Create or modify and enable the Walk-up Experience application configuration and the individual service location configurations for the **Appointment Booking** feature.

Administrators can create, modify, and enable the Walk-up Experience application configuration. Appointment booking administrators (appointment_booking_admin) can create, modify, and enable configurations for service locations within the Walk-up Experience application.

**Walk-up Experience** is an application level configuration provided with the base system appointment booking feature. You can include as many service level configurations as needed. The service level configurations apply to the individual walk-up queue locations that exist. Administrators can modify these configurations as needed or use them as examples to create new configurations.

For more information on appointment booking administration, see **Administer appointment booking**

**Enable Walk-up Experience appointment booking**

Enable or disable the appointment booking feature for Walk-up Experience as well as for the individual walk-up service locations available to customers.

**Before you begin**

Role required: admin or sn_walkup.walkup_admin

**About this task**

The Appointment Booking plugin (com.snc.appointment_booking) must be activated to use the application.

When appointment booking is enabled, the **Schedule an appointment** tab appears on the online check-in page. Users choose a reason for the appointment and select a date a time from current available appointments.

**Procedure**

1. Navigate to **Appointment Booking > Appointment Booking Configuration**.
2. Click **Walk-up Experience**.
   - The **Walk-up Experience** configuration is provided with the base system **Appointment Booking** feature.
3. Click **Active** to enable appointment booking for the Walk-up Experience application. Alternatively, if the feature is active you can deactivate it by clicking **Active**.

4. In the Appointment Booking Service Configuration related list, click the name of a service.
   For Walk-up Experience, a service is defined by the physical location of a walk-up queue. Every walk-up queue associated with your application is a service that needs to be configured for appointment booking. The Appointment Booking Service Configuration form for the selected service opens.

5. Click **Active** to set the field to true.

6. Click **Update**.

---

**Walk-up Experience appointment booking configuration**

Create or modify appointment booking configurations for the Walk-up Experience. You can view or modify the Walk-up Experience application appointment booking configuration and create or modify related service appointment configurations.

The base system Walk-up Experience application includes a default appointment booking configuration that can be modified. By default, the information stored in the Walk-up Experience application appointment booking configuration applies to all services within that application. Services within the Walk-up Experience application are defined as the actual walk-up queue locations. You can create new appointment booking service configurations for the Walk-up Experience application or modify existing configurations.

For example, you may want to configure one walk-up queue to accept appointment booking every day from Monday to Friday, but for another queue, you only want appointment booking available on Monday, Wednesday, and Friday. By configuring appointment booking at the service level, you can achieve this goal.

Specific Walk-up Experience set-up criteria for appointment booking include the following configurations:

- Define different appointment schedules and time windows per queue location.
- Define the time window in which you want to support appointments. For example, 15 minutes now_V. 30 minutes.
- Define the time window capacity. For example, the maximum number of appointments per time window.
View or modify a Walk-up Experience appointment booking configuration

View the base system default appointment booking application configuration to determine if the criteria meets your walk-up appointment booking needs. You can modify the application configuration to uniquely manage appointment booking for your experience. The information stored in the Walk-up Experience appointment booking application configuration applies to all the services within the application.

Before you begin
Role required: admin or sn_walkup.walkup_admin

About this task
The Walk-up Experience configuration is provided with the Appointment Booking feature.

Procedure
1. Navigate to Appointment Booking > Appointment Booking Configuration.
2. To view the Walk-up Experience configuration, click the configuration name.
3. In the Appointment Booking Configuration form, view or modify the following fields as needed.

Appointment booking application configuration fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the application configuration.</td>
</tr>
<tr>
<td>Task Table</td>
<td>Table where appointments are created for the tasks. The Walk-up Appointment [wu_appointment] table is the default table for the Walk-up Experience configuration.</td>
</tr>
<tr>
<td>Availability Method</td>
<td>Option to determine the appointment availability.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Number of appointments per slot</strong>: Define a specific number of appointments per time slot. Use this availability method if the task assignment method is set to manually. This is the default setting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Scripted</strong>: Use this configuration setting to determine availability if the task assignment method is set to using auto assignment or dynamic scheduling.</td>
</tr>
<tr>
<td>Advanced Calendar</td>
<td>Displays an advanced view of the calendar for booking an appointment.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>view for Portal</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Activates the application configuration and enables appointment booking.</td>
</tr>
<tr>
<td>Auto acceptance</td>
<td>If the application configuration setting for Process lifecycle is set to task-driven, an agent must accept or reject an assigned task. Enable the Auto acceptance check box to override this configuration setting for appointment booking.</td>
</tr>
<tr>
<td>Portal View</td>
<td>Displays available appointments for a single day or for a week on the online Self Service Walk-up Check-in portal or from the Service Portal if the walk-up icon is configured there.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Create a record producer to capture Walk-up Experience appointment records

Capture Walk-up Experience appointment records by creating unique record producers for your individual walk-up locations. The Appointment Booking Service Configuration form contains required fields that refer to variables in the associated record producer.

Before you begin
Role required: appointment_booking_admin or admin

About this task
In order to properly configure your walk-up location services for appointment booking, you must first create a unique record producer for each walk-up location. You must also add variable sets to the record producer. By creating the unique record producer with appropriate variable sets, you can capture all your walk-up appointment records for each location.

Procedure
1. Navigate to Service Catalog > Record Producers.
2. Click New to open the Record Producer New Record form.
3. Provide a unique name for the record producer in the Name field.
4. Search for and select Walk-up Appointment [wu_appointment] in the Table name field.
5. Provide a short description for added detail.
6. Click **Submit**.

7. Return to the Record Producers list and search for your newly created record producer.

8. Click to open your newly created record producer.

9. Scroll down the form and click to open the Variable Sets tab.

10. Click **Edit** to add the appropriate variable sets to the record producer.

11. Select and add the following variable sets to the record producer using the add button: `sn_appointment_variable_set` and `sn_walkup_variable_set`.

12. Click **Save**.

---

**Create or modify a Walk-up Experience appointment booking service configuration**

Create or modify appointment booking configurations for Walk-up Experience services. A service is defined as the actual physical location of a walk-up queue. The information stored in the Walk-up Experience application configuration applies to all services, or queue locations, within the application.

**Before you begin**

Role required: appointment_booking_admin or admin

**About this task**

To use the appointment booking feature, administrators must create a configuration for each service, or queue location, that is available to walk-up customers. Service configurations are created within the Walk-up Experience application configuration, as part of the Appointment Booking application.

**Procedure**

1. Navigate to **Appointment Booking > Appointment Booking Configuration**.

2. Click **Walk-up Experience**.

3. Create or modify Appointment Booking Configuration.
   
   • To create configuration for appointment booking, click **New**.
   
   • To modify an existing configuration, select the configuration from the list.

4. On the form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option to activate appointment booking for the service.</td>
</tr>
<tr>
<td></td>
<td>Note: If deactivated, customers cannot schedule appointments for the service but can still create work orders.</td>
</tr>
<tr>
<td>Enable day level configuration</td>
<td>Option to configure the schedule at a day level. For more information, see Configure day-level appointment booking.</td>
</tr>
</tbody>
</table>

**General Information**

| Name                          | Name of the service configuration.                                           |
| Configuration                 | Name of the appointment booking configuration to which this service belongs. |
| Availability table            | Table used to calculate appointment availability. For Walk-up Experience, choose Walk-up Appointment [wu_appointment]. |
| Holiday Schedule              | Holiday schedule to use when determining availability. Appointment booking evaluates the holiday schedule when determining the number of available appointments and excludes any day in the schedule that is set to Exclude. Click the lookup icon and select a schedule from the Schedules list. |
|                               | Note: Holiday schedules are useful when the assignment method for tasks is set to manually, which does not consider agent schedules. |

**Catalog Information**

| Catalog item                  | The service in the service catalog for which this appointment booking configuration is being created. Click the lookup icon and select the associated service from the Record Producers list. You must create a record producer for each walk-up service location. Refer to Create a record producer to capture Walk-up Experience appointment records. |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> The catalog item must exist in the service catalog.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> If you are using appointment booking with work orders, create a work order template before you configure appointment booking.</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>The field on the record provider that determines the appointment location.</td>
</tr>
<tr>
<td><strong>Note:</strong> Ensure the Location field on both this form and the Walk-up Location Queue (wu_location_queue) form are configured in alignment. contains the location reference variable, which is a Location (cmn_location) record. Selecting Location from the search list icon ensures you are aligning with the same time zone as the walk-up location you are configuring for. When you select Location, the online appointment scheduling calendar displays in the user timezone. If this field is left empty or if the user preference for the instance is not configured to have an associated time zone, the appointment scheduling calendar defaults to display in the user timezone. If a user in Europe has User preferences for Time zone configured for Europe/Brussels and the Appointment Booking Configuration for the Location field is set to a cmn_location with the time zone US/Pacific , then the appointment scheduling calendar will display in the US/Pacific time zone. When a user creates an appointment, the system defaults to use the schedule associated with the Walk-up Location Queue (wu_location_queue), regardless of the Location field value of this record producer.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| • If selected, the Appointment field appears on the record producer and the user selects an available appointment before submitting the service request.  
• If not selected, the user can submit the service request without selecting an appointment. |
| User contact          | The field on the record producer that determines who the appointment is being created for. Set this field to Contact. This is a reference field that looks for a sys_user variable on the record producer.                                                                                                                                                                                                                                                                                                                                                                           |
| Booking               |                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                             |
| Appointments per window | Number of available appointments for each configured appointment time slot. This number determines the number of available appointments that are displayed on the Select Appointment window. Enter a number in this field if the assignment method for tasks is set to manually. If set to either using auto-assignment or using dynamic scheduling, this setting does not apply, unless a location is not provided. Then the configuration defaults to the number of appointments per window. |
| Lead time             | Number of hours or days from the current time after which an appointment can be booked for this service. Define the lead time in hours or days. The default is 4 hours.                                                                                                                                                                                                                                                                                                                                                                                   |
| Future bookable max days | Number of days in advance of the current day for which an appointment can be booked for this service. The default is 14 days.                                                                                                                                                                                                                                                                                                                                                                               |
| Reschedule / Cancel by time | Number of hours or days prior to an appointment start time that are required for an appointment to be canceled or rescheduled. If a user attempts to cancel or reschedule an appointment within this number of hours, the Cancel button is not available. Define the time in hours or days. The default is 4 hours.                                                                                                                                                                                                                                                                 |
| Appointments          |                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                             |
| Appointment window    | Duration of the appointment window.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                             |

**Note:** Allow enough time for the work to be started and completed within this window.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work duration</td>
<td>Time required to complete all tasks created by the record producer. This duration is set for a task when it is created. Used to determine availability. The default is 1 hour.</td>
</tr>
<tr>
<td>Travel duration (round trip)</td>
<td>Estimated value of the average travel time required (round trip) for the agent performing the task. Set the value to 0 since the work is performed onsite and travel time is not needed.</td>
</tr>
</tbody>
</table>

**Daily Schedule**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookable days</td>
<td>Days of the week for which appointments can be booked. The default is Monday through Friday. Bookable days should reflect the appointment schedule.</td>
</tr>
<tr>
<td>Note:</td>
<td>Appointment schedules are separate from the walk-up queue location schedule but should be the same days and hours as the walk-up queue location schedule.</td>
</tr>
<tr>
<td>Daily start time</td>
<td>Start of the work day and the earliest start time for an appointment window. The default is 9:00.</td>
</tr>
<tr>
<td>Daily end time</td>
<td>End of the work day and the latest end time for an appointment window. The default is 18:00 PM.</td>
</tr>
<tr>
<td>Include daily break</td>
<td>Option to schedule a break for each bookable day, then select the break start and end times. You can define one break which applies to all days.</td>
</tr>
<tr>
<td>Appointment booking preview</td>
<td>Option to provide a preview of the appointment windows and times based on the selected start and end times, break time, and appointment window.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Configure day-level appointment booking**

Create or modify different schedules at a day level when booking appointments for a service. The appointments can be scheduled for different slots such as morning, afternoon, and evening.

**Before you begin**

Role required: admin
Procedure

1. Navigate to **Appointment Booking > Appointment Booking Configuration**.
2. Click **Walk-up Experience**.
3. In the Appointment Booking Service Configuration related list, click a service configuration for which you want to configure the appointment schedules.
4. Select **Enable day level configuration**.
5. In the Appointment Booking Day Configuration related list, click **New**.
6. On the form, fill in the fields.

### Appointment Booking Day Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the day level configuration, such as Morning, Afternoon, or Evening</td>
</tr>
<tr>
<td>Active</td>
<td>Option to indicate if the appointment slot is active or not.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date of the appointment booking window</td>
</tr>
<tr>
<td>End date</td>
<td>End date of the appointment booking window</td>
</tr>
<tr>
<td>Daily start time</td>
<td>Start of the work day and the earliest start time for an appointment window. The default is 9:00.</td>
</tr>
<tr>
<td>Daily end time</td>
<td>End of the work day and the latest end time for an appointment window. The default is 18:00 PM.</td>
</tr>
<tr>
<td>Service configuration</td>
<td>Name of the service configuration for which you are scheduling configurations at a day level, such as Point-of-Sale Installation.</td>
</tr>
<tr>
<td>Work duration</td>
<td>Time required to complete all tasks created by the record producer. This duration is set for a task when it is created. Used to determine availability. The default is 1 hour.</td>
</tr>
<tr>
<td>Travel duration</td>
<td>Estimated value of the average travel time required (round trip) for the agent performing the task. Used to determine availability. The default is 15 minutes.</td>
</tr>
<tr>
<td>Appointment window</td>
<td>Duration of the appointment window.</td>
</tr>
<tr>
<td>Appointments per window</td>
<td>Number of available appointments for each configured appointment time slot. This number determines the number</td>
</tr>
</tbody>
</table>

*Note: Allow enough time for the work to be started and completed within this window.*
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>of available appointments that are displayed on the Select Appointment window. Enter a number in this field if the assignment method for tasks is set to <strong>manually</strong>. If set to either using auto-assignment or using dynamic scheduling, this setting does not apply, unless a location is not provided. Then the configuration defaults to the number of appointments per window.</td>
</tr>
<tr>
<td>Include daily break</td>
<td>Option to schedule a break for each bookable day. Set the break start and end times. You can also define one break which applies to all days.</td>
</tr>
<tr>
<td>Appointment booking preview</td>
<td>Provides a preview of the appointment windows and times based on the selected start and end times, break time, and appointment window.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

**Configure daily schedules for Walk-up Experience service appointment booking**

Specify different daily hours of operation for your Walk-up Experience location appointment booking.

**Before you begin**

Role required: appointment_booking_admin or admin

**About this task**

Create a unique appointment booking schedule for each day of the week or for specific days of the week. For example, you can set the appointment booking availability schedule to run all day, from 9:00am to 5:00pm, Monday, Wednesday, and Friday. The Tuesday and Thursday appointment availability schedule can run from 9:00am to 12:00pm. You can completely remove appointment booking for a specific day of the week, for example, Friday.

**Note:** To specify unique daily booking schedules, while using your associated appointment booking configuration, create new Schedule Entries to exclude the hours appointment booking is not available.

**Procedure**

1. To configure, for example, the Tuesday and Thursday appointment availability schedule from 9:00am to 12:00pm, navigate to **Walk-up Experience > Schedules**.

2. Select the schedule you use, for example, the **8-5 weekdays excluding holidays** schedule.
3. In the Schedule Entries related list, click **New**. The Schedule Entry New record form appears.

4. Name the new record **Excludes** and fill in the form to create a unique daily booking schedule for Tuesday and Thursday appointments.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name the record. For example, name the record <strong>Excludes</strong> to indicate the hours excluded from appointment booking.</td>
</tr>
<tr>
<td>Type</td>
<td>Choose <strong>Excluded</strong> as the type.</td>
</tr>
<tr>
<td>Show as</td>
<td>Choose <strong>Busy</strong> as the reason for the exclusion.</td>
</tr>
<tr>
<td>When</td>
<td>Indicate the date to begin using this booking availability schedule. Also indicate the time to exclude booking availability for this date. For example, the hours of 12:00pm through 5:00pm.</td>
</tr>
<tr>
<td>Repeats</td>
<td>Indicate the recurrence for this availability schedule. For example, <strong>Weekly on Tue and Thu</strong>.</td>
</tr>
<tr>
<td>Repeat until</td>
<td>Specify how long you want this availability schedule to run by selecting an end date.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

6. To verify that Tuesday and Thursday appointment booking is only available from 9:00am to 12:00am, navigate to your online Walk-up Check-in application. If configured for view, You can access the online Walk-up Check-in application from the **Service Portal Home** page or under **Self-Service** in the left navigation bar.

7. Select the walk-up location for which you are verifying the schedule.

8. Click **Schedule an appointment** and select a reason for the visit.
9. Select a date for the appointment. The Select Appointment window displays the first available appointment, by week and day.

10. Determine that appointments are only available on Tuesdays and Thursdays from 9:00am to 12:00pm.

Configure excluded hours for Walk-up Experience appointment booking

Using the Appointment Booking application, you can specify excluded appointment hours in the schedule for your Walk-up Experience location.

Before you begin
Role required: appointment_booking_admin or admin

About this task
Configure your Walk-up Experience location to exclude certain hours of operation from users scheduling appointments. For example, you can set the appointment booking availability schedule to run from 8:00 a.m. to 5:00 p.m., Monday through Thursday. On Friday, you can schedule the appointment booking availability from 8:00 a.m. to 2:00 p.m. You can also completely remove appointment booking for a specific day of the week, for example, Mondays or Friday.

Reconfigure the Holiday Schedule field on the Appointment Booking Service Configuration form for your walk-up location to use a custom Off hours schedule instead of the default holidays schedule.

Procedure
1. To create a schedule to exclude your unavailable appointment booking hours, navigate to Walk-up Experience > Administration > Schedules.

2. Click New.
3. Provide a name for your schedule, for example, Off hours schedule.
4. Add a description, if desired.
5. Click Submit.
6. In the Schedules list, search by Name for the new Off hours schedule record.
7. Click Off hours schedule to open the record.
   Use the Schedule Entries related list to create two separate excluded hours schedule entries, one for Friday off hours and one for Weekday off hours.
8. Click New in the Schedule Entries related list to create Friday off hours. You will configure Fridays to exclude all appointments after 1:00 p.m.
9. Click Update to save your changes.
10. Add the **U.S. Holidays** default off-hour schedule as a child schedule to the **Off hours schedule**.

   **a.** Click the Child Schedules related list.

   **b.** Click **Edit** and use the slush bucket to move the **U.S. Holidays** schedule into the Child Schedules List for the **Off hours schedule**. Adding the **U.S. Holidays** schedule as a child ensures that all holidays are excluded from appointment booking and overrides the **Off hours schedule** configurations for holidays.

   **Note:** The **U.S. Holidays** schedule is the default off-hours schedule for the United States. Default off-hours schedules will differ depending on your location.

   **c.** Click **Save**.

11. Click **Update** to save the **Off hours schedule** record.

12. Next, to configure your walk-up location to use the **Off hours schedule**, navigate to **Appointment Booking > Appointment Booking Configuration**.

13. Select **Walk-up Experience** and then the walk-up location you want to reconfigure, for example, San Diego Tech Lounge.

   ![Appointment Booking Configuration](image)

   **14.** In the **Holiday Schedule** field, change the default, base system schedule value to **Off hours schedule**, using the list search icon.

   **15.** Click the **Daily Schedule** tab to configure the daily start and end times for the walk-up location.

   For this location, the hours of operation begin at 8:00 a.m. and end at 5:00 p.m. (17:00), Monday through Friday.
16. Click **Update** to save your changes.

17. To verify the hours you want excluded from appointment booking are unavailable, navigate to **Self-Service > Walk-up Check-in**.

18. Select the walk-up location with the excluded hours you want to verify.

**Welcome to the walk-up check-in**

Need service? Select a location and reason for visit below to join a walk-up queue.

19. Click **Schedule an appointment**.

20. Click the calendar icon to view the available appointment times for the walk-up location.
The appointment schedule reflects the excluded hours you configured by using the **Off hours schedule**. Scroll down in the **Select Appointment** window to view the end times.

### Activate and configure appointment booking reminders for Walk-up Experience

Configure scheduled appointment reminders for Walk-up Experience users. Reminders ensure users attend appointments in a timely manner or reschedule or cancel an appointment if they can no longer attend.

**Before you begin**

Role required: admin or sn_walkup.walkup_admin

**About this task**

In order for appointment booking reminders to operate, you must activate the **Appointment Booking Reminders** Scheduled Job, which is not active by default. In addition, the **Appointment reminder** field does not appear on the **Appointment Booking Service Configuration** form by default. You must add it to the form and configure reminders. Reminders are inactive unless a configuration is set.

**Procedure**

1. To activate the **Appointment Booking Reminders** Scheduled Job, navigate to **System Definition > Scheduled Jobs**.
2. Search for **Appointment Booking Reminders** by name and click to open.
3. Click the **Active** field to activate the scheduled job.
4. Click **Update**.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
5. To add the Appointment reminder field to the Appointment Booking Service Configuration form, navigate to Walk-up Experience > Administration > Appointment Configurations.

6. Select a Walk-up Experience service configuration from the list. The Appointment Booking Service Configuration form opens.

7. Click the menu button ( ) and scroll to Configure > Form Layout.

8. Select Appointment reminder from the Available list and move it to the Selected list using the add button.

9. Click Save. The Appointment Booking Service Configuration form displays with the Appointment reminder field.

10. To configure an appointment reminder, choose an amount of time, in hours, from the Appointment reminder field drop-down list. The hour or hours you choose represents the amount of time before a scheduled appointment that you want to send a reminder, for example, 2 hours before a scheduled appointment.

11. Click Update to add the appointment reminder configuration.

Create or modify a Walk-up Experience stockroom

Create stockrooms and assign assets and groups specifically for your walk-up location. Walk-up stockrooms contain common assets that visitors to the walk-up location will typically request, such as a computer mouse, monitors, and cables. The walk-up location stockroom should be easily accessible to your walk-up location for fast request fulfillment.

Before you begin
Role required: admin, sn_walkup.walkup_admin, asset, or inventory_user

About this task
Stockrooms are separate, standalone entities in the Asset Management application.

Procedure
1. To view walk-up location stockrooms, navigate to Walk-up Experience > Administration > Walk-up Stockrooms. The Stockrooms [Walk-up view] list opens.

2. To modify an existing walk-up stockroom, click the stockroom name, otherwise click New to create a stockroom.
3. Complete the Stockroom New record [Walk-up view] form or modify fields on an existing form.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Display name and unique identifier of the stockroom.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group that primarily uses the stockroom.</td>
</tr>
<tr>
<td>External</td>
<td>Whether this stockroom is managed internally (check box is cleared) or is managed externally by a third party (check box is selected).</td>
</tr>
<tr>
<td>Location</td>
<td>Physical location (address) of the stockroom.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of stockroom. Chose <strong>Walk-up</strong> to create a walk-up stockroom.</td>
</tr>
<tr>
<td>Manager</td>
<td>Person in charge of the stockroom. Receives restocking notifications and requests for the stockroom stock rules.</td>
</tr>
</tbody>
</table>

To complete this process and for detailed information pertaining to creating or modifying a stockroom, and adding and managing stockroom assets, refer to [Stockrooms](#).

**Create or modify Walk-up Experience locations**

Walk-up Experience locations contain all the information about the physical walk-up support venue. Easily configure Walk-up Experience to serve all users in your organization by using an inclusive branding, such as Tech Lounge, Service Center, Genius Bar, and more.

**Before you begin**

Role required: admin, sn_walkup.walkup_admin, or sn_walkup.walkup_manager

**About this task**

You can configure schedules, assignment groups, associate stockrooms, and both management and administrative information for your walk-up location. Specify reasons-for-visit options and configure how interactions display for each walk-up location.
Procedure

1. Navigate to **Walk-up Experience > Administration > Walk-up Locations**.

2. To modify an existing walk-up location, click the name of the walk-up location queue. Otherwise, click **New** to create a walk-up location. The Walk-up Location Queue form opens.

3. Complete the form.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a detailed name for the location, such as the city or building it is located at.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a description of the location, if desired.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Select a schedule for operation days and hours.</td>
</tr>
<tr>
<td>Appointment Booking</td>
<td>Add and configure an appointment booking schedule for the walk-up location.</td>
</tr>
<tr>
<td>Service channel</td>
<td>Search for and choose the <strong>Walk-up</strong> service channel.</td>
</tr>
<tr>
<td>Define condition here</td>
<td>Select whether or not to automatically route work items to this queue using a condition.</td>
</tr>
<tr>
<td>Condition mode</td>
<td>Choose either <strong>Simple</strong> mode or <strong>Advanced</strong> mode to automatically route work to the queue. Simple mode is the default. With simple mode you can select from pre-built conditions. For example, select <strong>Location is X</strong> [search and select location]. With advanced mode you can provide your own scripting and code.</td>
</tr>
<tr>
<td>Work item routing condition</td>
<td>Configure and specify who will provide customer support at a walk-up location. Location is determined by physical address.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to make this queue location active.</td>
</tr>
<tr>
<td>Enable away state</td>
<td>Check to allow an away state.</td>
</tr>
<tr>
<td>Away message</td>
<td>Specify a display message for when the location is temporarily closed. This is for hours other than the scheduled closed times.</td>
</tr>
<tr>
<td>Stockroom</td>
<td>Select a stockroom to supply assets for the location.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Location</td>
<td>Select the physical address of your location.</td>
</tr>
<tr>
<td>Location image</td>
<td>Click to add an image of your location. For example, this can be an image of the city or building where the walk-up location is located.</td>
</tr>
</tbody>
</table>

4. Click the **Management** tab to complete the Management section of the form.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position notification</td>
<td>Select the queue position that triggers a notification to visitors when they are close to being assisted at the location. For example, when a visitor is third in line to be assisted.</td>
</tr>
<tr>
<td>Last check-in</td>
<td>Specify the last available check-in time in minutes. For example, 30 minutes before closing.</td>
</tr>
<tr>
<td>Enable online check-in</td>
<td>Allow visitors to check in to the location remotely from a laptop or mobile phone.</td>
</tr>
<tr>
<td>Enable appointment delegation</td>
<td>Enable users to book an appointment for someone else.</td>
</tr>
</tbody>
</table>

**Note:** When you enable appointment delegation, the **Appointment delegation group** field appears. Select a group to allow appointment delegation. Add a new group of users if an appropriate group does not exist. Only users in this group will have the choice of scheduling for themselves or another user when they book an appointment.

<table>
<thead>
<tr>
<th>Name configuration</th>
<th>Select a name configuration to display visitor information on the onsite queue TV monitor and online check-in screen. The first name will always display. However, you can show first and last name, first name with last name initial only, or first name only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appointment routing time</td>
<td>Specify the amount of time, in minutes, to route the work item to an agent prior to an appointment time.</td>
</tr>
<tr>
<td>Hold time</td>
<td>Enter an amount of time, in minutes, that you want to put an interaction on hold before attempting to route it again to a technician. For example, entering 5 will put the interaction on hold for 5 minutes before rerouting.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show estimated wait time</td>
<td>Enable the estimated wait time to show for walk-up queues.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The wait time is calculated from the average wait time of the queue and how many users are currently in the queue. All estimated wait times are rounded to the nearest whole minute.</td>
</tr>
<tr>
<td></td>
<td>The estimated wait time calculation requires the use of the Advanced Work Assignment queueing system to calculate the average wait time.</td>
</tr>
<tr>
<td></td>
<td>Estimated wait times display in the following places:</td>
</tr>
<tr>
<td></td>
<td>• Online check-in.</td>
</tr>
<tr>
<td></td>
<td>• Onsite check-in and onsite queue screen (TV).</td>
</tr>
<tr>
<td></td>
<td>• <strong>Status</strong> widget on the Service Portal</td>
</tr>
<tr>
<td>Audio Playback</td>
<td>Specify when the audio confirmation will play, for example, when a requester checks into an onsite queue, when a requester checks in online, or both. The default mode is <strong>None</strong>.</td>
</tr>
<tr>
<td>Audio File</td>
<td>Specify an audio file to play for these walk-up queue conditions:</td>
</tr>
<tr>
<td></td>
<td>• When a requester checks into a queue, audio emits from the actual check-in location, typically a stationary laptop.</td>
</tr>
<tr>
<td></td>
<td>• When a new requester moves up in the queue, audio emits from the location large wall monitor.</td>
</tr>
<tr>
<td></td>
<td>• When a requester makes an appointment online, audio emits from the person device.</td>
</tr>
<tr>
<td></td>
<td>The base-system default file is walkup_checkin.mp3.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only mp3 file formats are supported across all browsers.</td>
</tr>
<tr>
<td></td>
<td>You may need to provide additional browser permissions to use an audio file on the Safari browser.</td>
</tr>
</tbody>
</table>

5. Click the **Administration** tab to complete the Administration section of the form.
<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue time display</td>
<td>Chose from <strong>None</strong>, <strong>Check-in time</strong>, or <strong>Time waited</strong> to be displayed on the location wall monitor.</td>
</tr>
<tr>
<td>Queue message</td>
<td>Specify a welcome message for your location wall monitor.</td>
</tr>
<tr>
<td>Check-in greeting</td>
<td>Create a check-in message to guide visitors to sign into the queue at the designated check-in monitor.</td>
</tr>
<tr>
<td>Closed message</td>
<td>Create a message to alert visitors that it is outside the hours of operation and the location is closed.</td>
</tr>
<tr>
<td>Closed phone number</td>
<td>Select your country from the drop-down menu to display the IT phone number.</td>
</tr>
<tr>
<td>Closed phone number label</td>
<td>Define a label to display, such as, Contact IT Support.</td>
</tr>
<tr>
<td>Closed record producer</td>
<td>Search for and select a record producer to display and link to during closed hours, such as <strong>Create incident</strong>.</td>
</tr>
<tr>
<td>Badge Check-in Reason</td>
<td>Define a reason for checking into a walk-up location. The default reason is <strong>Other</strong>.</td>
</tr>
<tr>
<td>Note: Badge scan check-in is not an authentication mechanism.</td>
<td></td>
</tr>
<tr>
<td>Badge Check-in reason description</td>
<td>Define the check-in reason description. The default description is <strong>Walk-up badge scan check-in</strong>.</td>
</tr>
<tr>
<td>Note: Badge scan check-in is not an authentication mechanism.</td>
<td></td>
</tr>
<tr>
<td>Closed image</td>
<td>Click to add an image indicating the walk-up location is closed. The image displays on the wall monitor to alert walk-in visitors that the location is closed.</td>
</tr>
<tr>
<td>Max search results</td>
<td>Specify how many search results to provide for contextual searches.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Contextual search config</td>
<td>Configure which search context will provide results at the location.</td>
</tr>
<tr>
<td>Enable unregistered user entry</td>
<td>Check to allow users who do not have a user name in the system to check in to the location for support. For example, guests visiting the location (opposed to employees).</td>
</tr>
<tr>
<td>Enable lookup user entry</td>
<td>Check so that when users begin typing their names they can quickly see and select their names from a list.</td>
</tr>
<tr>
<td>Enable technician info</td>
<td>Check to allow the display of available technician names on the location wall monitor.</td>
</tr>
<tr>
<td>Enable technician avatar</td>
<td>Check to allow the display of technician avatars on the location wall monitor.</td>
</tr>
<tr>
<td>Enable badge check-in notification</td>
<td>Enable to show a notification when a requester checks into a queue using a badge scanner.</td>
</tr>
<tr>
<td>Header logo</td>
<td>Click to add a header logo. The header logo is location specific. If no logo is specified, by default, the Walk-up Portal logo is used.</td>
</tr>
<tr>
<td>Queue logo</td>
<td>Click to add a logo for the designated walk-up location wall monitor. Design this logo to work correctly with a black background. If no logo is specified for the queue, by default, the Header logo is used. If no Header logo is specified, the Walk-up Portal logo is used.</td>
</tr>
</tbody>
</table>

6. Right-click in the form header and select **Save**. Several tabs appear.

- **Interactions**
- **Walk-up Appointments**
- **Reasons for Visit**
- **Assignment Eligibility**
- **Work Item Sort Order**
- **Location Queues Badge Readers**
7. Click the **Interactions** tab to view interactions or configure how the walk-up Interactions list should display. You can use the filter icon (🔍) and the personalize list icon (🌀) to modify.

8. Click the **Walk-up Appointments** tab to view appointments or configure how the Walk-up Appointments list should display. You can use the filter icon (🔍) and the personalize list icon (🌀) to modify.

9. Click the **Reasons for Visit** tab to view, modify, or create a reason for visit option. The base system includes three active reasons:
   - **I need something**
   - **Something is not working**
   - **Laptop refresh**
   - **Other**

10. Click the **Assignment Eligibility** tab to view, modify, or create an assignment rule for your walk-up queue locations. Assignment rules are configured in the Advanced Work Assignment product.

11. Click the **Work Item Sort Order** tab to view, modify, or create an Work Item Sort Orders for your walk-up queue locations.

12. Click the **Location Queues Badge Readers** tab to view, modify, or add a badge reader for your walk-up queue locations.

13. Click **Update** to save the new or modified location queue.

**Walk-up Experience customer satisfaction surveys**

With Walk-up Experience surveys, users can rate their satisfaction with walk-up location interactions, providing management with feedback to improve the walk-up experience.

Two base-system predefined Walk-up Experiences surveys are provided:

- **Walk-up CSAT survey**: Onsite one-click sentiment-analysis survey where the user can quickly rate service based on a 1 - 3 scale, where 1 is a negative experience and 3 is a positive experience. The survey uses an image scale of three faces with different sentiments (sad, neutral, and smiling).
Walk-up Experience Satisfaction Survey: A survey link is sent via email when walk-up interactions are closed. It uses sentiment analysis for the overall experience, wait-time experience, technician experience, technician professionalism, and additional comments. This survey is based on a 1 - 5 numeric rating scale, where 1 is very unsatisfied and 5 is very satisfied.

Walk-up administrators and managers can modify these surveys and the associated trigger conditions. Managers and administrators can review responses by question and see a scorecard for each survey on the Walk-up Experience Dashboard module. User comments provide feedback that is used to improve the performance of walk-up interactions.

For more detailed information about working with surveys, sentiment analysis, trigger conditions, and survey questions, see Survey Management.

Create or modify a Walk-up Experience customer satisfaction survey

Improve your Walk-up Experience operations and customer service by using surveys and monitoring survey results. Walk-up surveys capture important information from users about the interaction experience provided to them at the venue.

Before you begin
Role required: admin or sn_walkup.walkup_admin or sn_walkup.walkup_manager

About this task
Creating a new customer satisfaction survey requires that you first define a new survey and then use the Survey Designer to design, configure, and make it available to users.
Procedure

1. To view and use a base-system predefined survey in the Walk-up Experience application, navigate to **Walk-up Experience > Administration > Surveys**. The Assessment Metric Types list opens displaying the available walk-up surveys.

2. To modify an existing walk-up survey, click the survey name, otherwise navigate to **Survey > View Surveys** and click **New** to define a new survey if none of the base-system surveys are optimal for your walk-up location. The Survey Definition New record form opens.

3. To modify or complete the form, refer to **Modify a survey definition**.

Remove a Walk-up Experience location

If you permanently close down a physical Walk-up Experience location, you can also remove the location from the Walk-up Location Queues table.

**Before you begin**
Role required: admin or sn_walkup.walkup_admin

**Procedure**

1. Navigate to **> Administration > Walk-up Locations**.

2. Click the name of the walk-up location you want to remove to open the location queue record.

3. Click **Delete** in the form header.
   - A confirmation pop-up appears ensuring you want to delete the record.

4. When the confirmation pop-up asks if you want to delete the record, click **Delete**.
   - The Walk-up Experience location queue is removed from the application.

Badge Reader Integration for Walk-up Experience

Improve your Walk-up Experience user satisfaction by introducing the Badge Reader Integration application at your onsite walk-up queue locations. Walk-up Experience users can scan an employee badge to check in to a queue, rather then entering credentials.
**Badge Reader Integration for Walk-up Experience onsite queue locations**

Badge Reader Integration is a pre-built, domain-separated, base-system application enabling your Walk-up Experience users to simply scan an employee badge to join an onsite walk-up queue. Badge scanning is quick and eliminates the need for users to look up a name or email to join a queue. Administrators configure badge scanning integration for use. There is no need for customizations because the application is pre-built and ready for operation.

By providing an enhanced, easier, and faster Walk-up Experience check-in process, use of onsite walk-up location queues can increase and overall user satisfaction can improve. Users receive an on-screen confirmation and an audio alert upon successful check in to a walk-up queue.

Badge scanning integration requires activation of the Badge Reader Integration plugin (com.snc.badge_reader). The plugin enables applications, such as Walk-up Experience, to integrate with badge reader hardware. Badge Reader Integration administration requires the Badge Admin role (sn_badge.badge_admin).

ℹ️ **Note:** Badge Reader Integration is not an authentication mechanism.

**Walk-up Experience Badge Reader Integration components**

The badge reader hardware and integration client are physically located at a walk-up queue location. The Badge Reader Integration application provides a generic, reusable REST API used by the badge integration clients. Walk-up Experience uses the Badge Reader Integration application as a soft dependency.

Download the Badge Reader Integration executable for installation on your system. Activation of the Badge Reader Integration application provides an executable file. The client integrates with the Human Interface Device (HID) Omnikey 5427ck USB Badge Reader hardware and the Badge Reader Integration application REST API. The **Badge Reader Integration** module contains links to download the client to either a Linux or OSX operating system.

Walk-up Experience implementers install the HID Omnikey 5427ck USB Badge Reader hardware on a new computer at each onsite walk-up queue location. The hardware replaces any existing tablets used for onsite echeck-in. The following are important associated components to know:

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Badge number</td>
<td>Employee badge number.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Facility code</td>
<td>Unique facility or site code encoded into each card that identifies the organization.</td>
</tr>
<tr>
<td>Human Interface Device (HID)</td>
<td>Protocol for interfacing with user interface devices via USB.</td>
</tr>
<tr>
<td>Physical Access Control Services (PACS)</td>
<td>Method used to protect the security of a physical environment by setting authorization and authentication rules.</td>
</tr>
<tr>
<td>Badge reader client</td>
<td>Acceptable platforms include Mac and Linux.</td>
</tr>
<tr>
<td>Badge reader plugin</td>
<td>Badge Reader Integration plugin (com.snc.badge_reader) is no additional cost.</td>
</tr>
</tbody>
</table>

**Badge Reader Integration components**

**Badge Reader Integration modules**

Badge admins can access several application modules.

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Downloads</td>
<td>Badge Reader Integration client for download to your system.</td>
</tr>
<tr>
<td>Badge Readers</td>
<td>Configuration module for defining and activating your badge reader devices.</td>
</tr>
<tr>
<td>Badge Event Handlers</td>
<td>Configuration module for defining what action to take when a badge is scanned by a badge reader device.</td>
</tr>
<tr>
<td>Module</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Module</td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>The script entered is the code executed when a badge is scanned. These records are typically delivered as part of the application specific badge reader integrations.</td>
</tr>
<tr>
<td>User Badges</td>
<td>Configuration module for associating users with user badges. Configuration requires associating a sys_user with a unique badge number and facility code.</td>
</tr>
<tr>
<td>Badge Scan Logs</td>
<td>View-only module to monitor badge reader error events.</td>
</tr>
</tbody>
</table>

**Badge Reader Integration security**

The Badge Reader Integration application is not an authentication mechanism. It provides a quicker, more convenient way for users to check into a walk-up queue. It is meant for use within the existing security perimeter at the facility. The application does not integrate with existing access control software at the facility.

**Activate Badge Reader Integration**

You can activate the Badge Reader Integration plugin (com.snc.badge_reader) if you have the Badge sn_badge.badge_admin role.

**Before you begin**

Role required: sn_badge.badge_admin

**About this task**

The Badge Reader Integration application is a framework enabling other applications, such as Walk-up Experience, to integrate with badge reader hardware. Administrators configure and manage badge reader clients and integrations by linking badge scanners to walk-up locations and ensuring there is mapping between badge ID numbers and the reader.

Developers can extend the badge scanning framework to trigger actions in other applications based on a badge scan event. The Badge Reader Integration application does not require customization, but is customizable to respond to unique badge system hardware.
Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Installed with Badge Reader Integration

Several types of components are installed with activation of the Badge Reader Integration plugin, including tables and user roles.

   Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Badge admin [sn_badge.badge_admin]</td>
<td>Used to administer badge reader integrations.</td>
<td>None</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Badge [sn_badge_user_badge]</td>
<td>Record used to configure a user badge, associating a user to a badge number and facility code.</td>
</tr>
<tr>
<td>Badge Event Handler [sn_badge_event_handler]</td>
<td>Record used to configure actions associated with a badge scan event.</td>
</tr>
</tbody>
</table>
### Tables installed (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Badge Scan Log</td>
<td>Record used to log all badge reader error events.</td>
</tr>
<tr>
<td>[sn_badge_scan_log]</td>
<td></td>
</tr>
<tr>
<td>Badge Reader</td>
<td>Record used to configure badge reader devices.</td>
</tr>
<tr>
<td>[sn_badge_badge_reader]</td>
<td>Extends the Task table.</td>
</tr>
</tbody>
</table>

**Walk-up Experience Badge Reader Integration setup and configuration**

Badge Reader Integration set up and configuration enables your onsite Walk-up Experience users to scan a badge to quickly check into the queue.

The Walk-up Experience (com.snc.walkup) and Badge Reader Integration (com.snc.badge_reader) plugins must be activated before you set up and configure the integration. Refer to [Activate Walk-up Experience](#) and [Activate Badge Reader Integration](#) for details regarding activation.

Badge Reader Integration is automatically activated with Walk-up Experience via a conditional plugin.

Activation of Badge Reader Integration provides a client executable file, that, once installed on the appropriate computer, integrates with the HID Omnikey 5427ck USB Badge Reader hardware and the Badge Reader Integration application REST API. The **Badge Reader Integration** module contains links to download the client to either a Linux or OSX operating system.

Badge Reader Integration requires connecting the HID Omnikey 5427ck USB Badge Reader hardware to a client computer at an onsite Walk-up Experience location. Downloading and installing the badge reader client executable on this computer enables integration between it and the badge reader hardware.

Set up and configuration entails the following stages:

- **Client software**: Download the client executable file and install on your system.
- **Badge reader device**: Configure the badge reader device and register it manually or via an assisted process.
• Approval: Request and receiving device activation approval.
• Walk-up Experience application: Configure Walk-up Experience to integrate with a badge reader device.

**Download Badge Reader Integration client and configure hardware**

Configuring the HID Omnikey 5427 CK USB badge reader device after you download and install the client software enables the Badge Reader Integration application to parse data from the device.

**Before you begin**
Role required: sn_badge.badge_admin

**About this task**

Note: This procedure is based on the HID Omnikey 5427 CK USB badge reader device hardware. Specific configurations may vary depending on your device manufacturer. For complete configuration details regarding the HID Omnikey 5427 CK USB badge reader device and for related supplemental documentation, refer to:

- Find facility code/card number with PACS data output for HID Global 5427 USB Multi reader
- Wiegand interface

You need to have the HID Omnikey 5427 CK USB badge reader device hardware available for configuration. Download the executable client and configure the badge reader device to integrate with the Badge Reader Integration application.

To successfully configure the badge reader, you need to configure the **Keyboard Wedge Enable**, **Card Data Selection**, and the **Card Data Manipulation** tabs. Configuring the Card data Selection depends on your specific card format. Please refer to your manufacturer documentation for specific details.

Configuring Card Data Selection is a device configuration and depends on your specific card format. Please refer to your specific manufacturer documentation for details.

Configure the Card Data Manipulation format so the badge reader client obtains the expected and necessary badge reader device data output. The client requires the badge reader to output accordingly: `<facility code>:`:<badge number>[enter], so it can parse the data when the badge is scanned.
Procedure

1. Plug your device into a Linux or Windows machine.

2. Navigate to the IP address of your device.

   The out-of-the-box IP address is 192.168.63.99. The out-of-the-box IP address may have been overridden in your system if this device was previously configured. Refer to the HID OMNIKEY 5427 CK Keyboard Wedge User Guide User Manual for more details.

3. Navigate to **Badge Reader Integration** > **Downloads** to select your operating system.

4. Click the download icon to choose either a **Linux** or **OSX** client.

   **Note:** Ubuntu Linux is supported.

   The appropriate client software executable is downloaded to your computer.

5. Click to open the client **badge-reader** executable file to install it on your computer.

6. On the HID Omnikey 5427 CK USB badge reader device interface, click the **Keyboard Wedge** tab and then the **General Config** tab to configure the card data output in a format that the Badge Reader Integration application can parse.

7. Check the **Keyboard Wedge Enable** box to activate this mode.

8. From the **Keyboard Wedge** tab, click the **Card Data Selection** tab.

9. Choose **Seos** from the **Card Type** drop-down menu.

   **Note:** Currently only Seos is supported.

10. Ensure **Enable Seos** is checked.
11. Check the **PACS Custom** box to output the card data into an easily parsed format.

12. Specify the offset and length appropriate for your card format.

**Example**

This configuration is for a 48bit card format. The first bit is a parity bit. There are 23 bits for the facility code, 23 bits for the card number, and 1 final parity bit.

**Note:** If necessary, refer to the supplemental documentation links provided above in this topic to determine the offset and length for your card format.

13. Type : to configure the first **Poststrokes** element to contain a colon. The first **Prestrokes** element is the facility code. The colon separates the facility code from the badge card number, with is the second **Prestrokes** element.

14. Type `[ENTER]` to configure the second **Poststrokes** element. The second **Prestrokes** element is the badge card number. ENTER refers to the keystroke that terminates the card data string, triggering the badge reader client to send the badge scan event to the API endpoint.

**Example**

The goal is to output the facility code and badge card number separated by a colon and terminated by pressing the Enter key on your keyboard. If the facility code is 12345 and the badge card number is 6789, the desired output is: 12345:6789[enter] where [enter] is pressing the enter key.
15. From the **Keyboard Wedge** tab, click the **Card Data Manipulation** tab.

16. In the **PACS Custom 1 > Format** field, use the drop-down menu to change the format to **DEC**. The sets the output to decimal format for readability.

17. Set the **PACS Custom 2 > Format** field to **DEC** for output readability.

18. Navigate to the **System Config** tab to apply your changes.

19. Click **Apply Changes**.

20. Scan a badge to ensure your system is working.

   The client application should not be running. Ensure the badge reader is connected and enabled for Keyboard Wedge mode.

   The badge reader should keystroke out the data in the format you have configured, for example: 12345:6789[enter]

**Create or modify Badge Reader Integration event handlers**

Configure actions associated with a badge scan event and define the code to execute when a badge is scanned.

**Before you begin**

Role required: sn_badge.badge_admin
About this task
Using the **Badge Event Handlers** module you can map badge event handlers to multiple badge readers. For example, you may have a badge reader at your San Diego, CA walk-up location and another badge reader at your Santa Clara, CA location. Both of these badge readers can be mapped to the same Walk-up Badge Reader event.

Badge Event Handler records are delivered as part of the Walk-up Experience application-specific badge reader integrations.

**Note:**

The code entered in the **Script** field of the Badge Event Handler form is executed using a GlideScopedEvaluator in the BadgeScanProcessor.

**Procedure**

1. Navigate to **Badge Reader Integration** > **Badge Event Handlers**.
   The Badge Event Handlers list appears and displays any existing badge event handlers.

2. To modify an existing badge event handler, click on the name. Otherwise, to create a new badge event handler, click **New**.
   The Badge Event Handler form opens for configuration.

3. Enter a name for the badge event handler in the **Name** field. For example, **Walk-up Badge Event**.

4. Enter details in the **Short description** field, if desired.

5. Enter code in the **Script** field.
   Enter the code in the **// your code goes here** section of the scripting field.

**Note:** This code is executed when a badge is scanned.
Note: By default, the Application field is set to Global until you enter code specifying Walk-up Experience application in the Script field and save or submit the record.

6. Click Submit to create the record.

Use Badge Reader Client to define and register a badge reader device

Use the Badge Reader Client to create a badge reader device for registration in your system. Registering your badge reader enables you to make it operational at your Walk-up Experience onsite queue.

Before you begin
Role required: sn_badge.badge_admin

About this task
There are two ways to register a badge reader device:

• Assisted method, through the Badge Reader Client.

• Manually, through the Now Platform®. Refer to Manually define and register a badge reader device for details on this procedure.
The **Badge Reader Client** assisted registration method creates an initial Badge Reader record. When a badge is scanned using the client executable, this method automatically populates the **Device Identifier** field in the record with the badge reader device serial number.

Automatic population of the **Device Identifier** field saves you time from looking for the badge reader device serial number to add to the Badge Reader record.

To register your badge reader device with **Badge Reader Client** assistance, first you need to configure system properties to enable badge scan registration and disable the badge access token. The following System Properties must be configured:

- **sn_badge.enable_scan_registration**: Disabled by default. When set to **True**, this property enables n_badge.badge_admins to quickly register badge reader devices by scanning a badge.
- **sn_badge.disable_access_token**: Enabled by default. This property disables the access token requirement for the Badge Reader Integration API.

**Procedure**

1. Navigate to **System Properties > All Properties**.
2. Search by **Name** for the properties by typing `sn_badge`. The Badge Reader Integration system properties are listed for view.
3. Click **sn_badge.enable_scan_registration** to open the system property record. The property is set to **False** by default.
4. Change the property **Value** field to **True** and click **Update**.
5. Click **sn_badge.disable_access_token** to open the system property record. The property is set to **False** by default.
6. Change the property **Value** field to **True** and click **Update**.
7. Navigate to your downloaded **Badge Reader Client** files to configure `client.json`.
8. Locate and click the `client.json` file.

   **Note**: Start the client using sudo to enable access to a USB port.
When using scan registration, only the URL is required. The Secret Key field is generated when the Badge Reader record is created.

9. Navigate to **Badge Reader Integration > Badge Readers** to view the newly created record.

10. Provide a name for the badge reader in the **Name** field. For example, *Building B Tech Lounge Badge Reader*.

    **Note:** The **Status** field is read only and indicates **New** when configuring a new badge reader. The field indicates **Activated** when a badge reader is approved for activation. If a badge reader is deactivated, the field indicates **Deactivated**.

11. Specify a **Badge Event Handler** using the search list icon.

    **Note:** If no badge event handlers are available to select, create a new Badge Event Handler record. For details about this process, refer to *Create or modify Badge Reader Integration event handlers*.

12. Verify that the **Device Identifier** and **Secret Key** fields are populated. The Device Identifier uniquely identifies the badge reader hardware. The client defaults to using the badge reader device serial number. The value entered must match the device serial number received from the client software application.

13. Populate the non-mandatory **Short description** and **Location** form fields if desired.

14. Click **Submit** to register the badge reader.
Manually define and register a badge reader device

Manually create a badge reader device for registration in your system. Registering your badge reader enables you to make it operational at your Walk-up Experience onsite queue.

Before you begin
Role required: sn_badge.badge_admin

About this task
There are two ways to register a badge reader device:

• Manually, through the Now Platform®.
• Assisted method, through the Badge Reader Client. Refer to Use Badge Reader Client to define and register a badge reader device for details on this procedure.

Procedure
1. To manually register your badge reader device, navigate to Badge Reader Integration > Badge Readers.
2. Click New to create a new badge record
   The Badge Reader form opens for configuration.
3. Provide a name for the badge reader in the Name field. For example, Building B Tech Lounge Badge Reader.
   Note: The Status field is read only and indicates New when configuring a new badge reader. The field indicates Activated when a badge reader is approved for activation. If a badge reader is deactivated, the field indicates Deactivated.
4. Specify a Badge Event Handler using the search list icon.
   Note: If no badge event handlers are available to select, create a new Badge Event Handler record. For details about this process, refer to Create or modify Badge Reader Integration event handlers.
5. Enter the Device Identifier.
   The Device Identifier uniquely identifies the badge reader hardware. The client defaults to using the badge reader device serial number. The value entered must match the device serial number received from the client software application.
   Note: The Secret Key field is automatically populated when you create the badge reader record.
6. Populate the non-mandatory **Short description** and **Location** form fields if desired.

7. Click **Submit** to register the badge reader.

**Request activation approval for a badge reader device**

Request activation approval for your badge reader device. Badge Reader Integration will not trigger event handlers until the badge reader is activated. Badge reader device approval and activation is granted by users with the itil role.

**Before you begin**
Role required: sn_badge.badge_admin

**About this task**
When you request activation approval, via the Badge Reader record, you initiate the device registration workflow. Activation requests are routed to a badge reader approvers group. System approvals require the itil role. Ensure users with the itil role are added to the badge reader approvers group.

If there are no people in the approval group, the workflow will skip past the approval group requirement, and activate the badge reader. For detailed information about approvals, groups, and adding users to groups, refer to **Approvals** and **Groups**.

**Note:** Badge Reader record required fields are read only when the badge reader device is activated. Badge reader devices can be deactivated by de-selecting the **Active** field on the Badge Reader record. Reactivation of a badge reader requires going through the approval process again.

**Procedure**

1. Navigate to **Badge Reader Integration > Badge Readers**.

2. Click the name of the badge reader you want to activate.
   The Badge Reader record opens.

3. Ensure all mandatory form fields are populated. This includes the **Name**, **Badge Event Handler**, **Device Identifier**, and **Secret Key** fields.
   Refer to **Use Badge Reader Client to define and register a badge reader device** or **Manually define and register a badge reader device** for information regarding populating Badge Reader form fields.

4. Click **Request Activation** to initiate the activation approval workflow.
The request is approved by a user with the itil role in the badge reader approvers group. If there is no badge reader approvers group or the group is empty, then the badge reader is activated when a user with the sn_badge.badge_admin role requests activation.

**Configure Walk-up Experience for Badge Reader Integration**

Associate badge reader devices with an onsite Walk-up Experience queue. While you can associate more than one badge reader device to a walk-up location, individual badge reader devices are mapped to only one walk-up location.

**Before you begin**
Role required: sn_walkup.walkup_manager

**About this task**
The Walk-up Experience application requires that a badge reader device is mapped to a walk-up location for feature integration.

Walk-up Experience managers can configure badge reader integration to a walk-up location using the **Location Queues Badge Readers** related list on the Walk-up Location Queue (wu_location_queue) table.

At least one badge reader must be activated and available to integrate with the walk-up location. Refer to Request activation approval for a badge reader device if no badge readers are activated for use.

**Procedure**

1. Navigate to **Walk-up Experience > Administration > Walk-up Locations**.
2. Click the name of the walk-up location queue you want to associate with a badge reader device. The Walk-up Location Queue form opens.
3. Click the **Location Queues Badge Readers** related link.
4. Click **New** and use the search list icon in the **Badge Reader** form field to select an available badge reader.
5. Click **Submit**.

You can integrate with as many badge readers at your walk-up location as you need.
View Badge Scanner Integration scan logs

Monitor scanner-use error activity at a Walk-up Experience onsite location by viewing the scan logs. Each time a badge reader device triggers an error, a scan event is logged in the Badge Scan Logs module.

Before you begin
Role required: sn_badge.badge_admin

About this task
The Badge Scan Logs module only stores badge reader integration error messages. It does not display error messages for Walk-up Experience specific badge scans.

Walk-up Experience badge scan errors can be found in the System Log.

Procedure
1. Navigate to Badge Reader Integration > Badge Scan Logs.
2. Click an event in the Badge Scan Logs list to view the associated Message, Badge Reader, and User Badge.

Badge Reader Integration customization

 Badge Reader Integration includes several scripted extension points enabling you to customize script includes installed with the feature.

The underlying Badge Reader Integration script includes are read only. Customers who want to modify the look and feel of the feature can alter several script includes using scripted extension points.

Various scenarios exist whereby the ability to modify script-includes code is beneficial. For example, if you already use a data model to store your badge numbers, you may not want to use the Badge Reader Integration application User Badge (sn_badge_user_badge) table to store your badge numbers. Instead, you can create an extension implementation for sn-badge.BadgeReader that supports your data model.

Perhaps you want to customize the types of data you receive from a badge scan or how you want to parse that data. You can create an extension implementation for sn-badge.BadgeReaderParser that supports your data model.

The following code is available for alteration using scripted extension points with the Badge Reader Integration application:
<table>
<thead>
<tr>
<th>Scripted Extension Points</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BadgeReader</td>
<td>Extension point used by the BadgeReaderImpl script include. Use this script to find a badge reader by its device identifier.</td>
</tr>
<tr>
<td>API name: sn_badge.BadgeReader</td>
<td></td>
</tr>
<tr>
<td>BadgeReaderParser</td>
<td>Extension point used by the BadgeReaderParserImpl script include. Use this to parse the card data string from the API.</td>
</tr>
<tr>
<td>API name: sn_badge.BadgeReaderParser</td>
<td></td>
</tr>
<tr>
<td>BadgeReaderUser</td>
<td>Extension point used by the BadgeReaderUserImpl script include. Use this script to find a sys_user from a badge number and facility code.</td>
</tr>
<tr>
<td>API name: sn_badge.BadgeReaderUser</td>
<td></td>
</tr>
<tr>
<td>BadgeReaderScanProcessor</td>
<td>Extension point used by the BadgeReaderScanProcessor script include. Use this frontage to manage the badge scan event.</td>
</tr>
<tr>
<td>API name: sn_badge.BadgeReaderScanProcessor</td>
<td></td>
</tr>
</tbody>
</table>

For complete details about scripted extension points and how to create and use them, refer to Using extension points to extend application functionality and Creating and adding a scripted extension point.

**Walk-up Experience Microsoft Office 365 calendar integration**

With Microsoft Office 365 calendar integration Walk-up Experience users can view appointments in their primary calendar. When they make an appointment, modify it, or cancel it, they are sent invites and updates via their Outlook calendar.
This feature is only available when Microsoft Office 365 Outlook is the hosted calendar service. Administrators enable the flows that execute the integration using Flow Designer. Other prerequisites include:

- Microsoft Azure AD and the Microsoft Office 365 tenant exists and is configured.
- Associated connections and credentials are setup and tested.

**Note:** These prerequisites are assumed already in place at your business.

**Set up Microsoft Office 365 integration for Walk-up Experience**

Enable Walk-up Experience Microsoft Office 365 calendar integration. When users make an appointment, modify it, or cancel it, the Outlook calendar is sent invites to an appointment and any updates.

**Before you begin**

Logging into the Microsoft Azure Portal ([https://portal.azure.com](https://portal.azure.com)) with your specific customer account is necessary. You will already have a tenant, as logging into the portal requires access to this tenant. For details about setting up a tenant, refer to [Quickstart: Set up a tenant](#).

Also required is that you have a Microsoft Office 365 subscription linked to an existing tenant. For details regarding this, refer to [Set up a Microsoft 365 developer subscription](#).

Role required: admin

**Procedure**

1. Confirm that the Walk-up Experience (com.snc.walkup), Microsoft Exchange Online Spoke (sn_ex_online_spke), and Microsoft Exchange Server Spoke (sn_exchange_spoke) plugins are activated on your instance.

2. Navigate to **System Oauth > Application Registry > Microsoft Exchange Online** to set up Oauth.

   a. Insert the client ID (Application ID), which you can get from the Microsoft Azure AD application.

   b. Insert the client secret, which you can get from the Microsoft Azure AD application.

   c. Copy and paste the following links to access authorization, token, and redirect:
3. Navigate to Connections & Credentials > Credentials to set up credentials.
   a. Click New.
   b. Choose OAuth 2.0 Credentials.
   c. In the OAuth 2.0 Credentials new record provide a name for the Credential and in the OAuth Entity Profile form field, choose Microsoft Exchange Online default_profile.
   d. Click Save.
   e. Select Get QAuth Token in the Related Links section of the form.
   f. Sign in as a valid user on the Microsoft Exchange Tenant.

4. Navigate to Connections and Credentials Aliases to set up connection.
   a. Select Microsoft Exchange Online.
   b. In the Connections Related Links click New.
   c. Name the connection Exchange_Online_Connection and choose the previously created credential in the Credential form field.
   d. In the Connection URL field, enter: https://graph.microsoft.com.

5. Navigate to Flow Designer to enable flows.
   a. Select Create Walk-up Appointment Calendar Event, open in Flow Flow Designer, and activate.
   b. Select Update/Delete Walk-up Appointment Calendar Event, open in Flow Flow Designer, and activate.

6. Schedule an appointment to confirm everything is working properly.
   a. Create a new test user in the system. Refer to Create a user for details.

   Note: Provide a user ID, first name, last name, password and email for the test user.

   b. Impersonate the test user in your instance.

   c. Navigate to Self-Service > Service Portal > Walk-up Check-in to schedule an appointment.
Note: The Walk-up Check-in icon link must be configured to appear on the Service Portal landing page for you to see and click the link. Refer to Configure Walk-up Experience online check-in icon to appear on Service Portal if the link is not on the Service Portal landing page.

d. Schedule an appointment as the test user.

7. Verify everything is working correctly by navigating to Flow Designer > Today’s Executions.

8. Click Create Walk-up Appointment Calendar Event.

9. Check the test user’s corporate Microsoft Office 365 calendar to see the emailed calendar event.

Note: It can take a minute or two before the calendar event is created. After you enable this feature, users automatically receive calendar invites, updates, and cancellations on their individual corporate calendars.

Walk-up Experience queue and interaction management

Walk-up Experience managers and technicians can efficiently manage all aspects of a walk-up location queue and interaction demand. Technicians can view assigned walk-up locations, interactions, and associated stockrooms used for walk-up fulfillment.

Walk-up Experience provides technicians with inclusive fulfiller resources to organize and manage a walk-up queue.

Technicians primarily access Agent Workspace to manage all aspects of Walk-up Experience. Using Agent Workspace technicians can:

• Access a personal inbox to view work assigned from multiple service channels, including the Walk-up Service Channel.

• Get assignments automatically pushed to the inbox from the walk-up interaction queue.

• Work on concurrent or multiple interactions at the same time.

• Promote interactions to incidents or requests.

• Work with any requester in the queue at any time by pulling from anywhere in the queue list, as well as from the top of the list.

• Use Agent Assist for expedited fulfillment.
With Agent Workspace, technicians typically fulfill interactions on a first-come-first-served basis as interactions are pushed to individual walk-up inboxes. Interactions are distributed to walk-up agent inboxes based on assignment rule configurations in the Advanced Work Assignment feature.

Technicians can directly open incidents in Agent Workspace when an issue is not resolved at the walk-up location. Technicians can also directly create a request for hardware or software through the Service Catalog when an asset is not available at the walk-up location stockroom.

Walk-up Experience also includes a Technician module in the application navigator where IT agents supporting a walk-up queue can perform the following actions:

• Access the personal walk-up inbox linking directly to Agent Workspace.
• View assigned walk-up interactions.
• Reassign and modify walk-up interactions when necessary.
• View all scheduled and upcoming appointments.
• View walk-up queue locations.
• View available assets and fulfill requests from a local stockroom.
• Create incidents and requests when necessary.
• Transfer walk-up interactions to other agents or queue locations when necessary.

The following applications are included in the platform Technician module of the Walk-up Experience navigation bar as well as viewed in the Agent Workspace Walk-up Experience interface:

<table>
<thead>
<tr>
<th>Walk-up Experience technician applications</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform: My Walk-up Inbox</td>
<td>View walk-up interactions assigned to you in your personal inbox on Agent Workspace. Interactions are pushed to your inbox according to assignment rule configurations in the Advanced Work Assignment feature.</td>
</tr>
<tr>
<td>Platform: My Walk-up Locations</td>
<td>View walk-up queue locations that you are assigned to support by physical address.</td>
</tr>
</tbody>
</table>
### Walk-up Experience technician applications (continued)

<table>
<thead>
<tr>
<th>UI view and application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent Workspace:</strong> Walk-up Locations</td>
<td>View walk-up interactions you are assigned to resolve or fulfill. These interactions have a <strong>Work in Progress</strong> state. You can also see your assigned interactions in your personal inbox on Agent Workspace.</td>
</tr>
<tr>
<td><strong>Platform and Agent Workspace:</strong> My Assigned Walk-ups</td>
<td>View stockrooms and assets associated with the walk-up queue locations you support.</td>
</tr>
<tr>
<td><strong>Platform:</strong> My Walk-up Stockrooms</td>
<td>View all open and unassigned walk-up interactions for your queue locations. These interactions have either a <strong>New</strong>, <strong>Queued</strong>, or <strong>Work in Progress</strong> state.</td>
</tr>
<tr>
<td><strong>Agent Workspace:</strong> My Stockrooms</td>
<td>View all closed walk-up interactions. Closed interactions have either a <strong>Closed Complete</strong> or <strong>Closed Abandoned</strong> state.</td>
</tr>
<tr>
<td><strong>Platform and Agent Workspace:</strong> Open - Unassigned</td>
<td>View all upcoming appointments scheduled for your walk-up queue.</td>
</tr>
</tbody>
</table>

For more information on Agent Workspace and Advanced Work Assignment, refer to **Agent Workspace** and **Advanced Work Assignment**.
**View assigned Walk-up Experience locations**

Walk-up Experience technicians can view a list of the walk-up queues they are assigned to support. Locations queues reveal all the information a technician needs to know to operate the queue efficiently.

**Before you begin**
Role required: sn.walkup.walkup_technician

**About this task**
There are two ways technicians can view the walk-up location queues they are assigned to support. Technicians primarily access Agent Workspace for all Walk-up Experience related information, including locations. However technicians can also access Walk-up Experience in the application navigator, or left navigation bar, to view assigned queue locations.

**Procedure**
1. To view walk-up locations using Agent Workspace, navigate to **Workspace Experience > Agent Workspace Home**.
   The Agent Workspace homepage opens, greeting you with your name.
2. Click **List** in the left navigation bar.
3. Under **Walk-up**, click **Walk-up Locations**.
   Walk-up locations you are assigned to support are listed.
4. Click a queue name to view details about the location, such as, interactions, appointments, reasons for visits, and more.
5. Alternatively, to view walk-up locations via the application navigator, navigate to **Walk-up Experience > Technician > My Walk-up Locations**.
6. Click a queue name to see details about the location, such as, interactions, appointments, reasons for visits, and more.
   If interactions are leftover from a previous day or are still queued at the end of the day with no associated guests at the queue, you can click **Abandon All** to cancel these interactions.

**View Walk-up Experience inbox**

View a personal inbox of automatically assigned Walk-up Experience interactions using the Agent Workspace feature interface.

**Before you begin**
Role required: sn.walkup.walkup_technician
About this task
There are two ways technicians can view the walk-up inbox. Technicians primarily access Agent Workspace for all Walk-up Experience related information, including the inbox. However technicians can also access Walk-up Experience in the application navigator, or left navigation bar, to link to and view the inbox in Agent Workspace.

Procedure
1. To view the walk-up inbox using Agent Workspace, navigate to Workspace Experience > Agent Workspace Home.
   The Agent Workspace homepage opens, greeting you with your name.
2. Click Inbox in the left navigation bar of the interface.
   Automatically pushed interaction assignments appear in the inbox based on agent schedules and assignment rule configurations in the Advanced Work Assignment feature. Technicians can set an inbox status of Available, Away, and Offline.
3. Alternatively, to view the walk-up inbox via the application navigator, navigate to Walk-up Experience > Technician > My Walk-up Inbox.
   You are linked directly to your personal inbox in Agent Workspace. Automatically pushed interaction assignments appear in the inbox based on agent schedules and assignment rule configurations in the Advanced Work Assignment feature.

Related information
Manage automatically assigned Walk-up Experience interactions

Manage automatically assigned Walk-up Experience interactions
Technicians supporting Walk-up Experience locations can view and manage interactions automatically pushed to the Agent Workspace inbox.

Before you begin
Role required: sn_walkup.walkup_technician

About this task
Walk-up Experience interactions can be automatically pushed to a personal inbox in Agent Workspace based on agent schedules and assignment rule configurations in the Advanced Work Assignment feature. Technicians fulfill interactions on a first-come-first-served basis as they appear in the inbox.

To manually assign and manage interactions using the Walk-up Experience Technician modules found in the application navigator, refer to Manage Walk-up Experience interactions manually.
Technicians set a status in the Agent Workspace inbox to indicate readiness to accept interactions. Status choices are Available, Away, and Offline.

Even though interactions are automatically pushed to the walk-up inbox, agents can work with anyone in the walk-up queue at any time.

View walk-up queue interactions assigned to you automatically in your walk-up inbox or in your My Assigned Walk-ups list. You can also view all Open - Unassigned interactions for the queue you support.

With Agent Workspace you can view lists of all your related walk-up interactions and appointments, your cases, customer accounts and contacts, incidents, requests, and more using one convenient interface. The Walk-up Experience related interaction list includes the following items:

<table>
<thead>
<tr>
<th>List item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Assigned Walk-ups</td>
<td>Interactions you assign to yourself when you accept an active interaction or that are assigned to you. Agents assign interactions to themselves when they accept a queued interaction. Managers can assign interactions to specific agents. These interactions are in a Work in Progress state. Once assigned, an agent can transfer the interaction to another agent or queue to complete the work, if necessary.</td>
</tr>
<tr>
<td>Open — Unassigned</td>
<td>All open but unassigned interactions associated with your specific walk-up queue location. When a guest checks into a walk-up queue, an interaction is created. The interaction is Queued until an agent accepts it or is assigned the interaction. At that point, the state changes to Work in Progress.</td>
</tr>
<tr>
<td>Closed Walk-ups</td>
<td>All Closed Complete and Closed Abandoned interactions assigned to a specific walk-up location queue. Agents can abandon an interaction when a guest leaves the queue before receiving support.</td>
</tr>
</tbody>
</table>

**Procedure**

1. To begin supporting a walk-up queue guest, navigate to Workspace Experience > Agent Workspace Home. The Agent Workspace homepage opens, greeting you with your name.

2. Click Inbox and ensure your status is set to Available. View interactions in your inbox automatically pushed to you.
3. Select the interaction at the top of the list and begin resolving the issue or fulfilling the request.

When you create an associated incident or request through the Service Catalog, a **New Incident** tab or a **New Catalog Item** tab opens next to the **Details** tab of the original interaction. Fill out the new incident form or order assets. Click the **Save** button to save the new incident or complete the order confirmation. You will receive an Request Number for your ordered item.

a. If an interaction requires an unusual amount of time to resolve or fulfill or if closure depends on resources not readily available, you can place the interaction on hold. The requester does not lose position in the queue and you can help another requester simultaneously. Placing an interaction on hold does not affect your capacity for new interactions. To put an interaction on hold, click the **Put on Hold** button.

b. You can associate the interaction with another record by selecting **Associate Record** from the more UI actions icon in the interaction header.

c. To view the walk-up location stockroom for fulfillment requests, click **List** in the left navigation panel of the Agent Workspace interface. Then click **My Stockrooms**.

d. If you cannot resolve an issue, click the **Create Incident** button in the interaction header. If you cannot fulfill a request from the stockroom, click the more UI actions icon in the interaction header to view more actions. Select **Create Request** from the list to access the Service Catalog.

When you create an associated incident or request through the Service Catalog, a **New Incident** tab or a **New Catalog Item** tab opens next to the **Details** tab of the original interaction. Fill out the new incident form or order assets. Click the **Save** button to save the new incident or complete the order confirmation. You will receive an Request Number for your ordered item.

4. When you are finished resolving the interaction, click the **Close** button in the interaction header.

Closing an interaction affects your capacity because a new interaction will be pushed to your inbox.

**Related information**

- Agent Workspace
- Agent Workspace for ITSM
- Create an incident
- Create a request through a catalog
Manage Walk-up Experience interactions manually

Technicians supporting walk-up locations can manually manage queue requests with several Walk-up Experience interaction-related modules.

**Before you begin**
Role required: sn_walkup.walkup_technician

**About this task**
Manage interactions manually using the Walk-up Experience Technician modules found in the application navigator. To manage automatically assigned interactions from the Agent Workspace inbox, refer to Manage automatically assigned Walk-up Experience interactions.

Walk-up queues support guests in the order that they check into the queue — first come, first served. Technicians supporting the queue can decide who will work the first interaction. As new guests enter the queue and submit interactions, technicians share the workload, assigning queued interactions to themselves.

Certain guests are considered VIPs. The system recognizes this when they check into the queue. An interaction for a VIP shows `true` for **VIP** in the Interactions list. Technicians can move VIP guests to the front of the queue by assisting them first.

View walk-up queue interactions using several Walk-up Experience modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Assigned Walk-ups</td>
<td>Interactions you assign to yourself when you accept an active interaction or that are assigned to you. Agents assign interactions to themselves when they accept a queued interaction. Managers can assign interactions to specific agents. These interactions are in a Work in Progress state. Once assigned, an agent can transfer the interaction to another agent or queue to complete the work, if necessary.</td>
</tr>
<tr>
<td>Open — Unassigned</td>
<td>All open but unassigned interactions associated with your specific walk-up queue location. When a guest checks into a walk-up queue, an interaction is created. The interaction is Queued until an agent accepts it or is assigned the interaction. At that point, the state changes to Work in Progress.</td>
</tr>
<tr>
<td>Closed Walk-ups</td>
<td>All Closed Complete and Closed Abandoned interactions assigned to a specific walk-up location queue. Agents can</td>
</tr>
</tbody>
</table>
Walk-up Experience interaction modules (continued)

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>abandon an interaction when a guest leaves the queue before receiving support.</td>
</tr>
</tbody>
</table>

Procedure

1. To begin supporting a walk-up queue guest, navigate to  > Walk-up Experience > > Technician > Opened - Unassigned. The Interactions list opens.

2. Find the guest name under the Opened for column of the Interactions list.

3. Click the interaction Number associated with the guest. The Walk-up Interaction form opens with details about the issue or request.

4. Enter your name in the Assigned to field on the form, change the State to Work in Progress, and click Update.
   
   a. To close an interaction if the guest has left the queue, click Abandon in the form header or choose Closed Abandoned from the State form field and click Update
   
   b. Alternatively, you can associate the interaction with another record by clicking the Associate Record button in the interaction header.

5. To resolve the interaction, navigate to Walk-up Experience > Technician > My Assigned Walk-ups.

6. Click the interaction number from the list to open the Walk-up Interaction form.

7. Resolve the issue or fulfill the request.
   
   a. Change the interaction status to On Hold if the requester is not present for an appointment or if the interaction entails a lengthy process, for example, an OS upgrade.
   
   b. To view the walk-up location stockroom for fulfillment requests, click the Stockroom Consumables related link.
   
   c. If you cannot resolve the issue or fulfill the request, click either the Create Incident or Create Request related link to create an incident or access the Service Catalog. When you create an associated incident or request through the Service Catalog, the associated related lists on the form populate accordingly. Related lists include the following details:
• Incidents for Interaction: Incidents associated with the interaction
• Requests for Interaction: Service Catalog requests associated with the interaction
• Incidents by Same Caller: Incidents created for a walk-up guest
• Requests by Same Caller: Requests created for a walk-up guest

8. When you are finished resolving the interaction, change the interaction State to Closed Complete and click Update to update the interaction. Alternatively, you can click Close to complete the interaction.

Related information
Use platform view to fulfill a Walk-up Experience request from a stockroom
Create an incident
Create a request through a catalog

View Walk-up Experience location stockroom and assets
Technicians supporting Walk-up Experience locations can view and access stockrooms to provide commonly requested hardware and software assets for walk-up queue guests. Stockroom inventory is defined by asset and inventory managers. Walk-up location agents can monitor inventory and alert asset and inventory managers when additional consumables are needed.

Before you begin
Role required: sn_walkup.walkup_technician

About this task
There are two ways technicians can view associated walk-up location stockrooms. Technicians primarily access Agent Workspace for all Walk-up Experience related information, including stockroom information and assets. However technicians can also access Walk-up Experience in the application navigator, or left navigation bar, to view stockrooms.

Procedure
1. To view walk-up stockrooms using Agent Workspace, navigate to Workspace Experience > Agent Workspace Home.
   The Agent Workspace homepage opens, greeting you with your name.
2. Click List in the left navigation bar.
3. Under Walk-up, click My Stockrooms.
   Walk-up stockrooms associated with your assigned queue are listed.
4. Click the name of your stockroom to view details about the stockroom, such as the physical address, the group assigned to the stockroom, and the available assets (hardware, consumables, and software licenses).

5. Alternatively, to view walk-up locations via the application navigator, navigate to Walk-up Experience > Technician > My Walk-up Stockrooms.

6. Click the name of your stockroom.
The associated stockroom form opens displaying information about the stockroom, such as the physical address, the group assigned to the stockroom, and the available assets (hardware, consumables, and software licenses).

7. In either Agent Workspace or via the application navigator, click any of the list tabs to see available inventory. For example, you can click the Consumables tab to see a list of all available consumables. Inventory list tabs include:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
<td>Cables, connectors, batteries, and more.</td>
</tr>
<tr>
<td>Consumables</td>
<td>Computer monitors, video equipment, tablets, laptops, computer mouse, and more.</td>
</tr>
<tr>
<td>Software Licenses</td>
<td>Available software programs and tools.</td>
</tr>
<tr>
<td>Other Assets</td>
<td>Miscellaneous other assets.</td>
</tr>
</tbody>
</table>

8. Click the name of an available consumable.
The Consumable form opens displaying details about the asset, such as, Quantity (how many are stocked), cost, and Expense Line information.

**Related information**

Use platform view to fulfill a Walk-up Experience request from a stockroom

Walk-up Experience technicians can access an associated stockroom and fulfill user requests directly from an interaction in platform view.

**Before you begin**
Role required: sn_walkup.walkup_technician
About this task
When a walk-up queue guest requests a consumable, such as a computer monitor or keyboard, you can quickly fulfill the request by accessing an associated on-site stockroom. Walk-up guests leave the queue with the requested item in hand.
For details regarding fulfilling a Walk-up Experience request from a stockroom using Agent Workspace, refer to

Procedure

1. Navigate to > Technician > My Assigned Walk-ups.
   The Interaction list opens.

2. Click the interaction Number associated with the request.
   The Walk-up Interaction form opens with details about the request.

3. Click Stockroom Consumables in the Related Links section of the interaction.
   The associated Stockroom list opens displaying all available consumables.

4. Click the requested consumable Display name.
   The Consumable form opens with details about the item.

5. Click the Consume button.
   The Consume pop-up form opens with the name of the consumable and the associated stockroom.

6. Update the form with the Quantity, Asset, and User information.

7. Click OK.
   The Consumable form indicates that an item has been consumed and attached to the specified user.

8. Retrieve the item from the stockroom and provide it to the requester.

9. Return to the interaction in your My Assigned Walk-ups module to change the State to Closed Complete and click Update to update the interaction. Alternatively, you can click Close to complete the interaction.

   If you cannot fulfill the request from the associated stockroom, click the Create Request related link from the interaction form to access the Service Catalog. Refer to Create a request through a catalog to order an item for the requester.

Use Agent Assist to expedite Walk-up Experience fulfillment

Walk-up Experience technicians can use the Agent Assist feature in Agent Workspace to expedite incidents and requests.
Before you begin
Role required: sn_walkup.walkup_technician

About this task
Agent Assist is a contextual search option available in Agent Workspace when a technician creates a new incident or new case associated with a Walk-up Experience interaction.

Procedure
1. To use Agent Assist navigate to Workspace Experience > Agent Workspace Home.
2. Open a walk-up interaction from your inbox or from My Assigned Walk-ups under Lists that you know requires an associated new incident or new case.
3. Click the Create Incident or Create Case button.
   A new incident or case tab opens next to the details tab for the original associated walk-up interaction.
4. Click the agent assist icon to use the feature.
   For more detailed information about Agent Assist and using it to expedite incidents and requests, refer to Using Agent Assist in Agent Workspace and Order a catalog item using Agent Assist.

View and manage Walk-up Experience appointments in Agent Workspace
Viewing upcoming scheduled Walk-up Experience appointments provides technicians with an estimate of future queue demand and workload. Managers can view future appointments and adjust staffing at walk-up queue locations to best support demand.

Before you begin
Role required: sn_walkup.walkup_technician

About this task
Technicians and managers primarily use Agent Workspace for all Walk-up Experience related information, including viewing and managing scheduled appointments.

Note: You can also view and manage scheduled appointments from Walk-up Experience in the application navigator, or left navigation bar.
Appointments are automatically routed to your Agent Workspace inbox based on availability. You can also view a list of scheduled appointments and choose which one to accept.

Upcoming appointments also display with a small calendar icon next to the user name on the onsite walk-up location queue wall monitor. The user with an appointment appears on the monitor a short time before the appointment is scheduled to begin.

Note: Upcoming appointments are also displayed on online check-in screen with the same calendar icon next to the user name.

Procedure

1. Navigate to Workspace Experience > Agent Workspace Home. The Agent Workspace homepage opens, greeting you with your name.
2. Click List in the left navigation bar.
3. Under Walk-up, click Appointments. Walk-up appointments assigned to your queue are listed.
4. Click an appointment number to view details, such as the requester name, the interaction number and description, and the appointment time.
   a. To open the associated interaction to view details, click the open record icon next to the interaction number.
   b. Click Accept appointment to begin working on the interaction. If necessary, you can assign the appointment to another agent and add work notes.
   If a significant amount of time has passed and the requester does not show up for the appointment, you can delete the appointment by clicking the more UI actions icon in the interaction header and choosing Delete.
   c. Click Save to save any changes you make to the appointment interaction.

View and manage Walk-up Experience appointments from application navigator

Viewing upcoming scheduled Walk-up Experience appointments provides technicians with an estimate of future queue demand and workload. Managers can view future appointments and adjust staffing at walk-up queue locations to best support demand.
Before you begin
Role required: sn_walkup.walkup_technician

About this task
Technicians and managers can view and manage scheduled walk-up appointments from Walk-up Experience in the application navigator, or left navigation bar.

Note: Primary access is through Agent Workspace for all Walk-up Experience related information, including scheduled appointments.

Upcoming appointments also display with a small calendar icon next to the user name on the onsite walk-up location queue wall monitor. The user with an appointment appears on the monitor a short time before the appointment is scheduled to begin.

Procedure
1. Navigate to Walk-up Experience > Technician > Scheduled Appointments. all walk-up appointments scheduled for the upcoming 14 days display.
2. Click an appointment number to view details, such as the requester name, the interaction number and description, and the appointment time.
   a. If desired, to preview the associated interaction details, click the preview record icon next to the appointment number.
   b. To begin working on the interaction, click Accept appointment on the Walk-up Appointment form.
      If necessary, you can assign the appointment to an agent and add work notes.
      If a significant amount of time has passed and the requester does not show up for the appointment, you can delete the appointment by clicking delete.
   c. Click Update to save any changes you make to the interaction form.

Walk-up Experience dashboard overview
The Walk-up Experience dashboard and reporting module provides basic high-level reporting on incident and request types, record volume, average wait and service times, assignments by technician and location, and more. By viewing
the dashboard, IT managers can quickly understand the walk-up location operations and can report performance data to upper management.

To view the Walk-up Experience dashboard you must be assigned one of the following roles:

• sn_walkup.walkup_manager
• sn_walkup.walkup_admin
• admin

Access the dashboard by navigating to **Walk-up Experience > Dashboard**. To view detailed information, hover over any report graphic. You can save graphs as PNG or JPEG files to attach to emails or include in reporting presentations. All graphs can be refreshed for the latest data.

<table>
<thead>
<tr>
<th>Dashboard report graphic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed Walk-ups for the Quarter</td>
<td>Total number of records created during the fiscal business quarter. Volume shown as a single score.</td>
</tr>
<tr>
<td>Exit Survey CSAT for this Year</td>
<td>Speedometer showing the average customer satisfaction sentiment (1 to 3) during the exit survey for the current calendar year.</td>
</tr>
<tr>
<td>Overall CSAT within Last Year</td>
<td>Speedometer showing the average customer satisfaction sentiment (1 to 5) captured by the email survey within the last year (364 days from current date).</td>
</tr>
<tr>
<td>Walk-ups by Location within Last Year</td>
<td>Total number of walk-up interactions, by location within the last year (364 days from current date). Volume shown as a spline distributed by month.</td>
</tr>
<tr>
<td>Walk-up Interactions with Incidents by Location within Last Year</td>
<td>Total number of walk-up incidents, by location within the last year (364 days from current date). Volume shown as a spline distributed by month.</td>
</tr>
<tr>
<td>Walk-up Interactions with Requests by Location within Last Year</td>
<td>Total number of walk-up requests, by location within the last year (364 days from current date). Volume shown as a spline distributed by month.</td>
</tr>
</tbody>
</table>
Dashboard report graphic | Description
--- | ---
| **Walk-up Reasons by Location within Last Year** | Reasons for visiting the walk-up queue, by location within the last year (364 days from current date). Data shown as a bar chart. |
| **Walk-ups by Day of the Week** | Total number of walk-up interactions per day during the course of a week, by location. Data shown as a bar chart. |
| **Walk-ups by Hour** | Total number of walk-up interactions, by hour and by location. Data shown as a bar chart. |
| **Walk-up Consumables** | Total number of assets consumed by walk-up guests, by location stockroom. Data shown as a bar chart. |
| **Average Service Time by Location** | Average time it takes to close an interaction, by location. Time average shown as a spline by month. |
| **Average Wait Time by Location** | Average time a walk-up guest waits for service, by location. Data shown as a bar chart. |

For more information about viewing and using dashboards, see Analytics and Reporting Solutions.

**Walk-up Experience on Now® Mobile**

You can create and manage your appointments for a walk-up venue like the Tech Lounge when you use the ServiceNow® Walk-up Experience on the Now® Mobile app on your own mobile device.

With the Now® Mobile app, you can use your mobile device to book appointments, see where you are in a queue, and cancel or modify your appointments for the Tech Lounge. You’ll never miss an appointment again because you’ll get reminders about your upcoming appointments and notifications if your appointment changes.
Book an appointment at a Walk-up Experience Tech Lounge

Book an appointment at a ServiceNow Walk-up Experience Tech Lounge by using the Now Mobile app.

Before you begin
Role required: user

Procedure

1. On your mobile device, tap the Now Mobile app icon ( ).
2. Navigate to the list of available Tech Lounges using any of these options.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Items</td>
<td>Tap the headphones icon ( ).</td>
</tr>
<tr>
<td>Services</td>
<td>Tap the more options icon ( ) &gt; Visit a Tech Lounge.</td>
</tr>
<tr>
<td>Information</td>
<td>Tap the headphones icon ( ).</td>
</tr>
</tbody>
</table>

3. From the list of active Tech Lounges, tap your preferred Tech Lounge.
4. Tap Make Appointment.

! Note: The option to book a slot in advance is not available in all Tech Lounges. If the Maximum future bookable day field doesn't appear in the Tech Lounge details view, you can't book a slot in advance in that particular Tech Lounge.

5. On the form, fill in the fields.

Make Appointment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason</td>
<td>Reason for your visit.</td>
</tr>
<tr>
<td>Date</td>
<td>Preferred date for the visit.</td>
</tr>
<tr>
<td>Time slot</td>
<td>Preferred time slot for your visit.</td>
</tr>
</tbody>
</table>
If you select a date when the Tech Lounge is closed or is not available for appointments, the time slot doesn’t appear. Select a different date and time slot.

6. Tap Submit.
   Your appointment confirmation is displayed on the screen.

7. Optional: Tap OPEN on your appointment to view the details.
   Another way to view your appointment confirmation is to return to the Tech Lounge list view and tap the Visits tab, or return to the Now® Mobile app home page and tap My Tech Visits.

Modify an appointment at the Walk-up Experience Tech Lounge

Edit or cancel an appointment at a ServiceNow Walk-up Experience Tech Lounge by using the Now® Mobile app on your mobile device.

Before you begin
Role required: user

About this task
The time limit for modifying an appointment may vary across Tech Lounges. You can’t modify a confirmed appointment within the time limit that was set for the particular Tech Lounge. For example, let’s say a Tech Lounge has set this time limit as two hours. So, if your appointment is at 10 a.m., you can’t modify it after 8 a.m. of the same day.

Procedure

1. On your mobile device, tap the Now® Mobile app icon.
2. Navigate to your appointment card using any of these options.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Items</td>
<td>Tap My Tech Visits</td>
</tr>
<tr>
<td>Services</td>
<td>Tap the more options icon &gt;</td>
</tr>
<tr>
<td></td>
<td>Visit a Tech Lounge &gt; Visits.</td>
</tr>
<tr>
<td>Information</td>
<td>Tap the headphones icon &gt;</td>
</tr>
<tr>
<td></td>
<td>Visits</td>
</tr>
</tbody>
</table>
3. Tap the appointment card to open it.
4. Choose either of the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Change the date or time of the appointment.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancel the appointment.</td>
</tr>
</tbody>
</table>

You can also swipe the appointment card and tap your preferred action to modify the appointment.

**Join a queue at the Walk-up Experience Tech Lounge**

Join a queue at a ServiceNow Walk-up Experience Tech Lounge by using the Now® Mobile app for immediate assistance with an issue.

**Before you begin**

Role required: user

**Procedure**

1. On your mobile device, tap the Now® Mobile app icon ( ).
2. Navigate to the list of available Tech Lounges using any of these options.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Items</td>
<td>Tap the headphones icon ( ).</td>
</tr>
<tr>
<td>Services</td>
<td>Tap the more options icon ( ) &gt; Visit a Tech Lounge.</td>
</tr>
<tr>
<td>Information</td>
<td>Tap the headphones icon ( ).</td>
</tr>
</tbody>
</table>
3. From the list of active Tech Lounges, tap your preferred Tech Lounge.
4. Tap Join Queue.
5. On the form, fill in the fields.

Join Queue form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason</td>
<td>Reason for your visit.</td>
</tr>
<tr>
<td>Description</td>
<td>Brief description of the problem.</td>
</tr>
</tbody>
</table>

6. Tap Submit.
Your visit details and position in the queue are displayed on the screen.

Leave a queue at the Walk-up Experience Tech Lounge
Leave a ServiceNow Walk-up Experience Tech Lounge queue at any time by using the Now® Mobile app on your mobile device.

Before you begin
Role required: user

Procedure

1. On your mobile device, tap the Now® Mobile app icon ( ).
3. Navigate to your Queue card using one of these options.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Items</td>
<td>Tap My Tech Visits</td>
</tr>
<tr>
<td>Services</td>
<td>Tap the more options icon ( ) &gt; Visit a Tech Lounge &gt; Visits</td>
</tr>
<tr>
<td>Information</td>
<td>Tap the headphones icon ( ) &gt; Visits</td>
</tr>
</tbody>
</table>
4. Tap your visit card to open it.

5. Tap Leave queue.
   You can also swipe your visit card and tap Leave queue.

**Configure day-level appointment booking**

Create or modify different schedules at a day level when booking appointments for a service. The appointments can be scheduled for different slots such as morning, afternoon, and evening.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to Appointment Booking > Appointment Booking Configuration.
2. Click Walk-up Experience.
3. In the Appointment Booking Service Configuration related list, click a service configuration for which you want to configure the appointment schedules.
4. Select Enable day level configuration.
5. In the Appointment Booking Day Configuration related list, click New.
6. On the form, fill in the fields.

**Appointment Booking Day Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the day level configuration, such as Morning, Afternoon, or Evening</td>
</tr>
<tr>
<td>Active</td>
<td>Option to indicate if the appointment slot is active or not.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date of the appointment booking window</td>
</tr>
<tr>
<td>End date</td>
<td>End date of the appointment booking window</td>
</tr>
<tr>
<td>Daily start time</td>
<td>Start of the work day and the earliest start time for an appointment window.</td>
</tr>
<tr>
<td>Daily end time</td>
<td>End of the work day and the latest end time for an appointment window.</td>
</tr>
<tr>
<td>Service configuration</td>
<td>Name of the service configuration for which you are scheduling configurations at a day level, such as Point-of-Sale Installation.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Work duration</td>
<td>Time required to complete all tasks created by the record producer. This duration is set for a task when it is created. Used to determine availability. The default is 1 hour.</td>
</tr>
<tr>
<td>Travel duration (round trip)</td>
<td>Estimated value of the average travel time required (round trip) for the agent performing the task. Used to determine availability. The default is 15 minutes.</td>
</tr>
<tr>
<td>Appointment window</td>
<td>Duration of the appointment window. <strong>Note:</strong> Allow enough time for the work to be started and completed within this window.</td>
</tr>
<tr>
<td>Appointments per window</td>
<td>Number of available appointments for each configured appointment time slot. This number determines the number of available appointments that are displayed on the Select Appointment window. Enter a number in this field if the assignment method for tasks is set to <strong>manually</strong>. If set to either using auto-assignment or using dynamic scheduling, this setting does not apply, unless a location is not provided. Then the configuration defaults to the number of appointments per window.</td>
</tr>
<tr>
<td>Include daily break</td>
<td>Option to schedule a break for each bookable day. Set the break start and end times. You can also define one break which applies to all days.</td>
</tr>
<tr>
<td>Appointment booking preview</td>
<td>Provides a preview of the appointment windows and times based on the selected start and end times, break time, and appointment window.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

**ITSM Agent Workspace**

Improve your ITSM agent experience and manage your IT fulfillment volume more efficiently using ITSM Agent Workspace. The easy-to-navigate, multi-tab interface enables you to efficiently oversee and resolve multiple incidents, problems, and change requests.

**ITSM Agent Workspace in action**

Here’s how IT agents use ITSM Agent Workspace.

Overview of ITSM agent workspace
Key features

Data in unified location

Interact with your requesters, respond to inquiries, and resolve incidents, problem, and change tasks using ITSM Agent Workspace.

Single-pane view

See all details related to an incident, problem, or change task in one place.

Agent assistance

Efficiently and quickly resolve tickets with AI-assisted recommendations.
Get started
Select a tile to get started.

1. **Agents and system administrators** go here to learn about Workspace.

1. **System administrators** go here to set up Workspace.

1. **Agents** go here to learn how to use Workspace.

### Exploring ITSM Agent Workspace

Get an overview of ITSM Agent Workspace and how it works.

### Features

Manage multiple incident, problem, and change records using these ITSM Agent Workspace features.
<table>
<thead>
<tr>
<th>Number</th>
<th>ITSM Agent Workspace feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1      | Multi-tab interface         | Tabs to easily navigate between multiple open records.  
  - Incident records open in top-level tabs.  
  - Associated records, such as problem and change, open in sub-tabs below the Incident tab. |
| 2      | Form header                 | Configurable fields in the form header to give you a quick summary of incident, problem, or change records. |
| 3      | Form fields                 | Detailed view of the form fields from the Details related list. |
| 4      | Activity stream             | Activity stream to display a chronological record of activities. The activity stream occupies a central location in the default layout, making it easy for...
(continued)

<table>
<thead>
<tr>
<th>Number</th>
<th>ITSM Agent Workspace feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>agents to scroll through the record history.</td>
</tr>
<tr>
<td>5</td>
<td>Agent Assist</td>
<td>List of information across multiple sources such as open incidents, problem, and change records. With Predictive Intelligence, agents can also view similar task records.</td>
</tr>
</tbody>
</table>

**Components installed with ITSM Agent Workspace**

Several types of components are installed with activation of the ITSM Workspace (com.snc.agent_workspace.itsm) plugin, including user roles.

![Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.]

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workspace agent [agent_workspace_user]</td>
<td>The Workspace agent role (agent_workspace_user) is added to the ITIL role. The role is required to access ITSM Agent Workspace.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Tables**

ITSM Agent Workspace provides the Workspace view for the following tables:

- Incident [incident]
- Problem [problem]
- Change [change]
- Problem Tasks [problem_task]
- Change Tasks [change_task]
- Affected CIs [task_ci]
• Impacted Services/CIs [task_cmdb_ci_service]
• Task SLA [task_sla]
• Outages [task_outage]
• Approvals [sysapproval_approver]

Viewing incident details and your incident tasks in ITSM Agent Workspace - Standard landing page

On the ITSM Agent Workspace standard landing page, you can view incident reports that provide information such as the number of open priority 1 incidents, incidents for which SLA is not met, or incidents that are in the verge of breaching the SLA, and any unassigned incidents in the system. You can also view all the tasks that are assigned to you.

The ITSM Workspace plugin (com.snc.agent_workspace.itsm) activates the ITSM Workspace Landing Pages (com.snc.agent_workspace.itsm.landing_page) plugin that delivers the basic version of ITSM Agent Workspace landing page.

To see the list of incidents for a queue, click a tile in the Happening Now section. To view the details of an incident, click the incident number. The My Work section contains the list of all the tasks that are assigned to you.

ITSM Agent Workspace landing page

Monitor the work assigned to you and the overall performance of incident resolution using Workforce Optimization for ITSM Agent Workspace.
Home tab

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>As a workspace agent, you can:</td>
<td>sn_incident_read, sn_incident_write, itil.</td>
</tr>
<tr>
<td>• Analyze the incidents you are currently working on or incidents that have not yet been assigned.</td>
<td></td>
</tr>
<tr>
<td>• Monitor incidents with SLAs that have been breached or at risk, open P1 incidents, or the ones not been updated in 24 hours.</td>
<td></td>
</tr>
<tr>
<td>• Track the mean time to resolution, first call resolution, and customer satisfaction to analyze the performance of incident resolution.</td>
<td></td>
</tr>
</tbody>
</table>

Use case

Monitor your work when you start your day, view reports that need your attention, and navigate to the incidents on which you want to take action.

Indicators

Mean time to resolution
The average time taken to resolve incidents.

**First call resolution**
Number of incidents resolved the first time it was handled by an agent.

**Customer satisfaction**
Overall customer satisfaction on incident resolution.

**My incidents**
A list of incidents that you manage.

**Unassigned incidents**
A list of incidents that has not been assigned.

**Breakdowns**
- Priority
- Category
- Assignment Group
- Assigned To

**Reports**

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open P1 Incidents</td>
<td>Single score</td>
<td>Number of open incidents with top priority.</td>
</tr>
<tr>
<td><a href="42">42</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Incidents not updated in 24 hours</td>
<td>Single score ( <a href="42">42</a> )</td>
<td>Number of incidents that have not been updated in the last 24 hours.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Incident SLAs Breached</td>
<td>Single score</td>
<td>Number of incidents with SLAs that have been breached.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="42" /></td>
</tr>
<tr>
<td>Incident SLAs at Risk</td>
<td>Single score</td>
<td>Number of incidents with SLAs that are at risk.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="42" /></td>
</tr>
</tbody>
</table>

### Setting up ITSM Agent Workspace

Set up ITSM Agent Workspace for your agents so they can engage with customers, answer questions, create task records, and resolve issues.

The ITSM Workspace (com.snc.agent_workspace.itsm) plugin provides you with the functionality of ITSM Agent Workspace. The plugin is available by default for new and existing customers.

### Activate ITSM Workspace Landing Pages – Premium

You can activate the ITSM Workspace Landing Pages – Premium plugin (com.snc.agent_workspace.itsm.landing_page_premium) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: agent_workspace_user or admin

**About this task**

The ITSM Workspace Landing Pages – Premium plugin (com.snc.agent_workspace.itsm.landing_page_premium) activates the related plugin if it is not already active.

### Plugins for ITSM Workspace Landing Pages – Premium

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Workspace</td>
<td>Provides a suite of tools that provide agents, case managers, help desk</td>
</tr>
<tr>
<td>[com.agent_workspace]</td>
<td></td>
</tr>
</tbody>
</table>
Plugins for ITSM Workspace Landing Pages – Premium (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>professionals, and managers with tools to help answer customer questions or resolve customer problems.</td>
</tr>
<tr>
<td></td>
<td>Note: The Agent Workspace plugin activates the ITSM Workspace Landing Pages plugin (com.snc.agent_workspace.itsm.landing_page) that delivers the standard landing page for ITSM Agent Workspace.</td>
</tr>
<tr>
<td>Performance Analytics – Content Pack – ITSM Dashboards</td>
<td>Activation of this plugin on production instances may require a separate Performance Analytics license.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Related information**

  List of plugins (New York)

**Set the default landing page**

You can set a default landing page to surface the information that is most relevant for your agents.

**Before you begin**

Role required: agent_workspace_user or admin
Procedure

1. Navigate to Workspace Experience > Administration > All Workspaces.
2. Click Agent Workspace.
3. In the Landing Pages related list, set the value of the Order field of the landing page that you want to set as the default to minimum.

   Note: The landing page with the minimum order value is considered to be the default landing page.
4. Optional: Verify the default landing page assignment by navigating to Workspace Experience > Workspaces > Agent Workspace Home. The default landing page opens.

Add field or related list to a workspace form

You can quickly add fields or related lists to a workspace form by configuring form layout or related lists from Platform.

Before you begin
Role required: agent_workspace_user or admin

About this task
3. Open an incident record.

4. **Optional:** Click the settings icon (⚙️) and under System Settings, click Developer.

5. From the Application list, select ITSM Landing Pages or ITSM Landing Pages Premium depending on which form layout you want to update and close the window.

6. Perform any of the following actions:

<table>
<thead>
<tr>
<th>What do you want to do?</th>
<th>How do you do it?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add field</td>
<td>Click the additional actions icon and select <strong>Configure &gt; Form Layout.</strong></td>
</tr>
<tr>
<td>Add related list</td>
<td>Click the additional actions icon and select <strong>Configure &gt; Related Lists.</strong></td>
</tr>
</tbody>
</table>

7. Move the required fields and related lists from the **Available** box to the **Selected** box.

8. Click **Save**.

**Create an interaction record in ITSM Agent Workspace**

Create an interaction record when you communicate with the user if you are not clear on the user requirements. You can create an incident or a request later from the interaction based on the use case.

**Before you begin**
Role required: workspace_agent or admin
About this task

- On clicking **Create Incident** from the Interaction record form, a new unsaved Incident opens that has the value of the caller and the short description copied from the Interaction record.

- On clicking **Create Problem** from the Interaction record form, a new unsaved Problem opens that has the value of the **Problem statement** copied from the Short description of the Interaction record. The **Allow Problem creation from Interaction** (`glide.problem.interaction.allow_create`) problem property available at Problems > Administration > Problem Properties determines whether the **Create Problem** option is shown on the Interaction form.

- On clicking the **Create Standard Change**, you are directed to the New Catalog Item page. Select **Standard Change** from the menu.

- On clicking **Create Request**, you are directed to the New Catalog Item page from where you can create a new catalog request.

Procedure

1. Navigate to **Agent Workspace > Agent Workspace Home**.

2. Click the plus icon (➕) to open a new tab. The New Interaction page appears.

3. On the form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Auto-generated]. Unique number to identify the interaction record.</td>
</tr>
<tr>
<td>Type</td>
<td>The communication channel using which the agent interacted with the user.</td>
</tr>
<tr>
<td>State</td>
<td>Different states through which the interaction proceeds for a resolution.</td>
</tr>
<tr>
<td>Opened for</td>
<td>The agent for whom the interaction is created.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The agent to work on the interaction.</td>
</tr>
<tr>
<td>Wait time</td>
<td>The duration from creation of the interaction to the time it is assigned to an agent.</td>
</tr>
</tbody>
</table>
4. Click Save.

An interaction record is created. The User's Calls and the User's Task related list are available on the Interaction form.

- **User's Calls**: The User's Calls related list displays historical calls between a requester and Service Desk agents. This feature is available to the users who have the Service Desk Call plugin (com.snc.service_desk_call) already activated.

  - **Note**: From the Orlando release, the Service Desk Call plugin (com.snc.service_desk_call) requires a separate subscription and must be activated by a ServiceNow personnel. Users with the admin role can no longer activate the plugin.

The customer name in the **Opened for** field in Interaction is matched with the **Caller** field in Service Desk calls and records are retrieved based on the number of days mentioned in the interaction property **Number of days (integer)** for which past user call records are retrieved. The default value is seven (7). A setting of zero (0) disables this feature.

  `(glide.new_call.interaction.records_age)`.

- **User's Task**: When a requester contacts an agent through chat, phone call, request, or walk-in, the User's Task related list shows the agent all of the other tasks (incident, problem, change request, request, and so on) that have been created for the requester. For example, if a requester calls about the status of a request that was made the previous day, the User's Task related list shows the request. Workspace includes the other tasks in the User's Task related list when the value for the **Opened for** field in the interaction record matches the:
  - **Caller** field in an incident record
  - **Opened by** field in a problem record
  - **Requested by** field in a change record
  - **Requested for** field in a Service Catalog record

### Create an outage from a task record in ITSM Agent Workspace

You can create an outage from a task record such as incident, problem, or change, to track the down time of a configuration item.
Before you begin
Role required: agent_workspace_user or admin

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. Navigate to the task record type from which you want to create an outage.

<table>
<thead>
<tr>
<th>Task record</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>Click Incidents &gt; Open.</td>
</tr>
<tr>
<td>Problem</td>
<td>Click Problems &gt; Open.</td>
</tr>
<tr>
<td>Change</td>
<td>Click Change &gt; Open.</td>
</tr>
</tbody>
</table>

3. Open the task record from which you want to create an outage.
4. Click the more actions icon (… ) and then click Create Outage.
5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique number that identifies the outage.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the outage applies to.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the outage such as Degradation, Outage, and Planned Outage.</td>
</tr>
<tr>
<td>Begin</td>
<td>Date and time when the outage starts. To enter the current date and time, click the Begin Outage Now related link.</td>
</tr>
<tr>
<td>End</td>
<td>Date and time when the outage ends. When the outage ends, open the record and enter the date and time manually. To enter the current date and time, click the End Outage Now related link.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Duration of the outage in days and hours.</td>
</tr>
<tr>
<td>Task number</td>
<td>Parent task record number from which you have created the outage.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the outage.</td>
</tr>
</tbody>
</table>

6. **Optional:** If you want to attach a supporting document, click the attachment icon (_files) and select the file.

7. **Click Save.**

### Using ITSM Agent Workspace

Use ITSM Agent Workspace to interact with customers, create and work on task records, and resolve issues.

### ITSM Agent Workspace - Incident

The Incident workspace form is similar to the default platform Incident form.

If you want to change the view of the incident workspace form, customize the workspace view from the Incident form. For details, see Add field or related list to a workspace form.

#### Overview of ITSM Agent Workspace

![ITSM Agent Workspace — Incident](attachment:image.png)
Create an incident in ITSM Agent Workspace

You can create an incident record to document a deviation from an expected standard of operation.

Before you begin
Role required: agent_workspace_user or admin

About this task
Incident records enable you to track the investigation, possible solutions, and resolution of a problem for a customer. If resolving the incident involves creating a problem, change, or service request, you can create the record directly from the incident record.

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the navigation list, click Incidents > Open.
3. Click New.
4. On the form, fill in the fields.

Incident form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Auto-generated]. Unique number to identify the incident record.</td>
</tr>
<tr>
<td>Caller</td>
<td>User who contacted you with an issue. Begin typing the first name of the caller to select from a list of matching names, or click the lookup icon (🔍) and select the user.</td>
</tr>
<tr>
<td>Category</td>
<td>Type of issue. After selecting a category, you can select a subcategory if applicable.</td>
</tr>
<tr>
<td>Subcategory</td>
<td>Subdivision of the category.</td>
</tr>
<tr>
<td>Service</td>
<td>Business service that is affected.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing,</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item that is affected.</td>
</tr>
<tr>
<td>Contact type</td>
<td>Mode of communication taken by the user to create the incident.</td>
</tr>
<tr>
<td>State</td>
<td>Different states through which the incident proceeds during its life cycle.</td>
</tr>
<tr>
<td>Impact</td>
<td>The effect of an incident, problem, or change on the business processes.</td>
</tr>
<tr>
<td>Urgency</td>
<td>How long the resolution can be delayed until an incident, problem, or change has a significant business impact.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the task. Priority is based on impact and urgency.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to work on this incident. If you do not provide a value, the incident is automatically assigned. You can populate the <strong>Assignment group</strong> field automatically based on the support group available for the respective configuration item (CI). If the CI does not have any support group, then the field gets populated with the support group available for service offerings. The business rule <strong>Populate Assignment Group based on CI/SO</strong> triggers the functionality when an incident, problem, or change request is created or updated and when the <strong>Assignment group</strong> and the <strong>Assigned to</strong> field is empty. The following properties identify the field whose</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>value populates the <strong>Assignment group</strong> field:</td>
<td></td>
</tr>
</tbody>
</table>
• com.snc.incident.ci_assignment_group.field_name  
This incident property identifies which CI field populates the **Assignment group** field.  
• com.snc.incident.service_offering_assignment_group.field_name  
This incident property identifies which service offering field populates the **Assignment group** field.  
  
**Note:** The default value for the properties is support group for incident or problem and change group for change request respectively. The business rule **Populate Assignment Group based on CI/SO** is shipped as part of the development plugin ITSM CSDM Best Practice – Quebec plugin (com.snc.best_practice.itsm_csdm.quebec) and is available only for the new customers. |
| Assigned to                                | The user to work on this incident.  
  
**Note:** If the **Assignment group** changes, the **Assigned to** field is cleared. |
<p>| Short description                          | Brief description of the incident.                                                                                                                                                                                                                                                                                                                                                                                                                                      |
| Description                                | Detailed explanation of the incident.                                                                                                                                                                                                                                                                                                                                                                                                                                   |
| Notes                                      |                                                                                                                                                                                                                                                                                                                                                                                                                                                                       |
| Watch list                                | Users who receive notifications about the incident when comments are added.                                                                                                                                                                                                                                                                                                                                                                                                   |
| Work notes list                           | Users who receive notifications about the incident when work notes are added.                                                                                                                                                                                                                                                                                                                                                                                                  |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> The administrator must create an email notification for the work notes list.</td>
</tr>
<tr>
<td>Additional comments (Customer</td>
<td>More information about the issue as needed. All users who can view incidents can also see additional comments.</td>
</tr>
<tr>
<td>visible)</td>
<td></td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve the incident or steps taken to resolve it, if applicable.</td>
</tr>
<tr>
<td>Related Records</td>
<td></td>
</tr>
<tr>
<td>Parent Incident</td>
<td>Associated parent incident that makes the current incident a child incident.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When the parent incident is resolved, the child incident is also marked as resolved.</td>
</tr>
<tr>
<td>Problem</td>
<td>Any related problem record.</td>
</tr>
<tr>
<td>Change Request</td>
<td>Any related change request.</td>
</tr>
<tr>
<td>Caused by Change</td>
<td>Associated change request that prompted the creation of the incident.</td>
</tr>
<tr>
<td>Resolution Information</td>
<td></td>
</tr>
<tr>
<td>Knowledge</td>
<td>Option for enabling a knowledge article to be created from this incident when the incident is closed.</td>
</tr>
</tbody>
</table>
Create an incident from an interaction

Create an incident record directly from an interaction when the customer reports events that result in interruption of one or more services.

Before you begin
Role required: agent_workspace_user or admin

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. Create an interaction record. For more information, see Create an interaction record in ITSM Agent Workspace.
3. On the interaction page, click Create Incident.
4. On the form, fill the fields.

Incident form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto-generated unique number to identify the incident record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Caller</td>
<td>User who contacted you with an issue. Begin typing the first name of the caller to select from a list of matching names, or click the lookup icon (🔍) and select the user.</td>
</tr>
<tr>
<td>Category</td>
<td>Type of issue. After selecting a category, you can select a subcategory if applicable.</td>
</tr>
<tr>
<td>Subcategory</td>
<td>Subdivision of the category.</td>
</tr>
<tr>
<td>Service</td>
<td>Business service that is affected.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item that is affected.</td>
</tr>
<tr>
<td>Contact type</td>
<td>Mode of communication taken by the user to create the incident.</td>
</tr>
<tr>
<td>State</td>
<td>Different states through which the incident proceeds during its life cycle.</td>
</tr>
<tr>
<td>Impact</td>
<td>The effect of an incident, problem, or change on the business processes.</td>
</tr>
<tr>
<td>Urgency</td>
<td>How long the resolution can be delayed until an incident, problem, or change has a significant business impact.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the task. Priority is based on impact and urgency.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to work on this incident. If you do not provide a value, the incident will be assigned automatically.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field description</td>
<td>is automatically assigned based on assignment rules.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user to work on this incident.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the <strong>Assignment group</strong> changes, the <strong>Assigned to</strong> field is cleared.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the incident.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed explanation of the incident.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Watch list</td>
<td>Users who receive notifications about the incident when comments are added.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notifications about the incident when work notes are added.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The administrator must create an email notification for the work notes list.</td>
</tr>
<tr>
<td>Additional comments (Customer visible)</td>
<td>More information about the issue as needed. All users who can view incidents can also see additional comments.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve the incident or steps taken to resolve it, if applicable.</td>
</tr>
<tr>
<td>Related Records</td>
<td></td>
</tr>
<tr>
<td>Parent Incident</td>
<td>Associated parent incident that makes the current incident a child incident.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When the parent incident is resolved, the child incident is also marked as resolved.</td>
</tr>
<tr>
<td>Problem</td>
<td>Any related problem record.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Request</td>
<td>Any related change request.</td>
</tr>
<tr>
<td>Caused by Change</td>
<td>Associated change request that prompted the creation of the incident.</td>
</tr>
<tr>
<td>Resolution Information</td>
<td></td>
</tr>
<tr>
<td>Knowledge</td>
<td>Option for enabling a knowledge article to be created from this incident when the incident is closed.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge), the check box is disabled and the Create Knowledge UI is available by clicking the more actions icon (⋯).</td>
</tr>
<tr>
<td>Resolution code</td>
<td>The resolution code for the incident.</td>
</tr>
<tr>
<td>Resolution notes</td>
<td>How or why the incident was closed.</td>
</tr>
<tr>
<td>Resolved by</td>
<td>User who resolved the issue.</td>
</tr>
<tr>
<td>Resolved</td>
<td>Date and time when the incident was resolved.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

An incident is created and the interaction appears in the Interactions related list.

### Create an incident from a chat

With ITSM Agent Workspace, you can accept and respond to customer chat requests and create incidents as needed.

**Before you begin**

Role required: agent_workspace_user or admin

**About this task**

Chat with customers and find out more about their issues. Jot down notes about both the customer and the issue in an interaction form. If it’s an easy fix, solve the
issue directly from the interaction. If the issue requires more investigation, create an incident and assign it to an agent.

**Workflow: Create an incident from a chat**

**Procedure**

1. Set your presence status so that you're ready to accept chats.
   
   From your inbox, click **Status** and select **Available**.

2. Accept a chat from your inbox and respond to the customer.
   
   Click **Accept** on the chat card, review the information in the Active Chat panel, and type your response.

3. Ask questions and find out more about the issue.

4. Add information about the customer and issue to the interaction record.

5. Create an incident for this issue.
   
   Click **Create Incident** on the Interaction form to open a new incident with the details from the interaction.

**What to do next**

**Resolve an incident using knowledge**

**Resolve an incident using knowledge**

Resolve an incident by searching for related knowledge and attaching a knowledge article.
**Before you begin**
Role required: agent_workspace_user or admin

**About this task**
When you are ready to work on an incident, select an incident from a list or from your inbox. Read the details in the activity stream to get an understanding of the issue. Use Agent Assist to search for related knowledge, select and preview an article, and then attach it to the incident.

**Workflow: Resolve an incident using knowledge**

---

**Procedure**

1. Open an incident from a list or from your inbox.
2. Review the incident details in the activity stream.
3. Use Agent Assist to search for related knowledge.
4. Select and preview an article.
5. Click **Attach** and then **Attach Article** to attach the article to the incident.

   The system attaches the knowledge article to the incident and adds the action to the activity stream.

   From the ITSM Service Portal, the customer can see the knowledge article attached to the incident and can click the link to open the article in a new tab. If the article solves the issue, the customer can click **Close Incident** in the Actions widget.
Create a knowledge article from an incident

Create a knowledge article from an incident in ITSM Agent Workspace and capture the detailed information used to resolve an issue. Use the knowledge article for quick resolution of similar incidents.

Before you begin
Role required: agent_workspace_user or admin
Activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge).

About this task
You can create a knowledge article only when the incident is resolved and a knowledge article has not yet been created from the incident.

Workflow: Create knowledge article from an incident

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Incidents > Resolved.
3. Open the incident record from which you want to create a knowledge article.
4. Click the more actions icon (…) and then click Create Knowledge.
5. On the form, fill in the fields.
**Note:** If the KCS Integration for Incident Management (com.snc.incident.knowledge) plugin is active, then the fields listed in the CSM Table Map (csm_table_map) table are copied from the incident. If the plugin is not active, then the incident number from the parent incident is copied to the **Parent** field of the knowledge gap feedback task and the text from the **Short Description** is copied to the **Description** field.

### Incident KCS Article form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Auto-generated] Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Knowledge base in which the article is stored. The Incident KCS Article is stored in the [kb_template_incident_kcs_article] table.</td>
</tr>
<tr>
<td>Category</td>
<td>[Auto-generated] Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date after which the knowledge article is deleted from the database. After this date, the article does not appear in the search result.</td>
</tr>
<tr>
<td>Version</td>
<td>[Auto-generated] Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Workflow</td>
<td>[Auto-generated] Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Source Task</td>
<td>[Auto-generated] Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Option to automatically download an attached article instead of opening the article, when you access an article.</td>
</tr>
<tr>
<td>Display attachments</td>
<td>Option to display attachments in the knowledge article. The attachments appear below the article text.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Brief description of the knowledge article.</td>
</tr>
<tr>
<td>Issue</td>
<td>Information on the cause of the incident.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Method used to resolve the incident.</td>
</tr>
</tbody>
</table>

6. **Optional:** If you want to attach a supporting document, click the attachment icon (_attach) and select the file.

7. **Click Save.** A knowledge article is created. The article record is listed in the Created Knowledge related list on the Incident form.

### Report a knowledge gap from an incident
Report a knowledge gap when you do not find any appropriate resolution documented for an incident. The knowledge gap record helps the team know to create a knowledge article for the incident.

**Before you begin**
Role required: agent_workspace_user or admin

**About this task**
If the KCS Integration for Incident Management (com.snc.incident.knowledge) plugin is active, then the fields to be copied from an Incident to the knowledge gap feedback task are maintained in the CSM Table Map (csm_table_map) table. If the plugin is not active, the incident number from the parent incident is copied to the **Parent** field of the knowledge gap feedback task and the text from the **Short Description** is copied to the **Description** field.

**Note:** Incident managers with the sn_km_ml.knowledge_curation_user role can use the Demand Insights for Incidents dashboard to identify which incidents have no or insufficient knowledge coverage. For more information, refer Demand Insights for Incidents dashboard.
Workflow: Report knowledge gap from an incident

Procedure
1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. Open an incident record from which you want to create a record to report a knowledge gap.
3. Click the more actions icon (⋯) and then click **Report Knowledge Gap**. A knowledge gap feedback task record is created in a sub-tab.
4. On the form, fill in the fields.
5. Click **Save**. The knowledge gap feedback task is saved and added to the Knowledge Gaps related list.

Capture information on affected configuration items in **ITSM Agent Workspace**

Capture information on affected configuration items (CIs), with type as asset, in an incident to keep a record of the updated, repaired, swapped, or retired configuration items. By keeping track of the assets, you can tell where the assets are located, how they are used, and when changes were made to them. This information helps you to monitor and manage your company using a systematic approach.

**Before you begin**
Role required: itil or admin

Activate the Hardware Asset Management Professional plugin (com.sn_hamp).
About this task
If you are not the caller of the incident and have a CI value in the affected CIs list, it is mandatory to provide information on the CI before changing the state of the incident to Resolved.

You can enter CI information either from the Affected CIs related list. You need to manually add the Asset Action and the Swapped CI fields in the related list. To know how to add related lists, refer Add field or related list to a workspace form.

Procedure
1. Navigate to Incident > Open.
2. Open an incident.
3. Navigate to the Affected CIs related list before resolving the incident.
4. Open the affected CI.
5. On the form, fill in the fields.

Information on CIs Affected form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Action</td>
<td>Information on whether a CI is updated or repaired, swapped with another CI, or retired from the system. The options available are: No action, Update/Repair, Swap, and Retire.</td>
</tr>
<tr>
<td></td>
<td>Note: If you swap or retire a CI, the sn_hamp_asset.swap or sn_hamp_asset.retire events are generated respectively.</td>
</tr>
<tr>
<td>Swapped CI</td>
<td>Information on the new CI that is swapped with the existing CI.</td>
</tr>
<tr>
<td></td>
<td>Note: · This field appears only when you select the value of the Asset Action field as Swap. · The CI values available for swapped CI are the ones with asset CI class as hardware.</td>
</tr>
</tbody>
</table>
6. Click **Save**.
   The record is saved and the information about CI is stored in the [task_ci] table.

**Create a copy of an incident in ITSM Agent Workspace**

Create a copy of an incident to avoid having to manually enter the value of all the fields in the new incident.

**Before you begin**

Role required: agent_workspace_user or admin

**About this task**

Users with the agent_workspace_user role can copy any incident but users without any role can copy only the incidents that they created. Fields and related lists are copied from the parent incident to the new incident based on the incident property settings.

**Note:** Affected CIs (task_ci) and Impacted Services (task_cmdb_ci_service) are available by default in the related list. You cannot add any other table in this field but you can remove any of the default values.

**Procedure**

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. From the list, click **Incidents > Open**.
3. Open the incident record that you want to copy.
4. Click the more actions icon (····) and select **Copy Incident**.
5. In the Copy Incident dialog box, enter the name of the caller for whom you are creating the copied incident.
6. Click **OK**.
   A new incident is created and saved. The following message appears in the activity stream:
   - This incident is copied from INCXXXXXXX.

**Propose an incident to be a major incident from a workspace**

Proposing an incident as a major incident sends the request to the major incident manager to analyze the incident and accept or reject it as a major incident. Major incidents have a separate procedure with shorter timescales.
and urgency that is required to accelerate resolution process for incidents with high business impact.

**Before you begin**  
Role required: agent_workspace_user or admin

**Procedure**

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. In the menu, click **Incidents > Open**.
3. Open the incident record that you want to propose as a major incident.
4. Click the more actions icon (⋯) and then click **Propose Major Incident**.
5. In the Work notes field in the Propose Major Incident dialog box, provide information about the business impact that supports classifying this incident as a major incident and click **Propose**. The major incident state changes to **Proposed** and the message **INCXXXXXXX has been proposed as a major incident candidate** is displayed.

**Report a knowledge gap from an incident**

Report a knowledge gap when you do not find any documented appropriate resolution documented for an incident. The knowledge gap record helps the team know to create a knowledge article for the incident.

**Before you begin**  
Role required: agent_workspace_user or admin

**About this task**

If the KCS Integration for Incident Management (com.snc.incident.knowledge) plugin is active, then the fields to be copied from an Incident to the knowledge gap feedback task are maintained in the CSM Table Map (csm_table_map) table. If the plugin is not active, the incident number from the parent incident is copied to the **Parent** field of the knowledge gap feedback task and the text from the **Short Description** is copied to the **Description** field.

**Procedure**

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. From the list, click **Incidents > Open**.
3. Open the incident record from which you want to create a record to report a knowledge gap.
4. Click the more actions icon (⋮) and then click Report Knowledge Gap. A knowledge gap feedback task record is created in a sub-tab.

5. On the form, fill in the fields.

6. Click Save. The knowledge gap feedback task is saved and added to the Knowledge Gaps related list.

Refresh impacted services and CIs

The impacted services and CIs related list in ITSM Agent Workspace refreshes its records based on the affected CIs. Identify the impacted services and CIs and take necessary action.

Before you begin
Role required: itil, agent_workspace_user or admin
Ensure that you have configured the Business Applications related list.

About this task
When you refresh impacted services, the Impacted Services/CIs, Business Applications, and Service Offerings related lists get updated based on the affected CIs. The records in each of the related list are unique even though the impact can be from a single affected CI. The following properties are responsible for this functionality:

• Populate Impacted Services based on Affected CIs. Note: This requires any Business Service identified to have previously been converted to an Application Service. (incident.refresh_impacted.include_affected_cis)

• Populate the Business Application related list for incidents (com.snc.incident.populate_business_application)

• Populate the Service Offering related list for incidents (com.snc.incident.populate_service_offering)

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Incidents > Open.
3. Open the incident record for which you want to refresh the related lists those values are based on affected CIs.
4. Click the more actions icon (…) and then click Refresh Impacted Services. The records in the Impacted Services/CIs, Business Applications, and Service Offerings related lists are updated.

Create a problem record from an incident

When the cause of an incident is an error or widespread issue, you can create a problem record to track the root cause of the issue.

Before you begin
Role required: agent_workspace_user or admin

Procedure

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Incidents > Open.
3. Open the incident record from which you want to create a problem record.
4. Click the more actions icon (…) and then click Create Problem.
5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Auto-generated] Unique number to identify the problem record.</td>
</tr>
<tr>
<td>First reported by</td>
<td>Task that first identified the problem. In this case, it is the incident number from which it is being created.</td>
</tr>
<tr>
<td>Category</td>
<td>Group to which the problem belongs, such as software or hardware. After selecting the category, select the subcategory, if applicable.</td>
</tr>
<tr>
<td>Service</td>
<td>Business service that is affected.</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. You can choose to receive different levels</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item that is affected. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>State</td>
<td>For customers prior to the Madrid release, the available states are: <strong>Open, Pending Change, Known Error,</strong> and <strong>Closed</strong> or <strong>Resolved</strong>.</td>
</tr>
<tr>
<td></td>
<td>For customers starting with the Madrid release, the new state model is applied and the <strong>State</strong> field is read-only. The field value changes as the problem proceeds from one state to another state. The states available are: <strong>New, Assess, Root Cause Analysis, Fix in Progress,</strong> <strong>Resolved,</strong> and <strong>Closed</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To access the new state management process, activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.</td>
</tr>
<tr>
<td>Impact</td>
<td>Effect that the problem has on business.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Extent to which the problem resolution can bear delay.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The <strong>Priority</strong> field is read-only and is set according to the <strong>Impact</strong> and <strong>Urgency</strong> values.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to which the problem is assigned. If you don't supply a value, the problem is automatically assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Problem coordinator that the problem is assigned to. If an assignment rule applies, the problem is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td>Problem statement</td>
<td>Brief description of the problem.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem.</td>
</tr>
<tr>
<td>Notes section</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notifications about the problem when work notes are added.</td>
</tr>
<tr>
<td>Note:</td>
<td>The administrator must create an email notification for the work notes list. For more information, see <a href="#">Create an email notification</a>.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about the work that you perform on the problem.</td>
</tr>
<tr>
<td>Analysis Information section</td>
<td></td>
</tr>
<tr>
<td>Workaround</td>
<td>Method used to temporarily solve the problem until it is resolved.</td>
</tr>
<tr>
<td>Cause notes</td>
<td>Description of what caused the problem.</td>
</tr>
<tr>
<td>Resolution Information section</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Resolved</td>
<td>Date and time when the incident was resolved.</td>
</tr>
<tr>
<td>Resolved by</td>
<td>User who resolved the issue.</td>
</tr>
<tr>
<td>Fix notes</td>
<td>Information on how fixed the problem was fixed.</td>
</tr>
<tr>
<td>Other Information section</td>
<td></td>
</tr>
<tr>
<td>Opened</td>
<td>[Auto-generated] The user who opened the problem.</td>
</tr>
<tr>
<td>Opened by</td>
<td>[Auto-generated] Date and time when the user opened the problem.</td>
</tr>
<tr>
<td>Confirmed</td>
<td>[Auto-generated] User who confirmed the problem.</td>
</tr>
<tr>
<td>Confirmed by</td>
<td>[Auto-generated] Date and time the user confirmed the problem.</td>
</tr>
</tbody>
</table>

6. **Optional:** If you want to attach a supporting document, click the attachment icon ( ![Attachment](attachment.png)) and select the file.

7. Click **Save**.

**Create a change request from an incident**

If the cause of an incident requires a change to your infrastructure or a business service, you can create a change request from the incident as part of fixing the problem.

**Before you begin**
Role required: agent_workspace_user or admin

**Procedure**
1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. From the list, click **Incidents > Open**.
3. Open the incident record from which you want to create a change.
4. Click the more actions icon ( ![More Actions](more_actions.png)) and click **Create Change Request**.
5. In the Create Change Request dialog box, select the type of change.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Any service change that is not a standard change or an emergency change.</td>
</tr>
<tr>
<td>Standard</td>
<td>A pre-authorized change that is low risk, relatively common, and follows a specified procedure or work instruction.</td>
</tr>
<tr>
<td>Emergency</td>
<td>An emergency change that bypasses group and peer review and approval, and goes straight to the authorization state for approval by the CAB approval group.</td>
</tr>
</tbody>
</table>

6. Click **Create**.

7. Creating the change record.
   For more information, see Create a change task.

8. Click **Save**.
   The change record appears under the Change Requests related list.

**Create a knowledge article from an incident in ITSM Agent Workspace**

You can create a knowledge article from an incident in Agent Workspace to capture the troubleshooting steps and other detailed information used to resolve an issue for faster resolution of similar incidents.

**Before you begin**
Role required: agent_workspace_user or admin

Activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge)

**About this task**
You can create a knowledge article only when the incident is resolved and you have not already created a knowledge article from that incident.

**Procedure**
1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. From the list, click **Incidents > Resolved**.
3. Open the incident record from which you want to create a knowledge article.
4. Click the more actions icon (…) and then click Create Knowledge.

5. On the form, fill in the fields.

**Note:** If the KCS Integration for Incident Management (com.snc.incident.knowledge) plugin is active, then the fields listed in the CSM Table Map (csm_table_map) table are copied from the incident. If the plugin is not active, then the incident number from the parent incident is copied to the Parent field of the knowledge gap feedback task and the text from the Short Description is copied to the Description field.

### Incident KCS Article form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Auto-generated] Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Knowledge base in which the article is stored. The Incident KCS Article is stored in the [kb_template_incident_kcs_article] table.</td>
</tr>
<tr>
<td>Category</td>
<td>[Auto-generated] Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date after which the knowledge article is deleted from the database. After this date, the article does not appear in the search result.</td>
</tr>
<tr>
<td>Confidence</td>
<td>Maturity of an article based on its completeness and reusability.</td>
</tr>
<tr>
<td>Version</td>
<td>[Auto-generated] Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Workflow</td>
<td>[Auto-generated] Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Source Task</td>
<td>[Auto-generated] Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Option to automatically download an attached article instead of</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display attachments</td>
<td>Option to display attachments in the knowledge article. The attachments appear below the article text.</td>
</tr>
<tr>
<td>Governance</td>
<td>An attribute of an article that allows you to control sensitive, critical, or regulated information. Some articles are based on the collective experience of those who use the articles (experience-based). Other articles have policy or legal information that require tight control (compliance-based).</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the knowledge article.</td>
</tr>
<tr>
<td>Issue</td>
<td>Information on the cause of the incident.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Method used to resolve the incident.</td>
</tr>
</tbody>
</table>

**Note:** The **Confidence** and **Governance** fields appear when the Knowledge Management KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) is activated. For more information, see [Managing the KCS article state](#).

6. **Optional:** If you want to attach a supporting document, click the attachment icon (_attach) and select the file.

7. **Click Save.**
   A knowledge article is created. The article record is listed in the Created Knowledge related list on the Incident form.

**Create an improvement initiative from an incident**

Create an improvement initiative from an incident to track and manage tasks for improving a service or process, or tasks related to the incident.
Before you begin
Role required: agent_workspace_user, itil, or admin

- The Continual Improvement Management (com.sn_cim) plugin must be activated. For more information on activating the plugin, see Request Continual Improvement Management.
- The administrator must add the Improvement Initiatives related list to the incident form in Workspace view.

About this task
An improvement initiative contains goals to measure success, and phases that contain tasks with specific actions to complete the improvement. For more information, see Continual Improvement Management overview.

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Incidents > All.
3. Open the incident for which you want to create an improvement initiative.
4. Click the Improvement Initiative related list.
5. Click New.
6. In the Improvement Initiative field, click the search icon to find the appropriate initiative.
7. Associate an existing initiative or create a new one.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you find an existing initiative</td>
<td>Select the initiative to associate with this incident.</td>
</tr>
<tr>
<td>If you do not find an initiative</td>
<td>a. Click the Create Improvement Initiative related link.</td>
</tr>
<tr>
<td></td>
<td>b. Create an initiative by filling in the Improvement Initiative form. For more information, see Create an improvement request.</td>
</tr>
</tbody>
</table>

8. Optional: If you want to attach a supporting document, click Browse and select the file.
9. Click Save.
   The improvement initiative is now associated with the incident.
Delete an incident

If you no longer need incident information, you can delete the incident. This action deletes the incident both from the ServiceNow database and from the Incident [incident] table.

Before you begin
Role required: agent_workspace_user or admin

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Incidents > Open.
3. Open the incident record that you want to delete.
4. Click the more actions icon and then click Delete.
5. In the Confirmation dialog box, click OK.

Incident Management integration with Universal Request in ITSM Agent Workspace

With the integration of Incident Management and Universal Request applications, you can provide a consistent user experience for employees while creating service requests. By providing a common help desk for all employees, you can hide the complexities of inter-department request transfers and multi-department use cases.

Install and configure the Universal Request Integration for Incident Management plugin (com.snc.incident.universal_request). The integration provides the following configurations and functionalities:

Incident management integration with Universal Request

- The Universal Request form has a UI action to create an incident. The default fields that are copied from the universal request record to the incident record when a new incident is created are: universal_request, short_description, description, caller_id, and opened_by. An incident manager can customize the fields using the system property sn_inc_uni_req.incident.universal_request.copy_fields.
- The Universal Request field appears on the Incident form only when an incident is associated with a universal request record.
- The Transfer button appears on the incident form where an itil agent can transfer an incident back to the universal request, another department, or service.
• An incident created from a record producer automatically creates a universal request. It happens only when the Create Universal Request check box is enabled on the record producer.

• When an incident associated to a universal request goes through a state change, a notification is sent to the employee (requester) with the universal request number and not the incident number.

Create incident from Universal Request in ITSM Agent Workspace

Create an incident from a universal request record to restore service to a customer as soon as possible. After creating the incident record, you can investigate potential solutions.

Before you begin
Role required: routing_agent and ITIL or admin

Activate the Universal Request (sn_uni_req) and the Universal Request Integration for Incident Management (sn_inc_uni_req) plugins.

Procedure

1. Navigate to Universal Requests > All.
2. Open the universal request record from which you want to create an incident.
3. Click Create Incident. An incident record is created and associated with universal request. The incident record is not saved until you submit the record.
4. Fill in the fields on the incident form and click Save. The universal request number from which the incident is created appears in the Universal Request field on the Incident form in workspace. The incident number appears in the Primary Ticket field and also in the Associated Tickets related list of the Universal Request form.

Transfer incident in ITSM Agent Workspace

Transfer the back to the Universal Request queue, or to another department with or without resolution. When you realise that the issue is not incident related, transfer the incident without any resolution to the relevant department or service. If you resolve the issue, you can transfer the incident with the resolution.

Before you begin
Role required: itil or admin

Associate an incident with a Universal Request record.
Procedure

1. Open the incident that you want to transfer.

2. Click Transfer.

3. In the Transfer Ticket dialog box, provide the following details.

   - **Action**: Select if the case should be transferred to another department or back to Universal Request
   - **Department**: Select the department from the list.
   - **Service**: Select the specific service of the chosen department.

   Note: This field does not appear if you have selected Transfer to Department in Action

   - **Transfer reason**: Select the reason from the list.
   - **Transfer notes**: A brief description for routing the primary ticket that you want to pass to the UR Routing agent.
   - **Copy additional comments and attachments**: Deselect if you do not want to transfer the ticket with additional comments and attachments. By default, all attachments and comments are transferred.

   Note: Work notes are not copied while transferring.

4. Click Transfer.
Mark an incident as restricted

You can restrict an incident ticket that contains sensitive information. By marking an incident as restricted, you limit its access for the agents.

Before you begin
Role required: admin or user

About this task
Both agents and users can mark an incident as restricted. Users can mark an incident as restricted while creating it. An agent can also mark an incident as restricted whiletriaging it or while working on it. Cases marked as restricted can only be accessed by

- Routing agents who are part of the assignment group and has sensitive agent role.
- Agents who are a member of primary ticket assignment group.

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the navigation list, click Incidents > Open.
3. Open the incident that you want to mark as restricted.
4. Click Restrict.
5. Click Update.

ITSM Agent Workspace - Problem

The Problem workspace form is similar to the default platform Problem form.

All fields that are available on the Problem form are available on the problem workspace form. However, on the problem workspace form, the State field is read-only.

Note: Currently, Agent Workspace supports only the creation and minor update of a Problem record such as updating the short description, description, and work notes.

Overview of itsm agent workspace - problem
Create and track a problem in workspace

When you have recurring incidents or a major incident, you can create a problem to identify the root cause of the incidents and help prevent them from happening again.

Before you begin
Role required: agent_workspace_user, problem_coordinator, or admin

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the Lists menu, select Problems > Open.
3. Click New.
4. On the form, fill in the fields.

Create New Problem form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Auto-generated]. Unique number that identifies the problem record.</td>
</tr>
<tr>
<td>First reported by</td>
<td>Task that first identified this problem.</td>
</tr>
</tbody>
</table>

**Note:** Activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category and Subcategory</td>
<td>Group to which the problem belongs, such as software or hardware. After selecting the category, select the subcategory, if applicable.</td>
</tr>
<tr>
<td>Service</td>
<td>Business service, such as email or IT Services, that the problem applies to.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the problem applies to. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>State</td>
<td>For customers prior to the Madrid release, the available states are: <strong>Open, Pending Change, Known Error</strong>, and <strong>Closed</strong> or <strong>Resolved</strong>.</td>
</tr>
<tr>
<td></td>
<td>For customers starting with the Madrid release, the new state model is applied and the State field is read only. The field value changes as the problem proceeds from one state to another state. The states available are: <strong>New, Assess, Root Cause Analysis, Fix in Progress, Resolved</strong>, and <strong>Closed</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong> To access the new state management process, activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.</td>
<td></td>
</tr>
<tr>
<td>Impact</td>
<td>Effect that the problem has on business operations.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Extent to which the problem resolution can bear delay.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem. The Priority field is automatically set to the Impact and Urgency values.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to which the problem is assigned. You can populate the Assignment group field automatically based on the support group available for the respective configuration item (CI). If the CI does not have any support group, then the field gets populated with the support group available for service offerings. The business rule Populate Assignment Group based on CI/SO triggers the functionality when an incident, problem, or change request is created or updated and when the Assignment group and the Assigned to field is empty. The following properties identify the field whose value populates the Assignment group field:</td>
</tr>
<tr>
<td></td>
<td>• com.snc.problem.ci_assignment_group.field_name</td>
</tr>
<tr>
<td></td>
<td>This problem property identifies which CI field populates the Assignment group field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>• <code>com.snc.problem.service_offering_assignment_group</code> &lt;br&gt; <strong>Note:</strong> The default value for the properties is support group for incident or problem and change group for change request respectively. The business rule Populate Assignment Group based on CI/SO is shipped as part of the development plugin ITSM CSDM Best Practice – Quebec plugin (com.snc.best_practice.itsm_csdm.quebec) and is available only for the new customers.</td>
<td></td>
</tr>
<tr>
<td>Assigned to</td>
<td>Problem coordinator to whom the problem is assigned. If an assignment rule applies, the problem is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td>Problem statement</td>
<td>Brief description of the problem. &lt;br&gt; <strong>Note:</strong> Activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notification when work notes are added to the problem.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Informative notes about the work performed on the problem.</td>
</tr>
<tr>
<td>Analysis Information</td>
<td></td>
</tr>
<tr>
<td>Workaround</td>
<td>Method used to overcome the issue if no resolution is available yet.</td>
</tr>
<tr>
<td>Cause notes</td>
<td>The cause of the problem.</td>
</tr>
<tr>
<td>Auto-generated information</td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>[Auto-generated]. Date and time when the user resolved the problem.</td>
</tr>
<tr>
<td>Resolved by</td>
<td>[Auto-generated]. Name of the user who resolved the problem.</td>
</tr>
<tr>
<td>Fix notes</td>
<td>Information on how the problem was fixed.</td>
</tr>
<tr>
<td>Auto-generated information</td>
<td></td>
</tr>
<tr>
<td>Opened</td>
<td>[Auto-generated]. Date and time when the user opened the problem.</td>
</tr>
<tr>
<td>Opened by</td>
<td>[Auto-generated]. User who opened the problem.</td>
</tr>
<tr>
<td>Confirmed</td>
<td>[Auto-generated]. Date and time when the user confirmed that the issue was indeed a problem.</td>
</tr>
<tr>
<td>Confirmed by</td>
<td>[Auto-generated]. User who accessed the issue and confirmed that it was a problem.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Create a problem from an interaction**

You can create a problem record directly from an Interaction when the customer contacts regarding an issue and you need to investigate the cause of the issue.
Before you begin
Role required: agent_workspace_user or admin

• Activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.

• Select the **Allow Problem creation from Interaction** (glide.problem.interaction.allow_create) problem property from **Problem > Problem Properties**.

**Note:** Users who used to create problem record from the New Call feature of the Service Desk Call (com.snc.service_desk_call) plugin, can now create problems from Interaction. Starting the Orlando release, the Service Desk Call (com.snc.service_desk_call) plugin is a maintenance plugin and the user cannot activate the plugin.

**Procedure**

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.

2. Create an interaction record.
   For more information, see Create an interaction record in ITSM Agent Workspace.

3. On the interaction page, click the more actions icon ( ▼ ) and then select Create Problem.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Problem form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Auto-generated]. Number that identifies the problem record.</td>
</tr>
<tr>
<td>First reported by</td>
<td>Task that first identified the problem.</td>
</tr>
<tr>
<td>Category and Subcategory</td>
<td>Group to which the problem belongs to such as software or hardware.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>After selecting the category, select the subcategory, if applicable.</td>
<td></td>
</tr>
<tr>
<td>Note: Activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.</td>
<td></td>
</tr>
<tr>
<td>Service</td>
<td>Business service that the problem applies to.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the problem applies to. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>State</td>
<td>For customers prior to the Madrid release, the available states are: Open, Pending Change, Known Error, and Closed or Resolved. For customers starting with the Madrid release, the new state model is applied and the State field is read only. The field value changes as the problem proceeds from one state to another state. The states available are: New, Assess, Root Cause Analysis, Fix in Progress, Resolved, and Closed.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note:</td>
<td>To access the new state management process, activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.</td>
</tr>
<tr>
<td>Impact</td>
<td>Effect that the problem has on business operations.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Extent to which the problem resolution can bear delay.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem. The <strong>Priority</strong> field is automatically set to the <strong>Impact</strong> and <strong>Urgency</strong> values.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to which the problem is assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Problem coordinator to whom the problem is assigned. If an assignment rule applies, the problem is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td>Problem statement</td>
<td>Brief description of the problem.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notification when work notes are added to the problem.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Informative notes about the work performed on the problem.</td>
</tr>
</tbody>
</table>
5. Click **Save**.
A problem record is created and the record appears in the Related tasks related list on the Interaction form.

### Create a problem task in a workspace

If you need to engage another team or agent for help, create a problem task and assign it to them.

**Before you begin**

Role required: agent_workspace_user, problem_task_analyst, or admin

Activate the Problem Management Best Practice — Madrid — State Model (com.snc.best_practice.problem.madrid.state_model) plugin to access the problem task types
Procedure

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. In the List menu, choose **Problems > Open**.
3. Open the problem record for which you want to create tasks.
4. Click the Problem Tasks related list, and then click **New**.
5. In the Create Problem Task dialog box, select the problem task type to be created.
   - **General**: Tasks other than root cause analysis tasks.
   - **Root Cause Analysis**: Tasks to investigate the root cause of a problem and find a resolution for the problem.
6. Click **Create**.
7. On the form, fill in the fields.

### Create New Problem Task form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Auto-generated]. Number that identifies the problem task record.</td>
</tr>
<tr>
<td>State</td>
<td>For customers prior to the Madrid release, the available states are: <strong>Open</strong>, <strong>Pending Change</strong>, <strong>Known Error</strong>, and <strong>Closed</strong> or <strong>Resolved</strong>. For customers starting with the Madrid release, the new state model is applied and the <strong>State</strong> field is read only. The field value changes as the problem proceeds from one state to another state. The states available are: <strong>New</strong>, <strong>Assess</strong>, <strong>Root Cause Analysis</strong>, <strong>Fix in Progress</strong>, <strong>Resolved</strong>, and <strong>Closed</strong>.</td>
</tr>
</tbody>
</table>

**Note:** To access the new state management process, activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The problem task type.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the problem task applies to. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>Due date</td>
<td>Date by which the problem task must be completed.</td>
</tr>
<tr>
<td>Problem</td>
<td>ID number of the problem for which the problem task is created.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group to which the problem task is assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Problem analyst to whom the task is assigned.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the problem tasks must be associated to the problem.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the problem task.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem task.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notification when work notes are added to the problem task.</td>
</tr>
<tr>
<td>Work notes (Private)</td>
<td>Information about the work performed on the problem task.</td>
</tr>
</tbody>
</table>

Analysis information — Available for the Root Cause Analysis problem type
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause code</td>
<td>Code for the cause of the problem type such as Environmental disaster, Hardware issue, or People/Process/Documentation.</td>
</tr>
<tr>
<td>Cause notes</td>
<td>Information on the cause of the problem task.</td>
</tr>
<tr>
<td>Proposed fix notes</td>
<td>Proposed fix for the problem task.</td>
</tr>
<tr>
<td>Workaround</td>
<td>Method used to overcome the issue if no resolution is available yet.</td>
</tr>
<tr>
<td>Closure information</td>
<td></td>
</tr>
<tr>
<td>Closed by</td>
<td>[Auto-generated]. Name of the user who closed the problem task.</td>
</tr>
<tr>
<td>Closed</td>
<td>Date and time when the user closes the problem task.</td>
</tr>
<tr>
<td>Close notes (Only for General problem task type)</td>
<td>Information on the work completed for the problem task.</td>
</tr>
</tbody>
</table>

8. Click **Save**.
   The problem task record is created and is added to the Problem tasks related list on the Problem form.

Attach a knowledge article to a problem or problem task from Agent assist

You can attach a knowledge article, for example a Known Error article, to a problem or problem task that provides information to solve the issue quickly.

**Before you begin**
Role required: agent_workspace_user or admin

**Procedure**
1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. In the Lists menu, choose **Problems > Open**.
3. Access the relevant problem record or problem task.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are attaching an article to a problem record</td>
<td>Open the problem record.</td>
</tr>
<tr>
<td>If you are attaching an article to a problem task</td>
<td>a. Open the related problem record.</td>
</tr>
<tr>
<td></td>
<td>b. Click the Problem Tasks related list.</td>
</tr>
<tr>
<td></td>
<td>c. Select the problem task record.</td>
</tr>
</tbody>
</table>

4. In Agent Assist, search for the article you want to attach and select it.

5. Click the more actions icon and click **Attach**.

The knowledge article appears under the Attached Knowledge related list.

**Create a change request from a problem**

If the cause of a problem requires a change to your infrastructure or a business service, you can create a change request from the problem as part of fixing the problem.

**Before you begin**

Role required: agent_workspace_user, itil, or admin

**About this task**

You can implement a resolution to a problem by applying a standard change procedure and testing to confirm service recovery. For a normal change, you raise a Request For Change (RFC). The Change Advisory Board (CAB) must approve the RFC before a resolution is applied to the Problem.
Procedure

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. From the list, click **Problems > Open**.
3. Open the problem record from which you want to create a change request.
4. Click the more actions icon (⋯) and click **Create Change Request**.
5. In the Create Change Request dialog box, select the type of change.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Any service change that is not a standard change or an emergency change.</td>
</tr>
<tr>
<td>Standard</td>
<td>A pre-authorized change that is low risk, relatively common, and follows a specified procedure or work instruction.</td>
</tr>
<tr>
<td>Emergency</td>
<td>An emergency change that bypasses group and peer review and approval, and goes straight to the authorization state for approval by the CAB approval group.</td>
</tr>
</tbody>
</table>

6. Click **Create**.
7. Create the change record.
   For more information, see **Create a change task**.
8. Click **Save**.
   The change record appears under the Change Requests related list.

Create an improvement initiative from a problem

Create an improvement initiative from a problem to track and manage tasks for improving a service or process, or tasks related to the problem.

**Before you begin**

Role required: agent_workspace_user, itil, or admin
• The Continual Improvement Management (com.sn_cim) plugin must be activated. For more information on activating the plugin, see Request Continual Improvement Management.

• The administrator must add the Improvement Initiatives related list to the problem form in Workspace view.

About this task
An improvement initiative contains goals to measure success, and phases that contain tasks with specific actions to complete the improvement. For more information, see Continual Improvement Management overview.

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. In the Lists tab, click Problems > All.
3. Open the problem for which you want to create an improvement initiative.
4. Click the Improvement Initiative related list.
5. Click New.
6. In the Improvement Initiative field, click the search icon to find the appropriate initiative.
7. Associate an existing initiative or create a new one.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you find an existing initiative</td>
<td>Select the initiative to associate with this incident.</td>
</tr>
<tr>
<td>If you do not find an initiative</td>
<td>a. Click the Create Improvement Initiative related link.</td>
</tr>
<tr>
<td></td>
<td>b. Create an initiative by filling in the Improvement Initiative form. For more information, see Create an improvement request.</td>
</tr>
</tbody>
</table>

8. Optional: If you want to attach a supporting document, click Browse and select the file.
9. Click Save.
   The improvement initiative is now associated with the problem.
Delete a problem

If you no longer need problem information, you can delete the problem. This action deletes the problem both from the ServiceNow database and from the Problem table.

Before you begin
Role required: admin

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. From the list, click Problem > Open.
3. Open the problem record that you want to delete.
4. Click the more actions icon (⋯) and then click Delete.
5. In the Confirmation dialog box, click OK.

ITSM Agent Workspace - Change Management

Use ServiceNow® ITSM Agent Workspace to create and manage your change requests.

The Change workspace form is similar to the Now Platform Change request form. You can customize the view of the Agent Workspace form by changing the workspace view. For more information, see Add field or related list to a workspace form.

ITSM Agent Workspace — Change
Create a change request in Agent Workspace

A change request is a proposal to alter a supported configuration item (CI). Use a change request form to record information such as the reason for the change, type, priority, and risk.

**Before you begin**
Role required: sn_change_write, itil, or admin

**Procedure**
1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. From the navigation list, click **Change > Open**.
3. Click **New**.
4. Select a change type and then click **Create**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Any service change that is not a standard change or an emergency change.</td>
</tr>
<tr>
<td>Standard</td>
<td>A pre-authorized change that is low risk, relatively common, and follows a</td>
</tr>
<tr>
<td></td>
<td>specified procedure or work instruction.</td>
</tr>
<tr>
<td>Emergency</td>
<td>An emergency change that bypasses group and peer review and approval, and</td>
</tr>
<tr>
<td></td>
<td>goes straight to the authorization state for approval by the CAB approval</td>
</tr>
<tr>
<td></td>
<td>group.</td>
</tr>
</tbody>
</table>

5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Change form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The unique change request number</td>
</tr>
<tr>
<td>Requested by</td>
<td>User who requested the change.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the change, for example, <strong>Hardware</strong>, <strong>Network</strong>, or <strong>Software</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service</td>
<td>The business service that you want to make available for the change request.</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the change applies to. You can associate any type of CI with a change request, including service offerings. It also provides detailed access to SLA and availability requirements.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority value that is auto-generated based on impact and urgency. It identifies how quickly the service desk should address the task</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact auto-calculated value that indicates a measure of the effect of an incident, problem, or change on business processes.</td>
</tr>
<tr>
<td>Type</td>
<td>Displays the selected change request type (Standard, Normal, or Emergency). You can change this value by selecting another type.</td>
</tr>
<tr>
<td>State</td>
<td>State of the change request. By default, the state is <strong>New</strong>.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group assigned to the change. You can populate the <strong>Assignment group</strong> field automatically based on the support group available for the respective configuration item (CI). If the CI does not have any</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>support group, then the field gets populated with the support group available for service offerings. The business rule <strong>Populate Assignment Group based on CI/SO</strong> triggers the functionality when an incident, problem, or change request is created or updated and when the <strong>Assignment group</strong> and the <strong>Assigned to</strong> field is empty. The following properties identify the field whose value populates the <strong>Assignment group</strong> field:</td>
<td></td>
</tr>
<tr>
<td>• <strong>com.snc.change_request.ci_assignment_group.field_name</strong>: This change property identifies which CI field populates the <strong>Assignment group</strong> field.</td>
<td></td>
</tr>
<tr>
<td>• <strong>com.snc.change_request.service_offering_assignment_group.field_name</strong>: This change property identifies which service offering field populates the <strong>Assignment group</strong> field.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The default value for the properties is support group for incident or problem and change group for change request respectively. The business rule <strong>Populate Assignment Group based on CI/SO</strong> is shipped as part of the development plugin ITSM CSDM Best Practice – Quebec plugin (com.snc.best_practice.itsm_csdm.quebec) and is available only for the new customers.</td>
<td></td>
</tr>
<tr>
<td><strong>Assigned to</strong></td>
<td>User assigned to the change request. If an assignment rule applies, the change is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td><strong>Risk</strong></td>
<td>The risk level for the change.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Field</td>
<td>Either <strong>High</strong>, <strong>Moderate</strong>, or <strong>Low</strong>. You can set this value manually or use <strong>Risk Calculation and Risk Assessment</strong> to derive it.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the change.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the change.</td>
</tr>
<tr>
<td>Planning section</td>
<td>Reason for the planned change request, which helps approvers determine their decision.</td>
</tr>
<tr>
<td>Justification</td>
<td>Plan or process to follow to implement the change.</td>
</tr>
<tr>
<td>Implementation plan</td>
<td>Detailed analysis of the risk and impact foreseen if the change is implemented.</td>
</tr>
<tr>
<td>Risk and impact analysis</td>
<td>The information required to restore the system to its original state if an implementation fails.</td>
</tr>
<tr>
<td>Backout plan</td>
<td>Detailed information on the test strategy and objectives for the change request.</td>
</tr>
<tr>
<td>Schedule section</td>
<td>Date to begin working on the change.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>Date the change is planned to be completed.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>If the task type is <strong>Implementation</strong>, the <strong>Planned start date</strong> and <strong>Planned end date</strong> values must fall within the planned start and end dates specified in the change request.</td>
</tr>
<tr>
<td>Unauthorized</td>
<td>Option to indicate that the change is an unauthorized change. For more information see, <strong>Unauthorized change request</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Actual start date</td>
<td>Start date of the implementation.</td>
</tr>
<tr>
<td>Actual end date</td>
<td>Date when the change was completely implemented.</td>
</tr>
<tr>
<td>Notes section</td>
<td></td>
</tr>
<tr>
<td>Watch list</td>
<td>Users to receive notifications when work notes are added.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users to receive notifications when work notes are added.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The administrator must create an email notification for the work notes list.</td>
</tr>
<tr>
<td>Additional comments (Customer visible)</td>
<td>More information about the change.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve the change or steps taken to resolve it, if applicable. This note is for internal use. The work notes information is not visible to your customer.</td>
</tr>
<tr>
<td>Closure Information section</td>
<td></td>
</tr>
<tr>
<td>Close code</td>
<td>Resolution code for the change.</td>
</tr>
<tr>
<td>Close notes</td>
<td>How or why the change was closed.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

**Create a standard change from an interaction**

Create a standard change record directly from an interaction to implement a pre-approved, low-risk change without having to go through the Change Management module to implement it.

**Before you begin**

Role required: itil, sn_change_write or admin

**Procedure**

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. Create an interaction record.
For more information, see Create an interaction record in ITSM Agent Workspace.

3. On the Interaction form, click the more actions icon and then click Create Standard Change.

4. On the New Catalog Item page, expand the Standard change list and select from the available change categories.

5. Click Submit.
A standard change is created and the record appears in the Related tasks related list on the Interaction Management form.

Link a change request to an incident through Agent Assist
You can identify incidents caused by a change and link it to the change record from the Agent Assist panel in a workspace.

Before you begin
Role required: sn_change_write, itil, or admin

Procedure
1. Navigate to Work Experience > Workspaces > Agent Workspace Home.
2. From the list, click Change > Open.
3. Click the change record you want to work on.
4. In Agent Assist, click the settings icon ( ).
5. Select Change Related Incidents from the menu list.
6. Click the more actions icon ( ) in the incident tile that you want to link to the change.
7. Click the Link to Incident menu item.
8. In the Link to Incident form, fill in the work notes and any additional comments.
9. Click Link to Incident.

Results
The change record is linked to the incident and the incident details appear when you view the Incidents Caused By Change related list.
Delete a change request

If you no longer require the change information, you can delete the change record. This action deletes the change record from the ServiceNow database and the Change [change] table.

Before you begin
Role required: agent_workspace_user, itil_admin, or admin

Procedure
1. Navigate to Work Experience > Workspaces > Agent Workspace Home.
2. From the list, click Change > Open.
3. Open the change record that you want to delete.
4. Click the more actions icon (•••) and then click Delete.
5. In the Confirmation dialog box, click OK.

Disable creating an emergency change in Agent Workspace

Limit the access to create an Emergency change request from the Agent Workspace. However, you can continue creating the emergency change from your Now Platform instance.

Before you begin
Role required: itil_admin or admin

Procedure
1. Navigate to Change > Administration > Workspace Record Types Selectors.
2. Click the change_request target table that has the Emergency display value. The record opens in the read-only mode.
3. Click here in the message displayed to edit the record. The editable record opens.
4. Click the Active check box to make it inactive. By making the record inactive, you remove the Emergency option that appears in the New Change Request window of the Agent Workspace. This action impacts creating change in placed where the interceptor is used.

Workforce Optimization for ITSM Agent Workspace

Manage your schedule using Scheduling in agent workspace in Workforce Optimization for ITSM. Use Coaching to review and complete assigned training.
Access your profile in ITSM Agent Workspace

Track and monitor the real-time status of your work by accessing your profile in ITSM Agent Workspace. You can track how many incidents and interactions you have closed and how many you are actively working on. You can also view the roles and groups to which you belong and see information about your manager and teammates.

Before you begin
Role required: sn_wfo_itsm.employee

About this task
Access your profile to analyze information such as:

- Key performance indicators that matter most to you and Performance Analytics targets set for you by your manager. For information on Performance Analytics, see Performance Analytics targets.
- Pending training that has been assigned to you and when they're due.
- Service channels that you are assigned to and their current utilization.
- Skills and skill levels that you currently use and skill gaps that you may want to address.
- Upcoming PTO.

Procedure

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.

   When you click the home icon, you can view the status of your work, organizational performance, current status of incidents, and unassigned incidents in the ITSM Agent Workspace - Premium landing page.

2. Click the lists icon.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access your profile from an incident record</td>
<td>a. Click Incidents and select Assigned to me.</td>
</tr>
<tr>
<td></td>
<td>b. In the Assigned column, select your name. The profile page appears. In that page, you can access all the information that is related to your profile.</td>
</tr>
<tr>
<td>To Create your profile for centralized access</td>
<td>Do this</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>a.</strong> Select the <strong>My Lists</strong> tab.</td>
<td></td>
</tr>
<tr>
<td><strong>b.</strong> Click <strong>New List</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>c.</strong> In the <strong>New List</strong> screen, click <strong>Create your own</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>d.</strong> In the <strong>List Name</strong> field, enter a name for the list; for example, My Profile.</td>
<td></td>
</tr>
<tr>
<td><strong>e.</strong> In the <strong>Select Source</strong> field, select <strong>User</strong> (sys_user).</td>
<td></td>
</tr>
<tr>
<td><strong>f.</strong> In the <strong>Add Filters</strong> condition builder, select <strong>[Name] [is] [&lt;your name&gt;]</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>g.</strong> Click <strong>Create</strong>.</td>
<td></td>
</tr>
<tr>
<td>The workspace adds your profile to the <strong>My Lists</strong> tab.</td>
<td></td>
</tr>
<tr>
<td>For information on creating a list, see <strong>Create My Lists in Workspace</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To Analyze Performance Analytics targets</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>a.</strong> Click <strong>Incidents</strong> and select <strong>Assigned to me</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>b.</strong> In the <strong>Assigned</strong> column, select your name.</td>
<td></td>
</tr>
<tr>
<td><strong>c.</strong> Select an <strong>indicator</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>d.</strong> Click the target icon and view the personal or global targets set by your manager.</td>
<td></td>
</tr>
</tbody>
</table>

**ITSM Agent Workspace - Scheduling**

Use ITSM Agent Workspace Scheduling to manage your schedule.

**Manage your schedule using the ITSM Agent Workspace**

Look up your schedule, request time off for an on-call or work shift, or swap your shift with your peers using the calendar in ITSM Agent Workspace. If you can work during the requested shift, you can also approve your peer's request for shift swap. When you request time off for an on-call shift, you can also propose an agent to cover the shift.
Before you begin
Role required: sn_shift_planning.agent

About this task
You can swap shifts with agents that are within your assignment group.

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. Click the Schedule icon ( ).
   Access the schedule:
   • View your schedule by clicking the My Calendar tab. Then, use the list menu to select the schedule that you want to view by day, week, or month.
   • View another agent's schedule by clicking the Team Calendar tab. Then, click an agent's schedule to see that agent's work and break times.
3. Make a request.
   You can communicate with other agents by using Connect Chat or the activity stream on the record to make sure that they would like to swap the requested shift with you.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request a shift swap</td>
<td>a. Select a shift on the calendar and click the swap shift icon.</td>
</tr>
<tr>
<td></td>
<td>b. From the Shift menu for your shift, select the shift that you want to swap with another agent. This information is auto-populated when you open the request using the swap shift icon.</td>
</tr>
<tr>
<td></td>
<td>c. In the Agent field for the requested shift, select the agent that you want to swap with.</td>
</tr>
<tr>
<td></td>
<td>d. From the Shift menu for the requested shift, select the agent's shift that you want to swap with.</td>
</tr>
<tr>
<td></td>
<td>e. Click Submit.</td>
</tr>
<tr>
<td>Request time off for a work shift</td>
<td>Create a new time-off request or select a work shift for which you want to take time off. To create a new request:</td>
</tr>
<tr>
<td></td>
<td>a. Click New and select Time Off.</td>
</tr>
<tr>
<td></td>
<td>b. In the Start date field, click the calendar icon and select the date to start taking time off.</td>
</tr>
</tbody>
</table>
To | Do this
---|---
c. In the **End date** field, click the calendar icon and select the date you want to the end time off.  
d. Click **Save**.

To create a request from a work shift:

a. Select the work shift in the calendar for which you want to take time off and click the Request Time-off icon (📅).

   The start date and time and the end date and time are automatically populated.

b. In the **Title** field, enter a name for the work shift.

c. In the **Description** field, enter a reason for the time-off.

d. Click **Save**.

### Request time off for an on-call shift

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>Select an on-call or a work shift in the calendar for which you want to take time-off.</td>
</tr>
</tbody>
</table>
| b. | Click the Request Time-off icon (📅).  
   The start date and time, the end date and time, and the group are automatically populated. |
| c. | In the **Proposed Cover** field, select the name of the agent. |
| d. | Request time off. |
| e. | Click **Save**. |

The shift-swap request moves to the approval queue of the agent that you have requested to swap with. For more information, see Approve or reject a shift swap.

The time-off request moves to your manager's approval queue. For more information about approvals, go to Track and manage your teams' schedule.

### Approve or reject a shift-swap

You can approve a shift swap requested by your peer if you are available to work for that time period. You can reject it if you are unable to work then.

**Before you begin**

Role required: sn_shift_planning.agent
Procedure

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. Click **Shift Approvals**.
3. Select the request you want to approve or reject.
4. Review the details of the shift swap request and do one of the following:
   • To approve the request, click **Approve**.
   • To reject the request, click **Reject**.
   If you approve a shift-swap, the application moves the request to your manager's approval queue. For more information, go to **Track and manage your teams' schedule**.

Request time off using ITSM Virtual Agent

Automate your request for time off using the ITSM Virtual Agent. Type keywords into the chatbot to create and submit your request, which then gets automatically routed to your manager for approval. You can also use Natural Language Understanding to make your time-off request.

Before you begin

**Important:** This feature is available with the Workforce Optimization Content Pack for ITSM (sn_wfo_itsm_cnt) from the ServiceNow Store. To enable this feature, see Workforce Optimization for ITSM Reference.

The ITSM Virtual Agent Conversation Topics (com.snc.itsm.virtualagent) plugin must be enabled.

**Note:** To search shifts and schedules, you must **generate the text index** for the **Topic [sys_cs_topic]** table before you start using the ITSM Virtual Agent for making time off requests.

Before you can use **Natural Language Understanding** to make time-off requests, the Time Off Request NLU model must be **trained** and **published**.

Role required: **sn_shift_planning.agent**

Procedure

1. Navigate to **Service Portal > Service Portal Home**.
2. Click the chat icon.
3. In the chat window, do one of the following to create the request:
• To use keywords, enter *time off*, *vacation*, or similar keywords.

• To use Natural Language Understanding, enter an *utterance*.

The Time Off Request topic appears.

4. Select the topic.
   The calendar appears with the message, "When do you want to start your time off?"

5. Select the start date and time for your time-off request and click *Select*.
   The calendar appears with the message, "When do you want to end your time off?"

6. Select the end date and time for your time-off request and click *Select*.
   The "Would you like to enter the reason for your time off?" message appears.

7. **Optional**: Click *Yes* and enter the reason for taking time off and click *Enter*.
   The message, "Your time-off request has been submitted and is in your manager's approval queue," appears.

8. To view the submitted request on your calendar, click *View submitted request (Request Number)*.

**ITSM Agent Workspace - Coaching**

Use ITSM Agent Workspace Coaching to review and complete training.

As an agent, you can respond to surveys or your assessments.

**Complete learning tasks using the ITSM Agent Workspace**

Enhance your skills set by completing learning tasks from internal or external learning content.

**Before you begin**

Role required: sn_lc.content_reader

**Procedure**

1. Navigate to *Workspace Experience > Workspaces > Agent Workspace Home*.
2. Click the Lists icon.
3. Go to *Learning Tasks > All Tasks*.
4. Select a learning task.
5. Complete the learning task.
6. Click *Mark as Complete*.
Workforce Optimization for ITSM

Manage and maintain the productivity of your workforce from a single location using Workforce Optimization for ITSM. Using this application, you can efficiently manage your team’s skills and schedules, route work assignments to your team, and monitor their performance.

Workforce Optimization for ITSM enables you to do these tasks:

• Predict and recommend skills for agents.
• Use queues to route the agents based on their assigned groups and skills set.
• Monitor and measure team performance and provide feedback using assessments.
• Create opportunities to coach and train your teams.

Workforce Optimization for ITSM in action

Here’s how managers use Workforce Optimization for ITSM. Workforce Optimization for ITSM

Key Features

Predict demand for agents
Forecast resources for your shifts based on historical data.

Automating employee coaching and training
Assess your team’s performance and set coaching plans to improve their skills.
Integrated application data

Drive workforce optimization effectively by managing schedules, shifts, and queues for your teams. You can assess skills, automate agent recommendations based
on those skills, and provide mentoring opportunities for
Exploring Workforce Optimization for ITSM

Use Workforce Optimization for ITSM to optimize your workforce and manage your teams efficiently. Coach your teams so that they gain the skills that let you address the demands from your customers. Efficiently schedule your teams to provide better coverage with integrated channel management.

As a manager, you can monitor the demand for agents and skills in your organization to resolve issues. Assess agent skills, identify areas where they need improvement and provide training to enhance their skills set. Track your teams performance, and manage the schedule of all agents in your assignment group—all from a unified location.

As an agent, you can manage your own schedule, access the schedule of your peers and request time off or shift swaps.

Workforce Optimization for ITSM Overview

Get an overview of how you can set up Workforce Optimization for ITSM in this video.

Workforce Optimization for ITSM Setup

Get an overview of how managers can monitor the status of incidents and the KPIs for organizational performance in this video.

Workforce Optimization for ITSM landing page

Channel Management

Monitor your teams in real time and jump in to help when there is a need.

Using this application, you can also:
• Route work to specific groups based on agent skills
• Review real-time performance as the team is actively working on tasks across channels
• Monitor pending work items in a queue

**Scheduling**
Access your teams' calendar to know which agents are scheduled for coverage and which agents have taken time-off.

Using the application, you can also:
• Assign agents to shifts
• Define break time
• Preview and publish team schedule
• Approve agent time-off or shift-swap requests

**Teams**
Monitor performance trends for your teams using KPI groups. Create a set of KPIs and apply them to all groups within a team and assess team performance from one location.

Using the application, you can also:
• Identify all the teams you manage as well as the ones you have visibility into
• Analyze KPIs that are crucial for your team
• Drill into agents within each team and monitor their performance
• Access each agent’s profile to view details such as their manager, peers, and assignment groups
• Drill down into each agent’s skills or recommend them for coaching

**Coaching and Skills Assessment**
Enhance the quality of work done by your agents using Coaching. Use Predictive Intelligence to recommend skills based on issues the agents have resolved. Create coaching opportunities based on the recommendation and train the agents to acquire those skills.

Using this application, you can also:
• Automate the scoring, grading, and assessment of agent skills
• Use coaching opportunities to create assessments
• Track training assigned to agents based on their assessments
• Analyze skill gap and recommend training

Global Search in Workforce Optimization for ITSM

Important: This feature is available with the Workforce Optimization Content Pack for ITSM (sn_wfo_itsm_cnt) from the ServiceNow Store. To enable this feature, see Workforce Optimization for ITSM Reference.

As an agent or a manager, you can perform a search for users, groups, shifts, schedules, or tasks using the search icon in Workforce Optimization for ITSM to easily find the information you need.

Note: To search shifts and schedules, you must generate the text index for the following tables before you start performing the search for shifts and schedules:
  • Schedule [sn_shift_planning_schedule_plan]
  • Shift Plan [sn_shift_planning_shift_plan]

Channels in Workforce Optimization for ITSM

Learn how you can use channels to route work to specific groups and with skill-based routing to ensure that the right work goes to the right agent. Monitor the health of your queues reviewing real-time performance and jumping in to help with escalations.

Manage queues and monitor real-time team performance from a central location using Channel Management.
As a channel manager, you can:

- Associate assignment groups to queues
- Monitor the health of your queues in real time
- Track team performance
- Monitor pending work items in the queue

**Example: channel management using Workforce Optimization for ITSM**

Understand how you can route work to specific groups and monitor real-time performance using Channel Management.

Ingrid manages IT operations for a large organization and has 12 teams reporting to her. Each of her teams has anywhere from 20 through 50 agents. She must ensure that incoming work gets effectively routed to the right groups across all channels.
As a manager, Ingrid must ensure that she can set up Channel Management to monitor team performance as follows:

- Add service channels and queues to route work items
- Add KPIs to the channels and queues to measure team performance
- Monitor her teams' ongoing work and performance
- Join chat conversations to assist agents

For detailed information on setting up channels using Workforce Optimization for ITSM, refer to Setting up Channels using Workforce Optimization for ITSM.

Scheduling in Workforce Optimization for ITSM

Learn how you can plan shifts with automatically staggered break times for your agents to effectively manage their schedule in Workforce Optimization for ITSM. Publish schedules for the next scheduling period to get a snapshot of which agent is lined up to solve issues for that time period.

Shift planning

Manage the scheduling for your organization from a central location. Use On-Call Scheduling with Workforce Optimization for ITSM to have dedicated team members to resolve issues as they arise.

The image below provides a high-level overview of the Scheduling application.
Scheduling
Manage on-call and regular shifts from a central location. Get the coverage you need and have dedicated agents to resolve issues as they arise.

Plan
Create shift plans that automatically stagger breaks to maximize coverage

Schedule
Create schedule plans, view them in real time, and publish the schedule for the next time period

Manage
Create time-off requests and swap shifts for your agents without going through an approval process

Forecast
Model demand scenarios to analyze agent forecast and view updated demand on the calendar

View team schedule
Know when your peers are working and when they are taking time off

Add events
Create events such as a meeting, training, or an ad hoc work shift

Request time off
Send a request for the span of time you want to take off

Swap shifts
Trade shifts with your peers

The image below provides a high-level overview of the tasks schedulers and agents can perform on the calendar.
As a shift planning administrator, you can:

• Create shifts to ensure customer coverage for the required span of time.
• Add breaks to the shifts that automatically stagger agent availability for those shifts.
• Preview the schedule and make necessary changes before publishing it to your agents.
• Access the schedule of all of your teams from one location.

As a shift planning agent, you can:

• Look up your schedule and request time off when required.
• Swap your shift with one of your peers.

**Example: scheduling using Workforce Optimization for ITSM**

Understand how you can set up and publish agent schedules and how your agents can manage their own schedule based on an example.

Ingrid manages IT operations for a large organization and has 12 teams reporting to her. Each of her teams has anywhere from 20 through 50 agents. At any given point, she needs visibility into her teams' schedule. She must also be able to create shifts, and approve or reject shift-swap or time-off requests from her agents.

As a manager, Ingrid can manage her entire teams' schedule using **Scheduling**. Ingrid’s team can manage their own schedule effectively by requesting shift-swaps or time-off.
Ingrid and her team can manage schedules by performing the following steps from one central location:

1. Create shift plan
2. Create a schedule plan
3. Assign agents to work shifts
4. Publish the schedule
5. Agents make requests to change the schedule or take time off
   For more information, refer to ITSM Agent Workspace - Scheduling.
6. Approve requests

Get an overview of how to you can create shift plans and assign agents to the shifts using the schedule plan in this video.

Workforce Optimization for ITSM Create Shift Plans
Get an overview of how you can monitor shifts and schedule for your entire team from a single location in this video.

Workforce Optimization for ITSM Monitor Team Schedule
Get an overview of how agents use the workspace to manage their schedule.

Workforce Optimization for ITSM Agent Schedule
For detailed information on creating and managing schedules using Workforce Optimization for ITSM, refer to Scheduling in Workforce Optimization for ITSM.

Demand Forecast in Workforce Optimization for ITSM
Learn how you can use Demand Forecast to predict resources based on historical data.

Here’s an overview of the Demand Forecast application. Demand Forecast for Workforce Optimization for ITSM
The Demand Forecast application uses MetricBase to forecast the demand for teams.
When you create demand forecast configurations, the application creates metrics:
- To forecast the number of agents you need for interactions.
- To resolve incidents throughout a given day.

⚠️ Note: You can create forecast configurations for any table.
Analyzing Demand Forecast resource prediction

Demand Forecast - Model Demand Scenarios

As a manager with the forecast admin role, you can create forecast parameters in the Workforce Optimization for ITSM Manager Workspace. Modify forecast parameters to visualize forecast data and preview time-series data before publishing it. You can create any number of forecasts to preview the time-series data in real time.

You can also make manual adjustments to tweak the forecast and analyze the forecast pattern. You can overlay the manual adjustments on the visualized forecast data and view the time-series data to analyze the forecast model. For example, if you have a specific pattern for the upcoming week but you know that a national holiday falls in the middle of the week where you need more agents because you expect the sales to go up, you can manually tweak the forecast to increase it by 10% and analyze that data.

Demand Forecast

The Demand Forecast application includes the following four modules:

<table>
<thead>
<tr>
<th>Demand forecast application modules</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Module Name</strong></td>
</tr>
<tr>
<td>Data Collection Definitions</td>
</tr>
<tr>
<td>Formula Parameters</td>
</tr>
<tr>
<td>Resource Conversion Formula</td>
</tr>
<tr>
<td>Group Forecast Configuration</td>
</tr>
</tbody>
</table>

As a forecast admin (sn_agent_forecast.admin), you can forecast the number of agents you need for a shift.

To forecast the demand:

1. Collect data by defining data collection definitions
2. Create forecast parameters.
3. Create formulas to convert the forecasting number of incidents into the number of resources you must respond to those incidents.
4. Associate the formulas to assignment groups.
5. View the predicted demand on the calendar.

**Note:** Refer to Workforce Optimization for ITSM Reference for information on default components and configurations installed with Demand Forecast.

### Collect data by defining data collection definitions

Use the **Data Collection Definitions** application to define the data you want to collect for forecasting agents.

- **Use the Collect daily data for automated forecast configurations** scheduled job to gather data for the metrics defined in the data collection definitions. The scheduled job fetches the records from the previous day for each hour and for every assignment group. It stores this data in the MetricBase.

  You can access the time series for the collected data using the MetricBase **list** on the Group [sys_user_group] table. For more information on accessing MetricBase data, refer to **Access MetricBase data using the list command**.

- **Use the Collect historical data for automated forecast configurations** on-demand job to collect hourly historical data. This job collects data for the past three years.

- **Use the Forecast resources for future** scheduled job to forecast the resources based on the collected data. The scheduled job stores the data in the Agent Forecast metric in MetricBase. Refer to the **Forecast properties** to set the collection frequency such as the number of days you must collect the data. You can use this information to calculate the forecast or the time period for which you want to store the data.

**Note:** The time series metrics created for data collection definitions use the **WFO Forecast** retention policy. This policy stores data at a one-hour interval for the past three years.

### Create formula parameters

Use numeric values or a script to define parameters to use in the formula for forecasting. Refer to **Forecast Parameters** for the forecast parameters available by default.

### Create formula to convert forecast to resources

Build formulas to convert the forecast to resources. Refer to **Resource Forecast Configurations** for the configured resource forecast formulas available by default.
**Associate formulas to assignment groups**

Associate assignment groups with the resource conversion formula to convert the number of incidents to agents.

**View the predicted demand on the calendar**

The data collected by the Agent Forecast metric in MetricBase is used to forecast the agents you need for each hour in a day. This data is displayed on the team calendar. In a Week view for the calendar, it displays the staffing levels for a given week.

**Related information**

- Set up Demand Forecast

---

**Teams in Workforce Optimization for ITSM**

Learn how you can organize each of your teams into assignment groups. You can then define a set of Key Performance Indicators (KPIs) to analyze the performance of all groups within that team. Drill into the metrics for a group, an agent, or an incident within that team—all from a central location.

**Teams**

Analyze the performance of your agents and teams, also known as assignment groups, with common indicators for consistent reporting across your teams.

- Organize the teams you manage into assignment groups
- Add a manager to the group
- Assign additional managers
- Add a primary assignment group for a user
- Create KPI groups for different types of teams
- Add indicators that matter most to your teams
- Associate the KPI group with multiple assignment groups that represent your teams
- Apply the KPI set once to a KPI group and it gets automatically applied to all groups within that team

Drill down into your reports.
As an administrator for **Teams**, you can:

- Create a KPI group for a common set of indicators (KPIs) you use to measure your teams' performance.

  ⚠ **Note:** Your teams are called assignment groups within the **Teams** application.

- Add the KPIs to the KPI group.
- Add assignment groups to the KPI group.

  ⚠ **Note:** Ensure that you have added a manager to each assignment group. The manager either directly manages the assignment group or needs visibility into the assignment group.

As a manager, you can:

- Analyze the performance trends for your teams.
- Drill down into the performance of teams, agents, or incidents.
**Example: teams using Workforce Optimization for ITSM**

Understand how you can manage your teams from a single location using an example.

Ingrid is the manager of IT Service Desk and directly manages 15 teams. She is an additional manager of other teams that she has visibility into although they don't directly report to her.

To effectively analyze the performance of her teams from one location, she sets up the Teams as follows:

1. Organizes her teams into groups called assignment groups. The teams either directly report to her or she may have visibility into their performance.
2. Creates a KPI group with a set of indicators that matter most to measure the performance of her assignment groups.
3. Adds all assignment groups that use the set of KPIs to the KPI group.

With this set up, she can effectively analyze the performance of her teams grouped by KPI groups.

Ingrid can set up and use Teams by performing the following steps:

1. Create a KPI group
2. Add KPIs to that group
3. Add managers to assignment groups
4. Add assignment groups to the KPI group
5. Drill down into a KPI, agent, or an incident to analyze performance

Get an overview of how you can set up team performance and how KPI aggregates are calculated.

**Workforce Optimization for ITSM**

Set Up Team Performance

Get an overview of how you can analyze team performance in this video.

Analyze Team Performance

For detailed information on how to setup and use Teams, see Teams.

---

**Coaching in Workforce Optimization for ITSM**

Learn how you can review and assess the quality of your team’s completed interactions and tasks. You can enhance your team’s skills set by assigning training that is based on those assessments. You can also add skills to your team’s profiles after they get trained.
Assess
Evaluate agents' skills based on quality of completed tasks.

Train
Recognize improvement opportunities and assign training tasks.

Improve
Monitor team performance for more improvement.

Coach admin

Train
Assign training tasks to agents based on the assessment.

Trainee

Assess
Assess agents' ability to complete assigned training.

Complete assigned training.
Here's an example of how Workforce Optimization for ITSM uses Predictive Intelligence to recommend skills for agents:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Predictive Intelligence associates the incidents that were closed using similar skills and then groups the tasks by the agents who resolved them.</td>
<td>Predictive Intelligence looks at the similarity between the tasks that were resolved using the skill Firewall.</td>
</tr>
<tr>
<td>2.</td>
<td>When agents resolve incidents, the Skill Recommendation application stores the skill and agent associations.</td>
<td>Agent A completes a task that requires the skill Firewall, but that skill is not in the agent's user profile yet.</td>
</tr>
<tr>
<td>3.</td>
<td>System administrators set the threshold for the skill and agent associations. When the threshold is reached, the Skill Recommendation application recommends to the agent's manager that the skill be added to an agent's profile.</td>
<td>The system administrator sets the threshold at 10. That means that the agents must have the same skill and complete 10 similar tasks. Agent A completes 10 tasks using the skill Firewall. The Skill Recommendation application recommends the skill Firewall for Agent A to the agent's manager.</td>
</tr>
<tr>
<td>4.</td>
<td>The manager approves and adds the skill to the agent's profile.</td>
<td>Agent A's manager approves the skill Firewall and adds that skill to Agent A's profile.</td>
</tr>
<tr>
<td>5.</td>
<td>Advanced work assignment (AWA) uses the new skills that were added to the agent's profile, looks up tasks that require those skills, and assigns the agents to complete those tasks.</td>
<td>When a task requires the skill Firewall, Agent A is automatically considered for that task assignment.</td>
</tr>
<tr>
<td>6.</td>
<td>Over time, the Predictive Intelligence machine learning algorithms learn which skills were assigned to the agents to resolve the incidents.</td>
<td></td>
</tr>
</tbody>
</table>

The infographic shows how you can use Predictive Intelligence to recommend skills for your agents.
As a coach, you can:

- Use surveys to evaluate your team’s performance.
- Recognize improvement opportunities and assign training tasks.
- Assess a trainee’s ability to resolve incidents.
• Assign training that is based on the assessments.
• Add skills to a trainee’s profile that is based on a recommendation from Predictive Intelligence.

As a trainee, you can get trained to address your skill gaps.

Example: coaching using Workforce Optimization for ITSM

Understand how you can assess your agents performance, identify skill gaps, and train them to enhance their skills sets with Coaching.

Ingrid manages IT operations for a large organization and has 12 teams reporting to her. Each of her teams has anywhere from 20 through 50 agents. She is also added as a manager of other teams where she needs visibility.

She wants a single location where she can:
• Monitor the skills that her teams use the most to solve issues
• Analyze metrics and monitor pending coaching assessments and training for the teams
• Add skills used for resolving issues or when Predictive Intelligence Workbench recommends them.

Ingrid can manage all of these actions by doing the following:
1. Set conditions that trigger coaching opportunities.
2. Assess her agents’ skills and assign training.
3. Add skills to agent profile when they complete training or using recommendations from Predictive Intelligence.

Get an overview on coaching, creating assessments, taking surveys, assigning training, and adding skills.

Workforce Optimization for ITSM Coaching Overview
Get an overview of how you can add skills manually or the ones recommended using Predictive Intelligence and the Skill Recommendation application.

Workforce Optimization for ITSM Skill Recommendation
For detailed instructions on setting up and using Coaching for Workforce Optimization for ITSM, see Coaching.
Setting up Workforce Optimization for ITSM

Enable Workforce Optimization for ITSM and configure settings to use the Teams, Coaching, Scheduling, and Channel Management applications.

Activate Workforce Optimization for ITSM

The Workforce Optimization for ITSM plugin (com.snc.wfo_itsm) is available as a separate subscription.

Before you begin
Role required: admin

About this task
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

<table>
<thead>
<tr>
<th>Workforce Optimization for ITSM plugins</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Plugin</strong></td>
</tr>
<tr>
<td>Workforce Optimization for ITSM</td>
</tr>
<tr>
<td>(com.snc.wfo_itsm)</td>
</tr>
<tr>
<td>ITSM Agent Workspace</td>
</tr>
<tr>
<td>(com.snc.agent_workspace.itsm)</td>
</tr>
<tr>
<td>MetricBase</td>
</tr>
<tr>
<td>(com.snc.clotho)</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
## Workforce Optimization for ITSM plugins (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITSM Virtual Agent Conversations (com.snc.itsm.virtualagent)</td>
<td>Activates the ITSM Virtual Agent and enables you to use virtual agent to create time-off requests.</td>
</tr>
<tr>
<td><strong>Note:</strong> This is a ServiceNow Store plugin. You must install this plugin separately from the ServiceNow Store.</td>
<td></td>
</tr>
<tr>
<td>ITSM Mobile Agent v5.0 for Workforce Optimization for ITSM</td>
<td>Activates the ITSM Mobile Agent and enables agents to request shift-swaps or time off and managers to approve the requests using the ITSM Mobile Agent application.</td>
</tr>
<tr>
<td><strong>Note:</strong> This is a ServiceNow Store plugin. You must install this plugin separately from the ServiceNow Store.</td>
<td></td>
</tr>
<tr>
<td>Workforce Optimization Content Pack for ITSM (sn_wfo_itsm_cnt)</td>
<td>Activates enhanced features related to Coaching and Schedule modules. Enable this plugin to use the following features:</td>
</tr>
<tr>
<td><strong>Note:</strong> This is a ServiceNow Store plugin. You must install this plugin separately from the ServiceNow Store.</td>
<td></td>
</tr>
<tr>
<td>Coaching with Learning (sn_coach_lrn)</td>
<td>Activates the Coaching with Learning application and enables you to integrate the Learning module with the Coaching application and the spokes to integrate with external learning applications.</td>
</tr>
<tr>
<td><strong>Note:</strong> This is a ServiceNow Store plugin. You must install this plugin separately from the ServiceNow Store.</td>
<td></td>
</tr>
</tbody>
</table>
Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Workforce Optimization for ITSM Reference

Workforce Optimization for ITSM installs the roles and tables when you enable the Workforce Optimization for ITSM plugin (com.snc.wfo_itsm).

Workforce Optimization for ITSM

<table>
<thead>
<tr>
<th>Roles</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workforce Optimization User [sn_wfo.user]</td>
<td>Grants read access to primary group and additional managers.</td>
<td>• pa_analyst</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_agent_forecast.user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• approver_user</td>
</tr>
<tr>
<td>Workforce Optimization Admin [sn_wfo.admin]</td>
<td>Grants administrative rights to create, read, update, and delete (CRUD)</td>
<td>• sn_wfo.user</td>
</tr>
<tr>
<td></td>
<td>additional managers.</td>
<td>• pa_analyst</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_agent_forecast.admin</td>
</tr>
<tr>
<td>Workforce Optimization ITSM Manager</td>
<td>Grants rights to create, read, or update, coaching, scheduling,</td>
<td>• sn_wfo.user</td>
</tr>
<tr>
<td>ITSM Manager [sn_wfo_itsm.manager]</td>
<td>teams, or channel</td>
<td>• sn_shift_planning.agent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_coaching.trainee</td>
</tr>
</tbody>
</table>
### Roles (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
|                   | management applications. | • sn_team_performance.user  
|                   |             | • sn_channel_mgmt.user  
|                   |             | • sn_mgr_workspace.manager  |
| Workforce Optimization ITSM Employee [sn_wfo_itsm.employee] | Grants read rights for coaching, scheduling and teams applications. | • sn_wfo.user  
|                   |             | • sn_shift_planning.agent  
|                   |             | • sn_coaching.trainee  
|                   |             | • sn_team_perf.team_performance_user  
|                   |             | • awa_agent  |
| Workforce Optimization ITSM Admin [sn_wfo_itsm.admin] | Grants administrative rights to create, read, update, and delete (CRUD) coaching, scheduling, teams, or channel management applications. | • sn_mgr_workspace.manager  
|                   |             | • sn_wfo.user  
|                   |             | • sn_shift_planning.admin  
|                   |             | • coaching.admin  
|                   |             | • sn_team_perf.team_performance_admin  
|                   |             | • sn_mgr_workspace.admin  
|                   |             | • sn_sre.skill_recommendation_admin  
|                   |             | • skill_model_admin  |

### Filter Configuration Tables

<table>
<thead>
<tr>
<th>Module Name</th>
<th>Module Tables / Database View</th>
</tr>
</thead>
</table>
| Schedule    | • User [sys_user]  
|             | • User Skill [sys_user_has_skill]  
|             | • Agent Schedule [sys_shift_planning_agent_schedule]  
|             | • Schedule Event [sn_shift_planning_event]  
|             | • Manager Groups database view [sn_wfo_manager_group]  |
Filter Configuration Tables (continued)

<table>
<thead>
<tr>
<th>Module Name</th>
<th>Module Tables / Database View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching</td>
<td>• Skill [cmn_skill]</td>
</tr>
<tr>
<td></td>
<td>• Skill Category M2M [cmn_skill_m2m_category]</td>
</tr>
<tr>
<td></td>
<td>• Group Member [sys_user_grmember]</td>
</tr>
<tr>
<td>Channels</td>
<td>Manager Groups database view [sn_wfo_manager_groups]</td>
</tr>
</tbody>
</table>

Scheduled job

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WFO data collection</td>
<td>Runs the job on demand and collects data for all Workforce Optimization for ITSM indicators.</td>
</tr>
</tbody>
</table>

ITSM Manager Workspace

Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manager Workspace User [sn_mgr_workspace.user]</td>
<td>Grants read access to home and list modules.</td>
<td>• workspace_user&lt;br&gt;• sn_channel_mgmt.user</td>
</tr>
<tr>
<td>Manager Workspace Manager [sn_mgr_workspace.manager]</td>
<td>Grants read access to primary groups, additional managers, and the approval button.</td>
<td>• sn_mgr_workspace.user&lt;br&gt;• sn_wfo.user</td>
</tr>
<tr>
<td>Manager Workspace Admin [sn_mgr_workspace.admin]</td>
<td>Grants administrative rights to create, read, update, and delete (CRUD) all applications and settings in Manager Workspace.</td>
<td>• sn_mgr_workspace.manager&lt;br&gt;• workspace_admin&lt;br&gt;• ui_builder_admin</td>
</tr>
</tbody>
</table>
Properties

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cnm_skills.ws_max_users_swap_skill_matrix</td>
<td>The limit for the number of users to swap axes in the skill matrix.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 50</td>
</tr>
</tbody>
</table>

Indicators

<table>
<thead>
<tr>
<th>Indicator Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed Incidents</td>
<td>Number of incidents closed.</td>
</tr>
<tr>
<td>Customer Satisfaction</td>
<td>Average customer satisfaction for incidents based on CSAT survey results. This indicator is associated with agent and assignment group breakdowns. It provides the customer satisfaction survey results for each agent and the agent’s team.</td>
</tr>
<tr>
<td>Quality</td>
<td>Provides calculated assessment feedback score.</td>
</tr>
<tr>
<td>Average Handling Time (MTTR)</td>
<td>Mean time taken to resolve an incident.</td>
</tr>
<tr>
<td>First Call Resolution</td>
<td>Percentage of incidents resolved on first call.</td>
</tr>
<tr>
<td>Trainee Quality Rating</td>
<td>Average score, in percentage, of all surveys taken by the coach to assess the trainee.</td>
</tr>
</tbody>
</table>

**Important:** This feature is available with the Workforce Optimization Content Pack for ITSM (sn_wfo_itsm_cnt) from the ServiceNow Store. To enable this feature, see Workforce Optimization for ITSM Reference.

Channel Management

Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Management User [sn_channel_mgmt.user]</td>
<td>Grants read access to channel reports, channel</td>
<td>awa_manager</td>
</tr>
</tbody>
</table>
Roles (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Management Admin [sn_channel_mgmt.admin]</td>
<td>Grants administrative rights to create, read, update, and delete (CRUD) channel reports, channel view, and queue report tables.</td>
<td>• sn_channel_mgmt.user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• awa_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_wfo.admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• report_admin</td>
</tr>
</tbody>
</table>

Note: To use channel management properties, they must be added to the System Property [sys_properties] table. For information on how to add a system property, refer to **Add a system property**.

Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_channel_mgmt.list_auto_refresh.enable</td>
<td>Selectable disable auto refresh of lists in Channel Management.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> True or False</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> True</td>
</tr>
<tr>
<td>sn_channel_mgmt.list_auto_refresh.interval.seconds</td>
<td>Define the auto refresh interval for the channel management list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 30</td>
</tr>
<tr>
<td>sn_channel_mgmt.kpi_auto_refresh.interval.seconds</td>
<td>Set the frequency for refreshing data on channel management indicators.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 5</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Report name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interaction Work Items Assigned Today</td>
<td>Number of interaction work items assigned on a given day.</td>
</tr>
<tr>
<td>Report name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Abandoned Interaction Work Items</td>
<td>Number of abandoned interaction work items.</td>
</tr>
<tr>
<td>Unassigned Interaction Work Items</td>
<td>Number of interaction work items not assigned to agents.</td>
</tr>
<tr>
<td>Average Work Item CSAT Score</td>
<td>Customer Satisfaction score for an average work item.</td>
</tr>
<tr>
<td>Unassigned Incident Work Items</td>
<td>Number of incident work items not assigned to agents.</td>
</tr>
<tr>
<td>Completed Interaction Work Items</td>
<td>Number of interaction work items completed by agents.</td>
</tr>
<tr>
<td>Today's Average Interaction Service Time</td>
<td>Average time it takes to close an interaction.</td>
</tr>
<tr>
<td>Interaction Work Items Resolved Today</td>
<td>Average number of interaction work items resolved on a given day.</td>
</tr>
<tr>
<td>New Incident Work Items Created Today</td>
<td>New work items created for incidents on a given day.</td>
</tr>
<tr>
<td>Average Handling time for Interaction Work Items</td>
<td>Average time taken to resolve interaction work items.</td>
</tr>
<tr>
<td>Agents Available to take Interaction Work Items</td>
<td>Number of agents available to work on the interaction work items.</td>
</tr>
<tr>
<td>Breached SLA Incident Work Items</td>
<td>Number of work items with breached SLAs.</td>
</tr>
<tr>
<td>Open P1 Incident Work Items</td>
<td>Number of work items open for P1 incidents.</td>
</tr>
<tr>
<td>Incident Work Items Resolved Today</td>
<td>Number of work items resolved on a given day.</td>
</tr>
<tr>
<td>Average Walkup Interaction Wait Time</td>
<td>The average time a user is in queue before starting a walk-up interaction.</td>
</tr>
<tr>
<td>Currently Waiting Interaction Work Item</td>
<td>Work items currently in queue waiting to be processed.</td>
</tr>
</tbody>
</table>
# Scheduling

## Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Planning User [sn_shift_planning.user]</td>
<td>Grants read access for scheduling including the ability to view schedules and shifts.</td>
<td></td>
</tr>
<tr>
<td>Shift Planning Agent [sn_shift_planning.agent]</td>
<td>Grants agents access to their calendar. Agents can request shift swap or time off.</td>
<td>sn_shift_planning.user</td>
</tr>
<tr>
<td>Shift Planning Admin [sn_shift_planning.admin]</td>
<td>Grants administrative access to create, read, update, and delete (CRUD) schedules and work shifts.</td>
<td>sn_shift_planning.approver, sn_shift_planning.user, sn_shift_planning.agent</td>
</tr>
</tbody>
</table>

## Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_shift_planning.number_of_days_to_cache</td>
<td>Number of days to cache agent schedules.</td>
</tr>
<tr>
<td>- Type: Integer</td>
<td></td>
</tr>
<tr>
<td>- Default value: 5</td>
<td></td>
</tr>
<tr>
<td>sn_itsm_mobile_agent.events_query_days_past</td>
<td>The maximum number of days past events for your shifts can be displayed on your mobile application. You can enter values that range from -1 to -31.</td>
</tr>
<tr>
<td>- Type: Integer</td>
<td></td>
</tr>
<tr>
<td>- Default value: -31</td>
<td></td>
</tr>
<tr>
<td>sn_itsm_mobile_agent.events_query_days_future</td>
<td>The maximum number of days future events for your shifts can be displayed on your mobile application. You can enter values that range from 1 to 90.</td>
</tr>
<tr>
<td>- Type: Integer</td>
<td></td>
</tr>
<tr>
<td>- Default value: 90</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Shift Planning - Delete All Agent Schedules Cache</td>
<td>Deletes cache from the sn_shift_planning_agent_availability table.</td>
</tr>
<tr>
<td></td>
<td>• Runs automatically everyday at 2:30 am</td>
</tr>
<tr>
<td></td>
<td>• Run this job on-demand when you import data.</td>
</tr>
</tbody>
</table>

Setting the due date for time-off and shift-swap request approvals: Administrators can configure the due date logic for the Time Off Request and Shift Swap Request approval flows. The approval due date is set as the number of days before the request start date. The default is set to two days which means if the approval is not approved two days before the request start date, it will be auto-rejected. For information on configuring flows, refer to Build your first flow in Flow Designer.

Demand Forecast

<table>
<thead>
<tr>
<th>Forecast configurations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>----------------------------------</td>
</tr>
<tr>
<td>Chat Interactions Created</td>
</tr>
<tr>
<td>Non P1 Incidents Created</td>
</tr>
<tr>
<td>P1 Incidents Created</td>
</tr>
<tr>
<td>Walkup Interactions Created</td>
</tr>
</tbody>
</table>

The WFO Forecast time series metric retention policy is available by default for all forecast configurations. By default, this retention policy stores data at a one-hour interval for the past three years.
## Resource Forecast Configurations

<table>
<thead>
<tr>
<th>Name</th>
<th>Formula to create this resource forecast configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat Interactions to Agent Conversion</td>
<td>([\text{FC:Chat Interactions Created}] \times \frac{\text{Average Chat Duration}}{\text{Average Agent Work Time Per Day}})</td>
</tr>
<tr>
<td>Incident and Interaction Resources</td>
<td>(\text{[FC:Incidents Created to Agent Conversion]} + \frac{\text{[FC:Chat Interactions to Agent Conversion]}}{\text{[FC:Walkup Interactions to Agent Conversion]}})</td>
</tr>
<tr>
<td>Incidents Created to Agent Conversion</td>
<td>(\frac{\text{[FC:P1 Incidents Created] \times \text{Average P1 Incident Work Time}}}{\text{Average Agent Work Time Per Day}} + \frac{\text{[FC:Non P1 Incidents Created] \times \text{Average Non P1 Incident Work Time}}}{\text{Average Agent Work Time Per Day}})</td>
</tr>
<tr>
<td>Walkup Interactions to Agent Conversion</td>
<td>(\frac{\text{[FC:Walkup Interactions Created] \times \text{Average Walkup Duration}}}{\text{Average Agent Work Time Per Day}})</td>
</tr>
</tbody>
</table>

## Forecast Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Agent Work Time Per Day</td>
<td>Average time an agent works in a given day.</td>
</tr>
<tr>
<td>Average Chat Duration</td>
<td>Average duration of an agent chat for each incident or interaction.</td>
</tr>
<tr>
<td>Average Non P1 Incident Work Time</td>
<td>Average time an agents spends working on all incidents that are not categorized as Priority 1.</td>
</tr>
<tr>
<td>Average P1 Incident Work Time</td>
<td>Average time an agents spends working on all incidents that are categorized as Priority 1.</td>
</tr>
<tr>
<td>Average Walkup Duration</td>
<td>Average duration an agent spends on a walkup interaction.</td>
</tr>
</tbody>
</table>

If you create forecast parameters for a forecast configuration, the values set in the configuration are used instead of the default forecast parameters listed in the forecast properties section. For information on configuring forecast parameters, see **Modify forecast parameters to visualize forecast data**.
## Forecast Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_agent_forecast.historical_data_points</td>
<td>The hourly historical data points to be used for the forecast. The maximum allowed data points is 26280. The default value is 8760 and represents the hourly data points for a one year time period (24 hours x 365 days x 1 year).</td>
<td>For example: 24 hours x 365 days x 3 years = 26280</td>
</tr>
<tr>
<td>sn_agent_forecast.seasonal_frequency</td>
<td>The seasonal frequency of a repeated pattern. The default value is 168.</td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td>• Daily data pattern = 1 * 24 = 24</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Weekly data pattern = 7 * 24 = 168</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Monthly data pattern = 30 * 24 = 720</td>
<td></td>
</tr>
<tr>
<td>sn_agent_forecast.forecast_periods</td>
<td>The number of periods/seasons to forecast. A period is the length of a season. The default value is 5.</td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td>• If the length of a season is daily which is equal to 24 hours (1 day) and the forecast period is 30, then the number of periods to forecast is equal to 24 * 30 = 720 hours.</td>
<td></td>
</tr>
</tbody>
</table>
### Forecast Properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If the length of a season is weekly which is equal to 168 hours (1 week) and the forecast period is 5, then the number of periods to forecast is equal to 168 * 5 = 840 hours.</td>
<td></td>
</tr>
</tbody>
</table>

| sn_agent_forecast.number_of_historical_days_in_timeseries_chart | The number of historical days that will be plotted in the time-series chart in Manager Workspace. | For example, if the number is set to 90, then the number of days is counted from the current day to 90 days ago. |

### Roles for Demand Forecast

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Forecast admin [sn_agent_forecast.admin] | Grants administrative rights to create, read, update, and delete (CRUD) forecast configuration tables. | • sn_agent_forecast.users  
• clotho_admin |
| Forecast user [sn_agent_forecast.user] | Grants read access to forecast configuration tables. | |
### Tables for Demand Forecast (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_agent_forecast_configuration_m2m_sys_user] Forecast Configuration group</td>
<td>Associate resource conversion formula with assignment groups.</td>
</tr>
</tbody>
</table>

By default, forecast configurations are available for the following groups:

- Deskside Support
- IT Service Desk
- Application Support
- Technical Support

### Schedule jobs for Demand Forecast

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collect historical data for automated forecast configurations</td>
<td>• On-demand job to collect historical data</td>
</tr>
<tr>
<td></td>
<td>• Collects historical data daily for every hour for the past three years</td>
</tr>
<tr>
<td>Collect daily data for automated forecast configurations</td>
<td>• Runs daily at 2 am</td>
</tr>
<tr>
<td></td>
<td>• For each table defined in the Data Collection Definition configuration, it fetches the records from the previous day for each hour for every group and stores it in the MetricBase</td>
</tr>
<tr>
<td></td>
<td>• You can access the time series for the collected data using the MetricBase list command on the Group [sys_user_group] table</td>
</tr>
<tr>
<td></td>
<td>• Uses the WFO Forecast retention policy for data retention</td>
</tr>
</tbody>
</table>
Schedule jobs for Demand Forecast (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forecast resources for future</td>
<td>Calculates the forecast resources for the future based on the collected data.</td>
</tr>
<tr>
<td></td>
<td>• Runs daily at 3 am</td>
</tr>
<tr>
<td></td>
<td>• Collects hourly data every day for the formula forecast configuration</td>
</tr>
<tr>
<td></td>
<td>• Stores the data in the Agent Forecast metric in MetricBase</td>
</tr>
<tr>
<td></td>
<td>• Uses forecast properties to set the data collection frequency or time period to store the data. The forecast properties will not be used if a published forecast parameter exists for a data collection definition.</td>
</tr>
</tbody>
</table>

Teams

Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teams User</td>
<td>Grants access to read KPI tables.</td>
<td>wfo.user</td>
</tr>
<tr>
<td>[sn_team_perf.team_performance_user]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Teams Admin</td>
<td>Grants access to create and configure KPIs, KPI groups, and assignment groups in the Teams module.</td>
<td>wfo.admin</td>
</tr>
<tr>
<td>[sn_team_perf.team_performance_admin]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_team_perf.kpi_group.max_parent_kpis</td>
<td>The maximum number of parent indicators that you can add to one KPI group.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 5</td>
</tr>
</tbody>
</table>
Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_team_perf.kpi_group.max_supporting_kpis</td>
<td>The maximum number of supporting KPIs you can define for a parent KPI.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 10</td>
</tr>
<tr>
<td>sn_team_perf.ws.max_assignment_groups</td>
<td>The maximum number of assignment groups prioritized by order number to display on the Teams application in Manager Workspace.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 15</td>
</tr>
<tr>
<td>sn_team_perf.default_date_range</td>
<td>The default date range set in the date range picker.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 30</td>
</tr>
</tbody>
</table>

Coaching

Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Coaching Admin [sn_coaching.admin] | Grants administrative rights to create, read, update, and delete (CRUD) coaching opportunities, assessments, training, and skills. | • sn_coaching.coach  
• sn_lc.learning_admin |
| Coaching Coach [sn_coaching.coach] | Grants administrative rights to create, read, or update coaching opportunities, assessments, training, and skills. | • sn_coaching.trainee  
• pa_viewer  
• sn_lc.catalog_manager |
Roles (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching Trainee [sn_coaching.trainee]</td>
<td>Grants access to add training, assessments, and skill records.</td>
<td>• skill_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• survey_reader</td>
</tr>
</tbody>
</table>

**Important:** This feature is available with the Workforce Optimization Content Pack for ITSM (sn_wfo_itsm_cnt) from the ServiceNow Store. To enable this feature, see Workforce Optimization for ITSM Reference.

Coaching Opportunities

<table>
<thead>
<tr>
<th>This coaching opportunity</th>
<th>Triggers when</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching on Incident SLA Breach</td>
<td>An SLA is breached.</td>
</tr>
<tr>
<td>Coaching on interaction long call time</td>
<td>A phone call lasts longer than 10 minutes.</td>
</tr>
<tr>
<td>Coaching on interaction long chat time</td>
<td>A chat interaction lasts longer than 30 minutes.</td>
</tr>
<tr>
<td>Coaching on interaction long walk-up time</td>
<td>A walk-up interaction lasts longer than 60 minutes.</td>
</tr>
</tbody>
</table>

**Important:** This feature is available with the Workforce Optimization Content Pack for ITSM (sn_wfo_itsm_cnt) from the ServiceNow Store. To enable this feature, see Workforce Optimization for ITSM Reference.

Coaching Surveys

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone Quality Survey</td>
<td>Survey associated with the Phone Interaction coaching opportunity. The coach assess the agent using this survey after the agent completes a phone interaction.</td>
</tr>
<tr>
<td>Chat Quality Survey</td>
<td>Survey associated with the Chat Interaction coaching opportunity. The coach assess the agent using this survey after the agent completes a chat interaction.</td>
</tr>
</tbody>
</table>
Coaching Surveys (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-up Quality Survey</td>
<td>Survey associated with the Walk-up Interaction coaching opportunity. The coach assess the agent using this survey after the agent completes a walk-up interaction.</td>
</tr>
</tbody>
</table>

Business rule

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate coaching survey score</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
<td>Sets the feedback rating based on the survey score.</td>
</tr>
</tbody>
</table>

Coaching with Learning

**Important:** This feature is available with the Coaching with Learning (sn_coach_lrn) from the ServiceNow Store. To enable this feature, see Activate Workforce Optimization for ITSM.

For roles and tables installed with the Coaching with Learning (sn_coach_lrn) plugin, see Components installed with Learning Core The ServiceNow Learning Core application enables you to build a learning content repository by integrating with third-party Learning Management Systems, such as Cornerstone OnDemand, Udemy and PluralSight.

Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.sn_coaching_assessment_activity</td>
<td>Edit coaching assessment activities.</td>
</tr>
<tr>
<td>sn_coaching.recommended_learning deprecated</td>
<td>Recommended Trainings is being deprecated and replaced with the Learning Tasks and course items from Coaching with Learning.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_coach.lrn.exclude_weekends_on_learning_task_due_date | Enable property to exclude weekends while setting the due date for learning tasks.  
  - **Type**: true | false  
  - **Default value**: true |
| sn_coach_lrn.learning_list_menu_props         | Data array properties for the now-list-menu component on the Learning Tasks tab, coaching module.  
  - **Type**: string  
  - **Default value**: script for data array |
| com.glide.transform.json.max-partial-length   | Transforms JSON objects to internal objects and sets the word limit for records fetched through an API call.  
  - **Type**: integer  
  - **Default value**: 16384 |

**Note:**  
You must add this system property to set the desired value.  
When you synchronize third-party learning content with your ServiceNow instance, if the word count of the content being pulled into your instance exceeds the value set for this property, the synchronization will fail.

| com.snc.process_flow.reporting.serialized.val_size_limit | Specify the number of bytes allowed for runtime values in each step in the flow execution details. To prevent truncation, set the value to an integer equal to or less than zero. |
### Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Type</strong>: integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 16384</td>
</tr>
<tr>
<td>Note:</td>
<td>When you synchronize third-party learning content with your ServiceNow instance, if the word count of the content being pulled into your instance exceeds the value set for this property, the synchronization will fail.</td>
</tr>
</tbody>
</table>

### Skill Recommendation

### Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skill Recommendation User [sn_sre.user]</td>
<td>Grants rights to view skill recommendation tables.</td>
<td>wfo.user</td>
</tr>
<tr>
<td>Skill Recommendation Admin [sn_sre.admin]</td>
<td>Grants administrative rights to edit the properties for skill recommendation.</td>
<td>wfo.admin, sn_sre.user</td>
</tr>
</tbody>
</table>

Navigate to **Skill Recommendation > Configuration** to configure these properties.

### Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable skill recommendation.</td>
<td>Enable this property.</td>
</tr>
<tr>
<td>sn_sre.enable_skill_recommendation</td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>:</td>
</tr>
<tr>
<td></td>
<td>Maximum number of skills to predict based on supervised learning.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_sre.max_supervised_skills</td>
<td>Maximum number of skills to predict based on supervised learning.</td>
</tr>
<tr>
<td>sn_sre.max_unsupervised_skills</td>
<td>Using unsupervised learning, the maximum number of skills to predict for each incident ordered by confidence of prediction.</td>
</tr>
<tr>
<td>sn_sre.number_of_similar_incidents</td>
<td>The number of resolved similar tasks to use for predicting skills.</td>
</tr>
<tr>
<td>sn_sre.user_predicted_skill_threshold</td>
<td>The number of times Predictive Intelligence must predict the same skill for an agent before recommending it for the agent.</td>
</tr>
<tr>
<td>sn_sre.unsupervised_solution_definition_for_incidents</td>
<td>Similarity solution definition to recommend skills from similar incidents.</td>
</tr>
<tr>
<td>sn_sre.supervised_solution_definition_for_incidents</td>
<td>Similarity solution definition to recommend skills for incidents.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Scheduled job

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start skill prediction</td>
<td>Runs the job every day at 1 AM on all incidents that were closed the previous day. Recommends the skills used to close the incidents to resolve similar open incidents.</td>
</tr>
</tbody>
</table>

### Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| User Predicted Skill [sn_sre_user_predicted_skill] | • Stores how many times a skill has been predicted for the user.  
• Skills not recommended in the last 60 days are automatically deleted from this table. |
| Task Predicted Skill [sn_sre_task_predicted_skill] | • Stores the skills predicted to resolve each type of incident.  
• Tables created over 60 days ago are automatically deleted from this table. |

### Domain separation and Workforce Optimization for ITSM

Domain separation is supported in Workforce Optimization for ITSM. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

### Support level: Basic

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.
Sample use case: When a service provider (SP) uses chat to respond to a tenant CUSTOMER’S message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

**How domain separation works in Workforce Optimization for ITSM**

Domain separation is supported in Workforce Optimization for ITSM and does not require any setup or configuration.

**Domain separation for Channels Workforce Optimization for ITSM**

For information on how domain separation works in Channel Management for Workforce Optimization for Customer Service, refer to Domain separation and Advanced Work Assignment

Domain separated tables for Channel Management

- sn_customerservice_case
- interaction

**Domain separation for Scheduling Workforce Optimization for ITSM**

When an agent schedule is generated and assigned to an agent, the schedule is only available in the domain to which that agent belongs.

Domain separated tables for Scheduling

- sn_shift_planning_agent_schedule
- sn_shift_planning_agent_schedule_request
- sn_shift_planning_break
- sn_shift_planning_day
- sn_shift_planning_event
- sn_shift_planning_schedule_plan
- sn_shift_planning_schedule_shift
- sn_shift_planning_schedule_shift_agent
- sn_shift_planning_shift_plan
- sn_shift_planning_shift_swap_request

**Domain separation for Teams in Workforce Optimization for ITSM**

The sn_wfo_add_manager table is domain separated. When users are added as additional managers, those users can only view users within that domain.
Domain separation for Skill Recommendation in Workforce Optimization for ITSM
Domain separated tables for Skill Recommendation
- sn_sre_task_predicted_skill
- sn_sre_user_predicted_skill

Domain separation for Coaching in Workforce Optimization for ITSM
For information on how domain separation works in Coaching for Workforce Optimization for ITSM, refer to Domain separation and Coaching

Setting up Channels in Workforce Optimization for ITSM
Channel administrators can set up service channels and work item queues and then automatically route incoming work to agents. Managers can monitor their agents' work across all channels and drill down into the KPIs to analyze team performance.

Set up Channel Management using the information provided below. To use Channel Management, refer to Channels in Workforce Optimization for ITSM

Add service channels and queues
Add service channels and queues to automatically route incoming work items to agents.

Before you begin
Role required: sn_channel_mgmt.admin

About this task
A service channel is a means of assigning a specific type of work items to agents. You can modify the existing service channels or create your own custom service channel.

Procedure
1. To create a service channel, do the following:
   a. Navigate to Workforce Optimization for ITSM > Channel Management > Service Channels.
   b. Click New and refer to the information in the Create a service channel to create the service channel.
   c. Click Submit. The service channel is created.
2. To create a queue, do the following:
   a. Navigate to Workforce Optimization for ITSM > Channel Management > Queues or select the service channel and click the Queues tab.
   b. Click New and refer to the information in Create a work item queue to create the queue. The queue is created in the service channel.

Create assignment rules and groups
Define assignment rules and specify groups of agents eligible to receive overflow work assignments for a queue. An eligible assignment group can consist of one or more groups of agents available to work on items in the queue. This feature helps to find a qualified agent from a wider group of agents.

Before you begin
Role required: sn_channel_mgmt.admin

Procedure
1. Navigate to Workforce Optimization for ITSM > Channel Management > Queues
2. Select a queue to define an assignment rule.
3. In the Assignment Eligibility tab, click New.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent assignment rule</td>
<td>Name of the rule to assign work items to agents.</td>
</tr>
<tr>
<td>Eligible at</td>
<td>The duration that this assignment rule is valid for a set of agents.</td>
</tr>
<tr>
<td>Groups</td>
<td>The set of groups eligible for assignment.</td>
</tr>
<tr>
<td></td>
<td>• Click the lock icon to unlock it and select the agent groups in the eligible assignment pool.</td>
</tr>
<tr>
<td></td>
<td>• Click the lock icon to lock it.</td>
</tr>
</tbody>
</table>

5. Click Submit to create the eligible or Update if modifying an eligible assignment pool.
The Queues [awa_queues] table is updated with the eligible assignment group.

ℹ️ Note: For a new service channel, you must first create a new assignment rule and then create a service channel.

Configure KPIs for service channels
Configure key performance indicators in service channels to track the ongoing work and real-time performance of your teams.

Before you begin
Role required: sn_channel_mgmt.admin

About this task
Add key performance indicators to channels to help managers perform the following actions:

• Review real-time performance as the team is actively working on tasks across channels and queues.
• Track progress against KPIs and drill down into agents, team, and individual performance.
• Drill down into all queues and monitor ongoing cases, interactions, and tasks.
• Jump in and support agents for help requested work items using chat whisper or add work notes to a task.

Procedure
1. Click the service channel to which you want to add KPIs.
2. In the Reports tab, click Edit.

ℹ️ Note: You must add the Reports related list if you do not see the Reports tab.

3. Add Workforce Optimization for ITSM KPIs filtered based on My Managed Groups. To create reports that are explicitly applicable to your managed teams, refer to Create a report.

4. Click Submit.
   The key performance indicators are added to the service channel and appears in the Channels and Queues page in Manager Workspace. The first five KPIs that are configured with the lowest order number appear in the service channel. By default, the key performance indicators are
automatically refreshed at an interval of five seconds. You can add the `sn_channel_mgmt.kpi_auto_refresh.interval.seconds` property in the system properties to modify the interval time of the single score KPIs.

**Configure KPIs for queues**

Configure key performance indicators in queues to track the incoming work for specific categories of work in a service channel.

**Before you begin**
Role required: sn_channel_mgmt.admin

**Procedure**

1. Add KPIs to a queue.

<table>
<thead>
<tr>
<th>To</th>
<th>Do This</th>
</tr>
</thead>
</table>
| Add from a service channel | a. Navigate to Workforce Optimization for ITSM > Channel Management > Service Channel  
  b. Select a service channel.  
  c. Select the Queue tab.  
  d. Select a queue. |
| Add from a queue | a. Navigate to Workforce Optimization for ITSM > Channel Management > Queues  
  b. Select a queue. |

2. Click the **Reports** tab.

   **Note:** You may have to configure the related list to display the **Reports** tab.

3. Click **Edit**.

4. Add Workforce Optimization for ITSM KPIs (reports) that are filtered based on **My Managed Groups**. To create reports that explicitly apply to your managed teams, refer to **Create a report**.

5. Click **Submit**.

   The key performance indicators are added to the queue and appear in the **All Queues** tab in Manager Workspace. By default, the indicators get
automatically refreshed at an interval of five seconds. You can add the `sn_channel_mgmt.kpi_auto_refresh.interval.seconds` property to the system properties to modify the interval time.

**Configure supervisor lists for service channels**
Create a database view in a service channel.

**Before you begin**
Role required: sn_channel_mgmt.admin

**Procedure**
1. Navigate to **Workforce Optimization for ITSM > Channel Management > Service Channels**.
2. Select the service channel to which you want to add a supervisor list.
3. Click the **Supervisor Lists** tab.
4. Click **New**.
5. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Title</td>
<td>The display name for the list.</td>
</tr>
<tr>
<td>Tab Title</td>
<td>Title for the tab that displays in workspace.</td>
</tr>
<tr>
<td>Service Channel</td>
<td>A service channel that has the supervisor list.</td>
</tr>
<tr>
<td>View Name</td>
<td>Select the database view for the service channel.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter the number to display the order.</td>
</tr>
</tbody>
</table>

6. Click **Update**.
   The supervisor list is added to the service channels in Manager Workspace.

**Setting up Scheduling in Workforce Optimization for ITSM**
Manage events using the team calendar. You can create different types of event categories and use scripted extension points to customize the event types.
Configure event categories for the ITSM Manager Workspace

Add an event category. Create or update field configurations for events. You can also specify if an event category must be excluded when the shift coverage for agents are calculated.

Before you begin
Role required: sn_shift_planning.admin

The following event category configurations are available by default:
- Work
- Meeting
- Training
- Time Off
- Break

Procedure

1. Navigate to Workforce Optimization for ITSM > Scheduling > Event Categories.
2. In the Event Categories list, click New.
3. In the Name field, enter a name for the event category.
4. If you want to exclude this event category for agent coverage calculation, enable the Exclude from coverage check box.
5. In the Event field configuration dialog box, edit the following configuration as necessary:

   Note: You can remove any property that does not apply to a type of event.

   ```json
   {  
       "create": {   
           "attendees": {   
               "mandatory": true,   
               "readOnly": false,   
               "allowAllUsers": false   
           },   
           "startDate": {   
               "mandatory": true,   
               "readOnly": false   
           },   
           "endDate": {   
               "mandatory": true,   
               "readOnly": false   
           }   
       }   
   }
   ```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
"mandatory": true,
"readOnly": false
},
"additionalSelectors": [  //Add custom fields to the form
  {  
    "fieldLabel": "Select Shift", //Name of the field that displays on
the form
    "table": "sn_shift_planning_shift_plan", //Name of the table
referenced by the field
    "field": "name", //Any field from the selected table whose display
values must be shown in the custom field
    "value": ",
    "mandatory": true,
    "additionalQueryString": "
  }
],
"edit": {  //Edit an event type form
  "attendees": {  
    "mandatory": true,
    "readOnly": false,
    "allowAllUsers": false
  },
  "startDate": {
    "mandatory": true,
    "readOnly": false
  },
  "endDate": {
    "mandatory": true,
    "readOnly": false
  },
  "additionalSelectors": [
  {  
    "fieldLabel": "Select Shift",
    "table": "sn_shift_planning_shift_plan",
    "field": "name",
    "value": ",
    "mandatory": true,
    "additionalQueryString": "
  }  ]}
6. Click **Submit**.

### Configure an event load order in Workforce Optimization for ITSM

Add a system property to display your preferred event categories first on the calendar.

**Before you begin**

Set the map application scope to **Shift Planning**. For information on how to set the scope, see **Set map application scope**.

Role required: **admin**

**Procedure**

1. In the application navigator, enter `sys_properties.list`.
2. Click **New**.
3. Enter the following field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suffix</td>
<td><code>sn_shift_planning.event_load_order</code></td>
</tr>
<tr>
<td>Application scope</td>
<td><strong>Shift Planning</strong></td>
</tr>
<tr>
<td>Type</td>
<td><strong>String</strong></td>
</tr>
</tbody>
</table>
| Value          | `{                              
|               |   "fastLoad": [            
|               |     "07e433f449a11010f877de942e7c1d18"                               
|               |   ]                      
|               | }                        |

where **fastLoad** is the array of sys_ids for event categories that you would like to load first. The remaining custom event categories will be loaded after all event categories with **fastLoad** categories are loaded and updated on the calendar.

**Read roles**: `sn_shift_planning.agent`
Field | Value
--- | ---
Write roles | sn_shift_planning.admin

4. Click **Submit**.

Create event types to add to the team calendar

Create multiple events from the same category and add them to the calendar in ITSM Manager Workspace.

**Before you begin**
Role required: sn_shift_planning.admin

**Procedure**

1. Navigate to **Workforce Optimization for ITSM > Scheduling > Event Types**.
2. Click **New**.
3. On the form, fill in the fields.

**Event Type form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the event type.</td>
</tr>
<tr>
<td>Priority Order</td>
<td>Priority of the event type that you want to exclude from the coverage. The higher the number means the higher the priority. For example, let's say you are attending a work event for four hours in a day. You have marked that time window as both a time off and as a meeting event type. If time off has a higher order of priority, then the application excludes that event type from coverage.</td>
</tr>
<tr>
<td>Color</td>
<td>Color that identifies this type of event in the team calendar.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that when enabled, displays the event type on the calendar.</td>
</tr>
<tr>
<td>Category</td>
<td>Type of event, for example, meeting, break, or time off.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Event type extension points in Workforce Optimization for ITSM**

Use extension points to call scripts for event categories such as a meeting, time off, or work time.
To see a list of extension points that you can use for Workforce Optimization for ITSM, navigate to System Extension Points > Scripted Extension Points. In the Extension Points list, open the sn_shift_planning.EventManager extension point.

Use scripted extension points to integrate customizations without altering the core components in the application code. When customizing a base application, you implement the scripted extension points by creating the custom script includes and registering them against the scripted extension points.

### Extension points for event types

<table>
<thead>
<tr>
<th>Extension point name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_shift_planning.EventManager</td>
<td>Implement this extension point to customize the logic for the event categories that you create.</td>
</tr>
</tbody>
</table>

You can use extension points to create events such as meeting, training, and time-off requests. For example extension point implementations, see the following extension instances in the Implementations related list:

<table>
<thead>
<tr>
<th>Category</th>
<th>Extension script</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting</td>
<td>AgentScheduleMeetingEventManager</td>
</tr>
<tr>
<td>Break</td>
<td>AgentScheduleBreakEventManager</td>
</tr>
<tr>
<td>Training</td>
<td>AgentScheduleTrainingEventManager</td>
</tr>
<tr>
<td>Time off</td>
<td>AgentScheduleTimeOffEventManager</td>
</tr>
<tr>
<td>Work</td>
<td>AgentScheduleWorkEventManager</td>
</tr>
</tbody>
</table>

### Related information

Using extension points to extend application functionality

### Setting up Teams in Workforce Optimization for ITSM

Organize your teams into assignment groups and create reports for those groups so that you can gain visibility into the team's performance.
Create KPI groups to monitor team performance

Create key performance indicator (KPI) groups with the KPIs that matter most to your teams. When you associate your KPI groups with assignment groups, you can monitor your team’s performance.

Before you begin
Role required: sn_team_perf.team_performance_admin

About this task
By default, the KPIs that are associated with your KPI assignment groups are scheduled to collect data daily. The KPIs must have the following indicator breakdown:

- Assignment groups
- Assigned to

Procedure
1. Create a KPI group.
   a. Navigate to Workforce Optimization for ITSM > Team Performance > KPI Groups.
   b. Click New.
   c. In the Name field, enter a name for the KPI group.
   d. In the Type menu, select Teams.
   e. Right-click the form header and click Save.
   You can add up to five KPIs to a KPI group. For more information about KPIs and how the aggregates are calculated, see the overview video in the Teams example section.

2. Add KPIs to a KPI group.
   a. In the KPIs related list, click New.
   b. In the KPI field, select the KPI to apply for this group.
   c. Click Submit.

3. Add KPI assignment groups to the KPI group.
Note:

- You can associate a KPI assignment group to only one KPI group.
- You can add additional managers to each assignment group.
- You can associate a user with a KPI group as the primary assignment group for that user.

a. In the Assignment Groups tab, click Edit.
b. Move the desired assignment groups from the Collection to the Assignment Groups list.
c. Click Save.

Add managers to a KPI assignment group

Assign one or more managers to each KPI assignment group so that they can gain visibility into the group and monitor the team's performance.

Before you begin
Role required: sn_wfo_admin or admin

About this task
You can associate a user with a primary assignment group by selecting the group in the user record.

Procedure

1. Navigate to Workforce Optimization for ITSM > Team Performance > Additional Managers.
2. Click New.
3. In the Assignment Group field, select an assignment group.
4. In the Manager field, select a manager that you want to add to this assignment group.
5. Click Submit.

What to do next
Analyze the performance trends for your teams.

Setting up Coaching in Workforce Optimization for ITSM

Manage agent skills and assess the quality of completed tasks.
You can integrate Coaching with Learning with third-party learning management systems to pull learning content into your repository. For more information on how to perform this integration, see Integrate Learning Core with third-party management systems.

The Learning Core application enables you to build a learning content repository by integrating with third-party Learning Management Systems, such as Cornerstone OnDemand, Udemy, PluralSight and Sumtotal. It allows you to configure learning catalogs that contain course items from both external learning systems and internal learning systems.

Configure an indicator to display in the Coaching Overview tab in Workforce Optimization for ITSM

Add a system property to display the desired indicator in the Coaching Overview tab in the Coaching application.

Before you begin

Important: This feature is available with the Workforce Optimization Content Pack for ITSM (sn_wfo_itsm_cnt) from the ServiceNow Store. To enable this feature, see Workforce Optimization for ITSM Reference.

Set the map application scope to Coaching. For information on how to set the scope, see Set map application scope.

Role required: admin

About this task

Replace the existing indicator with any Performance Analytics indicator that has the Assigned to and Assignment group breakdowns to display in the Coaching Overview tab in the Coaching application.

Procedure

1. In the application navigator, enter `sys_properties.list`.
2. Click New.
3. Enter the following field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suffix</td>
<td>sn_coaching.coaching_overview_default_quality_indicator</td>
</tr>
<tr>
<td>Application scope</td>
<td>Coaching</td>
</tr>
</tbody>
</table>
Field | Value
--- | ---
Type | String
Value | {"title": "<name>", "sys_id": "<sys id>"}
where <name> is the name of the indicator that you want to display in the Coaching Overview tab and <sys id> is the unique record identifier (sys_id) of the indicator.

Example:
- Name: % of P1 incidents resolved on first call.
- Sys ID: 0423e59387401010ca99e12397cb0bbb
  {"title": "% of P1 incidents resolved on first call", "sys_id": "0423e59387401010ca99e12397cb0bbb"}

Read roles | sn_coaching.coach

4. Click Submit.

The configured indicator replaces the existing indicator in the Overview tab in the Coaching application in Workforce Optimization for ITSM.

The image below show an example of the configured indicator displayed in the Coaching Overview tab.

**Setting up skill prediction in Workforce Optimization for ITSM**

Collect skill data based on skills agents have used for incident resolution. Use supervised learning to recommend these skills for agents to resolve similar open
incidents. You can also find patterns in how skills are used for incident resolution and use unsupervised learning to recommend skills for agents.

**Before you begin**
Predictive Intelligence must be set up and configured on your instance to train the models. For more information, see Predictive Intelligence.

Activate the Skill Recommendation application plugin (com.snc.sre) to use predictive intelligence for recommending skills.

Role required: sn_sre.admin

**Procedure**
1. Configure the properties for the Skill Recommendation application.
2. Run the solution definition models to train the supervised and unsupervised solutions. For more information on training a solution, refer to Create and train a similarity solution.
3. Run the **Start skill prediction** scheduled job everyday to start predicting skills for incidents or agents. This scheduled job is inactive by default. When you activate it, the job runs daily at 1:00 AM on all incidents resolved the previous day. The job then adds the skills to the User Predicted Skill [sn_sre_user_predicted_skill] table and Task Predicted Skill [sn_sre_user_predicted_skill] table.

**Use extension points for skill prediction**
Use scripted extension points to customize skill prediction for tasks.

**Before you begin**
The Skill Recommendation extension point is included with the Skill Recommendation (com.snc.sre) plugin.

Role required: admin

**About this task**
You can create multiple implementations for each extension point and provide an order number for each implementation. The implementation that has the lowest order number is executed.

**Procedure**
1. Navigate to **System Extension Points > Client Extension Points**.
2. From the Extension Points list, select **Skill Recommendation** (sn_sre.SkillPredictionAPI).
3. Do one of the following:
   • To create a new skill recommendation implementation, click **Create Implementation**.
   • To modify an existing implementation, from the **Implementations** related list, select a class.

4. Modify the script as required.

5. Click **Update**.

**Configure a list menu to display in the Learning tab in Workforce Optimization for ITSM**

Add a system property to add to or modify the list menu for Coaching with Learning in the Coaching application in Workforce Optimization for ITSM.

**Before you begin**

- **Important:** This feature is available with the Coaching with Learning plugin (sn_coach_lrn) from the ServiceNow Store. To enable this feature, see Workforce Optimization for ITSM Reference.

Set the map application scope to **Coaching With Learning**. For information on how to set the scope, see Set map application scope.

**Role required:** admin

**Procedure**

1. In the application navigator, enter `sys_properties.list`.

2. Click **New**.

3. Enter the following field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suffix</td>
<td>learning_list_menu_props</td>
</tr>
<tr>
<td>Name</td>
<td>sn_coach_lrn.learning_list_menu_props</td>
</tr>
<tr>
<td>Application</td>
<td>Coaching With Learning</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
</tr>
</tbody>
</table>
| Value     | `[[  
          "children": [  
          "conditions": "<filter condition on table>"],  
          ...  
]` |
where:

- `<children>` is an array of objects to create the list
- `<conditions>` is the condition set on the selected table
- `<label>` is the name of the list
- `<id>` unique identifier for the selection path
- `<selectionPath>` is the path to establish parent-child relationship in the menu
- `<table>` is the name of the table for the menu item

### Read roles
sn_mgr_workspace.user

### Write roles
sn_mgr_workspace.admin

4. Click **Submit**.
The configured list displays in the Learning tab in Coaching in the Workforce Optimization for ITSM manager workspace.

**What to do next**
You can copy the code below into the Value field in the system property and modify as required.

```json
{
  "children": [
    {
      "conditions": "assigned_toDYNAMICf3c5e1013a08d2136a8dc15",
      "label": "All Tasks",
      "id": "all",
      "selectionPath": [
```
"learning_tasks",
  "all"
},
"table": "sn_lc_learning_task"
},
{
  "conditions": "assigned_toDYNAMICfdc474aab313001013a082c136a8dc15^active=true",
  "label": "Active Tasks",
  "id": "active",
  "selectionPath": [
    "learning_tasks",
    "active"
  ],
  "table": "sn_lc_learning_task"
},
{
  "conditions": "assigned_toDYNAMICfdc474aab313001013a082c136a8dc15^due_date<javascript:gs.beginningOfToday()^state!=3",
  "label": "Overdue Tasks",
  "id": "overdue",
  "selectionPath": [
    "learning_tasks",
    "overdue"
  ],
  "table": "sn_lc_learning_task"
},
{
  "conditions": "assigned_toDYNAMICfdc474aab313001013a082c136a8dc15^state=3",
  "label": "Completed Tasks",
  "id": "complete",
  "selectionPath": [
    "learning_tasks",
    "complete"
  ],
  "table": "sn_lc_learning_task"
}
],
"label": "Learning Tasks",
"id": "learning_tasks",
"isExpanded": true,
"selectionPath": ["learning_tasks"]
}, {
"children": ["sn_lc_learning_task"]}
"conditions": "",
"label": "All Catalogs",
"id": "all",
"selectionPath": [
   "learning_catalogs",
   "all"
],
"table": "sn_lc_catalog"
},
{
   "conditions": "sys_created_by=javascript: gs.getUserName()",
   "label": "My Catalogs",
   "id": "my",
   "selectionPath": [
   "learning_catalogs",
   "my"
],
   "table": "sn_lc_catalog"
}
],
"label": "Learning Catalogs",
"id": "learning_catalogs",
"isExpanded": true,
"selectionPath": ["learning_catalogs"]
},
{"children": [{
   "conditions": "active=true",
   "label": "All Courses",
   "id": "all",
   "selectionPath": [
   "learning_courses",
   "all"
],
   "table": "sn_lc_course_item"
}],
{
   "conditions": "author:DYNAMIC90d1921e5f510100a9ad2572f2b477fe^active=true",
   "label": "Internal Courses",
   "id": "internal",
   "selectionPath": [
   "learning_courses",
   "internal"
],
   "table": "sn_lc_content"
Setting up Demand Forecast in Workforce Optimization for ITSM

Configure the data you want to collect, modify forecast parameters and calibrate manual adjustments using Demand Forecast.

Configure the data collection to forecast the demand for resources

Define the data that you want to collect for incidents, interactions, or any table to forecast the number of agents that you require for your staffing needs.

Before you begin

You must have the MetricBase plugin [com.snc.clotho] enabled to use Demand Forecast in Workforce Optimization for ITSM. For more information, see Requesting the MetricBase product.

Role required: sn_agent_forecast.admin

Procedure

1. Navigate to Workforce Optimization for ITSM > Demand Forecast

2. Define the data that you want to collect for forecasting the number of agents that you need.

   a. Click Data Collection Definitions.

      See the Forecast Configuration table in Scheduling for the list of configurations that are available by default.

   b. Click New.
c. On the form, fill in the fields.

**Forecast Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the collection forecast configuration.</td>
</tr>
<tr>
<td>Type</td>
<td>Data Collection Definition type that is set to Collection by default and collects data using a scheduled job.</td>
</tr>
</tbody>
</table>
| Table     | Table that is used for collecting data. From the list, do one of the following:  
  • To collect data to forecast incidents, select Incidents.  
  • To collect data to forecast interactions, select Interactions. |
| Condition | Conditions that you can set so that you can capture the data that you need. |
| Date Field| Data that you can add to forecast for the future. |

d. Click **Submit**.

**Note:** A forecast parameter in Published state is automatically created.

e. Create an index for the table that you have created using the date field and the conditions that you have added to the table. For information on creating a table index, see Create a table index.

3. Add parameters for the formula to calculate how many agents you need per hour in a day.

a. Click **Formula Parameters**.

b. In the **Name** field, enter a name for the parameter.

c. Do one of the following:

  • To add a value to be calculated for the formula, in the **Value** field, enter the value.
  
  • To use the performance analytics score card API or a custom API, click **Advanced**, and add the script. The Average Chat Duration and Average Walkup Duration forecast parameters that are provided by default are examples of how you can use scripts to add the parameters. For a list of parameters provided by default, see Workforce Optimization for ITSM Reference.

d. Click **Submit**.
4. Configure the resource conversion formula.
   a. Click **Resource Conversion Formula**.
   b. Click **New**.
   c. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the resource forecast configuration.</td>
</tr>
<tr>
<td>Type</td>
<td>Type that is set to <strong>Resource Conversion Formula</strong>.</td>
</tr>
<tr>
<td>Formula</td>
<td>Formula to calculate the forecasted number of agents that you need.</td>
</tr>
</tbody>
</table>

**Note:** You can set the minimum or maximum number of agents available by default per hour. For more information, see Define the minimum and maximum number of agents to forecast demand.

In the Related Links section, do the following:

- Click **Browse Forecast Configuration**, select the forecast configuration to add to the formula and click **Add**.
- Click the **Browse Forecast Parameter** related link, select the forecast parameter to add to the formula, and click **Add**.

**Note:** FC refers to Forecast Configuration and FP refers to Forecast Parameter.

d. Click **Submit**.

5. Associate an assignment group with a resource conversion formula.
   You can assign a forecast configuration to multiple assignment groups, but an assignment group can have only one forecast configuration.

   a. Click **Group Forecast Configurations**.
   b. Click **New** and do the following:

   - In the **Assignment Group** field, click the search icon 🔍 and select the group to which you want to associate a forecast configuration.
   - In the **Forecast Configuration** field, click the search icon 🔍 and select a **Resource Conversion Formula**.
What to do next
Run the Collect historical data for automated forecast configurations scheduled job. For more information, see Demand Forecast Scheduled Job.

Related information
Use Demand Forecast

Define the minimum and maximum number of agents to forecast demand
Set the minimum or maximum number of agents required per hour so that you always have the desired staffing coverage.

Before you begin
Role required: sn_agent_forecast_admin

About this task
When you calculate the number of agents for your staffing needs, you have the option of defining how many minimum or maximum number of agents you would need by default per hour using the Math.min and the Math.max functions.

Procedure
1. Navigate to Workforce Optimization for ITSM > Demand Forecast > Formula Parameters.
2. Create a formula parameter to set either the minimum or maximum number of agents you need every hour.
   a. Click New.
   b. In the Name field, enter a unique name for the parameter.
   c. In the Value field, enter the number of agents required when converting resources.
      • To set the minimum number of agents, enter the lowest number of agents you would require per hour.
      • To set the maximum number of agents, enter the highest number of agents you would require per hour.
   d. Click Submit.
3. Create a Resource Conversion formula.
   a. Click Resource Conversion Formula.
   b. Click New.
   c. In the Name field, enter a unique name for the resource conversion formula.
   d. Right-click the form header and click Save.
In the **Formula** field, do one of the following:

- To create a formula for the minimum number of agents required per hour:
  
  i. Add the `Math.max` function.

  ii. Click **Browse Formula Parameters** and select the formula you have created to set the minimum number of agents.

  iii. Click **Browse Forecast Configuration** and select the formula you want to use for the forecast configuration.

  When the resource conversion formula is calculated, the higher of the two values is used as the lower limit for the minimum number of agents required per hour.

  For example, let's assume you need a minimum of two agents per hour and you're using the following formula: $\text{Math.max}([\text{FP:Min Number of Agents}], (\text{[FC:Chat Interactions Created]} * \frac{\text{[FP:Average Chat Duration]}}{\text{[FP:Average Agent Work Time Per Day]}])).

  - You've set the `[FP:Min Number of Agents]` value to 2.
  
  - The output value for this formula $\text{[FC:Chat Interactions Created]} * \frac{\text{[FP:Average Chat Duration]}}{\text{[FP:Average Agent Work Time Per Day]}}$ is 0.

  Although the forecast configuration indicates that no agents are required, because you've set the minimum number of agents to two, that value will be used for resource conversion.

- To create a formula for the minimum number of agents required per hour:
  
  i. Add the `Math.min` function.

  ii. Click **Browse Formula Parameters** and select the formula you have created to set the maximum number of agents.

  iii. Click **Browse Forecast Configuration** and select the formula you want to use for the forecast configuration.

  When the resource conversion formula is calculated, the lower of the two values is used as the upper limit for the minimum number of agents required per hour.

  For example, let's assume you need a maximum of eight agents per hour and you're using the following formula: $\text{Math.min}([\text{FP:Max Number of Agents}], (\text{[FC:Chat Interactions Created]} * \frac{\text{[FP:Average Chat Duration]}}{\text{[FP:Average Agent Work Time Per Day]}])).

  - You've set the `[FP:Max Number of Agents]` value to 8.
  
  - The output value for this formula $\text{[FC:Chat Interactions Created]} * \frac{\text{[FP:Average Chat Duration]}}{\text{[FP:Average Agent Work Time Per Day]}}$ is 0.

  Although the forecast configuration indicates that no agents are required, because you've set the maximum number of agents to eight, that value will be used for resource conversion.
° You've set the [FP:Max Number of Agents] value to 8.
° The output value for this formula [FC:Chat Interactions Created] * [FP:Average Chat Duration]) / [FP:Average Agent Work Time Per Day] is 10.

Although the forecast configuration indicates that 10 agents are required, because you’ve set the maximum number of agents to eight, that value will be used for resource conversion.

f. Click Submit.

Modify forecast parameters to visualize forecast data

Configure and tweak forecast parameters to see how the forecast behaves when you vary the period length, periods to forecast, or algorithm. You can view the modified forecast on the time-series visualization.

Before you begin
Role required: sn_agent_forecast.admin and sn_wfo_itsm.manager

The user with these roles must also be a manager of the assignment group that is associated with the resource conversion formula.

About this task
You can define the start and end dates for which you want to visualize the forecast data. The start date for a forecast configuration is based on the number of historical days you want to consider for data visualization. This is set using the sn_agent_forecast.number_of_historical_days_in_timeseries_chart property.

The default start date is set to 90 days ago starting from the day before the current day. The end date is calculated based on the period length and the periods to forecast represented in days. For example, if the period length is 7 days and the periods to forecast is 5, then the end date is 35 days including the current day.

Procedure
1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the Schedule icon 📅.
3. Click Forecasts.
4. Select the forecast model for which you want to view the time-series data.
   You can visualize each of the forecast parameters that were created for the forecast model.
5. Click the gear icon 🔄.
6. Click the plus (+) sign.
7. Configure the forecast parameter.
   a. From the **Period length unit** list, select the unit for the length of the period to forecast.
   b. In the **Period length** field, enter the length of a season to forecast.
   c. In the **Periods to forecast** field, enter the number of seasons, which is the period length, for which you want to forecast.
   d. In the **Algorithm** field, select an algorithm you want to use to calculate the forecast.
   e. Click **Update**.

   The forecast is created in **Draft** state. The forecast is calculated and displays in the forecast model. You can analyze the forecast with the new forecast parameters before you publish it.

8. To preview a forecast before publishing it, click **Preview**. The forecast is calculated using the algorithm and parameters configured in the forecast parameter. When you create a manual adjustment to predict future resources, Demand Forecast overlays the adjustment in the time-series chart.

<table>
<thead>
<tr>
<th>When you</th>
<th>Then the forecast</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unpublish a published forecast</td>
<td>Become inactive.</td>
</tr>
<tr>
<td>Preview an inactive forecast para-</td>
<td>Displays for the date range for which the</td>
</tr>
<tr>
<td>meter</td>
<td>forecast parameter was active.</td>
</tr>
<tr>
<td>Preview an active forecast</td>
<td>Displays the time-series data for the future</td>
</tr>
<tr>
<td></td>
<td>time-period.</td>
</tr>
</tbody>
</table>

9. Publish the forecast parameters.
   a. To publish a newly created forecast parameter, click **Save** and then click **Publish**.
   b. To publish an active forecast parameter, click **Publish**.

   **Note:** You can only have one forecast in **Published** state, which is used to calculate the resources.

   When the forecast parameter is published:
• The state of the record changes to **Published**.

• The **Forecast resources for future** job runs daily and uses the published forecast parameters to calculate the agent forecast. The calculation uses the resource conversion formula to calculate the forecast data from the current point forward. You can view the updated resources in the team calendar.

• Any other forecast parameters that were created would be unpublished and inactive.

### What to do next

Create a manual adjustment for a forecast

### Create a manual adjustment for a forecast

Adjust forecasts manually to fine-tune them for greater accuracy. Create the adjustment for a specified time period and analyze how it impacts your forecast.

### Before you begin

Role required: sn_agent_forecast.admin and sn_wfo_itsm.manager

The user with these roles must also be a manager of the assignment group that is associated with the resource conversion formula.

### Procedure

1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
2. Click the Schedule icon.
3. Click **Forecasts**.
4. Select the forecast model for which you want to make a manual adjustment.
5. Click the Manual Adjustments icon.
   a. Click the manual adjustment icon.
   b. Fill in the following fields.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the manual adjustment.</td>
</tr>
<tr>
<td>Start Date Time</td>
<td>Date and time when the manual adjustment for the forecast must start.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>End Date Time</td>
<td>Date and time when the manual adjustment for the forecast must end.</td>
</tr>
<tr>
<td>Adjustment Unit</td>
<td>Unit for the manual adjustment. Available values:</td>
</tr>
<tr>
<td></td>
<td>• Percentage—adjustment value percentage. For example, if the forecast data shows incident count and if the adjustment value is 15, the manual adjustment shows a 15% increase in incident count than the forecast data.</td>
</tr>
<tr>
<td></td>
<td>• Number—adjustment value count. For example, if the forecast data shows incident count and if the adjustment value is 15, the manual adjustment shows 15 more incidents than the forecast data.</td>
</tr>
<tr>
<td>Adjustment Value</td>
<td>The numeric value for which you want to adjust the forecast. The value is applied to each group in the Groups [sys_user_groups] table. The manual adjustment visualization on the time-series chart displays the data for your groups. For example, let’s assume that the value is 15 and the unit is number. On a given day, if you have two groups for a forecast model and both have 2 agents each before you do the manual overlay, when you enter the value as 15, it is applied to each of the two groups and the total value displays as 34. This is calculated as follows:</td>
</tr>
<tr>
<td></td>
<td>• Two agents for group A + the adjustment value 15 = 17</td>
</tr>
<tr>
<td></td>
<td>• Two agents for group B + the adjustment value 15 = 17</td>
</tr>
<tr>
<td></td>
<td>The total is 34.</td>
</tr>
</tbody>
</table>

c. Click **Save**.
The manual adjustment is created in **Draft** state. The manual adjustment is calculated and displays as a green line in the forecast model. You can analyze or update the forecast with this manual adjustment before you publish it.

7. Publish the manual adjustment.
a. Click the saved manual adjustment that you want to use for forecasting resources.

b. Click Publish. The state changes to Ready to Publish. When the Forecast resources for future job is run, it calculates the forecast, checks for manual adjustments, applies those values if any, and moves it to the Published state.

Note:
- When you unpublish a forecast, it moves to Draft state. You can delete a forecast that is in Draft state.
- If you want to end a manual adjustment after it has started and before its end date, you can click End Now. The forecast will no longer be used in the resource conversion formula.

When the manual adjustment is published:
- The state of the record changes to Published.
- The adjusted values will be used in the resource conversion formula and the demand forecast displayed on the calendar.
- Any other manual adjustment configurations that were created would be unpublished and moved to Draft state.

Configure filters for ITSM Manager Workspace

Define filter configurations for Schedule, Coaching, and Channels applications. You can use these filters to refine your search and view targeted results.

Before you begin
Role required: sn_mgr_workspace.admin

About this task

Procedure
1. Navigate to Workforce Optimization for ITSM > Manager Workspace Configurations > Filter Configurations.
2. Click New.
3. On the form, fill in the fields.
Filter Configuration form

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Name</td>
<td>Unique name for the filter configuration.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that is used for the filter configuration.</td>
</tr>
<tr>
<td>Note: You can filter only on specific tables or database views for each module.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Field on which to filter.</td>
</tr>
<tr>
<td>Filter Query</td>
<td>Query to narrow down the filter options.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of field to choose from:</td>
</tr>
<tr>
<td>• Choice: choice type field.</td>
<td></td>
</tr>
<tr>
<td>• Reference: reference type field.</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>Filter that you can use to see the display order in Manager Workspace.</td>
</tr>
<tr>
<td>Workspace Module</td>
<td>Workforce Optimization for ITSM module that displays the filter configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that enables the filter configuration in Manager Workspace.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Using Workforce Optimization for ITSM**

Enhance the quality and efficiency of your teams using smart scheduling and monitor team performance in a unified location. Assess the quality of tasks completed, recommend skills for agents, and train them to address skill gaps.

**Workforce Optimization for ITSM landing pages**

Track and monitor the performance of your organization using the Workforce Optimization for ITSM landing pages. If you are a coach or a channel manager, you can access metrics specific to your application using the Channels or the Quality landing pages respectively.
Workforce Optimization for ITSM manager landing page

Monitor your teams’ work and organizational performance using Workforce Optimization for ITSM.

Home tab

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>As a workspace manager, you can:</td>
<td>sn_mngr_workspace.manager</td>
</tr>
<tr>
<td>• Analyze the incidents your team is currently working on or incidents that have not yet been assigned.</td>
<td></td>
</tr>
<tr>
<td>• Monitor incidents with SLAs that have been breached or at risk, open P1 incidents, or the ones not been updated in 24 hours.</td>
<td></td>
</tr>
<tr>
<td>• Track the mean time to resolution, first call resolution, and customer satisfaction to analyze the performance of your whole organization.</td>
<td></td>
</tr>
</tbody>
</table>
Use case

Monitor your agent’s work when you start your day, view reports that need your attention, and navigate to the incidents on which you want to take action.

Indicators

- **Mean time to resolution**
  The average time taken to resolve incidents.

- **First call resolution**
  Number of incidents resolved the first time it was handled.

- **Customer satisfaction**
  Overall customer satisfaction on incident resolution.

My teams' work

A list of incidents assigned to the teams managed by the current logged-in user.

Unassigned incidents

A list of incidents assigned to groups managed by the current logged-in user that does not have an assignee.

Breakdowns

- Priority
- Category
- Assignment Group
- Assigned To

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open P1 Incidents</td>
<td>Single score</td>
<td>Number of open incidents with top priority.</td>
</tr>
<tr>
<td>Incidents not updated in 24 hours</td>
<td>Single score</td>
<td>Number of incidents that have not been updated in the last 24 hours.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Incident SLAs Breached</td>
<td>Single score</td>
<td>Number of incidents with SLAs that have been breached.</td>
</tr>
<tr>
<td>Incident SLAs at Risk</td>
<td>Single score</td>
<td>Number of incidents with SLAs that are at risk.</td>
</tr>
</tbody>
</table>

**Workforce Optimization for ITSM Channels landing page**

Manage queues and analyze the status of incidents and chats using the Channels landing page. You can also monitor team performance and work assignments from one location.

**Important:** This feature is available with the Workforce Optimization Content Pack for ITSM (sn_wfo_itsm_cnt) from the ServiceNow Store. To enable this feature, see Workforce Optimization for ITSM Reference.

**End user and roles**

As an admin, you can create or customize landing pages for the channel manager. For more information, see Creating custom landing pages for workspaces. If you have multiple landing pages, you can set the order for the
landing pages. The lower the order, the higher the precedence in displaying the pages.

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>As a channel manager, you can:</td>
<td>sn_channel_mgmt.user</td>
</tr>
<tr>
<td>• Analyze real-time data such as:</td>
<td></td>
</tr>
<tr>
<td>◦ The number of incidents with critical priority, breached SLAs, escalated or unassigned incidents.</td>
<td></td>
</tr>
<tr>
<td>◦ The number of chats that are in progress or with requests for help.</td>
<td></td>
</tr>
<tr>
<td>◦ Agent distribution across work assignments, work items awaiting to be assigned, and number of agents available.</td>
<td></td>
</tr>
<tr>
<td>◦ The performance of your team.</td>
<td></td>
</tr>
<tr>
<td>• Drill down into each report or analytics to get more data.</td>
<td></td>
</tr>
</tbody>
</table>

**Use cases**

As a channel manager, you can monitor key information such as the number of SLAs that have been breached, how many open incidents have critical priority, and how many work items are waiting to be assigned from one location.

**Performance Analytics Indicator**

**Incidents closed this week**

The number of incidents closed during the current week.

**Breakdowns**

• Assigned to

• Assignment group
<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table or database view</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Critical</td>
<td>Single</td>
<td>Incident [incident]</td>
<td>Number of open incidents with critical priority.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>Unassigned</td>
<td>Single</td>
<td>Incident [incident]</td>
<td>Number of open incidents that have not been assigned.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>Escalated</td>
<td>Single</td>
<td>Incident [incident]</td>
<td>Number of open incidents that have been escalated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>SLAs breached</td>
<td>Single</td>
<td>Task SLA [task_sla]</td>
<td>Number of open incidents with Service Level Agreements that have been breached.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>Updated &gt; 7 days</td>
<td>Single</td>
<td>Incident [incident]</td>
<td>Number of open incidents that have not been updated in the last 7 days.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Source table or database view</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open for 30 days</td>
<td>Single</td>
<td>[incident]</td>
<td>Number of incidents that have not been updated in the last 30 days.</td>
</tr>
<tr>
<td>In-progress chats</td>
<td>Single</td>
<td>Presence</td>
<td>Number of open interactions where agents are currently on a chat with customers resolving issues.</td>
</tr>
<tr>
<td>Help requested</td>
<td>Single</td>
<td>Presence</td>
<td>Number of current open interactions where agents are requesting help from a manager while on a chat with customers to resolve issues.</td>
</tr>
<tr>
<td>Agent distribution</td>
<td>Bar</td>
<td>States</td>
<td>The current presence status of agents distributed on work assignments.</td>
</tr>
<tr>
<td>Waiting work items</td>
<td>Single</td>
<td></td>
<td>Number of work items that are currently waiting to be assigned.</td>
</tr>
<tr>
<td>Available agents</td>
<td>Single</td>
<td></td>
<td>Number of agents currently available to work on work items.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Source table or database view</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------</td>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Total open incidents</td>
<td>Bar chart</td>
<td></td>
<td>Total number of incidents that are in various workflow states and have not been closed.</td>
</tr>
</tbody>
</table>

**Workforce Optimization for ITSM Coaching landing page**

Monitor the performance of your agents and measure the quality of how they resolved issues using the Coaching landing page. Analyze patterns in skill usage over time and see which skills are in demand.

**Important:** This feature is available with the Workforce Optimization Content Pack for ITSM (sn_wfo_itsm_cnt) from the ServiceNow Store. To enable this feature, see Workforce Optimization for ITSM Reference.

**End user and roles**

As an admin, you can create or customize landing pages for the coach to monitor the quality of how agents resolve incidents. For more information, see Creating custom landing pages for workspaces. If you have multiple landing pages, you can set the order for the landing pages. The lower the order, the higher the precedence in displaying the pages.
End user and goal | Required role
---|---
As a coach, you can analyze real-time data such as: | sn_coaching.coach
  • The quality of how agents resolved incidents.
  • The mean time it took to resolve the incidents.
  • The trends in customer satisfaction, the type of skills used to resolve incidents, and completed assessments.
  • List of overdue training and assessments.

**Use cases**

As a coach, you can monitor the quality of agents resolving issues and take corrective actions by assessing their ability to resolve skills and provide them with training to address their skill gaps.

**Indicators**

**CSAT**

Average customer satisfaction based on CSAT survey results.

**Quality**

Average score, in percentage, of all surveys taken by the coach to assess the trainee.

**Incident Mean Time to Resolve**

Average time agents have taken to work on an incident until they’ve marked it as closed or resolved.

**Completed Assessment**

Assessment closed over time.

**Breakdowns**

  • Assigned to
  • Assignment group
Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trainings</td>
<td>Assigned Training</td>
<td>[sn_coaching_assessment_recommended_learning]</td>
<td>List of training that agents need to complete.</td>
</tr>
<tr>
<td>Coaching Assessments</td>
<td>Assessed Record</td>
<td>[sn_coaching_assessed_records]</td>
<td>List of assessments that coaches need to complete for their agents.</td>
</tr>
</tbody>
</table>

Channels in Workforce Optimization for ITSM

Route work items to assigned groups using channels. Use skill-based routing to ensure that the right work goes to the right agent. Review real-time performance as your team is actively working on tasks across channels. When you see escalations, you can help your agents resolve issues without the requester being aware of it.

Using Channels in Workforce Optimization for ITSM

Use Channels to monitor ongoing work, jump in to escalations, and to track and manage agent performance.

Monitor ongoing work in service channels and queues

Monitor the incoming data and on-going work done by your agents against each service channel and queue.

Before you begin

Role required: sn_wfo_itsm.manager

About this task

Track the real-time performance of your teams directly reporting to you and the teams you have visibility into. Drill down into the data for a work item, a specific...
agent, service channel, queue, or assignment group. Filter agents based on assigned queues and assignment groups. Assign the work items or help agents as needed.

Drill-down into the specific record and perform the following actions against each channel and queue:

- Real-time information of ongoing incidents, interactions, and other tasks.
- Work done during the day.
- Waiting work items that must be assigned.
- Drill down and view agent information in one or more assignment groups.
- Summary information across queues and agents
- Take or change ownership.
- Add comments.

Procedure
1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Using one of the following ways, select a service channel:
   • From the Overview section.
   • From the Active Work Items tab.
3. Monitor ongoing work from agents.

Manage service channels and queues
Manage your agents' on-going work against every queue. Monitor the incoming data of the service channels and track real-time performance of your direct reporting teams and additional managing teams using key performance indicator reports in service channels and queues.

Before you begin
Role required: sn_wfo_itms.manager

About this task
The work item views display the list of pending and queued work items from all channels and queues. Drill down into the specific record to get an idea of how much work is at-hand within the team on various channels and queues pertaining to the assignment groups. The work item is allocated to qualified agents using work item queues, routing conditions, and assignment criteria that you define. Using channels and queues, managers at a glance can gain
visibility into the team's on-going work, quality of service, and improve agent performance and end-user experience.

Procedure
1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
2. Click the **Channels** icon.
3. Click the **Queues** tab.
4. Select a queue and do any of the following:
   - Assign work items to agents.
   - Take or change work item ownership.
   - Review agent performance.

Assist agents by joining their chat conversation
Assist agents in real time by joining their chat conversation and collaborate on any record by connecting with the right people instantly to achieve faster resolution.

Before you begin
Role required: sn_wfo_itsm.manager

About this task
View the work-in-progress chat interactions and see if any of the agents has set the **Help Requested** flag as **Yes**. Open the interaction record and view all messages exchanged between the end user and agent, gain the context and choose to join the conversation by either sending internal messages or joining the conversation in public.

Procedure
1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
2. Do one of the following:
   - Click the **Help Requested** indicator on the landing page.
   - Click the **Channels** icon, select a queue and then click the **Active Interactions** tab.
   - In **Lists**, click **Conversation Monitoring**.
3. Click the interaction record for which you want to join the conversation.
4. Choose **Join Conversation** to start interacting with the agent or **Send Private Message** to send a message that only goes to the agent. The chat conversation is established.

Allocation work items manually to agents
Allocate pending work items to agents to complete the work.

**Before you begin**
Role required: sn_wfo_itsm.manager
Ensure that the agent has relevant skills, availability, and access to at least one queue in the service channel.

**About this task**
The active work items remain in the queue pending manual allocation for one of the following reasons:

- The agent's capacity is exceeded to the maximum.
- Work items may not be accepted by any available agents.
- Agents with required skills are not available.

**Procedure**
1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
2. Click the **Channels** icon.
3. Do one of the following to manually allocate the work items:

<table>
<thead>
<tr>
<th>Navigate To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Work Items tab</td>
<td>Select the work item and click <strong>Allocate</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>a.</strong> Click a service channel. For example, Chat.</td>
</tr>
<tr>
<td>Service Channel page</td>
<td><strong>b.</strong> Click the <strong>Work Items</strong> tab.</td>
</tr>
<tr>
<td></td>
<td><strong>c.</strong> Select the work item.</td>
</tr>
<tr>
<td></td>
<td><strong>d.</strong> Click <strong>Allocate</strong>.</td>
</tr>
<tr>
<td>All Queues tab</td>
<td><strong>a.</strong> Click a queue.</td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> Click the <strong>Work Items</strong> tab.</td>
</tr>
<tr>
<td>Navigate To</td>
<td>Do this</td>
</tr>
<tr>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>c.</td>
<td>Select the work item.</td>
</tr>
<tr>
<td>d.</td>
<td>Click Allocate.</td>
</tr>
</tbody>
</table>

The list of available agents appears with details such as presence state, capacity, and matching skills.

4. Select the agent to assign the work item. For example, if the capacity is 0/4, it means that the agent's maximum capacity is 4 work items.

Note: You can allocate a single work item at a time to the agent.

5. Click Allocate.

The work item is allocated to the selected agent. The agent gets an alert on the assigned work item.

- If the agent accepts the work item and the status moves from Pending Accept to Accepted state. The Assigned To field is updated with the agent's name.
- If the agent rejects the work item and the status moves to Queued state.
- If the agent does not accept the work item for a long time and the status remains in Pending Accept state and you must allocate it again.

Track and analyze agent's performance

View your agent's profile and summary information in Agent 360 and review their performance.

Before you begin

Role required: sn_wfo_itsm.manager

About this task

You can drill down into the data for a specific agent and view the following details.

- Real-time information of ongoing cases, interactions, and other tasks.
- Upcoming time off.
- Assigned training tasks.
- Skill set, schedule, and profile
Procedure

1. Navigate to Workforce Optimization for ITSM > Channel Management > Service Channels.

2. To view information about the agent and their work, click the All Agents tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>Agent name. Click the agent's name to view the agent's profile summary in Agent 360.</td>
</tr>
<tr>
<td>Service Channel</td>
<td>Service channel name.</td>
</tr>
<tr>
<td>Total Capacity</td>
<td>Number of items automatically assigned to agents (pending overrides).</td>
</tr>
<tr>
<td></td>
<td>• Chat: The default is 4.</td>
</tr>
<tr>
<td></td>
<td>• Incident: The default is 2.</td>
</tr>
<tr>
<td>Capacity in use</td>
<td>The number of on-going work items.</td>
</tr>
<tr>
<td>Utilization</td>
<td>Condition that determines what constitutes an active item that counts toward agent workload/capacity in percentage.</td>
</tr>
<tr>
<td>Assignment Group</td>
<td>Group to which the work item is assigned.</td>
</tr>
</tbody>
</table>

3. Select an agent to view real-time reports. You can also view agent presence history such as how often they were active or were on breaks on a given day.

Override channel capacity for an agent

Change the default number of work items that an agent can handle for a service channel.

Before you begin
Role required: sn_wfo_itsm.manager

About this task
By default, the override capacity is valid for 12 hours. Administrator can change the duration using the sn_channel_mgmt.awa_agent_temporary_override_time.minutes system property. For information on adding a system property, see Add a system property. The capacity resets to the previous value after the specified time. The scheduled job Reset Temporary Capacity Override is executed every two minutes to check the invalid or expired overridden capacity and resets to the previous value.
Note: You can override the channel capacity for a single agent at a time. Ensure that an agent to whom you want to override the channel capacity needs to be associated with Advanced Work Assignment and the required channels.

Procedure

1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Navigate to an agent’s profile.

<table>
<thead>
<tr>
<th>To set the override capacity</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Channels</td>
<td>a. Click the Channels icon.</td>
</tr>
<tr>
<td></td>
<td>b. Click the All Agents tab.</td>
</tr>
<tr>
<td></td>
<td>c. Click an agent’s record.</td>
</tr>
<tr>
<td>From Teams</td>
<td>a. Click the Teams icon.</td>
</tr>
<tr>
<td></td>
<td>b. Click the KPI group.</td>
</tr>
<tr>
<td></td>
<td>c. Select Group Members tab.</td>
</tr>
<tr>
<td></td>
<td>d. Click an agent’s record.</td>
</tr>
</tbody>
</table>

3. Click the Overview tab.
4. In the Channels section, select the service channel for which you want to override the capacity.
5. Click Capacity Override. The Agent Capacity Override page appears.
6. In the Override Capacity field, enter the new capacity.
7. Click Apply.

Results
A message appears indicating the capacity update is valid for the defined duration. The capacity resets to the previous value after the specified time.

Using Cloud Call Center with Workforce Optimization for ITSM

Use Cloud Call Center to deflect incidents away from your human agents using bots. You can record phone interactions when agents resolve issues. Also, you can monitor those interactions to evaluate and improve the quality of incident resolutions.
This video provides an overview of the Cloud Call Center application: Cloud Call Center Overview

With the Cloud Call Center application, you can:

- Enable your workforce to use the voice channel and get call recordings, call transcripts, and reports of sentiment analysis when agents interact with callers. You can visualize all of this information within the Channels application in Workforce Optimization for ITSM.
- Analyze the call transcripts and sentiments of users after an interaction is complete so that you can create assessments and provide feedback and training for agents.
- Synchronize agent presence within the queue.

Note: You can integrate any third-party telephony service with the Cloud Call Center application. By default, the Cloud Call Center provides you with the ability to integrate with the Amazon Connect application.

You can visualize the metrics from the Amazon Connect phone queues that are routed through Cloud Call Center using the Channels application in Workforce Optimization for ITSM. The Cloud Call Center application uses Advanced Work Assignment to report data from the Amazon Connect queues.

Cloud Call Center Amazon Connect integration workflow

Here’s how the Cloud Call Center integrates with Amazon Connect:
Let’s try and deflect the call

Cloud Call Center recognizes this is Zeke and identifies that there is a wifi issue in his office location

There is a wifi issue in San Diego. Is this why you are calling?
Benefits of using Cloud Call Center with Workforce Optimization for ITSM

As a manager, you can:

• Monitor your agent’s calls as they resolve customer issues.
• View synchronized agent presence states within the Channels application in Workforce Optimization for ITSM.
• Assess your agents by reviewing recordings of the agent interaction and call transcripts.
• Analyze sentiments from the call transcripts and use that information to coach and train your agents.

As an agent, you can:

• Get information about the caller before you answer an incoming call.
• Analyze call transcripts and listen to recordings after you complete an interaction.
• Place outbound calls using automated outbound dialing.

Associate Amazon Connect queues for ITSM to a ServiceNow instance

Set up phone queues for Amazon Connect to gain visibility into the queues using Workforce Optimization for ITSM.

Before you begin

Enable the Advanced Work Assignment plugin (com.glide.awa) to create the Amazon Connect queues. You must activate this plugin before you activate the Cloud Call Center Core (sn_cti_core) plugin so that you can successfully integrate the two applications.

After you install the Cloud Call Center applications, when you enable the Advanced Work Assignment plugin (com.glide.awa), the Amazon Connect (phone) service channel appears in the Workforce Optimization for ITSM.

Role required: sn_wfo_itsm.admin or sn_cti_amzn_cct.admin

About this task

After an agent completes a call using Workforce Optimization for ITSM, you can learn:

• Who was on hold and how long they were on hold
• How long the calls are taking
• Which agents are available and when they’re available
• How many agents are available and what is their current utilization

You can see the following queues when you install the demo data with the sample contact flow:

### Amazon Connect

#### Phone Queues

<table>
<thead>
<tr>
<th>Calls get routed to this queue</th>
<th>When</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Queue</td>
<td>An utterance is generic, such as, &quot;Let me talk to an agent.&quot;</td>
</tr>
<tr>
<td>VIP Queue</td>
<td>A user who has the VIP field enabled calls Support.</td>
</tr>
<tr>
<td>IT Equipment Support</td>
<td>An utterance includes IT equipment support or hardware issues.</td>
</tr>
<tr>
<td>Application Support</td>
<td>An utterance includes application support.</td>
</tr>
</tbody>
</table>

A routing profile links queues to agents. Every agent must have a routing profile in the Amazon Connect instance that is integrated with the ServiceNow instance. For more information, see create a routing profile.

**Note:**

• You can associate each profile with multiple Amazon Connect queues.

• You must associate each of these queues in your Amazon Connect instance with the corresponding queue in your ServiceNow instance using an Amazon Connect ARN number. This association enables you to report on queue statistics and call metrics within Workforce Optimization for ITSM.

**Procedure**

1. Create placeholder queues for an Amazon Connect (phone) service channel if you need additional queues.
   For more information on creating a queue, see Create a work item queue.

   **Note:** Do not add work item routing conditions when you create placeholder queues.

2. Associate the ServiceNow Advanced Work Assignment (AWA) queue record with the Amazon Web Services (AWS) queue ARN.
a. In the Amazon Connect instance, navigate to Routing > Queues.
b. Select a queue.
c. Copy the ARN for the queue.
d. In the ServiceNow instance, navigate to Advanced Work Assignment > Queues and select the corresponding queue.
e. In the Cloud Call Center Source ID field, enter the ARN number.
f. Click Update.
g. Repeat these steps for each queue.

3. Add assignment groups to a queue.
a. Select a work item queue.
b. Click the Group Queue Priorities related list.

   i  Note:  You may have to configure the form to display this related list.
c. Click New.
d. In the Group field, add an assignment group that include agents who can handle this queue.
e. In the Order field, select the order number for the assignment group that shows the priority in which incoming calls are handled.

   f. Click Submit.

Listen in to an agent call

Monitor agent calls when they are resolving issues for external callers by using Workforce Optimization for ITSM.

Before you begin
You must have an active session with Amazon Connect and be able to monitor live conversations. For more information, see Monitor live conversations.

Role required: sn_wfo_itsm.manager

About this task
When the Amazon Connect application answers a call from an external source, an interaction record is created.
Procedure

1. Monitor your agent’s call queue when an agent is talking to an external caller in Workforce Optimization for ITSM.
2. Open the active interaction record when the phone call is in progress.
3. Click Monitor Call and listen into the call in Amazon Connect.

Analyze transcripts and sentiments for the Amazon Connect phone channel

Analyze your agent’s call recordings, transcripts, and sentiment reports. With this information, you can assess the call quality and train your agents to handle calls better in the future.

Before you begin
Role required: sn_cti_core.user_manager

About this task
When an agent interacts with an external caller, the call gets recorded and transcribed. The application tags every statement within a transcript with a sentiment score. After a call has been completed, a sentiment report is automatically generated.

Note: The manager must have an active session with Amazon Connect to view the transcripts and sentiments. The transcripts and sentiments are generated in the Amazon Connect application. They are then displayed in the Channels application in Workforce Optimization for ITSM.

Procedure

1. Navigate to Workspace Optimization for ITSM > Manager Workspace.
2. Select an interaction record for analysis.

<table>
<thead>
<tr>
<th>To analyze call transcripts and sentiments</th>
<th>Do this</th>
</tr>
</thead>
</table>

Note: You can view the call transcripts and sentiments for all interactions that were closed today.

a. Click the Channels icon.
b. Click Amazon Connect (Phone).
c. From the All Interaction tab, select an interaction record.
<table>
<thead>
<tr>
<th>To analyze call transcripts and sentiments</th>
<th>Do this</th>
</tr>
</thead>
</table>
| From Teams                                | a. Click the Teams icon 🕵️.  
  b. Select a team.  
  c. Select a user.  
  d. Click the **Interactions** tab.  
  e. Select an interaction record. |
| From Coaching                              | Note: When you have assessments triggered from calls, you can view call transcripts and sentiments for those interactions. |
| From Coaching                              | a. Click the Coaching icon 😊.  
  b. Click the **Assessment** tab.  
  c. Select an interaction record. |

3. Click **Call Analysis**.
   The Amazon Connect application generates the interactions and sentiment analysis of those interactions and displays them as a report in Workforce Optimization for ITSM.

4. **Optional:** Assess the quality of completed interactions and assign training to coach the agents.

**Skill-based routing in Workforce Optimization for ITSM**
Identify skills for a specific set of conditions defined for incidents or interactions. Use business rules to automatically add the skills to those types of work items. In the Workforce Optimization for ITSM Channels application, the work items get automatically assigned to the right agents based on the skills.

**Important:** This feature is available with the Workforce Optimization Content Pack for ITSM (sn_wfo_itsm_cnt) from the ServiceNow Store. To enable this feature, see Workforce Optimization for ITSM Reference.

Learn how skill-based routing works.
Skill-based routing
Automatically add skills to incidents or interactions in Workforce Optimization for ITSM

Define conditions for incidents or interactions and add skills required for those conditions using skill determination rules. When new incidents and interactions that are created meet these conditions, the skill determination business rule automatically adds the skills to those records.

Before you begin

Important: This feature is available with the Workforce Optimization Content Pack for ITSM (sn_wfo_itsm_cnt) from the ServiceNow Store. To enable this feature, see Workforce Optimization for ITSM Reference.

Role required: skill_admin or admin

About this task

The following business rules are used in Workforce Optimization for ITSM skill determination:

- **Skill determination for incident** evaluates new incidents for the conditions defined in the skill determination rules set for all incidents and adds those skills to the incident records.

- **Skill determination for interaction** evaluates new interactions for the conditions defined in the skill determination rules set for all interactions and adds those skills to the interaction records.

The table below shows the skill determination rules available for Workforce Optimization for ITSM.

Note: To add language detection skills, you must set dynamic translation API. For more information, see Dynamic Translation API.

### Default skill determination rules for Workforce Optimization for ITSM

<table>
<thead>
<tr>
<th>Skill Determination Rule</th>
<th>Source Table</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language Detection Incident</td>
<td>Incident [incident]</td>
<td>Advanced</td>
<td>The business rule evaluates new incidents for the language entered in the incident short description and adds that language as a required skill for those incidents.</td>
</tr>
</tbody>
</table>
## Default skill determination rules for Workforce Optimization for ITSM (continued)

<table>
<thead>
<tr>
<th>Skill Determination Rule</th>
<th>Source Table</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language Detection Interaction</td>
<td>Interaction</td>
<td>Advanced</td>
<td>The business rule evaluates new interactions for the language entered in the interaction short description and adds that language as a required skill for those interactions.</td>
</tr>
<tr>
<td>SAP Skills</td>
<td>Incident</td>
<td>Simple</td>
<td>The business rule evaluates new incidents for the Service field that starts with 'SAP', 'sap', or 'Sap' and adds SAP and Backoffice skills as required skills for those incidents.</td>
</tr>
<tr>
<td>VPN Incident</td>
<td>Incident</td>
<td>Simple</td>
<td>The business rule evaluates new incidents for the Short description field that contains 'VPN', 'vpn', or 'Vpn' and adds Router and Switch and Network skills as required skills for those incidents.</td>
</tr>
<tr>
<td>VPN Interaction</td>
<td>Interaction</td>
<td>Simple</td>
<td>The business rule evaluates new interactions for the Short description field that contains 'VPN', 'vpn', or 'Vpn' and adds Router and Switch and Network skills as required skills for those incidents.</td>
</tr>
<tr>
<td>Windows</td>
<td>Incident</td>
<td>Simple</td>
<td>The business rule evaluates new incidents for the Configuration item field that contains 'Windows', 'windows', or 'WINDOWS' and adds Windows Installation/Setting and Windows Servers skills as required skills for those incidents.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to Skills > Skill Determination Rules.
2. Add the desired rule for an incident or an interaction. For information, see Create rules to assign skills to work items.
Analyze skills for your teams in Workforce Optimization for ITSM
Add skills to groups and view skill assignments for your teams.

Before you begin
Role required: skill_admin

Procedure
1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the Teams icon.
3. Select a team for which you want to analyze skills.
4. Add a skill to the team.
   a. Click New.
   b. In the Skill field, select a skill.
   c. In the Skill level field, select a level for the selected skill.
   d. In the Inherited from field, select the skill from which this skill is inherited.
   e. Click Save.
   You can click on a skill to analyze skill data such as the number of users or tasks with that skill, the overall skill coverage, and how many experts you currently have with that skill.

Scheduling in Workforce Optimization for ITSM
Manage your workforce efficiently by planning shifts for each day and assigning users to the shifts. With Scheduling, you can use your resources efficiently by planning and managing schedules and staffing needs across your teams from one location. You can also integrate with on-call scheduling and create shifts and schedule for on-call rotations.

You can add meeting, training, time-off request, or an ad hoc work shift using the team calendar. You can also filter agents in the team calendar based on their location, region, assignment groups, or any field in the agent's record.

Create a shift plan
Schedule shifts for your team so that you can make sure that you are covering all work assignments and breaks. You can also specify the days of the week that you might need to override scheduled shifts.
Before you begin
Role required: sn_shift_planning.admin

About this task
In the Shifts tab, the shifts are grouped by active and inactive shifts. The contextual side panel displays the active and then the inactive shifts in the order it is displayed in the Shifts tab.

Procedure
1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the Schedule icon (_schedule_icon_).
3. Click the Shifts tab.
4. Click the plus (+) icon.
5. Create a shift.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Create a work shift | a. Create a work shift.  
  i. Click Work shift.  
  ii. In the Name field, enter a name for the shift.  
  iii. Select the time window for the shift.  
  1. In the Time Zone field, select the time zone of the users that you want to allocate to the shift.  
  2. Note: To add a shift for agents working in their local time zones, select the Use agent time zone option. The system uses the time zone that is specified in the agent’s user record.  
  3. In the Start Time field, enter the time of day when you want to start the shift.  
  4. In the End Time field, enter the time of day when you want to end the shift.  
  5. Select the days of the week for which you want to add this shift.  
  6. Click Save.  
| b. Add schedule breaks to the shift. |
### To Do this

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>i.</td>
<td>Select the shift that you created.</td>
</tr>
<tr>
<td>ii.</td>
<td>Click <strong>Add break</strong>.</td>
</tr>
<tr>
<td>iii.</td>
<td>In the <strong>Name</strong> field, enter a name for the break.</td>
</tr>
<tr>
<td>iv.</td>
<td>Set a duration for the break.</td>
</tr>
<tr>
<td>1.</td>
<td>In the <strong>Duration</strong> field, enter the length of time for the break.</td>
</tr>
<tr>
<td>2.</td>
<td>In the <strong>Earliest Start Time</strong> field, enter the earliest time to start the break.</td>
</tr>
<tr>
<td>3.</td>
<td>In the <strong>Latest End Time</strong> field, enter the latest time to end the break.</td>
</tr>
<tr>
<td>For example, you can set the earliest start time as 11:00, the latest end time as 15:00, and the duration of the break as one hour. If you add four agents to that work shift, the Scheduling application automatically staggers the break duration for each agent. Stagger breaks to ensure that your four agents can cover the entire shift span.</td>
<td></td>
</tr>
<tr>
<td>4.</td>
<td>Click <strong>Save</strong>.</td>
</tr>
<tr>
<td>You can view the number of agents for each hour or day on the shift span window.</td>
<td></td>
</tr>
</tbody>
</table>

### Create an on-call shift

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td>Create an on-call shift.</td>
</tr>
<tr>
<td>i.</td>
<td>Click <strong>On-call shift</strong>.</td>
</tr>
<tr>
<td>ii.</td>
<td>In the <strong>Name</strong> field, enter a name for the shift.</td>
</tr>
<tr>
<td>iii.</td>
<td>From the <strong>Group</strong> field, select a group that you want to assign for the shift.</td>
</tr>
<tr>
<td>iv.</td>
<td>Select the time window for the shift.</td>
</tr>
<tr>
<td>1.</td>
<td>In the <strong>Start Time</strong> field, enter the time of day when you want to start the shift.</td>
</tr>
<tr>
<td>2.</td>
<td>In the <strong>End Time</strong> field, enter the time of day when you want to end the shift.</td>
</tr>
<tr>
<td>3.</td>
<td>From the <strong>Time Zone</strong> menu, select the time zone of the users that you want to allocate to the shift.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>----</td>
<td>---------</td>
</tr>
<tr>
<td>v.</td>
<td>Select the days of the week for which you want to apply the shift.</td>
</tr>
<tr>
<td>vi.</td>
<td>In the Rotation start date field, click the calendar icon ( ), select the on-call rotation start date for the shift and click OK.</td>
</tr>
<tr>
<td>vii.</td>
<td>Click Save.</td>
</tr>
</tbody>
</table>

b. Create the on-call rotation.

i. Select the shift that you created.

ii. Click Create Rotation.

iii. From the Agents field, select the names of the agents you would like to be part of the shift. When you click the field, the name of all agents that belong to the group that the on-call shift is being created for is displayed.

iv. From the Rotate interval field, select if you want the rotation to be daily or weekly.

v. Click Save.

Note: The Escalation Type field is auto-populated with Rotate through rosters field value if multiple rosters have been created for the rotation. If not, it is populated with Rotate through members field value.

c. Click Publish to make the shift active and publish it on the schedule.
To Do this

Note:

- You can select an active on-call shift and click **Unpublish** to make the shift inactive and remove it from the schedule.

- You can view all on-call shifts that have been published on the schedule in the agent and team calendar. When you add new agents to the on-call rotation, it might take some time to refresh the data on the team calendar.

- You can click on an on-call shift in the team calendar to see more details.

You can view the name of the primary agent for each on-call shift on the shift calendar.

---

**Related information**

**On-Call Scheduling**

**Create a schedule plan**

Manage your team's schedule by creating a schedule plan that covers a span of time and includes your team's work shifts. You can also assign agents to shifts based on their skills and availability. This way, you can make sure that you are using your resources in the best way possible for your organization.

**Before you begin**

Role required: sn_shift_planning.admin

**About this task**

You can set the number of days to cache agent schedules using the `sn_shift_planning.number_of_days_to_cache` system property.

If you do any of the following:

- Import agent schedules using table import
- Disable business rules and use a script to load the data

you must manually run the **Shift Planning - Delete All Agent Schedules Cache scheduled job** to clear the cache.
Procedure

1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**

2. Click the Schedule icon ( ).

3. Create a schedule plan.
   a. Click the **Team Calendar** tab.
      
      - **Note:** You can analyze the staff alignment for a day or for the week.
      
   b. In the contextual side panel, click the show schedules icon ( ) to display the schedules.
   c. In the Schedules panel, click the + icon.
   d. In the **Name** field, enter a name for the schedule plan.
   e. From the **Start Date** field, select a date to start the schedule plan and click OK.
   f. From the **End Date** field, select a date to end the schedule plan and click OK.
   g. Click **Save**. You can view the schedule of all agents in the assignment group that you directly or additionally manage.

4. Add a work shift to the schedule plan.
   a. Click **Add Shift**.
   b. In the **Shift** field, select the work shift that you want to add to the schedule plan.

5. Add agents to the work shift.
   a. In the **Agents** field, search for agents and add one or more agents to add to the shift.
   b. Click **Save**.
      
      - **Note:** It may take a few minutes for the screen to refresh.
Publish a schedule plan for visibility into team coverage

Generate a preview of your schedule plan and publish it so that your agents can see their shifts and schedules ahead of time. You can unpublish a schedule to make changes and then publish it again.

Before you begin
Role required: sn_shift_planning.admin

About this task
You can make a copy of a schedule and update it to create a new schedule. Updates could include modifying the schedule start and end dates as well as adding or removing shifts or agents.

When you make a copy of the schedule, the following updates are automatically made to the schedule copy:

• The start date is set to the current date and the end date to 30 days from the current date.
• The schedule state changes to Draft. You can make the necessary changes to the shift and click Save.
• The schedule only displays agents in the assignment group of the current logged in user.

You can also unpublish a schedule make updates, and then publish it again.

When you unpublish a schedule:

• If the start date is the either the current date or had occurred in the past, the schedule state remains as Published and the end date changes to tomorrow.
• If the start date is in the future, the application changes the schedule state to Draft.

Procedure
1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the Schedule icon ( ).
3. Generate a schedule preview.
   a. Click the Team Calendar tab.
   b. Click the show schedules icon ( ) to display in the contextual side panel. The team calendar refreshes and generates the preview when you save a work shift.
4. Publish a schedule.
a. Select a schedule and edit the schedule if necessary.
b. Edit the schedule if necessary and click Save.
c. Click Publish.

Note: You can click Delete in Draft state and delete the schedule if you no longer need it.
All the schedules that are in Draft state move to Published state. You can view the published schedule in the team calendar.

Track and manage your teams' schedule
Create, update, or monitor your teams' schedule from one location. You can approve or reject requests for swapping shifts or time off for agents within your assignment group.

Before you begin
Role required: sn_shift_planning.admin

About this task
Using the team calendar, you can access the list of all of your agents by assignment group. When you select a shift for an agent, you can see the agent's work schedule including the break time. You can also view the number of agents that are scheduled at every time interval for each group.

Procedure
1. Modify an agent's shift.
   The schedule that includes this shift must be in Preview or Published state.
   a. Navigate to Workforce Optimization for ITSM > Manager Workspace.
   b. Click the Schedule icon ( ).
   c. In the Team Calendar tab, navigate and point to the shift for the agent that you want to modify the schedule for.
   d. In the shift pop-up window, click the Edit icon ( ).
   e. Modify the agent's shift as desired.
   f. Click Save.
2. Approve or reject an agent's time off or shift-swap with another agent.
Note: You must approve a request two days before the time-off or shift-swap start date. If not, the approval will be auto-rejected. An administrator can change this default setting. For more information, see Setting the due date for time-off and shift-swap request approvals in Workforce Optimization for ITSM Reference.

a. Click Approvals. You can view all agent requests in your queue and the details for each request.

b. Select a request that you want to approve or reject and do one of the following:
   • To approve a request, click Approve.
   • To reject a request, click Reject.
   If you approve the request, the schedule gets updated in the team calendar based on the approvals.

Related information

Manage your schedule using the ITSM Agent Workspace

Analyze your staff alignment using Demand Forecast

Use Demand Forecast to plan the number of staff members that you require so that you have enough agents to do the job.

Before you begin
Role required: sn_agent_forecast.user

About this task
Using Demand Forecast, you can:
   • Monitor agent or team shift coverage for any day or week.
   • Analyze if you are overstaffed, understaffed, perfectly staffed, or not aligned well with your staffing needs.
   • Adjust your staff alignment depending on the coverage that you need and the schedule of your teams.
   • Analyze your staff alignment as you are creating a schedule.
   • You can analyze the agent coverage you have and the actual demand for the number of agents based on assignment groups and work shifts in a day.
Procedure

1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.

2. Click the Schedule icon ( ).

3. Click the **Team Calendar** tab.

4. Analyze your staff alignment for each shift.
   You can click the filter icon and select the assignment groups and shift plans for which you want to view the staff alignment.

<table>
<thead>
<tr>
<th>To analyze staff alignment</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Day from the list.</td>
<td>The Total coverage/demand row displays the number of agents that cover each shift in a day. It also shows the demand for the number of agents that you forecast to work for that day.</td>
</tr>
</tbody>
</table>

For example, 24/20 shows the following:

- You have 24 agents scheduled for all shifts for that day.
- The agent demand forecast for that day is 20.

You can also view the number of agents you have and the demand for every hour for each group. The current agent coverage and the demand is highlighted as follows:

<table>
<thead>
<tr>
<th>Highlight color for each day for a group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>The number of agents you have scheduled for that hour and demand for that hour are an exact match—your staffing needs are perfectly aligned.</td>
</tr>
<tr>
<td>Yellow</td>
<td>The number of agents you have scheduled are more than the demand you have for that hour.</td>
</tr>
</tbody>
</table>
To analyze staff alignment

<table>
<thead>
<tr>
<th>Highlight color for each day for a group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>The number of agents you have scheduled are less than the demand you have for that hour.</td>
</tr>
</tbody>
</table>

For a given week

- **a.** Select **Week** from the list. The Total coverage/demand row has indicators for the staff alignment.

<table>
<thead>
<tr>
<th>If the row displays</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>An arrow that points downwards</td>
<td>The predicted forecast is lower than the number of agents that you need for that day.</td>
</tr>
<tr>
<td>An arrow that points upwards</td>
<td>The predicted forecast is higher than the number of agents you need for that day.</td>
</tr>
<tr>
<td>A checkmark</td>
<td>The perfect alignment of the predicted forecast and the required number of agents.</td>
</tr>
</tbody>
</table>

- **b.** Click any of the indications that are displayed in the Total coverage/demand row to analyze further details about the forecast.

You can also view the coverage and demand for every hour for each group.

The following image shows an example of the staffing alignment in a Week view. The misaligned staffing indicator in the pop-up window shows that the...
forecast manager has scheduled four agents for each shift but more agents are needed to cover the shifts.

Add events to the team calendar
Create a meeting, training, time-off request, or an adhoc work shift from the team calendar.

Before you begin
Role required: sn_shift_planning.admin

About this task
You can create custom event types and add or remove the desired fields. For more information, see Configure event types for the ITSM Manager Workspace.

Procedure
1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the Schedule icon ( ).
3. Click the Team Calendar tab.
4. Click +New.
5. Create an event.
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| • To schedule a meeting, select **Meeting**.  
• To create a training event, select **Training**.  
• To create a time-off request, select **Time-off**. | a. Do one of the following:  
  i. In the **Title** field, enter a name for the meeting.  
  ii. Add the required names for the event:  
    • For a meeting, in the **Attendees** field, enter the names of the meeting attendees.  
    • For a training, enter the names of the agents who want to be trained in the **Trainees** field.  
    • For a time-off request, enter the names of the agents in the **Agents** field.  
    In the **Attendees** field, start typing the name of each of the attendees for the meeting and select the name.  
  iii. In the **Start date** field, click the calendar icon and select the date you want to start the meeting and click **OK**.  
  iv. In the **End date** field, click the calendar icon and select the date you want to end the meeting and click **OK**.  
  v. If the meeting spans for the whole day, click the **All Day** slider.  
  vi. In the **Description** field, enter a description for the meeting. |
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a work shift</td>
<td>a. Click <strong>Work</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. In the <strong>Agents</strong> field, start typing the name of each of the attendees for the work shift and select the name.</td>
</tr>
<tr>
<td></td>
<td>c. In the <strong>Start date</strong> field, click the calendar icon and select the date you want to start the meeting and click <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td>d. In the <strong>End date</strong> field, click the calendar icon and select the date you want to end the meeting and click <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td>e. Click the <strong>Select Shift</strong> field and select a shift.</td>
</tr>
</tbody>
</table>

6. Click **Save**.

**Swap your agents’ shifts in Workforce Optimization for ITSM**

Swap an agent’s shift in your assignment group with another agent who can work on that shift and skip the approval process.

**Before you begin**
Role required: sn_shift_planning.admin

**Procedure**

1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.

2. Click the Schedule icon ( ).

3. In the **Team Calendar** tab, navigate and point to the shift for the agent that you want to swap with another agent.

4. In the shift pop-up window, click the Shift Swap icon ( ).

5. In the **Requested Shift** section, click the **Agent** field and select the agent who can work on that shift.

6. Click **Submit**.

   The team calendar displays the updated schedule.

**Teams in Workforce Optimization for ITSM**

Use Teams to track and analyze performance trends for your teams from a single location. You can monitor the trends for each agent within your team and
compare your agents or team members with one another. With Teams, you can identify skill gaps so that you can recommend which skills are needed to coach your agents.

Organize your teams into assignment groups. You can add a set of key performance indicators (KPIs) to help you measure team performance consistently across the groups.

For example, let's say that you manage the IT Service Desk unit. The unit contains multiple teams, such as Hardware and Network Support. You can create a KPI group for the IT Service Desk unit and then add Hardware and Network Support as assignment groups to this KPI group. Next, you add a set of KPIs to the KPI group. With this data, you can measure the performance trends across the Hardware and Network Support teams.

**Add KPI targets for agents**

Set key performance indicator goals that you want your agents to achieve so that they can improve the quality of how they resolve incidents. You can also set goals to monitor and improve an existing baseline measurement.

**Before you begin**

Role required: pa_target_admin and sn_wfo_itsm.manager

**About this task**

You can set a global KPI target for an agent or a team that you manage. You can create the target for any indicator in the KPI group associated with the KPI assignment group that you manage. When you set the global target, it is visible to anyone within the assignment group and also displays on the time-series widget.

When you set a personal target, it is only visible to you.

**Procedure**

1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the Teams icon.
3. Select a team.
4. Select the agent for whom you want to set KPI targets.
5. Click the target icon.
   - To create a new target, click the plus (+) sign.
   - To edit an existing target, select the target you want to edit.
6. Select the target type.
• To set a global target, click **Global**.
• To set a personal target, click **Personal**.

7. Set the KPI target.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Update an existing target</strong></td>
<td>In the <strong>Target</strong> field, update the value that you’d like the agent to achieve for the selected KPI.</td>
</tr>
</tbody>
</table>

| **Set a target for a key performance indicator** | a. Select the KPI for which you want to set the target.  
b. In the **Target** field, enter a value that you’d like the agent to achieve for the selected KPI. |

| **Set a target to improve an existing baseline value** | a. Select the KPI for which you want to set the target.  
b. Enable the **Set target as an improvement of the baseline** checkbox.  
c. From the **Target Calculation** list, select the unit for this target.  
• If you select Percentage %, in the **Percentage %** field, enter a target percentage value.  
• If you select Units of the KPI, in the **Units of the KPI** field, enter the number of units as an integer value by which you want to improve the KPI. |

8. In the **Start date** field, click the calendar icon, select the date when you want to start tracking the goal for the target, and click **OK**.

9. In the **Review date** field, click the calendar icon, select the date when you want to start tracking the goal for the target, and click **OK**.

10. Set the target.

    • If you are creating a new target, click **Save**.
    • If you are updating an existing target, click **Update**.

You can analyze the target trend in the indicator time-series metric.
Related information

Performance Analytics targets

Analyze the performance trends for your teams
Analyze trends to monitor your team's performance within a KPI group.

Before you begin
Role required: sn_mgr_workspace.manager

About this task
Analyze the data by drilling down into the data for a team, a specific team member, an indicator, or an incident.

Procedure
1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Click the Teams icon.
3. Select a date range to view your team's performance for that time period.
   You can set the default date range using the sn_team_perf.default_date_range system property.
   All teams that you manage are identified with a My team highlight in the group header. You can also see the team that you have visibility into.
4. Analyze your team's performance.
   a. Select a team. You can view the data for the top-level KPIs.
   b. Drill down into the data for the team.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze indicator performance</td>
<td>Click the Performance tab to track and analyze the overall indicator performance for all members in the team.</td>
</tr>
<tr>
<td></td>
<td>i. To analyze the indicator performance for the team, click on an indicator.</td>
</tr>
<tr>
<td></td>
<td>ii. To analyze indicator performance for a team member, click an indicator value for the team member.</td>
</tr>
<tr>
<td>Track incidents</td>
<td>Click the Incidents tab and analyze all incidents that are related to the team.</td>
</tr>
</tbody>
</table>
To

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• To view the incident details, select an incident.</td>
</tr>
<tr>
<td></td>
<td>• To view a team member's details, from the <strong>Assigned to</strong> column, select a team member.</td>
</tr>
</tbody>
</table>

Analyze skills for your team

<table>
<thead>
<tr>
<th>Analyze skills for your team</th>
<th>Click the <strong>Performance</strong> tab to analyze skills for each agent in your team.</th>
</tr>
</thead>
<tbody>
<tr>
<td>i.</td>
<td>Select an agent for whom you want to analyze skills based on skill-level type.</td>
</tr>
<tr>
<td>ii.</td>
<td>Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• To analyze all skills for the agent, click the <strong>Skills</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>• To analyze skills based on the skill level types associated with the agent, click the <strong>Overview</strong> tab and in the <strong>Skills</strong> section, select a score for the skill level type.</td>
</tr>
</tbody>
</table>

You can also review incidents, details of assignment groups, additional managers, and information that is relevant to the team.

**Coaching in Workforce Optimization for ITSM**

By using Coaching in Workforce Optimization for ITSM, you can assess your team's abilities to efficiently resolve incidents by reviewing their work at critical service moments.

With Coaching, you can do the following:

• Provide training for your agents to address skill gaps.
• Use surveys to apply consistent, measurable scores across teams.
• **Create opportunities** for improvement using the Coaching application.
• Use Predictive Intelligence to recommend skills for your agents and provide training to address those skill gaps.

**Skills Overview in Workforce Optimization for ITSM**

Use Skills Overview to analyze skill data such as how many skills are assigned to users and tasks. You can also see how many experts you have for a particular skill and the overall skill coverage by your teams.

Access Skills Overview from the Teams application:
1. Go to **Workforce Optimization for ITSM > Manager Workspace**.

2. Click the teams icon.

3. Select a team.

4. Click the **Skills** tab.

5. Select a skill.

You can access the Skills Overview page when you click on a skill in a user profile page in any Workforce Optimization for ITSM application.

**Note:** You must enable the Coaching With Learning application to view the reports from the application. For enabling this application, see **Activate Workforce Optimization for ITSM**.

### Use cases

<table>
<thead>
<tr>
<th>User</th>
<th>Landing page use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skill Admin</td>
<td>• Analyze all experts available for each skill.</td>
</tr>
<tr>
<td>[skill_admin]</td>
<td>• Drill down into the skill hierarchy.</td>
</tr>
<tr>
<td></td>
<td>• Number of skills assigned to users and tasks.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>User</th>
<th>Landing page use</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• The mean time taken to resolve incidents for that skill.</td>
</tr>
<tr>
<td></td>
<td>• Visualize how many users you have at different skill levels.</td>
</tr>
</tbody>
</table>

**Indicators**

**MTTR of incidents of skill**

Mean time taken to resolve incidents with this skill.

**Breakdowns**

The indicator is broken down by Skill.

**Now Experience Components**

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Skill Overview Container [sn-manager-skill-overview-container] | Visualization | Contains the following components:  
• Reports  
• Mean Time to Resolution (MTTR) indicator  
• Skill Coverage pie chart  
• Content tree  
• Skill Experts components |
| Skill Tree Connected [sn-manager-skill-tree-connected] | Tree | Displays the skill hierarchy. If the selected skill does not have a skill hierarchy then the component will not display on the Skill Overview page. |
| Skill Experts [sn-manager-skill-experts-connected] | List | Displays all users who are at the expert level for the skill. |
| Skill Coverage [now-uxf-visualization-connected] | Pie-chart | Displays the percentage as well as the number of users with different levels of expertise for the skill. |
Reports

Important: The Pending Users and Assigned Tasks reports display when you enable the Coaching with Learning application from the ServiceNow® Store. To enable this application, see Activate Workforce Optimization for ITSM.

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned Users</td>
<td>42</td>
<td>User Skill [sys_user_has_skill]</td>
<td>The number of users who have the selected skill assigned to them.</td>
</tr>
<tr>
<td>Pending Users</td>
<td>42</td>
<td>Pending Users [sn_lc_learning_task]</td>
<td>The numbers of users who are yet to be assigned the selected skill from the learning task.</td>
</tr>
<tr>
<td>Assigned Tasks</td>
<td>42</td>
<td>Task Skill [task_m2m_skill]</td>
<td>The number of tasks for which this skill has been assigned.</td>
</tr>
<tr>
<td>Course Items</td>
<td>42</td>
<td>Learning Course Item [sn_lc_course_item]</td>
<td>The number of internal and external courses that have the skill associated with the course item.</td>
</tr>
</tbody>
</table>

Assess the quality of your agent’s completed tasks

Assess the ability of your agents to resolve incidents or the quality of their completed tasks.

Before you begin

You can create an assessment from an interaction or any task type. When you manually create an assessment, you can add a survey to it. Coaching assessments also get created and assigned to the coach based on the trigger conditions that are defined in coaching opportunities.

Role required: sn_coaching.coach
About this task
If the coaching opportunity includes a survey, you can opt to take the survey and the assessment. When you use a survey to assess a trainee, the score for the survey is automatically calculated when you complete the survey. The assessment rating is then updated based on that score.

The Coaching Overview screen displays the average quality of the tasks that were completed in the past 30 days for your assignment groups.

- The donut chart displays the number of assessments in various states of completion. You can point to one of the states and click to open all assessments in that state.
- The bar chart displays assessments created by coaching opportunities. You can click on any of the data in the graph to access the assessments.
- You can click on the graph that displays the indicator data and access detailed information on the indicator.

Procedure
1. Navigate to Workforce Optimization for ITSM > Manager Workspace.
2. Do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Perform adhoc assessments | a. Click the List icon.  
b. Select any record, such as an incident or change request, for which you want to create an assessment.  
c. Select the Assessments icon. The assessment screen appears in the right panel.  
d. Click the plus (+) icon. |
| Use assessments triggered by coaching opportunities | a. Click the Coaching icon.  
b. Select any record for which you want to create an assessment. |
To Do this

Note: Click the Active Assessments tab to view assessments of all teams for which you are a manager or an additional manager.

c. Select an incident to assess.

3. On the form, fill in the fields to assess the agent.

Assessment form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opportunity</td>
<td>Coaching opportunity that is associated with the coaching assessment.</td>
</tr>
<tr>
<td>State</td>
<td>State of the assessment.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Open</strong>: New coaching opportunity.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Work in progress</strong>: Trainee is being coached.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Resolved</strong>: Trainee is assigned coaching programs and training modules.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Closed Complete</strong>: Assessment has been resolved and closed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Closed Incomplete</strong>: Assessment that has been closed but not completed, typically because the coaching assessment <strong>Due Date</strong> has expired.</td>
</tr>
<tr>
<td>Assessment Rating</td>
<td>How well the agent resolved the incident. The Coaching application automatically populates this field when a coach completes a survey for the trainee.</td>
</tr>
<tr>
<td>Follow up</td>
<td>Whether the coach must take further action to improve the trainee performance.</td>
</tr>
<tr>
<td>Comments</td>
<td>Notes, if any, to add about the assessment.</td>
</tr>
<tr>
<td>Survey taken by coach</td>
<td>Survey for the trainee taken by the coach.</td>
</tr>
<tr>
<td></td>
<td>You can add a survey for an assessment when you create the assessment manually or when the coaching opportunity triggers an assessment that does not have a survey.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When a coaching opportunity triggers an assessment and contains a survey, the survey is automatically added to the assessment and cannot be changed by the coach.</td>
</tr>
<tr>
<td>Survey taken by trainee</td>
<td>Survey for the coach taken by the trainee.</td>
</tr>
<tr>
<td>Add skills</td>
<td>Skills to add to the trainee profile when the assessment is complete. When you click this field, it displays all skills and the skill levels that are not in the trainee profile.</td>
</tr>
<tr>
<td>Add training</td>
<td>Training to assign to the trainee. You can also assign learning tasks from course items.</td>
</tr>
</tbody>
</table>

### 4. Do the following:

- To complete the adhoc assessment, click **Save**.
- To complete assessments creating using coaching opportunities, click **Complete assessment**.

### Manage skills using Workforce Optimization for ITSM

Add or update skills for an agent. You can approve predicted skills if the skill is necessary for the agent to complete assigned tasks. You can also reject a skill if it doesn't apply to the agent.

**Before you begin**
Role required: skill_manager

**About this task**
The Predictive Intelligence application for skills displays the recommended skills on each agent’s profile. The application uses sample incidents that the agent has worked on to recommend skills for an agent.

You can view skills for all users grouped by assignment group and the overall skill coverage for each group.

**Procedure**
1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
2. Click the coaching icon.
3. Click the **Skills** tab.
You can view the list of all assigned skills and the skill level for each agent within each assignment group. You can also view the overall skill coverage for each group. For more information on skills and skills levels, see Skills Management.

You can also filter the skill matrix based on users, groups, skill type, skill level, or skill category. Reset the filter if you want to view the skills for all users.

4. Add a skill or skill level.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a skill</td>
<td>a. In the skill matrix, click Add for the skill that you want to add to the agent.</td>
</tr>
<tr>
<td></td>
<td>b. Select the Skill level field, select a level for the skill.</td>
</tr>
<tr>
<td></td>
<td>c. Click OK.</td>
</tr>
<tr>
<td></td>
<td>The skill gets automatically added to the agent.</td>
</tr>
</tbody>
</table>

| Update a skill level      | a. In the skill matrix, select a skill level for an agent.                                                                                 |
|                           | b. Select the skill level that you want to add for the agent.                                                                                 |
|                           | c. Click OK.                                                                                                                             |

5. Approve or reject a skill that is recommended by Predictive Intelligence.

a. In the skill matrix, click Recommended to approve and recommend a skill for the user.

b. In the Details tab, review the request for skill approval, the sample incident resolutions that were used to predict the skill, and the activity stream.

• To approve a skill, click Approve. The skill is added to the agent and the lowest level for the skill is automatically associated with the added skill. The state for the request changes to Approved and the skill is added to the agent.

• To reject a skill, click Reject. The state for the request changes to Rejected. Predictive Intelligence does not recommend the skill for the user again and the field changes to Add.

• Click the more options (···) icon and select Save. The application assigns the skill to the user. If the assigned skill does not have a skill level, the application adds the basic skill level to the user.
Coaching with Learning

Use Coaching with Learning to train your agents with internal and external learning content. Organize similar content in catalogs. Assign learning tasks and track completion.

**Important:** Coaching with Learning is available when you enable the Coaching with Learning application from the ServiceNow® Store. To enable this application, see Activate Workforce Optimization for ITSM.

Create a learning catalog

Create a catalog to organize related content into categories.

**Before you begin**
Role required: sn_lc.catalog_manager

**Procedure**

1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
2. Click the coaching icon.
3. Click the **Learning** tab.
4. Click **Learning Catalogs** and select **My Catalogs**.
5. Create a catalog.
   a. Click **New**.
   b. In the **Name** field, enter a unique name for the catalog.
   c. In the **Description** field, enter a description for the catalog.
   d. Click **Save**.

   **Note:** The catalog is visible to all groups that you directly or additionally manage.

6. Add course items to the catalog.
   a. Click the **Content** tab.
   b. Click **Add**.
   c. In the **Add Learning Courses** pop-up window, select all course items you want to add to the catalog.
   d. Click **Add**. The course items are added to the catalog.

   **Note:** To remove any course item you have added, select the course item and click **Remove**.

7. Add a group to a catalog.
a. Click the **Applicable Groups** tab.

b. Click **New**.

c. In the **Group** field, select a group that you want to associate with the catalog.

d. Click **Save**.

**Create a learning task**

Create learning tasks for agents to keep track of their learning activities.

**Before you begin**

Role required: sn_lc.task_creator

**About this task**

Set learning task completion due dates to include or exclude weekends using the `exclude_weekends_on_learning_task_due_date` system property. For more information, see *Workforce Optimization for ITSM Reference*.

**Procedure**

1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
2. Click the coaching icon.
3. Click **Learning Tasks** and select **All Tasks**.
4. Create a learning task.
   a. Click **New**.
   b. Fill in the following fields.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned to</td>
<td>Name of the agent to whom you want to assign the learning task.</td>
</tr>
<tr>
<td>Catalog</td>
<td>The catalog that contains the course item for the learning task.</td>
</tr>
<tr>
<td>Course item</td>
<td>The course that needs to be completed by the agent.</td>
</tr>
<tr>
<td>Due date</td>
<td>Date when the agent must complete the course. Default is 5 days after the creation of the learning task. This value is calculated from the <strong>Days to Complete</strong> field for the course item. The due date field is highlighted as follows:</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Green</td>
<td>if the task is due before the current day.</td>
</tr>
<tr>
<td>Yellow</td>
<td>if the task is due on the current day.</td>
</tr>
<tr>
<td>Red</td>
<td>if the task is due after the current day.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Create internal learning content**

Add internal courses so that agents can learn new content and enhance their skill set.

**Before you begin**

Role required: sn_lc.content_creator

**Procedure**

1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
2. Click the coaching icon.
3. Click **Learning Courses** and select **Internal Courses**.
4. Create an internal learning course.
   a. Click **New**.
   b. Fill in the following fields.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Name of the course.</td>
</tr>
<tr>
<td>Internal source</td>
<td>Select the type of content for the course.</td>
</tr>
<tr>
<td></td>
<td>Here are the available types of courses:</td>
</tr>
<tr>
<td></td>
<td>• URL—Youtube, Vimeo, or any link for a video</td>
</tr>
<tr>
<td></td>
<td>• Knowledge article</td>
</tr>
<tr>
<td></td>
<td>• Free form</td>
</tr>
<tr>
<td>Days to complete</td>
<td>The number of days required to complete the course.</td>
</tr>
<tr>
<td></td>
<td>Default value is set to 5.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Estimated duration</td>
<td>Length of time when the course has to be completed. For example, for a video, it is the duration of the video. For a KB article, the duration is estimated based on the length of the article.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

6. Add a skill to the internal content.
   a. Click the **Associated skills** tab.
   b. Click **New**.
   c. In the **Skill** field, select a skill you want to associate with the internal content.
   d. In the **Skill level** field, select a skill level for the selected skill.
   e. Click **Save**.

7. Add a learning task to the internal content.
   a. Click the **Learning Tasks** tab.
   b. Click **New**.
   c. In the **Assigned to** field, select a trainee to whom you want to assign the learning task.
   d. In the **Catalog** field, select the catalog to associate with the learning task.
   e. In the **Due date** field, click the calendar icon and select the date and time when you want to trainee to complete the learning task.
   f. Click **Save**.

**Add external courses to coaching with learning**

Add courses from external sources such as Udemy, Pluralsight, or Cornerstone to enable your users to gain skills from external content.

**Before you begin**
Role required: sn_lc.learning_admin

**Procedure**
1. Navigate to **Workforce Optimization for ITSM > Manager Workspace**.
2. Click the coaching icon.
3. Click the **Learning** tab.
4. Go to **Learning Courses > External Courses**.
5. Select a course.
6. Click Go to course.
   You can review and learn the external course.

**ITSM Mobile Agent for Workforce Optimization for ITSM**

Using the ITSM Mobile Agent app, shift planning agents can access their schedule. They can request time off to get their manager’s approval or swap shifts with their peers and receive notifications for those requests and approvals.

**Important:** The ITSM Mobile Agent for Workforce Optimization for ITSM features are available with the ITSM Mobile Agent 5.0 store application. For more information, see Workforce Optimization for ITSM Reference.

**ITSM Mobile Agent for Workforce Optimization for ITSM**

Workforce Optimization for ITSM Mobile Agent

**Using On-Call Scheduling with Workforce Optimization for ITSM**

If you are using Mobile experience for On-Call Scheduling along with the ITSM Mobile Agent for Workforce Optimization for ITSM, you can access the On-Call Scheduling actions from the Schedule section.

To access:

- **Upcoming shifts:** tap My calendar and view your shifts.
- **Time-off requests:** tap On-call time-off requests and view the list of requests awaiting your approval and the ones for which you have completed the approval process.
- **Who is on-call:** tap Who is on-call to view the list of groups in the on-call schedule.

**Setting the number of days to display events in shifts on the ITSM Mobile Agent**

As a Workforce Optimization admin [sn_wfo.admin], you can configure the number of days events for shifts can be displayed on the mobile application using system properties. For more information, see Properties in the Scheduling section in Workforce Optimization for ITSM Reference.

**Related information**

- Mobile experience for On-Call Scheduling

**ITSM Mobile Agent for Workforce Optimization for ITSM notifications**

Receive notifications when you manage shift-swap and time-off requests. Enable notifications for the actions that are most relevant to you. For example,
get notified when you receive a request for approval from an agent who wants to swap shifts with a peer.

As a Workforce Optimization for ITSM agent (sn_shift_planning.agent) and a Workforce Optimization for ITSM manager (sn_mgr_workspace.manager), you can enable or disable notifications for shift-swap and time-off requests and approvals. Agents can request a shift-swap with their peers and get approval from their manager. They can also request approval for time-off from their managers.

You must set your notification preferences in your desktop application to receive the notifications in your ITSM Mobile Agent application.

To enable the notifications:

1. On your desktop application instance, click the gear icon in the top-right corner. The **System Settings** screen appears.
2. Click **Notifications**.
3. Enable **Allow Notifications**.
4. In the **Notifications Category** section, click **Mobile - Shift Planning**.
5. Enable the desired notification.

<table>
<thead>
<tr>
<th>When you enable this notification</th>
<th>You receive a notification when your</th>
</tr>
</thead>
</table>
| Shift-swap approval request       | • Agents send shift-swap requests to approve.  
|                                   | • Your peer sends a shift-swap request to approve. |
| Shift-swap approved by manager    | Manager approves your request to swap shifts with your peer. |
| Shift-swap approved by peer       | Peer approves your request to swap shifts with them. |
| Shift-swap rejected by manager    | Manager rejects your request to swap shifts with your peer. |
| Shift-swap rejected by peer       | Peer rejects your request to swap shifts with them. |
| Time-off approval request         | Agents send requests to approve time off. |
| Time off approved                 | Manager approves your time-off request. |
When you enable this notification, you receive a notification when your manager rejects your time-off request.

### Related information
- Setting notification preferences in UI16

### Make a request to swap shifts or take time off using the Mobile Agent application

Use the ITSM mobile app to look up your schedule, request time off, or swap your shift with your peers. If you can work during the requested shift, you can also approve your peer’s request for the shift swap.

### Before you begin
Role required: sn_shift_planning.agent

### Procedure
1. Navigate to the ITSM Mobile Agent application.
2. Request time off.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Request time off after reviewing your schedule | a. In the Schedule section, tap My calendar.  
b. Tap the date for which you want to make the request.  
c. Tap the work shift for that day.  
   
   <i>Note:</i> Alternatively, you can swipe left on the shift you want to request time off or shift swap and select the desired option.  
d. Tap Request time off.  
e. In the Title field, enter a reason for the time off request.  
f. In the Description field, enter a reason requesting time off. |
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Request time off after reviewing your time-off requests</strong></td>
</tr>
<tr>
<td></td>
<td><strong>a.</strong> In the <strong>Schedule</strong> section, tap <strong>Work shift time-off requests</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> Tap the menu icon and then tap <strong>Request time off</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>c.</strong> In the <strong>Title</strong> field, enter a reason for the time off request.</td>
</tr>
<tr>
<td></td>
<td><strong>d.</strong> In the <strong>Start time</strong> field:</td>
</tr>
<tr>
<td></td>
<td>i. Tap the calendar icon.</td>
</tr>
<tr>
<td></td>
<td>ii. Tap and select the date you want to start taking time off.</td>
</tr>
<tr>
<td></td>
<td>iii. Tap the time field at the top-right corner of the calendar and select the time to start taking your time off.</td>
</tr>
<tr>
<td></td>
<td>iv. Click <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>e.</strong> In the <strong>End time</strong> field:</td>
</tr>
<tr>
<td></td>
<td>i. Tap the calendar icon.</td>
</tr>
<tr>
<td></td>
<td>ii. Tap and select the date you want to end taking time off.</td>
</tr>
<tr>
<td></td>
<td>iii. Tap the time field at the top-right corner of the calendar and select the time to end your time off.</td>
</tr>
<tr>
<td></td>
<td>iv. Click <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>f.</strong> In the <strong>Description</strong> field, enter a reason for requesting time off.</td>
</tr>
</tbody>
</table>

3. If you are using:
   - An Android application, tap the send icon.
   - An iOS application, tap **Submit**.
   A notification to approve your request is sent to your manager.

4. Request a shift-swap.
You can communicate with other agents by using Connect Chat or the activity stream on the record to make sure that they would like to swap the requested shift with you.

5. In the Schedule section, tap My calendar.
6. Tap the date for which you want to make the request.
7. Tap the work shift for that day.

⚠️ Note: Alternatively, you can swipe left on the shift you want to request time off or shift swap and select the desired option.

8. Tap Request shift swap.
9. In the Swap with field, tap and select the agent you want to swap with.
10. Make a shift-swap request.
11. In the Requested shift field, tap and select the agent’s shift that you want to swap with.
12. If you are using:
   • An Android application, tap the send icon.
   • An iOS application, tap Submit.
   A notification is sent to the agent to approve your request.

Approve or reject a shift swap using the ITSM Mobile Agent application

Using your ITSM Mobile Agent application, approve a shift swap requested by your peer if you are available to work at that time. You can reject it if you are unable to work then.

Before you begin
Role required: sn_shift_planning.agent

⚠️ Note: If you have notifications enabled, you can approve or reject shift-swap requests from the notifications without opening the request.

Procedure
1. Navigate to the ITSM Mobile Agent Agent application.
2. Tap Approvals.
3. In the Pending list, select a request to approve and review the request details.
4. Do one of the following:
To approve a request, tap **Approve**.

To reject a request, tap **Reject**.

Your peer receives a notification on the request approval status.

**Track and manage your agent's schedule using the ITSM Mobile Agent application**

Monitor the shifts and schedule of teams within your assignment group using the ITSM Mobile Agent application. You can approve or reject requests for swapping shifts or time off for your agents.

**Before you begin**

Role required: sn_shift_planning.admin

**Note:** If you have notifications enabled, you can approve or reject shift-swap or time-off requests from the notifications without opening the request.

**Procedure**

1. Navigate to the ITSM Mobile Agent application.
2. Monitor your team's schedule.
   a. Tap **My team**.
   b. In the **Schedule** section, click **Team Calendar**.
   c. Tap the day for which you would like to monitor the schedule.
   d. Tap a shift for the day to view the details for the shift.
3. Approve or reject an agent's time off or shift-swap with another agent.
   a. Tap **My work**.
   b. Tap **Approvals**. You can view the pending requests in your queue waiting for approval and also the approvals you have completed and the details for each request.
   c. From the **Pending** list, tap a request to approve.
      - To approve a request, tap **Approve**. The schedule gets update in the calendar based on the approval.
      - To reject a request, tap **Reject**. The agent receives a notification when you approve or reject the request.
Incident Communications Management

The ServiceNow® Incident Communications Management application enables organizations to create and manage communications related to major business issues or incidents.

Incident Communications Management allows incident communications administrators to bring together all involved users during these events and establish quick and easy communication within this group.

For example, a major issue occurs in a server room, which leads to a high-priority incident to be raised. The incident can potentially impact all users, so it is important to bring together key representatives and communicate quickly and effectively. An incident communication plan can facilitate this communication process and help resolve the source incident.

Usage of Incident Communications Management

- Create an incident communication plan when a crisis occurs.
- Set up contact responsibilities to identify the individuals who receive automatic notifications when incident communication plans are created. If they want to receive notifications, Self-Service users can subscribe to incident communication plans.
- Manage incident communication plans to improve communication while dealing with the crisis.
- Use the optional Notify feature to send notifications by SMS messages and voice mails, and to set up conference calls.
- Monitor events and results with the incident communication plan dashboard and reports.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Incident communication plan state model (old)</td>
<td>• Activate Incident Communications Management</td>
<td>• Run an incident communication plan report</td>
</tr>
<tr>
<td>• Incident communication plan state model (new)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Domain separation and Incident Communications Management</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Integrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>• NA</td>
<td>• Developer training</td>
<td>Incident Communications Management integrations</td>
</tr>
<tr>
<td></td>
<td>• Developer documentation</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Troubleshoot and get help

- Ask or answer questions in the Incident Communications Management community
- Search the Known Error Portal for known error articles
- Contact Customer Service and Support

Incident Communications Management plugins

Activate Incident Communications Management plugin (com.snc.iam) in the base system.

Activate Incident Communications Management

Activate the Incident Communications Management (com.snc.iam) plugin if you have the admin role.

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information

Incident Communications Management

Components installed with Incident Communications Management

Several types of components are installed with activation of the Incident Communications Management plugin (com.snc.iam), including tables and user roles.
### Note:
The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

## Roles installed

<table>
<thead>
<tr>
<th>Role title</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>ia_admin</td>
<td>Can create, edit, or cancel incident communication plan, incident communication task, and manage contact information.</td>
<td>• contact_admin&lt;br&gt;• sn_comm_management.comm_plan_manager&lt;br&gt;• notify_view</td>
</tr>
<tr>
<td>contact_admin</td>
<td>Can create and edit contact definitions and contact responsibilities.</td>
<td>contact_user</td>
</tr>
<tr>
<td>contact_user</td>
<td>Can view contacts, contact definitions, contact responsibilities, and default overrides.</td>
<td>NA</td>
</tr>
</tbody>
</table>
Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impacted CI [impacted_ci]</td>
<td>The CIs impacted by the source CI in the incident communication plan.</td>
</tr>
<tr>
<td>Incident Communication Plan</td>
<td>The Incident Communication Plan table extends from the Communication Plan table [comm_plan] so that the incident communication plan inherits any future enhancements made to the communication object.</td>
</tr>
<tr>
<td>Incident Communication Task</td>
<td>The Incident Communication Task table extends the Communication Task table [comm_task].</td>
</tr>
</tbody>
</table>

Incident communication plan state model (new)

Incident communication plan state model helps you to understand the different states through which a plan can progress and track the plan through its states. Incident communication plans are created with an Open state. They follow a process that finishes with the Closed or Canceled state. The following state model is applicable to new customers starting the Madrid release.

The following two properties are responsible for different actions that take place on Incident Communication Plan and Incident Communication Task:
• The **Close open Incident Communication Plans when Incident is closed or canceled** property (com.snc.incident.incident_alert.closure) is responsible for the following action:
  ◦ When incident is closed, any open Incident Communication Plan is closed.
  ◦ When an incident is canceled, any open Incident Communication Plan is canceled.

• The **Close open Incident Communication Tasks when an Incident Communication Plan is closed or canceled** property (com.snc.iam.incident_alert_task.closure) is responsible for the following actions:
  ◦ If an Incident Communication Plan is **Closed** or **Canceled**, then the state of any open Incident Communication Task on which communication is not yet performed, is set to **Skipped**.
  ◦ If an Incident Communication Plan is **Closed** or **Canceled**, then the state of any open Incident Communication Task on which communication is performed at least once, is set to **Complete**.

**Note:** The **Close open Incident Communication Plans when Incident is closed or canceled** and **Close open Incident Communication Tasks when an Incident Communication Plan is closed or canceled** property is visible when you activate the Incident Communications Management plugin (com.snc.iam). This property is set to false for both new and existing customers.

**Incident communication plan state model (old)**

Incident communication plan state model helps you to understand the different states through which a plan can progress and also to track the plan through its states.

Incident alerts are created with a **New** state. They follow a process that finishes with the **Closed** or **Canceled** state.

**Note:** The state model shown below is available only for customers prior to the London release. Beginning London release, customers who have upgraded to the latest release, can refer to **Incident communication plan state model (new)**.
The incident communication plan changes from the **New** state to the **Work in Progress** state when you update the **Actions Taken** field. Only the incident communication plan creator or a user with the admin role can cancel an incident communication plan.

The following two properties are responsible for different actions that take place on Incident Communication Plan and Incident Communication Task:

- **The Close open Incident Communication Plans when Incident is closed or canceled** property (`com.snc.incident.incident_alert.closure`) is responsible for the following actions:
  - If an incident is closed or canceled when the incident communication plan state is **New** or **Work in Progress**, the incident communication plan state is set to **Canceled**.
  - If an incident is closed or canceled when the incident communication plan state is **Resolved**, the incident communication plan state is set to **Closed**.

- **The Close open Incident Communication Tasks when an Incident Communication Plan is closed or canceled** property (`com.snc.iam.incident_alert_task.closure`) is responsible for the following actions:
  - If an incident communication plan is closed, the state of all open incident communication tasks is set to **Closed Incomplete**.
  - If an incident communication plan is canceled, the state of all open incident communication tasks is set to **Closed Skipped**.
Note: The Close open Incident Communication Plans when Incident is closed or canceled and Close open Incident Communication Tasks when an Incident Communication Plan is closed or canceled property is visible when you activate the Incident Communications Management plugin (com.snc.iam). This property is set to false for both new and existing customers.

Working with Incident Communications Management

Incident Communications Management provides a framework for defining and managing a communication process for an incident. It helps you to streamline a communication process by creating designated incident communication plans for effective communication during an event.

Communication plan definition

An incident communication plan helps you to streamline a communication process with regards to an incident. It defines the stakeholders who should be informed, what information should be shared, when the information should be delivered, and the methods of communication.

For information on how to create a communication plan definition, refer to Create communication plan definition.

Important: While creating the Communication Plan definition, ensure that the table is Incident [incident]. If you have upgraded to London or a higher release and you use communication plan to streamline the communication process, deactivate the Major Incident Response and Resolution flow designer.

Communication task definition

Each communication plan involves a series of communication tasks. A communication task definition helps you to specify the mode of communication (channel) and the frequency at which the communication must be carried out.

For information on how to create a communication task definition, refer to Create communication task definition.

Communication contact definition

Communication contact definition helps you to define the recipients of a particular communication plan. The contact determines the target audience involved in each communication task and the responsibilities they are expected to handle. A notification for a task is sent to all individuals specified for that task. You can add or remove any particular communication contact manually.
For information on how to create a communication contact definition, refer to Create communication contact definitions.

**Communication channel definition**

You can define a communication channel for each communication task. The communication channel determines which mode of communication to use for the task when a plan is attached to an incident. The modes of communication available are: email, SMS, conference, and Slack.

For information on how to create a communication channel definition, refer to Create communication channel definition.

**Create adhoc incident communication plan**

Create an adhoc incident communication plan to manage and track communications around a high-priority incident or other issues.

The adhoc incident communication plan can be created in the following ways:

- Create adhoc incident communication plan from Incident Communications Management.
- Create adhoc incident communication plan from an incident.

**Create adhoc incident communication plan from Incident Communications Management**

Create an incident communication plan from Incident Communications Management when an issue is not considered earlier. If you need collaboration on that issue, you can create an incident communication plan.

**Before you begin**

Role: major_incident_manager, ia_admin, or admin

**Procedure**

1. Navigate to Incident Communications Management > Create New.
2. On the form, fill in the fields.
### Incident Communication Plan form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique incident communication plan ID, in the ICPxxxxxxxx format.</td>
</tr>
<tr>
<td>Source incident</td>
<td>The source incident for this communication plan, if any. If you select a source incident, the <strong>Background</strong> field is populated with data from this incident, unless there is existing data in this field.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of communication plan available are Ad hoc, End User, Stakeholder, and Technical.</td>
</tr>
<tr>
<td>Communication plan definition</td>
<td>The communication plan definition based on which this incident communication plan is attached.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the communication plan. The available values are <strong>Open</strong>, <strong>Closed</strong>, or <strong>Canceled</strong>.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The assignment group, if any, for that incident communication plan. For example, there might be a group that represents a crisis management team, including several Incident Managers, Duty Directors, and Duty Managers.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The assigned user for the communication plan. By default, the assigned to user is the one who creates the communication plan. The communication plan can also</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
be assigned to an ITIL user or an incident communication plan administrator. | 
Order | Order in which the communication plan appears in the incident. If there are multiple communication plans, this field indicates which communication plan to execute first. |
Short description | A brief summary of the communication plan. |
Description | A detailed description of the communication plan. |
Notes | Work notes, activities, and background information regarding the incident communication plan. |

3. **Click Submit.**
An incident communication plan is created. The **Communication** tab lists the communication tasks that have email, SMS, or slack as the communication channel. The **Conference** tab lists the communication tasks that have conference as the communication channel.

**Create adhoc incident communication plan from incident**
Create an adhoc incident communication plan from an incident when an issue related to the incident is not considered earlier. The incident automatically populates the required information in the adhoc communication plan, saving you time and effort.

**Before you begin**
Role: major_incident_manager, ia_admin, or admin

**Procedure**
1. **Navigate to Self-Service > Incident > Open.**
2. Open an existing incident.
3. **Click the Incident Communication Plans related list.**
4. **Click New.**
The original incident becomes the source incident of this communication plan.
5. **On the form, fill in the fields.**
## Incident Communication Plan form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated unique incident communication plan ID, in the ICPxxxxxxxx format.</td>
</tr>
<tr>
<td>Source incident</td>
<td>The source incident for this communication plan, if any. If you select a source incident, the <strong>Background</strong> field is populated with data from this incident, unless there is existing data in this field.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of communication plan available are Ad hoc, End User, Stakeholder, and Technical.</td>
</tr>
<tr>
<td>Communication plan definition</td>
<td>The communication plan definition based on which this incident communication plan is attached.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the communication plan. The available values are <strong>Open</strong>, <strong>Closed</strong>, or <strong>Canceled</strong>.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The assignment group, if any, for that incident communication plan. For example, there might be a group that represents a crisis management team, including several Incident Managers, Duty Directors, and Duty Managers.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The assigned user for the communication plan. By default, the assigned to user is the one who creates the communication plan. The communication plan can also be assigned to an ITIL user or an incident communication plan administrator.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the communication plan appears in the incident. If there are multiple communication plans, this field indicates which communication plan to execute first.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief summary of the communication plan.</td>
</tr>
<tr>
<td>Description</td>
<td>A detailed description of the communication plan.</td>
</tr>
<tr>
<td>Notes</td>
<td>Work notes, activities, and background information regarding the incident communication plan.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.
An incident communication plan is created. The **Communication** tab lists the communication tasks that have email, SMS, or slack as the communication channel. The **Conference** tab lists the communication tasks that have conference as the communication channel.

**Create adhoc incident communication task from Incident Communications Management**

Create an adhoc incident communication task while you are working on the communication plan. The communication task helps you to specify the mode of communication (channel) and the frequency at which the communication must be carried out.

**Before you begin**
Role required: major_incident_manager, ia_admin, or admin

**Procedure**
1. Navigate to **Incident Communications Management > Open**.
2. Open the incident communication plan for which you want to create the communication task.
3. In the Incident Communication Tasks related list and click **New**.
4. On the form, fill in the fields.

### Incident Communication Task form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique incident communication task ID, in the ICTxxxxxxxx format.</td>
</tr>
<tr>
<td>Incident Communication Plan</td>
<td>[Read-only field] Incident communication plan for which you create the task.</td>
</tr>
<tr>
<td>Source incident</td>
<td>[Read-only field] Lookup icon to select the incident on which you want the plan to be attached.</td>
</tr>
<tr>
<td>Type</td>
<td>Lookup icon to select the type of task such as internal communication.</td>
</tr>
<tr>
<td>Communication task definition</td>
<td>[Read-only field] Unique name of the communication task definition for which you are creating the task.</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>The state of the communication plan. The available values are <strong>Pending</strong>, <strong>Open</strong>, <strong>In Progress</strong>, <strong>Complete</strong>, and <strong>Skipped</strong>.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The assignment group, if any, for that incident communication task.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The assigned user for the communication task.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the communication task appears in the communication plan. If there are multiple communication tasks, this field indicates which communication task to execute first.</td>
</tr>
<tr>
<td>Communication frequency</td>
<td>Frequency of the communication task execution. You can send the notification once or the notification can be repeated.</td>
</tr>
<tr>
<td>Due in</td>
<td>Time by which the communication task must be completed.</td>
</tr>
<tr>
<td>Last communication sent</td>
<td>The date and time when the last communication is sent to the user or the group.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief summary of the communication task.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the communication task.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**What to do next**
Create adhoc incident communication channel. For more information on how to define a communication channel, refer [Define a communication channel](https://www.servicenow.com/support/).
Incident Communications Management and Contacts

You can define contacts to associate users or groups to an incident communication plan. The users or groups are contacted to complete the tasks included in a communication plan.

If you have the ia_admin role, you can assign users or groups to an incident communication plan based on the information provided in these records:

- **Contact responsibilities**: Provides a name, such as Incident Duty Manager, for a set of tasks related to incident communication plan. The contact responsibility record also indicates whether the tasks are performed by an individual user or a group of users. Contact responsibilities can also be used to manually add contacts to an incident communication plan.

- **Contact definitions**: Identifies a set of conditions to determine which specific user or group is assigned to handle a particular responsibility for an incident communication plan. For example, All P1 Incidents must have an Incident manager, assigned to US Incident Management group.

Contact responsibilities and contact definitions allow you to define and modify data-driven contact information for automatic notifications. You do not have to specify individual users or groups directly for each incident communication plan.

You can use group contacts. You can use the Group contacts functionality when you have on-call scheduling, Notify, and Incident Communications Management. Group contacts include the people that are on-call. The group contacts can be included when initiating a conference call that is a result of an incident communication plan. By default, the primary and secondary on-call persons are available. To modify this behavior, set the system property `com.snc.iam.on_call_escalation_level`.

Responsibilities for Incident Communication Plan

Contact responsibilities helps you to identify contacts by their responsibilities and to understand what you can expect from the user throughout the life cycle of the communication plan.

There are two types of responsibilities available for use with incident communication plans:

- **Default Responsibilities**: Contacts who are notified by default.
- **Other Responsibilities**: Contacts who can be selected for notification.

Use contact definitions to view and modify the rules that determine the specific users associated with contact responsibilities.
Default Responsibilities
By default, contacts with the following responsibilities are notified when an incident communication plan is created:

- Duty Manager
- Incident Manager
- Duty Director

These roles are involved with resolving the source incident or original event that the incident communication plan relates to. They are seen as key contacts for the incident communication plan.

The following sections describe typical operational roles for these responsibilities.

Contact Administration Default Responsibilities

<table>
<thead>
<tr>
<th>Responsibility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duty Manager</td>
<td>The senior point of presence in the monitoring environment at the time an incident occurs. The Duty Manager assesses the incident against standard operating procedures, escalation triggers, and personal knowledge and experience, to take corrective actions. To clarify the urgency and impact of an incident, the Duty Manager can contact the Incident Manager for advice.</td>
</tr>
<tr>
<td>Incident Manager</td>
<td>A senior technician, accountable for coordinating and managing all technical resources required to resolve incidents. After being notified by the Duty Manager of a serious incident, the Incident Manager assesses the seriousness and associated business impact. Based on this assessment, the Incident Manager decides whether to escalate the incident to the Duty Director. The Incident Manager may escalate to the Duty Director to gain access to resources outside of the department, if necessary.</td>
</tr>
<tr>
<td>Duty Director</td>
<td>The escalation point for all issues that affect critical services. The Duty Director works in partnership with the business directors in the organization to approve recovery plans developed by the Incident Manager. The Duty Director also manages the senior level communications for the source incident.</td>
</tr>
</tbody>
</table>

Other Responsibilities
Incident Communications Management provides the following additional responsibilities that can be added to incident communication plans. You can also create contact responsibilities, as needed. The associated users receive notifications about the incident communication plan.
## Contact Administration Other Responsibilities

<table>
<thead>
<tr>
<th>Responsibility</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Director</td>
<td>Director within the business who is identified as a potential contact when an incident communication plan occurs.</td>
</tr>
<tr>
<td>Communication Manager</td>
<td>Business-facing role in the event communication is required in an incident communication plan.</td>
</tr>
<tr>
<td>Crisis Action Manager</td>
<td>Overall responsibility and accountability for managing incident communication plans.</td>
</tr>
<tr>
<td>Crisis Action Team Member</td>
<td>Nominated department heads who are involved when an incident communication plan occurs.</td>
</tr>
<tr>
<td>Development personnel</td>
<td>Development personnel involved in the troubleshooting and resolving an incident communication plan.</td>
</tr>
<tr>
<td>Operations support personnel</td>
<td>Personnel involved in the second or third level of support in troubleshooting and resolving an incident communication plan.</td>
</tr>
<tr>
<td>Service Owner</td>
<td>Service owner or manager who is identified as a potential contact when an incident communication plan relates to one or more of their services.</td>
</tr>
<tr>
<td>Technical Support</td>
<td>Second or third level technical support personnel involved in troubleshooting and resolving an incident communication plan.</td>
</tr>
</tbody>
</table>

### Define contact responsibilities

Define the different contacts or target audience involved in the communication process and their responsibility to understand the expectations from those contacts throughout the process.

**Before you begin**

Role required: ia_admin or admin

**Procedure**

1. Navigate to Incident Communications Management > Contact Administration > Contact Responsibilities.
2. Click New.
3. On the form, fill in the fields.
Contact Responsibility form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Check box to determine whether the contact responsibility is available for all tables or for a specific table. If the check box is not selected, the Table field appears where you can select the table for which you are defining the contact responsibility.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique name of the contact, such as Business Director or Communication Manager, involved in the communication process.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of contact such as user, group, or recipient list.</td>
</tr>
<tr>
<td>Table</td>
<td>Table on which contact is activated when a communication plan is attached.</td>
</tr>
</tbody>
</table>

4. Click **Submit**. 
Contact responsibilities are defined.

**Create a contact definition**

Define the recipients of a particular incident communication plan to determine the target audience involved in each communication task and the responsibilities the recipients are expected to handle.

**Before you begin**

Role: ia_admin or admin

**Procedure**

1. Navigate to **Incident Communications Management > Contact Administration > Contact Definitions.**
2. Click **New.**
3. On the form, fill in the fields.

### Contact definition form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the contact definition.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of contact such as user or group that you want to involve in the plan.</td>
</tr>
<tr>
<td>Responsibility</td>
<td>Responsibility that the user or group is expected to handle.</td>
</tr>
<tr>
<td>Source</td>
<td>Method to determine the user or group to associate with this definition.</td>
</tr>
<tr>
<td></td>
<td>The source can be:</td>
</tr>
<tr>
<td></td>
<td>- <strong>None</strong>: Use no association. You should associate users or groups manually within the Incident Communication Plan form.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default Override</strong>: Use default override to associate users or groups based on conditions.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Form Field</strong>: Use information from the incident communication plan form based on the value specified in the Source field.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The maximum number of contacts that can be associated with the selected responsibility for each incident communication plan record.</td>
</tr>
</tbody>
</table>

**Note:** The Quantity field appears only when you select None as the value for the Source field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source field</td>
<td>The field on the Incident Communication Plan form whose value is considered to be the contact associated with the selected contact responsibility.</td>
</tr>
<tr>
<td></td>
<td>• For contact type as User, the values are Assigned to, Closed by, Opened by, or Resolved by.</td>
</tr>
<tr>
<td></td>
<td>• For contact type as Group, the value is Assignment group.</td>
</tr>
<tr>
<td></td>
<td>Note: The Source field appears only when you select Form field as the value for the Source field.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to indicate whether the definition is active or not.</td>
</tr>
<tr>
<td>Condition</td>
<td>The conditions that must be met to associate this contact definition to a particular user or group. If multiple conditions are defined, each condition is evaluated in the order listed.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Create a default override

Create a default override to specify user or group for a contact definition of an incident communication plan. It helps you to set multiple conditions based on which a user or a group is considered as a contact.

Before you begin
Role: ia_admin or admin

About this task
The Default overrides related list is available only if you select Default override as the value of the Source field in the Contact definition form.

Procedure
1. Navigate to Incident Communications Management > Contact Administration > Contact Definitions.
2. Open the contact definition record.
3. In the Default override section, click New.
4. On the form, fill the fields.

Default override form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order</td>
<td>The order in which the condition in default override should be evaluated.</td>
</tr>
<tr>
<td>User value</td>
<td>User specified in the User value field is assigned as the contact if the condition in the default override matches.</td>
</tr>
<tr>
<td>Group value</td>
<td>Group specified in the Group value field is assigned as the contact if the condition in the default override matches.</td>
</tr>
<tr>
<td>Condition</td>
<td>The conditions defining whether the default override values are to be applied. If multiple conditions are defined, each condition is evaluated as per the listed order. If no conditions match, the default override is not applied.</td>
</tr>
</tbody>
</table>

5. Click Submit.
Default override and its conditions are defined for a contact definition.

Add a user as a contact

Add a user to a communication plan if you have not added the user earlier in the contact. You can assign a communication task to the user to resolve an issue.
Before you begin
Role: ia_admin or admin

Procedure
1. Navigate to Incident Communications Management > Open.
2. Open an incident communications plan record.
3. Click the Users related list and click New.

4. On the form, fill in the fields.

Contact form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Task table for which you are creating the contact.</td>
</tr>
<tr>
<td>Document</td>
<td>The incident communication plan for which you are creating the contact.</td>
</tr>
<tr>
<td>Responsiblity</td>
<td>Responsibility that the user is expected to handle throughout the communication process.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of contact such as user, group, or recipient list that you want to involve in the plan.</td>
</tr>
<tr>
<td>Note: To add a user, select User for the Type field.</td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>Name of the user who is considered as the contact.</td>
</tr>
</tbody>
</table>

5. Click Submit.
The contact information appears in the Users related list.
Close an incident communication plan

Close an incident communication plan after its execution or if it is no longer needed.

Before you begin
Role required: itil, ia_admin, or admin

About this task
• The business rule IA_State_Management allows any user with the ia_admin role or an itil user who is assigned to the incident communication plan, to close or cancel an incident communication plan.
• If a user with the itil role closes or cancels a parent incident, all related incident communication plans are closed or canceled.

ℹ️ Note: Use the incident management property Close open Incident Communication Plans when incident is closed or canceled (com.snc.incident.incident_alert.closure) to control this behavior.

Procedure
1. Navigate to Incident Communications Management > Open.
2. Open the incident communications plan record that you want to close.
3. In the State field, select Closed.
4. Right-click on the form header and click Save.

Initiate conference call on incident communication task

Initiate a conference call and include all the required stakeholders to discuss on the resolution of the incident and the communication task.

Before you begin
Role required: sn_comm_management.comm_plan_manager or sn_comm_management.comm_plan_admin

Activate the Notify plugin (com.snc.notify), configure the Twilio account, configure the com.snc.iam.notify_number property and create a default provider selector. You can also create a provider selector on the Incident Communication Task table [incident_alert_task]. The provider selector specifies the Notify group containing the Notify phone numbers or conference provider to make outgoing calls.
Procedure

1. Navigate to **Incident > All**.
2. Open an incident record.
3. From the Incident Communication Plan related list, open the incident communication plan.
4. From the Incident Communication Tasks related list, open the incident communication task.
5. In the related link, click **Initiate Conference Call**.
6. Select the conference bridge number and the participants for the conference call and click **Start Call**.

Join or end conference call on incident communication task

After a conference call is initiated, join the call to participate in the discussion or end the call when the conference is no longer required.

Before you begin

Role required:

- Join conference call: ia_admin, itil, or sn_incident_write
- End conference call: sn_comm_management.comm_plan_manager or sn_comm_management.comm_plan_admin

Procedure

1. Navigate to **Incident > All**.
2. Open an incident record.
3. From the Incident Communication Plan related list, open the incident communication plan.
4. From the Incident Communication Tasks related list, open the incident communication task.
5. In the related links, perform any of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join Conference Call</td>
<td>If the logged in user is not already a part of the conference call, the user can join the conference.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>End Conference Call</td>
<td>End the conference when the discussion is over.</td>
</tr>
<tr>
<td>Note:</td>
<td>The work notes get updated with the details of the conference call such as duration and participants.</td>
</tr>
</tbody>
</table>

**Send communication updates**

Update users on the latest communication on an incident through selected communication channels.

**Before you begin**

- Role required: admin
- Activate the Notify plugin (com.snc.notify) if you want to send communication through SMS.
- Set at least one communication channel of a communication task as SMS or email.

**Procedure**

1. Navigate to **Incident Communications Management > All**.
2. Open an incident communication plan record.
3. From the Incident Communication Tasks related list, open the incident communication task for which you want to send updates.
4. In the related links, click **Send Updates**.
5. Fill in the required information and click **Compose**.
   For sending an SMS communication, in the **From** list, select a number from which you want to send the communication. It contains a list of phone numbers derived from the selected **Provider selector** column which is a reference to the Provider selector table [notify_group_selector]. The **From** list displays phone numbers of all the groups associated with the Provider selector only when the following conditions are met:
   - The **Manual selector** check box in the Provider selector form is selected.
   - The value of the **Source table** field in the Provider selector is either empty or the same table that you have selected.
6. Click **Compose**.
Run an incident communication plan report

Run an incident communication plan report to view the status of communication plans. You can track the progress of the plan and intervene to improve the overall efficiency and effectiveness of the communication process.

Before you begin
Role: ia_admin or admin

Procedure
1. Navigate to Reports > View / Run.
2. Click Create a report.
3. Under Data, fill in the fields.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report name</td>
<td>Unique name for the report.</td>
</tr>
<tr>
<td>Source type</td>
<td>Source from which the data is populated. The default value is Table.</td>
</tr>
<tr>
<td>Table</td>
<td>Table from which the data is retrieved.</td>
</tr>
</tbody>
</table>

4. Click Run.

Note: You can also choose a graphical representation for the report or narrow down the result using the Type and Configure options.
Subscribe to incident communication notifications

Subscribe to incident communication notifications to get periodic information about issues related to incident communication plans.

Before you begin
Role: itil, ia_admin, or admin

Procedure
1. Navigate to Self-Service > My Notification Preferences.
2. Under System Settings, select Notifications.
3. Under Notifications By Category, select Incident Communication Plan.
   The following notification options appear for incident communication plan: IA Actions Taken, IA Cancelled, IA Resolved Or Closed, and New IA Raised.
4. Click the notification option for which you want to receive notifications.
5. Under NOTIFICATION CHANNELS, right-swipe or left-swipe the toggle button to subscribe or unsubscribe from a notification.
6. Click the channel name to add a schedule for the notification and to filter the notification conditions as required.

   Note: Apply filter to your notification channel to avoid receiving every notification for the subscription.

7. Click Save.
   You are subscribed to incident communication notification.
Incident Communications Management integrations

Incident Communications Management is integrated with other applications such as Notify to improve the overall communication process.

Notify with Incident Communications Management

Notify allows you to integrate with the Twilio telephony service to send and receive phone calls and SMS from within your instance. In Incident Communications Management, Notify provides you with SMS and conference as channels.

For more information on how notify works with Incident Communications Management, refer Using Notify with Incident Communications Management.

Domain separation and Incident Communications Management

Domain separation is supported in Incident Communications Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Standard

• Includes Basic level support.

• Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.

• The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

Overview

• The Incident Communications Management application enables organizations to create and manage communications related to major business issues or incidents. Incident communication plan administrators can bring together all involved users during these events and establish quick and easy communication within this group.
• Typically, Incident Communication Plan Admin or Major Incident Manager creates incident communication plans for an existing incident. Multiple incident communication plans can be created against the same incident.

• The incident communication plan and incident communication task tables support domain separation. Therefore, an Itil/Fulfiller sees only incident communication plans or incident communication tasks that have been created within the (tenant) domain that they belong to.

How domain separation works in Incident Communications Management
Fulfillers see only incident communication plan and incident communication plan tasks that have been created within the (tenant) domain that they belong to.

Domain separated tables
• Incident Communication Plan [incident_alert]
• Incident Communication Task [incident_alert_task]

Use cases
• An Incident Communication Plan Admin or Major Incident Manager is able to view incidents only of those domains that they have access to. They can create incident communication plans against only those incidents.

Related information
Domain separation for service providers

Incident Management
Incident Management restores normal service operation while minimizing impact to business operations and maintaining quality.

ServiceNow Incident Management supports the incident management process in the following ways:
• Log incidents in the instance or by sending email.
• Classify incidents by impact and urgency to prioritize work.
• Assign to appropriate groups for quick resolution.
• Escalate as necessary for further investigation.
• Resolve the incident and notify the user who logged it.
• Use reports to monitor, track, and analyze service levels and improvement.

Any user can record an incident and track it through the entire incident life cycle until service is restored and the issue is resolved.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Incident Management process</td>
<td>• Create an incident template</td>
<td>• Show flagged VIPs in the incident list</td>
</tr>
<tr>
<td>• Incident Management state model</td>
<td>• Create a record producer</td>
<td></td>
</tr>
<tr>
<td>• Upgrade to Rome</td>
<td>• Configure incident categories or subcategories</td>
<td></td>
</tr>
<tr>
<td>• Domain separation and Incident Management</td>
<td>• Define an assignment rule for incidents</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Configure Incident Management</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Integrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Create an incident</td>
<td>• Developer training</td>
<td>• Incident ticketing integrations</td>
</tr>
<tr>
<td>• Major incident management</td>
<td>• Developer documentation</td>
<td></td>
</tr>
<tr>
<td>• Copy an incident or create child incident</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Promote an incident</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Troubleshoot and get help</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Ask or answer questions in the Incident Management community</td>
<td>• Search the Known Error Portal for known error articles</td>
<td></td>
</tr>
<tr>
<td>• Search the Known Error Portal for known error articles</td>
<td>• Contact Customer Service and Support</td>
<td></td>
</tr>
</tbody>
</table>

**Incident Management process**

ServiceNow Incident Management supports the incident management process with the ability to identify and log incidents, classify and prioritize incidents,
assign incidents to appropriate users or groups, escalate, resolve, and report incidents.

Any user can record an incident and track it until service is restored and the issue is resolved. Each incident is generated as a task record that contains pertinent information. Incidents can be assigned to appropriate service desk members, who resolve the task and document the investigation. After the incident is resolved, you can manually close the incident. You can also close incidents automatically based on the last updated date or the resolution date of the incident. For more information about auto-closing incidents, see Configure incidents to close automatically.

Any user can log an incident within the system using the following methods. Introduction to incident management; creating, working on, resolving, closing, and reopening an incident; creating a knowledge base article from an incident; escalating an incident; creating a problem or change from an incident.

ServiceNow Incident Management process follows these steps:

1. Incident identification
2. Incident logging
   - Incident categorization
   - Incident prioritization
3. Incident response
   - Initial diagnosis
   - Incident escalation
   - Investigation and diagnosis
   - Resolution and recovery
   - Incident closure

**Incident Identification**

The first step in the life of an incident is incident identification. You can report incidents through emails, sms, phone call, support chats, walk-ups, and applications. The service desk decides if the issue is truly an incident or if it is a request.

**Incident logging**

Once identified as an incident, the service desk logs the incident. The incident should include information, such as the caller, business service, configuration item, and contact type. The logging process includes categorization and prioritization of an incident.
Incident categorization
Incident categorization is a vital step in the incident management process. Categorization involves assigning a category and at least one subcategory to the incident.

Incident prioritization
Incident prioritization is important for SLA response adherence. The priority of an incident is determined by its impact on users or business and its urgency.

Incident response
Once identified, categorized, prioritized, and logged, the service desk can handle and resolve the incident. Incident resolution involves five steps:

- Initial diagnosis: Occurs when the user describes his or her problem and answers troubleshooting questions.
- Incident escalation: Happens when an incident requires advanced support, such as sending an on-site technician or assistance from certified support staff.
- Investigation and diagnosis: Takes place during troubleshooting when the initial incident hypothesis is confirmed as being correct. Once the incident is diagnosed, service desk can apply a solution, such as changing software settings, applying a software patch, or ordering new hardware.
- Resolution and recovery: Happens the service desk confirms that the service of the user is restored within the stipulated SLA time.
- Incident closure: At this point, the incident is considered closed and the incident process ends.

Life cycle of an Incident
Incident Management is responsible for managing the life cycle of incidents, from creation to closure.

The Incident Management process has many states, and each is vitally important to the success of the process and the quality of service delivered. The different states can be represented in a diagram as follows:
Incident management state model flow

Incident states

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Incident is logged but not yet investigated.</td>
</tr>
<tr>
<td>In Progress</td>
<td>Incident is assigned and is being investigated.</td>
</tr>
<tr>
<td>On Hold</td>
<td>The responsibility for the incident shifts temporarily to another entity to provide further information, evidence, or a resolution. When you select the <strong>On Hold</strong> option, the <strong>On hold reason</strong> list appears. If the <strong>On hold reason</strong> is <strong>Awaiting Caller</strong>, the <strong>Additional comments</strong> becomes mandatory. <strong>Note:</strong> If the caller updates the incident, the <strong>On hold reason</strong> field is cleared and the state of the incident is changed to <strong>In Progress</strong>. An email notification is sent to the user whose name is mentioned in the <strong>Assigned to</strong> field as well as to the users in the <strong>Watch list</strong>. An incident can be placed in the <strong>On hold</strong> state one or more times prior to being closed.</td>
</tr>
</tbody>
</table>
Incident states (continued)

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolved</td>
<td>A satisfactory fix is provided for the incident to ensure that it does not occur again.</td>
</tr>
<tr>
<td>Closed</td>
<td>Incident is marked <strong>Closed</strong> after it is in the <strong>Resolved</strong> state for a specific duration and it is confirmed that the incident is satisfactorily resolved.</td>
</tr>
<tr>
<td>Canceled</td>
<td>Incident was triaged but found to be a duplicate incident, an unnecessary incident, or not an incident at all.</td>
</tr>
</tbody>
</table>

Incident Management plugins

Many of the Incident Management plugins are activated in the base system. Others, you can activate when you are ready to use them. Some plugins include demo data.

**Activate Incident**

You can activate the Incident plugin (com.snc.incident) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**About this task**

Incident plugin activates these related plugins if they are not already active.

**Plugins for Incident**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Management Basics [com.snc.service]</td>
<td>Provides the baseline for Service Management functionality.</td>
</tr>
<tr>
<td>Incident Management Notification [com.snc.incident_notification]</td>
<td>Provides notification functionality for Incident Management.</td>
</tr>
<tr>
<td>Incident Overview Homepage</td>
<td>Incident Overview Homepage</td>
</tr>
</tbody>
</table>
Plugins for Incident (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[com.glideapp.report.itsm.incident.overview]</td>
<td></td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to **System Applications** > **All Available Applications** > **All**.

2. Find the plugin using the filter criteria and search bar. You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information

- [List of Rome plugins](#)

Components installed with Incident

Several types of components are installed with activation of the Incident plugin.

   Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see [Find components installed with an application](#).

Demo data is available for this feature.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>The Incident table is extended from the Task [task] table. It inherits all the fields, rules and policies from task.</td>
</tr>
</tbody>
</table>
Request Incident Management — Core

Incident Management - Core plugin (com.snc.incident_management) is a new incident state model that includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task
Incident Management - Core (com.snc.incident_management) is available by default in new instances. Customers upgrading from Geneva or earlier versions must request the plugin. For more information, see KB0564465.

⚠️ Note: If the new state model is installed on upgraded instances, then ensure that the old states are mapped to the new ones. The mapping is especially important if you have made customizations, implemented workflows, added script includes, and added business rules.

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.

3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.
4. Select your instance.
5. Select Actions > Activate Plugin.
6. On the form, fill in the fields.

### Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>

**Note:** Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the **Reason/Comments** field.

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments. |

7. Click **Submit**.

**Related information**

List of Rome plugins
Request ITSM Roles — Incident Management

Request the ITSM Roles plugin (com.snc.itsm.roles) to activate the ITSM Roles — Incident Management plugin (com.snc.itsm.roles.incident_management) to gain more control over the access that different service desk agents, technicians, and managers have within your Incident Management process.

Before you begin
Role required: admin

About this task
The ITSM Roles plugin (com.snc.itsm.roles) includes an additional security model. The security model provides more granular roles across ITSM applications as well as within them, allowing you flexibility in setting up access controls. The ITSM Roles plugin is available by default in new instances. Users upgrading from Madrid or earlier versions must request the plugin.

Plugins for ITSM Roles

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Stakeholder [com.snc_business_stakeholder]</td>
<td>business_stakeholder</td>
</tr>
<tr>
<td>ITSM Roles — Incident Management [com.snc.itsm.roles.incident_management]</td>
<td>• sn_incident_read&lt;br&gt;• sn_incident_write</td>
</tr>
<tr>
<td>ITSM Roles — Problem Management [com.snc.itsm.roles.problem_management]</td>
<td>• sn_problem_read&lt;br&gt;• sn_problem_write</td>
</tr>
<tr>
<td>ITSM Roles — Change Management [com.snc.itsm.roles.change_management]</td>
<td>• sn_change_read&lt;br&gt;• sn_change_write</td>
</tr>
</tbody>
</table>

Note: The business_stakeholder role contains the sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.
Plugins for ITSM Roles (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITSM Roles — Request Management [com.snc.service_management.roles.request_management]</td>
<td>• sn_request_read</td>
</tr>
<tr>
<td></td>
<td>• sn_request_write</td>
</tr>
</tbody>
</table>

Note: As there are future updates expected for the sn_request_read role, do not assign it to users without the business_stakeholder role.

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization's production and subproduction instances, generally within a few days.

If you don't have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

Note: Activate the ITSM Roles plugin on a subproduction environment and test the functionality before requesting activation in the production environment. For assistance, contact the ServiceNow Professional Services team.

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you</td>
<td>The date and time must be at least two business days from the</td>
</tr>
<tr>
<td>would like this plugin to be</td>
<td>current time.</td>
</tr>
<tr>
<td>enabled</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Note: Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.</td>
</tr>
</tbody>
</table>

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments. |

7. Click **Submit**.

**Related information**

List of Rome plugins

**Components installed with ITSM Roles — Incident Management**

Several user roles are installed with activation of the ITSM Roles — Incident Management plugin (com.snc.itsm.roles.incident_management).

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident read [sn_incident_read]</td>
<td>Read access to the Incident Management application and related records.</td>
<td>NA</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td><img src="image" alt="Note: An ESS user (user with no role) can view only those incidents that they create or someone else creates on their behalf. A user with the sn_incident_read role can view all incidents as well as the major incident workbench." /></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Incident write [sn_incident_write]</td>
<td>Write access to the Incident Management application and related records.</td>
<td>• sn_incident_read • template_editor</td>
</tr>
</tbody>
</table>

### Activate Business Stakeholder

Activate the Business Stakeholder plugin (com.snc.business_stakeholder) if you have an admin role. This plugin installs the Business Stakeholder role. Users with this role can view and approve records at all ITSM product levels.

#### Before you begin

*Role required: admin*

#### Procedure

1. **Navigate to** System Applications > All Available Applications > All.

2. **Find the plugin** using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. **Click Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

#### Related reference

List of plugins (Rome)

#### Installed with Business Stakeholder

The Business Stakeholder plugin (com.snc.business_stakeholder) installs the Business Stakeholder role when activated.
Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Business Stakeholder      | Users with this role can view and approve records within all products of ITSM. | • pa_viewer.business_stakeholder
                                   |                                                                             | • approver_user.business_stakeholder
                                   |                                                                             | • cmdb_read.business_stakeholder |
| [business_stakeholder]    |                                                                             |                                                                              |

Note: The business_stakeholder role contains the following ITSM roles sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.

Activate KCS Integration for Incident Management

Activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge) if you have the admin role. This plugin provides integration of Incident Management with the Advanced Knowledge Management features.

Before you begin
Role required: admin

About this task
The KCS Integration for Incident Management plugin (com.snc.incident.knowledge) activates the Knowledge Management Advanced Installer plugin.

Plugin for KCS Integration for Incident Management

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
| Knowledge Management Advanced Installer
   [com.snc.knowledge_advanced.installer]                      | Use this plugin to install the Knowledge Management Advanced plugin. Activating or upgrading this plugin validates knowledge articles and knowledge bases to ensure that |
Plugin for KCS Integration for Incident Management (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>the Knowledge Management Advanced plugin can be successfully installed.</td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   ✋ Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information

List of Rome plugins

Component installed with KCS Integration for Incident Management plugin

The Incident KCS Article table is installed with the activation of the KCS Integration for Incident Management plugin (com.snc.incident.knowledge).

✋ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident KCS Article [kb_template_incident_kcs_article]</td>
<td>The table is used to store knowledge articles created from the Incident KCS template.</td>
</tr>
</tbody>
</table>
Activate Incident Management Notification

You can activate the Incident Management Notification plugin (com.snc.incident_notification) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

⚠️ Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information
List of Rome plugins

Activate Incident Updates

You can activate the Incident Updates plugin (com.snc.incident.updates) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information

List of Rome plugins

**Activate Incident Management — ATF Tests**

You can activate the Incident Management — ATF Tests plugin (com.snc.incident.atf) if you have the admin role. The plugin delivers ATF tests for Incident Management. This plugin includes demo data.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.

2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information

List of Rome plugins

**Configuring Incident**

You can configure the incident form and other incident features, such as incident categories and UI behavior. The ITSM guided setup helps you configure incident management on your ServiceNow instance.
Configure the Incident form in the base system to follow ITIL best practices. The administrator can configure the incident form and use the form designer to customize it. You can copy or create child incident to reduce the effort of configuring the functionality of an open incident.

### Form configuration and design

<table>
<thead>
<tr>
<th>Menu option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form design</td>
<td>Administrators or users with the personalize_form role can use the form design feature to quickly create new or change existing form views. Form design is an alternative to configuring forms that combines several configuration options into one tool.</td>
</tr>
<tr>
<td>Form layout</td>
<td>Administrators or users with the personalize_form role can configure a form to show or hide fields from a view. You can create new fields on the table associated with the form.</td>
</tr>
<tr>
<td>Related lists</td>
<td>Related lists display records in another table that have a relationship with the current record. Administrators or users with the personalize_form role can configure related lists to appear on the form.</td>
</tr>
</tbody>
</table>
Using guided setup to implement Incident Management

IT Service Management guided setup provides a sequence of tasks that help you configure Incident Management on your ServiceNow instance. To open ITSM guided setup, navigate to Guided Setup > ITSM Guided Setup. For more information about using the guided setup interface, see Using guided setup.

Quick start tests for Incident Management

Validate that Incident Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Incident Management quick start tests require activating the Incident Management - ATF Tests plugin (com.snc.incident.atf).

### Incident Management test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>INCIDENT MGMT: Incident Resolution SLA</td>
<td>Test to verify the Incident Resolution SLA baseline functionality.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Incident Response SLA</td>
<td>Test to verify the Incident Response SLA baseline functionality.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Copy Incident</td>
<td>Test to verify whether the fields from the original Incident are copied correctly to the new Incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Copy Incident from a Closed Incident</td>
<td>Test to verify that the Copy Incident UI action is visible for closed Incidents.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Create Standard Change from Incident</td>
<td>Test to verify the creation of a Standard Change from an Incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Create of Emergency Change from an Incident</td>
<td>Test to verify the creation of an Emergency Change from an Incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>INCIDENT MGMT: Create Normal Change from an Incident</td>
<td>Test to verify the creation of a Normal Change from an Incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Create Problem from an Incident</td>
<td>Test to verify the creation of a Problem from an Incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Create Knowledge from an Incident</td>
<td>Test to verify the creation of a Knowledge from an Incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Incident State flow</td>
<td>Test to verify the state flow of an incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Reopening an Incident</td>
<td>Test to verify the reopen incident functionality.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Incident Assignment</td>
<td>Test to verify the incident assignment functionality.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Create child Incident using UI action and verify its fields</td>
<td>Test to verify the creation of a child Incident from an Incident through the Create Child Incident UI action. The test also verifies that the fields of the child Incident get copied correctly from the parent incident to the child incident.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Incident creation — Self Service</td>
<td>Test to verify the creation of an Incident using the Create Incident catalog item.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Parent and Child Incident state sync up</td>
<td>Test to verify that the state of a child Incident synchronizes with the parent Incident when the child Incident is created.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>
## Incident Management test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>INCIDENT MGMT: Parent and child Incident state sync up after reopening an Incident</td>
<td>Test to verify that the state of a child Incident synchronizes with the parent Incident when the parent Incident is reopened.</td>
<td>Madrid</td>
</tr>
<tr>
<td>INCIDENT MGMT: Verify creation of knowledge article from an Incident</td>
<td>Test to verify the creation of a knowledge article from an Incident using the <strong>Create Knowledge</strong> UI action on the Incident form. The UI action is visible when you activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge).</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

### Related information

**Quick start tests**

### Incident management properties

Incident management properties are used to control features such as copying and creating child incidents. The major incident properties control the promotion of major incident candidates to major incidents.

These properties are available at **Incident > Administration > Incident Properties**.

### Properties for incident management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident closure properties</td>
<td>Select the check box to auto-close incidents based on the resolution date of the incident instead</td>
</tr>
<tr>
<td>Enable auto closure of incidents based on Resolution date. Setting this to 'No' will make auto closure to run based on the Updated date.</td>
<td>com.snc.incident.autoclose.basedon.resolved_at</td>
</tr>
</tbody>
</table>
## Properties for incident management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.autoclose.time</td>
<td>Number of days (integer) after which Resolved incidents are automatically closed. Zero (0) disables this feature. Sets the duration of the incident auto-close function.</td>
</tr>
</tbody>
</table>

**Note:** This property is set to true only for the new (Madrid) customers. Existing customers have to manually set the property to true.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.incident.incident_task.closure</td>
<td>Close open Incident Tasks when Incident is closed or canceled. Select the check box to close open incident task when Incident is closed or canceled.</td>
</tr>
</tbody>
</table>

**Note:** This property is set to true by default only for the new (Madrid) customers.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.incident.incident_alert.closure</td>
<td>Close open Incident Communication Plans when Incident is closed or canceled. Select the check box to close open incident communication plan when an Incident is closed or canceled.</td>
</tr>
</tbody>
</table>
### Properties for incident management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> This property is visible when Incident Communications Management plugin (com.snc.iam) is enabled. This property is set to false for both new and existing customers.</td>
</tr>
</tbody>
</table>

Close open Incident Communication Tasks when an Incident Communication Plan is closed or canceled

com.snc.iam.incident_alert_task.closure

Select the check box to close open incident communication task when an incident communication plan is closed or canceled.

**Note:** This property is visible when Incident Communications Management plugin (com.snc.iam) is enabled. This property is set to false for both new and existing customers.

### Incident Re-open Properties

<table>
<thead>
<tr>
<th>List of fields (comma-separated) to copy from the original incident when an incident is reopened by email</th>
<th>Enter the name of the fields that you want to be copied from the original incident to the new incident when you reopen</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.incident.clone_fields_on_reopen</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Properties for incident management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>an incident through email.</td>
</tr>
<tr>
<td><img src="icon" alt="Note" /></td>
<td>Note: When an incident is reopened, a new incident is created.</td>
</tr>
<tr>
<td>Copy Incident and Create Child Incident Properties</td>
<td></td>
</tr>
<tr>
<td>Enable copy incident feature</td>
<td>Select the check box to get the <strong>Copy Incident</strong> option in the context menu.</td>
</tr>
<tr>
<td>com.snc.incident.copy.enable</td>
<td></td>
</tr>
<tr>
<td>Enable create child incident feature</td>
<td>Select the check box to get the <strong>Create Incident</strong> option in the context menu.</td>
</tr>
<tr>
<td>com.snc.incident.create.child.enable</td>
<td></td>
</tr>
<tr>
<td>Copy attachments from originating incident</td>
<td>Select the check box to copy attachments from original incidents when an incident is copied for created.</td>
</tr>
<tr>
<td>com.snc.incident.copy.attach</td>
<td></td>
</tr>
<tr>
<td>List of attributes (comma-separated) that will be copied from the originating incident</td>
<td>Enter the name of the attributes that you want to be copied from the original incident to the new incident when you copy or create an incident.</td>
</tr>
<tr>
<td>com.snc.incident.copy.attributes</td>
<td></td>
</tr>
<tr>
<td>Related lists (comma-separated) that will be copied from the originating incident</td>
<td>Enter the name of the related lists that you want to be copied from the original incident to the new incident when you</td>
</tr>
<tr>
<td>com.snc.incident.copy.related_lists</td>
<td></td>
</tr>
</tbody>
</table>
### Properties for incident management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of attributes (comma-separated) from Affected CIs (task_ci) related list that will be copied from the originating incident</td>
<td>Enter the name of the attributes from Affected CIs related list that you want to be copied from the original incident to the new incident when you copy or create an incident.</td>
</tr>
<tr>
<td>com.snc.incident.copy.rl.task_ci.attributes</td>
<td></td>
</tr>
</tbody>
</table>

| List of attributes (comma-separated) from Impacted Services (task_cmdb_ci_service) related list that will be copied from the originating incident | Enter the name of the attributes from Impacted Services related list that you want to be copied from the original incident to the new incident when you copy or create an incident. |
| com.snc.incident.copy.rl.task_cmdb_ci_services.attributes               |                                                                             |

### Incident Form Fields Configuration Properties

| List of fields (comma-separated) that appear in the activity formatter for Incident | Enter the names of the fields that are visible in the activity formatter. If the activities are personalized, this property updates automatically. |
| glide.ui.incident_activity.fields                                          |                                                                             |

| Additional comments icon used in Task Activity formatter                  | Enter the path of the icon that is used for additional comments.            |
| glide.ui.incident_activity.image.comments                                  |                                                                             |

| Work notes icon used in Task Activity formatter                           | Enter the path of the icon that is used for work notes.                     |
| glide.ui.incident_activity.image.work_notes                               |                                                                             |
Properties for incident management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident additional comments style</td>
<td>Enter the html syntax of comment style for incident additional comments.</td>
</tr>
<tr>
<td>glide.ui.incident_activity.style.comments</td>
<td></td>
</tr>
<tr>
<td>Incident work notes style</td>
<td>Enter the html syntax of comment style for incident additional comments.</td>
</tr>
<tr>
<td>glide.ui.incident_activity.style.work_notes</td>
<td></td>
</tr>
</tbody>
</table>

Major incident management

A user with admin or incident_manager role can edit the major incident properties to define whether a new major incident must be created or a major incident candidate must be promoted to a major incident. The properties are available only when you activate the Incident Management - Major Incident Management plugin (com.snc.incident.mim).

These properties are available at Incident > Administration > Major Incident Properties.

Properties for major incident management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create major incident from candidate</td>
<td>Provides option to create a new major incident or to promote a major incident candidate to a major incident.</td>
</tr>
<tr>
<td>sn_major_inc_mgmt.com.snc.incident.min.major_incident_creation</td>
<td></td>
</tr>
<tr>
<td>Compose Email on Major Incident Overview</td>
<td>Provides comma-separated list of incident communication task types that can have Compose</td>
</tr>
<tr>
<td>sn_major_inc_mgmt.com.snc.incident.mim.compose_email_on_iatasks</td>
<td></td>
</tr>
</tbody>
</table>
### Properties for major incident management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Email option on Major Incident Workbench.**
| PIR export ui page url
(sn_major_inc_mgmt.pir_export_pdf_ui_page) | Provides option to associate custom UI page to export post incident report. |
| Major Incident Management Group (sys_id) to whom the Major Incident should be re-assigned on promotion to ‘Major Incident’
(sn_major_inc_mgmt.major_incident_management_group) | Provides option to auto-assign a major incident to different assignment groups based on the actions taken on incident and also on conditions related to assignment group. |

### Incident categories and subcategories

Categorization of incidents helps in routing to the right team and saves a lot of time in troubleshooting and bringing the service to normalcy.

One of the KPIs (Key Performance Indicators) of the Incident Management process is to identify how many times the Incident is sent to different teams. It also helps in analyzing incidents based on the classification to do proactive Problem Management which, in turn, helps to reduce Incidents. Proper incident classification is very important to identify and prioritize on which Incidents to work on first.

Using categories and subcategories also improves the clarity and granularity of report data. The following categories and associated subcategories are in the base system. An administrator can add additional categories and subcategories, and use them in assignment rules and notifications.

© 2021 ServiceNow, Inc. All rights reserved.
### Incident categories

<table>
<thead>
<tr>
<th>Category</th>
<th>Subcategory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inquiry / Help</td>
<td>• Antivirus&lt;br&gt;• Email&lt;br&gt;• Internal Application</td>
</tr>
<tr>
<td>Software</td>
<td>• Email&lt;br&gt;• Operating System</td>
</tr>
<tr>
<td>Hardware</td>
<td>• CPU&lt;br&gt;• Disk&lt;br&gt;• Keyboard&lt;br&gt;• Memory&lt;br&gt;• Monitor&lt;br&gt;• Mouse</td>
</tr>
<tr>
<td>Network</td>
<td>• DHCP&lt;br&gt;• DNS&lt;br&gt;• IP Address&lt;br&gt;• VPN&lt;br&gt;• Wireless</td>
</tr>
<tr>
<td>Database</td>
<td>• DB2&lt;br&gt;• MS SQL Server&lt;br&gt;• Oracle</td>
</tr>
</tbody>
</table>

#### Configure incident category or subcategory

Configure incident category and subcategory for easy classification of incidents which helps in routing incidents to the right team. You can also generate reports based on category and subcategory of incidents.

**Before you begin**
Role required: admin
Procedure
1. Navigate to Incident > All.
2. Open an incident record.
3. Do any of the following:
   • Right-click on the Category field name and select Configure Choices.
   • Right-click on the Subcategory field name and select Configure Choices.
4. Move the required category or subcategory from the Available list to the Selected list.
5. Click Save.

Add a category or a subcategory
Add category or subcategory to assign incidents to the correct team and save time in troubleshooting and bringing the service to normalcy.

Before you begin
Role required: admin

Procedure
1. Navigate to Incident > All.
2. Open an incident record.
3. Do any of the following:
   • Right-click Category > Configure Choices.
   • Right-click Subcategory > Configure Choices.
4. In the Enter new item field, enter the new category or the subcategory name.
5. and click Add.
   The new category or subcategory is added under the Selected list.

Delete a category or a subcategory
Delete a category or subcategory if your organization no longer uses the category or subcategory.

Before you begin
Role required: admin
Procedure
1. Navigate to Incident > All.
2. Open an incident record.
3. Do any of the following activities:
   • Right-click on the Category field name and select Configure Dictionary.
   • Right-click on the Subcategory field name and select Configure Dictionary.
4. Click the Choices related list.
5. Select the category or the subcategory record that you want to delete.
6. Click Actions on selected rows menu and select Delete.

Define priority lookup rules
Define impact and urgency of an incident to calculate the priority. The priority calculation can then be used to prioritize work and drive service level agreements.

Before you begin
Role required: admin

Procedure
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>Impact is a measure of the effect of an incident, problem, or change on business processes.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency is a measure of how long the resolution can be delayed until an incident, problem, or change has a significant business impact.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority is based on impact and urgency, and it identifies how quickly the service desk should address the task.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the rules. The scope defines whether the rules are available for all applications or for scoped applications.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to define whether the rule is active or not.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the rules appear in the priority lookup list. This field indicates which rule to execute first.</td>
</tr>
</tbody>
</table>

**Note:**
Priority is calculated according to the following sample data lookup rules:

<table>
<thead>
<tr>
<th>Priority Data lookup rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>1 - High</td>
</tr>
<tr>
<td>1 - High</td>
</tr>
<tr>
<td>1 - High</td>
</tr>
<tr>
<td>2 - Medium</td>
</tr>
<tr>
<td>2 - Medium</td>
</tr>
<tr>
<td>2 - Medium</td>
</tr>
<tr>
<td>3 - Low</td>
</tr>
<tr>
<td>3 - Low</td>
</tr>
<tr>
<td>3 - Low</td>
</tr>
</tbody>
</table>

By default, the **Priority** field is read-only and must be set by selecting the **Impact** and **Urgency** values. To change how priority is calculated, administrators can either alter the priority lookup rules or disable the **Priority is managed by Data Lookup - set as read-only** UI policy and create their own business logic.

4. Click **Submit**.
Define assignment rules for incidents

Define assignment rules to identify the right group or the user which is skilled to work on an incident.

Before you begin
Role required: assignment_rule_admin or admin

Procedure
2. Create assignment rules by following the steps provided in Create an assignment rule.
3. Click Submit.

Incident templates and record producers

Templates simplify the process of submitting new records by populating fields automatically. A template ensures consistency in the way information about the incident is captured. A record producer is a specific type of catalog item that allows end users to create task-based records, such as incident records, from the service catalog.

You can use incident templates to quickly create incidents for similar issues.

• An administrator or user with the template_editor_global role can create templates that are available to everyone.
• An administrator can enable the global option for any personal template that a user creates so that all other users can access the template.
• A user with the itil role can create their own templates for incidents they log frequently.

ESS users typically log incidents using a record producer in the service catalog. A template can be used to create an incident record producer. The template automatically populates fields in the incident form.

For example, an incident record producer can be created to request account access to a network server. The user who submits the incident enters variable values, such as the server name, level of access needed, and due date. The incident template assigned to the record producer populates the incident Category, Subcategory, and Assignment Group. These fields and values applied from the template do not appear in the record producer form.
Create incident template

Create an incident template to ensure consistency in the way information about
the incident request is captured. A template also helps you to create incident
easily and accurately.

Before you begin
Role required: admin

About this task
Let us consider an example where you want to create a template to log an
incident when you are denied access to the Bond Trading application.

Procedure

1. Navigate to System Definition > Templates.
   You can also Create a template from the incident form.

2. Complete the steps in Create a template using the Template form using the
   following information:
   - **Name**: Bond Trading Access Denied
   - **Table**: Incident [incident]
   - **Global**: Select the check box. The Global option allows any user to use the
     template, not just the template creator.
   - **Short Description**: Bond Trading Access Denied
   - **Template**: Add the following values to define the fields that are filled in when
     the template is used:
     - [Category]: [Inquiry / Help]
     - [Configuration Item]: [Bond Trading]
     - [Description]: [The user was denied access to the Bond Trading
       application]
     - [Impact]: [2 - Medium]
     - [Urgency]: [3 - Low]
3. Click **Submit**.

**Create a module that uses incident template**

Create a module to log an incident with pre-filled field values from an existing template.

**Before you begin**  
Role required: admin

**About this task**  
In the **Create incident template** topic, you have created the Bond Trade Access Denied template. In this topic, you can use the template with a module in the Self-Service application.

**Procedure**

1. Point to **Self-Service** and click the edit icon.
2. In the Modules related list, click **New**.
3. On the form, fill in the fields.
   - **Title**: Bond Trading Access Denied.
   - **Order**: In the Module records list, view the order numbers and enter a number that is appropriate. For example, if the order number of **Homepage** is 50 and the order number of **Business Applications** is 52, and you want to place the new module between **Homepage** and **Business Applications**, enter the order number as 51.
     - **Hint**: Log an incident about the Bond Trade application.
Link Type section:

- **Link Type**: URL (from Arguments:)
- **Arguments**: incident.do?sys_id=-1&sysparm_template=Bond Trading Access Denied

**Note**: This path deploys the template in the new incident record.

4. Click **Submit**.

The new module appears in the Self-Service application.

**What to do next**

Click the module to open a new incident record with the applied Bond Trading Access Denied template.

**Create a record producer to log incidents**

Create record producers to log incidents directly from Service Catalog.

**Before you begin**

Role required: catalog_admin or admin

**About this task**

Incident record producers provide users with an interface from which user can log an incident. For example, the default **Can We Help You?** category features record producers such as **Create Incident** to enable users to log incidents from the catalog.

The following example demonstrates how to create a record producer to request a wireless router reset.
Procedure

1. Navigate to Service Catalog > Catalog Definitions > Record Producers.

2. Click New and complete the steps in Create a record producer using the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Request to Reset Router</td>
</tr>
<tr>
<td>Table name</td>
<td>Incident [incident]</td>
</tr>
<tr>
<td>What it will contain</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>Reset wireless router request</td>
</tr>
<tr>
<td>Description</td>
<td>Please reset the building’s router</td>
</tr>
<tr>
<td>Accessibility</td>
<td></td>
</tr>
<tr>
<td>Catalogs</td>
<td>Service Catalog</td>
</tr>
<tr>
<td>Category</td>
<td>Can We Help You?</td>
</tr>
</tbody>
</table>

3. Right-click on the form header and from the context menu select Save. Several related lists appear at the end of the form, including Variables and Variable Sets.

4. In the Variables related list, click New.

5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Reference</td>
</tr>
<tr>
<td>Question</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Entry</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Question</td>
<td>Which router needs to be reset?</td>
</tr>
<tr>
<td>Name</td>
<td>Router</td>
</tr>
<tr>
<td>Type Specifications</td>
<td></td>
</tr>
<tr>
<td>Reference</td>
<td>IP Router [cmdb_ci_ip_router]</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

7. **Optional:** To view the new record producer, click **Try It** in the form header.
   
   (Optional) In Service Catalog, the new catalog item appears and any user can select it.

**Create a record producer using a template**

If a predefined incident template exists, it can be used with the record producer to fill in standard information for the incident.

**Before you begin**

Role required: catalog_admin or admin

**Procedure**

1. Navigate to **Service Catalog > Catalog Definitions > Record Producers**.
2. Click **New** and complete the steps in Create a record producer.
3. Click **Generated Record Data** and select the incident template to populate fields when the record producer is submitted.
4. Right-click on the form header and click **Save**.
View VIP status for a caller in incident

View the callers with VIP status on the incident records list view as well as incident form. Organizations commonly designate VIP status in the user record for some of their VIP users.

Before you begin
Role required: personalize_list or admin

About this task
When a caller is assigned to an incident, the user record is automatically checked for VIP status. If the caller is a VIP caller, an icon appears beside the caller name in the list view or the caller field in the form view.

Procedure
1. Navigate to Incident > Open.
2. View the record for the VIP caller in the list of incident records.
3. Click the record to view the VIP status in the Caller field.
**View incident notifications**

View incident notifications that are sent during specific events in an incident lifecycle. These notifications are sent to various recipients including the ESS and the ITIL users.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Notification > Email > Notifications**.
2. Filter the list of notifications by **[Table] [is] [incident]**.
3. View the following list of default notifications for incidents.
4. Click the notification name to view the details.

ℹ️ **Note:** To receive these notifications, the end user must enable notifications. For more information, see **Subscription-based notifications**.

**Related information**

- **Create an email notification**

**Configure default user for auto-closing incidents**

Change the default user who last updated an incident to the user you mention for auto-closing incidents.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Scheduler > Scheduled Jobs > Scheduled Jobs**.
2. Open the **Autoclose Incidents** schedule job.
3. In the **Job context**, add the following:

```plaintext
fcRunAs=<user_name>
fcScriptName=incident autoclose
```

For example, if you add `fcRunAs=admin`, the code places **System Administrator** in the **Updated by** field.
Incident ticketing integrations

An incident ticketing integration exchanges ticket data between your ServiceNow instance and a third-party system.

The advantages of an incident ticketing integration include the following items.

- Establishing a ticket number that provides a unique key between systems.
- Synchronizing the systems so that notifications can be triggered.
- Transforming data for more uniform processing.
- Tracking ticket activity for accurate reporting.

The level of data and the direction of the data that is exchanged categorizes the integration as uni-directional or bi-directional. In a uni-directional integration, a third-party system creates an incident ticket, passes data to your instance, and receives a ticket ID back as confirmation. In a bi-directional integration, incident data is exchanged, synchronized, and updated while data is sent between the systems.

For both integration types, a good practice is to implement a record-based log of the individual transactions for a given time period. If an outage occurs, a record-based log can tell you what data was exchanged, how it was transformed, when processing occurred, and if there were any errors. Record-based logs also allow you to run all the validation and transformation logic away from the main form, helping performance.

Before implementing your project, develop an integration plan in which all the implementation aspects and requirements are defined. Developing the integration plan helps you to review the current data, plan for future requirements, and identify and sequence project tasks.

Uni-directional incident ticketing integrations

Consider the requirements for an external, third-party system to create tickets. Define the data that must be sent to create a ticket, and what validation is required.

In this way, a standard web service interface can be created and published. This integration responds with a ticket number on success, or with a structured error message for validation failures and processing issues. An advantage of this implementation is that you can publish once and reuse for multiple applications, provided the additional integrations follow the integration specifications. A good practice is to create a dedicated account for each interface. Accounts provide accountability and report user statistics, and use a simple connectivity Point of Contact (POC).
Integration plan contents
- Firewall requirements
- Protocols to be used
- Required middleware (for example, MS Biztalk)
- Error messages
- Validation rules

Example using basic authentication
This implementation responds to the third-party system with the ticket ID. The Import Set tables function as a staging area for your data.

Uni-directional ticketing integration using basic authentication

Example using import sets
An implementation variation for the inbound path would be to use the Import Set Tables as interface tables. In this example, the Incident_Interface Table stores a history of data as it was received and before the data was transformed. The destination Incident Table could store a history of how the incident has changed over time and who changed it. The transform scripts would process the import set and the business rules would run on the target table.
Uni-directional ticketing integration using import sets

A bi-directional integration exchanges data between your ServiceNow instance and a third-party system so that incident information is synchronized between the systems.

This integration is more complex than a uni-directional integration because it has the following requirements.

- Comprehensive definitions of field mappings.
- Standardization of where transformations take place: inbound, outbound, or both.
- Consideration of the ownership of reference data.
- How updates are performed on an ongoing basis.

Implement error handling. Include all these implementations in the integration plan.

While bi-directional implementations are developed on their own merits, you can develop a framework in the Now Platform that can be reused, for example, data driven validation rules.
Integration plan contents

- Plan contents for all the aspects needed for a bi-directional integration.
- State models for each organization.
- Business rule definitions for keeping the tickets synchronized.
- Requirements to store history of individual transactions. If this form of audit is a requirement, consider creating an interface table which is populated prior to creating and updating the destination table.
- Transformation rules for all data elements.
- Time lines for when reference data is transported to the information system. Include requirements to perform transformations before sending the data to and from each system.
- Statement of reference data ownership at all stages.
- Update schema definitions.

Example using import sets and web services

In this implementation, data authentication is done before insertion into the import set. Transform maps and scripts execute before the data reaches the Incident table. The Incident table is used to store the history of the incident records. For the outbound data path, the target table could trigger business rules before the data is queued in the outbound web service.
Example using import sets and the ECC queue

An implementation variation for the inbound path would be to use an import set table (in our example, the Incident Interface table) to store historical data. Data validation is also done now, and you can clear exceptions with processing or manual intervention. The Incident table uses a Third-Party Information table as a reference, and messages are generated based on business rules.

Implementing this type of integration involves a web-service component for third-party applications for inbound data. The ECC queue is recommended for outbound data.
Managing incidents

Working on incidents involves diagnosing and investigating the incident, recording results, and sometimes escalating or promoting the incident.

Initial diagnosis of incidents is largely a human process. The service desk agent looks at the details of the incident and communicates with the user to diagnose the issue.

To aid in the diagnosis, the service desk agent can query the configuration management database, or CMDB. The CMDB contains information about hardware and software within a network and the relationships between them. The CMDB can be populated by: Discovery. Discovery is available as a separate product.

Incident investigation

Incident investigation is also a human process. The service desk continues to use the information in the Incident form as well as the CMDB to solve the issue. Work notes are added to the incident as the service desk evaluates the incident, facilitating communication between the concerned parties. Work notes and other updates can be communicated to the concerned parties through email notifications.
One way to investigate incidents is to determine whether related records exist, using one of the following features.

**Related incidents icon**

The show related incidents icon (_RIGHT) appears beside the **Caller** field when it is populated. Click the icon to view the list of incidents for the same caller.

**Note:** Administrators can add this icon to any reference field by modifying the dictionary entry and adding the `ref_contributions=user_show_incidents` dictionary attribute. The icon appears only for users who have read or write access to the field. A UI macro named `user_show_incidents` defines the behavior. The UI macro must be active to view the related incidents icon.

**Incidents by Same Caller related list**

Another way to research related incidents is to use the **Incidents by Same Caller** related list. The administrator may need to configure the form to display this related list.

**Dependency views**

Dependency views can help find related incidents based on configuration items (CI). If a configuration item is attached to an incident, click the map icon (MAPPING) to display the dependency views map. In the dependency map, if you want to view the tasks that are attached to the CI, click the down arrow next to the CI and from the menu, select **View Related Tasks**.
Incident promotion

When the incident management team has determined that the cause of an incident is an error or widespread problem, the team initiates the problem management process. When the issue requires a change to the infrastructure or a business service, the team initiates the change management process.

A menu item on the Incident form lets you create a problem or change record easily and associate the incident with the problem or change record. For more information, refer Create a task record from incident

Note: If the incident already has an associated problem or change record, you cannot create another record of the same task type.

Sometimes, the resolution for the user is to request hardware or software for them. For example, a user may report a problem that requires a new mouse device or keyboard. The service desk agent can create a request from the incident. The incident is associated with the requested item.

Note: This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.

Incident escalation

There are two escalation methods the platform uses to track and report on incidents that are not being resolved according to your organization standards.
**Service level agreements (SLAs)**

SLAs monitor the progress of an incident according to a set of agreements between a service provider and customer that define the scope, quality, and speed of the services being provided. As time passes, the SLA escalates the priority of the incident and leaves a marker as to its progress. SLAs are also used as a performance indicator for the service desk.

**Inactivity monitor**

The inactivity monitor generates an event to prevent incidents from going unnoticed. When a certain amount of time has passed without an update to the incident, the event creates an email notification or triggers a script.

**Logging an incident**

Log incident records from sources such as email, service desk, service catalog, or external applications as per your convenience. You can also generate incident using business rules or SOAP messaging.

<table>
<thead>
<tr>
<th>Where</th>
<th>How</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service desk</td>
<td>User can call a service desk agent and the agent can log an incident based on the information provided by the user. Service desk (ITIL) agents can log an incident from the <strong>Self-Service &gt; Incidents &gt; Create New</strong> module.</td>
</tr>
<tr>
<td>Service catalog</td>
<td>User can log an incident in service catalog from the <strong>Self-Service &gt; Service Catalog &gt; Can We Help You? &gt; Create Incident</strong> record producer.</td>
</tr>
<tr>
<td>Email</td>
<td>User can send an email to the instance mailbox. An incident is created according to the inbound email actions.</td>
</tr>
<tr>
<td>SMS</td>
<td>User can send an SMS to ServiceNow Customer Service number and an incident is automatically created for the user.</td>
</tr>
</tbody>
</table>

**Note:** The user must install the Notify plugin (com.snc.notify) and set up a Twilio account in order to avail the messaging service.
<table>
<thead>
<tr>
<th>Where</th>
<th>How</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat window</td>
<td>User can request to create an incident using the Connect chat icon (chat) that appears on the upper-right corner of the instance. On the chat window, the user can add an ITIL user and also provide a short description of the issue. Based on the description, the ITIL user creates an appropriate incident.</td>
</tr>
</tbody>
</table>

**Note:** If you want to create a security incident, first activate the Security Incident Response Dependencies plugin (com.snc.si_dep). You can then click **Create Security Incident** on a new incident form to create a security incident from the currently displayed incident.

**ESS users can:**
- View the incidents they have opened. By default, the **Watch list**, **State**, and **Urgency** fields are available on the ESS view of the **Incident** form.
- Update the **Watch list** and **Short Description** fields, and enter **Additional comments**. The administrator can configure other fields to be editable.

User who do not have the itil role can view an incident only if the user is the caller for that incident, has opened the incident, or is included in the watchlist. The **incident query** business rule controls this function.

**Automatically generated incidents**
- Incidents can be automatically generated using business rules. Business rules use JavaScript to generate an incident if pre-defined conditions are met.
- Incidents can be generated from outside the platform with SOAP messaging. For more information, refer to **SOAP messaging**.

**Create an incident**
Create an incident record to document a deviation from an expected standard of operation.

**Before you begin**
Role required: itil, sn_incident_write, or admin
About this task
Incidents are also logged when a user fills out a record producer in the service catalog, or sends an email to the instance. This procedure describes how an ITIL agent completes the Incident form.

Procedure
1. Navigate to **Incident > Create New**.
   You can also click **New** from the Incident list view.

2. **Optional:** Use a template, if one exists for the type of incident you are logging.
   If the organization uses form templates, you can apply a template to prepopulate some of the fields for specific types of incidents.

3. On the form, fill in the fields.
   Your organization has configured the Incident form to adhere to its incident management process. Enter information in the form field based on the process. The following table describes typical Incident form fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique system-generated incident number.</td>
</tr>
<tr>
<td>Caller</td>
<td>The user who contacted you with an issue.</td>
</tr>
<tr>
<td>Category and Subcategory</td>
<td>The type of issue. After selecting the category, select the subcategory, if applicable.</td>
</tr>
<tr>
<td>Service</td>
<td>The affected business service, if applicable.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you select a business service as the configuration item and that business service is also listed as the configuration item in any other active task, the active tasks icon ( <img src="image.png" alt="icon" /> ) appears. Click the icon to view the list of all the other active tasks that are affecting the business service. You can view the BSM map (dependency view) of the selected business service by clicking the dependency icon <img src="dependency_icon.png" alt="dependency_icon.png" />.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>The affected CI, if applicable. After a CI is selected, you can click the open dependency views icon next to the field to see how the CI maps into the infrastructure. The dependency view shows you what is impacted and whether other CIs or services are experiencing issues. To capture information on the affected CIs, refer to <a href="#">Capture information on affected configuration items in an incident</a>.</td>
</tr>
<tr>
<td>Contact type</td>
<td>The communication method used by the user to create the incident.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>The state moves and tracks incidents through several stages of resolution.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> Use the <strong>State</strong> field, rather than the <strong>Incident State</strong> or <strong>Problem State</strong> fields, as your primary means of tracking the state of an incident as it progresses through the entire processing cycle. To learn more, see Life cycle of an Incident.</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact is a measure of the effect of an incident, problem, or change on business processes.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency is a measure of how long the resolution can be delayed until an incident, problem, or change has a significant business impact.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority is based on impact and urgency, and it identifies how quickly the service desk should address the task.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group who will work on the incident. The business rule <strong>Populate Assignment Group based on CI/CO</strong> populates the <strong>Assignment group</strong> field based on the support group available for the configuration item (CI) or the Service offering consecutively.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The business rule is triggered when an incident is created or updated and when the <strong>Assignment group</strong> and the <strong>Assigned to</strong> field is empty.</td>
</tr>
<tr>
<td></td>
<td>If you want to override the default value, you need to create new properties and provide the field in the property value that must be used to populate the <strong>Assignment group</strong> field. Create the properties in the following order of preference:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>com.snc.incident.ci_assignment_group.field_name</strong>:</td>
<td>identifies which CI field populates the Assignment group field.</td>
</tr>
<tr>
<td><strong>com.snc.incident.service_offering_assignment_group.field_name</strong>:</td>
<td>identifies which service offering field populates the Assignment group field.</td>
</tr>
</tbody>
</table>

**Note:** If you are an upgrade customer and want to install the ITSM CSDM Best Practices - Quebec plugin (com.snc.best_practise.itsm_csdm.quebec) on your instance, please contact Support.

**Note:** The sys_user_group read ACL calls the SNCRoleUtil function. The function verifies whether the group that is reviewed contains either the admin role or security_admin role. The function allows the user to view the group only if the user has the same role. As a result, a user with the itil role cannot assign an incident to a group that has the admin role or security_admin role nor to any group whose parent has those role.

<table>
<thead>
<tr>
<th>Assigned to</th>
<th>The user to work on this incident. If the Assignment group changes, the Assigned to field is cleared.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>A brief description of the incident.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed explanation on the incident.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Watch list</td>
<td>Users who receive notifications about this incident when comments are added. Click the add me icon ( <img src="add_me_icon.png" alt="add me icon" /> ) to add yourself to the watch list.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notifications about this incident when work notes are added. Click</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
</tbody>
</table>
Capture information on affected configuration items in an incident

Capture information on affected configuration items (CIs), with type as asset, in an incident to keep a record of the updated, repaired, swapped, or retired configuration items. By keeping track of the assets, you can tell where the assets are located, how they are used, and when changes were made to them. This information helps you to monitor and manage the assets in your company using a systematic approach.

Before you begin
Role required: itil or admin

Activate the Hardware Asset Management Professional plugin (com.sn_hamp).

About this task
If you are not the caller of the incident and have a CI value in the affected CIs list, it is mandatory to provide information on the CI before changing the state of the incident to **Resolved**.

You can enter CI information either from the **Affected CIs** related list or from the form layout of the Affected CIs. You need to manually add the **Asset Action** and the **Swapped CI** fields in the related list.

### Add fields in the related list

<table>
<thead>
<tr>
<th>Where</th>
<th>How</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related list</td>
<td>• In the <strong>Affected CIs</strong> related list, click the settings icon 🛠️.</td>
</tr>
<tr>
<td></td>
<td>• Move the <strong>Asset Action</strong> and the <strong>Swapped CI</strong> fields from the <strong>Available</strong> column to the <strong>Selected</strong> column.</td>
</tr>
<tr>
<td></td>
<td>• Click OK.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **Incident > Open**.
2. Open an incident.
3. Navigate to the **Affected CIs** related list before resolving the incident.
4. **Optional**: If you want to enter information in the form layout, click the CI.
5. On the related list or the form, fill in the fields.
Information on Affected CIs

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Action</td>
<td>Information on whether a CI is updated or repaired, swapped with another CI, or retired from the system. The options available are: No action, Update/Repair, Swap, and Retire.</td>
</tr>
<tr>
<td></td>
<td>Note: If you swap or retire a CI, the sn_hamp_asset.swap or sn_hamp_asset.retire events are generated respectively.</td>
</tr>
<tr>
<td>Swapped CI</td>
<td>Information on the new CI that is swapped with the existing CI.</td>
</tr>
</tbody>
</table>
|               | Note:  
|             | • This field appears only when you select the value of the Asset Action field as Swap.                                                        |
|               | • The CI values available for swapped CI are the ones with asset CI class as hardware.                                                         |

6. Click **Update**.  
The record is saved and the information about CI is stored in the [task_ci] table.

⚠️ **Note:** You can filter the **Affected CIs** related list to have the list of affected CIs with class as Asset.
Create a template from the incident form

Create a template that define default values for forms so that users can easily create incident. You need to have appropriate permissions before creating templates.

Before you begin
Role required: itil, sn_incident_write, or admin

Procedure
1. Navigate to Incident > Create.
2. Click the more options icon and then click Toggle Template Bar to see the template bar.
3. On the template bar, click the add icon (+).
4. On the form, fill in the fields.

**Create New Template form**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the template.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that this template applies to. Select <strong>Global</strong> to make the template available for use with all tables. <strong>Note:</strong> The table list shows only the tables and database views that are in the same scope as the template.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for making the template available for use. A template must be active to be used.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the rules. The scope defines whether the rules are available for all applications or for scoped applications.</td>
</tr>
<tr>
<td>User</td>
<td>User who can configure and apply the template. If you define a user, no other users can see the template unless you select the <strong>Global</strong> option.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Groups</td>
<td>Group whose members can configure and apply the template. If you define a group, no other groups can see the template unless you select the <strong>Global</strong> option.</td>
</tr>
<tr>
<td>Global</td>
<td>Option for allowing any user who can access the templates to view and apply this template.</td>
</tr>
<tr>
<td>Short description</td>
<td>Description of the template.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Adding content to this field does not add that content to the <strong>Short description</strong> field of the forms that use this template.</td>
</tr>
<tr>
<td>Template</td>
<td>Content that automatically populates records that are based on this template. Select a field from the specified table in the left column and then enter the data to automatically populate in the right column.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Even though you can select dot-walked fields in the template, they do not apply to fields that are on the form.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.  
The template is created and you can find it on the template bar.

**Apply a template in the Incident form**

Apply a template to a new incident record if the pre-populated information in the template is applicable to the incident record. It saves your time and effort to enter values in the incident record fields individually.

**Before you begin**
Role required: itil, sn_incident_write, or admin
Procedure

1. Navigate to Incident > Create New.

2. Click the more options icon and then click Toggle Template Bar to see all templates in the template bar.

3. Click a template to apply the template on the incident record.

Related information

Create incident template

Create an incident task

Create an incident task to communicate with and request work from assignment groups other than the one that is mentioned for the incident.

Before you begin
Role required: itil, sn_incident_write, or admin

Procedure

1. Navigate to Incident > Open.

2. Open the incident record.

3. In the Incident Tasks related list, click New.
   - If you do not see the Incident Tasks related list, you need to add it. For information on how to add a related list, refer Add a related list to a form.

4. On the form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique system-generated incident task number.</td>
</tr>
<tr>
<td>Incident</td>
<td>Incident with which the task is associated.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>The affected CI.</td>
</tr>
<tr>
<td>State</td>
<td>The state moves and tracks incident task through several stages of resolution.</td>
</tr>
<tr>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group who works on the incident task. If you leave it blank, the incident is automatically assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user to whom the incident task is assigned to work on.</td>
</tr>
<tr>
<td>Note: If the Assignment group changes, the Assigned to field is cleared.</td>
<td></td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the incident task.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed explanation on the incident task.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notifications about this incident task when work notes are added.</td>
</tr>
<tr>
<td>Note: You can the add me icon to add yourself to the work notes list.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve the incident task, or steps taken to resolve it, if applicable.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Synchronization between an incident and its incident tasks**

Use incident tasks to collaborate with and request work from other stakeholders. An incident and its tasks are synchronized such that the state of incident tasks changes depending on the state of the incident.

> Note: The Close open Incident Tasks when Incident is closed or canceled property (**com.snc.incident.incident_task.closure**) is responsible for different actions that take place on incident tasks based on the state of the incident.

The synchronization between an incident and its open incident task is as follows:

- When an incident is closed, the state of any open incident task is set to **Closed Incomplete**.
- When an incident is canceled, the state of any open incident task is set to **Closed Skipped**.

**Create a task record from incident**

Create a problem, change, or request record from an incident. When the cause of an incident is an error or widespread issue, a problem is generated from the incident. When the issue requires a change to the infrastructure or a business service, a change record is created from the incident. When the resolution for the user is to request hardware or software, a request is created from an incident.

**Before you begin**

Role required: itil, itil_admin, or admin

**Procedure**

1. Navigate to **Incident > Open**.
2. Open the incident record.
3. Right-click on the header form and on the context menu, select the appropriate option.
<table>
<thead>
<tr>
<th>Task record</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem</td>
<td>Create Problem. For more information, refer to Create a problem. <strong>Note:</strong> Use the property <strong>List of attributes</strong> (comma-separated) that will be copied from the incident to create a new problem (com.snc.problem.create_from_incident.attributes) to specify fields on the Incident form. The values of these fields are copied to the respective fields on the Problem form. The property is available for customers starting the Madrid release.</td>
</tr>
<tr>
<td>Request</td>
<td>Create Request. For more information, refer to Create a request from an incident.</td>
</tr>
<tr>
<td>Change</td>
<td>Create Normal, Standard, or Emergency Change. For more information, refer to Create a change request.</td>
</tr>
<tr>
<td>Task record</td>
<td>Option</td>
</tr>
<tr>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The Create Normal Change, Create Standard Change, and Create Emergency Change scripts copy these fields from the Incident form:</td>
</tr>
</tbody>
</table>
| | • short_description  
| | • description  
| | • cmdb_ci  
| | • priority  
| | • company  
| | The syntax for copying a field from the Incident form to the Change form is: |
| | changeRequest.setValue("field_name", current.field_name); The admin adds this information in the script block of the incident record.  

The form for the new record appears and is already saved. Some specific fields are copied to the newly generated record from the incident. You can find reference of the newly created task record in the Related Records section of the Incident form.  

**4. Optional:** Complete the Problem, Change, or Request form with additional information and click **Update**.  

**Create a request from an incident**  
When you work on an incident and determine that the user needs one or more catalog items, such as an application or a new laptop, you can create a request from the incident. It helps you in tracking the requests associated with an incident and vice versa.  

**Before you begin**  
Role required: itil or sn_incident_write  

The Best Practice - Incident Resolution Workflow plugin (com.snc.bestpractice.incident) should be active for creating a request from an
incident. To associate a parent incident with the request created for a record producer, the catalog_admin should add the following script in the script block of the record incident.

To associate a parent incident with the request created for a record producer, the administrator should add the following script in the script block of the record producer:

```javascript
var incRPUtil = new LinkRecordProducerToIncident();
incRPUtil.linkRecordProducerToParentIncident(RP.getParameterValue('sysparm_req_parent'), current);
```

Note: If you set the Use the sc_layout driven cart macros (default true) property to false and create a request from an incident, the request is not associated with the incident.

Procedure
1. Navigate to Incident > All.
2. Select the required open incident.
3. Click the additional actions menu icon ⬀ and select Create Request. The Catalogs home page is displayed with all active catalogs that you can access.

Note: If there is only one active catalog, then that catalog page is displayed with available categories.

4. Select the required catalog and navigate through its categories and items.
5. Checkout the required catalog item, order guide, or record producer. For information on checkout models, see Service Catalog checkout models. For a catalog item or order guide, a request is created and displayed under the Requests tab of the incident. For a record producer, the corresponding task is created and displayed under the Problems tab of the incident.

Note:
- The associated incident is specified in the annotation message throughout the request process.
- Both for the one-step and two-step checkout, the caller of the incident is automatically set as the Requested For user for the request. If the two-step checkout is enabled, the fulfiller can change the Requested For.
- You cannot add items to the wish list, or save a record producer in this flow.
Copy an incident or create a child incident

Copy an incident or create a child incident without manually entering the value of all the fields in the new incident.

Before you begin

- Role required: itil, sn_incident_write, or admin
- Select the Enable copy incident feature (com.snc.incident.copy.enable) and the Enable create child incident feature (com.snc.incident.create.child.enable) incident properties at Incident > Incident Properties.

Note: An itil user can copy or create a child of any incident whereas a user without any role can copy only the incident which the user has created.

About this task

The Copy Incident functionality copies the details of an existing incident record to a new incident record. The Create Child Incident functionality copies the details of the parent incident and links the new incident to the parent incident. You can enable the options as well as add or remove fields or related list using the copy incident and create child incident properties.

Procedure

1. Navigate to Incident > Open.
2. Open an existing incident that you want to copy or from which you want to create a child incident.
3. Perform one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy an incident</td>
<td>Click the Additional actions icon and then click Copy Incident. Note: After the incident is copied, the Work notes field of the new incident is updated with the following message: Created from a similar incident: INCXXXXXX.</td>
</tr>
<tr>
<td>Create a child incident</td>
<td>Click the Additional actions icon and then click Create Child Incident.</td>
</tr>
<tr>
<td>Option</td>
<td>Action</td>
</tr>
<tr>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Ensure you have added the <strong>Parent Incident</strong> field and the <strong>Incident -&gt; Parent Incident</strong> related list to the incident form. The incident, from which you have created the child incident, is considered as the parent incident.</td>
</tr>
</tbody>
</table>

4. Fill out the other fields, as required.

5. Click **Submit**.
   The default fields and related lists that are copied from the parent incident are:

<table>
<thead>
<tr>
<th>From where</th>
<th>What are copied</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fields</td>
<td>• Category</td>
</tr>
<tr>
<td></td>
<td>• Subcategory</td>
</tr>
<tr>
<td></td>
<td>• Business Service</td>
</tr>
<tr>
<td></td>
<td>• Configuration item</td>
</tr>
<tr>
<td></td>
<td>• Impact</td>
</tr>
<tr>
<td></td>
<td>• Urgency</td>
</tr>
<tr>
<td></td>
<td>• Assignment group</td>
</tr>
<tr>
<td></td>
<td>• Short Description</td>
</tr>
<tr>
<td></td>
<td>• Description</td>
</tr>
<tr>
<td></td>
<td>• Related lists</td>
</tr>
<tr>
<td></td>
<td>• Caused by Change</td>
</tr>
<tr>
<td></td>
<td>• Location</td>
</tr>
<tr>
<td></td>
<td>• Company</td>
</tr>
<tr>
<td></td>
<td>• Problem</td>
</tr>
<tr>
<td></td>
<td>• Change Request</td>
</tr>
<tr>
<td></td>
<td>• Parent incident</td>
</tr>
<tr>
<td>From where</td>
<td>What are copied</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><a href="#">Note: If the problem, change, or the parent incident is not active, then details of those fields are not copied.</a></td>
</tr>
</tbody>
</table>
| Related lists       | • Affected CIs  
• Impacted Services  
• Service Offerings  

[Note: The supported related tables are:](#)  
• Affected CIs (task_ci)  
• Impacted Services (task_cmdb_ci_service)  
• Service Offerings (task_service_offering)  
• Business Applications (task_cmdb_ci_business_app)  
You cannot add any other table in this field but you can remove any of the default values.|

**Synchronization between a parent and a child incident**

The parent and the child incidents are synchronized such that the state of a child incident changes depending on the state of the parent incident.

**Parent-Child state synchronization**

<table>
<thead>
<tr>
<th>Parent State</th>
<th>On Hold Reason (Parent)</th>
<th>Child State</th>
<th>On Hold Reason (Child)</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Progress</td>
<td>NA</td>
<td>In Progress</td>
<td>NA</td>
</tr>
<tr>
<td>On Hold</td>
<td>Awaiting Change/Awaiting Problem/Awaiting Vendor</td>
<td>Same as parent</td>
<td>Same as parent</td>
</tr>
<tr>
<td>On Hold</td>
<td>Awaiting caller</td>
<td>Not updated</td>
<td>Not updated</td>
</tr>
<tr>
<td>Resolved</td>
<td>NA</td>
<td>Resolved.</td>
<td>NA</td>
</tr>
</tbody>
</table>
Parent-Child state synchronization (continued)

<table>
<thead>
<tr>
<th>Parent State</th>
<th>On Hold Reason (Parent)</th>
<th>Child State</th>
<th>On Hold Reason (Child)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>NA</td>
<td>Not closed</td>
<td>NA</td>
</tr>
<tr>
<td>Canceled</td>
<td>NA</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>

The Activity log in the child incident form is updated with the resolution notes copied from the parent Incident.

Child incidents must always be closed by the caller or by the system based on the auto-closure property.

Note:
- When an incident has a child incident, the following actions take place:
  - If an ITIL user reopens the parent incident, then the parent incident as well as the child incident reopens. Both the parent and the child incident state is set to In Progress.
  - If an ESS user reopens the parent incident, the parent incident state is set to In Progress but the child incident is not reopened.

Enable the display of incident special handling notes

Enable the display of informative notes for a specific record or for a set of records that meet one or more conditions. Use these notes to help users understand the action that was taken for the incident or the next course of action to be taken.

Before you begin
Role required: admin

Activate the Special Handling Notes plugin (com.sn_shn) to add the Create Special Handling Notes related link from which you can create the notes.
Procedure
1. Navigate to Incident > All.
2. Open any incident record.

3. Click the Additional actions icon and select Configure > Form Layout.
4. From the Available list, select Special Handling Notes Pop Up and move it to the Selected list.
5. Click Save.
   The Incident form can now display special handling notes.

Related information
Create a special handling note

Create a knowledge article from an incident using an article template
Provide a resolution for an issue by creating a knowledge article from an incident with fields defined in an article template.

Before you begin
Role required: itil, sn_incident_write, or admin

Activate the KCS Integration for Incident Management plugin (com.snc.incident.knowledge).

About this task
You can create a knowledge article only when the incident is resolved and you have not already created a knowledge article from that incident.

Note: Incident managers with the sn_km_ml.knowledge_curation_user role can use the Demand Insights for Incidents dashboard to identify which incidents have no or insufficient knowledge coverage. For more information, refer Demand Insights for Incidents dashboard.

Procedure
1. Navigate to Incidents > Resolved.
2. Open a resolved incident record.
3. Access the Incident-KCS article - HTML form using one of the following methods:
   • Under Related Links, click Create Knowledge.
   • Right-click the form header and click Create Knowledge.
The Incident-KCS article - HTML template provided with the base system appears. If you want to create your own article template, refer to Create an article template.

4. On the form, fill in the fields.

### Incident KCS Article form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>[Auto-generated] Unique number to identify the knowledge article.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Knowledge base in which the article is stored. The Incident KCS Article is stored in the [kb_template_incident_kcs_article] table.</td>
</tr>
<tr>
<td>Category</td>
<td>[Auto-generated] The value of this field is automatically provided from the Category field of the knowledge.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date after which the knowledge article is deleted from the database. After this date, the article does not appear in the search result.</td>
</tr>
<tr>
<td>Confidence</td>
<td>Maturity of an article based on its completeness and reusability.</td>
</tr>
<tr>
<td>Version</td>
<td>[Auto-generated] Displays the article version number, which is incremented when changes are made to a published article.</td>
</tr>
<tr>
<td>Workflow</td>
<td>[Auto-generated] Workflow that is followed for creating the knowledge article. For more information, refer Knowledge workflows.</td>
</tr>
<tr>
<td>Source Task</td>
<td>[Auto-generated] Incident record from which you have created the article.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Check box to automatically download an attached article</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>instead of opening the article, when you access an article.</td>
<td></td>
</tr>
<tr>
<td>Display attachments</td>
<td>Check box to display attachments in the knowledge article. The attachments appear below the article text.</td>
</tr>
<tr>
<td>Governance</td>
<td>An attribute of an article that allows you to control sensitive, critical, or regulated information. Not all articles have the same requirement for compliance reviews. Some articles are based on the collective experience of those who use the articles (experience-based). Other articles have policy or legal information that require tight control (compliance-based).</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the knowledge article.</td>
</tr>
<tr>
<td>Issue</td>
<td>Information on the cause of the incident.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Method used to resolve the incident.</td>
</tr>
</tbody>
</table>

**Note:** The **Confidence** and **Governance** fields appear when the Knowledge Management KCS Capabilities plugin (com.snc.knowledge_kcs_capabilities) is activated. For more information, see Managing the KCS article state.

5. Click **Submit**.
   A knowledge article is created. The article record is listed in the Knowledge related list.

Create a knowledge article from an incident
When you are ready to close an incident, you can create a knowledge article so the next time the issue comes up the resolution is easy to find.

Before you begin
Role required: itil, sn_incident_write, or admin
About this task
When an incident is closed automatically or by the caller, a draft knowledge article is created.

Procedure
1. Open a resolved incident that you want to close.
2. Ensure that the Knowledge check box is selected and that a resolution is entered in the Additional comments (Customer visible) field.
3. Click Close incident.
   A new draft knowledge article is created. The content in the fields listed in the following table is copied from the Incident form to the Knowledge form.

<table>
<thead>
<tr>
<th>Field on Incident form</th>
<th>Field on Knowledge form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Additional comments</td>
<td>Text</td>
</tr>
<tr>
<td>Number</td>
<td>Source</td>
</tr>
</tbody>
</table>

The Knowledge related list on the Incident form is populated with the new draft knowledge article. The draft article does not appear in the knowledge base (KB) for users until it is reviewed and published.

If the Knowledge submission workflow (glide.knowman.submission.workflow) is enabled from the System Properties [sys_properties] table, the content in the Short description and Additional comments fields of the incident form become a knowledge submission instead of an article. The KB Submissions related list on the Incident form is populated with the new knowledge submission. For more information on creating a knowledge article and workflows, see Enable creating a knowledge article from an incident and Knowledge workflows.

What to do next
To see the draft articles, navigate to Knowledge > My Knowledge Articles and then open the draft article by its KB number in the Knowledge form.

View affected CIs in the dependency views map
A configuration item (CI) can result in an incident. Use dependency view to identify other configuration items (CIs) that are affected by the CI that resulted in the incident.

Before you begin
Role required: Itil, itil_admin sn_incident_write, or admin
About this task
Often, an incident is related to one or more specific configuration items (CIs). If the configuration management database (CMDB) is populated, the CI records hold valuable information to help resolve incidents. You can associate configuration items to an incident to see how the incident affects dependent CIs.

Use the Configuration Item field when a single CI is the cause of the incident and use the Affected CIs related list when multiple CIs are affected by the incident. For example, suppose a load-balancer in a data center is no longer operational. The Configuration Item field lists the specific server which is out of memory. The Affected CI related list contains the load-balancer, the data center, the servers that depend on the load-balancer, and business services that are impacted by the missing server.

Procedure
1. On the Incident form, associate the CIs.

<table>
<thead>
<tr>
<th>From where</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration item field</td>
<td>Click the lookup icon (🔍) beside the field and select the CI.</td>
</tr>
<tr>
<td>Affected CIs related list</td>
<td>a. Click Add at the top of the list.</td>
</tr>
<tr>
<td></td>
<td>b. Select the CI to associate.</td>
</tr>
<tr>
<td></td>
<td>c. Click Add Selected.</td>
</tr>
<tr>
<td></td>
<td>d. Right-click on the form header and click Save.</td>
</tr>
</tbody>
</table>

2. Click the dependency views icon (🔍) beside the Configuration item field. The Dependency Views map opens in a new tab or window.

3. To see items that this CI affects, click the down arrow and select View Affected CIs.
To add another affected CI to the incident, click the down arrow beside the CI and click **Add Affected CI(s)**.

**Related information**

**Dependency Views map**

**Refresh impacted services and CIs for incident**

The impacted services and CIs related list refreshes its records and also the records listed in the Service Offerings and Business Applications related lists based on the affected CIs. You can identify the impacted services and CIs and take necessary action.

**Before you begin**

Role required: itil, incident_manager, sn_incident_write, or admin

Ensure that you have configured the Business Applications related list.

**About this task**

When you refresh impacted services, the Impacted Services/CIs, Business Applications, and the Service Offerings related lists get updated based on the affected CIs. The records in each of the related list are unique even though the impact can be from a single affected CI. The following properties are responsible for this functionality:
• Populate Impacted Services based on Affected CIs. Note: This requires any Business Service identified to have previously been converted to an Application Service. (incident.refresh_impacted.include_affected_cis)

• Populate the Business Application related list for incidents (com.snc.incident.populate_business_application)

• Populate the Service Offering related list for incidents (com.snc.incidentpopulate_service_offering)

Procedure
1. Navigate to Incident > Open.
2. Open the incident record for which you want to refresh the related lists those values are based on affected CIs.

3. Click the Additional actions icon and then select Refresh Impacted Services.
   The records in the Impacted Services/CIs, Business Applications, and Service Offerings related lists are updated.

Associate CIs with incident
Associate affected or impacted configuration items (CIs) with an incident record to find out how the incident affects other CIs with dependent relationships.

Before you begin
Role required: admin

About this task
Use the Configuration Item field when there is a single, primary CI that is the cause of the incident and the Affected CIs or the Impacted Services/CIs related list when multiple CIs are affected by the incident.

Procedure
1. Navigate to Incident > Open.
2. Open the incident record to which you want to associate CI items.
3. Perform the following actions:
## Associate CI items

<table>
<thead>
<tr>
<th>Options</th>
<th>Procedures</th>
</tr>
</thead>
</table>
| Configuration item | a. Click the lookup icon (🔍).  
b. Select configuration item.  
   \[1\] **Note:** By default, Service Offering is filtered out and CIs with Principal Class are selected. The Principal Class filter functionality is applicable to the new customers starting the Paris release. |
| Affected CIs    | a. Click **Add**.  
b. Select configuration items.  
   \[2\] **Note:** By default, Service Offering is filtered out and CIs with Principal Class are selected. The Principal Class filter functionality is applicable to the new customers starting the Paris release. |
| Impacted Services/CIs | a. Click **Add**.  
b. Select configuration items.  
   \[2\] **Note:** By default, Service Offering is filtered out.  
c. Click **Add Selected**. |
Update the resolved incident notification template
Modify the content of the email template that is sent to the user when you resolve an incident.

Before you begin
Role required: admin

Procedure
1. Navigate to System Notification > Templates.
2. Open the incident.ess.resolve template.
3. Manually update the template content.
4. Click Update.

Incident resolution and closure
An incident is considered resolved when you provide the user with a temporary workaround or a permanent solution for the issue.

When an incident is resolved, the escalators stop, and the caller can review the resolution. If the caller is satisfied with the resolution, the caller can close the incident or the incident is auto-closed after a certain time based on the incident auto-close properties.

If the cause of an incident is understood but cannot be fixed, the service desk can create a problem from the incident to find the root cause of the issue. The problem is then evaluated through the problem management process.

If the incident creates the need for a change in IT services, the service desk can generate a change from the incident, which is evaluated through the change management process.

Incident closure
You can configure incident properties to auto-close an incident.

Your organization can also generate customer satisfaction surveys when incidents are closed. Surveys allow the service desk to gather information about the quality of their service directly from the user.

Resolve and close an incident
When the service is restored by rectifying the issue that resulted for an incident, you can set the incident state as resolved. If the user is satisfied with the resolution, the user can close the incident or the incident is auto-closed after a certain time based on the incident auto-close properties.
Before you begin
Role required: itil, list_updater, sn_incident_write, or admin (for resolution) and itil_admin or admin (for closure)

Procedure
1. Navigate to Incident > Open.
2. Open the incident that you want to resolve and close.
3. In the Resolution Information section, fill in the fields.

Resolution Information fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolved by</td>
<td>The user who resolved the issue and the date and time the incident was closed.</td>
</tr>
<tr>
<td>Resolved</td>
<td>The date and time when the incident was resolved.</td>
</tr>
<tr>
<td>Resolution code</td>
<td>Information to categorize resolved cases.</td>
</tr>
<tr>
<td>Resolution notes</td>
<td>Document how an incident is resolved.</td>
</tr>
</tbody>
</table>

4. Click Resolve.
The incident is in the resolved state.

5. Click Close Incident.
The incident is closed.

ℹ️ Note: Even when an incident is closed or canceled, you can edit the following fields on the Incident form, if you have an admin role:
Subcategory, Service, Service Offerings, Description, Contact type, Watch list, Work notes list, Parent Incident, Problem, Change Request, Caused by Change, Resolved by, Resolved, Reassignment count.

Configure incidents to close automatically
Close incidents automatically based on the last updated date or the resolution date of the incident by configuring incident properties. You can also mention the number of days system must wait before initiating the auto-closing functionality.
Before you begin
Role required: admin

About this task
You can auto-close incident based on the last updated date or the resolution date of the incident using the property **Enable auto closure of incidents based on Resolution date. Setting this to ‘No’ will make auto closure to run based on the Updated date** (com.snc.incident.autoclose.basedon.resolved_at). This property is set to true only for the new customers starting the London release. Existing customers before the London release have to manually set the property to true.

**Note:** You cannot auto-close a major incident based on the incident auto-closure property. For more information, refer Close a major incident.

A scheduled job called **Autoclose Incidents** (System Scheduler > Scheduled Jobs > Scheduled Jobs) runs the **Incident Autoclose** business rule to close incidents as described. By default, it assigns the name of the administrator, who is logged in when the **Autoclose Incidents** job runs, to the **Updated by** field.

**Procedure**

1. Navigate to **Incident** > **Administration** > **Incident Properties**.

2. Select the **Enable auto closure of incidents based on Resolution date. Setting this to ‘No’ will make auto closure to run based on the Updated date** check box if you want the incident to be auto-closed based on the resolution date.

3. In the **Number of days (integer) after which Resolved incidents are automatically closed. Zero (0) disables this feature** (glide.ui.autoclose.time) property, enter the number of days.

**Note:** If you have an inactivity monitor triggering on your incident, it resets this auto-close clock each time it triggers, preventing your incident to be closed. To prevent this reset, set a **Reset Condition** on your inactivity monitor to **[Incident state] [is not] [Resolved]**.

4. Click **Save**.

**Related information**

- Configure default user for auto-closing incidents

**Close multiple incidents from list**

Close multiple incidents from the incident list simultaneously that can have the same resolution code.
Before you begin
Role required: itil, list_updater, sn_incident_write, or admin

Procedure
1. Select the check box beside each incident that you want to close.
2. Right-click on any list column header and click Update Selected.
3. Set the value of State to Closed.
4. In the Resolution Information section, select a Resolution code and enter your notes in Resolution notes.
5. Click Update. The changes apply to all the selected records.

Create a UI action to close multiple incidents
Create a UI action to close multiple incidents at once from the Actions list in the list view.

Before you begin
Role: business_rule_admin (for business rule), ui_action_admin (for UI action), or admin

About this task
Closing an incident from Actions list adds the same close note to all the incidents that are closed and does not require the list_updater role. Implementing this process requires a script include that is referred from a UI action and a custom UI page.
Procedure

1. Navigate to **System Definition > Script Includes** and click **New**.

2. Create the script includes with the following information.
   - **Name**: IncidentClosure
   - **Client callable**: Select the check box
   - **Active**: Select the check box
   - **Script**: Paste the following information:

     ```javascript
     var IncidentClosure = Class.create();
     IncidentClosure.prototype = Object.extendsObject(AbstractAjaxProcessor, {
         closeIncidents: function() {
             var selectedIncidents = this.getParameter("sysparm_incidents");
             var notes = this.getParameter("sysparm_closeNote");
             var code = this.getParameter("sysparm_closeCode");
             var incidentGr = new GlideRecord('incident');
             incidentGr.addQuery('sys_id', 'IN', selectedIncidents);
             incidentGr.query();
             while (incidentGr.next()) {
                 incidentGr.setValue('state', 7);
                 incidentGr.setValue('close_notes', notes);
                 incidentGr.setValue('close_code', code);
                 incidentGr.update();
             }
             return true;
         },
         type: 'IncidentClosure'
     });
     ```

3. Save the record.

4. Create the following steps to create a UI page.
   - **Name**: mandatory_fields_to_close_incident_ui
   - **HTML**: Paste the following information:

     ```xml
     <?xml version="1.0" encoding="utf-8" ?>
     <j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null"
     xmlns:g2="null">
     <style>
     #content_row .reference-label {
         padding-right: 15px;
     }
     </style>
     ```

© 2021 ServiceNow, Inc. All rights reserved.
<form class="form-horizontal">
  <div class="form-group">
    <label class="col-xs-4 control-label">
      <span class="label-text">${gs.getMessage('Resolution code')}</span>
    </label>
    <div class="col-xs-5 form-field input_controls" style="line-height: 32px;">
      <select name="closeCode" id="closeCode">
        <option value="" selected="SELECTED" role="option">-- None --</option>
        <option value="Solved (Work Around)" role="option">Solved (Work Around)</option>
        <option value="Solved (Permanently)" role="option">Solved (Permanently)</option>
        <option value="Solved Remotely (Work Around)" role="option">Solved Remotely (Work Around)</option>
        <option value="Solved Remotely (Permanently)" role="option">Solved Remotely (Permanently)</option>
        <option value="Not Solved (Not Reproducible)" role="option">Not Solved (Not Reproducible)</option>
        <option value="Not Solved (Too Costly)" role="option">Not Solved (Too Costly)</option>
        <option value="Closed/Resolved by Caller" role="option">Closed/Resolved by Caller</option>
      </select>
    </div>
  </div>
  <div class="form-group">
    <label class="col-xs-4 control-label">
      <span class="label-text">${gs.getMessage('Resolution Notes')}</span>
    </label>
    <div class="col-xs-7 form-field input_controls">
      <textarea required="true" class="form-control" value="closeNotes" id="closeNotes" type="text"></textarea>
    </div>
  </div>
</form>
• **Client script**: Paste the following information:

```javascript
function actionOK() {
    var modal = GlideModal.prototype.get("mandatory_fields_to_close_incident_ui");
    var incidents = modal.getPreference("selected_incidents");
    if (incidents) {
        // close the incidents
        var glideAjax = new GlideAjax("IncidentClosure");
        glideAjax.addParam("sysparm_name", "closeIncidents");
        glideAjax.addParam("sysparm_incidents", incidents);
        glideAjax.addParam("sysparm_closeCode", "${closeCode}".value);
        glideAjax.addParam("sysparm_closeNote", "${closeNotes}".value);
        glideAjax.getXMLAnswer(function(answer) {
            GlideModal.prototype.get("mandatory_fields_to_close_incident_ui").destroy();
            GlideList2.get('incident').refresh();
        });
    }
}

function actionCancel() {
    GlideModal.prototype.get("mandatory_fields_to_close_incident_ui").destroy();
}

(function() {
    var okButton = gel('ok_button');
    var closeCodeEl = gel('closeCode');
    var closeNotesEl = gel('closeNotes');
    okButton.disabled = true;
    closeNotesEl.value = "";
    closeCodeEl.on('change', function() {
```

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
if (closeCodeEl.value !=="" && closeNotesEl.value !=="")
  okButton.disabled = false;
else
  okButton.disabled = true;
});
closeNotesEl.on('input', function() {
  if (closeCodeEl.value !=="" && closeNotesEl.value !=="")
    okButton.disabled = false;
  else
    okButton.disabled = true;
});
})();

5. Save the record.
6. Complete the following steps to create the UI action for closing multiple incidents.

a. Navigate to **System Definition > UI Actions** and click **New**.

b. Create the UI actions with the following information:
   - **Name**: Close incidents
   - **Table**: Incident [incident]
   - **Show update**: Select the check box
   - **List choice**: Select the check box
   - **List v2 Compatible**: Select the check box
   - **Client**: Select the check box
   - **Onclick**: closeIncidents()
   - **Condition**: current.getValue('state') !== '7'
   - **Script**: paste the following information

```javascript
function closeIncidents() {
  var list = GlideList2.get('incident');
  var title = list.getTitle();
  var incidents = list.getChecked();
  if (incidents) {
    var o = new GlideModal('mandatory_fields_to_close_incident_ui');
    getMessage("Close Incidents", function(msg) {
      o.setTitle(msg);
      o.setPreference('selected_incidents', incidents);
      o.render();
    });
  }
}
```
7. Save the record.

Results
Service desk agents can close multiple incidents using Close incidents in the Actions list below the Incident list.

Reopening an incident
Reopen an incident from the resolution notification email or from the incident to get answer for your query.

If you are not satisfied with the resolution of your incident, request to reopen the incident from the resolution notification email. You can also reopen the incident itself. The state of the incident is then changed from Resolved to In Progress.

If the incident is already closed and you request to reopen the incident by replying to the resolution notification email, a new incident is opened with selected field values from the closed incident. The values of the fields that you mention in the List of fields (comma-separated) to copy from the original incident when an incident is reopened by email property (com.snc.incident.clone_fields_on_reopen) are copied from the closed incident to the new incident. Add the text Please reopen to the subject line of the email.

• If an incident is reopened by a user after it was resolved, the Last reopened by and the Last reopened at fields are automatically populated with the name of the person who reopened it and the date and time when the incident is reopened. During audit, this information helps you to generate various reports for reopened incidents.

• On the Incident form, there is an existing field named Reopen count. Incidents that were reopened prior to the Kingston release, may already have some non-zero values in the Reopen count field while the values in the new fields, Last reopened by and the Last reopened at are null. For incidents that are reopened after the Kingston release, the Last reopened by and the Last reopened at fields are populated.

• If you do not have any roles in the system (ESS) and you change the incident state to Resolved, you receive a notification with a Reopen incident link.
If you do not have any roles in the system (ESS) and you are the caller, you can click **Reopen incident** on the incident form to reopen the incident. Add the text **Please reopen** to the subject line of the email.

**Note:** An ESS user is not able to resolve, reopen, or close a major incident even if the user is the caller.

**Incident standard ticket page**

The Incident standard ticket page is where you and your employees can view the details of an incident and can be used with service portal.

You can access the Incident ticket page in Service Portal using the **Requests** option from the main menu header of Service Portal. The Incident ticket page is available by default for new as well as upgrade users. The Incident standard ticket page shows the details of an Incident, such as the short description, caller, and urgency. It also shows the **Actions** list from where you can resolve, close, or reopen incident.

**Incident standard ticket page configuration**

You can configure the appearance of the Incident standard ticket page header and tabs from **Standard Ticket > Standard Ticket Configuration > Incident**. For more information, refer [Configure incident ticket page](#).
Configure incident ticket page

Configure the Incident ticket page from where users can view the details of an Incident in Service Portal.

Before you begin
Role required: admin

Procedure
2. Click the Incident record.
3. On the form, configure the fields.

Ticket Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Task-extended table for which you want to configure the standard ticket page.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to specify if the ticket configuration is active.</td>
</tr>
<tr>
<td>Application</td>
<td>Application associated with the ticket configuration.</td>
</tr>
<tr>
<td>State field</td>
<td>Any field of the task-extended table. By default, this field is mapped to the State field of the task-extended table. You have to configure the form to add this field.</td>
</tr>
<tr>
<td>Info Region</td>
<td>Show 'Description' Scenario where the request description should be displayed. Possible options are:</td>
</tr>
</tbody>
</table>

Note: You cannot add fields for any of the following information:
- Number
- Short description
- Created date
- Updated date
- Watch list
- Any user input such as comments and work notes
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• None</td>
<td></td>
</tr>
<tr>
<td>• Always</td>
<td></td>
</tr>
<tr>
<td>• When no variables</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** When displayed, you can expand and collapse the description.

<table>
<thead>
<tr>
<th>Advanced</th>
<th>Option to specify that a widget should be displayed in the info region.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info widget</td>
<td>Widget that should be displayed in the info region. This field appears only when the <strong>Advanced</strong> check box is selected.</td>
</tr>
<tr>
<td>Info widget parameters</td>
<td>Comma-separated list of info widget parameters. This field appears only when the <strong>Advanced</strong> check box is selected.</td>
</tr>
<tr>
<td>Info fields</td>
<td>Fields that should be displayed in the info region. This field disappears when you select the <strong>Advanced</strong> check box.</td>
</tr>
</tbody>
</table>

**Note:** You cannot add fields for any of the following information:

- Number
- Short description
- Created date
- Updated date
- Watch list
- State
- Any user input such as comments and work notes

<table>
<thead>
<tr>
<th>Action Region</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action widget</td>
</tr>
<tr>
<td>Action widget parameters</td>
</tr>
</tbody>
</table>
Note:

- By default, the Activity and Attachments type tab configurations are available for all standard configurations.
- You cannot duplicate any tab type other than Custom.
- You can configure a maximum of five tabs.
- You can add only one of these tab types:
  - Variable Editor (Read-Only)
  - Variable Summarizer

4. Right-click the header menu and click **Save**.

5. On the Tab Configurations related list, configure the fields.

Tab Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Tab type based on which a widget is displayed. Possible options are:</td>
</tr>
<tr>
<td></td>
<td>• None</td>
</tr>
<tr>
<td></td>
<td>• Activity</td>
</tr>
<tr>
<td></td>
<td>• Attachments</td>
</tr>
<tr>
<td></td>
<td>• Custom</td>
</tr>
<tr>
<td></td>
<td>• Variable Editor (Read-Only)</td>
</tr>
<tr>
<td></td>
<td>• Variable Summarizer</td>
</tr>
<tr>
<td><strong>Tab name</strong></td>
<td>Name of the tab.</td>
</tr>
<tr>
<td><strong>Application</strong></td>
<td>Application associated with the ticket configuration.</td>
</tr>
<tr>
<td><strong>Order</strong></td>
<td>Order in which the tab should be displayed in the tabs section.</td>
</tr>
<tr>
<td><strong>Visible</strong></td>
<td>Conditions for the tab visibility.</td>
</tr>
<tr>
<td><strong>Widget</strong></td>
<td>Widget that should be displayed in the tabs section. This field appears only when <strong>Custom</strong> is selected from <strong>Type</strong>.</td>
</tr>
<tr>
<td><strong>Widget parameters</strong></td>
<td>Comma-separated list of tab widget parameters. This field appears only when <strong>Custom</strong> is selected from <strong>Type</strong>.</td>
</tr>
</tbody>
</table>

6. On the Ticket Configuration form, click **Update**.
Incident reporting

Service desk and other IT managers can use dashboards and reports to monitor and track incident status and service levels.

Incident Overview

The Incident > Overview dashboard provides a quick glance at the current state of open incidents. At the top, single score widgets enumerate the open incident statuses, such as critical incidents, unassigned incidents, and overdue incidents. Charts in the dashboard group incidents by factors such as priority and state. The incident overview is fully interactive and configurable.

Incident reports

Various incident reports are available in the base system, and you can modify the existing reports or create new ones. Navigate to Reports > View / Run and enter incident in the search box to view all incident reports. Base system reports include the following:

- Basic bar or pie chart reports, such as incidents by assignment group, location, priority, or state. These reports help you analyze a specific data point, for example, whether enough staff is allocated to an assignment group.
- Time series reports, such as Incident Trend by Configuration Item. This report lets you analyze closed incidents by configuration item (CI) to identify potential problems.
- Multidimensional reports, such as Incidents by Priority and State older than 30 Days. This report can help you identify gaps in service levels. For example, if a high number of low-priority incidents are still in New state after being open more than 30 days.

Incident metric definition

A metric measures and evaluates the effectiveness of IT service management processes. The service desk can improve the incident management process using information gathered within the platform. You can activate the Metric Definition plugin (com.glide.metrics) and define the metrics to monitor within the system. With these metrics, and the information within the database, it is possible to generate reports that can be added to homepages or automatically generated and distributed.

Using this information, it is possible to refine automatic rules such as the assignment rules, service level agreements, or inactivity monitors to better suit the unique environment of the service desk. Unnecessary incidents can be avoided by encouraging users to consult the knowledge base before creating
an incident. The related search results function in the Incident form assists with this strategy.

**Complimentary Performance Analytics for Incident Management**

Complimentary Performance Analytics for Incident Management and aggregates data over time, and is enabled by default for Incident Management. Complimentary Performance Analytics for Incident Management provides an Incident Management dashboard with 15 indicators to help you assess organizational performance. For more information, see [Performance Analytics for Incident Management](#).

If you subscribe to Performance Analytics, additional Analytics and Reporting Solution are available for Incident Management. The Analytics and Reporting Solution for Incident Management contains preconfigured dashboards.

A subscription to Performance Analytics also gives you access to In-form analytics. In-form analytics integrate performance insights into Incident records so that users can access important metrics in context and make better decisions. For more information, see [Text-To-Display](#).

**Related information**

- Homepage administration
- Creating reports

**Incident Management Analytics and Reporting Solutions**

Analytics and Reporting Solutions and In-form analytics contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can use Performance Analytics for your application with minimal setup. You can also create your own objects.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

**Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see [Configure Analytics and Reporting Solutions](#).
The Analytics and Reporting Solution for Incident Management is available by default as part of Complimentary Performance Analytics for Incident Management.

**Related information**

- Analytics and Reporting Solutions
- Activate your Performance Analytics subscription

**Incident Management Dashboard**

The Incident Management dashboard lets you see recent trends in incident creation, duration, and resolution. Use the information on this dashboard to spot problem areas and plan your incident management strategy going forward.

**Tabs of the Incident Management dashboard**

<table>
<thead>
<tr>
<th>Incident Overview</th>
<th>Incident Open</th>
<th>Incident New</th>
<th>Incident Resolved</th>
</tr>
</thead>
</table>

---

**End user and roles**

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Manager: Needs to know how the incident management process is doing so they can plan for the future.</td>
<td>itil</td>
</tr>
</tbody>
</table>
Indicators

**Number of open incidents**
Daily count of the number of incidents that do not have a resolution date. This indicator is used as the basis of several other indicators on this dashboard.

**Number of open incidents not updated in last 5 days**
Daily count of the number of incidents last updated more than five days ago.

**Number of open incidents not updated in last 30 days**
Daily count of the number of incidents last updated more than 30 days ago.

**Number of new incidents**
Daily count of the number of incidents opened 'today.'

**Number of resolved incidents**
Daily count of indicators with State = Resolved.

**Incident Backlog Growth**
Tracks the increase or decrease in open incidents. The score is calculated according to the formula \([\text{Number of new incidents}] - \text{[Number of resolved incidents]}\).

**Average age of open incidents**
The average age in days in which an incident has been open. The score is calculated according to the formula \([\text{Summed age of open incidents}] / ([\text{Number of open incidents}]*24)\).

**% of new critical incidents**
The percentage of new incidents filtered on the Priority breakdown with the breakdown element 1 - Critical. The score is calculated according to the formula \((\text{[Number of new incidents > Priority = 1 - Critical]} / \text{[Number of new incidents]}) * 100\).

**Average resolution time of resolved incidents**
The average number of days it takes to resolve an incident, provided it is resolved. The score is calculated according to the formula \(([\text{Summed duration of resolved incidents}] / ([\text{Number of resolved incidents}] * 24))\).

The following indicators are not shown directly on the dashboard but are used in calculating formulas:
- Summed age of open incidents
- Summed duration of resolved incidents

**Breakdowns**
- Category
- Priority
- Age

**Incident Daily 7d - 28d dashboard**
View the last 28 days of incidents as raw trends, as a 7-day running average, or as a 28-day running average. Filter the scores by assignment groups or by the category of incident.
### Incident Manager: Needs to know how the incident management process is doing so they can plan for the future.

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Manager</td>
<td>ITIL</td>
</tr>
</tbody>
</table>

### Indicators

**Number of open incidents**

Daily count of the number of incidents that do not have a resolution date. This indicator is used as the basis of several other indicators on this dashboard.

**Number of resolved incidents**

Daily count of indicators with State = Resolved.

**Average resolution time of resolved incidents**
The average number of days it takes to resolve an incident, provided it is resolved. The score is calculated according to the formula \[ \frac{\text{Summed duration of resolved incidents}}{\text{Number of resolved incidents} \times 24}. \]

**Number of open incidents not updated in last 5 days**

Daily count of the number of incidents last updated more than five days ago.

**Number of open incidents not updated in last 30 days**

Daily count of the number of incidents last updated more than 30 days ago.

**Breakdowns**

You can apply breakdown elements on this dashboard to all widgets simultaneously. Above the chart in the upper left, select either Groups or Incident.Category. You can then select one or more elements and they will apply to all widgets.
Incident Premium dashboard

This dashboard uses Workbench widgets and other advanced Performance Analytics features to give you all the information about the Incident process in one place.

Tabs of the Incident Premium dashboard

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Manager: Needs to know how the incident management process is doing so they can plan for the future.</td>
<td>itil</td>
</tr>
</tbody>
</table>
Indicators

**Number of open incidents**

Daily count of the number of incidents that do not have a resolution date. This indicator is used as the basis of several other indicators on this dashboard.

**Number of new incidents**

Daily count of the number of incidents opened ‘today.’

**Number of closed incidents**

Daily count of indicators with State = Closed.

**Number of resolved incidents**

Daily count of indicators with State = Resolved.

**Average age of open incidents**

The average age in days in which an incident has been open. The score is calculated according to the formula \( \frac{[\text{Summed age of open incidents}]}{([\text{Number of open incidents}]*24)}. \)

**Average reassignment of open incidents**

The average number of times currently open incidents have been reassigned. This indicator is shown as ‘Average re-assignment times’ in the Process by State tab. The score is calculated according to the formula \( \frac{[\text{Summed re-assignment of open incidents}]}{[\text{Number of open incidents}]} \).

**Average age of last update of open incidents**

How long on average it has been since the last update to one of the currently open incidents, in days. The score is calculated according to the formula \( \frac{[\text{Summed age of last update of open incidents}]}{([\text{Number of open incidents}]*24) \times 24}. \)

**% of incidents not updated in last 5 days**

The percentage of currently open incidents that have not been updated for the last five days. The score is calculated according to the formula \( \frac{[\text{Number of open incidents not updated in last 5 days}]}{[\text{Number of open incidents}]} \times 100 \).

**% of incidents not updated in last 30 days**

The percentage of currently open incidents that have not been updated for the last 30 days. The score is calculated according to the formula \( \frac{[\text{Number of open incidents not updated in last 30 days}]}{[\text{Number of open incidents}]} \times 100 \).
% of new critical incidents

The percentage of new incidents filtered on the Priority breakdown with the breakdown element 1 - Critical. The score is calculated according to the formula \( \frac{\text{[Number of new incidents > Priority = 1 - Critical]} }{\text{[Number of new incidents]}} \times 100 \).

Average close time of incidents

The average amount of time in days it takes to close an incident. The score is calculated according to the formula \( \frac{\text{[Summed duration of closed incidents]}}{\text{[Number of closed incidents]}} \times 24 \).

% of incidents resolved without reassigning

The percentage of incidents with a State of Resolved that were never reassigned from the first assignment group. The score is calculated according to the formula \( \frac{\text{[Number of resolved incidents by first assigned group]}}{\text{[Number of resolved incidents]}} \times 100 \).

% of incidents closed by self-service

The percentage of incidents with State = Closed and Close code = Closed/Resolved by Caller. The score is calculated according to the formula \( \frac{\text{[Number of incidents closed by self-service]}}{\text{[Number of closed incidents]}} \times 100 \).

% of open incidents reassigned at least once

The percentage of incidents that are open and that have been transferred at least once. The score is calculated according to the formula \( \frac{\text{[Number of reassigned open incidents]}}{\text{[Number of open incidents]}} \times 100 \).

% of incidents resolved same day opened

The percentage of incidents with State = Resolved where the day in the Resolved field is the same as the day in the Opened field. The score is calculated according to the formula \( \frac{\text{[Number of incidents resolved on the same day opened]}}{\text{[Number of resolved incidents]}} \times 100 \).

% of incidents not solved

The percentage of closed incidents where Close code = Not Solved (Not Reproducible) or Not Solved (Too Costly). The score is calculated according to the formula \( \frac{\text{[Number of incidents not solved]}}{\text{[Number of closed incidents]}} \times 100 \).

The following indicators are not shown directly on the dashboard but are used in calculating formulas:
• Summed age of open incidents
• Summed re-assignment of open incidents
• Summed age of last update of open incidents
• Number of open incidents not updated in last 5 days
• Number of open incidents not updated in last 30 days
• Summed duration of closed incidents
• Number of resolved incidents by first assigned group
• Number of incidents closed by self-service
• Number of reassigned open incidents
• Number of incidents resolved on the same day opened
• Number of incidents not solved

Breakdowns
• Priority
• Category
• Assignment Group
• State

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incidents Opened Today</td>
<td>Single Score</td>
<td><img src="image" alt="42" /></td>
</tr>
<tr>
<td>Unassigned Incidents</td>
<td>Single Score</td>
<td><img src="image" alt="42" /></td>
</tr>
<tr>
<td>Overdue Incidents</td>
<td>Single Score</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Open Incidents</td>
<td>Single Score</td>
<td></td>
</tr>
<tr>
<td>Incidents not updated for 7 days</td>
<td>Single Score</td>
<td></td>
</tr>
<tr>
<td>Open incidents older than 30 days</td>
<td>Single Score</td>
<td></td>
</tr>
<tr>
<td>Open Incidents - Grouped</td>
<td>Horizontal Bar</td>
<td></td>
</tr>
<tr>
<td>Open incidents older than 30 days - Grouped</td>
<td>Horizontal Bar</td>
<td></td>
</tr>
<tr>
<td>Incidents by Priority and State</td>
<td>Heatmap</td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Incidents by Priority and State older than 30 days</td>
<td>Heatmap</td>
<td></td>
</tr>
<tr>
<td>Incidents opened per week</td>
<td>Line</td>
<td></td>
</tr>
<tr>
<td>Incidents closed per week</td>
<td>Line</td>
<td></td>
</tr>
<tr>
<td>Open Incidents older than 30 days by Assignment Group and State</td>
<td>Heatmap</td>
<td></td>
</tr>
<tr>
<td>Open Incidents Not Updated In Last 30 Days by Assignment Group and State</td>
<td>Heatmap</td>
<td></td>
</tr>
<tr>
<td>Open Incidents where assignee is not active</td>
<td>Heatmap</td>
<td></td>
</tr>
<tr>
<td>Open Incidents with closed Problem</td>
<td>Heatmap</td>
<td></td>
</tr>
</tbody>
</table>

**Open Incidents Age Monitor dashboard**

View average age and assignment times and breakdown incidents in different age buckets.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Manager: Needs to know how the incident management process is doing so they can plan for the future.</td>
<td>itil</td>
</tr>
</tbody>
</table>

Indicators

**Number of open incidents**

Daily count of the number of incidents that do not have a resolution date. This indicator is used as the basis of several other indicators on this dashboard.

**Average age of open incidents**
The average age in days in which an incident has been open. The score is calculated according to the formula \( \frac{\text{Summed age of open incidents}}{\text{Number of open incidents} \times 24} \).

**Average reassignment of open incidents**

The average number of times currently open incidents have been reassigned. This indicator is shown as 'Average re-assignment times' in the Process by State tab. The score is calculated according to the formula \( \frac{\text{Summed re-assignment of open incidents}}{\text{Number of open incidents}} \).

**Average age of last update of open incidents**

How long on average it has been since the last update to one of the currently open incidents, in days. The score is calculated according to the formula \( \frac{\text{Summed age of last update of open incidents}}{\text{Number of open incidents} \times 24} \).

The following indicators are not shown directly on the dashboard but are used in calculating formulas:

- Summed age of open incidents
- Summed re-assignment of open incidents
- Summed age of last update of open incidents

**Breakdowns**

- Priority
- Category
- Assignment Group
- State

**Open Incident State Monitor dashboard**

View average age and number of reassignments and breakdown incidents in the New, In Progress, and On Hold states.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Manager: Needs to know how the incident management process is doing so they can plan for the future.</td>
<td>itil</td>
</tr>
</tbody>
</table>

**Indicators**

**Number of open incidents**

Daily count of the number of incidents that do not have a resolution date. This indicator is used as the basis of several other indicators on this dashboard.

**Average age of open incidents**
The average age in days in which an incident has been open. The score is calculated according to the formula \[
\frac{\text{Summed age of open incidents}}{\text{Number of open incidents} \times 24}
\].

**Average reassignment of open incidents**

The average number of times currently open incidents have been reassigned. This indicator is shown as 'Average re-assignment times' in the Process by State tab. The score is calculated according to the formula \[
\frac{\text{Summed re-assignment of open incidents}}{\text{Number of open incidents}}
\].

**Average age of last update of open incidents**

How long on average it has been since the last update to one of the currently open incidents, in days. The score is calculated according to the formula \[
\frac{\text{Summed age of last update of open incidents}}{\text{Number of open incidents} \times 24}
\].

**% of incidents not updated in last 5 days**

The percentage of currently open incidents that have not been updated for the last five days. The score is calculated according to the formula \[
\frac{\text{Number of open incidents not updated in last 5 days}}{\text{Number of open incidents}} \times 100
\].

The following indicators are not shown directly on the dashboard but are used in calculating formulas:

- Summed age of open incidents
- Summed re-assignment of open incidents
- Summed age of last update of open incidents
- Number of open incidents not updated in last 5 days

**Breakdowns**

- Priority
- Category
- Assignment Group
- State

**Open Incidents Reports dashboard**

View the current information about open incidents as a list, or as a heatmap or pivot table organized by breakdown.
Tabs of the Open Incidents Reports dashboard

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
</table>

Use case

Interactive filters

- Priority
- Category
- Assignment Group
- State
- Age
### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Incidents List</td>
<td>List</td>
<td>List of all incident records for open incidents</td>
</tr>
<tr>
<td>Open Incidents Pivot</td>
<td>Pivot</td>
<td>Table that lets you explore open incidents by combinations of state, assignment group, category, priority, and age.</td>
</tr>
<tr>
<td>Open Incidents Heatmap</td>
<td>Heatmap</td>
<td>Heatmap that lets you explore the number of open incidents by combinations of state, assignment group, category, priority, and age.</td>
</tr>
</tbody>
</table>

### Incident SLA Management Analytics and Reporting Solutions

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can use Performance Analytics for your application with minimal setup. You can also create your own objects.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.
Note: Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure Analytics and Reporting Solutions.

To enable the solution for Incident SLA Management, an admin can navigate to Performance Analytics > Guided Setup. Click Get Started then scroll to the section for Incident SLA Management. The guided setup takes you through the entire setup and configuration process.

The dashboards in this content pack are inactive when installed. Complete configuration and run data collection jobs before you activate these dashboards. You can activate dashboards in Dashboard Properties, accessible from the context menu. You have to assign an owner to the dashboard to activate it. For more information about configuring Analytics and Reporting Solutions, see Configure Analytics and Reporting Solutions.

Inactive dashboards

Some dashboards in this content pack are inactive when installed. Complete configuration and run data collection jobs before you activate these dashboards. You can activate dashboards in Dashboard Properties, accessible from the context menu. You have to assign an owner to the dashboard to activate it. For more information about configuring Analytics and Reporting Solutions, see Configure Analytics and Reporting Solutions

Related information

Analytics and Reporting Solutions
Activate your Performance Analytics subscription

Incident SLA Management dashboard

See how well the incidents that are subject to a Service Level Agreement meet the deadlines of those SLAs.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Manager who is responsible for seeing that incident resolution meets the service level agreements.</td>
<td>sla_manager, and pa_viewer for the Incident SLA Assignment tab</td>
</tr>
</tbody>
</table>

Use case

Indicators

**Number of open and overdue incidents**

The number of open incidents with the following characteristics:

- Related to an SLA task of type 'SLA' (contract_sla.type)
- Not in stage 'Cancelled' (task_sla.stage)
- The amount of time taken to work on the task is over the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value more than 100%.
Number of open incidents that should be resolved in time

The number of open incidents with the following characteristics:

- Related to an SLA task of type 'SLA' (contract_sla.type)
- Not in stage 'Cancelled' (task_sla.stage)

% open and overdue incidents

The percentage of open incidents that are overdue. The score is calculated according to the formula

\[
\left( \frac{\text{Number of open and overdue incidents}}{\text{Number of open incidents that should be resolved in time}} \right) \times 100
\]

Number of incidents resolved in time

The number of SLA tasks related to an incident with the following characteristics:

- The resolution date (incident.resolved_at) is the date that the score is collected.
- The type is 'SLA' (contract_sla.type).
- The stage is not 'cancelled' (task_sla.stage).
- The amount of time taken to close the task is under the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value less than or equal to 100%.

Number of incidents resolved that should have been resolved in time

Number of incidents resolved that should have been resolved in time is measured daily as unit #.

The goal for this indicator is to maximize.

The score is the COUNT DISTINCT on the data source Incidents.SLA.Resolved, which is using the table Incident SLA [incident_sla] with the following conditions:

- The resolution date (incident.resolved_at) is the date that the score is collected.
- The type is 'SLA' (contract_sla.type).
- The stage is not 'cancelled' (task_sla.stage).

% incidents resolved in time

The percentage of resolved incidents that were resolved in time.

The score is calculated according to the formula

\[
\left( \frac{\text{Number of incidents resolved in time}}{\text{Number of incidents resolved that should have been resolved in time}} \right) \times 100
\]
incidents resolved in time]) / [([Number of resolved incidents that should be resolved in time])] * 100.

**Average Resolution Time In Hours For Resolved Incident SLA Tasks**

The score is calculated according to the following formula:

\[
\frac{\text{Summed duration time of resolved incident SLA tasks in hours}}{\text{Total resolved Incident SLA tasks}}
\]

**Total resolved Incident SLA tasks**

The score is the COUNT on the data source Incidents.SLA.Resolved, which is using the table Incident SLA [incident_sla] with the following conditions:

- The resolution date (incident.resolved_at) is the date that the score is collected.
- The type is 'SLA' (contract_sla.type).
- The stage is not 'cancelled' (task_sla.stage).

**Number of incident assignments responded to in time**

The number of SLA tasks related to an incident with the following characteristics:

- The close date (task_sla.end_time) is the date that the score is collected.
- The type is 'OLA' (contract_sla.type), meaning that it is a response task.
- The stage is not 'cancelled' (task_sla.stage).
- The amount of time taken to close the task is under the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value less than or equal to 100%.

**Number of incident assignments that should have been responded to in time**

The number of SLA tasks related to an incident with the following characteristics:

- The close date (task_sla.end_time) is the date that the score is collected.
- The type is 'OLA' (contract_sla.type), meaning that it is a response task.
- The stage is not 'cancelled' (task_sla.stage).

**Number of open and overdue incident assignments**
The number of SLA tasks related to an incident with the following characteristics:

- The type is 'OLA' (contract_sla.type), meaning that it is a response task.
- The stage is not 'cancelled' (task_sla.stage).
- The amount of time taken to work on the task is over the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value more than 100%.

**Number of open incident assignments that should be responded to in time**

The number of open incidents related to an SLA task with the following characteristics:

- The type is 'OLA' (contract_sla.type), meaning that it is a response task.
- The stage is not 'cancelled' (task_sla.stage).
- The response task is still open.

**% incident assignments responded to in time**

The percentage of response tasks that were responded to within the SLA limit. The score is calculated according to the following formula: \( \left( \frac{\text{Number of incident assignments responded to in time}}{\text{Number of incident assignments that should have been responded to in time}} \right) \times 100. \)

**% open and overdue incident assignments**

The percentage of open incident assignments that are overdue according to the SLA limit. The score is calculated according to the following formula: \( \left( \frac{\text{Number of open and overdue incident assignments}}{\text{Number of open incident assignments that should be responded to in time}} \right) \times 100. \)

The following indicator is used to calculate formulas but is not displayed directly on the dashboard:

**Summed duration time of resolved incident SLA tasks in hours**

This indicator sums the results of a script run on the Incident SLA [incident_sla] table that calculates the time it took for an incident SLA task to be resolved.
Breakdowns

- State
- Priority
- Category
- Assignment Group
- Task SLA Breached Status

Overdue by State dashboard

This dashboard lets you see incidents that are overdue according to an SLA, divided by the New, In Progress, and On Hold states. You can see the average age of the incidents, the average number of times they have been reassigned, and how long on average since the last update. You can also group them by standard breakdowns like Priority and Assignment Group.

This dashboard is inactive by default. Before using this dashboard, a Performance Analytics administrator or power user must open the Dashboard Properties, assign an owner, and select Active.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Manager who is responsible for seeing that incident resolution meets the service level agreements.</td>
<td>sla_manager</td>
</tr>
</tbody>
</table>

Indicators

**Number of open and overdue incidents**

The number of incidents on the Incident.SLA.Open indicator source with the following characteristics:

- Related to an SLA task of type 'SLA' (contract_sla.type)
- Not in stage 'Cancelled' (task_sla.stage)
- The amount of time taken to work on the task is over the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value more than 100%.

**Average age open and overdue incidents**

The score is calculated according to the following formula:

\[
\frac{\text{[Summed age of open and overdue incidents]}}{\text{[Number of open incidents that should be resolved in time]}}
\]

**Average reassignments of open and overdue incidents**

The score is calculated according to the following formula:

\[
\frac{\text{[Summed reassignments of open and overdue incidents]}}{\text{[Number of open and overdue incidents]}}
\]

**Average age of updated since of open and overdue incidents**

The average length of time in days since the last update of open, overdue incidents. The score is calculated according to the following formula:

\[
\frac{\text{[Summed age of updated since of open and overdue incidents]}}{\text{[Number of open and overdue incidents]}} / 24
\]

The following indicators are used to calculate formulas but are not displayed directly on the dashboard:

**Number of open incidents that should be resolved in time**

The number of open incidents with the following characteristics:
- Related to an SLA task of type 'SLA' (contract_sla.type)
- Not in stage 'Cancelled' (task_sla.stage)

**Summed age of open and overdue incidents**
Summed age of open incidents related to an SLA task with the following characteristics:
- Related to an SLA task of type 'SLA' (contract_sla.type)
- Not in stage 'Cancelled' (task_sla.stage)
- The amount of time taken to work on the task is over the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value more than 100%.

**Summed age of updated since of open and overdue incidents**
Sum of hours since the last update of all open and overdue incidents.

**Summed reassignments of open and overdue incidents**
The sum of the Reassignment Count field of all open and overdue incidents.

**Breakdowns**
- State
- Priority
- Age
- Assignment Group
- SLA

**Overdue by Age dashboard**
This dashboard lets you see incidents that are overdue according to an SLA, divided by age buckets. You can see the average age of the incidents, the average number of times they have been reassigned, and how long on average since the last update. You can also group them by standard breakdowns like Priority and Assignment Group.

This dashboard is inactive by default. Before using this dashboard, a Performance Analytics administrator or power user must open the Dashboard Properties, assign an owner, and select **Active**.
## End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Manager who is responsible for seeing that incident resolution meets the service level agreements.</td>
<td>sla_manager</td>
</tr>
</tbody>
</table>

## Indicators

**Number of open and overdue incidents**

The number of incidents on the Incident.SLA.Open indicator source with the following characteristics:
• Related to an SLA task of type 'SLA' (contract_sla.type)
• Not in stage 'Cancelled' (task_sla.stage)
• The amount of time taken to work on the task is over the SLA limit, determined by having an elapsed percentage (task_sla.percentage) value more than 100%.

**Average age open and overdue incidents**

The score is calculated according to the following formula:

\[
\frac{\text{Summed age of open and overdue incidents}}{\text{Number of open incidents that should be resolved in time}}
\]

**Average reassignments of open and overdue incidents**

The score is calculated according to the following formula:

\[
\frac{\text{Summed reassignments of open and overdue incidents}}{\text{Number of open and overdue incidents}}
\]

**Average age of updated since of open and overdue incidents**

The average length of time in days since the last update of open, overdue incidents. The score is calculated according to the following formula:

\[
\frac{\text{Summed age of updated since of open and overdue incidents}}{24}
\]

**Breakdowns**

• State
• Priority
• Age
• Assignment Group
• SLA

**Overdue Reports dashboard**

See the currently open incidents that are subject to an SLA. You can view a list of the incidents or see how they break down in a heatmap or a pivot table.

This dashboard is inactive by default. Before using this dashboard, a Performance Analytics administrator or power user must open the Dashboard Properties, assign an owner, and select **Active**.
### Overdue List tab

<table>
<thead>
<tr>
<th>Number</th>
<th>Short description</th>
<th>Priority</th>
<th>State</th>
<th>Assignment group</th>
<th>Assigned to</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC000003</td>
<td>Need help with Remedy, Can we configure list?</td>
<td>1 - Critical</td>
<td>In Progress</td>
<td>(empty)</td>
<td>David Loo</td>
<td>Inquiry / Help</td>
</tr>
<tr>
<td>INC000004</td>
<td>Page hangs while trying to query a record in Workday Payroll</td>
<td>3 - Moderate</td>
<td>Now</td>
<td>HR Systems Support</td>
<td>Rental Sarnien</td>
<td>Software</td>
</tr>
<tr>
<td>INC000005</td>
<td>Application response time is poor when performing any action in Workday World...</td>
<td>2 - High</td>
<td>In Progress</td>
<td>HR Systems Support</td>
<td>Chad Arata</td>
<td>Software</td>
</tr>
<tr>
<td>INC000006</td>
<td>Getting automatically logged out from Workday Human Capital Management</td>
<td>2 - High</td>
<td>In Progress</td>
<td>HR Systems Support</td>
<td>Charity Dvulikan</td>
<td>Software</td>
</tr>
<tr>
<td>INC000007</td>
<td>Getting automatically logged out from Workday Human Capital Management</td>
<td>2 - High</td>
<td>In Progress</td>
<td>HR Systems Support</td>
<td>Charity Dvulikan</td>
<td>Software</td>
</tr>
<tr>
<td>INC000008</td>
<td>Application response time is poor when performing any action in Workday World...</td>
<td>2 - High</td>
<td>New</td>
<td>HR Systems Support</td>
<td>Chad Arata</td>
<td>Software</td>
</tr>
<tr>
<td>INC000009</td>
<td>Please grant me additional roles in Sales Force Automation</td>
<td>4 - Low</td>
<td>Closed</td>
<td>Technical Services Support</td>
<td>Appliance Schumterm</td>
<td>Software</td>
</tr>
<tr>
<td>INC000010</td>
<td>Request for a new service</td>
<td>3 - Moderate</td>
<td>In Progress</td>
<td>Service Desk</td>
<td>Howard Johnson</td>
<td>Inquiry / Help</td>
</tr>
</tbody>
</table>
### Overdue Pivot tab

#### Overdue Incidents Pivot

<table>
<thead>
<tr>
<th>State</th>
<th>Category</th>
<th>1 - Critical</th>
<th>2 - High</th>
<th>3 - Moderate</th>
<th>4 - Low</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>▼ New</td>
<td>Total</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Software</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>▼ In Progress</td>
<td>Total</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Inquiry / Help</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Software</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>▼ Closed</td>
<td>Total</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Software</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Count</td>
<td></td>
<td>1</td>
<td>4</td>
<td>2</td>
<td>1</td>
<td>8</td>
</tr>
</tbody>
</table>
**Overdue Heatmap tab**

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Manager who is responsible for seeing that incident resolution meets the service level agreements.</td>
<td>sla_manager</td>
</tr>
</tbody>
</table>

**Reports**

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overdue list</td>
<td>List</td>
<td>List of all incident records for overdue open incidents</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Overdue pivot</td>
<td>Pivot</td>
<td>Table letting you explore the number of open and overdue incidents by any combination of state, assignment group, category, and priority, for any age bucket or for all ages.</td>
</tr>
<tr>
<td>Overdue heatmap</td>
<td>Heatmap</td>
<td>Heatmap letting you explore the number of open and overdue incidents by any combination of state, assignment group, category, and priority, for any age bucket or for all ages.</td>
</tr>
</tbody>
</table>

**Domain separation and Incident Management**

Domain separation is supported in Incident Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Standard**

- Includes **Basic** level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.
Overview

- The goal of Incident Management is to restore normal service operation as quickly as possible, while minimizing impact to business operations and ensuring quality is maintained.

- Typically, end users log incidents when a service they are using is impacted or not available. ITIL / Fulfiller users in your organization classify these incidents, route them as appropriate and work on resolving the incident.

- The incident and incident task tables support domain separation. Therefore, a Fulfiller sees only incidents or incident tasks that have been created within the (tenant) domain that they belong to.

How domain separation works in Incident Management

Fulfillers see only incidents and incident tasks that have been created within the (tenant) domain that they belong to.

Domain separated tables

- Incident [incident]
- Incident Task [incident_task]

Use cases

- An ESS user belonging to “Initech” domain, creates an incident. Only those ITIL users belonging to “Initech” domain or global domain can see this incident.

- An ITIL user belonging to a parent domain can see incidents of all its child domains as well.

- An ITIL user belonging to a specific domain can create incidents only on behalf of the domains that they have access to.

- An ITIL user can associate child incidents only of those domains that they have access to.

- If a user has access to multiple domains, the domain specified on the current record drives the functionality of that record and reference fields.

Related information

Domain separation for service providers

Major incident management

A major incident (MI) is an incident that results in significant disruption to the business and demands a response beyond the routine incident management
process. Major incidents have a separate procedure with shorter timescales and urgency that is required to accelerate resolution process for incidents with high business impact.

The definition of what constitutes a major incident must be determined and agreed upon. For example, a major incident can be created if a critical business service is impacted or if there is a service outage that affects a large number of users.

There are multiple ways to create a major incident candidate. You can:

- Propose an incident as a major incident candidate by clicking Propose Major Incident from the context menu of the Incident form.
- Create a new major incident candidate by clicking Create Major Incident Candidate from the left navigation pane.
- Mark an incident as a major incident candidate based on the major incident trigger rules.

As a major incident manager, you can:

- Promote a candidate to a major incident by clicking Promote to Major Incident from the context menu.
- Create a new major incident by clicking Create Major Incident from the left navigation pane.
- Promote an incident to a major incident without going through the proposal process.

Crucial things in responding to a major incident are to involve right resources, communicate updates to users and stakeholders, setup conference calls to investigate and resolve the incident, and escalate when required. Using Task Communications Management, you can define communication plans that are associated with a major incident based on pre-defined conditions. Incident communication plans and related communication tasks are created for a major incident based on the communication plan definitions. Thereafter, tasks get executed as defined in the attached incident communication.

**Major Incident Management process**

A major incident is a highest-impact, highest-urgency incident that affects a large number of users, depriving the business of one or more crucial services. Given the urgency of the situation, a well-coordinated response process is required to accelerate the resolution and minimize the business impact.

The goal of an organization is to have an effective and efficient system for responding to major incidents. The requirements are to:
• Minimize the impact of service interruptions.

• Ensure that an appropriate Incident Manager/Major Incident Team/Management Group are in place to manage a major incident.

• Ensure that stakeholders are well-informed of service interruptions, degradations, and resolutions.

• Conduct a review of each major incident once service is restored. Its purpose is to analyze the incident, and understand what can be done to prevent a similar incident in the future. This review also provides an opportunity to evaluate the incident response process and identify areas for improvement.

• Create a problem for root cause analysis.

Keeping the goals in mind, a major incident management process can be broadly classified into the following phases:

Identification

The first step in the process is to identify a potential major incident. A potential major incident can be identified automatically based on trigger rules or an existing incident can be proposed as a major incident candidate. These incidents are classified as major incident candidates and are reviewed by major incident managers who initiate the major incident response process.

Communication and Collaboration

Timely communication during a major incident is crucial to ensure that the IT teams, business stakeholders, end users, and customers are informed about the impact and progress of the incident. An occurrence of a major incident requires a comprehensive communication plan that includes who is contacted, the methods and frequency of communication, messaging, and so on. The communication plan enables the incident response team to focus their efforts on the resolution process and sets expectations for any future communications.

You can define one or more communication plans based on the type, priority of the incident, or the target audience. For example, communication plans for a P1 major incident could have more frequent communication than a communication plan for a P2 major incident.

Throughout the life cycle of the major incident, notifications and status updates are sent to the stakeholders to keep them informed and involved.

Resolution
In this phase, the agreed upon path to resolution is followed to resolve the issue. Resolving a major incident resolves all associated child incidents, and the individual callers receive a notification about incident resolution.

**Post incident review**

This is the final phase of a major incident life cycle. After the major incident is resolved, a post-incident review is conducted. Its purpose is to analyze the incident and understand what can be done to prevent a similar incident in the future. This review also provides an opportunity to evaluate the incident response process and identify areas for improvement.

To streamline the process, a post-incident report is created when an incident is resolved. The post-incident report can be reviewed and updated during the review process before it is shared with stakeholders.

A major incident progresses through different states during its life cycle. The following diagram illustrates the different states involved in a major incident management:

**Major Incident Management state flow**

**Major Incident Management plugins**

You can activate the Major Incident Management plugins if you have the admin role.
Activate Incident Management - Major Incident Management

You can activate the Incident Management - Major Incident Management plugin (com.snc.incident.mim) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task
Incident Management - Major Incident Management plugin (com.snc.incident.mim) must be manually activated for new and existing customers.

Incident Management - Major Incident Management plugin activates these related plugins if they are not already active:
- Incident Communications Management (com.snc.iam)
- Incident Updates (com.snc.incident.updates)
- Task-Outage Relationship (com.snc.task_outage)

Optional plugins for Incident Management - Major Incident Management

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notify [com.snc.notify]</td>
<td>Provides platform features for workflow-driven voice calls, conference calls, and SMS messages. Requires the Twilio Direct Driver and a separate contract with Twilio for SMS and Voice capabilities.</td>
</tr>
<tr>
<td>Note: Existing users already using Twilio Driver need to migrate to Twilio Direct Driver.</td>
<td></td>
</tr>
<tr>
<td>On-Call Scheduling [com.snc.on_call_rotation]</td>
<td>Provides the ability to create on-call schedules and escalation trees. When an incident is created, dynamically route the escalation to an on-call resource. On-Call Scheduling enables you to configure and build different on-call schedules per process and assignment group.</td>
</tr>
</tbody>
</table>

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

⚠ **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Related information**

- Major incident management
- Major incident overview (dashboard)
- Major incident workbench
- List of Rome plugins

**Components installed with Incident Management - Major Incident Management**

Several types of components are installed with activation of the Incident Management - Major Incident Management plugin, including tables and user roles.

⚠ **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available for this feature.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major incident manager</td>
<td>A major incident manager can:</td>
<td>This role inherits the ia_admin role.</td>
</tr>
<tr>
<td>[major_incident_manager]</td>
<td>• Initiate the major incident process by assessing and approving major incident candidates or creating a major incident.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Reject a major incident candidate.</td>
<td></td>
</tr>
</tbody>
</table>
Role title [name] | Description | Contains roles
---|---|---

- Demote a major incident after it is accepted so that the incident can be handled as a regular incident.
- Maintain the ownership and accountability for the life cycle of the incident.
- Identifies the users and groups to be involved in the resolution activities.
- Creates adhoc communication plans and tasks.
- Edits a communication plan that is attached to a major incident.
- Close a major incident.

Communications manager [communication_manager] | • Manages communications for major incidents and is responsible for communicating with all stakeholders.
• Creates adhoc communication plans and tasks.
• Edits a communication plan that is attached to a major incident.

This role inherits the ia_admin role.

Incident Manager [incident_manager] (Existing role with added responsibilities) | • Manages incident properties and major incident trigger rules.
• Can create and edit Communication Plan Definitions.

None

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major Incident Trigger Rules [major_incident_trigger_rule]</td>
<td>This table extends the Application File [sys_metadata] table and stores the major incident trigger rules.</td>
</tr>
</tbody>
</table>
Slack notification installed with Major Incident Management

Slack notifications are added with activation of Incident Management – Major Incident Management.

<table>
<thead>
<tr>
<th>Slack notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major Incident Candidate assigned</td>
<td>Notifies Major Incident Management Group when <strong>Major Incident State</strong> changes to <strong>Proposed</strong>.</td>
</tr>
<tr>
<td>IAT conference notification</td>
<td>When conference call is initiated, a slack notification is sent to all the participants of the conference call.</td>
</tr>
</tbody>
</table>

Quick start tests for Major Incident Management

Validate that Major Incident Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

**Major Incident Management**

Major Incident Management quick start tests require activating the Incident Management - Major Incident Management plugin (com.snc.incident.mim).

**MIM: Major Incident Management test suite**

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIM: Create a Major Incident</td>
<td>Test to verify the creation of major incident from the application navigation module.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Create a Major Incident Candidate</td>
<td>Test to verify the <strong>Create a Major Incident Candidate</strong> module from navigation menu.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Create a Major Incident from a Major Incident Candidate</td>
<td>Test to verify the creation of a major incident from a major incident candidate.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Major Incident Candidate creation</td>
<td>Test to verify the creation of a major incident.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
### MIM: Major Incident Management test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>when it matches Major Incident Management trigger rule</td>
<td>candidate when conditions to create a major incident match the major incident management trigger rule.</td>
<td></td>
</tr>
<tr>
<td>MIM: Propose a major Incident (Assignment group empty)</td>
<td>Test to verify auto assignment of major incident candidate when an incident is proposed as a major incident and the <strong>Assignment group</strong> and the <strong>Assigned to</strong> fields are empty.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Propose a major Incident (Assignment group is not empty)</td>
<td>Test to verify the auto assignment of a major incident when an incident is proposed as major incident and the <strong>Assignment Group</strong> and the <strong>Assigned to</strong> fields are not empty.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Promote a candidate to major Incident (Assignment group is empty)</td>
<td>Test to verify auto assignment of major incident when a candidate is promoted to a major incident and the <strong>Assignment Group</strong> is empty.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Promote a candidate to major Incident (Assignment group is not empty)</td>
<td>Test to verify auto assignment of major incident when a candidate is promoted to a major incident and the <strong>Assignment group</strong> is not empty.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
## MIM: Major Incident Management test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIM: Reject a Major Incident Candidate</td>
<td>Test to verify the rejection of a major incident candidate.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Demote a Major Incident</td>
<td>Test to verify whether a major incident gets demoted to an incident.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Major Incident closure</td>
<td>Test to validate the major incident closure functionality.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: State sync up with ICP and ICT</td>
<td>Test is to verify the state sync up with Incident Communication Plan and Incident Communication Task.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: ICP attached to an Incident based on conditions and its state sync up with ICT</td>
<td>Test is to verify Incident Communication Plan attached to an Incident based on defined conditions.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Resolving MI and PIR</td>
<td>Test is to verify resolving a Major Incident and Post Incident Report.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Major Incident workbench layout verification</td>
<td>Test is to verify Major Incident workbench layout verification.</td>
<td>Orlando</td>
</tr>
<tr>
<td>MIM: Verify communication task from MI workbench</td>
<td>Test is to verify communication task from MI workbench.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

To learn more about Major Incident Management, see [Major Incident Management](#).

### Related information

**Quick start tests**
Create trigger rules for major incidents

Create trigger rules to define conditions under which a trigger action is executed. You can create major incident trigger rules to define conditions under which an incident is automatically considered as a major incident candidate.

Before you begin
Role required: incident_manager or admin

About this task
Major incident trigger rules are evaluated asynchronously each time an incident is created or updated provided the following conditions are met:

- Incident record does not have the Parent Incident populated which means that the current incident is not a child incident.
- Major incident is not proposed or accepted.
- Incident is active.

Note: The base system major incident trigger rules are disabled by default.

Procedure
1. Navigate to Major Incidents > Administration > Major Incident Trigger Rules.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the trigger rule.</td>
</tr>
<tr>
<td>Table</td>
<td>Table on which the trigger rule executes.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope of the trigger rule. The trigger rule is available for all applications or for scoped applications.</td>
</tr>
<tr>
<td>Execution Order</td>
<td>The rule with lowest execution order is triggered first. In the following example, the rule with order = 100 is executed first.</td>
</tr>
</tbody>
</table>

Example:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If business criticality of business service is 1-most critical or 2-somewhat critical, Order = 100.</td>
</tr>
<tr>
<td></td>
<td>• If the number of child incidents is greater than 20, then Order = 200.</td>
</tr>
<tr>
<td></td>
<td>• For P1 incident, Order = 300.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If any of the existing trigger rule conditions are met, the incident is considered to be a major incident candidate and verification of the remaining rules is not required. Otherwise, all the rules are verified based on the execution order.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate or deactivate the trigger rule.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Conditions which must be met so that the trigger rule executes.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Working on major incident management**

The section covers topics that help you with a variety of technical concepts related to major incident management such as the different ways to create a major incident, ways to reject a major incident candidate, demote a major incident, or close a major incident.

**Create a major incident candidate**

You can create a major incident candidate in multiple ways. After a major incident candidate is created, the major incident manager evaluates the candidate and decides whether the candidate should be promoted to a major incident.

**Before you begin**

Role required: itil, sn_incident_write, or admin

**About this task**

A major incident manager can accept or reject a major incident candidate.
Procedure
Perform any of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create major incident trigger rules</td>
<td>An incident can be marked as a major incident candidate based on the major incident trigger rules. A major incident manager or an incident manager can Create trigger rules for major incidents to identify major incident candidates automatically.</td>
</tr>
<tr>
<td>Propose an incident as a major incident candidate manually</td>
<td>Manually propose an existing incident to be a major incident candidate by clicking Propose Major Incident from the context menu. You are prompted to enter the reason for proposing the incident as a candidate, and specifying the business impact of the incident.</td>
</tr>
</tbody>
</table>
| Create a candidate from application navigation | a. Create a new major incident candidate by clicking Incident > Major Incidents > Create Major Incident Candidate.  
   b. Fill in the fields and click Submit.                                                                                                   |

Note: The base system major incident trigger rules are disabled by default. A major incident manager or an incident manager needs to activate the trigger rules that define conditions under which an incident is automatically considered as a major incident candidate.

Note: If an incident is in the resolved, closed, or canceled state, the Propose Major Incident option does not appear on the context menu.
Note:
- When an incident is proposed as a major incident candidate, the Major incident state field in the incident form under the Major incident section is changed to Proposed.
- When you create a new major incident from a candidate, a new incident is created and becomes the major incident. The candidate is added as the child of the major incident. To get this behavior, the incident manager needs to set the major incident management property Create major incident from candidate – A new incident is created from a candidate as a major incident. The candidate is associated with the new incident as a child. (sn_major_inc_mgmt.com.snc.incident.mim.major_incident_creation) to Create major incident from candidate.
- System automatically assigns the newly created parent major incident to a user when the On-Call Scheduling plugin (com.snc.on_call_rotation) is activated, a shift is defined for the major incident management group, and a user is available for the on-call shift. If no on-call shift exists, the major incident manager decides the user for the Assigned to field.

Create a major incident
Create a major incident directly or review the candidates and promote the candidates to major incidents.

Before you begin
Role required: major_incident_manager

Procedure
Perform any of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Promote an incident to a major incident manually</td>
<td>On the context menu, click Promote to Major Incident. The incident directly becomes a major incident.</td>
</tr>
</tbody>
</table>
Option | Description
---|---
**Note:**
- Only a major incident manager can promote an incident to a major incident. If an incident is in the resolved, closed, or canceled state, the **Promote to Major Incident** option does not appear on the context menu.
- When an incident is promoted to a major incident, the incident itself is considered as a major incident and no new incident is created.

To get this behavior, you need to set the major incident management property **Create major incident from candidate** – A new incident is created from a candidate as a major incident. The candidate is associated with the new incident as a child. (sn_major_inc_mgmt.com.snc.incident.mim.major_incident_creation to **Promote candidate to a major incident**).

**Create a major incident from application navigation**

a. Click **Incident > Major Incidents > Create Major Incident**.

b. Fill in the fields and click **Submit**.

**Major incident assignment**

A major incident is assigned to a group automatically at the time of proposal and promotion based on the value of the property **Major Incident Management Group (sys_id) to whom the Major Incident should be re-assigned on promotion to 'Major Incident'** (sn_major_inc_mgmt.major_incident_management_group). The assigned group works on the major incident and resolves it.

The incident is assigned to an individual if the On-Call Scheduling plugin (com.snc.on_call_rotation) is activated and a shift is defined for the group. The following table illustrates the different conditions under which a major incident is assigned to a group and a user.
## Assignment of major incident

<table>
<thead>
<tr>
<th>Action</th>
<th>Condition</th>
<th>Assignment group</th>
<th>Assigned to</th>
</tr>
</thead>
</table>
| Incident is proposed as a candidate manually or based on major incident trigger rules | Assignment Group is empty                      | Group based on the property value              | • If on-call is activated, shift is defined and a user is available on-call then the incident is assigned to the on-call user  
• If on-call is not activated, the **Assigned to** field remains empty |
|                                                      | Assignment Group is not empty                   | No change - incident retains the current value of the assignment group                           | No change - incident remains with the current value in the **Assigned to** field                |
| Incident is manually promoted to a major incident    | Assignment Group is empty                       | Group based on the property value              | The value for the **Assigned to** field is the user who promoted the incident to a major incident |
### Assignment of major incident (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Condition</th>
<th>Assignment group</th>
<th>Assigned to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major incident is created</td>
<td>Assignment Group is empty</td>
<td>Group based on the property value</td>
<td>The value of the <strong>Assigned to</strong> field is the user who has created the major incident</td>
</tr>
<tr>
<td>Assignment Group is not empty</td>
<td>No change - incident retains the current value of the assignment group</td>
<td>No change - incident remains with the current value in the <strong>Assigned to</strong> field</td>
<td></td>
</tr>
</tbody>
</table>

### Assignment of incident communication plan and communication task

<table>
<thead>
<tr>
<th>Action</th>
<th>Condition</th>
<th>Assignment group</th>
<th>Assigned to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident communication plan is created with source as major incident</td>
<td>Assignment Group is empty</td>
<td>The value for the <strong>Assignment group</strong> field is copied from the source incident</td>
<td>The value of the <strong>Assigned to</strong> field is copied from the source incident</td>
</tr>
<tr>
<td>Assignment Group is not empty</td>
<td>No change - incident communication plan retains the current value of the assignment group</td>
<td>No change - incident communication plan retains the current value of the <strong>Assigned to</strong> field</td>
<td></td>
</tr>
</tbody>
</table>

| Incident communication task is created from incident communication plan whose | Assignment Group is empty        | The value for the **Assignment group** field is copied from the incident communication plan | The value of the **Assigned to** field is copied from the incident communication plan |
Assignment of incident communication plan and communication task (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Condition</th>
<th>Assignment group</th>
<th>Assigned to</th>
</tr>
</thead>
<tbody>
<tr>
<td>source is major incident</td>
<td>Assignment Group is not empty</td>
<td>No change - incident communication plan retains the current value of the assignment group</td>
<td>No change - incident communication task retains the current value of the Assigned to field</td>
</tr>
</tbody>
</table>

Accept or reject a major incident candidate

When an incident is proposed as a major incident candidate, a major incident manager can accept or reject the candidate. The manager accepts a candidate as a major incident if the incident requires accelerated resolution.

Before you begin
Role required: major_incident_manager

Procedure
Perform any of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept a major incident candidate</td>
<td>a. Navigate to Incident &gt; Major Incidents &gt; Candidates and open the candidate to be approved.</td>
</tr>
<tr>
<td></td>
<td>b. Click the additional actions icon and select Promote to Major Incident.</td>
</tr>
</tbody>
</table>

Note:
- While promoting the candidate, the major incident manager is prompted to enter work notes and business impact.
- The incident is promoted to a major incident, and the Major incident state field under the Major incident section is changed from Proposed to Accepted.
- The incident is assigned to the user who approves the major incident.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Reject a major incident candidate | **a.** Navigate to Incident > Major Incidents > Candidates and open the candidate to be rejected.  
  **b.** Click the additional actions menu icon and select Reject Major Incident Candidate. |

**Note:**
- While rejecting the candidate, the major incident manager is prompted to enter the reason for rejecting the candidate. A notification is sent to the user in the Assigned to field.
- The state of the incident remains the same while the Major incident state field is changed to Rejected.

**Associate multiple incidents with a major incident**

You can associate one or more incidents with a major incident using the Actions menu.

**Before you begin**
Role required: itil, sn_incident_write, or admin

**About this task**
When a major incident occurs, there are usually multiple incidents created for the same issue and there might be multiple major incident candidates created for a single issue. All the incidents for a single issue can be associated with the appropriate major incident.

**Procedure**
1. Navigate to Incident > Open.
2. Select the incidents that need to be associated with a major incident.
3. On the Actions menu, click Link to Major Incident.
4. In the Choose a Major Incident dialog box, select the major incident with which you want to associate the incidents.

5. Click OK.
   The incidents are added as a child to the major incident.

**Reject multiple major incident candidates using the Actions menu**

You can reject one or more major incident candidates using the Actions menu. If you decide that the candidates do not qualify to be major incidents, then you can reject multiple candidates at once and provide the rejection reason.

**Before you begin**
Role required: major_incident_manager

**Procedure**

1. Navigate to Incident > Major Incidents > Candidates.
2. Select the candidates that you need to reject.
3. On the Actions menu, click **Reject Major Incident Candidate**.
4. On the Rejection Reason dialog box, enter the reason why you decided not to accept the candidates as major incident.

5. Click **Reject**.
   The major incident candidates are rejected.

**Demote a major incident**

When an incident is incorrectly evaluated to be a major incident, you can demote the major incident even after it is accepted so that the incident can be handled as a regular incident.

**Before you begin**

Role required: major_incident_manager

**Procedure**

1. Navigate to **Major Incidents > Open**.
2. Open the major incident that you want to demote.
3. Click the additional actions icon and select **Demote Major Incident**.
4. Enter the reason for the demotion.
   The major incident state is set to **Canceled** but the incident state remains the same.

**Close a major incident**

You can close a major incident manually after validating the resolution and when the major incident is in the **Resolved** state.
Before you begin

- Role required: major_incident_manager or admin
- Major incident is in resolved state

Procedure

1. Navigate to **Major Incidents > Open**.
2. Open the major incident that you want to close.
3. Click **Close Incident**.

**Note:**

- If you cancel an incident and the major incident state is in **Proposed** or **Accepted** state, the major incident state changes to **Canceled**.
- The incident auto-closure property **Enable auto closure of incidents based on Resolution date**. Setting this to ‘No’ will make auto closure to run based on the **Updated date** does not close any incident record that is accepted as a major incident. Users with the major_incident_manager or admin role must close a major incident manually, after validating the resolution and when the major incident is in the **Resolved** state.
- If an incident was promoted as a major incident, then an ESS user cannot resolve, close, or reopen the incident.

View major incident information on the Incident form

When an incident enters the major incident life cycle, the **Major Incident** and the **Post Incident Report** tab appears on the incident form.

Before you begin

Role required: admin

Incident is in the major incident life cycle.

Procedure

1. Navigate to **Incident > Open**.
2. Click the **Major Incident** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major incident state</td>
<td>A major incident state can be one of the following:</td>
</tr>
</tbody>
</table>
### Field Description

- **Proposed**: The initial state when a major incident candidate is created or proposed.
- **Accepted**: The state when a major incident is directly created by a major incident manager or when a candidate is promoted to a major incident by a major incident manager.
- **Rejected**: The major incident candidate is rejected by a major incident manager.
- **Canceled**: The major incident is demoted by a major incident manager.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proposed by</td>
<td>The user who proposed the incident as a major incident candidate.</td>
</tr>
<tr>
<td>Proposed</td>
<td>Date and time when the incident was proposed as a major incident candidate.</td>
</tr>
<tr>
<td>Promoted by</td>
<td>The user who promoted the incident to a major incident.</td>
</tr>
<tr>
<td>Promoted</td>
<td>Date and time when the incident was promoted to a major incident.</td>
</tr>
<tr>
<td>Business impact</td>
<td>The business impact of the issue identified in the major incident.</td>
</tr>
<tr>
<td>Probable cause</td>
<td>The probable cause of the issue identified in the major incident.</td>
</tr>
</tbody>
</table>

3. **Click the Post Incident Report tab.**

   If you have already filled the post incident report information in the major incident workbench, the same information appears in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Summary of the incident.</td>
</tr>
<tr>
<td>Findings</td>
<td>Information on what caused the major incident and any lessons learnt in the process.</td>
</tr>
</tbody>
</table>
### Timeline

Information of all the activity feeds not only of the incident but also of the incident communication plan and incident communication tasks related to the incident.

### Major incident workbench

The major incident workbench is a single pane view designed for major incident managers, communication managers, and resolver groups. The workbench helps to manage major incidents by aggregating and providing actionable information.

To navigate to the major incident workbench, open a major incident or a major incident candidate, and click **View Workbench** on the form header.

ℹ️ **Note:** Groups and number of members involved in the groups widget are populated from the **Assignment group** and the **Assigned to** fields of incident, incident communication plan, incident task, as well as the members involved in an active conference call.
**Header components**

- From the workbench, to navigate back to the incident form, click View Form that appears on the header of the workbench.

- If an incident is not yet in the Resolved state, then the header displays the Resolve button. To resolve an incident, click Resolve.

- When an incident is not yet accepted as a major incident, then the workbench displays a choice list on the header. The list displays options to promote the incident to a major incident or to reject the incident.

- Use the chat icon ( ) on the header to initiate a chat on the incident level. The chat is a record feed — whatever you write in the chat appears in the activity stream.

- You can click to change the state of the incident.

- Duration is an active timer that tracks the time since the creation of the incident. The timer stops when the incident is resolved.

**Major incident workbench UI elements**

The major incident workbench provides UI elements which display the summary of tasks, progress of communication plan, conferencing information, and a report on the cause and resolution of the major incident.

The major incident workbench has the following UI elements: Summary, Communicate, Collaborate, and Post Incident Report.

ℹ️ **Note:** You need to activate the Notify plugin (com.snc.notify) for the Collaborate tab to appear. The Post Incident Report tab is visible only when the incident state is either Resolved or Closed.

**Major Incident workbench — Summary tab**

The Summary tab provides a unified view of information in the form of a card layout. The information on impacted services, affected CIs, active outages, locations that are impacted, and child incidents helps to keep you informed about related records associated with an incident.
Summary tab

View of the summary tab

You can add, create, or edit each of the components. You can also view, post, or filter the latest activity on the major incident.

The tab also provides a quantitative summary of the active and completed tasks, as well as users or groups who are involved in resolving the major incident. The communication tasks are sorted in ascending order based on the order value.

The **Time remaining** column provides information regarding the time when the communication task is due.

- If you do not perform the communication task within the set time, the value changes to **Overdue**.
- If you activate the On-call Scheduling plugin (com.snc.on_call_rotation): The user who is on-call for the respective group and the group name appear in the summary.

The **Groups** section displays On-Call information, including the On-Call Escalation Tracking icon ( ), that indicates the active status of the escalation. Green indicates an active escalation, and black indicates a finished escalation. Click the icon to view the On-Call Escalation Tracking pop-up.
Activate the Event Management plugin (com.glideapp.itom.snac) to add an Alert card under the Summary tab that keeps you up-to-date on the number of alerts for each incident. The count is the total of all primary and secondary alerts for the incident.

**Major Incident workbench — the Post Incident Report tab**

The Post Incident Report tab helps you to understand the cause of the major incident, and the actions taken by the teams to resolve the incident.

The teams can assess the incident response and resolution process and determine follow-up action items. The post incident report is required to record the actions performed, the reasons for doing them, and findings.

ℹ️ **Note:** The major incident manager can edit a report when the incident is in the Resolved state.

### View of the Post Incident Report tab

The post incident report includes the following sections where a major incident manager can provide required information:

- **Overview:** Summary of the incident.
- **Findings:** Information on what caused the major incident and any lessons learned in the process.
- **Resolution:** Information on the resolution steps taken to resolve the issue. The major incident manager can also add or edit any related Problem or Change information by clicking Add or Manage respectively.
- **Timeline:** Information of all the activity feeds, not only of the incident but also of the incident communication plan and incident communication tasks related to the incident. You can update the timeline with the latest activity by clicking Regenerate Timeline.

ℹ️ **Note:** The information that you provide for Overview, Findings, and Timeline gets updated in the Post Incident Report section on the Incident form.
If you activate the Continual Improvement Management (CIM) plugin (com.sn_cim), the Related Improvement Records section is displayed in the report. This section displays the Inbound CIM Integrations records.

When you click **View Complete Report**, all the information entered by the major incident manager is compiled together and you can download the report in the .PDF format by clicking **Download Report PDF**.

The following links appear in the Incident form under the Related Links section:

- **Regenerate PIR Timeline**: This link appears when incident is in the **Resolved** state and the user has the major_incident_manager role.
- **Preview PIR**: This link appears when incident is in the **Resolved** or **Closed** state and the user has the itil role.

**Note:** On the downloaded report, under **Incident Response Timeline**, the time displayed in the timing type **Time to Identify** is calculated in the following ways:

- If you propose the incident as a major incident: The time indicates the time from creation of the first related alert for this incident or creation of the incident (in case there is no alert or the Event Management plugin is inactive), whichever occurs first, until the time the incident is first proposed as a major incident.
- If you create a major incident directly: The time indicates the time from creation of the first related alert for this incident or creation of the incident (in case there is no alert or the Event Management plugin is inactive), whichever occurs first, until the time the incident is promoted as a major incident.

**Related information**

**Associate a new post incident report**

**Major Incident workbench — the Communicate tab**

The **Communicate** tab helps you understand the progress of communication plan and its related tasks.

If there are multiple communication tasks associated with a communication plan, all the tasks appear under the respective communication plan.
Communication task filter

You can filter the communication task to view all tasks, active tasks, or completed tasks. You can also add a new communication plan by clicking Add. You can create communication task for an existing plan by clicking Add Task. For more information, see Add communication plan from the major incident workbench. If you want to add or remove recipients from a particular plan after the plan is saved, click Manage Recipients.

Manage recipients

The following actions can be performed on a given communication task:

- Close Task: If the task is performed at least once, closes the communication task and changes the state to Complete else changes the state to Skipped.
- Snooze: Available only for recurring communication task. Allows the user to skip the communication task once and the due-in timer is refreshed.
- View Form: For each task in the plan, you can navigate back to the form.
- View Activity: Allows you to view activity history and post your work notes or additional comments for a communication task.
You can also view the due time of upcoming tasks and the overdue time in case the task is not completed within the expected time.

To send a notification, click **Compose**. If the notification has to be send only once, then after sending the notification, the status of the task changes to **Complete**. If the task is recurring, the status of the task changes to **Open**. After a recurring communication task is performed, the status of the communication task changes to **Sent** followed by the number of times the recurring communication task is performed until that time. For example, Sent(2x) means that the communication task is performed twice.

Icons to the left of the Communication Task name represent the state of the communication task such as completed, skipped, or active.

Under the Work Notes & Activity section, you can initiate a chat at the incident or incident communication plan level. You can also view the activity stream for that record.

**Messaging users through Slack**

For Slack functionality, install **Collaboration services** from ServiceNow® Store.

When you add Slack as a communication channel, it appears as follows:
Click **Compose** to convey the Slack message to the contacts that you have already mentioned in the communication contact while defining the communication plan. The selected contacts will receive a direct message from Slack bot. You can perform the communication task actions such as **Closed Task**, **Snooze**, **View Form**, and **View Activity**.

**Major Incident workbench — the Collaborate tab**

The **Collaborate** tab helps you to view information about communication tasks that have conference as their communication channel. It also allows you to manage the participants in a conference call.

Like the **Summary** tab, you can add a new communication plan by clicking **Add**. You can create communication task for an existing plan by clicking **Add Call**. For more information, see [Add-communication-plan-from-mim-workbench](#). If you want to add or remove recipients from a particular plan after the plan is saved, click **Manage Participants**.
To initiate a conference call, click **Initiate**. If the communication task is a one-time task, then after the call is ended, the status of the task changes to **Complete**. If task is recurring, the status of the task changes to **Open** and it displays the number of times the conference call is initiated.

**Note:** When you add a user group to the conference call, the group itself is added to the call, and the escalation hierarchy is automatically followed once you start the call. Set the `com.snc.iam.conference_call_follow_on_call_escalation` property to true. For more information about the property, see System properties for On-Call Scheduling.

Under each task, the Active participant section displays the active participants and the Inactive participant section displays the inactive participants.

If the call is in progress, the ITIL user, who has access to the workbench, can join the conference call by clicking **Join Call**. The participants can also add another user to an ongoing conference call by clicking **+ Participants**. The conference leader can end the conference call by clicking **End Call**. The conference leader can mute, unmute, or kick an active participant by hovering over the active participant and clicking [ ].

Under the Work Notes & Activity section, you can send connect message at incident or incident communication plan level. You can also view the activity stream.

To initiate a call directly to the group members, click **Start a call**.

To start a call, populate the `sn_major_inc_mgmt.notify_webrtc_number` property with a valid notify number that has voice capability. For user who is already in an
active conference call, Start a call is disabled. You can mute or unmute all the participants using the Mute All and Unmute All options. If you activate the Notify - Twilio Direct Driver plugin (com.snc.notify.twilio_direct), the active participants are highlighted in green.

For information on how to send a Microsoft Teams notification from major incident workbench, see Send mim notification
For information on process flow for slack communication, see Process flow for Slack communication
For information on how to add a collaborative communication task, see Add a collaborative communication task

**Associate a new post incident report**

Create your own post incident report and associate the UI page with the View Complete Report button under the Post Incident Report tab. Using the customized report, you can add information that is specific to your organization.

**Before you begin**

Role required: itil, major_incident_manager, or admin

**About this task**

For associating the View Complete Report button with your customized post incident report page, set the value of the PIR export ui page url major incident property to the new UI page.

**Procedure**

1. Navigate to System UI > UI Pages and click New.
2. Create a UI page.
   For information on how to create a UI page, refer UI pages.
3. Navigate to Incident > Major Incident Properties.
4. In the PIR export ui page url (sn_major_inc_mgmt.pir_export_pdf_ui_page) property, enter the link of the new UI page.
5. Click Save.
   When you click the View Complete Report button, the new UI page opens.

**Add communication plan from the major incident workbench**

You can create a new communication plan or add a new communication task to an existing communication plan from the workbench. This UI action is helpful when you do not have an existing well-defined communication plan in the system.
Before you begin
Role required: major_incident_manager

Procedure

1. Navigate to Major incident workbench.

2. Click the Communications tab and then click Add that appears in Communication Tasks section. The Adhoc Communication pop-up window appears.

3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Plan</td>
<td>List to select a new communication plan or to select an existing plan and add communication tasks to the plan.</td>
</tr>
<tr>
<td>Plan Short description</td>
<td>Brief description of what the communication plan is all about.</td>
</tr>
<tr>
<td>Task Short description</td>
<td>Brief description of what the communication task is all about.</td>
</tr>
<tr>
<td>Channels</td>
<td>Check box to select email, SMS, slack, or conference as mode of communication for the plan.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Frequency at which a specific task needs to be executed. A task can be executed only once or on specific durations.</td>
</tr>
<tr>
<td>Due in (Minutes)</td>
<td>Time span when the task must be executed after the task initiates. For recurring tasks, it also indicates the time span after which the task must repeat.</td>
</tr>
</tbody>
</table>

Add similar incidents from major incident workbench
Add similar incidents to a major incident so that the support teams can work on the parent record for a coordinated response process.

Before you begin
Role required: itil, major_incident_manager, communication_manager, incident_manager, or admin
• Activate the Predictive Intelligence plugin (com.glide.platform_ml).
  ◦ Configure Predictive Intelligence and train the solution definition with the name `ml_sn_global_similar_incidents_mim`. For more information on how to train a solution definition, refer Create and train a similarity solution.

• Ensure that there is an active ML solution at Predictive Intelligence > Similarity > Solutions with the solution name `ml_sn_global_similar_incidents_mim`.

Procedure
1. Navigate to Major incident workbench.
2. Click the Summary tab.

3. In the Child Incidents section, click  and then click Find Similar.

4. From the Add Similar Incidents dialog box, select the similar incidents that you want to relate to the major incident and then click Add Selected. The similar child incidents appear under the Child Incidents section.

Access on-call escalation path from major incident workbench
Access on-call roster and escalation details from major incident workbench to reach out to a support group.

Before you begin
Role required: itil, sn_incident_read, sn_incident_write, major_incident_manager, communication_manager, incident_manager, or admin
Activate the On-Call Scheduling plugin (com.snc.on_call_rotation).

Procedure
1. Navigate to Major incident workbench.
2. Click the Communications tab.
3. Under the Groups section, click On Call Groups.
4. From the list, select a group.
5. Click Roster and Escalation details.
6. In the window, click Escalation path.
   You can access the on-call escalation information.

Major incident overview (dashboard)
Major Incident Overview module provides two versions of the Performance Analytics (PA) Dashboard to review major incident information at a glance.

Users with itil, sn_incident_write, major_incident_manager or communication_manager role can access the dashboard.

The two versions of the Performance Analytics (PA) Dashboard are normal and premium. You must activate the Incident Management - Major Incident Management plugin (com.snc.incident.mim) to view the normal dashboard. To access the premium version of Major Incident Overview dashboard, activate Performance Analytics – Content Pack for Major Incident Management (com.snc.pa.incident.mim).

You can navigate to the dashboard in the following ways:
• Incident > Major Incidents > Overview
• Self – Service > Dashboard > Major Incident Overview

Major incident overview

Major Incident Overview dashboard

Major Incident Overview module provides information on the following content:

<table>
<thead>
<tr>
<th>#</th>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Dashboard controls</td>
<td>Provides options to create, duplicate, or delete a dashboard. You can copy the dashboard URL or duplicate the dashboard. In addition, you can add the dashboard in your favorite list, create a tab, or reset filters in the dashboard.</td>
</tr>
<tr>
<td>2</td>
<td>Dashboard overview</td>
<td>Takes you to the UI page where you view the recently accessed dashboard, dashboards owned or shared by you, or all the dashboards in the system. To create a new dashboard, click <strong>New</strong>.</td>
</tr>
<tr>
<td>3</td>
<td>Dashboard choice list</td>
<td>Provides options to select between different dashboards in the system.</td>
</tr>
<tr>
<td>4</td>
<td>Add widgets</td>
<td>Provides option to add widgets. You can drag to move or resize the widget on the dashboard.</td>
</tr>
<tr>
<td>#</td>
<td>UI component</td>
<td>Description</td>
</tr>
<tr>
<td>----</td>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>5</td>
<td>Sharing</td>
<td>Provides option to specify groups, users, and roles for the dashboard.</td>
</tr>
<tr>
<td>6</td>
<td>Configuration</td>
<td>Provides the configuration pane to select a layout to snap the widgets against or to modify a layout as required.</td>
</tr>
</tbody>
</table>
| 7  | Tabs         | • **Major Incidents Nearing Breach**: Number of active major incidents where the Major incident state is **Accepted** and the response or resolution SLA has reached 75% of the allotted time.  
  
• **Major Incidents Overdue**: Number of active major incidents where the Major incident state is **Accepted** and the response or resolution SLA has breached.  
  
• **Unassigned Major Incidents**: Number of active major incidents where **Assigned to** is empty.  
  
• **Open Major Incidents**: Major incidents which are open and has major incident state as **Accepted**.  
  
• **Major Incidents Opened Today**: Major incident state is **Accepted** and the major incident is created on the current day.  
  
  **Note**: Major incidents opened for that day includes both active and inactive incidents.  
  
• **Major Incidents Resolved Today**: Major incidents that are resolved on the current day and have the state as **Resolved**.  
  
• **Open Major Incidents – Grouped**: You can filter these incidents based on **Group by** and **Stacked by**.  
  
• **Open Major Incidents Older Than 7 Days – Grouped**: You can filter these incidents based on **Group by** and **Stacked by**.  
  
• **Major Incidents by Priority and State** |
<table>
<thead>
<tr>
<th>#</th>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
</table>
| | • Major Incidents by Priority and State Older than 7 Days  
| | • Major Incidents Opened per Week  
| | • Major Incidents Closed per Week |

**Major Incident Overview – Premium**

Major Incident Overview – Premium provides the following additional functions:

- **Process KPIs**: Provides information on **Active Major Incidents**, **Number of resolved major incidents**, **Average resolution time of Major Incidents**, and **New Major Incidents Vs Resolved**.
- Interactive filters: Helps to filter incidents based on category, priority, assignment group, and state.

**Related information**

Create and use dashboards  
Major incident workbench

**Incident Management integrations**

Users of an incident management solution need to have access to a multitude of features so that they can address specific challenges directly. Incident Management integrations aims to fully integrate and automate your incident response system.
Universal Request integration - Incident Management

Incident Management integrates with Universal Request to provide incident related service as unified services to users and to help them have a single service desk.

Install and configure the Universal Request Integration for Incident Management plugin (com.snc.incident.universal_request). The integration provides the following configurations and functionalities:

Incident management integration with Universal Request

- The Universal Request form has the UI action to create an incident. The default fields that are copied from the universal request record to the incident record when a new incident is created are: universal_request, short_description, description, caller_id and opened_by. An incident manager can customize the fields using the system property sn_inc_uni_req.incident.universal_request.copy_fields.
- The Universal Request field appears on the Incident form only when an incident is associated with a universal request record.
- The Routing reason field appears on the incident form when an itil agent routes an incident back to the universal request.
- On the record producer, if you select the Create Universal Request check box, a new incident created from that record producer automatically creates a universal request record. This universal request record is associated with the incident record.

Visibility of Incidents to a requester

- On Platform, incidents that are associated with Universal Request do not appear under the Self-Service > Incidents. Instead, you can access related universal request records under Self-Service > Universal Requests.
- On Service Portal, incidents that are associated with Universal Request do not appear under the Service Portal > Requests. Instead, you can access related universal request records under Service Portal > Requests.

Suppression of email notifications

If any incident is a part of Universal Request, then the notifications sent to the caller from an Incident are suppressed. In all other incident related email notifications, the universal request number is displayed instead of the incident number.
Requester Actions on Service Portal

For Universal Request record that has an incident as its primary task, an Actions widget with the requester actions is displayed. The actions can be Resolve, Reopen, or Close depending on the state of the incident.

Request Universal Request integration for Incident Management

To activate the integration between Incident Management and Universal Request, request the Universal Request: Integration for Incident management plugin (com.snc.incident.universal_request) through the Now Support Customer Service system. This plugin includes demo data and activates related plugins if they are not already active.

Before you begin
Role required: none

About this task
The Universal Request Integration for Incident management plugin activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal Request [com.snc.universal_request]</td>
<td>Enables seamless service experience across different groups and task types.</td>
</tr>
</tbody>
</table>

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the form, fill in the fields.

### Activate Plugin request form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>this plugin to be enabled</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the <strong>Reason/Comments</strong> field.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

**Related reference**

List of plugins (Rome)

**Create incident from Universal Request**

Create an incident from a universal request record to restore service to a customer as soon as possible. After creating the incident record, you can investigate potential solutions.

Before you begin

Role required: routing_agent and ITIL or admin

Activate the Universal Request (sn_uni_req) and the Universal Request Integration for Incident Management (sn_inc_uni_req) plugins.

**Procedure**

1. Navigate to **Universal Requests > All**.
2. Open the universal request record from which you want to create an incident.
3. Click **Create Incident**.
   
   An incident record is created and associated with universal request. The incident record is not saved until you submit the record.

4. Fill in the fields on the **incident form** and click **Submit**.
The universal request number from which the incident is created appears in the **Universal Request** field on the Incident form. The incident number appears in the **Primary Ticket** field and also in the **Associated Tickets** related list of the Universal Request form.

**Transfer incident**

Transfer the back to the Universal Request queue, or to another department with or without resolution. When you realise that the issue is not incident related, transfer the incident without any resolution to the relevant department or service. If you resolve the issue, you can transfer the incident with the resolution.

**Before you begin**

Role required: agent to whom the ticket is assigned to

Associate an incident with a Universal Request record.

**Procedure**

1. Open the incident that you want to transfer.
2. **Click Transfer.**

3. In the **Transfer Ticket** dialog box, provide the following details.

   - **Note:** Based on your transfer type configuration, the given fields are displayed. For more information, see **Universal Request properties**.
     
     - **Action**: Select if the case should be transferred to another department or back to Universal Request
     - **Department**: Select the department from the list.
     - **Service**: Select the specific service of the chosen department.
Note: This field does not appear if you have selected **Transfer to Department** in **Action**

- **Transfer reason**: Select the reason from the list.
- **Transfer notes**: A brief description for routing the primary ticket that you want to pass to the UR Routing agent.
- **Copy additional comments and attachments**: Deselect if you do not want to transfer the ticket with additional comments and attachments. By default, all attachments and comments are transferred.

Note: Work notes are not copied while transferring.

4. Click **Transfer**.

Resolve, reopen, or close incident associated with universal request

Resolve, reopen, or close are actions from the **Incident Actions** widget that is available on the universal request record for the requester. The **Incident Actions** widget is available only when an incident is the primary task of a Universal Request record.

**Before you begin**

Role required: none

Associate an incident with a Universal request.

**Procedure**

1. Navigate to your portal page.
2. Click **Requests**.
3. Open the universal request that is associated with the incident.
4. Perform any of the following actions from the **Actions** widget:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolve</td>
<td>Resolves the incident and updates the state of Universal Request record.</td>
</tr>
<tr>
<td>Reopen</td>
<td>Reopens a closed incident and updates the state of Universal Request record.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Close</td>
<td>Closes an incident and updates the state of Universal Request record.</td>
</tr>
</tbody>
</table>

**Note:** The state of Universal Request record is updated based on the configuration provided on the State Mapping [universal_request_state_mapping] table.

**Customize fields copied from Universal Request to incident**

Customize fields so that the values of some fields in the universal request automatically get copied to an incident record when an incident is associated with a universal request record. It saves your time from manually entering the information every time you create an incident.

**Before you begin**

Role required: incident_manager or admin

**Procedure**

1. In the left navigation pane, enter `sys_properties.list` and press the Enter key.
2. Search and open the system property `sn_inc_uni_req.incident.universal_request.copy_fields`.
3. In the **Value** field enter the universal request and the incident field.

For example, `caller_id=opened_for` means that the value of the field `caller_id` from the universal request form is copied to the `opened_for` field in the incident form.

**Restrict an incident access**

You can restrict an incident ticket that contains sensitive information. By marking an incident as restricted, you limit its access for the agents.

**Before you begin**

Role required: admin or user

**About this task**

Both agents and users can mark an incident as restricted. Users can mark an incident as restricted while creating it. An agent can also mark an incident as restricted while triaging it or while working on it. Cases marked as restricted can only be accessed by
• Routing agents who are part of the assignment group and has sensitive agent role.
• All primary ticket agents.

Procedure
1. Navigate to Incident > All.
2. Open the incident record that you want to restrict.
3. On the form, click Restrict.
   The restricted fields are hidden, and the form is only for view purpose.

  Note: To mark the request as unrestricted only agents with the access role can modify.

4. Click Update.

Creating an incident in Microsoft Outlook
To create incidents and VTB tasks or to chat with a virtual agent from within your Outlook email, activate and deploy the ServiceNow Add-in for Microsoft Outlook feature.

The ServiceNow Add-in for Microsoft Outlook feature lets you engage with IT directly from an email or, for IT users, quickly create an incident from an email and immediately assign it to the correct team. It also lets you create a VTB task.

Activate the ServiceNow Add-in for Microsoft Office
You can activate the ServiceNow Add-in for Microsoft Office plugin (com.sn_outlook_addin) if you have the admin role.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

### Related information

**List of Rome plugins**

#### Deploy the ServiceNow Add-in for Microsoft Outlook

Deploy the ServiceNow add-in for Microsoft Outlook to chat with a virtual agent, create incidents and VTB tasks from within the Microsoft Outlook.

**Before you begin**

In addition to having one of the following roles on the ServiceNow instance, you must be an Office365 administrator to deploy the ServiceNow add-in.

**Role required:** admin, sn_outlook_addin.outlook_addin_setup

**About this task**

Deploy the ServiceNow add-in to Microsoft Outlook using the instructions in this Microsoft article: Publish Office Add-ins using Centralized Deployment via the Office 365 admin center

**Note:** You must be an Office365 administrator to deploy the ServiceNow add-in.

The ServiceNow add-in is only supported for use with Outlook for Mac and Outlook for Windows (Requirement set 1.4).

You can add or remove fields directly on the Incident form for users with the itil role by customizing the Outlook view form layout. For users that do not have the itil role, you can configure a Service Catalog record producer to use for creating new incidents.

**Procedure**

1. Navigate to ServiceNow Add-Ins for Office > Office Add-In Manifests.
2. Click **New** on the Office Manifests page.
3. Fill in the form fields.
## Deploy MS Outlook add-in form fields

<table>
<thead>
<tr>
<th>Add-in Name</th>
<th>A user-friendly name for the add-in. For example, if the add-in needs to be deployed only for administrators, you can choose to name it accordingly.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>A short description of the add-in. For example, if the add-in is for a help desk, you can write a short description accordingly.</td>
</tr>
<tr>
<td>Plugin ID</td>
<td>A unique identification string for the add-in you are deploying. You can change the plugin ID value to a new UUID to allow usage of multiple instances of the add-in.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the plugin execution.</td>
</tr>
<tr>
<td>Icon URL</td>
<td>HTTPS URL or relative URL for ServiceNow icon to be displayed in Microsoft Outlook.</td>
</tr>
<tr>
<td>Active</td>
<td>Indicates if the add-in is active.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Note:** The Office Controls related list shows the menu and menu items associated with the add-in.

5. Click **Download Manifest** to download the add-in manifest file and follow the instructions in the Microsoft article for deployment. Microsoft article: [Publish Office Add-ins using Centralized Deployment via the Office 365 admin center page](#).

6. Optionally, you can also customize the add-in by clicking **Clone Manifest** from the context menu. This option clones the current manifest into a new record that allows customizing the labels, icons, menus, and menu items.

7. To customize the Incident form for users with the itil role, configure the Incident form layout directly.
a. Click the context menu (≡) on the form and select View > Outlook.
b. Click the context menu again and select Configure > Form Layout.
c. Add or remove fields, as needed.

8. To customize the Incident form for users that do not have the itil role, use a Service Catalog record producer to configure the Incident form.
   a. Navigate to Service Catalog > Record Producers.
   b. Right-click the record producer to use for creating new incidents and select Copy sys_id.
   c. Paste the copied sys_id into the Value field of the Provide sys_id of the record producer for create incident action from Outlook Add-In (sn_outlook_addin.create_incident_cat_item) system property.

Use the ServiceNow Add-in for Microsoft Outlook

Create an incident or VTB task or chat with a virtual agent directly from within Microsoft Outlook using ServiceNow icons.

Before you begin
Role required: none

Procedure

1. On the Microsoft Outlook Home tab, click the ServiceNow icon ( ) and select Create Incident or Create VTB Task.

2. In the ServiceNow IT Service Management pane, click Login and enter your ServiceNow credentials.
   You may need to reauthenticate if your session has expired.

3. For an incident record, fill in the following fields and click Submit.

<table>
<thead>
<tr>
<th>Incident form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Caller</td>
</tr>
<tr>
<td>Short description</td>
</tr>
<tr>
<td>Additional comments</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Category of incident.</td>
</tr>
<tr>
<td></td>
<td>• Inquiry / Help</td>
</tr>
<tr>
<td></td>
<td>• Software</td>
</tr>
<tr>
<td></td>
<td>• Hardware</td>
</tr>
<tr>
<td></td>
<td>• Network</td>
</tr>
<tr>
<td></td>
<td>• Database</td>
</tr>
</tbody>
</table>

You can add or remove fields directly on the Incident form for users with the itil role by customizing the Outlook view form layout.

⚠ **Note:** For users that do not have the itil role, the configured Service Catalog form for creating new incidents is shown.

### 4. For a task record, see fill in the following fields and click **Create**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Board</td>
<td>VTB board to which task belongs.</td>
</tr>
<tr>
<td>Select Lane</td>
<td>Lane of the VTB board.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Short description of the task.</td>
</tr>
</tbody>
</table>

### 5. To chat with a virtual agent, select the **Chat with Virtual Agent** UI action.

A chat window opens as a pane. You can begin the virtual chat regarding your requests.

## On-Call Scheduling

The On-Call Scheduling application identifies the assigned and available member of a support group, for example, when assigning an incident.

The On-Call Scheduling application helps you to ensure that dedicated support team members are available to resolve issues as they arise. You can set up on-call schedules, roster rotations, and escalation policies, escalate notifications for a group, and determine the current contact for an escalation.
Activate On-Call Scheduling

You can activate the On-Call Scheduling (com.snc.on_call_rotation) plugin if you have the admin role.

**About this task**
Activating the On-Call Scheduling plugin activates the following third-party libraries:

- Subscription-based notifications
- Advanced Schedules support
• NG shared components
• ServiceNow common calendar
• Fullcalendar library

Note: The On-Call Scheduling plugin (com.snc.on_call_rotation) is active by default for zBoot customers.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related information
On-Call Scheduling

Tables installed with On-Call Scheduling
On-Call Scheduling adds the following tables.

Tables installed with On-Call Scheduling

Note: Tables with prefix "v_" such as [v_alternate_rotation] are view-only tables used for generating on-call reports. Do not use these tables to create reports.

<table>
<thead>
<tr>
<th>Display name [Table name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-call Member [cmn_rota_member]</td>
<td>Table of group members that are participating in the on-call schedule and escalations.</td>
</tr>
<tr>
<td>Display name [Table name]</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Roster [cmn_rota_roster]</td>
<td>Table that holds the members of the shift, the shift interval, and escalation settings.</td>
</tr>
<tr>
<td>Shift [cmn_rota]</td>
<td>The table that holds the on-call schedule for a shift.</td>
</tr>
<tr>
<td>Roster Schedule Span [roster_schedule_span]</td>
<td>Table that contains the schedule span definitions. On-Call Scheduling adds a group reference and the On-call type to the Type field.</td>
</tr>
<tr>
<td>Trigger Rule [trigger_rule]</td>
<td>Table that extends the Assignment Rule [sysrule_assignment] table and stores when the escalation process is triggered and what actions to take.</td>
</tr>
<tr>
<td>On-call Notifications [v_on_call]</td>
<td>Table that lists the reminder notifications that were sent.</td>
</tr>
<tr>
<td>Rotation Schedule [v_rotation]</td>
<td>Table that lists shift schedules by start date and time and includes user contact information, if available.</td>
</tr>
<tr>
<td>User Rotation Schedule [v_user_rotation]</td>
<td>Table that lists the shift schedule by user.</td>
</tr>
<tr>
<td>Alternate Rotation Schedule [v_alternate_rotation]</td>
<td>Table that lists the alternate user schedules by shift and roster and the start and end date and time stamps.</td>
</tr>
<tr>
<td>Rotation Escalation [cmn_rota_escalation]</td>
<td>Table that lists the escalations including the event and last updated time stamp.</td>
</tr>
<tr>
<td>Shift Contact Preference [cmn_rota_contact_preference]</td>
<td>Table that holds the contact preferences for default and custom escalations.</td>
</tr>
<tr>
<td>On-Call Communication Type [on_call_communication_type]</td>
<td>Table that lists the type of communication channel used.</td>
</tr>
<tr>
<td>On-Call Group Template [sys_on_call_group_template]</td>
<td>Table with information about the template used to create/edit a schedule of a group.</td>
</tr>
<tr>
<td>On-Call Shift Template [sys_on_call_shift_template]</td>
<td>Table with information about the template used to create/edit a schedule of a shift.</td>
</tr>
<tr>
<td>Display name [Table name]</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>On-Call User Preference [on_call_user_preference]</td>
<td>Table with information on a member's preferences.</td>
</tr>
<tr>
<td>On-Call User Contact Preference [on_call_user_contact_preference]</td>
<td>Table with information on a member's contact preferences.</td>
</tr>
<tr>
<td>[sys_on_call_contact_source]</td>
<td>Table that lists the contact sources and devices</td>
</tr>
<tr>
<td>On-Call Escalation [on_call_escalation]</td>
<td>Table that records the source, group, and related details for escalation tracking.</td>
</tr>
<tr>
<td>On-Call Escalation Level [on_call_escalation_level]</td>
<td>Table that logs the escalation levels reached for an escalation and related details for escalation tracking.</td>
</tr>
<tr>
<td>On-Call Escalation Contact Attempt [on_call_escalation_con_attempt]</td>
<td>Table that logs contact attempts at an escalation level and related details for escalation tracking.</td>
</tr>
<tr>
<td>On-Call Escalation Notification [on_call_escalation_comm]</td>
<td>Table that logs both the notifications and the responses for a contact attempt and related details for escalation tracking.</td>
</tr>
<tr>
<td>On-Call Escalation Response [on_call_escalation_response]</td>
<td>Table that tracks On-Call escalation responses by On-Call workflows. Once consumed, entries are deleted by the system.</td>
</tr>
<tr>
<td>Trigger Rule Table Configuration [trigger_rule_table_cfg]</td>
<td>Table that lists the tables that are enabled for creating escalation trigger rules. The table is used to enable the escalation trigger rules for the tables that do not extend tasks.</td>
</tr>
<tr>
<td>On-Call Add Member [on_call_add_member]</td>
<td>Table that records the member details for adding a member to the roster.</td>
</tr>
<tr>
<td>On-Call Remove Member [on_call_remove_member]</td>
<td>Table that records the member details for removing a member from the roster.</td>
</tr>
<tr>
<td>On-Call Move Member [on_call_swap_member]</td>
<td>Table that records the member details for swapping the order of a member with the target member or moving the order of a member after the target member in the roster.</td>
</tr>
</tbody>
</table>
Scheduled jobs installed with On-Call Scheduling

On-Call Scheduling includes scheduled jobs.

<table>
<thead>
<tr>
<th>Schedule job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-Call Reminders</td>
<td>Sends daily reminders to on-call roster members.</td>
</tr>
<tr>
<td>On-Call Gaps Conflicts Report</td>
<td>Sends a weekly report of gaps and conflicts in on-call schedules to shift managers, group managers, and admin.</td>
</tr>
</tbody>
</table>

Quick start tests for On-Call Scheduling

Validate that On-Call Scheduling still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

On-Call Scheduling

Activate the On-Call Scheduling plugin (com.snc.on_call_rotation) to run the On-Call Scheduling quick start tests.

On-Call: On-Call scheduling ATF Suites

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-Call: Verify request time-off when PTO approval preferences is Not allowed</td>
<td>Verify whether you can request a time-off when PTO approval preferences is set to <strong>Not allowed</strong>.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Create overlapping shifts without selecting a template</td>
<td>Verify whether you can create overlapping shifts without selecting a template.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Create overlapping shifts when allow shift overlap is set to No</td>
<td>Verify whether you can create overlapping shifts when <strong>Allow overlap</strong> is set to <strong>No</strong>.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Request time-off when PTO approval preferences is with approval</td>
<td>Verify whether you can request a time-off when PTO approval</td>
<td>Orlando</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td>preference is With approval.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>On-Call: Assign shift managers for maintaining on-call schedules.</td>
<td>Verify whether shift managers can maintain on-call schedules.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Search on-call schedules by user name</td>
<td>Verify whether you can search for on-call schedules by user name.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Search on-call schedules by group name or schedule name</td>
<td>Verify whether you can search for on-call schedules by group name or schedule.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Roster details for overlapping shifts with the escalation rule 'Escalate to incoming shift'</td>
<td>Verify the roster details for overlapping shifts when the escalation rule is set to Escalate to incoming shifts.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Calendar preview with timezone options</td>
<td>Verify whether the calendar preview is available with the timezone options.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Create overlapping shifts by selecting a template</td>
<td>Verify whether you can create overlapping shifts by selecting a template.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Show active shifts</td>
<td></td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Make shift draft/publish form shift form</td>
<td>Verify whether you can publish/unpublish a shift and alternate between making the rota Draft and Publish state from the form.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Roster Details for overlapping shifts</td>
<td>Verify the roster details for overlapping shifts</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
### On-Call: On-Call scheduling ATF Suites (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>with the escalation rule 'Escalate to outgoing shift'</td>
<td>when the escalation rule is set to <strong>Escalate to outgoing shifts</strong>.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-Call: Roster Details for overlapping shifts with the escalation rule 'Escalate to all shifts'</td>
<td>Verify the roster details for overlapping shifts when the escalation rule is set to <strong>Escalate to all shifts</strong>.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-call: Verify On-Call workbench</td>
<td>Test to verify the On-Call workbench layout.</td>
<td>Orlando</td>
</tr>
<tr>
<td>On-call: Hide or show shifts</td>
<td>Verify whether you can hide or show shifts from On-Call calendar</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

To learn more about On-Call Scheduling, see [On-Call Scheduling](#).

**Related information**

### Quick start tests

### Domain separation and On-Call Scheduling

Domain separation is supported in On-Call Scheduling. The On-Call Scheduling application helps you to ensure that dedicated support team members are available to resolve issues as they arise. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

### Support level: Standard

- Includes **Basic** level support.
- **Business logic:** The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.
Sample use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

Overview

• On-Call Scheduling behaves the same with domain support as it does without domain support. Customers have the same ability to create and maintain on-call shifts.

• A shift includes a selection of users from a group. It uses the base-system Advanced Schedules Support plugin to specify when the shift is active.

How domain separation works in On-Call Scheduling

With domain separation enabled, a user with the rota_admin role uses the Create New Schedule wizard to generate schedules in the group’s domain. All generated related records for the new schedule are created with a matching domain.

This setup is enforced with a combination of the domain field and the domain_master attribute. The attribute is used to derive the domain of the record from the master record. For the roster table, it derives the domain from the associated shift record.

Domain-separated tables

• Shift [cmn_rota]
• Rotation Escalation [cmn_rota_escalation]
• Shift Escalation Set [cmn_rota_escalation_set]
• Shift Escalation Step Definition [cmn_rota_esc_step_def]
• On-Call Group Preference [on_call_group_preference]
• On-Call Contact Source [sys_on_call_contact_source]
• On-Call Group Template [sys_on_call_group_template]
• On-Call Shift Template [sys_on_call_shift_template]
• On-Call Escalation [on_call_escalation]
• On-Call Escalation Level [on_call_escalation_level]
• On-Call Escalation Contact Attempt [on_call_escalation_con_attempt]
• On-Call Escalation Notification [on_call_escalation_comm]
Tables that use the domain_master attribute

- Roster [cmn_rota_roster]: domain_master=rota
- Rota Member [cmn_rota_member]: domain_master=roster
- Roster Schedule Span [roster_schedule_span]: domain_master=schedule
- Shift Escalation Set [cmn_rota_escalation_set]: domain_master=cmn_rota
- Shift Escalation Step Definition [cmn_rota_esc_step_def]: domain_master=cmn_rota_escalation_set
- On-Call Escalation Level [on_call_escalation_level]: domain_master=escalation
- On-Call Escalation Contact Attempt [on_call_escalation_con_attempt]: domain_master=escalation_level
- On-Call Escalation Notification [on_call_escalation_comm]: domain_master=contact_attempt

To learn more, see Domain support for schedules

Use cases
For the following On-Call Scheduling features, domain separation ensures that end users (whether they possess the itil or rota_admin role) are able to see only shifts accessible via their domain:

- On-Call calendars
- On-Call schedules
- My Schedule reports
- Schedule reports
- Escalations

Related information
Domain separation for service providers

Definitions of On-Call Scheduling terms
Some terms have specific meaning in the On-Call Scheduling application.

Shift
A shift is the time period during which the members of a roster are on-call. You can view the details of any shift from the calendar.

Roster
A roster is a set of members that is on call for a shift. Because there is typically a roster for each escalation level (primary, secondary,
tertiary), there are typically multiple rosters for a shift. The members of any roster are contacted in the order that is defined by the escalation policy.

**Roster members (members)**

The members of a roster are the users that have been added to a single roster. Roster members typically have the itil role. During an assigned shift, members must be available to act if notified of an escalation.

- Users must be members of the same group.
- The shift manager (rota_manager role) might or might not be a roster member.

**Rotation**

Rotation is the process of exchanging the turn of duty of members of a roster.

- Members’ From and To dates determine when they are members of the roster.

**Schedule**

A schedule specifies the times that shifts are active. For example, a company that wants coverage of tasks around the clock would use a 24-7 schedule. Companies that provide support around the globe could use a follow the sun schedule to cover time zones across continents.

**Escalation**

Escalations are a series of notifications to roster members for a task. The notifications happen in the order specified by the escalation path for the shift.

**Notification**

On-Call Scheduling sends escalation notifications to members of a shift. Notification methods include email, voice, Slack, and SMS.

**Holidays and time off**

Roster members can request time off. Managers can plan for and manage holidays and requests for time off.

**Related information**

On-Call Scheduling
Administering and managing On-Call Scheduling

You can configure On-Call Scheduling properties, templates, trigger rules, escalation policies, rosters, and schedules.

Tasks for the On-Call Scheduling admin

As an on-call administrator, you can configure preferences and application behavior and create tools that improve the effectiveness of roster members and shift managers.

Assigning On-Call Scheduling roles

Admins can assign On-Call Scheduling roles to user groups and to individual users based on user activities and responsibilities.

On-Call Scheduling Roles: Tasks and access permissions

<table>
<thead>
<tr>
<th>Role</th>
<th>Tasks and access permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift administrator [rota_admin]</td>
<td>A user with the rota_admin role can create, read, update, and delete shifts. The rota_admin can create shifts using the Create new schedule wizard, modify shifts and rosters, and maintain coverage and time off on the Manage shifts from the Calendar view. The rota_admin role contains the platform assignment_rule_admin role.</td>
</tr>
<tr>
<td>Shift manager [rota_manager]</td>
<td>The Shift manager role is for the manager of a group. The purpose of the role is to distinguish a member that has been delegated the role of managing shifts of a group. The role cannot be used to manage all groups on the instance. The role can be delegated to the members of a group. See Delegating roles. A user with the Shift manager role that meets any of the following</td>
</tr>
<tr>
<td>Role</td>
<td>Tasks and access permissions</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Role</strong></td>
<td><strong>Tasks and access permissions</strong></td>
</tr>
<tr>
<td></td>
<td>requirements can manage shifts for their group:</td>
</tr>
<tr>
<td></td>
<td>• The user is the manager of the group.</td>
</tr>
<tr>
<td></td>
<td>• The user was delegated the rota_manager role. For information on delegating the shift manager role, see Delegate the shift manager [rota_admin] role. For information on role delegation, see Delegate roles.</td>
</tr>
<tr>
<td></td>
<td>⚠️ <strong>Note:</strong> When a user is delegated a role on behalf of a group, the user can manage the shifts only for that group.</td>
</tr>
<tr>
<td></td>
<td>• The user is configured as a shift manager for a group. For information on configuring group preferences, see Configure preferences for a user group.</td>
</tr>
<tr>
<td>itil</td>
<td>A user with the itil role can view the Manage shifts from the Calendar view, on-call commitments on reports, and has general read-only access to their group’s shifts.</td>
</tr>
<tr>
<td>DEPRECATED: roster_admin</td>
<td>⚠️ <strong>CAUTION:</strong> Do not use this role for new users. This deprecated legacy role exists only to support customers that still use the role.</td>
</tr>
</tbody>
</table>

**Related information**

Roles
Base system Roles

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Assign a role to a group
Assign a role to a user

Viewing Escalation Overview reports
Run Escalation Overview reports to view count and rate information on escalations currently in progress, acknowledged and unacknowledged escalations, and Mean Time to Acknowledge (MTTA). You can view data for all groups or for one or more selected groups.

Opening the reports
Any user with the itil role can view the reports. Use one of the following methods to open the reports:

• Click Self-Service > Dashboards and select On-Call Overview. If you have licensed the premium version, then click On-Call Overview - Premium.
• Click On-Call Scheduling > Reports > Overview.

Click the Escalations Overview tab.

Escalations Overview reports

• Acknowledged escalations are accepted by at least one user. The "true" value indicates acknowledged escalations.

• Unacknowledged escalations are not accepted by any user or are rejected by all users. The "false" value indicates unacknowledged escalations.
My On-Call Groups

Select one or more groups. Only data for selected groups appears in the reports. If no group is specified, then data for all groups appears.

Active Escalations - 7 days

The number of escalations that are currently in progress.

Unacknowledged Escalations - 7 days

The number of escalations that nobody has yet acknowledged during the most recent seven-day period.

Acknowledged Escalations

The number of escalations that escalatees have acknowledged during the most recent seven-day period.

Acknowledged Escalations by Level - 7 days

The number of acknowledged escalations during the most recent seven-day period.
• The Y axis indicates groups.
• The X axis indicates escalation level.
• The color shade indicates the count of escalations in the box.

Acknowledged and Unacknowledged Escalations by Group - 7 days

The number of escalations by group during the most recent seven-day period.
• The "true" value indicates acknowledged escalations.
• The "false" value indicates unacknowledged escalations.

Escalations per Day

The number of escalations for the specified date.
• The Y axis represents the count of escalations.
• The X axis represents time by date.

Mean Time to Acknowledge (MTTA) - 7 days

The average time that it took a user to acknowledge an escalation during the most recent seven-day period.
• The Y axis indicates the time it took a user to acknowledge an escalation.
• The X axis indicates the group.

Viewing Group Overview reports

Run My Groups Overview reports to view the activities of a selected group: Count information on acknowledged and unacknowledged escalations by shift, acknowledged escalations by user, and the hours for each user over seven days.

Opening the reports

Any user with the itil role can view the reports. Use one of the following methods to open the reports:

• Click Self-Service > Dashboards and select On-Call Overview. If you have licensed the premium version, then click On-Call Overview - Premium.
• Click On-Call Scheduling > Reports > Overview.

Click the My Groups Overview tab and then specify the group in the My On-Call Groups list.
• **Acknowledged escalations** are accepted by at least one user. The “true” value indicates acknowledged escalations.

• **Unacknowledged escalations** are not accepted by any user or are rejected by all users. The “false” value indicates unacknowledged escalations.

**My Groups Overview reports**

On-Call Hours - 7 days

The sum for each day over the last seven days: (Number of hours / roster member) * (number of roster members that worked on an escalation)

**Acknowledged and Unacknowledged Escalations by Shift - 7 days**

The number of escalations by shift during the most recent seven-day period.

- The Y axis represents the count of escalations.
- The X axis represents the shift.

- The "true" value indicates acknowledged escalations.
- The "false" value indicates unacknowledged escalations.

Hours Distribution by User - 7 days
Pie chart that displays the number of hours that each user in the group worked on escalations during the most recent seven-day period.

Acknowledged Escalations by User - 7 days

Pie chart that displays the number of acknowledged escalations that each user in the group worked on during the most recent seven-day period.

Viewing the Performance reports for escalations

The Performance reports enable detailed review of how well escalations are being processed. You have precise control of the data that describes escalation progress using filters like group, priority, level, or escalation category.

Opening the reports

You must have the Premium Dashboard user [rota_prem_dashboard_user] role to view the Performance reports. Use one of the following methods to open the reports:

- Click **Self-Service > Dashboards** and select **On-Call Overview - Premium**.
- Click **On-Call Scheduling > Reports > Overview**.

Click the **Performance** tab and then select the date of interest. The time line shows the time of day at which escalations happen. Use the tabs to control the type of data to view:

**Breakdowns tab**

Use the filters to segment the data into categories that suit your need. For example, if you are investigating your SMS costs, you can set filters to display how many notifications of the SMS type are sent and to which groups or users they are being sent. For example, you might notice that you sent 68 SMS messages to users in the Network group. The group, however, did not acknowledge any escalations. You might therefore consider that you can lower SMS costs by not sending SMS notifications to that group.

- Groups
- Escalation Category

**Records tab**

The **Records** tab lists the individual records that make up the results that you configured on the **Breakdowns** tab. Click a name to view record details.
Note: Each record also appears in the appropriate escalation log. See View details in an escalation log.

All Escalations tab

- Acknowledged escalations are accepted by at least one user.
- Unacknowledged escalations are not accepted by any user or are rejected by all users.

- All Escalations: Count of escalations that started on the selected date.
- Escalation Notifications: Count of notifications that were sent on the selected date. An escalation might have triggered several notifications.
Acknowledged Escalations tab

- **Acknowledged Escalation Notifications**: Count of escalations that had any of the following values in the *Response* field for the notification:
  - Accepted or Accepted from other device
  - Auto-assigned
- **Acknowledged Escalation %**: Percent of escalations that had a valid value in the *Response* field for the notification.
- **Acknowledged Contact Attempt %**: Percent of contact attempts that were acknowledged.

Unacknowledged Escalations tab

Unacknowledged escalations have one of the following values for each member of an escalation path in the *Response* field for the escalation notification:

- Rejected
- Rejected from other device
- Invalid response
- [no response]
Enable users to subscribe to the On-Call calendar

Configure an On-Call calendar subscription URL and send it to the members of a shift. The URL is an iCal link that enables users to subscribe to their on-call calendar from their preferred calendar client.

**Before you begin**
Role required: admin, rota_admin, or rota_manager

**About this task**
Because the subscription URL supports basic authentication, the end user must provide instance credentials to authenticate and view their on-call events. Only the Calendar application on Mac OS X 8.0 and newer and the Outlook application on Windows 2013 and newer support basic authentication for calendar subscriptions. If SSO is in use, basic authentication is still required to subscribe with the URL.

**Procedure**
1. Navigate to **On-Call Scheduling > My Group Schedules**.
2. Select the shift for which you want to send the on-call calendar subscription URL.
3. Specify the following details in the **Calendar Subscription** section.
<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coverage interval</td>
<td>Select if you want to update the subscribed calendar with weekly or daily coverage details.</td>
</tr>
<tr>
<td>Get coverage for</td>
<td>Based on your coverage interval selection, select the number of weeks or days for which you want to update the subscribed calendar.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

5. Click **Send Subscriptions** to send the calendar subscription URL to all members of the shift by email.

**Configure preferences for a user group**

Specify the On-Call preferences for a user group.

**Before you begin**

Role required: admin, rota_admin, or rota_manager.

**Procedure**

1. Navigate to **On-Call Scheduling > Administration > Group Preferences** and then set the values as needed.

**On-Call Group Preference form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>User group for which the On-Call preferences should apply.</td>
</tr>
<tr>
<td>Allow Shift Schedule Overlap</td>
<td>Specifies if overlapping schedules are allowed for shifts within the group. When set to Default, the value selected for the Configuration to control whether to allow overlapping Shift schedules (com.snc.on_call_rotation.allow_rota_overlap) property is applied.</td>
</tr>
<tr>
<td>Escalation rule on Shift overlap</td>
<td>Escalation rule that applies when there is a shift overlap. When set to Default, the value selected for the Escalation rule which applies when Shifts overlap</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(com.snc.on_call_rotation.escalation_rule_rota_over) property is applied.</td>
<td>Specifies if an On-Call member in the group can create PTO. When set to Default, the value selected for the This property governs if an On-Call user (Not &quot;admin, rota_manager, group manager or rota_admin&quot;) is allowed to create PTO.</td>
</tr>
<tr>
<td>Shift managers</td>
<td>Users who can manage the shift in addition to group managers, shift managers [rota_admin], and delegated shift managers. You can also select the current group members.</td>
</tr>
</tbody>
</table>

2. To view On-Call property settings, click **View Global Settings**.
3. Click **Submit** to configure the settings or **Delete** to delete the preference.

### Escalations in On-Call Scheduling

An escalation is a mechanism that ensures that important issues are addressed in a timely manner.

On-Call Scheduling monitors response time for a task. You can define the actions to take when a task is not acknowledged. The actions, like sending out an email or an SMS, are fired by trigger rules. You define a trigger rule by specifying the conditions that trigger the actions and the actions to take when the conditions are met.

For example, a critical incident is raised for Acme Pharmaceuticals regarding a problem with their network access. An SMS task notification is sent to Ken, the third-line support engineer who is on call for this type of incident. Ken is unavailable, however, and does not respond within the specified 30-minute response time.

A trigger rule that is defined for Acme Pharmaceuticals critical incidents starts an escalation if a task goes 30 minutes without a response. The person specified as the next point-of-contact is Nakul, Ken’s line manager, so an SMS notification is sent to Ken. Settings in the escalation policy specify how many notifications to send, how long to wait, and so on.

Shift administrators and shift managers can define trigger rules and configure escalation policies.
Related information
Viewing Escalation Overview reports
Viewing the Performance reports for escalations

Designing an escalation process
To design an escalation process for a task, you define a trigger rule and configure one or more escalation policies. A trigger rule specifies both the conditions under which an escalation process should begin and the escalation actions (workflow or script) to perform. An escalation policy describes the order in which escalation notifications are sent, the escalation audience, and other aspects of the escalation.

How a trigger rule works
When a task is created or updated, the instance compares the assignment rules with the rule’s conditions to determine whether a condition is met. If there is a match, then the instance activates the workflow or script that is specified by the rule’s action. Trigger rules are an extension of assignment rules and they have the same behavior as assignment rules.

For example, a trigger rule might specify:

- If (rule condition): An incident with level Critical or High is raised and is assigned to the Network group.
- Then (rule action): Run the Assign and Notify workflow. (The workflow sends an email notification to the current on-call roster member.)
Rule action on the What action to take tab

See Create an escalation trigger rule.

About escalation policies
An escalation policy includes the following configurations:

- The escalation audience (roster members and managers).
- A policy type that defines the order in which rosters and roster members receive escalation notifications.
- Other aspects of the escalation process like the contact methods to use and the number of reminders to send for each notification.

You can create a custom escalation policy for a shift by overriding settings in a default escalation type, for example, by configuring custom delays between escalation steps.

Configure a table for escalation trigger rules
Configure escalation trigger rules for the tables that do not extend tasks.

Before you begin
Role required: admin

About this task
Tables that are configured in the Trigger Rule Table Configuration [trigger_rule_table_cfg] table do appear in the Table field in the Trigger Rule form for creating an escalation trigger rule.
Procedure

1. Navigate to On-Call Administration > Administration > Trigger Rule Table Configuration.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Name of the table that will be enabled for creating escalation trigger rules.</td>
</tr>
<tr>
<td>Trigger group field</td>
<td>Group field value in the table based on which trigger rule processes.</td>
</tr>
<tr>
<td>Trigger user field</td>
<td>User field value in the table based on which trigger rule processes.</td>
</tr>
<tr>
<td>Journal field</td>
<td>The ongoing escalation activity.</td>
</tr>
</tbody>
</table>

4. Click Submit.
   The Trigger Rules related list shows the escalation trigger rules that are configured for the table.

Create an escalation trigger rule

Create a trigger rule to specify both the conditions under which an escalation process should begin and the actions (workflow or script) to perform for the escalation.

Before you begin
Role required: rota_admin, admin, or rota_manager

About this task
Users with the rota_manager role can create escalation trigger rules (with the Trigger action field set to Workflow) only for the groups that are managed by the rota_manager.

Procedure

1. Navigate to On-Call Administration > Administration > Trigger Rules.
2. Click New.
3. On the form, fill in the fields.
### Trigger Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Unique and meaningful name for the trigger rule.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>Task table that applies to the trigger rule.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Only tables and database views that are in the same scope as the trigger rule appear in the list.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Tables that do not extend tasks do appear in the list only if those tables are configured for trigger rules in the Trigger Rule Table Configuration [trigger_rule_table_cfg] table.</td>
</tr>
<tr>
<td><strong>Execution order</strong></td>
<td>Run order of the trigger rule.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Option to activate the trigger rule.</td>
</tr>
<tr>
<td><strong>When to activate</strong></td>
<td>Option to process the trigger rule only when the <strong>Group</strong> field value in the table is changed.</td>
</tr>
<tr>
<td><strong>Trigger when group assigned changes</strong></td>
<td>Type of trigger for the table that is the default behavior or conditional.</td>
</tr>
<tr>
<td></td>
<td>This field is available only when the <strong>Trigger when group assigned changes</strong> check box is enabled.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Condition matches</strong>: Triggers escalation when conditions match.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default</strong>: Triggers escalation based on only the <strong>Trigger action</strong> field value.</td>
</tr>
<tr>
<td><strong>Match conditions</strong></td>
<td>Conditions type to match before triggering escalation.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All</strong>: Each condition must be met.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Any</strong>: Any one of the conditions can be met.</td>
</tr>
<tr>
<td><strong>Conditions</strong></td>
<td>Conditions that must be met for the trigger rule to fire (run the workflow or script that is the action for the rule).</td>
</tr>
<tr>
<td><strong>What action to take</strong></td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Group</td>
<td>Group that becomes the <strong>Task assignment group</strong> when the trigger rule fires.</td>
</tr>
<tr>
<td></td>
<td>This field is available only when the <strong>Trigger when group assigned changes</strong> check box is cleared.</td>
</tr>
<tr>
<td>Trigger action</td>
<td><strong>Workflow</strong> or <strong>Script</strong> (server-side JavaScript) to execute when the <strong>Match conditions</strong> and <strong>Conditions</strong> are met.</td>
</tr>
<tr>
<td>Trigger workflow</td>
<td>Workflow to execute. Available only if <strong>Trigger action</strong> is set to <strong>Workflow</strong>.</td>
</tr>
<tr>
<td>Trigger script</td>
<td>Script (server-side JavaScript) to execute. Available only if the <strong>Trigger action</strong> field is set to <strong>Script</strong>.</td>
</tr>
</tbody>
</table>

**Note:** This action is available only for users with the rota_admin and admin roles.

4. Click **Submit**.

**Create an escalation policy**

An escalation policy includes the policy type that defines the order in which rosters and roster members receive escalation notifications. You can create a custom escalation policy for a shift by overriding settings in a default escalation type, for example, by configuring custom delays between escalation steps.

**Before you begin**
Role required: rota_admin, rota_manager, or admin

**About this task**
The escalation type determines the order in which members of a user group are notified about the escalation. The escalation type depends on the number of rosters.

- If a shift has only one roster, the escalation type is automatically set to **Rotate through members** and the escalation path goes through the member list of a roster (primary, secondary, tertiary) to determine whom to notify.

- If the shift has multiple rosters, the escalation type is automatically set to **Rotate through rosters** and the escalation path goes through all rosters to determine whom to notify.

- If the shift has a customized escalation hierarchy, the escalation type is set to **Custom** and the escalation path goes through members as defined in the escalation hierarchy. See **Create an escalation policy** for details.
On-Call Scheduling supports multiple escalation policies per shift; for example, policies based on the priority of the incident or type of task record.

**Procedure**

1. Create a custom escalation policy using the escalation designer.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Navigate to <strong>On-Call Scheduling &gt; On-Call Schedules</strong>.</td>
<td></td>
</tr>
<tr>
<td>b. Click the required shift card.</td>
<td></td>
</tr>
<tr>
<td>c. In the <strong>Shifts</strong> tab, click the actions icon for the shift.</td>
<td></td>
</tr>
<tr>
<td>d. Click <strong>Override escalation</strong> and click <strong>OK</strong> in the confirmation window.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Navigate to <strong>On-Call Scheduling &gt; My Group Schedules</strong>.</td>
<td></td>
</tr>
<tr>
<td>b. Open the required shift.</td>
<td></td>
</tr>
<tr>
<td>c. Click <strong>Override Escalation Policy</strong> and then click <strong>Yes</strong> in the confirmation dialog box.</td>
<td></td>
</tr>
</tbody>
</table>

2. Click the Add Escalation Step icon and then fill in the Add Escalation Step form.

**Add Escalation Step form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the escalation step.</td>
</tr>
<tr>
<td>Escalation level</td>
<td>Hierarchy level of the step.</td>
</tr>
<tr>
<td>Time to next step</td>
<td>Wait time from the last reminder to run the next step.</td>
</tr>
<tr>
<td>Escalation set</td>
<td>Escalation set for the step.</td>
</tr>
<tr>
<td>Number of reminders</td>
<td>Number of reminders to send in this step.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Time between reminders</td>
<td>Time between each reminder of this step.</td>
</tr>
<tr>
<td>Escalation audience</td>
<td></td>
</tr>
<tr>
<td>Roster</td>
<td>Rosters to which escalation notifications and reminders are sent.</td>
</tr>
<tr>
<td>Groups</td>
<td>User groups to which escalation notifications and reminders are sent.</td>
</tr>
<tr>
<td>Users</td>
<td>Users to whom escalation notifications and reminders are sent.</td>
</tr>
<tr>
<td>Devices</td>
<td>Devices to which escalation notifications and reminders are sent. For example, a mobile phone that is rotated between group members.</td>
</tr>
<tr>
<td>Group manager</td>
<td>Option to send escalation notifications and reminders to the group manager.</td>
</tr>
</tbody>
</table>
| Group manager field          | Option to select group managers hierarchically to send escalation notifications and reminders. 
                                | This field is available only when the **Group manager** check box is selected. |

**Add Escalation set form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name the escalation policy.</td>
</tr>
<tr>
<td>Shift</td>
<td>The shift to which the escalation policy applies.</td>
</tr>
<tr>
<td>Default</td>
<td>Select the check box to mark the escalation policy as default. The default escalation policy is used for all on-call escalations in the case that none of the specified <strong>Conditions</strong> are met.</td>
</tr>
<tr>
<td>Table</td>
<td>Choose the table for which you want to set the escalation policy.</td>
</tr>
<tr>
<td>Condition</td>
<td>Use the condition section to add filters to the escalation criteria.</td>
</tr>
<tr>
<td>Description</td>
<td>Short description of the escalation policy.</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to enable the escalation policy.</td>
</tr>
<tr>
<td>Override user preference</td>
<td>Select the check box to override the user's contact preferences.</td>
</tr>
<tr>
<td>Order</td>
<td>When there are multiple escalation policies defined for a shift, the order in which to apply this policy. Smaller numbers first.</td>
</tr>
</tbody>
</table>

3. **Optional:** To edit an escalation step, click the edit escalation step icon and perform the edits.

4. **Optional:** Add multiple escalation steps if required.

5. **Optional:** To edit the escalation hierarchy for the shift, click the actions icon and click **Edit escalation**.

6. **Optional:** To reset to the default escalation type for the shift, click the actions icon and click **Reset escalation**.

### Escalation and reminder settings for rosters

Use the escalation settings to specify how and when escalations occur and when reminder notifications are sent.

### Escalation and reminder settings

You can specify unique settings for each roster. When you configure a roster, you can specify

- **Forced communication channel:** You can specify a mandatory communication channel: SMS, voice, Slack, or email.
  - SMS and voice require that Notify is active.
  - An on-call member must have an SMS device to receive SMS notifications. If the member does not have an SMS device, then no further attempts are made and the lack of an SMS device is logged.

- **Number of reminders:** The number of times the instance sends reminders to a person who does not reply within the time frame specified by **Time between reminders**.

- **Time between reminders:** The time interval between sending reminders.
• Values in the **Number of reminders** and **Time between reminders** fields determine the value in the **Time before escalation** field. For example, if **Number of reminders** is 2 and **Time between reminders** is 10 minutes, then the **Time before escalation** is 30 minutes. That is, the time that passes between the first notification of a non-responsive roster member and the first notification of the next member in the escalation path.

**Instructions**

For detailed instructions, see [Configure a roster](#).

**Example escalation reports**

Because escalation reports depend on the escalation type, report content can vary greatly.

Because escalation reports depend on the escalation type, report content can vary greatly. Example reports follow:

**Example report for a Rotate through members escalation type**

In this example, users can see which shifts they are part of in My Schedule reports. Users who are not the first on-call person appear as well. This action enables the user to view the shift from a personal perspective, which is the preferred method for most users.

**Example report for a Rotate through rosters escalation type**

In this example, reminders are defined for the **Primary**, **Secondary**, and **Tertiary** rosters. Members of the primary roster are notified first, then the members of the secondary, and so on, for all rosters.
Track the progress of an escalation

Use the On-Call Escalation Tracking page for full visibility into the time line of an active or closed escalation as it progresses through its on-call escalation path.

Before you begin
Role required: Any role that enables the user to read incidents.

About this task

Note: Escalation logging must be enabled to view the On-Call Escalation Tracking page. See the com.snc.on_call_rotation.log_escalations property in System properties for On-Call Scheduling.

Procedure

1. Navigate to Incident and open the incident.
   The Assignment group field includes the On-Call Escalation Tracking icon that indicates the active status of the escalation. Green indicates an active escalation, and black indicates a finished escalation.

2. Click the On-Call Escalation Tracking icon.
   The On-Call Escalation Tracking dialog box opens.
1. The Escalation Path section identifies the escalation with start time, group, and shift that handles the escalation, and Escalation category.

2. Indicators on the time line show status:
   a. For active escalations, a green arrow on the path time line indicates the current active response phase.
   b. Unfilled check mark: Skipped response.
   c. Filled green check mark: Accepted response.
   d. Red X: Rejected response.

3. Click the escalation timestamp for an escalatee or escalatee's name to view timing details. The list on the Contact Information tab shows contact times, modes of contact, and responses for the associated escalation phase.

The dots for the escalation timestamps indicate overall acceptance. Point to a dot to view further information. Color codes of the dots:

- Green: At least one escalatee has accepted the escalation.
- Orange: At least one escalatee has rejected the escalation.
- Red: All escalatees have rejected the escalation.
4. Depending on the contact settings, you can call or send a direct message to the person from the escalatee’s **Profile** tab.

**View details in an escalation log**

View the escalation log record for full details on the timeline and actions for an on-call escalation as it progressed through the on-call escalation path. You can also access escalation and escalation notification information from reports.

**Before you begin**

Role required: rota_admin or admin

**About this task**

This topic describes how to use the logs to access escalation information. You can also access escalation notification information from reports. See [Viewing the Performance reports for escalations](#).

You can enable or disable logging using the `com.snc.on_call_rotation.log_escalations` property, as described in [System properties for On-Call Scheduling](#).

**Procedure**

1. Navigate to **On-Call Scheduling > Escalations > Escalation Logs** and open the incident.
   
   The On-Call Escalations [Escalation Logs view] opens.

2. Click the Information icon (ℹ️) to open the incident record.
3. For each item in the related lists, you can click the Information icon (i) to drill deeper into the details of the escalation (for example, to determine **Time to acknowledge** values).

**System properties for On-Call Scheduling**

The property settings configure On-Call Scheduling operations.

**Setting properties from the UI**

You can set most property values from the On-Call Properties page at **On-Call Scheduling > Administration > On-Call Properties**.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.on_call_rotation.calendar_macro</td>
<td>The name of the macro used for the First On-Call shift. The default is ocf_calendar.xml.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.support_legacy_spans</td>
<td>Used to search for override or time-off records that may have been generated as cmn_schedule_span records and not in the standard roster_schedule_span table.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.pto.approval.required</td>
<td>Configuration to determine if PTO requests need approval.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.factor_daily_rotation_interval_all_day</td>
<td>If true, mandates daily rotation to occur at midnight. If false, then use the time that is specified for the roster start time for the next day.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.log.level</td>
<td>Enable logs for debugging.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.log_escalations</td>
<td>Enable logging of escalations. See View details in an escalation log.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.calendar_macro</td>
<td>The name of the macro that provides a calendar for On-Call shift. The default uses DHTMLX scheduler. Fullcalendar is set by ocf_calendar.xml.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.support_legacy_spans</td>
<td>Used to search for override or time-off records that may have been generated as cmn_schedule_span records and not in the standard roster_schedule_span table.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.pto.approval.required</td>
<td>Configuration to determine if PTO requests need approval.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.contrast</td>
<td>Sets text color to either white or black depending on which has the highest contrast with the background color on the calendar. The following algorithms determine text color: ContrastYIQ, ContrastPercent, ContrastLuminance.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.access.debug</td>
<td>If true, enable general On-Call logs for debugging.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.reminders.showtz</td>
<td>Include a user’s time zone in On-Call Shift Reminder notification emails.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> System Property [sys_properties] table</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.show_legacy_calendar</td>
<td>Show the legacy On-Call calendar.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> System Property [sys_properties] table</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.calendar_read_roles</td>
<td>Comma-separated list of roles that can read the calendar.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> System Property [sys_properties] table</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.cover.color</td>
<td>Sets the color of the span for On-Call coverage for another roster member.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> System Property [sys_properties] table</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.timeoff.color</td>
<td>Sets the color of the span when the type is time-off.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> System Property [sys_properties] table</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.landing_page.group_limit</td>
<td>The number of On-Call schedules loaded per batch on the client side.</td>
</tr>
<tr>
<td></td>
<td>Default: 20.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.landing_page.max_groups</td>
<td>The maximum number of On-Call schedules that can be loaded on the client side. Default: 300.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Note:</strong> The default value is chosen as the limit of acceptable client performance.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.landing_page.pinned_notification</td>
<td>Displays a message when any schedule is pinned successfully.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.landing_page.notification_timeout</td>
<td>Specifies the time (in milliseconds) until the message for successful pinned scheduled is displayed.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.landing_page.show_wizard_btn</td>
<td>Displays the <strong>New</strong> button to open the On-Call schedule wizard.</td>
</tr>
<tr>
<td>com.snc.iam.conference_call_follow_on_call_escalation</td>
<td>If selected, On-Call the escalation path is followed when a user group is added to a conference call. This property is added when the Incident Communications Management (com.snc.iam) plugin is installed.</td>
</tr>
<tr>
<td>com.snc.iam.conference_call_escalation_workflow</td>
<td>If selected, custom escalation hierarchy is applicable in On-Call Scheduling workflows. This property is added when the Incident Communications Management (com.snc.iam) plugin is installed.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.landing_page.show_pending_actions</td>
<td>If true, displays the pending actions on the On-Call Schedules landing page.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.allow_rota_overlap</td>
<td>If true, overlapping shifts are allowed for a user group.</td>
</tr>
<tr>
<td>com.snc.on_call_rotation.escalation_rule_rota_overlap</td>
<td>Escalation rule that applies for shift overlap:</td>
</tr>
<tr>
<td>• Escalate to outgoing Shift</td>
<td>• Escalate to incoming Shift</td>
</tr>
<tr>
<td>• Escalate to all Shift</td>
<td></td>
</tr>
<tr>
<td>com.snc.on_call_rotation.pto.configuration</td>
<td>Specifies how a roster member can create vacation time (PTO):</td>
</tr>
<tr>
<td>• With approval</td>
<td>• Without approval</td>
</tr>
<tr>
<td>• Not allowed</td>
<td></td>
</tr>
<tr>
<td>com.snc.notify.default.on_call_escalation_level</td>
<td>Fetches the number of users from the group escalation plan. A value of -1 fetches all users from the plan, and so on.</td>
</tr>
<tr>
<td>Note: This is the default property for the task type. Replace the word &quot;default&quot; in the key with the task type.</td>
<td></td>
</tr>
<tr>
<td>Note: This property is used only when the com.snc.notify.default.conference_call_follow_on_call_escalation sys property is false.</td>
<td></td>
</tr>
<tr>
<td>com.snc.notify.default.conference_call_follow_on_call_escalation</td>
<td>If true, the On-Call escalation rules are followed when a user group is added to a conference call. Example: For Incident, the property key would be com.snc.notify.incident.conference_call_follow_on_call_escalation.</td>
</tr>
<tr>
<td>Note: The property key (com.snc.notify) is replaced by the task type.</td>
<td></td>
</tr>
<tr>
<td>com.snc.notify.default.on_call_escalation_level</td>
<td>Fetches the number of users from the group escalation plan. A value of -1 fetches all users from the plan, and so on.</td>
</tr>
<tr>
<td>Note: This is the default property for the task type. Replace the word &quot;default&quot; in the key with the task type.</td>
<td></td>
</tr>
<tr>
<td>Note: This property is used only when the com.snc.notify.default.conference_call_follow_on_call_escalation sys property is false.</td>
<td></td>
</tr>
<tr>
<td>com.snc.notify.default.conference_call_escalation_workflow</td>
<td>The sys_id of the default workflow that must be attached when escalating a conference call.</td>
</tr>
</tbody>
</table>
### Configure or update an On-Call shift

You can add extra coverage, specify extra times for when a shift is active, and schedule time off.

**Before you begin**
Role required: rota_admin or rota_manager

**About this task**
You can update the calendar only for the time zone specified in your user profile.

**Procedure**

1. Navigate to On-Call Scheduling > On-Call Calendars.
   The on-call calendar opens.

2. Click the Timeline view icon ( ).

3. Click the Filters icon ( ) and then select the group.
   The calendar displays the selected group.

4. Right-click a block that represents a member of the shift and select **Manage Shift**.
   The Manage Shift dialog box displays the current shift settings.
5. Select an **Action**, as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Provide coverage</strong></td>
<td>Select details of the member who will provide on-call coverage for another roster member. The following options appear when you select this option:</td>
</tr>
<tr>
<td></td>
<td>• Rosters: Select one or more rosters for which the member will provide coverage.</td>
</tr>
<tr>
<td></td>
<td>• Member: Select the member to provide extra coverage.</td>
</tr>
<tr>
<td></td>
<td>• Shift start: Select the date from which the coverage will start.</td>
</tr>
<tr>
<td></td>
<td>• Shift end: Select the date on which the coverage will end.</td>
</tr>
<tr>
<td><strong>Schedule extra time</strong></td>
<td>Specify extra coverage for the selected shift. The following options appear when you select this option:</td>
</tr>
</tbody>
</table>

**Note:** The coverage is created between the start and end date of the shift based on its schedule time.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift</td>
<td>Select the shift for which you want to specify extra time.</td>
</tr>
<tr>
<td>Shift start</td>
<td>Select the date from which the extra time will start.</td>
</tr>
<tr>
<td>Shift end</td>
<td>Select the date on which the extra time will end.</td>
</tr>
</tbody>
</table>

Schedule time off
Specify the group member who will take scheduled time off during the selected time frame. The following options appear when you select this option:
- **Member**: Select the member who requested time off.
- **Starts**: Select the date and time from which the time-off period will start.
- **Ends**: Select the date and time on which the time-off period will end.
- **All day event**: Select if the time-off period is a total of one working day.
- **Proposed cover**: Select the name of the shift member who you would like to provide cover in your absence.

6. Click **Schedule** to schedule the update.

7. To save the view settings, click the Bookmark this filter icon ( ).

**Related information**
- View On-Call schedules
- Manage shifts from the Calendar view

**Configure a roster**
Edit a roster to specify its reminder and escalation settings and to identify a subset of group members to participate in the On-Call roster.

**Before you begin**
Role required: rota_admin or admin

**Procedure**
1. Navigate to **On-Call Scheduling > On-Call Calendars**.
2. Right-click a shift and select **Edit Shift** from the **Actions** list.
3. In the Rosters related list, select a roster and then fill the form.

### Roster form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the roster.</td>
</tr>
<tr>
<td>Shift</td>
<td>Shift associated with the current roster.</td>
</tr>
<tr>
<td>Active</td>
<td>If selected, the roster is active for on-call operations.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of the roster.</td>
</tr>
<tr>
<td>Rotation interval</td>
<td>Type of the rotation interval.</td>
</tr>
<tr>
<td>Day of week for rotation</td>
<td>Weekday on which the roster rotation should start. When this field is specified, roster rotation happens based on the specified frequency and the weekday.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Note" />: This field is displayed only if the Rotation interval field is set to Weekly.</td>
</tr>
<tr>
<td>Rotate every</td>
<td>Frequency of the rotation interval.</td>
</tr>
<tr>
<td>Rotation start date</td>
<td>Start date of the rotation.</td>
</tr>
<tr>
<td>Rotation start time</td>
<td>Start time of the rotation.</td>
</tr>
<tr>
<td>All day rotation</td>
<td>If selected, roster rotation happens throughout the day.</td>
</tr>
<tr>
<td></td>
<td>To specify a particular time of day for roster rotation, for example 08:00 instead of midnight, deselect the check box and specify the time.</td>
</tr>
</tbody>
</table>

### Escalation Settings

<p>| # reminders               | Number of times that reminders are sent to a user who does not reply within the time frame defined in Time between reminders. |
| Time between reminders    | Time between each reminder.                                                |
| Time before escalation    | Values in the <strong>Number of reminders</strong> and <strong>Time between reminders</strong> fields determine the value in the <strong>Time before escalation</strong> field. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of reminders</td>
<td>For example, if <strong>Number of reminders</strong> is 2 and <strong>Time between reminders</strong> is 10 minutes, then the <strong>Time before escalation</strong> is 30 minutes. That is, the time that passes between the first notification of a non-responsive roster member and the first notification of the next member in the escalation path.</td>
</tr>
<tr>
<td>Send on-call reminders</td>
<td>If selected, a reminder is sent to the email address specified in the user record, unless it is specified somewhere else in the notification preferences. Notification preferences take precedence over the user record.</td>
</tr>
<tr>
<td>Reminder lead time (days)</td>
<td>Lead time for email reminders. Note: This field is displayed only when the Send On-Call Reminders check box is selected.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Note:**
- Initially, roster members are automatically populated from the user group.
- All members of a roster must be members of the same user group.

**Related reference**

**Escalation and reminder settings for rosters**

**Delegate the shift manager [rota_admin] role**

As a shift manager, you can delegate your role to a member of shift.

**Before you begin**
Role required: rota_manager or admin

**Procedure**

1. Navigate to **User Administration > Delegate Roles in Group**.
2. Follow the instructions to delegate the shift manager role to a member of your shift.

  **Note:** Ensure that you select the shift group where you want to delegate the shift manager role.

3. Submit the role delegation request.
Related information
Assigning On-Call Scheduling roles

Set a shift to Draft mode while waiting for info
If you do not have all the information that you need to define a shift, you can set the shift to Draft mode. Later, when all the information is available, you can publish the shift so you can add it to a schedule.

Before you begin
Role required: rota_manager

Procedure
1. Navigate to On-Call Scheduling > My Group Schedules.
2. Select the shift that will include the group.
3. On the Shift dialog box, click Move to Draft.
   A message confirms that the rotation schedule is updated for the shift that you moved to a draft mode.

Update shift details from the On-Call calendar
To save time, update shift details directly from an on-call calendar.

Before you begin
Role required: rota_admin or admin

Procedure
1. Navigate to On-Call Scheduling > On-Call Calendars.
2. In the title bar, click the toggle filters icon and select a user group.
3. Click the shift name on the calendar.
   A dialog box displays the Actions list and information about the primary and secondary rosters. For each listed user, you have an option to either connect through phone, email, or chat. The application that is launched for phone or email is dependent on the client that is installed in the local machine.
4. Navigate to Actions > Edit Shift.

Edit Shift form fields

<table>
<thead>
<tr>
<th>Question</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the shift.</td>
</tr>
<tr>
<td>Question</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Group</td>
<td>Select Yes, and then select one of the predefined options in the next question. Select No to set up the schedule's configuration manually.</td>
</tr>
<tr>
<td>Active</td>
<td>Shows the state of the shift</td>
</tr>
<tr>
<td>Schedule</td>
<td>The shift is a part of this schedule. Choose from a predefined list of schedules using the lookup if you want to change the schedule. Click the calendar to view the complete schedule.</td>
</tr>
<tr>
<td>Based on</td>
<td>The template that the schedule is based on</td>
</tr>
<tr>
<td>Background Color</td>
<td>Use this field to specify the background color of the shift or to change from an existing color. Differentiate between groups with the colors.</td>
</tr>
<tr>
<td>Catch All</td>
<td>Specify who should receive notifications in case none of the people who are on-call accepted the incident assignment. It can be none, a group manager, a shift manager, an individual, or any or all roster members.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Notify Individual</strong> to specify a member of the group to notify.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Notify All</strong> to specify a shift. All shift members are notified.</td>
</tr>
<tr>
<td>Manager</td>
<td>The user with the shift manager [rota_admin] role.</td>
</tr>
<tr>
<td>Override user preference</td>
<td>User preferences are overridden with contact preferences when set to true.</td>
</tr>
<tr>
<td>Send On-Call Reminders</td>
<td>If selected, on-call reminders are sent.</td>
</tr>
<tr>
<td>Reminder lead time (days)</td>
<td>Lead time for email reminders.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is displayed only when the Send On-Call Reminders check box is selected.</td>
</tr>
<tr>
<td>Coverage interval</td>
<td>Update interval for the subscribed calendar: Weekly or daily coverage details.</td>
</tr>
<tr>
<td>Get coverage for</td>
<td>Number of weeks or days for which you want to update the subscribed calendar.</td>
</tr>
</tbody>
</table>
Send or resend reminders of an upcoming shift

Remind roster members of an upcoming shift by sending an email notification. You specify the number of days before their shift starts for the email.

Before you begin
Role required: rota_admin or admin

About this task
The reminder is sent to the email address specified in the user record, unless the address is specified in other notification preferences. Notification preferences take precedence over the user record.

Procedure
1. Navigate to On-Call Scheduling > My Group Schedules. The option is also available when you edit a shift in an On-Call calendar.
2. Select the shift.
3. On the Shift form, select the Send on-call reminders check box and then specify the number of days in the Reminder lead time field.
   
   Note: If you set the value of Reminder lead time (days) to more than one day and also set the roster to daily rotation, the instance does not send reminder emails.
4. To resend a reminder, click Resend.
5. Click Update.

Related information
Assigning On-Call Scheduling roles
Manage shifts from the Calendar view

Create a shift template to simplify configuring shifts
You can predefine sets of shift settings using shift templates. Shift templates are a subset of group templates.

Before you begin
Role required: rota_admin
Procedure

1. Navigate to On-Call Scheduling > Administration > Group Templates.
2. From the list of group schedule templates, select the template for which you want to create a new shift template.
3. On the related list of the shift templates, click New and then fill in the On-Call Shift Template form.

New shift template fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift name</td>
<td>The friendly name of the shift template. For example, US or EMEA.</td>
</tr>
<tr>
<td>Schedule type</td>
<td>The type of schedule. You can specify settings for a Simple schedule. Alternatively, you can select an existing template.</td>
</tr>
<tr>
<td>All day</td>
<td>Select the check box if the shift spans the full workday.</td>
</tr>
<tr>
<td>Start Time</td>
<td>If this is not an all-day shift, then specify the start time of the shift.</td>
</tr>
<tr>
<td>End time</td>
<td>The end time of the shift.</td>
</tr>
<tr>
<td>End time day</td>
<td>The day on which the shift should end.</td>
</tr>
<tr>
<td>Repeat on</td>
<td>For repeating shifts, the days of the week on which the shift should repeat.</td>
</tr>
<tr>
<td>On-Call Group Template</td>
<td>The group template to which the shift belongs.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The time zone of the members of the rosters that will fill the shift.</td>
</tr>
<tr>
<td>Specify holiday Schedule</td>
<td>Select the check box to specify the holiday schedule for the shift. The setting is applied to the shift.</td>
</tr>
</tbody>
</table>

4. Click Submit.
Results
The template is now available for you to choose when creating or updating a shift.

Configure the lead time for email reminders
On-Call Scheduling includes a scheduled job that checks if any shift members should be notified about upcoming On-Call commitments. Modify the lead time for the reminder to be sent.

Before you begin
Role required: rota_manager or rota_admin

Procedure
1. Navigate to On-Call Scheduling > On-Call Calendars.
2. Right-click the shift and select Edit Shift.
3. Update the Reminder lead time (days) value for the on-call schedule record or for any of its rosters.
   The reminder lead time defined on a roster is always respected. If no lead time is defined, the instance uses the schedule reminder lead time. If the reminder lead time is not defined for either the schedule or its rosters, then the instance uses a default of 2 days.

   Note: The Reminder lead time on the Roster form is different from the # reminders and Time between reminders values in the Escalation Settings section of the form.

   The escalation settings are used only to configure reminders for escalations. The Reminder lead time is in the Reminder Communication section of the Roster form, and is used to email reminders for upcoming on-call commitments.

Manage requests for time off
As a shift manager, you can review and approve time-off requests from shift members. You also specify the roster member who can cover for the time.

Before you begin
Role required: rota_manager

Procedure
1. Navigate to Self-Service > My Approvals.
2. Select the time-off request record to approve.
The time-off request displays the details of the time-off requested by the member of your team. In this example, the dark blue shade with stripes represents the requested time-off. A message also gives you the request details including that of the proposed cover.

3. Optional. Enter comments in the **Comments** section.

4. Select **Approve** or **Reject**.
   
   - For rejection, the On-Call calendar no longer indicates the time-off details and the requester receives email notification.
   
   - For approval, the On-Call calendar indicates the time-off details and the requester receives email notification.

**Related information**

**Assigning On-Call Scheduling roles**
Resolve gaps, conflicts, and time-off requests in a shift

Review and resolve gaps and conflicts. Find a replacement on-call member for time-off requests to ensure proper support coverage.

Before you begin
Role required: rota_manager

About this task
Possible reasons for gaps are:

• Time off without coverage
• User has been moved out of the group
• User is marked as inactive

A conflict is possible if a user is assigned as both the primary and secondary point of contact for a shift.

Procedure

1. Navigate to On-Call Scheduling > On-Call Schedules.
2. Click a shift card.

   Note: If you are a shift manager or roster member, the schedule view opens. In all other cases, you are redirected to the calendar view. For more information on on-call scheduling calendars, see Manage shifts from the Calendar view.

   • The On-Call Schedules page open. For more information, see Updating an On-Call schedule
   • The pending actions for the current shift appear in the Pending Actions section.

3. To resolve gaps or conflicts, perform the following steps.

   a. Click Review in the Pending Actions section.
      The calendar view appears, and gaps or conflicts are highlighted.

   b. Click the Information icon (i) to view gaps.

   c. Right-click the shift and select Edit shift from the Actions list.
d. Navigate to the **Rosters** related list and select the roster where the user is unavailable.

e. In the **Members** related list, add a **To** value for the unavailable user.

f. Add a new member with a **From** value to close the gap.

4. To resolve a time-off request, perform the following steps.

   a. Click **Review** in the **Pending Actions** section. The calendar view appears, and time-off requests are highlighted.

   b. Right-click the shift and select **Manage shift** from the **Actions** list. The Manage Shift dialog box appears.

   c. Approve the time-off requests.

**Managing roster members**

You can manage roster members by adding and removing users to or from the roster as needed. You can also modify the order number for a member without affecting the past shift schedule.

ℹ️ **Note:** To manage roster members, the system administrator or rota_admin must enable the **Manage roster members** (com.snc.on_call_rotation.allow_manage_members) system property.

For zBoot users, this property is active and set to true by default. If you upgraded from earlier versions, the property must be created and enabled to use the UI actions (Add, Remove, and Move). If the property is not enabled, you can use the Edit action to manage roster members, but it does not auto-balance rosters.

**Add a new or returning employee to a roster**

You can add a new employee or an employee who had previously been a member to a roster.

**Before you begin**

Role required: rota_manager, rota_admin, or admin
Procedure

1. Navigate to **On-Call Scheduling > My Group Schedules**.
2. Open the required shift form.
3. In the Rosters related list, click the information icon (ℹ️) for the roster to which you want to add a member.
4. Click **Open Record**.
5. On the Roster form, click **Add** in the Members related list.
6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From date</td>
<td>Date on which the employee will join the roster.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The member will be active on the roster in the next rotation.</td>
</tr>
<tr>
<td>Add after member</td>
<td>Name of the member after whom the new member will be in the order. The order number determines where the member starts on the rotation cycle.</td>
</tr>
<tr>
<td>Shift</td>
<td>Name of the shift.</td>
</tr>
<tr>
<td>Member</td>
<td>Name of the member to add to the roster.</td>
</tr>
<tr>
<td>Rosters</td>
<td>Rosters affected after modifying the order of a member. This field is auto-populated by comparing the members in the rosters. If a member exists in more than one roster, both the rosters are auto-populated to avoid conflicts in schedule.</td>
</tr>
<tr>
<td>Current roster</td>
<td>Roster from which you navigated to the form.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.  
The instance adds the employee to the roster.

   **Note:** For a returning employee: The instance displays two shift member records for the same employee with different start and end validity dates.

**Modify the order of a member in a roster**

You can modify the order number for a member without affecting the past shift schedule.
Before you begin
Role required: rota_admin, rota_manager, or admin

Procedure
1. Navigate to On-Call Scheduling > My Group Schedules.
2. Open the required shift form.
3. In the Rosters related list, click the information icon (i) for the roster in which you want to modify the order of a member.
4. Click Open Record.
5. On the Roster form, click Move in the Members related list.
6. On the form, fill in the fields.

On-Call Move Member form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From date</td>
<td>Date from when the order change applies to the member.</td>
</tr>
<tr>
<td>Note:</td>
<td>The member's order will be active on the roster in the next rotation.</td>
</tr>
<tr>
<td>Member</td>
<td>Name of the member to update the order.</td>
</tr>
<tr>
<td>Current roster</td>
<td>Roster from which you navigated to the form.</td>
</tr>
<tr>
<td>Shift</td>
<td>Name of the shift.</td>
</tr>
<tr>
<td>Move type</td>
<td>Type of move.</td>
</tr>
<tr>
<td>• Move after</td>
<td>Moves the order of the member after the target member.</td>
</tr>
<tr>
<td>• Swap</td>
<td>Swaps the order of the member with the target member.</td>
</tr>
<tr>
<td>Target member</td>
<td>Name of the member with whom the order is swapped or after whom the member will be in the execution order.</td>
</tr>
<tr>
<td>Rosters</td>
<td>Rosters affected after modifying the order of a member. This field is auto-populated by comparing the members in the rosters. If a member exists in more than one roster, both the rosters are auto-populated to avoid conflicts in schedule.</td>
</tr>
</tbody>
</table>
7. Click **Submit**.
   The member appears in the new order. The original record has a **To** date for the end of validity and the new record has the current date as the **From** date for the start of validity.

**Remove a member from a roster**
You might remove a member from a roster, for example, if they are no longer a member of the organization or of the group.

**Before you begin**
Role required: rota_manager, rota_admin, or admin

**Procedure**

1. Navigate to **On-Call Scheduling > My Group Schedules**.
2. Open the required shift form.
3. In the Rosters related list, click the information icon (עיון) for the roster from which you want to remove a member.
4. Click **Open Record**.
5. On the Roster form, click **Remove** in the Members related list.
6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From date</td>
<td>Date from when the member is removed.</td>
</tr>
<tr>
<td>Rosters</td>
<td>Rosters affected after modifying the order of a member. This field is auto-populated by comparing the members in the rosters. If a member exists in more than one roster, both the rosters are auto-populated to avoid conflicts in schedule.</td>
</tr>
<tr>
<td>Delete member</td>
<td>Option to delete the member record.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CAUTION:</strong></td>
<td>When you enable this option to delete the member record, the deleted member rotation history is removed, and the rotation history of other members is affected.</td>
</tr>
<tr>
<td>Member</td>
<td>Name of the member to remove from the roster.</td>
</tr>
<tr>
<td>Current roster</td>
<td>Roster from which you navigated to the form.</td>
</tr>
<tr>
<td>Shift</td>
<td>Name of the shift.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

### Related information

Assigning On-Call Scheduling roles

### Configure or update an On-Call schedule

Create an On-Call schedule or edit an existing schedule by defining shifts and rosters.

**Before you begin**

Role required: rota_admin, rota_manager

**About this task**

You can use the wizard to create an on-call schedule using an existing template or you can create shifts from scratch. You can create multiple shifts at given time and can preview shifts while creating them. This enables you to create rosters, define escalation policies, and review and publish shifts.

After running the wizard, you can adjust individual roster, escalation, and reminder settings to fine-tune the setup. You can also enable on-call notifications by setting up rotation workflow triggers.

**Procedure**

1. Navigate to **On-Call Scheduling > Create/Edit Schedule**.
2. In the **Define Schedule**, from the **Select Group** choice list, select the group for which you are defining the schedule.
1. **Note:** You can edit an existing shift for a selected group. If you want to create a new schedule, click **Add shift** button.

3. Choose an existing template for the shifts or create a new shift.

4. Optional. Select the **Allow Shift Schedule overlap** check box to allow overlapping schedules for shifts within the group. For example, if a group has a 24x7 schedule, you can create multiple schedules for the group. Shift overlap is required to have a hand-off period between shifts so that multiple shifts can be on-call for the same duration.

   If you select **Allow Shift Schedule overlap**, then the **Escalation rule on Shift overlap** check box appears.

5. Optional. Select the **Escalation rule on Shift overlap** check box to specify which shift needs to be notified of an escalation during a shift overlap. You can escalate to an incoming, an outgoing, or to all shifts.

6. Fill in the form fields.

### Define Schedule

<table>
<thead>
<tr>
<th>Question</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the shift that appears on the On-call calendar page.</td>
</tr>
<tr>
<td>Would you like to use an existing schedule?</td>
<td>Option to use an existing schedule.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Yes</strong> to use an existing or predefined shift.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>No</strong> to create a new schedule.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Select the value to base your schedule on. Some options are available in the base system, for example, 24x7, Workday 8-5. This option appears only if you answer <strong>Yes</strong> to Would you like to use an existing schedule?. The logged-in user’s time zone is used as the basis for these schedules. If the logged-in user does not have a time zone specified, the instance time zone is used.</td>
</tr>
<tr>
<td>Start date</td>
<td>The date on which the shift is scheduled to begin.</td>
</tr>
<tr>
<td>Specify holidays</td>
<td>Option to define holidays.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>Yes</strong> to define holidays for the on-call shift. You can select an existing holiday schedule.</td>
</tr>
<tr>
<td></td>
<td>• Select <strong>No</strong> to not specify holidays for the shift.</td>
</tr>
<tr>
<td>Question</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Holiday Schedule</td>
<td>Specify a holiday schedule for the group.</td>
</tr>
<tr>
<td>Additional fields</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The following fields are displayed only when the <strong>Would you like to use an existing schedule?</strong> field is set to <strong>No</strong>.</td>
<td></td>
</tr>
<tr>
<td>Time Zone</td>
<td>The time zone in which the shift operates.</td>
</tr>
<tr>
<td>Is the shift for this schedule all day?</td>
<td>List of options. Specify whether this shift is an all-day shift.</td>
</tr>
<tr>
<td>Start</td>
<td>The time of day the shift is scheduled to start. The start and end time represent one shift. The date is different only if the shift spans midnight.</td>
</tr>
<tr>
<td>End</td>
<td>The time of day the shift is scheduled to end. The start and end time represent one shift. The date is different only if the shift spans midnight. For example, for the 8 a.m. to 8 p.m. shift, the start is 2014-01-01 08:00:00 and the end is 2014-01-01 19:59:59. For the 8 p.m. to 8 a.m. shift, the start is 2014-01-01 20:00:00 and the end is 2014-01-02 07:59:59.</td>
</tr>
<tr>
<td>Repeats</td>
<td>The days that the shift repeats.</td>
</tr>
<tr>
<td><strong>Note:</strong> The wizard does not provide a monthly or yearly option. Creating a monthly or a yearly shift by editing the schedule manually is not advised because it is hard to determine the on-call person over a long period. In this case, create a yearly or a monthly schedule with only one roster and one member so that the same person is always on-call. Make any exceptions as a one-time change in the roster for the shift.</td>
<td></td>
</tr>
<tr>
<td>Send On-Call Reminders</td>
<td>Option to send on-call reminders to members of the roster.</td>
</tr>
<tr>
<td>Reminder lead time (days)</td>
<td>Lead time for email reminders.</td>
</tr>
<tr>
<td>Question</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong> This field is displayed only when the <strong>Send On-Call Reminders</strong> option is selected.</td>
<td></td>
</tr>
<tr>
<td>Coverage interval</td>
<td>Interval for updates of coverage details. Specifies whether you want to update the subscribed calendar with weekly or daily coverage details.</td>
</tr>
<tr>
<td>Get coverage for</td>
<td>Number of weeks or days for which you want to update the subscribed calendar.</td>
</tr>
</tbody>
</table>

**Note:** The instance saves the schedule and adds it to the list of existing schedules.

7. Click **Next**.

8. **Optional:** Click **Add Shift** to add another shift to the schedule if needed.

9. Use the **Members** page to specify members for a shift and rosters.

**Configure Members**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roster Name</td>
<td>Use the edit icon to edit the name of the roster that you are adding members to.</td>
</tr>
<tr>
<td>Which members would you like to be in your schedule?</td>
<td>Move the members you want to add from Available list to Selected list.</td>
</tr>
<tr>
<td>Rotation start date</td>
<td>Date on which the rotation needs to start.</td>
</tr>
<tr>
<td>Rotation interval</td>
<td>Type of the rotation interval.</td>
</tr>
<tr>
<td>Rotate every</td>
<td>Frequency of the rotation interval.</td>
</tr>
<tr>
<td><strong>Note:</strong> This field appears only if the <strong>Rotation interval</strong> field is set to <strong>Weekly</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day of week for rotation</td>
<td>Day of the week on which the roster rotation should start. When this field is specified, roster rotation happens based on the specified frequency and the day of the week.</td>
</tr>
<tr>
<td><strong>Note:</strong> This field appears only if the <strong>Rotation interval</strong> field is set to <strong>Weekly</strong>.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Send On-Call Reminders</td>
<td>If selected, on-call reminders are sent to the members of the roster.</td>
</tr>
<tr>
<td>Reminder lead time (days)</td>
<td>Lead time for email reminders.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is displayed only when the <strong>Send On-Call Reminders</strong> option is selected.</td>
</tr>
</tbody>
</table>

10. Click **Next Step**.  
The Escalation Setup form appears.

11. Use the form to specify escalation settings.

### Escalation Setup steps

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation type</td>
<td>Method used to determine who receives an escalation notification. Its value is automatically set to Rotate Through Members if a shift has only one roster. The escalation path goes through all members of that roster. If a shift has more than one roster, the default value is Rotate Through Rosters. The escalation path goes through all the rosters to determine who to notify. Click Override escalation to change the default setting.</td>
</tr>
</tbody>
</table>
| Catch-All         | Specifies users who receive a notification when no other on-call users have acknowledged the escalation. The value can be none, a group manager, a shift manager, an individual, or any or all roster members.  
  - Select Notify Individual to specify a member of the group to notify.  
  - Select Notify All to specify a shift. All shift members are notified. |

12. Click **Next Step**.

13. Click **Edit Reminder** to edit the reminder settings for an escalation.  
The Edit Reminder form opens.

14. Use the form to edit the reminder settings for a schedule.
**Escalation Reminder form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td># reminders</td>
<td>When escalations are configured for this group, the instance first sends this number of reminders before notifying the backup personnel.</td>
</tr>
<tr>
<td>Time between reminders</td>
<td>The interval of time between reminders. Default: 15 minutes. If your choice is not in the list, select the closest value. <strong>Edit the roster</strong> to update the number of reminders after the schedule is generated.</td>
</tr>
<tr>
<td>Time before escalation</td>
<td>The interval of time to wait before escalating a task.</td>
</tr>
</tbody>
</table>

15. Review the schedule and then click **Save**. The schedule is saved in Draft mode.

16. Select **Send subscriptions** to send a subscription URL to an on-call member after the shift is published.

17. After the schedule is complete, click **Finish** to save and publish the schedule.

**What to do next**
Perform one of the following procedures to update the schedule.

**View On-Call schedules**
The tiled grouping of on-call shift schedules helps you to review shifts rather than having to search through all shifts in the system.

**Before you begin**
Role required: itil, rota_manager, or rota_admin

**About this task**
Each card on the On-Call Schedules page represents a shift and identifies the on-call members. A card displays the group name, the shift name, and rosters (Primary and Secondary).
On-Call schedules enable you to view the presence of on-call members. For more information on presence, see **User presence**.
**Note:** By default, On-Call schedules are loaded in batches of 20. You can use the `com.snc.on_call_rotation.landing_page.group_limit` property to update the setting. For details, see System properties for On-Call Scheduling.

**Procedure**

1. Navigate to On-Call Scheduling > On-Call Schedules.

   **Note:** For a group with overlapping shifts, shift cards are displayed based on the escalation setting.

   The following tabs appear:
   - **Pinned On-Call Schedules:** Displays a personalized list of who is on-call for the groups you are most interested in. Pin groups here for fast access.
   - **My On-Call Schedules:** Displays only the On-Call schedules that you manage or are a member of.
   - **All On-Call Schedules:** Displays the list of all groups that have active On-Call schedules. You can also find who is on-call for groups that you have not pinned.

   Use the filter to display On-call schedules by group, schedule, or username.

2. Optional: To pin a shift card, point to the card on the **All On-Call Schedules** tab and click the Pin icon (📌) icon. To unpin a card, click the Pin icon in the **Pinned On-Call Schedules** tab.

   **Note:** When you pin a shift card of a group with overlapping shifts, all other shift cards of that group are also pinned.

3. To view details of a shift, click the shift card.

   **Note:** Each shift card displays only the first two rosters.

   If you are a shift manager or roster member, the schedule opens. For more information, see Updating an On-Call schedule. In all other cases, you are redirected to the calendar view. For more information on on-call scheduling calendars, see Manage shifts from the Calendar view.

4. Optional: To view roster and escalation details, click Roster and escalation details on the shift card.

   A dialog box displays the following tabs:
   - Roster: Displays a list of all rosters and contact number, email address, group, and the shift for the active On-Call member.
   - Escalation Path: Displays the escalation path defined for the shift.
Note: By default, the details of the on-call member of the primary roster are displayed. Click Send a direct message to send a direct message to the on-call member. Alternatively, call the member if the Notify WebRTC is configured. For more information on real-time messaging, see Connect. For information on Notify WebRTC, see Forward to notify client workflow activity. For information on the Specify a valid Notify Number with voice capability property that enables the Notify WebRTC for on-call, see System properties for On-Call Scheduling.

5. Optional: To view gaps and conflicts in a shift, click the info badge on the shift card.
   • This is applicable only for group managers, shift managers, and delegated shift managers.
   • This information is displayed based on the setting of the com.snc.on_call_rotation.landing_page.show_pending_actions property. For more information, see System properties for On-Call Scheduling.

Updating an On-Call schedule
Shift managers and members can use the Schedules tabs to view and update the on-call schedules of a group. Shift managers can review, manage, and resolve gaps or conflicts in your On-Call schedule from a single view.

Opening the Schedules page
To open and start working on a schedule, navigate to On-Call Scheduling > On-Call Schedules and then click the card for the group.

Overview tab
This tab gives an overview of the current shift. The following sections are available:
   • On-Call: Displays information about the current on-call shift. From here, you can:
     ◦ Navigate to the previous and next shifts.
     ◦ View the roster and escalation details of the current shift. When you click Roster and escalation details, a dialog box displays the following tabs:
       ■ Roster: Displays a list of all rosters along with its active on-call member. Information of the on-call member such as the contact number, email address, group, and the shift to which the user belongs to is also available.
       ■ Escalation Path: Displays the escalation path defined for the shift.
       ■ Profile: Displays the user profile of the primary on-call member. You can send a direct message to the on-call member by clicking Send a direct
**message** or call the member if Notify WebRTC for on-call is set up. For more information on real-time messaging, see **Connect**. For information on Notify webrtc, see **Forward to notify client workflow activity**. For information on the **Specify a valid Notify Number with voice capability** property that enables the Notify WebRTC for on-call, see **System properties for On-Call Scheduling**.

- **Contact Preferences**: The contact preferences set for the primary on-call member.

- **Pending Actions**: Displays the pending actions for the group’s on-call schedule. You can review gaps, conflicts, and time-off requests to find a replacement and ensure proper support coverage. For information on resolving the pending actions, see **Resolve gaps, conflicts, and time-off requests in a shift** and **Resolve gaps, conflicts, and time-off requests in a shift**.

  - **Note**: This section is displayed only for a shift manager.

- **Your Upcoming Shifts**: Displays your upcoming shifts in a calendar view.
Note: This section is displayed for a shift member or a Shift Manager who is a shift member.

- **On-call calendar**: This section displays the calendar view of all shifts of the group. By default, the week view is displayed. For more information on on-call calendar, see Manage shifts from the Calendar view.

**Shifts tab**
This tab displays all shifts defined for the user group. From here, you can edit a shift or create a custom escalation policy to override the default policy. For information on editing the escalation type, see Create an escalation policy.

You can also edit contact preferences from this tab. For more information on configuring a contact preference, see Configure my availability and contact preferences.

**Settings tab**
This tab displays the group preferences set for your group’s on-call shift. If not already set, click Create Custom Group Settings to set the group preferences. For more information about group preferences, see Configure preferences for a user group.

Note: The group preferences set here affect only this group. These settings override the global settings.

To view on-call properties, click View Global Settings.

Note: View Global Settings is only visible to rota_admin.

**Update a schedule entry**
You can deactivate a schedule entry or update setting like schedule entry type, date, or time.

Before you begin
Role required: rota_admin or rota_manager

Procedure
1. Navigate to On-Call Scheduling > On-Call Calendars.
   The on-call coverage for your group’s calendar appears.
2. Click the shift name and navigate to Actions > Edit span.
   The Schedule Entry dialog box is displayed.
3. Update the fields as needed.

### Schedule Entry

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Modify the name of the schedule entry, if required.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of schedule entry. For example, on-call or time off.</td>
</tr>
<tr>
<td>Group</td>
<td>The <strong>Group</strong> field is empty by design.</td>
</tr>
<tr>
<td>Show as</td>
<td>Select what the schedule entry must be displayed as. For example, busy or on-call.</td>
</tr>
</tbody>
</table>

**CAUTION:** If the **Group** field is populated, then the spans for the entry are not displayed.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When</td>
<td>Select the appropriate start and end date, and time for the schedule entry.</td>
</tr>
<tr>
<td>All day check box</td>
<td>Select the check box to make the schedule entry active for the entire duration.</td>
</tr>
<tr>
<td>Timezone</td>
<td>Displays the time zone for the schedule entry. This cannot be modified.</td>
</tr>
</tbody>
</table>
| Repeats      | Select the frequency with which the schedule entry repeats. For example, daily or weekly. The following fields appear if you select **Monthly**:
  - **Monthly type**: specify the date of the month when the schedule entry repeats.
    The following fields appear if you select **Yearly**:
  - **Yearly type**: specify the date of the year when the schedule entry repeats or if it is floating. If you select the **Floating** option, then the following fields appear:
    - **Float week**: Select the week of the month when the schedule entry repeats.
    - **Float day**: Select the day of that week when the schedule entry repeats.
    - **Month**: Select the month when the schedule entry repeats.
| Repeat every | If the schedule entry is selected to repeat, then specify how often it repeats. For example, if you select weekly repetitions, specify the frequency such as every week or every two weeks. |
| Repeat on    | If the schedule entry is selected to repeat, then specify when it repeats. For example, if you select weekly repetitions, specify the days of the week when it would repeat. |
| Repeat until | If the schedule entry is scheduled to repeat, then specify an end date until which the schedule entry repeats itself. |
| Deactivate   | Deactivate the schedule entry. A warning message appears.                   |
| Delete       | Delete the schedule entry. A warning message appears.                       |

4. Click **Update**.

**Related information**

**Assigning On-Call Scheduling roles**
Specify the sources of contact information for schedule notifications

Configure the communications methods that shift managers can choose from to send on-call schedule notifications. For example, add email and phone contact sources.

Before you begin
Role required: admin

Procedure
1. Navigate to On-Call Scheduling > Administration > Contact Sources.
2. Click New and then fill in the form.

On-Call Contact Source form

<table>
<thead>
<tr>
<th>Name</th>
<th>Unique and meaningful display label for the type of contact source.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Table that contains the contact source.</td>
</tr>
<tr>
<td>User Field</td>
<td>Reference field to the user table. This field appears only for some tables.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the contact source for use.</td>
</tr>
<tr>
<td>Source Type</td>
<td>Type of communication method.</td>
</tr>
<tr>
<td>Source</td>
<td>- For email, the source of the email address.</td>
</tr>
<tr>
<td></td>
<td>- For phone numbers, the source of the phone number.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Override contact preferences for a shift

Override all shift members' contact preferences to enforce a communication channel, for example, in case of an emergency.

Before you begin
Role required: rota_admin, rota_manager
**Procedure**

1. Use one of the following methods to open the Edit Escalation and Contact Preferences page:

   - a. Navigate to **On-Call Scheduling > On-Call Schedules**. The On-Call Schedules page opens to the All On-Call Schedules tab.
   - b. Click a schedule card.
   - c. On the **Shifts** tab, click the Actions icon ( ) for the shift and select **Edit Escalation and Contact Preferences**.

   - a. Navigate to **On-Call Scheduling > My Group Schedules**.
   - b. Select the shift.
   - c. Click **Edit Escalation and Contact Preferences**

2. On the **Contact Preferences** tab, click the contact **Attempt** method to configure.
   The **Contact Preferences** dialog box appears.

3. Select the contact methods that the instance should use for all shift members for the selected contact attempt.
   Depending on your instance configuration, you can specify any or all of the following notification methods:
   - SMS text
   - Email
   - Slack
   - Voice

   **Note:** SMS and voice require that Notify is active.

4. Enable the **Override user preference** option.

**Manage shifts from the Calendar view**

The Calendar view displays all shifts for a user group for a specified time interval. Use the Calendar view of an On-Call schedule to update or manage shifts.

**Before you begin**

Role required:
- View and update: rota_admin, rota_manager, or admin
- View only: itil
About this task

- For information on updating a shift, see Update shift details from the On-Call calendar.
- For information on managing a shift, see Configure or update an On-Call shift.

Procedure

1. Navigate to On-Call Scheduling > On-Call Calendars.

2. Click the Calendar View icon ( ) to open the calendar view of shifts. By default, the calendar displays one month of shifts.

   Fastpath: The Time Zone view displays shift members grouped by shift within the specified geographical time zone. To open the Time Zone view on this page, click the Time Zone icon ( ). See Manage shifts from the Timeline view.

3. Perform any of the following operations to organize the view for your needs:
   - Specify the time period that appears: View events for the current day, week, or month: In the title bar, click Day, Week, or Month.

   Note: You cannot view the calendar for a month in the Timeline view.
   - Navigate to the previous or the next occurrence of the time period: In the title bar, click the left or the right arrow next to Today ( ).
   - View the event of any specific day, week, or month: In the title bar, click the Calendar icon ( ) and specify the date.
   - View the list of navigation shortcuts: In the title bar, click the keyboard shortcuts icon ( ).

4. Configure the view: Click the Filter icon ( ).
   - To show working hours for a time zone, enable Time zone.
   - To view roster assignments within a time zone, click the Primary, Secondary, or Tertiary check box as needed.
   - To view roster assignments for all rosters in all time zones, select the Show all rosters check box.
To show gaps: In the **Review options** section, enable **Show gaps**. An info icon indicates a shift with gaps. Click the icon to view the gaps. Gaps occur when no one is on-call when support coverage is required. Possible reasons:

- Time off without coverage.
- User has been moved out of the group.
- User is marked as inactive.

For information on resolving gaps and conflicts, see [Resolve gaps, conflicts, and time-off requests in a shift](#).

To show conflicts: In the **Review options** section, enable **Show conflicts**.

For example, a conflict occurs when a user is assigned as both primary and secondary point of contact for a shift. An info icon indicates a shift with conflicts. Click the icon to view the conflicts.

For information on resolving gaps and conflicts, see [Resolve gaps, conflicts, and time-off requests in a shift](#).

5. To save the view settings, click the Bookmark this filter icon (★).
Manage shifts from the Timeline view

Use the Timeline view of an On-Call schedule to update or manage shifts based on the geographical location of roster members.

Before you begin
Role required: rota_admin, itil, rota_manager, or admin

About this task
• For information on updating a shift, see Update shift details from the On-Call calendar.
• For information on managing a shift, see Configure or update an On-Call shift.

Procedure
1. Navigate to On-Call Scheduling > On-Call Calendars.

2. Click the Timeline view icon ( ).
   
   © Fastpath: The Calendar view on this page displays all shifts for a user group for a specified time interval. To open the Calendar view, click the Calendar View icon ( ). See Manage shifts from the Calendar view.

3. Perform any of the following operations to organize the view for your needs:
   • Specify the time period that appears: View events for the current day, week, or month: In the title bar, click Day, Week, or Month.

   © Note: You cannot view the calendar for a month in the Timeline view.
   • Navigate to the previous or the next occurrence of the time period: In the title bar, click the left or the right arrow next to Today ( ).
   • View the event of any specific day, week, or month: In the title bar, click the Calendar icon ( ) and specify the date.
   • View the list of navigation shortcuts: In the title bar, click the keyboard shortcuts icon .

4. Configure the view: Click the Filter icon ( ).
• To show working hours for a time zone, enable **Time zone**.

• To view roster assignments within a time zone, click the **Primary**, **Secondary**, or **Tertiary** check box as needed.

• To show gaps: In the **Review options** section, enable **Show gaps**. An info icon indicates a shift with gaps. Click the icon to view the gaps. Gaps occur when no one is on-call when support coverage is required. Possible reasons:
  ◦ Time off without coverage.
  ◦ User has been moved out of the group.
  ◦ User is marked as inactive.
  
  For information on resolving gaps and conflicts, see **Resolve gaps, conflicts, and time-off requests in a shift**.

• To show conflicts: In the **Review options** section, enable **Show conflicts**.

  For example, a conflict occurs when a user is assigned as both primary and secondary point of contact for a shift. An info icon indicates a shift with conflicts. Click the icon to view the conflicts.

  For information on resolving gaps and conflicts, see **Resolve gaps, conflicts, and time-off requests in a shift**.

5. To save the view settings, click the Bookmark this filter icon (🌟).

### Create a group template to simplify configuring schedules

Create templates to help your group create on-call schedules. For example, use the 24/7 template, which is available in the on-call demo data, to create on-call schedules for continuous service.

**Before you begin**

Role required: rota_admin

**Procedure**

1. Navigate to **On-Call Scheduling** > **Administration** > **Group Templates**.

2. Click **New** to create a new template. In the new record form that opens, enter the following details.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the new template. For example, 8-5.</td>
</tr>
</tbody>
</table>
3. Click **Submit**.

**On-Call Scheduling workflows**

Workflows perform On-Call Scheduling operations.

**Workflows installed with On-Call Scheduling**

**On-Call: Assign by Acknowledgement**

The workflow uses data from escalation settings, including overlapping shifts and custom escalation settings for shifts and rosters. Depending on the settings, the workflow moves through the escalation path and sends notifications by SMS, voice, or email that ask users to accept a task.

To send notifications, a trigger rule is required. Trigger rules supersede some On-Call business rules in earlier releases. To define a trigger rule, you must deactivate business rules that you customized in earlier releases.

The workflow respects time off as specified in rosters. Roster members with time off are not included in the escalation path and no notifications are sent to them.

If **Force communication channel** is specified in the Escalation settings for rosters, the preferred contact method (user device) is used: SMS, email, or voice. If the preferred method is SMS and the on-call member does not have an SMS device defined, the user is not contacted even if the user has an email address. When forcing a communication channel on an escalation level does not succeed, no further communication attempts are made. The failed contact attempt is logged. The setting **Force communication channel** is available only if Notify is installed.

- Until acknowledged, sends on-call notifications to escalatees based on the escalation policy and configured contact preference.
- Logs escalation details for each communication.
- Resumes the workflow immediately after rejection.
- Catch-all users are treated like all other escalation users: A response is expected and the incident might be assigned to them based on their response.
On-Call: Escalations by Email

- Until acknowledged, sends on-call email notifications to escalatees based on the escalation policy and configured email contact preferences.
- Logs escalation details for each communication.
- Catch-all users are treated like all other escalation users: A response is expected and the incident might be assigned to them based on their response.

On-Call: Assign

Assigns the task to the current primary roster member.

On-Call: Check Assignment Response

- Triggered when an inbound SMS message is received.
- Based on the response in the message, assigns the task to the roster member.
- Updates the response in the corresponding notification record.

On-Call: Assign by Acknowledgement Voice

- Triggered when an outbound call is made from the on-call number to any user or device.
- Based on the response to the voice call, assigns the task to the roster member.
- Updates the response in the corresponding notification record.

On-Call: Time-off approval

- Triggered when vacation time off (PTO) is requested by a user.
- Sends approval requests to appropriate managers.

On-Call: Conference Call Escalation

- Triggered when a conference call is initiated and a group is added to the call.
- Makes a voice call to the first group member in the escalation policy.
- If the member does not join the conference call, then escalates to next group member in the policy.
Workflow Activities for On-Call Scheduling

Workflow activities in On-Call Scheduling workflows.

Escalation workflow activities

On-Call: Log Escalation Start

Creates an escalation record based on group, task, and workflow details

⚠️ Note:

The escalation that the workflow creates the
workflow.scratchpad.escalationSysId sys_id. Use the sys_id in
any of the other workflow activities.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>sys_id of the group that the escalation belongs to.</td>
</tr>
<tr>
<td>Table</td>
<td>Table name of the task record of the incident.</td>
</tr>
<tr>
<td>Source</td>
<td>sys_id of the task record on which the escalation happened.</td>
</tr>
<tr>
<td>WorkflowDefinition</td>
<td>sys_id of the workflow definition that is used to escalate.</td>
</tr>
<tr>
<td>WorkflowContext</td>
<td>sys_id of the workflow context.</td>
</tr>
<tr>
<td>ParentEscalationLevelId</td>
<td>sys_id of the parent escalation in the case that the escalation was triggered from another escalation.</td>
</tr>
</tbody>
</table>
| Category                | Category of the escalation. One of: [assign_by_acknowledgement,
auto_assignment,
notify_manual_assignment,conferencing].                                   |
| Channels                | Comma-separated list of the channels used to communicate during the
escalation. Any or all of: [email, sms, voice, slack]. For example, sms,email,voice |
| IgnoreDefReminders      | If true, the workflow sends notification reminders as specified by the workflow, |
rather than as specified in On-Call Escalation settings. For example, in Conference On-Call escalations, the workflow might to dial the on-call members at one-minute intervals instead of the standard 15-minute intervals.

**On-Call: Log Escalation Level**

Creates an escalation level record given escalation and level details.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EscalationId</td>
<td>sys_id of the escalation to which the level belongs.</td>
</tr>
<tr>
<td>RotaId</td>
<td>sys_id of the shift for which the escalation is happening.</td>
</tr>
<tr>
<td>Level</td>
<td>Current escalation level. For example, 2.</td>
</tr>
<tr>
<td>Escalatee</td>
<td>Escalatee object at current escalation level. For example, getEscalationPlan()[1].</td>
</tr>
<tr>
<td>CatchAll</td>
<td>True if the escalation level belongs to a catch-all.</td>
</tr>
</tbody>
</table>

**On-Call: Log Escalation Attempt**

Creates a Contact attempt record given an escalation, level, and attempt details.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EscalationId</td>
<td>sys_id of the escalation to which the contact attempt belongs.</td>
</tr>
<tr>
<td>RotaId</td>
<td>sys_id of the shift for which the escalation is happening.</td>
</tr>
<tr>
<td>Level</td>
<td>Current escalation level. For example, 2.</td>
</tr>
<tr>
<td>ContactAttempt</td>
<td>Contact attempt number within the escalation level. For example, 1.</td>
</tr>
</tbody>
</table>

**On-Call: Log Escalation Communication**
Creates a communication record given escalation, level, attempt, and communication details.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EscalationId</td>
<td>sys_id of the escalation to which the communication belongs.</td>
</tr>
<tr>
<td>RotaId</td>
<td>sys_id of the shift for which escalation is happening.</td>
</tr>
<tr>
<td>Level</td>
<td>Current escalation level. For example, 2.</td>
</tr>
<tr>
<td>ContactAttempt</td>
<td>Contact attempt number within the escalation level. For example, 1.</td>
</tr>
<tr>
<td>EscalateeType</td>
<td>Type of escalatee to whom the communication is sent. One of: [user, device]</td>
</tr>
<tr>
<td>EscalateeId</td>
<td>sys_id of the user or device, depending on escalatee type.</td>
</tr>
<tr>
<td>CommType</td>
<td>Type of communication. One of: [sms, voice, email, slack]</td>
</tr>
<tr>
<td>CommValue</td>
<td>Phone number or email address, depending on communication type. For example, <a href="mailto:abel.tuter@servicenow.com">abel.tuter@servicenow.com</a></td>
</tr>
<tr>
<td>Status</td>
<td>Status of the communication. One of: [sent, failed].</td>
</tr>
<tr>
<td>Escalatee</td>
<td>Escalatee object at current escalation level. For example, getEscalationPlan()[1].</td>
</tr>
<tr>
<td>CatchAll</td>
<td>True if the escalation level belongs to a catch-all.</td>
</tr>
</tbody>
</table>

**On-Call: Log Escalation End**

Completes the escalation by setting active flag to false.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EscalationId</td>
<td>sys_id of the escalation.</td>
</tr>
</tbody>
</table>

**On-Call: Send Notification**

Sends notification to the current escalatee via voice, SMS, or Slack.
Setting | Description
--- | ---
Notification type | Type of notification. One of: [sms, voice, slack].
Message | Text of message to send to current escalatee if notification type is sms.
Notification detail | List of parameters that are required for a notification:
  - SMS: notify_number, users, groups, numbers
  - Voice: numberToCallFrom, numberToCall, user
  - Slack: slack user, taskId, catchAllOption, wfContextId

### On-Call: Manage Escalation Response

Manage an escalation response record (insert escalation record, clean escalation records, update response to an escalation). An escalation response record keeps track of a response received for an escalation through the SMS, voice, email, or Slack notification channels. An escalation response record is used to resume the **On-Call: Assign by Acknowledgement** workflow upon rejection of an escalation.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Context</td>
<td>Workflow context ID.</td>
</tr>
<tr>
<td>Escalatee Id</td>
<td>UserID of the current escalatee.</td>
</tr>
<tr>
<td>Table Name</td>
<td>Table name of the task record. For example, incident.</td>
</tr>
<tr>
<td>Current Record Id</td>
<td>sys_id of the task record.</td>
</tr>
<tr>
<td>Action Type</td>
<td>Type of action. One of: [add, clean, update]</td>
</tr>
<tr>
<td>Response</td>
<td>Response by escalatee to an escalation. One of: [accepted, rejected]</td>
</tr>
</tbody>
</table>

Example uses:
• Insert (add) - Workflow Context, Escalatee ID, Table Name, Current Record ID
• Clean - Workflow Context
• Update - Escalatee ID, Table Name, Current Record ID, Response

**Setting up Slack as a contact method**

You configure Slack to enable users to receive Slack notifications for escalations. To offer Slack as a contact method for shift members, you install the IntegrationHub spoke for Slack.

**Procedure: Configuring Slack for On-Call Scheduling**

For more information on the IntegrationHub implementation, see Slack spoke. To configure the integration with Slack, follow the instructions at: Set up Slack spoke.

The Slack spoke automates On-Call Scheduling notifications and responds to them. The following configurations support On-Call Scheduling notifications:

**Outbound Configurations**

**Slack > Outbound Configurations > On-Call: Assign by Acknowledgement**

Generates a general escalation message. Modify the record to customize the message template.
Slack > Outbound Configurations > On-Call: Assign by Acknowledgement Catch All

Generates a catch-all escalation message. Modify this record to customize the message template.

Inbound Decisions

Slack > Inbound Decisions > On-Call: Assign by Acknowledgement Decision

Defines inbound configuration for general response handling for Accept or Reject escalation messages. Use action_id as the key to map outbound configuration and inbound decisions for general escalations. The answer points to the subflow that is executed when the user clicks Accept or Reject. Modify the record to change the response handling behavior.
Slack > Inbound Decisions > On-Call: Assign by Acknowledgement Catch All Decision

Inbound configuration for catch-all response handling for escalation for Accept or Reject messages. Use `action_id` as the key to map outbound configuration and inbound decisions for catch-all situations. The answer points to the subflow that is executed when the user clicks **Accept** or **Reject**. Modify the record to change response handling behavior.
**Subflows**

**On-Call Assign by Acknowledgement**

This subflow handles incoming responses from Slack and then acts. For example, assign a task to a user and return an acknowledgement message. In case of rejection, the subflow logs the response and moves the escalation to the next escalatee.

**Insert Slack Response**

This action creates a record in the [sn_slack_ah_v2_inbound] table for incoming Slack responses. You can reference the response by workflow based on context_id.

**On-Call Response Controller**

This action performs appropriate operations when the user clicks Accept or Reject from Slack. It invokes the utility methods to perform actions from the OnCallSlackUtils script include.

**Setting up SMS and voice messaging as contact methods**

To send On-call escalation notifications as SMS or voice messages, you must configure use Notify. One important application is sending messages when an incident is assigned.

Configure the following items to use Notify with On-Call Scheduling:

- You must add at least one Notify phone number to the On-Call Group number group. This group is configured by default to handle inbound SMS responses (via On-Call: Check Assignment Response) that accepts or rejects an on-call assignment and to handle outbound voice calls (via On-Call: Assign by Acknowledgement Voice) to accept or reject assignments.

- You must configure workflows, such as the On-Call: Assign by Acknowledgement to drive escalations via SMS and Voice.
Related information
- Workflow: On-Call: Assign by Acknowledgement
- Controlling the on-call communication channel with Notify

On-Call roster members: Your schedules and preferences
You can view your schedule, see who is on-call with you, request time off, and set your preferences for contact methods.
You can view your schedule, see who is on-call with you, request time off, and set your preferences for contact methods.

Configure my availability and contact preferences
You specify your availability and the methods to use to contact you for On-Call escalations. The instance notifies you if an admin overrides your settings for some reason.

Before you begin
Role required: itil or admin

Procedure
1. Navigate to On-Call Scheduling > My Preferences
2. On the Contact Attempts tab, click the + icon and fill in the Availability form.

Availability form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique and meaningful name for this record of your availability settings.</td>
</tr>
<tr>
<td>User</td>
<td>The user for whom you are creating the availability (typically yourself).</td>
</tr>
<tr>
<td>Active</td>
<td>Option to enable this availability record. Select the check box to activate your availability.</td>
</tr>
<tr>
<td>Schedule type</td>
<td>Select an existing availability schedule or create a custom schedule.</td>
</tr>
</tbody>
</table>

Use these fields to create a custom availability schedule:
Start time
If this shift is not an all-day shift, then specify the start time of your availability.

End time
The end time of your availability.

Repeat on
The time of a single duration. For example, if you select weekly repetitions, specify the days of the week when you are available.

Time zone
The time zone of your availability.

Note: The time zone is not editable and is taken from your user's profile.

3. Click Submit.

4. On the Contact Preferences tab, click the contact Attempt method to configure.
   The Contact Preferences dialog box appears.

5. Select the contact methods that the instance should use to contact you while you are on-call.
   The methods you select are the contact methods that the instance should use for this contact attempt. Depending on your instance configuration, you can specify any or all of the following notification methods:
   • SMS text
   • Email
   • Slack
   • Voice

6. Repeat the process for each contact attempt.

   Note: Admins can specify overrides of your contact methods for all members of your group. Override settings appear on the Contact Overrides tab.

View my group schedules
You can see the on-call schedules for your groups.

Before you begin
Role required: itil
Procedure

1. Navigate to **On-Call Scheduling > My Group Schedules**.
2. Open a schedule.
3. **Optional:** To view a roster, click its order number in the **Rosters** related list.

**View my personal schedule on the My Schedule report**

You can view when you are on call and the escalation lineup for a particular date range.

**Before you begin**

Role required: itil

---

**Procedure**

1. Navigate to **On-Call Scheduling > Reports > My Schedule Report**.
2. In the **Show for** field, select a date range and then click **Submit**.

   The User Rotation Schedules list shows the shift, the roster, and the start and end times for each timeslot.

3. To view alternate rosters, expand an entry by clicking the arrow.
The alternate roster appears for that timeslot. For example, if you are the primary contact, this list shows secondary and tertiary contacts for the timeslot.

### Request time off and suggest who can cover

You can schedule your own time off and suggest a suitable cover from among fellow roster members.

**Before you begin**

To use this feature, the system administrator must enable the **Configuration to determine if PTO requests need approval** system property (com.snc.on_call_rotation.pto.approval.required).

**Role required:** itil

**Procedure**

1. Navigate to **On-call Calendar**.
2. Select the shift entry for the time off.
3. Click **Schedule Time Off** and fill in the form.
Schedule time off form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Member</td>
<td>The member getting time off (typically, yourself).</td>
</tr>
<tr>
<td>Starts and</td>
<td>Start and end dates for the time off.</td>
</tr>
<tr>
<td>Ends</td>
<td></td>
</tr>
<tr>
<td>Propose</td>
<td>Name of a roster member who can provide cover in the absence.</td>
</tr>
<tr>
<td>cover</td>
<td></td>
</tr>
<tr>
<td>All day</td>
<td>Option to specify that the time-off period involves full workdays.</td>
</tr>
<tr>
<td>event</td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td>Optional. Comments to help the shift manager understand the request.</td>
</tr>
</tbody>
</table>

4. Click **Schedule**.
   The time off is tentatively scheduled in your On-Call calendar.

**View my On-Call calendar on my calendar app**
You can subscribe to your On-Call calendar using your personal calendar client.
**Before you begin**

1. Ensure that your calendar client uses and supports the iCalendar format.
2. Ensure that your calendar client can subscribe to an external calendar.
3. If calendar client meets the requirements, ask your shift manager to send your On-Call calendar subscription URL by email notification.

⚠ **Attention:** You must provide your instance credentials to authenticate yourself to use the subscription URL to view On-Call events. Currently, only the Calendar application on Mac OS X 8.0 and newer and the Outlook application on Windows 2013 and newer support authenticated calendar subscriptions.

Role required: rota_admin, itil, rota_manager, or admin

**Procedure**

1. On your calendar client, add a new external calendar subscription.
2. Enter the On-Call calendar subscription URL that you received.
3. Click **Subscribe**.
4. Enter your login details for your instance.
5. Specify additional details such as how frequently to update the calendar.

**Related information**

Assigning On-Call Scheduling roles

Run a Schedule report to view my schedule

An On-Call Rotation Schedule report shows users or groups that are on-call for a specified time period.

**Before you begin**

Role required: itil

**Procedure**

1. Navigate to **On-Call Scheduling > Reports > Schedule Report**. The On-Call Rotation Schedule report form opens.
2. Specify the **Report style**:
   - **Table**: Display a list that can be sorted, filtered, and configured.
   - **Formatted**: Generate a report in PDF format. Click **Click to Print** to print the report.
3. Select the start date for the report.

4. Move at least one group into the **Selected** list. Enter the first few letters of the group into the **Name starts with** field to see a list of groups that start with those letters. Or select the **All groups** check box to see the list of all groups.

5. Click **Run Report**.

**Example:**
Example Formatted report: The report shows on-call commitments for all specified groups during the specified date range.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware (US)</td>
<td>Primary</td>
<td>07:00:00-15:30:00</td>
<td>Beth Anglin</td>
<td>Beth Anglin</td>
<td>Beth Anglin</td>
<td>Beth Anglin</td>
<td>Beth Anglin</td>
</tr>
<tr>
<td></td>
<td>Secondary</td>
<td>07:00:00-15:30:00</td>
<td>David Loo</td>
<td>David Loo</td>
<td>David Loo</td>
<td>David Loo</td>
<td>David Loo</td>
</tr>
<tr>
<td>Hardware (APAC)</td>
<td>Primary</td>
<td>15:00:00-23:30:00</td>
<td>David Dan</td>
<td>David Dan</td>
<td>David Dan</td>
<td>David Dan</td>
<td>David Dan</td>
</tr>
<tr>
<td></td>
<td>Secondary</td>
<td>15:00:00-23:30:00</td>
<td>Bow Ruggeri</td>
<td>Bow Ruggeri</td>
<td>Bow Ruggeri</td>
<td>Bow Ruggeri</td>
<td>Bow Ruggeri</td>
</tr>
<tr>
<td>Hardware (Weekend)</td>
<td>Primary</td>
<td>15:00:00-23:59:59</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ITIL User</td>
</tr>
</tbody>
</table>

**Run an Escalations report to view who is on call**

The Escalations report displays the escalation sequence and the rules that apply for a selected date. For each group that you are authorized to see, you can choose to show either the active roster members or the on-call person.

**Before you begin**
Role required: itil

**Procedure**

1. Navigate to **On-Call Scheduling > Reports > Escalations Report**.

2. Select a value for the **For each group, show** setting.
   - **Active escalation members**: Display the on-call persons and catch-all persons in the escalation order, along with their delay times.
   - **On-call person**: Determine who is on duty.

3. Select the start date for the report.

4. Move at least one group into the **Selected** list.
Enter the first few letters of the group into the **Name starts with** field to see a list of groups that start with those letters. Or select the **All groups** check box to see the list of all groups.

5. Click **Run Report**.

**Mobile experience for On-Call Scheduling**

View and manage on-call schedules from a mobile device with the On-Call Scheduling mobile applet.

On-call managers and shift managers can perform the following actions:

- View your group’s on-call schedule including any gaps, time-off requests, and so on.
- View roster and escalation details for a shift.
- Review and act on gaps and conflicts.
- Approve/Reject time-off and shift swap requests.
- Provide, replace, or delete coverage and delete time-offs

Members of a roster can perform the following actions:

- View your on-call schedules, who else is on-call during a shift, and your role for the shift (primary/secondary).
- View the roster and escalation details for a shift.
- Submit time-off and shift swap requests.
- Send a message (Slack/MS teams/Push notifications) to find a replacement.

**Getting started with the On-Call Scheduling mobile app**

Use the ServiceNow Agent mobile app to access the On-Call Scheduling mobile application. Then log in to an instance and work on your schedules.

**Before you begin**

Depending on your device, go to the Apple App Store or the Google Play Store and download the ServiceNow Agent mobile app.

**Procedure**

1. Tap the mobile app icon on your device, and then tap + to open an instance.
2. In the instance address field, enter the instance address in one of two ways:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Input</td>
<td>Type the instance address in the instance address field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You do not need to include service-now.com at the end of the instance name.</td>
</tr>
<tr>
<td>Scan QR code</td>
<td>Tap the QR icon (Scan a QR code), and then scan the QR code that was provided by your administrator.</td>
</tr>
</tbody>
</table>

3. Tap **Login**.

**Mobile On-Call Scheduling overview**

Members and managers of a shift can use the On-Call Scheduling applets and navigation menu on the Mobile Agent app application to view and manage shifts and schedules.

**Applet launchers**

Applet launchers serve as landing pages or home pages. When you log in to your instance, you see an applet launcher and the applets configured to display on that launcher. The system administrator configures the applet launcher and applets for the Now Agent mobile application.

**Navigation bar**

The navigation bar appears at the bottom of the mobile application screen. This bar includes the following tabs that you can use to access different applets and application launch pages:

- **My Work**: As a member of a shift, view your upcoming shifts, request time off, and accomplish daily tasks related to your schedule.

- **My Team**: As an on-call manager, view your team’s schedule and act upon important activities, like approving time-off requests and providing coverage.

- **Notification**: View a list of the notifications that have been pushed to an agent. Tap a notification in the list to see the details, then tap the details open the case.

- **Settings**: Manage settings for the mobile application.
On-Call Scheduling

As a member of a shift, view your upcoming shifts, request time off, and accomplish daily tasks related to your schedule.

My work application in the mobile agent app has the On-Call Scheduling applet to access your upcoming shifts and time-off requests of members of your team.

### On-call schedule actions - Upcoming shifts

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap on <strong>Upcoming shifts</strong></td>
<td>View all upcoming shifts for the current month.</td>
</tr>
<tr>
<td>Swipe left on the shift card</td>
<td>Request a time-off for the shift.</td>
</tr>
<tr>
<td>Tap on the shift card</td>
<td>View details for the shift like the group, roster, start time, and end time.</td>
</tr>
<tr>
<td>Tap <strong>Request time-off</strong></td>
<td>Request a time-off for the shift.</td>
</tr>
<tr>
<td>Tap the <strong>i</strong> icon.</td>
<td>Changes the view of the calendar from monthly to daily.</td>
</tr>
</tbody>
</table>

### On-call schedule - Time-off requests

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap on <strong>Time-off requests</strong></td>
<td>View a list of time-off requests divided into pending and completed requests.</td>
</tr>
<tr>
<td>Tap the filter icon</td>
<td>Filter the time-off requests.</td>
</tr>
<tr>
<td>Tap the menu icon</td>
<td>Request time off from the Time-off requests screen.</td>
</tr>
<tr>
<td>Tap a pending time-off request</td>
<td>View the details of the request.</td>
</tr>
<tr>
<td>Tap <strong>Cancel time-off</strong></td>
<td>Cancel the time-off by clicking <strong>YES</strong> on the confirmation message.</td>
</tr>
</tbody>
</table>

### On-call schedule - Who is on-call

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap on <strong>Who is on-call</strong></td>
<td>View a form that lets you select a group from a list of groups.</td>
</tr>
<tr>
<td>Tap the right arrow</td>
<td>View the list of groups that should be on-call in a schedule.</td>
</tr>
</tbody>
</table>
On-call schedule - Who is on-call (continued)

| Select a group          | Select a group from the list of groups and click the arrow to view who is on-call for the schedule. |

Mobile My team On-Call Scheduling

As an On-Call Scheduling manager, view your team’s schedule and perform activities like approving time-off requests and providing coverage.

On-call schedule actions: Upcoming shifts

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap <strong>Upcoming shifts</strong></td>
<td>View all upcoming shifts for the current month.</td>
</tr>
<tr>
<td>Swipe left on the shift card</td>
<td>Request time off for this shift.</td>
</tr>
<tr>
<td>Tap the shift card</td>
<td>View details for the shift (like group, roster, start time, and end time).</td>
</tr>
<tr>
<td>Tap <strong>Request time-off</strong></td>
<td>Request a time-off for this shift by providing information on the Request time-off screen.</td>
</tr>
<tr>
<td>Tap <strong>Provide Coverage</strong></td>
<td>Provide coverage for a shift member.</td>
</tr>
</tbody>
</table>

On-call schedule: Time-off requests

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap <strong>Time-off requests</strong></td>
<td>View a list of time-off requests divided into pending and completed requests.</td>
</tr>
<tr>
<td>Tap the filter icon</td>
<td>Filter the time-off requests using filters like End date or group.</td>
</tr>
<tr>
<td>Tap the menu icon</td>
<td>Request time off on the Time-off requests screen.</td>
</tr>
<tr>
<td>Tap a pending time-off request</td>
<td>View details of the request.</td>
</tr>
<tr>
<td>Tap <strong>Approve</strong> or <strong>Reject</strong></td>
<td>Approve or reject a time-off request.</td>
</tr>
</tbody>
</table>
On-call schedule: Time-off requests (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>Add a reason for rejection of a time-off request.</td>
</tr>
</tbody>
</table>

On-call schedule: Gaps and conflicts

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap Gaps and conflicts</td>
<td>View a list of all the gaps and conflicts for the shifts in your group.</td>
</tr>
<tr>
<td>Tap any day of the month</td>
<td>View all gaps and conflicts for shifts on that day.</td>
</tr>
<tr>
<td>Tap any of the shift cards</td>
<td>View gaps and conflicts for the shift.</td>
</tr>
<tr>
<td>Swipe left on any of the shift cards</td>
<td>Tap <strong>Provide coverage</strong> to provide coverage for the shift.</td>
</tr>
<tr>
<td>Tap <strong>Provide Coverage</strong></td>
<td>Provide coverage for a gap in the shift.</td>
</tr>
</tbody>
</table>

Problem Management

ServiceNow® Problem Management helps to identify the cause of an error in the IT infrastructure, reported as occurrences of related incidents.

Problem Management is responsible for managing the life cycle of all problems and to prevent problems and resulting incidents from happening. It also aims at eliminating recurring incidents and minimizing the impact of incidents that cannot be prevented. Resolving a problem includes the activities required to diagnose the root cause of incidents and to determine the resolution for the problem. Problem resolution and elimination of root cause often calls for applying a change to the configuration item in the existing IT environment.

Problem Management also maintains information about problems and the appropriate workarounds and resolutions, so that the organization is able to reduce the number and impact of incidents over time. In this respect, Problem Management has a strong interface with Knowledge Management so that the known error articles are documented thoroughly for any future reference.
**Understanding problem management**

Understand the Problem Management process, the plugins that you activate, and the functionalities that you can validate after any configuration change.

### Problem Management process

Problem Management supports the ITIL process to find and fix the root cause of issues that result in incidents. You can record problems, associate incidents, and assign them to appropriate groups. You can create knowledge from problems, request changes, escalate, and manage problems to its resolution and reporting.

Introduction to problem management; creating a problem; checking dependencies; creating problem tasks to initiate root cause analysis; communicating a workaround; posting knowledge; creating a change request from a problem; closing a problem and related incidents.

Within the platform, problems are handled using the task record system. Each problem is generated as a task record through various means, and is populated with the pertinent information. These tasks are assigned to Problem Management team members to resolve and then close.

### Identify and log problems

A problem can be created in several ways. For detailed information, refer to Create a problem.

---

**Use**

- Data lookup for prioritizing problems
- Quick start tests for Problem Management
- Communicating the outcome of a problem

**Develop**

- Developer training
- Developer documentation

**Troubleshoot and get help**

- Ask or answer questions in the Problem Management community
- Search the Known Error Portal for known error articles
- Contact Customer Service and Support

---

**Problem Management process**

- Configuring problem management
- Problem management integrations
- Managing Problems
- Communicating the outcome of a problem

---

**Understanding problem management**

Understand the Problem Management process, the plugins that you activate, and the functionalities that you can validate after any configuration change.

### Problem Management process

Problem Management supports the ITIL process to find and fix the root cause of issues that result in incidents. You can record problems, associate incidents, and assign them to appropriate groups. You can create knowledge from problems, request changes, escalate, and manage problems to its resolution and reporting.

Introduction to problem management; creating a problem; checking dependencies; creating problem tasks to initiate root cause analysis; communicating a workaround; posting knowledge; creating a change request from a problem; closing a problem and related incidents.

Within the platform, problems are handled using the task record system. Each problem is generated as a task record through various means, and is populated with the pertinent information. These tasks are assigned to Problem Management team members to resolve and then close.

### Identify and log problems

A problem can be created in several ways. For detailed information, refer to Create a problem.
Associating a problem with a configuration item using CMDB helps the Problem Management team see the affected items and its relationship to other configuration items.

A problem can be associated with one or more incidents in the Incidents related list. The association is automatic if the problem is generated from an incident. Associating incidents provides the Problem Management team with access to the information gathered during incident investigation.

**Investigate and update problems**

If the Problem Management team has a problem model process for dealing with certain problems, they can be added to the system with workflows. Workflows standardize and automate a process.

As a problem is updated, email notifications are sent to concerned parties. If inbound email actions are specified, the problem can be updated via email.

You can use the other active tasks icon next to Configuration item to look up active problem records. When you click the icon, it shows all active tasks linked to that configuration item.

The platform provides escalations rules to ensure that problems are handled promptly. Two types of escalation rules are available in the system.

- **Service level agreements**: SLAs can be used to ensure that problems are highlighted. As investigating and fixing a problem could be a long-term effort, it is not recommended that you apply SLAs to an overall problem. SLAs are also used as a performance indicator for the Problem Management team.

- **Inactivity monitors**: The inactivity monitors prevent problems from being overlooked by generating an event. When a problem has not been updated within a certain amount of time, the event can create an email notification or trigger a script.

**Resolve problems**

If a problem needs a change request to be resolved, it is possible to request a change that goes through the change management process. After requesting a change, the problem appears on a related list on the Change Request form.

⚠️ **Note**: For Madrid Best Practices: The problem coordinator, whom the Problem is assigned to, is notified when all related change requests are completed or canceled.

The following information applies for London and prior releases:

- A business rule (SNC-ITIL-Close-related) automates the process of closing problems in Pending Change state when the change request is closed. If the problem is closed, another business rule (SNC - ITIL - Resolve Related...
Incidents] automatically sets the State to Resolved for all incidents associated with that problem whose State was On Hold and On hold reason was Awaiting Problem.

- If the cause of a problem has been determined but there is no permanent fix, change the problem state to Known Error to communicate this fact. IT agents can click the Known Errors module and look for the issue they are investigating to reduce time spent on a similar issue. To communicate information related to a problem, you can open the problem and describe a workaround, create a knowledge base article, or create a news item.

Life cycle of a problem
Problem Management is responsible for managing the life cycle of underlying problems. State transition of a problem guides you through the stages of a problem life cycle, from creation to closure.

Problem Management has one single goal: Identifying and resolving the underlying issues that cause Incidents. Problem Management is a systematic, methodical process where time to resolution is less important than identifying and resolving the root cause.

⚠️ Note: The state-based information is available only in new instances starting from the Madrid release. Activate the Problem Management Best Practice — Madrid — State Model (com.snc.best_practices.problem.madrid.state_model) plugin. Existing users (London and prior releases) cannot activate this plugin.

The Problem Management process has many states, and each is vitally important to the success of the process and the quality of service delivered. The different states can be represented in a diagram as follows:

![Problem Management state transitions](image-url)
Life cycle of a problem task

A problem task is the smallest unit of work that you should perform to complete a problem. State transition of a problem task guides you through the stages of a problem task life cycle, from creation to closure.

If a problem coordinator requires help to resolve a problem, the coordinator can create and assign problem tasks to assignment groups or users to complete those activities.

⚠ Note: The state-based information is available only in new instances starting from the Madrid release. Activate the Problem Management Best Practice — Madrid — State Model (com.snc.best_practices.problem.madrid.state_model) plugin. Existing users cannot activate the plugin.

You can create the following types of tasks:

- **Root Cause Analysis:** When you need to investigate the root cause and the resolution for a problem
- **General:** For any other task

### Problem task state transitions

![Problem task state transitions diagram]

**Problem Management plugins**

Many of the Problem Management plugins are activated in the base system. Others, you can activate when you are ready to use them. Some plugins include demo data.

**Activate Problem Management**

You can activate the Problem Management plugin (com.snc.problem) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.
Before you begin
Role required: admin

About this task
The Problem Management plugin activates these related plugins if they are not already active.

Plugins for Problem Management

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem Overview Homepage</td>
<td>This plugin delivers content for Problem Overview home page.</td>
</tr>
<tr>
<td>[com.glideapp.report.itsm.problem.overview]</td>
<td></td>
</tr>
</tbody>
</table>

Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   ✨ **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: **Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>**.

Related reference

- List of plugins (Rome)

Components installed with Problem Management

Several types of components are installed with activation of the Problem Management plugin, including tables.

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem</td>
<td>The Problem table is extended from the Task [task] table. It inherits all the fields, rules and policies from task.</td>
</tr>
</tbody>
</table>
### Activate Problem Management Best Practice — Madrid

Activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

**Role required:** admin

**About this task**

The Problem Management Best Practice — Madrid plugin identifies the cause of a service interruption reported by a significant or recurring incidents. The plugin does the following activities:

- Provides roles for problem management including a problem task analyst, a problem coordinator, a problem manager, and a problem administrator.
- Provides fields to record the category where the issue was first reported, the workaround, the cause notes, and the fix notes.
- Searches for and attaches knowledge articles.
- Communicates when a workaround or fix is available.
- Clears the **Assigned to** field when changing the **Assignment Group**.

**Note:** The plugin is activated by default for the new customers. Existing customers need to request the plugin.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

⚠️ **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Related information**

**List of Rome plugins**

**Components installed with Problem Management**

Several types of components are installed with activation of the Problem Management Best Practice — Madrid plugin, including user roles.

Demo data is available for this feature.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem Task Analyst</td>
<td>Works on a problem task and manages it through its life cycle.</td>
<td>None</td>
</tr>
<tr>
<td>[problem_task_analyst]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Co-ordinator</td>
<td>Works on a problem or problem task and manages it through its life cycle.</td>
<td>problem_task_analyst and itil</td>
</tr>
<tr>
<td>[problem_coordinator]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Manager</td>
<td>Responsible for the overall problem management process and can configure problem management settings as well as act as a problem coordinator.</td>
<td>problem_coordinator</td>
</tr>
<tr>
<td>[problem_manager]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Admin</td>
<td>Responsible for the overall problem management process as well as delete problems and problem tasks.</td>
<td>problem_manager</td>
</tr>
<tr>
<td>[problem_admin]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Activate Business Stakeholder

Activate the Business Stakeholder plugin (com.snc.business_stakeholder) if you have an admin role. This plugin installs the Business Stakeholder role. Users with this role can view and approve records at all ITSM product levels.

Before you begin
Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related reference

List of plugins (Rome)

Installed with Business Stakeholder

The Business Stakeholder plugin (com.snc.business_stakeholder) installs the Business Stakeholder role when activated.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Stakeholder</td>
<td>Users with this role can view and approve records within all products of ITSM.</td>
<td>pa_viewer.business_stakeholder, approver_user.business_stakeholder, cmdb_read.business_stakeholder</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The business_stakeholder role contains the following ITSM roles sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Request ITSM Roles — Problem Management

Request the ITSM Roles plugin (com.snc.itsm.roles) to activate the ITSM Roles — Problem Management plugin (com.snc.itsm.roles.problem_management) to gain more control over the access that different service desk agents, technicians, and managers have within your Problem Management process.

**Before you begin**
Role required: admin

**About this task**
The ITSM Roles plugin (com.snc.itsm.roles) includes an additional security model. The security model provides more granular roles across ITSM applications as well as within them, allowing you flexibility in setting up access controls. The ITSM Roles plugin is available by default in new instances. Users upgrading from Madrid or earlier versions must request the plugin.

### Plugins for ITSM Roles

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Stakeholder [com.snc_business_stakeholder]</td>
<td>business_stakeholder</td>
</tr>
<tr>
<td><strong>Note:</strong> The business_stakeholder role contains the sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.</td>
<td></td>
</tr>
</tbody>
</table>

| ITSM Roles — Incident Management [com.snc.itsm.roles.incident_management] | sn_incident_read  
| sn_incident_write |
### Plugins for ITSM Roles (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
</table>
| ITSM Roles — Problem Management [com.snc.itsm.roles.problem_management] | • sn_problem_read  
• sn_problem_write |
| ITSM Roles — Change Management [com.snc.itsm.roles.change_management] | • sn_change_read  
• sn_change_write |
| ITSM Roles — Request Management [com.snc.service_management.roles.request_management] | • sn_request_read  
• sn_request_write  

#### Note:
As there are future updates expected for the sn_request_read role, do not assign it to users without the business_stakeholder role.

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization's production and subproduction instances, generally within a few days.

If you don't have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

#### Note:
Activate the ITSM Roles plugin on a subproduction environment and test the functionality before requesting activation in the production environment. For assistance, contact the ServiceNow Professional Services team.

#### Procedure

1. Navigate to **System Applications > All Available Applications > All**.
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the form, fill in the fields.

**Activate Plugin request form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong> Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the <strong>Reason/Comments</strong> field.</td>
<td></td>
</tr>
</tbody>
</table>

| Reason/Comments | Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments. |

7. Click **Submit**.

**Related information**

**List of Rome plugins**

**Components installed with ITSM Roles — Problem Management**

Several user roles are installed with activation of the ITSM Roles — Problem Management plugin (com.snc.itsm.roles.problem_management).

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem read [sn_problem_read]</td>
<td>Read access to the Problem Management application and related records.</td>
<td>NA</td>
</tr>
</tbody>
</table>
| Problem write [sn_problem_write] | Write access to the Problem Management application and related records. | • sn_problem_read  
• template_editor |
**Activate Problem Management Best Practice — Madrid — State Model**


**Before you begin**
Role required: admin

**About this task**
The new best practices are not compatible with the previous version of problem management and requires verification before this plugin can be activated. The plugin is activated by default for the new customers.

Existing customers should use the Migration Utility to verify and migrate to this plugin.

**Related information**
- List of Rome plugins

**Activate Problem Management Best Practice — Madrid — Knowledge Integration**

Activate the Problem Management Best Practice — Madrid — Knowledge Integration (com.snc.best_practice.problem.madrid.knowledge) plugin if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**
Role required: admin

**About this task**
The Problem Management Best Practice — Madrid – Knowledge Integration plugin (com.snc.best_practice.problem.madrid.knowledge) helps you to create known error articles to help with incident deflection. The plugin helps in the following activities:

- Creating a known error article from a problem.
- Creating a knowledge base for known error articles.

**Procedure**
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Related information**

List of Rome plugins

**Components installed with Problem Management**

Several types of components are installed with activation of the Problem Management Best Practice — Madrid — Knowledge Integration plugin, including tables.

Demo data is available for this feature.

**Tables installed**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Known Error article</td>
<td>Table to store Known Error articles.</td>
</tr>
<tr>
<td>[kb_template_known_error_article]</td>
<td></td>
</tr>
</tbody>
</table>

**Activate Problem Management — ATF Tests**

You can activate the Problem Management — ATF Tests plugin (com.snc.problem.atf) if you have the admin role. This plugin includes demo data.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

**Related information**

List of Rome plugins

**Activate Problem Management Best Practice — Jakarta**

The Problem Management Best Practice - Jakarta plugin introduces lookups (impact, urgency and priority) for Problem Management.

**Before you begin**

Role required: admin

**About this task**

**Important:** Do not activate this plugin if you have upgraded from a pre-Jakarta release.

If you have modified the base functionality required for the Problem Management Best Practice — Madrid — State Model plugin (com.snc.best_practice.problem.madrid.state_model), use the Migration Utility to repair the plugin.

**Related reference**

List of plugins (Rome)

**Migration Utility**

The Problem Management Migration Utility, available in the ServiceNow® Store, is a guided setup application that helps you upgrade to adopt the base version of Problem Management using the guided problem life cycle.
Important:
If you run into issues or need additional help with resolving your modifications, contact your ServiceNow Account Representative or ServiceNow Solution Consultant. You might need help from ServiceNow Customer Outcomes or a partner.

The migration utility consists of several guided activities:

**Introduction**
Describes the purpose of the Problem Management Best Practice State Model plugin and the migration utility. This activity also confirms that you have practiced or are practicing on a sub-production instance that is a clone of the production instance.

**Preparation**
Helps you prepare for your migration, including optional scenarios if you want to remove all of your existing problem and problem task records.

**Migrate**
Guides you through the Migration job.

**Clean-up**
The guided setup activity guides you through the manual clean-up activities after you have completed the main migration.

Introducing activities for migration
The Introduction activity helps you to understand the purpose of the migration utility.

The activity helps you understand the Problem Management Best Practice State Model plugin and the new problem and task states. This activity also confirms that you have practiced or are practicing on a sub-production instance that is a clone of the production instance.

Preparing for migration
You can prepare your instance for migration before you start the migration activity.

Before you start the migration activity, if you want to optionally remove all of your problem records or all of your problem task records, take a backup of the records first before you remove them.
Migration job

Get your instance ready for the Problem Management Best Practice — Madrid — State Model plugin (com.snc.best_practice.problem.madrid.state_model) and so you can update your existing records with the new states.

Before starting migration the migration process, see the Problem Management Migration Utility - Instance Backup and Recovery [KB0994130] article in the HI Knowledge Base.

The stages to get your instance ready for the problem state model and to migrate your records are:

1. Resolve blocking modifications
2. Review warning modifications
3. Map problem states
4. Map problem task states
5. Activate Problem Management Best Practice — Madrid — State Model
6. Prepare base plugins
7. Restore base plugins
8. Resolve blocking and warning modifications
9. Migrate active records
10. Migrate inactive records

Resolve blocking modifications

Blocking modifications that are detected in your instance are not compatible with the problem state model and you must resolve them before you activate the Problem Management Best Practice — Madrid — State Model plugin.

Before you begin
Role required: admin

Procedure

1. Review and resolve all blocking modifications.
   For more information about modifications that block the problem state model plugin from being activated, see the KB0819060 article in the HI Knowledge Base.

2. Click Run Checks.

What to do next
Review warning modifications.
Review warning modifications

Warning modifications do not block the Problem Management Best Practice — Madrid — State Model plugin from being activated.

Before you begin
Role required: admin

About this task
For more information about warning and informational modifications and how to resolve them, see the Problem Management Migration Utility - How to resolve detected modifications [KB0819196] article in the HI Knowledge Base.

Procedure

1. Review and resolve all warning modifications.
   Warning modifications, though initially are not blocking, can become blocking when you activate the problem state model plugin. You must resolve them before you can migrate your records.

2. View informational modifications.
   Informational modifications provide information about only the changes that you have made that do not impact the migration.

3. If you resolved any warnings, click Run Checks.

4. Click Next.

What to do next
Map problem states.

Map problem states
Define how problem records are updated when you migrate the records.

Before you begin
Role required: admin

Procedure

1. Provide information for all the mandatory fields at this stage.
   The required field values are used when you apply new states to the existing problem records.
Note:

- The **Assigned to** field is used when the new state is beyond **101 - New** and the problem is not already assigned to a user.
- If you have activated the problem state model plugin, the **Assigned to** field is filtered to users with the problem_coordinator, problem_manager or problem_admin role.
- The `${current.state}` variable is replaced with the current state value and label.

2. Map all current problem states to the new states.
   The following table provides an example of state mapping for the base system version of the problem records:

<table>
<thead>
<tr>
<th>Current state</th>
<th>New state</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Open</td>
<td>101 - New</td>
</tr>
<tr>
<td>2 - Known Error</td>
<td>107 - Closed as Risk Accepted</td>
</tr>
<tr>
<td>3 - Pending Change</td>
<td>104 - Fix in Progress</td>
</tr>
<tr>
<td>4 - Closed/Resolved</td>
<td>107 - Closed as Fix Applied</td>
</tr>
</tbody>
</table>

3. Click **Detect Unmapped States** to verify whether any state is not mapped.
   If any state is not mapped, you must provide a mapping.

What to do next
Map problem task states.

Map problem task states
Define how problem task records are updated when you migrate the records.

Before you begin
Role required: admin

Procedure

1. Provide the information for the mandatory fields at this stage.
   The mandatory field values are used when you apply new states to the existing problem task records.
Note:

- The **Assigned to** field is used when the new state is beyond **151 - New** and the problem task is not already assigned to a user.
- If you have activated the problem state model plugin, you can assign only users with the problem_task_analyst, problem_coordinator, problem_manager or problem_admin role.
- The `${current.state}` variable is replaced with the current state value and label.

2. Map all current problem task states to the new states.
   The following table provides an example of state mapping for the base system version of the problem task records:

   **Mapping of the current states to the new states**

<table>
<thead>
<tr>
<th>Current state</th>
<th>New state</th>
</tr>
</thead>
<tbody>
<tr>
<td>-5 - Pending</td>
<td>151 - New</td>
</tr>
<tr>
<td>1 - Open</td>
<td>151 - New</td>
</tr>
<tr>
<td>2 - Work in Progress</td>
<td>154 - Work in Progress</td>
</tr>
<tr>
<td>3 - Closed Complete</td>
<td>157 - Closed as Complete</td>
</tr>
<tr>
<td>4 - Closed Incomplete</td>
<td>157 - Closed as Canceled</td>
</tr>
<tr>
<td>7 - Closed Skipped</td>
<td>157 - Closed as Canceled</td>
</tr>
</tbody>
</table>

3. Click **Detect Unmapped States** to verify whether any state is not mapped. If any state is not mapped, you must provide a mapping.

What to do next

**Activate Problem Management Best Practice — Madrid — State Model.**

**Activate Problem Management Best Practice — Madrid — State Model**

You can activate the Problem Management Best Practice — Madrid — State Model plugin (com.snc.best_practice.problem.madrid.state_model) on your instance using the Problem Management Migration Utility store app.

**Before you begin**

Before you activate the plugin, be sure to resolve blocking modifications. For more information, see **Resolve blocking modifications**.

Role required: admin
About this task
An administrator must activate the Problem Management Best Practice — Madrid — State Model plugin (com.snc.best_practice.problem.madrid.state_model) (first introduced in the Madrid release) through the Migration Utility because the plugin includes features that are not compatible with the previous version of Problem Management.

New York Patch 9 or Orlando Patch 3 or later are required before the administrator can see and activate the problem state model plugin on an instance. If you do not have the required patch, you have to request the plugin as it is a development plugin.

Procedure
1. Activate the plugin.
   If you have the required patch level, you have access to the plugin and can activate it. If you do not have the patch level, you must request it.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Activate the plugin (required patch level is installed) | a. Click **Request Plugin** in the plugin activation stage of the migration utility migration job.  
b. On the System Plugin page, click the **Activate/Repair** related link.  
c. Click **Activate**.  
d. Close and reload the form.  
   The plugin status changes to **Activated**. You can return to the Migration Utility and continue with the migration. |
| Request the plugin              | a. Click **Request Plugin** in the plugin activation stage of the migration utility migration job.  
b. On the **ServiceNow HI Request Plugin** page, provide the required details. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Target instance: Instance on which to request the plugin</td>
<td></td>
</tr>
<tr>
<td>• Plugin Name: com.snc.best_practice.problem.madrid.state_model</td>
<td></td>
</tr>
<tr>
<td>• Reason/Comments: Request from the Problem Management Migration Utility</td>
<td></td>
</tr>
<tr>
<td>• Select Maintenance Start Time: Select your preferred start time</td>
<td></td>
</tr>
<tr>
<td>c. Click <strong>Submit</strong>.</td>
<td></td>
</tr>
<tr>
<td>d. Once the plugin is activated, return to the Migration Utility and continue with the migration.</td>
<td></td>
</tr>
</tbody>
</table>

2. Continue with the migration process.

**What to do next**

Prepare base plugins.

**Prepare base plugins**

Prepare to restore the base functionality that is required for the problem state model you have modified.

**Before you begin**

Role required: admin

**About this task**

ℹ️ **Note:** You cannot move back to any earlier stage because in the previous stage you activated the Problem Management Best Practice — Madrid — State Model plugin (com.snc.best_practice.problem.madrid.state_model) on this instance and the old states are invalid.

**Procedure**

1. Resolve blocking modifications.
   
   a. For each blocking modification, click **View Modification**.
   
   b. Select the **Replace on upgrade** check box.
Note: If this option is not available, add the Replace on update field to the form using Configure > Form Layout.

c. Click Update.
d. Click Back.

2. Click Run Checks.

What to do next
Restore base plugins.

Restore base plugins
Repair the plugins in the specified order to restore the base functionality that is required for the problem state model.

Before you begin
Role required: admin

About this task
New York Patch 9, or Orlando Patch 3 or later are required before you can see and repair the Problem Management Best Practice – Jakarta (com.snc.best_practice.problem.jakarta) and Problem Management Best Practice — Madrid — State Model (com.snc.best_practice.problem.madrid.state_model) plugins. Before the mentioned patches, these plugins were development plugins.

Note: If you do not have the required patch, refer to Blocking modifications for required base functionality in the KB0819196 article in the HI Knowledge Base.

Procedure
1. Repair the plugins, one at a time.
   a. Repair the plugin or apply the update set as required.

      Note: Certain plugins contain functionality for applications including Problem Management. For those plugins, refer to the specified knowledge article to restore the required problem functionality instead of repairing the plugin.
   b. Return to the migration job and mark that plugin as repaired.

2. Click Run Checks.
What to do next
Resolve blocking and warning modifications.

Resolve blocking and warning modifications
Resolve any blocking modifications and resolve or verify any warning modifications that are detected on your instance.

Before you begin
Role required: admin

About this task
For more information about blocking, warning, and informational modifications and how to resolve them, see the Problem Management Migration Utility - How to resolve detected modifications [KB0819196] article in the HI Knowledge Base.

Procedure
1. Review and resolve all blocking modifications.
2. Review and resolve or verify warning modifications.
3. Optional: View informational modifications.
4. Click Run Checks after you have resolved all blocking modifications and you have either resolved or verified the warning modifications.

What to do next
Migrate active records.

Migrate active records
Migrate active records to apply the new mappings to your active problem and problem task records.

Before you begin
Role required: admin

Procedure
Click Migrate Active Records.
If there are no active records to migrate, the migration job moves to the migrate inactive records stage.

Note: Even if you close the migration window or navigate away from the migration job, the migration of records continues. If you click Migrate Active Records, the migration window displays the current progress.

If any record fails to migrate, it is listed in one of the related lists:
• Failed Active Problem Updates
• Failed Active Problem Task Updates

Verify the reason for their failure, resolve it, and migrate the records again.

What to do next
Migrate inactive records.

Migrate inactive records
Migrate inactive records to apply the new mappings to all the remaining problem and problem task records.

Before you begin
Role required: admin

Procedure
Click Migrate Inactive Records.
If there are no inactive records to migrate, the migration job moves to the migrated stage.

Note: Even if you close the migration window or navigate away from the migration job, the migration of records continues. If you click Migrate Inactive Records, the migration window displays the current progress.

If any record fails to migrate, it is listed in one of the related lists:
• Failed Inactive Problem Updates
• Failed Inactive Problem Task Updates

Verify the reason for their failure, resolve it, and migrate the records again.

What to do next
View the Migrated topic.

Migrated
You have successfully activated the Problem Management Best Practice - Madrid - State Model plugin and updated your problem and problem task records to the new best practice states.

Before you begin
Role required: admin
Procedure

1. Optional: View the records after migration in the related links. The records are listed in one of the following related lists:
   - Problems by State
   - Problem Tasks by State

2. Optional: If any record failed to migrate, verify the reason for the failure, resolve it, and migrate the records again. The failed records are listed in one of the following related lists:
   - Failed Active Problem Updates
   - Failed Active Problem Task Updates
   - Failed Inactive Problem Updates
   - Failed Inactive Problem Task Updates

3. Click Finish to return to guided setup to perform the clean-up tasks.

Modifications

A modification is any alteration such as addition, deletion, or update that you carry out on Problem Management. If you have made significant modifications, you will need to review and resolve some possible blocking modifications.

For more information on modifications, see the following KB articles:

- For more information about modifications that block the problem state model plugin from being activated, see the KB0819060 article in the HI Knowledge Base.
- For more information about other types of modification and how to resolve them, see the Problem Management Migration Utility - How to resolve detected modifications [KB0819196] article in the HI Knowledge Base.

Activities to clean up after migration

After you complete your main migration, you must do some manual clean-up to make your instance similar to the base version of problem management.

Manual clean-up involves the following activities:

- Reactivate problem state models
- Remove old module menus
- Remove old filters
- Remove old UI actions
- Remove old business rules
• Remove old UI policies
• Update the dashboard overview
• Reset problem form layouts

⚠️ Note: You can skip this action if you have not modified your form.
• Search for problems from incidents

Update dashboard overview
When you activate the problem state model, you need to update the overview dashboard to use the new states.

Before you begin
Role required: admin

About this task
In the problem overview dashboard, refer to the closed problems by setting Active = false instead of state = 4.

⚠️ Note: If you have added your own custom dashboards or charts, you may need to manually update them as you have migrated to the problem state model.

Procedure
1. If you are prompted with the message To edit this record click here, then click here.

2. Click the configuration icon ( ).

3. Hover your mouse on Problems Closed per Week chart to view and select the Edit Content menu.

4. Select the filter to open the condition builder and update the condition from Problem state is 4 to Active is false.

5. Click Run.

6. Click Save.

7. Click Back to return to the dashboard.

Configuring problem management
Create or redesign problem form layouts to be aligned with the workflow of the business process of the organization. Categorize problems for monitoring
and reporting purpose. Use data lookup and assignment rules to automatically assign a task to a user or group based on pre-defined conditions.

**Configure the problem form**

Configure the problem form layout to conform to the workflow and the process of your organization. Add, remove, and customize fields and related lists, create problem categories, and modify links as needed.

**Before you begin**

Role required: admin

**About this task**

The Problem form in the base system is configured to follow recommended ITIL practices. Evaluate the form layout and design with your existing business processes, and plan the changes to make.

For additional form customization not described in this page, such as adding company-specific annotations or configuring related lists, see Form administration and Configuring the form layout.

By default, auditing is enabled for the problem table. The administrator can configure the form layout to add the Audit Records and Audit History related lists. For more information about options for auditing a table, see Enable auditing for a table.

**Procedure**

Navigate to **Problem > Create New**. Some of the following configuration activities are not accessed from within the problem form. These activities are noted in the procedure.

**Configure the problem form layout**

Configure the problem form so the information it collects is relevant to your organization’s processes. You can easily modify the form to show only the fields, related lists, and other elements that you need.

**Before you begin**

Role required: personalize_form

**Procedure**

1. Navigate to **Problem > Create New**.
2. In the problem form context menu, select **Configure > Form Layout**.
3. Follow the steps in Configuring the form layout to perform any of the following layout modifications. Some of these modifications are illustrated in the example.
• Show or hide fields on a form.

• Add a related list to a form.

  The **Incidents** and **Problem Tasks** related lists appear by default. Review the available related lists and select appropriate lists. For example, if you enable auditing for the Problem table, add the **Audit History** related list.

• Add an annotation to a form.

• Create a form section.

• Embed a list within a form.

  This activity allows the embedded list to be used like any other element on the form. In addition, technicians can create records in the list view. Changes made to the contents of the embedded list are saved when the form is saved.

  **Note:** There are other activities described in the form layout topic, but the items listed here are commonly configured during initial setup.
Redesign the problem form

The form designer allows you to customize elements in the problem form to create different form views, display a field navigator, or provide field properties.

Before you begin
Role required: admin

About this task
Form design is an alternative to configuring forms that combines several configuration options into one tool. You can make and save changes, then return to the browser tab with the open problem form and reload the form to test your changes. Using the form designer lets you try out the changes you want to make for the best result.

Procedure
1. In the form context menu, select Configure > Form Design to open the form designer in a new browser tab.
2. Follow the directions in Form design to customize elements in the problem form.

Configure problem categories

Configure problem categories to provide a refined way of monitoring and reporting problems. Add to or remove category and subcategory choices from the list of problem categories or subcategories.

Before you begin
Role required: admin

Procedure
Follow the steps in Define an option for a choice list to enter your problem categories.

Define an assignment rule for problems

After a problem is logged, it must be assigned to the appropriate group or individual to handle the problem. You can define assignment rules to automate the assignment process.

Before you begin
Role required: assignment_rule_admin or admin
About this task
Some assignment rules are predefined for Problem Management. Review the predefined assignment rules, and verify that the problem assignment rules you want to use are active. For example, the Network Problem assignment rule looks at the configuration item class for network problems and assigns the problem to the Network group.

In this procedure, define an assignment rule to assign database problems to the Database group. It is just an example to let you know how to define an assignment rule. The Database Problem assignment rule is already available in the base system.

Procedure
1. Navigate to System Policy > Assignment and click New.
2. Complete the form using the following information.
   - **Name**: Database Problems
   - **Applies To** tab or section:
     - **Table**: Problem [problem]
     - **Conditions**: Dot-walk to [Configuration Item.Class] [is] [Database].
   - **Group** in the Assign To tab or section: Database
3. Click Submit.
4. Test the assignment rule by completing the following steps.
   - a. Navigate to Problem > Create New.
   - b. Complete the problem form and select a configuration item with a class of Database.
   - c. Click Submit.
   - d. Open the problem and verify that the assignment group was added.

Categorize a problem as a major problem
You can prioritize a problem and highlight that it needs a review.

Before you begin
Role required: admin
About this task

Note: This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.

- If the Problem Management Best Practice – Madrid plugin (com.snc.best_practice.problem.madrid) is activated, configure the Problem form to include the **Major problem** check box and add the **Major problem review** field to the **Resolution Information** tab.
- If the Problem Management Best Practice – Madrid plugin (com.snc.best_practice.problem.madrid) is not activated, add the **Review outcome** field to the **Closure Information** tab.

Procedure

1. Open a Problem record to categorize it as a major problem.

2. Select the **Major problem** check box.
   
   The **Work notes** field is mandatory. Either the **Major problem review** field is displayed in the **Resolution Information** tab, or the **Review outcome** field is displayed in the **Closure Information** section.

3. Fill out the **Review outcome** field to document review results and lessons learned.

4. Click **Update**.

Data lookup for prioritizing problems

To follow ITIL guidelines, problem records are prioritized by the impact and urgency of the problem.

Problem prioritization is available on new instances.

On the problem form, users select values from the **Impact** and **Urgency** fields that determine which priority value is generated for the problem.

**ITIL problem order**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>Impact is a measure of the effect of an incident, problem, or change on business processes.</td>
</tr>
</tbody>
</table>
ITIL problem order (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Urgency</td>
<td>Urgency is a measure of how long the resolution can be delayed until an incident, problem, or change has a significant business impact.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority is based on impact and urgency, and it identifies how quickly the service desk should address the task.</td>
</tr>
</tbody>
</table>

Priority is calculated according to the following data lookup rules:

**Priority Data lookup rules**

<table>
<thead>
<tr>
<th>Impact</th>
<th>Urgency</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - High</td>
<td>1 - High</td>
<td>1 - Critical</td>
</tr>
<tr>
<td>1 - High</td>
<td>2 - Medium</td>
<td>2 - High</td>
</tr>
<tr>
<td>1 - High</td>
<td>3 - Low</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>1 - High</td>
<td>2 - High</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>2 - Medium</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>2 - Medium</td>
<td>3 - Low</td>
<td>4 - Low</td>
</tr>
<tr>
<td>3 - Low</td>
<td>1 - High</td>
<td>3 - Moderate</td>
</tr>
<tr>
<td>3 - Low</td>
<td>2 - Medium</td>
<td>4 - Low</td>
</tr>
<tr>
<td>3 - Low</td>
<td>3 - Low</td>
<td>5 - Planning</td>
</tr>
</tbody>
</table>

By default, the **Priority** field is read-only and must be set by selecting the **Impact** and **Urgency** values. To change how priority is calculated, administrators can either alter the priority lookup rules or disable the **Priority is managed by Data Lookup - set as read-only** UI policy and create their own business logic.

In the Problem Priority Data Lookup [dl_problem_priority] table, you can modify data lookup rules for task priority.

**Work notes for problem priorities**

When you initially create and save a problem, the **Work notes** field is not mandatory. If you change the priority of the problem by selecting different **Impact** or **Urgency** values on a problem form that was saved, the **Work notes** field becomes mandatory.
Note: This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.

Problem management properties

Problem Management properties are used to control features such as creating problem task on a closed problem and reanalyzing a closed or a canceled problem.

These properties are available at Problem > Administration > Problem Properties.

### Properties for Problem Management

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Problem State Transition Properties</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Accept Risk moves the Problem to Closed state instead of Resolved state problem.acceptrisk.move_to_closed | • Type: string  
• Value: true or false  
• Default value: true |
| Can create a Problem Task on a Closed Problem? problem.closed.can_create_tasks | • Type: string  
• Value: true or false  
• Default value: false |
| Who can Re-analyze a Canceled Problem? problem.closed.role.reanalyze_from_canceled | • Type: choice list  
• Default value: problem_manager |
| Who can Re-analyze a Risk Accepted (Closed state) Problem? problem.closed.role.reanalyze_from_closed_riskaccepted | • Type: choice list  
• Default value: problem_manager |
| Who can Re-analyze a Completed Problem? problem.closed.role.reanalyze_from_completed | • Type: choice list  
• Default value: problem_manager |
| **Problem Task State Transition Properties** | |
| Cancel open Problem Tasks when closing a Problem problem.closed.cancel_open_tasks | • Type: string  
• Value: true or false  
• Default value: true |
### Properties for Problem Management (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who can Re-assess a Completed or Canceled Problem Task?</td>
<td></td>
</tr>
</tbody>
</table>
  * Type: choice list  
  * Default value: ```problem_coordinator``` |

#### Problem Related List Properties

- List of related task records (comma-separated) to track as fixes for this Problem. Used to notify the Coordinator when all the related fix records are Completed or Canceled. E.g. ```incident.problem_id, change_request.parent```  
  * Type: string  
  * Default value: ```change_request.parent, rm_defect.parent, rm_release.parent, rm_enhancement.parent, sn_cim_register.source_id``` |

- List of related task records (comma-separated) to move over when a problem is marked as a duplicate of another. E.g. ```incident.problem_id, change_request.parent```  
  * Type: string  
  * Default value: ```incident.problem_id, sn_customerservice_case.problem, problem_task.problem``` |

#### Problem Created from Incident Properties

- List of attributes (comma-separated) that will be copied from the incident to create a new problem  
  * Type: string  
  * Default value: ```number, description, short_description, cmdb_ci, impact, urgency, priority, company, sys_domain, business_service, category, subcategory``` |

---

**Quick start tests for Problem Management**

Validate that Problem Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Problem Management quick start tests require activating the Problem Management Best Practice — Madrid plugin.
(com.snc.best_practice.problem.madrid) and the Problem Management — ATF Tests plugin (com.snc.problem.atf). For all state related test, the Problem Management State Model (com.snc.best_practice.problem.madrid.state_model) plugin needs to be active.

## PRB MGMT: Problem Management test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRB MGMT: Cancel a Problem when the state of the Problem is Assess</td>
<td>Verify that when a Problem in the <strong>Assess</strong> state is canceled, the state of the Problem changes to <strong>Closed</strong> with Resolution code as <strong>Canceled</strong>.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Cancel a Problem when the state of the Problem is Root Cause Analysis</td>
<td>Verify that when a Problem is in the <strong>Root Cause Analysis</strong> state and is canceled, the state of the Problem changes to <strong>Closed</strong> with Resolution code as <strong>Canceled</strong>.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Mark a Problem as Duplicate when the state of the Problem is Assess</td>
<td>Verify that when a Problem is in the <strong>Assess</strong> state and is marked as duplicate, the state of the Problem changes to <strong>Closed</strong> with Resolution code as <strong>Duplicate</strong>.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Mark a Problem as Duplicate when the state of the Problem is Root Cause analysis</td>
<td>Verify that when a Problem is in the <strong>Root Cause Analysis</strong> state and is marked as duplicate, the state of the Problem changes to <strong>Closed</strong> with Resolution code as <strong>Duplicate</strong>.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Accept Risk of Problem</td>
<td>Verify that when a Problem state is <strong>Fix in Progress</strong> and the</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>(problem.acceptrisk.move_to_closed:false,state:Fix in Progress)</td>
<td>If the Problem state changes to <strong>Resolved</strong> with <strong>Resolution code</strong> as <strong>Risk Accepted</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The test is valid when Problem property <strong>Accept Risk</strong> moves the Problem to <strong>Closed state</strong> instead of <strong>Resolved state</strong> (problem.acceptrisk.move_to_closed) is false.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRB MGMT: Accept Risk of Problem (problem.acceptrisk.move_to_closed:true,state:Fix in Progress)</td>
<td>Verify that when a Problem state is <strong>Fix in Progress</strong> and the risk is accepted, then the Problem state changes to <strong>Closed</strong> with <strong>Resolution code</strong> as <strong>Risk Accepted</strong>.</td>
<td>Madrid</td>
</tr>
<tr>
<td><strong>Note:</strong> The test is valid when Problem property <strong>Accept Risk</strong> moves the Problem to <strong>Closed state</strong> instead of <strong>Resolved state</strong> (problem.acceptrisk.move_to_closed) is true.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRB MGMT: Accept Risk of Problem (problem.acceptrisk.move_to_closed:false,state:Root Cause Analysis)</td>
<td>Verify that when a Problem state is <strong>Root Cause Analysis</strong> and the risk is accepted, then the Problem state changes to <strong>Resolved</strong>.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>
## PRB MGMT: Problem Management test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>with Resolution code as Risk Accepted.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: The test is valid when Problem property Accept Risk moves the Problem to Closed state instead of Resolved state (problem.acceptrisk.move_to_closed) is false.</td>
<td></td>
</tr>
<tr>
<td>PRB MGMT: Accept Risk of Problem</td>
<td>Verify that when a Problem state is Root Cause Analysis and the risk is accepted, then the Problem state changes to Closed with Resolution code as Risk Accepted.</td>
<td>Madrid</td>
</tr>
<tr>
<td></td>
<td>Note: The test is valid when Problem property Accept Risk moves the Problem to Closed state instead of Resolved state (problem.acceptrisk.move_to_closed) is true.</td>
<td></td>
</tr>
<tr>
<td>PRB MGMT: Reanalyze Problem which is closed-Risk Accepted from state Root Cause Analysis</td>
<td>Verify that when a Problem is reanalyzed after it is Closed with the Resolution code as Risk Accepted, Problem state changes to Root Cause Analysis.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Create Emergency Change from Problem</td>
<td>Verify the creation of Emergency Change from a Problem.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>PRB MGMT: Create Normal Change from Problem</td>
<td>Verify the creation of Normal Change from a Problem.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Problem State Management</td>
<td>Verify problem state management.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Reanalyze a Problem from Complete</td>
<td>Verify that when a Problem is reanalyzed after it is Closed with the Resolution code as Fix Applied, Problem state changes to Root Cause Analysis.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Reanalyze a Problem which is canceled from state Assess</td>
<td>Verify that when a Problem is reanalyzed after it is Closed with the Resolution code as Canceled, Problem state changes to Root Cause Analysis.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Reanalyze a Problem which is canceled from state Root Cause Analysis</td>
<td>Verify that when a Problem is reanalyzed after it is Closed with the Resolution code as Canceled, Problem state changes to Root Cause Analysis.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Reanalyze Problem which is closed-Risk Accepted from state Fix in progress</td>
<td>Verify that when a Problem is reanalyzed after it is Closed with the Resolution code as Risk Accepted, Problem state changes to Root Cause Analysis.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Create a Known Error article from Problem</td>
<td>Verify creation of Known Error article from a Problem.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>PRB MGMT: Risk Accept reason on Incident</td>
<td>Verify the <strong>Risk Accepted reason</strong> is copied to the Incidents which are awaiting resolution of a Problem.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Communicate Fix</td>
<td>Verify the communicate fix functionality.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Communicate Workaround</td>
<td>Verify the communicate workaround functionality.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Fix information on Incident</td>
<td>Verify that when a Problem is resolved, the state of the Incidents that are awaiting resolution of the Problem changes to <strong>Resolved</strong>. The fix notes of the Problem are copied to the Incidents.</td>
<td>Madrid</td>
</tr>
<tr>
<td>PRB MGMT: Problem task (Type:General) state management</td>
<td>Verify Problem task state management of a general type Problem.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>

**Related information**

**Quick start tests**

**Managing Problems**

Understand how Problem and Problem task is created, assessed, investigated, and fixed in a Problem or Problem task states.

**Create a problem**

A problem is a cause of one or more incidents. Create a problem to identify the root cause of the incidents and try to prevent them from happening again.
Before you begin
Role required: itil, sn_problem_write, admin, problem_admin, problem_manager, or problem_coordinator
If you do not have Problem Management Best Practice — Madrid plugin (com.snc.best_practice.problem.madrid) activated, see Create a problem (legacy).

About this task
• You can generate a problem record manually from the problem module.
• You can generate a problem from an incident.
• You can create a record producer to log problems from the service catalog.
• You can also generate a problem from an email when an appropriate inbound email action is configured.

Procedure
1. Create the problem with one of these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Problem module</td>
<td>Navigate to Problem &gt; Create New.</td>
</tr>
<tr>
<td></td>
<td>a. Open the incident.</td>
</tr>
<tr>
<td></td>
<td>b. On the context menu, click Create Problem.</td>
</tr>
</tbody>
</table>

Note: Use the property List of attributes (comma-separated) that will be copied from the incident to create a new problem (com.snc.problem.create_from_incident.attributes) to specify fields on the Incident form. The values of these fields are copied to the respective fields on the Problem form.

2. On the Problem form, fill in the fields.
### Problem form

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Read-only field. Unique number to identify the problem.</td>
</tr>
<tr>
<td>First reported by</td>
<td>Task that first identified this Problem.</td>
</tr>
<tr>
<td>Category</td>
<td>Group to which the problem belongs to such as software, hardware. After selecting the category, select the subcategory, if applicable.</td>
</tr>
<tr>
<td>Service</td>
<td>Business service that the problem applies to. If you select a business service as the configuration item and that business service is also listed as the configuration item in any other active task, the active tasks icon (şı) appears. Click the icon to view the list of all the other active tasks that are affecting the business service. You can view the BSM map (dependency view) of the selected business service by clicking the dependency icon.</td>
</tr>
<tr>
<td>Service Offering</td>
<td>Consists of one or more service commitments that uniquely define the level of service in terms of availability, scope, pricing, and packaging options. Service offering enables you to receive different features and their levels of performance for a given service.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the problem applies to. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>Name</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State</td>
<td>For existing customers, the available states are: <strong>Open</strong>, <strong>Pending Change</strong>, <strong>Known Error</strong>, and <strong>Closed</strong> or <strong>Resolved</strong>. For new customers from Madrid, the state management process is applied. This state field is a read-only field. The field value changes as the problem proceeds from one state to another state. The states available are: <strong>New</strong>, <strong>Assess</strong>, <strong>Root Cause Analysis</strong>, <strong>Fix in Progress</strong>, <strong>Resolved</strong>, and <strong>Closed</strong>.</td>
</tr>
<tr>
<td>Resolution code</td>
<td>Indicates whether the problem is resolved, a fix is applied, a duplicate is available, or the problem coordinator accepts the risk. <strong>Note:</strong> This field appears only for new customers from Madrid or a later release as it is part of the state management process.</td>
</tr>
<tr>
<td>Duplicate of</td>
<td>When Resolution code is <strong>Duplicate</strong>, the Duplicate of field is the reference to the Problem from which the current Problem is duplicated.</td>
</tr>
<tr>
<td>Impact</td>
<td>Effect that the problem has on business. Select the appropriate impact level (<strong>High</strong>, <strong>Medium</strong>, or <strong>Low</strong>).</td>
</tr>
<tr>
<td>Urgency</td>
<td>Extent to which the problem resolution can bear delay. Select the appropriate urgency level (<strong>High</strong>, <strong>Medium</strong>, or <strong>Low</strong>).</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem (<strong>Critical</strong>, <strong>High</strong>, <strong>Moderate</strong>, <strong>Low</strong>, or <strong>Planning</strong>). The Priority field is read-only and is set according to the Impact and Urgency values entered.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group who will work on the incident. The business rule Populate Assignment Group based on CI/SO populates the Assignment group field based on the support group</td>
</tr>
<tr>
<td>Name</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>available for the configuration item (CI)</td>
<td>available for the configuration item (CI) or the Service offering consecutively.</td>
</tr>
<tr>
<td>Note:</td>
<td>The business rule is triggered when an incident is created or updated and when the <strong>Assignment group</strong> and the <strong>Assigned to</strong> field is empty.</td>
</tr>
<tr>
<td></td>
<td>If you want to override the default value, you need to create new properties and provide the field in the property value that must be used to populate the <strong>Assignment group</strong> field. Create the properties in the following order of preference:</td>
</tr>
<tr>
<td></td>
<td>• com.snc.problem.ci_assignment_group.field_name: identifies which CI field populates the <strong>Assignment group</strong> field.</td>
</tr>
<tr>
<td></td>
<td>• com.snc.problem.service_offering_assignment_group.field_name: identifies which service offering field populates the <strong>Assignment group</strong> field.</td>
</tr>
<tr>
<td></td>
<td>If the <strong>Assignment group</strong> field is blank, the incident is automatically assigned to a group.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Specific problem coordinator that the problem is assigned to. If an assignment rule applies, the problem is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td>Problem Statement</td>
<td>Description of the problem that the problem-solving team addressing. When you update the problem statement and move to another field, the <strong>Related Search</strong> field displays knowledge articles. If you configure the problem properties, then the <strong>Related Search</strong> field displays other related information related to the problem statement.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem.</td>
</tr>
<tr>
<td>Related Search</td>
<td>Result of a search.</td>
</tr>
<tr>
<td>Name</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you want to search and link a known error article or knowledge article</td>
</tr>
<tr>
<td></td>
<td>to the Problem, click <strong>Attach</strong>.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notification when work notes are added to the problem.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Inscription about the work that you perform on the Problem.</td>
</tr>
<tr>
<td>Analysis Information</td>
<td></td>
</tr>
<tr>
<td>Workaround</td>
<td>Method that you have used to overcome the Problem. Providing a workaround</td>
</tr>
<tr>
<td></td>
<td>if useful for fast Incident resolution. It can be a way of</td>
</tr>
<tr>
<td></td>
<td>dealing with a problem or making something work despite the problem</td>
</tr>
<tr>
<td></td>
<td>not being resolved.</td>
</tr>
<tr>
<td></td>
<td>If a workaround is available, the problem</td>
</tr>
<tr>
<td></td>
<td>coordinator can click the Communicate Workaround action to notify the</td>
</tr>
<tr>
<td></td>
<td>related Incidents.</td>
</tr>
<tr>
<td>Cause notes</td>
<td>Inscription on what had caused the problem.</td>
</tr>
<tr>
<td>Resolution Information</td>
<td></td>
</tr>
<tr>
<td>Resolved by</td>
<td>Read-only field. Name of the user who resolved the issue.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field appears only for new customers from Madrid or a later release</td>
</tr>
<tr>
<td></td>
<td>as it is part of the state management process.</td>
</tr>
<tr>
<td>Resolved</td>
<td>Read-only field. The date and time when the Problem is resolved.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field appears only for new customers from Madrid or a later release</td>
</tr>
<tr>
<td></td>
<td>as it is part of the state management process.</td>
</tr>
<tr>
<td>Fix notes</td>
<td>Inscription on how you have fixed the problem.</td>
</tr>
<tr>
<td></td>
<td>If a fix is available, the problem coordinator</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>can click the Communicate Fix action to notify the related Incidents.</td>
<td></td>
</tr>
</tbody>
</table>

**Other Information**

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opened by</td>
<td>Read-only field. Name of the user who opened the problem.</td>
</tr>
<tr>
<td>Opened</td>
<td>Read-only field. The date and time when the user opened the Problem.</td>
</tr>
<tr>
<td>Confirmed by</td>
<td>Read-only field. Name of the user who confirms that the problem is valid and needs a resolution.</td>
</tr>
</tbody>
</table>

### Note:
This field appears only for new customers from Madrid or a later release as it is part of the state management process.

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirmed</td>
<td>Read-only field. The date and time when the user confirms that the Problem is valid and needs a resolution.</td>
</tr>
</tbody>
</table>

### Note:
This field appears only for new customers from Madrid or a later release as it is part of the state management process.

3. Click **Submit**.

The problem enters the **New** state. If you have filled the mandatory fields that are necessary to move a problem record to the **Assess** state, the problem record directly moves to the **Assess** state. If you want to add any additional field for the assess state, you must add the field at **System UI > Form Sections**. For more information, refer **Add a field in the assess mandatory field dialog**.

**What to do next**

Assess the problem.

**Create a problem (legacy)**

A problem is a cause of one or more incidents. Create a problem to identify the root cause of the incidents and try to prevent them from happening again.

**Before you begin**

Role required: itil
Procedure

1. Create the problem with one of these options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Problem module</td>
<td>Navigate to Problem &gt; Create New.</td>
</tr>
<tr>
<td>From an incident</td>
<td>a. Open the incident.</td>
</tr>
<tr>
<td></td>
<td>b. On the context menu, click Create Problem.</td>
</tr>
</tbody>
</table>

2. Complete the form, as appropriate.

Problem form fields

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business service</td>
<td>Business service that the problem applies to. If you select a business service as the configuration item and that business service is also listed as the configuration item in any other active task, the active tasks icon ( ) appears. Click the icon to view the list of all the other active tasks that are affecting the business service. You can view the BSM map (dependency view) of the selected business service by clicking the dependency icon .</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the problem applies to. The CI class of the selected configuration item identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>Change request</td>
<td>Change request associated with the problem.</td>
</tr>
<tr>
<td>Major problem</td>
<td>Check box to prioritize a problem and highlight that it needs a review.</td>
</tr>
<tr>
<td>Name</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Knowledge</td>
<td>Check box to automatically submit a knowledge article when a problem is closed.</td>
</tr>
<tr>
<td>State</td>
<td>State of the problem:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Open</strong>: Open and unassigned.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Pending Change</strong>: Waiting for the corresponding change request to be closed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Known Error</strong>: This problem is not going to be fixed and there is a workaround. Users with the itil role have access to the Known Errors module.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Closed/Resolved</strong>: The problem is fixed and closed.</td>
</tr>
<tr>
<td>Impact</td>
<td>Effect that the problem has on business. Select the appropriate impact level (<strong>High</strong>, <strong>Medium</strong>, or <strong>Low</strong>).</td>
</tr>
<tr>
<td>Urgency</td>
<td>Extent to which the problem resolution can bear delay. Select the appropriate urgency level (<strong>High</strong>, <strong>Medium</strong>, or <strong>Low</strong>).</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem (<strong>Critical</strong>, <strong>High</strong>, <strong>Moderate</strong>, <strong>Low</strong>, or <strong>Planning</strong>). The Priority field is read-only and is set according to the Impact and Urgency values entered.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Group who will work on the problem. The business rule Populate Assignment Group based on CI/SO populates the Assignment group field based on the support group available for the configuration item (CI) or the Service offering consecutively.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: The business rule is triggered when a problem is created or updated and when the Assignment group and the Assigned to field is empty.</td>
</tr>
<tr>
<td></td>
<td>If you want to override the default value, you need to create new properties and provide the field in the property value that must be</td>
</tr>
<tr>
<td>Name</td>
<td>Definition</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td>Name</td>
<td>Definition</td>
</tr>
<tr>
<td>used to populate the <strong>Assignment group</strong> field. Create the properties in the following order of preference:</td>
<td></td>
</tr>
<tr>
<td>• <code>com.snc.problem.ci_assignment_group.field_name</code>: identifies which CI field populates the <strong>Assignment group</strong> field.</td>
<td></td>
</tr>
<tr>
<td>• <code>com.snc.problem.service_offering_assignment_group.field_name</code>: identifies which service offering field populates the <strong>Assignment group</strong> field.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> If you are an upgrade customer and want to install the ITSM CSDM Best Practices - Quebec plugin (com.snc.best_practise.itsm_csdm.quebec) on your instance, please contact Support.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> The <code>sys_user_group</code> read ACL calls the SNCRoleUtil function. The function verifies whether the group that is reviewed contains either the admin role or security_admin role. The function allows the user to view the group only if the user has the same role. As a result, a user with the itil role cannot assign an incident to a group that has the admin role or security_admin role nor to any group whose parent has those role.</td>
<td></td>
</tr>
<tr>
<td><strong>Assigned to</strong></td>
<td>Specific user that the problem is assigned to. If an assignment rule applies, the problem is automatically assigned to the appropriate user or group.</td>
</tr>
<tr>
<td><strong>Parent</strong></td>
<td>The parent task for this problem.</td>
</tr>
<tr>
<td><strong>Short description</strong></td>
<td>Summary of the problem.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Detailed description of the problem.</td>
</tr>
<tr>
<td><strong>Work notes list</strong></td>
<td>Users who receive notification when work notes are added to the problem. Click the <strong>Add me</strong> icon to add yourself to the work notes list.</td>
</tr>
</tbody>
</table>
Name | Definition
--- | ---
 | notes list for problems you are interested in monitoring.

3. To enter work notes for the problem, click the **Notes** tab.

When you initially create and save a problem, entering notes in the **Work notes** field is not mandatory. If you change the priority of the problem by selecting different **Impact** or **Urgency** values on an existing problem, the **Work notes** field becomes mandatory.

<i>Note:</i> This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.

4. To enter notes on why the problem is closed, click the **Closure Information** tab and enter the information.

The date on which the problem was closed and the user who closed it populate automatically.

5. Click **Submit**.

**What to do next**
Assess the problem.

**Assess a problem**

Assess a problem to determine whether the problem requires a thorough investigation.

**Before you begin**

- Role required: admin, problem_admin, problem_manager, or problem_coordinator
- Activate the Problem Management Best Practice — Madrid — State Model (com.snc.best_practice.problem.madrid.state_model) to get the new best practice states and guided actions to navigate the lifecycle of a problem. For details, see [Activate Problem Management Best Practice — Madrid — State Model](#).

**About this task**

Assessing a problem involves analyzing the scale and extent of the problem, as well as its cause and effect.

**Procedure**

Click **Assess** and fill the mandatory fields.
After assessing the problem, you can perform any one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action to be taken</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the problem is valid and requires a resolution</td>
<td>Click <strong>Confirm</strong>.</td>
</tr>
<tr>
<td>If there is an existing problem with similar issue</td>
<td>Click <strong>Mark Duplicate</strong>.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
</tr>
<tr>
<td></td>
<td>• When you mark a problem as duplicate, the related records from the duplicate problem are moved to the existing problem.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>List of related task records (comma-separated)</strong> to move over when a problem is marked as a duplicate of another (problem.duplicate.records_to_move) problem management property controls the related records that are copied from the existing to the original problem.</td>
</tr>
<tr>
<td>If the problem is not a valid problem</td>
<td>Click <strong>Cancel</strong>.</td>
</tr>
</tbody>
</table>

**What to do next**

After you confirm that the problem needs investigation and a resolution, the problem enters the **Root Cause Analysis** state.

**Add a field in the assess mandatory field dialog**

Add the mandatory fields necessary to move a problem or a problem task record from the **New** state to the **Assess** state in the assess dialog form. If you miss filling any of the fields, you can always fill those in the assess dialog form.

**Before you begin**

Role required: admin
Procedure

1. Navigate to **System UI > Form Sections**.
2. Search and open **Assess Dialog Form View** or **PTASK Assess Dialog View** for problem record or problem task record respectively.
3. Click the **Form Sections** tab.
4. Click problem or problem_task from the list for problem record or problem task record respectively.
5. Click the **Section Elements** tab.
6. Click **New**.
7. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element</td>
<td>Name of the field that you want in the assess dialog form.</td>
</tr>
<tr>
<td>Position</td>
<td>Position of the field in the assess dialog form.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the element that you want to enter in the form such as an element or a split.</td>
</tr>
<tr>
<td>Sys UI section</td>
<td>Name of the UI section under which the element appears.</td>
</tr>
<tr>
<td>Sys UI formatter</td>
<td>Name of the formatter that is used to display information.</td>
</tr>
</tbody>
</table>

8. Click **Submit**.

**Add multiple incidents to a problem**

Add multiple incidents to a problem to avoid creating multiple problems for incidents that have same issue.

**Before you begin**

Role required: itil, admin, problem_admin, problem_coordinator or problem_manager
About this task
The topic applies to Problems where you have activated the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.

Procedure
1. Navigate to Problem > Open.
2. Open a problem record.
3. In the related list, click the Incidents tab.
4. Click Add.
5. From the list, select the records and click Add Selected.
   The selected incidents appear under the Incidents tab.

Associate CIs with Problem
Associate multiple affected or impacted configuration items (CIs) to a problem to find out all the CIs that are affected by the same problem.

Before you begin
Role required: itil, sn_problem_write, admin, problem_admin, problem_coordinator or problem_manager

About this task
Use the Configuration Item field when there is a single, primary CI that is the cause of the problem and the Affected CIs or the Impacted Services/CIs related list when multiple CIs are affected by the problem.

Procedure
1. Navigate to Problem > Open.
2. Open the problem record to which you want to associate CI items.
3. Perform the following actions:
### Associate CI items

<table>
<thead>
<tr>
<th>Options</th>
<th>Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration item</td>
<td>a. Click the lookup icon (🔍).</td>
</tr>
<tr>
<td></td>
<td>b. Select configuration item.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> By default, Service Offering is filtered out and CIs with Principal Class are selected. The Principal Class filter functionality is applicable to the new customers starting the Paris release.</td>
</tr>
<tr>
<td>Affected CIs</td>
<td>a. Click <strong>Add</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Select configuration items.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> By default, Service Offering is filtered out and CIs with Principal Class are selected. The Principal Class filter functionality is applicable to the new customers starting the Paris release.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Add Selected</strong>.</td>
</tr>
<tr>
<td>Impacted Services/CIs</td>
<td>a. Click <strong>Add</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Select configuration items.</td>
</tr>
</tbody>
</table>
Options | Procedures
---|---
| **Note:** By default, Service Offering is filtered out. |
| c. Click **Add Selected**. |
| **Note:** If the Impacted Services/CIs is not visible on the form, configure the form layout. |

### Data for problem resolution

The quick resolution of problems requires gathering as much information as possible about the problem.

In addition to the information within the problem ticket, useful information is often found in other tables.

### Pertinent related records

Common related records include changes (through the **Change request** related list) and incidents in the **Incidents** related list. All the directly related records are accessible through related lists. If the appropriate related list does not appear on the form, the administrator can configure the form to add it.

### Known errors and knowledge articles

Information about already-known issues can be found in two places: the **Known Errors** module in the Problem Management application, or in the Knowledge application. The **Known Errors** module filters the problem table to present all the problems whose cause has been identified but cannot be fixed. The knowledge base can have information that was gathered from incidents, and may also have useful workarounds for problems.

### Dependency Views map

The Dependency Views map provides a visual representation of the configuration items and their relationships and displays information about related issues.

For example, the following image is a map for the CI **nyc rac na200**, which is a mass storage device.
The icons beside CIs indicate the following information. You can view information for the selected CI by clicking Details in the form header, or by pointing to the icon and viewing a pop-up box.

- The cloud x icon indicates that the CI has an associated problem, which is listed in the Problem details pane.
- The (!) icon indicates that there is a related incident.
- The link icon indicates that there are associated tasks, which can be incidents, problems, or changes. If you select the CI, the Details pane displays the associated records.

To open the incident or problem record, click the number in the Details pane.

The map shows the upstream and downstream relationships of the CI. The storage device problem might be an improper change to one of the UNIX servers.

**CMDB baseline history**

If a baseline is generated, planned or unplanned changes are tracked within the system. A common cause of problems is improperly executed changes, and reviewing the history of changes to a CI helps track problems caused by improper changes.

To check the CMDB Baseline, view the CI record and check Baseline Differences and Scheduled Changes. The administrator can use the form designer to add these formatters.
In the example above, the change in RAM is associated with a change request. You can review the change and see what was planned and what was implemented. The removal of QuickTime software was recorded as an unplanned change.

**Investigate root cause of a problem**

Identify the root cause of the problem to analyze, track, and resolve recurring incidents permanently.

**Before you begin**

- Role required: admin, problem_admin, problem_coordinator, or problem_manager
- Activate the Problem Management Best Practice — Madrid — State Model (com.snc.best_practice.problem.madrid.state_model) to get the new best practice states and guided actions to navigate the lifecycle of a problem. For details, see Activate Problem Management Best Practice — Madrid — State Model.
About this task

Procedure

You can perform any one of the following tasks:

<table>
<thead>
<tr>
<th>Option</th>
<th>Actions to be taken</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you can resolve the problem</td>
<td>Click <strong>Fix</strong>. The problem state changes to <strong>Fix in Progress</strong>. You can then create a new Change Request or link to an existing Change Request to apply a permanent fix to the problem.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Notification is sent to the problem coordinator, who is assigned to the Problem, when all the related Change Requests are completed or canceled.</td>
</tr>
<tr>
<td>If you acknowledge the problem but there is no permanent resolution to the problem</td>
<td>Click <strong>Accept Risk</strong>. The problem directly enters the Closed or Resolved state with the Resolution code as Risk accepted.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Whether the problem enters the Closed state or the Resolved state, depends on the property Accept Risk moves the Problem to Closed state instead of Resolved state (problem.acceptrisk.move_to_closed).</td>
</tr>
<tr>
<td>If you decide to reanalyze the problem</td>
<td>Click <strong>Re-analyze</strong>. The problem opens for reanalysis and the state is changed to Root Cause Analysis.</td>
</tr>
</tbody>
</table>

If you had created any known error article for this problem or any similar problem, you can add the reference of that article in the Primary Known Error article field.
Note: The Primary Known Error article field is available only when you activate the Problem Management Best Practice — Madrid — Knowledge Integration plugin (com.snc.best_practice.problem.madrid.knowledge).

What to do next
You can resolve and complete the problem. You can also create a change request to implement a fix for the problem.

Resolve and complete a problem
Resolve the issue and add detailed note of the resolution for future reference.

Before you begin
• Role required: admin, problem_admin, problem_coordinator, or problem_manager
• Activate the Problem Management Best Practice — Madrid — State Model (com.snc.best_practice.problem.madrid.state_model) to get the new best practice states and guided actions to navigate the lifecycle of a problem. For details, see Activate Problem Management Best Practice — Madrid — State Model.

Procedure
1. Click Resolve.

The problem enters the Resolved state with Resolution code as Fix Applied.

2. Click Complete.

The problem enters the Closed state with Resolution code as Fix Applied.
Note:

• When a problem is closed or canceled, all related open problem tasks are canceled provided you select the problem management property **Cancel open Problem Tasks when closing a Problem** (problem.closed.cancel_open_tasks).

• When a problem is closed, you can still create problem tasks provided you select the problem management property **Can create a Problem Task on a Closed Problem?** (problem.closed.can_create_tasks).

You can reanalyze the problem even after it is closed by clicking **Re-analyze**. The state of the problem changes from **Closed** to **Root Cause Analysis**. The following problem management properties controls who can reanalyze the problem:

• **Who can Re-analyze a Canceled Problem?** (problem.closed.role.reanalyze_from_canceled)

• **Who can Re-analyze a Risk Accepted (Closed state) Problem?** (problem.closed.role.reanalyze_from_closed_riskaccepted)

• **Who can Re-analyze a Completed Problem?** (problem.closed.role.reanalyze_from_completed)

When all the related tasks mentioned in the problem management property **List of related task records (comma-separated) to track as fixes for this Problem. Used to notify the Coordinator when the all of the related fix records are Completed or Canceled. E.g. incident.problem_id, change_request.parent (problem.fix.records)** are completed, a notification is sent to the problem coordinator regarding the same.

Note: Changing this property to include new tables also requires you to create a corresponding Business Rule for the overall functionality to work seamlessly. For example, for the Change request, the Business Rule is **Check Related Problem Fixes – Change Req.**

Create change request from a problem

After you investigate and perform a root cause analysis of the Problem, you can understand whether the Problem can be resolved or you should find a temporary workaround for the Problem. If the Problem can be resolved, implement the fix, or the resolution for the Problem.

**Before you begin**
Role required: problem_coordinator or admin
About this task
You can implement a resolution to a problem by applying a standard change procedure and testing to confirm service recovery. For a normal change, you raise a Request For Change (RFC). The Change Advisory Board (CAB) needs to approve the RFC before a resolution is applied to the Problem.

Procedure
1. Navigate to Problem > Open and open a problem record.
2. On the context menu, perform any one of the following activities:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action to be taken</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal change</td>
<td>Click Create Normal Change.</td>
</tr>
<tr>
<td>Emergency change</td>
<td>Click Create Emergency Change.</td>
</tr>
</tbody>
</table>

A change request is created to implement the solution for the problem.

Add multiple change requests to a problem
Add multiple change requests to a problem to capture all the requests that you need to implement to fix the problem.

Before you begin
Role required: itil, admin, problem_admin, problem_coordinator or problem_manager

About this task
The topic applies to Problems where you have activated the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.

Procedure
1. Navigate to Problem > Open.
2. Open a problem record.
3. In the related list, click the Change Requests tab.
4. Click Add.
5. From the list, select the records and click Add Selected.
   The selected change requests appear under the Change Requests tab.
Create a problem task

A problem task is the smallest unit of work that you should perform to complete a problem. Divide your problem into multiple problem tasks which you can easily assign to different assignment groups or users.

Before you begin
Role required: itil, sn_problem_write, admin, problem_admin, problem_coordinator, problem_manager, or problem_task_analyst

Procedure
1. Navigate to Problem > Open.
2. Open the problem record for which you want to create a problem task.
3. In the related list of the problem record, click Problem Tasks and click New.
4. Select any one of the following problem tasks:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root Cause Analysis</td>
<td>Tasks where you investigate the root cause of a problem and find a resolution for the problem</td>
</tr>
<tr>
<td>General</td>
<td>All other tasks</td>
</tr>
</tbody>
</table>

5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Read-only. Unique number to identify the task.</td>
</tr>
<tr>
<td>Type</td>
<td>Read-only state. Determines whether the problem task is created specifically to investigate the cause of the problem or is a general task.</td>
</tr>
<tr>
<td></td>
<td>Note: This field appears only for new customers from Madrid or a later release as it is part of the state management process.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Configuration item (CI) that the problem applies to. The CI class of the selected configuration item</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Report problem</td>
<td>Identifies the type of problem, for example, hardware, network, or database.</td>
</tr>
<tr>
<td>Due date</td>
<td>Date within which the problem task should be completed.</td>
</tr>
<tr>
<td>Source problem</td>
<td>Unique number of the problem for which the problem task is created.</td>
</tr>
<tr>
<td>State</td>
<td>For existing customers, the available states are: <strong>Pending, Open, Work in Progress, Closed Complete, Closed Incomplete</strong>, and <strong>Closed Skipped</strong>. For new customers from Madrid, the state management process is applied. This state field is a read-only field. The states available are: <strong>New, Assess, Work in Progress</strong>, and <strong>Closed</strong>.</td>
</tr>
<tr>
<td>Close code</td>
<td>Read-only field indicating whether the problem task was completed or canceled.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field appears only for new customers from Madrid or a later release as it is part of the state management process.</td>
</tr>
<tr>
<td>Priority</td>
<td>How quickly the service desk should address the problem task (Critical, High, Moderate, Low, or Planning).</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Specific group to whom the problem task is assigned to.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Specific problem analyst to whom the task is assigned to.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the problem task.</td>
</tr>
<tr>
<td></td>
<td>When you update the short description, and move to another field, the <strong>Related Search</strong> field displays knowledge articles. If you configure the problem properties, then the</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Related Search</strong></td>
<td>Related Search field displays other related information related to the short description.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the problem task.</td>
</tr>
<tr>
<td>Related Search</td>
<td>Result of a search.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you want to search and link a knowledge article to the Problem task, click Attach.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Work notes list</td>
<td>Users who receive notification when work notes are added to the problem task.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Inscription about the work that you perform on the problem task.</td>
</tr>
<tr>
<td>Analysis Information</td>
<td></td>
</tr>
<tr>
<td>Cause code</td>
<td>Cause of the Problem such as Environmental disaster, Hardware issue, People/Process/Documentation.</td>
</tr>
<tr>
<td>Workaround (Root Cause Analysis only)</td>
<td>Method that you have used to overcome the Problem. It can be a way of dealing with a problem or making something work despite the problem not being resolved.</td>
</tr>
<tr>
<td>Closure Information</td>
<td></td>
</tr>
<tr>
<td>Completed by</td>
<td>Read-only field. Name of the user who completed the task.</td>
</tr>
<tr>
<td>Completed</td>
<td>The reason why this problem task has been canceled.</td>
</tr>
<tr>
<td>Fix notes (Root Cause Analysis only)</td>
<td>Inscription on how you have fixed the problem task.</td>
</tr>
<tr>
<td>Close notes (General task only)</td>
<td>Inscription on the work you have completed.</td>
</tr>
</tbody>
</table>
6. Click Submit.
The problem task enters the **New** state. If you have filled the mandatory fields that are necessary to move a problem task record to the **Assess** state, the problem task record directly moves to the **Assess** state. If you want to add any additional field for the assess state, you must add the field at **System UI > Form Sections**. For more information, refer **Add a field in the assess mandatory field dialog**.

**What to do next**
Assess the problem task.

**Assess a problem task**
Assess a problem task to determine the feasibility of working on the task.

**Before you begin**
Role required: admin, problem_admin, problem_coordinator, problem_manager, or problem_task_analyst

**About this task**
Assessing a problem task involves analyzing the scale and extent of the task, as well as its cause and effect.

**Procedure**
1. Click **Assess**.

The problem task enters the **Assess** state. You can confirm whether there is enough information to work on the task or if the task should be canceled.

2. After assessing the task, you can perform the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Actions to be taken</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you are ready to work on the task</td>
<td>Click <strong>Start Work</strong>. The problem task enters the <strong>Work in Progress</strong> state.</td>
</tr>
<tr>
<td>Option</td>
<td>Actions to be taken</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>When you do not need to work on the task. For example, if the problem task is duplicate or no longer needed</td>
<td>Click <strong>Cancel</strong>. The problem task enters the <strong>Closed</strong> state with <strong>Close code</strong> as <strong>Canceled</strong>.</td>
</tr>
</tbody>
</table>

**What to do next**

Resolve the problem task.

**Complete a problem task**

Resolve and complete the problem task.

**Before you begin**

Role required: admin, problem_admin, problem_coordinator, problem_manager, or problem_task_analyst

**Procedure**

Click **Complete**.

![Problem Task States](image)

The problem task enters the **Closed** state with **Close code** as **Complete**.

![Note: You can configure the Problem properties to reanalyze a task even after it is closed by clicking Re-assess. The state of the task changes from Closed to Assess. After all the problem tasks are completed or canceled, a notification is sent to the problem coordinator regarding the same.](image)

**Resolve related incidents from a problem**

After you consider a problem to be resolved, the incidents related to the problem with the state **On Hold** may be resolved using a UI action from the **Problem** form.

**Before you begin**

Role required: itil

**About this task**

The topic only applies to legacy problem — Jakarta to London.
Procedure
1. Open a resolved problem that has associated incidents.
2. From the context menu, click Resolve Incidents.
3. Enter values for mandatory fields.

Note: Only the incidents in state On Hold and with Awaiting Problem as the on hold reason can be resolved.

The state of the incidents in the problem related list is changed to Resolved and work notes are added to the activity feed.

Synchronization between incident and problem records
Change in a Problem record impacts related Incident records. Notification is sent to the user for each such update.

When you activate the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) and the Problem Management Best Practice — Madrid — State Model (com.snc.best_practice.problem.madrid.state_model) plugin, the changes in a Problem record impact incidents that are associated to that Problem.

Impact on incident records

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Incident state</th>
<th>Problem state</th>
<th>Action on Problem</th>
<th>Action on Incident</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem Management Best Practice — Madrid plugin</td>
<td>Any incident state other than resolved, closed, or canceled.</td>
<td>Any</td>
<td>Click the Communicate workaround related link</td>
<td>• The workaround information is copied from the Workaround field on the Problem form to the Additional Comments field on the Incident form. • An email notification is sent to</td>
</tr>
</tbody>
</table>
## Impact on incident records (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Incident state</th>
<th>Problem state</th>
<th>Action on Problem</th>
<th>Action on Incident</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Problem Management Best Practice — Madrid plugin</strong></td>
<td></td>
<td></td>
<td></td>
<td>the caller and the user who is assigned to the Incident.</td>
</tr>
<tr>
<td>com.snc.best_practice.problem.madrid</td>
<td>On Hold and On hold reason is Awaiting Problem</td>
<td>Any</td>
<td>Click the Communicate fix related link</td>
<td></td>
</tr>
<tr>
<td><strong>Problem Management Best Practice — Madrid — State Model plugin</strong></td>
<td>On Hold and On hold reason is Awaiting Problem</td>
<td>Problem state is Closed or Resolved and the problem Resolution code is Fix Applied</td>
<td>NA</td>
<td><strong>•</strong> The Resolution notes on the incident form displays the message Related problem INCxxxx</td>
</tr>
</tbody>
</table>

---

The fix information is copied from the Fix notes field on the Problem form to the Additional Comments field on the Incident form.

An email notification is sent to the caller and the user who is assigned to the Incident.
### Impact on incident records (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Incident state</th>
<th>Problem state</th>
<th>Action on Problem</th>
<th>Action on Incident</th>
</tr>
</thead>
</table>
| Problem Management Best Practice — Madrid — State Model plugin | On Hold and On hold reason is Awaiting Problem | Problem state is Closed or Resolved and the problem Resolution code is Risk Accepted | NA | closed. Please see additional comments for fix notes, where INCxxxx is the incident number from which the problem was created.  
- The incident state is changed to Resolved.  
- The Resolution code is changed to Solved (Permanently).  
- An email notification is sent to the caller and the user who is assigned to the Incident.  
- The information from the Risk accepted reason field on the
Impact on incident records (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Incident state</th>
<th>Problem state</th>
<th>Action on Problem</th>
<th>Action on Incident</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.best_practice.problem.madrid.state_model</td>
<td></td>
<td></td>
<td></td>
<td>Problem form is copied to the Work notes field on the Incident form.</td>
</tr>
</tbody>
</table>

• An email notification is sent to the user who is assigned to the Incident.

Communicating the outcome of a problem

Document the cause and resolution of a problem to resolve incoming incidents quickly and avoid further problems to be raised on the same issue.

Communicate workaround for Problem

Document and communicate workaround to let others know that you are aware of the issue. The workaround is a temporary way to restore service failures and lessen the impact of a Problem for which an actual resolution is not yet available.

Before you begin

admin, problem_admin, problem_manager or problem_coordinator

About this task

When you communicate a workaround, notification is sent to related incidents that a workaround is available. The Incident process is designed to use the workaround information or to notify the user of the same. For more information on notification, refer Synchronization between incident and problem records.

Note: The topic applies to Problems where you have activated the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.
Procedure
1. Navigate to Problem > Open.
2. Open the Problem record.
3. Enter the information in the Analysis Information > Workaround field.
4. Save the record.
5. Under Related Links, click Communicate Workaround.

Communicate workaround (legacy)
You can enter a workaround note into a problem record, and then post the information into every associated incident.

Before you begin
Role required: itil or admin

About this task
The Communicate Workaround related link on the Problem form eliminates the need to manually update each incident related to the Problem.

Procedure
1. Open the problem for which you have a workaround.
2. Enter the information in the Workaround field.
3. Click Post.
4. Click the Communicate Workaround related link.
   The problem number and the content of the Workaround field are added to the activity stream on all related incidents. By default, any entries made in an incident activity stream field generate an email notification to the Caller that you mention on the Incident form.
   If group on-call rotation scheduling is in effect when you communicate a workaround, the system stops the escalations on the associated incidents. Escalation stops because a workaround is available. This action effectively communicates knowledge to the appropriate audience, but does not create a knowledge article.

Communicate a fix
After you have completed root cause analysis of a problem and have come up with a resolution or fix for that problem, submit change requests to get the problem fixed. Documenting and communicating fix helps user to know the solution to a problem.
Before you begin
admin, problem_admin, problem_manager or problem_coordinator

About this task
When you communicate a fix, notification is sent to related incidents that a fix is available. The Incident process is designed to use the fix information or to notify the user of the same. For more information on notification, refer Synchronization between incident and problem records.

⚠️ Note: The topic applies to Problems where you have activated the Problem Management Best Practice — Madrid (com.snc.best_practice.problem.madrid) plugin.

Procedure
1. Navigate to Problem > Open.
2. Open the Problem record.
3. Enter the information in the Resolution Information > Fix notes field.
4. Save the record.
5. Under Related Links, click Communicate Fix.

Knowledge articles from problems
Knowledge bases house the information an organization wants to keep and share. The Problem form includes four options for creating knowledge and communicating information.

⚠️ Note: If you have Problem Management Best Practice — Madrid — Knowledge Integration plugin (com.snc.best_practice.problem.madrid.knowledge) activated, see Create a known error article. The topic applies to legacy Problem (London or a prior release) only.

- You can select the Knowledge check box and automatically submit a knowledge article when a problem is closed.
- You can enter a workaround note into a problem record, and then post the information into every associated incident.
- You can create a knowledge article from the problem immediately, and not wait for when the problem is closed.
- You can quickly create and publish a knowledge article in the News category.
By default, most new articles are created as drafts and move through a review state before they are published. An exception to the standard workflow is posting news from the Problem form.

If the administrator enables the optional knowledge submission workflow, articles created from incidents or problems become knowledge submissions, which are processed through a different path. For more information, see Knowledge workflows.

**Use the knowledge check box**

As with incidents, problems often generate information that may be needed in the future. The system can automatically submit a knowledge article when a problem is closed.

**Before you begin**

Role required: itil

**About this task**

ℹ️ **Note:** If you have Problem Management Best Practice — Madrid — Knowledge Integration plugin (com.snc.best_practice.problem.madrid.knowledge) activated, see Create a known error article. The topic applies to legacy Problem (London or a prior release) only.

You can select the Knowledge check box and automatically submit a knowledge article when a problem is closed.

**Procedure**

1. Select the Knowledge check box on the Problem form.
2. Resolve and close the problem.

Closing the problem triggers the business rule Problem Create Knowledge. By default, the business rule creates a knowledge article in the Draft workflow state, ready for a knowledge team member to review and publish. The problem Short description becomes the article Short description, and the problem Work notes become the article Text.

If the knowledge submission workflow is enabled, the problem Work notes become a knowledge submission instead of an article. For more information, see Knowledge workflows.
Create a known error article

Create known error articles as reference material. The known error articles document the root cause and the workaround of the problem to help with deflecting incidents.

Before you begin
Role required: admin, problem_admin, problem_coordinator, or problem_manager

About this task
After you create a known error article from a problem, the article is saved in the knowledge base and maintained in the Knowledge Management application. The publishing and retirement processes for a knowledge article are controlled by workflows defined for the knowledge base that the article belongs to. For more information, see Knowledge workflows.

Procedure
1. Navigate to Problem > Open.
2. Open the Problem record.
3. Under Related Links, click Create Known Error Article.

   Note: The link appears when the Primary Known Error article field is empty under the Analysis Information tab on the Problem form.
4. On the form, fill in the fields.

Known Error article form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Read-only field. Unique number to identify the known error article.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Knowledge base (defaults to Known Error) in which the article is stored for future reference. The article is saved in the Known Error article [kb_template_known_error_article] table.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Category</td>
<td>Read-only field. The value of this field is reference from the Category field of the Problem.</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date after which the known error article is deleted from the database. After this date, the article does not appear in the search result.</td>
</tr>
<tr>
<td>Version</td>
<td>Read-only field. Managed by the Knowledge Management process when changes are made to a published article.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Read-only field.</td>
</tr>
<tr>
<td>Source Task</td>
<td>Read-only field. The Problem record on which you are creating the article.</td>
</tr>
<tr>
<td>Attachment link</td>
<td>Select the check box so that the article appears as an attachment in the Problem record. If you do not select the check box, the content of the article appears in the work note of the Problem.</td>
</tr>
<tr>
<td>Display attachments</td>
<td>Select the check box so that all attachments to the article appear when you view the article. The field is relevant only when the Attachment link field is not selected.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the Known Error.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed explanation of the Known Error.</td>
</tr>
<tr>
<td>Workaround</td>
<td>Method that you have used to overcome the Problem. It can be a way of dealing with a problem or making something work despite the problem not being resolved.</td>
</tr>
<tr>
<td>Cause</td>
<td>Information on what had caused the problem.</td>
</tr>
</tbody>
</table>
Note: Click Search for Duplicates to search for existing known error articles. The search is based on short description, category, and topic.

5. Click Submit.

Note: To read the content of the article, click View Article under Related Links.

What to do next
Click Publish to send the article for review and approval. Depending on the Knowledge base where the article is stored and the Knowledge Base access controls, this Known Error article may be available to search for users outside of the IT team to help with Incident deflection.

Post knowledge
You can create a knowledge article from the problem immediately, and not wait for when the problem is closed.

Before you begin
Role required: itil, knowledge

About this task
If you have Problem Management Best Practice — Madrid — Knowledge Integration plugin (com.snc.best_practice.problem.madrid.knowledge) activated, see Create a known error article. The topic applies to legacy Problem (London or a prior release) only.

Procedure
1. Open a problem from which to post a knowledge article.

2. Click the Post Knowledge related link.
   The resulting knowledge article contains the following information.
   • The problem number and Short description become the knowledge article Short description.
   • The problem Description and Workaround become the knowledge article Text.
   • The problem Configuration item becomes the knowledge article Configuration Item.
   • The article Topic is set to Known Error.
By default, the system creates a knowledge article in **Draft** workflow state. If the knowledge submission workflow is enabled, the problem **Short description** and **Work notes** are placed into a knowledge submission instead of an article. For more information, see Knowledge workflows.

**Problem management integrations**

Problem Management is integrated with other ServiceNow applications such as Contextual search and Performance Analytics to improve the overall business process.

The following topics provide information about integration of different applications with Problem Management and way to enable functionality of those integrated applications.

**Working with contextual search**

Contextual search display results on forms and record producers based on the text that you provide in a field.

ℹ️ **Note:** Contextual Search is available for problems in instances starting with the Madrid release. Existing users can request to activate the Problem Management Best Practice — Madrid plugin (com.snc.best_practice.problem.madrid).

You can:

- Find articles using the **Related Search** field. The articles can be based on any category that you select from the choice list.
- Use the choice list next to the **Related Search** field to select the category such as **Knowledge (All)**, **Pinned Articles**, **Incidents**, **Open Problems**, and **Resolved Problems**.
- Attach the article in the **Notes > Work notes** if your search result displays knowledge articles.

**Related information**

- Contextual search overview

**Domain separation and problem management**

Domain separation is supported in Problem Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.
Support level: Standard

- Includes Basic level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

Overview

- Problem Management is about eliminating the root cause of a service interruption.
- The problem and problem task tables support domain separation. Therefore a Problem user sees only problems or problem tasks that have been created within the (tenant) domain that they belong to.
- Only Problem users can create and access Problems and problem tasks.
- Problem and problem task tables both support domain separation. Therefore, a Problem user sees only problems and problem tasks that have been created within the (tenant) domain that they belong to.

How domain separation works in Problem Management

Problem users see only problems and problem tasks that have been created within the (tenant) domain that they belong to.

Problem users can use Problems and problem tasks within the tenant domains. Problem users can create and update problems and problem tasks of their domain, any child domains, and the global domain.

Known Issues

Task-Outage Relationship [cmdb_ci_outage] is not domain separated.

If installed, the Task-Outage Relationship table is not domain separated. Therefore Fulfillers or Problem users can view any Task-Outage Relationship records regardless of the domain that the records belong to.
The Task-Outage Relationship table is installed when administrator activates the optional Task-Outage Relationship plugin.

**Related information**

- Domain separation for service providers

### Problem Management Analytics and Reporting Solutions

Analytics and Reporting Solutions and in-form analytics contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can use Performance Analytics for your application with minimal setup. You can also create your own objects.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

**Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see [Configure Analytics and Reporting Solutions](#).

To enable the solution for Problem Management, an admin can navigate to **Performance Analytics** > **Guided Setup**. Click **Get Started** then scroll to the section for Problem Management. The guided setup takes you through the entire setup and configuration process.

Several of the dashboards in this content pack are inactive when installed. Complete configuration and run data collection jobs before you activate these dashboards. You can activate dashboards in Dashboard Properties, accessible from the context menu. You have to assign an owner to the dashboard to activate it. For more information about configuring Analytics and Reporting Solutions, see [Configure Analytics and Reporting Solutions](#).

### Inactive dashboards

Some dashboards in this content pack are inactive when installed. Complete configuration and run data collection jobs before you activate these dashboards. You can activate dashboards in Dashboard Properties, accessible from the context menu. You have to assign an owner to the dashboard to activate it. For more information about configuring Analytics and Reporting Solutions, see [Configure Analytics and Reporting Solutions](#).
Related information

Analytics and Reporting Solutions
Activate your Performance Analytics subscription

Problem Overview dashboard

This dashboard shows the current state of open problems.

- **Critical Open Problems**: 3
- **Unassigned Problems**: 11
- **Overtue Problems**: 4
- **Open Problems**: 70
- **Problems not updated for 7 days**: 67
- **Open Problems older than 30 Days**: 67

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem manager and Problem agent</td>
<td>None</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### End user and goal

overdue, and unassigned problems to identify immediate action areas.

### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical open problems</td>
<td>Single Score</td>
<td>All open problems where Priority is 1 - Critical. This report tells you at a glance how many top priority problems there are.</td>
</tr>
<tr>
<td>Unassigned problems</td>
<td>Single Score</td>
<td>All open problems where 'Assigned to' is empty. These are the problems you have to assign.</td>
</tr>
<tr>
<td>Overdue problems</td>
<td>Single Score</td>
<td>All open problems where Escalation = Overdue</td>
</tr>
<tr>
<td>Open problems</td>
<td>Single Score</td>
<td>All open problems</td>
</tr>
<tr>
<td>Problems not updated for 7 days</td>
<td>Single Score</td>
<td>Open problems where the value in the Updated field is more than 7 days ago</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open problems older than 30 days</td>
<td>Single Score</td>
<td>Open problems where the value in the Created field is more than 30 days ago</td>
</tr>
<tr>
<td>Open problems - Grouped</td>
<td>Horizontal Bar</td>
<td>Open problems grouped by Priority</td>
</tr>
<tr>
<td>Open problems older than 30 days - Grouped</td>
<td>Horizontal Bar</td>
<td>Open problems where the value in the Created field is more than 30 days ago, grouped by Priority</td>
</tr>
<tr>
<td>Problems by Priority and State</td>
<td>Heatmap</td>
<td>Open Problems grouped on a matrix of Priority and State</td>
</tr>
<tr>
<td>Open problems older than 30 days by Priority and State</td>
<td>Heatmap</td>
<td>Open problems where the value in the Created field is more than 30 days ago, grouped on a matrix of Priority and State</td>
</tr>
<tr>
<td>Problems Opened per Week</td>
<td>Line</td>
<td>Count of all problems opened this year, trending by Opened per Week</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Problems Closed per Week</td>
<td>Line</td>
<td>Count of all problems closed this year, trending by Closed per Week</td>
</tr>
</tbody>
</table>

**Problem Management dashboard**

Use this dashboard to gain a high-level view across the problem management process, from opening to closing.

**Problem Overview tab**

![Graph showing open problems by priority and basic indicators]

<table>
<thead>
<tr>
<th>Basic indicators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Number of open problems</td>
</tr>
<tr>
<td>Number of new problems</td>
</tr>
<tr>
<td>Number of closed problems</td>
</tr>
<tr>
<td>Problem backlog events</td>
</tr>
</tbody>
</table>

![Graph showing new problems by priority and priority by new]

---

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Problem Open tab

### Problem Overview

<table>
<thead>
<tr>
<th>Date</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 Jan</td>
<td>10</td>
</tr>
<tr>
<td>23 Jan</td>
<td>15</td>
</tr>
<tr>
<td>26 Jan</td>
<td>20</td>
</tr>
<tr>
<td>29 Jan</td>
<td>25</td>
</tr>
<tr>
<td>1 Feb</td>
<td>30</td>
</tr>
<tr>
<td>4 Feb</td>
<td>35</td>
</tr>
<tr>
<td>7 Feb</td>
<td>40</td>
</tr>
<tr>
<td>10 Feb</td>
<td>45</td>
</tr>
<tr>
<td>13 Feb</td>
<td>50</td>
</tr>
<tr>
<td>16 Feb</td>
<td>55</td>
</tr>
<tr>
<td>19 Feb</td>
<td>60</td>
</tr>
<tr>
<td>22 Feb</td>
<td>65</td>
</tr>
<tr>
<td>25 Feb</td>
<td>70</td>
</tr>
<tr>
<td>28 Feb</td>
<td>75</td>
</tr>
<tr>
<td>3 Mar</td>
<td>80</td>
</tr>
<tr>
<td>6 Mar</td>
<td>85</td>
</tr>
<tr>
<td>9 Mar</td>
<td>90</td>
</tr>
<tr>
<td>12 Mar</td>
<td>95</td>
</tr>
<tr>
<td>15 Mar</td>
<td>100</td>
</tr>
<tr>
<td>18 Mar</td>
<td>105</td>
</tr>
<tr>
<td>21 Mar</td>
<td>110</td>
</tr>
<tr>
<td>24 Mar</td>
<td>115</td>
</tr>
<tr>
<td>27 Mar</td>
<td>120</td>
</tr>
</tbody>
</table>

### Average age of open problems

<table>
<thead>
<tr>
<th>Date</th>
<th>Days</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 Jan</td>
<td>1</td>
</tr>
<tr>
<td>23 Jan</td>
<td>2</td>
</tr>
<tr>
<td>26 Jan</td>
<td>3</td>
</tr>
<tr>
<td>29 Jan</td>
<td>4</td>
</tr>
<tr>
<td>1 Feb</td>
<td>5</td>
</tr>
<tr>
<td>4 Feb</td>
<td>6</td>
</tr>
<tr>
<td>7 Feb</td>
<td>7</td>
</tr>
<tr>
<td>10 Feb</td>
<td>8</td>
</tr>
<tr>
<td>13 Feb</td>
<td>9</td>
</tr>
<tr>
<td>16 Feb</td>
<td>10</td>
</tr>
<tr>
<td>19 Feb</td>
<td>11</td>
</tr>
<tr>
<td>22 Feb</td>
<td>12</td>
</tr>
<tr>
<td>25 Feb</td>
<td>13</td>
</tr>
<tr>
<td>28 Feb</td>
<td>14</td>
</tr>
<tr>
<td>3 Mar</td>
<td>15</td>
</tr>
<tr>
<td>6 Mar</td>
<td>16</td>
</tr>
<tr>
<td>9 Mar</td>
<td>17</td>
</tr>
<tr>
<td>12 Mar</td>
<td>18</td>
</tr>
<tr>
<td>15 Mar</td>
<td>19</td>
</tr>
<tr>
<td>18 Mar</td>
<td>20</td>
</tr>
<tr>
<td>21 Mar</td>
<td>21</td>
</tr>
<tr>
<td>24 Mar</td>
<td>22</td>
</tr>
</tbody>
</table>

### Open problems by Priority

<table>
<thead>
<tr>
<th>Priority</th>
<th>Name</th>
<th>Mar 22</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Critical</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2 - High</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3 - Moderate</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4 - Low</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5 - Planning</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>

### Average age of open problems by Priority

<table>
<thead>
<tr>
<th>Name</th>
<th>Trend</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 - Planning</td>
<td><img src="example.png" alt="Trend" /></td>
<td><img src="example.png" alt="Distribution" /></td>
</tr>
<tr>
<td>1 - Critical</td>
<td><img src="example.png" alt="Trend" /></td>
<td><img src="example.png" alt="Distribution" /></td>
</tr>
<tr>
<td>2 - High</td>
<td><img src="example.png" alt="Trend" /></td>
<td><img src="example.png" alt="Distribution" /></td>
</tr>
<tr>
<td>3 - Moderate</td>
<td><img src="example.png" alt="Trend" /></td>
<td><img src="example.png" alt="Distribution" /></td>
</tr>
<tr>
<td>4 - Low</td>
<td><img src="example.png" alt="Trend" /></td>
<td><img src="example.png" alt="Distribution" /></td>
</tr>
</tbody>
</table>
Problem Closed tab

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem manager -</td>
<td>pa_viewer needed to view the Basic Indicators list</td>
</tr>
</tbody>
</table>

Indicators

**Number of open problems**

Problems on the Problem [problem] table created on or before today and with no Closed date. This indicator is used in several other indicators on the dashboard.

**Number of new problems**
Problems on the Problem [problem] table created today. This indicator is used in several other indicators on the dashboard.

**Number of closed problems**

Problems on the Problem [problem] table closed today. This indicator is used in several other indicators on the dashboard.

**Problem backlog growth**

The score for this indicator is calculated according to the formula 
\[ [\text{Number of new problems}] - [\text{Number of closed problems}] \].

**Average age of open problems**

The score for this indicator is calculated according to the formula 
\[ \frac{[\text{Summed age of open problems}]}{[\text{Number of open problems}]} / 24 \]

**% of new critical problems**

The score for this indicator is calculated according to the formula 
\[ \left( \frac{[\text{Number of new problems > Priority = 1 - Critical}]}{[\text{Number of new problems}]} \right) * 100 \]

**Average close time of problems**

The score for this indicator is calculated according to the formula 
\[ \frac{[\text{Summed duration of closed problems}]}{[\text{Number of closed problems}]} / 24 \]

The following indicators are not shown directly on the dashboard but are used in calculating formulas:

- Summed age of open problems
- Summed duration of closed problems

**Breakdowns**

- Priority

**Problem Premium dashboard**

This dashboard uses advanced features such as interactive filters and workbench widgets to provide a broad view of problem reports, both current and over time.
## Process by Age Tab

### Problem Process by Age

<table>
<thead>
<tr>
<th>Process by Age</th>
<th>Overview</th>
<th>Data Quality</th>
<th>Process KPIs</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 1 day: 5</td>
<td>1 - 5 days: 4</td>
<td>6 - 30 days: 18</td>
<td>31 - 90 days: 20</td>
</tr>
</tbody>
</table>

#### Mar 23

1 - 5 days

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>▼ 3 (-42.9%)</td>
</tr>
</tbody>
</table>

- **Average age**: [Graph](#)
- **Days**: [Graph](#)
- **Average re-assignment times**: [Graph](#)
- **#**: [Graph](#)

#### Breakdowns

1 - 5 days, Mar 23: 4 ▼ 3 (-42.9%)
Note: The Overview tab has the same contents as the Problem Overview dashboard.
### Open Problems Older Than 30 Days by Assignment Group and State

<table>
<thead>
<tr>
<th>Assignment Group</th>
<th>New</th>
<th>Assess</th>
<th>Root Cause Analysis</th>
<th>Fix in Progress</th>
<th>Resolved</th>
<th>Closed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Systems...</td>
<td>14</td>
<td>5</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>HR Systems Support</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Marketing Systems...</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oracle Support</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Solving</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales Systems Sup...</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP Support</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ServiceNow System...</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Service...</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Open Problems Not Updated In Last 30 Days by Assignment Group and State

<table>
<thead>
<tr>
<th>Assignment Group</th>
<th>New</th>
<th>Assess</th>
<th>Root Cause Analysis</th>
<th>Fix in Progress</th>
<th>Resolved</th>
<th>Closed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Financial Systems...</td>
<td>14</td>
<td>5</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>HR Systems Support</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Marketing Systems...</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oracle Support</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem Solving</td>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales Systems Sup...</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP Support</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ServiceNow System...</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Technical Service...</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Process KPIs tab

<table>
<thead>
<tr>
<th>% of new critical problems</th>
<th>Average age of open problems</th>
<th>Average close time of problems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mar 22</td>
<td>Mar 20</td>
<td>Mar 23</td>
</tr>
<tr>
<td>17%</td>
<td><strong>182 days</strong></td>
<td><strong>1 days</strong></td>
</tr>
</tbody>
</table>

% of problems reassigned at least once
% of problems closed on first assignment
Average reassignment count of closed problems

65%
0

No data available

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>All roles concerned with Problem</td>
<td>itil to see the list of Problem</td>
</tr>
<tr>
<td>Management</td>
<td>records</td>
</tr>
</tbody>
</table>

Indicators

**Number of open problems**
Problems on the Problem [problem] table created on or before today and with no Closed date. This indicator is used in several other indicators on the dashboard.

**Number of closed problems**
Problems on the Problem [problem] table closed today. This indicator is used in several other indicators on the dashboard.

**Average age of open problems**
The score for this indicator is calculated according to the formula
\[
\frac{\text{Summed age of open problems}}{\text{Number of open problems}} \div 24
\]
Average re-assignment of open problems
The average number of times an open problem gets reassigned. The score for this indicator is calculated according to the formula
[[Summed re-assignment of open problems]] / [[Number of open problems]].

Average age of updated since of open problems
The average time in days since the last update of an open problem. The score for this indicator is calculated according to the formula
[[Summed age of updated since of open problems]] / [[Number of open problems]] / 24.

% of new critical problems
The score for this indicator is calculated according to the formula
( ( [[Number of new problems > Priority = 1 - Critical]] / [[Number of new problems]] ) * 100

Average close time of problems
The score for this indicator is calculated according to the formula
[[Summed duration of closed problems]] / [[Number of closed problems]] / 24

% of problems reassigned at least once
The score for this indicator is calculated according to the formula
( ( [[Number of reassigned open problems]] / [[Number of open problems]] * 100 ).

% of problems closed on first assignment
The score for this indicator is calculated according to the formula
( ( [[Number of problems closed on first assignment]] / [[Number of closed problems]] ) * 100 ).

Average reassignment count of closed problems
The average value of the Reassignment Count field on closed problems, where Reassignment Count is not empty.

% of open problems classified as known error
The score for this indicator is calculated according to the formula
( ( [[Number of open problems classified as known error]] / [[Number of open problems]] ) * 100.

% of closed problems without any close notes
The score for this indicator is calculated according to the formula
( ( [[Number of closed problems without close notes]] / [[Number of closed problems]] ) * 100.
% of open problems with at least one incident

The score for this indicator is calculated according to the formula
\[
\left( \frac{\text{Number of open problems with at least one incident}}{\text{Number of open problems}} \right) \times 100.
\]

The following indicators are not shown directly on the dashboard but are used in calculating formulas:

- Summed age of open problems
- Summed age of updated since of open problems
- Summed duration of closed problems
- Summed re-assignment of open problems
- Number of reassigned open problems
- Number of problems closed on first assignment
- Number of open problems classified as known error
- Number of closed problems without close notes
- Number of open problems with at least one incident

Breakdowns

- Age
- Priority
- State
- Assignment Group

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical open problems</td>
<td>Single Score</td>
<td>All open problems where Priority is 1 - Critical. This report tells you at a glance how many top priority problems there are.</td>
</tr>
<tr>
<td>Unassigned problems</td>
<td>Single Score</td>
<td>All open problems where 'Assigned to' is empty. These are the problems you have to assign.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Overdue problems</td>
<td>Single Score</td>
<td>All open problems where Escalation = Overdue</td>
</tr>
<tr>
<td>Open problems</td>
<td>Single Score</td>
<td>All open problems</td>
</tr>
<tr>
<td>Problems not updated for 7 days</td>
<td>Single Score</td>
<td>Open problems where the value in the Updated field is more than 7 days ago</td>
</tr>
<tr>
<td>Open problems older than 30 days</td>
<td>Single Score</td>
<td>Open problems where the value in the Created field is more than 30 days ago</td>
</tr>
<tr>
<td>Open problems - Grouped</td>
<td>Horizontal Bar</td>
<td>Open problems grouped by Priority</td>
</tr>
<tr>
<td>Open problems older than 30 days - Grouped</td>
<td>Horizontal Bar</td>
<td>Open problems where the value in the Created field is more than 30 days ago, grouped by Priority</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Problems by Priority and State</td>
<td>Heatmap</td>
<td>Open Problems grouped on a matrix of Priority and State</td>
</tr>
<tr>
<td>Open problems older than 30 days by Priority and State</td>
<td>Heatmap</td>
<td>Open problems where the value in the Created field is more than 30 days ago, grouped on a matrix of Priority and State</td>
</tr>
<tr>
<td>Open problems not updated in last 30 days by assignment group</td>
<td>Heatmap</td>
<td>Open problems where the value in the Updated field is more than 30 days ago, grouped on a matrix of State and Assignment Group</td>
</tr>
<tr>
<td>Problems Opened per Week</td>
<td>Line</td>
<td>Count of all problems opened this year, trending by Opened per Week</td>
</tr>
<tr>
<td>Problems Closed per Week</td>
<td>Line</td>
<td>Count of all problems closed this year, trending by Closed per Week</td>
</tr>
<tr>
<td>Open Problems Where Assignee Is Not Active</td>
<td>Heatmap</td>
<td>Open problems where the value of Assigned to Active is false, grouped on a matrix of State and Assignment Group</td>
</tr>
<tr>
<td>Problems Pending a Change Request that is Already Closed</td>
<td>Heatmap</td>
<td>Open problems where the Change request has a State value of 3, meaning the request is closed, grouped on a matrix of State and Assignment Group</td>
</tr>
</tbody>
</table>
Problem daily 7d - 28d dashboard

Track the progress made by different assignment groups in resolving problems in the daily, weekly, and monthly time frames.

Problem daily tab

- Open problems
- Closed problems
- Average age of open problems
Problem 7d tab (same widgets on Problem 28d)

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem manager - Track the progress of their groups in managing problems across daily, weekly, and monthly time frames</td>
<td>None</td>
</tr>
<tr>
<td>Problem agent - Track the progress of incidents they own across daily, weekly, and monthly timeframes</td>
<td>None</td>
</tr>
</tbody>
</table>
**Indicators**

In the 7 day and 28 day tabs, the widgets apply seven day and 28 day time series aggregations to the indicators.

**Number of open problems**

Problems on the Problem [problem] table created on or before today and with no Closed date. This indicator is used in several other indicators on the dashboard.

**Number of closed problems**

Problems on the Problem [problem] table closed today. This indicator is used in several other indicators on the dashboard.

**Average age of open problems**

The score for this indicator is calculated according to the formula 
\[
\text{Average age of open problems} = \frac{\text{Summed age of open problems}}{\text{Number of open problems}} / 24
\]

**Number of open problems not updated in last 30 days**

The number of open problems with the value of the Updated field more than 30 days ago.

**Number of open problems not updated in last 90 days**

The number of open problems with the value of the Updated field more than 90 days ago.

**Average close time of problems**

The score for this indicator is calculated according to the formula 
\[
\text{Average close time of problems} = \frac{\text{Summed duration of closed problems}}{\text{Number of closed problems}} / 24
\]

The following indicators are not shown directly on the dashboard but are used in calculating formulas:

- Summed age of open problems
- Summed duration of closed problems

**Breakdowns**

You can apply breakdown elements on this dashboard to all widgets simultaneously. Only Assignment Group elements are available. Select one or more assignment groups from the **Select elements** list.
Open Problem Age Monitor dashboard

Use this dashboard to track the progress of open problems across different age buckets. You can break down the problems by priority or assignment group.
### End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem manager - Track how their groups are managing long-standing problems</td>
<td>itil to read records, otherwise none</td>
</tr>
<tr>
<td>Problem agent - Track long-standing problems that they own</td>
<td>itil to read records, otherwise none</td>
</tr>
</tbody>
</table>

### Indicators

**Number of open problems**

Problems on the Problem [problem] table created on or before today and with no Closed date. This indicator is used in several other indicators on the dashboard.
Average age of open problems
The score for this indicator is calculated according to the formula
\[
\frac{\text{Summed age of open problems}}{\text{Number of open problems}} / 24
\]

Average re-assignment of open problems
The average number of times an open problem gets reassigned.
The score for this indicator is calculated according to the formula
\[
\frac{\text{Summed re-assignment of open problems}}{\text{Number of open problems}}.
\]

Average age of updated since of open problems
The average time in days since the last update of an open problem.
The score for this indicator is calculated according to the formula
\[
\frac{\text{Summed age of updated since of open problems}}{\text{Number of open problems}} / 24.
\]

The following indicators are not shown directly on the dashboard but are used in calculating formulas:
- Summed age of open problems
- Summed re-assignment of open problems
- Summed age of updated since of open problems

Breakdowns
- Priority
- State
- Assignment Group

Release Management
The ServiceNow® Release Management v2 application encompasses the planning, design, build, configuration, and testing of hardware and software releases to create a defined set of release components.

The Release Management v2 application handles releases using the task record system. Each planned feature is generated through various means as a task record, populated with the pertinent information in individual fields. These tasks can be assigned to appropriate release management team members, who deal with the tasks as appropriate until the release has been properly deployed.

Release Management can be effectively used to coordinate releases as a vehicle for planning releases, composed of individual work items such as, projects, epics, stories, and problems. After the release scope (projects, stories,
and so on) is finalized, you can generate Change Items and associate them to the release, allowing the implementation and deployment of a release to be handled within the change management process.

**Activate Release Management**

Activate the Release Management plugin (com.snc.release_management_v2) with the admin role.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see **Request a plugin**.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Components installed with Release Management**

Several types of components are installed with activation of the Release Management v2 plugin, including tables and user roles.

Demo data is available for this feature.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>[]</td>
<td>Can access the entire application</td>
<td>• release_v2_user</td>
</tr>
<tr>
<td>[release_v2_admin]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Release admin</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[release_v2_user]</td>
<td>Can access all the various feature and task-related modules but cannot update any content.</td>
<td>• None</td>
</tr>
<tr>
<td>Release user [release_v2_user]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Tables installed
The Release Management v2 application contains with a flexible product, release, phase, release work items, and task hierarchical table layout to allow for releases of varying complexity.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product [rm_product]</td>
<td>Represent whole products whose releases are being managed. It is optional to use the Product construct. A generic release can also be defined without any specific product.</td>
</tr>
<tr>
<td>Release [rm_release]</td>
<td>Represent individual releases of the product.</td>
</tr>
<tr>
<td>Release Phase [rm_release_phase]</td>
<td>Represent the different stages of work required to complete a release.</td>
</tr>
<tr>
<td>Release Tasks [rm_task]</td>
<td>Represent tasks under a phase for phase activities.</td>
</tr>
<tr>
<td>Release Items [rm_m2m_release_task]</td>
<td>Represents work items and change records associated to the release.</td>
</tr>
</tbody>
</table>

Business stakeholder role for Release Management
Use the business stakeholder role to read and retrieve data from any table of the Release Management application to generate reports.
When you activate the Business Stakeholder plugin (com.snc.business_stakeholder) in your ServiceNow instance, the Read only roles for Release Management plugin (com.snc.release_management_read_roles) is also activated. This plugin provides a business stakeholder role (sn_release_read) with which you can access all the tables of the Release Management application. You can assign this role to any user in your organization who is a business stakeholder.

**Plugin availability**

If you are a new customer, the Read only roles for Release Management plugin (com.snc.release_management_read_roles) is activated on zBoot. However, the business stakeholder role (sn_release_read) is available only when you activate the Release Management plugin (com.snc.release_management_read_roles).

If you are an upgrade customer, you must manually activate the read-only roles for Release Management plugin and the Release Management plugin (com.snc.release_management_v2).

**Release Management tables accessible by users with the business stakeholder role**

When the Read only roles for Release Management plugin (com.snc.release_management_v2) is active in your ServiceNow instance, the user with the business stakeholder role (sn_release_read) has read access to the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product [rm_product]</td>
<td>Represent whole products whose releases are being managed. It is optional to use the Product construct. A generic release can also be defined without any specific product.</td>
</tr>
<tr>
<td>Release [rm_release]</td>
<td>Represent individual releases of the product.</td>
</tr>
<tr>
<td>Release Phase [rm_release_phase]</td>
<td>Represent the different stages of work required to complete a release.</td>
</tr>
<tr>
<td>Release Tasks [rm_task]</td>
<td>Represent tasks under a phase for phase activities.</td>
</tr>
</tbody>
</table>
### Domain separation in Release Management

This is an overview of domain separation and Release Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

#### Support level: Basic

- **Business logic**: Ensure that data goes into the proper domain for the application’s service provider use cases.
- **The application supports domain separation at run time**: The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- **The owner of the instance must set up the application to function across multiple tenants**.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

---

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release Items</td>
<td>Represents work items and change records associated to the release.</td>
</tr>
<tr>
<td>[rm_m2m_release_task]</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td>Represent whole products whose releases are being managed.</td>
</tr>
<tr>
<td>[rm_product]</td>
<td>It is optional to use the Product construct. A generic release can also be defined without any specific product.</td>
</tr>
<tr>
<td>Release</td>
<td>Represent individual releases of the product.</td>
</tr>
<tr>
<td>[rm_release]</td>
<td></td>
</tr>
<tr>
<td>Release Phase</td>
<td>Represent the different stages of work required to complete a release.</td>
</tr>
<tr>
<td>[rm_release_phase]</td>
<td></td>
</tr>
</tbody>
</table>
Release Management concepts

The Release Management application encompasses the planning, design, build, configuration, and testing of hardware and software releases to create a defined set of release components.

Release management comprises of a series of activities performed to ensure that the changes are applied successfully to both pre-production and product environments.

<table>
<thead>
<tr>
<th>Concept</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products</td>
<td>Represents the hardware or software for which releases are built. A product can be linked with a Business Service in the CMDB to link it with other ITIL processes.</td>
</tr>
<tr>
<td>Releases</td>
<td>Bundles all the work done (projects, epics, stories, enhancements, defects, problems, incidents, and so on) for products or services</td>
</tr>
<tr>
<td>Concept</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Release Phases</td>
<td>Represents the planned phases within a release, which are used to group the tasks required to carry out the release. For example, gathering requirements, planning, design, development, testing, and deployment.</td>
</tr>
<tr>
<td>Release Tasks</td>
<td>Represents any of the tasks required to implement a feature of a product.</td>
</tr>
</tbody>
</table>

### Table relationships in Release Management

![Diagram of table relationships in Release Management]

**Note**: The tables for Feature and Feature Task under a release are not removed. If you already use Feature and Feature Task under a release, you can continue doing so.

### Using Release Management v2

The Release Management v2 plugin (com.snc.release_management_v2) provides release tables which store information about the planned release and tasks that are required to execute the release.
Product

Use a Product record in Release Management to store information about a product for reference purposes and groups all the releases and work artifacts for the product.

You can use the Configuration Items reference field to link the product with a corresponding CI in the CMDB. Each CI keeps information about how it relates to other CIs, and can track any incidents, problems, or changes related to it. Specifying a CI for the Product connects information from the release process to other processes in the instance.

Defining a product is not mandatory to manage the release process. A release can be an enterprise release in which it is associated with all products or services, or it can be associated to more than one product as well. In either of these cases, defining a product is not mandatory.

Once releases are defined for a product, the Product Hierarchy related link displays the hierarchy of releases, release phases, and release tasks associated with the product.

Release

Once a product is defined, you can plan and execute a release. Start by defining a release for the product and add child releases or release phases for the release. Then, scope the release by defining work artifacts for the release.

Release Phase

Define multiple release phases for a release for release governance and smooth execution.

For example, if the release is managed more like a waterfall process, the release phases could be requirement gathering, design, development, testing, build, acceptance, and deployment. For each phase, there can be release tasks associated to it. The phase gets completed as and when all tasks are completed for a phase. Release managers must keep the release phases updated.

If the release is divided into multiple merges, the phases could be merge 1, merge 2, merge 3, and so on. The type and number of phases would depend upon the release management process of your organization.

Scoping a release

Before starting the release execution, you must define scope of the release. Scope of a release includes the work artifacts such as projects, epics, stories, enhancements, and defects that are a part of the release.
For example, a minor release might only have a few problems and enhancements whereas a major release might have multiple projects or epics associated to it.

**Important:** From the New York release, scoping a release using the SDLC or Scrum (Agile Development 1.0(com.snc.sdlc.scrum.pp)) is not available.

While scoping the release, you can use the **Release Hierarchy** related list on the Release Form to view the release as a hierarchy.

**Product hierarchy in Release Management**

A release can be an enterprise release, in which it is associated to all products or services or to more than one product. In either case, defining a product is not required.

If a product has releases defined, the **Product Hierarchy** related link displays the hierarchy of releases, phases, and phase tasks associated with the product.
Define a product in Release Management

Define a product in the Release Management application to facilitate managing a release process.

Before you begin
Role required: release_v2_admin

Procedure
1. Navigate to Release > Products.
2. click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto-generated unique identifier for the Product.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>CI that corresponds to the product.</td>
</tr>
<tr>
<td>Assignment Group</td>
<td>Group responsible for the product.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>user responsible for the product.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Brief description of the product.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the product.</td>
</tr>
<tr>
<td>Work Notes</td>
<td>A journal field for logging notes about the product.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Define a release in Release Management

During the release planning process, release managers define the type of the release (major, minor, and so on.), schedule of the release (planned start and end dates), required phase, phase tasks, and the scope.

Before you begin
Role required: release_v2_admin

Procedure
1. Navigate to Release > Products.
2. Open the product to which you want to add a release.
If a release belongs to no product or more than one product, you can directly navigate to Release > Releases to define the release. You need not define a release in the context of a product.

3. In the Releases related list, click New.

4. Fill in the fields, as appropriate:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Auto-generated unique identifier for the release.</td>
</tr>
<tr>
<td>Release Type</td>
<td>Type of the release such as Major, Minor, Upgrade, Patch, or others.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of the release such as Critical, High, Moderate, or others.</td>
</tr>
<tr>
<td>State</td>
<td>State of the release such as Draft, Work in progress, testing, or others.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Progress of the release as a percentage of the whole.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the release. This description helps in identifying this release from a list of releases.</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the release.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>Tentative start date of the release.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Tentative end date of the release.</td>
</tr>
<tr>
<td>Planned duration</td>
<td>Duration of the release in days. When you submit the form, this field auto-populates based on the values of Planned start date and Planned end date.</td>
</tr>
</tbody>
</table>

5. Click Submit.
What to do next

- Attach documents such as release and deployment plans, installation manuals, and training documentation to a release.
  For more information, see Add and manage attachments.
- Releases can have child releases. So, you can group minor releases under major releases.
  Add a child release by clicking **New** in the Releases related list in the Release form.
- Define a release phase in Release Management.
- Define scope of a release in Release Management.

Define a release phase in Release Management

Define a release to represent the different stages of work required to complete your release.

**Before you begin**
Role required: release_v2_admin

**Procedure**

1. Navigate to **Release > Releases**.
2. Click the release number to which you want to add a release phase.
3. In the **Release Phases** related list, click **New**.
4. Fill in the fields, as appropriate:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>Priority of the phase such as Critical, High, Moderate, or others.</td>
</tr>
<tr>
<td>State</td>
<td>State of the phase such as Draft, Work in progress, testing, or others.</td>
</tr>
<tr>
<td>Percent complete</td>
<td>Progress of the phase as a percentage of the whole.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the phase. This description helps in identifying this phase from a list of release phases.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Details of the phase.</td>
</tr>
<tr>
<td>Planned start date</td>
<td>Tentative start date of the phase.</td>
</tr>
<tr>
<td>Planned end date</td>
<td>Tentative end date of the phase.</td>
</tr>
<tr>
<td>Planned duration</td>
<td>Duration of the phase in days. When you submit the form, this field auto-populates based on the values of Planned start date and Planned end date.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Define scope of a release in Release Management**

Add projects, epics, stories, enhancements, and defects to define the scope of a release.

**Before you begin**

Role required: release_v2_admin

**Procedure**

1. Navigate to **Release > Releases**.
2. Click the release number for which you want to define the scope.
3. On the Release form, navigate to one of the following related lists:
   - Projects
   - Scrum Epics
   - Scrum Stories
   - SAFe Epics
   - SAFe Features
   - SAFe Stories
   - Defects
   - Enhancements
   - Incidents
   - Problems
   - Changes
Note: To view the respective work items, ensure that the plugins Agile Development 2.0, Project Portfolio Management, Essential SAFe, and Portfolio SAFe are active.

4. Add a task to the related list.
   a. Click Attach task.
   b. Find and locate the required task by clicking the search icon (🔍).
   c. Add the task as a release task by clicking the task number.

5. Click Submit.

Software control distribution

The application enables the Release Management team to control the distribution of software by creating a Definitive Media Library (DML) stored in the CMDB.

The DML consists of a physical store and a logical store.

- The physical store holds master copies of all software media. This tends to be software that has been provided from an external source.
- The logical store is the index of all software and releases, versions, and so on, highlighting where the physical media can be located. The logical store may also be used to store software that is developed within the organization.

Both physically and logically stored software are represented as records on the DML table.

Request Management

Request Management allows catalog items to be requested and fulfilled based on defined flows.

Request Management architecture

Request Management allows catalog items to be requested and fulfilled based on defined flows.

Request Management hierarchy

Service Catalog is the starting point of the request management process. The request management process is triggered only when a catalog item from the Catalog Item [sc_cat_item] table is requested.
When a user submits a request for a catalog item, records are generated in the following hierarchy.

Note: Variables are associated only with the Requested Item [sc_req_item] table. Variables are not supported for extended tables.

Request Management hierarchy

When you configure Request Management:

- The data model does not support a record producer generating request management objects such as request, request item, and catalog task. Hence, do not use a record producer to insert records in the following request management tables or their extensions:
  - Request [sc_request]
  - Request Item [sc_req_item]
  - Catalog Task [sc_task]

- Do not write business rules with the before trigger for the following tables:
  - Request [sc_request]
  - Request Item [sc_req_item]
  - Cart [sc_cart]
  - Cart Item [sc_cart_item]

Request management process

Catalog item is ordered directly without adding it to the cart

When a catalog item is ordered or requested directly without adding it to the cart, the following steps are performed:
1. A temporary cart, `sc_cart`, is created.

2. The catalog item along with the variables (values entered by the user) is added to the temporary cart as a record in the Cart Item [sc_cart_item] table.

3. The variables are saved in the Options [sc_item_option] and Variable Ownership [sc_item_option_mtom] tables.

4. The temporary cart is checked out by performing these steps.
   a. A record in the Request [sc_request] table is initialized but not committed in the database.
   b. A record in Request Item [sc_req_item] table is initialized but not committed in the database.
   c. The request reference for the Request Item [sc_req_item] table record is updated with the Request [sc_request] table record.
   d. The variables record in the Options [sc_item_option] and Variable Ownership [sc_item_option_mtom] tables are updated based on the Request Item [sc_req_item] table record.
   e. The Request Item [sc_req_item] table record is committed in the database.
   f. The Request [sc_request] table record is committed in the database.

Request is submitted after adding the item to the cart

If a catalog item is added to the cart and the request is submitted using the checkout process, the default cart is checked out.

All steps mentioned in the preceding scenario, Catalog item is ordered directly without adding it to the cart, are applicable. However, if multiple catalog items are added to the cart, step b to step e are repeated for each item.

Request is submitted using an order guide

For a two-step order guide checkout, the temporary cart is used for all items. For a three-step order guide checkout, the default cart is used for the items.

All steps mentioned in the preceding scenario, Catalog item is ordered directly without adding it to the cart, are applicable.

⚠️ Note: The base system workflow attached to the request is demo data.
Domain separation in Request Management

This is an overview of domain separation in Request Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Standard

- Includes Basic level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

Activation information

The Domain Support - Domain Extensions Installer plugin (com.glide.domain.msp_extensions.installer) should be activated to enable domain separation for Request Management. For information on how you can request for this plugin activation, see Request domain separation.

How domain separation works in Request Management

Fulfillers see only requests, requested items, and catalog tasks that have been created within the (tenant) domain for which the fulfiller has the visibility. For information on visibility in domain hierarchies, see Visibility domains and Contains domains.

Domain separated tables

- Request [sc_request]
- Requested Item [sc_req_item]
- Catalog Task [sc_task]
Use cases

- A user belonging to "Initech" domain, submits a request. Only those fulfillers belonging to "Initech" domain or global domain can see this request.
- A fulfiller belonging to a parent domain can see requests, requested items, and catalog tasks of all its child domains as well.
- A fulfiller belonging to a specific domain can create requests only on behalf of the domains that they have access to.
- If a user has access to multiple domains, the domain specified on the current record drives the functionality of that record and reference fields.

Related information

Domain separation for service providers

Agent Workspace for Request Management

Agent Workspace for Request Management integrates the platform functionality specific to tier 1 agents into an easy-to-navigate interface. This multi-tab interface helps the agents to efficiently manage multiple incidents, catalog requests, and catalog tasks. The ITSM Workspace plugin (com.snc.agent_workspace.itsm) that automatically activates the Service Catalog - Workspace (com.glideapp.servicecatalogworkspace) plugin should be activated for the Request Management flows in workspace.

Request Management categories in workspace

- **Request**: Displays the active requests and requested items.
- **Catalog Task**: Displays the active tasks assigned to the current user, and to at least one of the assignment groups of the user.

Request Management forms in workspace

The form layouts, UI actions, UI policies, and client scripts that are available on the following Request Management forms in Platform are also available on the corresponding Workspace forms.

- Request
- Request Item
- Catalog Task
Create a catalog request in Agent Workspace

You can create a catalog request in Agent Workspace to join the Service Catalog flow from a different flow. For example, from an incident flow, you can create a request, and associate the request with the incident. It helps you in tracking the requests associated with an incident and vice versa.

Before you begin
Role required: itil
You can create a catalog request in Agent Workspace to join the Service Catalog flow from a different flow. For example, from an incident flow, you can create a request, and associate the request with the incident. It helps you in tracking the requests associated with an incident and vice versa.

- To associate a request with any parent table record, the corresponding mapping configuration should be available in the Catalog Administration > Request Parent Mapping submodule.
- To associate a record producer request with the parent table record, retrieve the `sysparm_parent_sys_id` and `sysparm_parent_table` parameters from the URL using the RP.getParameterValue() method in the Script field of the record producer.
- For the Create Request UI actions in workspace on the Interaction [interaction] table, the field values should be as follows:
  - **Workspace Client Script:**
    ```javascript
    function onClick() {
      var result = g_form.submit('sysverb_ws_save');
      if (!result) { // failed form submission return; } result.then(function()
        { var params = {}; params.sysparm_parent_table = "interaction";
          params.sysparm_parent_sys_id = g_form.getUniqueValue();
          g_service_catalog.openCatalogItem('sc_cat_item', '-1', params); }); }
    ```
- For the Create Request UI actions in workspace on the Incident [incident] table, the field values should be as follows:
Condition: current.incident_state != global.IncidentState.CLOSED && 
gs.hasRole("itil")

Workspace Client Script:

```javascript
function onClick() { g_form.submit('sysverb_ws_update').then(function() 
  { var params ={}; params.sysparm_parent_table = "incident";
    params.sysparm_parent_sys_id = g_form.getUniqueValue();
    g_service_catalog.openCatalogItem('sc_cat_item', '-1', params); }); }
```

Procedure

1. Initiate a catalog request using any of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>From an incident using the Create Request UI action</td>
<td>a. From the List panel, select an open incident.&lt;br&gt;b. In the Details tab, from the More UI Actions menu, select Create Request. The Service Catalog categories page is displayed with available categories.&lt;br&gt;c. Navigate to a catalog item, order guide, or record producer that you want to order.&lt;br&gt;Note: You can only order items from the catalogs that are accessible.</td>
</tr>
<tr>
<td>From an incident using Agent Assist</td>
<td>a. From the List panel, select an open incident.&lt;br&gt;b. In the Details tab, click the Toggle Sidebar.&lt;br&gt;c. From Agent Assist in the contextual sidebar, search for the catalog item, order guide, or record producer that you want to request.&lt;br&gt;d. Click Order.</td>
</tr>
<tr>
<td>Option</td>
<td>Steps</td>
</tr>
<tr>
<td>--------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| From an interaction record | a. Select **Add New > Interaction**.  
b. From the **More UI Actions** menu, select **Create Request**. The Service Catalog categories page is displayed with available categories.  
c. Navigate to a catalog item or order guide that you want to order.  
  
  **Note:** You can only order items from the catalogs that are accessible. |

2. Click **Order Now**.  
The Order Confirmation window is displayed.  
  
  **Note:** The caller of the incident is set as the **Request For** user by default.  
3. **Optional:** Specify the **Delivery Information** and **Special instructions**.  
4. Click **Checkout**.  
The request is created and associated with the parent incident.  
5. Click **Close**.  
6. **Optional:** To view the created request, click **View Details**.  

**Request Management integration with Universal Request**  
Integration of Request Management with the Universal Request application extends the capabilities of Universal Request and enables your employees and agents to create a universal request by submitting a request from a catalog item or record producer. This integration provides a consistent ticketing experience and facilitate inter-department request transfers.  
  
  **Note:** To use this capability, enable the `sn_uni_req.com.snc.ur.request_integration` property under Universal Request properties in the Universal Request application. For more information, see Universal Request properties.  

Configure the catalog item or record producer to create a universal request. The associated requested item (for catalog item) or task-based record (for record producer) becomes the primary ticket for that universal request. For more information on Universal Request, see **Exploring Universal Request**.  

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.  
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Benefits of integrating with Universal Request
The integration enables you to perform the following actions:

• Create a request directly from the Universal Request application using the Create Request option.

• Transfer a request to another department or back to the Universal Request queue by using the Transfer option.

• Configure a catalog item as Universal Request and automatically associate the request as a primary ticked for the universal request. For more information, see Configure a catalog item or record producer to create a universal request.

• View all the associated requests and request items as a related list for a universal request.

• Employees can view the details related to their Universal Request from Employee Center.

System requirements to integrate Request Management with Universal Request
Ensure that you have installed the following plugins to create a universal request from a request item.

• Universal Request plugin (com.snc.universal_request)

• Request Management plugin (com.sn_cs_sm_request)

After the plugins are installed, in the Universal Request application properties, set the sn_uni_req.com.snc.ur.request_integration to true. For more information, see Universal Request properties.

Create a request from Universal Request
As a routing agent, create a request from a universal request and then assign it to the appropriate assignment group. The request manager handles the requested items and takes further actions to fulfill the request.

Before you begin
Ensure that you have the following plugins installed.

• Universal Request plugin (com.snc.universal_request)

• Request Management plugin (com.sn_cs_sm_request)

Role required: routing agent
Procedure

1. Navigate to **Universal Request > All**.
2. Open the universal request record from which you want to create a request.
3. Click **Create Request**.

Results
A request is created and is automatically assigned to the appropriate assignment group. If required, you can also add more details on the Requested item form.

On the Requested item form, the universal request number that was used for creating the request is displayed. The request item number (RITM#) appears in the **Primary ticket** field on the Universal Request form and also under the Associated Requests related list.

Requested item state mapping
Map your requested items states to the universal request (UR) states to provide a better user experience during the requested item state transition and to track the progress of the request.

Before you begin
Role required: admin

About this task
Mapping the states of the requested item to the universal request state ensures that the status of request is also reflected on the state of universal request. As the request moves through different stages of the life cycle, the state of the universal request also gets updated to reflect the change.

For example, consider a universal request has a requested item as a primary ticket. When the state of the request changes from **Open** to **Work in Progress**, the universal request state changes from **New** to **In Progress**.
The following table lists the default state mapping of requested item state with UR states.

### Default state mapping of requested item state with UR states

<table>
<thead>
<tr>
<th>Request item state</th>
<th>UR state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>In Progress</td>
</tr>
<tr>
<td>Work in Progress</td>
<td>In Progress</td>
</tr>
<tr>
<td>Pending</td>
<td>In Progress</td>
</tr>
<tr>
<td>Closed Complete</td>
<td>Closed</td>
</tr>
<tr>
<td>Closed Skipped</td>
<td>Closed</td>
</tr>
<tr>
<td>Closed Incomplete</td>
<td>Closed</td>
</tr>
</tbody>
</table>

If you change the state of the request to Close Incomplete, Closed Skipped, or Closed Complete without transferring the request back to the Universal Request queue or to another department, then one of the following action is performed:

- **If the Needs resolution review option** is selected on the Universal Request, then the state of the request changes to Close Incomplete, Closed Skipped, or Closed Complete and the UR state reason is changed to Confirm response.

- **If the Needs resolution review option** is not selected on the Universal Request, then the request is closed based on the state mapping.

⚠️ **Note:** By default, the Needs resolution review on the Universal Request is set to false.
Procedure
1. Navigate to Universal Request > Administration > State Mapping.
2. Click New.
3. On the form, fill in the fields. For more information, see State mapping form.

Transfer a request to another department
Transfer a request to another department with or without resolution to fulfill the request.

Before you begin

Note: To transfer a request, either you must be part of the assignment group or the request must have been assigned to you.

Role required: routing agent

Procedure
1. Navigate to Service Catalog > Open Records > Items.
2. Select the request item that you want to transfer.
3. Click Transfer.
4. In the Transfer Ticket dialog box, fill in the details.

Transfer ticket dialog

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>Department that you want to transfer the request to.</td>
</tr>
<tr>
<td>Transfer reason</td>
<td>Reason why you are transferring the request to the department.</td>
</tr>
<tr>
<td>Transfer notes</td>
<td>Brief description on the reason for transferring the primary ticket. These notes are read by the UR Routing agent who handles universal requests.</td>
</tr>
<tr>
<td>Copy additional comments and attachments</td>
<td>Option to copy the comments and attachments of the request while transferring. The option is automatically selected.</td>
</tr>
</tbody>
</table>

Note: Work notes are not copied while transfer.

5. Click Transfer.
Results
The request item is transferred to the selected department.

Request ITSM Roles - Request Management
Request the ITSM Roles plugin (com.snc.itsm.roles) to activate the ITSM Roles — Request Management plugin (com.snc.itsm.roles.request_management) to gain more control over the access that different service desk agents, technicians, and managers have within your Request Management process.

Before you begin
Role required: admin

About this task
The ITSM Roles plugin (com.snc.itsm.roles) includes an additional security model. The security model provides more granular roles across ITSM applications as well as within them, allowing you flexibility in setting up access controls. The ITSM Roles plugin is available by default in new instances. Users upgrading from Madrid or earlier versions must request the plugin.

Plugins for ITSM Roles

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Stakeholder [com.snc_business_stakeholder]</td>
<td>business_stakeholder</td>
</tr>
<tr>
<td></td>
<td>⚠️ Note: The business_stakeholder role contains the sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.</td>
</tr>
</tbody>
</table>
| ITSM Roles — Incident Management [com.snc.itsm.roles.incident_management] | • sn_incident_read  
|                                                             | • sn_incident_write                           |
| ITSM Roles — Problem Management [com.snc.itsm.roles.problem_management] | • sn_problem_read  
|                                                             | • sn_problem_write                           |
| ITSM Roles — Change Management [com.snc.itsm.roles.change_management] | • sn_change_read  
|                                                             | • sn_change_write                           |
## Plugins for ITSM Roles (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Adds roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>ITSM Roles — Request Management</td>
<td>• sn_request_read</td>
</tr>
<tr>
<td>[com.snc.service_management.roles.request_management]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• sn_request_write</td>
</tr>
</tbody>
</table>

⚠️ **Note:** As there are future updates expected for the `sn_request_read` role, do not assign it to users without the `business_stakeholder` role.

To purchase a subscription, contact your ServiceNow account manager. The account manager can arrange to have the plugin activated on your organization’s production and subproduction instances, generally within a few days.

If you don't have an account manager, decide to delay activation after purchase, or want to evaluate the product on a subproduction instance without charge, follow these steps.

⚠️ **Note:** Activate the ITSM Roles plugin on a subproduction environment and test the functionality before requesting activation in the production environment. For assistance, contact the ServiceNow Professional Services team.

### Procedure

1. Navigate to **System Applications > All Available Applications > All.**
2. On the All Applications page, click **Request Plugin** to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the <strong>Reason/Comments</strong> field.</td>
<td></td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

**Components installed with ITSM Roles — Request Management**

Several user roles are installed with the activation of the ITSM Roles - Request Management plugin (com.snc.itsm.roles.request_management).

*Note:* The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

**Roles installed**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_request_read</td>
<td>Read access to the Request (sc_request) or Requested Item (sc_req_item) only for a user who is also an approver of the request or requested item.</td>
<td>NA</td>
</tr>
</tbody>
</table>

*Note:* As there are future updates expected for the sn_request_read role, do not assign it to users without the business_stakeholder role.
Activate Business Stakeholder

Activate the Business Stakeholder plugin (com.snc.business_stakeholder) if you have an admin role. This plugin installs the Business Stakeholder role. Users with this role can view and approve records at all ITSM product levels.

Before you begin
Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related reference
   List of plugins (Rome)

Installed with Business Stakeholder
The Business Stakeholder plugin (com.snc.business_stakeholder) installs the Business Stakeholder role when activated.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_request_write</td>
<td>Write access to the Request (sc_request) or Requested Item (sc_req_item).</td>
<td>• task_editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• dependency_views</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• agent_workspace_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• view_changer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• cmdb_read</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• cmdb_query_builder_read</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_request_read</td>
</tr>
</tbody>
</table>
Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Stakeholder [business_stakeholder]</td>
<td>Users with this role can view and approve records within all products of ITSM.</td>
<td></td>
</tr>
<tr>
<td>Note: The business_stakeholder role contains the following ITSM roles sn_incident_read, sn_problem_read, sn_change_read, sn_request_read, and approver_user roles.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Service Desk

The Now Platform includes a default homepage and the ServiceNow® Service Desk application to provide a basic set of service desk functions.

Note:

The Service Desk Call plugin (com.snc.service_desk_call) is deprecated in the Quebec release. Similar outcome can be achieved using Interaction in Agent Workspace. For more details, refer Create an interaction record in ITSM Agent Workspace.

Both can be customized to suit the processes you are involved in and the needs of the organization.
The ITIL Homepage provides commonly used reports that give an overview of the processes you are involved in. Access the ITIL Homepage from the homepage icon on the edge (UI15) or favorites tab (UI16).

By default, the ITIL Homepage includes the following reports.

- **Users by location**: a pie chart displaying users divided by location.
- **Open Items by Escalation**: tasks with an open state, grouped by escalation.
- **My Groups Work**: outstanding work for your group.
- **My Work**: your outstanding work.
- **ITIL Summary Counts**: tasks that are critical, overdue, and over a week old.

These reports link directly to the appropriate records and tables. Use the work queues and the reports on critical tasks to manage your work directly from the homepage.
Service Desk Call

Using Service Desk Call, ITIL users can create a call record and quickly capture basic information from a customer contact. Users can then decide if the call is an incident, a problem, a change, or a service catalog request.

Note:
The Service Desk Call plugin (com.snc.service_desk_call) is deprecated in the Quebec release. Similar outcome can be achieved using Interaction in Agent Workspace. For more details, refer Create an interaction record in ITSM Agent Workspace.

Service desk personnel can more quickly process customer calls by retaining and reusing the information captured during the call. Users with the itil role can read, create, and edit an existing call, but cannot delete existing calls or edit a call after it is transferred.

At the end of the call, the ITIL user can decide the action to take.

• Transfer the call record to an incident, problem, change, or service catalog request.
• Record the call as another type of contact, such as a wrong number.

Related information
Create a call
Call transfer

Request Service Desk Call

The Service Desk Call plugin (com.snc.service_desk_call) is deprecated in the Quebec release.

Before you begin
Role required: none

About this task
Similar outcome can be achieved using Interaction in Agent Workspace. For more details, refer Create an interaction record in ITSM Agent Workspace.

Procedure
1. Navigate to System Applications > All Available Applications > All.
2. On the All Applications page, click Request Plugin to open the Request form on HI.
3. On Now Support, select the redirect link to access the Now Support Service Portal Service Catalog.

4. Select your instance.

5. Select Actions > Activate Plugin.

6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>The date and time must be at least two business days from the current time.</td>
</tr>
</tbody>
</table>
Note: Plugins are activated in two batches, once in the morning and once in the evening, on every business day in the US Pacific time zone. If the plugin must be activated at a specific time, enter the request in the Reason/Comments field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify that in the comments.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

**Related information**

**List of plugins (Orlando)**

**Installed with Service Desk Call**

Several types of components are installed with Service Desk Call.

**Tables installed with Service Desk Call**

Service Desk Call plugin adds the following table.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call</td>
<td>The base table for service desk call that contains all call information.</td>
</tr>
<tr>
<td>[new_call]</td>
<td></td>
</tr>
</tbody>
</table>

**Client scripts installed with Service Desk Call**

Service Desk Call plugin adds the following client script.
### Client script

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Script contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Populate company</td>
<td>Call [new_call]</td>
<td>Code to populate the company field on the form with an appropriate value based on the selected caller.</td>
</tr>
</tbody>
</table>

### Related information

**Client scripts**

**Business rules installed with Service Desk Call**

Service Desk Call plugin adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CallTypeChanged</td>
<td>Call [new_call]</td>
<td>Creates an incident, problem, or change record, based on the call type selection.</td>
</tr>
<tr>
<td>CallTypeChanged to Request</td>
<td>Call [new_call]</td>
<td>Redirects to a new service catalog request page based on the call type and request item selection.</td>
</tr>
<tr>
<td>Calculate time spent</td>
<td>Call [new_call]</td>
<td>Calculates the time spent between opening the form and saving it.</td>
</tr>
<tr>
<td>Domain - Set Domain - SD Call</td>
<td>Call [new_call]</td>
<td>Supports domain separation.</td>
</tr>
</tbody>
</table>

### Related information

**Business rules**

**Domain separation and Service Desk Call**

Domain separation is supported in Service Desk Call. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Support level: Basic**
• Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.

• The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

Overview

• Using Service Desk Call, ITIL users can create a call record and quickly capture basic information from a customer contact. Users can then decide if the call is an incident, a problem, a change, or a service catalog request.

• Service Desk personnel can process customer calls more quickly by retaining and reusing the information captured during the call. Users with the ITIL role can read, create, and edit an existing call, but cannot delete existing calls or edit a call after it is transferred.

• At the end of the call, the ITIL user can decide one of two actions to take:
  ◦ Transfer the call record to an incident, problem, change, or service catalog request.
  ◦ Record the call as another type of contact, such as a wrong number.

• Typically, ITIL users create the new_call (Service Desk) records when they receive a call from ESS user. Once they understand the nature of the issue, the new_call record is converted into a corresponding incident, request, problem, change, and so on.

• The [new_call] table supports domain separation. Therefore, an ITIL/Fulfiller sees only those new_call records that have been created within the (tenant) domain that they belong to.

How domain separation works in Service Desk

ITIL/Fulfillers see only those new_call records that have been created within the (tenant) domain that they belong to.

Domain separated tables

• Calls [new_call]
Use cases

• An ITIL/Fulfiller creates new_call records only in those domains to which they have access.

• When a new_call record is converted into a Request / Incident / Problem / Change, and so on, the corresponding record is created in the same domain as that of the associated new_call record.

• An ITIL/Fulfiller can create a new_call record only for those callers who belong to the domains to which they have access.

Related information

Domain separation for service providers

Service Desk Call and domain separated systems

Saving a call record may create two records: a service desk call record and a transferred record. For systems using domain separation, these two records may be stored in different domains.

The service desk call record is saved in the ITIL user’s domain. This domain is determined as follows:

• Use the ITIL user’s domain if the ITIL user has a domain.
• Otherwise, use the default domain.

Any transferred record is saved in the domain of the caller. This domain is determined as follows:

• Use the domain of the caller if applicable.
• Otherwise, use the default domain.

Service Desk Call uses

ITIL users, users with the itil role, can quickly capture basic information within a call record while in contact with the customer.

After the information has been gathered, they can decide how to classify that call record, for example, as an incident.

ITIL users can use service desk call to perform any of the following tasks.

• Create a call record.
• Transfer a call record to an incident, problem, change, or service request.
• View call record information.
Note:
The Service Desk Call plugin (com.snc.service_desk_call) is deprecated in the Quebec release. Similar outcome can be achieved using Interaction in Agent Workspace. For more details, refer Create an interaction record in ITSM Agent Workspace.

Create a call
You can create a call when a user contacts you for assistance with an issue.

Before you begin
Role required: itil

Procedure
1. Navigate to Service Desk > Calls > New Call.
2. Complete the form.

Call form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>An auto-generated identifying number for the call record.</td>
</tr>
<tr>
<td>Caller</td>
<td>The person who contacted the service desk. Entry is mandatory if the call type is Incident, Problem, Change, or Request.</td>
</tr>
<tr>
<td>Company</td>
<td>The company where the call originated.</td>
</tr>
<tr>
<td>Call type</td>
<td>A field that specifies the status of the call.</td>
</tr>
<tr>
<td></td>
<td>• Select a task type, such as Incident, to transfer the call.</td>
</tr>
<tr>
<td></td>
<td>• Select Hang Up, Wrong Number, Status Call, or General Inquiry to save the call record without transferring.</td>
</tr>
<tr>
<td>Opened</td>
<td>The date and time when the call record was opened.</td>
</tr>
<tr>
<td>Opened by</td>
<td>The ITIL user who communicated with the customer.</td>
</tr>
<tr>
<td>Contact type</td>
<td>The type of communication used to contact the service desk.</td>
</tr>
<tr>
<td>Short description</td>
<td>A short description of the issue or question.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the call that might be helpful for others to know. This field is visible to the customer.</td>
</tr>
</tbody>
</table>
3. Click Submit.
   If the call type is Incident, Problem, Change, or Request, the call transfers, creating another record of the appropriate task type. A message provides the task number as a link.

**Tasks by same caller or company**

When you submit a call, two related lists are associated with the call record: Tasks by Same Caller and Tasks by Same Company. Checking these related lists can be useful to check for duplicate calls.

All active incidents, problems, changes, and service catalog requests for that caller or company are listed.

The Tasks by Same Caller list shows all active records where the value in the Caller field on the Call form matches the value in:

- The Caller field on the Incident form.
- The Opened by field on the Problem form.
- The Requested by field on the Change Request form.
- The Requested for field on the service catalog Request form.

The Tasks by Same Company list shows all active records where the value in the Company field on the Call form matches the value in:
• The company of the caller on the Incident form.
• The company of the user that opened the problem on the Problem form.
• The company of the user that requested the change on the Change form.
• The company of the user the request was made for on the service catalog Request form.

Call transfer
Details gathered during the customer contact determine the type of record. Saving the call with a call type of Incident, Problem, Change, or Request saves the call record and also creates a record of the task type selected.

For example, the service desk receives a phone call from a customer reporting email issues with a laptop. When the call is answered, the service desk user opens a call record and enters basic information during the phone call. At the end of the phone call, the service desk user decides it should be logged as an incident, sets the Call type to Incident, and saves the call record. A new incident record with details taken from the original call record is created. The new incident is handled through standard incident management processes.

After a call is transferred, the number of the new record appears in the Transferred to field on the Call form and the Calls list. A link to the new record appears above the Calls list.

Related information
Incident Management

Transfer a call to an incident, problem, or change
When you select a task call type, you transfer the call to an incident, problem, or change request.

Before you begin
Role required: itil

Procedure
1. In the Call form, set Call type to Incident, Problem, or Change.
2. Click Submit to transfer the call.

A record of the appropriate type is created, with the following information copied from the call.
• Short description
• Description
Transfer a call to a service catalog request

You can transfer a call to a service catalog request and enter the relevant details for the requested catalog item as part of a single process.

Before you begin
Role required: itil

Procedure

1. In the Call form, set Call Type to Request.
   A Request item field appears on the form.

2. Select the catalog item to request.
   Content items, record producers, and order guides are not supported.

3. Click Submit.
   The order form for that catalog item appears.

4. Select any other options for that catalog item, as required.

5. Order the item.
   The service catalog request is created with the following information.
   - The Caller is copied to the Requested For field in the request.
   - The Description field in the Call form is copied to Special instructions.
   The requested item is listed in the Task by Same Caller related list in the call.

Related information

Service Catalog request screens

View service desk calls

You can view call records from several Service Desk modules.
• **Service Desk > Calls > My Calls** lists all calls that you created.

• **Service Desk > Calls > My Open Calls** lists all calls you created that have transferred records, such as incidents, that are still open.

• **Service Desk > Calls > All Open Calls** lists all calls created in the last month that have transferred records that are still open.

The **Time Spent** column shows the time between creating and saving the call record.

## Service Portfolio Management

ServiceNow® Service Portfolio Management enables you to improve your IT business operations and meet customer demands by documenting and managing your IT services using a standardized, structured format.

### Explore
- Placeholder
- Upgrade to Paris
- Understanding Service Portfolio Management
- Placeholder

### Set up
- Set up Service Portfolio Management
- Model your taxonomy using Service Portfolio Management sample IT services portfolio content
- Create a service portfolio in Service Portfolio Management
- Create a Service Portfolio Management service
- Create and manage Service Portfolio Management service offerings

### Administer
- Activate Service Portfolio Management
- Activate Service Portfolio Management Sample Content Pack

### Use
- Develop
- Troubleshoot and get help

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Understanding Service Portfolio Management

With the Service Portfolio Management application, your organization can document and manage services using a standardized, structured format.

What is Service Portfolio Management?
Service Portfolio Management is a single, centralized application that aggregates the information portfolio managers and service owners need to:

• Design a pipeline of services that meets the greatest needs of the organization.
• Prevent unnecessary service duplication and overlap.
• Quickly identify and retire low value services so resources can be redeployed.

In the IT industry, service portfolio management is the creation, organization, and management of a portfolio of IT services, for example, communication-related services or infrastructure-related services. The purpose of implementing service portfolio management is to improve your IT business operations and meet customer demands by optimizing the value of services and reducing their costs. The Service Portfolio Management application helps you accomplish these goals. A service portfolio includes information related to the organization of services and data about each service, including status, as well as related items.

The service portfolio typically consists of services in three phases:

• Service pipeline: Status of services that are not yet operational or available for use. These services are typically proposed or services in review for suitability. You can leverage this aspect of the portfolio to analyze and manage the future growth and time line for each service.
Service catalog: Overview of all services that are operational and available for use, as well as design and development. These services typically have representation in a request catalog.

Retired services: Overview of services that are no longer operational or available for use. This overview can include any essential historical information.

With Service Portfolio Management, you can manage the entire portfolio of IT services available to your enterprise. Apply modules and features to justify each service based on business need by ensuring they deliver maximum value within managed risks and costs.

What is Service Owner Workspace?
To enhance your Service Portfolio Management experience, you can subscribe to Service Owner Workspace. Service Owner Workspace provides a premium Service Portfolio Management experience. Portfolio managers and service owners access an integrated and graphically intuitive user interface to manage and monitor portfolios and services in a central location.

Service Owner Workspace tracks and measures the performance of services and service offerings within multiple portfolios across a variety of common key metrics. Service Owner Workspace provides these key features:

- Metrics configuration.
- Service Offering Estimated Spend.
- Integration with other applications, for example, Financial Management and Vendor Manager Workspace.

Add business-related services to your service portfolio taxonomy and create dependencies to this type of service. Technical-related services are not added as part of your service portfolio taxonomy, but you can still gain insight into these services using common information (CI) relationship dependencies.

For details about subscribing to this premium upgrade, refer to Service Owner Workspace.

Who uses Service Portfolio Management?
IT organizations looking to provide greater value to the business and meet customer needs through information technology services. These IT organizations need to fully understand the assortment of services they offer. Service portfolio management is typically a critical objective for mature IT organizations and businesses seeking to provide superior support to customers or users.

A team of people work together to create, manage, and oversee the service portfolio. There are strategic roles, as well as operational roles, among the team.
members. In most organizations, people may participate in more than one role and often share roles with others.

**Portfolio owner**

Strategic role involved in the ownership of a portfolio. This person has overall authority and accountability for an entire IT service portfolio, typically at the CIO level. The portfolio owner's goal is to deliver a portfolio that offers value to the organization. There is only one portfolio owner, per portfolio.

**Portfolio manager**

Operational role involved with overall administrative capabilities over a portfolio. Creates and edits portfolio records of all types.

**Service owner**

Strategic role involved in the ownership of services. Typically this person is at the director-level within IT and has end-to-end accountability for a given service and its offerings through the full life cycle. This person often owns more than one service and may even own a branch of services. Service owners are not heavily involved in the day-to-day operation of the service.

**Service manager**

Operational role involved in the management of a service. Typically this person is at the director-level within IT and is responsible for the day-to-day delivery and operation of a service. Occasionally, the service owner and service manager are the same person.

**Process owner**

Strategic role external to the ownership and management of a portfolio or service. This person is responsible for defining and evolving the services, taxonomy, policies, procedures, governance, roles, and responsibilities over time. The process owner's goal is to progress service portfolio management maturity for the business.

**Process manager**

Operational role external to the ownership and management of a portfolio or service. This person is responsible for ensuring consistency of the portfolios and services within the portfolios across the IT organization. This person also ensures that the policies, procedures, and governance are upheld, as determined by the Process Owner. Occasionally, the process owner and process manager are the same person.
How do you benefit from Service Portfolio Management?

- Transform your focus from IT assets and associated costs into services that you can price and link to business value. Your IT organization can go from a business cost center to a value-added service provider offering transparency into operations and spending.
- Align your IT services to strategic business goals.
- Meet the service demands of your customers and end users.
- Make better decisions regarding new service creation, improvement, delivery, and retirement.
- Improve productivity of IT support staff by better identifying and increasing focus on the services that offer the most business value.
- Increase cost-efficiency by consolidating duplicate services, enhancing under-performing services, and retiring low-value, unnecessary, or unused services.
- Document the various services offered using a standardized, structured format. Link offerings to items in a consumer-friendly service catalog.
- Define service offerings and the system automatically begins to track performance against defined metrics for operational service offerings. If outages occur, the platform handles availability tracking.

Service Portfolio Management administration

Service Portfolio Management includes several plugins to enable the organization, documentation, and management of service portfolios within your IT business department. With Service Owner Workspace, different features and functionalities are available at both the foundation level and at the premium level.

Service Portfolio Management Taxonomy Content Pack

You can also activate the Service Portfolio Management Taxonomy Content Pack plugin [com.snc.spm.content]. This plugin contains demo data and provides sample taxonomy metadata, complete with portfolio, taxonomy layers, and nodes. Users can view services and service offerings, including related items, such as SLAs, incidents, changes, and more as a demonstration.

Portfolio managers benefit from the Service Portfolio Management Taxonomy Content Pack because it provides a useful example of how service portfolios and services are constructed within the application. This example results in faster modeling of an organization’s service portfolio. Also, portfolio managers often
have to quickly provide the organization with an example of a portfolio structure to accelerate decision making on the business approach.

**Service Portfolio Management product applications**

Administrators can activate plugins and assign specific Service Portfolio Management roles to system users.

The following product application plugins are available:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portfolio Management Core (com.snc.service_portfolio_core)</td>
<td>Adds the Service Offering table [service_offering] to the Configuration Management Database (CMDB). Available by default for ITSM SKUs.</td>
</tr>
<tr>
<td>Service Portfolio Management Foundation (com.snc.service_portfolio)</td>
<td>Enables your organization to document portfolios, taxonomies, services, and service offerings using a standard and structured format.</td>
</tr>
<tr>
<td>Service Portfolio Management Premium (com.snc.spm)</td>
<td>Collects service offering metrics. Rolls these calculations up to parent services and to taxonomy nodes. The calculations are used as performance scores and other metrics, which can be viewed via Service Owner Workspace.</td>
</tr>
<tr>
<td>Service Portfolio Management Foundation Demo Data (com.snc.service_portfolio.demo_data)</td>
<td>Adds demo data for Service Portfolio Management and service level agreement commitments. <strong>Note:</strong> If you installed the Service Portfolio Management SLA Commitments plugin (com.snc.service_portfolio.sla_commitment) before the New York release, this plugin activates the newer version.</td>
</tr>
<tr>
<td>Service Owner Workspace (com.spm_owner_workspace)</td>
<td>Enables enhanced features and provides the Service Owner Workspace to the Service Portfolio Management environment.</td>
</tr>
</tbody>
</table>
**Activate Service Portfolio Management**

The Service Portfolio Management Core plugin (com.snc.service_portfolio_core) is available by default for users with ITSM SKUs. You can activate additional available related plugins for enhanced features and functionality.

**Before you begin**

Role required: admin

**About this task**

The Service Portfolio Management Foundation plugin (com.snc.service_portfolio) enables your organization to document portfolios, taxonomies, services, and service offerings using a standardized, structured format. It contains demo data and activates related plugins.

The premium Service Owner Workspace plugin (com.spm_owner_workspace) requires a separate subscription and automatically activates the Service Portfolio Management Premium plugin (com.snc.spm). Subscribe to Service Owner Workspace to enable enhanced features and provide a superior Service Portfolio Management experience. For details, refer to Service Owner Workspace. View the applications and plugins that are included with a subscription to verify if your company has purchased a subscription for this premium plugin.

The Service Portfolio Management Foundation plugin (com.snc.service_portfolio) is activated out of the box and activates related plugins if they are not already active.

**Related plugins for Service Portfolio Management Foundation**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portfolio Management Core [com.snc.service_portfolio_core]</td>
<td>Adds the Service Offering table [service_offering] to the Configuration Management Database (CMDB).</td>
</tr>
</tbody>
</table>
### Related plugins for Service Portfolio Management Foundation (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Catalog core applications [com.glideapp.servicecatalog]</td>
<td>Enables integrations with the Service Catalog application and its capabilities.</td>
</tr>
</tbody>
</table>

Several additional plugins offer increased functionality to Service Portfolio Management Foundation. Activate these plugins to enhance your experience.

### Additional plugins for Service Portfolio Management Foundation functionality

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portfolio Management Taxonomy Content Pack [com.snc.spm.content]</td>
<td>Provides sample taxonomy metadata, complete with portfolio, layers, and nodes. Demo data includes services and service offerings, including related items, such as SLAs, incidents, changes, and more. Includes demo data.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

⚠️ Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related reference
Installed with Service Portfolio Management
Related information
List of plugins (New York)

Installed with Service Portfolio Management

Service Portfolio Management Core is active by default for users with ITSM SKUs. Service Portfolio Management Foundation is administrator activated and enables you to document portfolios, taxonomies, services, and service offerings using a standardized, structured format.

⚠️ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Two plugins are available to obtain feature Service Portfolio Management functionality. The Service Portfolio Management Foundation plugin (com.snc.service_portfolio) automatically activates the Service Portfolio Management Core plugin (com.snc.service_portfolio_core), if not already activated. Each plugin independently installs a set of roles and tables.

Service Portfolio Management Core

Roles installed with Service Portfolio Management Core

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Portfolio Admin [portfolio_admin] | Manages the service portfolio, related commitments, and availability. | • portfolio_editor
                                |                                                                  | • sla_manager                     |
Roles installed with Service Portfolio Management Core (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Updates portfolios, taxonomy layers, taxonomy nodes, services, service offerings, and can reparent services.</td>
<td></td>
</tr>
</tbody>
</table>

| Service Editor [service_editor] | Can view all layers and update owned services. Service Editors cannot reparent a service. | • service_viewer |

| Service Viewer [service_viewer] | Can view all services and offerings. | • cmdb_read  
• sn_svc_workspace.service_workspace_user |

**Note:** The `sn_svc_workspace.service_workspace_user` role is used to view Service Owner Workspace. The Service Portfolio Management Premium plugin (com.snc.spm) and the Service Owner Workspace plugin (com.spm_owner_workspace) are available as separate subscriptions.

Tables installed with Service Portfolio Management Core

<table>
<thead>
<tr>
<th>Table [service_offering]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Extends the [cmdb_ci_service] table.</td>
</tr>
</tbody>
</table>
Service Portfolio Management Foundation

Roles installed with Service Portfolio Management Foundation

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Portfolio Editor [portfolio_editor]    | Updates portfolios, taxonomy layers, taxonomy nodes, services, service offerings, and can reparent services. | • service_editor
                                               |                                                                                   | • portfolio_viewer                    |
| Portfolio Viewer [portfolio_viewer]    | Can view portfolios, taxonomy layers, taxonomy nodes, and services.          | • service_viewer                      |

Tables installed with Service Portfolio Management Foundation

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spm Service Portfolio [spm_service_portfolio]</td>
<td>Used to create or modify a service portfolio.</td>
</tr>
<tr>
<td>Spm Taxonomy Layer Definition [spm_taxonomy_layer_definition]</td>
<td>Used to define the order of a taxonomy layer associated with a service portfolio.</td>
</tr>
<tr>
<td>Spm Taxonomy Node [spm_taxonomy_node]</td>
<td>Used to create or modify a taxonomy node associated with a service portfolio and taxonomy layer.</td>
</tr>
<tr>
<td>Service Subscribe Company [service_subscribe_company]</td>
<td>Used to associate service offering subscriptions to a specific company.</td>
</tr>
<tr>
<td>Service Scope [service_scope]</td>
<td>Used to stores user-defined limits to the service levels of a service.</td>
</tr>
<tr>
<td>Service Subscribe Department [service_subscribe_department]</td>
<td>Used to associate service offering subscriptions to a specific department.</td>
</tr>
<tr>
<td>Service Availability [service_availability]</td>
<td>Used to store the calculated availability records of a service.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
### Tables installed with Service Portfolio Management Foundation (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Subscribe Sys User</td>
<td>Used to create a module enabling you to categorize subscribers by individual user.</td>
</tr>
<tr>
<td>[service_subscribe_sys_user]</td>
<td></td>
</tr>
<tr>
<td>Sc Cat Item Subscribe Mtom</td>
<td>Used to create a catalog item and make it available for subscription.</td>
</tr>
<tr>
<td>sc_cat_item_subscribe_mtom</td>
<td></td>
</tr>
<tr>
<td>Sc Cat Item Subscribe No Mtom</td>
<td>Used to create an item while not making it available for subscription.</td>
</tr>
<tr>
<td>sc_cat_item_subscribe_no_mtom</td>
<td></td>
</tr>
<tr>
<td>Service Subscribe Location</td>
<td>Used to specify where a service offering is located, by actual physical address.</td>
</tr>
<tr>
<td>service_subscribe_location</td>
<td></td>
</tr>
<tr>
<td>Sc Cat Item Service</td>
<td>Used to enter an item in the Service Catalog.</td>
</tr>
<tr>
<td>sc_cat_item_service</td>
<td></td>
</tr>
<tr>
<td>Service Offering Commitment</td>
<td>Used to create and configure service commitments by specifying order and associating service offerings.</td>
</tr>
<tr>
<td>service_offering_commitment</td>
<td></td>
</tr>
<tr>
<td>Service in Scope</td>
<td>Used to create and define services In Scope and specify the scope parameters.</td>
</tr>
<tr>
<td>service_in_scope</td>
<td></td>
</tr>
<tr>
<td>Service Subscribe Sys User Grp</td>
<td>Used to create a module enabling you to categorize subscribers by group.</td>
</tr>
<tr>
<td>service_subscribe_sys_user.grp</td>
<td></td>
</tr>
<tr>
<td>Service Commitment</td>
<td>Used to store records from the Service Commitments related list in the Service Offerings form.</td>
</tr>
<tr>
<td>service_commitment</td>
<td></td>
</tr>
<tr>
<td>Service Out Scope</td>
<td>Used to create and define services Out of Scope and specify the scope parameters.</td>
</tr>
<tr>
<td>service_out_scope</td>
<td></td>
</tr>
</tbody>
</table>

### Service Portfolio Management users and roles

An IT organization employs a team of people to work together to create, manage, and oversee the service portfolio. The team can consist of strategic, more supportive users, as well as operational, and critical day-to-day users.
Roles assignment is contingent on the responsibilities and duties of each team member.

**System security role assignment**

A person with the Admin [admin] role can assign Service Portfolio Management roles to other users. Assign roles to users based on their individual access needs to create, read, update, and delete records.

A person with the Portfolio admin [portfolio_admin] role can assign Service Portfolio Management roles to other users.

Admins or portfolio admins assign roles to system users based on functions, duties, and responsibilities. Users can perform the necessary functions within the service portfolio, taxonomies, services, and service offerings they are responsible for, based on assigned roles.

**Service Portfolio Management users and roles**

Common Service Portfolio Management team members with typical role assignment include the following users:

- **Portfolio owner**
  - Typically assigned the Portfolio Editor [portfolio_editor] role.
  - Strategic role involved in the ownership of a portfolio. This person has overall authority and accountability for an entire IT service portfolio, typically at the CIO level. The goal of the portfolio owner is to deliver a portfolio that offers value to the organization. There is only one portfolio owner.
  - Portfolio owners can read and update the entire portfolio that they own. They do not have access to taxonomies within other portfolios that they do not own.

- **Portfolio manager**
  - Typically assigned the Portfolio Admin [portfolio_admin] role.
  - Operational role involved with overall administrative capabilities over a portfolio.
  - Portfolio managers can create, read, update, and delete portfolio records of all types, including portfolios, taxonomy levels and nodes, services, service offerings, relationships, and performance criteria for the entire business.

- **Service owner**
Typically assigned the Portfolio Viewer [portfolio_viewer] and Service Editor [service_editor] roles.

Strategic role involved in the ownership of services. Usually at the director-level within IT, this person is accountable for a given service and its offerings through the full service life cycle. The service owner typically owns more than one service, and may even own a branch of services. Typically, service owners are not heavily involved in day-to-day operations of the service.

Service owners can read portfolios and existing taxonomy assets, services, and service offerings. However, they can only update services and service offerings that they own or delegate.

Service owners cannot reparent services, or change the service owner. However, they can add subscriber groups, locations, departments, companies, and users.

**Service owner delegate**

Typically assigned the Portfolio Viewer [portfolio_viewer] and Service Editor [service_editor] roles.

Optional role involved in the management of a service. This person is designated as an editor of a set of services, potentially delegating for multiple service owners.

Service owner delegates can read portfolios and existing taxonomy assets, services, and service offerings. However, they can only update services and service offerings that they delegate.

Service owner delegates cannot reparent services, or change the service owner. However, they can add subscriber groups, locations, departments, companies, and users.

For more details regarding roles and assigning roles to users and groups, refer to [Installed with Service Portfolio Management](#) for Service Portfolio Management-specific roles and [User administration](#) for role usage in the platform.

**Activate Service Portfolio Management Sample Content Pack**

Activate the Service Portfolio Management Taxonomy Content Pack plugin (com.snc.spm.content) to access a sample portfolio structure and service taxonomy. This sample data offers a demonstration users can adopt to accelerate the creation and management of a service portfolio.
Before you begin
Role required: admin or portfolio_admin

About this task

Note: The Service Portfolio Management Taxonomy Content Pack data is best viewed in Service Owner Workspace. For details about accessing this workspace through a Service Owner Workspace subscription, refer to Service Owner Workspace.

The Service Portfolio Management Taxonomy Content Pack plugin (com.snc.spm.content), contains demo data and provides sample taxonomy structure metadata. Users can quickly and efficiently implement portfolios and associated taxonomies.

Gain access to a sample list of services that provides examples of service data, offerings, catalog items, and the relationships they share. Link to periphery example data, such as vendors and contracts, SLA definitions, cost models, and more.

After sample data loads, use it as a starting point to create and manage your service portfolios. You can view sample content in the Service Portfolios module of the Service Portfolio Management application as Sample IT Services Portfolio. Alternatively, if subscribed to and activated, users can view this data in Service Owner Workspace.

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.
   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

View Service Portfolio Management sample IT services portfolio content

Access, view, and analyze the Service Portfolio Management sample IT services portfolio content to plan and create your service portfolio. Consider the sample
structure as a starting point. You can add to it or modify it to suit the specific needs of your organization.

**Before you begin**
Role required: portfolio_admin, service_editor, or service_viewer

**About this task**
Sample IT service portfolio content provides both usable data, in the form of portfolios, taxonomy layers, and taxonomy nodes. It also provides demo data in the form of services, service offerings, incidents, commitments, and more. Sample IT service portfolio content is available for view by anyone with a Service Portfolio Management-related assigned role. Only users with the Portfolio Admin [portfolio_admin] or Service Editor [service_editor] role can create and manage the levels and nodes of a service portfolio based on the structure and presented sample content.

You can view the sample content in the Service Portfolios module in the Service Portfolio Management application. Sample content is best viewed in Service Owner Workspace, provided you have subscribed to and activated the Service Owner Workspace plugin (com.spm_owner_workspace).

ℹ️ Note: For details about accessing Service Owner Workspace, refer to Activate Service Owner Workspace.

**Procedure**
1. Navigate to **Service Portfolio Management**.
2. To view the sample IT service portfolio, click either **Service Owner Workspace**, if activated, or **Service Portfolios**.
3. In the Service Owner Workspace, click **All Services** to reveal the sample list of service-related taxonomy nodes. Alternatively, on the Service Portfolio form in platform view, click **Sample IT Services Portfolio** and then the Taxonomy Nodes Related List to see the sample list of service-related nodes.

A list of sample IT service-related nodes appear including:
- Software Management
- Hardware Support
- IT Management and Consulting
- Network Support
- Data Center Management
- Software Support
4. Click a service-related taxonomy node in platform view, or expand a service in the Service Owner Workspace to view associated information.

5. Study the sample IT service portfolio and its taxonomy layers and nodes to understand the basic structure.

Domain separation and Service Portfolio Management

Domain separation is supported in Service Portfolio Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Basic*

The support level is Basic but has some exceptions or special conditions.

- Business logic: Ensure that data goes into the proper domain for the application’s service provider (SP) use cases.
- The user interface, cache keys, reporting, rollups, and aggregations all use the domain at production run time.
- The owner of the instance must be able to set up the application to function across multiple tenants.

Sample use case: When an SP uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

Overview

*All components of Service Portfolio Management (SPM) and Service Owner Workspace (SOW) are domain-separated in releases of New York and forward. If using Financial Management for the SPM plugin for estimated spend, there can be only one fiscal calendar defined per instance. When this plugin is activated, there can be only one approach for service offering cost modeling per instance (using either the Financial Management engine or local data. Different domains cannot choose their own spend model.

Related information

- Domain separation for service providers
Set up Service Portfolio Management

Set up Service Portfolio Management to define services, document them, track performance against defined availability commitments, and relay the performance information in real-time to your stakeholders.

Before you begin
Role required: portfolio_admin or service_editor

Procedure

1. Define the service offerings and commitments.
   Create service offering records that define different levels of service for an existing service. For example, you might offer two levels of desktop support in your organization. You offer a standard offering for upgrades and virus protection and an executive offering that also includes availability guarantee. Create a complete set of service offerings defined by service commitments that define the specifics of the offering.

2. Define the scope of the service offerings.
   Scope in Service Portfolio Management refers to the detailed service parameters that define the limits of a service. Define specific additional services related to the service as In Scope or Out of Scope. For instructions about applying scope definitions to services, refer to Apply scope to a service in Service Portfolio Management.

3. Configure the price of the service offering.
   Each service offering may have a pricing model and a price unit. Values are set on the parent service and inherited by the offerings. The actual price per unit that is charged for the service is established in the offering. For information about price modeling, refer to Set Service Portfolio Management service offering price models and units and Service Portfolio Management service offering price.

4. Configure the service catalog for the end user.
   All the data created in the previous steps displays on the service catalog page for a service. The layout is not configurable, but an administrator can control how the service is categorized and who can view the service in the catalog. For information, see Service Catalog administration.

5. Subscribe to service offerings.
   With Service Portfolio Management, service owners can subscribe various business entities to service offerings, refer to Service Portfolio Management service offering subscriptions.
Service Portfolio Management design experience

Creating and maintaining a service portfolio for your organization requires an investment in planning and design time. The Service Portfolio Management application is a powerful tool that provides a time-conscious approach for you to successfully plan, design, build, and implement your service portfolios.

Service Portfolio Management key design experience features and capabilities

Portfolio managers and owners can access the many benefits of the Service Portfolio Management application, including the following system capabilities:

• Review and use sample IT service portfolio content provided via the Service Portfolio Management Taxonomy Content Pack plugin (com.snc.spm.content). This data offers an accelerated, time-to-value solution for designing, creating, and implementing a service portfolio.
  ◦ Enable this sample content to build a service taxonomy that quickly results in the creation of standard portfolios with optimal taxonomy.
  ◦ View a list of service-related taxonomy nodes that provides examples of service data, offerings, catalog items, and the relationships they share. Sample data also includes links to periphery data, such as providers, vendors, contracts, SLA definitions, cost models, and more.

• Create and manage portfolios.

• Add new services to a portfolio.
  ◦ Create and oversee service categories and service lines.

• Create and manage the overall portfolio taxonomy.
  ◦ Create and manage layers of services within the taxonomy for optimal organization.

• Access the Service Owner Workspace to monitor and manage portfolio health and performance. Quickly view and summarize all information related to a given portfolio and its component services.

  Note: Service Owner Workspace is available with a separate subscription. For details about accessing this workspace, refer to Service Owner Workspace.

Service owners benefit from the following system capabilities and can perform the following tasks:
• View a list of services that provides service data, offerings, catalog items, and the relationships they share. You can also access links to periphery data, such as providers, vendors, contracts, SLA definitions, cost models, and more.

• Access the Service Owner Workspace, when activated, to monitor and manage services.

• Add new services and compare them for any redundancy.

• Evaluate services for business suitability.

• Incorporate appropriate data elements from service requirements, descriptions, and relationships into a service record. For example, data from users or groups, cost models, SLAs, vendors, and other related services.

• Establish governance and management of life-cycle states and approvals.

• Integrate with Change Management by obtaining and recording approval to develop new services.

• Add services to a service catalog.
  ◦ Create a catalog item stub from the service offering.
  ◦ Link catalog items to service offerings.
  ◦ Record request fulfillment.
  ◦ Build reporting for service and offering consumption based on request fulfillment.
  ◦ Link offering and catalog item state models.

• Assess the value provided to an organization from a given service or offering, based on indicators and data, such as, expenditures, tasks, CSAT, and more.

• Manage subscriptions to offerings by departments, groups, and more.

• Include services in the platform benchmarking framework with Benchmarks.

⚠️ Note: Some feature functionality requires a subscription to Service Owner Workspace.

Integration with Common Service Data Model
Improve your measurement and evaluation by using services and offering references on multiple IT Service Management task forms, including:

• Problem
• Change
• Continual Improvement Management
• Incident
Directly reference a service offering as the target of a problem, change, or incident for consistency with the Common Service Data Model (CSDM). The system filters available offerings based on the service selected.

View and define the Service Model reference field added to the Service and Offering forms to integrate with the CSDM.

**Service Portfolio Management portfolios**

A service portfolio presents an overall top-level view of your currently available services, possible future services, and services that existed in the past. By establishing service portfolios, you can more precisely evaluate the impact that services have on your business, and prioritize them accordingly. With Service Portfolio Management you can define and manage a single portfolio or multiple portfolios, each with its own unique taxonomy structure, owner, and market scope.

Gain valuable knowledge about your service portfolio, including an overall performance score and estimated spend. This knowledge helps you optimize your service budgeting efforts and streamline your decision-making regarding adding new services and retiring services that no longer benefit your business.

ℹ️ Note: Application functionality requires the activation of several Service Portfolio Management plugins. Refer to Activate Service Portfolio Management for details.

Users with the portfolio_admin role can create a single service portfolio or multiple portfolios. If your organization has multiple businesses, the ability to define multiple portfolios enables you to segregate portfolios by business location, by vendor, or by Chief Information Officer (CIO). Portfolio Admins can add and remove services from the portfolio, and determine how those services are categorized. Portfolio Admins can update associated taxonomy layers and nodes.

Portfolio Admins can update portfolio data. Both Portfolio Admins and users with the service_editor role can update services and service offerings, and also reparent services.

Think of the service portfolio as a container that holds a hierarchical organization of definable taxonomy layers and associated nodes, services, and service offerings. Taxonomy in Service Portfolio Management refers to the classification of your portfolio layers and associated services. Typically, taxonomy is structured from a general, high-level perspective to a specific level, such as a service offering. With this dynamic taxonomy structure, you can organize your service portfolios in a variety of ways.
Create a service portfolio in Service Portfolio Management

Create a single service portfolio or multiple service portfolios, each with its own taxonomy structure. Creating a service portfolio presents an overall view of your currently available IT services, what services may be available in the future, and what services existed in the past.

Before you begin
Role required: portfolio_admin

About this task
Creating a service portfolio is the first step before you define taxonomy layers and nodes, and before you populate these nodes with services and service offerings. Once you create the service portfolio, you can edit it within the platform and monitor its performance in Service Owner Workspace. For details on accessing Service Owner Workspace, refer to Service Owner Workspace.

Procedure
1. Navigate to Service Portfolio Management > Service Portfolios.
2. Click New.
3. On the form, fill in the fields.

Service Portfolio form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name that reflects the nature of the service portfolio. For example,</td>
</tr>
<tr>
<td></td>
<td>IT Service Portfolio.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description about the service portfolio.</td>
</tr>
<tr>
<td>Description</td>
<td>Comprehensive description about the service portfolio and its details, such</td>
</tr>
<tr>
<td></td>
<td>as its software and its network support tiers.</td>
</tr>
<tr>
<td>Market scope</td>
<td>Detailed service parameters that define the limits of the service. For</td>
</tr>
<tr>
<td></td>
<td>example, you can specify who uses the portfolio services.</td>
</tr>
<tr>
<td>Service portfolio owner</td>
<td>Person who owns the portfolio. The owner is typically at the CIO level.</td>
</tr>
<tr>
<td></td>
<td>The owner has the portfolio_editor role.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service portfolio manager</td>
<td>Person authorized to manage the service portfolio. This person has the portfolio_admin role and can create, read, update, and delete portfolio records of all types. These types include portfolios, taxonomy levels and nodes, services, service offerings, relationships, and performance criteria for the entire business.</td>
</tr>
<tr>
<td>Upper performance score threshold</td>
<td>Designated high threshold percentage point above which the indicators change from amber to green in Service Owner Workspace. This field is automatically set to 80. Note: This field requires a Service Owner Workspace subscription.</td>
</tr>
<tr>
<td>Lower performance score threshold</td>
<td>Designated low threshold percentage point below which the indicators change from amber to red in Service Owner Workspace. This field is automatically set to 60. Note: This field requires a Service Owner Workspace subscription.</td>
</tr>
<tr>
<td>Performance score</td>
<td>Most recent performance score for the entire portfolio of services.</td>
</tr>
</tbody>
</table>
| Add default performance metrics   | Option to automatically add five default metrics when you create a new service portfolio. The default metrics are the following:  
  • Availability  
  • Customer Satisfaction  
  • Critical Incidents                                                                                                                               |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Activity</td>
<td></td>
</tr>
<tr>
<td>• Breached SLA</td>
<td>This field is hidden on Service Portfolio records. It only appears when creating a record.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field requires a Service Owner Workspace subscription.</td>
</tr>
<tr>
<td>Auto-create service offerings</td>
<td>Option to automatically create one-to-many offerings on a newly created service within a service portfolio. The offers are automatically added also when adding a service to an existing service portfolio.</td>
</tr>
<tr>
<td>Evenly weight performance metrics for new offerings</td>
<td>Option to evenly distribute the performance weight of each metric. For example, each default metric is weighted at 20%. This option is automatically selected when an offering is created as part of this portfolio. The option is inactive when the Add default performance metrics field is cleared.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field requires a Service Owner Workspace subscription.</td>
</tr>
<tr>
<td>Estimated Spend</td>
<td>Details for the portfolio display if you have integrated with Financial Management and have configured the Estimated SpendCost model field on the Service Offering form.</td>
</tr>
</tbody>
</table>

4. To save your service portfolio, click **Submit**.

**Results**

The newly created service portfolio appears in the **Service Portfolios** module list.
What to do next

If you click the newly created service portfolio name in the list, then various related lists appear on the form. These lists include the Taxonomy Nodes, Portfolio Metrics, and Taxonomy Node Weights related lists appear on the Service Portfolio form. Refer to Service Portfolio Management taxonomy for detailed information regarding creating and adding taxonomy nodes within your service portfolio structure.

To edit the service portfolio, click the name of the service portfolio to open the form. Change any of the form field data as needed, then click Update.

To delete the service portfolio, click Delete Portfolio and Taxonomy.

Service Portfolio Management taxonomy

Service Portfolio Management uses a taxonomy to classify containers of services your organization provides and manages via a service portfolio. A service portfolio can contain multiple elemental layers—from general to specific—that provide the hierarchical top-to-bottom structure of your portfolio.

Taxonomy structure

The Service Portfolio Management taxonomy structure is a framework for organizing and managing your services.

The taxonomy framework ends where your services begin. For example, your structural framework may contain, at its highest level, a taxonomy layer named Tier. The Tier layer may contain several taxonomy nodes, named, for example, Software Support Tier and Network Support Tier. The Tier layer may contain a sublevel taxonomy layer named Category. This second-level Category layer may also contain several taxonomy nodes, such as Virtual Machines Category, Archiving Category, and Networking Category.

Leaf nodes comprise the bottom-level of the taxonomy structure and contain associated services. The services contain the associated service offerings. This taxonomy structure presents as an organized hierarchical structure.

Note: Your taxonomy structure can have multiple layers. The bottom-level layer nodes are the leaf nodes and they contain services.

Taxonomy layer and node definitions

Build your service portfolio by defining your taxonomy layers and nodes. Taxonomy layers are high-level containers for the associated taxonomy nodes. Nodes represent all the available branches for that layer. For example, a layer named Tier may contain two nodes or branches named Software Support Tier and Network Support Tier.
**Taxonomy layer creation and modification**

Users with the portfolio_admin role can create, view, update, and delete taxonomy layers. Users with the portfolio_editor role can update existing layers. When creating a taxonomy layer, you must provide a layer name, specify the order of appearance in the hierarchical structure, and associate the layer to a service portfolio.

There is no limit to how many taxonomy layers you can create. To create nodes and attach services in a service portfolio, your portfolio must contain at least one taxonomy layer. Nodes are added to layers as children of a parent node. You cannot add nodes to any random layer. A node must be attached to a parent node in the parent layer.

Order layers according to how they appear in the taxonomy structure. A layer with the Order number 100, appears at the top of the service portfolio structure and contains all other elements below it.

If nodes exist in a taxonomy layer, you cannot delete or reorganize that layer. To delete or reorganize the layer, move the nodes to a new or existing layer.

**Taxonomy node creation and modification**

Users with the portfolio_admin role can create, view, update, and delete taxonomy nodes. Parent nodes create the taxonomy structure within a layer. When creating a taxonomy node, you must provide a node name, and associate the node to a parent node and taxonomy layer.

There is no limit to how many taxonomy nodes you can create within a layer. To create nodes and attach services in a service portfolio, your portfolio must contain at least one taxonomy layer.

You can reparent a node by changing the **Parent** value on the Taxonomy Node form.

- You can reparent a node to another node at the same taxonomy layer.
- You can reparent multiple nodes simultaneously using list view in the application.

Child nodes display in a related list on the Taxonomy Node form, enabling you to browse deeper into the hierarchical service portfolio structure.

Leaf nodes at the bottom of the hierarchical structure contain a Related List of associated services. Create new services from or add existing services by modifying the **Taxonomy Node** field on the Service form.
Create or modify Service Portfolio Management taxonomy layer definitions

Create an unlimited number of taxonomy layers to organize, label, and manage your service portfolio. Taxonomy layers represent the highest containment levels of your service portfolio. Each level supports branches, or nodes, that contain child nodes or services in a hierarchical top-to-bottom structure.

Before you begin
Role required: portfolio_admin

About this task
Opening the Taxonomy Layer Definitions module displays a list of all existing layers defined for all service portfolios.

By default, the service portfolio name associated with the taxonomy layer is listed in the first Service portfolio column of the list. The service portfolio is the parent element to the taxonomy layer. Existing taxonomy layers appear in the Name column, and are chronologically sorted in the Order column. Your layer with order number 100 is always at the top, followed by order number 200, and so on.

Always associate taxonomy layers with a parent service portfolio. Example layers for an IT services portfolio might include the following taxonomy layers:
- Service Class
- Service Group

If the Service Portfolio Management Taxonomy Content Pack [com.snc.spm.content] plugin sample data is activated on your instance, review the provided taxonomy data to gain an understanding of how to best define your taxonomy layers. Refer to Activate Service Portfolio Management Sample Content Pack for more details.

Procedure

1. To create a new taxonomy layer definition, navigate to Service Portfolio Management > Taxonomy Layer Definitions and click New. Alternatively, to edit an existing taxonomy layer definition, click the name of the taxonomy layer definition to open the form. Change any of the form field data as needed.

2. Fill in or edit the form fields.
Taxonomy Layer Definitions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name that defines the purpose of the taxonomy layer, for example, Tier, as in software support tier or network support tier.</td>
</tr>
<tr>
<td>Order</td>
<td>Value that represents the hierarchical level where the taxonomy layer will exist. 1 is the highest level, with each chronological number following at a lower level.</td>
</tr>
<tr>
<td>Note:</td>
<td>Layer ordering is locked and cannot be changed when a node is created for any layer in a service portfolio. Nodes cannot be added to layers if there is a gap in the layer order.</td>
</tr>
<tr>
<td>Service Portfolio</td>
<td>Service portfolio for which the taxonomy layer is associated.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief detail about the taxonomy layer purpose.</td>
</tr>
</tbody>
</table>

3. Click **Submit** to save your service portfolio or click **Update** after editing a taxonomy layer.

4. Click the newly created taxonomy layer definition in the list.
   The Taxonomy Nodes and Portfolio Metrics Related Lists appear on the Service Portfolio form. Refer to Service Portfolio Management taxonomy for detailed information regarding creating and adding taxonomy nodes within your service portfolio structure.

Create Service Portfolio Management taxonomy nodes

Create an unlimited number of nodes or branches. Add these nodes to your service portfolio taxonomy layers. By configuring taxonomy nodes, you can successfully achieve a highly detailed and organized service portfolio that contains multiple elemental layers, from general to specific.

**Before you begin**
Role required: portfolio_admin
About this task

In Service Portfolio Management, taxonomy nodes typically represent service types within the configured taxonomy layers. These types act as containers for child nodes or services. Examples for an IT services portfolio could include the following taxonomy nodes:

- Data Center Management
- Hardware Support
- Software Management

If the Service Portfolio Management Taxonomy Content Pack [com.snc.spm.content] plugin sample data is activated on your instance, review the provided taxonomy data to gain an understanding of how to best define your taxonomy layers. Refer to Activate Service Portfolio Management Sample Content Pack for more details.

Procedure

1. Navigate to Service Portfolio Management > Taxonomy Nodes
2. To create a new taxonomy node, click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name that defines the purpose of the node.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief detail about the taxonomy node purpose.</td>
</tr>
<tr>
<td>Description</td>
<td>In-depth details about the node.</td>
</tr>
<tr>
<td>Service portfolio</td>
<td>Service portfolio that this taxonomy node is associated with.</td>
</tr>
<tr>
<td>Taxonomy layer</td>
<td>Taxonomy layer that this node is associated with.</td>
</tr>
<tr>
<td>Parent</td>
<td>Taxonomy node to which the taxonomy node is associated.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Owner of the taxonomy node.</td>
</tr>
<tr>
<td>Valid from</td>
<td>Date when the taxonomy code is valid.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Valid to</td>
<td>Date when the taxonomy code is no longer valid.</td>
</tr>
<tr>
<td>Performance score</td>
<td>Most recent performance score for this node. The performance score is calculated by a nightly script.</td>
</tr>
<tr>
<td>Note:</td>
<td>Appears with a Service Owner Workspace subscription.</td>
</tr>
<tr>
<td>Note:</td>
<td>Only an admin can change the score, if necessary.</td>
</tr>
</tbody>
</table>

4. To save your taxonomy node, right-click in the header to save or click **Submit**.

5. To edit existing child service weights or child node weights, click the **Edit Weights** related Link.

   **Note:** The **Edit Weights** related Link requires a Service Owner Workspace subscription. Weight values for associated child nodes are specified at the service offering level via the **Edit Metric Weights** related Link on the Service Offering form.

6. Specify weight values for each associated child node.
   The total weight must equal 100 percent. For more information on weights and specifying weight values, refer to **Service Owner Workspace performance metrics**.

7. Review Related List records. Depending on the type of node, whether it is a leaf node or a non-leaf node, Related Lists display the following associated data:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Taxonomy Nodes</strong></td>
<td>List of all associated child nodes. You can edit an existing child node by clicking a Taxonomy Node name. Create a new child node by clicking <strong>New</strong> and completing the <strong>Taxonomy Node</strong> form.</td>
</tr>
<tr>
<td><strong>Services</strong></td>
<td>List of all associated services shown for leaf nodes. Select <strong>New</strong> to create a service. On the <strong>Create a service</strong> page, select the type of service you want to create. Click <strong>Edit</strong> to add or remove services in the related list. On the <strong>Edit member</strong> page, use <strong>Class</strong> to...</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>filter the list for Business or Technical services. Refer to Create a Service Portfolio Management service.</td>
<td></td>
</tr>
</tbody>
</table>

**Results**
A taxonomy node is created

**What to do next**
To edit the taxonomy node, do the following:

1. Click the name of the taxonomy node to open the form.
2. Change any of the form field data as needed.
3. To re-parent a node to another node at the same taxonomy layer, edit the **Parent** field.
4. Click **Update**.

To delete the node, click **Delete**.

**Service Portfolio Management services**

Configure IT services within your portfolios to add the most value to your organization. The IT services defined in your portfolios may, or may not be, specifically aligned to an application. IT services defined in your portfolios may, or may not be, represented in a request catalog.

The phase and status of a service indicates the life-cycle position of the service. You can view, track, and monitor the services by phase and status with platform lists and reports. The lists can also include retired services for viewing purposes.

Each service record has a unique number to identify the record.

To reflect the importance or impact of each service on the operations of your organization, you can select a criticality level for them. For example, you might select a high level for a service that supports sales functionality using the organization’s website. You might then select a lower level for a service that provides internal printing for the organization’s employees.

**Business services**

Business services make up the structure of your service portfolio taxonomy. You can create dependencies to these types of services and view and manage associated service and offering details via the dependency tabs of the related list on the Service and Service Offering forms as well as in Service Owner Workspace if activated.
Create offerings as children of services. Offerings are created in the Service Offering [service_offering] table. Refer to Service Portfolio Management service offerings for more details.

You can designate services as Services I depend On or Services Dependent On Me via form related lists.

**Technical services**

Although technical services are not added as part of your service portfolio taxonomy, you can still gain insight into these services by adding them as Services I depend On or Services Dependent On Me in the related list section of the Service form.

Create a Service Portfolio Management service

Create services that benefit and add value to your internal organization, external customers, and users.

**Before you begin**

Role required: portfolio_admin or service_editor

**About this task**

Create a service directly though the menu. The service can be either a business services or a technical service. You can add these services to the Service portfolio.

**Procedure**

1. Navigate to Service Portfolio Management > Services.
2. To create a service, click New.
   Alternatively, you can create business or technical services by selecting Business Services or Technical Services respectively, directly from the navigation pane.
3. On the form, fill in the fields.

**Service form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name that reflects the nature of the service.</td>
</tr>
<tr>
<td>Service portfolio</td>
<td>Service portfolio that this service is associated with.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Taxonomy node</td>
<td>Taxonomy leaf node that this service is associated with.</td>
</tr>
<tr>
<td>Phase</td>
<td>Phase that the service is in. Available values are the following:</td>
</tr>
<tr>
<td></td>
<td>• Pipeline</td>
</tr>
<tr>
<td></td>
<td>• Catalog</td>
</tr>
<tr>
<td></td>
<td>• Retired</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the service per phase.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Type of service. Available values are the following:</td>
</tr>
<tr>
<td></td>
<td>• Business Service</td>
</tr>
<tr>
<td></td>
<td>• Technical Service</td>
</tr>
<tr>
<td></td>
<td>• Application Service.</td>
</tr>
<tr>
<td>Performance score</td>
<td>Most recent performance score. This field is populated after the service becomes active. The performance score is calculated by a nightly script and cannot be changed by the user.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field requires a Service Owner Workspacesubscription.</td>
</tr>
<tr>
<td>CSAT score</td>
<td>Customer service feedback score.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field requires a Service Owner Workspacesubscription.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Service owner who is responsible for this service in the organization.</td>
</tr>
<tr>
<td>Delivery manager</td>
<td>Delivery manager for the service.</td>
</tr>
<tr>
<td>Business relation manager</td>
<td>Relationship manager for this service.</td>
</tr>
</tbody>
</table>

4. To complete the General section of the form, click the **General** tab.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Automatically generated unique identification for a new service record. Its value consists of a 'BSN' string and a unique number. Other forms and scripts can reference this identification. The <strong>Number</strong> field is visible with the Service Portfolio form view.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The <strong>Number</strong> field is empty in service records that were created before the field was added.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the service.</td>
</tr>
<tr>
<td>Aliases</td>
<td>Other names used for this service.</td>
</tr>
<tr>
<td>Service classification</td>
<td>Type of service. Available values are the following:</td>
</tr>
<tr>
<td></td>
<td>• Business Service</td>
</tr>
<tr>
<td></td>
<td>• Technical Service</td>
</tr>
<tr>
<td></td>
<td>• Application Service</td>
</tr>
<tr>
<td>Consumer type</td>
<td>Type of consumer. Available values are: <strong>Internal</strong>, <strong>External</strong>, and <strong>Internal and External</strong>.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date the service is available.</td>
</tr>
<tr>
<td>End date</td>
<td>Date the service is retired.</td>
</tr>
<tr>
<td>Last review date</td>
<td>Date the service was last reviewed.</td>
</tr>
</tbody>
</table>

5. To complete the Team section of the form, click the **Team** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delegate</td>
<td>Person authorized to manage the service on behalf of the service owner.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Business contact</td>
<td>Person to contact for issues related to this service.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor who is providing this service.</td>
</tr>
<tr>
<td>Stakeholders</td>
<td>People with an interest or concern regarding this service.</td>
</tr>
</tbody>
</table>

6. To complete the Business Need section of the form, click the **Business Need** tab.

**Note:** This section appears only if is **Business Services** is selected from the **Service classification** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business need</td>
<td>Business need that is supported by this service.</td>
</tr>
<tr>
<td>Business criticality</td>
<td>Criticality level that defines the importance of the service in your organization.</td>
</tr>
</tbody>
</table>

7. Right-click the header bar and select **Save** from the pop-up menu. The related lists for the service appear. These lists are the following:

- Offerings
- In Scope
- Out of Scope
- Services I depend On
- Services Dependent On Me
- Incidents
- Problems
- Change Requests
- Other tasks
- Knowledge Articles
- Service Offering Node Weights
• Improvement Initiatives
• Business Capabilities (Appears only in Business Services)

8. To save your service, click Submit.

Results
The service is created.

What to do next
To edit the service, click the name of the service to open the form. Change any of the form field data as needed, and click Update.
To delete the service, click the Delete button.

Apply scope to a service in Service Portfolio Management
Define the limits of a service with scope details. Out of Scope items define what a service cannot provide and In Scope items define what a service provides. By defining scope, you can grant or deny specific services that define a more detailed view of a service. For example, nightly backups may be In Scope for the Desktop Support service, but Out of Scope for the Disaster Recovery service.

Before you begin
Role required: portfolio_admin or service_editor

About this task
The In Scope and Out of Scope definitions appear in the service catalog page that users see when they access the service catalog.

To view the list of scope entries in your system, enter service_scope.list in the navigator and press the Enter key.

Procedure
1. Navigate to Service Portfolio Management > Services.
2. Select the name of a service for which you want to define scope.
   Only a parent service can have scope.
3. In the In Scope or Out of Scope related list, click New to create a new definition or click Edit to add the scope to the In Scope or Out of Scope list for the service.
   Configure scope with anything that is pertinent to the service and helps define the limits of the service.
4. Give the scope item a descriptive name and provide details in the **Description** field.

5. Click **Submit**.

**Set Service Portfolio Management service offering price models and units**

Define the pricing structure for a service offering to use either a per unit price model or a fixed price model.

**Before you begin**

Role required: portfolio_admin or service_editor

**Procedure**

1. Navigate to **Service Portfolio Management > Services Offerings**.

2. Select a service offering from the Service Offerings list.

3. Define the **Price model**.
   The choices are **Per Unit** and **Fixed**. If you select **Per Unit**, the **Price unit** field appears.

4. Type the name of a unit to use for pricing, for example, service, server, or person.

5. Click **Update**.

**Service Portfolio Management service offerings**

A service offering derives from a service, refining the parent service to a specific business need and performance level.

**Service offerings and commitments**

Offering records define different levels of performance for an existing service. For example, you might offer two levels of desktop support in your organization. You can offer a standard offering for upgrades and virus protection and an executive offering that also includes availability guarantee.

Service offering types include business service offerings and technical service offerings.

Create a complete set of service offerings defined by commitments that define the specifics of the offering. Each service must have at least one defined offering to move to the Catalog phase. This is because service offerings are where you define Service Level Agreements (SLAs) and where metrics are collated.
For detailed information about SLAs, including SLA definitions and results, refer to Service Level Management.

**Service offering pricing**
Each service offering may have a pricing model and a price unit. Use this pricing data towards creating catalog items.

**Service offering subscriptions**
You can subscribe different entities to a service offering. This data is then used to determine the total subscriber count on the offering form.

**Technical service offerings**
Technical service offerings can be shown as inherited relationships to business services and offerings. They are not included in metric models and do not use the weighting model.

**Re-parenting service offering types**
You can change a service offering parent from one type of service to another. For example, changing an offering parent from a business service to a technical service or vice versa. Offerings cannot be re-parented to an application service. Some important information and guidelines concerning re-parenting service offering types, include:

- When you change the offering parent from a business service to a technical service you will receive a message alerting you that performance scoring is not available with technical service offerings.
- When you re-parent from one service type to another, existing weighting rules will apply.
- If you try to re-parent and the parent service is in Catalog phase with only one offering, you will receive a message that you cannot make this change.
- If the metric weight on the parent service is >0, you will receive a message alerting you to adjust the data before re-parenting the offering. You cannot re-parent the offering to a different service type until the weight for the offering on the former service type is set to zero.

**Create and manage Service Portfolio Management service offerings**
Create service offerings to define services, document them, track performance against defined availability commitments, and relay the performance information in real time to your end users.
About this task
Often, data defined on the service and its child offerings is identical. For example, the same person may own a service and its offerings, as defined in the Owned by field on the Service form. However, flexibility exists for defined data to be different between services and child offerings if the organization desires. For example, one person may own the service while another person owns the child offering.

Link service offerings to catalog items required to provision a service. Each service offering has commitments, which in turn, have service level agreements.

A service offering consists of a set of service commitments which uniquely define the level of service in terms of availability, scope, and pricing. For example, an organization may offer two levels of Desktop Support in your organization. A Standard offering of upgrades and virus protection. And an Executive offering with the standard commitments plus some type of availability guarantee, such as 98% availability from 8-5 on weekdays.

When an offering is added to a service for the first time, some Offering form field values are inherited from the parent Service record. These form fields are: Owned by, Business criticality, Delivery Manager, and Delegate. When an offering is added and the parent Service record has empty field values, these fields are also empty on the Offering record. When you first insert an offering into a service, the parent Service record field values will overwrite any existing values in the Offering record. You can update the fields after you have added the offering, if necessary.

Procedure
1. To create a new service offering, navigate to Service Portfolio Management > Service Offerings and click New. Alternatively, to edit an existing service offering, click the name of the service offering to open the form. Change any of the form field data as needed.
   To delete an existing service, click the delete button in the form header.
2. Fill in the form fields.

<table>
<thead>
<tr>
<th>Offering form</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Parent</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>---------------------</td>
</tr>
<tr>
<td>Phase</td>
</tr>
<tr>
<td>Status</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Performance score</td>
</tr>
<tr>
<td>Note:</td>
</tr>
<tr>
<td>CSAT score</td>
</tr>
<tr>
<td>Note:</td>
</tr>
<tr>
<td>Total Subscribers</td>
</tr>
<tr>
<td>Note:</td>
</tr>
<tr>
<td>Owned by</td>
</tr>
<tr>
<td>Note:</td>
</tr>
<tr>
<td>Note:</td>
</tr>
</tbody>
</table>

3. Click the **General** tab to complete the General section of the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aliases</td>
<td>Other names used for this service.</td>
</tr>
<tr>
<td>Business criticality</td>
<td>Degree of how critical this service offering is to the business. You can base a demand response strategy off this value.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Consumer type</td>
<td>Type of consumer. Available values are: <strong>Internal</strong> and <strong>External</strong>.</td>
</tr>
<tr>
<td>Service classification</td>
<td>Type of service. Available values are: <strong>Business Service</strong>, <strong>Technical Service</strong>, and <strong>Application Service</strong>.</td>
</tr>
<tr>
<td>CSAT Survey Frequency</td>
<td>How often a customer satisfaction survey is sent.</td>
</tr>
<tr>
<td>CSAT Survey Last Sent</td>
<td>Last time a customer satisfaction survey was sent.</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the service offering.</td>
</tr>
<tr>
<td>Start date</td>
<td>Date the service is available.</td>
</tr>
<tr>
<td>End date</td>
<td>Date the service is retired.</td>
</tr>
<tr>
<td>Location</td>
<td>Physical location of the service.</td>
</tr>
</tbody>
</table>

4. Click the **Team** tab to complete the Team section of the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery Manager</td>
<td>The delivery manager for this service.</td>
</tr>
<tr>
<td>Delegate</td>
<td>Person authorized to manage the service along with the service owner.</td>
</tr>
<tr>
<td>Support group</td>
<td>Group managing the service.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Vendor</td>
<td>The vendor providing this service.</td>
</tr>
<tr>
<td>Stakeholders</td>
<td>People with an interest or concern regarding this service.</td>
</tr>
</tbody>
</table>

5. Click the **Price** tab to complete the Price section of the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price model</td>
<td>Pricing structure for a service offering as defined in the parent service. The <strong>Price model</strong> field is read-only. This value is set in the parent service.</td>
</tr>
<tr>
<td>Price unit</td>
<td>Short name of the unit for this service. Appears when <strong>Per Unit</strong> is chosen for the <strong>Price Model</strong> type in the parent service. The <strong>Price unit</strong> field is read-only. This value is set in the parent service.</td>
</tr>
<tr>
<td>Price</td>
<td>Price and currency.</td>
</tr>
<tr>
<td>Unit Description</td>
<td>Longer description of a unit of this offering.</td>
</tr>
</tbody>
</table>

6. Click the **Operations** tab to complete the Operations section of the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract</td>
<td>Associated contract number.</td>
</tr>
<tr>
<td>Maintenance schedule</td>
<td>Time during which maintenance is scheduled.</td>
</tr>
<tr>
<td>Service level requirement</td>
<td>Field captures the requirements, which include the service level agreements and service level targets, for the service.</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>Prerequisites for this service offering.</td>
</tr>
<tr>
<td>Compatibility dependencies</td>
<td>Compatibility dependencies for this service offering.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring requirements</td>
<td>Requirements to monitor this service offering.</td>
</tr>
</tbody>
</table>

7. Click the **Estimated Spend** tab to view the Estimated Spend section.

8. Choose a value for the **Cost model** field. Choices include the default **None**, **Fixed**, and **Per unit**. View read-only data in the **Estimated spend** field.

   <p>Note: When Service Owner Workspace (com.spm_owner_workspace) and Financial Management for SPM (com.snc.financial_management_for_spm) are activated and the **sn_spm_spend.offering_cost_source** system property is set to the value **Financial Management** the **Estimated Spend** form section displays the fields **FM period** and **FM cost**. These fields reveal read-only data associated with the service offering. For more information on estimated spend, refer to **Financial Management for Service Owner Workspace**.</p>

9. After completing the form, right-click in the header bar and select **Save** from the pop-up menu.

   The **Related Links** and related lists for the offering appear.

10. In **Related Links** you can create an offering improvement initiative, edit offering metric weights, and subscribe to the offering by clicking the associated link.

   <p>Note: For detailed information regarding creating an improvement initiative, refer to **Create an improvement request**. For information on metric weights, refer to **Service Owner Workspace performance metrics**.</p>

11. View associated related lists and items or create a new item. Related lists include:

   The related lists for the offering appear. View associated or create new:
   - Service Commitments
   - Service Offerings I Depend On
   - Service Offerings Dependent On Me
   - Outages
   - Incidents
   - Problems
   - Change Requests
   - Other Tasks
12. Click **Submit** to save your service offering or click **Update** after editing a service offering.

**Define Service Portfolio Management service commitments**

Service commitments are specific services that define the unique availability guarantees, scope, and pricing for a service offering.

**Before you begin**
Role required: service_editor

**About this task**
Service commitments define the expected level of a service. A service offering derives from a service, tailoring the parent service to a specific business need. A service offering consists of a set of service commitments which uniquely define the service offerings.

To create service commitments, each service needs at least one associated service offering.

**Procedure**

1. Navigate to **Service Portfolio Management > Service Offerings**. Alternatively, you can navigate to **Service Portfolio Management > Commitments**.

2. Open a service offering record.

3. In the Service Commitments related list, click **New**. The Service commitment form opens.

4. Give the commitment a descriptive name. You can specify any kind of service.

5. Select the **Type** of commitment from the list.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Availability or Maintenance Window</strong></td>
<td>Used in system processing. If you select <strong>Maintenance Window</strong>, the <strong>Schedule</strong> field is required. Creates Availability records for the service offering based on the outages for that offering. If an Availability commitment exists, when an Outage is created against a service offering with the Availability commitment, it will begin tracking down time and availability.</td>
</tr>
<tr>
<td><strong>Response Time, Delivery or Other</strong></td>
<td>Display additional information in the service catalog. This information details the type of service commitment the user may expect from a given service offering. These service commitment types do not provide additional functionality or a homepage gauge.</td>
</tr>
<tr>
<td><strong>Recovery time objective</strong></td>
<td>Guarantee of how long it takes to recover the system from the recovery point. Set the recovery time in the <strong>Time Amount</strong> field that appears when you select this commitment type. This field is available with vendor ticketing.</td>
</tr>
<tr>
<td><strong>Recovery point objective</strong></td>
<td>Guarantee of how often backups are performed. Set the backup interval in the <strong>Time amount</strong> field that appears when you select this commitment type. This field is available with vendor ticketing.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>SLA</strong></td>
<td>Allows commitments defined by a service level agreement (SLA) that tracks whether a vendor provides a level of service for a defined percentage of the time. The SLA results are calculated automatically and can be viewed on the My Services - SLAs homepage or by navigating to Services &gt; Service Offering SLAs &gt; SLA Results.</td>
</tr>
</tbody>
</table>

**Note:** These service commitment types do not provide additional functionality or a homepage gauge.

6. Optionally, select a **Contract** for this service commitment. This information is used when creating vendor credit records.

7. Enter the information to calculate credit owed by the vendor for any contract breaches. These fields are available with vendor ticketing:
   - **Breach penalty amount**: Amount assessed per unit of time for a breach.
   - **Per**: Unit of time used to calculate the total credit owed for a breach.
   - **Breach penalty time**: Amount of free time provided by the vendor per breach.

8. Complete the form and click **Submit**. The Service Offering form opens, and the new commitment appears in the Service Commitment related list.

9. Click **New** to add another service commitment or click **Edit** to add an existing commitment to this offering.

**Create Service Portfolio Management service outages**

Adjust your service commitment availability by creating maintenance commitments to accommodate planned outages.

**Before you begin**

Role required: service_editor
About this task

Service Portfolio Management tracks and reports on outages for all service offerings that include availability commitments. Outages are recorded manually and are visible in service offering records and in Service Owner Workspace. Availability is a key metric used in Service Owner Workspace.

Note: For details about access to Service Owner Workspace refer to Service Owner Workspace.

The outage is used to evaluate the availability of the offering and appears in the reports generated for this offering. There are three types of outages:

- **Outage**: Unplanned outages such as those caused by hardware or network issues. The only type of outage considered when calculating availability of a service.
- **Planned Outage**: Necessary, expected outages caused by planned maintenance or upgrades.
- **Degradation**: Indicates a problem affecting a service that does not result in a disruption of that service.

Outage records can relate to multiple configuration items (CIs). You can link a single outage to multiple CI records using the Affected CIs related list.

Note: An outage must be created and saved before you can add a CI relation or link an outage to multiple CI records using the Affected CIs related list.

View a unique Outage Number identifier for your outage records. View the Outage Number column in the Outage table records list and on the Outage form.

Note: The Outage Numbering plugin (com.snc.outage_numbering) must be activated to introduce number data. The plugin is automatically activated for all instances and upgrades except those that already have a number prefix column on the Outage table. Refer to the Activate Outage Numbering plugin [KB0823685] article in the HI Knowledge Base or contact Customer Service and Support if the plugin is not active and you want to move to the base system field.

When an outage is opened against a service, the system adds all child offerings to the Affected CI related list on the outage form, affecting all child offering availability. An outage record is then created for each offering. A pop-up notifies you that the outage affects all child offerings. The offerings can be removed from the Affected CIs related list if needed.
Procedure

1. Navigate to Service Portfolio Management > Outages.

2. Click New to create a new outage or find the service offering in the Outages records list Configuration item field to edit.
   - If creating a new outage, the Outage form opens.
   - If editing an existing outage, click the outage in the Type field.

3. Edit the Type field as necessary or choose None.

4. Enter any desired text in the Message field.

5. Define the length of the outage by selecting the Begin and End dates and times with the calendar, or by entering the Duration as a function of days and hours.

6. Right click in the form header to save the record or click Submit or Update to edit an existing outage record.

   Note:
   
   If a single outage impacts multiple service offerings, you can add those offerings to the Affected CIs related list.

7. To add an associated affected CI, click Add.
   The Add Affected Configuration Items list window appears displaying Service Offering as the configuration class. All affected CIs are listed.

8. Select a single CI or group of CIs by checking the box next to the CI name and clicking Add Selected. Alternatively, you can choose to add all the listed affected CIs to the outage record by clicking Add All.

9. Close the Add Affected Configuration Items list window.
   The CI or CIs are added to the Affected CIs related list.

10. Click Update.

Service Portfolio Management service offering price

Service offerings inherit the pricing structure of the associated parent service. Each service offering in Service Portfolio Management may have a price model, defined as either fixed or per unit. If the price model is defined in the parent service as per unit, then each service offering must also have an associated price unit. The actual price for that unit is established in the service offering record.

You can review service offering information regularly as a part of Data Certification and workflow. For example, you can set up a certification to validate pricing for your service offerings.
Forecast service usage and cost for a fiscal period to plan your future business using the Showback functionality of Financial Management.

To set a service offering price, navigate to Service Portfolio Management > Service Offerings and select an offering for which a defined pricing structure exists. Enter the Price for the service price unit and update the record. You can also type an optional description in the Unit description field of the service offering record.

**Service Portfolio Management service offering subscriptions**

Service Portfolio Management enables service owners to subscribe users to service offerings.

> Note: Functionality described here requires the Service Portfolio Management Foundation plugin (com.snc.service_portfolio).

With Service Portfolio Management, service owners can subscribe various business entities to service offerings.

**Subscribe users to a service offering in Service Portfolio Management**

Subscribe your users to a service offering. This functionality also applies to subscribing companies, locations, groups, and departments to service offerings when that foundational data is available.

**Before you begin**

Role required: service_editor

**Procedure**

1. In a Service Offering record, click Edit in the Subscribed by User Related List.
2. In the slushbucket that appears, move the subscribed users to the Subscribed by User List.
3. Save your changes.
   - These users can now add a gauge for this service offering to their home pages.

**Create or modify a Service Portfolio Management SLA result**

Define service commitments for your service offerings and monitor the results to manage performance.
Before you begin
Role required: admin

Procedure
1. To create a new SLA result, navigate to Service Portfolio Management > Service Level Management > SLA Results and click New. Alternatively, to edit an existing SLA result, click the name of the SLA result to open the SLA Result form. Change any of the form field data as needed.

2. Fill in the form fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service offering</td>
<td>Select the service offering for which you want to create or modify an SLA Result record.</td>
</tr>
<tr>
<td>Service commitment</td>
<td>Select the service commitment to apply the SLA Result record.</td>
</tr>
<tr>
<td>Start</td>
<td>Specify the start date for this SLA Result interval.</td>
</tr>
<tr>
<td>End</td>
<td>Specify the end date for this SLA Result interval.</td>
</tr>
<tr>
<td>Company</td>
<td>Specify the company for which the SLA Result record is created.</td>
</tr>
<tr>
<td>Required SLA percentage</td>
<td>Enter the percentage of tasks that must meet this SLA.</td>
</tr>
</tbody>
</table>

Note: The following fields display SLA result data when available:

- **Total tasks** — Total number of tasks related to this service offering for this SLA.
- **Breached** — Number of tasks that breached this SLA for this interval.
- **Achieved** — Number of tasks that achieved this SLA for this interval.
- **Total achieved %** — SLA percentage achieved for the entire interval.

3. Click Submit.
The Tasks for Interval Related List appears.
Note: When an SLA definition is triggered against a particular task, a task SLA record generates and contains all the tracking data for the specific SLA on that record.

4. To create an SLA task or modify an existing task, refer to Task SLA table.

Service Level Management for Service Portfolio Management

Service Portfolio Management leverages the Service Level Management application and includes a module to manage your Service Level Agreement (SLA) definitions and results.

If not already activated, you can activate the Service Portfolio Management SLA Commitments plugin (com.snc.service_portfolio.sla_commitment) to enable Service Level Agreement (SLA) commitment support to Service Portfolio Management. Refer to Activate Service Portfolio Management for more information about this and other plugins that add feature functionality to Service Portfolio Management.

View, modify, or create SLA definitions from the Service Portfolio Management application. You can also view, modify, or create SLA results. Refer to Service Level Agreement (SLA) definition and Create an SLA definition for information about SLA definitions and configuration. For complete detailed information about SLAs, refer to Service Level Management.

Service Owner Workspace

ServiceNow® Service Owner Workspace provides a premium Service Portfolio Management experience. If you’re a portfolio manager or service owner, you can manage and monitor portfolios and services in one integrated and graphically intuitive user interface.

Service Owner Workspace is available as a separate subscription and is part of the Service Portfolio Management Premium experience.

Track and analyze how your services are performing and which services need attention. You can also integrate data from the Vendor Management Workspace, Contract Management, SLA Contracts, Risk Management, and Continual Improvement Management (CIM) applications to quickly access data from one place.
### Key features

<table>
<thead>
<tr>
<th>Data all in one place</th>
<th>Comprehensive service performance layout</th>
<th>Integrated application data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage the performance of your services. Evaluate performance against value to ensure your services merit the investment.</td>
<td>Analyze service performance metrics using a comprehensive layout of all information that is related to a service and its offerings.</td>
<td>Use aggregated data from multiple applications and measure service performance using qualitative and quantitative metrics.</td>
</tr>
</tbody>
</table>

### Get started
Select a tile to get started.

---

**Exploring Service Owner Workspace**

The Service Owner Workspace provides portfolio and service owners with an integrated and graphically intuitive user experience to manage and monitor portfolios and services.
How does Service Owner Workspace work?

Service Owner Workspace is a read only user interface driven by Service Portfolio Management Premium plugin (com.snc.spm) functionality. Service Portfolio Management Premium collects service offering metrics and rolls these calculations up to parent services and taxonomy nodes for performance scores and other metrics viewed via Service Owner Workspace. Performance Analytics indicators capture this data and Service Portfolio Management Premium uses the Performance Analytics data as input metrics to calculate a service offering performance score. These indicators can also track data about a service offering without including it in the offering performance score.

Users can create new metric definitions or use the metric definitions provided in the base system application. Assign metrics to service portfolios and define weights for every metric at an offering level to provide more granularity into performance. Daily jobs then calculate the offering performance score and roll the scores up to the service and other associated taxonomy nodes to monitor in Service Owner Workspace.

Service Owner Workspace browser requirements

ServiceNow workspaces do not support mobile devices, and, starting with the Orlando release, Internet Explorer, or Microsoft Edge. Instead, use Microsoft Edge-Chromium or one of the other supported browsers listed in Browser support. If you're using New York or an earlier release and you're using Internet Explorer 11 or Microsoft Edge with any workspace, such as ServiceNow® CSM Agent Workspace or ServiceNow® Vendor Manager Workspace, you must migrate to a newer browser before you upgrade to at least the Orlando release. See the Internet Explorer 11 Performance [KB0683275] article in the Now Support Knowledge Base for more information.

Service Owner Workspace overview

Manage and monitor your services with premium features. View service offering details in the workspace:
<table>
<thead>
<tr>
<th>Number</th>
<th>Agent Workspace feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1      | Tabs                    | The multi-tab interface enables you to easily navigate between service-related records.  
  • All services open in the **Services Home** tab.  
  • Associated service offering details open in subtabs. Drill down to the lowest hierarchical level to view details about all related service offerings. |
<p>| 2      | Form header             | The form header provides you with a quick summary of the service offering and an associated performance score. Estimated spend details appear in the form header when available. |
| 3      | Related items menu      | Service-related information is available to view in the related items menu. Click an item to see the related information. |
| 4      | Ribbon                  | Ribbon components display service offering performance score, customer satisfaction, and total subscriber trends. Estimated spend data is also viewable when available. |
| 5      | Form pane               | Additional service-related information is displayed as you scroll down the page and drill deeper into the data. Information includes, service-offering availability, |</p>
<table>
<thead>
<tr>
<th>Number</th>
<th>Agent Workspace feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>breached SLAs, customer satisfaction, stability, and activity.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Contextual side panel details</td>
<td>Unique data details are displayed. Click icons to display Outages, Critical Incidents, Change Requests, or Attachments details.</td>
</tr>
<tr>
<td>7</td>
<td>Contextual side panel</td>
<td>The contextual side panel displays unique data depending on which icon you select.</td>
</tr>
</tbody>
</table>

Integration with Common Service Data Model

Improve your measurement and evaluation by using services and offering references on multiple IT Service Management task forms, including:

- Problem
- Change
- Continual Improvement Management
- Incident

Directly reference a service offering as the target of a problem, change, or incident for consistency with the Common Service Data Model (CSDM). The system filters available offerings based on the service selected.

View and define the service model Model ID reference field on the Service and Offering forms to integrate with the CSDM.

Service Owner Workspace performance metrics

Service Owner Workspace includes a metrics model in the platform Service Portfolio Management Premium application for measuring the performance of services offerings. These performance metrics are then aggregated to services and taxonomy nodes via a weighting mechanism.

Metric Definitions

When activated, Service Portfolio Management Premium collects service offering metrics which permit calculations to roll up to parent services and taxonomy nodes for performance scores and other metrics. All metric configurations are performed in the platform application. Service owners can view these performance scores and metrics via Service Owner Workspace. The
following **Metric Definitions** are installed with the Service Portfolio Management Premium plugin (com.snc.spm):

**Activity**

The metric indicator is from service portfolio-related catalog activity. The metric is calculated from fulfilled request items derived from catalog items, which are connected to service offerings.

**Availability**

The metric indicator is Service Portfolio Management availability as calculated from outage records.

**Note:** If more than one Availability commitment exists for a service offering, at least one must be set as the Primary for trending purposes. Only one availability commitment is considered for performance score calculation, determined by the **Use in performance score** flag. Additional features include:

- Creation of Availability definitions specific to describe Availabilities for service offerings.
- Directly link a service offering commitment to an Availability definition.
- Maintain Availability statistics regarding outages.

**Breached SLA**

The metric indicator is from an SLA record, based on a breached SLA. Calculations depend on activation of the Service Portfolio Management SLA Commitments plugin (com.snc.service_portfolio.sla_commitment), which enables the following features:

- Creation of SLA definitions specific to describe the SLAs in place for service offerings.
- Directly link a service offering commitment to an SLA definition.
- Maintain SLA statistics regarding breaches.

**Note:** If more than one SLA commitment exists for an offering, at least one must be set as the Primary for use in performance scoring. Only one SLA commitment is considered for performance score calculation, determined by the **Use in performance score** flag.

**Customer Satisfaction**
Calculations are tabulated from surveys sent to unique subscribers to an offering.

**Critical Incidents**

The metric indicator is calculated from a combination of daily P1 and major incident counts. You will need to update the lower and upper boundary for this metric. For details refer to Service offering performance weighting.

<i>Note: </i>Prior to the Quebec release, the Critical Incidents metric was called Stability and was depicted as a single score widget on the Trends tab the workspace. The data currently appears as a time series chart. The default time frame for Service Owner Workspace metric performance is 30 days, except for the Critical Incidents metric, which shows all open major and P1 incidents per day.

**Service offering performance weighting**

Service owners can vary the inclusion and weighting of service offering metrics to reflect the business needs and perspectives of their stakeholders. Metrics are normalized and weighted to determine the performance of an offering. Metrics are only maintained for service offerings with an operational status. Weights must equal 100 percent.

To disable a service offering metric with unavailable or unreliable data from performance calculations, you can set the metric weight to 0 in the platform Service Portfolio Management Premium application.

Click the Edit Metric Weights Related Link on the Service Offering form to edit the upper and lower boundaries for each metric. The Maintenance pop-up window appears for you to customize per service offering. The upper and lower boundaries define how a metric is measured against a 0 through 100 percent scale and normalized together. To obtain a 100% score for negative metrics, such as for Critical Incidents, the score must be below or equal to the lower boundary.
Service offering to service performance weighting

Service owners can vary the inclusion and weighting of the service offering in service performance to reflect the business needs and perspectives of their stakeholders. Service offering performance is weighted and combined to determine the performance of a service. Only offerings with an operational status are used to contribute to service performance.

Set a service offering weight to 0 to disable it from the performance calculations of its parent service.

Click the **Edit Weights** Related Link on the **Services** form to edit the weights for associated offerings. Weights are valued against a 0 through 100 percent scale and normalized together.
Note: Upper and lower weight boundaries can be anything, from negative numbers to thousands of numbers. They do not have to be 0 to 100. But the outcome of the linear ranging math is to use those boundaries to make a normalized number between 0% and 100%.

For example, the normalization process dictates, that if you choose -20 and 150 as lower and upper boundaries, then anything at -20 or below will get normalized to 0% and anything at or above 150 will get normalized to 100%. Every number in between -20 and 150 is scaled to within the 0 through 100 range.

Another way to describe the normalization process is, for example, if you choose 5 and 150 as lower and upper boundaries and the metric is negative (minimize). With this metric anything below or equal to 5 gets a normalized score of 100%. Therefore, for a negative metric, the lower the raw score is, the higher the normalized score, which is capped at 100%. If you choose 5 and 150 as lower and upper boundaries and the metric is positive (maximize), then anything below or equal to 5 will get a normalized score of 0%.

Service to nodes performance weighting

Portfolio owners and editors can vary the inclusion and weighting of services in node performance to reflect the business needs and perspectives of their stakeholders. Service performance is weighted and combined to determine the performance of sublevel taxonomy nodes, also called child nodes.
Use the **Edit Weights** Related Link on the **Taxonomy Nodes** form to edit the associated service weights. Service weights are valued against a 0 through 100 percent scale and normalized together.

### Node to node performance weighting

Portfolio owners and editors can vary the inclusion and weighting of node in node performance to reflect the business needs and perspectives of their stakeholders. Node performance is weighted and combined to determine the performance of taxonomy parent nodes.

### Performance scores

The performance score for services and offerings are highlighted with a different color in Service Owner Workspace based on the configured threshold limit defined on the portfolio record.

- **Red**: Indicates the score is lower than the set threshold limit.
- **Amber**: Indicates the score is within the set threshold.
- **Green**: Indicates the score is higher than the set threshold limit.
Metrics configuration

To view or configure Service Owner Workspace metric definitions, refer to Configure Service Owner Workspace metric definitions.

To view or configure Service Owner Workspace portfolio metrics, refer to Configure Service Owner Workspace portfolio metrics.

Setting up Service Owner Workspace

Prepare for your Service Owner Workspace experience by activating necessary applications, accessing quick start tests to ensure proper functionality, and configuring metrics to monitor.

Integrate with other applications

After activating the Service Owner Workspace plugin (com.spm_owner_workspace), align with other ServiceNow applications to expand your service portfolio monitoring experience.

Service Owner Workspace is meant to work seamlessly with Vendor Manager Workspace. Often service owners are also vendor managers. For this reason, activation of the Vendor Manager Workspace application is useful. Toggling between the two workspaces is easy because they share the same interface. Simply click the Vendor Manager Workspace icon in the workspace to view vendor-related data.
Integrating with the Financial Management application provides estimated spend calculations based on fiscal periods and rolls spend data up from service offerings to associated services and taxonomy nodes within your portfolio. Estimated spend data is available to monitor and analyze in the workspace.

Refer to Service Owner Workspace integrations for complete details about applications that you can activate to add greater depth and value to your Service Owner Workspace monitoring experience.

**Metrics definition and configuration**

Monitoring your services involves metrics and scores that keep you apprised of how well your services are performing, how satisfied your customers are with the services you provide, and how many people are subscribing to your services. Defining metrics and applying the metrics to your portfolios, services, and offerings ensures an accurate and goal-oriented monitoring experience. You determine the upper and lower thresholds of service performance.

**Portfolio setup automations**

Choose from pre-built setup automations to apply to a portfolio to reduce your time creating services and offerings. Edit and update automations and scripts and define fields at the Service Portfolio record level which trigger when to run a script, or series of scripts.

- Automatically add five default metrics when you create a new service portfolio. You can choose not to add the metrics.
- Evenly weight all performance metrics for new offerings at the portfolio level. Each time an offering is created as part of a portfolio, the performance weight of each metric is evenly distributed. For example, each default metric is weighted at 20%.
If re-parenting a service to a different portfolio, offerings will automatically assume the metrics of the new portfolio and the weights when the **Evenly weight performance metrics for new offerings** is active when creating a new portfolio. This same logic applies when an offering is created.

**Note:** When you cannot evenly equal 100% across all metrics, use order to give the highest number the highest weight. For example, if you have seven metrics, you can weight the percentages as: 15, 15, 14, 14, 14, 14, 14. If you have three metrics, you can weight the percentages as: 34, 33, 33.

- Automatically create one-to-many offerings on a newly created service within a service portfolio or when adding a service to an existing service portfolio. The service must be associated with a service portfolio and it must not have any child offerings. When you activate this feature, a drop down field appears enabling you to choose how many offerings you want to create.

To activate these automations, refer to Create a service portfolio in Service Portfolio Management.

**Activate Service Owner Workspace**

The Service Owner Workspace plugin (com.spm_owner_workspace) is available as a separate subscription. It activates related plugins, including the Service Portfolio Management Premium plugin (com.snc.spm). Subscribing to Service Owner Workspace adds the service-owner user interface and premium functionality to your Service Portfolio Management environment.

**Before you begin**

Role required: admin

**About this task**

You can subscribe to Service Owner Workspace if your organization has purchased a Service Owner Workspace subscription. Refer to View the applications and plugins that are included with a subscription View subscription applications and plugins to verify if your company has purchased the subscription.
Note:

A subscription to Service Owner Workspace entitles you to Service Portfolio Management Premium. Service Owner Workspace automatically activates the Service Portfolio Management Premium plugin. The Service Owner Workspace plugin enables platform functionality, which provides access to all the data necessary for workspace effectiveness.

A subscription to Service Owner Workspace includes full access to Performance Analytics.

The Performance Analytics - Premium plugin (com.snc.pa.premium) is necessary for Service Owner Workspace feature functionality. It must be activated before you can activate the Service Owner Workspace plugin.

The Service Owner Workspace plugin (com.spm_owner_workspace) activates related plugins if they are not already active.

### Related plugins for Service Owner Workspace

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics — Premium [com.snc.pa.premium]</td>
<td>Adds the following functionality to Service Portfolio Management:</td>
</tr>
</tbody>
</table>
### Related plugins for Service Owner Workspace (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Note:** This plugin must be activated before activating the Service Owner Workspace plugin (com.spm_owner_workspace). | • Create indicators, breakdowns, and other records.  
• Create text analytics widgets.  
• Use Performance Analytics with external data.  
• Preserve performance scores beyond 180 days. |
| Service Portfolio Management Premium [com.snc.spm] | Collects service offering metrics and rolls these calculations up to parent services and taxonomy nodes for performance scores and other metrics viewed via Service Owner Workspace. |
| Service Portfolio Management Estimated Spend [com.snc.spm.spend] | Provides a simple cost model. |
| Agent Workspace - List [com.snc.agent_workshop.list] | Provides workspace list configurations. |
| Agent Workspace - Highlighted Values [com.snc.agent_workshop.highlighted_values] | Provides support for highlighted values in workspace. |
| Agent Workspace - Declarative Actions [com.snc.agent_workshop.declarative_actions] | Provides support for declarative actions in workspace. |
| Service Workspace [com.snc.service_workspace] | Provides the Service Workspace application. |
Several additional plugins offer increased functionality to Service Owner Workspace. Activate these plugins to enhance your monitoring experience.

### Additional plugins for Service Owner Workspace monitoring functionality

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Manager Workspace [com.snc.vlm.vmw]</td>
<td>Provides integration with the Vendor Manager Workspace as part of the Service Owner Workspace monitoring experience.</td>
</tr>
<tr>
<td>Continual Improvement Management CIM [com.sn_cim]</td>
<td>Enables display of existing CIM records in Service Owner Workspace when a service relation is indicated on associated forms. Service owners can initiate a CIM record to address a performance issue with a service or offering.</td>
</tr>
<tr>
<td>Incident Management - Major Incident Management [com.snc.incident.mim]</td>
<td>Provides a consolidated workbench to view major incidents via Service Owner Workspace.</td>
</tr>
</tbody>
</table>

**Note:** Users can also choose not to use the local cost model or the Financial Management model, by selecting **None** in the
Procedure

1. Navigate to **System Applications > All Available Applications > All**.

2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see **Request a plugin**.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*

**Related reference**

- **Installed with Service Owner Workspace**

**Related information**

- **List of plugins (New York)**

**Installed with Service Owner Workspace**

Service Owner Workspace automatically activates the Service Portfolio Management Premium plugin (com.snc.spm). Service Portfolio Management Premium installs the following components.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

**Service Portfolio Management Premium**

**Tables installed with Service Portfolio Management Premium**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric Definition [spm_metric_definition]</td>
<td>Used to define metrics for use in the Service Portfolio Management Premium application.</td>
</tr>
<tr>
<td>Service Offering Metric Data [service_offering_metric_data]</td>
<td>Used to configure service offering metric data. With this record you can:</td>
</tr>
</tbody>
</table>
Tables installed with Service Portfolio Management Premium (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Set boundaries within a service</td>
<td>offering performance score range.</td>
</tr>
<tr>
<td>• Set a weight value.</td>
<td></td>
</tr>
<tr>
<td>Portfolio Metric [spm_portfolio_metric]</td>
<td>Used to configure portfolio metric data.</td>
</tr>
<tr>
<td>SPM Node Weight [spm_node_weight]</td>
<td>Used to assign a weight value to a node in relation to the value of its</td>
</tr>
<tr>
<td></td>
<td>sibling nodes.</td>
</tr>
</tbody>
</table>

Quick start tests for Service Portfolio Management Premium

Validate that Service Portfolio Management Premium still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Service Portfolio Management Premium quick start tests require activating the Service Portfolio Management Premium plugin (com.snc.spm).

Service Portfolio Management Premium - ATF Tests test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portfolio Editor: Not Portfolio Owner, Read Only Taxonomy Access</td>
<td>Ensure a portfolio editor can only read associated non-owned portfolio taxonomies.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Portfolio Editor: Cannot create new Portfolios</td>
<td>Ensure a portfolio editor cannot create new portfolios.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Portfolio Editor: Valid Portfolio Owner Taxonomy Access</td>
<td>Ensure a portfolio owner has access to taxonomies within owned portfolios.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Service Editor: Access</td>
<td>Ensure a service editor can only edit owned services and offerings.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Portfolio Editor: Can Modify Owned Portfolios</td>
<td>Ensure a portfolio editor can modify and update owned portfolios.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Create a Portfolio</td>
<td>Ensure a portfolio admin can create a new portfolio.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Portfolio Editor: Cannot Modify Non-Owned Portfolios</td>
<td>Ensure a portfolio editor cannot modify non-owned portfolios.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Service Workflow</td>
<td>Verify that a service cannot move forward to Catalog phase without a service portfolio, taxonomy node, and service offering attached to it. Verify a service cannot move backward from the Catalog phase to the Pipeline phase.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Service Portfolio (Normal)</td>
<td>Create a service portfolio, taxonomy layer, and taxonomy nodes.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Create a Portfolio + 3 Taxonomy Layers</td>
<td>Create a service portfolio with three taxonomy layers.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Service Portfolio (Exception) - Taxonomy Layer Definition Set 01</td>
<td>Create a service portfolio, taxonomy layer, and taxonomy nodes.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>SPM: Create a Portfolio</td>
<td>Create a service portfolio.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Create a Portfolio + 3 Taxonomy Layers</td>
<td>Create a service portfolio, with three taxonomy layers.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Service Portfolio (Normal)</td>
<td>Create a service portfolio, taxonomy layer, and taxonomy nodes.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Service Portfolio (Exception) - Taxonomy Layer Definition Set 01</td>
<td>Create a service portfolio, taxonomy layer, and taxonomy nodes.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Portfolio Editor: Can Modify Owned Portfolios</td>
<td>Ensure a portfolio editor can modify portfolios that they own.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Portfolio Editor: Cannot Modify Non-Owned Portfolios</td>
<td>Ensure a portfolio editor cannot modify portfolios that they do not own.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Portfolio Editor: Cannot create new Portfolios</td>
<td>Ensure a portfolio editor cannot create new Portfolios.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Portfolio Editor: Valid Portfolio Owner Taxonomy Access</td>
<td>Ensure portfolio owners have access to taxonomies that they own.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Portfolio Editor: Not Portfolio Owner, Read Only Taxonomy Access</td>
<td>Ensure a portfolio editor can only read the taxonomies of portfolios they do not own.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Service Editor: Access</td>
<td>Ensure a service editor can only edit services and offerings that they own or are a delegate of.</td>
<td>Paris</td>
</tr>
</tbody>
</table>
## Service Portfolio Management Premium - ATF Tests test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPM: Service Viewer: Access</td>
<td>Ensure a service viewer has access to view services.</td>
<td>Paris</td>
</tr>
<tr>
<td>SPM: Service Workflow</td>
<td>Verify a service cannot move forward to Catalog phase without a service portfolio, taxonomy node, and service offering attached to it. Verify a service cannot move backward from Catalog to Pipeline phase.</td>
<td>Paris</td>
</tr>
</tbody>
</table>

### Related information

**Quick start tests**

## Service Owner Workspace Migration Dashboard

Service Owner Workspace provides a migration dashboard to support your transition from the legacy Service Portfolio Management structure to the enhanced application structure.

By viewing the **Migration Dashboard**, portfolio managers can quickly determine which existing services and offerings contain a deprecated structure or are considered orphaned in the enhanced Service Portfolio Management taxonomy structure.

Users with the following assigned roles can view the Service Portfolio Management dashboard:

- `service_viewer`
- `portfolio_admin`

Users with the portfolio_admin or service_editor role can modify services and service offerings to structurally comply with and migrate to the Service Portfolio Management Foundation application.
By default, the dashboard displays reports for all existing service portfolios. An interactive filter enables you to choose a single portfolio to view. The dashboard reports are visible even if there are no service portfolios defined.

Dashboard report categories display the number of related identified migration issues. If there are no migration issues identified for a report category, a 0 is shown.

Access the dashboard by navigating to Service Portfolio Management > Migration Dashboard. To view detailed information, hover over any report graphic. All report graphs can be refreshed for the latest data.

Migration issues are indicated when a number graphic greater than zero is indicated on the report. For these reports, hover over and click the number graphic. A list opens displaying the services or offerings that require modification to migrate to the Service Portfolio Management Enterprise structure.

The following reports are available on the Migration Dashboard. If migration issues are indicated, refer to the report description and how to remedy the issue for migration.

<table>
<thead>
<tr>
<th>Migration Dashboard report</th>
<th>Description and migration task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deprecated Operational Status Used for Offerings</td>
<td>Indicates the number of existing service offerings using the deprecated singular status of Operational Status. Modify these offerings by filling in both the Phase and Status fields on the Service Offering form.</td>
</tr>
<tr>
<td></td>
<td>Note: Status can be one of several choices, such as Design, Development, Build/Test/Release, Operational, and Retiring.</td>
</tr>
<tr>
<td></td>
<td>Click Update.</td>
</tr>
<tr>
<td>Deprecated Operational Status Used for Service</td>
<td>Indicates the number of existing services using the deprecated singular status of Operational Status. Modify these services by filling in both the Phase and Status fields on the Service form.</td>
</tr>
<tr>
<td>Migration Dashboard report</td>
<td>Description and migration task</td>
</tr>
<tr>
<td>----------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image.png" alt="Image" /></td>
<td><strong>Note:</strong> Status can be one of several choices, such as Requirements, Definition, Analysis, Approved, and Chartered. Click <strong>Update</strong>.</td>
</tr>
<tr>
<td>Operational Services not in a Portfolio</td>
<td>Indicates the number of existing services not currently associated with a portfolio. Modify the <strong>Service</strong> form by selecting a portfolio in the <strong>Service portfolio</strong> field. Click <strong>Update</strong>.</td>
</tr>
<tr>
<td>Orphaned Services in Catalog Phase</td>
<td>Indicates the number of services in Catalog phase that do not have a parent taxonomy node. Modify the <strong>Service</strong> form by selecting a taxonomy node in the <strong>Taxonomy node</strong> field. Click <strong>Update</strong>.</td>
</tr>
<tr>
<td>Deprecated Usage of Service Catalog Entry</td>
<td>Indicates the number of services or offerings linked to a catalog item via the deprecated <strong>Service Catalog Entry</strong> (sc_cat_item_service) table.</td>
</tr>
<tr>
<td>Orphaned Service Offerings</td>
<td>Indicates the number of service offerings where the <strong>Parent</strong> field on the <strong>Service Offering</strong> form is not pointing to a parent service. Offerings must be children of a service. In the <strong>Parent</strong> field on the <strong>Service Offering</strong> form, search for and select the associated service. Click <strong>Update</strong>.</td>
</tr>
<tr>
<td>Cataloged Non-operational Offerings</td>
<td>Indicates the number of active catalog items connected to service offerings not in the catalog phase or with an operational status. Modify the <strong>Service Offering</strong> form <strong>Phase</strong> field to <strong>Catalog</strong> and the <strong>Status</strong> field to <strong>Operational</strong>. Click <strong>Update</strong>.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.  
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Migration Dashboard report</th>
<th>Description and migration task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Services in Catalog Phase without Offering</td>
<td>Indicates the number of services in the Catalog phase without at least one associated service offering. An offering must be defined for a service to move into Catalog phase. To associate a service offering to a service, open a specific service offering associated with the cataloged service indicated in the Migration Dashboard. In the Parent field on the Service Offering form, search for and select the associated service. Click Update.</td>
</tr>
</tbody>
</table>

**Service Owner Workspace integrations**

Align with other product applications to add value to your Service Owner Workspace monitoring experience.

**Service Owner Workspace and product alignment**

Activate and integrate with these products to expand the functionality of Service Owner Workspace:

**Vendor Manager Workspace**

Activate the Vendor Manager Workspace plugin (com.snc.vlm.vmw) to align this workspace data with Service Owner Workspace.

Manage your vendors from the same workspace interface to effectively gain knowledge of all vendor-related information.

Monitor and view vendor performance reports from the workspace view.

Decide what vendor metrics to monitor and manage in workspace view.

Calculate and view vendor CSAT weight and vendor service offering performance weight.

**Financial Management**

Activate the Service Portfolio Management Estimated Spend plugin (com.snc.spm.spend) to view service offering spend, enabling
you to select between your local cost model and the cost model provided by the Financial Management application.

Activate the Financial Management for SPM plugin (com.snc.financial_management_for_spm) to provide preconfigured service offering cost models to view in . Select between your local cost model and the Financial Management application model, when used.

Continual Improvement Management (CIM)

Display existing CIM records in Service Owner Workspace when a service relation is indicated on associated forms.

Service owners can initiate a CIM record when a performance issue with a service or offering is displayed.

Incident Management — Major Incident Management

Activate the Incident Management - Major Incident Management plugin (com.snc.incident.mim) to provide a consolidated workbench to view major incidents via the Service Owner Workspace activity stream.

Integration with Common Service Data Model

Improve your measurement and evaluation by using services and offering references on multiple IT Service Management task forms, including:

- Problem
- Change
- Continual Improvement Management
- Incident

Directly reference a service offering as the target of a problem, change, or incident for consistency with the Common Service Data Model (CSDM). The system filters available offerings based on the service selected.

View and define the service model Model ID reference field on the Service and Offering forms to integrate with the CSDM.

When the Service Portfolio Management Premium plugin (com.snc.spm) is activated with CSDM is applied, the navigational pane includes the modules Manage Technical Services and Sell and Consume. Service offerings with associated catalog items are available to view and manage via Technology Request Catalog and Business Request Catalog within these modules. For complete information about CSDM and how it relates to Service Portfolio Management Premium, refer to Common Service Data Model.
Configure Service Owner Workspace metric definitions

Configure unique metric definitions to measure the performance of your service offerings in Service Owner Workspace.

Before you begin
Role required: admin or portfolio_admin

About this task

Service Owner Workspace includes several metric definitions which you can view and edit, if necessary. You can also create new metric definitions unique to your desired performance monitoring needs.

Procedure

1. Navigate to Service Portfolio Management > Configuration > Metric Definitions.
2. View the available base system metric definitions and associated indicators.
3. To create a unique metric definition, click New.
   The Metric Definition form opens.
4. Provide a unique name for the metric definition in the Name field.
5. Select a Performance Analytics indicator in the Indicator field.
6. Click Submit.
   For more information about metrics and weight configuration, refer to Service Owner Workspace performance metrics.

Configure Service Owner Workspace portfolio metrics

Decide which metrics to configure for your service portfolio to measure the performance of your service offerings in Service Owner Workspace.

Before you begin
Role required: admin or portfolio_admin

About this task
Procedure

1. Navigate to **Service Portfolio Management > Configuration > Portfolio Metrics**.
2. Click an existing service portfolio to learn what metrics are associated. The Portfolio Metrics list opens displaying all the metrics applied to the service portfolio.
3. To add an additional metric to the service portfolio, click **New**.
4. Fill in the form fields.

**Portfolio Metric form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service portfolio</td>
<td>Select the service portfolio for which you want to create a metric</td>
</tr>
<tr>
<td>Metric</td>
<td>Select the metric to apply. Choices include: <strong>Activity</strong>, <strong>Availability</strong>, <strong>Breached SLA</strong>, <strong>Customer Satisfaction</strong>, and <strong>Critical Incidents</strong>.</td>
</tr>
<tr>
<td>Order</td>
<td>Specify the display order of the trend chart on the <strong>Trends</strong> tab in Service Owner Workspace.</td>
</tr>
<tr>
<td>Trend chart</td>
<td>Check the box to display this metric on the <strong>Trends</strong> tab in Service Owner Workspace.</td>
</tr>
<tr>
<td>Performance calculation</td>
<td>Check the box to use this metric in the service offering performance calculation.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

For more information about metrics and weight configuration, refer to **Service Owner Workspace performance metrics**.

**Generate a service offering availability**

Generate on-demand availability reports displayed in Service Owner Workspace. When a service commitment contains an availability guarantee, the service offering displays an availability report.

**Before you begin**

Role required: service_editor
About this task

Availability records are generated by a daily job when you select an Availability type service commitment for your service offering. By defining service offering availability, you generate reports that track the actual availability of the offering. For a 7-day chart, no reporting data is available until five days after the service offering is created. For 30-day charts, 23 days of data is required before a report is generated. For a 12-month chart, the database must contain at least 10 months of data.

Procedure

1. To generate a new service availability, navigate to Service Portfolio Management > Availability and click New.

⚠️ **Note:** When an Availability commitment type is added to a service offering, it will generate a year’s worth of availability records for that offering and commitment. For this reason, existing Availability forms should not be edited. Availability is calculated based on the outages in the system for that offering. If an outage is updated, then the related availability records are updated too.

2. Fill in the form fields.

**Service Availability form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Enter the name of the service availability as it appears in record lists. Automatically set at record creation based on service offering and commitment.</td>
</tr>
<tr>
<td>Service offering</td>
<td>Select the service offering for which you want to generate an availability record.</td>
</tr>
<tr>
<td>Service commitment</td>
<td>Select the service commitment to apply the availability record.</td>
</tr>
<tr>
<td>Start</td>
<td>Choose the start of this availability interval.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>End</td>
<td>Choose the end of this availability interval.</td>
</tr>
<tr>
<td>Committed uptime</td>
<td>Enter the total expected service availability for this commitment.</td>
</tr>
<tr>
<td>Acceptable downtime</td>
<td>Enter the acceptable amount of downtime against this commitment schedule for this interval.</td>
</tr>
<tr>
<td>Total downtime</td>
<td>Enter the wall-clock downtime, independent of schedule.</td>
</tr>
<tr>
<td>Met commitment</td>
<td>Availability commitment was met for this interval. Check to indicate the commitment was met.</td>
</tr>
</tbody>
</table>

**Note:** The following fields display SLA result data when available:

- **Total availability %** — Availability percentage for the entire interval, independent of schedule.
- **Total outages** — Total number of outages in this interval, independent of schedule.
- **Commitment availability %** — Availability percentage within this commitment schedule.
- **Commitment downtime** — Downtime that counts against this commitment schedule.
- **Commitment outages** — Number of outages against this commitment schedule in this interval.

3. Click **Submit**.
   View service offering **Availability** reports in Service Owner Workspace.

### Change scope to Service Portfolio Management Premium

Grant access to a dedicated user to enable switching the scope from Global to Service Portfolio Management Premium to create a custom automated indicator.

**Before you begin**
Role required: admin
About this task

Both the indicator and the job must be in the same scope. Provide a user with delegated developer access and the pa_admin role to change the scope from Global to Service Portfolio Management Premium when creating custom indicators for Service Portfolio Management Premium jobs.

Procedure

1. In the Navigator, type `sys_scope.list` and press Enter. The Applications list appears.
2. Search by name for Service Portfolio Management Premium and click the application name to open the associated Store Application form.
3. In Related Links, click Manage Developers.
4. Search for the user or group you want to grant delegated developer access to. The Permissions configuration screen appears.
5. Configure delegated developer access for the user or group.
a. In the **File Type Access** section, toggle the **Reporting** category radio button to grant this type of access.

b. Click **Save**.
Grant access to any other section category by toggling the associated radio button.

6. Assign the `pa_admin` role to the user or group with delegated developer access.

### Create indicators in Service Portfolio Management Premium

Create custom indicators for your Service Portfolio Management Premium jobs in the correct scope.

**Before you begin**
Role required: `pa_admin`

**About this task**

You must have the Reporting file type delegated developer access to change the scope from Global to Service Portfolio Management Premium when creating custom indicators for the application. Administrators grant the Reporting file type delegated developer access. For information regarding obtaining delegated developer access, refer to Create indicators in Service Portfolio Management Premium.

When you create an indicator and associate it with a job in an application, both the indicator and the job must be in the same scope. Jobs and indicators available in the Service Portfolio Management Premium base system are in the correct Service Portfolio Management Premium scope. However, when you create a custom indicator, by default it is created in the Global scope. To associate a custom indicator with a Service Portfolio Management Premium job, you need to first change the scope from Global to Service Portfolio Management Premium.
Procedure

1. Click the Settings icon in the banner.

2. In System Settings, click Developer.

3. In Application, find and select Service Portfolio Management Premium.

4. Navigate to Performance Analytics > Indicators > Automated Indicators and click New to create an indicator in the Service Portfolio Management Premium scope.

   For details on how to create an automated indicator, refer to Create an automated indicator.

Using Service Owner Workspace

Use Service Owner Workspace to monitor the health of your services and your customer satisfaction. View outages, critical incidents, and change requests associated with services and offerings.

With Service Owner Workspace you can monitor metrics and analyze the health of your services from a single user interface. Get to know how metric models are
created and configured for service offerings and how they are used in Service Owner Workspace.

**Service Owner Workspace features**

Service Owner Workspace features include:

- A view-only, multi-tab interface for monitoring and managing multiple portfolios and related services.
- Dashboards offer immediate access to portfolio and service health and performance metrics, as well as who owns and manages the service.

**Note:** In most cases, data is collected up to the previous day. If there is a current outage or incident, then data does not appear in trend charts or displays.

- Comprehensive layout of all information related to a portfolio and its component services.

Service owners can access the workspace to perform their most common tasks, including:

- View and manage owned IT services, as well as view all IT services the business manages.
- Expand service lists to expose child services and service offerings.
- Select a service to access pertinent information, including service trends, related services and information, improvement initiatives, and associated service offerings.
- View and monitor service performance score reports, customers' scores, and total subscribers.
- Monitor recent and upcoming changes.
- Drill down into service offerings to view availability, SLA compliance, customer satisfaction, offering stability, performance scores, and more.
- View associated unique or critical information about the service offering in the impact stream panel on the right side of the workspace. For example, you can view outages records with a unique **Outage Number** identifier. You can also
see the outage number on the list view for outages via the Outage tab in the report viewer.

⚠️ Note: The Outage Numbering plugin (com.snc.outage_numbering) must be activated to introduce number data. The plugin is automatically activated for all instances and upgrades except those that already have a number prefix column on the Outage table. Refer to the Activate Outage Numbering plugin [KB0823685] article in the HI Knowledge Base or contact Customer Service and Support if the plugin is not active and you want to move to the base system field.

System administrators can configure the workspace according to the specific needs within the organization:

- Disable particular metrics from displaying in the workspace.
- Configure the metric weights that contribute to performance scores within the workspace.
- Configure the metric thresholds for each metric that displays in the workspace.

Start here: Access Service Owner Workspace.

Access Service Owner Workspace

Open the Service Owner Workspace to access and display all your portfolios and services at a single location. Monitor and manage your services and offerings from the workspace.

Before you begin
Role required: service_viewer

About this task

To access and use Service Owner Workspace, the Service Owner Workspace plugin (com.spm_owner_workspace) must be activated and you must be assigned the Service Viewer [service_viewer] role.

Procedure

1. Navigate to Service Portfolio Management > Service Owner Workspace.
2. Click a portfolio name to expand the layers of services.
3. Click **My Services** to view portfolios that you own and manage. Or click **All Services** to view all the services your organization owns and manages. A list of services displays. You can expand each service to see child services within the service taxonomy.

4. Click a service name to view pertinent information about the service. The **Overview** dashboard provides a recent snapshot of the service offering performance. View performance over the last 7 days. The **Additional Node Info** sidebar displays who owns and manages the service, as well as the associated **Performance score**, **Taxonomy Nodes** (services), and **Estimated spend** if available.

To contact a service owner, service offering owner, or associated manager, click the person's name in the workspace and then click the associated email. Phone numbers are also displayed for quick access to service stakeholders.

5. Choose how to group and sort dashboard data in the **Group by** and **Sort by** lists.
   You can group by **No grouping** or **Taxonomy node owner**. You can sort by **Ascending**, **Descending**, **Node weight**, **Performance score**, or **Name**.

6. Click a **Taxonomy Node** (service) to view pertinent information about the service.
   The associated service displays in the **Overview** tab.

7. Click in the **Service** card to drill deeper into the details and view health and performance metrics, as well as any associated service offerings.
   Service health and performance metrics, such as **Service Performance Score**, **Customer Satisfaction**, **Total Subscribers**, **Estimated spend**, and associated **Service Offerings** are displayed.
8. Click additional tabs besides the **Overview** tab to display data relevant to the offering, including:

- **Trends** — View performance over a specified time frame, as well as SLA compliance. The **Trends** tab provides you with a more strategic view of service and offering performance over a longer period of time, so you can determine if performance is trending up or down. The base system includes performance metrics for **Activity**, **Availability**, **Breached SLA**, **Customer Satisfaction**, and **Critical Incidents**. The default time frame for **Trends** performance is 30 days, except for the **Critical Incidents** metric, which shows all open major and P1 incidents per day. Use the drop down menu to change the time frame if desired. Choices include as few as the last 7 days to the last year.

  **Note:** Prior to the Quebec release, the **Critical Incidents** metric was called **Stability** and was depicted as a single score widget. The data is now visualized in a time series chart. You need to set the lower and upper boundaries for the **Critical Incident** metric. For details, refer to [Service Owner Workspace performance metrics](#).

- **Relationships** — View service dependency details. This tab shows offering relationships, for example, which services a service depends on and which services depend on it. View the **I depend on** and **Depends on me** sections to see service offering dependencies at the parent service level via a card with a highlighted label reading **Inherited relationship**.

  **Note:** Dependencies that a service inherits from a child offering are visually distinct from dependencies defined directly between services.

Service and offering types are distinguishable in the card by a unique icon and label specifying the type of service and offering. For example, **Business Service**, **Application Service**, and **Technical Service**. When you click on an offering card, the record view of the offering is displayed.
• **Info** — View the service offering description, performance breakdown, general information, commitments, team, and more. You can also view your service offering to catalog item relationships via this tab. Click to open a catalog item to drill down into more details.

Monitor fulfilled requests for all associated catalog items in the **Offering Activity** metric. For complete details about service offerings and associated catalog items, refer to [Service offering to catalog item relationships](#).

**Note:** The **Create Catalog Item** action is only available when there is no catalog item mapped to a service offering and there is no catalog item with the same name as the offering. This prevents the issue of having catalog items with the same name.

• **Improvement Initiatives** — View all CIM initiatives as links to the records. This tab displays with activation of the Continual Improvement Management (CIM) plugin (com.sn_cim).

9. Click icons in the impact stream panel, on the right side of the workspace, to display related information about **Outages, Critical Incidents, Change Requests, or Attachments** details.

View the associated unique or critical information about the service offering in the impact stream.

10. Click an outage, critical incident, or change request to drill deeper into the details.

Once you click an impact stream item, for example, a critical incident, you can view all details related to the item and even open the associated record by clicking **Open record**.

Recent, current, and upcoming outage data is available. Click a type of outage for the information you want. Refer to **Outages** for information about a unique **Outage Number** identifier and activating the Outage Numbering plugin (com.snc.outage_numbering).

11. If the service you are viewing has associated child offerings, click an offering to drill down and view details.
View the offering overview, as well as other pertinent data, such as service offering availability, breached SLAs, customer satisfaction, stability, and activity. Available service offering tabs include, Overview, Trends, Relationships, Info, Catalog Items, and Improvement Initiatives. These tabs similar data as is provided for services. The Catalog Items tab displays all catalog items related to the service offering, as well as a short description of the item.

Service offering to catalog item relationships

Manage the relationships between your service offerings and catalog items by associating your pre-existing catalog items to your service offerings and vice versa. View relationships in both Now Platform form related lists and Service Owner Workspace.

Required roles and actions

Service owners and catalog administration managers can edit relevant forms to associate and manage pre-existing service offering to catalog item relationships. This feature is in addition to the Create Catalog Item feature that enables you to create a new catalog item.

With the service_editor role, you can add, change, and remove catalog items associated with an owned service offering via the Service Offering form Catalog Item related list. You can also create a catalog item from a service offering via Service Owner Workspace by clicking the Create Catalog Item link. A single service offering may have many related catalog items. Click the Link button in the Catalog Item related list to make a change.

Note: If a catalog item is already associated with a service offering, you cannot associate the item to a new offering. You will have to contact a catalog_admin to remove the existing association so that you can make changes.
With the catalog_admin role, you can add, change, and remove service offerings associated with a catalog item via the Catalog Item form Service Offerings related list. A single catalog item can be related to one service offering.

Click the Link button in the related list to make a change. You can remove the association if needed with the related list Delete button.

Note: If a service offering is already associated to a catalog item, the Link button does not appear in the related list. For details about viewing and editing Catalog Items, refer to Create or edit a catalog item.

Catalog items in Service Owner Workspace

View catalog items related to a service offering in Service Owner Workspace from the offering page Catalog Items tab. Click to open a catalog item to drill down into more details and even open up the form view.

Monitor fulfilled requests for all associated catalog items and order guides in the offering Trend tab Activity metric.

Hover over the Trends tab Activity metric to view both the catalog item name and the 30 day average running count.

When you click the trend line for an individual catalog item, only Requested Items for that catalog item and the offering are visible on the list view of the report viewer.

Things to keep in mind

• Avoid model phase conflicts between offerings and catalog items.
  ◦ Catalog items can only be associated to service offerings in the Catalog phase.
  ◦ The service offering must be operational for catalog items to be active.
  ◦ Inactive catalog items can be associated to operational service offerings.

• Order guides are not referenced as associated items.
  ◦ In Service Owner Workspace, Activity metrics are driven by catalog items that compose an order guide.

Service Portfolio Management Premium notifications

Notifications are added with Service Portfolio Management Premium to manage your service offering to catalog item relationships.
Service Portfolio Management Premium includes several email notifications that alert catalog admins when a service offering associated with a catalog item is retired or when a new catalog item has been created from a service offering.

The following notifications are included:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offering retired</td>
<td>Sends an email to a specified user group when a service offering that is associated with a catalog item is retired.</td>
</tr>
<tr>
<td>Table: Service Offering [service_offering]</td>
<td></td>
</tr>
<tr>
<td>Catalog Item created from Offering</td>
<td>Sends an email to a specified user group when a new catalog item has been created from a service offering. The email asks that the new catalog item be reviewed and prepared for activation in the catalog.</td>
</tr>
<tr>
<td>Table: Available for Subscribers [sc_cat_item_subscribe_mtom]</td>
<td></td>
</tr>
</tbody>
</table>

To configure catalog_admin recipients for these notifications, refer to Create a user group.

**Service Owner Workspace Service Offering survey**

Subscribers can rate their experience with service offerings via the Service Portfolio Management Premium Service Offering survey. This feedback provides portfolio managers and service owners with valuable information to improve service offering performance and subscriber satisfaction.

In the base system, a predefined SPM Service Offering Survey is available. Surveys are sent for operational and retiring service offerings only. Portfolio admins [portfolio_admin] can edit the survey and service editors [service_editor] can configure the associated trigger conditions.

You must have the admin or portfolio_admin role to modify the SPM Service Offering Survey. To view the survey, navigate to Survey > View Surveys.

The SPM Service Offering Survey is triggered randomly for 10% of service offering subscribers. Only subscribers who have not been polled within the previous three-month time period can receive a survey. Subscribers receive an email with the survey link. The service offering name is displayed and the survey inquires how satisfied the subscriber is with the service or service offering. Subscribers
use radio buttons to rate satisfaction on a 1 through 5 scale, with 1 being not satisfied and 5 being very satisfied.

You are encouraged to modify the survey to better match your organization’s needs.

Two system properties determine the percentage of subscribers to receive the survey and how often a subscriber is polled.

- **sn_spm.csat.survey_probability**: Default value is 10% of subscribers are randomly polled.
- **sn_spm.csat.survey_period**: Default value is 90 days. The system does not send a survey to a subscriber who has been polled within the previous 90 days.

Service owners can use the Service Offering form to define how often to send a CSAT survey. The **CSAT survey frequency** field offers the following frequency choices:

- **Never** (default)
- **Daily**
- **Weekly**
- **Monthly**

Service owners can view the last time a survey was sent for an offering in the **CSAT survey last sent** field on the Service Offering form.

Portfolio managers and service owners can review responses and view vendor CSAT weight in Service Owner Workspace.

For more detailed information about working with surveys, trigger conditions, and survey questions, see **Survey Management**.

### Financial Management for Service Owner Workspace

Integrate Service Owner Workspace with Financial Management to access preconfigured service offering cost models. You can use these cost models to evaluate expenses and generate cost lines based on the level of service offering for a defined cost.

---

### Activation and features

Activate the Financial Management for SPM plugin (com.snc.financial_management_for_spm) to access the preconfigured, base
system models. Financial Management for SPM contains demo data and activates related plugins if they are not already active.

The Service Portfolio Management Estimated Spend plugin (com.snc.spm.spend) is available to enhance your Service Owner Workspace experience. With this feature, you can choose to use the default local service offering cost model or access the cost models offered via the Financial Management application.

When Service Owner Workspace (com.spm_owner_workspace) and Financial Management for SPM (com.snc.financial_management_for_spm) are activated and the sn_spm_spend.offering_cost_source system property is set to the value Financial Management the Estimated Spend form section displays the fields Estimated annual spend, FM aggregated period, and FM aggregated cost. These fields reveal read-only data stored on the service offering, service, and taxonomy records.

View calculated spend per offering in Service Owner Workspace

When you choose to use the cost models offered via the Financial Management application, calculated spend per service offering is displayed as a single score widget in Service Owner Workspace. View Estimated Spend as part of the Overview dashboard displaying associated service offering health and performance metrics.

Service offering spend estimates are combined and summed up per period to the service and portfolio levels within your portfolio taxonomy. Estimated spend at the service and portfolio level enables you to better understand costs and how this aligns with performance throughout your service portfolio. With the estimated spend feature, you can:

• Balance your required service performance with the appropriate spend.
• Compare similar services by weighing spend to performance.
• Verify whether service spend is meeting your desired goals.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• View cost drivers within your service portfolio and the taxonomy structure.
• Compare an internal service spend to external service provider options.

**Local model compared to Financial Management model for estimated spend**

Estimated spend calculations run daily as a separate job.

When the system property `sn_spm_spend.offering_cost_source` = **Local Model**, the estimated annual spend for a service offering, service, and taxonomy is determined by adding the estimated annual spends for all child entities. Estimated annual spend data is stored on the service offering, service, and taxonomy records.

When the system property `sn_spm_spend.offering_cost_source` = **Financial Management**, the estimated spend for a service offering, service, and taxonomy is determined by adding the Financial Management estimated spends for all child entities.

For each node, determine the Financial Management estimated spend for the currently selected Financial Management period by adding all the child entity estimated spends. This happens recursively up the entire taxonomy structure, starting with the service offering, to the service, to the taxonomy.

For detailed information about integrating with Financial Management and configuring costing for a service offering, refer to **Financial Management for licensed SPM users**.

**Configure the estimated spend offering cost source**

Define the source used to calculate the estimated cost for service offerings. You can use the default local model or access the preconfigured Financial Management service offering cost models.

**Before you begin**

Role required: admin

**About this task**

---

The Service Portfolio Management Estimated Spend plugin (com.snc.spm.spend) is automatically activated with Service Owner Workspace.
Activate the Financial Management for SPM plugin (com.snc.financial_management_for_spm) to enable the associated cost model.

Service Portfolio Management Estimated Spend provides the `sn_spm_spend.offering_cost_source` system property. With this property, you can define the source used to calculate the estimated cost for service offerings. Values include:

- **Local Model**
- **Financial Management**
- **None**

The default value is **Local Model**.

**Procedure**

1. Enter `sys_properties.list` in the navigation filter to open the System Properties [sys_properties] table.
2. Find the `sn_spm_spend.offering_cost_source` system property and set it to the desired value.

**Note:** Users can choose not to use the local cost model or the Financial Management model, by selecting **None** as the desired value.

<table>
<thead>
<tr>
<th>Estimated spend offering cost source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Value</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Local Model</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>With this default source, the offering Estimated Spend cost is calculated based on the following fields on the Service Offering form:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Cost model</strong>: Choices include, Fixed and Per unit.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Estimated spend</strong>: The estimated cost of the offering for the associated time period.</td>
</tr>
<tr>
<td></td>
<td>When the <strong>Cost model</strong> value is <strong>Fixed</strong>, additional fields appear on the Service Offering form, including: <strong>Offering cost</strong>, <strong>Time period</strong>, and <strong>Cost Unit</strong>.</td>
</tr>
<tr>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>When the Cost model is Per Unit</strong>, additional fields appear on the Service Offering form, including: Offering cost, Time period, Units per period, and Cost Unit.</td>
<td></td>
</tr>
</tbody>
</table>
| **Financial Management** | With this source, the offering Estimated Spend cost is calculated based on the following Service Offering form fields, as calculated by the Financial Management application:  
  - **FM period**: Fiscal calendar period.  
  - **FM cost**: The actual currency amount. |
| None                  | With this value, or any incorrect values, the system ignores both the local and Financial Management cost models and does not display associated Service Offering form fields. |

3. Click **Update** to save any changes.

**Service Builder**

ServiceNow® Service Builder provides a guided experience workflow to create and maintain services and offerings.

Service Builder enables you to create and maintain definitions of your business and technical services and offerings through a guided experience. You can edit service definitions at any time before you publish as well as update already published services using version control.
How does Service Builder work?

When you launch Service Builder, you can create a service from the Dashboard tab or you can review and edit a list of your services and service offerings from the Services tab.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard</td>
<td>The default landing page where you can create a business service or a technical service. You can also view services that you interacted with in the last few days from the dashboard view.</td>
</tr>
<tr>
<td>Services</td>
<td>You can view a list of all services along with their state, classification, phase, status, and owner. If you have editing access to the services and service offerings, you can edit them from this tab.</td>
</tr>
</tbody>
</table>

Contextual guidance walks you through the process of creating your service. When you create a service, the contextual guidance assists you as you add values in the following subtabs:

- Details: Provide the minimal details of the service.
- Team: Create your service team members to identify accountable people for the overall service, including stakeholders.
• Manage offerings: Create and define new offerings of the service. Here is where you associate commitments, catalog items, dependencies, and financials for the service.

• Review and publish: Review your service and its offerings and make changes if necessary. Then, publish your service.

You can modify your services and offerings at any time. You can even duplicate them (create a copy) to edit the services as needed so that you can create other services and offerings quickly. Once you are modifying a service or an offering, the published version stays active until the draft that you are working on becomes the new published version.

Service item states
A service goes through various states during the creation and maintenance process.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
</table>
| Draft | A service item is in the Draft state in one of these scenarios:  
• A new service or offering is being created in Service Builder.  
• An existing published service or offering that has been checked out for editing in Service Builder. When the item is being edited, Service Builder checks out the item and creates a copy of the item and its associated records (offerings and subscribers). The item copy is in the Draft state and has a red dot next to it. The published item remains in the Published state and the Checked out field is set to True. Once the editing is done and the item is submitted, the edits to the draft item are merged with the associated published item and the draft item is deleted. |

Note:

◦ You can only edit a draft service but not a published service that has been checked out.

◦ A draft service is always inactive and does not show up in the search or browse experience.

◦ You cannot modify the Active flag of a draft service.

◦ Any changes to the draft service are not available until it is submitted.
### State Description

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Published</td>
<td>When a new service is submitted, the item then moves to the Published state. This state indicates that it is the service version being used by the application and available for others. When you edit a published service, it is checked out in Service Builder and the service’s draft copy is created.</td>
</tr>
</tbody>
</table>

### Roles installed with Service Builder

Roles are added to Service Builder with the activation of ServiceNow® Service Portfolio Management.

### Roles

⚠️ **Note:** Service Builder is a feature of Service Portfolio Management. Its plugin (com.snc.service_builder) is activated from the base system and activates related plugins if they are not already active. The following role definitions are part of Service Portfolio Management but are used in conjunction for Service Builder.

Service Builder uses these roles.

### Roles installed with Service Builder

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
</table>
| Portfolio manager [portfolio_admin] | Enables users to set up, create, duplicate, edit, and delete services and service portfolios. | • portfolio_editor  
• service_admin  
• service_author  
• service_editor  
• service_viewer |
| Portfolio owner [portfolio_editor] | Enables users to create, duplicate, edit, and delete service portfolios. | • portfolio_editor |
| Service admin [service_admin] | Enables users to set up, create, duplicate, edit, and delete services and service offerings. | • None |
| Service author [service_author] | Enables users to create, duplicate, edit, and delete services and service offerings of which they are an owner or have created. | • None |
Roles installed with Service Builder (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service editor</td>
<td>Enables users to edit services and service</td>
<td>• None</td>
</tr>
<tr>
<td>[service_editor]</td>
<td>offerings.</td>
<td></td>
</tr>
</tbody>
</table>

Create a service

Create a service in Service Builder to model, map, and document your own business and technical services and offerings that relate to your data in Service Portfolio Management.

Before you begin
Role required: service_admin, service_author, service_editor, portfolio_admin, or portfolio_editor

About this task
The Service Builder framework offers you the option to create a business service or a technical service. Once you select the type of service that you want to create, the workflow guides you through the process of adding information in a logical order:

1. Details
2. Team
3. Manage Offerings
4. Review and Publish

Procedure
1. Navigate to Service Portfolio Management > Service Builder.
2. From the landing page, select the type of service that you want to create - Business or Technical.
3. Review the Getting Started screen, and then click Continue.
4. On the form, fill in the fields.

Details form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service name</td>
<td>Unique name that reflects the nature of the service. The name should be technology agnostic.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Consumer type</td>
<td>Definition of who the service is to be provided for.</td>
</tr>
<tr>
<td>Portfolio</td>
<td>A hierarchical categorization of services that enables you to organize your services and report on them at each level of the portfolio taxonomy.</td>
</tr>
<tr>
<td>Node</td>
<td>Taxonomy nodes enable you to organize and categorize services in your portfolio. Services can only be added to the lowest level taxonomy node of the portfolio.</td>
</tr>
<tr>
<td>Phase</td>
<td>The phase for the service that you are creating.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Pipeline</strong>: The service is being designed and a business case is being created.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Catalog</strong>: The service has been approved and it is now being designed or is operational.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Retired</strong>: The service is no longer in operation.</td>
</tr>
<tr>
<td>Status</td>
<td>A unique status workflow that enables you to track each step of the service life cycle.</td>
</tr>
<tr>
<td>Description</td>
<td>A concise description of your service to verify that it makes sense to the end user or consumer of the service.</td>
</tr>
<tr>
<td>Business criticality</td>
<td>Business criticality for the service:</td>
</tr>
<tr>
<td></td>
<td>• 1 - <strong>most critical</strong></td>
</tr>
<tr>
<td></td>
<td>• 2 - <strong>somewhat critical</strong></td>
</tr>
<tr>
<td></td>
<td>• 3 - <strong>less critical</strong></td>
</tr>
<tr>
<td></td>
<td>• 4 - <strong>not critical</strong></td>
</tr>
<tr>
<td>Business need</td>
<td>The business justification for the service. Some examples are how it reduces costs and how it increases employee productivity.</td>
</tr>
</tbody>
</table>

5. Click the **Team** tab or **Continue to Team**.

6. On the form, fill in the fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owned by</td>
<td>Person that is accountable for the service and can edit this service at any time. This person is the service owner. Service owners must have the service_editor role.</td>
</tr>
<tr>
<td>Delegate</td>
<td>Person that can edit this service and who can act on behalf of the service owner. Delegates must have the service_editor role.</td>
</tr>
<tr>
<td>Delivery manager</td>
<td>Person that has responsibility for the day-to-day management and delivery of this service.</td>
</tr>
<tr>
<td>Business relationship manager</td>
<td>Person that provides business requirements to the service owner. This person helps to define the vision, strategy, and desired outcomes for the service and works closely with the service owner.</td>
</tr>
<tr>
<td>Business contact</td>
<td>Person that contributes business requirements to the service, or who has a vested interest in the service performance.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor that may help deliver and support this service or may provide the required tooling or technology to deliver this service.</td>
</tr>
<tr>
<td>Stakeholders</td>
<td>Individuals that have a vested interest in this service.</td>
</tr>
</tbody>
</table>

7. Click the **Manage Offerings** tab or **Continue to Manage Offerings**.
   The **Manage Offerings tab** displays those offerings that this service is provided for and how it is provided to them. Here you can create a new offering, view an offering phase, status, owner, and when an offering was last updated. A service must have at least one offering to be published.

8. Click **Continue to Review and Submit**.

9. Scroll down the page to review all your entries and if needed, make edits to any of your entries.

10. Click **Submit**.

**Create a service offering**

Create a service offering to define and view the products or applications that make up your service. Service Builder.

**Before you begin**

Role required: service_author or service_editor
About this task
A service offering represents how a service is provided and who it is for. A service must have at least one offering to be published. The workflow guides you to create a service offering in a logical order:

1. Details
2. Team
3. Operations
4. Financials

To create a service and service offering, you must be assigned the service_author role. To edit (not create) a service or service offering, you must be assigned the service_editor role.

Procedure
1. Navigate to Service Portfolio Management > Service Builder.
2. To add or edit a service offering, select the service and then click the Manage offerings tab.
3. To add a new service offering, click New.
4. On the form, fill in the fields.

Details form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offering name</td>
<td>Unique name for the offering that associates with the parent service.</td>
</tr>
<tr>
<td>Consumer type</td>
<td>Definition of who the offering will be provided for.</td>
</tr>
<tr>
<td>Business criticality</td>
<td>Signifies the importance of this offering to business operations. The value of this field could be used to trigger business logic. For example, your most critical offerings may warrant special treatment for disaster recovery.</td>
</tr>
<tr>
<td>Phase</td>
<td>The phase for the offering:</td>
</tr>
<tr>
<td></td>
<td>• Pipeline: The offering is being designed and a business case is being created.</td>
</tr>
<tr>
<td></td>
<td>• Catalog: The offering has been approved and it is now being designed or is operational.</td>
</tr>
<tr>
<td></td>
<td>• Retired: The offering is no longer in operation.</td>
</tr>
</tbody>
</table>
5. Click the **Team** tab or click **Continue to Team**.

6. On the form, fill in the fields.

### Team form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owned by</td>
<td>Person accountable for the service offering and can edit the service at any time. This person is the service owner. Service owners must have the service_author role.</td>
</tr>
<tr>
<td>Delegate</td>
<td>Person that can edit the service offering and who can act on behalf of the service owner. Delegates must be assigned the service_editor role.</td>
</tr>
<tr>
<td>Delivery manager</td>
<td>Person responsible for the daily management and delivery of the service offering.</td>
</tr>
<tr>
<td>Support group</td>
<td>Group that provides expert support to the service offering. This group is usually a level 2 support team.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor that may help deliver and support the service offering. This field helps show and track accountability for service offering delivery.</td>
</tr>
<tr>
<td>Stakeholders</td>
<td>Individuals that have a vested interest in the service offering.</td>
</tr>
</tbody>
</table>

7. Click the **Operations** tab or click **Continue to Operations**.

8. On the form, fill in the fields.

### Operations from

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected groups</td>
<td>Subscriber groups that have an interest in the service offering.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Selected departments</td>
<td>Departments that have an interest in the service offering.</td>
</tr>
<tr>
<td>Selected locations</td>
<td>Users by location.</td>
</tr>
<tr>
<td>Selected users</td>
<td>Individuals impacted by the service offering.</td>
</tr>
<tr>
<td>Selected companies</td>
<td>Individuals impacted by the service offering that are defined by the core company table. These individuals represent all users related to a given company.</td>
</tr>
<tr>
<td>Selected commitments</td>
<td>Select commitments, for example, service level agreements and availability commitments. Commitments may be defined in a contract for the service offering or based on standards defined by your company.</td>
</tr>
<tr>
<td>Service level requirements</td>
<td>Service level requirements for the service offering.</td>
</tr>
<tr>
<td>Active contract</td>
<td>Active contract to maintain awareness of the service commitments.</td>
</tr>
<tr>
<td>Additional contracts</td>
<td>Supporting, secondary, or past contracts related to the service offering.</td>
</tr>
<tr>
<td>Selected catalog items</td>
<td>Catalog item to track the request activity for all catalog items associated with this offering. A single offering can have multiple catalog items.</td>
</tr>
<tr>
<td>Offerings I depend on</td>
<td>Other service offerings that your service offering depends on. For example, if another offering experiences an outage, your offering availability may be impacted or degraded as a result.</td>
</tr>
<tr>
<td>Application services I depend on</td>
<td>Application services that the service offering depends on.</td>
</tr>
</tbody>
</table>

9. Click the **Financials** tab or click **Continue to Financials**.

10. On the form, fill in the fields.
### Financials form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price model</td>
<td>How the service offering is to be priced. Your selection determines the next field to display.</td>
</tr>
<tr>
<td>Price unit</td>
<td>If the price model is set to <strong>Per Unit</strong>, then enter the price unit in this field. For example, license or subscription.</td>
</tr>
<tr>
<td>Price</td>
<td>If the price model is set to <strong>Fixed</strong>, then enter the price in this field. Be sure to enter the currency symbol as well (for example, $ for United States dollar).</td>
</tr>
<tr>
<td>Unit description</td>
<td>If the price model is set to <strong>Per Unit</strong>, then use this field to describe what is included in the unit.</td>
</tr>
</tbody>
</table>

The following fields appear conditionally according to the cost source selected in Service Portfolio Management. These fields are enabled as part of the financial optional plugin for Service Portfolio Management. For financial information, the required plugin is com.snc.financial_management_for_spm. For estimate spend information, the required plugin is com.snc.spm.spend. Both plugins require ITSM Pro SKU.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost model</td>
<td>The cost model that determines how the estimated spend will be calculated.</td>
</tr>
<tr>
<td>Offering cost</td>
<td>If the cost model is set to <strong>Fixed</strong>, then the cost should represent the estimated cost of the offering per time period.</td>
</tr>
<tr>
<td>Time period</td>
<td>Interval that you want to track the estimated spend (<strong>day</strong>, <strong>month</strong>, <strong>quarter</strong>, <strong>year</strong>).</td>
</tr>
<tr>
<td>Cost Unit</td>
<td>If the cost model is set to <strong>Per unit</strong>, the cost should represent the cost per unit.</td>
</tr>
<tr>
<td>Units per period</td>
<td>The number of units per period.</td>
</tr>
<tr>
<td>Estimated spend</td>
<td>The estimated spend for this item.</td>
</tr>
</tbody>
</table>

11. Click **Save & Close**.

### Service Level Management

The ServiceNow® Service Level Management (SLM) application helps to gather service requirements as well as monitor and report with regards to agreed...
Service Level Management concepts

The ServiceNow® Service Level Management (SLM) application enables you to monitor and manage the quality of the services offered by your organization. Service Level Managers are responsible for a set of agreements between a service provider and customer that define the scope, quality, and speed of the services being provided. The intention of SLM is to provide the customer with an expectation of service within a known timescale and the ability to monitor when service levels are not being met.

SLM can be used across the organization in departments such as HR, Facilities, and IT to track how internal and external teams are performing against their agreed service levels.

---

<table>
<thead>
<tr>
<th>Explore</th>
<th>Set up</th>
<th>Administer</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Upgrade to Rome</td>
<td>• Configure Service Level Agreement (SLA) properties</td>
<td>• Create an SLA definition</td>
</tr>
<tr>
<td>• Domain separation and Service Level Management</td>
<td>• Add custom business rules to Service Level Agreement (SLA)</td>
<td>• Service Level Agreement (SLA) processing</td>
</tr>
<tr>
<td>• Migrate to service level management</td>
<td></td>
<td>• Repair Service Level Agreement (SLA)</td>
</tr>
<tr>
<td>• Service Level Agreement (SLA) processing</td>
<td></td>
<td>• Monitoring Service Level Agreement (SLA)</td>
</tr>
<tr>
<td>• SLA calculation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Scheduled jobs for SLA</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Task SLA table</td>
<td>• Developer training</td>
<td>• Ask or answer questions in the Service Level Management community</td>
</tr>
<tr>
<td>• SLA timeline</td>
<td>• Developer documentation</td>
<td>• Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td></td>
<td>• Installed with Service Level Management</td>
<td>• Contact Customer Service and Support</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The SLM offers the following features:

- Service Level Agreement (SLA) definitions
- Task SLAs
- Integration with other ServiceNow plugins

**Service Level Agreement (SLA) roles**

Ensure that users can perform all necessary actions by assigning SLA roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>sla_admin</td>
<td>Provides full administrative rights to SLM. Users that possess the sla_admin role can configure SLM properties, run SLA repair, view the SLA Overview dashboard, and manage SLA definitions. They may associate existing workflows or schedules to SLA definitions, but are unable to create workflows. The additional roles required to create workflows or schedules must be granted explicitly. See Base system roles for more information.</td>
</tr>
<tr>
<td>sla_manager</td>
<td>Lets users define SLA definitions, view SLA repair logs, and view the SLA Overview dashboard. Does not let users change SLM property values or define SLA condition types.</td>
</tr>
</tbody>
</table>

**Service Level Agreement (SLA) definitions**

Use the SLA Definition record to define a specific set of criteria that would result in an SLA being generated. Define some of the following parameters:

- **Table:** The task table that the SLA is defined for.
- **Duration:** The time duration in which the service must be provided to the customer.
- **Schedule:** The schedule, which indicates valid working and non-working days that the service provider follows to deliver the service. The selected schedule is used to determine when the SLA breaches.
- **Conditions:** The conditions under which the SLA starts, pauses, stops, or resets.
**Task SLA definitions**

When an SLA definition is triggered against a particular task, the task SLA record is generated and contains all the tracking data for the specific SLA on that record. For example, if an SLA definition exists for P1 incidents a task SLA record attaches to the P1 incident record and captures all the data associated with it. Often there are multiple task SLA records against a single task because many definitions apply.

**Note:** This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.

On the Task SLA form, you can also select the target for the SLA: **Response**, **Resolution**, or **None**.

**Integration with other ServiceNow plugins**
The following plugins introduce extra functionality within SLM:

- SLA Contract Add-on
- Service Portfolio Management - SLA Commitments

**Define a service contract**

A new table of SLA contracts is provided through the **Service Level Management > Service Contracts** module. These contracts group together SLAs that relate to a single vendor or customer, as well as the CIs, locations, groups, users, and child contracts that are related to the contract.

The table Service Contract [ast_service] extends the table Contract [ast_contract]. It stores information about service contracts for asset management purposes. To get the service contract functionality, activate the Service Level Management - Contract Management Integration [com.snc.sla.contract2] plugin. Installing the SLA Contract Add-on plugin adds relations to this table to make it useful for Service Management purposes. Once the plugin is installed, the Service Contract record possesses related lists for:

- SLAs
- Contract CIs
- Contract Locations
- Contract Groups
- Contract Users
- Child Contracts

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Service contract table fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>A unique number associated with the contract.</td>
</tr>
<tr>
<td>Starts</td>
<td>The date on which the contract takes effect.</td>
</tr>
<tr>
<td>Ends</td>
<td>The date on which the contract expires.</td>
</tr>
<tr>
<td>Approver</td>
<td>The person who approves the contract.</td>
</tr>
<tr>
<td>Location</td>
<td>The primary location of the contract, if applicable. If there are multiple, use the Contract locations related list.</td>
</tr>
<tr>
<td>Active</td>
<td>Whether the contract is currently in use.</td>
</tr>
<tr>
<td>Automatically renew/extend</td>
<td>Whether the contract has the possibility of being renewed or extended at the end of its term.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The vendor responsible for the contract.</td>
</tr>
<tr>
<td>Vendor account</td>
<td>The account the vendor is responsible to.</td>
</tr>
<tr>
<td>Contract number</td>
<td>The number of the contract defining the Service Contract.</td>
</tr>
<tr>
<td>Total cost</td>
<td>The total cost of the contract.</td>
</tr>
<tr>
<td>Payment amount</td>
<td>The amount which has been paid so far.</td>
</tr>
<tr>
<td>Payment schedule</td>
<td>The duration at which payments are made.</td>
</tr>
<tr>
<td>Process non-contractual SLAs</td>
<td>If selected, you can have both contractual SLAs as well as non-contractual SLAs, such as OLA and Underpinning contracts, processed for the same task. You can track the contractual SLAs as well as any SLA that is internal to the organization to enhance compliance.</td>
</tr>
</tbody>
</table>

**Note:** The Process non-contractual SLAs check box is available for the zboot and upgrade customers. The system property `com.snc.sla.contract.tables` is not available for zboot customers so that contracts are processed for any table in the system instead of specific tables.

| Short description            | A short description of the Service Contract.                                                                                                         |
Service contract table fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>A full description of the Service Contract.</td>
</tr>
</tbody>
</table>

**Add contract field to task form**

Depending on how the contract is used, the **Contract** field can be added to any task form by configuring the form. For information about how to configure a form, see [Form configuration](#). As the **Caller**, **Assignment Group**, **Location**, and **Configuration item** fields are populated, the **Contract** field filters appropriately, helping the support desk to associate the ticket to the correct contract.

ℹ️ **Note:** Do not add the same field to different sections of a form unless the field displays read-only data. Having two or more instances of an editable field can cause data loss and prevent the proper functioning of UI and data policies.

**Service Level Management plugins**

You can activate one or more of the Service Level Management plugins if they are not already active. Some plugins include demo data. You can activate one or more of the following Service Level Management plugins.

**Activate Service Level Management**

You can activate the Service Level Management plugin (com.snc.sla) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**About this task**

Activating this plugin, provides the core SLA functionalities.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

![Note](image)

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: `Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

### Related reference

**List of plugins (Rome)**

### Installed with Service Level Management

Activating the Service Level Management plugin adds or modifies these components: tables, properties, UI actions, UI policies, script includes, client scripts, business rules, email notifications, scheduled jobs, and workflows.

### Tables installed with Service Level Management

Tables are added with Service Level Management.

<table>
<thead>
<tr>
<th>Display name [Table name]</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA Definition [contract_sla]</td>
<td>Provides the conditions, duration, and schedule for an SLA Definition.</td>
</tr>
<tr>
<td>SLA Conditions [sla_condition_class]</td>
<td>Defines how the conditions in the SLA Definition are used to determine the transitions between different stages of each task SLA.</td>
</tr>
<tr>
<td>SLA Repair Log [sla_repair_log]</td>
<td>Used to provide a log of when the SLA Repair function is set to action.</td>
</tr>
<tr>
<td>SLA Repair Log Entry [sla_repair_log_entry]</td>
<td>Extends syslog and stores the before or after values of a task SLA record that has been repaired.</td>
</tr>
<tr>
<td>Task SLA [task_sla]</td>
<td>Associates a task with the SLA Definition that applies to it.</td>
</tr>
<tr>
<td>SLA Timer Configuration [sla_timer_config]</td>
<td>Stores the timer configuration information.</td>
</tr>
<tr>
<td>SLA timer configuration mapping [sla_timer_config_mapping]</td>
<td>Stores the Task SLA mapping information.</td>
</tr>
</tbody>
</table>
Roles installed with Service Level Management

Roles are added with activation of Service Level Management plugin.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sla_admin</td>
<td>Users with this role have full administrative rights to the Service Level Management application</td>
<td>flow_operator</td>
</tr>
<tr>
<td>sla_manager</td>
<td>Users with this role can define SLA definitions and view SLA repair logs.</td>
<td>flow_operator</td>
</tr>
</tbody>
</table>

Scheduled jobs installed with Service Level Management

Scheduled jobs are added with Service Level Management.

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA update (already breached)</td>
<td>Refreshes the timings in task SLA records that have already breached. This is limited to task SLAs where the breach time is within the last 365 days. This job runs once a day.</td>
</tr>
<tr>
<td>SLA update (breach after 30 days)</td>
<td>Refreshes the timings in task SLA records where the breach time is more than 30 days away. This is limited to task SLA records where the breach time is within the next 365 days. This job runs every 5 days.</td>
</tr>
<tr>
<td>SLA update (breach within 1 day)</td>
<td>Refreshes the timings in task SLA records where the breach time is more than 1 hour away and less than 24 hours away. This job runs every hour.</td>
</tr>
<tr>
<td>SLA update (breach within 1 hour)</td>
<td>Refreshes the timings in task SLA records where the breach time is more than 10 minutes away and less than 1 hours away. This job runs every 10 minutes.</td>
</tr>
<tr>
<td>Scheduled job</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SLA update (breach within 10 min)</td>
<td>Refreshes the timings in task SLA records where the breach time is in the next 10 minutes. This job runs every minute.</td>
</tr>
<tr>
<td>SLA update (breach within 30 days)</td>
<td>Refreshes the timings in task SLA records where the breach time is more than 1 day away and less than 30 days away. This job runs once a day.</td>
</tr>
</tbody>
</table>

**Activate SLA Breakdown definitions**

You can activate the SLA Breakdowns plugin (com.snc.sla.breakdowns) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**About this task**

SLA Breakdowns plugin (com.snc.sla.breakdowns) activates these related plugins if they are not already active.

**Plugins for SLA Breakdowns**

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service level management [com.snc.sla]</td>
<td>Provides the core SLA functionality. SLA Definitions provide conditions to start, pause, stop, cancel and reset Task SLAs against any Task type. In addition, you can specify a schedule on the definition to define the working hours and also a workflow to run against each Task SLA which is typically used to generate notifications.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

⚠ Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Related reference
List of plugins (Rome)

Installed with SLA breakdown definitions
Several types of components are installed with the SLA breakdown definitions.

Plugins installed with SLA breakdowns
Plugins are added with activation of SLA breakdowns.

SLA breakdowns adds the following plugin.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA Breakdowns</td>
<td>com.snc.sla.breakdowns</td>
<td>Provides the ability to generate breakdown data for each Task SLA record. For example, the breakdown data for each Task SLA record can be generated by Assignment group or Assigned to field.</td>
</tr>
</tbody>
</table>
Table installed with SLA breakdowns

Tables are added with activation of SLA breakdowns.

SLA breakdowns adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA Breakdown Definition</td>
<td>A breakdown definition that is associated to a specific task type. For example, Incident.</td>
</tr>
<tr>
<td>[sla_breakdown_definition]</td>
<td></td>
</tr>
<tr>
<td>SLA Breakdown Definition Field</td>
<td>A breakdown definition field (a child record of a breakdown definition). Each record defines a mapping between a field on the associated task table and the breakdown data table.</td>
</tr>
<tr>
<td>[sla_breakdown_definition_field]</td>
<td></td>
</tr>
<tr>
<td>SLA Breakdown Definition to SLA Definition relation</td>
<td>The relation between SLA Breakdown Definition and SLA Definitions.</td>
</tr>
<tr>
<td>[sla_definition_sla_breakdown]</td>
<td></td>
</tr>
<tr>
<td>SLA Breakdown Core</td>
<td>The common columns for all SLA breakdown data tables. Each breakdown data table must extend this core table.</td>
</tr>
<tr>
<td>[sla_breakdown_core]</td>
<td></td>
</tr>
</tbody>
</table>

Note: You must have up-to-date versions of script includes TaskSLAController and RepairTaskSLAController before activating the plugin to ensure that breakdown data is generated correctly. If you have customized versions of either of these script includes, any customizations should be incorporated into the versions of these files from the most recent upgrade.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon" alt="Note" /></td>
<td>In the Madrid release, only the single breakdown data table SLA Breakdown By Assignment [sla_breakdown_by_assignment] is supported.</td>
</tr>
<tr>
<td>SLA Breakdown By Assignment [sla_breakdown_by_assignment]</td>
<td>Contains the breakdown records generated for each Task SLA record that has an associated breakdown definition.</td>
</tr>
</tbody>
</table>

**Properties installed with SLA breakdowns**

Properties are added with activation of SLA breakdowns.

SLA breakdowns adds the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.sla.breakdown_processor.log</td>
<td>Logging level for script include SLABreakdownProcessor.</td>
</tr>
<tr>
<td>Type: Choice list</td>
<td>Default value: Notice</td>
</tr>
<tr>
<td>Location: SLA logging module</td>
<td></td>
</tr>
</tbody>
</table>

**UI policy installed with SLA breakdowns**

UI policies are added with activation of SLA breakdowns.

SLA breakdowns adds the following UI policies.

<table>
<thead>
<tr>
<th>UI policy</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make definition fields read only</td>
<td>SLA Breakdown Definition Field [sla_breakdown_definition_field]</td>
<td>Make read only any fields on the form that are from the parent SLA Breakdown Definition</td>
</tr>
<tr>
<td>Hide &quot;Fieldname data&quot; field</td>
<td>SLA Breakdown Definition Field [sla_breakdown_definition_field]</td>
<td>The ui policy hides the field &quot;Fieldname data&quot; from the form. This field is only used by scripts that dynamically update other</td>
</tr>
</tbody>
</table>
UI policy | Table | Description
--- | --- | ---
 |  | fields on the form and which should not be modified through the UI.

**Script includes installed with SLA breakdowns**

Script includes are added with activation of SLA breakdowns.

SLA breakdowns adds the following script includes.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLABreakdown</td>
<td>Base class that provides constants for SLA Breakdowns.</td>
</tr>
<tr>
<td>SLABreakdownDefinition</td>
<td>Extends SLABreakdownDefinitionSNC and in future releases can be used to override default functionality or provide additional methods. For the Madrid release, the script include is read only.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionSNC</td>
<td>Provides methods for managing records in the sla_breakdown_definition table.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionAJAX</td>
<td>Provides client callable methods used for managing records in the sla_breakdown_definition table.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionBreakdownField</td>
<td>Extends SLABreakdownDefinitionBreakdownFieldSNC and in future releases can be used to override default functionality or provide additional methods. For the Madrid release, the script include is read only.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionBreakdownFieldSNC</td>
<td>Provides methods that determine the available values for breakdown_field on the sla_breakdown_definition_field table.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionSourceField</td>
<td>Extends SLABreakdownDefinitionSourceFieldSNC and in future releases can be used to override default functionality or provide additional methods. For the Madrid release, the script include is read only.</td>
</tr>
<tr>
<td>SLABreakdownDefinitionSourceFieldSNC</td>
<td>Provides methods that determine the available values for breakdown_field on the sla_breakdown_definition_field table.</td>
</tr>
</tbody>
</table>
**Script include** | **Description**
---|---
| SLABreakdownDefinitionSourceFieldSNC | Provides methods that determine the available values for source_field on the sla_breakdown_definition_field table. |
| SLABreakdownDefinitionTaskTablesSNC | Extends SLABreakdownDefinitionTaskTablesSNC and in future releases can be used to override default functionality or provide additional methods. For the Madrid release, the script include is read only. |
| SLABreakdownDefinitionTaskTables | The method that determines the available Task tables for breakdown definitions. |
| SLABreakdownProcessor | Extends SLABreakdownProcessorSNC and can be used to override default functionality or provide additional methods. |
| SLABreakdownProcessorSNC | Provides the methods for generating the breakdown data records for Task SLAs based on the available breakdown definition records. |
| SLABreakdownUtils | Extends SLABreakdownUtilsSNC and can be used to override default functionality or provide additional methods. |
| SLABreakdownUtilsSNC | Provides utility methods used by some of the other SLA breakdown script includes. |
| TaskSLABreakdownUtils | Extends TaskSLABreakdownUtilsSNC and can be used to override default functionality or provide additional methods. |
| TaskSLABreakdownUtilsSNC | Provides methods for the task_sla table. |

**Client scripts installed with SLA Breakdowns**

Client scripts are added with activation of SLA breakdowns.

SLA breakdowns adds the following client scripts.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide assignment breakdown reports</td>
<td>Task SLA [task_sla]</td>
<td>Hides the embedded charts on the Task SLA form when no breakdown data is available.</td>
</tr>
<tr>
<td>Script include</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set available breakdown tables</td>
<td>SLA Breakdown Definition</td>
<td>Populates the options in the sla_breakdown_table field.</td>
</tr>
<tr>
<td></td>
<td>[sla_breakdown_definition]</td>
<td></td>
</tr>
<tr>
<td>Set fieldname data</td>
<td>SLA Breakdown Definition Field</td>
<td>Sets data into a hidden field which is then used by the field choice scripts that populate breakdown_field_name and source_field_name.</td>
</tr>
<tr>
<td></td>
<td>[sla_breakdown_definition_field]</td>
<td></td>
</tr>
<tr>
<td>Show 2010 engine message</td>
<td>SLA Breakdown Definition</td>
<td>Displays a message on the form for instances that are running the 2010 SLA engine.</td>
</tr>
<tr>
<td></td>
<td>[sla_breakdown_definition]</td>
<td></td>
</tr>
<tr>
<td>Show breakdown data exists</td>
<td>SLA Breakdown Definition Field</td>
<td>Displays a message on the form to explain that fields are read only due to breakdown data existing.</td>
</tr>
<tr>
<td>message</td>
<td>[sla_breakdown_definition_field]</td>
<td></td>
</tr>
<tr>
<td>Show breakdown data exists</td>
<td>SLA Breakdown Definition</td>
<td>Displays a message on the form to explain that fields are read only due to breakdown data existing.</td>
</tr>
<tr>
<td>message</td>
<td>[sla_breakdown_definition]</td>
<td></td>
</tr>
<tr>
<td>Update already defined task</td>
<td>SLA Breakdown Definition</td>
<td>Disables options in the task_table field for task types that already have a breakdown definition.</td>
</tr>
<tr>
<td>tables</td>
<td>[sla_breakdown_definition]</td>
<td></td>
</tr>
<tr>
<td>Warning on setting inactive</td>
<td>SLA Breakdown Definition</td>
<td>Prompts for confirmation when a breakdown definition is updated to be inactive.</td>
</tr>
<tr>
<td></td>
<td>[sla_breakdown_definition]</td>
<td></td>
</tr>
</tbody>
</table>

**Business rules installed with SLA breakdowns**

Business rules are added with the activation of SLA breakdowns.

SLA breakdowns adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear SLA Breakdown definitions cache</td>
<td>SLA Breakdown Definition to SLA Definition relation</td>
<td>Clears the SLA definitions cache when a record is inserted, updated, or deleted.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Clear SLA Breakdown definitions cache</td>
<td>SLA Breakdown Definition Field [sla_breakdown_definition_field]</td>
<td>Clears the SLA breakdown definitions cache whenever a record is inserted, updated, or deleted.</td>
</tr>
<tr>
<td>Clear SLA Breakdown definitions cache</td>
<td>SLA Breakdown Definition [sla_breakdown_definition]</td>
<td>Clears the SLA breakdown definitions cache whenever a record is inserted, updated, or deleted.</td>
</tr>
<tr>
<td>Delete active breakdown data on inactive</td>
<td>SLA Breakdown Definition [sla_breakdown_definition]</td>
<td>Deletes any breakdown data records for active Task SLA records when the breakdown definition is updated to inactive.</td>
</tr>
<tr>
<td>Get breakdown table data</td>
<td>SLA Breakdown Definition [sla_breakdown_definition]</td>
<td>Populate data on the scratchpad that is required by client scripts.</td>
</tr>
<tr>
<td>Get SLA breakdown data</td>
<td>Task SLA [task_sla]</td>
<td>Populate data on the scratchpad that is required by client scripts.</td>
</tr>
<tr>
<td>m2mSLABreakdownRestrictBreakdownDefs</td>
<td>Global [global]</td>
<td>Script to restrict the available values in the sla_breakdown_definition column in many-to-many table sla_definition_sla_breakdown.</td>
</tr>
<tr>
<td>m2mSLABreakdownRestrictSLAs</td>
<td>Global [global]</td>
<td>Script to restrict the available values in the sla_definition column in many-to-many table sla_definition_sla_breakdown.</td>
</tr>
<tr>
<td>Process changes to tables</td>
<td>SLA Breakdown Definition [sla_breakdown_definition]</td>
<td>Perform additional processing when either the sla_breakdown_table or task_table is changed.</td>
</tr>
<tr>
<td>Process SLA Breakdowns</td>
<td>Task SLA [task_sla]</td>
<td>Creates and updates breakdown data whenever a record is inserted, updated, or deleted.</td>
</tr>
</tbody>
</table>
### Activate SLA timeline

You can activate the SLA timeline plugin (com.snc.sla.timeline) if you have the admin role. This plugin activates related plugins if they are not already active.

**Before you begin**

Role required: sla_admin

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Related information**

- List of plugins

**Script includes installed with SLA timeline**

When SLA timeline is activated, script includes are installed.

SLA timeline adds the following script includes.
### SLATimeline

This script include generates the timeline data for a task SLA record by replaying the task’s history and using the SLATimelineAPI to determine the appropriate stage transitions and timings for the task SLA.

### SLATimelineAPI

This script include provides a number of functions that simulate how the SLA engine processes a particular task and SLA definition without actually creating any task SLA records.

### SLATimeLineV2SNC

This script include is used by SLA Timeline internal REST API to inspect audit history of a Task and extract task SLA details to be presented on the UI.

### ReadOnlyTaskSLAContoller

This script include is a helper script include and is for internal use. This script include is called by SLATimeLineV2SNC to process the task SLA stage details.

### Activate Service Level Management - SLA Timer Config API

You can activate the Service Level Management - SLA Timer Config API plugin (com.sn_slm_timer) if you have the admin role. Activating this plugin provides the ability to set a preferred SLA for a given task through configuration which is dynamic, such as First SLA to breach, or declarative through a hierarchical mapping of first to match SLA definitions. This plugin includes demo data and activates related plugins if they are not already active.

**Before you begin**

Role required: admin

**About this task**

**Procedure**

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

Related reference

List of plugins (Rome)

Installed with Service Level Management- SLA Timer Config API

The Service Level Management - SLA Timer Config API (com.sn_slm_timer) plugin installs the admin role.

Roles installed

<table>
<thead>
<tr>
<th>Role title</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_slm_timer.sla_timer_admin</td>
<td>Users with this role has full administrative rights to the Service Level Management timer configuration.</td>
<td>sn_sla_definition_read</td>
</tr>
</tbody>
</table>

Script Includes installed with SLA Timer Config API

When SLA Timer Config API is activated, script includes are installed. SLA Timer Config API adds the following script includes.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLATimerConfigAPI</td>
<td>This script includes provides various functions to process and identify the task SLA that is about to breach.</td>
</tr>
</tbody>
</table>

Configure Service Level Agreement (SLA)

Configure SLAs to define a set amount of time for a task to reach a certain condition, to ensure that incidents are closed or resolved according to the expectations set for customers.
**Service Level Agreement (SLA) definition**

An SLA definition is used to create and progress SLAs, enabling you to use an SLA system for your organization's tasks.

An SLA definition record defines the timings, conditions, workflows, and other information required to create and progress task SLAs.

For example, the default **Priority 1 resolution (8 hour)** SLA Definition defines the Task SLAs to attach to incidents with a P1 - Critical priority, specifies appropriate conditions for those Task SLAs, and uses the default SLA workflow to create events such as to send a notification, when an incident's Task SLA reaches 50% of its allotted time.

**Create an SLA definition**

You can create one or more Service Level Agreement (SLA) definitions and use them to create an SLA record. This SLA record enables you to use an SLA system for your organization's task.

**Before you begin**

When you create an SLA definition, avoid using dot-walked fields that change frequently in any of the SLA conditions (start, stop, pause, and reset). The SLA engine features, such as SLA Timeline and SLA Repair replays the audit history of the Task record that the task_sla is attached to. The SLA engine does not replay the audit history of any dot-walked fields from that Task, rather only considers the final state of the dot-walk fields.

For example, a pause condition is set to an incident dot-walk field `incident.company.cost_center`. The value of the Cost Center is first set to Finance and later changed to Engineering. When the SLA repair runs, only the final value of the Cost Center is considered. So, if the SLA pause condition is: `incident.company.cost_center is Engineering`, SLA Repair pauses immediately, because the SLA Repair does not consider the previous Cost Center value: Finance. This condition also applies to SLA Timeline (as well as when executing the SLA Engine asynchronously).

Now, if the requirement is to pause when `incident.company.cost_center` is Engineering and not Finance, then the audit history must be on the Task record using a custom field. Create a custom field (in this example on the incident table) such as: `u_company_cost_center` and a business rule to populate the field when either the company changes or the Cost Center of the company changes. In this approach, instead of setting the SLA pause condition to the dot-walked field, it is set against the custom field. The given approach ensures that the task_sla, SLA repair, and SLA Timeline always shows the same results.

⚠️ **Note:** The deeper the dot walk, the more business rules are required.
Role required: admin

Procedure

1. Navigate to Service Level Management > SLA > SLA Definitions.
2. Click New.
   The SLA Definition form is displayed.
3. On the form, fill in the fields.

**SLA Definition form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that identifies the SLA definition.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of agreement being defined: SLA, OLA, or Underpinning contract.</td>
</tr>
<tr>
<td></td>
<td>Note: Type is used for reporting purposes only.</td>
</tr>
<tr>
<td>Target</td>
<td>Select the target of the agreement being defined: None, Response, or Resolution. Target is used for filtering, searching, and reporting purposes only.</td>
</tr>
<tr>
<td></td>
<td>Note: This feature is available only in new instances starting with Jakarta or a later release.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that determines the records tracked by the SLA. SLAs can be defined for any table that extends the task table, including incident, change request, and service catalog tasks.</td>
</tr>
<tr>
<td></td>
<td>Note: Starting with the Helsinki release, you can and create an SLA definition for configuration items and business services for Event Management.</td>
</tr>
<tr>
<td>Flow</td>
<td>Select the flow to run when the SLA definition attaches to a Task record. Selecting a flow disables the Workflow field.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Select the workflow to run when the SLA definition attaches to a Task record. Selecting a workflow disables the Flow field.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Select the vendor associated with the SLA definition.</td>
</tr>
<tr>
<td>Service Commitment</td>
<td>A flag that helps to differentiate between a normal SLA definition and a service offering SLA definition.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>⚫ Schedule source field:</td>
<td>Select the appropriate field from the task such as an incident or problem that provides the schedule. For example, Configuration item &gt; Schedule.</td>
</tr>
<tr>
<td>Timezone Source</td>
<td>Specify the time zone source to be used when creating task SLAs. You can specify one of the following time zones:</td>
</tr>
<tr>
<td></td>
<td>• The caller's timezone.</td>
</tr>
<tr>
<td></td>
<td>• The SLA definition's timezone: If the The SLA definition's timezone option is selected, the Timezone choice list appears.</td>
</tr>
<tr>
<td></td>
<td>◦ Timezone: Specify a time zone for the SLA. The time zone can be the system time zone or active standard geographical time zones.</td>
</tr>
<tr>
<td></td>
<td>• The CI location's timezone.</td>
</tr>
<tr>
<td></td>
<td>• The task's location's timezone.</td>
</tr>
<tr>
<td></td>
<td>• The caller's location's timezone.</td>
</tr>
<tr>
<td>Tabs</td>
<td>Start condition</td>
</tr>
<tr>
<td></td>
<td>• Start conditions are not met option: If one or more of the specified start conditions change, the SLA is canceled. This option is selected by default.</td>
</tr>
<tr>
<td></td>
<td>• Cancel conditions are met option: The start condition must be met only once, thereafter the SLA is canceled only when the cancel condition is met.</td>
</tr>
<tr>
<td></td>
<td>• Never option: The SLA is never canceled. Retroactive start: to choose a date and time field from the task that provides the start time of the task SLA. If you select the Retroactive start check box, the Set start to field and the Retroactive pause time check box appear.</td>
</tr>
<tr>
<td></td>
<td>• Set start to field: Offers the date and time fields available on the task type that this SLA definition applies to. For example, if you select Retroactive start on a Priority 1 SLA definition and choose Created in the Set start to field, then the SLA is attached with the start time</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>that is the date and time from the Created field on the incident.</td>
</tr>
<tr>
<td></td>
<td>• Retroactive pause time check box: Enables the calculation of retroactive pause time on the specific SLA definition. For example, if you select Retroactive start on a Priority 1 SLA definition and then select the Retroactive pause time check box, the SLAs that have enabled retroactive start can recover prior to the pause time.</td>
</tr>
<tr>
<td></td>
<td>      Note: The Retroactive pause time check box is available only when the duration is a user-specified duration.</td>
</tr>
<tr>
<td>Pause condition</td>
<td>Define the conditions under which the SLA suspends increasing elapsed time. From the When to resume list, you can choose the conditions under which the SLA resumes increasing elapsed time.</td>
</tr>
<tr>
<td></td>
<td>• Pause conditions are not met option: If one or more of the specified pause conditions no longer match, the elapsed time continues to increase. The Pause conditions are not met option is selected by default.</td>
</tr>
<tr>
<td></td>
<td>• Resume conditions are met option: If one or more of the specified resume conditions match, the elapsed time continues to increase.</td>
</tr>
<tr>
<td>Stop condition</td>
<td>Define the conditions under which the SLA completes. If all these conditions match, then the task SLA completes regardless of whether it is breached.</td>
</tr>
<tr>
<td>Reset condition</td>
<td>Determines whether the existing task is canceled or completed on task SLA reset. Defines the conditions under which the running SLA is canceled or completed and a new SLA is attached. For a new SLA to be attached, the start condition must match.</td>
</tr>
<tr>
<td></td>
<td>Reset condition also helps to configure SLAs when the value of any specific field on the task record changes, changes to, or changes from a specific value. For example, the value of the Location field in the task record is 101 Broadway East, Seattle, WA. If you set the SLA reset condition as Location changes from 101 Broadway East,</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Seattle, WA, any change in the value of the <strong>Location</strong> field resets the SLA of the task record.</td>
<td></td>
</tr>
</tbody>
</table>

**Fields that can be added by configuring the form**

| Condition type | Select the condition type to determine when an SLA attaches, pauses, completes, or resets. |

**Flows for SLA**

Use the flow actions to send SLA notifications when the duration specified in the SLA definition is crossed.

You can create and edit flows using the Flow Designer. The default flow that is available with the Service level management plugin is **Default SLA flow**.

The **Default SLA flow** creates the events that send out notifications. For example, it creates an event to send a notification to the user assigned to a task, such as an incident, when the task SLA reaches 50% of its allotted time.

The **SLA Notification and Escalation flow** creates the events that send out notifications. When a task reaches 50% of its allotted SLA duration, a notification is sent to the assignee and the user listed in the **Supported by** field on the configuration item. At 75% and 100%, a notification is sent to the assignee and the assignee's manager.

**Note:** This feature is available only in new instances starting with Orlando or a later release.

**Related information**

- Flow Designer

**Workflows for SLA**

SLA typically uses workflows to send notifications.

You can create and edit workflows with the Workflow Editor. The default workflow that is available with the Service level management plugin is **Default SLA Workflow**.

The **Default SLA Workflow** creates the events that send out notifications. For example, it creates an event to send a notification to the user assigned to a task, such as an incident, when the task SLA reaches 50% of its allotted time.

The **SLA Notification and Escalation Workflow** creates the events that send out notifications. When a task reaches 50% of its allotted SLA duration, a notification is sent to the assignee and the user listed in the **Supported by** field on the configuration item. At 75% and 100%, a notification is sent to the assignee and the assignee's manager.
configuration item. At 75% and 100%, a notification is sent to the assignee and the assignee's manager.

Note: This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.

Related information
- Workflow editor

SLA duration types
You can select one of two SLA duration types to define the length of time within which a task must be completed before the SLA is breached. If an SLA schedule is defined, the duration works along with the schedule. In a user-specific duration, you can choose to specify the length of time that an SLA must run before it is marked as breached. Relative durations specify durations that are relative to the start time of the task SLA and are defined using a script.

When you define an SLA, you can select either a user specified duration or a relative duration.

User specified duration
Specifies a static duration period, such as 8 hours, along with a business schedule. The Duration field is displayed, enabling you to specify the length of time in days, hours, minutes, and seconds that the SLA must run before it is marked as breached. The number of days specified in the Duration field is converted to 24-hour blocks.

Each time that you set a duration, an example breach time information message is displayed at the top of the form. This information assists you in understanding how the breach date is calculated. For example, if the current date is January 1, 2015, the time is 10:30 am, and the duration is set to 10 hours and no schedule has been selected, the following information message is displayed:

An SLA starting now will end breach on 2015-01-01 20:30 (Actual elapsed time: 10 Hours).

Relative duration
Specifies a duration relative to the start time of the task SLA and is defined using a script. For example, you can select a relative duration such as Breach on Due Date, End of next business day or Next business day by 4pm. The set of relative durations is defined in the core configuration using script-based duration calculations.
Note: Pause conditions are not compatible with relative durations. You can use a relative duration within the Service Level Management application in the following ways:

- Specify a relative duration.
- Relative duration usage scenarios.

Specify a relative duration

To specify a relative duration, select an option such as Next business day by 4pm or End of next business day from the list of available relative durations in the Duration type field. When you select a relative duration such as Next business day by 4pm, the Relative duration works on field appears. You can specify the record that the relative duration should be calculated for. You can select to use Task record or SLA record and the record you select is available as current for the relative duration script.

Note: If a relative duration is selected, the example breach date information message is not displayed.

If your task record has a target date and time field, you can create an SLA with a relative duration based on that field.

Relative duration usage scenarios

If a schedule is selected in the SLA definition, the SLA duration works with the SLA schedule. For example, an SLA might have a user-specified duration of 16 hours with the schedule as 8-5 weekdays. If this SLA starts to run for a task at 8:00, it breaches at 17:00. The breach time is calculated from the schedule that defines working time as eight hours per day from Monday to Friday. So the 16-hours duration equates to two days later in the schedule.

The Breach on Due Date sets the breach time of the SLA to the date and time from the Due Date field of the task that the SLA is attached to.

If the Due Date field is empty or occurred in the past, the breach time of the task SLA is calculated to be one second ahead of the task SLA start time. If the date and time in the Due Date field is outside the schedule for the task SLA, the breach time is set to the next available scheduled time. For example, if the SLA definition specifies a task SLA schedule as 08:00-17:00 and the value in the Due Date field is Wednesday 11th Jan 2017 20:30, the breach time is set to Thursday 12th 2017 Jan 08:00.
If your task record has a target date and time field, you can create an SLA with a relative duration based on that field.

Schedules within SLA

Schedules within SLA enable you to define the time periods during which the SLAs accumulate business time.

Schedules are typically based on the working hours of the resource or departments to whom a task is allocated. When you define an SLA, you can select a schedule during which the SLA will accumulate business time. You can specify the schedule that each SLA must use in the SLA definition form.

Schedules in SLA definitions

You can specify the schedule to be used when creating new task SLAs in the Schedule source field. You can specify one of the following options:

• **No schedule**: If the No Schedule option is selected, the SLA will calculate based on a 24 x 7 schedule.

• **SLA definition**: If the SLA definition option is selected, the Schedule drop-down list appears.
  
  ◦ **Schedule**: Specify the hours during which the SLA timer runs. These set of schedules are defined in the core configuration. For example, you can select a schedule of 8-5 weekdays or 8-5 weekdays excluding holidays.

• **Task table field**: This option picks its title from the option selected in the Table field earlier on the SLA Definition form. For example, if Incident is selected in the Table field, then this option appears as Incident field. If the Task table field option is selected, the Schedule source field drop-down list appears.
  
  ◦ **Schedule source field**: Select the appropriate field from the task such as an incident or problem that will provide the schedule. For example, Configuration item > Schedule.

SLA duration and schedules

Schedules have an impact on the duration specified in an SLA definition.

This impact is reflected in the timings that are taken into consideration while calculating an SLA.

⚠️ **Note**: If a schedule is not selected for an SLA, the SLA will run 24X7.

Consider a scenario where you select a duration of one day, which is 24 hours, and a schedule of 9 am to 5 pm, which is 8 hours. The SLA calculation will distribute the 24 hours across three working days of 8 hours each. So a team
working on a task associated with this SLA has 3 days to complete the task before the SLA is breached.

### Time zones in SLAs

You can specify the geographical time zone that is used for schedule calculation.

Specify the time zone source to be used when creating task SLAs. You can select one of the following options:

- **The caller's timezone**: If this option is selected and the caller has not selected a time zone, then the system time zone is used.

- **The SLA definition's timezone**: If the **The SLA definition's timezone** option is selected, the Timezone list appears.
  - **Timezone**: Specify a time zone for the SLA. The time zone can be the system time zone or active standard geographical time zones.

- **The CI location's timezone**

- **The task location's timezone**

- **The callers' location's timezone**

**Note**: If you select a time zone source other than the **The SLA definition's timezone** and the time zone derived from the time zone source is empty, the system time zone is used.

### SLA conditions

SLA conditions determine when a task SLA record is attached, paused, resumed, reset, canceled, and completed.

On the SLA definition, you specify up to six conditions that are evaluated each time a task record is created or updated. For example, for an SLA to attach to a task, the start conditions must match and stop conditions must not match.
SLA conditions work in the following ways:

- SLA conditions
- SLA condition evaluation

**SLA conditions**
You can set up to six SLA conditions: start, cancel, pause, resume, stop, reset.

**Start condition**
Enables you to define the conditions under which the SLA will be attached.
You can choose the conditions from the **When to cancel** list under which the SLA will be canceled.

- **Start conditions are not met** option: If one or more of the specified start conditions change, then the SLA will be canceled. The **Start conditions are not met** option is selected by default.

- **Cancel conditions are met** option: The start condition has to be met only once, thereafter the SLA will only cancel when the cancel condition is met.

- **Never** option: The SLA will never be canceled.

- **Select Retroactive start** to choose a date and time field from the task that will provide the start time of the task SLA. If you select the **Retroactive start** check box, the **Set start to** field appears offering the date and time fields available on the task type that this SLA definition applies to. For example if you select **Retroactive start** on a Priority 1 SLA definition and then choose **Created** in the **Set start to** field, then the SLA is attached with the start time being the date and time from the **Created** field on the Incident.

**Cancel condition**
Enables you to define the conditions under which the SLA will cancel. You can specify the cancel conditions at the same time when you specify the start conditions.

**Pause condition**
Enables you to define the conditions under which the SLA will suspend increasing elapsed time.
You can choose the conditions from the **When to resume** list under which the SLA will resume increasing elapsed time.
• **Pause conditions are not met** option: If one or more of the specified pause conditions no longer match, then the elapsed time will continue to increase. The **Pause conditions are not met** option is selected by default.

• **Resume conditions are met** option: If one or more of the specified resume conditions match, then the elapsed time will continue to increase.

**Resume condition**

Enables you to define the conditions under which the SLA will resume increasing elapsed time. You can specify the resume conditions at the same time when you specify the pause conditions.

**Stop condition**

Enables you to define the conditions under which the SLA completes. If all of the specified stop conditions match, then the task SLA will complete regardless of whether it is breached.

**Reset condition**

Enables you to define the conditions under which the running SLA will be completed and a new SLA will be attached. For a new SLA to be attached, the start condition must match.

Reset condition also helps to configure SLAs when the value of any specific field on the task record changes, changes to or changes from a specific value in the record. For example, the value of the **Location** field in the task record is 101 Broadway East, Seattle, WA. If you set the SLA reset condition as **Location changes from** 101 Broadway East, Seattle, WA, any change in the value of the **Location** field resets the SLA of the task record.

**SLA condition evaluation**

Every task in the system is evaluated in the following order:

• Process new SLAs-- Determine if a new SLA record must be attached to a task
• Process existing SLA records attached to a task.

SLA conditions are evaluated in the following ways:

• **Attach** if start condition matches and both the stop and cancel conditions don't match.
• **Complete** if the stop condition matches.
• Pause if the pause condition matches.
• Resume if the pause condition doesn't match or resume condition matches.
• Reattach if both the reset and the start conditions match.
• Cancel if the start condition doesn't match or cancel conditions matches.

Consider this evaluation order when you create conditions. For example, if your Start condition is a subset of your Stop condition, the Stop condition will always match when the Start condition matches and the SLA will never attach. This includes processing any new SLAs that were just created.

Similarly, if your Pause condition is a subset of your Start condition, the SLA will attach but will permanently be in Paused state. As soon as the Pause condition does not match, the equivalent Start condition will also not match and that task SLA record will be canceled.

In addition, if you create a SLA definition with a Start condition and a Pause condition that are mutually exclusive, your SLA will never pause but will always be canceled first. For example, for an SLA definition where the Start condition is **State is one of "New, Active"** and the Pause condition is **State is "On Hold"**, when the Task is updated to state **On Hold**, the start condition will no longer match and the task SLA will be canceled.

**SLA transitions**

SLA records pass through a series of transitions during processing.

The following transitions exist for an SLA:

• Attach: when an SLA is created and bound to a task.
• Pause: when an SLA should temporarily stop tracking time.
• Resume: when an SLA should resume tracking elapsed time.
• Complete: when an SLA is marked complete.
• Reattach: when an SLA is marked completed and a new copy is reapplied.
• Cancel: when an SLA is cancelled.

SLA conditions determine what action is performed on a task SLA record.

<table>
<thead>
<tr>
<th>SLA condition</th>
<th>Resultant action on task SLA record</th>
</tr>
</thead>
<tbody>
<tr>
<td>If Start condition matches and both Stop and Cancel conditions don't match</td>
<td>Attach</td>
</tr>
<tr>
<td>SLA condition</td>
<td>Resultant action on task SLA record</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>If Start condition matches, and <strong>When to Cancel</strong> is set to <strong>Start conditions are not met</strong></td>
<td>Cancel if one or more of the specified start conditions no longer match.</td>
</tr>
<tr>
<td>If Start condition matches, and <strong>When to Cancel</strong> is set to <strong>Cancel conditions are met</strong></td>
<td>Cancel when cancel conditions match.</td>
</tr>
<tr>
<td>Pause condition matches</td>
<td>Pause</td>
</tr>
<tr>
<td>If Pause condition matches, and <strong>When to Resume</strong> is set to <strong>Pause conditions are not met</strong></td>
<td>Resume if one or more of the specified paused conditions no longer match.</td>
</tr>
<tr>
<td>If Pause condition matches, and <strong>When to Resume</strong> is set to <strong>Resume conditions are met</strong></td>
<td>Resume if one or more of the specified resume conditions match.</td>
</tr>
<tr>
<td>Start and Reset</td>
<td>Reattach</td>
</tr>
<tr>
<td>Stop</td>
<td>Complete</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

**SLA condition methods when the default cancel and resume conditions are selected**

**SLACCondition methods**

![SLA condition flowchart](image)
Each of these conditions is defined as a method within a Script Include, referenced by an SLA Conditions Rule record.

**SLA condition rules**

SLA condition rules control how the different conditions you define in an SLA definition are combined to determine whether an SLA should attach, pause, complete, reattach, or cancel.

The way that the conditions in an SLA definition are interpreted, to control transitions in state, can be varied using SLA Condition Rules. SLA Condition Rules are defined globally, and can be overridden for specific SLA definitions.

**SLACConditionBase** is the default set of SLA condition rules.

Navigate to Service Level Management > Administration > SLA Condition Rules to see a list of SLA condition records.

**SLACConditionBase script**

The **SLACConditionBase** script include implements the default SLA transitions.

The **SLACConditionBase** script include implements the default SLA condition processing.
To view the script, navigate to Service Level Management > Administration > SLA Condition Rules, then click on the SLAConditionBase entry to view details. The record in the Class name field is the script include that defines the condition processing.

**Note:** We recommend you do not modify this script, but use it as an example for creating your own script includes.

The following diagram shows how the transitions work:

**SLAConditionSimple script**

The SLAConditionSimple script include provides an example modification of default SLA condition processing.

The SLAConditionSimple script include is one of the default supplied SLA condition rules. This shows an example of how you can modify and extend condition processing, by overriding the SLAConditionBase methods, with a ‘simple’ variation that interprets each condition to match a particular transition. For example, for an SLA to attach only the start condition is checked. This affects attach, reattach, and cancel.

To edit this script, navigate to Service Level Management > Administration > SLA Condition Rules, then click on the SLAConditionSimple entry to view or modify details. Click Class name field to open the script include that defines the condition processing.
The following diagram shows how the transitions work:

![Diagram of SLA transitions]

**Extend SLA condition rules**

You can create custom SLA condition class and condition rule records. Custom SLA condition class and condition rule records enable you to modify the logic around one or more of the transitions involved in task SLA processing. The custom records can then be applied globally to the processing of all task SLA records or on a per SLA definition basis.

**Create a custom SLA condition rule**

You can create custom SLA condition rules to determine whether an SLA should attach, pause, complete, reattach, or cancel. SLA condition classes contain script to define processing for an SLA condition rule. Create an SLA condition rule after the SLA condition class is defined.

**Procedure**

1. Define an SLA Condition Class.
   Navigate to **System Definition > Script Includes** and click **New**.
   Within the script in the SLA Condition Class, provide methods to modify one or more of the default SLA transitions (attach, pause, complete, reattach, cancel), defining the conditions for SLA processing. For example, the **attach**
method defines when an SLA is created and attached to a task. The methods need to test a condition, referencing the condition fields on the SLA Definition form.

2. Create an SLA Condition Rule.
   b. Name the SLA Condition Rule.
   c. Select the Script Include defined above in the Class Name reference field.

Example: Example of an SLA Condition Class

For example, including the following method in an SLA Condition Class attaches the SLA if its condition matches the SLA’s start_condition field:

```javascript
attach: function() {
    return (this._conditionMatches(this.sla.start_condition));
},
```

The following is an example which shows the format of a script include that would extend the SLAConditionBase class and provide methods for each of the SLA transitions:

```javascript
var SLAConditionLocal = Class.create();

SLAConditionLocal.prototype = Object.extendObject(SLAConditionBase, {
    attach: function() {
        // insert script here
    },

    pause: function() {
        // insert script here
    },

    complete: function() {
        // insert script here
    },

    reattach: function() {
        // insert script here
    },

    cancel: function() {
        // insert script here
    }
});
```
Invoke an SLA condition rule globally

You can globally change the default set of SLA condition rules.

**About this task**

By default, the `SLAConditionBase` is used for the SLA condition rules. This can be changed by doing the following:

**Procedure**

1. Navigate to **Service Level Management > SLA Properties**.
2. Change the value of the `com.snc.sla.default_conditionclass` SLA property to the new condition rule name:

   ![SLAConditionBase](image)

   **Note:** This is the default condition rule, if no condition rule is specified on an SLA definition.

**Related information**

- [SLA condition rules](#)

Invoke SLA condition rules on a specific SLA definition

You can change the SLA condition rules for a specific SLA definition.

**About this task**

In cases where a particular SLA requires that specific SLA condition rules should be used, you can specify the condition rule to be used within the relevant SLA definition form,

**Procedure**

1. Navigate to **Service Level Management > SLA > SLA Definitions**.
2. Open an SLA definition record.
3. Configure the form to add the **Condition type** field to the form.
4. Specify the appropriate SLA condition rule in the Condition type field

Note: If no condition rule is defined, the global default condition rule is used.

Related information
SLA condition rules

Use SLA retroactive start and pause
You can use retroactive start to retain timing information for an SLA when a task record changes. Retroactive pause prevents immediate breaches and notifications when retroactive start is enabled for SLA definitions.

About this task
When a task record changes, typically a new SLA may be attached, with a new set of timing information. This is useful if you are re-assigning an incident to another group and want to attach a new SLA record with new timing information.

However, you may want to retain time information for the task in specific situations. For example, an incident is raised with a priority of 3 - Moderate and the priority changes to 1 - Critical after 3 hours. A priority 1 SLA is attached to the incident at that time. You can use retroactive start to ensure this SLA timing is adjusted retroactively to count from when the incident was first created, rather than from when the incident's priority changed. This reflects the actual time the user contacted you.

You can use the retroactive pause property to apply pause times to the new SLA.

Procedure
1. Navigate to Service Level Management > SLA > SLA Definitions.
2. Open the relevant SLA definition record.
3. In the Start Condition section, select the Retroactive start check box.
4. From the Set start to, select the event from which the SLA starts.

This option determines the start time used for every task SLA record created from this SLA definition.

For example, you can select Opened to start the SLA from when the task form was initially opened to create the record, which accurately reflects the time the end user contacts the service desk. Alternatively, you can select Created to start the SLA from when the task form was initially saved.
5. To enable the retroactive pause property, select the **Retroactive pause** check box. Enabling this property ensures that the new task SLA record gets any pause time that would have been accumulated during the period between the retroactive start time and now. This pause time increases the breach time with the appropriate amount.

6. Click **Update**.

**What to do next**
When retroactive start is enabled, it may result in task SLAs being breached as soon they attach, which will trigger multiple notifications. To prevent the workflow from being processed for these breached SLAs, set the `com.snc.sla.workflow.run_for_breached` property to false.

**Configure Service Level Agreement (SLA) properties**
You can configure the SLA engine, logging, and repair properties based on the requirements within your organization.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **Service Level Management > Properties**.
2. Select one of the following:
   
   **SLA Engine**
   
   configure properties for the SLA engine.
   
   **SLA Logging**
   
   configure logging properties for SLA Script Includes and logging output destination.
   
   **SLA Repair**
   
   configure properties for the SLA Repair process.

**SLA engine properties**
Administrators can manage the SLA engine using SLA engine properties.

Navigate to **Service Level Management > Properties > SLA Engine** to view SLA engine properties.
## SLA Engine Properties

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.sla.calculation.percentage                           | Maximum 'Actual elapsed percentage' value after which the 'SLA - update calculations' scheduled job will stop regularly calculating the SLA's time values. This is used to prevent 'long since breached' records from being unnecessarily updated. Setting to '0' will stop all calculations and leaving this blank will allow all SLAs to be calculated.  
By default, this is set to 1,000%, so that recalculation stops after the breach is exceeded by a factor of 10.  
• Type: integer  
• Default value: 1000 |
| com.snc.sla.maximum_duration                                 | Maximum duration in days that is allowed in the SLA definition.  
• Type: integer  
• Default value: 1095 |
| com.snc.sla.engine.version                                  | Run the 2011 SLA engine (2010, 2011)  
• Type: choice list  
• Default value: 2011 |
| com.snc.sla.engine.async                                     | Run the 2011 SLA engine asynchronously after |
## SLA Engine Properties (continued)

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>task insert or update operations.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>com.snc.sla.compatibility.breach</td>
<td>Enable compatibility with 2010 'breached' status of SLAs (default: false)</td>
</tr>
<tr>
<td></td>
<td>Only enable if you require the old way of showing breached status (in the stage value), for reporting purposes. Using only the 'breached flag' is preferred</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>com.snc.sla.default_conditionclass</td>
<td>The name of the Script Include class that will be used to evaluate SLA Conditions for the 2011 SLA engine (use to override with your own extension of the SLAConditionBase class)</td>
</tr>
<tr>
<td></td>
<td>• Type: String</td>
</tr>
<tr>
<td></td>
<td>• Default value: SLAConditionBase</td>
</tr>
<tr>
<td>com.snc.sla.workflow.run_for_breached</td>
<td>An update to a Task can result in an SLA being attached that is already breached - for example when an incident that</td>
</tr>
</tbody>
</table>
### SLA Engine Properties (continued)

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>has already been open for a while is upgraded to a high priority with a short resolution SLA.</td>
</tr>
<tr>
<td></td>
<td>By default if there is a workflow specified in the SLA Definition it will not run if the Task SLA is attached and the Planned End Time has already passed.</td>
</tr>
<tr>
<td></td>
<td>Enable this property if you would like the workflow to run for a Task SLA that is already breached when it is attached to the Task.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>com.snc.sla.calculate_planned_end_time_after_breach</td>
<td>Continue to re-calculate the &quot;Planned End Time&quot; of SLAs after they have breached.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>Note: zboot customers do not have this property available in the SLA Engine Properties page.</td>
<td></td>
</tr>
<tr>
<td>com.snc.sla.calculation.use_time_left</td>
<td>Use field business_time_left to calculate breach time instead of</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### SLA Engine Properties (continued)

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
</table>
| business_percentage                               | The business_percentage field. Using business_time_left is more accurate because the business_percentage field is rounded to 2 decimal places. This means that once the business percentage reaches 99.995%, it is recorded as 100%, and the task SLA is marked as breached.  
  - Type: true | false  
  - Default value: false                                                                                           |
| glide.sla.calculate_on_display                    | Recalculate Task SLA records when a Task form is displayed. This ensures that the task SLAs calculations are up to date but this may increase form load time.                                                                                                                       
  - Type: true | false  
  - Default value: false                                                                                           |
| com.snc.sla.always_populate_business_fields       | When this property is set to true, the business fields such as Business elapsed time will be populated with the same values as those in the actual fields when there is no schedule specified on the Task SLA.  
  If the property is false, the business fields will be                                                                 |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
SLA Engine Properties (continued)

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>empty when a Task SLA has no schedule.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true for new instances, false for upgraded instances</td>
</tr>
</tbody>
</table>

SLA logging properties

Administrators can configure SLA logging using SLA properties.

Navigate to Service Level Management > Properties > SLA Logging to view SLA logging properties.

The Logging level for... properties set logging levels for relevant script includes. This allows you to activate extra logging targeted at whenever that script include is invoked via a task SLA. For example, if you know of an issue with the TaskSLAWorkflow script include, you can use the com.snc.sla.workflow.log property to enable logging on that script include. These properties are all set to Notice level by default.

<table>
<thead>
<tr>
<th>SLA Logging Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.sla.task_sla_controller.log</td>
<td>Logging level for TaskSLAController</td>
</tr>
<tr>
<td>com.snc.sla.task_sla.log</td>
<td>Logging level for TaskSLA</td>
</tr>
<tr>
<td>com.snc.sla.condition.log</td>
<td>Logging level for SLAConditionBase</td>
</tr>
<tr>
<td>com.snc.sla.workflow.log</td>
<td>Logging level for TaskSLAWorkflow</td>
</tr>
<tr>
<td>com.snc.sla.calculatorng.log</td>
<td>Logging level for SLACalculatorNG</td>
</tr>
<tr>
<td>com.snc.sla.repair.log</td>
<td>Logging level for SLARepair (SLA repair must be enabled to use this)</td>
</tr>
<tr>
<td>com.snc.sla.log.destination</td>
<td>Logging output destination.</td>
</tr>
</tbody>
</table>
SLA Logging Properties (continued)

<table>
<thead>
<tr>
<th>SLA Logging Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select the log destination: either output to both the Database and node logs (the default), or output to node logs only. Database and node logs <em>(gs.log)</em> are visible as system logs from ServiceNow, node logs <em>(gs.print)</em> only appear in log files.</td>
</tr>
</tbody>
</table>

Logging levels

The following logging levels are available for the Logging level for... properties:

<table>
<thead>
<tr>
<th>Level</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emerg</td>
<td>Emergency</td>
<td>Total failure.</td>
</tr>
<tr>
<td>Alert</td>
<td>Alert</td>
<td>System corruption of a database, for example.</td>
</tr>
<tr>
<td>Crit</td>
<td>Critical</td>
<td>Typically used for hardware errors, for example.</td>
</tr>
<tr>
<td>Err</td>
<td>Errors</td>
<td>Errors</td>
</tr>
<tr>
<td>Warning</td>
<td>Warnings</td>
<td>Warnings</td>
</tr>
<tr>
<td>Notice</td>
<td>Notice</td>
<td>Possible action required but not essential.</td>
</tr>
<tr>
<td>Info</td>
<td>Informative</td>
<td>No action required.</td>
</tr>
<tr>
<td>Debug</td>
<td>Debugging</td>
<td>Generally not used except for capturing everything for fault-finding.</td>
</tr>
</tbody>
</table>

⚠️ Note: By default, logging levels are set to Notice

SLA repair properties

Administrators can manage the SLA repair function using system properties.

Navigate to Service Level Management > Properties > SLA Repair to view SLA repair properties.
Service Level Agreement (SLA) process example

As work is done on the relevant task, the SLA may change stage appropriately, depending on the information defined for that SLA in the relevant SLA definition.

About this task
For example, if an incident is resolved within the time specified, the SLA stage is typically set to Complete.

Similarly, if the incident does not reach the required condition within the set amount of time, the Task SLA record associated to that Incident marked as Has Breached. For example, by default, if a P1 incident is not resolved within 8 hours, the Task SLA for that incident will have Has Breached set to true.

This example demonstrates how an SLA can be attached to an incident, then progressed to completion.
Procedure

1. Navigate to Incident > Create New.

2. Set both Impact and Urgency to 1. This changes the Priority to 1 - Critical.

3. Save the form.

The Task SLA Related List should now have a Priority 1 SLA attached to this incident.

4. Change the Impact to 2, which changes the Priority to 2 - High, then save the form.

The Priority 1 SLA is now marked Cancelled, and a Priority 2 SLA has been attached, because of the conditions on the SLAs.

5. Change the Incident State to Awaiting User Info, then save the form.

Awaiting User Info is a Pause condition on the Priority 2 SLA, so the SLA is marked Paused.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Note:
The pause duration on Task SLA gets updated only after the SLA moves out of pause.

<table>
<thead>
<tr>
<th>Task SLA Name</th>
<th>SLA Definition</th>
<th>Type</th>
<th>Stage</th>
<th>Start Time</th>
<th>Stop Time</th>
<th>Actual Elapsed Time</th>
<th>Actual Elapsed Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task 1</td>
<td>SLA definition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task 2</td>
<td>SLA definition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6. Change the **Incident State** to **Active**, then save the form. Because the incident is no longer in a **Pause** condition, it resumes timing.

<table>
<thead>
<tr>
<th>Task SLA Name</th>
<th>SLA Definition</th>
<th>Type</th>
<th>Stage</th>
<th>Start Time</th>
<th>Stop Time</th>
<th>Actual Elapsed Time</th>
<th>Actual Elapsed Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task 1</td>
<td>SLA definition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task 2</td>
<td>SLA definition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

7. Enter any **Close code** and **Close notes** values in the **Closure Information** section of the incident.

8. Change the **Incident State** to **Resolved**, then save the form. The SLA is marked **Completed**.

<table>
<thead>
<tr>
<th>Task SLA Name</th>
<th>SLA Definition</th>
<th>Type</th>
<th>Stage</th>
<th>Start Time</th>
<th>Stop Time</th>
<th>Actual Elapsed Time</th>
<th>Actual Elapsed Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task 1</td>
<td>SLA definition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task 2</td>
<td>SLA definition</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Add custom business rules to Service Level Agreement (SLA)**

You can add custom business rules to your SLAs.

**Before you begin**
Role required: admin

**Procedure**
Select one of the following methods to add custom business rules.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use setWorkflow(false)</strong></td>
<td><strong>a.</strong> Prior to updating your task, add a call to <code>setWorkflow(false)</code> on the GlideRecord object for the task within the business rule that is updating the task. This prevents the business rules from being processed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The <code>setWorkflow(false)</code> disables processing of all engines and the update does not appear in the audit history of the task.</td>
</tr>
<tr>
<td></td>
<td>For example, a script that copies the breach time to a custom field on the task.</td>
</tr>
</tbody>
</table>
|                             | ```javascript
(function(){
  if (current.planned_end_time.changes()) {
    var taskGr = current.task.getRefRecord();
    taskGr.u_sla_breach_time = current.planned_end_time;
    taskGr.setWorkflow(false);
    taskGr.update();
  }
})();
```                                                                                                                                     |
| **Create a sys_trigger (Schedule job) to update the task**                                                                                       | **a.** In your custom business rule, use the Script field to generate a scheduled job to update the task. To ensure that the scheduled job is queued for processing immediately, it must be of type Run once, and have next action time of Now. |
Option | Description
--- | ---
**Note:** The ScheduleOnce script includes functions to specify the target record and when to run the scheduled job. This enables you to specify the script to be executed and call another function to create the appropriate record in the sys_trigger table.

For example, a script to create a scheduled job that copies the breach time from the task SLA to a custom field on the task.

```javascript
(function(){
    if (current.planned_end_time.changes()) {
        var scheduleJob = new ScheduleOnce();
        scheduleJob.setDocument(t.task.getRefRecord());
        scheduleJob.script = "current.u_sla_breach_time.setValue('" + current.getValue('planned_end_time') + ");current.update();",
        scheduleJob.schedule();
    }
})();
```

Add custom business rules to Service Level Agreement (SLA) considerations

Prior adding custom business rules to the task SLA table, you must consider a few points regarding the processing and calculation of the task SLA based on your organization’s needs.
Add custom fields to the task SLA table

You can add custom fields to the task SLA table and write business rules to populate them. This does not impact the SLA engine. However, you must consider performance implications, if any, of these business rules since task SLAs are updated frequently during their lifecycle.

Points to consider

• Business rule that directly updates the parent task when an SLA is updated. Avoid writing a business rule on the task SLA table that updates the parent task directly. Doing so causes recursive processing of the business rules. This is represented in the diagram.

• Business rule that updates the default fields on a task SLA. Avoid writing a business rule on the task SLA table that updates the default fields. These default fields are managed and updated by the SLA engine, and any updates made to them might result in the following.
  ◦ Fields being ignored, overwritten, or both the next time the SLA is calculated.
  ◦ Incorrect calculations of other values on the task SLA.

Service Level Agreement (SLA) breakdown definitions

Using SLA breakdown, the service owner or service desk manager can see detailed task ownership and SLA duration related data for any task SLA record associated with a task. This helps determine which teams and users are contributing to SLA compliance. SLA breakdown is configurable and typically should be configured for the more significant SLAs such as P1 and P2 resolution.

By default, the system deletes SLA breakdown data that is more than one year old. This is performed by a new table cleanup job `sla_breakdown_by_assignment`. Table cleanup jobs are defined in the [sys_auto_flush] table.

Related information

Configure Service Level Agreement (SLA)
Create SLA breakdown definitions

You can define an SLA breakdown to capture, store, and relay detailed task ownership information and duration for all task SLA records related to a specific task (incident). SLA breakdown is configurable and you can configure it on the basis of a specific SLA definition.

Before you begin
Role required: admin

About this task
SLA breakdown data includes:

• Task SLA
• SLA Definition
• Assigned to
• Assignment Group
• Start time
• End time
• Business time during this period
• Total % of allocated SLA Duration
• Whether the Task SLA is breached during this period

⚠ Note: SLA breakdown is on a per task-type basis. For example, once you define a breakdown definition for Incident that uses the breakdown table [SLA Breakdown by Assignment], you cannot define another breakdown definition for this task type.

SLA breakdown by assignment

Procedure

1. Navigate to Service Level Management > Breakdowns > Breakdown definitions, and click New.
2. On the form, fill in the fields.
SLA Breakdown Definitions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the SLA breakdown.</td>
</tr>
<tr>
<td>Task table</td>
<td>Task table on which the definition is applicable.</td>
</tr>
<tr>
<td>SLA breakdown table</td>
<td>Table where the SLA breakdown data is stored.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For the Madrid release, only a single breakdown table is available: [SLA Breakdown by Assignment].</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to select if the SLA breakdown definition is active.</td>
</tr>
</tbody>
</table>

3. Click **Submit**. The SLA Breakdown Definition Fields and the SLA Definitions related lists appear.

4. Under the **SLA Breakdown Definition Fields** tab, click **New** and fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown field name</td>
<td>Field in the breakdown table that is mapped with the field that you select in the source field.</td>
</tr>
<tr>
<td>Source field name</td>
<td>Field in the task record table which is mapped to the breakdown field.</td>
</tr>
</tbody>
</table>

5. Click **Submit**. The breakdown field and the associated source field appears under the **SLA Breakdown Definitions Field** tab.

6. Under the **SLA Definitions** tab, click **Edit** to relate one or more SLA definitions to the breakdown definition.

7. In the slush bucket, under Collection, select SLA Definitions to related to SLA Breakdown Definition. The breakdown is applied on this task record.

8. Click **Save**. The selected SLA Definitions appear.
Service Level Agreement (SLA) processing

The SLA engine performs two passes to evaluate SLA definitions and their conditions based on a task.

The SLA engine performs the following passes:

1. Checks the SLA definitions that do not have an active SLA record associated to the task. The SLA engine determines if the SLA definition applies to the task and if it needs to create a SLA record. The following condition checks are performed:
   a. If the Start condition is true and the Stop condition is true, do nothing. No SLA record is created, because the Stop condition overrides the Start condition.
   b. If the Start condition is true and the Stop condition is false, a new SLA record is created for this task using the SLA definition. The SLA record is then set to the In Progress stage.

2. Checks all active SLA records associated to the task. The engine determines if the SLA records are changing stage. The condition checks are performed in the following order:
   a. If the Stop condition is true, the SLA changes to Completed and becomes inactive.
   b. If both the Reset and Start conditions are true, the SLA changes to Completed and a new task SLA is created.
   c. If the Start condition is false, the SLA changes to Cancelled and becomes inactive.
   d. If the SLA is active, the Pause condition is true, and the SLA stage is In Progress, the SLA is paused.
   e. If the SLA is active, the Pause condition is false, and the SLA stage is Paused, the SLA changes back to In Progress.

Actual and business elapsed times

Task SLA records contain two sets of timing information: Actual elapsed and Business elapsed.

The difference between these two sets of timing is vital when you create and report on SLA definitions.
- **Actual elapsed** values are calculated on a 24x7 basis.
- **Business elapsed** values are calculated based on the schedule specified in the task SLA. The schedule is taken from the SLA definition by default.

**Note:** If no schedule is specified, then the **Business elapsed time** is the same as the **Actual elapsed time**. This can be disabled by changing the `com.snc.sla.always_populate_business_fields` property to false in the SLA Engine. When this property is set to false, the **Business** fields will be 0 or empty.

By default, the related list for the task SLA record displays the actual elapsed time only. You can configure the list to also display the business elapsed time.

### Elapsed times and schedules

Consider a scenario where an SLA has a defined schedule of 9 am to 5 pm on weekdays. With this schedule, the difference between actual and business elapsed times can be significant.

For example, if a task SLA starts at 2 pm on a weekday, its business elapsed time at 9 am on the next weekday is 3 hours while its actual elapsed time is 19 hours.

![Business elapsed time vs actual elapsed time](image)

In addition, if a schedule defines an 8 hour working day, then 24 hours or one day in business elapsed time equates to 3 days in actual elapsed time.
Example

For example, an incident is opened on Friday, December 12 at 9 pm, outside of the SLA schedule of 8 am to 5 pm on weekdays.

If the current time is the following Monday at 9:30 am, then:

- **Business elapsed time** is 1 hour and 30 minutes because the SLA business timer stopped at 5 pm on Friday and restarted at 8 am on Monday.

- **Actual elapsed time** is 60 hours and 30 minutes, representing the real time between the incident being opened and the current time.

Elapsed percentages are also similarly calculated. The actual elapsed percentage is over 750% while the business elapsed percentage is 19% on an 8 hour SLA.

**SLA calculation**

SLAs are calculated and assessed by a business rule and scheduled jobs that run in the background.

The mechanisms that control SLA Workflow and SLA Automation are independent of each other. You may have a requirement to send out email notifications from the SLA Workflow displaying the current elapsed percentage of the SLA. However, this does not work because using percentage in a notification only displays the most recently calculated value of the Task SLA. This
results in inaccurate values sent out in email when using SLA calculated values in a Task SLA email notification.

One solution is to specify elapsed percentage in SLA notifications by using notifications for each percentage level. For example, an email notification for "75 percent SLA Warning" is created and a special event is used to trigger that notification. The event can be called "sla.warning.75". Another solution is hard-coding these email notifications to trigger at a specified duration percentage, and configure the workflow linked to that SLA definition to send an email notification after waiting an elapsed percentage.

Run the 2011 SLA engine asynchronously

By default in the 2011 SLA engine, the SLA processing is performed by the Run SLAs business rule. This business rule runs synchronously and is the suggested configuration.

Before you begin
Role required: sla admin, admin

About this task
SLA processing runs asynchronously. For example, you can run this for performance reasons, such as to avoid delays when a user saves a new incident record. While the SLA engine is running asynchronously, there can be a short delay before the Task SLA records are available after updating a Task. Refresh the form to see the updated Task SLAs.
Use synchronous processing to get the best user experience. Asynchronous processing mode is used only when there a performance issues.

Note: In the 2010 engine, the Process SLAs business rule runs the asynchronous processing.

Procedure
2. Select Yes for the Execute the 2011 SLA Engine asynchronously (com.snc.sls.engine.async) property.
3. Click Save.

Recalculate SLA times automatically
By default when a user opens a task, the SLA timing information for that task is not automatically recalculated.
About this task
You can enable this information to be automatically recalculated each time the task is opened, to provide current information rather than information from the last scheduled job.

Procedure
2. For the Recalculate Task SLA records when a task's form is displayed property, select the Yes check box.

   i Note: This property is disabled by default because there is a potential performance impact when several users concurrently open tasks.
3. Click Save.

Use exact times in SLA calculations
When business percentages are used for SLA calculations, they are rounded up to two decimal places.

About this task
As a result, breaches can occur when SLA calculations are rounded up to 100%. You can enable SLA calculations to instead use the business time or actual time left.
For example, a business percentage of 99.951% is rounded up to 100%, which causes a breach.
For more accurate SLA calculations, enable the SLA engine property for using the exact value of the business time left if a schedule is specified or the actual time left if the SLA has no schedule specified.

Procedure
2. For the Use field "business_time_left" to calculate breach time instead of "business_percentage" field property, select the Yes check box.
3. Click Save.

Scheduled jobs for SLA
SLA has default scheduled jobs to regularly refresh the time calculations on each active task SLA.
• SLA update (breach after 30 days): repeats every 5 days
• SLA update (breach within 1 day): repeats every hour
• SLA update (breach within 1 hour): repeats every 10 minutes
• SLA update (breach within 10 min): repeats every 1 minute
• SLA update (breach within 30 days): repeats every day
• SLA update (already breached): repeats every day

¹ Note: By default, the SLA update (already breached) scheduled job will calculate either for up to one year after it was breached or if 1000% of its allocated time is breached. You can set this maximum actual elapsed percentage value property in the SLA Engine properties.

Scheduled job runs more frequently when the task SLA is closer to being breached.

Related reference
  SLA engine properties

Related information
  Event scheduling
  Create a scheduled job

Repair Service Level Agreement (SLA)

SLA Administrators can repair SLA records to ensure SLA timing and duration information is accurate.

Repair of SLAs is useful to determine accurate timing information if your system has SLA records that contain incorrect values. For example, you may need to repair SLA records as a result of:

• Changing the SLA definition or SLA schedule for any task SLA that is still active.
• Changing the conditions of the SLA definition for any task SLA that is still active.
• Some other system anomaly.

The repair function removes the SLA record, then recreates and recalculates it from the start, including recreating the workflow. The repair uses the history from the Task and if appropriate will also create new Task SLAs that did not previously exist. For example, a new Task SLA may be needed if a new SLA Definition has been added since an associated Incident was created or updated.
SLA repair does not use the history of dot-walk fields but considers only the final state of the dot-walk fields. For example, if a pause condition is set to an incident dot-walk field as `incident.caller_id.location` and in real time the location is set to London, and later changed to San Diego. Then, when the SLA repair runs, only the final location is considered. So, if SLA is in pause state when the `incident.caller_id.location` is San Diego, repair pauses immediately as it does not consider the previous London location.

The workflow used when recreating the SLAs is controlled by system properties and can be found by navigating to Service Level Management > Properties > SLA Repair. Any workflow that is used in the repair process will attempt to follow a repair path when processing the SLA Percentage Timer activities. This can be used to avoid running activities that are not needed for the repair over and over again.

You can repair single SLAs from the relevant form or multiple SLAs from relevant lists.

⚠️ **Note:** SLA repair is not available on SLA definitions, as running a repair operation for an SLA definition could affect large numbers of records on your system, with significant performance impact.

You can also configure and manage SLA repair functions.

**Configure SLA repair**

Administrators can set SLA repair properties and view repair logs.

**Enable or disable SLA repair**

The Repair SLA function is enabled for all new installed instances running the 2011 engine, but is disabled by default for upgraded instances. If disabled, no SLA repair functions are available, including all SLA repair modules, SLA repair logs, and UI actions.

⚠️ **Note:** Repair actions will not be available for instances that are not running the 2011 engine.

To enable or disable SLA repair, use the `com.snc.sla.repair.enabled` repair property.

⚠️ **Note:** You can also configure SLA workflow usage.

**View repair logs**

An SLA repair log record is created each time a repair action takes place with details such as who initiated the repair and start and end date and time. The log record contains a number of child SLA Repair Log Entry records related to
it. Each repair log entry has a type of either **Before repair** or **After repair** that will contain the appropriate values from each Task SLA record that is repaired. If there is only a **Before repair** entry record for a task SLA, this indicates that it has been deleted. If there is only an **After record**, the repair function has created a task SLA that did not previously exist.

Navigate to **Service Level Management > Repair Logs** to view repair log information:

- **Active Repairs**: view repairs that are still in progress.
- **My Repairs**: view repairs you have run.
- **All Repairs**: view all repairs.
- **Repair Entries**: view SLA Repair Log entries for all repairs that have run.

### Repair SLA from a form

You can repair task SLA records from the Task form, or from the task SLA form for an SLA associated to a Task.

**About this task**

You can also repair multiple task SLA records from a list.
Procedure

1. To repair all SLAs associated to a specific task, open that form and select the Repair SLAs related link.

2. Alternatively, to repair a specific SLA on a specific Incident record, open the Incident record, open the SLA record associated with that incident, then select the Repair button on that SLA form.

   The SLAs selected are repaired. When the repair process is completed, the user selecting to repair receives a standard notification of the repair results.

   **Note:** Closing the progress dialog box does not stop the repair process. You can go to Active repairs or My repairs and click Show progress to view the progress dialog again.
Repair SLAs from a list
You can repair multiple SLA records from a list of task or SLA records.

About this task
You can also repair SLA records from the relevant Task form, or from the SLA form for the SLA associated with the task.

Procedure
1. Navigate to a list of SLA records or task records.
2. Check the records to repair against.
3. Select the Repair SLAs for selected list action.
4. Alternatively, to repair SLAs for all records on that list, select the Repair for all filtered definitions related link.
   The SLAs selected are repaired. When the repair process is completed, the user selecting to repair receives a standard notification of the repair results.

   Note: Closing the progress dialog box does not stop the repair process. You can go to Active repairs or My repairs and click Show progress to view the progress dialog again.

Related information
Repair Service Level Agreement (SLA)

SLA Repair workflow
You can configure workflow usage for SLA repair operations.

Workflow usage
The SLA repair workflow is used if SLA repair functionality is enabled.

When the SLA repair function is in progress and new task SLA records are created, the workflow will follow a repair path through the workflow. The repair path is based on the result of the SLA Percentage Timer activities. While repair is in progress, the result of this activity will be repair, which enables the workflow to follow a different path in order to skip certain actions, such as generating events for notifications. This avoids duplicate notifications from being sent out during the repair process for each SLA that is repaired.

To specify that the SLA repair function should use the SLA's original workflow for repair operations, go to Service Level Management > Properties > SLA Repair and remove the selection from the com.snc.sla.repair.use_repair_workflow repair property.
Note: If you choose to use a non-default repair workflow, or a workflow you have changed, you should modify this workflow to ensure it includes appropriate repair conditions on the **SLA Percentage Timer** activities. When a task SLA is repaired, the repair transitions are followed for any activities that occurred in the past. For example, the Default SLA Repair workflow configures the repair conditions to follow repair transitions.

**Workflows for new or upgraded instances**

For new instances, the SLA Repair function uses the Default SLA workflow, which incorporates repair activities. For upgrades, the SLA Repair function uses the Default SLA Repair workflow because the Default SLA workflow will not be updated in case it has been customized.

To change the default workflow the SLA repair function uses, go to **Service Level Management > Properties > SLA Repair** and set the `com.snc.sla.repair.workflow` repair property.

**Monitoring Service Level Agreement (SLA)**

You can view the details for every task SLA record created for a task.

In the task SLA record, you can view the task SLA details such as the stage the task SLA is in and if it has breached.

You can also view the target of the agreement being defined: **None**, **Response** or **Resolution**.

Target is used for filtering, searching, and reporting purposes only.

Note: This feature is available only in new instances starting with Jakarta or a later release. The Problem Management Best Practice – Jakarta plugin (com.snc.best_practice.problem.jakarta) plugin must be activate.

In addition, you can get an overview of the timings for the task SLA such as the actual and business elapsed time and percentage, and the actual and business time left in days and hours.

**SLA timeline**

The SLA timeline is a feature of the Service Level Management application. The SLA timeline detail helps you understand the progress of an SLA. The timeline provides detailed insight to the task updates which triggered stage changes during the life cycle of a task SLA.

The SLA timeline detail helps you to:
• View the progress of SLAs, OLAs, and underpinning contracts.
• View related task updates.
• Identify the reason a task update triggered a specific stage in the task SLA.
• Debug and verify a task SLA and the SLA definition.

ℹ️  **Note:** This feature is available only on the SLA Engine 2011 version.

Role required: itil, sla_admin, sla_manager

### SLA Timeline field description

<table>
<thead>
<tr>
<th>Levels</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>Specifies the SLA definition name and lists the task SLAs that result from the SLA definition. This field also displays, in the form of symbols, the last known stage, and the completion or the cancellation status, if any, of the task SLA.</td>
</tr>
<tr>
<td>2</td>
<td>Preference to see <strong>Business elapsed time</strong> or <strong>Business time left</strong> on timeline row</td>
<td><strong>Business elapsed time:</strong> Specifies the business time that has accumulated from the beginning of the SLA to its end. <strong>Business time left:</strong> Specifies the business time that is remaining by which the SLA task must be completed.</td>
</tr>
</tbody>
</table>
### SLA Timeline field description (continued)

<table>
<thead>
<tr>
<th>Levels</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| 3      | ![Filter icon] | Enables filtering of the data displayed by the SLA timeline. You can filter data by selecting the following options:  
  - **Show only breached**: When selected, displays the task SLAs that are breached. This check box appears only when the SLA engine property **Enable compatibility with 2010 ‘breached’ stage for SLAs** is set to false.  
  - **SLA Stage**: Select to view the task SLA records that match the final stage of a specific task SLA.  
    - **Note**: If the SLA engine property **Enable compatibility with 2010 ‘breached’ stage for SLAs** is set to true, the **Completed** stage appears as **Achieved** and the **Breached** check box appears under the SLA stage.  
  - **SLA Definitions**: Select to view the task SLA records for a specific SLA definition. |
| 4      | ![Information icon] | Lets you view detailed information about the task when you click the information icon. |
| 5      | ![Zoom icons] | Provides several zoom in/out levels to control SLA timeline zoom resolution. |

**Note**: The selected option from the choice list is saved as a user preference and is selected by default when you navigate to the SLA timeline in the future. Whether you set the system property **Always populate business fields on a Task SLA** to true or false, the SLA timeline always populates the **Business fields for representation**.
### SLA Timeline field description (continued)

<table>
<thead>
<tr>
<th>Levels</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Note:</td>
<td>If the duration of any task SLA is more than 1 year, then the 5-minutes view is disabled because of performance issues and browser limitations. The condition is applicable for all the browsers. For IE and EDGE:</td>
</tr>
<tr>
<td></td>
<td>1.</td>
<td>• The 5-minutes view is not available for any task SLA that has a duration of more than 35 days.</td>
</tr>
<tr>
<td></td>
<td>2.</td>
<td>• The 8-hours view is not available for any task SLA that has a duration of more than 10 months, and the default view is set to 16 hours.</td>
</tr>
<tr>
<td></td>
<td>3.</td>
<td>• The 16-hours view is not available for any task SLA that has a duration of more than 21 months, and the default view is set to 24 hours.</td>
</tr>
<tr>
<td>6</td>
<td>Legend provides the following categories.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Shapes</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ Completed: Symbolizes a task update which completed the task SLA.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ Canceled: Symbolizes a task update which canceled the task SLA.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ Task update: Symbolizes an update of the task.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ Task update with stage change: Symbolizes an update of the task which also led to the change in SLA stage.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ Breach time (Estimated): Symbolizes estimated Breach time of an in-progress task SLA that is not yet breached or paused.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>◦ Expected start: Symbolizes estimated Start time of a task SLA. This scenario is encountered for a retroactive task SLA starting in the future.</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### SLA Timeline field description

<table>
<thead>
<tr>
<th>Levels</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Bar color (SLA Duration)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ Below 50%: Green represents a task SLA stage below 50% of the defined SLA duration.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ In-between 50% and 75%: Yellow represents a task SLA stage between 50% and 75% of the defined SLA duration.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ In-between 75% and 100%: Orange represents a task SLA stage between 75% and 100% of the defined SLA duration.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ Above 100%: Red represents a task SLA stage after the SLA is breached.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ Paused: Gray represents a task SLA stage when it is paused.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Modifiers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ Retroactive (in lighter shade): Represents the stages, updates, and out-of-schedules that are in the retroactive time.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>◦ Out of schedule (with center stripe): Represents the time period that the task SLA was outside of the schedule time defined in the SLA definition.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>Provides a toggle to show and hide task updates that did not cause an SLA stage. Task updates that are not responsible for an SLA stage change can help debug SLA definition conditions.</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>Refreshes the information on the SLA timeline.</td>
</tr>
<tr>
<td>9</td>
<td>Task SLA Details</td>
<td>Displays the details of a task SLA, depending on where you click the timeline.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Stage details</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Task update details</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Out of schedule details</td>
</tr>
</tbody>
</table>
### SLA Timeline field description (continued)

<table>
<thead>
<tr>
<th>Levels</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Stage details:</strong> When you click the update on the task SLA timeline, the stage details section appears with the following information:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Summary of the changes or useful information relevant to the selected stage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Information on stage start and stage end such as the start and the end time, actual elapsed time and percentage, actual time left, pause duration. The stage information also displays any breach of the SLA.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> If no schedule is attached to the SLA definition, then business values are hidden and actual values are displayed. If any schedule is attached to the SLA definition, both the business and the actual values are displayed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Task update details:</strong> When you click the task update, the <strong>Task update details</strong> section appears with the following information:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>SLA definition conditions:</strong> Displays the respective conditions of the task SLA and the values for the related columns at that point for the task. A blue check mark appears for the conditions that affect the SLA stage change.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Time:</strong> Displays the date and the time when an update takes place in the task SLA. It also displays the delta changes that occurred in the task for that update.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Out of schedule details:</strong> When you click the out of business schedule on the task SLA timeline, the outside business period details section appears with the following information:</td>
</tr>
</tbody>
</table>
SLA Timeline field description (continued)

<table>
<thead>
<tr>
<th>Levels</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• <strong>Start date:</strong> Displays the start date of the selected task SLA.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>End date:</strong> Displays the end date of the selected task SLA.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Duration:</strong> Displays the duration of the current out of schedule selection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Total out of schedule duration:</strong> Displays the total out-of-schedule hours until the end of the current selection.</td>
</tr>
</tbody>
</table>

<i>Note:</i> Click < and > to navigate to the left and right task update in the details section.

<i>Note:</i>
The SLA timeline receives information about the task from the audit history and refers to the current SLA definition to pull data for the SLA timeline. The SLA timeline displays task SLA information as though the SLA repair is already executed, irrespective of whether it is executed or not.

**Related information**

- Use SLA timeline to determine business schedule
- Use SLA timeline to understand SLA stage change
- Use SLA Timeline to validate a new SLA definition
- Understand why an SLA did not trigger as expected

**Verify SLA definition using SLA timeline**

You can verify that a task is mapped appropriately with a defined SLA using the SLA timeline. If a task is mapped with the SLA definition, the SLA timeline displays a graphical representation of the progress of the task SLA.

**Before you begin**

Role required: admin
Procedure

1. Navigate to SLA > SLA Definitions.
2. Click the SLA Definition that you want to verify.
3. Click the Validate SLA Definition related link. The SLA Timeline page appears.
4. From the SLA Definition Picker, select the SLA definition for which you want to confirm if an appropriate task is mapped.
5. From the Task Record Picker, select the task that must be mapped to the SLA definition.
   If the selected task is mapped to the SLA definition, then the SLA timeline displays a graphical progress of the task SLA.

Note:

When a selected task does not have any task SLA attached to it, the SLA timeline still displays the update to the task when the Show all Task updates check box is selected. This information can be used for debugging the task SLA.

View SLA timeline

You can view an SLA timeline from a Task SLA record or from an SLA definition.

About this task
Role: itil, sla_admin, sla_manager
To view the SLA timeline:

Procedure

You can open an SLA definition from the following:

<table>
<thead>
<tr>
<th>Location</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA definition</td>
<td>Navigate to Service Level Management &gt; SLA &gt; SLA Definitions. Click on the name of the SLA definition and then click the Validate SLA Timeline link.</td>
</tr>
<tr>
<td>Task SLA record</td>
<td>Open a task SLA record from the task form. Click the Validate SLA Timeline link to view the SLA timeline for that specific SLA.</td>
</tr>
</tbody>
</table>
Click the Validate SLA Timeline link that appears under related links in the task form. The SLA Timeline appears with the list of all the SLAs that are associated with the task.

Right-click on a Task SLA in the related list on a task form such an incident record and select the Validate SLA Timeline option. The SLA Timeline appears for the specific SLA.

The SLA timeline for the selected task or incident is displayed. It includes SLA report details and visual representation of the progress of the task SLA over the lifetime of the task.

Understand why an SLA did not trigger as expected

Describes the conditions when an SLA might not trigger as expected.

Using Task SLA -1 (highlighted in the screenshot) as an example, an SLA Manager may have expected this SLA to trigger earlier.

To troubleshoot this inconsistency, the SLA Manager can enable Show all task updates from the settings menu in the upper right of the SLA Timeline. The SLA timeline displays task updates that do not cause an SLA stage change as a white triangle.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
If you click the first or second task updates that did not cause a stage change, the details section displays the SLA start conditions and the task values that are key to trigger the start condition. In this case, the Configuration Item field is not populated and the SLA Definition conditions are defined to trigger when the Configuration Item is defined as the CI SAN 001.

On inspecting the details for the task update that triggered the SLA start condition, you can find that the configuration item is set to Storage Area Network 001 and this matches the SLA Definition start condition.

Show all task updates is a powerful tool to help SLA Managers understand why an SLA may not have behaved as expected.
Use SLA timeline to determine business schedule

This example demonstrates how to use the SLA timeline to determine the business schedules and business percentage time related to a task SLA.

In the example above, the business percentage for the priority 2 incident is 0 seconds. The dark stripe in the SLA timeline determines the time when the SLA was out-of-schedule. The SLA time is not calculated during the out-of-schedule time. So, the business elapsed time is 0 since the total duration of this SLA is out of schedule.

If you want more detail of the out-of-schedule duration, you can hover over the dark stripe for summary detail or click it. The Out of Schedule detail section
provides information on the details of the schedule such as when the out of schedule started, when it ended, the current duration of that out of schedule time and the total duration of all out of schedule time for the entire SLA. This provides detailed insight into when the SLA was accumulating time and the periods of time it did not accumulated time.

Using another example, you can understand in details how business time in an SLA is calculated. In the example below, the total SLA defined duration for Task SLA-2 is 8 hours. The highlighted area shows that the SLA is out of schedule from 07:00AM until 08:00AM and starts accumulating time at 8:00AM reaching 50% of it’s total duration at 12:00PM. From 12:00PM to 14:00PM the SLA accumulates from 50 – 75% of it's total duration and from 14:00PM to 16:00PM it accumulates from 75 – 100% of it's total duration, ultimately breaching at 16:00PM.

At any time, you can hover over any stage to get a summary of it’s detail or click a stage to get comprehensive detail of that SLA’s stage, including a summary and detail of the stage start and stage end.
Details of task stage

Use SLA timeline to understand SLA stage change

Describes how you can understand SLA stage changes using SLA timeline.

Using Task SLA-2 as an example, you can see a period of retroactive and out of schedule time preceding the task update that caused the SLA to attach to INC0010001. The task update is represented by the first triangle. When this event is selected, the detail pane displays and the Start tab has a blue check and is highlighted indicating this is the SLA Definition condition this event met and the task values which matched the SLA Definition start condition.

When the second task update represented by the second black triangle, which triggered an SLA stage change occurs, you can see that it triggers a pause condition. If you select this event in the timeline, the detail pane displays the
highlighted Pause that contains a blue check indicating a match. Once again, the task values which match the SLA Definition condition are displayed so you easily know why the stage change occurred.

Similarly, when the third task update which triggers a stage change occurs, you can see this resumes the SLA. When that update is clicked, the Stage details section highlights the Resume tab which now contains a blue check and provides detailed information about the task update that occurred and the SLA conditions those updates matched.

The SLA continues to accumulate time, until it is breached and this is visually represented by the yellow, orange, and the red colors. Eventually, another task update occurs which triggers the SLA’s cancel conditions that is represented by the white diamond. The Stage details section highlights the conditions for the
task SLA cancellation. In this case, the SLA Definition is defined to cancel when the ‘Start conditions are not met’.

Use SLA Timeline to validate a new SLA definition

When a new SLA Definition is created the SLA Timeline can be used to see how the SLA will behave against existing task records.

From the SLA Definition form, open the SLA Timeline by clicking the Validate SLA Definition related link. Select a task by using the task picker in the upper left. The SLA Definition automatically populates for you. When a task is selected that matches your SLA Definition, the SLA Timeline allows you to inspect the different elements of the SLA.

SLA timer

Use the SLA timer component to track the amount of time that is required to complete the task as defined by the matching SLA definition.

The SLA timer component is designed to visually display the current status of the Task SLA. You can also view more information about the task in the tooltip, such as the SLA definition name, the remaining time to breach, and the percentage
completed details. When your task is in-schedule, then the tooltip provides extra information, such as the out-of-schedule details.

The timer component can show any of the following stages depending on the current status of the task.

### SLA timer stages

<table>
<thead>
<tr>
<th>Stage</th>
<th>Color code</th>
<th>Description</th>
</tr>
</thead>
</table>
| In-progress | ![00:08]    | The stage of the timer when the task SLA is in progress. You can find more information about the schedule and time on tooltip. The color code changes for in-progress state:  
- ![00:04] green to yellow: When the time to complete reaches 50%  
- ![00:02] yellow to orange: When the time to complete reaches 25% |
| Breached    | ![Breached] | The stage of the timer when the time allocated to complete the task SLA is over. The tooltip provides more information on the time that the task was breached. |
| Cancelled   | ![Cancelled] | The stage of the timer when the task SLA is cancelled. On the tooltip, you can see the time when it was cancelled.                               |
| Paused      | ![Paused]   | The stage of the timer when the task SLA is paused or put on-hold.                                                                        |
### SLA timer stages (continued)

<table>
<thead>
<tr>
<th>Stage</th>
<th>Color code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Achieved (2010 SLA engine)</td>
<td>🔄 Achieved</td>
<td>The stage of the timer when the task SLA is achieved. The information on when it was achieved is seen on the tooltip.</td>
</tr>
<tr>
<td>Completed</td>
<td>🔄 Completed</td>
<td>The stage of the timer when the task SLA is completed. You can see when the it was completed on the tooltip.</td>
</tr>
<tr>
<td>Out of Schedule</td>
<td>🔄 Out of Schedule</td>
<td>The stage of the timer when the task SLA goes out-of-schedule. You can find more information about the schedule and time on tooltip.</td>
</tr>
</tbody>
</table>

**SLA timer configurations**

Configure the SLA timer to determine which task SLA must be displayed as part of the timer component.
Before you begin
Role required: admin, sla_admin, sla_manager, itil, or sn_slm_timer.sla_timer_admin

About this task
All Service Level Agreement (SLAs) attached to a task, such as an incident, problem, or change are of equal importance. However, on various scenarios and user interfaces, you might want to configure a hierarchy of preferred SLAs. After configuring the hierarchy, you can determine from the list, the most important or preferred SLA that can be displayed.

The `slm-timer-config-api` application provides the ability to set a preferred SLA for a given task using the configuration that is either dynamic, such as First SLA to breach or declarative from a hierarchical mapping of first to matching SLA definitions.

The SLA timer configuration provides the following demo data which also serves as an example to customize.

- **Do not show SLA timer**
  Use this configuration if you do not want to show the timer component.

- **Show SLA that will breach first**
  Use this configuration to determine the task SLA that has the earliest breach time.

- **Incident Response and Resolution Team**
  Use this configuration if you prefer to display Task SLA matching specific SLA Definition in the timer component. This configuration creates hierarchy of SLA Definitions to be displayed.

The SLA Timer Configuration application comes only with demo data, it is always advisable to create your own configuration records. You can use the demo data as a guide to help ensure the preferred task SLA record is shown against a particular task.

Procedure
1. Navigate to **Service Level Management > Administration > SLA Timer Configuration**.
2. Click **New**.
3. On the forms, fill in the fields.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the SLA timer configuration</td>
</tr>
<tr>
<td>SLA timer source</td>
<td>Choose any one of the following:</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong></td>
</tr>
<tr>
<td></td>
<td>When you do not want to show the timer.</td>
</tr>
<tr>
<td></td>
<td><strong>First to breach</strong></td>
</tr>
<tr>
<td></td>
<td>When you want to display the task SLA with the earliest breach time.</td>
</tr>
<tr>
<td>Note:</td>
<td>When a task SLA with the earliest breach time pauses, goes out of schedule,</td>
</tr>
<tr>
<td></td>
<td>or is completed, then the next task SLA is displayed.</td>
</tr>
<tr>
<td>Task to SLA mapping</td>
<td>When you want to create your own display hierarchy of task SLAs. If you</td>
</tr>
<tr>
<td></td>
<td>choose this option, you must define the SLA Definition mappings to ensure</td>
</tr>
<tr>
<td></td>
<td>that there is always a preferred SLA definition.</td>
</tr>
<tr>
<td>Show completed</td>
<td>Select if you want to display the preferred task SLA that includes the</td>
</tr>
<tr>
<td></td>
<td>breached stage. If this option is selected, on complete, it will not move</td>
</tr>
<tr>
<td></td>
<td>to the next SLA priority.</td>
</tr>
<tr>
<td>Show completed</td>
<td>Select if you want to display the timer when the task SLA canceled. If this</td>
</tr>
</tbody>
</table>
4. Click **Update**.

5. Open the SLA configuration you created.

6. If the SLA timer **Source** is set to **Task to SLA Mapping**, then you must configure the mappings.

7. To configure the task to SLA mapping, click **New** in the **SLA timer configurations mappings** related list.

8. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLA timer config</td>
<td>Select the timer config from the look-up list. If created from related list, the timer config will be auto-populated with the parent record.</td>
</tr>
<tr>
<td>Order</td>
<td>The hierarchical order of the task SLA. This value is pre-populated. However, you can edit it based on your requirements.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table that the task belongs to, for example, Incident, Problem, or Change. This is used as a reference qualifier on the SLA definition.</td>
</tr>
<tr>
<td>SLA definition</td>
<td>Select the SLA definition that is available for the table.</td>
</tr>
</tbody>
</table>

**Note:** If there is an identical mapping for the **Order** or **SLA definition** in the selected table, the configuration is prevented using business rules. This check ensures that there is always only one preferred SLA definition at each level in the hierarchy.

9. Click **Submit**.

**Trouble?**
If no configuration sys_id is provided to the sla-timer-configuration API, then default behaviour is:
• **SLA Timer source**: First to Breach
• **Show cancel**: true
• **Show complete**: true

However, as a best practice do not provide a configuration sys_id to the application. Setup their your own configuration, even if it is identical to the default behavior.

### SLA notifications

SLA sends notifications at certain events defined in the workflow.

By default, SLA notifications are sent on three occasions:

1. SLA is at 50% of the duration specified in the SLA Definition: Notification is sent to the user in the **Assigned to** field mentioned in the incident form and the **Supported by** field in the configuration item form.

2. SLA is at 75% of the duration specified in the SLA Definition: Notification is sent to the user in the **Assigned to** field mentioned in the incident form and the manager of the user.

3. SLA is breached: Notification is sent to the user in the **Assigned to** field mentioned in the incident form and the manager of the user.

### Related information

**Workflows for SLA**

### Legacy Service Level Agreement (SLA) engines

If you are on an earlier version of the SLA engine, you can upgrade to the 2011 engine to make use of the complete service level management functionality.

The SLA engine has three versions:

<table>
<thead>
<tr>
<th>SLA engine version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation engine (pre-2010)</td>
<td>Tracks only one SLA per task.</td>
</tr>
<tr>
<td>The 2010 engine (the Service level management plugin)</td>
<td>Supports multiple SLAs per task. Business rules handle the processing of these SLAs while workflows handle notifications. The majority of logic is in a single large business rule called Process SLAs.</td>
</tr>
<tr>
<td>SLA engine version</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>The 2011 engine (also part of the Service level management plugin)</td>
<td>The 2010 SLA engine functionality is concentrated into a number of script includes. Provides retroactive pause calculations and enables the customization of SLA condition processing through the use of condition rules.</td>
</tr>
</tbody>
</table>

### Legacy SLA fields

Previously, only a single SLA could be attached to a task via the Escalation engine. The information for the SLA was stored in the task table using the **SLA Due**, **Made SLA**, and **Escalation** fields.

The Task SLA engine now enables multiple SLAs to be attached to a single task, making the earlier task fields redundant. Their equivalents are in the **task_sla** table for each SLA attached to the task.

- **Task SLA, Breach time**: This is equivalent to the SLA Due field
- **Task SLA, Has breached**: This will be true if the SLA has breached, the opposite of **Made SLA** field.
- There is no equivalent field for **Escalation** field. Notifications can be sent via the SLA workflow and an increase in priority can trigger additional SLAs to be attached to the task.

**Note:** The **Business Duration** field is neither part of the Escalations Engine nor the Task SLA Engine.

The fields on the **Task** are considered legacy and are not updated by the Task SLA engine. In case these fields are being updated, the legacy Escalation engine may still be running. This can happen if you have upgraded from Express or a previous instances.

To prevent the Escalation engine from running, set the `com.snc.sla.run_old_sla_engine` property to false. If this property is set to false and the fields are still being updated, check the customizations made to your instance.

### Migrate to service level management

Migrate SLA processing from the escalations engine to use the service level management functionality.

The two core differences between the old SLA engine and the new service level management plugin are that tasks can now run multiple SLAs simultaneously,
and the escalation concept has been replaced with the more robust Workflow Editor. This allows administrators greater control on what actions, notifications, and events are triggered by tasks, to take into account more mature Service Level processes.

If an instance has been using the original SLA engine and has just activated the Service Level Agreements (SLA) Plugin, the old SLAs will not work. For the old SLAs to work, they must be converted to the new SLA Definition records, which will attach the appropriate Task SLA records to the matching Task records. This is done manually by creating new SLA Definition records that reflect the definition of the old SLA. Old SLAs will continue to function, but any time a task is updated, the appropriate new Task SLAs will attach.

Once new Task SLAs are implemented, they will attach themselves to any new or updated incident, including ones which already have old SLAs attached. If the new Task SLA is set to retroactively start, it will automatically calculate the duration from that point in the past, which means that the duration will still be accurate.

When enabled, the property **Compute prior SLA pause time for new, retroactive SLAs (2011 SLA engine only)** calculates the pause time when a retroactive SLA is attached.

For example: if a retroactive SLA attaches to an incident one hour after its creation, and meets the pause conditions for half an hour, then the elapsed time is half an hour rather than the full hour.

![Note:](image) **Note:** This property is only used with audited tables. Tables which are not audited ignore the pause time before the creation of the record.

### Move from the 2010 Engine to the 2011 Engine

You can upgrade SLA processing to use the 2011 Engine.

#### About this task

The service level management plugin was enhanced with the ability to script the condition rules for SLA transitions, giving control over how the conditions in an SLA Definition are used. Please review the documentation before enabling the enhancements to understand how the new engine will impact existing customizations.

![Note:](image) **Note:** Activating the 2011 SLA engine will deactivate all business rules on the `task_sla` table (except for the rule `Task SLA Empty Schedule Warning`, which is part of the 2011 engine). If you have added any additional business rules or customized the default business rules, these will not be automatically deactivated. So you should review these customizations, and manually deactivate such business rules, before making this change.
The default Process SLAs rule on the task table will also be deactivated, so any customizations to this script must be incorporated into the new SLA engine.

In addition, breach information is removed from the Stage field, and stored in the new Has breached field.

To enable the new functionality:

**Procedure**

1. Navigate to Service Level Management > SLA Properties.
2. Change the following property from 2010 to 2011:

   **Example**

   ![Which version of SLA engine to run (Default '2011' for new installations)](default)

   By default, the 2011 Engine sets the Stage field to In Progress, shaded red to indicate the breached status, and sets the Has Breached field to true. The SLA continues to run until the stop conditions are met.

**Organize the migration process**

There are several ways to convert the old SLAs to the new Task SLAs.

**About this task**

Perform the following steps to organize the conversion process:

**Procedure**

1. Convert the old SLAs to new SLA Definitions, but leave the Active flag unchecked on each one.
2. Back up the old SLAs by exporting the table to XML.
3. Deactivate the old SLAs, setting the Run the old SLA engine (System Policy -> SLA Management) system property (com.snc.sla.run_old_sla_engine) to false.

   This deactivates the legacy SLA engine preventing both engines from running and conflicting. This property is set to true by default, but will be set to false by the new SLA plugins, effectively deactivating the old SLAs.
4. Activate the new SLA Definitions by checking the Active flags on each one.
5. Navigate to Incident > Open and use the List Editor to “touch” each record. As each record is updated, the new Task SLA will attach to each incident. If there are too many open incidents to effectively touch using the List Editor, run a business rule that will update every open incident.

**Convert an SLA to an SLA Definition**

You must replicate the default SLA record as a new SLA definition.

**About this task**

To convert old SLAs to SLA Definitions:

**Procedure**

1. Transfer the Name and Table fields.
2. If desired, check the Retroactively Start checkbox. If checked, this will cause the SLA to calculate from the moment the record is created (or from the date and time on the selected task), rather than the moment the SLA is attached. This is especially helpful for Task SLAs that will attach to active incidents that have old SLAs currently running.
3. Transfer the Conditions field to the Start Conditions field. Make sure to add Active is True as well, so that the new Task SLAs don’t attach to closed incidents when they are updated.
5. Set the Duration Type and Duration fields. The old SLAs did not support relative duration, so to define the Task SLA to behave similarly to the old SLA, select User Defined Duration as the Duration Type and put the total length of time of all of the escalations here.

**Example**

For instance, an old SLA that has escalations of 4 hours to Moderate, 2 hours to High, and 2 hours to Overdue, the new Task SLA should have Duration set to Days 0 Hours 08:00:00.

6. Calendars have been replaced by Schedules, so if schedules haven’t been defined yet, they will need to be.
7. Instead of escalations, attach an SLA Workflow. There is a default SLA workflow, however, you must create a new workflow to replicate the escalation levels on the old SLA. Escalation Levels are defined hour-by-hour, whereas the SLA Workflow uses a percentage timer.
Example
So for the above example of 4 hours to Moderate, 2 hours to High, and 2 hours to overdue, the workflow will need a 50% timer and then two 25% timers. The new task SLA records do not use the Escalation or Made SLA fields on the task record.

Example:
The following example is an old SLA for Priority 1 incidents to be resolved on a Monday-Friday (8-5) Calendar, with escalations to Moderate at 4 hours, to High at 2 hours, and to Overdue at 2 hours:

This is the new Task SLA created from the same information:
New SLA example

This is the workflow which powers the new Task SLA.

**Note:** This example workflow responds to each escalation by firing off an event. A business rule can be configured to respond to escalation events, or the workflow can be adjusted to match the organization's process.
Task SLA table

The Task SLA [task_sla] table stores Task SLA records for the SLAs attached to particular tasks.

For each task, attached SLAs are accessible in a related list on the Task's form.

<table>
<thead>
<tr>
<th>Task SLAs</th>
<th>Go to SLA definition</th>
<th>Search</th>
<th>1 to 2 of 2</th>
</tr>
</thead>
</table>

The SLA form for a task shows further details:

Stage values

The following **Stage** values are defined:

- In progress
- Cancelled
• Paused
• Completed

⚠️ Note: The Breached stage value is also available for systems either using the 2010 SLA engine, or running in compatibility mode.

Timing information

The Timings fields on the Task SLA contain the crucial information powered by the SLA Engine:

### Task SLA Time-Based Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>The time the SLA was started.</td>
</tr>
<tr>
<td>Stop time</td>
<td>The time the SLA ended.</td>
</tr>
<tr>
<td>Breach time</td>
<td>The time the SLA will breach, adjusted for business pause duration (for task SLAs with a schedule specified) or pause duration (for task SLAs with no schedule).</td>
</tr>
</tbody>
</table>

⚠️ Note: Breach time is the same as Planned end time.

<table>
<thead>
<tr>
<th>Actual Elapsed Time</th>
<th>Time between start time and now (minus pause duration).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual Elapsed Percentage</td>
<td>Percentage of total SLA that has elapsed (minus pause duration).</td>
</tr>
<tr>
<td>Actual Time Left</td>
<td>Time remaining until SLA breach.</td>
</tr>
<tr>
<td>Business Elapsed Time</td>
<td>Time within the specified schedule between start time and now (minus pause duration).</td>
</tr>
<tr>
<td>Business Elapsed Percentage</td>
<td>Percentage of total SLA that has elapsed within the specified schedule (minus pause duration).</td>
</tr>
<tr>
<td>Business Time Left</td>
<td>Time within the schedule remaining until SLA breach.</td>
</tr>
</tbody>
</table>
Task SLA Time-Based Fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original breach time</td>
<td>The date/time the SLA would breach, as calculated when the SLA is first attached.</td>
</tr>
</tbody>
</table>

⚠️ **Note:** You may have to configure the form to see this field.

---

**Reactivate escalation engine**

Escalation engine is replaced with 2011 SLA Engine.

**Before you begin**

Role: admin

**About this task**

ServiceNow Express used the legacy Escalation Engine to process SLAs. If for any reason a customer who has upgraded from ServiceNow Express to ServiceNow Enterprise wants to reactivate the Escalation engine, they can follow the steps below.

**Procedure**

1. Navigate to sys_properties.list.
2. Update the property `com.snc.sla.run_old_sla_engine` to `true`.

⚠️ **Note:**

ServiceNow recommends using the 2011 SLA Engine.

---

**Service level management overview dashboard**

The Service Level Management Overview Dashboard provides insight into Service Level Agreement (SLA) information relevant to the logged-in user. By default, the Overview dashboard is available to users who possess the itil role.

The Overview Dashboard is enabled by default for new customers. Customers upgrading from a prior release have to enable the Service Level Management Dashboard plugin (com.snc.sla.overview) to activate this feature.

You can navigate to the dashboard in the following ways:

- **Service Level Management > Overview**
- **Self – Service > Dashboard > SLA Overview**
## SLA overview dashboard

### UI component | Description
--- | ---
My at Risk SLAs | Number of active task SLAs for tasks assigned to the logged in user that have not yet breached but have elapsed 75% of the duration of the SLA.
My Active Breached SLAs | Number of active task SLAs for tasks assigned to the logged in user that have breached.
My Active SLAs (count) | Number of active task SLAs for tasks assigned to the logged in user.
My Groups Active SLAs (count) | Number of active task SLAs for tasks assigned to groups that the logged in user is a member of.
My Active SLAs (bar chart) | Displays a bar chart of active task SLAs for tasks assigned to the logged in user. The data can be grouped and/or stacked on some of the fields available in the task SLA records.
My Groups Active SLAs (bar chart) | Displays a bar chart of active Task SLAs for Tasks assigned to groups that the logged in user is a member of. The data can be grouped and/or stacked on some of the fields available in the task SLA records.
My Active SLAs (list) | Displays a list of active task SLAs for tasks assigned to the logged in user. The data can be grouped on some of the fields available in the task SLA records.
Analytics and Reporting Solutions for Service Level Management

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Enabling the Performance Analytics Solution

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

Note: Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.

To enable the solution for Service Level Management, an admin navigates to System Definitions > Plugins and activates the Service Level Management PA Dashboard (com.snc.pa.sla.overview) plugin.

To use this Analytics and Reporting Solution, you must have an entitlement to use Performance Analytics with Service Level Management.

Domain separation and 'Run As' user

By default, System Administrator is the Run As user for data collection jobs in the Analytics and Reporting Solutions. Verify that this user exists on the instance, and whether this user has the appropriate level of access. An inappropriate Run As user can cause errors or limit the data that is collected. This setting only has an effect if domain separation is enabled.

Related information

Analytics and Reporting Solutions
Activate your Performance Analytics subscription

Service level management PA dashboard

The Service Level Agreement (SLA) Overview module provides a Performance Analytics (PA) Dashboard to review SLA information at a glance.

Users with the itil role can access the dashboard.

You can navigate to the PA dashboard in the following ways:

• Service Level Management > Overview
• Self – Service > Dashboard > SLA Overview (Premium)
This dashboard has the following requirements:

- An entitlement to use Performance Analytics with Service Level Management.
- The Service Level Management PA Dashboard (com.snc.pa.sla.overview) plugin, which contains this dashboard.
- The SLA Breakdowns plugin (com.snc.sla.breakdowns) plugin, because some of the reports are generated from the breakdown data.

### Overview tab

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Duration of Active Breached SLAs | Uses available SLA breakdown data to generate a report showing time spent working on breached task SLAs that are still active and the SLA Definition Type is SLA.  
Use the Group by and Stacked By breakdown lists to show different representations of this data, for example: Group by Assignment group and Stacked By SLA Definition.  
The Assignment Group filter on the right can be used to limit the data shown in this report to a specific group. |
| Active Breached SLAs   | This chart shows all breached task SLAs that are still active and the SLA Definition Type is SLA.  
Use the Group by and Stacked By breakdown lists to show different representations of this data, for example: |

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### UI component | Description
--- | ---
| Group by Assignment group and Stacked By SLA Definition. The Assignment Group filter on the right can be used to limit the data shown in this report to a specific group. |  
Achieved SLAs in Last 30 Days | This chart shows all task SLAs that completed in the last 30 days without breaching and where the SLA Definition Type is SLA. Use the Group by and Stacked By breakdown lists to show different representations of this data, for example: Group by Assignment group and Stacked By SLA Definition.

### KPI tab
The KPI dashboard uses the following Performance Analytics indicators:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Version introduced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average durations of breached task SLA closed today</td>
<td>London</td>
</tr>
<tr>
<td>Number of closed task SLA today</td>
<td>London</td>
</tr>
<tr>
<td>Average duration of achieved SLA today</td>
<td>London</td>
</tr>
<tr>
<td>Number of achieved closed task SLA today</td>
<td>London</td>
</tr>
<tr>
<td>Achieved SLAs Today</td>
<td>London</td>
</tr>
</tbody>
</table>

⚠️ Note: These indicators are calculated on a daily basis to provide trend analysis.

Further operations are performed on the Performance Analytics indicators to generate the following KPIs on the dashboard:

### KPIs based on Performance Analytics indicators

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>% of Active Breached SLAs (Daily)</td>
<td>Shows the % of active task SLAs that breached yesterday.</td>
</tr>
</tbody>
</table>
### KPIs based on Performance Analytics indicators (continued)

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Assignment Duration (Breached)</td>
<td>Shows the average duration of individual assignments for breached task SLAs completed yesterday. The KPI that provides the data captures this value on a daily basis to provide trend analysis. This report is based on SLA breakdown data and so shows data only for SLA definitions that are linked to an SLA Breakdown definition.</td>
</tr>
<tr>
<td>% of Achieved SLAs (Daily)</td>
<td>Shows the % of task SLAs that were completed yesterday without breaching. The KPI that provides the data captures this value on a daily basis to provide trend analysis.</td>
</tr>
<tr>
<td>Average Assignment Duration (Achieved)</td>
<td>Shows the average duration of individual assignments for achieved task SLAs completed yesterday. The KPI that provides the data captures this value on a daily basis to provide trend analysis. This report is based on SLA breakdown data and shows data only for SLA definitions that are linked to an SLA Breakdown definition.</td>
</tr>
<tr>
<td>Average Duration of Assignments for Breached SLAs</td>
<td>Shows the average duration of individual assignments for breached task SLAs completed yesterday broken down by either Assignment group or SLA Definition. Use the Breakdown field to change which breakdown data is displayed. The KPI that provides the data captures this value on a daily basis to provide trend analysis. This report is based on SLA breakdown data and shows data only for SLA definitions that are linked to an SLA Breakdown definition.</td>
</tr>
<tr>
<td>Average Duration of Assignments for Achieved SLAs</td>
<td>Shows the average duration of individual assignments for achieved task SLAs completed yesterday broken down by either Assignment group or SLA Definition. Use the Breakdown field to change which breakdown data is displayed. The KPI that provides the data captures this value on a daily basis to provide trend analysis.</td>
</tr>
</tbody>
</table>
KPIs based on Performance Analytics indicators (continued)

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This report is based on SLA Breakdown data and shows data only for SLA definitions that are linked to an SLA Breakdown definition.</td>
</tr>
</tbody>
</table>

Domain separation and Service Level Management

Domain separation is supported in Service Level Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Standard

- Includes Basic level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

Overview

- Service Level Management helps customers monitor, measure, and report on agreed service level agreements (SLAs); SLA definitions encapsulate these agreements.
- Users can see only content in the domain to which they have access.

How domain separation works in Service Level Management

The intention of SLM is to provide customers with an expectation of service within a known timescale and the ability to monitor when service levels are not being met. To learn specific terms and definitions see Service Level Management concepts.
• SLA definitions and task SLAs have domain fields. However, task SLAs are created only in the domain of its attached task record.

• SLA definitions must be defined in a tenant domain (or global) in order for task SLAs to be created and attached to a given task (or extensions).

• Task SLAs attach to a task if an SLA definition exists in the task records domain or in an ancestor domain.

• Task SLAs always inherit the domain of its attached task record, which includes the workflow running on the task SLA record.
  ◦ If a task record ever flips, the task SLA also flips.

• If an SLA definition exists in an ancestor's domain, the definition can be overridden in a sub-domain (delegated administration).

Domain-separated tables
• SLA definition [contract_sla]
• Task SLA [task_sla]

Use cases
• An ESS user in the ACME domain logs in and creates an incident, at which point an SLA is attached. The SLA is created in the domain of the associated task record (incident), which is the ACME domain. The ESS user is not able to read SLA records. These are restricted to the following roles:
  ◦ Administrator
  ◦ ITIL
  ◦ SLA Administrator
  ◦ SLA Manager

• An ITIL user in the Acme domain logs in and creates an incident. The process above is the same except that the ITIL user can read the SLA record attached to the incident.

• If an SLA definition exists in the Acme domain and doesn’t meet the needs of an Acme sub-domain (Acme child) an SLA Administrator can remediate. SLA Administrators can navigate to the ACME SLA definition when their session domain is ACME child, make the relevant changes, and save them. The SLA Administrator is alerted that an override has been created.

• An ITIL user sets the session domain to Acme child and creates an incident. The task SLA is created using the SLA definition from Acme child.
Related information

Domain separation for service providers

Quick start tests for Service Level Management

Validate that Service Level Management still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Service Level Management quick start tests require activating the Service Level Management - ATF Tests plugin (com.snc.service_level_management.atf).

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLM: Service Level Management Task SLA completed workflow</td>
<td>Tests that a user can create a task SLA and complete the workflow.</td>
<td>Orlando</td>
</tr>
<tr>
<td>SLM: Service Level Management Task SLA cancelled workflow</td>
<td>Tests that a user can create a task SLA and cancel the workflow.</td>
<td>Orlando</td>
</tr>
<tr>
<td>SLM: Service Level Management Task SLA timer REST API</td>
<td>Tests that the SLA Timer API response matches data expected by SLA Timer Seismic component.</td>
<td>Paris</td>
</tr>
</tbody>
</table>

Related information

Quick start tests

Site Reliability Operations

Enterprises rely on digital services to deliver modern customer experiences. These digital services run on applications that need rapid development, testing, and production to deliver business outcomes. Companies delivering digital transformation outcomes are moving more workloads to the cloud and focusing on modular apps and micro services. It is becoming a team sport for DevOps and Site Reliability Engineers (SRE). The ServiceNow® Site Reliability Operations (SR Ops) application facilitates the operations of Site Reliability Engineering (SRE) teams.
Site Reliability Engineering (SRE) defines the reliability goals, measure those goals, and work to improve the services as needed. Site reliability engineers can register services, monitor service health, and respond to alerts and incidents effectively with the Site Reliability Operations application.

SR Ops provides SRE teams with the ability to:

- Manage their on-call schedules and escalations
- Correlate telemetry signals from monitoring tools
- Manage alert rules for telemetry signals

SR Ops provides Central IT Operations with:

- Central visibility of services registered by SRE Teams
- Visibility into the work of distributed teams without slowing them down

Watch the following video for a general understanding of SR Ops and how it is used. Getting started with the Now Platform user interface

**Visit our community**

For thought leadership, prescriptive guidance, and to interact with the product team and other customers using SR Ops, visit the [SR Ops community](#).

**Get Started with SR Ops**

There are two main guides to set up SR Ops. First, there is the SR Ops setup guide that will help administrators setup and configure the product. This guide will also cover any setup that Central IT needs to do before the SRE teams begin using the product. Then there is the SR Ops user guide which covers what an SRE team needs to do to start managing the services they own in SR Ops.
Supported Integrations

- Telemetry integrations
  - AWS
  - Azure
  - Datadog
  - Dynatrace
  - Google Cloud
  - Grafana
  - New Relic

- Collaboration Integrations
  - Slack
  - Microsoft Teams

- Notification Integrations
  - Twilio
  - Nexmo

Get help from SR Ops resources

- Ask or answer questions in the SR Ops community.
- Contact Customer Service and Support.

SR Ops setup guide

The SR Ops app is available on the ServiceNow Store. After you sign up for SR Ops Workspace, here's how you can get started.
### Process to set up SR Ops for your organization

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>See this</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ ✔️ ✔️</td>
<td>Install the Site Reliability Operations application and several supporting applications.</td>
<td>Install the Site Reliability Operations application</td>
</tr>
<tr>
<td>📑</td>
<td>Assign user roles</td>
<td>User roles and responsibilities in SR Ops</td>
</tr>
<tr>
<td>🔧 Optional: Set up SMS and voice notifications</td>
<td>You have the option to install and configure SMS and voice channels for notifying SREs.</td>
<td>Optional: Set up SMS and voice notifications</td>
</tr>
<tr>
<td>🔧</td>
<td>Configure a unique and optimized change request type for SR Ops.</td>
<td>Configure the change request type for SR Ops</td>
</tr>
<tr>
<td>🔧</td>
<td>Perform quick-start set up</td>
<td>Quick-start set up for SR Ops</td>
</tr>
</tbody>
</table>

Watch the following video to know more about setting up Site Reliability Operations and Site Reliability Metrics.

Setting up Site Reliability Operations and Site Reliability Metrics.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Install the Site Reliability Operations application

Install the Site Reliability Operations application and several supporting applications.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

• SR Ops requires the following ServiceNow product. Ensure that the product is installed before you install SR Ops.

  **ITSM Standard product**

  The IT Service Management (ITSM) solution provides scalable workflows to manage and deliver IT services to your users. See IT Service Management.

• SR Ops requires the following plugins. Ensure that these plugins are activated before you install SR Ops.

  **Required ServiceNow plugins**

  **Event Management plugin (com.glideapp.itom.snac)**

  The Event Management application enables users to create cases proactively from alerts either manually or through automation.

  ◦ For correct operation, the SR Ops-Managed Alert alert management rule must be the first rule to run (order=1).

  ◦ Any items matched against the rule are excluded from processing by following alert management rules (intended operation).

• The following plugin is optional but recommended. Ensure that the plugin is activated before you install SR Ops.

  **Notify (com.snc.notify)**

  Notify provides platform features for workflow-driven voice calls, conference calls, and SMS messages. See Optional: Set up SMS and voice notifications.

  **Note:** If you do not install and configure Notify, you can only use the email notifications.

• SR Ops requires the following ServiceNow Store application. Ensure that the application is installed before you install SR Ops.
Alert Rules Management plugin (sn_em_arm)

The Alert Rules Management application enables Event Management users to respond automatically to alerts. An alert management rule determines the required alert response, such as to open an incident, knowledge base article, open a task, and launch remediation action. Alert rules management help you respond to alerts. You can create filters to specify conditions for the rule so that the remedial action specified in the rule takes effect only when the conditions are met. For example, launch the required subflow or open an incident based on an alert. The alert’s execution history is automatically updated to indicate the actions. Ensure you are either in the Paris Patch 7 or Quebec Patch 1 release version.

Event Management Connectors

The Event Management Connectors app enables Application Performance Management (APM) tool to send alerts to SR Ops. The APM tools enable organizations to monitor the performance metrics of their business critical applications, receive timely alerts in case of performance issues, and generate reports for periodic performance analysis. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Role required: sro_admin or sro_manager

About this task

Roles and demo data are installed with SR Ops. The demo data includes templates that speed up implementation and help users to understand SR Ops quickly. For more information on roles, see User roles and responsibilities in SR Ops.

Procedure

1. Uninstall any previous versions of SR Ops, including the underlying tables.
2. Uninstall any previous versions of Modern Ops Workflow, including the underlying tables.
3. Navigate to System Applications > All Available Applications > All.
4. Find the Site Reliability Operations application using the filter criteria and search bar.
You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

5. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install SR Ops.

6. Optional: If demo data is available and you want to install it, click Load demo data.

(Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

Important: If you don’t load the demo data during installation, it’s unavailable to load later.

7. Click Install.

User roles and responsibilities in SR Ops

With user roles, you can grant users access to different parts of the SR Ops console. In other words, what users can or cannot do in SR Ops is decided based on their roles.

SR Ops has the following pre-defined roles:

<table>
<thead>
<tr>
<th>Roles</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
</table>
| sro_admin      | Administrators can manage account settings, configurations, and users.      | • sro_manager
                 | Administrators can perform the following actions:                          | • sro_user
                 | • Access, create, edit, or delete all configurations                       |                                      |
                 | • Define and change user roles                                             |                                      |
## Roles and responsibilities (continued)

<table>
<thead>
<tr>
<th>Roles</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
</table>
| sro_manager    | Managers oversee a team of SREs. Managers assign SREs to the team on-call schedule, monitor their performance, create procedures to deal with incidents, and develop solutions. Managers ensure resilience across all the systems and the DevOps workflows. Managers can perform the following actions:  
• Define and setup and teams, services, and on-call schedules  
• Add and delete users | sro_user                                                                 |                |
| sro_user       | An SRE that uses the SR Ops application to perform everyday tasks. Users are the individuals who are on call. They diagnose and remediate alerts and incidents in SR Ops.  
Users can only access the configurations that they are a part of. They can only access the alerts which they have permission for.  
SREs can perform the following actions:  
• Manage their profiles  
• Confirm their on-call schedules  
• Manage incident and alert records  
• Access the SR Ops homepage and dashboards | An sro_user inherits the following roles:  
• cmdb_read  
• flow_operator  
• itil  
• app_service_admin |                |
Optional: Set up SMS and voice notifications
You have the option to install and configure SMS and voice channels for notifying SREs.

Before you begin
Role required: sys_admin

Procedure
1. Install Notify and the appropriate connectors. See About Notify and Activate Notify on docs.servicenow.com. Any one of the following connectors are required:
   - Twilio connector
   - Nexmo connector
2. After you have installed Notify, go to Notify Numbers. Assign one or more SMS- and voice-capable Notify Numbers to the Site Reliability Operations Notify group.

Configure the change request type for SR Ops
Configure a unique and optimized change request type for SR Ops.

Before you begin
Role required: admin

Procedure
Complete the following steps to add a new choice to the Type field to change requests.

a. Open an existing change request.

b. Right-click the Type field and select Show Choice List.

c. Click New and fill in the following fields:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Select the Change Request table.</td>
</tr>
<tr>
<td>Label</td>
<td>Site Reliability Ops</td>
</tr>
<tr>
<td>Value</td>
<td>site_reliability_ops</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Sequence</td>
<td>Enter a sequence for the change type. For example, 4.</td>
</tr>
</tbody>
</table>

d. Click **Submit** to save the record.
For more information on adding a new change type, see **Add a new change request type.**

**Quick-start set up for SR Ops**

To create an SR Ops team for the first time, users request the catalog item that is used to create new team. Import and configure the update set that includes the base-system catalog item and its supporting IntegrationHub flows.

**About this process**

An IntegrationHub flow supports the team creation process and a subflow supports team updates. In the default flow, a System Administrator must approve requests to create a team. You can change the approver.

In this one-time procedure, you import and commit an update set that includes the catalog item and flows. You then configure the catalog item and flows to support your business processes. When you finish this process, team members and managers will be able to start using SR Ops.

**Import and commit the quick-start update set**

Because global-scope components cannot be shipped as part of a ServiceNow Store application, you install the update set separately.

**Before you begin**

Role required: sys_admin

**Procedure**

1. On the ServiceNow Store page for the Site Reliability Operations application, navigate to the Resources section.
   In the following steps, you import the downloaded XML file to your instance.
3. Elevate your privileges to the security_admin role.
4. Navigate to **System Update Sets > Retrieved Update Sets.**
5. Click the **Import Update Set from XML** link.
6. Click **Choose File** and select the Manage_Teams_Flows.xml file.
7. Click **Upload.**
The update set appears in the Retrieved Update Set related list in the **Loaded** state.

In the following steps, you preview the update set and address any issues. When all issues are fixed, you can commit the update set.

8. Click **Preview Update Set**.

   The Update Set Preview page shows results and lists problems.

9. Fix any issues and then click **Commit Update Set**.

**Activate the quick-start team catalog item**

To create an SR Ops team, users request a particular catalog item. You import and configure the base-system catalog item.

**Before you begin**

Role required: sys_admin

**Procedure**

1. Navigate to **Service Catalog > Maintain Items**.

2. In the **Catalog Items** list, search for **Create New Team** and then click the name.

   The Catalog Item form opens.

3. In the application picker, select the **Site Reliability Ops** scope.
On the Catalog Item form, click **Copy**. The system creates a clone of the catalog item.

On the form for the new catalog item, click the **Process Engine** tab.

Select **Global – Create New SRO Team** in the **Flow** field.

The update set that you imported added the flow to the Create New Team catalog item.

Modify the settings as needed for your team, select the **Active** check box, and then save the record. For example, you might want to move the catalog item to a different catalog or category or change the title and description.

Right-click in the heading and select **Copy sys_id** to copy the sys_id of the catalog item to the clipboard. You will use the sys_id when you configure the SR Ops system properties.

### Configure quick-start system properties

Configure the system properties that support creation of SR Ops teams.

**Before you begin**

Role required: sro_admin

**Procedure**

1. Navigate to **Site Reliability Operations > Administration > Properties**.
2. Set the following property values:

<table>
<thead>
<tr>
<th>Property</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog Item (sys_id) which is used to Create a Team</td>
<td>sn_sro.create_team_cat_item Set the value to the sys_id of the preconfigured catalog item. You copied the sys_id of the catalog item to the clipboard in the <strong>Activate the quick-start team catalog item</strong> procedure.</td>
</tr>
<tr>
<td>Update team subflow name</td>
<td>global.global__update_team_subflow</td>
</tr>
<tr>
<td>Property</td>
<td>Setting</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_sro.update_team_subflow</td>
<td>Tip: Copy/paste the value because it includes two underscore characters in a row.</td>
</tr>
</tbody>
</table>

**Results**
The basic processes for creating an SR Ops team are now in place. You have the option to use the flow designer to customize the flow. For more information on how to update a flow, see Edit a flow.

**Configure notifications and approval for team creation**
The system sends an email to the requester of a new SR Ops team when the request is approved or rejected. You can configure the email messages and configure which user role can approve requests for a team.

**Before you begin**
Role required: admin

**About this task**
In the default flow, a System Administrator must approve requests to create a team. This procedure shows you how to change the approver.

The default flow includes email message notification. This procedure shows how to customize the content of the notification messages for any of the following cases:

1. Validation of the request failed. Team is not created. Record of the request is updated.
2. Validation of the request passed. Change request to create the SR Ops team is rejected. Team is not created. Record of the request is updated.
3. Validation of the request passed. Change request to create the SR Ops team is approved. Attempt to create the SR Ops team succeeded. Team is created. Record of the request is updated.
4. Validation of the request passed. Change request to create the SR Ops team is approved. Attempt to create the SR Ops team failed. Team is not created. Record of the request is updated.
**TRIGGER**

**Service Catalog**

**ACTIONS**

1. **SR Ops - Manage Acme Team Action**

2. **Create Team Request Record**

3. **If Validation Failed then**
   - 3.1. **Update Team Request Record**
   - 3.2. **Send Email**

4. **If Validation Passed then**
   - 4.1. **Requested Item Admin Approval**
   - 4.2. **If Rejected then**
     - 4.2.1. **Update Team Request Record**
     - 4.2.2. **Send Email**
   - 4.3. **Else**
     - 4.3.1. **SR Ops - Manage Acme Team Action**
     - 4.3.2. **If Create Succeeded then**
       - 4.3.2.1. **Update Record**
       - 4.3.2.2. **Send Email**
   - 4.3.3. **Else**
     - 4.3.3.1. **Update Team Request Record**
     - 4.3.3.2. **Send Email**
Procedure
1. Navigate to Flow Designer > Designer and click Create New SR Ops Team.
2. Follow this procedure to change the approver:
   a. Select Requested Item Admin Approval and click the Subflow Designer icon.
   b. On the Subflow Designer, click Ask For Approval.

INPUTS & OUTPUTS

Subflow Inputs & Outputs

ACTIONS

1. Ask For Approval

2. If Admin Approval is Rejected then
   2.1. Assign Subflow Outputs
   2.2. End
c. On the Ask For Approval form, specify the role that should approve or reject requests to create an SR Ops team and then click **Close**.

<table>
<thead>
<tr>
<th>Action</th>
<th>Ask For Approval</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Record</strong></td>
<td>Input Requested Item</td>
</tr>
<tr>
<td>Table</td>
<td>Requested Item [sc_req_item]</td>
</tr>
<tr>
<td>Approval Field</td>
<td>Approval</td>
</tr>
<tr>
<td>Journal Field</td>
<td>Approval history</td>
</tr>
<tr>
<td><strong>Rules</strong></td>
<td></td>
</tr>
<tr>
<td>Approve</td>
<td>When:</td>
</tr>
<tr>
<td>Anyone approves</td>
<td>System Administrator</td>
</tr>
<tr>
<td>OR</td>
<td></td>
</tr>
<tr>
<td>Reject</td>
<td>When:</td>
</tr>
<tr>
<td>Anyone rejects</td>
<td>System Administrator</td>
</tr>
</tbody>
</table>

3. To update an email template, click the **Send Email** command in the flow, edit the fields as needed, and then click **Done**.

Example email template form:
4. Click **Save** to save your updates to the flow.

5. Click **Activate** to make the flow available for use.
Set up the first SR Ops team

To set up a team, you first request a team catalog item and then specify team members. If your request is approved, you are granted the sro_manager role. The first time that you set up a team, you do it in the Service Portal. For every subsequent team, you use a streamlined process in the SR Ops Workspace.

Before you begin
Role required: admin

Procedure

1. On the Service Portal, search for the catalog item that is used to create a team name.
   The catalog item was created during initial setup. For more information, see Activate the quick-start team catalog item.

2. Request the catalog item and fill in the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and meaningful name for the team.</td>
</tr>
<tr>
<td>Manager</td>
<td>Person who manages the team.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When your request for a team is approved, you are granted the sro_manager role.</td>
</tr>
<tr>
<td>Members</td>
<td>Users who will be team members.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the team that will help others to understand its organization and purpose.</td>
</tr>
<tr>
<td>Email</td>
<td>Email address that includes all team members.</td>
</tr>
<tr>
<td>Tags</td>
<td>Tags that can help other users search for your team.</td>
</tr>
</tbody>
</table>

3. Click Save.
   Your request is submitted for approval to the admin. When the request is approved, the following things happen:
• The team is created. The term sr_ops appears next to the team title to indicate that the team is created from SR Ops.
• You are granted the sro_manager role.
• The team can be assigned to support a service.

Note: SR Ops users create and manage teams through asynchronous flows. By default, approvals are required. In some cases, therefore, changes made in the UI and the resulting database updates may be delayed.

Results
To create additional teams, you use a streamlined process in the Site Reliability Ops Workspace. See Set up an SR Ops team.

Upgrade from Paris
Upgrading your instance from Paris requires you to run fix scripts.

Run script to load service map on the Service form
Run the Updating map component references fix script so that service map is available for instances that are upgraded from Paris to any later releases.

Before you begin
Role required: admin

About this task
If you upgrade your instance from Paris to any later releases, you will not be able to see service map on the Service form. The fix script Updating map component references fixes this issue and it runs only on the new instances starting the Quebec release. It does not run on the instances that are upgraded from Paris to any later releases. You need to manually run the Updating map component references fix script.

Procedure
1. Navigate to System Definition > Fix Scripts.
2. Search for the Updating map component references script and click to open it.
3. Click Run Fix Script.
4. On the pop-up window, click Proceed.
   The service map loads on the Service form.
Run script to load the Operator Workspace module on the SR Ops workspace

Run the `Nocpit component id change Quebec+` fix script so that the Operator Workspace module appears on the SR Ops workspace.

**Before you begin**
Role required: admin

**About this task**
If you upgrade your instance from Paris to any later releases, you will not be able to see the Operator workspace component on the SR Ops workspace. The fix script `Nocpit component id change Quebec+` fixes this issue and it runs only on the new instances starting the Quebec release. It does not run on the instances that are upgraded from Paris to any later releases. You need to manually run the `Nocpit component id change Quebec+` fix script.

**Procedure**
1. Navigate to **System Definition > Fix Scripts**.
2. Search for the `Nocpit component id change Quebec+` script and click to open it.
3. Click **Run Fix Script**.
4. On the pop-up window, click **Proceed**. The Operator Workspace module appears on the SR Ops workspace.

Run fix scripts manually when you upgrade to Quebec from Paris 12.0

If you are in SR Ops Paris 12.0 and you upgrade to Quebec, you need to run some fix scripts manually so that you get the functionality for the updated map component, change workflow conditions, and integration actions for services and integrations.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **System Definition > Fix Scripts**.
   On the list, you will find the following scripts:
   - Synchronize Integration Actions 2 ARM
   - Updating map component references
2. For each script, perform the following actions:
   a. Click to open the fix script.
   b. Click **Run Fix Script**.
   c. On the pop-up window, click **Proceed**.

### SR Ops user guide

The SR Ops guide will help you become skilled at creating and administering teams, services, and integrations.

## User process in SR Ops

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>See this</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Team Icon] Set up an SR Ops team</td>
<td>Set up a team and define services for the team. Teams are responsible for the issues that occur in the associated services.</td>
<td>Set up an SR Ops team</td>
</tr>
<tr>
<td>![On-call Schedule Icon] Set up on-call schedule and escalation policies</td>
<td>Create an on-call schedule for your team to ensure that dedicated support team members are available to resolve issues as they arise. You can set up an escalation policy for your team so that at least one team member is engaged in incident response.</td>
<td>Create an on-call schedule for your team</td>
</tr>
<tr>
<td>![Service Canvas Icon] Create services and configure service relationships</td>
<td>Use a map canvas to add, configure, and arrange services. You can add child services that depend on parent services.</td>
<td>Create services and configure relationships between them</td>
</tr>
<tr>
<td>![Goal Icon] Establish you goal on how well your service should operate. Also specify the maximum amount of time that a technical</td>
<td>Establish you goal on how well your service should operate. Also specify the maximum amount of time that a technical</td>
<td>Create a reliability indicator</td>
</tr>
<tr>
<td>Step</td>
<td>Description</td>
<td>See this</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Establish SLO &amp; error budget for services</td>
<td>system can fail without contractual consequences.</td>
<td></td>
</tr>
<tr>
<td>Integrate service with an APM tool</td>
<td>Set up the integration with an Event Management Application Performance Management (APM) tool — the push connector that sends alerts to SR Ops.</td>
<td>Integrate service with an APM tool</td>
</tr>
<tr>
<td>Set up alert rules</td>
<td>Alerting rules allow you to define alert conditions. Set up alert rules for each APM tool to define the conditions when the APM tool should send notifications to SR Ops.</td>
<td>Specific integrations in SR Ops</td>
</tr>
<tr>
<td>Register change</td>
<td>Create a change request to propose an alteration in a supported configuration item (CI).</td>
<td>Create a change request from a service</td>
</tr>
</tbody>
</table>

**SR Ops Workspace home page**

The SR Ops workspace home page provides relevant information about your work, services, schedules and maintenance reminders, and teams. View this home page by navigating to **Site Reliability Operations > Site Reliability Ops Workspace**.

**Site Reliability Ops Workspace home page sections**

In the workspace, click the home page icon (🏠) to view this home page.

**Home page sections**

- **My Work**
- **Alerts**
  - This table lists the alerts that are assigned to you.
- **Incidents**
  - This table lists the incidents that are assigned to you.
- **Approvals**
  - This table displays the approval status for the approvals submitted by you.
**Home page sections (continued)**

<table>
<thead>
<tr>
<th>Changes</th>
<th>This table lists the change requests that are assigned to you.</th>
</tr>
</thead>
</table>

**Services**

This table lists the services you own. It also lists the services that you manage or support as a team member of the support group responsible for the service. You can use the filter icon (✓) to filter services as required. You also have the option to create a new service by clicking **Create New Service**.

This table also lists query-based services or technical services that either you own or that you are part of the support group for the service. You can’t create or delete query-based or technical services in SR Ops, but you can manage these services, in the same way that you can create integration or alert rules for them.

**Reminders**

<table>
<thead>
<tr>
<th>Next on-call shift</th>
<th>Lists the upcoming on-call schedule for the team that you are a member of. Clicking the schedule takes you to the calendar view of the schedule.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next maintenance schedule</td>
<td>Lists the upcoming maintenance schedule for the team that you are a member of. Clicking the schedule opens the calendar view of the schedule.</td>
</tr>
</tbody>
</table>

**My Teams**

Details of the teams that you are a member of, or teams that you manage. To create a team, click the create team icon (+).

---

**SR Ops system properties**

You configure the system properties that support operations in SR Ops.

To access property settings, users with admin roles navigate to **Site Reliability Operations > Administration > Properties**.

<table>
<thead>
<tr>
<th>Properties for SR Ops</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Property Description</td>
<td></td>
</tr>
<tr>
<td>Update team subflow name</td>
<td>Name of the subflow that updates SR Ops team</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| sn_sro.update_team_subflow                   | - Type: text  
- Default value: global.global_sr_ops__process_update_team_subflow  
- Other possible values: As needed  
- Location: Site Reliability Operations > Administration Properties |
| Catalog Item (sys_id) which is used to Create a Team | Sys ID (sys_id) of the catalog item that is used to create a team.                                                                                                                                          |
| sn_sro.create_team_cat_item                  | - Type: sys_id  
- Default value: 92098f92e7a21010e10f6584c2f6a94a  
- Other possible values: As needed  
- Location: Site Reliability Operations > Administration Properties |
| Sys ID of the record producer that drives creation of service relationships | Sys ID (sys_id) of the record producer that drives creation of service relationships.                                                                                                                     |
| sn_sro.relationship_rp_sysid                 | - Type: sys_id  
- Default value: 66112d470f3110103cb43ab1df767e28  
- Other possible values: As needed  
- Location: Site Reliability Operations > Administration Properties |
| List of communication channels (comma separated) used to send notifications to users in the group if no contact preferences are set. Allowed values: email for E-mail, sms for SMS, voice for Voice calls | Comma-separated list of notification channels for team members where no contact preferences are set. Allowed values: email, sms, and voice. |
| sn_sro.notification_communication_channels    | - Type: CSV  
- Default value: email, sms, voice |
### Properties for SR Ops (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_sro.acknowledgement.workflow.wait_time</td>
<td>Time (in minutes) that SR Ops On-Call workflows wait to receive user acknowledgement.</td>
</tr>
<tr>
<td>- Type: integer</td>
<td></td>
</tr>
<tr>
<td>- Default value: 1440</td>
<td></td>
</tr>
<tr>
<td>- Other possible values: As needed</td>
<td></td>
</tr>
<tr>
<td>- Location: Site Reliability Operations &gt; Administration Properties</td>
<td></td>
</tr>
</tbody>
</table>

To learn more, see Optional: Set up SMS and voice notifications.

### SR Ops notifications

Notifications are sent to users based on various factors, such as on-call schedule of the team, team shift, user preferences, and the Notify settings.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-call schedule is installed, and shifts and user preferences are defined</td>
<td>Notification is sent to the users in the on-call shift as per the user preferences.</td>
</tr>
</tbody>
</table>
| On-call schedule is installed, shifts are defined but user preferences are not defined | • If Notify is installed and Twilio is configured, notifications are sent as voice calls.  
• If Notify is not installed, notifications are sent using emails. |
| On-call schedule is installed but shifts and user preferences are not defined | Notification is sent to all channels that are defined in the property sn_sro.notification.communication.channels. |
### SR Ops notifications (continued)

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-call schedule is installed, user preference is defined but shifts are not defined</td>
<td>Notification is sent as per the channels mentioned in the user preferences.</td>
</tr>
<tr>
<td>If the on-call schedule is not installed</td>
<td>Notification is sent to all users in the team associated with a service.</td>
</tr>
<tr>
<td>• If Notify is installed, notification is sent using all the channels, such as email, sms, and voice.</td>
<td></td>
</tr>
<tr>
<td>• If Notify is not installed, notification is sent using email.</td>
<td></td>
</tr>
</tbody>
</table>

### Working with teams, schedules, and escalations

Setting up and using your teams builds your experience with SR Ops and identifies champions who can help drive SR Ops adoption across your organization.

Teams are responsible for the issues that occur in the associated services. You can add an on-call schedule to your team to ensure that the right person is always available to quickly respond to alerts from a service.

**Set up an SR Ops team**

Set up a team and define services for the team. Teams are responsible for the issues that occur in the associated services.

**Before you begin**

Role required: sro_admin or sro_manager

**About this task**

The first time that you set up a team, you do it in the Service Portal. For more information, see Set up the first SR Ops team. After you create your first team, you set up all subsequent teams using the process described in this topic.

**Procedure**

1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. Use one of the following methods to open the Create New Team form and then fill in the form:
• On the Home page, in the My Teams section, click the Create New Team icon (➕).

• On the Teams page (👥), click Create New Team.

Create New Team form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and meaningful name for the team.</td>
</tr>
<tr>
<td>Manager</td>
<td>Person who manages the team.</td>
</tr>
<tr>
<td>Note: When your request for a team is approved, you are granted the sro_manager role.</td>
<td></td>
</tr>
<tr>
<td>Members</td>
<td>Users who will be team members.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the team that will help others to understand its organization and purpose.</td>
</tr>
<tr>
<td>Email</td>
<td>Email address that includes all team members.</td>
</tr>
<tr>
<td>Tags</td>
<td>Tags that can help other users search for your team.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

Your request is submitted for approval to the admin. When the request is approved, the following things happen:

• The team is created. The term **sr_ops** appears next to the team title to indicate that the team is created from SR Ops.

• You are granted the sro_manager role.

• The team can be assigned to support a service.

**Note:** SR Ops users create and manage teams through asynchronous flows. By default, approvals are required. In some cases, therefore, changes made in the UI and the resulting database updates may be delayed.
What to do next
If your team does not have any on-call schedule associated, the workspace displays a notification to configure the schedule.

Related reference
User roles and responsibilities in SR Ops

Related information
Set up the first SR Ops team

Set up on-call schedule and escalation policies for your team
Set up an on-call schedule for your team to ensure that the right person is always available to quickly respond to incidents and critical alerts. On-call schedules determine who is on call or available at a given time.

Before you begin
Role required: sro_admin or sro_manager

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. On the Home page, click the teams icon ( ).
3. On the team card, click the More actions icon ( ) and then click Create On-Call Schedule.
   The On-Call Scheduling application opens a wizard that helps you to set up the schedule.

4. Set up the schedule and escalation policies for your team.
For information on how to set up schedule, see Configure or update an On-Call schedule.

Note: To get details on the active or closed escalations, view the on-call escalations log.

Manage your team details
Add or edit team members, description, contact information of your team.

Before you begin
Role required: sro_admin or sro_manager

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. On the Home page, click the teams icon.
3. Click the team card whose details you want to update.
4. On the form, update the details as required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the team.</td>
</tr>
<tr>
<td>Manager</td>
<td>Person who manages the team.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the team that will help others to understand its organization and purpose.</td>
</tr>
<tr>
<td>Email</td>
<td>Email address that includes all team members.</td>
</tr>
<tr>
<td>Parent Team</td>
<td>Team of which the current team is a sub-team. Sub-grouping allows for better management of the group.</td>
</tr>
</tbody>
</table>

5. Click Save.

Manage your team members
Add new team members to your team. Edit the list of existing team members as required to plan, manage, resolve issues, and increase the efficiency of your business operations.
Before you begin
Role required: sro_admin or sro_manager

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. On the Home page, click the teams icon ( ).
3. Click the team card and then click the Members tab.
4. Click Manage Members.
5. In the Manage Members dialog box, add or delete members, and click Save.

Manage services for your team
Add or update the list of services associated with your team. Subscribing a team to a service creates alerts for the team members of that service. Team members are notified whenever there is a new incident within the service or any changes are made to the incident.

Before you begin
Role required: sro_admin or sro_manager

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. On the Home page, click the teams icon ( ).
3. Click the team card and then click the Members tab.
4. Click Manage Services.
5. In the Manage Services dialog box, add or delete required services, and click Save.

Create an on-call schedule for your team
Create an on-call schedule for your team to ensure that dedicated support team members are available to resolve issues as they arise. On-call schedules determine who is on call or available at a given time.

Before you begin
Role required: sro_admin, sro_manager, or sro_user
Procedure

1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. Use one of the following methods to create an on-call schedule for your team:
   - Click the Home page icon (🏠) and in the My Teams section, click the More actions icon (⋯) and then select Create On-Call Schedule.
   - Click a team card to open it in the form view, click the More actions icon (⋯), and then select Create On-Call Schedule.

View on-call schedule of a team

View on-call schedules of your team to ensure that the right person is always available to quickly respond to incidents and outages.

Before you begin
Role required: sro_admin, sro_manager, or sro_user

Procedure

1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. On the Home page, click the teams icon (👥).
3. On the team card, click the More actions icon (⋯) and then select View On-Call Calendar.

View on-call calendar

Teams

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
View your on-call schedules

View all your on-call schedules to quickly respond to incidents and outages.

Before you begin
Role required: sro_admin, sro_manager, or sro_user

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. On the Home page, click the List icon ( ) and then click On-Call Schedules > My Schedules.
   You can view all your schedules that you manage or you are a member of.

Deactivate a team

Deactivate a team when you no longer need it.

Before you begin
Role required: sro_admin or sro_manager

About this task

Note: A team can be re-activated only by an administrator.

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. On the Home page, click the teams icon ( ).
3. On the team card, click the More actions icon (⋮) and then select **Deactivate**.

**Deactivate a team**

![Image](image-url)

**Working with services**

A service can represent a team that you want to open incidents against. When you create a service in SR Ops, it must reflect a service in your infrastructure. You can add Event Management Application Performance Management (APM) tool integrations to that service to receive events from those APMs.

**Configuring and integrating a service**

When you create a service, you specify the basic tasks and parameters that define what makes up your service and how it should behave.

**The process of configuring a service**

To add and register services in the SR Ops Workspace, you need to go through the following process:

- **Create a web service account**
  
  Configure a web service account on your instance. An Event Management Application Performance Management (APM) tool uses the account to authenticate the instance so it can send alerts to SR Ops.

- **Create services and configure relationships between them**
  
  Any service that you add to the **Service Dependencies** map can be either an existing service or a new service that you create on the
Configure general service settings

For each service that you support in SR Ops, provide general information about the service and about the SR Ops team that supports it.

Set up an on-call schedule for the team

The Site Reliability Operations application is fully integrated with the On-Call Scheduling application. After you set up an SR Ops team, you set up the schedule using an on-call wizard.

Integrate service with an APM tool

Set up the integration with an Event Management Application Performance Management (APM) tool — the push connector that sends alerts to SR Ops.

Create a web service account

Configure a web service account on your instance. An Event Management Application Performance Management (APM) tool uses the account to authenticate the instance so it can send alerts to SR Ops.

Before you begin

Role required: sys_admin

Procedure

Create a web service account with the event_management_integration role. For more information on how to create a web service account, see Create a web service account.

Specify this account when you configure the APM tool so it can access the instance when sending alerts.

Related information

Assign a role to a user

Create services and configure relationships between them

Use a map canvas to add, configure, and arrange services. You can add child services that depend on parent services. Any service that you add to the Service Dependencies map can be either an existing service or a new service that you create on the page.
Before you begin
Role required: evt_mgmt_integration

About this task
You can add an application service as a child of a business service but not vice versa.

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. In the Site Reliability Ops Workspace, use one of the following methods to create a service record:
   - On the Home page ( ), in the Services section, click Create New Service.
   - On the Services Overview page ( ), click Create New Service.

   The Service Dependencies page opens with a blank map canvas. Any service that you add to the Service Dependencies map can be either an existing service or a new service that you create on the page. For a new service, you'll start with a parent service and then connect other services to the parent and to each other.

3. Click Add service.
   An Application Service box appears on the map canvas. You can configure several service properties in the New Service box.
4. For the **Start with** value, specify whether to add a new or existing service as the parent for the overall service that you are defining.

5. If you specify **Existing service**, then select the service in the **Service** list.

6. Specify the property settings for the service.

### Service property settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service type</td>
<td>• Application Service: A service that is made up of one or more CIs that performs a subset of the tasks that, together, perform a business-level function. For example, a cost calculation app or database servers.&lt;br&gt;• Business Service: The overall parent service that performs a business-</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
The following relationships are supported:
- A business service can be a parent or child of another business service.
- An application service can be a parent or child of another application service.
- A business service can be a parent of an application service but an application service cannot be a parent of any business service. If you want to link an application service to any other service, it will always be another application service. The **Service type** field value is grayed out.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique and meaningful name for the service.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the overall service that will help others to understand the purpose of the service and other relevant information.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Person who is responsible for the service overall. Click or start typing to view the selection list.</td>
</tr>
<tr>
<td>Support team</td>
<td>The SR Ops team that supports the service. Click or begin typing to view the selection list.</td>
</tr>
</tbody>
</table>

7. Click **Update Service**.

The box for the service appears on the canvas and displays the service type and name.
8. If the map includes a business service as a parent to an application service, then click the Settings icon ( ) and select Service offering. The system adds a service offering with the name `<business service name> - <application service name> offering`. Toggle the Show in map switch as needed.

Note: A service offering is required to connect an application service to a business service. You cannot change the settings for a service offering.

9. Continue to add services and connect them using the following methods:

- Click Add service. A new service is added to the map with no connections. Drag from anywhere inside a "parent" service to the service. A connection arrow appears and the child snaps into place.

- Click the plus symbol (+) on a service. The new service is connected as a child. A connection arrow appears and the child snaps into place.

- Change a connection. Select a connection arrow and drag it to a different service. Press the Delete key to remove the connection.

- Click the menu icon ( ) and select the operation:
  - Add Child: A new service is connected as a child. A connection arrow appears and the child snaps into place.
  - Add Parent: A new service is connected as a parent. A connection arrow appears and the parent snaps into place.
  - Manage Relationships: In a dialog box, specify a different parent or child for the service. This operation is the same as the Add Child and Add Parent actions.
  - Open Record: Open the record of the service on the Details tab in the Site Reliability Ops workspace. This option appears only for saved services.
  - Delete Service: The selected service is removed from the map and its CI entry in the CMDB is deleted. This option appears only for saved services.

Warning: If you delete the immediate child of a business service, then the associated service offering is also deleted and the business service will no longer be operational.

- Remove from Map: The selected service is removed from the map. The CI entry in the CMDB is not affected.


Connect services by clicking in the intended parent and dropping in the intended child. A connection arrow appears between the services.

10. Update the appearance of the map.
   - Click + or - to zoom in or out.
   - Click Fit to fit the entire map in the work area.
   - Toggle between Vertical and Horizontal to rotate the display.
   - Click the Refresh icon ( ) to ensure that the image on the screen is accurate. You might refresh when another user is editing services.

11. When all services are properly configured and connected, click Save Relationships.

   Note: You cannot change the property settings for a service that is part of a saved relationship map. Instead, you must replace the service with an updated version.

Edit service details

Edit an existing service owned by your team. For each service that you support in SR Ops, provide general information about the service and about the SR Ops team that supports it.

Before you begin
Role required: sro_admin

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. Click the Services page icon ( ).
3. On the Services Overview page, click to open the service that you want to update. The **Details** tab is selected by default.

4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the service.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the overall service that will help others to understand the purpose of the service and other relevant information.</td>
</tr>
<tr>
<td>Business criticality</td>
<td>The Business criticality value as set in the CMDB. This value comes from the CMDB.</td>
</tr>
<tr>
<td>Version</td>
<td>The Version value as set in the CMDB. This value comes from the CMDB.</td>
</tr>
<tr>
<td>Operational status</td>
<td>The Operational status value as set in the CMDB. This value comes from the CMDB.</td>
</tr>
<tr>
<td>Environment</td>
<td>The Environment value as set in the CMDB. This value comes from the CMDB.</td>
</tr>
<tr>
<td>Support team</td>
<td>The SR Ops team that supports the service.</td>
</tr>
<tr>
<td></td>
<td>Click or begin typing to view the selection list.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Person who is responsible for the service.</td>
</tr>
<tr>
<td></td>
<td>Click or begin typing to view the selection list.</td>
</tr>
</tbody>
</table>

5. To open the service for editing in the canvas view, click the **Relationships** tab. The content in the canvas is visible as read-only.

6. To edit the service information, click **Edit relationships**.

7. To save the updated service details after editing, click **Save Relationships**.
Results
The general service settings are configured. In the next procedure, you set up the integration with push connector that sends messages to the service.

Optional: Set up an On-Call schedule
The Site Reliability Operations application is fully integrated with the On-Call Scheduling application. After you set up an SR Ops team, you set up the schedule using an on-call wizard.

Before you begin
Role required: sro_admin or sro_manager

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.

2. Click the Services page icon ( ).

3. On the Services Overview page, open any service where an SR Ops team does not yet have an on-call schedule.
   The workspace displays a notification to configure the schedule.

4. Click the link.
   The On-Call Scheduling application opens a wizard that helps you to set up the schedule.

5. Set up the schedule. See the instructions at Configure or update an On-Call schedule.
**Remove a service from the service map**

Remove a service from service map when the service is not required. The CI entry for the service in CMDB is not affected.

**Before you begin**
Role required: sro_admin

**Procedure**

1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. Click the Services page icon ( ).
3. On the Services Overview page, click to open the service that you want to update.
   The Details tab is selected by default.
4. Click the Relationships tab.
   The content in the canvas is visible as read-only.
5. Click Edit relationships to edit the service information.
6. For the service that you want to remove, click the More actions icon ( ) and select Remove from map.
7. To save the updated relationships after editing, click Save Relationships.
Related information

Delete a service from the service map

Delete a service from the service map
Delete a service from the map when the service is a duplicate service, created in error, or not required anymore. The CI entry of the service in CMDB is deleted. This option appears only for saved services.

Before you begin
Role required: sro_admin

About this task

⚠️ Warning: If you delete the immediate child of a business service, then the associated service offering is also deleted and the business service will no longer be operational.

Procedure

1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. Click the Services page icon ( ).
3. On the Services Overview page, click to open the service that you want to update. The Details tab is selected by default.
4. Click the Relationships tab. The content in the canvas is visible as read-only.
5. Click Edit relationships to edit the service information.
6. For the service that you want to remove, click the More actions icon ( ) and then select Delete Service.
7. On the Delete Service confirmation dialog box, click Delete.
8. To save the updated relationships after editing, click **Save Relationships**.

**Related information**

**Delete a service offering**

**Use the command line interface to create and update services or relationships**

Use the command line interface (CLI) to perform operations on services and relationships using a single command instead of navigating to the SR Ops workspace.

**Before you begin**

Ensure that the CLI client is connected to the instance where both the Site Reliability Operations and ServiceNow CLI store apps are installed.

Role required: sro_manager or sro_admin

**About this task**

Currently, deletion of services or relationships is not supported.
Procedure

1. Open the Terminal, type `snc sro` and press Enter.

   The command group `sro` lets you perform the create, update, and delete operations on services and relationships for SR Ops. Under the list of available commands, the `build` command is displayed.

   ![Command Output]

   Note: The `build` command accepts `.json` file name as its input.

2. Ensure that the json payload is in the correct format.

   For example, `services-payload.json` has the following payload:

   ```json
   {
       "services": [
           {
               "name": "Email Enterprise",
               "description": "Email Enterprise service",
               "$class": "cmdb_ci_service"
           },
           {
               "name": "Email Premium",
               "description": "Email Service for Office 365 accounts",
               "$class": "cmdb_ci_service_discovered"
           }
       ],
       "relationships": [
           {
               "parent": "Email Enterprise",
               "child": "Email Premium"
           }
       ]
   }
   ```

3. Type `snc sro build --data <filename>.json` and press Enter.

   For example, `snc sro build --data services-payload.json`.
Results
Based on the json payload, services and relationships are created or updated on the instance.

Edit the details of a service offering
Edit the details of a service offering whenever required.

Before you begin
Role required: sro_admin

About this task
If the service map includes a business service as a parent to an application service, then a service offering is created to connect an application service to a business service.

Procedure
1. On the service map, click the service offering to open it in the form view. The Details and the Subscribed by related lists appear.
2. Click the Details tab.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Service offering form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About this service offering</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Unique name that reflects the nature of the service offering.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Brief details about the service offering.</td>
</tr>
<tr>
<td>Additional Information</td>
<td></td>
</tr>
<tr>
<td>Owned by</td>
<td>Service owner responsible for this service in the organization.</td>
</tr>
<tr>
<td>Delivery manager</td>
<td>The delivery manager for this service.</td>
</tr>
</tbody>
</table>

4. To view the users who are subscribed to the service offering, click the Subscribed by tab.
5. To save the edits, click Save.
Delete a service offering
Delete a service offering from the service map if the application service is deleted. Deleting a service offering removes the service offering and its relationships permanently.

Before you begin
Role required: sro_admin
Ensure that the Service Portfolio Management plugin (com.snc.service_portfolio) is not active and the service offering is not connected to any application service.

About this task
If the service map includes a business service as a parent to an application service, then a service offering is created to connect an application service to a business service. When we delete the application service, the service offering is no longer required.

Procedure
1. On the service offering that you want to remove, click the More actions icon (⋯) and then select Delete Service Offering.
2. To save the updated relationships after editing, click Save Relationships.

Create an incident from a service
Create an incident from a service when there is a deviation from an expected standard of operation in any of the configuration items (CIs). Incident records enable you to track the investigation, possible solutions, and resolution of a problem.

Before you begin
Role required: sro_admin, sro_manager, or sro_user

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. In the Site Reliability Ops Workspace, use one of the following methods to open a service record:
<table>
<thead>
<tr>
<th>Option</th>
<th>Action to be taken</th>
</tr>
</thead>
</table>
| Lists icon        | • Click the Lists icon (_duplicates).  
• Select Services > All.  
• Click to open the record.                                                                                                               |
| Services icon     | • Click the Services icon (services).  
• Under Services section, click to open the services record.                                                                                   |

3. Click the More actions icon ( More Actions ) and then select Create Incident.

Option to create an incident on the services page

4. On the form, fill in the fields.
   For more information on the fields of the incident form, see Create an incident in ITSM Agent Workspace

5. Click Save.

Create a change request from a service

Create a change request to propose an alteration in a supported configuration item (CI).

Before you begin
Role required: sro_admin, sro_manager, or sro_user

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. In the Site Reliability Ops Workspace, use one of the following methods to open a service record:
<table>
<thead>
<tr>
<th>Option</th>
<th>Action to be taken</th>
</tr>
</thead>
</table>
| Lists icon          | • Click the Lists icon (···).  
                       • Select Services > All.  
                       • Click to open the record. |
| Services icon       | • Click the Services icon (···).  
                       • Under Services section, click to open the services record. |

3. Click the More actions icon (···) and then select **Create Change**.

Option to create a change on the services page

4. On the Create Change Request dialog box, select the type of change, and click **Create**.

Create Change Request dialog box

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.  
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Starting the Quebec release, the Site Reliability Ops change model has been introduced. The Site Reliability Ops change model is executed when the following properties are false:

- com.snc.change_management.change_model.manage_workflow: false
- com.snc.change_management.change_model.type_compatibility: false

5. On the form, fill in the fields.
   For more information on the fields on the change request form, see Create a change request in Agent Workspace.

6. Click Save.
   If the value of the **Priority** field of the change request is **High**, the change request needs to be approved by an authorized person else the change request is automatically created.

**Related information**

- [Approve a change request](#)
- [Delete a service record](#)

Delete a service record
Delete a service record if it is no longer needed.

**Before you begin**
Role required: sro_admin, sro_manager, or sro_user

**Procedure**

1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. In the Site Reliability Ops Workspace, use one of the following methods to open a service record:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action to be taken</th>
</tr>
</thead>
</table>
   | Lists icon        | • Click the Lists icon ( ).  
                     | • Select Services > All.  
                     | • Click to open the record. |
   | Services icon     | • Click the Services icon ( ).  
                     | • Under Services section, click to open the services record. |
3. Click the More actions icon (⋮) and then select Delete.

4. On the Delete Service confirmation dialog box, click Delete.

Integrate service with an APM tool

Set up the integration with an Event Management Application Performance Management (APM) tool — the push connector that sends alerts to SR Ops. APM ensures that it provides services to the customer up to the level defined and identifies the problems related to the application performance. Application performance can be monitored or tracked using different categories such as load time, the response time of the application.

Before you begin
Role required: sro_user or sro_admin

About this task
The Event Management Connectors plugin makes the APM tools available to SR Ops.

You configured a web service account on your instance. The APM tool uses the account to authenticate the instance so it can send alerts to this service on SR Ops. In this task, you configure the following items:

1. In SR Ops:
   - Specify whether to create an incident for each alert.
   - Specify whether to send a notification to team members when an alert is received or when an incident is created.
   - Specify the APM tool that forwards alerts from the service.

2. On the management console for the APM tool, configure the authentication header following settings for actions on alerts:
• The secured endpoint to which the APM tool sends alerts.
• The service account that the APM tool uses to send alerts. You typically use the account to generate the authentication header for the endpoint for alerts.

Procedure
1. Create a web service account with the evt_mgt_integration role. See Create a web service account.
3. In the Site Reliability Ops Workspace, use one of the following methods to open a service record:
   • In the Services section on the home page, open a service.
   • On the Services Overview page, open a service.
   The service page displays the Details, Relationships, and Integrations tabs.
4. Click the Integrations tab and then click New.
5. On the form, fill in the fields.

Integrations form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the integration.</td>
</tr>
<tr>
<td>Source</td>
<td>The push connector that will send messages from the service. SR Ops uses this information to determine how to decode incoming messages. Click the Search icon in the Source field and then select the source to use for the service.</td>
</tr>
<tr>
<td>Create incident</td>
<td>Option to create an incident for each received alert.</td>
</tr>
<tr>
<td>Trigger notification / Notify on</td>
<td>Option to send notifications when an alert is received or when an incident is created. Select the Trigger notification check box to send notifications. The Notify</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>on setting</td>
<td>specifies whether to send the notification when an alert is received or when an incident is created.</td>
</tr>
<tr>
<td>If an on-call schedule is configured for the group, then the notification goes to the on-call shift members. If no schedule is defined, then the system sends the notification to all members of the group.</td>
<td></td>
</tr>
<tr>
<td>The system sends notifications on the channels that are specified by the \texttt{sn_sro_notification_communication_channels} property. See \texttt{SR Ops system properties} for details.</td>
<td></td>
</tr>
</tbody>
</table>

\textbf{Note:} The base-system SR Ops application supports the actions of sending notifications when an alert is received and when an incident is created. You can define both custom actions and custom conditions that trigger an action. See Define a custom condition to trigger actions and Define a custom action.

6. Click \textbf{Save}.

The \textbf{Integrations} tab is replaced by two tabs: The \textbf{Details} and \textbf{Integration Actions} tabs for the new integration.

- The \textbf{Details} tab displays the values that you have defined so far.
- The base-system SR Ops application supports the actions of sending notifications when an alert is received and when an incident is created. You can define both custom actions and custom conditions that trigger an action. Custom condition/action pairs for the integration appear on the \textbf{Integration Actions} tab. See Define a custom condition to trigger actions and Define a custom action.

The system generates a \textbf{Webhook URL} that is the secured endpoint to which the APM should send messages. The URL appears on the \textbf{Details} tab for the integration. You copy the URL for use in the next step.
7. Open the management console for the APM tool and configure the following settings:

   a. Specify the Webhook URL as the endpoint for alert messages. Some APM tools call this the "action" to perform for alert events.

   b. Specify the service account that you configured. The APM uses the account to connect and authenticate the instance to send alert messages to SR Ops.

Results
The service is now fully registered in SR Ops.

Related information
Define a custom condition to trigger actions
Define a custom action
Define a custom action

The base-system SR Ops application supports the actions of sending notifications when an alert is received and when an incident is created. You can define both custom actions and custom conditions that trigger an action.

Before you begin
Role required: sro_admin or sro_manager

Procedure
1. Navigate to Site Reliability Operations > Service Health > Actions.
2. On the Actions form, click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the action.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the action that will help others to understand its purpose.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Type of entity for which to perform the action.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of action to perform.</td>
</tr>
<tr>
<td>Integration hub action</td>
<td>Action to perform when the specified condition is met.</td>
</tr>
<tr>
<td>Note:</td>
<td>IntegrationHub flows and actions must follow the conventions outlined in Create a custom subflow.</td>
</tr>
<tr>
<td>Script</td>
<td>Executable script for each custom action that you want to implement. The script can accept and process the parameters passed to it by APM.</td>
</tr>
<tr>
<td>Subflow</td>
<td>Subflow that is executed to resolve an alert.</td>
</tr>
</tbody>
</table>

4. Click Submit.
Results
The action is added to the list of actions on the **Integrations** tab.

Define a custom condition to trigger actions
The base-system SR Ops application supports the actions of sending notifications when an alert is received and when an incident is created. You can define both custom actions and custom conditions that trigger an action. Control when a flow takes a specific decision outcome or waits for a specific resume event.

Before you begin
Role required: sro_admin or sro_manager

Procedure
1. Navigate to **Site Reliability Operations > Service Health > Conditions**.
   The Condition form opens.
2. On the Condition form, click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the condition.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the condition that will help others to understand its purpose.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Type of entity against which the condition must be applied.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of condition:</td>
</tr>
<tr>
<td></td>
<td>• Criteria: Set of parameter:value pair conditions to apply against the data.</td>
</tr>
<tr>
<td></td>
<td>• Script: Code that applies the condition against data.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Set of parameter:value pair conditions to apply against the data. Select parameters and values to create conditions and logical operators to join conditions.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
This option appears only if the **Type** value is **Criteria**.

### Script
Code that applies the condition against data.

This option appears only if the **Type** value is **Script**.

4. Click **Preview** to apply the condition to current data. The system returns a link that indicates how many records match the condition. Click the link to view the results.

5. When you finish defining the condition, click **Submit**.

**Example:**
This example condition matches only critical alerts

![Condition definition example](image)

**Create alert rules for a service**
You can create alert rules to trigger an action for a service. You can also create conditions in alert rules and create more actions to associate with alert rules. SR Ops supports the execution of actions such as creating an incident or sending notifications when an alert is received or an incident is created.

**Before you begin**
Role required: sro_user or sro_admin
Procedure

1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. Click the Services page icon.
3. On the Services Overview page, open a service.
4. Click the Alert Rules tab.
5. Click New.
6. On the form, fill in the fields.

New Alert Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Types of the service that you want to trigger the alert rule for. You can set a trigger for any of the following types:</td>
</tr>
<tr>
<td>Service Trigger Type</td>
<td>• <strong>Service</strong>: The alert is triggered only for the service that you are creating the alert rule for.</td>
</tr>
<tr>
<td></td>
<td>• <strong>CI</strong>: The alert is triggered only for the impacted configuration item (CI) for the service that you are creating the alert rule for.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Service + CI</strong>: The alert is triggered for both the service that you are creating the alert rule and the impacted CI for the service.</td>
</tr>
<tr>
<td>Note:</td>
<td>For the CI and Service + CI types, the rule triggers only if the CI is a child of a service or a Technical Service. If the CI is more than one level deep, the rule does not trigger.</td>
</tr>
<tr>
<td>Service</td>
<td>Name of the service. The field is automatically set based on the service that you are creating the alert rule for.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which you want the actions to be executed.</td>
</tr>
<tr>
<td>Conditions</td>
<td></td>
</tr>
</tbody>
</table>

Condition that the trigger action is based on. When the service associated with the alert matches the value in the **Service** field and all these conditions are met, the action is executed.

As long as the conditions in the alert rules are met, the action triggers.
The order in which the actions are executed between the actions at the integration level and at a service level is not guaranteed.

All alert rules are evaluated and processed in order. Anytime that a rule matches the condition, an action runs once for this matching rule. This action may happen when there is an update to the alert. Initially, a rule may not trigger but a subsequent rule may change the alert so that the previous non-matching conditions, when matched, triggers the action.

You can create a custom condition, or you can also add more available conditions.

To create a custom condition, complete these steps:

**a.** Click **Create custom condition**.

**b.** On the New custom condition form, fill in the fields.
   - **Name**: Name of the condition.
   - **Short description**: Brief description of the condition.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mode</strong>: The mode that you want to use to create the condition. You can either create a condition based on criteria or based on a script. Based on the mode that you select, enter the condition that must be met or add a script.</td>
<td></td>
</tr>
<tr>
<td>c. Click <strong>Save</strong>. If you want to add more available conditions for this alert rule, click <strong>+ Add Condition</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

**Action**

| Add an action | Action that you want to execute for this alert rule. You can select an available action tile. If you want to use another action that is not available in the tile, click **More actions** and then select the name of the action. If you want to create more actions, click the more UI actions icon ("...") that appears next to the **Save** button on the New Alert Rule page, and then select **Create Action**. |

**Note**: While setting the action for the alert rule, if the action selected has the **Configuration required** field value as **true**, the **Configuration** field appears. The variables required for configuration are determined by the action. These variables are specified in the **Description** field when you create an action on the Action page.
### Field | Description
---|---
Configuration | The action is executed with the configuration that you select from the list. To enter a value in the Configuration field, point to this field and click inside it. The field shows a list of the available configurations to select from. If you want to create a new configuration to associate with the action, click the more UI actions icon (*** ) that appears next to the Save button, and then select Create Configuration.

7. Click Save.

**Note:** In the base system SR Ops, you can view the list of alert rules by navigating to Site Reliability Operations > Service Health > Alert Rules. Don't modify or delete the alert rules with a name that begins with SRO and a description that begins with DO NOT EDIT.

**Create alert rules for an integration**

You can create alert rules to trigger an action for an integration. You can also create conditions in the alert rules and create more actions to associate with alert rules. SR Ops supports the execution of actions such as creating incident or sending notifications when an alert is received or when an incident is created.
Before you begin
Role required: sro_user or sro_admin

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. Click the services page icon ( ).
3. On the Services Overview page, open a service.
4. Click the Integrations tab.
5. Open the integration that you want to add alert rules for.
6. Click the Alert Rules tab.
7. Click New.
8. On the form, fill in the fields.

New Alert Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>This field value is automatically set to Integration because you are creating the action for an integration.</td>
</tr>
<tr>
<td>Trigger Type</td>
<td>Name of the integration. This field is automatically set based on the integration that you are creating alert rules for.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which you want the actions to be executed.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Condition that the trigger action is based on. When the service associated with the alert matches the value in the Service field and all these conditions are met, the action is executed. As long as the conditions in the alert rules are met, the action triggers.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td>The order in which the actions are executed between the actions at the integration level and at a service level is not guaranteed.</td>
</tr>
<tr>
<td></td>
<td>All alert rules are evaluated and processed in order. Anytime, a rule matches the condition, an action runs once for this matching rule and this may happen on an update to the alert. Initially, a rule may not trigger but a subsequent rule may change the alert so that the previous non-matching conditions, when matched, trigger the action.</td>
</tr>
<tr>
<td></td>
<td>All alert rules are evaluated and processed in order. Anytime that a rule matches the alert, an action runs once for this matching rule. This action may happen when there is an update to the alert. Initially, a rule may not trigger but a subsequent rule may change the alert so that the previous non-matching conditions, when matched, triggers the action.</td>
</tr>
<tr>
<td></td>
<td>You can create a custom condition, or you can also add more available conditions.</td>
</tr>
<tr>
<td></td>
<td>If you want to create a custom condition, complete these steps:</td>
</tr>
<tr>
<td><strong>a.</strong></td>
<td><strong>Click Create custom condition.</strong></td>
</tr>
<tr>
<td><strong>b.</strong></td>
<td><strong>On the New custom condition form, fill in the fields.</strong></td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Name of the condition.</td>
</tr>
<tr>
<td><strong>Short description</strong></td>
<td>Brief description of the condition.</td>
</tr>
<tr>
<td><strong>Mode</strong></td>
<td>The mode that you want to use to create the condition. You can either create</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a condition based on criteria or based on a script. Based on the mode of condition that you select, enter the condition that must be met or add a script.</td>
<td></td>
</tr>
<tr>
<td>c. Click Save.</td>
<td>If you want to add more available conditions for this alert rule, click + Add Condition.</td>
</tr>
</tbody>
</table>

Action

Add an action

Action that you want to execute for this alert rule.
You can select an available action tile.
If you want to use another action that is not available in the tile, click More actions and then select the name of the action.
If you want to create more actions, click the more options icon (…) that appears next to the Save button on the New Alert Rule page, and then select Create Action.

Note: While setting the action for the alert rule, if the action selected has the Configuration Required field as true, the Configuration field appears. The variables required for configuration are determined by the action. These variables are specified in the Description field while creating an action on the Action page.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>The action is executed with the configuration that you select from the list. To enter a value in the Configuration field, point to this field and click inside it. The field shows a list of the available configurations to select from. If you want to create a new configuration to associate with the action, click the more UI actions icon (*** ) that appears next to the Save button, and then select Create Configuration.</td>
</tr>
</tbody>
</table>

9. Click **Save**.

**Note:** In the base system SR Ops, you can view the list of alert rules by navigating to **Site Reliability Operations > Service Health > Alert Rules**. Don’t modify or delete the alert with a name that begins with SRO and a description that begins with DO NOT EDIT.

**Filter alerts, incidents, and change requests**

Narrow your search results with filters.

**Before you begin**

Role required: sro_admin, sro_manager, or sro_user
### Procedure

1. Navigate to **Site Reliability Operations > Site Reliability Ops Workspace**.

2. Click the Services page icon (■).

3. On the right pane of the Services Overview page, use the icons and the respective filter list to add or remove filters as required.

<table>
<thead>
<tr>
<th>Filters on the Services Overview page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon</td>
</tr>
<tr>
<td>![Alert Icon]</td>
</tr>
<tr>
<td>![Incident Icon]</td>
</tr>
<tr>
<td>![Change Request Icon]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Filters on the right pane</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="services-overview.png" alt="" /></td>
</tr>
</tbody>
</table>

The respective cards from the result appear vertically. You can click any card to view the details.

### Approve a change request

Approve a change request when the change is reviewed and approved by the Change Advisory Board (CAB) workbench.
Before you begin
Role required: sro_admin or sro_manager

Procedure

1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.

2. In the Site Reliability Ops Workspace, use one of the following methods to open an approval record:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action to be taken</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home page icon</td>
<td>• Click the Home page icon.</td>
</tr>
<tr>
<td></td>
<td>• Under the My Work &gt; Approvals section, click to open the record.</td>
</tr>
<tr>
<td>Lists icon</td>
<td>• Click the Lists icon.</td>
</tr>
<tr>
<td></td>
<td>• Select Change &gt; Approvals.</td>
</tr>
<tr>
<td>Option</td>
<td>Action to be taken</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------</td>
</tr>
<tr>
<td>• Click to open the record.</td>
<td></td>
</tr>
<tr>
<td>3. Click to open the record.</td>
<td></td>
</tr>
<tr>
<td>4. On the <strong>State</strong> field, click the list and select <strong>Approved</strong>.</td>
<td></td>
</tr>
</tbody>
</table>
5. Click **Save**.
   The state of the change request changes from the **Assess** state to the **Approved** state.

**View the CMDB map of an SR Ops service**

View the service map for any SR Ops service to understand how services in your architecture connect and communicate.

**Before you begin**

Role required: sro_admin, sro_manager, or sro_user

**Procedure**

1. Click **Service Map** on any page that displays an SR Ops service.
   The **Service Map** tab displays the **Service Map** canvas.
2. Click **Full map** to perform map operations.

**Alert notification in Microsoft Teams**

Receive notifications in Microsoft Teams channel for specific events in a service. These notifications are targeted to a specific team in Microsoft Teams.

**Install Microsoft Teams Spoke for ServiceNow Integration Hub**

Install the Microsoft Teams Spoke for ServiceNow Integration Hub plugin to configure the actions that a process analyst can use when creating configurations to automate sending messages about alerts to a Microsoft Teams channel.

**Before you begin**

Role required: admin
Procedure

1. Navigate to System Application > All Available Applications > All.

2. In the search field, enter Microsoft Teams Spoke for ServiceNow IntegrationHub. The plugin is com.sn.ms_teams.ah.

You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release note information for all released apps, see the ServiceNow Store version history release notes.

3. Click Install.

Create a Webhook URL for a channel in Microsoft Teams

Create a Webhook URL for a specific team in Microsoft Teams to enable the external services to notify about the events for a service in the channel.

Before you begin
Role required: admin

Procedure

1. Launch Microsoft Teams application.

2. Select Teams tab.
3. Select a team, click **More options(...)** > **Connectors**.

4. In the **Connectors** pop up screen, enter **Incoming Webhook** in the search field.
5. Click **Add**.

6. Click **Add** on the Incoming Webhook pop-up screen.

7. On the Incoming Webhook screen, provide the values:
   a. **To set up an Incoming Webhook, provide a name and select Create:** Enter a unique name for the Webhook.
   b. **Upload Image:** Click **Upload Image**, select an image for the Incoming Webhook, and then click **Open**.
   c. **Click Create.**
      The Incoming Webhook URL is created.
d. Click  to copy the URL.

e. Click Done.

Create an alert rule configuration for Microsoft Teams

Create a configuration to associate with an alert rule for a service or integration. Notifications are sent during specific events in a service to a channel in the Microsoft Teams messaging service.

Before you begin
Role required: sro_admin, sro_manager, or sro_user

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. On the Services Overview page ( ), open a service.
3. Click the Alert Rules tab.
4. Select an alert that you want to create a configuration for.

5. Click the more UI actions icon (*** ) that appears next to the Save button, and then select Create Configuration.

6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Configuration form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the configuration. For example, Alerts notification Microsoft Teams.</td>
</tr>
<tr>
<td>Attach to Table</td>
<td>Table on which the action is performed. Select Action.</td>
</tr>
<tr>
<td>Attach to Document</td>
<td>Action to be executed on the selected table. Click Search. The Select the document form appears. To select a document, complete the following steps: a. In the Table name field, select Action. b. In the Document field, search for and select Post MS Teams Message. c. Click OK.</td>
</tr>
</tbody>
</table>

7. Right-click the header, and click Save. The Configuration Variables related list is created.

8. Under Configuration Variables, click New.


<table>
<thead>
<tr>
<th>Configuration Variable form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Name of the configuration that you are creating the configuration variable for. This field is auto-populated.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the configuration variable. Enter the value as ah_webhook_url.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the configuration variable.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Select</td>
<td><strong>Scalar</strong>. Webhook URL obtained when creating the connector in Microsoft Teams messaging service. Paste the URL.</td>
</tr>
</tbody>
</table>

For more information about creating a webhook URL, see [Create a Webhook URL for a channel in Microsoft Teams](#).

10. Click **Submit**.

**View notifications for an event in a service**
View the notifications that are sent during specific events in a service. These notifications are sent to the users for the specific channel in Microsoft Teams.

**Before you begin**
Role required: user

**Procedure**
1. Launch Microsoft Teams.
2. Click **Teams** tab.
3. Click your team.

A notification is displayed in the team for an event.

4. Click **Click here to see alert** link to view the record in the ServiceNow instance.

**Configuration Variables**

You can create the following variables for a notification. The notification is delivered to the user based on the configuration variables defined.
### Configuration Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Mandatory</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ah_webhook_url</td>
<td>MS teams webhook connector URL</td>
<td>True</td>
<td><a href="https://sro-webhook.office.com/webhook2121aw">https://sro-webhook.office.com/webhook2121aw</a></td>
</tr>
<tr>
<td>ah_title</td>
<td>Title of the notification</td>
<td>False</td>
<td>${number - [severity] - state}</td>
</tr>
<tr>
<td>ah_message</td>
<td>Message body of the notification</td>
<td>False</td>
<td>&lt;b&gt;Number:&lt;/b&gt; ${number} &lt;br&gt; &lt;b&gt;Source:&lt;/b&gt; ${source} &lt;br&gt; <a href="link">Click here to see alert</a></td>
</tr>
</tbody>
</table>

### Alert notification in Slack

Receive notifications in Slack channel for specific events in a service. These notifications are targeted to a specific team in Slack.

### Install Slack Spoke for ServiceNow Integration Hub

Install the Slack Spoke for ServiceNow Integration Hub plugin to configure the actions that a process analyst can use when creating configurations to automate sending messages about alerts to a Slack channel.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to System Application > All Available Applications > All.
2. In the search field, enter Slack Webhooks Spoke for ServiceNow IntegrationHub.

   The plugin is com.sn.slack.ah.

   You can search for the application by its name or ID. If you cannot find an application, you may have to request it from ServiceNow store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release
3. Click **Install**.

**Create a Webhook URL for a channel in Slack**

Create a Webhook URL for a specific channel in Slack to enable the external services to notify about the events for a service in the channel.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to your Slack workspace.
2. Search for webhook.
3. Click **Incoming WebHooks**.
4. Click **Add to Slack**.
5. For the Post to Channel list, select an existing channel or click **create a new channel** to create a new channel.
   If you create a new channel, perform the following actions:
   a. On the Create a channel form, in the **Name** and **Description** field, enter the name and description of the channel.
   b. Click **Create**.
6. Click **Add Incoming WebHooks integration**.
   The Slack channel is created and the webhook is integrated with the slack channel.

   **Note:** On the Incoming WebHooks page, from the **Webhook URL** field, copy the webhook URL as you will need this when creating ServiceNow integration.

**Create an alert rule configuration for Slack**

Create a configuration to associate with an alert rule for a service or integration. Notifications are sent during specific events in a service to a channel in the Slack messaging service.

**Before you begin**
Role required: sro_admin, sro_manager, or sro_user
Procedure

1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.

2. On the Services Overview page, open a service.

3. Click the Alert Rules tab.

4. Select an alert that you want to create configuration for.

5. Click the more UI actions icon that appears next to the Save button, then select Create Configuration.

6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the configuration. For example, Alerts Notification Slack.</td>
</tr>
<tr>
<td>Attach to Table</td>
<td>Table on which the action is performed.</td>
</tr>
<tr>
<td></td>
<td>Select Action.</td>
</tr>
<tr>
<td>Attach to Document</td>
<td>Action to be executed on the selected table.</td>
</tr>
<tr>
<td></td>
<td>Click Search. The Select the document form appears.</td>
</tr>
<tr>
<td></td>
<td>To select a document, complete the following steps:</td>
</tr>
<tr>
<td>a.</td>
<td>In the Table name field, select Action.</td>
</tr>
<tr>
<td>b.</td>
<td>In the Document field, search for and select Post Slack Message.</td>
</tr>
<tr>
<td>c.</td>
<td>Click OK.</td>
</tr>
</tbody>
</table>

7. Right-click the header, and click Save.

The Configuration Variables related list is created.

8. Under Configuration variables, click New.

### Configuration Variable form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Name of the configuration that you are creating the configuration variable for. This field is auto-populated.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the configuration variable. Enter the value as <code>ah_webhook_url</code>.</td>
</tr>
<tr>
<td>Type</td>
<td>The configuration variable type. Select <strong>Scalar</strong>.</td>
</tr>
<tr>
<td>Value</td>
<td>Webhook URL obtained when creating the connector in the Slack messaging service. Paste the URL in this field.</td>
</tr>
</tbody>
</table>

For more information about creating a webhook URL, see [Create a Webhook URL for a channel in Slack](#).

10. Click **Submit**.

### View Slack notifications for an event in a service

View the notifications that are sent during specific events in a service. These notifications are sent to the users for the specific channel in Slack.

**Before you begin**

Role required: user

**Procedure**

1. Launch Slack.

2. Click the Slack channel that you have created.
   
   A notification is displayed in the channel for an event.
3. Click **Click here to see alert** link to view the record in the ServiceNow instance.

**Configuration variables for Slack**

You can create the following variables for a notification. The notification is delivered to the user based on the configuration variables defined.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Mandatory</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ah_webhook_url</td>
<td>Slack webhook connector URL</td>
<td>True</td>
<td><a href="https://hooks.slack.com/services/TO1XXXXXXXX/3vTC1XXXXXXX">https://hooks.slack.com/services/TO1XXXXXXXX/3vTC1XXXXXXX</a></td>
</tr>
</tbody>
</table>
| ah_message      | Message body of the notification           | False     | • *Number:*  
|                 |                                            |           |     ${number}                                   |
|                 |                                            |           | • *Source:*  
|                 |                                            |           |     ${source}                                   |
|                 |                                            |           | • *Severity:*  
|                 |                                            |           |     ${severity}                                 |
|                 |                                            |           | • *State:*  
|                 |                                            |           |     ${state}                                    |
|                 |                                            |           | • *Description:*  
|                 |                                            |           |     ${description}                             |
|                 |                                            |           | • `<@{link}|Click here>` to see alert          |

**Working with integrations**

Integrations within SR Ops provides the ability to use monitoring and collaborating tools to manage alerts and incidents efficiently by the users.

SR Ops strives to integrate with tools needed by the users to collaborate and resolve incidents efficiently. We aim to have bi-directional integrations. If an
integration doesn’t exist for one of your tools, our integrations team will evaluate the options to build it.

The Event Management Connectors plugin makes the Application Performance Management (APM) tools available to SR Ops.

Create a webhook endpoint in SR Ops
Create webhook endpoint so that the Application Performance Management (APM) tools can send automated real-time messages or information to SR Ops.

Before you begin
Role required: evt_mgmt_integration

About this task
The Event Management Connectors plugin makes the APM tools available to SR Ops.

You configured a web service account on your instance. The APM tool uses the account to authenticate the instance so it can send alerts to this service on SR Ops. In this task, you configure the following items:

1. In SR Ops:
   • Specify whether to create an incident for each alert.
   • Specify whether to send a notification to team members when an alert is received or when an incident is created.
   • Specify the APM tool that forwards alerts from the service.

2. On the management console for the APM tool, configure the authentication header following settings for actions on alerts:
   • The secured endpoint to which the APM tool sends alerts.
   • The service account that the APM tool uses to send alerts. You typically use the account to generate the authentication header for the endpoint for alerts.

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. In the Site Reliability Ops Workspace, use one of the following methods to open a service record:
   • In the Services section on the home page (🏠), open a service.
   • On the Services Overview page (🔍), open a service.
   The service page displays the Details, Relationships, and Integrations tabs.
3. Click the **Integrations** tab and then click **New**.
4. On the form, fill in the fields.

### Integrations form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the integration.</td>
</tr>
<tr>
<td>Source</td>
<td>The push connector that will send messages from the service. SR Ops uses this information to determine how to decode incoming messages. Click the Search icon (🔍) in the <strong>Source</strong> field and then select the source to use for the service.</td>
</tr>
<tr>
<td>Create incident</td>
<td>Option to create an incident for each received alert.</td>
</tr>
<tr>
<td>Trigger notification / Notify on</td>
<td>Option to send notifications when an alert is received or when an incident is created. Select the <strong>Trigger notification</strong> check box to send notifications. The <strong>Notify on</strong> setting specifies whether to send the notification when an alert is received or when an incident is created.</td>
</tr>
<tr>
<td></td>
<td>If an on-call schedule is configured for the group, then the notification goes to the on-call shift members. If no schedule is defined, then the system sends the notification to all members of the group.</td>
</tr>
<tr>
<td></td>
<td>The system sends notifications on the channels that are specified by the <code>sn_sro.notification_communication_channels</code> property. See <a href="#">SR Ops system properties</a> for details.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>

⚠️ **Note:** The base-system SR Ops application supports the actions of sending notifications when an alert is received and when an incident is created. You can define both custom actions and custom conditions that trigger an action. See Define a custom condition to trigger actions and Define a custom action.

5. Click **Save**.

The **Integrations** tab is replaced by two tabs: The **Details** and **Integration Actions** tabs for the new integration.

- The **Details** tab displays the values that you have defined so far.
- The base-system SR Ops application supports the actions of sending notifications when an alert is received and when an incident is created. You can define both custom actions and custom conditions that trigger an action. Custom condition/action pairs for the integration appear on the **Integration Actions** tab. See Define a custom condition to trigger actions and Define a custom action.
The system generates a **Webhook URL** that is the secured endpoint to which the APM should send messages. The URL appears on the **Details** tab for the integration. You copy the URL for use in the next step.

```plaintext
Webhook URL
https://sro.com/api/sn_em_connector/em/inbound_event?
source=azuremonitor&integration_id=6a5e983
```

### Specific integrations in SR Ops

Most enterprise-level applications have a need to integrate with other applications used by the same organization or external organization. These integration usually cater to different layers, like Data, Business Logic, Presentation and Security, depending on the requirement. This helps organizations achieve greater levels of operational consistency, efficiency and quality.

To set up specific integrations, you need to do the following:

1. Create a webhook endpoint in SR Ops.
2. Configure the webhook endpoint in respective APM tool.
Microsoft Azure integration with SR Ops

Microsoft Azure provides alerts based on monitoring metrics for, or events on, services. Azure generates alerts for detected problems, and SR Ops ensures the right people are working on them.

For an alert rule on a metric value, when the value of a specified metric crosses a threshold assigned, the alert rule becomes active and sends a notification. For an alert rule on events, a rule can send a notification on every event, or, only when a certain number of events happen.

What does SR Ops offer Azure users?

Azure generates alerts based on metrics and events. SR Ops acts as a dispatcher for the alerts generated by Azure. SR Ops determines the right people to notify based on on-call schedules and escalations and notifies via using email, text messages (SMS), phone calls, and Android & iOS push notifications.

Functionality of the integration

When an alert is created in Azure, an alert is created in SR Ops automatically through the integration.

Configure webhook in Azure

Configure webhook endpoint in Azure so that SR Ops can communicate with Azure using the endpoint.

Before you begin

Ensure you have done the following actions:

- Created a webhook endpoint in SR Ops. For information, see Create a webhook endpoint in SR Ops.
- Created an account in Azure.

Role required: evt_mgmt_integration

Procedure

1. Log in to the Azure console.
2. Create a resource such as an app service.
3. Under Alerts > Manage actions, create or open the alert rule for which you want to receive alerts in SR Ops.
4. Integrate ServiceNow webhook URL with the alert rule under Actions > Action type.
Note: You need to enter the username and password at the beginning of the webhook URL. For example,
https://eventuser:password@spparis34.servicenow.com/api/sn_em_connector/em/inbound_event?
source=azuremonitormonitoringintegration_id=b23ac4621bc6a010391f59ff034bcb8e

5. To update the changes in the action group, click Save changes.

What to do next
To verify if the alerts are generated correctly, you can perform actions to trigger the alert rules.

Sample payload from Azure
Snapshot of the entity when an event occurs in Azure.

Sample payload sent from Azure

```json
{
    "schemaId": "azureMonitorCommonAlertSchema",
    "data": {
        "essentials": {
            "alertId": "/subscriptions/39fa8f87-83f2-4d92-a424-408ebdfbeb19/providers/Microsoft.AlertsManagement/alerts/f7068659-5c39-4c06-95b8-b3c80213b0d5",
            "alertRule": "CastorAL1",
            "severity": "Sev0",
            "signalType": "Metric",
            "monitorCondition": "Fired",
            "monitoringService": "Platform",
            "alertTargetIDs": [
                "/subscriptions/39fa8f87-83f2-4d92-a424-408ebdfbeb19/resourcegroups/castor-rg/providers/microsoft.web/sites/stage-castor-app"
            ],
            "originAlertId": "39fa8f87-83f2-4d92-a424-408ebdfbeb19_castor-rg_Microsoft.Insights_metricalerts_CastorAL1_-278978067",
            "firedDateTime": "2020-06-29T21:52:19.5607503Z",
            "description": "CastorAL1",
            "essentialsVersion": "1.0",
            "alertContextVersion": "1.0"
        },
        "alertContext": {
            "properties": null,
            "conditionType": "SingleResourceMultipleMetricCriteria",
            "condition": {
```
Amazon Web Services (AWS) Events Transform integration with SR Ops

Integrate Amazon Web Services (AWS) with SR Ops. To add AWS platform as a data source, configuration is required in the AWS platform.

You can set up routing rules to determine where to send your data to build application architectures that react in real time to all of your data sources. AWS Events Transform makes it easy to build event-driven applications because it takes care of event ingestion and delivery, security, authorization, and error handling for you.

What does SR Ops offer AWS users?

Use SR Ops's Amazon Events Transform Integration to forward alert events to SR Ops.

Functionality of the integration

Depending on the rule attached to the event source, the alert events can be forwarded to many different AWS services such as, SNS, SQS, Lambda, Kinesis, CloudWatch, SSM.

Amazon Events Transform connector is a managed service that provides message delivery from publishers to subscribers (also known as producers and consumers). Publishers communicate asynchronously with subscribers by sending messages to a topic, which is a logical access point and communication
channel. Clients can subscribe to the topic and receive published messages using a supported protocol, such as HTTP, HTTPS, Amazon Kinesis Data Firehose, Amazon SQS, AWS Lambda, email, mobile push notifications, and mobile text messages (SMS).

**Configure webhook in AWS**

Subscribe an endpoint to the topic to receive messages published to a topic. When you subscribe an endpoint to a topic, the endpoint begins to receive messages published to the associated topic.

**Before you begin**

Ensure you have done the following actions:

- Created topic in AWS.
- Created a webhook endpoint in SR Ops. For information, see Create a webhook endpoint in SR Ops.
- Created an account in AWS.

Role required: evt_mgmt_integration

**About this task**

**Procedure**

1. Log in to the AWS console.
2. Open Simple Notification Service.
3. In the left navigation pane, click **Topics** and from the existing topic list, open the topic for which you want to create a subscription.
4. Click the **Subscriptions** tab.
5. Click **Create subscription**.
6. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic ARN</td>
<td>The Amazon Resource Name (ARN) of a topic.</td>
</tr>
<tr>
<td>Protocol</td>
<td>The type of endpoint. You select HTTPS.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>The endpoint value, such as an email address or the web server that can receive notifications from AWS.</td>
</tr>
</tbody>
</table>

**Note:** An Amazon Resource Name (ARN) is a file naming convention used to identify a particular resource in the Amazon Web Services (AWS) public cloud. ARNs, which are specific to AWS, help an administrator track and use AWS items and policies across AWS products and API calls.
### Field | Description
---|---
| **Note:** Enter your webhook URL in this field. Example: https://admin:admin@valarem.servicenow.com/api/sn_em_connector/em/inbound_event?source=aws, where admin:admin is the username and password for basic authentication.  
Enable raw message delivery | Option to avoid having endpoints process the JSON formatting of messages.  
(Optional) Subscription filter policy | A subscription filter policy allows you to specify attribute names and assign a list of values to each attribute name.  
(Optional) Redrive policy (dead-letter queue) | A dead-letter queue to target for messages that can't be delivered to subscribers successfully. Messages that can't be delivered due to client errors or server errors are held in the dead-letter queue for further analysis or reprocessing.

7. Click **Create subscription**.  
   If the subscription is successful, the subscription status will be changed to confirmed from pending.

8. Search and open CloudWatch.

9. Create alarms for the topic.  
   For example, alarm that will be triggered if user publishes a message more than once in a minute.


11. In the left navigation pane, click **Topics**.

12. Click **Publish message**.

13. In the message body, enter the json message that you want to send to the endpoint.
14. Click **Publish message**.

What to do next

ServiceNow instance will be able to receive events from AWS. The events will be saved in the [em_event] table. You can view the respective alert from the **Alert** column.

**Sample payload from AWS**

Snapshot of the entity when an event occurs in AWS.

**Sample payload sent from AWS**

```json
{
    "Type": "Notification",
    "MessageId": "1466ec57-215a-5e3c-ad5f-b44e6e6c2698",
    "Subject": "ALARM: \"server-logicaldiskfree-moni-083ee6547856a1bcl\" in Asia Pacific (Sydney)",
    "Message": "\"AlarmName\":\"server-logicaldiskfree-moni-083ee6547856a1bcl\",\"AlarmDescription\":\"A
larm when Logical free disk is less than
10\"",""AWSAccountId\":\"175332051639\",\"NewStateValue\":\"ALARM\",\"NewStateReason\":\"T
hreshold Crossed: 1 datapoint [1.3441221714019775 (01/11/20 23:59:00)] was less than or
equal to the threshold
(10.0).\"",""StateChangeTime\":\"2020-11-02T00:04:06.730+0000\",\"Region\":\"Asia Pacific
caldiskfree-moni-083ee6547856a1bcl\",\"OldStateValue\":\"INSUFFICIENT_DATA\",\"Trigger":{
"MetricName":"LogicalDisk % Free
Space\",\"Namespace":"CWAgent\",\"StatisticType":"Statistic","Statistic":"AVERAGE
\",\"Unit":null,\"Dimensions":{{\"value":\"C:\",\"name":\"instance\"},{\"value":\"i-098
7654321\",\"name":\"InstanceId\"},{\"value":\"ami-04604b4eb0ec93b5f\",\"name":\"ImageId
\"},{\"value":\"LogicalDisk\",\"name":\"objectname\"},{\"value":\"t3.medium\",\"name":\"InstanceType\"}},{\"Period":300,\"EvaluationPeriods":1,\"ComparisonOperator":"LessThanOr
EqualToThreshold\",\"Threshold":10.0,\"TreatMissingData":\"- TreatMissingData:
missing\",\"EvaluateLowSampleCountPercentile\":\"\"}},

"Timestamp": "2020-11-02T00:04:06.776Z",
"SignatureVersion": "1",
"Signature": "S0hCeJzpTkdOBEP4zU3csNUrVIeWsV0aPSEcnnZS6fnHFXU78OvsytfxIr46Cb+yWgLcXIUIo/rt1nuhn0wybJwo
HmB1EAUio8FDvmL63yW7LfWQOqO/QHc2nE76BFaPDejC9KSnjZMe4qdBqNMGbeqBe+WaQQM+vacm58x012ZeUCv6Hb
```
Dynatrace integration with SR Ops

Dynatrace monitors virtual machines from various clouds and physical servers. It gives total visibility into all dimensions of applications; from end-user to application deep dive, to the network. You can integrate Dynatrace with SR Ops for intelligent monitoring of services running in the SR Ops.

What does SR Ops offer Dynatrace users?

Use Dynatrace integration to send alerts to SR Ops API with detailed information. SR Ops acts as a dispatcher for these alerts, determines the right people to notify based on on-call schedules—notifies via email, text messages (SMS), phone calls, and iPhone & Android push notifications, and escalates alerts until the alert is acknowledged or closed.

Functionality of the integration

When an alert is created on Dynatrace, an alert is created in SR Ops, and when the alert is resolved on Dynatrace, the alert is closed in SR Ops automatically through the integration.

Configure alert rules and notification on Dynatrace

Configure alert rules to automatically detect performance anomalies in your environment.

Before you begin

Ensure you have done the following actions:

• Created a webhook endpoint in SR Ops. For information, see Create a webhook endpoint in SR Ops.
• Created an account in Dynatrace.

Role required: evt_mgmt_integration
About this task
Dynatrace allows you to define specific thresholds that specify at what levels deviations above baseline performance are severe enough to generate problem alerts. Defining the thresholds is essentially about adjusting the sensitivity of problem detection. Adapting the sensitivity of anomaly detection either by deviating from automated baselines or by specifying fixed thresholds is supported for: Application, Services, and Database services. For the following, sensitivity can be adapted only by specifying fixed thresholds:

- Infrastructure
- Plugin events
- NAM (DC RUM) events
- Custom alerts

Procedure
1. Log in to the Dynatrace console.
2. In the left navigation pane, click Setting > Integration > Problem notifications. The Integrate with other notifications system page appears.
3. Click the Custom integration tile. The Set up custom integration page appears.
4. In the Name field, enter a name for the integration.
5. In the Webhook URL field, enter the webhook URL that you have already created.
6. Click Create basic authorization header.
7. Enter the credentials and click Add.
8. In the Custom payload field, enter the payload for the integration.
9. From the Alerting profile list, select the profile or alerting rules that you have created.
   The alerting profile controls the delivery of problem notifications related to the integration.
10. To verify if the integration is working fine with SR Ops, click Send test notification.
   A sample event is created in the em_event table.
11. Click Save.

Sample payload from Dynatrace
Snapshot of the entity when an event occurs in Dynatrace.
Sample payload sent from Dynatrace

```json
{
    "ImpactedEntities": [
        {
            "type": "HTTP_CHECK",
            "name": "srodev",
            "entity": "HTTP_CHECK-DFAE919F2904B11A"
        }
    ],
    "ImpactedEntity": "HTTP monitor global outage for HTTP monitor srodev",
    "PID": "-7567972756941671037",
    "ProblemDetailsHTML": "<h3>OPEN Problem 37 in environment rhl41861</h3><br><small>Problem detected at: 20:41 (UTC) 17.08.2020</small><br>1 impacted application<br>HTTP monitor<br>HTTP monitor global outage<br>6 failures<br>Location: N. California<br><a href="https://rhl41861.live.dynatrace.com/#problems/problemdetails;pid=-7567972756941671037_1597696877509V2">Open in Browser</a>",
    "ProblemDetailsJSON": {
        "id": "-7567972756941671037_1597696877509V2",
        "startTime": 1597696877509,
        "endTime": -1,
        "displayName": "37",
        "impactLevel": "APPLICATION",
        "status": "OPEN",
        "severityLevel": "AVAILABILITY",
        "commentCount": 0,
        "tagsOfAffectedEntities": [],
        "rankedEvents": [
            {
                "startTime": 1597700779435,
                "endTime": -1,
                "entityId": "HTTP_CHECK-DFAE919F2904B11A",
                "entityName": "srodev",
                "severityLevel": "AVAILABILITY",
                "impactLevel": "APPLICATION",
                "eventType": "HTTP_CHECK_GLOBAL_OUTAGE",
                "status": "OPEN",
                "severities": [],
                "isRootCause": false,
                "affectedPrivateSyntheticLocations": [ "N. California" ],
                "affectedSyntheticActions": [ "srodev xmlstats.do" ]
            },
            {
                "startTime": 1597699283077,
                "endTime": 1597699583467,
```
"entityId": "HTTP_CHECK-DFAE919F2904B11A",
"entityName": "srodev",
"severityLevel": "AVAILABILITY",
"impactLevel": "APPLICATION",
"eventType": "HTTP_CHECK_GLOBAL_OUTAGE",
"status": "CLOSED",
"severities": [],
"isRootCause": false,
"affectedPrivateSyntheticLocations": ["N. California"],
"affectedSyntheticActions": ["srodev xmlstats.do"]
},
{
"startTime": 1597696877509,
"endTime": 1597697474652,
"entityId": "HTTP_CHECK-DFAE919F2904B11A",
"entityName": "srodev",
"severityLevel": "AVAILABILITY",
"impactLevel": "APPLICATION",
"eventType": "HTTP_CHECK_GLOBAL_OUTAGE",
"status": "CLOSED",
"severities": [],
"isRootCause": false,
"affectedPrivateSyntheticLocations": ["N. California"],
"affectedSyntheticActions": ["srodev xmlstats.do"]
},
{
"startTime": 1597697780255,
"endTime": 1597698084149,
"entityId": "HTTP_CHECK-DFAE919F2904B11A",
"entityName": "srodev",
"severityLevel": "AVAILABILITY",
"impactLevel": "APPLICATION",
"eventType": "HTTP_CHECK_GLOBAL_OUTAGE",
"status": "CLOSED",
"severities": [],
"isRootCause": false,
"affectedPrivateSyntheticLocations": ["N. California"],
"affectedSyntheticActions": ["srodev xmlstats.do"]
},
{
"startTime": 1597698377936,
"endTime": 1597698674794,
"entityId": "HTTP_CHECK-DFAE919F2904B11A",
"entityName": "srodev",
"severityLevel": "AVAILABILITY",
"impactLevel": "APPLICATION",
"eventType": "HTTP_CHECK_GLOBAL_OUTAGE",
"status": "CLOSED",
"severities": [],
"isRootCause": false,
"affectedPrivateSyntheticLocations": ["N. California"],
"affectedSyntheticActions": ["srodev xmlstats.do"]
}
"status": "CLOSED",
"severities": [],
"isRootCause": false,
"affectedPrivateSyntheticLocations": [ "N. California" ],
"affectedSyntheticActions": [ "srodev xmlstats.do" ]
},
{
"startTime": 1597699880034,
"endTime": 1597700179483,
"entityId": "HTTP_CHECK-DFAE919F2904B11A",
"entityName": "srodev",
"severityLevel": "AVAILABILITY",
"impactLevel": "APPLICATION",
"eventType": "HTTP_CHECK_GLOBAL_OUTAGE",
"status": "CLOSED",
"severities": [],
"isRootCause": false,
"affectedPrivateSyntheticLocations": [ "N. California" ],
"affectedSyntheticActions": [ "srodev xmlstats.do" ]
}]
]
"rankedImpacts": [
{
"entityId": "HTTP_CHECK-DFAE919F2904B11A",
"entityName": "srodev",
"severityLevel": "AVAILABILITY",
"impactLevel": "APPLICATION",
"eventType": "HTTP_CHECK_GLOBAL_OUTAGE"
},
{
"entityId": "HTTP_CHECK-DFAE919F2904B11A",
"entityName": "srodev",
"severityLevel": "AVAILABILITY",
"impactLevel": "APPLICATION",
"eventType": "HTTP_CHECK_GLOBAL_OUTAGE"
},
{
"entityId": "HTTP_CHECK-DFAE919F2904B11A",
"entityName": "srodev",
"severityLevel": "AVAILABILITY",
"impactLevel": "APPLICATION",
"eventType": "HTTP_CHECK_GLOBAL_OUTAGE"
},
{
"entityId": "HTTP_CHECK-DFAE919F2904B11A",
"entityName": "srodev",
"severityLevel": "AVAILABILITY",
"impactLevel": "APPLICATION",
"eventType": "HTTP_CHECK_GLOBAL_OUTAGE"
},
}
"entityId": "HTTP_CHECK-DFAE919F2904B11A",
"entityName": "srodev",
"severityLevel": "AVAILABILITY",
"impactLevel": "APPLICATION",
"eventType": "HTTP_CHECK_GLOBAL_OUTAGE"
},
{
"entityId": "HTTP_CHECK-DFAE919F2904B11A",
"entityName": "srodev",
"severityLevel": "AVAILABILITY",
"impactLevel": "APPLICATION",
"eventType": "HTTP_CHECK_GLOBAL_OUTAGE"
}
],
"affectedCounts": {
"INFRASTRUCTURE": 0,
"SERVICE": 0,
"APPLICATION": 1,
"ENVIRONMENT": 0
},
"recoveredCounts": {
"INFRASTRUCTURE": 0,
"SERVICE": 0,
"APPLICATION": 0,
"ENVIRONMENT": 0
},
"hasRootCause": false
},
"ProblemDetailsMarkdown": "## OPEN Problem 37 in environment
*rhl41861*

Problem detected at: 20:41 (UTC) 17.08.2020

---
**1 impacted application**

---

HTTP monitor
### **srodev**
> **HTTP monitor global outage**
> 6 failures
> Location: N. California

---

[Open in Browser](https://rhl41861.live.dynatrace.com/#problems/problemdetails;pid=-7567972756941671037_1597696877509V2)

"ProblemDetailsText": "OPEN Problem 37 in environment rhl41861

Problem detected at: 20:41 (UTC) 17.08.2020

1 impacted application

HTTP monitor global outage
6 failures
Location: N. California

https://rhl41861.live.dynatrace.com/#problems/problemdetails;pid=-7567972756941671037_1597696877509V2",
"ProblemID": "37",
"ProblemImpact": "APPLICATION",
"ProblemSeverity": "AVAILABILITY",
"ProblemTitle": "HTTP monitor global outage",
"ProblemURL": "https://rhl41861.live.dynatrace.com/#problems/problemdetails;pid=-7567972756941671037_1597696877509V2"
New Relic integration with SR Ops

New relic is the all-in-one web application performance tool that provides performance insight from the end user experience, through servers, and down to a line of application code. New Relic Alerts is New Relic's new incident management platform that offers a centralized monitoring for all New Relic products.

What does SR Ops offer New Relic users?

SR Ops has a native integration with New Relic Alerts. Use the integration to send New Relic incidents to SR Ops's API with detailed information. SR Ops acts as a dispatcher for New Relic incidents, determines the right people to notify based on on-call schedules—notifies via email, text messages (SMS), phone calls, and iPhone & Android push notifications, and escalates alerts until the alert is acknowledged or closed.

Functionality of the integration

- When an alert is created in New Relic Alerts, an alert is also created in SR Ops automatically through the integration.
- When an alert is closed in New Relic Alerts, the related alert is also closed in SR Ops automatically through the integration.
- When an alert is acknowledged in New Relic Alerts, the related alert is also acknowledged in SR Ops automatically through the integration.

- Create a notification channel of type webhook at NewRelic to send events to ServiceNow and add that notification channel to policy.
- Configure policies on NewRelic and attach Alert Conditions to the policy based on which alert will be generated at NewRelic.
- Whenever there is a violation in alert condition then an incident is created on NewRelic portal and the same will be sent to the servicenow url defined in the notification channel.
- Configure Event rules on servicenow to bind the affected host to cmdb_ci_vm_object [for virtual server] or cmdb_ci_server [for physical server].
Create a notification channel

Use alerts to set up notification channels, and attach those channels to policies. Your selected channels provide fast and consistent ways for the right personnel to be notified about incidents.

Before you begin

- Ensure you have created a webhook endpoint for New Relic. For information on how to create a webhook, see Create a webhook endpoint in SR Ops.
- Created an account in New Relic.

Role required: evt_mgmt_integration

Procedure

1. Log in to the New Relic console.
2. Click the Alerts & AI tab.
3. In the left navigation pane, click Notification Channels.
4. Click New notification channel.
5. On the Create a new notification channel form, under the Channel details tab, perform the following actions:
   - **Select a channel type**: Select Webhook.
   - **Channel name**: Enter a name for the channel.
   - **Base Url**: Enter the webhook URL.
   - + **Add basic auth**: Enter your credentials.
   - + **Add custom payload**: Select Payload type as json.
6. Click Create channel.
7. To verify if the integration is working fine with SR Ops, click Send a test notification.
8. Click Save changes.
9. To select from existing alert policies, do the following actions:
   - Click the Alert policies tab.
   - In the Add or remove alert policies pop-up window, select the alert policies for the integration.
   - Click Save changes.

What to do next

Create an alert policy
Create an alert policy

Create an alert policy to associate with a notification channel. A policy is a group of one or more conditions.

Before you begin
Role required: evt_mgmt_integration

Procedure
1. Log in to the New Relic console.
2. Click the **Alerts & AI** tab.
3. In the left navigation pane, click **Policies**.
4. On the policy index page, click **New alert policy**.
5. On the Create alert policy form, perform the following actions:
   - **ALERT POLICY NAME**: Enter a name for the policy.
   - **INCIDENT PREFERENCE**: Select incident preference to define when alerts create incidents and how violations are grouped.
6. Click **Create alert policy**.

What to do next
You can continue from here to assign notification channels or create alert conditions.

Create alert conditions

Create alert conditions to describe a monitored data source and the behavior of that data source that will be considered a violation.

Before you begin
Ensure that you have an alert policy.
Role required: evt_mgmt_integration

Procedure
1. Log in to the New Relic console.
2. Perform any of the following actions:
   - **Create an alert policy** and you will automatically be prompted to add a condition.
   - From an existing policy page, click **Create alert condition**.
3. Give the following necessary details and add it to the policy:
• Select a product/data-source
• Select a condition type
• Define thresholds

4. Click **Create alert condition**.

**Sample payload from New Relic**

Snapshot of the entity when an event occurs in New Relic.

**Sample payload sent from New Relic**

```json
{
  "metadata" : null,
  "open_violations_count_critical" : 1,
  "closed_violations_count_critical" : 0,
  "incident_acknowledge_url" : "https://alerts.newrelic.com/accounts/2857531/incidents/163450695/acknowledge",
  "targets" : [ {
    "id" : "AWS_US_WEST_1",
    "name" : "srodev2 - synthetic",
    "link" : "https://synthetics.newrelic.com/accounts/2857531/monitors/7fcbaad0-3dde-48f8-aea7-eca5b262de22/results/61a98a6f-96e2-4749-9db1-6b3ae910e3db",
    "labels" : { "account" : "Account 2857531",
                 "accountId" : "2857531",
                 "monitorStatus" : "Enabled",
                 "monitorType" : "Scripted API",
                 "period" : "5",
                 "publicLocation" : "San Francisco, CA, USA",
                 "trustedAccountId" : "2857531"
               },
    "product" : "SYNTHETICS",
    "type" : "Monitor"
  } ],
  "duration" : 99,
  "open_violations_count_warning" : 0,
  "event_type" : "INCIDENT",
  "incident_id" : 163450695,
  "account_name" : "Account 2857531",
  "details" : "Monitor failed for location San Francisco, CA, USA on 'srodev2 - synthetic'",
  "condition_name" : "All"
}
```
Datadog integration with SR Ops

Datadog is a popular cloud and application monitoring service. With Datadog, gain insight into granular metrics from entire stacks, from application-level to actual hosts and VMs. Datadog provides alerts based on monitoring metrics for, or events on, services. Datadog generates alerts for detected problems, and SR Ops ensures the right people are working on them.

For an alert rule on a metric value, when the value of a specified metric crosses a threshold assigned, the alert rule becomes active and sends a notification. For an alert rule on events, a rule can send a notification on every event, or, only when a certain number of events happen.

What does SR Ops offer Datadog users?

SR Ops has a native, powerful bidirectional integration with Datadog. Use the integration to automatically sync your Datadog alerts with SR Ops alerts, and benefit from SR Ops's rich alert notification system, escalations, and on-call rotations. Datadog generates alerts based on metrics and events. SR Ops acts as a dispatcher for the alerts generated by Datadog. SR Ops determines the right people to notify based on on-call schedules and escalations and notifies via using email, text messages (SMS), phone calls, and Android & iOS push notifications.
• Datadog triggers an alert when a defined condition is matched. When an alert is created in Datadog, an alert is also created in SR Ops automatically through the integration.

• When the alert is acknowledged in SR Ops, alert is acknowledged automatically in Datadog as well.

• When the alert is closed in SR Ops, alert is closed automatically in Datadog as well.

• When an alert is created in SR Ops from any source (other than Datadog), SR Ops is able to post the alert to Datadog (optional).

• Acknowledge (or close) the alerts from Datadog.

• Notify on-call responders based on alerts sent from Datadog.

• Send enriched event data from Datadog including visualizations of the metric/service-level indicator (SLI) that triggered the event.

• Create high and low urgency incidents based on the severity of the event from the Datadog event payload.

• Incidents and escalations are synchronized across both SR Ops and Datadog as they update.

• Incidents will automatically resolve in SR Ops when the metric in Datadog returns to normal with bidirectional synchronization.

**Functionality of the integration**

When an alert is created in Datadog, an alert is created in SR Ops automatically through the integration.

Datadog metrics that fall outside of a designated range will send an event to a service in SR Ops. Events from Datadog will trigger a new incident on the corresponding SR Ops service, or group as alerts into an existing incident.

Once the metric has returned to its designated range, a `resolve` event will be sent to the SR Ops service to resolve the alert, and associated incident on that service.

**Configure webhook in Datadog**

Configure webhook endpoint in Datadog so that SR Ops can communicate with Datadog using the endpoint.

**Before you begin**

Ensure you have done the following actions:
• Created a webhook endpoint in SR Ops. For information, see Create a webhook endpoint in SR Ops.
• Created an account in Datadog.

Role required: evt_mgmt_integration

Procedure
1. Log in to the Datadog console.
2. From the left navigation pane, click Integrations > Integrations.
3. Search for Webhook and click to open the Webhook card.
4. Click the Configuration tab.
5. To create a webhook, scroll down to the Webhooks section and click New.
6. On the New Webhook form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the webhook.</td>
</tr>
<tr>
<td>URL</td>
<td>Enter that URL that you have already created.</td>
</tr>
<tr>
<td>Note:</td>
<td>You need to enter the username and password at the beginning of the webhook URL. For example, <a href="https://event:admin@kgsrontop.service-now.com/api/sn_em_connector/em/inbound_event?source=datadog&amp;integration_id=f9a3f75a1b16e090e96c631abc4bcbbb">https://event:admin@kgsrontop.service-now.com/api/sn_em_connector/em/inbound_event?source=datadog&amp;integration_id=f9a3f75a1b16e090e96c631abc4bcbbb</a></td>
</tr>
<tr>
<td>Payload</td>
<td>A json object that describes the file or folder (target) that triggered the webhook, as well as the event that has been triggered.</td>
</tr>
<tr>
<td>Note:</td>
<td>Custom headers must be in JSON format.</td>
</tr>
<tr>
<td>Custom Headers</td>
<td>Option to send custom header fields along with the outgoing request.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Encode as form</strong></td>
<td>Option to convert payload into valid URL format.</td>
</tr>
</tbody>
</table>

**Note:** Custom headers must be in JSON format.

7. Click **Save**.

8. From the left navigation pane, click **Monitors > Manage Monitors**.

9. Click **New Monitor**.

10. Under the **Custom Monitors** tab, select the monitor type as **Metric**.

11. Choose the detection method, define the metric, and set alert conditions.

12. In the **Say what’s happening** section, under the **Edit** tab, enter a name for the monitor.

13. In the **Notify your team** section, in the first field, select the webhook integration that you created.

14. To verify if the integration is working fine with SR Ops, click **Test Notifications**.

15. Click **Save**.

**Sample payload from Datadog**

Snapshot of the entity when an event occurs in Datadog.

**Sample payload sent from Datadog**

```json
{
    "body": "$EVENT_MSG",
    "last_updated": "$LAST_UPDATED",
    "event_type": "$EVENT_TYPE",
    "title": "$EVENT_TITLE",
    "date": "$DATE",
    "org": {
        "id": "$ORG_ID",
        "name": "$ORG_NAME"
    },
    "id": "$ID",
    "alert_id": "$ALERT_ID",
    "alert_metric": "$ALERT_METRIC",
    "alert_priority": "$ALERT_PRIORITY",
    "alert_transition": "$ALERT_TRANSITION",
    "alert_status": "$ALERT_STATUS"
}
```
Google Monitor integration with SR Ops

Google Monitor provides powerful monitoring, logging, and diagnostics. It equips you with insight into the health, performance, and availability of cloud-powered applications, enabling you to find and fix issues faster.

Google Monitor is natively integrated with Google Cloud Platform, Amazon Web Services, and popular open source packages. Google Monitor provides a wide variety of metrics, dashboards, alerting, log management, reporting, and tracing capabilities.

For an alert rule on a metric value, when the value of a specified metric crosses a threshold assigned, the alert rule becomes active and sends a notification. For an alert rule on events, a rule can send a notification on every event, or, only when a certain number of events happen.

What does SR Ops offer Google Monitor users?

SR Ops has a webhook integration with Google Monitor. Using the integration, Google Monitor sends incidents to SR Ops API with detailed information. SR Ops acts as a dispatcher for Google Monitor alerts, determines the right people to notify based on on-call schedules—notifies via email, text messages (SMS), phone calls and iPhone & Android push notifications, and escalates alerts until the alert is acknowledged or closed.

Functionality of the integration

When an alert is created in Google Monitor, an alert is created in SR Ops automatically through the integration.

- When the state of a notification is open in Google Monitor, an alert is also created in SR Ops automatically through the integration.
- When the state of a notification is close in Google Monitor, the related alert is closed automatically.
- When the state of a notification is acknowledge in Google Monitor, the related alert is acknowledged automatically.
Configure webhook in Google Cloud Platform

Configure webhook endpoint in Google Cloud Platform so that SR Ops can communicate with Google Cloud Platform using the endpoint.

Before you begin
Ensure you have done the following actions:

• Created a webhook endpoint in SR Ops. For information, see Create a webhook endpoint in SR Ops.

• Created an account in Google Cloud Platform.

Role required: evt_mgmt_integration

Procedure
1. Log in to the Google Cloud Platform console.
2. In the left navigation pane, under OPERATIONS, click Monitoring > Alerting.
3. Click EDIT NOTIFICATION CHANNELS.
4. Under the Webhooks section, click ADD NEW.
5. On the Add Static Webhook form, fill the fields.
   • Endpoint URL: Enter the webhook URL that you have already created.
   • Display name: Enter a display name for the webhook endpoint.
6. Select Use HTTP Basic Auth and enter your credentials.
7. To verify if the integration is working fine with SR Ops, click TEST CONNECTION.
8. Click SAVE.
9. In the left navigation pane, click Alerting.
10. Click + CREATE POLICY.
11. Under the What do you want to track? section, click ADD CONDITION and add the required conditions for the alert.
12. Click ADD.
13. Under the Who should be notified? section, select the webhook names where you want to get alert notifications and click OK.
14. Under the What are the steps to fix the issue? section, in the Alert name field, enter an alert name.
15. Optional: In the Optional field, enter instructions or suggestions to solve the issue.
16. Click Save.
Sample payload from Google Monitor
Snapshot of the entity when an event occurs in Google Monitor.

Sample payload sent from Google Monitor

```
{
  "incident": {
    "incident_id": "0.lsnwib31sglo",
    "resource_id": "",
    "resource_name": "deductive-reach-207607 VM Instance",
    "resource": {"type": "gce_instance","labels": {}},
    "resource_type_display_name": "VM Instance",
    "metric": {"type": "compute.googleapis.com/instance/cpu/usage_time", "displayName": "CPU usage"},
    "started_at": 1602000626,
    "policy_name": "CPU Usage",
    "condition_name": "VM Instance - CPU usage for deductive-reach-207607 by label.instance_name [SUM]",
    "condition": {
      "name": "projects/deductive-reach-207607/alertPolicies/4416258801778683037/conditions/4416258801778682826",
      "displayName": "VM Instance - CPU usage for deductive-reach-207607 by label.instance_name [SUM]",
      "conditionThreshold": {
        "filter": "metric.type="compute.googleapis.com/instance/cpu/usage_time" resource.type="gce_instance" resource.label."project_id"="deductive-reach-207607"",
        "aggregations": [{"alignmentPeriod": "60s", "perSeriesAligner": "ALIGN_RATE", "crossSeriesReducer": "REDUCE_SUM", "groupByFields": ["metric.label.instance_name"]}],
        "comparison": "COMPARISON_GT",
        "thresholdValue": 0.6,
        "duration": "300s",
        "trigger": {"count": 1}
      },
      "url": "https://console.cloud.google.com/monitoring/alerting/incidents/0.lsnwib31sglo?project=deductive-reach-207607",
      "state": "open",
      "ended_at": 1602000987,
    }
  }
```
Grafana integration with SR Ops

Grafana is the all-in-one web application performance tool that provides performance insight from the end user experience, through servers, and down to a line of application code.

What does SR Ops offer Grafana users?

SR Ops has a native integration with Grafana. Use the integration to send Grafana alerts to SR Ops's API with detailed information. SR Ops acts as a dispatcher for Grafana alerts, determines the right people to notify based on on-call schedules – notifies via email, text messages (SMS), phone calls, and iPhone & Android push notifications, and escalates alerts until the alert is acknowledged or closed.

Functionality of the integration

• Whenever there is a violation in alert condition then an alert is created on the Grafana portal and the same will be sent to the SR Ops using the webhook url defined in the notification channel.

• When an alert is closed in Grafana, the related alert is also closed in SR Ops automatically through the integration.

Configure webhook in Grafana

Configure webhook endpoint in Grafana so that SR Ops can communicate with Grafana using the endpoint.

Before you begin

Ensure you have done the following actions:

• Created a webhook endpoint in SR Ops. For more information, see Create a webhook endpoint in SR Ops.

• Created an account in Grafana.

Role required: evt_mgmt_integration
Procedure

1. Log in to the Grafana console.

2. In the left navigation pane, click the Bell icon ( ) and then click Alerting > Notification channels.
   The Alerting page appears and the Notification channels tab is selected by default.

3. Click New channel.
   The New notification channel form appears.

4. To create a webhook, scroll down to the Webhooks section and click New.

5. On the form, fill the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the notification channel.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the notification channel.</td>
</tr>
<tr>
<td></td>
<td>Note: You need to select the type as webhook.</td>
</tr>
<tr>
<td>Url</td>
<td>Enter that webhook url that you have already created.</td>
</tr>
<tr>
<td>Optional Webhook settings</td>
<td></td>
</tr>
<tr>
<td>Http Method</td>
<td>The protocol to enable communication.</td>
</tr>
<tr>
<td></td>
<td>Note: You need to select POST.</td>
</tr>
<tr>
<td>Username</td>
<td>User name for the ServiceNow user who has the evt_mgmt_integration role.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the ServiceNow user.</td>
</tr>
<tr>
<td>Notification settings</td>
<td></td>
</tr>
<tr>
<td>Options to manage your notifications</td>
<td></td>
</tr>
</tbody>
</table>

6. To verify your configuration, click Test.

7. Click Save.
8. In the left navigation pane, click the Dashboards icon and then click **Manage**.

9. Click an existing dashboard where you want to add the alert rules and conditions.

10. Right-click on the required panel and click **Edit**.

11. Click the **Create Alert** tab and click the **Create Alert** button.

12. Provide the rules and conditions for the alert.

13. In the Notification section, under **Send to**, click the + sign and add the notification channel which you have created.

14. In the Tags section, add the following tags:
   - **severity**: (Optional) Severity with which alert has to be created.
   - **count**: (This tag is mandatory, otherwise the alerts won't close automatically in ServiceNow.) The number of devices, hosts, or servers monitored by this alert rule.

15. Click **Save**. Alert rule is created. To access your alert rule, in the left navigation pane, click the Bell icon and then click **Alerting > Alert Rules**.

   **Note:** You may see extra clear events coming into ServiceNow which are not bound to an alert. Ignore them as they are created to overcome the issue of Grafana not sending information in the clear notification.

**Sample payload from Grafana**

Snapshot of the entity when an event occurs in Grafana.

**Sample payload sent from Grafana**

```json
{
    "dashboardId": 2,
    "evalMatches": [
        {
            "value": 19377.996875,
            "metric": "System - Processes executing in kernel mode",
            "tags": {
                "__name__": "process_cpu_seconds_total",
                "instance": "168.62.217.70:9100"
            }
        }
    ]
}
```
Domain separation and Site Reliability Operations

Domain separation is supported for Site Reliability Operations. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Basic*

The support level is Basic but has some exceptions or special conditions.

- Business logic: Ensure that data goes into the proper domain for the application’s service provider (SP) use cases.
- The user interface, cache keys, reporting, rollups, and aggregations all use the domain at production run time.
- The owner of the instance must be able to set up the application to function across multiple tenants.

Sample use case: When an SP uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.
Overview

- Domain separation is present in all metadata tables in the application. Instance level tables also have domain separation explicitly. Other internal tables, such as the internal Team Request table, are domain-separated implicitly by referencing domain-separated records.

- System properties are not domain-separated, which has implications for Team Management features. The properties are shared by multiple domains and are set at the instance level. Domain-specific setup for these is not supported.

- Where another application is being leveraged (for example the Event Management Connectors) domain separation is determined by the domain-separation capabilities of that application.

How domain separation works in the Site Reliability Operations application

The specific conditions indicated by the Basic* support level rating above relate to team management:

- New teams are created through a catalog item backed by an IntegrationHub flow. The sro_admin must set up the flow and can initiate it from the Service Portal or through the Site Reliability Operations workspace. Instructions appear in the setup guide.

- IntegrationHub subflows and actions control management of Site Reliability Operations teams.

- Only one catalog item and flow can be set up for each instance. The customer is responsible for setting up team properties to support domain separation as a customization of the existing flows.

- The requestor of a team catalog item is associated with the domain and is available as part of the request item. As a result, if needed, the requester can create the team in a specific domain or the catalog Item and extend it to capture the domain another way. In either case, the sro_admin must make changes to the IntegrationHub flows and actions to support this.

Domain-separated tables

- Action (sn_sro_act)
- Condition (sn_sro_cnd)
- Integration (sn_sro_em_integration)
- Integration Action (sn_sro_em_int_act)
- Configuration (sn_sro_cfg)
• Configuration Variable (sn_sro_cfg_var)
• Service Metrics (sn_sro_service_metrics)

Learn more by seeing the Domain separation and On-Call Scheduling topic.

Related information
Domain separation for service providers

Site Reliability Metrics
Site Reliability Metrics (SRM) is an application that extends Site Reliability Operations (SRO). It serves as a signal aggregation point for Application Performance Management (APM) alerts.

SRM enables Site Reliability Engineers (SRE)s to capture signals from multiple sources, set Service Level Objective (SLO) targets, view Error Budgets (EB) and invoke policy-based actions such as creating an incident or sending a notification based on Error Budget thresholds. SREs can measure the service experience and manage release velocity by evaluating key Service Level Indicators (SLI)s sourced from one or more performance management tools. The evaluation and aggregation of these signals enables SREs to trigger policy-based actions and respond quickly to changing conditions.

Site reliability engineers and service owners can use SRM to ensure that the service they provide meets consumer expectations. They can measure quality by setting service level objectives based on SLI types (For example, latency, throughput, availability) and then use Error Budget Policies to trigger one or more policy-based actions.

The key features of the SRM application are:
• SLI signal aggregation
• Create duration and count based service level objectives
• Calculate error budgets (EB)
• Error budget policies
• Error budget visualization

High-level workflow
1. SRM leverages SRO integrations for signal aggregation.
2. Reliability indicators containing SLIs and SLOs are created for the service in SRM.
3. When a qualified alert is generated for a service in the APM tool, the cumulative breach and the error budget values are updated for the reliability indicators in SRM.

4. An error budget policy is created for the service to trigger actions such as creating an incident, sending notifications, and so on, to remediate service issues.

Watch the following video for a general understanding of Site Reliability Metrics and how you can use it.

An overview of the Site Reliability Metrics application.

**Install Site Reliability Metrics**

You can install the Site Reliability Metrics application (sn_srm) if you have the admin role. The application includes demo data and installs related ServiceNow® Store applications and plugins if they are not already installed.

**Before you begin**

Ensure that you have installed the application in which you want to access the SRM view from the workspace of the application. For example, Site Reliability Operations Workspace.

ℹ️ **Note:** You can configure Site Reliability Metrics for any of your workspace that you are using. If you want to use SRM for your workspace, you must set up navigation to SRM inside your desired workspace. You can add a related list for Service Level Objective (sn_srm_service_level_objective) to the Services record views or add Service Level Objective (SLO) as a standalone list to main list in navigation.

Role required: admin

**About this task**

Roles and demo data are installed with Site Reliability Metrics. The demo data includes templates that speed up implementation and help users to understand Site Reliability Metrics quickly. For more information on roles, see [User roles and responsibilities in SRM](#).

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**
2. Find the Site Reliability Metrics application (sn_srm) using the filter criteria and search bar.
You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Site Reliability Metrics.

4. Optional: If demo data is available and you want to install it, click Load demo data.

(Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

<i>Important:</i> If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click Install.

**Site Reliability Metrics basic terminologies**

A quick guide to some of the basic terminology to understand Site Reliability Metrics (SRM) and use its features.

<table>
<thead>
<tr>
<th>Terms used in SRM</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Performance Management (APM)</td>
<td>The monitoring and management of performance and availability of applications. APM strives to detect and diagnose complex application performance problems and maintain an expected level of service.</td>
</tr>
<tr>
<td>Service Level Management (SLM)</td>
<td>A framework by which service levels are agreed to between a provider and a consumer to support business processes. Service Level Management</td>
</tr>
</tbody>
</table>
### Terms used in SRM (continued)

<table>
<thead>
<tr>
<th>Terms</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Service Level Agreements (SLA)</strong></td>
<td>An SLA defines the level of service agreed to between a provider and a consumer. It typically lays out the metrics by which service is measured, as well as remedies or penalties if the agreed-upon service levels are not achieved.</td>
</tr>
<tr>
<td><strong>Service Level Objective (SLO)</strong></td>
<td>A target value or range of values for a service level that is measured by an SLI.</td>
</tr>
<tr>
<td><strong>Service Level Indicator (SLI)</strong></td>
<td>A quantitative measure of some aspect of the level of service that is provided. Metrics are used to define SLO targets.</td>
</tr>
<tr>
<td><strong>Measured reliability</strong></td>
<td>The ability to deliver the promised services in a consistent and accurate manner. Reliability is calculated automatically by subtracting outages from 100%.</td>
</tr>
<tr>
<td><strong>Error budget</strong></td>
<td>An error budget is the amount of SLO that you can spend over a specified time. It can be used to manage release velocity. It is typically based on availability, latency, and so on.</td>
</tr>
<tr>
<td><strong>Error budget policy</strong></td>
<td>A policy or rule that is created for a service to trigger actions such as creating an incident, or sending notifications when a set threshold is crossed.</td>
</tr>
</tbody>
</table>
**User roles and responsibilities in SRM**

With user roles, you can grant users access to different parts of the Site Reliability Metrics (SRM) console. In other words, what users can or cannot do in SRM is decided based on their roles.

SRM has the following pre-defined roles:

<table>
<thead>
<tr>
<th>Roles</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_srm_admin</td>
<td>Administrators can manage every aspect of Site Reliability Metrics setup. Administrators can perform the following actions for all services and groups:</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>• Create integrations with Application Performance Monitoring (APM) tools</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Setup and maintain Reliability Indicators</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Setup and maintain Error Budget Policies</td>
<td></td>
</tr>
<tr>
<td>sn_srm_manager</td>
<td>Managers oversee teams which in turn maintain specific services. Managers ensure resilience across all the systems and the DevOps workflows. Managers can perform the following actions for the services that they are responsible for:</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>• Create Integrations with Application Performance Monitoring (APM) tools</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Setup and maintain Reliability Indicators</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Setup and maintain Error Budget Policies</td>
<td></td>
</tr>
<tr>
<td>sn_srm_user</td>
<td>Users perform everyday tasks needed to monitor service</td>
<td>None</td>
</tr>
</tbody>
</table>
### Roles and responsibilities (continued)

<table>
<thead>
<tr>
<th>Roles</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_srm_business_stakeholder</td>
<td>Business stakeholders are external interested parties who want to have a view of service resilience, but do not get directly involved in maintaining it. Business stakeholders can perform the following actions:</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>• View Integrations with Application Performance Monitoring (APM) tools</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View Reliability Indicators</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View Error Budgets</td>
<td></td>
</tr>
</tbody>
</table>

### SRM system properties

You can configure the system properties that support SRM.

To access system properties, in the navigation filter, enter `sys_properties.list`, and then press Enter. The System Properties `[sys_properties]` table appears. Ensure that you have the admin role to access and modify the system properties.
### Properties for SRM

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>sn_srm.actions.log</strong></td>
<td>Controls the logging level for error budget policies action processing. Default value: <strong>notice</strong></td>
</tr>
<tr>
<td><strong>sn_srm.alert_processing.log</strong></td>
<td>Controls the logging level for error budget policies action processing. Default value: <strong>notice</strong></td>
</tr>
<tr>
<td><strong>sn_srm.error_budget_policies.log</strong></td>
<td>Controls the logging level for error budget policies processing. Default value: <strong>notice</strong></td>
</tr>
<tr>
<td><strong>sn_srm.sli_slo.log</strong></td>
<td>Controls the logging level for Service Level Indicators (SLI) and Service Level Objectives (SLO) processing. Default value: <strong>notice</strong></td>
</tr>
</tbody>
</table>

- List of communication channels (comma separated) used to send notifications to users in the group if no contact preferences are set. You can use the following values:
  - email for E-mail
  - sms for SMS
  - voice for Voice calls

<table>
<thead>
<tr>
<th><strong>sn_srm.notification_communication_channels</strong></th>
<th>Comma-separated list of notification channels to use for team members where no contact preferences are set. You can use the following values:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>email</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>sms</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>voice</strong></td>
</tr>
<tr>
<td></td>
<td>• Type: <strong>CSV</strong></td>
</tr>
<tr>
<td></td>
<td>• Default value: <strong>email, sms, voice</strong></td>
</tr>
<tr>
<td></td>
<td>• Other possible values: Any other combination</td>
</tr>
</tbody>
</table>

- Time, in minutes, that the SRM On-call workflows wait to receive user acknowledgement

| **sn_srm.acknowledgement.workflow.wait_time** | Time, in minutes, that SR Ops On-Call workflows wait to receive user acknowledgement. |
Properties for SRM (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Type: integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 1440</td>
<td></td>
</tr>
<tr>
<td>• Other possible values: As needed</td>
<td></td>
</tr>
</tbody>
</table>

Working with Site Reliability Metrics

Use the Site Reliability Metrics (SRM) features to define Service Level Indicators (SLIs), Service Level Objectives (SLOs), and error budget policies for your service. These metrics help you and your team track your services and take necessary actions when required.

You can view the error budget and a graphical representation of the cumulative breach and remaining error budget. You can also create an error budget policy and associate it with the following actions to trigger when the threshold of a service level objective is crossed:

• Send an email.
• Create an incident.
• Send messages using the Microsoft Teams messaging service.
• Send messages using the Slack messaging service.
• Create an incident and notify on-call.

The Site Reliability Metrics (SRM) view in the Site Reliability Operations (SRO) workspace contains the following sections:

Reliability Indicators

Reliability indicators show the following details:

• SLI and SLO details
• Application Performance Monitoring (APM) properties
• Measured reliability
• Error budget
• Remaining error budget
• Graphical representation of the cumulative breach
• Graphical representation of the remaining error budget

ℹ️ **Note:** You can also view graphical representations of the cumulative breach and remaining error budgets for previous periods. This field is available only if the data for previous periods is available.

The latest information about the cumulative breach is shown with the value as Current in the graphical representation. If you want to find out the exact time when the data was captured, point your cursor to the last data point for the value Current.
Error Budget Policy
The Error Budget Policy shows the following details:

- Threshold details, such as burn rate and error budget remaining
- Actions corresponding to the thresholds

You can also define SLO, SLI, and error budget policies for query-based or technical services.

If you want to know more about query-based or technical services, see Manage Technical Services domain.
**Source alerts from an APM tool**

Source service alerts from an Application Performance Management (APM) tool to evaluate key Service Level Indicators (SLI)s.

**Before you begin**

Role required: sn_srm_manager or sn_srm_admin or sn_srm_user

**Procedure**

1. Navigate to **Site Reliability Metrics > Data processor > Data processor**.
2. Click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the data processor.</td>
</tr>
<tr>
<td>Data processor definition</td>
<td>Rules to understand and map alerts coming from APM tools.</td>
</tr>
<tr>
<td><strong>Note:</strong> You can receive Site Reliability Operations (SRO) Azure and Site Reliability Operations (SRO) Dynatrace alerts by installing SRO and then creating a data processor using this procedure.</td>
<td></td>
</tr>
<tr>
<td>Service</td>
<td>Service for which the data processor is defined.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the data processor that is automatically retrieved from the data processor definition.</td>
</tr>
<tr>
<td><strong>Note:</strong> If SRO is not installed, you can create data processor for all alerts, which can be filtered down further inside of the SLI.</td>
<td></td>
</tr>
</tbody>
</table>

4. Click **Submit**.

An attribute for the integration defined by the data processor is created and the **Service level indicators** related list is created.
5. On the Service level indicator related list, click **New**.
The Service level indicator form opens.

6. On the form, fill in the fields.

**Service level indicator form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the service level indicator.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The value in this field must be same as the name of the SLI in your APM tool.</td>
</tr>
<tr>
<td>SLI type</td>
<td>Type of the SLI based on which the Service Level Metrics (SLM) is calculated. The available types of SLI are as follows:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Latency</strong>: Time taken to service a request. The actual amount of time that elapsed.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Availability</strong>: Percentage of time your service is available.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Errors</strong>: Measurement of how frequently service error occurs.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Saturation</strong>: Measurement of your system fraction, emphasizing the resources that are most constrained.</td>
</tr>
<tr>
<td>Service</td>
<td>Service for which you are creating the service level indicator.</td>
</tr>
<tr>
<td>Data processor</td>
<td>Name of the data processor for which you are creating the service level indicator.</td>
</tr>
<tr>
<td>Description</td>
<td>Summary of the indicator.</td>
</tr>
<tr>
<td>Operator</td>
<td>Condition to perform specific logical function.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Upper limit after which the metrics are triggered.</td>
</tr>
</tbody>
</table>
Create a reliability indicator

Create a reliability indicator to get a quantitative characterization of the reliability of your services.

Before you begin
Role required: sn_srm_manager or sn_srm_admin or sn_srm_user

About this task
The Site Reliability Ops Workspace view will only be available if you install the Site Reliability Operations application. You can create Service Level Indicators (SLI)s and Service Level Objectives (SLO)s using the classic UI as well. To create an SLI or SLO from the classic UI, navigate to Site Reliability Metrics > Service Level Indicators or Site Reliability Metrics > Service Level Objectives.

Note: You can set up only one SLO for an SLI.

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. Click the Services page icon.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>Unit of measurement for the metrics.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to enable the service level indicator. If not enabled, metrics will not be generated for the service.</td>
</tr>
<tr>
<td>Alert filtering</td>
<td>Ability to further filter qualifying alerts.</td>
</tr>
</tbody>
</table>
3. On the Services Overview page, click the service for which you want to create reliability indicators.

4. Click the **Reliability indicators** tab.

5. Click **New**.
6. On the form, fill in the fields.

### Service Level Objective form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Indicator (SLI)</td>
<td>Name of the indicator.</td>
</tr>
</tbody>
</table>
| Service Level Indicator (SLI) | Type of the SLI based on which the Service Level Metrics (SLM) is calculated. The available types of SLI are as follows:  
  - **Latency**: Time taken to service a request. The actual amount of time that elapsed.  
  - **Availability**: Percentage of time your service is available.  
  - **Errors**: Measurement of how frequently service error occurs.  
  - **Saturation**: Measurement of your system fraction, emphasizing the resources that are most constrained. |
<p>| SLI type | |
| Objective type | Objective measured | Objective (percentage) |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td>Service for which you are creating the reliability indicator.</td>
</tr>
<tr>
<td>Application Performance Monitoring (APM) properties</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Name of the property on which the metric is based.</td>
</tr>
<tr>
<td><strong>Note:</strong> The value in this field must be same as the name of the SLI in your APM tool.</td>
<td></td>
</tr>
<tr>
<td>Source</td>
<td>Data source for which the SLI must be defined.</td>
</tr>
<tr>
<td>Operator</td>
<td>Condition to perform specific logical function.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Upper limit after which the metrics are triggered.</td>
</tr>
<tr>
<td>Units</td>
<td>Unit of measurement for the metrics.</td>
</tr>
<tr>
<td>Service Level Objective (SLO)</td>
<td></td>
</tr>
<tr>
<td>Objective type</td>
<td>The available types of objectives are as follows:</td>
</tr>
<tr>
<td><strong>Duration:</strong> Desired amount of time the service spends without breaching.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> If you select <strong>Objective type</strong> as <strong>Duration</strong>, the next two fields will be <strong>Objective period</strong> and <strong>Objective (percentage)</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Count:</strong> Number of times an SLI is allowed to breach during a specific period.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> If you select <strong>Objective type</strong> as <strong>Count</strong>, the next two fields will be <strong>Limit period</strong> and <strong>Limit (occurrences)</strong>.</td>
<td></td>
</tr>
<tr>
<td>Objective period or Limit period</td>
<td>Period for which the metrics is calculated.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>For <strong>Count</strong> as <strong>Objective type</strong>, the <strong>Limit period</strong> field appears. The available options are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Month</strong>: The duration is considered to be the current month. For example, if the current date is 26th January, the duration will be considered from 1st January till 31st January.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Rolling 30 days</strong>: The duration is considered to be 30 days from the current date. For example, if the current date is 26th January, the duration will be considered from 25th December.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Rolling 7 days</strong>: The duration is considered to be 7 days from the current date.</td>
</tr>
<tr>
<td>Objective (percentage) or Limit (occurrences)</td>
<td>Percentage or count of the desired SLI performance.</td>
</tr>
</tbody>
</table>

7. Click **Save**.
You can see the graphical representation of the cumulative breach and the remaining error budget.

**Edit a reliability indicator**

Update the details of a reliability indicator when required.

**Before you begin**

Role required: sn_srm_manager or sn_srm_admin or sn_srm_user

If you update the Service Level Objective (SLO) during an active measurement period, it might result in inconsistency in the graphs.

**Procedure**

1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.
2. Click the Services page icon.
3. On the Services Overview page, click the service for which you want to edit reliability indicators.
4. Click the Reliability indicators tab.
5. Click to open the reliability indicator that you want to modify.
6. Edit the details as required.
7. Click **Save**.

**Delete reliability indicator**

Delete a reliability indicator when you no longer require it.

**Before you begin**

Role required: sn_srm_manager or sn_srm_admin or sn_srm_user

**Procedure**

1. Navigate to **Site Reliability Operations > Site Reliability Ops Workspace**.
2. Click the Services page icon.
3. On the Services Overview page, click the service for which you want to delete reliability indicators.
4. Click the **Reliability indicators** tab.
5. Click to open the reliability indicator that you want to delete.
6. On the reliability indicators page, click ![Edit](edit.png) and click **Delete**.

**Create action definitions**

You can create action definitions in SRM classic UI. Create action definitions to create an incident or send an email. Also, you can create action definitions to send messages on Microsoft Teams and Slack messaging services.

**Before you begin**

Role required: sn_srm_admin, sn_srm_manager, or sn_srm_user

**Procedure**

1. Navigate to **Site Reliability Metrics > Error budget policy > Action definitions**.
2. On the Error budget policy action definitions page, click **New**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the action.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Icon</td>
<td>Icon for the communication.</td>
</tr>
</tbody>
</table>
| Type                         | Type of action to perform.  
Select **Integration Hub - SubFlow** to use action definitions for actions provided by default.                                                                                                                                                                                                                                                                                                                                                                                               |
| Single use per threshold     | Option to determine the number of times an action can be created per threshold. If you select the check box, the action is created only once per threshold.  
Select the **Single use per threshold** check box.                                                                                                                                                                                                                                                                                                                                                                                   |
| Description                  | Description for the use of the action.                                                                                                                                                                                                                                                                                                                                                                                                                                                                |
| Integration Hub - SubFlow    | Subflow that is executed to resolve an alert. For example, you can search for and select **SRM - Create Incident**, **SRM - Slack - Post Message**, **SRM - MS Teams - Post Message**, and so on.  
This field appears only when **Integration Hub - SubFlow** is selected from the **Type** list.                                                                                                                                                                                                                                                                                          |

**Webhook**  
The webhook for sending a notification.  
Enter a value in this field only if you are creating an action definition to send messages on Slack and Microsoft Teams messaging services.  

**Note:** Create the webhook URL for Microsoft Teams and Slack messaging services before configuring this action definition.

For more information about creating a webhook URL, see [Create a Webhook URL for a channel in Microsoft Teams](#) or [Create a Webhook URL for a channel in Slack](#).

4. Click **Submit**.

Create an error budget policy

Create an error budget policy to trigger actions, such as sending a notification or creating an incident when the threshold of a service level objective is crossed.

**Before you begin**  
**Role required:** sn_srm_manager, sn_srm_admin, or sn_srm_user
About this task
The SR Ops Workspace view is available only if you install the Site Reliability Operations application. You can create an error budget policy using the classic UI as well. To create an error budget policy threshold from the classic UI, navigate to Site Reliability Metrics > Error budget policy > Thresholds. You can also create thresholds from the Error budget policy thresholds Error budget policy thresholds related list on the Service level objective form.

You can create an action definition to invoke a workflow, flow, or script. To create an action definition, navigate to Site Reliability Metrics > Error budget policy > Action definitions. You can create actions from the Error budget policy actions related list in the Error budget policy threshold form.

Procedure
1. Navigate to Site Reliability Operations > Site Reliability Ops Workspace.

2. Click the services page icon ( ).

3. On the Services Overview page, click the service that you want to create an error budget policy for.

4. Click the Error Budget Policy tab.
5. Click the **Create error budget policy** link to set a threshold which determines when to take an action for your Service Level Objective.

6. In the Add Thresholds dialog box, select one of the following values from the Threshold Type list:
• **Burn Rate**: Rate at which an error budget is consumed. The Ideal burn rate is 1 or below because it indicates that the error budget is being consumed at an expected pace. The threshold is breached when the burn rate is equal to or greater than the specified value.

• **Error Budget Remaining**: Percentage of error budget left to spend for the specified period. The threshold is breached if the percentage remaining is equal to or less than of what is specified.

7. In the **Threshold** field, enter a value.

8. Click **Add**.

   ✉ **Note**: You can add multiple thresholds for a policy. But you can't add duplicate thresholds. If you try adding duplicate thresholds, you see an error message.

After a threshold is added, you can add an action for that threshold.

9. Select the threshold that you want to add an action for, and click any of the following actions:

   • **Create an Incident**
   • **Send an Email**
   • **Send Slack message**

   Install the Slack Spoke for ServiceNow IntegrationHub plugin to automate sending messages about alerts to a Slack channel. Also, create a Webhook URL for a channel in Slack. For more information about installing the plugin and creating a Webhook URL in Slack, see Install Slack Spoke for ServiceNow Integration Hub and Create a Webhook URL for a channel in Slack.

   • **Send MS Teams message**

   Install the Microsoft Teams Spoke for ServiceNow IntegrationHub plugin to automate sending messages about alerts to a Microsoft Teams channel. Also, create a Webhook URL for a channel in Microsoft Teams. For more information about installing the plugin and creating a Webhook URL in Microsoft Teams, see Install Microsoft Teams Spoke for ServiceNow Integration Hub and Create a Webhook URL for a channel in Microsoft Teams.
Note: The messages in the Microsoft Teams and Slack messaging services show the links to the reliability indicator. If the SR Ops Workspace is not installed, the link opens a classic UI. If you want to view the reliability indicator in your available workspace, navigate to **System Definition > Script Includes**, and override the _genReliabilityIndicatorURL function in the ErrorBudgetPolicyActionUtils script include.

- **Create an Incident and notify on-call**

Note: If you add all the actions, they occur at the same time when the threshold is crossed.

10. Click **Save**.

Any changes to the thresholds or actions are saved only after you click **Save** at the top of the form.

If you want to edit any threshold, click the policy actions icon ( ), for the threshold, and then click **Edit threshold**.

The required action is triggered when the threshold is crossed.

---

**SRM notifications**

Notifications are sent to users based on various factors, such as the on-call schedule of the team, team shift, user preferences, and the Notify settings.
### SRM notifications

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>On-call schedule is installed,</td>
<td>Notification is sent to the users in the on-call shift as per the user preferences.</td>
</tr>
<tr>
<td>shifts and user preferences are defined</td>
<td></td>
</tr>
<tr>
<td>On-call schedule is installed,</td>
<td>• If Notify is installed and the Twilio communication service is configured, notifications are sent as voice calls.</td>
</tr>
<tr>
<td>shifts are defined but user preferences are not defined</td>
<td>• If Notify is not installed, notifications are sent using emails.</td>
</tr>
<tr>
<td>On-call schedule is installed but</td>
<td>Notification is sent to all channels that are defined in the property <code>sn_srm.notification.communication.channels</code>.</td>
</tr>
<tr>
<td>shifts and user preferences are not defined</td>
<td></td>
</tr>
<tr>
<td>On-call schedule is installed,</td>
<td>Notification is sent as per the channels mentioned in the user preferences.</td>
</tr>
<tr>
<td>user preference is defined but shifts are not defined</td>
<td></td>
</tr>
<tr>
<td>If the on-call schedule is not</td>
<td>Notification is sent to all users in the team associated with a service.</td>
</tr>
<tr>
<td>installed</td>
<td>• If Notify is installed, notification is sent using all the channels, such as email, SMS message, and voice.</td>
</tr>
<tr>
<td></td>
<td>• If Notify is not installed, notification is sent using email.</td>
</tr>
</tbody>
</table>

### Site Reliability Metrics change approval policies

Change approval policies use approval definitions to generate approvals based on your business requirements. A change approval policy is a course of action that can be applied to a change request. A change approval policy uses a set of variable inputs to evaluate the decisions that are associated with it. For each matching decision, the associated approval definition is applied.

An approval policy can contain multiple decisions, such that a single policy can handle every approval required for a change type. When a decision condition matches, the related approval definition is evaluated. If one or more decisions match, all the related approval definitions are evaluated.

To view the approval policies for SRM, navigate to **Change > Change Policy > Change Approval Policies**. Then, on the Change Approval Policies page, select **Site Reliability Ops Change Policy**.
The Change Approval Policy page shows a list of policy inputs. You can view the following policy inputs for SRM:

- Service Level Objective (SLO) with lowest error budget remaining percent (slo_with_lowest_error_budget_remaining_percent)
- SLO with highest burn rate (slo_with_highest_burn_rate)

These policy inputs should be populated with the following appropriate Service Level Objective (SLO) records:

- The SLO with lowest error budget remaining that is relevant to the change request
- The SLO record with the highest burn rate

Policy inputs for SRM

This approval policy contains the following two decisions for SRM:

- Budget < 25% and Burn Rate > 1
- Budget > 25% and Burn rate < 1

These decisions are marked as inactive to prevent any changes in the behavior of this existing approval policy.

You can review and use these decisions in this and other approval policies as examples of how you can base decisions on the SLO inputs.
SRM input decisions

To provide the policy inputs related to SLO to your change approval policies, actions are created in Flow Designer.

An input of a comma-separated list of the sys_ids of a service is specified, but typically, an input of a single sys_id is passed. The action uses this sys_id to find all the active SLOs that are related to this service. From the SLOs that are found, the action sets:

- The output **SLO with highest burn rate** to the SLO with highest burn rate value.
- The output **SLO with lowest error budget remaining percent** to the SLO with the lowest value for error budget remaining percent.

This image shows an input for the **SRM – Get worst performing SLOs** action.

This image shows the output for the **SRM – Get worst performing SLOs** action.
An example of this action being used to provide the inputs into the Change Approval Policy can be found in the Change - SRO - Authorize flow in Flow Designer. The Restrict query to SLOs linked to these Service Ids field shows the action that is called with the configuration item (CI) of the change request that is authorized. The flow also shows the output from the action.

The following outputs from the Get worst performing SLOs action can be used as inputs to the Apply Change Approval Policy action:

- SLO with lowest error budget remaining percent
- SLO with highest burn rate
Inputs for the Apply Change Approval Policy action

Task Outage

CI unavailability, or outage, is the actual down time of a CI. Whenever there is an outage for any of the CI items, the outage information is stored in the Outage [cmdb_ci_outage] table. The Task-Outage table [task_outage] maintains the mapping between the Task [task] table and the Outage [cmdb_ci_outage] table.

Activate Task-Outage Relationship

Activate the Task-Outage Relationship plugin (com.snc.task_outage) to track outage duration.

Before you begin

Role required: admin

About this task


Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   Tip: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*

Related information

List of plugins (Rome)

Components installed with Task-Outage Relationship

The Task Outage table is installed with activation of the Task-Outage Relationship plugin (com.snc.task_outage).

   Tip: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see **Find components installed with an application**.

Table installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>

Add the Outage UI action to another task form

By default, the **Create Outage** UI action is available on the incident and problem forms, and can be added to other task forms. For new instances from Jakarta only, this feature is also available on the change request form.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Definition > UI Actions**.
2. Select the UI Action **Create Outage** on the Task [task] table.
   
   By default, the condition is:
current.getRecordClassName() == 'incident' || current.getRecordClassName() == 'problem'

3. Modify the **Conditions** field as described in the following examples.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add this UI action to the Ticket [ticket] table</td>
<td>current.getRecordClassName() == 'incident'</td>
</tr>
<tr>
<td>To use the UI action on only the Problem [problem] table</td>
<td>current.getRecordClassName() == 'problem'</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Associate a task with an outage**

You can associate multiple tasks with a defined outage.

**Before you begin**

Role required: itil

**About this task**

The administrator must configure the Outage form to include the Tasks related list.

**Procedure**

1. Navigate to the outage record.

2. Click **Edit** in the Tasks related list.

   All incident and problem tasks are listed. For new instances in Jakarta, change requests are also listed.

3. Use the filter or the search field above the **Collection** box to locate the task to associate to the outage.

   **Example**

   For example, filter for the same configuration item or business service, or look for tasks created on the same day as the outage.

4. Move the associated tasks to the **Task List** box on the right.

5. Click **Save**.
Create an outage from a task

Create an outage from a task record to understand the down time of a configuration item.

Before you begin
Role required: itil or admin

About this task
The **Create Outage** UI action is added for the Task [task] table. When the Task-Outage Relationship plugin (com.snc.task_outage) is activated, the Outages related list is added to the related list of the task forms such as Incident, Problem, or Change. If you have the admin role, you can assign multiple tasks to an outage by configuring the Tasks related list to appear on the Outages form.

Procedure
1. Open the task record.
2. Right-click the header form and select **Create Outage**.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique number that identifies the outage.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>Look up icon [ ] to select configuration item from the list.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of the outage.</td>
</tr>
<tr>
<td>Begin</td>
<td>The date and time when the outage starts. You can click the <strong>Begin Outage Now</strong> related link to populate the field with the current date and time.</td>
</tr>
<tr>
<td>End</td>
<td>The date and time when the outage ends. When the outage ends, open the record and enter the date and time manually. You can also click the <strong>End Outage Now</strong> related link to populate the field with the current date and time.</td>
</tr>
<tr>
<td>Duration</td>
<td>Duration of the outage in days and hours.</td>
</tr>
<tr>
<td>Task number</td>
<td>The parent task record number from which you have created the outage.</td>
</tr>
<tr>
<td>Field</td>
<td>Entry</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the outage.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Domain separation and task outage**

Domain separation is supported in task outage. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

**Support level: Basic**

- **Business logic:** Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

**Overview**

Task-Outage Relationship [cmdb_ci_outage] is domain separated. Outages are now data separated, meaning they can be exposed to the appropriate personas without risk of data exposure. Fulfillers can view any Task-Outage Relationship records regardless of the domain that the records belong to. The Task-Outage Relationship table is installed when administrator activates the optional Task-Outage Relationship plugin.

**Related information**

Domain separation for service providers
Collaboration services

Collaboration services provides a way to communicate and collaborate in real-time. You can directly use a collaboration tool from task records and as a channel within communication plans.

Compatibility

Compatible with all the releases starting with the Madrid release.

Key features

• Add Slack as a collaboration channel when creating communication plans for tasks.
• Create a dynamic slack channel for a task based on pre-defined communication plans.
• Add or remove users from the slack channel by managing recipients on the task record.
• Post a message to the channel to collaborate with support teams or send a communication to keep stakeholders informed.
• Archive the channel when the task is closed.

Install Collaboration services

You can install the Collaboration services application (sn_tcm_collab_hook) if you have the admin role.

Before you begin

• Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.
• Collaboration services requires the following ServiceNow Store applications. Ensure that these applications are installed before you install Collaboration services.

  Required ServiceNow Store applications

  Slack Spoke for ServiceNow IntegrationHub
  [com.sn.slack.ahv2]

  If you want Slack integration for tasks or task communication management, install the Slack Spoke for ServiceNow IntegrationHub application. The application provides actions that you can use
when designing flows. These actions allow you to communicate with Slack APIs.

**ServiceNow for Microsoft Teams**

If you want to integrate ServiceNow for Microsoft Teams, install the IT Service Management integration with Microsoft Teams or HR Service Delivery integration with Microsoft Teams applications as required. For more information on the integration, see ServiceNow for Microsoft Teams.

Role required: admin

**About this task**

For the tables that are installed with Collaboration services, refer Components installed with Collaboration services.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the application () using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.

   Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install.

4. **Optional:** If demo data is available and you want to install it, click **Load demo data**.

   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click **Install**.
Components installed with Collaboration services

Several types of components are installed with activation of the Collaboration services application.

⚠️ Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Tables installed

⚠️ Note: The tables are installed when you activate the Task Communications Management plugin (com.snc.task_communication_management).

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Channel Definition — Slack</td>
<td>Extends the Communication Channel Definition [comm_channel_def_slack] table.</td>
</tr>
<tr>
<td>Communication Channel — Slack</td>
<td>Extends the Communication Channel Definition [comm_channel_slack] table.</td>
</tr>
<tr>
<td>Communication Plan — Collaboration Service Data</td>
<td>Stores Collaboration Service related data.</td>
</tr>
<tr>
<td>[comm_plan_collab_data]</td>
<td></td>
</tr>
</tbody>
</table>

Setting up Slack for communication

The Slack spoke requires creating a custom app on your Slack account to generate OAuth 2.0 tokens for the Slack spoke.

For more information, refer to Set up Slack spoke.

Configure Slack as a communication channel for a communication task

Configure Slack as a mode of communication for a communication task to send direct message to the users.

Before you begin
Role required: admin
Procedure

1. Navigate to **Incident > Communication Plan Definitions**.

2. Open the communication plan where you want to add Slack as a communication channel for a communication task.

3. Open the communication task definition for which you want to add Slack as the mode of communication.

4. Click the **Add Channel – Slack** related links.

5. Click **Submit**.

   Slack gets added as a communication channel for the communication task.

---

**Import messages from an incident**

You can import messages from a slack channel for an incident and append them in the **Comments** to store all important messages in the ServiceNow® instance.

**Before you begin**

- Role required: sn_incident_write, itil, or admin
- You must be a member of the private slack channel to import messages from the private channel.
- Your ServiceNow® email ID must be associated with your slack account.
- This feature is compatible with:
  - Collaboration Services store app - minimum version 3.04
  - Slack store app - minimum version 1.4.x

**About this task**

Importing messages helps agents to view the history of the incident, allow the requester to see all discussions about their incident in one place. This helps to capture the information required for post-ticket review and continuous improvement processes.

Procedure

1. Navigate to **Incident > Open**.

2. Select the incident for which you want to import messages.

3. Click the **View Slack Channels** related link.

   The View Slack Channels form appears. The form shows all the available slack channel for that incident.
4. Click **Import messages** for the channel that you want to import the messages from.
   The Import messages from Slack form appears. The form shows all the messages on that channel sorted by date.

5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>Field to enter a keyword and search for a specific message.</td>
</tr>
<tr>
<td>Include reply threads in search</td>
<td>Option to include threads in search.</td>
</tr>
<tr>
<td>Filter by</td>
<td>• <strong>Shared by</strong>: The messages will be filtered based on the selected users.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Date</strong>: The messages will be filtered based on the <strong>Start</strong> and <strong>End</strong> dates that you select.</td>
</tr>
<tr>
<td>Import messages as</td>
<td>• <strong>Additional comments</strong>: The messages will be appended under Additional comments.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Work notes</strong>: The messages will be appended under Work notes.</td>
</tr>
<tr>
<td>Include attachments</td>
<td>Option to include attachments while importing messages.</td>
</tr>
</tbody>
</table>

6. Click **Import messages**.

**Process flow for Slack communication**

Collaborate with the stakeholders from major incident management workbench using slack for an open and transparent communication.

Define a communication plan to manage the communication process. The plan includes tasks to achieve the plan goal and the stakeholders whom you must contact in the process.

When you create communication tasks for a plan, select slack as a mode of communication. To know how to define a channel for any communication task, refer to Define a communication channel. Keeping in mind the fact that it not always possible to plan for a communication plan or task in advance, you have
the option to create adhoc communication plan and its tasks from an incident. When any task record meets the conditions in the communication plan, the plan gets attached with the task record. If for a major incident, a communication plan gets attached to the incident which has communication channel as slack for any of its tasks, you can send slack notifications from the major incident workbench.

**Note:** The slack communication is a one-way communication from ServiceNow application to slack. The contacts in the slack cannot reply to the person who initiated the slack communication. Also, the users in slack must be employees of the organization. For example, the email address that they share for participating in a slack collaboration must be their email address of that organization.

Slack communication uses the following subflows:

- TCM Slack – Add Users to Channel
- TCM Slack – Archive Channel
- TCM Slack – Create Channel
- TCM Slack – Send Message
- TCM Slack – Remove User From Channel

**Slack communication through workbench**

- In the major incident workbench, under the **Communicate** tab, you can find all the communication tasks for the plan.

- For the task where you have selected slack as a channel, you can click **Compose** to start a slack communication. For information on how to create a communication plan, refer to Add communication plan from the major incident workbench

- In the dialog box, the **To** field includes the contacts that you have added while creating the communication contact for the plan.

- The **Message** field includes the message you are intending to convey to the recipients.

**Add a collaborative communication task**

In major incident workbench, you can add a collaborative communication task to collaborate and understand the progress of communication plan and its related tasks.
Before you begin

- Role required: major_incident_manager
- This feature is compatible with:
  - Collaboration Services store app - minimum version 3.04
  - Slack store app - minimum version 1.4.x

Procedure

1. Navigate to Incident Major incident > Open.
2. Select the incident for which you want to add a collaborative communication task.
3. Click View Workbench.
4. Click the Collaborate tab, and then click Add that appears in the Collaborative Communication Tasks section. The Collaborative communication task plan form appears.
5. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Plan</td>
<td>List to select a new communication plan or to select an existing plan and add communication tasks to the plan</td>
</tr>
<tr>
<td>Plan Short description</td>
<td>Brief description of what the communication plan is all about.</td>
</tr>
<tr>
<td>Task Short description</td>
<td>Brief description of what the communication task is all about.</td>
</tr>
<tr>
<td>Channel</td>
<td>Option to select Slack chat as a channel for collaboration.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Frequency at which a specific task must be executed. A task can be executed only once or on specific durations</td>
</tr>
<tr>
<td>Due in (Minutes)</td>
<td>Time span when the task must be executed after the task initiates. For recurring tasks, it also indicates the</td>
</tr>
</tbody>
</table>
6. Click **Next**.

7. In the **Manage Recipients** tab, add the users required to be involved in the major incident collaborative communication task, and click **Add**.

**Create a Slack channel for collaborative communication task**

You can create a Slack channel for a collaborative communication task to collaborate and discuss the communication task details.

**Before you begin**
Role required: major_incident_manager

**Procedure**

1. Navigate to **Incident > Major Incident Open**.
2. Select the relevant major incident.
3. Click **View Workbench**.
4. Click the **Collaborate** tab.
   The Collaborative Communication Tasks section appears.
5. Click **Initiate** for the task that you want to create a Slack channel.
   The Initiate form appears.
6. On the form, fill in the fields.

**Initiate form**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add participants</td>
<td>Individual users or groups whom you want as participants to the channel.</td>
</tr>
<tr>
<td>Recommended and Selected</td>
<td>Columns to personalize your list. Select the items in the <strong>Recommended</strong> column and move them to the <strong>Selected</strong> column using the right-arrow icon (&gt;).</td>
</tr>
</tbody>
</table>
### Slack integration - Incident Management

With Slack integration, you can create a dedicated channel for incident responders to collaborate during an incident enabling bidirectional integration with slack. You can create and update an incident, view information such as who is on-call for a group or view the list of incidents assigned to you.

### Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

### Compatibility

The Collaboration Services store app version 2.0.x is compatible with all the releases starting with the Paris Patch 3 release.

### Key features

- Send a direct message to the caller
- Assign the incident to a user
- Create a collaboration channel for an incident

---

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• View and join a channel from an incident
• Create and update incident using a Slash Command
• View who is on-call for a group

System requirements
• Incident Management (com.snc.incident)
• Collaboration Services plugin (sn_tcm_collab_hook) version 2.0.x
• Slack Spoke for ServiceNow IntegrationHub plugin (com.sn.slack.ahv2) version 1.3.x and the necessary IntegrationHub license to use Slack as a collaboration channel.

ℹ️ Note: The Slack spoke requires creating a custom app on your Slack account to generate OAuth 2.0 tokens for the Slack spoke. For more information, refer Set up Slack spoke.

Create slack channel for an incident
Create a private or a public slack channel to collaborate with support teams or send a communication to keep stakeholders informed.

Before you begin
• Role required: sn_incident_write, itil, or admin
• Plugins required:
  ◦ Collaboration Services plugin (sn_tcm_collab_hook) version 2.0.x
  ◦ Slack Spoke for ServiceNow IntegrationHub plugin (com.sn.slack.ahv2) version 1.3.x
• Ensure you have set up interactivity and shortcuts for slack. For more information, refer configure slack app.

About this task
The system property sn_tcm_collab_hook.slack_on_task enables the slack feature on a task table. By default, the value is incident. If you want to enable the slack feature on other task tables such as problem or change_request, add the table names in the Value field.

Procedure
1. Navigate to Incident > Open.
2. Open an active incident record.
3. Click the Create Slack Channel related link.
4. On the form, fill in the fields.

Create slack channel form

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add participants</td>
<td>Individual users or groups whom you want as participants to the channel.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Recommended and Selected</td>
<td>Columns to personalize your list. Select the items in the <strong>Recommended</strong> column and move them to the <strong>Selected</strong> column using the right-arrow icon.</td>
</tr>
<tr>
<td>Channel name</td>
<td>Unique name of the channel that differentiates it from the rest of the channels in Slack.</td>
</tr>
<tr>
<td>Channel topic</td>
<td>Description about the purpose of the channel.</td>
</tr>
<tr>
<td>Include a brief message for</td>
<td>Brief message that you want to send to the participants.</td>
</tr>
<tr>
<td>participants</td>
<td></td>
</tr>
<tr>
<td>Private channel</td>
<td>Option to indicate whether the slack channel is private or public. If you select the check box, the channel is created as a private channel else it is created as a public channel.</td>
</tr>
</tbody>
</table>

5. Click **Create channel**.
A slack channel is created and an invitation is sent to the participants. Any duplicate user is removed from the selected participant list before the notification is sent. The participants can click **Skip** or **Join Channel** to ignore or join a slack channel.

**View or join slack channel from an incident**
View all slack channels associated with an incident to know if a required slack channel already exists before you create a new one. You can also import messages from a slack channel.

**Before you begin**
- Role required: sn_incident_write, itil, or admin
- Plugins required:
  - Collaboration Services plugin (sn_tcm_collab_hook) version 2.0.x
  - Slack Spoke for ServiceNow IntegrationHub plugin (com.sn.slack.ahv2) version 1.3.x
About this task
The system property `sn_tcm_collab_hook.slack_on_task` enables the slack feature on a task table. By default, the value is incident. If you want to enable the slack feature on other task tables, such as problem or change_request, add the table names in the Value field.

⚠️ Note: When an incident becomes inactive, the associated slack channels get archived.

Procedure
1. Navigate to Incident > Open.
2. Open an active incident record.
3. Click the View Slack Channels related link.

View slack channels
View Slack channels

<table>
<thead>
<tr>
<th>Channel name</th>
<th>Channel topic</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>inc0010112-device</td>
<td>Troubleshoot hardware issues</td>
<td>View channel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Import messages</td>
</tr>
<tr>
<td>inc0010112-network</td>
<td>Troubleshoot network issues</td>
<td>View channel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Import messages</td>
</tr>
<tr>
<td>inc0010112_review</td>
<td>Track the status</td>
<td>View channel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Join channel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Import messages</td>
</tr>
<tr>
<td>inc0010112_support</td>
<td>Internal support</td>
<td>View channel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Import messages</td>
</tr>
</tbody>
</table>

All the dedicated slack channels for the incident are displayed.

⚠️ Note: The Join channel option appears only for public channels.
4. Optional: Click View channel to open the slack channel.
5. Click Join channel to join any slack channel.
6. To import messages from any slack channel, click Import messages.
Add form section to view slack channels

View unarchived slack channels associated with an incident in the form section. The form section saves you the effort of opening the available channel list manually from the related list.

Before you begin
Role required: personalize_form or admin

Procedure
1. Navigate to Incident > Open.
2. Open an incident record.
3. Click the Additional actions icon and select Configure > Form Layout. For more information, refer Configuring form layouts.
4. Under Form view and section, in the Section field, click New.
5. In the Section caption field, enter a name for the section such as Slack Channels and click OK.
6. From the Available column, select View Slack Channels and move it to the Selected column using the right-arrow icon.
7. Click Save.
The new section displays all the active slack channels.

### Slack channels associated with the incident

<table>
<thead>
<tr>
<th>Channel name</th>
<th>Channel topic</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>@inc010111-network</td>
<td>Troubleshoot network issues</td>
<td>View channel</td>
</tr>
<tr>
<td>@inc010112-device</td>
<td>Track the status</td>
<td>View channel</td>
</tr>
<tr>
<td>@inc010112_support</td>
<td>Internal support</td>
<td>View channel</td>
</tr>
<tr>
<td>@inc010112_review</td>
<td>Troubleshoot hardware issues</td>
<td>View channel, Join channel</td>
</tr>
</tbody>
</table>

Set up slack for a user or group

Set up slack from an incident to communicate and work together in channels with a user or a group.

**Before you begin**

Role required: admin

**About this task**

To enable slack for the **Assignment group** field, ensure you have set up a slack channel for that group. For more information, refer [Associate existing slack channel with a group](#).

**Procedure**

1. Download the **Fix script to add Slack field decorators** update set to get the fix scripts from ServiceNow Store app.
2. Import the update set file.
   For more information, refer [Import an update set](#).
3. Navigate to **System Definition > Fix Scripts**.
4. Open the **Add Slack Field Decorator** fix script.
5. **Optional:** In the **Scripts** field, edit the script to indicate the table and the field for which you want to enable the slack communication.

6. Click **Run Fix Script**.

   The slack icon ( ) appears next to the following fields mentioned in the script.
   - **Caller**
   - **Assignment group**
   - **Assigned to**

   Clicking the icon takes you to the direct message with the user on slack or slack channel for an assignment group.

**Related information**

- **Open slack from an incident**
- **Associate existing slack channel with a group**

Associate an existing slack channel to reach out to an assignment group from an incident. Assignment groups are a great way to contact all your stakeholders at once.

**Before you begin**

Role required: sn_slack_ah_v2.slack_admin or admin

**Procedure**

1. Navigate to **Slack > Slack Channel Cache** and click **New**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Name</td>
<td>Name of the existing slack channel.</td>
</tr>
<tr>
<td>Channel ID</td>
<td>Unique ID given by slack for a channel.</td>
</tr>
<tr>
<td>Channel Topic</td>
<td>Description about the purpose of the channel.</td>
</tr>
<tr>
<td>Channel Link</td>
<td>URI scheme to deep link into native Slack client of user.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Example: slack://channel?team={TEAM_ID}&amp;id={CHANNEL_ID}, where &lt;TEAM_ID&gt; is slack workspace id and &lt;CHANNEL_ID&gt; is the unique Id for the slack channel.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>For more information, refer Deep linking into Slack.</td>
</tr>
<tr>
<td>Document ID</td>
<td>Group record for which channel is intended to be used.</td>
</tr>
<tr>
<td></td>
<td>• Table: Group [sys_user_group]</td>
</tr>
<tr>
<td></td>
<td>• Document: &lt;Reference to a group&gt;</td>
</tr>
<tr>
<td>Is Archived</td>
<td>Option to indicate whether the slack channel is active or inactive.</td>
</tr>
<tr>
<td>Is Private</td>
<td>Option to indicate whether the slack channel is private or public.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>It is strongly recommended to associate a public slack channel. In case of private channel, and you are not a member of it, the navigation link may break.</td>
</tr>
<tr>
<td>Creator</td>
<td>User who creates the slack channel cache record.</td>
</tr>
</tbody>
</table>

3. **Click Submit.**

**Open slack from an incident**

Open slack from an incident and send message to a user or an assignment group to exchange incident information. You do not need to manually search for a user in slack to send a message.

**Before you begin**

Role required: sn.incident_read, sn.incident_write, itil, or admin
About this task

The slack icon ( ) appears for the fields that you include in the fix script. For example, if you have the **Caller**, **Assigned to**, and the **Assignment group** fields for incident in the fix script, then the icon appears for these fields.

Procedure

1. Navigate to **Incident > Open**.
2. Open an active incident record.
3. Click the slack icon ( ) that appears next to the **Caller**, **Assigned to**, or the **Assignment group** fields.
4. In the Open Slack dialog window, click **Open Slack**. A direct message with the user on slack or a slack channel opens for the group.

Slack slash commands

Slash commands provides a quick way to invoke your app to perform specific actions from Slack.

You need to [configure slash commands](#) to execute the commands. Only a user with the `sn_incident_write`, `itil` or `admin` role can execute the commands.

<table>
<thead>
<tr>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/now help</td>
<td>Provides list of available ServiceNow commands with description.</td>
</tr>
<tr>
<td>/now create incident</td>
<td>Creates an incident with the inputs provided by the user.</td>
</tr>
<tr>
<td>/now list incidents</td>
<td>Lists all active incidents assigned to the user.</td>
</tr>
<tr>
<td>/now oncall [group name]</td>
<td>Displays shifts and members who are currently on-call for a group.</td>
</tr>
</tbody>
</table>
Slash commands (continued)

<table>
<thead>
<tr>
<th>Commands</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/now comment [comment]</td>
<td>Posts a comment in the Additional comments field of the associated incident.</td>
</tr>
<tr>
<td>/now note [note]</td>
<td>Posts a note in the Work notes field of the associated incident.</td>
</tr>
<tr>
<td>/now assigntome</td>
<td>Assigns associated incident to the slack user.</td>
</tr>
<tr>
<td>/now assign [@slack_user]</td>
<td>Assigns associated incident to a specific user.</td>
</tr>
</tbody>
</table>

Note: Only a user with the itil or the admin role can execute this command.

Slash commands that can be run only from channels associated with ServiceNow

Vendor Management Workspace

Monitor the performance of your company's vendors and manage all vendor-related information using the ServiceNow® Vendor Management Workspace. Assess the performance of your vendors using key performance indicators (KPIs) that you can configure to create vendor metrics.

Track and analyze how your vendors are executing on their goals and which areas need attention from a unified, central location. Integrate data from Service Portfolio Management (SPM), Contract Management, Assets, SLA Contracts, Vendor Risk Management, and Continual Improvement Management (CIM) applications.

Key features

- **Data in a unified location**
  
  View vendor profile and manage the performance of your company's vendors in a unified location.
Comprehensive vendor information layout

Analyze historical vendor health using a comprehensive layout of all information related to a vendor and its services.

Integrated with Vendor Risk Management

Use aggregated data from the vendor risk application and analyze that in a central location.
Explore configurable Vendor Management Workspace

Learn how vendor managers analyze vendor health using Vendor Management Workspace.

Set up configurable Vendor Management Workspace

Plan and configure your implementation.

Use configurable Vendor Management Workspace

Analyze vendor health using the configurable Vendor Management Workspace.

Explore Vendor Management Workspace

Use Vendor Management Workspace to monitor metrics and analyze your vendor's health from a single user interface. Gain insights when you compare top-performing vendors and track compensation your vendors owe you when they breach the service agreement.

Vendor KPI Groups in Vendor Management Workspace

Learn how you can organize your vendors into vendor KPI groups. You can then define Key Performance Indicators (KPI) to analyze the performance of all...
vendors within that vendor KPI group. Drill down into the metrics for a vendor, KPI or the KPI group—all from a central location.

As a vendor administrator, you can:

• Create a vendor KPI group for a common set of indicators (KPIs) you use to measure the performance of all vendors in that group.
• Add KPIs to the vendor KPI group.
• Add vendors that you want to measure using the KPIs.
• Define upper and lower thresholds to monitor the indicator status.

As a vendor manager, you can:

• Analyze the performance trends for your vendors as well as the performance for associated service offerings, contracts, improvement initiatives, and SLA definitions.
• Drill down into vendors, a KPI group, or a KPI to view trends and historical performance.

Understanding Vendor KPI Groups setup and use in Vendor Management Workspace

Learn how you can organize your vendors into Vendor KPI Groups. Understand how you can set up Vendor KPI Groups and how vendor scores get calculated and displayed in the Vendor Management Workspace.

Set up and use the Vendor Management Workspace configurable using User Interface Builder (UIB) with five simple steps:

1. Organize similar types of vendors into vendor KPI group categories.
2. Add a common set of KPIs that matter most to this type of vendors.
3. Set upper and lower thresholds for each vendor KPI group to monitor the status of the KPIs.
4. Add vendors to the KPI groups.
   
   For information on setting up KPI groups, see Create KPI groups to track metrics for your vendors.
5. Analyze vendor health using Vendor Management Workspace. For information on using Vendor Management Workspace, see Use Vendor Management Workspace in the UIB workspace.

Related information

Example: Vendor Management Workspace setup
Example: Vendor Management Workspace setup

Learn how you can create KPI groups using Vendor Management Workspace with an example.

Before you begin
Role required: sn_vlm.vendor_admin

About this task
Let's assume that a vendor manager wants to create a vendor KPI group for all of their software vendors. They want to associate KPIs with the vendor KPI group to measure the performance of all vendors in the vendor KPI group.

Procedure
1. Create a KPI group.
   a. Navigate to Vendor Management > Configuration > KPI Groups
   b. Click New
   c. Create a vendor KPI group for software vendors.
      i. In the Name field, enter Software.
      ii. In the Description field, enter a description such as, "This KPI Group is for software vendors."
      iii. In the Type menu, select Vendors.
      iv. Right-click the form header and click Save.

2. Associate three KPIs with the vendor KPI group to evaluate the software vendors in that group.
   a. In the KPIs related list, click New.
   b. In the KPI field, click the search icon, select each of the indicators listed below and click Submit to add the KPIs to the group.
      • Vendor Satisfaction with the Display Aggregate set to Average.
      • Average Stability - Critical Incidents with the Display Aggregate set to Average.
      • Total Incidents Created with the Display Aggregate set to Sum.

3. Add a weight value, which represents the relative order of importance, for each KPI that contributes towards the vendor score.
• For Vendor Satisfaction, set the weight value to 60.
• For Average Stability - Critical Incidents, set the weight value to 40.
• For Total Incidents Created, set the weight value to 0, which indicates that it does not contribute to the vendor score calculation.

The combined weight of all indicators added to the KPI group must be equal to 100. If the combined weight is above or below 100, then they are proportionately readjusted to 100.

4. Associate thresholds to the KPI group.
Define a range for the threshold values and assign a state for each range. For example, you can assign the lower threshold as 0 and the upper threshold as 60 and define the status as critical.
Each range has a color associated with it by default. When the vendor score is calculated for the vendors in the vendor KPI group, the score displays the highlighted color associated with the threshold range in the Vendor Management Workspace.
For example:

a. In the KPI Group Thresholds related list, click New.
   • In the Lower Threshold field, enter 0.
   • In the Upper Threshold field, enter 60.
   • In the Status menu, select Critical.
   • In the Order field, enter 200.

b. Click Submit.
Here is another example which shows that if the threshold values overlap between two different ranges, the one with a lower order number will be given preference.

a. In the KPI Group Thresholds related list, click New.
   • In the Lower Threshold field, enter 50.
   • In the Upper Threshold field, enter 80.
   • In the Status menu, select Moderate.
   • In the Order field, enter 300.

b. Click Submit.
Because the KPI group threshold value of 60 overlaps between the two sets of thresholds set above, the preference is given to the KPI group threshold that has the Critical status because it has a lower order number. Therefore, if the KPI threshold has a value of 60, the highlighted color for that value in Vendor Management Workspace displays in the color set for the Critical status.

5. Add thresholds for the individual KPIs.
After you set the thresholds, you can view the KPI values in highlighted colors that correspond to each threshold range for the KPI in Vendor Management Workspace.

a. In the KPIs related list, click the preview icon next to the KPI for which you want to set the threshold and click **Open Record**.

b. In the KPI Thresholds related list, click **New**.
   - In the **Lower Threshold** field, enter **60**.
   - In the **Upper Threshold** field, enter **80**.
   - In the **Status** menu, select **Moderate**.
   - In the **Order** field, enter **300**.

c. Click **Submit**.

The threshold values for the KPI are highlighted with the color based on the threshold range in Vendor Management Workspace.

6. Add vendors to the KPI group.
   a. In the Vendors related list, click **Edit**.
   b. Add the vendors you want to add to the KPI group and click **Save**.

---

**Vendor Success Indicators in Vendor Management Workspace**

Gain insights into how your vendors are performing in comparison with other vendors in your organization. Using Predictive Intelligence, find out which
attributes contribute to the success of your vendors. You can also see what
common characteristics contribute to high performance. Identify gaps that
could enhance the performance of your vendors and create improvement
initiatives based on these insights.

The Vendor Success Indicators application includes the following five modules:

<table>
<thead>
<tr>
<th>Module Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes</td>
<td>Identify and set up attributes that may correlate to the success of the vendor performance. Attributes are key data points such as geographical location, or contract costs. For the attributes available by default with your application, see Attributes installed with Vendor Success Indicators.</td>
</tr>
<tr>
<td>Executions</td>
<td>Displays the table and filter conditions based on the scheduled job that is run to collect the comparison data.</td>
</tr>
<tr>
<td>Inputs</td>
<td>Collects the data derived by the attributes specific to a vendor when the scheduled job is run.</td>
</tr>
<tr>
<td>Results</td>
<td>Displays high-performing attributes based on the inputs using Predictive Intelligence.</td>
</tr>
<tr>
<td>Properties</td>
<td>Properties to collect comparison data. For detailed information on properties for Vendor Success Indicators, see Properties installed with Vendor Success Indicators.</td>
</tr>
</tbody>
</table>

As a vendor admin, you can:

- Configure attributes for vendor success indicators to compare common characteristics against top-performing vendors.
- Run a scheduled job to collect attribute data and generate results that can be viewed on Vendor Management Workspace.

As a vendor manager, you can:

- Understand which attributes were used for comparing the vendors.
- Analyze how your vendors are ranked against the same attributes as compared with all other vendors in your organization.
- Get insights into the attributes that contribute to the success of high-performing vendors.
Related information

Setting up Vendor Success Indicators
Compare your vendor characteristics with high-performing vendors

Service Credits in Vendor Management Workspace

Track and manage the compensation that your vendors owe your organization when they breach the service agreement you have with them.

Using Service Credits, you can:

• Track the compensation for every breach the vendor has made to the service agreement.
• Analyze the cumulative effect of multiple breaches by the same vendor from one location.
• Determine the credits your vendors owe you based on the breach count or the duration of each breach.
• Mark off credits that you’ve redeemed, which automatically calculates the amount that the vendor has paid off and the remaining amount, if any, they might still owe your organization.
• Associate service agreement breaches based on an outage, incident, service availability, or for the vendor.

Related information

Create a service credit

Set up the Vendor Management Workspace application

Enable Vendor Management Workspace and integrate with other applications.

Using this application, you can also:

• Add vendors and set up metrics to analyze their performance goals.
• Generate vendor satisfaction assessments to assess stakeholder satisfaction.
• Create key performance indicator groups (KPI) to track vendor metrics.
• Create improvement initiatives and set goals to measure success.
• Create service credits for vendor-agreement breaches.
• Set up Vendor Success Indicators to get meaningful insights when you compare vendor characteristics.
• Segregate and analyze data between business entities using domain separation.
• Validate configuration changes to your instance using quick tests.

Activate Vendor Management Workspace

The Vendor Management Workspace (com.snc.sn_itsm_vendor) plugin is available as a separate subscription. This plugin activates related plugins if they are not already active.

Before you begin
Role required: admin

About this task

Vendor Management Workspace plugins

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
| Vendor Management (com.snc.sn_itsm_vendor)        | Activates the Performance Analytics Premium for Service Management (com.snc.pa.premium.service_management) plugin which adds the following functionality to Vendor Management Workspace:  
  • Create indicators, breakdowns, and other records.  
  • Create text analytics widgets.  
  • Use Performance Analytics with external data.  
  • Preserve performance scores beyond 180 days.  
  
  Note: This is a ServiceNow Store plugin. You must install this plugin separately from the ServiceNow Store.  

Activates the Service Owner Workspace (com.spm_owner_workspace) plugin which adds the following functionality:  
  • Measure the performance of your vendor’s services and service offerings.  
  • Analyze data across multiple portfolios that have common metrics between the two applications.  

Activates the Continual Improvement Management (com.sn_cim) plugin. This
Vendor Management Workspace plugins (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>plugin enables you to monitor the continual improvement initiatives that your vendors are engaged with.</td>
</tr>
</tbody>
</table>

You can also integrate Vendor Management Workspace with the Vendor Risk Management application when you enable the Vendor Risk Management (app-vendor-risk-management) plugin.

If you have downloaded the Vendor Risk Management application that is available from the ServiceNow Store, you can view the risk rating for your vendors. For more information on downloading the Vendor Risk Management application, refer to Download and activate Vendor Risk Management.

When you enable the GRC: Vendor Risk Management Workspace (sn_vrm_ws) plugin from the ServiceNow Store you can view Vendor risk workspace within the Vendor Management Workspace application.

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click Install, and then in the Activate Plugin dialog box, click Activate.

Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

Installed with Vendor Management Workspace

Vendor Management Workspace provides a single destination for you to view and manage your vendors.

Vendor Management Workspace

When you activate the Vendor Management Workspace (com.snc.sn_itsm_vendor) plugin, the following components are installed.
# Roles installed with Vendor Management Workspace

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor admin [sn_vlm.vendor_admin]</td>
<td>Can create, edit, or delete vendor types and vendor score metric models in Vendor Management Workspace</td>
<td>sn_vlm.vendor_manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• service_viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• service_credit_mgr</td>
</tr>
</tbody>
</table>

# Table installed with Vendor KPI Groups

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>KPI Vendors [sn_itsm_vendor_kpi_group_m2m_vendor]</td>
<td>Store the relationship between KPIs and vendors.</td>
</tr>
</tbody>
</table>

# Installed with Vendor Success Indicators in Vendor Management Workspace

Using the Vendor Success Indicators application, you can compare the performance of your vendors against other top-performing vendors. Vendor Success Indicators is available as a separate subscription and installs the following components.

# Scheduled Job installed with Vendor Success Indicators

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Success Indicator Weekly Scheduled Job</td>
<td>Runs weekly and gathers vendor attributes data for the past 30 days. The job then computes the correlation of the attributes with high-performing vendors using Predictive Intelligence.</td>
</tr>
</tbody>
</table>
### Properties installed with Vendor Success Indicators

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_app_ml_insights.top_n_results</td>
<td>Top N results to retrieve from the Insight Results table for further analysis. Default value is 5.</td>
</tr>
<tr>
<td>sn_app_ml_insights.max_records_to_process</td>
<td>Maximum number of records to be processed by the Success Indicator job. Default value is 50000.</td>
</tr>
<tr>
<td>sn_app_ml_insights.attr_category_string_value</td>
<td>Maximum number of string values allowed before creating categories. Default value is 5.</td>
</tr>
<tr>
<td>sn_app_ml_insights.keep_last_n_runs</td>
<td>The number of the most recent executions to be retained after you run the table cleaner. Default value is 2.</td>
</tr>
<tr>
<td>sn_app_ml_insights.attr_datatype_inclusion_list</td>
<td>Comma separated list of valid data types to use for defining Vendor Insights attributes. Default value is boolean,currency,date,datetime,due_date,field_name,glide_date,glide_date_time,glide_list,int,integer,long,string,time,translated,translated_field,translated_text.</td>
</tr>
<tr>
<td>sn_app_ml_insights.chi_squared_critical_value</td>
<td>Critical value for a chi-square test that compares two values to see if there is a statistical significance. Default value is 3.84.</td>
</tr>
<tr>
<td>sn_app_ml_insights.chi_squared_threshold</td>
<td>The threshold for the critical value for the chi-square test. Default value is 5.</td>
</tr>
</tbody>
</table>

### Attributes installed with Vendor Success Indicators

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Attribute Type</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Availability</td>
<td>Average Availability</td>
<td>true</td>
</tr>
<tr>
<td>Average SLA Achievement</td>
<td>Average SLA Achievement</td>
<td>true</td>
</tr>
<tr>
<td>Average Stability</td>
<td>Average Stability</td>
<td>true</td>
</tr>
<tr>
<td>Avg Customer Satisfaction</td>
<td>Average Customer Satisfaction</td>
<td>true</td>
</tr>
</tbody>
</table>
### Attributes installed with Vendor Success Indicators (continued)

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Attribute Type</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg Perf Score of SO</td>
<td>Average Performance Score of Service Offering</td>
<td>true</td>
</tr>
<tr>
<td>Vendor Satisfaction</td>
<td>Vendor Satisfaction</td>
<td>true</td>
</tr>
</tbody>
</table>

**Table attributes**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Attribute Type</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract SLA Commitment</td>
<td>SLA Definition [contract_sla]</td>
<td>true</td>
</tr>
<tr>
<td>Contract SLA Type</td>
<td>SLA Definition [contract_sla]</td>
<td>true</td>
</tr>
<tr>
<td>Country</td>
<td>Company [core_company]</td>
<td>true</td>
</tr>
<tr>
<td>Rank Tier</td>
<td>Company [core_company]</td>
<td>true</td>
</tr>
<tr>
<td>Relationship Start</td>
<td>Company [core_company]</td>
<td>false</td>
</tr>
<tr>
<td>Service Commitment Type</td>
<td>Service commitment [service_commitment]</td>
<td>true</td>
</tr>
<tr>
<td>Service Offering Business Criticality</td>
<td>Service Offering [service_offering]</td>
<td>true</td>
</tr>
<tr>
<td>Total Contract Cost</td>
<td>Company [core_company]</td>
<td>false</td>
</tr>
<tr>
<td>Unique Subscribers</td>
<td>Company [core_company]</td>
<td>true</td>
</tr>
<tr>
<td>Vendor State</td>
<td>Company [core_company]</td>
<td>false</td>
</tr>
<tr>
<td>Vendor Type</td>
<td>Company [core_company]</td>
<td>false</td>
</tr>
</tbody>
</table>

**Vendor KPI Groups in Vendor Management Workspace reference**

Use Vendor KPI Groups that are provided by default to analyze vendor performance.

**Vendor KPI Groups**

The following two Vendor KPI Groups are available by default:

- **IT Services**—includes KPIs to analyze vendor performance related to IT Services.
- **Vendor Fulfillment**—includes KPIs to analyze vendor performance related to fulfillment.

Each KPI group provided by default has the following related lists:
• KPIs—indicators with a vendor breakdown that measure the performance of your vendors.
  Each indicator that contributes towards the vendor score has a weight associated with it.
• KPI group thresholds—defines threshold values to indicate the status of each KPI group.
• Vendors—list of vendors to analyze their performance.

IT Services KPIs
The table below shows the indicators that are used to calculate the vendor score.

<table>
<thead>
<tr>
<th>Indicators name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Customer Satisfaction</td>
<td>Measures CSAT scores based on service offerings.</td>
</tr>
<tr>
<td>Vendor Satisfaction</td>
<td>Provides monthly breakdown of vendor satisfaction scores.</td>
</tr>
<tr>
<td>Average SLA Achievement</td>
<td>Calculates average value for SLAs that have been successfully completed.</td>
</tr>
<tr>
<td>Average Availability</td>
<td>Calculates average value achieved for incident SLAs.</td>
</tr>
<tr>
<td>Average Request Activity</td>
<td>Average value calculated from fulfilled request items derived from service portfolio catalog items. These items must be connected to service offerings.</td>
</tr>
<tr>
<td>Total Incidents Created</td>
<td>The total number of incidents created for vendors.</td>
</tr>
<tr>
<td>Average Stability</td>
<td>Provides average values calculated from a combination of P1 and major incident counts.</td>
</tr>
</tbody>
</table>

Vendor Fulfillment KPIs
The table below shows indicators that are used to calculate vendor metrics.
Indicators that contribute towards vendor score

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Customer Satisfaction</td>
<td>Measures CSAT scores based on service offerings.</td>
</tr>
<tr>
<td>Vendor Satisfaction</td>
<td>Provides monthly breakdown of vendor satisfaction scores.</td>
</tr>
<tr>
<td>Average Incident SLA Achievement</td>
<td>Calculates average value achieved for incident SLAs that have been successfully completed.</td>
</tr>
<tr>
<td>Average Request Fulfillment SLA Achievement</td>
<td>Calculates average value for SLAs that have been successfully completed.</td>
</tr>
<tr>
<td>Total Incidents Created</td>
<td>The total number of incidents created for vendors.</td>
</tr>
<tr>
<td>Average Request Activity</td>
<td>Average value calculated from fulfilled request items derived from service portfolio catalog items. These items must be connected to service offerings.</td>
</tr>
</tbody>
</table>

Vendor score indicator

The **Vendor Score** indicator is an automated indicator. It used for calculating and displaying the vendor score. The calculation is done based on all indicators added to the metric model for evaluating vendor performance.

Schedule job

The **VMW Update Vendor Score** scheduled job runs daily and updates the score. You can run this job on-demand to get updated scores at any time.

The **VMW Update Vendor Profile** scheduled job runs monthly and updates all vendor profiles. You can run this job on-demand to get updated vendor profiles at any time.

Calculating the vendor score

The vendor score calculation is based on the weight of each indicator and the KPI score. The table below provides an example of how a vendor score is calculated.
### Vendor score calculation

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Indicator weight</th>
<th>KPI score</th>
<th>Indicator score that contributes towards vendor score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Satisfaction</td>
<td>10.00%</td>
<td>54.42%</td>
<td>5.442%</td>
</tr>
<tr>
<td>Average Customer Satisfaction</td>
<td>55.00%</td>
<td>83.00%</td>
<td>45.65%</td>
</tr>
<tr>
<td>Number of New Incidents</td>
<td>25.00%</td>
<td>88.50%</td>
<td>22.125%</td>
</tr>
<tr>
<td>Number of Open Incidents</td>
<td>10.00%</td>
<td>100.00%</td>
<td>10.00%</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td></td>
<td><strong>83.217%</strong></td>
<td></td>
</tr>
</tbody>
</table>

The total vendor score has been rounded up to 83.22%. The score is also highlighted in the header with colors that are distinct for the defined threshold values for the KPI group.

**Note:** The vendor score is impacted based on the whether the direction for the indicator is set to maximize or minimize. Below is an example that shows how the vendor score is impacted based on the indicator direction.

### Vendor score impacted by indicator direction

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Direction</th>
<th>Indicator weight</th>
<th>Indicator metric score</th>
<th>Indicator score that contributes towards vendor score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Satisfaction</td>
<td>Maximize</td>
<td>10.00%</td>
<td>54.42%</td>
<td>5.442%</td>
</tr>
<tr>
<td>Average Customer Satisfaction</td>
<td>Maximize</td>
<td>55.00%</td>
<td>83.00%</td>
<td>45.65%</td>
</tr>
<tr>
<td>Number of New Incidents</td>
<td>Minimize</td>
<td>25.00%</td>
<td>88.50%</td>
<td>2.875%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$[(100 - 88.5) \times 0.25]$</td>
</tr>
</tbody>
</table>
Vendor score impacted by indicator direction (continued)

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Direction</th>
<th>Indicator weight</th>
<th>Indicator metric score</th>
<th>Indicator score that contributes towards vendor score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Open Incidents</td>
<td>Minimize</td>
<td>10.00%</td>
<td>100.00%</td>
<td>0%</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td>53.967%</td>
</tr>
</tbody>
</table>

Integrating Vendor Management Workspace with other ServiceNow applications

Bring in data from other ServiceNow applications to assess the relationship with your vendors.

Vendor Management Workspace Integrations

You can integrate the following applications with Vendor Management Workspace:

- **Service Portfolio Management** and **Service Owner Workspace**—Understand the active service offerings and unique service offering subscribers associated with your vendors. Use this information to evaluate the business impact a vendor has on your company.

- **Asset Management**—Track and analyze assets related to your vendors.

- **Continual Improvement Management**—Track performance improvements or optimization initiatives by viewing the continual improvement initiatives a vendor is engaged in.

- **Contract Management**—Discover how many active contracts a vendor has to evaluate the financial impact the vendor has on your company.

- **Service Level Management**—Find out how many active SLA definitions a vendor has to monitor their service level agreements with your company.

- **Vendor Assessments**—Use data collected in vendor assessments to evaluate, score, and rank vendors.

- **Vendor Risk Management**—Use a centralized process to view and manage risks associated with your vendor portfolio and completing the vendor assessment and remediation life cycle.
Browser support for workspaces

Do not use Internet Explorer 11 to access any workspaces. Internet Explorer 11 is not supported. See KB0683275 for more information on Internet Explorer 11, and see Generally supported browsers for more information about supported browsers that you can use across the platform.

Create a vendor in Vendor Management Workspace

Add vendors to your existing vendor list or modify existing vendor-related information. Plan and define the information to collect and enter it to accomplish the vendor performance goals of your organization.

Before you begin
Role required: admin or sn_vlm.vendor_manager

About this task
Define the information to include in a vendor record. For example, contact and contract information, the assigned vendor manager, and evaluation criteria.

Note: Only users with the admin role can create a new vendor record. Users with the sn_vlm.vendor_manager role can edit existing vendor records.

For administrators, creating a vendor record entails simply adding general vendor information to a new record, for example, the vendor name and address, and updating the list. Vendor managers can then define the vendor record by adding more specific details about the vendor, such as, who manages the vendor, what state the vendor is in, internal and external contacts, and more.

Before defining the vendor record, vendor managers benefit from reviewing the Company form and planning and collecting all pertinent information about the vendor.

Procedure

1. To create a new vendor, administrators navigate to Vendor Management > All Vendors and click New. Alternatively, to edit an existing vendor record, vendor managers click the name of the vendor to open the Company form. Add to or change form field data as needed.

To delete an existing vendor, click the delete button in the form header.

2. Fill in the form fields, as appropriate.
## Company form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The vendor providing this service. Typically this is the company name.</td>
</tr>
<tr>
<td>Vendor Score</td>
<td>Average overall score for all performance metrics applied to a vendor.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Check box selected by default, to recognize this company as a vendor in the system.</td>
</tr>
<tr>
<td>Vendor manager</td>
<td>Person who manages the vendor. Add yourself as the manager or click the lock icon to add one or more users as vendor managers.</td>
</tr>
<tr>
<td><strong>Note:</strong> Select only users who have the sn_vlm.vendor_manager role.</td>
<td></td>
</tr>
<tr>
<td>Secondary Internal Contacts</td>
<td>Alternative person to contact regarding this vendor. Add yourself as the secondary internal contact or click the lock icon to add one or more users.</td>
</tr>
<tr>
<td>Vendor State</td>
<td>Status of the vendor. Available values are: In Evaluation, Not Selected, Selected - In Negotiation, Onboarding, Operational, and Terminated.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Check box to indicate if this company is a manufacturer.</td>
</tr>
<tr>
<td>Primary External Contact</td>
<td>Primary person to contact at the vendor company.</td>
</tr>
<tr>
<td>Secondary External Contacts</td>
<td>Alternative person to contact at the vendor company.</td>
</tr>
<tr>
<td>Notes</td>
<td>Additional information about the vendor, if known.</td>
</tr>
<tr>
<td>General section or tab</td>
<td></td>
</tr>
<tr>
<td>Address fields</td>
<td>The full address of the location you work with for the vendor, including street, city, state, and zip code. For example, enter the corporate headquarters or a local branch address.</td>
</tr>
<tr>
<td>Phone and Fax fields</td>
<td>The primary phone number and fax number for the vendor.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Stock symbol</td>
<td>The three or four letter stock symbol for the vendor, if any.</td>
</tr>
<tr>
<td>Latitude and Longitude</td>
<td>The geographical coordinates for the vendor location, if known.</td>
</tr>
<tr>
<td>Website</td>
<td>The URL for the vendor website. Click the lock icon to add the URL.</td>
</tr>
<tr>
<td>Banner image</td>
<td>The image to appear in the vendor scorecard header, usually the company logo. Select <strong>Click to add</strong> to upload an image. The image should be approximately 60–70 pixels high, and in one of these file formats: .jpg, .png, .bmp, .gif, .jpeg, and .ico.</td>
</tr>
<tr>
<td>Banner text</td>
<td>Text for the vendor scorecard, such as the company slogan. Enter up to 100 characters.</td>
</tr>
<tr>
<td>Vendor type</td>
<td>Type of business that applies to the vendor, for example, service, hardware, or software. Click the lock icon to add one or more vendor types.</td>
</tr>
<tr>
<td>Rank tier</td>
<td>Ranking that represents the organization opinion of the products from this vendor. The <strong>Rank tier</strong> field appears on the Catalog Item and Product Model forms in the Vendor Catalog Items related list. This ranking helps the catalog administrator decide whether to promote or discontinue using this vendor.</td>
</tr>
<tr>
<td>Number of employees</td>
<td>The number of employees for the vendor, if known.</td>
</tr>
<tr>
<td>Relationship Start Date</td>
<td>The date on which your relationship with the began. Click the calendar icon to select the date.</td>
</tr>
<tr>
<td>Unique Subscribers</td>
<td>The total number of subscribers to the product offered by the vendor.</td>
</tr>
<tr>
<td>Financial information</td>
<td>Useful financial information to use in the management or evaluation of the vendor. As this information fluctuates</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>per year, Stock price, Market cap)</td>
<td>over time, devise a process for keeping it up to date, if necessary.</td>
</tr>
<tr>
<td>Publicly traded</td>
<td>Check box indicating if the vendor is a publicly traded company.</td>
</tr>
<tr>
<td>Discount</td>
<td>The discount specified in the contract with the vendor.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This discount is not the one displayed in the scorecard summary, which is derived from purchase agreement contracts.</td>
</tr>
<tr>
<td>Fiscal year</td>
<td>The date on which the vendor fiscal year ends. Click the calendar icon to select the date.</td>
</tr>
<tr>
<td>Total Cost of Contracts</td>
<td>Cost of all contracts.</td>
</tr>
</tbody>
</table>

3. Right click in the header to save the new vendor record.
   The following related links and related lists appear.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Links</td>
<td></td>
</tr>
<tr>
<td>Create Vendor Credit</td>
<td>Credit that the vendor owes your organization because of a breached business service contract. Click to create a vendor credit if necessary.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Appears only if Vendor Performance is enabled.</td>
</tr>
<tr>
<td>See Vendor's Profile</td>
<td>General information, including performance metrics, about the vendor in the Vendor Management Workspace.</td>
</tr>
<tr>
<td>View Matrix</td>
<td>The default decision matrix. Use decision matrixes to compare vendors in selected categories.</td>
</tr>
<tr>
<td>View Vendor Scorecard</td>
<td>The scorecard for this vendor. Use scorecards to view various rating summaries for a vendor. This related link is available only if there are assessable records for the vendor.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> Appears only if Vendor Performance is enabled.</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td><strong>Related Lists</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor Contacts</td>
<td>Vendor contacts by role with contact details.</td>
</tr>
<tr>
<td><strong>Note:</strong> Appears only if Vendor Performance is enabled.</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td>Vendor Activities</td>
<td>Activities related to the vendor, such as demos and trade shows.</td>
</tr>
<tr>
<td><strong>Note:</strong> Appears only if Vendor Performance is enabled.</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>Product Models</td>
<td>Product models related to the vendor, for vendors that are designated as manufacturers.</td>
</tr>
<tr>
<td>Assets</td>
<td>Assets purchased from the vendor that are available for assignment to in use.</td>
</tr>
<tr>
<td>Contracts</td>
<td>Contracts established with the vendor and the contract status.</td>
</tr>
<tr>
<td>Vendor Catalog Items</td>
<td>Catalog items from the vendor that are available for users to order. This related list is available when vendor ticketing is active.</td>
</tr>
<tr>
<td>Vendor Stakeholders</td>
<td>Stakeholders associated with the vendor via the Assessments and Surveys application.</td>
</tr>
<tr>
<td>Vendor Categories</td>
<td>Metric categories related to the vendor.</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>Business services offered by this vendor. This related list is available when vendor ticketing is active.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service Commitment for Vendor</td>
<td>Service commitments negotiated with the vendor. For example, a cloud services vendor commits to 95% uptime. This related list is available when vendor ticketing is active.</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>Purchase orders opened with the vendor. This related list is available when procurement is active.</td>
</tr>
</tbody>
</table>

4. Click any related list tab to view existing information or click **New** within a related list to create a new record.

5. Click **Submit** to save your vendor record or click **Update** after editing a vendor record.

**Related information**

- Create an Asset
- Create a contract

**Generate the Vendor Satisfaction Assessment in Vendor Management Workspace**

Use Assessments and Surveys to assess how satisfied your stakeholders are with the vendors they collaborate with. Generate assessments using the Vendor Satisfaction Assessment metric type that comes with the Vendor Management Workspace application.

**Before you begin**

Role required: assessment_admin or sn_vlm.vendor_manager

**About this task**

The **Vendor Satisfaction Assessment** metric type is used to measure the satisfaction of stakeholders who collaborate with your vendors. This metric type uses the **Vendor Satisfaction** metric category to determine the vendor satisfaction score that displays in Vendor Management Workspace. Any new categories that are added to the metric type do not contribute towards the calculation of the vendor satisfaction score.

**Procedure**

1. Navigate to **Vendor Management > Assessment Administration > Types**.
2. Click **Vendor Satisfaction Assessment**.
For descriptions of the assessment metric type fields, refer to Configure an assessment.

3. Select the Conditions tab.
4. Add the desired filter conditions for the Company [core_company] table.
5. Click Update.
6. Click Generate Assessments.

Related information
Configure an assessment
Survey Management
Assessment metrics

Create KPI groups to track metrics for your vendors

Create key performance indicator (KPI) groups and include KPIs that matter most for your vendors. Associate the KPI groups with your vendors, set thresholds to monitor indicator status, and analyze vendor performance.

Before you begin
Configure Performance analytics indicators that you want to add to each vendor KPI group. For a list of indicators that are available by default refer to Installed with Vendor Management Workspace.

The indicators must have a vendor breakdown on the Company [core_company] table with associated vendors.

You can configure and track up to six KPIs with a percentage value that contribute towards the vendor score. Add 15 more KPIs with any unit value to analyze additional data.

For each indicator, configure:

• A weight value—A numeric value that indicates the percentage of contribution towards the vendor score. This value represents the importance of that indicator relative to other indicators within that KPI group. Each indicator is weighted against 100% of the combined weight of all indicators added to the KPI group. If the combined weight is over or under 100 %, then the weight of the indicators will be proportionately readjusted to 100.

• Order of priority—You can also establish the order of priority in which you want these indicators to appear on the vendor profile.

• Thresholds—Define upper and lower limit values to assess vendor performance for each indicator.
Role required: sn_vlm.vendor_admin

Procedure
1. Navigate to **Vendor Management > Configuration > KPI Groups**.
2. Create a KPI group.
   a. Click **New**.
   b. In the **Name** field, enter a name for the KPI group.
   c. From the **Type** menu, select **Vendors**.
   d. Right-click the form header and click **Save**.
3. Add KPIs to a KPI group.
   a. In the KPIs related list, click **New**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator</td>
<td>Descriptive name for the indicator.</td>
</tr>
<tr>
<td>Indicator display name</td>
<td>Business-friendly name for the indicator. This name displays in the Vendor Score Metrics widget in Vendor Manager Workspace.</td>
</tr>
<tr>
<td>Weight</td>
<td>The percentage of the total score you would like to attribute to this indicator. The combined weight of all indicators added to a metric model must equal to 100.</td>
</tr>
<tr>
<td>Order</td>
<td>The order of priority in which you want this indicator to display in the Vendor Score Metrics widget in Vendor Manager Workspace.</td>
</tr>
<tr>
<td>Lower Threshold</td>
<td>Lower limit defined for this indicator. You can view the highlighted value seen in the vendor profile.</td>
</tr>
<tr>
<td>Upper Threshold</td>
<td>Upper limit defined for this indicator. You can view the highlighted value seen in Vendor Manager Workspace.</td>
</tr>
</tbody>
</table>

b. In the **KPI** field, select the KPI to apply for this vendor.

**Note:** The KPI could also have child KPIs that you could drill down into.

c. Click **Submit**.

4. Set KPI thresholds for a KPI group.
a. In the KPI Group Thresholds related list, click **New**.

b. In the **Lower Threshold** field, enter the lower threshold limit to be used for the status defined for the KPI group.

c. In the **Upper Threshold** field, enter the upper threshold limit to be used for the status defined for the KPI group.

d. In the **Order** field, enter a number for the defined threshold limits. This number must be unique for each set of limits.

5. Add vendors to the KPI groups.
   a. In the Vendors related list, click **Edit**.
   b. Move the desired vendors from the Collection to the Vendors list.
   c. Click **Save**.

**What to do next**
Associate the KPI group to vendors.

**Create an improvement in Vendor Management Workspace**
Create an improvement initiative for a vendor to track and manage tasks for improving a service, process, or tasks related to vendors.

**Before you begin**
The Continual Improvement Management (com.sn_cim) plugin must be activated. For more information on activating the plugin, see Request Continual Improvement Management.

You can view your vendor initiatives by navigating to **Vendor Management > Improvement Initiatives**.

Role required: sn_vlm.vendor_manager, sn_vlm.vendor_admin, or admin

**Procedure**
1. Navigate to **Vendor Management > Workspace**.
2. Click the Vendor Home icon.
3. From the list, go to **Vendors > All Vendors**.
4. Select a vendor to create the improvement initiative.
5. Create an improvement initiative.
<table>
<thead>
<tr>
<th>To create an initiative</th>
<th>Do this</th>
</tr>
</thead>
</table>
| From the vendor profile              | **a.** Select the **Improvement Initiatives** tab.  
|                                      | **b.** Click **New**.                                                                                                                                 |
| From an indicator                    | **a.** On the vendor profile screen, click the indicator for which you want to create the initiative.                                    |
|                                      | **b.** On the indicator screen, click the ellipses icon and then select **Create CIM Initiative**.                                    |
|                                      | The Improvement KPI field is automatically populated with the name of the selected indicator.                                            |
| From a vendor success indicator      | **a.** Click the **Success Indicators** icon.                                                                                             |
|                                      | **b.** Select an indicator.                                                                                                               |
|                                      | **c.** Click **Create CIM Initiative**.                                                                                                    |

6. In the **Vendor** field, select the vendor for which you want to create the initiative.

7. In the **Service offering** field, select the service offering for which you want to set improvement goals.

8. Fill in all required fields to complete the initiatives. For information on field descriptions, see **Improvement field descriptions**

9. **Optional:** If you want to add supporting documents, click **Browse** and select the file.

10. Click **Save**.

**Create a service credit in Vendor Management Workspace**

Create a service credit record each time the vendor breaches the agreement. The breaches are typically associated with an outage, incident, or SLA breaches.

**Before you begin**

From Vendor Management Workspace, you can create service credits from an incident, outage, or service availability record based on the conditions listed in the table below.
Conditions for creating a service credit

<table>
<thead>
<tr>
<th>Record</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>• The incident state is <strong>On Hold</strong>.</td>
</tr>
<tr>
<td></td>
<td>• The on hold reason is <strong>Awaiting Vendor</strong>.</td>
</tr>
<tr>
<td>Outage</td>
<td>The configuration item field in the outage record must be configured to a service offering.</td>
</tr>
<tr>
<td>Service availability</td>
<td>The service offering must be configured in the service availability record.</td>
</tr>
</tbody>
</table>

Role required: sn_vlm.vendor_manager

You must have the sn_incident_read role enabled to view service credit reports.

**Procedure**

1. Navigate to **Vendor Management > Workspace**.
2. Click the Vendor Home icon.
3. Create a service credit from a vendor, incident, outage, or a service offering.

<table>
<thead>
<tr>
<th>To create a service credit</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>From a vendor</td>
<td>a. Click the Lists tab.</td>
</tr>
<tr>
<td></td>
<td>b. Click All Vendors.</td>
</tr>
<tr>
<td></td>
<td>c. Select a vendor to create the service credit.</td>
</tr>
<tr>
<td></td>
<td>d. Click the Service Credit tab.</td>
</tr>
<tr>
<td>From an incident, outage, or service availability</td>
<td>a. Click the Lists tab.</td>
</tr>
<tr>
<td></td>
<td>b. Select the incident, outage, or service availability list to create the service credit.</td>
</tr>
<tr>
<td></td>
<td>c. Select an record for which you want to create a service credit.</td>
</tr>
<tr>
<td></td>
<td>d. Click the overflow icon and select Create Service Credit.</td>
</tr>
</tbody>
</table>

4. Click **New**.
a. Fill in the following fields as required:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System generated reference number for this credit record.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Name of the vendor.</td>
</tr>
<tr>
<td>Service offering</td>
<td>Service offering related to this vendor.</td>
</tr>
<tr>
<td>Service commitment</td>
<td>Specific service commitment that affects this vendor credit.</td>
</tr>
<tr>
<td>Service availability</td>
<td>Business service availability commitment that affects this vendor credit.</td>
</tr>
<tr>
<td>Related incident</td>
<td>Number of any incidents related to these vendor products.</td>
</tr>
<tr>
<td>Related outage</td>
<td>Actual outage that created the vendor credit. The value in this field is from the Short description in the outage record.</td>
</tr>
<tr>
<td>Vendor contract</td>
<td>Contract for this vendor, if any. Choose a contract for the specified vendor. These contracts can be in any state.</td>
</tr>
<tr>
<td>Reference number</td>
<td>Any reference that pertains to this credit, for example, a confirmation number from the vendor or the name of a contact.</td>
</tr>
<tr>
<td>Breach penalty time</td>
<td>Duration of the breach. This value is the elapsed time of the credit-generating event and is inherited from the Service commitment selected.</td>
</tr>
<tr>
<td>Breach penalty amount</td>
<td>Total amount of credit due from this event, inherited from the Service commitment selected.</td>
</tr>
<tr>
<td>Per</td>
<td>Unit for calculating the breach penalty amount, inherited from the Service commitment selected.</td>
</tr>
<tr>
<td>Credit used</td>
<td>Check box indicating that credit from this vendor has been recovered.</td>
</tr>
<tr>
<td>Notes</td>
<td>Notes pertaining to this credit record, for example, to keep track of recovered credit.</td>
</tr>
</tbody>
</table>

5. Click **Save**.
Setting up Vendor Success Indicators in Vendor Management Workspace

Configure attributes that can give you meaningful insights when comparing top-performing vendors.

You can configure either tables or indicators to define attributes. The base evaluating table for the vendor success indicator is the Company [core_company] table.

Use properties to configure the Vendor Success Indicators. For more information, see Properties installed with Vendor Success Indicators.

This video provides an overview of the Vendor Success Indicators setup. Vendor Success Indicator Setup

Set up table attributes in Vendor Management Workspace

Configure attributes for a table to compare them with top-performing vendors.

Before you begin
Role required: sn_vlm.vendor_admin

About this task
The fields for a selected table display all supported string and numeric data types. The allowed data types are defined in the sn_app_ml_insights.attr_datatype_inclusion_list system property. For more information, see Properties installed with Vendor Success Indicators.

Procedure
1. Navigate to Vendor Management > Success Indicators > Attributes.
2. Click New.
3. In the Name field, enter a unique name for the evaluating attribute.
4. In the Type field, select Table.
5. Set up the field attributes.

<table>
<thead>
<tr>
<th>To configure attributes for</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Company [core_company] table</td>
<td>In the Configuration section, select Company [core_company] from the Table list. This table is the same as the base evaluating table.</td>
</tr>
<tr>
<td>To configure attributes for</td>
<td>Do this</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>• For configuring a field that has a string datatype:</td>
<td></td>
</tr>
<tr>
<td><strong>a.</strong> From the <strong>Field Name</strong> list, select the string datatype, for example, Country. A pop-up shows the number of distinct values available for this field. You can categorize these values based on how you want to evaluate your vendors.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Set the number of string datatype values you want to allow before you categorize them using the <code>sn_app_ml_insights.attr_category_string_value_limit</code> system property. For more information, see Properties installed with Vendor Success Indicators.</td>
<td></td>
</tr>
<tr>
<td><strong>b.</strong> Right-click the form header and click <strong>Save</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>c.</strong> In the Success Indicator Attribute Categories related list, click <strong>New</strong>.</td>
<td></td>
</tr>
<tr>
<td>i. In the <strong>Category</strong> field, enter the name to group a set of attribute values.</td>
<td></td>
</tr>
<tr>
<td>ii. In the <strong>Field Value</strong> field, move the desired fields to the <strong>Selected</strong> list.</td>
<td></td>
</tr>
<tr>
<td>iii. Click <strong>Submit</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Repeat this step to add each category for the selected field.</td>
<td></td>
</tr>
<tr>
<td><strong>d.</strong> Click <strong>Update</strong>. The attribute is added to the <strong>Success Indicator Attribute</strong> list.</td>
<td></td>
</tr>
<tr>
<td>• For configuring a field that has a numeric datatype:</td>
<td></td>
</tr>
<tr>
<td>To configure attributes for</td>
<td>Do this</td>
</tr>
<tr>
<td>----------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| a. From the **Field name** list, select the numeric datatype, for example Relationship Start Date. | **b. Click Submit.**%0A  
  
  † **Note:** The *Upper Threshold (Age in Days)*, *Lower Threshold (Age in Days)*, and *Direction* fields are populated automatically. If you select a numeric field type with a date value, the application calculates the number of days between the threshold values and represents them as age. |
| Any table other than the **Company [core_company]** table       | a. In the **Configuration** section, select any table other than Company [core_company] from the Table list.  
  
  b. From the **Field Name** list, select a field.  
  
  c. From the **Collection Type** field, select one of the following:  
  
  • **Field Value:** Calculates the actual value for the selected field.  
  
  † **Note:** If the selected field is a numeric type, the *Upper Threshold*, *Lower Threshold*, and *Direction* fields are populated automatically.  
  
  • **Record Count:** Counts the number of records with valid values that match the conditions defined in the **Normalization Script** field.  
  
  The application sets the relationship between the base evaluating table and the table used for selecting the attribute using the **sourceIDField** and **encodedQuery** fields.  
  
  **d. Click Submit.**%0A  
  
  **Example:**  
  
  Example 1: In the example configuration shown in the following image:
• The table used for configuring the vendor success attributes is the same as the base table, Company [core_company].

• The field name selected, which is Country, is a string data type.

The pop-up message shows that the attribute Country has nine distinct values.

The nine values for Country are Germany, Ireland, Switzerland, Israel, Japan, South Korea, Canada, U.S., and USA. You have the option of configuring the attributes for Country by grouping them into categories such as EMEA, APAC, and AMS.

Example 2: In the example configuration shown in the following image:
• The table used for configuring the vendor success attributes is not the same as the base table, Company [core_company].

• The field selected for setting attributes has the numeric data type, `sourceId`.

Set up indicator attributes in Vendor Management Workspace
Configure indicator attributes to compare them with top-performing vendors.

Before you begin
Role required: sn_vlm.vendor_admin
Procedure

1. Navigate to **Vendor Management Workspace > Success Indicators > Attributes**.
2. Click **New**.
3. In the **Name** field, enter a unique name for the evaluating attribute.
4. In the **Type** field, select **Indicator**.
5. In the Configuration section, from the **Indicator** field, select an indicator with the Company [core_company] breakdown from which you want to derive attributes. The **High** and **Low** fields are automatically populated based on the recommended values and the **Direction** field is set to **Maximize** by default.
6. Click **Submit**.

**Example:**
The following image shows an example configuration where the attribute is of type indicator.
Domain separation and Vendor Management Workspace

Domain separation is supported in Vendor Management Workspace. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Standard

• Includes Basic level support.
• Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
• The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

The Vendor Management Workspace application uses performance analytics to collect data and provides domain separation support.

Request Vendor Management Workspace Domain Separation

The Domain Support - Domain Extensions Installer plugin (com.glide.domain.msp_extensions.installer) must be activated by ServiceNow personnel. After this plugin has been activated, as an administrator, you can activate the Performance Analytics - Domain Support plugin (com.snc.pa.domain_support) plugin.

The Performance Analytics - Domain Support plugin (com.snc.pa.domain_support) must be activated to enable the features for Vendor Manager Workspace

Related information

Configure domain separation for vendor scores and analyze the data for a specific domain. Configure domains for vendor score metric models.
Before you begin
Role required: pa_data_collector or admin

Procedure

1. Configure a domain to collect vendor score performance analytics data for that domain.
   a. Navigate to Performance Analytics > Data Collector > Domain Configurations.
   b. Create a domain configuration for Vendor Management Workspace
      i. Click New.
      ii. In the Name field, enter a name for the configuration.
      iii. In the Configuration type menu, select Conditions.
      iv. In the Aggregate options section, select the Collect children check box to collect scores from all child domains.
   c. Right-click the form header and click Save.
   d. Add the following performance analytics jobs to the related list:

      Note: If you do not have the Jobs related list, you must configure the form to display the related list.

      - VMW Scheduled Data Collection
      - VMW Weight Collection
      - VMW Daily Data Collection
      - VMW Vendor Score Collection

   e. Click Update.

   For more information on creating or scheduling a data collection job, refer to Create or schedule a data collection job

   Note: The Performance Analytics application:
      - Runs the job and collects the score as the Run as user.
      - Collects the scores only for the domain in which the logged-in user runs the job. The scores are not visible to vendor admins or vendor managers who are not part of that domain in Vendor Manager Workspace.
      - Automatically adds database queries that limit results from the domain to the indicator source queries when the application runs a job for a domain configuration.
2. Configure a domain to assign a vendor score metric model to a domain.
   a. Navigate to **Vendor Manager Workspace > Vendor Score Metric Models**
   b. Do any of the following:

<table>
<thead>
<tr>
<th>To Configure the Vendor Score Metric Model list</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Click the personalize icon.</td>
<td></td>
</tr>
<tr>
<td>b. Move <strong>Domain</strong> from the <strong>Available</strong> to the <strong>Selected</strong> column.</td>
<td></td>
</tr>
<tr>
<td>c. Click <strong>OK</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To Configure a Vendor Score Metric Model form</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. From the list, select a vendor score metric model.</td>
<td></td>
</tr>
<tr>
<td>b. Right-click the context menu icon and select <strong>Configure &gt; Form Layout</strong>. Make sure you are in the Vendor Manager Workspace section.</td>
<td></td>
</tr>
<tr>
<td>c. Move <strong>Domain</strong> from the <strong>Available</strong> to the <strong>Selected</strong> column.</td>
<td></td>
</tr>
<tr>
<td>d. Click <strong>Save</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

### Quick start tests for Vendor Management Workspace

Validate that Vendor Management Workspace still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Vendor Manager Workspace quick start tests require activating the Vendor Manager Workspace plugin (com.snc.vlm.vmw) and loading demo data.

### Vendor Manager Workspace - Tests test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>VLM: Create a Vendor</td>
<td>Track problems with the Vendor Manager Workspace plugin after upgrade. Create a new vendor.</td>
<td>New York</td>
</tr>
</tbody>
</table>
Related information

Quick start tests

Use Vendor Management Workspace

Create metric models, add them to vendors and evaluate vendor health using Vendor Management Workspace.

Vendor Management Workspace landing page

Monitor vendor metrics, the number of recently created contracts, the ones that are ending soon and the number of active improvement initiatives at any given time. See which characteristics contribute to the success of your vendors. View how your vendors are ranked against those characteristics in comparison to other vendors.

Required Vendor Manager Workspace roles

If you have the Vendor Manager [sn_vlm.vendor_manager] role, you can access the Vendor Manager Workspace landing page.
Use cases

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>As a vendor manager, you can analyze real-time details such as:</td>
<td>Vendor Manager [sn_vlm.vendor_manager]</td>
</tr>
<tr>
<td>• Breakdown of vendors by vendor metrics.</td>
<td>To view reports on catalog items ordered, the sc_req_item access control list (ACL) must be enabled.</td>
</tr>
<tr>
<td>• How many new contracts were created in the last 30 days.</td>
<td></td>
</tr>
<tr>
<td>• How many contracts are ending in the next 90 days.</td>
<td></td>
</tr>
<tr>
<td>• Number of continual improvement initiatives that are currently open.</td>
<td></td>
</tr>
<tr>
<td>• The top five vendor success indicators.</td>
<td></td>
</tr>
</tbody>
</table>

Indicators

**Vendor score**

Vendor performance of all vendors in your organization that's based on their vendor score for the last 90 days.

**Vendor satisfaction**

Satisfaction of stakeholders who collaborate with your vendors.

Breakdowns

The indicators breakdown is by vendors.

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendors by metric model</td>
<td>Donut</td>
<td>Company [core_company]</td>
<td>Breakdown of vendors by metric model.</td>
</tr>
</tbody>
</table>
## Analyze Vendor KPI Groups

After you set up vendor KPI Groups, you can analyze the metrics related to all of your vendors in one location. You can search all vendor-related information such as incidents, outages, improvement initiatives, and vendors and find associated records.

### Before you begin

Role required: sn_vlm.vendor_manager

### About this task

In workspace, you can sort the list by vendor types and analyze the performance of each vendor type in a single view. You can then drill down to each vendor and analyze additional data. You can also add attachments for the vendor profile in the **Vendor Details** section and download added attachments.

### Procedure

1. Navigate to **Vendor Management > Workspace**.

2. Analyze the vendor score. For information on how the vendor score is calculated, refer to **Calculating the vendor score**.

### Table

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New contracts</td>
<td>Single</td>
<td>Contract [ast_contract]</td>
<td>Number of contracts created in the last 30 days.</td>
</tr>
<tr>
<td>Contracts ending</td>
<td>Single</td>
<td>Contract [ast_contract]</td>
<td>Number of contracts ending the next 90 days.</td>
</tr>
<tr>
<td>Improvement initiatives</td>
<td>Single</td>
<td>Improvement Initiative [sn_cim_register]</td>
<td>Number of active improvement initiatives.</td>
</tr>
</tbody>
</table>
The color indicator that highlights the vendor score in the header shows you how the vendor is performing based on the set threshold.

ℹ️ Note: The VMW:Update Vendor Score scheduled job is set to run daily. If you want to view updated score, you can run this scheduled job at any time.

3. Click each indicator widget to view the breakdown for that metric.
   You can view:
   - A single-score widget that displays the indicator metric.
   - A time-series widget that shows the trend line for the last 12 months
   - A breakdown of related service offerings for the last 12 months
   - Threshold for each indicator highlighted to provide a visual indication for each service offering
   For the breakdown on the Vendor Satisfaction indicator, you can also view the Assessments Completed widget that displays the results of vendor satisfaction surveys.

4. Add supporting documents to a vendor profile.
   a. In the Vendor Details section, click the attachments icon .
   b. Click Browse and select the desired file to attach to the profile.
   c. Optionally, you can click the ellipses icon and download, replace, or remove the attachment.

Compare your vendor characteristics with high-performing vendors in Vendor Management Workspace

Monitor the attributes that define your vendor performance and compare them with top-performing vendors.

Before you begin
Role required: sn_vlm.vendor_manager

Procedure

1. Navigate to Vendor Management > Workspace.
2. Select a vendor.
3. Click the Success Indicators icon (♀).
4. Analyze the metrics for your vendors and compare them against top performers.
Note: Vendors must meet the following criteria for evaluating against top-performing vendors:

- Have a vendor score metric model assigned to them
- Have a valid vendor score

Only vendors who have a vendor score metric model assigned to them and also have a valid vendor score will be used for evaluating against top-performing vendors.

The preceding image shows an example of success indicators for the company Cloud MSP. The success indicators provide insight into the top five attributes across all vendors that contribute to high performance. These indicators are displayed in the order of their contribution to the performance ranking which is as follows:

a. Average Availability
b. Average SLA Achievement
c. Avg Perf Score of SO
d. Avg. Customer Satisfaction

For numeric attributes, the interpretation of the value depends on the direction set for the indicator.

5. Click See more to drill down into the data. The following image shows the drill-down data for the Average Availability indicator.
### Descriptions for the single-score widget drill-down data

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor display name [Example: Cloud MSP]</td>
<td>Displays the score for the selected attribute. The <strong>Rank</strong> field shows the overall vendor ranking for the attribute.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the score falls outside the range of ranked vendors, the ranking displays as unranked.</td>
</tr>
<tr>
<td>My Top Performing Vendor</td>
<td>For the selected attribute, displays the score for the attribute. It also displays the ranking of the highest performing vendor among all the vendors that you manage.</td>
</tr>
<tr>
<td>Top Performing Vendor</td>
<td>For the selected attribute, displays the score for the attribute. It also displays the ranking of the highest performing vendor among all vendors in your organization.</td>
</tr>
</tbody>
</table>

### Descriptions for the list view drill-down data

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Top Vendors</td>
<td>Displays the ranking and success indicator attribute details of all vendors that you manage.</td>
</tr>
<tr>
<td>Top Vendors</td>
<td>Displays the ranking and success indicator attribute details of all vendors in your organization.</td>
</tr>
</tbody>
</table>

You can click on a rank or the name of a vendor to view the vendor profile.

### Compare vendor performance within a vendor KPI group

Monitor the performance of all vendors within a KPI group to assess their performance.

**Before you begin**

Role required: sn_vlm.vendor_manager

**Procedure**

1. Navigate to **Vendor Management > Workspace**.
2. Click the Performance icon (kers).
3. From the KPI groups list, select the group for which you want to compare vendor performance.

4. In the **Start date** field, click the calendar icon and select the date from which you want to start analyzing the data.

5. In the **End date** field, click the calendar icon and select the date up to which you want to analyze the data.

The vendors and the indicator scores display for the selected KPI group and the date range.

---

**Vendor Manager Workspace - Legacy**

Monitor the performance of your company’s vendors and manage all vendor-related information using the ServiceNow® Vendor Manager Workspace. Assess vendor performance using configurable vendor metric indicators.

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Track and analyze how your vendors are executing on their goals and which areas need attention from a unified, central location. Integrate data from Service Portfolio Management (SPM), Contract Management, Assets,
SLA Contracts, Vendor Risk Management, and Continual Improvement Management (CIM) applications.

**Vendor Manager Workspace in action**

Here’s how agents use Vendor Manager Workspace.

**Video for Vendor Manager Workspace**

**Key features**

**Data in a unified location**

View vendor profile and manage the performance of your company's vendors in a unified location.

**Comprehensive vendor information layout**

Analyze historical vendor health using a comprehensive layout of all information related to a vendor and its services.
Integrated application data

Use aggregated data from multiple applications and measure vendor performance using qualitative and quantitative metrics.

Get started

Select a tile to get started.

1. Agents and system administrators go here to learn about Workspace.
1. System administrators go here to set up Workspace.
1. Agents go here to learn how to use Workspace.

Explore Vendor Manager Workspace

Vendor Manager Workspace allows you to monitor metrics and analyze your vendor’s health from a single user interface. Get to know how metric models are created and configured for vendors and how they are used in the Vendor Manager Workspace.
Important: To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Tip: For an example of how you can implement and use the Vendor Manager Workspace application, go to Sample Vendor Score Metric Model setup and use.

The image below shows the work flow for Vendor Manager Workspace application.

Vendor Manager Workspace Application

Vendor Score Metric Model

Create vendor score metric models from the Vendor Score Metric Models module to analyze vendor metrics. A metric is a standard of measurement used for assessing the effectiveness of a process.

Important: To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Each metric model includes:
• Vendor score metric model indicators and configurable attributes
• Additional metrics
• A list of all vendors associated with this metric model

**Vendor score metric model**

Create a metric model that allows you to select a set of metrics to apply and assess different groups of vendors. Define upper and lower threshold values that you can apply for each vendor group.

**Vendor score metric model indicators**

In each metric model, you can include up to six vendor score metric model indicators with a percentage value. The metrics from these indicators are used to calculate the vendor score. The unit of measurement is pre-populated based on the performance analytics indicator you’ve selected and is derived from that indicator record.

When you create an indicator, consider whether you want to use the maximize or minimize direction for that indicator. The vendor score is calculated based on the indicator direction.

**Additional metrics**

Configure up to 15 additional metrics that have any unit such as days, percentage, or month. All additional indicators configured for a metric model are displayed in workspace.

As a vendor administrator, in the ServiceNow® platform:

• Create vendor score metric models for evaluating your vendors.

  ❗ **Note:** Vendor score metric models are also referred to as vendor scoring models.

• Configure up to six indicators for each metric model to calculate vendor score that can be used to measure vendor health.
• Add more indicators to monitor vendor health in other areas.

As a vendor manager, in the Vendor Manager Workspace:

• Associate the metric models with the vendors.
• Monitor the performance of your company’s vendors in a single interface.
• Access the vendor directory to view vendors you personally manage and also view all vendors your business contracts with.
• Analyze performance metrics for vendors as well as the metrics for associated service offerings, contracts, improvement initiatives, and SLA definitions.

• Drill deeper into each metric report to view trends and historical performance.

### Analyzing indicator scores in Vendor Manager Workspace

You can use monthly aggregates or running averages to analyze metrics for an indicator with a daily or monthly data collection frequency.

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

To understand how the Performance Analytics application collects data, see Performance Analytics data collection.

### Sample representation of indicator scores calculated using monthly aggregates

The example in the figure shows the monthly aggregate values for an indicator.

![Sample representation of indicator scores](image)

The table describes what data is displayed for each time period assuming the current month is March.
<table>
<thead>
<tr>
<th>Data collection time period</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mar 2020</td>
<td>Displays the value of data collected from March 1, 2020 to the current day.</td>
</tr>
<tr>
<td>Feb 2020</td>
<td>Displays the value of data collected for February 2020.</td>
</tr>
<tr>
<td>Dec 2019</td>
<td>Displays the value of data collected for December 2019.</td>
</tr>
<tr>
<td>Sept 2019</td>
<td>Displays the value of data collected for September 2019.</td>
</tr>
<tr>
<td>Mar 2019</td>
<td>Displays the value of data collected for March 2019.</td>
</tr>
</tbody>
</table>

Sample representation of indicator scores calculated using running average values

The example in the figure shows the running average values for an indicator.

The table describes what data is displayed for each time period.

<table>
<thead>
<tr>
<th>Data collection time period</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This Month</td>
<td>Displays the average value of data collected for the current month.</td>
</tr>
<tr>
<td>Previous Month</td>
<td>Displays the average value of data collected for the previous month.</td>
</tr>
</tbody>
</table>
### Data collection time period

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous 3 Months</td>
</tr>
<tr>
<td>Displays the average value of data collected for the last three months.</td>
</tr>
<tr>
<td>Previous 6 Months</td>
</tr>
<tr>
<td>Displays the average value of data collected for the last six months.</td>
</tr>
<tr>
<td>Previous 12 Months</td>
</tr>
<tr>
<td>Displays the average value of data collected for the last 12 months.</td>
</tr>
</tbody>
</table>

### Related information

#### Applying time series aggregations

#### Sample Vendor Manager Workspace setup and use

Understand how vendor score metric models are set up and how vendor scores are calculated and displayed in the Vendor Manager Workspace based on an example.

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Setup and use Vendor Manager Workspace with three simple steps:

1. Create vendor score metric models
2. Assign metric models to vendors
3. Analyze vendor health using Vendor Manager Workspace

#### Setting up a vendor score metric model

Using the vendor admin role, you can create or modify vendor score metric models.

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.
Creating vendor score metric model indicators

Create vendor score metric models. Add vendor score metric model indicators that contribute to the vendor score calculation. You can also add additional indicators that display in Vendor Manager Workspace.

Important: To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Let’s assume a vendor manager wants to measure their Cloud MSPs against metrics specific to that vendor type. To create a metric model, provide a name for the metric model. Define the upper and lower vendor score thresholds for this metric model. These thresholds would apply for all vendors that use this metric model.

The vendor score for vendors that have this vendor score metric model assigned are highlighted with a different color in the Vendor Manager Workspace based on the threshold limits.

- Red—lower than the set threshold limit
- Amber—within the set threshold
- Green—higher than the set threshold limit

The image below shows how the configuration parameters for the vendor score metric model in the platform display in Vendor Manager Workspace.

The vendor score for a vendor is calculated based on the sum of each vendor score metric model indicator score that comprises the metric model taking into consideration the percentage weight value assigned to each indicator. For
more information on how a vendor score is calculated, see Calculating the vendor score.

Adding vendor score indicators to the metric model
Add up to six vendor score metric model indicators that meet the following criteria:

- Has a percentage value
- Has a vendor breakdown associated with the company [core_company] table
- Has a frequency that is set to daily or monthly

Set the following parameters for each indicator:

- upper and lower threshold
- the weight in percentage that is applied to the vendor score
- whether you want to apply the SPM threshold or a Vendor Score Metric Model indicator threshold
- whether you want it displayed on Vendor Manager Workspace

The image below displays the breakdown for the vendor score metric model indicators and shows how the configuration in platform displays in Vendor Manager Workspace. You can view the monthly averages based on running average or a monthly average.

Analyzing the lowest performing scores
If the **Average Performance Score of Service Offerings** indicator is selected in the vendor score metric model indicators or the additional metrics indicators,
then the vendor profile will display the lowest performing service offerings for that vendor.

### Additional vendor manager metrics

Add more indicators to view additional information for the vendor.

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

### Additional metrics

The image below shows how the additional metrics configured in platform is displayed in Vendor Manager Workspace.
Using a vendor score metric model

As a vendor manager, you can associate vendor score metric models to vendors and analyze the metrics using the Vendor Manager Workspace.

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Analyzing metric breakdown

Drill down the data for each metric and evaluate the vendor’s performance over the last 12 months.

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

In workspace, when you click on a widget, you can view the drill down for each metric.

The drilldown shows:

- A single score widget with the indicator score
- A time-series widget that displays the trend for the last 12 months
- A breakdown of service offerings for the last 12 months
- The threshold for each service offering highlighted for a visual indication of the performance for that offering.
Qualitative analysis using Vendor Satisfaction Widget

The Vendor Satisfaction indicator gathers data from the vendor satisfaction assessments. If you add Vendor Satisfaction as one of the indicators to calculate vendor score, the breakdown for this widget also displays the number of vendor satisfaction surveys that were sent out and the number of assessments that have been completed.

Vendor Success Indicators

Gain insights into how your vendors are performing in comparison with other vendors in your organization. Using Predictive Intelligence, find out which attributes contribute to the success of your vendors. You can also see what common characteristics contribute to high performance. Identify gaps that could enhance the performance of your vendors and create improvement initiatives based on these insights.

Important: To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

The Vendor Success Indicators application includes the following five modules:

<table>
<thead>
<tr>
<th>Module Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes</td>
<td>Identify and set up attributes that may correlate to the success of the vendor performance. Attributes are key data points</td>
</tr>
</tbody>
</table>
As a vendor admin, you can:

- Configure attributes for Vendor Success Indicators to compare common characteristics against top-performing vendors.
- Run a scheduled job to collect attribute data and generate results that can be viewed on Vendor Manager Workspace.

As a vendor manager, you can:

- Understand which attributes were used for comparing the vendors.
- Analyze how your vendors are ranked against the same attributes as compared with all other vendors in your organization.
- Get insights into the attributes that contribute to the success of high-performing vendors.

Related information

Setting up Vendor Success Indicators

Compare your vendor characteristics with high-performing vendors

Vendor Manager Workspace user interface

The Vendor Manager Workspace is a unified interface that allows you to monitor all aspects of vendor performance.
Important: To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Using the Vendor Manager Workspace, for each vendor profile, you can view and analyze:

- Vendor score for the selected vendor
- Vendor score metric model indicator metrics
- Additional indicator metrics
- Vendor success indicators

You can also drill down into the vendor score indicator metrics and the additional indicator metrics to analyze the metric breakdown.

**Vendor score for the selected vendor**

The vendor score is the sum of the score of all vendor score metric model indicators added to the metric model. It also considers the percentage weight value assigned to each indicator. For information on how to calculate the vendor score, see Calculating the vendor score. The workspace header displays the score as a highlighted value.

**Vendor score metric model indicator metrics**

The Vendor Score Metrics section displays the vendor score metric model indicator metrics and the weight for each metric. You can view the daily and monthly breakdown for each indicator by clicking View breakdown. For example, you could have a metric to analyze potential savings for products. The breakdown would show the savings for each product per month.

The indicator metric values are highlighted as follows:

- Red—below the lower threshold.
- Amber—within the lower and upper threshold.
- Green—above the upper threshold.

For information on customizing the colors for the highlights, refer to Highlights list fields.
**Additional indicator metrics**

The Additional Metrics section displays the metrics for additional indicators. Click an indicator to view and analyze the metric breakdown for that indicator.

**Vendor success indicators**

The vendor success indicator metrics display when you click the vendor success indicator icon 📊. Analyze the attributes that contribute to the success of your vendors.

**Service Credits**

Track and manage the compensation that your vendors owe your organization when they breach the service agreement you have with them.

![Important:](image)

To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information, see, [Vendor Management Workspace](#).

Using Service Credits, you can:

- Track the compensation for every breach the vendor has made to the service agreement.
- Analyze the cumulative effect of multiple breaches by the same vendor from one location.
- Determine the credits your vendors owe you based on the breach count or the duration of each breach.
- Mark off the credits that you’ve redeemed, which automatically calculates the amount that the vendor has paid off. It also calculates the remaining amount, if any, they might still owe your organization.
- Associate service agreement breaches based on an outage, incident, service availability, or for the vendor.

**Related information**

- [Create a service credit](#)

**Set up Vendor Manager Workspace application**

Bring in data from other ServiceNow applications to assess the relationship with your vendors. Segregate and analyze data between business entities using...
domain separation. Validate configuration changes to your instance using quick tests.

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

**Vendor Manager Workspace Integrations**
Increase the benefits of and complete your Vendor Manager Workspace experience by aligning with the following applications:

- **Service Portfolio Management and Service Owner Workspace**—Understand the active service offerings and unique service offering subscribers associated with your vendors. Use this information to evaluate the business impact a vendor has on your company.

- **Asset Management**—Track and analyze assets related to your vendors.

- **Continual Improvement Management**—Track performance improvements or optimization initiatives by viewing the continual improvement initiatives a vendor is engaged in.

- **Contract Management**—Discover how many active contracts a vendor has to evaluate the financial impact the vendor has on your company.

- **Service Level Management**—Find out how many active SLA definitions a vendor has to monitor their service level agreements with your company.

- **Vendor Assessments**—Use data collected in vendor assessments to evaluate, score, and rank vendors.

- **Vendor Risk Management**—Use a centralized process to view and manage risks associated with your vendor portfolio and completing the vendor assessment and remediation life cycle.

**Browser support for workspaces**
Do not use Internet Explorer 11 to access any workspaces. Internet Explorer 11 is not supported. See KB0683275 for more information on Internet Explorer 11, and see Generally supported browsers for more information about supported browsers that you can use across the platform.
Activate Vendor Manager Workspace

The Vendor Manager Workspace (com.snc.vlm.vmw) plugin is available as a separate subscription. This plugin activates related plugins if they are not already active.

Before you begin

Important: You can access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. If you have an ITSM Pro license, you can transition to Vendor Management Workspace at no cost. Vendor Management Workspace allows you to configure the workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Role required: admin

You can use guided setup to configure the Vendor Manager Workspace application on your instance. Navigate to Vendor Manager Workspace > Configuration > Guided Setup to access the guided setup.

About this task

Vendor Manager Workspace plugins

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
| Vendor Manager Workspace (com.snc.vlm.vmw) | Activates the Performance Analytics Premium for Service Management (com.snc.pa.premium.service_management) plugin which adds the following functionality to Vendor Manager Workspace:  
  • Create indicators, breakdowns, and other records.
  • Create text analytics widgets.
  • Use Performance Analytics with external data.
  • Preserve performance scores beyond 180 days. |

Activates the Service Owner Workspace (com.spm_owner_workspace) plugin which adds the following functionality:
Vendor Manager Workspace plugins (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Measure the performance of your vendor's services and service offerings.</td>
<td></td>
</tr>
<tr>
<td>• Analyze data across multiple portfolios that have common metrics between the two applications.</td>
<td></td>
</tr>
<tr>
<td>Activates the Continual Improvement Management (com.sn_cim) plugin. This plugin enables you to monitor the continual improvement initiatives that your vendors are engaged with.</td>
<td></td>
</tr>
</tbody>
</table>

The Vendor Key Performance Indicator groups feature is available in the ServiceNow Store.

Note: This is a ServiceNow Store plugin. You must install this plugin separately from the ServiceNow Store.

Installs Vendor Key Performance Indicator groups feature

You can also integrate Vendor Manager Workspace with the Vendor Risk Management application when you enable the Risk Management (app-grc) and (app-vendor-risk-management) plugins.

If you have the Vendor Risk Management application available from the ServiceNow Store, you can view the risk rating for your vendors. For more information on downloading the Vendor Risk Management application, refer to Download and activate Vendor Risk Management.

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.

You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Installed with Vendor Manager Workspace**

Vendor Manager Workspace provides a single destination for you to view and manage your vendors.

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

**Vendor Manager Workspace**

When you activate the Vendor Manager Workspace (com.snc.vlm.vmw) plugin, the following components are installed.

**Roles installed with Vendor Manager Workspace**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor admin [sn_vlm.vendor_admin]</td>
<td>Can create, edit, or delete vendor types and vendor score metric models in Vendor Manager Workspace</td>
<td>sn_vlm.vendor_manager</td>
</tr>
<tr>
<td>Vendor Manager [sn_vlm.vendor_manager]</td>
<td>Views and manages vendors using Vendor Manager Workspace. Configures vendor performance metrics for use in Vendor Manager Workspace.</td>
<td>• pa_viewer&lt;br&gt;• service_viewer&lt;br&gt;• service_credit_mgr</td>
</tr>
</tbody>
</table>
Tables installed with Vendor Manager Workspace

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Score Metric Model</td>
<td>Stores the metric models created to calculate vendor score.</td>
</tr>
<tr>
<td>[sn_vlm_vmw_vendor_score_metric_model]</td>
<td></td>
</tr>
</tbody>
</table>

Vendor Score Metric Model

IT Services Vendor Score Metric Model

The IT Services vendor score metric model is added by default to vendor records that have one of the following:

- a vendor manager assigned to the company account
- at least one service offering

The IT Services vendor score metric model form includes the following sections:

- Vendor Score Metric Model
- Vendor Score Metric Model Indicators
- Additional Metrics

Vendor Score Metric Model

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The default name, which is IT Services, provided for the metric model.</td>
</tr>
<tr>
<td>Active</td>
<td>Metric model is active by default. Vendors that use this metric model can manage and monitor performance of their IT Service Providers.</td>
</tr>
<tr>
<td>Description</td>
<td>Brief explanation of this metric model.</td>
</tr>
<tr>
<td>Vendor Score Lower Threshold</td>
<td>The lower limit set for this metric model. The default value is set to 60. If this value for a vendor is lower than this threshold, it is highlighted in red.</td>
</tr>
<tr>
<td>Vendor Score Upper Threshold</td>
<td>The upper limit set for this metric model. The default value is set to 80. If this value for a vendor is lower than this threshold, it is highlighted in green.</td>
</tr>
</tbody>
</table>
## Vendor Score Metric Model Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Performance Score of Service Offerings</td>
<td>Measures the daily average customer satisfaction on service offerings associated with the vendor. The indicator direction is set to maximize and therefore the score should increase over time.</td>
</tr>
<tr>
<td>Vendor Satisfaction</td>
<td>Provides monthly breakdown of vendor satisfaction scores.</td>
</tr>
</tbody>
</table>

## Additional Metrics

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Customer Satisfaction</td>
<td>Measures CSAT scores based on service offerings.</td>
</tr>
<tr>
<td>Average SLA Achievement</td>
<td>Calculates average value of SLAs completed successfully.</td>
</tr>
<tr>
<td>Average Availability</td>
<td>Service Portfolio Management average availability as calculated from outage records.</td>
</tr>
<tr>
<td>Average Stability</td>
<td>Provides average values calculated from a combination of P1 and major incident counts.</td>
</tr>
<tr>
<td>Average Request Activity</td>
<td>Average value calculated from fulfilled request items derived from service portfolio catalog items. These items must be connected to service offerings.</td>
</tr>
</tbody>
</table>

These metrics are based on Service Portfolio Management service offerings. For more information on these metrics, refer to Service Owner Workspace performance metrics.

### Vendor score indicator

The **Vendor Score** indicator is an automated indicator. It used for calculating and displaying the vendor score. The calculation is done based on all indicators added to the metric model for evaluating vendor performance.

### Schedule jobs

The **VMW Update Vendor Score** scheduled job runs daily and updates the score. You can run this job on-demand to get updated scores at any time.
The **VMW Update Vendor Profile** scheduled job runs monthly and updates all vendor profiles. You can run this job on-demand to get updated vendor profiles at any time.

### Vendor Success Indicators

#### Scheduled Job installed with Vendor Success Indicators

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Success Indicator Weekly Scheduled Job</td>
<td>Runs weekly and gathers vendor attributes data for the past 30 days. The job then computes the correlation of the attributes with high-performing vendors using Predictive Intelligence.</td>
</tr>
</tbody>
</table>

#### Properties installed with Vendor Success Indicators

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_app_ml_insights.max_records_to_process</td>
<td>Maximum number of input records to process when the <strong>Vendor Success Indicator Weekly Scheduled Job</strong> is run. The default is set to 50000.</td>
</tr>
<tr>
<td>sn_app_ml_insights.attr_category_string_value_limit</td>
<td>Number of allowed string datatype field values. Creating categories for attributes with field values greater than this number is highly recommended. The default is set to 5.</td>
</tr>
<tr>
<td>sn_app_ml_insights.attr.datatype.inclusion.list</td>
<td>Comma separated list of valid data types to use for defining vendor success indicator attributes. Default value is <code>boolean, currency, date, datetime, due_date, field_name, glide_date, glide_date_time, glide_list, integer, long, string, time, translated, translated_field, translated_text</code>.</td>
</tr>
<tr>
<td>sn_app_ml_insights.keep_last_n_runs</td>
<td>The number of most recent executions to be retained. The default is set to 2.</td>
</tr>
</tbody>
</table>

*Note:* The default value cannot be changed.
## Properties installed with Vendor Success Indicators (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_app_ml_insights.top_n_results</td>
<td>Top-N number of success indicators to display in vendor manager workspace. The default is set to 5.</td>
</tr>
<tr>
<td>sn_app_ml_insights.chi_squared_critical_value</td>
<td>The critical value for a chi-square test that compares two values to see if there is a statistical significance. Default value is 3.84.</td>
</tr>
<tr>
<td>sn_app_ml_insights.chi_squared_threshold</td>
<td>The threshold for the critical value for the chi-square. The default is set to 5.</td>
</tr>
</tbody>
</table>

**Note:** The default value cannot be changed.

## Attributes installed with Vendor Success Indicators

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Attribute Type</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Performance analytics indicators</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average Availability</td>
<td>Average Availability</td>
<td>true</td>
</tr>
<tr>
<td>Average SLA Achievement</td>
<td>Average SLA Achievement</td>
<td>true</td>
</tr>
<tr>
<td>Average Stability</td>
<td>Average Stability</td>
<td>true</td>
</tr>
<tr>
<td>Avg Customer Satisfaction</td>
<td>Average Customer Satisfaction</td>
<td>true</td>
</tr>
<tr>
<td>Avg Perf Score of SO</td>
<td>Average Performance Score of Service Offering</td>
<td>true</td>
</tr>
<tr>
<td>Vendor Satisfaction</td>
<td>Vendor Satisfaction</td>
<td>true</td>
</tr>
<tr>
<td><strong>Table attributes</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contract SLA Commitment</td>
<td>SLA Definition [contract_sla]</td>
<td>true</td>
</tr>
<tr>
<td>Contract SLA Type</td>
<td>SLA Definition [contract_sla]</td>
<td>true</td>
</tr>
<tr>
<td>Country</td>
<td>Company [core_company]</td>
<td>true</td>
</tr>
<tr>
<td>Rank Tier</td>
<td>Company [core_company]</td>
<td>true</td>
</tr>
<tr>
<td>Relationship Start</td>
<td>Company [core_company]</td>
<td>false</td>
</tr>
</tbody>
</table>
## Attributes installed with Vendor Success Indicators (continued)

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Attribute Type</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Commitment Type</td>
<td>Service commitment [service_commitment]</td>
<td>true</td>
</tr>
<tr>
<td>Service Offering Business Criticality</td>
<td>Service Offering [service_offering]</td>
<td>true</td>
</tr>
<tr>
<td>Total Contract Cost</td>
<td>Company [core_company]</td>
<td>false</td>
</tr>
<tr>
<td>Unique Subscribers</td>
<td>Company [core_company]</td>
<td>true</td>
</tr>
<tr>
<td>Vendor State</td>
<td>Company [core_company]</td>
<td>false</td>
</tr>
<tr>
<td>Vendor Type</td>
<td>Company [core_company]</td>
<td>false</td>
</tr>
</tbody>
</table>

## Create a vendor in Vendor Manager Workspace

Add vendors to your existing vendor list or modify existing vendor-related information. Plan and define the information to collect and enter it to accomplish the vendor performance goals of your organization.

### Before you begin

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Role required: admin or sn_vlm.vendor_manager

### About this task

Define the information to include in a vendor record. For example, contact and contract information, the assigned vendor manager, and evaluation criteria.

**Note:** Only users with the admin role can create a new vendor record. Users with the sn_vlm.vendor_manager role can edit existing vendor records.

For administrators, creating a vendor record entails simply adding general vendor information to a new record, for example, the vendor name and address, and updating the list. Vendor managers can then define the vendor record by adding more specific details about the vendor, such as, who
manages the vendor, what state the vendor is in, internal and external contacts, and more.

Before defining the vendor record, vendor managers benefit from reviewing the Company form and planning and collecting all pertinent information about the vendor.

**Procedure**

1. To create a new vendor, administrators navigate to **Vendor Manager Workspace > Vendors** and click **New**. Alternatively, to edit an existing vendor record, vendor managers click the name of the vendor to open the Company form. Add to or change form field data as needed.
   To delete an existing vendor, click the **delete** button in the form header.

2. Fill in the form fields, as appropriate.

### Company form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The vendor providing this service. Typically this is the company name.</td>
</tr>
<tr>
<td>Vendor Score</td>
<td>Average overall score for all performance metrics applied to a vendor.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Check box selected by default, to recognize this company as a vendor in the system.</td>
</tr>
<tr>
<td>Vendor manager</td>
<td>Person who manages the vendor. Add yourself as the manager or click the lock icon to add one or more users as vendor managers.</td>
</tr>
<tr>
<td><strong>Note:</strong> Select only users who have the sn_vlm.vendor_manager role.</td>
<td></td>
</tr>
<tr>
<td>Secondary Internal Contacts</td>
<td>Alternative person to contact regarding this vendor. Add yourself as the secondary internal contact or click the lock icon to add one or more users.</td>
</tr>
<tr>
<td>Vendor State</td>
<td>Status of the vendor. Available values are: <strong>In Evaluation</strong>, <strong>Not Selected</strong>, <strong>Selected - In Negotiation</strong>, <strong>Onboarding</strong>, <strong>Operational</strong>, and <strong>Terminated</strong>.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Check box to indicate if this company is a manufacturer.</td>
</tr>
<tr>
<td>Primary External Contact</td>
<td>Primary person to contact at the vendor company.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Secondary External Contacts</td>
<td>Alternative person to contact at the vendor company.</td>
</tr>
<tr>
<td>Notes</td>
<td>Additional information about the vendor, if known.</td>
</tr>
<tr>
<td>General section or tab</td>
<td></td>
</tr>
<tr>
<td>Address fields</td>
<td>The full address of the location you work with for the vendor, including street, city, state, and zip code. For example, enter the corporate headquarters or a local branch address.</td>
</tr>
<tr>
<td>Phone and Fax fields</td>
<td>The primary phone number and fax number for the vendor.</td>
</tr>
<tr>
<td>Stock symbol</td>
<td>The three or four letter stock symbol for the vendor, if any.</td>
</tr>
<tr>
<td>Latitude and Longitude</td>
<td>The geographical coordinates for the vendor location, if known.</td>
</tr>
<tr>
<td>Website</td>
<td>The URL for the vendor website. Click the lock icon to add the URL.</td>
</tr>
<tr>
<td>Banner image</td>
<td>The image to appear in the vendor scorecard header, usually the company logo. Select <strong>Click to add</strong> to upload an image.</td>
</tr>
<tr>
<td></td>
<td>The image should be approximately 60–70 pixels high, and in one of these file formats: .jpg, .png, .bmp, .gif, .jpeg, and .ico.</td>
</tr>
<tr>
<td>Banner text</td>
<td>Text for the vendor scorecard, such as the company slogan. Enter up to 100 characters.</td>
</tr>
<tr>
<td>Detailed section or tab</td>
<td></td>
</tr>
<tr>
<td>Vendor type</td>
<td>Type of business that applies to the vendor, for example, service, hardware, or software. Click the lock icon to add one or more vendor types.</td>
</tr>
<tr>
<td>Rank tier</td>
<td>Ranking that represents the organization opinion of the products from this vendor.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Rank tier</strong> field appears on the Catalog Item and Product Model forms in the Vendor Catalog Items related list. This ranking helps the catalog administrator</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>decide whether to promote or discontinue using this vendor.</td>
</tr>
<tr>
<td>Number of employees</td>
<td>The number of employees for the vendor, if known.</td>
</tr>
<tr>
<td>Relationship Start Date</td>
<td>The date on which your relationship with the began. Click the calendar icon to select the date.</td>
</tr>
<tr>
<td>Unique Subscribers</td>
<td>The total number of subscribers to the product offered by the vendor.</td>
</tr>
<tr>
<td>Financial section or tab</td>
<td></td>
</tr>
<tr>
<td>Financial information (Profits, Revenue per year, Stock price, Market cap)</td>
<td>Useful financial information to use in the management or evaluation of the vendor. As this information fluctuates over time, devise a process for keeping it up to date, if necessary.</td>
</tr>
<tr>
<td>Publicly traded</td>
<td>Check box indicating if the vendor is a publicly traded company.</td>
</tr>
<tr>
<td>Discount</td>
<td>The discount specified in the contract with the vendor.</td>
</tr>
<tr>
<td>Note:</td>
<td>This discount is not the one displayed in the scorecard summary, which is derived from purchase agreement contracts.</td>
</tr>
<tr>
<td>Fiscal year</td>
<td>The date on which the vendor fiscal year ends. Click the calendar icon to select the date.</td>
</tr>
<tr>
<td>Total Cost of Contracts</td>
<td>Cost of all contracts.</td>
</tr>
</tbody>
</table>

3. Right click in the header to save the new vendor record. The following related links and related lists appear.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Links</td>
<td></td>
</tr>
<tr>
<td>Create Vendor Credit</td>
<td>Credit that the vendor owes your organization because of a breached business service contract. Click to create a vendor credit if necessary.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **Note:**<br>Appears only if Vendor Performance is enabled. | |}
| See Vendor's Profile | General information, including performance metrics, about the vendor in the Vendor Manager Workspace. |
| View Matrix | The default decision matrix. Use decision matrixes to compare vendors in selected categories. |
| View Vendor Scorecard | The scorecard for this vendor. Use scorecards to view various rating summaries for a vendor. This related link is available only if there are assessable records for the vendor. |
| Related Lists | |}
| Vendor Contacts | Vendor contacts by role with contact details. |
| **Note:**<br>Appears only if Vendor Performance is enabled. | |}
| Vendor Activities | Activities related to the vendor, such as demos and trade shows. |
| **Note:**<br>Appears only if Vendor Performance is enabled. | |}
<p>| Product Models | Product models related to the vendor, for vendors that are designated as manufacturers. |
| Assets | Assets purchased from the vendor that are available for assignment to in use. |
| Contracts | Contracts established with the vendor and the contract status. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Catalog Items</td>
<td>Catalog items from the vendor that are available for users to order. This related list is available when vendor ticketing is active.</td>
</tr>
<tr>
<td>Vendor Stakeholders</td>
<td>Stakeholders associated with the vendor via the Assessments and Surveys application.</td>
</tr>
<tr>
<td>Vendor Categories</td>
<td>Metric categories related to the vendor.</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>Business services offered by this vendor. This related list is available when vendor ticketing is active.</td>
</tr>
<tr>
<td>Service Commitment for Vendor</td>
<td>Service commitments negotiated with the vendor. For example, a cloud services vendor commits to 95% uptime. This related list is available when vendor ticketing is active.</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>Purchase orders opened with the vendor. This related list is available when procurement is active.</td>
</tr>
</tbody>
</table>

4. Click any related list tab to view existing information or click **New** within a related list to create a new record.

5. Click **Submit** to save your vendor record or click **Update** after editing a vendor record.

**Related information**

- Create an Asset
- Create a contract

**Generate the Vendor Satisfaction Assessment**

Use Assessments and Surveys to assess how satisfied your stakeholders are with the vendors they collaborate with. Generate assessments using the Vendor Satisfaction Assessment metric type that comes with the Vendor Manager Workspace application.
Before you begin

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Role required: assessment_admin or sn_vlm.vendor_manager

About this task

The **Vendor Satisfaction Assessment** metric type is used to measure the satisfaction of stakeholders who collaborate with your vendors. This metric type uses the **Vendor Satisfaction** metric category to determine the vendor satisfaction score that displays in the Vendor Manager Workspace. Any new categories that are added to the metric type do not contribute towards the calculation of the vendor satisfaction score.

Procedure

1. Navigate to **Vendor Manager Workspace > Vendor Assessment Administration > Vendor Assessment Types**.
2. Click **Vendor Satisfaction Assessment**. For descriptions of the assessment metric type fields, refer to Configure an assessment.
3. Select the **Conditions** tab.
4. Add the desired filter conditions for the Company [core_company] table.
5. Click **Update**.
6. Click **Generate Assessments**.

Related information

Configure an assessment
Survey Management
Assessment metrics

Create a service credit

Create a service credit record each time the vendor breaches the agreement. The breaches are typically associated with an outage, incident, or SLA breaches.
Before you begin

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

An admin must create the incident, outage, or service offering lists in a workspace, for example Agent Workspace, with the required conditions to be able to create service credits from each of these records. For more information on creating these lists, see Create My Lists in workspace.

<table>
<thead>
<tr>
<th>Record</th>
<th>Conditions for creating service credit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident</td>
<td>• The incident state is <strong>On Hold</strong>.</td>
</tr>
<tr>
<td></td>
<td>• The on hold reason is <strong>Awaiting Vendor</strong>.</td>
</tr>
<tr>
<td>Outage</td>
<td>The configuration item field in the outage record must be configured to a service offering.</td>
</tr>
<tr>
<td>Service availability</td>
<td>The service offering must be configured in the service availability record.</td>
</tr>
</tbody>
</table>

Role required: sn_vlm.vendor_manager

You must have the sn_incident_read role enabled to view service credit reports.

**Procedure**

1. Navigate to **Vendor Manager Workspace > Vendor Manager Workspace**.
2. Click the Vendor Home icon.
3. Create a service credit from a vendor, incident, outage, or a service offering.

<table>
<thead>
<tr>
<th>To create a service credit</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>From a vendor</td>
<td>a. Click the <strong>Lists</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>b. Click All Vendors.</td>
</tr>
<tr>
<td></td>
<td>c. Select a vendor to create the service credit.</td>
</tr>
<tr>
<td></td>
<td>d. Click the <strong>Service Credit</strong> tab.</td>
</tr>
</tbody>
</table>
To create a service credit

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System-generated reference number for this credit record.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Name of the vendor.</td>
</tr>
<tr>
<td>Service offering</td>
<td>Service offering related to this vendor.</td>
</tr>
<tr>
<td>Service commitment</td>
<td>Specific service commitment that affects this vendor credit.</td>
</tr>
<tr>
<td>Service availability</td>
<td>Business service availability commitment that affects this vendor credit.</td>
</tr>
<tr>
<td>Related incident</td>
<td>Number of any incidents related to these vendor products.</td>
</tr>
<tr>
<td>Related outage</td>
<td>Actual outage that created the vendor credit. The value in this field is from the Short description in the outage record.</td>
</tr>
<tr>
<td>Vendor contract</td>
<td>Contract for this vendor, if any. Choose a contract for the specified vendor. These contracts can be in any state.</td>
</tr>
<tr>
<td>Reference number</td>
<td>Any reference that pertains to this credit. For example, it can be a confirmation number from the vendor or the name of a contact.</td>
</tr>
<tr>
<td>Breach penalty time</td>
<td>Duration of the breach. This value is the elapsed time of the credit-generating event and is inherited from the Service commitment selected.</td>
</tr>
</tbody>
</table>

4. Click New.
   a. Fill in the following fields as required:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breach penalty amount</td>
<td>Total amount of credit due from this event, inherited from the <strong>Service commitment</strong> selected.</td>
</tr>
<tr>
<td>Per</td>
<td>Unit for calculating the breach penalty amount, inherited from the <strong>Service commitment</strong> selected.</td>
</tr>
<tr>
<td>Credit used</td>
<td>Check box indicating that credit from this vendor has been recovered.</td>
</tr>
<tr>
<td>Notes</td>
<td>Notes pertaining to this credit record. For example, it could be notes to keep track of recovered credit.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Set up a vendor score metric model**

Using the vendor admin role, you can create or modify vendor score metric models. For each metric model, add configurable indicators that contribute to the vendor score. Add more metrics that you can monitor in Vendor Manager Workspace.

**Before you begin**

ℹ️ **Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, **Vendor Management Workspace**.

Configure **performance analytics indicators** that you want to add to each vendor score metric model. For a list of indicators that come with your application by default refer to **Installed with Vendor Manager Workspace**.

Role required: **sn_vlm.vendor_admin**

**About this task**

You can configure and track up to six vendor score metric model indicators with a percentage value that contribute towards the vendor score. Add 15 more metrics to analyze additional data.

The indicators must meet the following criteria:
• The vendor score metric model indicator must have a percentage value. The additional indicators can be have any unit.

• Has a vendor breakdown on the Company [core_company] table with associated vendors.

• Data collection frequency is set to monthly.

If an indicator breakdown is related to Service Portfolio Management (SPM), you have the option of applying the threshold set for SPM.

For each indicator, configure:

• A weight value—A numeric value that indicates the percentage of contribution towards the vendor score. This value represents the importance of that indicator relative to other indicators in that metric model. Each indicator is weighted against 100% of the combined weight of all indicators added to a metric model. You can choose to include the weight for a metric to calculate the vendor score, but not display in the vendor profile.

• Order of priority—You can also establish the order of priority in which you want these indicators to appear on the vendor profile.

• Thresholds—Define upper and lower limit values to assess vendor performance for each indicator. If the indicator is defined based on service offerings, you can use the Service Portfolio Management (SPM) thresholds already defined in SPM at the portfolio level.

Procedure

1. Navigate to Vendor Manager Workspace > Configuration > Vendor Score Metric Models.

2. Create a vendor score metric model.
   a. Click New.
   b. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for the vendor score metric model.</td>
</tr>
<tr>
<td>Active</td>
<td>Select the check box to enable the metric model and apply it to vendors.</td>
</tr>
<tr>
<td>Vendor Score Lower Threshold</td>
<td>The vendor score lower limit defined for this metric model. Default value is 60.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Vendor Score Upper Threshold | The vendor score upper limit defined for this metric model. Default value is 80.
Description | Description for the vendor score metric model.

**c.** Right-click the form and click **Save**.

### Add indicators to the metric model.

You can add existing indicators to the metric model. If you want to add new indicators, you must **create the indicator** before adding them to the metric model.

In the **Vendor Score Metric Model Indicators** section, fill in the following fields:

### Field | Description
--- | ---
Indicator | Descriptive name for the indicator.
Indicator display name | Business-friendly name for the indicator. This name displays in the Vendor Score Metrics widget in Vendor Manager Workspace.
Weight | The percentage of the total score you would like to attribute to this indicator. The combined weight of all indicators added to a metric model must equal to 100.
Order | The order of priority in which you want this indicator to display in the Vendor Score Metrics widget in Vendor Manager Workspace.
Lower Threshold | Lower limit defined for this indicator. You can view the highlighted value seen in the vendor profile.
Upper Threshold | Upper limit defined for this indicator. You can view the highlighted value seen in Vendor Manager Workspace.
Apply SPM Thresholds | If this indicator is related to Service Portfolio Management (SPM), you can choose to apply the SPM threshold set for this indicator. By default, this value is set to **true**.
| To apply the threshold set for the vendor score metric model indicator, set this value to **false**.
Display | If you select **false**, the indicator widget does not display in workspace.
4. In the **Additional Indicators** related list, repeat the steps above to create additional indicators for the metric model. All additional indicators display in workspace.

5. Click **Submit**.
   The application creates the vendor score metric model.

**What to do next**
Associate the vendor score metric model to vendors.

**Calculating the vendor score**
The vendor score calculation depends on the indicator direction. This section provides an example of how the vendor score is calculated and how it could vary based on the indicator direction.

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the **Now Experience UI Builder**. For more information see, **Vendor Management Workspace**.

The table below provides an example of how a vendor score is calculated.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Indicator weight</th>
<th>Indicator metric score</th>
<th>Indicator score that contributes towards vendor score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Satisfaction</td>
<td>10.00%</td>
<td>54.42%</td>
<td>5.442%</td>
</tr>
<tr>
<td>Average Customer Satisfaction</td>
<td>55.00%</td>
<td>83.00%</td>
<td>45.65%</td>
</tr>
<tr>
<td>Average SLA Achievement</td>
<td>25.00%</td>
<td>88.50%</td>
<td>22.125%</td>
</tr>
<tr>
<td>Average Stability</td>
<td>10.00%</td>
<td>100.00%</td>
<td>10.00%</td>
</tr>
</tbody>
</table>
Vendor score calculation (continued)

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Indicator weight</th>
<th>Indicator metric score</th>
<th>Indicator score that contributes towards vendor score</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Total</strong></td>
<td></td>
<td></td>
<td><strong>83.217%</strong></td>
</tr>
</tbody>
</table>

The total vendor score has been rounded up to 83.22%. The score is also highlighted in the header with colors that are distinct for values that fall within the threshold or when they go above or below the threshold.

*Note:* The vendor score is impacted based on the whether the direction for the indicator is set to maximize or minimize. Below is an example that shows how the vendor score is impacted based on the indicator direction.

### Vendor score impacted by indicator direction

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Direction</th>
<th>Indicator weight</th>
<th>Indicator metric score</th>
<th>Indicator score that contributes towards vendor score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Satisfaction</td>
<td>Maximize</td>
<td>10.00%</td>
<td>54.42%</td>
<td>5.442%</td>
</tr>
<tr>
<td>Average Customer Satisfaction</td>
<td>Maximize</td>
<td>55.00%</td>
<td>83.00%</td>
<td>45.65%</td>
</tr>
<tr>
<td>Number of New Incidents</td>
<td>Minimize</td>
<td>25.00%</td>
<td>88.50%</td>
<td>2.875%</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>[(100 - 88.5) \times 0.25]</td>
</tr>
<tr>
<td>Number of Open Incidents</td>
<td>Minimize</td>
<td>10.00%</td>
<td>100.00%</td>
<td>0%</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td></td>
<td></td>
<td></td>
<td><strong>53.967%</strong></td>
</tr>
</tbody>
</table>

**Setting up Vendor Success Indicators**

Configure attributes that can give you meaningful insights when comparing top-performing vendors.
Important: To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

You can configure either tables or indicators to define attributes. The base evaluating table for the Vendor Success Indicators is the Company [core_company] table.

Use properties to configure the Vendor Success Indicators. For more information, see Properties installed with Vendor Success Indicators.

This video provides an overview of the Vendor Success Indicators setup. Vendor Success Indicator Setup

Set up table attributes

Configure attributes for a table to compare them with top-performing vendors.

Before you begin

Important: To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Role required: sn_vlm.vendor_admin

About this task

The fields for a selected table display all supported string and numeric data types. The allowed data types are defined in the sn_app_ml_insights.attr_datatype_inclusion_list system property. For more information, see Properties installed with Vendor Success Indicators.

Procedure

1. Navigate to Vendor Manager Workspace > Vendor Success Indicators > Attributes.
2. Click New.
3. In the Name field, enter a unique name for the evaluating attribute.
4. In the Type field, select Table.
5. Set up the field attributes.
<table>
<thead>
<tr>
<th>To configure attributes for</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Company [core_company] table</td>
<td>In the <strong>Configuration</strong> section, select Company [core_company] from the Table list. This table is the same as the base evaluating table.</td>
</tr>
<tr>
<td></td>
<td>• For configuring a field that has a string datatype:</td>
</tr>
<tr>
<td></td>
<td>a. From the <strong>Field Name</strong> list, select the string datatype, for example, Country. A pop-up shows the number of distinct values available for this field. You can categorize these values based on how you want to evaluate your vendors.</td>
</tr>
<tr>
<td></td>
<td>‣ <strong>Note:</strong> Set the number of string datatype values you want to allow before you categorize them using the <code>sn_app_ml_insights.attr_category_string_value_limit</code> system property. For more information, see Properties installed with Vendor Success Indicators.</td>
</tr>
<tr>
<td></td>
<td>b. Right-click the form header and click <strong>Save</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. In the Success Indicator Attribute Categories related list, click <strong>New</strong>.</td>
</tr>
<tr>
<td></td>
<td>‣ i. In the <strong>Category</strong> field, enter the name to group a set of attribute values.</td>
</tr>
<tr>
<td></td>
<td>‣ ii. In the <strong>Field Value</strong> field, move the desired fields to the <strong>Selected</strong> list.</td>
</tr>
<tr>
<td></td>
<td>‣ iii. Click <strong>Submit</strong>.</td>
</tr>
<tr>
<td></td>
<td>‣ <strong>Note:</strong> Repeat this step to add each category for the selected field.</td>
</tr>
<tr>
<td></td>
<td>d. Click <strong>Update</strong>. The attribute is added to the <strong>Success Indicator Attribute</strong> list.</td>
</tr>
<tr>
<td></td>
<td>• For configuring a field that has a numeric datatype:</td>
</tr>
<tr>
<td>To configure attributes for</td>
<td>Do this</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------</td>
</tr>
</tbody>
</table>
| Any table other than Company [core_company] table | a. In the **Configuration** section, select any table other than Company [core_company] from the Table list.  
  b. From the **Field Name** list, select a field.  
  c. From the **Collection Type** field, select one of the following:  
    * Field Value: Calculates the actual value for the selected field.  
      
      **Note:** If the selected field is a numeric type, the **Upper Threshold**, **Lower Threshold**, and **Direction** fields are populated automatically.  
    * Record Count: Counts the number of records with valid values that match the conditions defined in the **Normalization Script** field.  
      
      The application sets the relationship between the base evaluating table and the table used for selecting the attribute using the **sourceIDField** and **encodedQuery** fields.  
  d. Click **Submit**.  

**Example:**  
Example 1: In the example configuration shown in the following image:
• The table used for configuring the vendor success attributes is the same as the base table, Company [core_company].
• The field name selected, which is Country, is a string data type.

The pop-up message shows that the attribute Country has nine distinct values. The nine values for Country are Germany, Ireland, Switzerland, Israel, Japan, South Korea, Canada, U.S., and USA. You have the option of configuring the attributes for Country by grouping them into categories such as EMEA, APAC, and AMS.

Example 2: In the example configuration shown in the following image:
• The table used for configuring the vendor success attributes is not the same as the base table, Company [core_company].
• The field selected for setting attributes has the numeric data type, `sourceId`.

**Set up indicator attributes**
Configure indicator attributes to compare them with top-performing vendors.

**Before you begin**

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Role required: sn_vlm.vendor_admin

Procedure

1. Navigate to **Vendor Manager Workspace > Vendor Success Indicators > Attributes**.
2. Click **New**.
3. In the **Name** field, enter a unique name for the evaluating attribute.
4. In the **Type** field, select **Indicator**.
5. In the Configuration section, from the **Indicator** field, select an indicator with the Company [core_company] breakdown from which you want to derive attributes. The **High** and **Low** fields are automatically populated based on the recommended values and the **Direction** field is set to **Maximize** by default.
6. Click **Submit**.

Example:
The following image shows an example configuration where the attribute is of type indicator.

![Example Configuration Image](image-url)
Use Vendor Manager Workspace

Create metric models, add them to vendors and evaluate vendor health using Vendor Manager Workspace.

Important: To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Vendor Manager Workspace landing page

Monitor vendor metrics, the number of recently created contracts, the ones that are ending soon and the number of active improvement initiatives at any given time. See which characteristics contribute to the success of your vendors. View how your vendors are ranked against those characteristics in comparison to other vendors.

Important: To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.
Required Vendor Manager Workspace roles

If you have the Vendor Manager [sn_vlm.vendor_manager] role, you can access the Vendor Manager Workspace landing page.

Use cases

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>As a vendor manager, you can analyze real-time details such as:</td>
<td>Vendor Manager [sn_vlm.vendor_manager]</td>
</tr>
<tr>
<td>• Breakdown of vendors by vendor metrics.</td>
<td>To view reports on catalog items ordered, the sc_req_item access control list (ACL) must be enabled.</td>
</tr>
<tr>
<td>• How many new contracts were created in the last 30 days.</td>
<td></td>
</tr>
<tr>
<td>• How many contracts are ending in the next 90 days.</td>
<td></td>
</tr>
<tr>
<td>• Number of continual improvement initiatives that are currently open.</td>
<td></td>
</tr>
<tr>
<td>• The top five vendor success indicators.</td>
<td></td>
</tr>
</tbody>
</table>

Indicators

**Vendor score**

Vendor performance of all vendors in your organization that's based on their vendor score for the last 90 days.

**Vendor satisfaction**

Satisfaction of stakeholders who collaborate with your vendors.

Breakdowns

The indicators breakdown is by vendors.
### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendors by metric model</td>
<td>Donut</td>
<td>Company [core_company]</td>
<td>Breakdown of vendors by metric model.</td>
</tr>
<tr>
<td>New contracts</td>
<td>Single</td>
<td>Contract [ast_contract]</td>
<td>Number of contracts created in the last 30 days.</td>
</tr>
<tr>
<td>Contracts ending</td>
<td>Single</td>
<td>Contract [ast_contract]</td>
<td>Number of contracts ending the next 90 days.</td>
</tr>
<tr>
<td>Improvement initiatives</td>
<td>Single</td>
<td>Improvement Initiative [sn_cim_register]</td>
<td>Number of active improvement initiatives.</td>
</tr>
</tbody>
</table>

**Associate a vendor score metric model with a vendor**

Add metric models to vendors and monitor the metrics using Vendor Manager Workspace.

**Before you begin**

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Role required: sn_vlm.vendor_manager, sn_vlm.vendor_admin, or admin
About this task
The metric model must include all performance indicators you want to monitor to measure vendor health.

Procedure
1. Navigate to Vendor Manager Workspace > Vendors.
2. In the Name field, select a vendor.
3. In the Vendor Score Metric Model field, click the search icon and select the metric model for this vendor.

   Note: The metric model must be active to associate it with vendors.
4. Click Update.

Analyze vendor score metrics
After you add vendor score metric models to vendors, you can analyze the metrics related to all of your vendors in one location.

Before you begin

Important: To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Role required: sn_vlm.vendor_manager

About this task
In workspace, you can sort the list by vendor types and analyze the performance of each vendor type in a single view. You can then drill down to each vendor and analyze additional data. You can also add attachments for the vendor profile in the Vendor Details section and download added attachments.

Procedure
1. Navigate to Vendor Manager Workspace > Vendor Manager Workspace.
2. Analyze the vendor score. For information on how the vendor score is calculated, refer to Calculating the vendor score.

   The color indicator that highlights the vendor score in the header shows you how the vendor is performing based on the set threshold.
| Note: The VMW:Update Vendor Score scheduled job is set to run daily. If you want to view updated score, you can run this scheduled job at any time.

3. Click each indicator widget to view the breakdown for that metric.
   You can view:
   • A single-score widget that displays the indicator metric
   • A time-series widget that shows the trend line for the last 12 months
   • A breakdown of related service offerings for the last 12 months
   • Threshold for each indicator highlighted to provide a visual indication for each service offering
   For the breakdown on the Vendor Satisfaction indicator, you can also view the Assessments Completed widget that displays the results of vendor satisfaction surveys.

4. Add supporting documents to a vendor profile.
   a. In the Vendor Details section, click the attachments icon (_attachment icon_).
   b. Click Browse and select the desired file to attach to the profile.
   c. Optionally, you can click the ellipses icon (_ellipsis icon_) and download, replace, or remove the attachment.

5. Optional: To view additional details, click the preview icon for each service offering and view the information on the service offering.

6. Optional: To view detailed information on the service offering, click Open in Services.
   The details for the service offering opens in Service Owner Workspace.

Create an improvement in Vendor Manager Workspace

Create an improvement initiative for a vendor to track and manage tasks for improving a service, process, or tasks related to vendors.

Before you begin

| Important: To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace. |
The Continual Improvement Management (com.sn_cim) plugin must be activated. For more information on activating the plugin, see Request Continual Improvement Management.

You can view your vendor initiatives by navigating to Vendor Manager Workspace > Vendor Improvement Initiatives.

Role required: sn_vlm.vendor_manager, sn_vlm.vendor_admin, or admin

Procedure

1. Navigate to Vendor Manager Workspace > Vendor Manager Workspace.
2. Click the Vendor Home icon.
3. From the list, go to Vendors > All Vendors.
4. Select a vendor to create the improvement initiative.
5. Create an improvement initiative.

<table>
<thead>
<tr>
<th>To create an initiative</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the vendor profile</td>
<td>a. Select the Improvement Initiatives tab.</td>
</tr>
<tr>
<td></td>
<td>b. Click New.</td>
</tr>
<tr>
<td>From an indicator</td>
<td>a. On the vendor profile screen, click the indicator for which you want to create the initiative.</td>
</tr>
<tr>
<td></td>
<td>b. On the indicator screen, click the ellipses icon and then select Create CIM Initiative. The Improvement KPI field automatically populates with the name of the selected indicator.</td>
</tr>
<tr>
<td>From a vendor success indicator</td>
<td>a. Click the Success Indicators icon.</td>
</tr>
<tr>
<td></td>
<td>b. Select an indicator.</td>
</tr>
<tr>
<td></td>
<td>c. Click Create CIM Initiative.</td>
</tr>
</tbody>
</table>

6. In the Vendor field, select the vendor for which you want to create the initiative.

7. In the Service offering field, select the service offering for which you want to set improvement goals.

8. Fill in all required fields to complete the initiatives. For information on field descriptions, see Improvement field descriptions.
9. **Optional:** If you want to add supporting documents, click **Browse** and select the file.

10. Click **Save**.

**Compare your vendor characteristics with high-performing vendors**

Monitor the attributes that define your vendor performance and compare them with top-performing vendors.

**Before you begin**

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Role required: sn_vlm.vendor_manager

**Procedure**

1. Navigate to **Vendor Manager Workspace** > **Vendor Manager Workspace**.
2. Select a vendor.
3. Click the Success Indicators icon 🗳️.
4. Analyze the metrics for your vendors and compare them against top performers.
Note: Vendors must meet the following criteria for evaluating against top-performing vendors:

- Have a vendor score metric model assigned to them
- Have a valid vendor score

The preceding image shows an example of success indicators for the company Cloud MSP. The success indicators provide insight into the top five attributes across all vendors that contribute to high performance. These indicators are displayed in the order of their contribution to the performance ranking which is as follows:

a. Average Availability
b. Average SLA Achievement
c. Avg Perf Score of SO
d. Avg. Customer Satisfaction

For numeric attributes, the interpretation of the value depends on the direction set for the indicator.

5. Click See more to drill down into the data. The following image shows the drill-down data for the Average Availability indicator.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor display name [Example: Cloud MSP]</td>
<td>Displays the score for the selected attribute. The Rank field shows the overall vendor ranking for the attribute.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>My Top Performing Vendor</strong></td>
<td>For the selected attribute, displays the score for the attribute. It also displays the ranking of the highest performing vendor among all the vendors that you manage.</td>
</tr>
<tr>
<td><strong>Top Performing Vendor</strong></td>
<td>For the selected attribute, displays the score for the attribute. It also displays the ranking of the highest performing vendor among all vendors in your organization.</td>
</tr>
</tbody>
</table>

**Descriptions for the list view drill-down data**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>My Top Vendors</strong></td>
<td>Displays the ranking and success indicator attribute details of all vendors that you manage.</td>
</tr>
<tr>
<td><strong>Top Vendors</strong></td>
<td>Displays the ranking and success indicator attribute details of all vendors in your organization.</td>
</tr>
</tbody>
</table>

You can click on a rank or the name of a vendor to view the vendor profile.

**Domain separation and in Vendor Manager Workspace**

Domain separation is supported in Vendor Manager Workspace. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Support level: Standard

- Includes Basic level support.
- Business logic: The service provider (SP) creates or modifies processes per customer. The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The instance owner must configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Sample use case: An admin must be able to make comments required when a record closes for one tenant, but not for another.

For more information on support levels, see Application support for domain separation.

The Vendor Manager Workspace application uses performance analytics to collect data and provides domain separation support.

Request Vendor Manager Workspace Domain Separation

The Domain Support - Domain Extensions Installer plugin (com.glide.domain.msp_extensions.installer) must be activated by ServiceNow personnel. After this plugin has been activated, as an administrator, you can activate the Performance Analytics - Domain Support plugin (com.snc.pa.domain_support) plugin.

The Performance Analytics - Domain Support plugin (com.snc.pa.domain_support) must be activated to enable the features for Vendor Manager Workspace

Related information

- Domain separation for service providers

Configure domain separation for Vendor Manager Workspace

Configure domain separation for Vendor Manager Workspace to collect vendor scores and analyze the data for a specific domain. Configure domains for vendor score metric models.
Before you begin

**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Role required: pa_data_collector or admin

Procedure

1. Configure a domain to collect vendor score performance analytics data for that domain.
   a. Navigate to **Performance Analytics > Data Collector > Domain Configurations**.
   b. Create a domain configuration for Vendor Manager Workspace
      i. Click **New**.
      ii. In the **Name** field, enter a name for the configuration.
      iii. In the **Configuration type** menu, select **Conditions**.
      iv. In the Aggregate options section, select the **Collect children** check box to collect scores from all child domains.
   c. Right-click the form header and click **Save**.
   d. Add the following performance analytics jobs to the related list:
      - VMW Scheduled Data Collection
      - VMW Weight Collection
      - VMW Daily Data Collection
      - VMW Vendor Score Collection
   e. Click **Update**.

For more information on creating or scheduling a data collection job, refer to Create or schedule a data collection job.
Note: The Performance Analytics application:

- Runs the job and collects the score as the Run as user.
- Collects the scores only for the domain in which the logged-in user runs the job. The scores are not visible to vendor admins or vendor managers who are not part of that domain in Vendor Manager Workspace.
- Automatically adds database queries that limit results from the domain to the indicator source queries when the application runs a job for a domain configuration.

2. Configure a domain to assign a vendor score metric model to a domain.
   a. Navigate to Vendor Manager Workspace > Vendor Score Metric Models
   b. Do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Configure the Vendor Score Metric Model list | a. Click the personalize icon.  
b. Move Domain from the Available to the Selected column.  
c. Click OK. |
| Configure a Vendor Score Metric Model form | a. From the list, select a vendor score metric model.  
b. Right-click the context menu icon and select Configure > Form Layout. Make sure you are in the Vendor Manager Workspace section.  
c. Move Domain from the Available to the Selected column.  
d. Click Save. |

Quick start tests for Vendor Manager Workspace

Validate that Vendor Manager Workspace still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.
**Important:** To access the next generation of vendor management and performance application, transition to the Vendor Management Workspace application that is available from the ServiceNow Store. You can now configure Vendor Management Workspace using the Now Experience UI Builder. For more information see, Vendor Management Workspace.

Vendor Manager Workspace quick start tests require activating the Vendor Manager Workspace plugin (com.snc.vlm.vmw) and loading demo data.

### Vendor Manager Workspace - Tests test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>VLM: Create a Vendor</td>
<td>Track problems with the Vendor Manager Workspace plugin after upgrade. Create a new vendor.</td>
<td>New York</td>
</tr>
</tbody>
</table>

**Related information**

Quick start tests

---

**Vendor Performance - Legacy**

The ServiceNow® Vendor Performance application is not available for new instances in the Rome release. Vendor Performance is still available on instances upgraded from a previous release. Vendor Performance will remain accessible to you, but will not be supported by ServiceNow. Upgrading to Rome will not affect your content, enabling your continued use of Vendor Performance in the Rome release.

**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.
Vendor managers can use instance assessment tools to evaluate, score, and rank vendors across a variety of categories, such as compliance, product reliability, and user satisfaction. Scorecards incorporate vendor-related information from Configuration Management Database (CMDB) Database, Asset Management (including procurement), incident and problem records, and any other service management process.

A typical use for Vendor Performance is to monitor enterprise services delivered by vendors to an organization. Examples include telephony and business machine procurement and maintenance.

### Vendor Performance features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Top tasks</th>
</tr>
</thead>
</table>
| **Vendor management**   | Vendor managers create and modify vendor records, vendor types, vendor contacts, and vendor activities, such as demos and trade shows. Vendor managers use the information in scorecards, decision matrixes, and bubble charts to examine and make decisions about vendors. | • Add vendors  
• Add vendor contacts  
• Create vendor activities  
• Add a vendor type |
| **Vendor assessments**  | Use assessments with Vendor Performance to rank the importance of your vendors and to detect possible problem areas, such as contract breaches and incidents.  | • Vendor assessments |
| **Vendor scorecards**   | The printable vendor scorecard contains a comprehensive vendor summary and views of vendor ratings, based on assessment results. Use it to compare current and previous assessment results, or to compare results between vendors. | • Vendor scorecards  
• Scorecard ratings |
| **Vendor bubble charts**| Vendor managers create and use bubble charts to compare the relative standing of vendors. A bubble chart is a dynamically updated graph that plots assessment results for multiple vendors. | • Using vendor bubble charts |
Vendor Performance features (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Top tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top tasks</td>
<td></td>
<td>• Create a vendor bubble chart</td>
</tr>
<tr>
<td>Vendor decision matrixes</td>
<td>A decision matrix plots assessment results for multiple vendors. Vendor managers use them to compare the relative standing of vendors in selected categories.</td>
<td>• Vendor decision matrixes • View a vendor decision matrix</td>
</tr>
</tbody>
</table>

**Vendor ticketing**

Use the vendor ticketing feature to extend vendor performance to establish a relationship between vendors, incidents, and service level agreements (SLAs). Track credits that a vendor owes due to breached service contacts.

An administrator can activate the Vendor Ticketing plugin [ com.snc.vendor_ticket]. It is integrated with Service Portfolio Management, Service Portfolio Management-SLA Commitments, and Task-Outage Relationship. Vendor credits can be issued when SLA commitments are not met and when a vendor issue causes an outage.

**Configuring Vendor Performance**

Plan and define information to use for managing vendors and assessing their performance. Assign vendor managers to manage and maintain vendor contacts, activities, and performance.
**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Vendor records are entered into the Company [core_company] table with the Vendor check box selected. The Vendors module in the Vendor Performance application opens the list of vendor company records, and records appear in the Vendor form view. The Vendor form view is customized to include fields and related lists relevant to managing vendors.

![Company record in Vendor view](image)
Implementing Vendor Performance

Begin the implementation of Vendor Performance by reviewing the base system values and outlining the data in the following areas to collect and enter. When you have completed the planning phase, configure the application in the following order.

Add a vendor type

Vendor types group vendors that offer similar goods and services, and are useful for reporting and comparing vendor performance. Evaluate the vendor types in the base system and add other types that your organization uses.

Before you begin

Role required: vendor_manager or admin

Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

About this task

By default, decision matrixes filter data by vendor type so you can compare similar vendors. A vendor can be classified as more than one vendor type.

Vendor types in the base system

<table>
<thead>
<tr>
<th>Vendor type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications</td>
<td>Vendors that provide enterprise applications, such as enterprise resource planning software.</td>
</tr>
<tr>
<td>Hardware</td>
<td>Vendors that provide hardware products, such as computers or cell phones.</td>
</tr>
<tr>
<td>Services</td>
<td>Vendors that provide services, such as catering or custodial duties.</td>
</tr>
</tbody>
</table>
Vendor types in the base system (continued)

<table>
<thead>
<tr>
<th>Vendor type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software</td>
<td>Vendors that provide software, such as word processing or email applications.</td>
</tr>
</tbody>
</table>

Create other vendor types that are useful for your organization. For example, if you purchase office supplies from several vendors, create an **Office supplies** vendor type.

**Procedure**

1. Navigate to **Vendor Performance > Vendors > Vendor Types**.
2. Click **New**.
3. Enter the **Name**, and then click **Submit**.

**Create a vendor record**

Create vendor records or add information to existing vendor records. Plan and define the information to collect and enter to accomplish the vendor performance goals of the organization.

**Before you begin**

Role required: vendor_manager or admin

**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

**About this task**

Planning includes defining the information to include in vendor records, and then gathering that data. Examples of data to plan and gather include contact and contract information, the manager to assign, and evaluation criteria.
Procedure

1. Navigate to **Vendor Performance > Vendors > Vendors**.

2. Click **New**.

3. Fill in the fields, as appropriate.

### Company vendor form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the vendor.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enter the vendor primary contact phone number.</td>
</tr>
<tr>
<td>Vendor manager</td>
<td>Click the lock icon to add one or more users as vendor managers. <strong>Note:</strong> Select only users who have the vendor_manager role.</td>
</tr>
<tr>
<td>Vendor type</td>
<td>Click the lock icon to add one or more vendor types that apply to the vendor.</td>
</tr>
<tr>
<td>Fax phone</td>
<td>Enter the fax number for the vendor primary contact.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vendor</td>
<td>Leave the check box selected, so this company is recognized in the system as a vendor.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Select the check box if the company is a manufacturer.</td>
</tr>
<tr>
<td>Notes</td>
<td>Provide additional information about the vendor, if known.</td>
</tr>
<tr>
<td>General section or tab</td>
<td></td>
</tr>
<tr>
<td>Address fields</td>
<td>Enter the full address of the location you work with for the vendor, including city, state, and zip code. For example, enter the corporate headquarters or a local branch address.</td>
</tr>
<tr>
<td>Stock symbol</td>
<td>Enter the three or four letter stock symbol for the vendor, if any.</td>
</tr>
<tr>
<td>Latitude and Longitude</td>
<td>Enter geographical coordinates for the vendor location, if known.</td>
</tr>
<tr>
<td>Website</td>
<td>Click the lock icon to enter URL for the vendor website.</td>
</tr>
<tr>
<td>Banner image</td>
<td>Select <strong>Click to add</strong> to upload an image to appear in the vendor scorecard header, usually the company logo. The image should be approximately 60–70 pixels high, and in one of these file formats: .jpg, .png, .bmp, .gif, .jpeg, and .ico.</td>
</tr>
<tr>
<td>Banner text</td>
<td>Enter up to 100 characters of text for the vendor scorecard, such as the company slogan.</td>
</tr>
<tr>
<td>Information section or tab</td>
<td></td>
</tr>
<tr>
<td>Financial information</td>
<td>Enter any useful financial information to use in the management or evaluation of the vendor. As this information fluctuates over time, devise a process for keeping it up to date, if necessary.</td>
</tr>
<tr>
<td>(Profits, Revenue per year, Stock price, Market cap)</td>
<td></td>
</tr>
<tr>
<td>Number of employees</td>
<td>Enter the number of employees for the vendor, if known.</td>
</tr>
<tr>
<td>Publicly traded</td>
<td>Select the check box if the vendor is a publicly traded company.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Rank tier | Select the ranking that represents the organization opinion of the products from this vendor. The Rank tier field appears on the Catalog Item and Product Model forms in the Vendor Catalog Items related list. This ranking helps the catalog administrator decide whether to promote or discontinue using this vendor.
Discount | Enter the discount specified in the contract with the vendor. **Note:** This discount is not the one displayed in the scorecard summary, which is derived from purchase agreement contracts.
Fiscal year | Click the calendar icon to select the date on which the vendor fiscal year ends.

4. Open the form context menu and click **Save**.

The following related links and related lists appear.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Links</td>
<td></td>
</tr>
<tr>
<td>Create Vendor Credit</td>
<td>Click to create a vendor credit for this vendor. This related link is available only when vendor ticketing is active.</td>
</tr>
<tr>
<td>View Matrix</td>
<td>Click to view the default decision matrix. Use decision matrixes to compare vendors in selected categories.</td>
</tr>
<tr>
<td>View Vendor Scorecard</td>
<td>Click to view the scorecard for this vendor. Use scorecards to view various rating summaries for a vendor. This related link is available only if there are assessable records for the vendor.</td>
</tr>
<tr>
<td>Related Lists</td>
<td></td>
</tr>
<tr>
<td>Vendor Contacts</td>
<td>Vendor contacts by role with contact details.</td>
</tr>
<tr>
<td>Vendor Activities</td>
<td>Activities related to the vendor, such as demos and trade shows.</td>
</tr>
<tr>
<td>Product Models</td>
<td>Product models related to the vendor, for vendors that are designated as manufacturers.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assets</td>
<td>Assets purchased from the vendor that are available for assignment to in use.</td>
</tr>
<tr>
<td>Incidents</td>
<td>Incidents related to the vendor that require vendor resolution. Placing an incident in <strong>On Hold</strong> state as <strong>Awaiting Vendor</strong> force entry of the vendor and the ticket open with the vendor.</td>
</tr>
<tr>
<td>Contracts</td>
<td>Contracts established with the vendor and the contract status.</td>
</tr>
<tr>
<td>Vendor Catalog Items</td>
<td>Catalog items from the vendor that are available for users to order.</td>
</tr>
<tr>
<td>Vendor Stakeholders</td>
<td>Stakeholders who evaluate specific categories of performance when assessing this vendor.</td>
</tr>
<tr>
<td>Vendor Categories</td>
<td>Metric categories related to the vendor.</td>
</tr>
<tr>
<td>Service Offerings</td>
<td>Business services offered by this vendor.</td>
</tr>
<tr>
<td>Service Commitment for Vendor</td>
<td>Service commitments negotiated with the vendor. For example, a cloud services vendor commits to 95% uptime.</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>Purchase orders opened with the vendor.</td>
</tr>
</tbody>
</table>

**Example:**

Vendor record
Assign vendor managers and other applicable roles

Vendor managers use the information in scorecards, decision matrixes, and bubble charts to examine and make decisions about vendors. Assessment administrators set up assessments for vendor management. Other roles are used with vendor management. Assign the appropriate roles to users.

Before you begin
Role required to update user roles: user_admin or admin
**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

**About this task**
The following roles apply to the processes and tasks of managing vendors.

**Vendor performance process roles**

<table>
<thead>
<tr>
<th>Role title</th>
<th>Role name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor manager</td>
<td>vendor_manager</td>
<td>Create and modify vendor records, vendor types, vendor contacts, vendor activities, and bubble charts. Vendor managers can also view vendor assessable records.</td>
</tr>
<tr>
<td>IT agent or technician</td>
<td>itil</td>
<td>Perform basic technician operations in the system. Technicians track vendor-related events and can view vendor scorecards and decision matrixes.</td>
</tr>
<tr>
<td>Assessment administrator</td>
<td>assessment_admin</td>
<td>Configure assessments for evaluating vendor performance.</td>
</tr>
<tr>
<td>Administrator</td>
<td>admin</td>
<td>Access and work with all vendor performance and assessment processes. Only administrators can set up vendor assessment schedules.</td>
</tr>
</tbody>
</table>

Assign both the vendor_manager and assessment_admin roles to users as applicable so they can manage both vendors and vendor assessments.
Procedure

1. Prepare a list of the users to assign as vendor managers, and the vendors each is assigned to manage.
2. Identify the users to configure vendor performance assessments.
3. Follow the steps in Assign a role to a user to grant the necessary access.

Create a vendor contact

Create vendor contacts for vendor managers to request assistance, report issues, or resolve problems with their products.

Before you begin

Role required: vendor_manager or admin

Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

About this task

Enter known vendor contacts and include the role they hold in the vendor organization. Vendor managers use the information to contact the most appropriate vendor user based on the issue or need. Creating vendor contacts does not create new users in the system. Vendor contacts are for reference only, and are not used by the system in other processing.

Procedure

1. Navigate to Vendor Performance > Vendors, and select the Vendor Contacts related list.
2. Click New.
3. Fill in the fields, providing as much contact information as is known.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Full name.</td>
</tr>
<tr>
<td>Type</td>
<td>Role the contact holds in the vendor organization. The <strong>Primary</strong> contact is displayed on the vendor scorecard with an email link.</td>
</tr>
<tr>
<td>Primary phone</td>
<td>Main phone number.</td>
</tr>
<tr>
<td>Alternate phone</td>
<td>Secondary phone number.</td>
</tr>
<tr>
<td>Email</td>
<td>Email address.</td>
</tr>
<tr>
<td>Title</td>
<td>Job title within the vendor organization.</td>
</tr>
<tr>
<td>Address</td>
<td>Full street address.</td>
</tr>
<tr>
<td>Fax</td>
<td>Fax number.</td>
</tr>
<tr>
<td>Company</td>
<td>Company for which this person is a contact. It defaults to the company from which you create a vendor contact.</td>
</tr>
</tbody>
</table>

**Example: Vendor contact**

![Vendor Contact](image)

**Create vendor activity**

Vendor managers and other staff use activities to record and track significant events and activities. For example, vendor managers and IT technicians can record details of engagements with the vendor, such as meetings and phone calls. Events, such as the vendor annual conference, are another example.
Before you begin
Role required: vendor_manager or admin

**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

About this task
Vendor activities are not related to vendor assessments.

Procedure
1. Complete one of the following steps to add a vendor activity.

<table>
<thead>
<tr>
<th>To</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add an activity from the vendor record</td>
<td>Click <strong>New</strong> in the Vendor Activities related list.</td>
</tr>
<tr>
<td>Add an activity from a module</td>
<td>Navigate to <strong>Vendor Performance &gt; Vendors &gt; Vendor Activity</strong> and click <strong>New</strong>.</td>
</tr>
</tbody>
</table>

2. Fill in the fields, as appropriate

**Vendor activity form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>Vendor associated with the activity. If you started from the Vendor Activities related list, the vendor name appears by default.</td>
</tr>
<tr>
<td>Activity type</td>
<td>Type of interaction with the vendor.</td>
</tr>
<tr>
<td>Activity date</td>
<td>Date and time of the activity. You can select a past, present, or future date.</td>
</tr>
</tbody>
</table>
### Vendor assessments

Using assessments effectively enhances your ability to evaluate vendor performance. Vendor managers use data collected in vendor assessments to evaluate, score, and rank vendors.

**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard to Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

A vendor scorecard summarizes information, provides visual breakdowns of its performance, and includes assessment results when they are available. Vendor

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User</strong></td>
<td>User who is involved with the activity. The logged-in user appears by default.</td>
</tr>
<tr>
<td><strong>Summary</strong></td>
<td>Information about the activity, such as location, additional parties involved, purpose, and action items.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Example: Vendor activity**

![Vendor Activity]

---

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
decision matrixes, which are graphs of assessment results for multiple vendors, use only assessment results.

Assessments consist of metric types, metric categories, and metrics. Metric categories represent the assessment, and metrics are the questions. Users are assigned to metric categories that they are qualified to evaluate.

The **Vendor** metric type and associated categories and metrics become available when Vendor Performance is activated. An assessable record is inserted automatically for every vendor in your system, and for new vendors that you add.

As illustrated in the diagram, you associate metric categories and category users to the assessable record for the vendor. When the administrator generates vendor assessments, the users can open the assessment from **Self-Service > My Assessments & Surveys**. Only one assessment is generated for each user. It contains sections for each vendor and each metric category.

In this example, there are three vendors. You can see the metric categories for ServiceNow, and the metric for the **Procurement Rating** metric category.
Set up vendor assessments

Assessment administrators define the metric categories and metrics you use to assess vendor performance. They complete the assessable records to prepare for assessment generation.

Before you begin
Verify that there are vendor company records and assign vendor managers to them. Obtain a list of the vendor managers and the vendors they manage, and the areas of expertise for each manager.
Role required: assessment_admin or admin
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

About this task
Complete the following steps to plan and configure vendor assessments, and to prepare them for assignment to vendor managers.

Procedure
1. Review and update the metric categories for the Vendor assessment type.
   a. Navigate to Assessments > Metric Definition > Types, and select Vendor.
   b. Open each record in the Metric Categories related list.
   c. For each record, review the category and metric details, and update them to align with your business requirements.

2. Navigate to Assessments > Assessable Records and filter by Vendor type. Assessable records are listed by vendor name. Vendor records that existed when Vendor Performance was activated are associated with all base system metric categories. Manually add metric categories to vendors that were added after Vendor Performance was activated.

3. For each vendor assessable record, review and update the assigned metric categories.
   a. Open an assessable record and select the Metric Categories related list.
   b. Click Edit, and add or remove metric categories as appropriate.
   c. Click Save, and then repeat this process for all vendor assessable records.

4. For each vendor assessable record, assign category users.
   a. Select the Category users related list and click Edit.
      The Edit Members page that opens lists user (metric category) pairs for each user and metric category associated with the assessable record. For example, for user Beth Anglin you see Beth Anglin (Importance Rating), Beth Anglin (SLA Performance), Beth Anglin (User Satisfaction), and so on.
b. Select the user (metric category) pairs that apply to this vendor.

c. Click Save, and then repeat this process for all vendor assessable records.

What to do next
The system administrator generates assessments from the Vendor Performance > Admin > Generate Assessments module. The users associated with the vendor and metric category open the assessment from Self-Service.

Vendor assessments can be generated also using other assessment generation methods. Establish a process for routinely generating assessments and notifying vendor managers the assessments are ready to complete.

For more information about assessment generation methods, see Assessment administrator tasks. For more information about defining notifications for assigned assessment, see Create an email notification.

Activate Vendor Performance
An administrator can activate the Vendor Performance plugin to access the application.

Before you begin
Role required: admin
**Note:**
The ServiceNow® Vendor Performance application is not available for new instances in the Rome release. Vendor Performance is still available on instances upgraded from a previous release. Vendor Performance will remain accessible to you, but will not be supported by ServiceNow. Upgrading to Rome will not affect your content, enabling your continued use of Vendor Performance in the Rome release.

**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

**Procedure**

1. Navigate to **System Applications > All Available Applications > All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

**Components installed with Vendor Performance**

Several types of components are installed with activation of the Vendor Performance plugin, including tables and user roles.
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Note: The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available with Vendor Performance.

Roles installed

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>vendor_manager</td>
<td>Vendor managers can:</td>
<td>• itil</td>
</tr>
<tr>
<td></td>
<td>• View and customize the Overview module.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View assessable records, vendor scorecards, and decision matrixes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View, create, edit, and delete vendor types, vendors, vendor contacts, and bubble charts.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View vendor assessment records by directly navigating to the tables.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If vendor ticketing is activated, vendor managers can also view, create, edit, and delete vendor credits and vendor tickets.</td>
<td></td>
</tr>
</tbody>
</table>
Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Activity [vm_vendor_activity]</td>
<td>Stores vendor activity records, to help vendor managers track significant events and interactions with vendors.</td>
</tr>
<tr>
<td>Vendor Contact [vm_vendor_contact]</td>
<td>Stores vendor contact records containing information for those individuals who provide useful information or support on behalf of vendors.</td>
</tr>
</tbody>
</table>

Use the Vendor Performance Overview

The Vendor Performance overview is a homepage with widgets that provide vendor statistics.

Before you begin
Role required: vendor_manager or admin

⚠️ Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

About this task
Use the widgets to get information at a glance about vendor performance and comparative statistics. Click an element, such as one bar in a chart, to see a list of the corresponding records. Add and remove content as desired from the Overview page.

Procedure
1. Navigate to Vendor Performance > Overview.
2. Click elements within the reports to obtain more information.

The following reports are included by default:
• Average Score by Vendor
• P1 and P2 Incidents by Vendor (with Vendor Ticketing)
• Open Vendor Tickets (with Vendor Ticketing)
• Vendors in SLA Breach
• Assets by Vendor
• Top 12 Vendors
• CIs by Vendor
• Asset Cost by Vendor
• Residual Value by Vendor

Vendor Performance Overview

Vendor scorecards

The printable vendor scorecard contains a comprehensive vendor summary and views of vendor ratings, based on assessment results. Use it to compare current and previous assessment results, or to compare results between vendors.
To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

The vendor scorecard is a view of the Company form. A scorecard compares current vendor assessment results with previous results, or to the results of other vendors. Vendor scorecards show the most current information because the information is calculated when you generate the scorecard.

The vendor scorecard displays the vendor logo and name, a summary of the vendor’s information from the system, and the vendor ratings.

**View a vendor scorecard**

View a vendor scorecard to get a snapshot of its performance and current assessment results compared with prior results.

**Before you begin**

Role required: vendor_manager or admin

To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.
Procedure

1. Navigate to **Vendor Performance > Vendors > Vendor Scorecard**.
2. Select a vendor to open the scorecard.
   You can also click the **View Vendor Scorecard** related link in a vendor record.

Vendor scorecard details

Each scorecard displays a header to clearly identify the vendor. Review the summary section for financial information and to see how the vendor engages with your organization.

**Important:** To access the next generation vendor management and performance application, transition to **Vendor Management Workspace** in the Rome release. **Vendor Management Workspace** is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to **Vendor Management Workspace** does not migrate performance data from the **Vendor Scorecard** in **Vendor Performance** to **Vendor Management Workspace**. However, **Vendor Management Workspace** continues to use the `core_company` table to identify vendors in your organization. For more information about **Vendor Management Workspace**, including activation, please refer to **Vendor Management Workspace**.

Vendor scorecard header

In the header, click the name to view the vendor company record.
Vendor summary details

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Click a vendor type to display the decision matrix for that type and view a comparison of its ratings with similar vendors. Click a vendor name in the decision matrix to open the scorecard for the vendor. The name of the originating vendor scorecard displays in purple text.</td>
</tr>
<tr>
<td>Rank/Tier</td>
<td>This ranking helps a catalog administrator decide whether to promote or discontinue products from this vendor. Click the rank to open the vendor record for editing.</td>
</tr>
<tr>
<td>Assets</td>
<td>Click the number to view a list of assets that are in use within the organization. In this example, there are 516 assets, such as laptops and phones, in stock or allocated to a user. Missing and retired assets are not listed.</td>
</tr>
<tr>
<td>Incident Breaches</td>
<td>Click the number to view the list of incident SLA breaches associated with this vendor.</td>
</tr>
<tr>
<td>Incidents</td>
<td>Click the number to view the list of open incidents associated with this vendor. The calculation of this value depends on whether vendor ticketing is active.</td>
</tr>
</tbody>
</table>
### Vendor summary links (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Active</td>
<td>• Active: Number of incidents in which this vendor is listed in the incident.</td>
</tr>
<tr>
<td></td>
<td>• Not active: Number of incidents in which this vendor associated with the configuration item.</td>
</tr>
<tr>
<td>Awaiting Vendor</td>
<td>Click the number to view incidents that are on hold pending the receipt of information from the vendor. Vendor ticketing must be active.</td>
</tr>
<tr>
<td>Vendor Managers</td>
<td>Click the name to view details about the manager.</td>
</tr>
<tr>
<td>Contacts</td>
<td>Click the link to view and update the list of contacts for this vendor.</td>
</tr>
<tr>
<td>Asset Value</td>
<td>Click the number to view a list of assets that are in use within the organization. The number represents the total value of the allocated and available assets.</td>
</tr>
<tr>
<td>Spend</td>
<td>Amount of money spent on products and services for this vendor. The calculation of this value depends on whether procurement is active.</td>
</tr>
<tr>
<td></td>
<td>• Active: Calculated from the purchase orders submitted for the current contract with this vendor.</td>
</tr>
<tr>
<td></td>
<td>• Not active: Estimated amount spent based on the cost and installation date from the asset record.</td>
</tr>
<tr>
<td></td>
<td>Spend is calculated for the last year unless Commitment shows that there is a purchase agreement contract. If a contract exists, the calculation uses the date range of the purchase agreement.</td>
</tr>
<tr>
<td>Commitment End Date</td>
<td>View the commitment end date of the purchase order with the earliest date. This information is visible only when there is an active purchase order.</td>
</tr>
<tr>
<td>Commitment</td>
<td>Click the number that represents the total monetary commitment or all active purchase agreements. The list of active purchase agreements opens for your review.</td>
</tr>
<tr>
<td>Remaining Commitment</td>
<td>View the value of the contract that remains after subtracting the Spend from the Commitment. This value appears when</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Vendor summary links (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>procurement is active and there is an active purchase agreement. If Spend is greater than Commitment, this field is 0.</strong></td>
<td></td>
</tr>
<tr>
<td>Availability Breaches</td>
<td>Click the number to review a list of the service availability breaches for service offerings from this vendor. Appears when vendor ticketing is active.</td>
</tr>
<tr>
<td>Stock</td>
<td>Click the stock symbol to see the current share price information on an external web site.</td>
</tr>
<tr>
<td>Revenue Market Cap Employees</td>
<td>View the vendor published yearly revenue, current market cap, and number of employees, if recorded in the vendor record.</td>
</tr>
<tr>
<td>Actual Discount</td>
<td>Click the number to view the vendor purchase orders. The number is calculated from the difference between the total cost of the purchase order line items and the total list price. This link appears only when procurement is active.</td>
</tr>
<tr>
<td>Agreed Discount</td>
<td>Click the number to view active purchase agreements and the associated discounts. This value is a weighted average of all promised discounts from the active purchase agreements. This link appears when procurement is active and a purchase agreement is active.</td>
</tr>
<tr>
<td>Credits</td>
<td>Click the number to view the unused vendor credits caused by breached business service contracts. Appears if vendor ticketing is active.</td>
</tr>
</tbody>
</table>

### Scorecard ratings

Review scorecard ratings to evaluate and compare vendors. Each view provides a different type of information.
**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

### Scorecard rating views

![Scorecard Rating Views](image)

The overall rating column, if it appears, displays a weighted average of categories used to evaluate the vendor. Only categories in which the vendor has been evaluated appear on the scorecard. If the ratings section has no data, either the assessable record or the category results were deleted for that vendor.

Click a category to view the metric category record. Point to a metric category in any view to display a line chart that shows the rating trend for that category.
Averages by vendor type

This view compares the current ratings for a vendor in each metric category with the average, maximum, and minimum values for all vendors of a certain type.

**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

All ratings are from assessments generated over the trailing twelve months (TTM).
Rating variance highlights

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Vendor is below average in this category. The <strong>Diff</strong> column displays a negative number.</td>
</tr>
<tr>
<td>Green</td>
<td>Vendor is above average in this category. The <strong>Diff</strong> column displays a positive number.</td>
</tr>
<tr>
<td>White</td>
<td>Vendor is average in this category. The <strong>Diff</strong> value is 0.0.</td>
</tr>
</tbody>
</table>

Select a vendor type to compare the current vendor against similar vendors, such as **Hardware** or **Software**. By default, all vendors of the specified type are included. A vendor manager can add a filter condition in the vendor assessment metric type record. For example, to compare hardware vendors with a market cap less than $1,000,000.

**Example averages comparison of software vendors**

Averages by categories

The Categories view bar chart compares the average ratings for each metric category in the selected time interval.
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Metric category average ratings over time

Category metrics
This view displays the weighted average results for each metric (question) within a metric category.
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Select a category from the choice list to display the chart. If no metrics are available, the metric results have been deleted. To view metric results, navigate to Assessments > Results > Metric Results and look for records in the Source column that begin with Vendor.

**Metric results by metric category**

Head-to-head vendor comparison

The Head to Head Compare view displays the comparison between the average ratings for the current vendor and a selected vendor. This view is useful when deciding between vendors.
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Select a vendor to compare against the current vendor's trailing twelve month (TTM) average ratings. Diff displays the difference between each vendor's most recent TTM ratings. The scorecard displays three years of average ratings for the comparison record.

### Head-to-head vendor comparison with Acer

<table>
<thead>
<tr>
<th>Category</th>
<th>Current TTM</th>
<th>Acer</th>
<th>Diff</th>
<th>Other TTM</th>
<th>2017</th>
<th>2016</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Rating</td>
<td>6.37</td>
<td>6.59</td>
<td>0.22</td>
<td>5.84</td>
<td>5.64</td>
<td>5.99</td>
</tr>
<tr>
<td>Importance Rating</td>
<td>4.77</td>
<td>2.13</td>
<td>2.63</td>
<td>3.12</td>
<td>3.74</td>
<td>3.74</td>
</tr>
<tr>
<td>Compliance Score</td>
<td>7.32</td>
<td>-0.37</td>
<td>7.70</td>
<td>8.28</td>
<td>8.92</td>
<td>8.92</td>
</tr>
<tr>
<td>User Satisfaction</td>
<td>7.44</td>
<td>1.59</td>
<td>5.85</td>
<td>6.37</td>
<td>6.56</td>
<td>6.56</td>
</tr>
<tr>
<td>Company Alignment</td>
<td>7.79</td>
<td>3.90</td>
<td>3.88</td>
<td>4.09</td>
<td>3.33</td>
<td>3.33</td>
</tr>
<tr>
<td>Procurement Rating</td>
<td>2.61</td>
<td>0.08</td>
<td>2.53</td>
<td>2.74</td>
<td>3.41</td>
<td>3.41</td>
</tr>
<tr>
<td>Catalog Depth</td>
<td>7.24</td>
<td>0.29</td>
<td>6.95</td>
<td>6.89</td>
<td>7.56</td>
<td>7.56</td>
</tr>
<tr>
<td>Technology Rating</td>
<td>7.77</td>
<td>3.01</td>
<td>4.76</td>
<td>5.24</td>
<td>5.95</td>
<td>5.95</td>
</tr>
</tbody>
</table>

**Overall Rating**

The Overall Rating is calculated as:

\[
\frac{\text{sum of normalized values in category result}}{\text{number of assessment groups}}
\]

In the following example, the calculation is

\[
\frac{2.13 + 2.86 + 3.79 + 1.43 + 2.39 + 3.7}{2} = 8.15
\]
Vendor scorecard history

The History view compares the current ratings for each metric category with ratings from the previous three years or four quarters.

**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Ratings that have dropped are highlighted in red and appear as negative numbers. Ratings that have improved appear in green with positive numbers. Arrows beside the **Diff** column indicate the trend of the current assessment against the previous assessment.

### 3 Years History scorecard

To calculate the current ratings, the system averages the ratings from the trailing 12 month (TTM) period. The **Diff** column shows the discrepancy between the current ratings and the previous calendar year ratings.
History for three years

4 Quarters History scorecard

Quarterly assessments compare the average rating for each category in the current quarter against the previous four quarters. The Diff column shows the discrepancy between the current ratings and the previous quarter ratings. The column labels count backward, by quarter, from the current quarter.

For example, if the current quarter is the third quarter of 2018, then the previous quarters appear as 2nd [2018], 1st [2018], 4th [2017], and 3rd [2017]. All four of the previous quarters appear, whether or not there were any ratings for them.
**Overall Rating**
The Overall Rating is calculated as:

\[
\text{Overall Rating} = \frac{\text{sum of normalized values in category result}}{\text{number of assessment groups}}
\]

In the following example, the calculation is

\[
\frac{2.13 + 2.86 + 3.79 + 1.43 + 2.39 + 3.7}{2} = 8.15
\]

### Normalized values

<table>
<thead>
<tr>
<th>Assessment Category Results</th>
<th>Go to</th>
<th>Created</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Vendor decision matrixes</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

A decision matrix plots assessment results for multiple vendors. Vendor managers use them to compare the relative standing of vendors in selected categories.

**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.
Assessment administrators can view and create these dynamically updated graphs, which make it possible to compare assessable records by category. Decision matrixes display data from a trailing twelve month (TTM) period.

For information about the components and calculations of decision matrixes, see Decision matrixes.

View a vendor decision matrix

View a vendor decision matrix to compare relative standings of vendors in selected categories.

Before you begin
Role required: vendor_manager or admin

Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Procedure

1. Navigate to Vendor Performance > Vendors > Vendor Decision Matrix.
2. Click the name of the decision matrix to review.
3. Select the options for the information to evaluate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Select the vendor type, or include all vendors.</td>
</tr>
<tr>
<td>Scale</td>
<td>Select the size of the matrix to view.</td>
</tr>
</tbody>
</table>

The decision matrix includes the following components.
• X- and Y-axes: Represent one or more categories or themes used to evaluate vendors.

• Plotted items: The labeled points represent averages of category scores for vendors. Point to a vendor name to view the vendor rating summary. Click a vendor name to view the vendor scorecard.

Example:

Example decision matrix

Plotted item rating summaries

When you point to a vendor name on a decision matrix, a pop-up rating summary displays the vendor’s average ratings for each axis.
**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

### Rating summary window

If an axis represents one category, the ratings are calculated averages from results for that category. If an axis represents multiple categories, the ratings are calculated averages from results for all of the categories. The rating summary shows:

- Current rating
- Difference between the current rating and the previous year's rating
- Ratings from each of the three previous years, if available
Using vendor bubble charts

Vendor managers create and use bubble charts to compare the relative standing of vendors. A bubble chart is a dynamically updated graph that plots assessment results for multiple vendors.

Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Bubble charts compare the relative standing of vendors in three categories. The X- and Y-axes each represent a different category. Vendors are plotted on the chart as circular markers, or bubbles, which vary in size according to scores for the third category, or Z-axis.

The Vendor Quality bubble chart is added when Vendor Performance is activated. View this bubble chart in Vendor Performance > Vendors > Vendor Bubble Charts. Click the name, and then click the View Bubble Chart related link.
Vendor Quality bubble chart

- Chart axes: Each axis represents a category.
- Bubbles: Each labeled bubble represents an average of category scores for a vendor. Point to a bubble to view a vendor score summary. Click a bubble or bubble label to view the scorecard for the vendor.
- Vendor list: Lists all active vendors. The bubble chart only plots vendors for which there are assessment results.

Vendor score summary

The vendor score summary displays the vendor's average score for each category. The scores are based on data from the last 12 months. Use it to see the breakdown for the rated categories.
Create a vendor bubble chart

Create a bubble chart to customize the comparison of vendor assessment results.

Before you begin
Role required: vendor_manager or admin

Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Procedure
1. Navigate to Vendor Performance > Vendors > Vendor Bubble Charts.
2. Click New.
3. Enter a descriptive name for the comparison the bubble chart represents.
4. Edit the labels and colors of the four quadrants, as desired.
For color fields, enter HTML names or hexadecimal (hex) values. For hex values, the # character is optional, and values are not case-sensitive. For example, all of the following values are valid: LightGray, lightgray, #D3D3D3, d3d3d3.

5. Select the categories and enter the labels for the X-, Y-, and Z-axes. The Z-axis appears in the bubble score summary pop-up window when you point to a vendor bubble in the chart.

6. Optional: Enter a different hex number or HTML name for the quadrant border color. The Default check box is not used with vendor bubble charts.

7. Open the form context menu and click Save.

8. Click View Bubble Chart to open it in a new browser tab or window.

Vendor ticketing

Vendor ticketing helps establish stronger relationships between vendors, incidents, and SLAs. With vendor ticketing, vendor managers monitor how quickly vendors resolve issues with their products and services.
**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

The organization receives credit with the vendor when contractual obligations are not met. Vendor ticketing provides the following features.

- An easy way to pause contract or service commitment SLAs and start vendor-oriented SLAs from an incident.
- A view on the vendor record of all incidents opened against services or products provided by the vendor.
- The ability to start vendor-oriented SLAs from different vendor events from the incident.

Vendor ticketing is activated by the administrator, and activation adds the Vendor Credits module to the Vendor Performance application menu. Vendor managers create and track credits that a vendor owes due to breached service contracts. Various reports can be used to identify missed commitments, criticality of issues by vendor, and so on.

**Roles used with Vendor Ticketing**

The following roles are installed when other applications are activated. Assign the appropriate roles to users involved with creating or tracking vendor tickets.

<table>
<thead>
<tr>
<th>Role Title</th>
<th>Description</th>
<th>Installed with</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor manager</td>
<td>Vendor managers manage and track vendor information, including vendor credits.</td>
<td>Vendor Performance</td>
</tr>
<tr>
<td>vendor_manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IT agent or technician</td>
<td>IT agents and technicians add vendor information to incidents.</td>
<td>Base system</td>
</tr>
<tr>
<td>itil</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Role Title</td>
<td>Description</td>
<td>Installed with</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Portfolio administrator</td>
<td>Portfolio administrators view, create, and delete SLA records, and use all vendor ticketing features included with SLAs.</td>
<td>Service Portfolio Management</td>
</tr>
<tr>
<td>portfolio_admin</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Activate Vendor Ticketing

An administrator can activate the Vendor Ticketing (com.snc.vendor_ticket) plugin.

**Before you begin**

Role required: admin

**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

### Procedure

1. Navigate to **System Applications** > **All Available Applications** > **All**.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

**Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.
Components installed with Vendor Ticketing

One table is installed with activation of the Vendor Ticketing plugin.

**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see Find components installed with an application.

Demo data is available with Vendor Ticketing.

**Table**

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Credit</td>
<td>Stores vendor credit records for vendors that breach service level agreements (SLAs).</td>
</tr>
<tr>
<td>[vndr_credit]</td>
<td></td>
</tr>
</tbody>
</table>

**Using Vendor Ticketing**

Vendor Ticketing integrates with Vendor Performance for contract and service offering service level agreements (SLAs). When an incident is moved to a specific state and a vendor is associated with the configuration item (CI), a service offering is started for the vendor.
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Incident fields record the date and time of specific vendor events, and appear as options for starting an SLA. When an incident requires vendor interaction, an SLA can start when the incident is opened, closed, or resolved. The Vendor Credit module in the Vendor Performance application menu is used to enter and track credit owed by a vendor from breached business service contracts.

SLA stage example
This example uses demonstration data available with vendor ticketing to illustrate how the application can manage SLA stages for different incident states.

Before you begin
Role required: vendor_manager or admin

Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.
Procedure

1. Create a new incident record and select the **MacBook Pro 15”** computer as the affected **Configuration item**.

2. Set the **Impact** and **Urgency** to either **Medium** or **High**.

![Selecting the CI](image)

The system starts a contract SLA for this incident based on the incident priority, not the CI. In this case, the system creates the **Priority 1 resolution (8 hour)** SLA. The system adds the SLA to the **Task SLAs** related list.

![Task SLAs](image)

3. You call Apple, the vendor for this CI, and update the incident state to **On Hold**, and select **Awaiting Vendor** as the **On hold reason**.

   The Vendor form section or tab appears, with **Apple** entered as **Vendor**.

4. Complete the required vendor fields and save the record.
The *Priority 1 resolution (8 hour)* SLA paused when the incident state is *On Hold*.

5. You discover that this CI is part of a service offering called *Apple iCloud* that has an SLA. You change the *Configuration item* value to the service offering and save the record.
The system starts the SLA for the Apple iCloud service offering. The SLA for this service offering is configured to start when the **Vendor open** event occurs in the incident. The event is triggered when the incident is updated by setting the incident state to **On Hold** and adding a vendor.

6. After the vendor responds, update the incident state appropriately.

The SLAs react to each state as follows:

<table>
<thead>
<tr>
<th>States</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Hold</td>
<td>Additional help is needed to resolve this incident. Any of these states marks the service offering SLA as <strong>Complete</strong>. The incident SLA remains <strong>Paused</strong>.</td>
</tr>
<tr>
<td>State</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>The vendor responded with the information needed to work on the incident. This state restarts the paused contract SLA and marks the service offering SLA as <strong>Complete</strong>.</td>
</tr>
<tr>
<td>Resolved or Closed</td>
<td>Work on the incident is complete. Either state marks both SLAs as <strong>Complete</strong>.</td>
</tr>
</tbody>
</table>

**Results**

If the issue is reopened, a new contract SLA is started with the start date and time of the original SLA. The stage is set to **In progress**.

**Configure SLAs for vendor ticketing**

Review the service offering SLAs that are installed with vendor ticketing. Update existing SLAs or add new SLAs to pause contract SLAs and start service offering SLAs automatically for incident state changes.

**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

**Configure a contract SLA**

A contract SLA applies to vendors that offer products, such as laptops or copy machines. The contract with the vendor specifies the duration of the service level agreement (SLA).

**Before you begin**

Role required: sla_admin, sla_manager, or admin
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

About this task
For example, the contract with a vendor specifies that malfunctioning copy machines must be fixed within 48 hours. When an incident is opened for one of the vendor copy machines, the SLA tracks the resolution time.

Procedure
1. Navigate to **Service Level Management > SLA > SLA Definitions**. To review existing SLA definitions, filter the form to show SLAs for the Incident [incident] table.
2. Click **New**.
3. Select **Contract SLA**.
4. Complete the form based on the details of the contract with the vendor, as illustrated in the following example.

Example
A contract SLA is configured to start when a priority 1 incident is opened in Paris. The SLA is configured to pause when the user working on the incident is on hold for the **On hold reason** set to **Awaiting Vendor**.
Add vendor information to an incident

Vendor information is added to an incident when the agent or technician sets the incident status to **On Hold** for the reason **Awaiting Vendor**.

**Before you begin**
Role required: itil or admin
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

About this task

The Vendor form section appears, and the agent must select the vendor enter the ticket number opened with the vendor before saving the incident.

When the record is saved, a timestamp is inserted into the Vendor Open field. Other vendor time fields are updated as the vendor ticket is resolved. These fields do not appear in the default Incident view. Agents, technicians, and vendor managers use the Metrics view of the incident form to review the state of incidents associated with the vendor.
When the incident moves to closed or resolved state, those fields are automatically updated with the timestamp.

**Procedure**

1. When you work on an incident that cannot be resolved until the vendor takes action, select **Awaiting Vendor** in the **State** field. This state pauses any SLAs affected by this incident that have **Awaiting Vendor** defined as a pause condition. This action ensures that vendor delays do not impact SLA performance.

2. Complete the information in the Vendor form section that appears.

   **Vendor**
   
   If necessary, select the vendor associated with the incident. The vendor appears automatically when the incident is associated with a configuration item manufactured by a company that is also a vendor.

   **Vendor ticket**
   
   Enter a ticket or incident number provided by the vendor. This ticket is the vendor identification number for the issue and is for reference only.
Vendor point of contact

Enter contact information for the vendor. For example, enter the name of a customer service representative, a phone number, or an email address.

3. In the Notes section or tab, add comments or work notes to document the action the vendor agreed to take to resolve the issue.

4. Save, update, or submit the record.

5. After the vendor resolves the issue, select a state of Active to restart the SLA.

What to do next

When the vendor issue is resolved, change the state to In Progress or Resolved, as appropriate. Setting the state to In Progress restarts the SLA.

View an incident from a vendor record

A vendor manager views incidents for the vendor products from the vendor form. The manager uses the list to get a snapshot of how the vendor products are performing.

Before you begin

Role required: vendor_manager or admin

⚠️ Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Procedure

1. Navigate to Vendor Performance > Vendors > Vendors.
2. Select a vendor, such as Microsoft, from the list.
3. Select the Incidents related list.
Sort and group the listed incidents in a meaningful way for evaluation. For example, sort by **Category** or group by the **State**. Click the number of an incident to see its details.

**Vendor-related incidents**

![Vendor-related incidents](image)

**Note:** The related list is visible only if there is at least one incident associated with the vendor.

**Vendor credit**

Vendor credit offers a method for manually tracking the credit that a vendor owes an organization because of a breached business service contract.

**Important:** To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Monetary penalties for contract breaches are tracked as service commitment. The information from the service commitment for the vendor service offering is used to calculate the vendor credit due for a breach. Manual vendor credits are entered by vendor managers using the Vendor Credit module. The **Credits** field in a vendor scorecard provides access to unused vendor credit records.
Create a vendor credit manually

Vendor managers can enter vendor credits manually when they cannot be processed automatically.

Before you begin
Role required: vendor_manager or admin

Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Procedure

1. Navigate to Vendor Performance > Vendors > Vendor Credits.
2. Click New.
3. Select the Vendor, and then fill in the other fields, as appropriate.

Note: The selected vendor determines the options available for other fields. If you change the vendor, all field values are cleared.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>System generated reference number for this credit record.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Name of the vendor.</td>
</tr>
<tr>
<td>Related incident</td>
<td>Number of any incidents related to these vendor products.</td>
</tr>
<tr>
<td>Service offering</td>
<td>Service offering related to this vendor.</td>
</tr>
<tr>
<td>Service commitment</td>
<td>Specific service commitment that affects this vendor credit.</td>
</tr>
<tr>
<td>Service availability</td>
<td>Business service availability commitment that affects this vendor credit.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Related outage</td>
<td>Actual outage that created the vendor credit. The value in this field is from the <strong>Short description</strong> in the outage record.</td>
</tr>
<tr>
<td>Vendor contract</td>
<td>Contract for this vendor, if any. Choose a contract for the specified vendor. These contracts can be in any state.</td>
</tr>
<tr>
<td>Reference number</td>
<td>Any reference that pertains to this credit, for example, a confirmation number from the vendor or the name of a contact.</td>
</tr>
<tr>
<td>Breach penalty time</td>
<td>Duration of the breach. This value is the elapsed time of the credit-generating event and is inherited from the <strong>Service commitment</strong> selected.</td>
</tr>
<tr>
<td>Breach penalty amount</td>
<td>Total amount of credit due from this event, inherited from the <strong>Service commitment</strong> selected.</td>
</tr>
<tr>
<td>Per</td>
<td>Unit of time used to calculate the breach penalty amount, inherited from the <strong>Service commitment</strong> selected.</td>
</tr>
<tr>
<td>Credit used</td>
<td>Check box indicating that credit from this vendor has been recovered.</td>
</tr>
<tr>
<td>Notes</td>
<td>Notes pertaining to this credit record, for example, to keep track of recovered credit.</td>
</tr>
</tbody>
</table>

**Create a vendor credit from specific records**

Several types of records that track issues with vendor products have a Create **Vendor Credit** related link. Creating a vendor credit when the need is identified saves time and prevents credits from being missed.

**Before you begin**

Role required: itil, vendor_manager, or admin
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

About this task

The Create Vendor Credit related link appears in records when the record references a vendor. These procedures contain instructions for exposing the link when it is hidden.

Procedure

Click the Create Vendor Credit related link in the following types of records:

• Outage
• Incident
• Service availability
• Company

When a vendor credit record is created from one of these sources, it automatically populates the form with related data, such as vendor name, contract, and service offering. The Breach penalty amount, Per, and Breach penalty time fields are populated from the service commitment record.

Create vendor credit from an outage

Create vendor credit when an outage is related to a vendor or its products.

Before you begin

Role required: itil or admin
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Procedure

1. Open a task outage record.

2. If the Create Vendor Credit related link does not appear on the Outage form, define a vendor in the referenced table.
   a. Click the Configuration Item field reference icon. The Service Offering form opens.
   b. Select a vendor.
   c. Click Update. The Outage form reopens with the related link available.

3. In the Outage form, click the Create Vendor Credit related link. The Vendor, Service offering, Vendor contract, and Related outage fields are populated.

Create vendor credit from an incident

Create vendor credits from incidents opened against business services. Other configuration item types do not have service offerings and cannot issue vendor credits.

Before you begin
Role required: itil or admin
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Procedure
1. If the Create Vendor Credit related link does not appear on the Incident form, define a vendor for the incident.

   a. Select On Hold in the State field, and Awaiting Vendor in the On hold reason field. The Vendor form section appears.

   b. Select the vendor and enter the vendor ticket reference number.

   c. Click Update. The related link appears on the Incident form.

2. When the issue results in a vendor credit, open the incident and click the Create Vendor Credit related link. The Vendor, Related incident, Service offering, and Vendor contract fields are populated.

Create vendor credit from Service Availability
You can create vendor credit from the Service Availability form.

Before you begin
Role required: portfolio_admin or admin
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Procedure

1. If the Create Vendor Credit related link does not appear on the Service Availability form, define a vendor in the referenced service offering record.
   a. In the Service Availability form, click the Service Offering field reference icon.
      The Service Offering form opens
   b. Select a vendor.
   c. Click Update.
      The Service Availability form reopens with the related link available.

2. In the Service Availability record, click the Create Vendor Credit related link.
   The Vendor, Service offering, and Service commitment fields are populated.

Create vendor credit from the vendor
Vendor managers can create a vendor credit when view the vendor company details.

Before you begin
Role required: vendor_manager or admin
Important: To access the next generation vendor management and performance application, transition to Vendor Management Workspace in the Rome release. Vendor Management Workspace is included in the ITSM Pro subscription package. Manage and monitor your vendor performance and vendor-related information through a graphically intuitive user interface. Transitioning to Vendor Management Workspace does not migrate performance data from the Vendor Scorecard in Vendor Performance to Vendor Management Workspace. However, Vendor Management Workspace continues to use the core_company table to identify vendors in your organization. For more information about Vendor Management Workspace, including activation, please refer to Vendor Management Workspace.

Procedure

1. Navigate to **Vendor Performance** > **Vendors** > **Vendors**.

2. Open the vendor record to issue a credit.

3. Click the **Create Vendor Credit** related link.
   
   The **Vendor** field is populated.

Domain separation and Vendor Performance

Domain separation is unsupported in Vendor Performance. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.
Support level: No support

- The domain field may exist on data tables but there is no business logic to manage the data.
- This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.

Related information
  - Domain separation for service providers

**ITSM Predictive Intelligence Workbench**

The ServiceNow® ITSM Predictive Intelligence Workbench application provides prebuilt use case templates and guides you through your machine learning implementation to create intelligent ITSM business processes.

**What is ITSM Predictive Intelligence Workbench?**

The ITSM Predictive Intelligence Workbench application is built to help you get started using machine learning to quickly solve and expedite your IT incidents. The workbench includes prebuilt use case templates that systematically guide you through the process of creating and training new predictive models, evaluating and testing them, and finally adding them to your business process to add value to your IT organization.

Guided machine learning provides next steps and helps you make informed decisions while you increase your knowledge of machine learning.

Once you train your use cases, they are usable immediately. Using Performance Analytics capabilities, you can monitor your successfully implemented use cases to ensure the best model efficacy. Define thresholds and monitor whether your models are performing as expected or if they are under-performing with the Predictive Intelligence for Incidents dashboard.

The ITSM Predictive Intelligence Workbench application depends on activation of the Predictive Intelligence application, which is available with the ITSM Pro SKU.

**Who uses ITSM Predictive Intelligence Workbench?**

Business process architects use Predictive Intelligence Workbench functionality to get started with machine learning-based use cases. You can determine your business value, monitor your models, and view related statistics using the Predictive Intelligence Workbench dashboard.
If you are a process architect or owner, or someone who is championing machine learning for your IT organization, ITSM Predictive Intelligence Workbench can help you streamline your incident case load. Trained predictive models can resolve your incidents through past similar resolutions or by recommending relevant knowledge base articles to help expedite your incident investigation and resolution processes. This frees up valuable time for IT professionals who often need to spend time on more complex and challenging issues.

No prior knowledge or experience with artificial intelligence or machine learning is required when you use ITSM Predictive Intelligence Workbench. The application includes templates with prebuilt guidance to assist you in creating, training, evaluating, testing, and producing, your unique predictive models. You can also link to your knowledge base articles to support your IT incident case load, as well as access the many features of the Predictive Intelligence platform application.

How do you benefit from ITSM Predictive Intelligence Workbench?
Cutting-edge artificial intelligence and machine learning technologies are widely adopted throughout many industries. The ITSM Predictive Intelligence Workbench application provides you with the machine learning tools you need to quickly and effectively resolve your IT incident tasks and improve your IT organization. The process of creating and implementing your predictive models can result in valuable business analysis and operations optimization.

What is the ITSM Predictive Intelligence Workbench user experience like?

**Simple, streamlined model creation, evaluation, testing, and integration**

Evaluate and test different model versions. When a retrained model version doesn’t perform as well as the previous version, you can tune it, view the winning model version, and mark it as active.

View your trained models on the Use case guided steps page. When a model is integrated, the integration data is indicated parenthetically next to the model name. You can also see the Created on and Trained on dates and the Active version number for the model. Integrated models appear at the top of the list.

Identify the model with the highest net automation score as the green highlighted winning model. When two models have the same net automation score, the most recently created model is highlighted in green.
Use the faceted filters feature on the **Use cases - All Created Use Cases** page to filter by **Domain**, model **State**, and **Model training status**.

Use the faceted filters feature on the **Use cases - Create new from Template** page to filter by **Domain**, **Setup Help**, and **Business Value**.

Quickly find use case templates or use cases with a search filter added to the **Use cases - All Created Use Cases** and **Use cases - Create new from Template** pages.

Identify **Integrated** and **In progress** models by unique icons and easily recognize when a model training has failed or a model is underperforming with icons and flags on the **Use cases - All page**.

Edit model names and short descriptions as needed.

Deactivate a previous model version or select a previous model version to activate.

Know whether you have the necessary required data before starting the process of creating a use case. A message notifies you if data is insufficient.

Download a .CSV file of your model batch test or go to the test phase to view the results.

**Dot-walking for input fields**

Access fields on related tables from a form, list, or script.

**Right to left language support**

For users who read from right to left, this language support is added.

**ITSM Predictive Intelligence Workbench administration**

Administrators can activate the necessary plugins for ITSM Predictive Intelligence Workbench. Users with the piwb_admin role can configure the application to meet specific requirements.

Predictive Intelligence Workbench admins can perform the following tasks:

- Configure Predictive Intelligence Workbench property settings, such as the minimum number of predictions for evaluating use cases that underperform and the minimum percentage of net automation to show a pretrained model.
- Create a Predictive Intelligence Workbench user group and assign users necessary roles to move through the model implementation process.
- Configure notifications to alert Predictive Intelligence Workbench users via email for the following events:
○ When a new model is trained and ready for evaluation.
○ When batch testing is initiated and when test results are available.

**Activate ITSM Predictive Intelligence Workbench**

ITSM Predictive Intelligence Workbench is available with activation of the core Predictive Intelligence Workbench (com.sn_piwb_ml) plugin and the Predictive Intelligence Workbench ITSM content (com.sn_piwb_itsm_content) plugin.

**Before you begin**
Role required: admin

**About this task**
The ITSM Predictive Intelligence Workbench-related plugins require activation of the Predictive Intelligence application. Predictive Intelligence is available with activation of the Predictive Intelligence (com.glide.platform_ml) plugin and the Predictive Intelligence Reports (com.glide.platform_ml_pa) plugin, which require an ITSM Pro package subscription. For more details, refer to [Activate Predictive Intelligence](#).

**Procedure**
1. Navigate to **System Applications** > **All Available Applications** > **All**.
2. Find the plugin using the filter criteria and search bar.
   - You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see [Request a plugin](#).
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.
   - **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.

**Components installed with ITSM Predictive Intelligence Workbench**
Several roles are installed with activation of the Predictive Intelligence Workbench plugin.

- **Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see [Find components installed with an application](#).
Two plugins are available to obtain feature ITSM Predictive Intelligence Workbench functionality.

- Predictive Intelligence Workbench (com.sn_piwb_ml): Provides a common framework for creating and managing use cases.

  **Note:** Requires activation of Predictive Intelligence and Predictive Intelligence Reports plugins, which are available with an ITSM Pro subscription.

- Predictive Intelligence Workbench ITSM content (com.sn_piwb_itsm_content): Enables access to ITSM-specific content that provides implementation guidance for use cases created through Predictive Intelligence Workbench. Also, with this plugin you can access the Predictive Intelligence for Incidents dashboard to communicate value across multiple applications within IT Service Management.

  **Note:** Requires activation of Predictive Intelligence Workbench, Performance Analytics - Content Pack - ITSM Dashboards, and Incident plugins.

### Predictive Intelligence Workbench

#### Roles installed with Predictive Intelligence Workbench

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Predictive Intelligence Workbench admin [piwb_admin] | Predictive Intelligence Workbench administrator. Configures the Predictive Intelligence Workbench property settings. Can create and manage use cases. | • piwb_manager  
• ml_admin |
| Predictive Intelligence Workbench manager [piwb_manager] | Typically a business process architect. Can create and manage use cases. Configures the Predictive Intelligence Workbench property settings. | • ml_admin  
• piwb_viewer  
• pa_admin |
Roles installed with Predictive Intelligence Workbench (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitors the <strong>Predictive Intelligence for Incidents</strong> dashboard.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Predictive Intelligence Workbench viewer [piwb_viewer]</td>
<td>Can view the <strong>Predictive Intelligence for Incidents</strong> dashboard.</td>
<td>• pa_viewer • ml_report_user</td>
</tr>
</tbody>
</table>

**Note:** All new records are created and updated through the Predictive Intelligence Workbench application. Only users with the maint role can update the base system tables.

Tables installed with ITSM Predictive Intelligence Workbench

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use case Prediction Run [piwb_prediction_run]</td>
<td>Used to define the test prediction type for a use case, whether it is a single or batch test.</td>
</tr>
<tr>
<td>Setup Assistant Tracker [piwb_usecase_sa_tracker]</td>
<td>Used to track the status of the guided path steps (Stage or Task).</td>
</tr>
<tr>
<td>PIWB Setup Assistant Stage Task [piwb_sa_stage_task]</td>
<td>Used to store the tasks for each stage of setup assistant plan. Extends the PIWB Setup Assistant Base Task [piwb_sa_task_base] table.</td>
</tr>
<tr>
<td>PIWB Setup Assistant Plan [piwb_sa_plan]</td>
<td>Used to define the Setup Assistant Plan (Guided Path) for each type of use case.</td>
</tr>
<tr>
<td>PIWB Setup Assistant Base Task [piwb_sa_task_base]</td>
<td>Used to create a new Setup Assistant Base Task record and to make the task active.</td>
</tr>
<tr>
<td>PIWB Use Case [piwb_usecase]</td>
<td>Used to create a new use case per prebuilt template (piwb_admin and piwb_manager can create, update,</td>
</tr>
</tbody>
</table>
### Tables installed with ITSM Predictive Intelligence Workbench (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI Solution Model [piwb_model]</td>
<td>Used to create a <strong>Predictive Intelligence</strong> solution model and to make the model active (piwb_admin and piwb_manager can create, update, and delete; piwb_viewer can only view).</td>
</tr>
<tr>
<td>PIWB Setup Assistant Stage [piwb_sa_stage]</td>
<td>Extends the PIWB Setup Assistant Base Task [piwb_sa_task_base] table.</td>
</tr>
<tr>
<td>Usecase Prediction Result [piwb_prediction_result]</td>
<td>Used to define a use case prediction result based on the Prediction Run and Model (piwb_admin and piwb_manager can create, update, and delete; piwb_viewer can only view).</td>
</tr>
<tr>
<td>PI Solution Comment [piwb_model_comment]</td>
<td>Used to define a comment on a <strong>Predictive Intelligence</strong> solution for a given class (piwb_admin and piwb_manager can create, update, and delete; piwb_viewer can only view).</td>
</tr>
</tbody>
</table>

### Domain separation and Predictive Intelligence Workbench

Domain separation is supported in the Predictive Intelligence Workbench application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.
Support level: Standard

- Includes Basic level support.
- Business logic: Processes can be created or modified per customer by the service provider (SP). The use cases reflect proper use of the application by multiple SP customers in a single instance.
- The owner of the instance needs to be able to configure the minimum viable product (MVP) business logic and data parameters per tenant as expected for the specific application.

Overview

Predictive Intelligence Workbench enables the creation of machine learning models using historic datasets. A machine learning model can be configured in Predictive Intelligence Workbench per domain, which ensures that the data used by the solution is domain-specific data. After a model is trained for a domain, the model calls for a prediction to be made for resolution, depending on what that domain belongs to. For example, the model predicts an incident or case.

How domain separation works in Predictive Intelligence Workbench

An instance owner can train a machine learning model for each domain by creating a model definition for each domain and training those models. In this way each model uses data specific to the corresponding domain.

- Data can be domain separated
- Domain column is present for base system application tables
- Domain-specific configuration is managed by instance owner
- Tenant domains can manage their own application data

Related information

- Domain separation for service providers

Configure ITSM Predictive Intelligence Workbench settings

View the default Predictive Intelligence Workbench property settings and configure them to meet your business process needs.

Before you begin
Role required: piwb_admin or piwb_manager

About this task
Predictive Intelligence Workbench includes several configurable property settings that enable you to define how you want to use and experience the
application. For example, decide how many rows you want for batch testing or the minimum percentage of net automation to show that a model is auto trained. Default settings are configured in the base-system application.

**Procedure**

1. **Navigate to Predictive Intelligence Workbench > Administration > Settings.** The Predictive Intelligence Workbench Settings page appears with default setting configurations.

<table>
<thead>
<tr>
<th>Predictive Intelligence Workbench Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Predictive Intelligence Workbench</strong></td>
</tr>
<tr>
<td>The minimum # of predictions for evaluating use case underperformance</td>
</tr>
<tr>
<td>The % difference between estimated and actual net automation for an underperforming use case</td>
</tr>
<tr>
<td>The # of recommended input fields to display that best correlate to the output field</td>
</tr>
<tr>
<td>The minimum % of net automation to show auto-trained model</td>
</tr>
<tr>
<td>Maximum # of rows for batch testing</td>
</tr>
</tbody>
</table>

2. **Modify the property settings, if desired, or work within the default parameters.**

3. **Click Save if you make any changes.**

**ITSM Predictive Intelligence Workbench notifications**

Email notifications are added with Predictive Intelligence Workbench.

Predictive Intelligence Workbench includes several email notifications that alert users throughout the use case model implementation.

Predictive Intelligence process architects creating and training use case models receive an email notification when a use case model is successfully trained and when batch testing has finished successfully. If a use case fails training or if batch testing produces errors, users will receive notifications about these scenarios, as well.
Users can click a link in the email notification to view a newly trained use case or batch test results. They can also download the test results, if desired. Users can receive the following notifications:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use case model training successful</td>
<td>Sends an email to a specified user group when a use case model is successfully trained. S Ends an email to a specified user group when batch testing is complete.</td>
</tr>
<tr>
<td>Batch test run complete</td>
<td>Sends an email to a specified user group when batch testing is complete.</td>
</tr>
<tr>
<td>Use case Model training failed</td>
<td>Sends an email to a specified user group when a use case model training has failed.</td>
</tr>
</tbody>
</table>

Create an ITSM Predictive Intelligence Workbench user group and add users or roles to ensure Predictive Intelligence process architects are notified during the use case model implementation process. Refer to Create an ITSM Predictive Intelligence Workbench user group.

For more details about email notifications for Predictive Intelligence Workbench, refer to Preview email notification.

**Create an ITSM Predictive Intelligence Workbench user group**

Create an ITSM Predictive Intelligence Workbench user group and add users or roles to the group to receive email notifications when the use case model training and testing phase is complete.

**Before you begin**

Role required: admin

**About this task**

Create an ITSM Predictive Intelligence Workbench user group and add either users or roles to the group so that email notifications are sent to alert users throughout the use case model training and testing phases.

Users can receive notifications for the following Predictive Intelligence Workbench events:
• Use case training is successful
• Batch testing is complete
• Use case training has failed

Procedure
To create an ITSM Predictive Intelligence Workbench user group and add users, refer to Create a user group.
For more information about the email notifications provided with this application, refer to ITSM Predictive Intelligence Workbench notifications.

Predictive Intelligence Workbench Migration Utility
Predictive Intelligence Workbench managers can easily migrate existing compatible Predictive Intelligence solution definitions into Predictive Intelligence Workbench. The Migration Utility enables a simplified configuration and expanded reporting functions.

The Predictive Intelligence Workbench Migration Utility enables existing Predictive Intelligence users with the piwb_manager role to convert a solution definition to a use case. The active solution is then converted into a model associated with the new use case.

A Related Link on the Predictive Intelligence Classification Definition form enables users to migrate a solution definition from Predictive Intelligence directly into Predictive Intelligence Workbench.

The Related Link only appears on the form when there is an active solution definition and that solution is not associated with a Predictive Intelligence Workbench use case.

Users can also access the Migration Utility as a module in the Predictive Intelligence Workbench application.
Clicking the **Migrate this solution to PI Workbench** Related Link or clicking the **Migration Utility** module, takes you to the Migration Utility detail page for the solution definition.

![Migration Utility](image)

Clicking **Migrate** from the Migration Utility details page alerts you that a new use case will be created in Predictive Intelligence Workbench. You can then follow guided setup to integrate a new model.

![Migrate Alert](image)

Clicking **Migrate** from this pop-up alert finalizes the migration.
Migration to Predictive Intelligence Workbench is complete!

You can find your previous active solution definition as a model in this use case. You can easily integrate the newly created model through the guided integration step.

Ensure that any integration from your previous solution has been removed. Click here to go to documentation regarding integration.

Migration is complete

- Use case created
- Model created
- Data added to dashboards

Predictive Intelligence Workbench pretrained use cases

The pretrain functionality mechanism for use cases enables and trains the machine learning solution definition when you activate the Predictive Intelligence Workbench application.

When a pretrained machine learning solution exists in the system, Predictive Intelligence Workbench highlights the use case templates with the Pretrained flag.

The Pretrained flag for use case templates displays when the following criteria are met.

- The Predictive Intelligence Workbench $\text{piwb.instance_eligible_auto_train}$ system property for pretraining is enabled (true) on the your instance. This property is disabled by default. Requires the piwb_admin role to enable.

- The instance has to be one of the following types:
  - ded-prod
  - shared-prod
The associated machine learning solution is active and ready for deployment.

- The use case template does not contain an existing pretrained use case.
- The machine learning solution net automation is greater than the threshold value.

**Note:** The default base-system threshold value is 30. You can configure this value via the Predictive Intelligence Workbench piwb.auto_train_threshold system property for. Requires the piwb_admin role to modify the default value.

- The machine learning solution is a pretrained base-system solution with an associated record for its definition in the ML Auto Train Solution [ml_autotrain_solution] table.

### Predictive Intelligence Workbench integration and customization

Predictive Intelligence Workbench uses scripted extension points to integrate a trained use case model for prediction.

#### Scripted extension points for trained use case integration implementation

The scripted extension point is PIWBPredictionProcessor and PIWBPredictionProcessor_incident is the default implementation of PIWBPredictionProcessor for the Incident [incident] table. PIWBPredictionProcessor_incident runs all the predictions for integrated incident-related use case models.

#### Customizing default implementation

If you want to customize the default implementation, you can modify the PIWBPredictionProcessor_incident script. The business rule PIWB Prediction – Incident on the Incident table calls the PIWBPredictionProcessor_incident script for predictions. For details about scripted extension points, refer to Using extension points to extend application functionality.

### ITSM Predictive Intelligence Workbench implementation

Use machine learning to optimize your business processes. You can train and implement ITSM Predictive Intelligence Workbench use case models to augment your existing application workflows.
Explore use case templates

Users with the piwb_admin or piwb_manager role can explore the prebuilt use case templates and create predictive machine learning models. To create a machine learning model, you first select a prebuilt use case template. Some of the prebuilt templates are guided and display the Guided Setup flag. These templates include a comprehensive setup process to help ease you through implementation. Non-guided templates display the Classic Setup flag.

Templates with available pretrained models accelerate your setup process, by providing a pre-generated model based on your data. When a template indicates Pretrained, this means you can go directly to the evaluation phase of the use case setup. If the pretrained model is acceptable, you can directly integrate it with your business processes. Otherwise, you can tune this model or create another model. You may change the name and description of the use case later. Pretrained models display the estimated percentage of your correctly predicted incidents.

Templates with available pretrained models also display the estimated percentage of the correctly predicted incidents. If the pretrained model is acceptable, you can directly integrate it with your business processes. Otherwise, you can tune this model or create another model. You may change the name and description of the use case later. Pretrained models display the estimated percentage of your correctly predicted incidents.

Non-guided, Classic Setup templates provide links to relevant Predictive Intelligence Workbench product documentation or link to the ServiceNow platform Predictive Intelligence application with the Take me there button.
Use case creation phases

Creating a predictive machine learning model involves several phases. After you create and train your model you need to evaluate and tune it, test its prediction results, and then integrate it with your business process. Use case model creation phases include:

- Create and train models: Define parameters to create a model that you'll train based on your unique data. It is common to create multiple models in this phase. You'll tune and refine your models by defining the right combination of coverage and precision to use.

- Test your models: Get prediction results from your models to decide which one is best to integrate with your business process. To see if a model returns a correct result, you can use either the single or batch testing process.

- Integrate the best model: Deploy the best model into your business process. After you determine which model returns the best, correct result, integrate it into production.

**Note:** For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

Predict Assignment Group for incoming incidents

Use this guided template to auto-assign incoming incidents to the correct assignment group to reduce your incident resolution times.
Before you begin
Role required: piwb_manager or piwb_viewer

About this task
This template walks you through customizing a use case model to predict the correct assignment group for your incoming incidents. When the use case template shows the label Pretrained, you can bypass several implementation steps and are automatically taken to evaluate and tune your models when you click Start. Otherwise, you will begin by creating a machine learning model.

Procedure
1. Navigate to Predictive Intelligence Workbench > Use Cases > Create New from Template.
2. Select the Predict Assignment Group for incoming incidents guided template.

The Use case - Predict Assignment Group for incoming incidents pop-up form opens.

3. Provide a unique name for your use case in the Use case name field.

Note: The use case will contain multiple models that you create. You can use the same name as the template, if desired.
4. Although not mandatory, it's beneficial to provide unique details about the use case in the **Short description** field.

**Note:** Typically the short description provides details about what the goal of the use case is or your purposes for creating the use case.

5. Provide a name for the model in the **Model name** field.

**Note:** Models are trained based on default parameters. The name of the model should reflect its purpose, for example, "Model for past years data".

6. Review the base system parameters set to help train the model in the **Input fields** and **Number of records** fields. To modify this data, click **Advanced Setup**.

**Note:** By clicking **Advanced Setup** you can change the processing language, review and modify filters used to train the model. You can customize the filters to best represent your business data or add new criteria by clicking **New Criteria**. Review and modify input fields used to generate predictions. Customize the fields to best represent your business data by moving fields between the **Available** and **Selected** slush buckets. Save any changes you make.

7. Click **Start**.
   A pop-up message lets you know your model is created and that training is underway.

**Note:** To start implementation, you must provide at least a use case name and model name.
8. Click **Done**.

The use case page displays the name and description of the use case you created. On this page, you can see all the guided implementation phases you will work through to create and implement your use case model.

9. Click **View Progress** below the header on the use case setup page to monitor a current training process.
1. When training is complete, you will receive an email notification letting you know your use case model training was successful. For more information about use case model notifications, refer to ITSM Predictive Intelligence Workbench notifications.

10. Click the model name under Trained Models on the use case setup page to view associated data about the trained model. The Model details page opens.

11. In the Retraining Schedule field of the Models detail page you can change the definition, if desired. The default value is Every 30 days, but you can retrain as often as once to every 180 days.

12. If you made schedule retraining changes to the use case model, click either Update or Update and retrain, to retrain again.

13. To tune a model, click Tune Values on the use case setup page under Trained Models.

   The tuning page for the use case opens displaying the associated model name with the following data: Distribution (%), Net Automation, Precision (%), Coverage (%), and any comments. View the evaluation data used for the use case and associated model.

   Note: You can only tune values when the model is trained.
14. If desired, tune and refine the model by defining the right combination of coverage and precision to use. Double click in the **Precision (%)** and **Coverage (%)** fields to change values. Changes are automatically saved.

15. If desired, click **Create Another** to create another model associated with your use case in the **Create and train models** section of the setup page. Repeat the process to create and train the model.

16. In the **Test your models** section of the use case page, click **Start** to begin the testing process. The **Testing your models** page opens.

17. Under **Select models to test**, decide if there are other use case models available that you want to test. If so, move them to the **Selected** slush bucket.

18. Under **Define testing parameters**, decide if you want to test one use case model. If so, select the **Single test** test type. **Single test** is the default.

   **Note:** Select **Batch test** when you want to test more than one use case model.

19. Determine the number of top results you want to display.


21. Click **Run Test**.

22. View the test results data for the use case model under **View test results**.
23. If you are ready to integrate your use case model into your business processes, return to the use case set up page and click **Start** in the **Integrate a model** section. The **Select a model to integrate** page opens.

24. In the **Select a Model** drop-down menu, select the model you want to integrate. The **Select a model to integrate** page opens.
Note: You can change the retraining schedule via this page if you desire. Use the Retraining Schedule drop down selection field to change from the default 30 day value.

25. Click Integrate.

26. Click Integrate again when the pop-up asks you if you are sure you want to perform this action.
You have integrated a use case model into your business process.

Note: For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

Predict Category for incoming incidents

Use this guided template to auto-assign incoming incidents to the correct category to reduce your incident resolution times.

Before you begin
Role required: piwb_manager or piwb_viewer

About this task
This template walks you through customizing a use case model to predict the category for your incoming incidents. When the use case template shows the label Pretrained, you can bypass several implementation steps and are automatically taken to evaluate and tune your models when you click Start. Otherwise, you will begin by creating a machine learning model.

Procedure
1. Navigate to Predictive Intelligence Workbench > Use Cases > Templates.
2. Select the Predict Category for incoming incidents guided template.
3. Provide a unique name for your use case in the **Use case name** field.

   **Note:** The use case will contain multiple models that you create. You can use the same name as the template, if desired.

4. Although not mandatory, it's beneficial to provide unique details about the use case in the **Short description** field.

   **Note:** Typically the short description provides details about what the goal of the use case is or your purposes for creating the use case.

5. Provide a name for the model in the **Model name** field.

   **Note:** Models are trained based on default parameters. The name of the model should reflect its purpose, for example, “Model for past years data”.

6. Review the base system parameters set to help train the model in the **Input fields** and **Number of records** fields. To modify this data, click **Advanced Setup**.
Note: By clicking Advanced Setup you can change the processing language, review and modify filters used to train the model. You can customize the filters to best represent your business data or add new criteria by clicking New Criteria. Review and modify input fields used to generate predictions. Customize the fields to best represent your business data by moving fields between the Available and Selected slush buckets. Save any changes you make.

7. Click Start.
A pop-up message lets you know your model is created and that training is underway.

Note: To start implementation, you must provide at least a use case name and model name.

Great job, you’re on your way!
The training process could take a little while depending on the number of records and input fields used for training.

You will be notified via email when training is done.

Once complete, you can evaluate the model and determine if it meets your expected performance.

8. Click Done.
The use case page displays the name and description of the use case you created. On this page, you can see all the guided implementation phases you will work through to create and implement your use case model.
9. Click **View Progress** below the header on the use case setup page to monitor a current training process.

![Training Progress](image)

**Note:** When training is complete, you will receive an email notification letting you know your use case model training was successful. For more information about use case model notifications, refer to **ITSM Predictive Intelligence Workbench notifications**.
10. Click the model name under **Trained Models** on the use case setup page to view associated data about the trained model. The **Model details** page opens.

11. In the **Retraining Schedule** field of the **Models detail** page you can change the definition, if desired. The default value is **Every 30 days**, but you can retrain as often as once to every 180 days.

12. If you made schedule retraining changes to the use case model, click either **Update** or **Update and retrain**, to retrain again.

13. To tune a model, click **Tune Values** on the use case setup page under **Trained Models**.
   
   The tuning page for the use case opens displaying the associated model name with the following data: **Distribution (%)**, **Net Automation**, **Precision (%)**, **Coverage (%)**, and any comments. View the evaluation data used for the use case and associated model.

   **Note:** You can only tune values when the model is trained.

14. If desired, tune and refine the model by defining the right combination of coverage and precision to use. Double click in the **Precision (%)** and **Coverage (%)** fields to change values. Changes are automatically saved.

15. If desired, click **Create Another** to create another model associated with your use case in the **Create and train models** section of the setup page. Repeat the process to create and train the model.

16. In the **Test your models** section of the use case page, click **Start** to begin the testing process. The **Testing your models** page opens.
17. Under **Select models to test**, decide if there are other use case models available that you want to test. If so, move them to the **Selected** slush bucket.

18. Under **Define testing parameters**, decide if you want to test one use case model. If so, select the **Single test** test type. **Single test** is the default.

   **Note:** Select **Batch test** when you want to test more than one use case model.

19. Determine the number of top results you want to display.


21. Click **Run Test**.

22. View the test results data for the use case model under **View test results**.
23. If you are ready to integrate your use case model into your business processes, return to the use case set up page and click Start in the Integrate a model section. The Select a model to integrate page opens.

24. In the Select a Model drop-down menu, select the model you want to integrate. The Select a model to integrate page opens.

! Note: You can change the retraining schedule via this page if you desire. Use the Retraining Schedule drop down selection field to change from the default 30 day value.

25. Click Integrate.

26. Click Integrate again when the pop-up asks you if you are sure you want to perform this action. You have integrated a use case model into your business process.

! Note: For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

**Predict Change risk**

Use this guided template to implement a data driven approach to predicting change risk. Gain a more precise view into your business change risk.

**Before you begin**

Role required: piwb_manager or piwb_viewer

**About this task**

This template walks you through customizing a use case model to predict change risk. When the use case template shows the label Pretrained, you can bypass several implementation steps and are automatically taken to evaluate
and tune your models when you click Start. Otherwise, you will begin by creating a machine learning model.

**Procedure**

1. Navigate to **Predictive Intelligence Workbench > Use Cases > Templates**.
2. Select the **Predict Change risk** guided template.

The **Predict Change risk** pop-up form opens.

3. Provide a unique name for your use case in the **Use case name** field.

   **Note:** The use case will contain multiple models that you create. You can use the same name as the template, if desired.

4. Although not mandatory, it’s beneficial to provide unique details about the use case in the **Short description** field.

   **Note:** Typically the short description provides details about what the goal of the use case is or your purposes for creating the use case.

5. Provide a name for the model in the **Model name** field.
6. Review the base system parameters set to help train the model in the **Input fields** and **Number of records** fields. To modify this data, click **Advanced Setup**.

**Note:** By clicking **Advanced Setup** you can change the processing language, review and modify filters used to train the model. You can customize the filters to best represent your business data or add new criteria by clicking **New Criteria**. Review and modify input fields used to generate predictions. Customize the fields to best represent your business data by moving fields between the **Available** and **Selected** slush buckets. Save any changes you make.

7. Click **Start**.
   A pop-up message lets you know your model is created and that training is underway.

**Note:** To start implementation, you must provide at least a use case name and model name.

---

Great job, you’re on your way!

The training process could take a little while depending on the number of records and input fields used for training.

You will be notified via email when training is done.

Once complete, you can evaluate the model and determine if it meets your expected performance.

---

8. Click **Done**.
The use case page displays the name and description of the use case you created. On this page, you can see all the guided implementation phases you will work through to create and implement your use case model.

<table>
<thead>
<tr>
<th>Guided Steps</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create and train models</strong></td>
<td>Define parameters to create a model that will be trained based on your data. You can also create additional models through this step.</td>
</tr>
<tr>
<td>1/1</td>
<td>Create first model</td>
</tr>
<tr>
<td></td>
<td>Create additional models (optional)</td>
</tr>
<tr>
<td><strong>Test your models</strong></td>
<td>Get prediction results from your models to decide which one is best.</td>
</tr>
<tr>
<td>0/1</td>
<td>Test models - use a single or batch testing process to see if a model returns the expected results.</td>
</tr>
<tr>
<td><strong>Integrate a model</strong></td>
<td>Display the best model into your business process</td>
</tr>
<tr>
<td>1/1</td>
<td>Integrate a model into production</td>
</tr>
</tbody>
</table>

9. Click **View Progress** below the header on the use case setup page to monitor a current training process.
Note: When training is complete, you will receive an email notification letting you know your use case model training was successful. For more information about use case model notifications, refer to ITSM Predictive Intelligence Workbench notifications.

10. Click the model name under Trained Models on the use case setup page to view associated data about the trained model. The Model details page opens.

11. In the Retraining Schedule field of the Models detail page you can change the definition, if desired. The default value is Every 30 days, but you can retrain as often as once to every 180 days.

12. If you made schedule retraining changes to the use case model, click either Update or Update and retrain, to retrain again.

13. To tune a model, click Tune Values on the use case setup page under Trained Models. The tuning page for the use case opens displaying the associated model name with the following data: Distribution (%), Net Automation, Precision (%), Coverage (%), and any comments. View the evaluation data used for the use case and associated model.

Note: You can only tune values when the model is trained.

14. If desired, tune and refine the model by defining the right combination of coverage and precision to use. Double click in the Precision (%) and Coverage (%) fields to change values. Changes are automatically saved.

15. If desired, click Create Another to create another model associated with your use case in the Create and train models section of the setup page. Repeat the process to create and train the model.

16. In the Test your models section of the use case page, click Start to begin the testing process. The Testing your models page opens.
17. Under **Select models to test**, decide if there are other use case models available that you want to test. If so, move them to the **Selected** slush bucket.

18. Under **Define testing parameters**, decide if you want to test one use case model. If so, select the **Single test** test type. **Single test** is the default.

    **Note:** Select **Batch test** when you want to test more than one use case model.

19. Determine the number of top results you want to display.


21. Click **Run Test**.

22. View the test results data for the use case model under **View test results**.
23. If you are ready to integrate your use case model into your business processes, return to the use case set up page and click **Start** in the **Integrate a model** section.

The **Select a model to integrate** page opens.

24. In the **Select a Model** drop-down menu, select the model you want to integrate.

The **Select a model to integrate** page opens.

![Select a model to integrate](image)

**Select a model to integrate**

Once a model is selected and integrated, the defined business logic implementation will automatically apply the model's predictions when a record is stored in the target table. Click here to view model details.

**Select a Model**

- **Model name**: Pretrained model
- **Input Fields**: Short description
- **Output Fields**: Category
- **Records trained on**: Various dates
- **Net Accuracy (%)**: Various percentages
- **Coverage (%)**: Various percentages
- **Precision (%)**: Various percentages

![Integrate](image)

**Integrate**

25. Click **Integrate**.

26. Click **Integrate** again when the pop-up asks you if you are sure you want to perform this action.
You have integrated a use case model into your business process.

Note: For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

Predict Configuration Item for incoming incidents

Use this guided template to auto-assign incoming incidents to the correct configuration item to reduce your incident resolution times.

Before you begin
Role required: piwb_manager or piwb_viewer

About this task
This template walks you through customizing a use case model to predict the configuration item for your incoming incidents. When the use case template shows the label Pretrained, you can bypass several implementation steps and are automatically taken to evaluate and tune your models when you click Start. Otherwise, you will begin by creating a machine learning model.

Procedure
1. Navigate to Predictive Intelligence Workbench > Use Cases > Templates.
2. Select the Predict the Configuration Item for incoming incidents guided template.

The Use case - Predict the Configuration Item for incoming incidents pop-up form opens.
3. Provide a unique name for your use case in the **Use case name** field.

   **Note:** The use case will contain multiple models that you create. You can use the same name as the template, if desired.

4. Although not mandatory, it's beneficial to provide unique details about the use case in the **Short description** field.

   **Note:** Typically the short description provides details about what the goal of the use case is or your purposes for creating the use case.

5. Provide a name for the model in the **Model name** field.

   **Note:** Models are trained based on default parameters. The name of the model should reflect its purpose, for example, "Model for past years data".

6. Review the base system parameters set to help train the model in the **Input fields** and **Number of records** fields. To modify this data, click **Advanced Setup**.

   **Note:** By clicking **Advanced Setup** you can change the processing language, review and modify filters used to train the model. You can customize the filters to best represent your business data or add new criteria by clicking **New Criteria**. Review and modify input fields used to generate predictions. Customize the fields to best represent your business data by moving fields between the **Available** and **Selected** slush buckets. Save any changes you make.
7. Click **Start**.
A pop-up message lets you know your model is created and that training is underway.

ℹ️ **Note:** To start implementation, you must provide at least a use case name and model name.

Great job, you’re on your way!
The training process could take a little while depending on the number of records and input fields used for training.
You will be notified via email when training is done.
Once complete, you can evaluate the model and determine if it meets your expected performance.

8. Click **Done**.
The use case page displays the name and description of the use case you created. On this page, you can see all the guided implementation phases you will work through to create and implement your use case model.
9. Click **View Progress** below the header on the use case setup page to monitor a current training process.

![Training Progress](image)

**Note:** When training is complete, you will receive an email notification letting you know your use case model training was successful. For more information about use case model notifications, refer to **ITSM Predictive Intelligence Workbench notifications**.
10. Click the model name under **Trained Models** on the use case setup page to view associated data about the trained model. The **Model details** page opens.

11. In the **Retraining Schedule** field of the **Models detail** page you can change the definition, if desired. The default value is **Every 30 days**, but you can retrain as often as once to every 180 days.

12. If you made schedule retraining changes to the use case model, click either **Update** or **Update and retrain**, to retrain again.

13. To tune a model, click **Tune Values** on the use case setup page under **Trained Models**.
   The tuning page for the use case opens displaying the associated model name with the following data: **Distribution (%)**, **Net Automation**, **Precision (%)**, **Coverage (%)**, and any comments. View the evaluation data used for the use case and associated model

   **Tip:** You can only tune values when the model is trained.

14. If desired, tune and refine the model by defining the right combination of coverage and precision to use. Double click in the **Precision (%)** and **Coverage (%)** fields to change values. Changes are automatically saved.

15. If desired, click **Create Another** to create another model associated with your use case in the **Create and train models** section of the setup page. Repeat the process to create and train the model.

16. In the **Test your models** section of the use case page, click **Start** to begin the testing process.
   The **Testing your models** page opens.
17. Under **Select models to test**, decide if there are other use case models available that you want to test. If so, move them to the **Selected** slush bucket.

18. Under **Define testing parameters**, decide if you want to test one use case model. If so, select the **Single test** test type. **Single test** is the default.

    **Note:** Select **Batch test** when you want to test more than one use case model.

19. Determine the number of top results you want to display.


21. Click **Run Test**.

22. View the test results data for the use case model under **View test results**.

![Image of test results interface]

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
23. If you are ready to integrate your use case model into your business processes, return to the use case set up page and click **Start** in the **Integrate a model** section.
   The **Select a model to integrate** page opens.

24. In the **Select a Model** drop-down menu, select the model you want to integrate.
   The **Select a model to integrate** page opens.
   
   ![Select a model to integrate](image)

   **Note:** You can change the retraining schedule via this page if you desire. Use the **Retraining Schedule** drop down selection field to change from the default 30 day value.

25. Click **Integrate**.

26. Click **Integrate** again when the pop-up asks you if you are sure you want to perform this action.
   You have integrated a use case model into your business process.
   
   **Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization**.

**Predict Service for incoming incidents**

Use this guided template to auto-assign incoming incidents to the correct service to reduce your incident resolution times.

**Before you begin**

Role required: piwb_manager or piwb_viewer

**About this task**

This template walks you through customizing a use case model to predict the service for your incoming incidents. When the use case template shows the label **Pretrained**, you will bypass several implementation steps and are automatically...
taken to evaluate and tune your models when you click Start. Otherwise, you will begin by creating a machine learning model.

Procedure

1. Navigate to Predictive Intelligence Workbench > Use Cases > Templates.
2. Select the Predict Service for incoming incidents guided template.

The Use case - Predict Service for incoming incidents pop-up form opens.

3. Provide a unique name for your use case in the Use case name field.

   Note: The use case will contain multiple models that you create. You can use the same name as the template, if desired.

4. Although not mandatory, it's beneficial to provide unique details about the use case in the Short description field.

   Note: Typically the short description provides details about what the goal of the use case is or your purposes for creating the use case.

5. Provide a name for the model in the Model name field.
6. Review the base system parameters set to help train the model in the Input fields and Number of records fields. To modify this data, click Advanced Setup.

   Note: By clicking Advanced Setup you can change the processing language, review and modify filters used to train the model. You can customize the filters to best represent your business data or add new criteria by clicking New Criteria. Review and modify input fields used to generate predictions. Customize the fields to best represent your business data by moving fields between the Available and Selected slush buckets. Save any changes you make.

7. Click Start.
   A pop-up message lets you know your model is created and that training is underway.

   Note: To start implementation, you must provide at least a use case name and model name.

8. Click Done.
The use case page displays the name and description of the use case you created. On this page, you can see all the guided implementation phases you will work through to create and implement your use case model.

9. Click **View Progress** below the header on the use case setup page to monitor a current training process.
**Note:** When training is complete, you will receive an email notification letting you know your use case model training was successful. For more information about use case model notifications, refer to ITSM Predictive Intelligence Workbench notifications.

10. Click the model name under **Trained Models** on the use case setup page to view associated data about the trained model. The **Model details** page opens.

11. In the **Retraining Schedule** field of the **Models detail** page you can change the definition, if desired. The default value is **Every 30 days**, but you can retrain as often as once to every 180 days.

12. If you made schedule retraining changes to the use case model, click either **Update** or **Update and retrain**, to retrain again.

13. To tune a model, click **Tune Values** on the use case setup page under **Trained Models**. The tuning page for the use case opens displaying the associated model name with the following data: **Distribution (%)**, **Net Automation**, **Precision (%)**, **Coverage (%)**, and any comments. View the evaluation data used for the use case and associated model.

**Note:** You can only tune values when the model is trained.

14. If desired, tune and refine the model by defining the right combination of coverage and precision to use. Double click in the **Precision (%)** and **Coverage (%)** fields to change values. Changes are automatically saved.

15. If desired, click **Create Another** to create another model associated with your use case in the **Create and train models** section of the setup page. Repeat the process to create and train the model.

16. In the **Test your models** section of the use case page, click **Start** to begin the testing process. The **Testing your models** page opens.
17. Under **Select models to test**, decide if there are other use case models available that you want to test. If so, move them to the **Selected** slush bucket.

18. Under **Define testing parameters**, decide if you want to test one use case model. If so, select the **Single test** test type. **Single test** is the default.

   **Note:** Select **Batch test** when you want to test more than one use case model.

19. Determine the number of top results you want to display.


21. Click **Run Test**.

22. View the test results data for the use case model under **View test results**.
23. If you are ready to integrate your use case model into your business processes, return to the use case set up page and click **Start** in the **Integrate a model** section. The **Select a model to integrate** page opens.

24. In the **Select a Model** drop-down menu, select the model you want to integrate. The **Select a model to integrate** page opens.

25. **Note:** You can change the retraining schedule via this page if you desire. Use the **Retraining Schedule** drop down selection field to change from the default 30 day value.

26. Click **Integrate**.

27. Click **Integrate** again when the pop-up asks you if you are sure you want to perform this action.
You have integrated a use case model into your business process.

**Note:** For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

**Similar Business Applications**

Use this template to recommend the business application category based on name and description of existing business applications.

**Before you begin**

Role required: piwb_manager or piwb_viewer

**About this task**

This use case template helps you improve your ITSM business application category recommendations based on name and description of existing business applications. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent assist and also in the Incident form via related search.

**Note:** You will need business users to validate the similar past active incident search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label **Pretrained**, you can go directly to the **Testing your models** implementation section. Otherwise, you will begin by creating a machine learning model.

**Procedure**

1. If you started this procedure directly from the Predictive Intelligence Workbench product **Create New from Template** module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to **Predictive Intelligence Workbench > Use Cases > Create New from Template**.

2. Select the **Suggest relevant Incidents for an Incident** template.

   The **Suggest relevant Incidents for an Incident** pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.

3. Create and train a machine learning predictive model.
Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a. **Create a word corpus.**

When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident [incidents] in the **Table** field and define the time frame that best describes the current usage of words in the **Filter** field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the **Field List** field, define only the fields that best capture the words: **Description**, **Short description**, and **Resolution notes**. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.

Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b. **Create and train a similarity solution.**

c. **For this initial model creation, provide the similarity solution definition label** **Similar Incidents** in the **Label** field.

d. **Set the Training Frequency field to Run Once.** You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e. **Set the Update Frequency field to Every 15 minutes.** This defines the frequency at which past incidents refresh in the search window.

When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the **Table** field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the **Test Table** field, if required, for comparison. It is best to start with similar fields for both the **Table** and **Test Table** fields.

The **Filter** field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.
f. Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold**.

5. Once you have a satisfactory model, **test the similarity solution prediction**. You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, **configure the user experience layout** to show attributed results and actions performed on the results. You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context through **Tables** configuration and user experience and card layout through **Contextual Search > Search Result Display Configuration**.

7. **Integrate trained models by exporting them to production.**

1. **Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization**.

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. **Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.**
Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

**Similar Demands**

Use this template to include the demand name and description as inputs to list similar demands.

**Before you begin**

Role required: piwb_manager or piwb_viewer

**About this task**

This use case template helps you improve your ITSM business ability to include the demand name and description as inputs to list similar demands. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent assist and also in the Incident form via related search.

ℹ️  **Note:** You will need business users to validate the similar past active incident search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

**Procedure**

1. If you started this procedure directly from the Predictive Intelligence Workbench product Create New from Template module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Create New from Template.

2. Select the Suggest relevant Incidents for an Incident template. The Suggest relevant Incidents for an Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.
3. Create and train a machine learning predictive model.
   Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

   a. Create a word corpus.

      When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident [incidents] in the Table field and define the time frame that best describes the current usage of words in the Filter field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the Field List field, define only the fields that best capture the words: Description, Short description, and Resolution notes. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.

      Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

   b. Create and train a similarity solution.

   c. For this initial model creation, provide the similarity solution definition label Similar Incidents in the Label field.

   d. Set the Training Frequency field to Run Once. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

   e. Set the Update Frequency field to Every 15 minutes. This defines the frequency at which past incidents refresh in the search window.

      When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the Table field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the Test Table field, if required, for comparison. It is best to start with similar fields for both the Table and Test Table fields.

      The Filter field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.
4. Evaluation and tune your model.

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to Update your similarity score threshold.

5. Once you have a satisfactory model, test the similarity solution prediction. You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, configure the user experience layout to show attributed results and actions performed on the results. You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context through Tables configuration and user experience and card layout through Contextual Search > Search Result Display Configuration.

7. Integrate trained models by exporting them to production.

Note: For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

8. Monitor similarity results and ensure IT agents are providing useful feedback.

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.
Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

Similar Ideas
Use this template to include the idea name and description as inputs to list similar ideas.

Before you begin
Role required: piwb_manager or piwbViewer

About this task
This use case template helps you improve your ITSM business ability to include the idea name and description as inputs to list similar demands. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent assist and also in the Incident form via related search.

Note: You will need business users to validate the similar past active incident search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

Procedure
1. If you started this procedure directly from the Predictive Intelligence Workbench product Create New from Template module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Create New from Template.
2. Select the Suggest relevant Incidents for an Incident template. The Suggest relevant Incidents for an Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.
3. Create and train a machine learning predictive model.
   Creating a model involves the following: creating a word corpus, defining a
   similarity prediction rule, defining the initial training frequency, and defining
   the refresh frequency.

a. Create a word corpus.
   When creating a word corpus on the Word Corpus Content form, select an
   incidents-related table, such as Incident [incidents] in the Table field and
   define the time frame that best describes the current usage of words in the
   Filter field. For example, if your IT system experienced a major infrastructure
   change six months back, use data from the last six months only. In the Field
   List field, define only the fields that best capture the words: Description, Short
   description, and Resolution notes. Defining these alone is typically enough,
   since the prediction rule is expected to find incidents based on the short
   description.

   Creating the word corpus prepares you for the next step, creating the
   similarity prediction rule.

b. Create and train a similarity solution.

c. For this initial model creation, provide the similarity solution definition label
   Similar Incidents in the Label field.

d. Set the Training Frequency field to Run Once. You can reset this
   configuration after you implement this use case into your business processes
   and have monitored its performance in the Predictive Intelligence
   Workbench dashboard.

e. Set the Update Frequency field to Every 15 minutes. This defines the
   frequency at which past incidents refresh in the search window.

   When possible, and if applicable, use an existing word corpus, created
   for another use case to reduce your overall word corpora and ease
   management of these records. In the Table field of the Similarity Definition
   form, select only those inputs for similarity that will be available at prediction
   time for incoming incidents. You can select more inputs in the Test Table
   field, if required, for comparison. It is best to start with similar fields for both
   the Table and Test Table fields.

   The Filter field conditions determine the search window for past resolved
   incidents. Configure the filter conditions to optimize for the best set of
   resolved incidents to search within. This includes many considerations, such
   as, time frame, location, category where incidents are relevant, and more.
f. Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

   If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

   If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

   If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold**.

5. Once you have a satisfactory model, **test the similarity solution prediction**. You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, **configure the user experience layout** to show attributed results and actions performed on the results. You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context though **Tables** configuration and user experience and card layout through **Contextual Search > Search Result Display Configuration**.

7. **Integrate trained models by exporting them to production.**

   🟢 **Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization**.

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**

   The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. **Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.**
Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The "likes" you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

Similar Projects
Use this template to include the project name and description as inputs to list similar ideas.

Before you begin
Role required: piwb_manager or piwb_viewer

About this task
This use case template helps you improve your ITSM business ability to include the project name and description as inputs to list similar demands. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent assist and also in the Incident form via related search.

Note: You will need business users to validate the similar past active incident search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

Procedure
1. If you started this procedure directly from the Predictive Intelligence Workbench product Create New from Template module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Create New from Template.
2. Select the Suggest relevant Incidents for an Incident template. The Suggest relevant Incidents for an Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.
3. Create and train a machine learning predictive model.
   Creating a model involves the following: creating a word corpus, defining a
   similarity prediction rule, defining the initial training frequency, and defining
   the refresh frequency.

   a. Create a word corpus.

      When creating a word corpus on the Word Corpus Content form, select an
      incidents-related table, such as Incident [incidents] in the Table field and
      define the time frame that best describes the current usage of words in the
      Filter field. For example, if your IT system experienced a major infrastructure
      change six months back, use data from the last six months only. In the Field
      List field, define only the fields that best capture the words: Description, Short
      description, and Resolution notes. Defining these alone is typically enough,
      since the prediction rule is expected to find incidents based on the short
      description.

      Creating the word corpus prepares you for the next step, creating the
      similarity prediction rule.

   b. Create and train a similarity solution.

   c. For this initial model creation, provide the similarity solution definition label
      Similar Incidents in the Label field.

   d. Set the Training Frequency field to Run Once. You can reset this
      configuration after you implement this use case into your business processes
      and have monitored its performance in the Predictive Intelligence
      Workbench dashboard.

   e. Set the Update Frequency field to Every 15 minutes. This defines the
      frequency at which past incidents refresh in the search window.

      When possible, and if applicable, use an existing word corpus, created
      for another use case to reduce your overall word corpora and ease
      management of these records. In the Table field of the Similarity Definition
      form, select only those inputs for similarity that will be available at prediction
      time for incoming incidents. You can select more inputs in the Test Table
      field, if required, for comparison. It is best to start with similar fields for both
      the Table and Test Table fields.

      The Filter field conditions determine the search window for past resolved
      incidents. Configure the filter conditions to optimize for the best set of
      resolved incidents to search within. This includes many considerations, such
      as, time frame, location, category where incidents are relevant, and more.
f. Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold.**

5. Once you have a satisfactory model, **test the similarity solution prediction.** You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, **configure the user experience layout** to show attributed results and actions performed on the results. You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context though **Tables** configuration and user experience and card layout through **Contextual Search > Search Result Display Configuration.**

7. **Integrate trained models by exporting them to production.**

1. **Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization.**

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. **Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.**
Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The "likes" you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

**Suggest relevant Incidents for an Incident**

Use this template to recommend similar relevant incidents to help expedite your incident investigation and resolution processes.

**Before you begin**

Role required: piwb_manager or piwb_viewer

**About this task**

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for incoming incidents. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent assist and also in the Incident form via related search.

ℹ️ **Note:** You will need business users to validate the similar past active incident search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label **Pretrained**, you can go directly to the **Testing your models** implementation section. Otherwise, you will begin by creating a machine learning model.

**Procedure**

1. If you started this procedure directly from the Predictive Intelligence Workbench product **Create New from Template** module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to **Predictive Intelligence Workbench > Use Cases > Create New from Template**.

2. Select the **Suggest relevant Incidents for an Incident** template. The **Suggest relevant Incidents for an Incident** pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.
3. Create and train a machine learning predictive model. Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a. Create a word corpus. When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident [incidents] in the Table field and define the time frame that best describes the current usage of words in the Filter field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the Field List field, define only the fields that best capture the words: Description, Short description, and Resolution notes. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.

Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b. Create and train a similarity solution.

c. For this initial model creation, provide the similarity solution definition label Similar Incidents in the Label field.

d. Set the Training Frequency field to Run Once. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e. Set the Update Frequency field to Every 15 minutes. This defines the frequency at which past incidents refresh in the search window.

When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the Table field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the Test Table field, if required, for comparison. It is best to start with similar fields for both the Table and Test Table fields.

The Filter field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.
f. Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold**.

5. Once you have a satisfactory model, **test the similarity solution prediction.** You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, **configure the user experience layout to show attributed results and actions performed on the results.** You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context through **Tables** configuration and user experience and card layout through **Contextual Search > Search Result Display Configuration**.

7. **Integrate trained models by exporting them to production.**

    **Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization.**

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**

    The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. **Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.**
Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The "likes" you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

**Suggest relevant Incidents for a Major Incident**

Use this template to recommend similar resolved incidents to help expedite your major incident investigation and resolution processes.

**Before you begin**
Role required: piwb_manager or piwb_viewer

**About this task**
This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for incoming incidents. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent assist and also in the Incident form via related search.

**Note:** You will need business users to validate the similar past active incident search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label **Pretrained**, you can go directly to the **Testing your models** implementation section. Otherwise, you will begin by creating a machine learning model.

**Procedure**

1. If you started this procedure directly from the Predictive Intelligence Workbench product **Create New from Template** module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to **Predictive Intelligence Workbench > Use Cases > Create New from Template**.

2. Select the **Suggest relevant Incidents for a Major Incident** template. The **Suggest relevant Incidents for a Major Incident** pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.
3. Create and train a machine learning predictive model.
   Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a. Create a word corpus.
   When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident [incidents] in the Table field and define the time frame that best describes the current usage of words in the Filter field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the Field List field, define only the fields that best capture the words: Description, Short description, and Resolution notes. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.

   Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b. Create and train a similarity solution.

c. For this initial model creation, provide the similarity solution definition label Similar Incidents in the Label field.

d. Set the Training Frequency field to Run Once. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e. Set the Update Frequency field to Every 15 minutes. This defines the frequency at which past incidents refresh in the search window.
   When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the Table field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the Test Table field, if required, for comparison. It is best to start with similar fields for both the Table and Test Table fields.

   The Filter field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.
f. Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold**.

5. **Once you have a satisfactory model, test the similarity solution prediction.** You can manually provide inputs and select the top similar results outcome values.

6. **Once you have tested the behavior, configure the user experience layout to show attributed results and actions performed on the results.** You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context through **Tables configuration and user experience and card layout through Contextual Search > Search Result Display Configuration.**

7. **Integrate trained models by exporting them to production.**

   **Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization.**

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**

   The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. **Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.**
Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The "likes" you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

**Suggest relevant Major Incident for an Incident**

Use this template to recommend similar resolved major incidents to help expedite your incident investigation and resolution processes.

**Before you begin**
Role required: piwb_manager or piwb_viewer

**About this task**
This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for incoming incidents. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent assist and also in the Incident form via related search.

**Note:** You will need business users to validate the similar past active incident search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

**Procedure**
1. If you started this procedure directly from the Predictive Intelligence Workbench product Create New from Template module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Create New from Template.
2. Select the Suggest relevant Major Incident for an Incident template. The Suggest relevant Major Incident for an Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.
3. Create and train a machine learning predictive model.

Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a. Create a word corpus.

When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident [incidents] in the Table field and define the time frame that best describes the current usage of words in the Filter field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the Field List field, define only the fields that best capture the words: Description, Short description, and Resolution notes. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.

Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b. Create and train a similarity solution.

c. For this initial model creation, provide the similarity solution definition label Similar Incidents in the Label field.

d. Set the Training Frequency field to Run Once. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e. Set the Update Frequency field to Every 15 minutes. This defines the frequency at which past incidents refresh in the search window.

When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the Table field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the Test Table field, if required, for comparison. It is best to start with similar fields for both the Table and Test Table fields.

The Filter field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.
f. Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold**.

5. Once you have a satisfactory model, **test the similarity solution prediction.** You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, **configure the user experience layout to show attributed results and actions performed on the results.** You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context though **Tables** configuration and user experience and card layout through **Contextual Search > Search Result Display Configuration**.

7. **Integrate trained models by exporting them to production.**

    ¡ Note: For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**

    The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. **Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.**
Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The "likes" you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

**Suggest relevant KB article for an Incident**

Use this template to recommend relevant knowledge base articles to help expedite your incident investigation and resolution processes.

**Before you begin**

Role required: piwb_manager or piwb_viewer

**About this task**

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for incoming incidents. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with relevant knowledge base articles for smarter resolution. Similar past active incidents are displayed in Agent assist and also in the Incident form via related search.

**Note:** You will need business users to validate the similar past active incident search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label **Pretrained**, you can go directly to the **Testing your models** implementation section. Otherwise, you will begin by creating a machine learning model.

**Procedure**

1. If you started this procedure directly from the Predictive Intelligence Workbench product Create New from Template module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Create New from Template.

2. Select the Suggest relevant KB article for an Incident template. The Suggest relevant KB article for an Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.
3. Create and train a machine learning predictive model.
   Creating a model involves the following: creating a word corpus, defining a
   similarity prediction rule, defining the initial training frequency, and defining
   the refresh frequency.

   a. Create a word corpus.

   When creating a word corpus on the Word Corpus Content form, select an
   incidents-related table, such as Incident [incidents] in the Table field and
   define the time frame that best describes the current usage of words in the
   Filter field. For example, if your IT system experienced a major infrastructure
   change six months back, use data from the last six months only. In the Field
   List field, define only the fields that best capture the words: Description, Short
   description, and Resolution notes. Defining these alone is typically enough,
   since the prediction rule is expected to find incidents based on the short
   description.

   Creating the word corpus prepares you for the next step, creating the
   similarity prediction rule.

   b. Create and train a similarity solution.

   c. For this initial model creation, provide the similarity solution definition label
      Similar Knowledge Articles in the Label field.

   d. For this initial model creation, set the Training Frequency field to Run Once.
      You can reset this configuration after you implement this use case into your
      business processes and have monitored its performance in the Predictive
      Intelligence Workbench dashboard.

   e. Set the Update Frequency field to Every 15 minutes. This defines the
      frequency at which past incidents refresh in the search window.

      When possible, and if applicable, use an existing word corpus, created
      for another use case to reduce your overall word corpora and ease
      management of these records. In the Table field of the Similarity Definition
      form, select only those inputs for similarity that will be available at prediction
      time for incoming incidents. You can select more inputs in the Test Table
      field, if required, for comparison. It is best to start with similar fields for both
      the Table and Test Table fields.

      The Filter field conditions determine the search window for past resolved
      incidents. Configure the filter conditions to optimize for the best set of
      resolved incidents to search within. This includes many considerations, such
      as, time frame, location, category where incidents are relevant, and more.
f. Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold**.

5. Once you have a satisfactory model, **test the similarity solution prediction**. You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, **configure the user experience layout** to show attributed results and actions performed on the results. You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context through **Tables** configuration and user experience and card layout through **Contextual Search > Search Result Display Configuration**.

7. **Integrate trained models by exporting them to production.**

   **Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization**.

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. **Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.**
Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The "likes" you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

Suggest relevant Open incidents for an Incident
Use this template to recommend similar open incidents to help expedite your incident investigation and resolution processes.

Before you begin
Role required: piwb_manager or piwb_viewer

About this task
This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for incoming incidents. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent assist and also in the Incident form via related search.

Note: You will need business users to validate the similar past active incident search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

Procedure

1. If you started this procedure directly from the Predictive Intelligence Workbench product Create New from Template module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Create New from Template.

2. Select the Suggest relevant Open Incidents for an Incident template. The Suggest relevant Open Incidents for an Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.
3. Create and train a machine learning predictive model.

Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a. Create a word corpus.

When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident [incidents] in the Table field and define the time frame that best describes the current usage of words in the Filter field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the Field List field, define only the fields that best capture the words: Description, Short description, and Resolution notes. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.

Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b. Create and train a similarity solution.

c. For this initial model creation, provide the similarity solution definition label Similar Open Incidents in the Label field.

d. Set the Training Frequency field to Run Once. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e. Set the Update Frequency field to Every 15 minutes. This defines the frequency at which past incidents refresh in the search window.

When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the Table field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the Test Table field, if required, for comparison. It is best to start with similar fields for both the Table and Test Table fields.

The Filter field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.
f. Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold.**

5. Once you have a satisfactory model, **test the similarity solution prediction.** You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, **configure the user experience layout** to show attributed results and actions performed on the results.

You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context though **Tables** configuration and user experience and card layout through **Contextual Search > Search Result Display Configuration.**

7. **Integrate trained models by exporting them to production.**

   **Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization.**

8. **Monitor similarity results and ensure IT agents are providing useful feedback.**

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. **Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.**
Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The "likes" you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

**Suggest relevant Resolved Incidents for an Incident**

Use this template to recommend similar relevant resolved incidents to help expedite your incident investigation and resolution processes.

**Before you begin**

Role required: piwb_manager or piwb_viewer

**About this task**

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for incoming incidents. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an incoming incident with past resolved incidents for smarter resolution. Similar past active incidents are displayed in Agent assist and also in the Incident form via related search.

ℹ️ **Note:** You will need business users to validate the similar past active incident search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

**Procedure**

1. If you started this procedure directly from the Predictive Intelligence Workbench product Create New from Template module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Create New from Template.

2. Select the Suggest relevant Resolved Incidents for an Incident template.

The Suggest relevant Resolved Incidents for an Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.
3. Create and train a machine learning predictive model.
Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a. **Create a word corpus.**
   When creating a word corpus on the Word Corpus Content form, select an incidents-related table, such as Incident [incidents] in the Table field and define the time frame that best describes the current usage of words in the Filter field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the Field List field, define only the fields that best capture the words: Description, Short description, and Resolution notes. Defining these alone is typically enough, since the prediction rule is expected to find incidents based on the short description.
   Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b. **Create and train a similarity solution.**

c. For this initial model creation, provide the similarity solution definition label Similar Resolved Incidents in the Label field.

d. Set the Training Frequency field to Run Once. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e. Set the Update Frequency field to Every 15 minutes. This defines the frequency at which past incidents refresh in the search window.
   When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the Table field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for incoming incidents. You can select more inputs in the Test Table field, if required, for comparison. It is best to start with similar fields for both the Table and Test Table fields.
   The Filter field conditions determine the search window for past resolved incidents. Configure the filter conditions to optimize for the best set of resolved incidents to search within. This includes many considerations, such as, time frame, location, category where incidents are relevant, and more.
f. Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

4. **Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold**.

5. Once you have a satisfactory model, **test the similarity solution prediction**. You can manually provide inputs and select the top similar results outcome values.

6. Once you have tested the behavior, **configure the user experience layout** to show attributed results and actions performed on the results.

You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context through **Tables** configuration and user experience and card layout through **Contextual Search > Search Result Display Configuration**.

7. Integrate trained models by exporting them to production.

   **Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization**.

8. Monitor similarity results and ensure IT agents are providing useful feedback.

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics.
Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The "likes" you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence for Incidents dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

**Suggest relevant Open Change requests for an Incident**

Use this template to recommend similar open change requests to help expedite your change request investigation and resolution processes.

**Before you begin**

Role required: piwb_manager or piwb_viewer

**About this task**

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for change requests. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an open change request with past resolved change requests for smarter resolution. Similar open changes are displayed in Agent assist and also in the Incident form via related search.

ℹ️ **Note:** You will need business users to validate the similar open changes search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label *Pretrained*, you can go directly to the **Testing your models** implementation section. Otherwise, you will begin by creating a machine learning model.

**Procedure**

1. If you started this procedure directly from the Predictive Intelligence Workbench product *Create New from Template* module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Create New from Template.

2. Select the **Suggest relevant Open Change requests for an Incident** template. The **Suggest relevant Open Change requests for an Incident** pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.
3. Create and train a machine learning predictive model.

Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a. Create a word corpus.

When creating a word corpus on the Word Corpus Content form, select Incident [incidents] and Change [change] in the Table field and define the time frame that best describes the current usage of words in the Filter field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the Field List field, define only the fields that best capture the words: Description, Short description, and Resolution notes. Defining these alone is typically enough, since the prediction rule is expected to find change requests based on the short description.

Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b. Create and train a similarity solution.

c. For this initial model creation, provide the similarity solution definition label Similar Open Change requests in the Label field.

d. Set the Training Frequency field to Run Once. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e. Set the Update Frequency field to Every 15 minutes. This defines the frequency at which past change requests refresh in the search window.

When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the Table field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for change requests. You can select more inputs in the Test Table field, if required, for comparison. It is best to start with similar fields for both the Table and Test Table fields.

The Filter field conditions determine the search window for past resolved change requests. Configure the filter conditions to optimize for the best set of resolved change requests to search within. This includes many
considerations, such as, time frame, location, category where change requests are relevant, and more.

**f. Click Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

**4. Evaluation and tune your model.**

If you have a similarity score above 60, but the two incidents do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold.**

**5. Once you have a satisfactory model, test the similarity solution prediction.** You can manually provide inputs and select the top similar results outcome values.

**6. Once you have tested the behavior, configure the user experience layout to show attributed results and actions performed on the results.** You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context through **Tables** configuration and user experience and card layout through **Contextual Search > Search Result Display Configuration.**

**7. Integrate trained models by exporting them to production.**

**Note:** For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

**8. Monitor similarity results and ensure IT agents are providing useful feedback.**

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.
9. Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics. Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence workbench dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

**Suggest relevant Open Problems for an Incident**

Use this template to recommend similar open problem records to help expedite your problem investigation and resolution processes.

**Before you begin**

Role required: piwb_manager or piwb_viewer

**About this task**

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for problem records. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an open problem record with past resolved problem records for smarter resolution. Similar open problem records are displayed in Agent assist and also in the Incident form via related search.

⚠️ **Note:** You will need business users to validate the similar open problem search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.

**Procedure**

1. If you started this procedure directly from the Predictive Intelligence Workbench product Create New from Template module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to Predictive Intelligence Workbench > Use Cases > Create New from Template.

2. Select the Suggest relevant Open Problems for an Incident template.
The Suggest relevant Open Problems for an Incident pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.

3. Create and train a machine learning predictive model.
Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

a. Create a word corpus.
When creating a word corpus on the Word Corpus Content form, select Incident [incidents] and Problem [problem] in the Table field and define the time frame that best describes the current usage of words in the Filter field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the Field List field, define only the fields that best capture the words: Description, Short description, and Resolution notes. Defining these alone is typically enough, since the prediction rule is expected to find problems based on the short description.

Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

b. Create and train a similarity solution.

c. For this initial model creation, provide the similarity solution definition label Similar Open Problems in the Label field.

d. Set the Training Frequency field to Run Once. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e. Set the Update Frequency field to Every 15 minutes. This defines the frequency at which past problem records refresh in the search window.

When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the Table field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for problem records. You can select more inputs in the Test Table field, if required, for comparison. It is best to start with similar fields for both the Table and Test Table fields.
The **Filter** field conditions determine the search window for past resolved problem records. Configure the filter conditions to optimize for the best set of resolved problem records to search within. This includes many considerations, such as, time frame, location, category where problem records are relevant, and more.

**f.** Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

**4. Evaluation and tune your model.**

If you have a similarity score above 60, but the two problem records do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.

If you want to adjust the score for your similarity solution, refer to **Update your similarity score threshold**.

**5.** Once you have a satisfactory model, test the similarity solution prediction. You can manually provide inputs and select the top similar results outcome values.

**6.** Once you have tested the behavior, configure the user experience layout to show attributed results and actions performed on the results. You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context though **Tables** configuration and user experience and card layout through **Contextual Search > Search Result Display Configuration**.

**7.** Integrate trained models by exporting them to production.

**Note:** For details regarding trained use case integration implementation, refer to **Predictive Intelligence Workbench integration and customization**.

**8.** Monitor similarity results and ensure IT agents are providing useful feedback.

The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that
part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

9. Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics. Select one or more KPIs that you think is most beneficial to your IT agents. Create a Performance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence workbench dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

**Suggest skill assignment by comparing completed work with skills**

Use this template to recommend who an assignment is routed to, based on skill set to help expedite your problem investigation and resolution processes.

**Before you begin**
Role required: piwb_manager or piwb_viewer

**About this task**

* Note: The Skill Recommendation plugin (sn.sre) must be activated to use predictive intelligence for recommending skills. # Configure skill recommendations in the Skill Recommendation module as part of this procedure.

This use case template helps you improve your ITSM first-call resolution and reduce the time required to investigate resolution steps for problem records. The template also provides a link to the Predictive Intelligence platform application and associated documentation.

The use case uses a similarity-based predictive model that compares an open problem record with past resolved problem records for smarter resolution. Similar open problem records are displayed in Agent assist and also in the Incident form via related search.

* Note: You will need business users to validate the similar open problem search results. Contact Customer Service and Support, if necessary, to configure sources for contextual search.

When the use case template shows the label Pretrained, you can go directly to the Testing your models implementation section. Otherwise, you will begin by creating a machine learning model.
Procedure

1. Navigate to **Skill Recommendation > Configuration** to define the properties to recommend skills.

   **Note:** By default, the `Enable skill recommendation` property is configured to recommend skills for agents. Deselect the check box to disable skill recommendation.

2. If you started this procedure directly from the Predictive Intelligence Workbench product **Create New from Templates** module, and clicked on the product documentation link to get here, skip this step. Otherwise, navigate to **Predictive Intelligence Workbench > Use Cases > Create New from Templates**.

3. Select the **Suggest skill assignment by comparing completed work with skills** template.
   The **Suggest skill assignment by comparing completed work with skills** pop-up opens featuring a link to this procedure and a link to the platform Predictive Intelligence product and associated documentation.

4. Create and train a machine learning predictive model.
   Creating a model involves the following: creating a word corpus, defining a similarity prediction rule, defining the initial training frequency, and defining the refresh frequency.

   **a. Create a word corpus.**
   
   When creating a word corpus on the Word Corpus Content form, select Incident [incidents] and Problem [problem] in the **Table** field and define the time frame that best describes the current usage of words in the **Filter** field. For example, if your IT system experienced a major infrastructure change six months back, use data from the last six months only. In the **Field List** field, define only the fields that best capture the words: **Description**, **Short description**, and **Resolution notes**. Defining these alone is typically enough, since the prediction rule is expected to find problems based on the short description.

   Creating the word corpus prepares you for the next step, creating the similarity prediction rule.

   **b. Create and train a similarity solution.**

   **c. For this initial model creation, provide the similarity solution definition label Similar Open Problems in the Label field.**
d. Set the **Training Frequency** field to **Run Once**. You can reset this configuration after you implement this use case into your business processes and have monitored its performance in the Predictive Intelligence Workbench dashboard.

e. Set the **Update Frequency** field to **Every 15 minutes**. This defines the frequency at which past problem records refresh in the search window. When possible, and if applicable, use an existing word corpus, created for another use case to reduce your overall word corpora and ease management of these records. In the **Table** field of the Similarity Definition form, select only those inputs for similarity that will be available at prediction time for problem records. You can select more inputs in the **Test Table** field, if required, for comparison. It is best to start with similar fields for both the **Table** and **Test Table** fields.

The **Filter** field conditions determine the search window for past resolved problem records. Configure the filter conditions to optimize for the best set of resolved problem records to search within. This includes many considerations, such as, time frame, location, category where problem records are relevant, and more.

f. Click **Submit & Train** to create your similarity solution record and train it. Alternatively, you can click **Submit** to save your similarity solution record and return to train it later.

5. **Evaluation and tune your model.**

Make sure you run the **Start Skill Prediction** scheduled job every day to start predicting skills for incidents or agents.

⚠️ **Note:** By default, this scheduled job is disabled. When enabled, it is set to run daily at 1:00 AM on all incidents resolved the previous day. The skills are then added to the User Predicted Skill [sn_sre_user_predicted_skill] table and Task Predicted Skill [sn_sre_user_predicted_skill] table.

If you have a similarity score above 60, but the two problem records do not look similar, you may want to create another model, word corpus, or both by changing inputs and filters. Keep in mind that modifying the solution definition will help you create a new solution, but it will invalidate the previous solution.

If you want to revert back to the previous solution definition, you will have to reset the parameters and retrain the solution. Therefore, first try creating a new similarity model before creating a new word corpus.
If you want to adjust the score for your similarity solution, refer to Update your similarity score threshold.

6. Once you have a satisfactory model, test the similarity solution prediction. You can manually provide inputs and select the top similar results outcome values.

7. Once you have tested the behavior, configure the user experience layout to show attributed results and actions performed on the result. You can configure these results and actions via Workspace UI for Agent assist or via the Now Platform for Contextual Search. Configure actions and search context through Tables configuration and user experience and card layout through Contextual Search > Search Result Display Configuration.

8. Integrate trained models by exporting them to production.

Note: For details regarding trained use case integration implementation, refer to Predictive Intelligence Workbench integration and customization.

9. Monitor similarity results and ensure IT agents are providing useful feedback. The base-system Predictive Intelligence experience includes a built-in feedback mechanism to discern if the similarity results are useful. Train your IT agents to provide feedback, both online and offline, to capture this data for future reporting. Since this is an unsupervised algorithm, you may need to acquire periodic feedback from the IT agents to check that the similarity model is still providing satisfactory results. This feedback is the only way to determine if the model has drifted and requires new training. Ensure that part of your implementation and integration strategy, as well as your change management process, includes training IT agents to provide similarity results feedback.

10. Communicate the value of Predictive Intelligence to your stakeholders by linking business key performance indicators (KPIs) to machine learning metrics. Select one or more KPIs that you think is most beneficial to your IT agents. Create aPerformance Analytics dashboard showing the trend of these KPIs. The “likes” you get from your IT agents via the feedback mechanism helps you communicate the value of Predictive Intelligence.

For information regarding the Predictive Intelligence workbench dashboard, refer to ITSM Predictive Intelligence Workbench dashboard.

Manage ITSM Predictive Intelligence Workbench use cases

View your ITSM Predictive Intelligence Workbench use cases to monitor model performance and reevaluate the associated models, if necessary. You can also continue setup of models you started, but did not complete.
Before you begin
Role required: piwb_admin or piwb_manager

About this task
Via the Models detail page you can access the Test tab to perform the following actions:

• Perform single or batch tests on model versions.
• Export version test results as .csv files and mark versions as active.
• Filter the number of versions based on date range.
• Monitor testing progress with notifications via the guided process.

Procedure
1. Navigate to Predictive Intelligence Workbench > Use Cases > All.
The Use Cases - All page opens displaying all use cases. The status of the use case is depicted on the card, for example, In progress. Other statuses include, Completed and Monitoring.

2. Click on a use case to continue with implementation. Or you can evaluate performance if the use case is in the Monitoring state.

Note: If a use case is under performing, the net automation is lower than the threshold configured in the settings page. Refer to Configure ITSM Predictive Intelligence Workbench settings.

ITSM Predictive Intelligence Workbench dashboard
ITSM Predictive Intelligence Workbench provides the Predictive Intelligence for Incidents dashboard to enable you to measure the value of using machine learning to automate your IT business processes. Monitor use case models and
view associated statistics. Effectively demonstrate business value to stakeholders with dashboard views.

Know exactly what stage your model workflows are in with automated comments on specific ServiceNow® Performance Analytics indicators. Comments appear on the **Actual Net Automation** indicators. Model stages comments include, when the model is integrated, when an integration is removed, when an existing model is changed to a new model, and when retraining is complete.

**Business Value tab**

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Incident Assignment</th>
<th>Business Value</th>
<th>Monitoring Models</th>
<th>Model Statistics</th>
</tr>
</thead>
</table>

**Net Automation**

<table>
<thead>
<tr>
<th>Name</th>
<th>IW 2020</th>
<th>IW 2021</th>
<th>Score</th>
<th>Change %</th>
<th>Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net Automation</td>
<td>58%</td>
<td>62%</td>
<td>77%</td>
<td>14.0%</td>
<td></td>
</tr>
</tbody>
</table>

**Predicted Incidents**

<table>
<thead>
<tr>
<th>Name</th>
<th>IW 2020</th>
<th>IW 2021</th>
<th>Score</th>
<th>Change %</th>
<th>Trend</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Predicted Incidents</td>
<td>1,864</td>
<td>1,080</td>
<td>0</td>
<td>-208.4%</td>
<td></td>
</tr>
</tbody>
</table>

**Monitoring Models tab**

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Incident Assignment</th>
<th>Business Value</th>
<th>Monitoring Models</th>
<th>Model Statistics</th>
</tr>
</thead>
</table>

**Estimated Net Automation**

Mar 18

81%

Change: 0 (0.0%)

**Actual Net Automation**

You can view the Net Automation Threshold graph on the **Monitoring Models** tab. This threshold is a computation of the difference between estimated net automation and the underperformance property values. Thresholds are calculated daily and notifications are sent to stakeholders when thresholds are breached.
View automatic comments on the **Actual Net Automation** indicator at various stages of the model monitoring. A comment is generated when any of the following model criteria exists:

- Model is integrated
- Model integration is removed
- Existing model is changed to a new model
- Integrated model is retrained

### Model Statistics tab

![Model Statistics Tab](image)

### End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process architect, process owner, or machine learning advocate:</td>
<td>Predictive Intelligence Workbench manager or viewer [piwb_manager] [piwb_viewer]</td>
<td>Ability to measure the value of using <strong>Predictive Intelligence</strong> to automate ITSM processes.</td>
</tr>
</tbody>
</table>
Indicators

Prediction Coverage for Incident

The score for this indicator is calculated according to the formula:
if ([[Number of attempted predictions based on Created Today for Incident]]==0){0}else{[[Number of applied predictions based on Created Today for Incident]]/[[Number of attempted predictions based on Created Today for Incident]]*100).

Number of predicted results based on final value date for incident

The number of predicted results is based on the final value date for an incident. The score is measured daily as unit #.

Net Automation for Incident

The score for this indicator is calculated according to the formula: 
[[Prediction Precision for Incident]]*[[Prediction Coverage for Incident]]/100.

Number of applied predictions based on Created Today for Incident

Number of applied predictions based on Created Today for Incident is measured daily as unit #.

Number of attempted predictions based on Created Today for Incident

Number of attempted predictions based on Created Today for Incident is measured daily as unit #.

The goal for this indicator is to maximize the quality of predictions.

Prediction Precision for Incident

The score for this indicator is calculated according to the formula:
if ([[Number of predicted results based on final value date for Incident]]==0){0}else{[[Number of successful predictions not skipped based on final value date for Incident]]/[[Number of predicted results based on final value date for Incident]]*100).

Estimated Net Automation

Estimated net automation measured daily as unit %.

Number of successful predictions not skipped based on final value date for Incident

Number of successful predictions not skipped based on final value date is measured daily as unit #. It is the count on data source MLPredictorResults.FinalValueDate.Incident, which is using the table: ml_predictor_results.

Number of Predicted for Incidents
Number of Predicted for Incidents is measured daily as unit #. It is the count on data source MLPredictorResults.CreatedToday.Incident, which is using the table: `ml_predictor_results`

### Breakdowns
- Use Case

### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predictions Skipped</td>
<td>Single Score</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Estimated precision. Estimated precision measured as unit %, based off the data the model was trained on.</td>
</tr>
<tr>
<td>Predictions Skipped Line</td>
<td>Line</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Predictions Skipped (num). Number of __, due to low confidence.</td>
</tr>
<tr>
<td>Class Distribution - Training Data</td>
<td>Bar</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Predicted solutions Skipped (line).</td>
</tr>
<tr>
<td>% Estimated Precision</td>
<td>Single Score</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Predicted Correctly (num). Number of __, comparing initial predicted value to final record value.</td>
</tr>
<tr>
<td>Classes Excluded due to Low Distribution</td>
<td>Single Score</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Predicted Correctly (line).</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Source table</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------</td>
<td>---------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Class Distribution - Actual</td>
<td>Bar</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Predicted Incorrectly (num). Number of ___, comparing initial predicted value to final record value.</td>
</tr>
<tr>
<td>Predicted Correctly</td>
<td>Single Score</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Predicted Incorrectly (line).</td>
</tr>
<tr>
<td>Predicted Correctly</td>
<td>Line</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Class Distribution, Training Data. Distribution of classes in data that the solution was trained on.</td>
</tr>
<tr>
<td>Predicted Incorrectly</td>
<td>Single Score</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Class Distribution, Actual. Current distribution of classes in live data.</td>
</tr>
<tr>
<td>Predicted Incorrectly</td>
<td>Line</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Predicted Predictor Classes. Number of values the model can return as a prediction.</td>
</tr>
<tr>
<td>Prediction Classes</td>
<td>Single Score</td>
<td>sn_piwb_itsm_conte_dbv_ml_predictor_results</td>
<td>Classes Excluded due. Number of values the model was not confident enough to return</td>
</tr>
</tbody>
</table>
Note: Regarding source tables, all indicators and reports are built off of newly added database views, combining ServiceNow platform Predictive Intelligence tables with Predictive Intelligence Workbench use case tables. With these new views, you can filter platform data by use case to better understand its impact on your metrics. All database views for this content application have a prefix of sn_piwb_itsm_conte_dbv.

Performance Analytics ITSM Dashboards

The ITSM Dashboards content pack provides several Analytics and Reporting Solutions that contain preconfigured dashboards. This content pack also includes several dashboards and indicators of its own. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can use Performance Analytics for your application with minimal setup. You can also create your own objects.

Important: Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

Note: Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure Analytics and Reporting Solutions.

To enable the solution plugin for ITSM dashboards, an admin can navigate to System Definitions > Plugins and activate the Performance Analytics - Content Pack - ITSM Dashboards plugin.

ITSM Dashboard solutions

The ITSM Dashboards plugin (com.snc.pa.itsm_dashboards) activates the following solutions, along with a set of additional dashboards:

- Change Management (com.snc.pa.change)
- Problem Management (com.snc.pa.problem)
- Request Management (Requested Item) (com.snc.pa.request)
• Request Management (Requests) (com.snc.pa.request2)
• Incident SLA (com.snc.pa.sla)
• Major Incident Management (com.snc.pa.incident.mim)
• Spotlight - Incident Spotlight Content Pack (com.snc.pa.spotlight.incident)

⚠ Note: For Performance Analytics Spotlight solutions, see Analytics and Reporting Spotlight solutions.

• Fixed Costs (com.snc.fixed_costs)

Inactive dashboards
Some dashboards in this content pack are inactive when installed. Complete configuration and run data collection jobs before you activate these dashboards. You can activate dashboards in Dashboard Properties, accessible from the context menu. You have to assign an owner to the dashboard to activate it. For more information about configuring Analytics and Reporting Solutions, see Configure Analytics and Reporting Solutions.

Add Self-Service Analytic widgets to the ITSM dashboards
If you have Self-Service Analytics activated on an instance, you can add Self-Service analytics widgets to your Performance Analytics dashboards or a Service Portal. To obtain a ready-made set of indicators and breakdowns, activate the Self-Service Analytics PA (com.snc.pa.self_service_analytics) plugin. Find the Self-Service indicators through the Performance Analytics Admin Console, then create widgets and add them to your dashboard or portal. Also activate the [SSA] Self-Service Analytics data collection job.

Related information
- Analytics and Reporting Solutions
- Activate your Performance Analytics subscription

IT Executive dashboard
See a high-level view across all of ITSM.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Executive</td>
<td>None</td>
</tr>
</tbody>
</table>

Indicators

% of new critical incidents

The result of the formula

\[
\left( \frac{\text{Number of new incidents > Priority = 1 - Critical}}{\text{Number of new incidents}} \right) \times 100
\]

% of new critical problems

The result of the formula

\[
\left( \frac{\text{Number of new problems > Priority = 1 - Critical}}{\text{Number of new problems}} \right) \times 100
\]

% of open incidents not updated in last 5 days

Number of open incidents not updated in last 5 days as a percentage of number of open incidents, according to the formula

\[
\left( \frac{\text{Number of open incidents not updated in last 5 days}}{\text{Number of open incidents}} \right) \times 100
\]
% of open requested items before due date

The result of the formula \( \frac{[[\text{Number of open requested items before due date}]]}{[[\text{Number of open requested items}]]} \times 100 \)

% of overdue requested items

The result of the formula \( 100 - \frac{[[\text{% of open requested items before due date}]]}{[[\text{Number of open requested items}]]} \)

Active Breached SLAs Today

The result in percentage of the formula \( \frac{[[\text{Number of breach task sla today}]][[\text{Number of active task sla}]]}{100} \)

Average age open incidents

The result, in days, of the formula \( \frac{[[\text{Summed age of open incidents}]][[\text{Number of open incidents}]]}{24} \)

Average Cost per Resolved Incident - Weekly

The result of the formula \( \frac{[[\text{Cost of Incidents Resolved / By week SUM +}]]}{[[\text{Number of resolved incidents / By week SUM +}]]}. \) In other words, the weekly sum of the cost of resolved incidents, including partial weeks, divided by the weekly sum of resolved incidents, including partial weeks.

Average reassignment of open incidents

The result of the formula \( \frac{[[\text{Summed re-assignment of open incidents}]][[\text{Number of open incidents}]}}{[[\text{Number of open incidents}]}} \)

Average resolution time of resolved incidents

The result of the formula \( \frac{[[\text{Summed duration of resolved incidents}]][[\text{Number of resolved incidents}]}}{24} \)

ITSM Average Overall Customer Satisfaction

Average of the normalized score for the Customer Satisfaction survey, as a result of the formula \( \frac{[[\text{ITSM normalized satisfaction score}]][[\text{ITSM survey instances}]}}{\text{[ITSM survey instances]}} \)

Number of new incidents

The number of incidents opened today

Number of new problems

The number of incidents opened today

Number of open incidents

Number of incidents with no Resolved date

Number of open incidents not updated in last 5 days
Number of open incidents with an Updated date of more than five days ago

**Number of open requested items**
Number of requests with a registration date on or before today and no closed date, or a closed date after today

**Number of open requested items before due date**
Number of requested items open today (before midnight on collection date) and a due date after midnight on the collection date.

**Number of resolved incidents**
Number of incidents with a value in the Resolved date field

The following indicators do not appear on the dashboard but are used in formulas:

**Cost of Incidents Resolved**
The daily sum of the Value field of incident_metric records where the Definition field value is Incident Resolution Fixed Cost.

**ITSM normalized satisfaction score**
Sum of the normalized score of metric results for the Customer Satisfaction survey

**ITSM survey instances**
Number of the survey instances of the Customer Satisfaction survey

**Number of active task sla**
The count of active SLA tasks on task_sla with a start time before today and a stop time after today.

**Number of breach task sla today**
The count of active SLA tasks on task_sla with a breach time before today

**Summed age of open incidents**
The sum of hours between the time an incident was opened and now

**Summed duration of resolved incidents**
The sum of hours between the time an incident was opened and the time it was resolved

**Summed reassignments of open incidents**
The summed reassignment count of all open incidents

**Breakdowns**

- Age (Requested Item, Incident)
- Assignment Group
- Backordered (Requested Item)
- Category (Incident)
- Contact Type (Incident)
- Item
- Opened by Department
- Priority (Requested Item, Incident, Problem)
- Requested by Department (Requested Item)
- SLA Definition
- Stage (Requested Item)
- State (Change, Request, Problem)

**IT Manager dashboard**

Follow the daily and weekly progress of incidents, problems, and requests for your assignment groups.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Manager - Needs to track the progress of their group in resolving incidents, problems, and requests</td>
<td>pa_viewer is required to see lists of indicators</td>
</tr>
</tbody>
</table>

Indicators

% Closed Requests with Breached SLA

The results of the formula: \( \left( \frac{\text{Number of Closed Requests with Breached SLAs}}{\text{Number of closed requests}} \right) \times 100 \)

% of incidents resolved by first assigned group

The results of the formula: \( \left( \frac{\text{Number of resolved incidents by first assigned group}}{\text{Number of resolved incidents}} \right) \times 100 \)

% of open incidents missed SLA
The percentage of open incidents that did not meet the SLA, as calculated by the formula
\[
\frac{\text{Number of incidents missed SLA}}{\text{Number of open incidents}} \times 100
\]

% of open incidents not updated in last 5 days

Number of open incidents not updated in last 5 days as a percentage of number of open incidents, according to the formula
\[
\left( \frac{\text{Number of open incidents not updated in last 5 days}}{\text{Number of open incidents}} \right) \times 100
\]

% of open incidents with problem

The result of the formula
\[
\frac{\text{Number of open incidents with problem}}{\text{Number of open incidents}} \times 100
\]

% of open problems not updated in last 30 days

The result of the formula
\[
\left( \frac{\text{Number of open problems not updated in last 30 days}}{\text{Number of open problems}} \right) \times 100
\]

% of open problems with at least one incident

The result of the formula
\[
\frac{\text{Number of open problems with at least one open incident}}{\text{Number of open problems}} \times 100
\]

% open and overdue incidents

The result of the formula
\[
\left( \frac{\text{Number of open and overdue incidents}}{\text{Number of open incidents that should be resolved in time}} \right) \times 100
\]

% Resolved Incidents with Breached SLA

The result of the formula
\[
\frac{\text{Number of Resolved Incidents with Breached SLAs}}{\text{Number of resolved incidents}} \times 100
\]

Active Breached SLAs Today

The result in percentage of the formula
\[
\frac{\text{Number of breach task sla today}}{\text{Number of active task sla}} \times 100
\]

Average age of open problems

The result, in days, of the formula
\[
\frac{\text{Summed age of open problems}}{\text{Number of open problems}} \div 24
\]

Average age of open requests

The result, in days, of the formula
\[
\frac{\text{Summed age of open requests}}{\text{Number of open requests}} \div 24
\]

Average age open incidents

The result, in days, of the formula
\[
\frac{\text{Summed age of open incidents}}{\text{Number of open incidents}} \div 24
\]
Average close time of requests

The result, in days, of the formula \[
\frac{\text{Summed duration of closed requests}}{\text{Number of closed requests}} / 24
\]

Average Cost per Incident

The result of the formula \[
\frac{\text{Cost of Incidents Resolved}}{\text{Number of resolved incidents}}
\], when the number of resolved incidents is more than zero.

Average Cost per Request

The result of the formula \[
\frac{\text{Cost of Requests Completed}}{\text{Number of completed requests}}
\], when the number of completed requests is more than zero.

Average Cost per Request - Weekly

The result of the formula \[
\frac{\text{Cost of Requests Completed / By week SUM} +}{\text{Number of completed requests / By week SUM} +}
\]. In other words, the weekly sum of the cost of completed requests, including partial weeks, divided by the weekly sum of completed requests, including partial weeks.

Average Cost per Resolved Incident - Weekly

The result of the formula \[
\frac{\text{Cost of Incidents Resolved / By week SUM} +}{\text{Number of resolved incidents / By week SUM} +}
\]. In other words, the weekly sum of the cost of resolved incidents, including partial weeks, divided by the weekly sum of resolved incidents, including partial weeks.

Average reassignments of open and overdue incidents

The result of the formula \[
\frac{\text{Summed reassignments of open and overdue incidents}}{\text{Number of open and overdue incidents}}
\]

Average resolution time of resolved incidents

The result of the formula \[
\frac{\text{Summed duration of resolved incidents}}{\text{Number of resolved incidents}} / 24
\]

Closed workload

The result of the formula \[
\text{Number of closed incidents} + \text{Number of closed problems} + \text{Number of closed requests}
\]

ITSM Average Overall Customer Satisfaction

Average of the normalized score for the Customer Satisfaction survey, as a result of the formula \[
\frac{\text{ITSM normalized satisfaction score}}{\text{ITSM survey instances}}
\]
New workload

The result of the formula \([\text{Number of new incidents}] + [\text{Number of new problems}] + [\text{Number of new requests}]\)

Number of closed complete requests

Number of requests closed today as complete (State = Complete)

Number of closed incidents

The number of incidents closed today

Number of closed problems

The number of problems closed today

Number of closed requests

The number of requests closed today

Number of Closed Requests with Breached SLAs

Count Distinct of SLA tasks \([\text{task}\_\text{sla}]\) with a task type of Request, Has breached = true, Stage != Cancelled, and closed today

Number of new incidents

The number of incidents opened today

Number of new problems

The number of incidents opened today

Number of new requests

The number of incidents opened today

Number of open changes planned in the next 7d

The number of Change Request \([\text{change}\_\text{request}]\) records opened today with a Planned Start date between today and the end of next week

Number of open incident unassigned

The number of open incidents not assigned to anyone

Number of open incidents

Number of incidents with no Resolved date

Number of open incidents not updated in last 5 days

Number of open incidents with an Updated date of more than five days ago

Number of open and overdue incidents
The number of open incidents related to an SLA task that is not in the Cancelled stage (task_sla.stage) and has an actual elapsed percentage greater than 100% (task_sla.percentage).

**Number of open incidents that should be resolved in time**

The count distinct of open incidents associated with an SLA task [task_sla] that is not in the Cancelled stage.

**Number of open incidents with problem**

The number of open incidents with a value in the Problem field

**Number of open problems**

The number of problems opened on or before today and not yet closed.

**Number of open problems not updated in last 30 days**

Number of open problems with an Updated date of more than 30 days ago

**Number of open problems with at least one open incident**

The count distinct of open incidents where the Problem Active field value is true.

**Number of open requests**

Number of requests opened on or before today and not yet closed

**Number of requests closed after due date**

Number of requests that are closed after request due date (sc_request.closed_at > sc_request.due_date)

**Number of resolved incidents**

Number of incidents with a value in the Resolved date field

**Number of resolved incidents by first assigned group**

Number of incidents that were resolved by the first group assigned to them

**Open workload**

The result of the formula \([\text{Number of open incidents}] + [\text{Number of open problems}] + [\text{Number of open requests}]\)

**Predicted Average Cost of Open Incidents**

The result of the formula \([\text{Cost of Incidents Resolved / By week SUM} +] / [\text{Number of resolved incidents / By week SUM} +] * [\text{Number of open incidents}]\)
Predicted Average Cost of Open Requests

The result of the formula \[ \frac{[[\text{Cost of Requests Completed} / \text{By week }] \text{SUM} +]}{[[\text{Number of requests completed} / \text{By week }] \text{SUM} +]} \times [[\text{Number of open requests}]] \]

Workload backlog growth

The result of the formula \[ [[\text{New workload}]] - [[\text{Closed workload}]] \]

The following indicators do not appear on the dashboard but are used in formulas:

**Cost of Incidents Resolved**

The daily sum of the Value field of incident_metric records where the Definition field value is Incident Resolution Fixed Cost.

**Cost of Requests Completed**

The daily sum of the Value field of sc_request_metric records where the Definition field value is Request Resolution Fixed Cost.

**ITSM normalized satisfaction score**

Sum of the normalized score of metric results for the Customer Satisfaction survey

**ITSM survey instances**

Number of the survey instances of the Customer Satisfaction survey

**Number of active task sla**

The count of active SLA tasks on task_sla with a start time before today and a stop time after today.

**Number of breach task sla**

The count of active SLA tasks on task_sla with a breach time before today.

**Number of incidents missed SLA**

The number of records on the incident_sla table created on or before today, not yet closed, and that have breached SLA.

**Number of open incidents with problem**

The count of open incidents with a Problem referenced in the Problem field.

**Number of Resolved Incidents with Breached SLAs**

Number of Incident-type SLA tasks that are not cancelled, that were resolved today, and where Has Breached is true.
Summed age of open incidents
   The sum of hours between the time an incident was opened and now

Summed age of open problems
   The sum of hours between the time a problem was opened and now

Summed age of open requests
   The sum of hours between the time a request was opened and now

Summed duration of closed requests
   The sum of hours between the time a request was opened and the time it was closed

Summed duration of resolved incidents
   The sum of hours between the time an incident was opened and the time it was resolved

Summed reassignments of open and overdue incidents
   The summed reassignment count of all open Incident SLAs

Breakdowns
• Age (Request, Incident, Problem, and Change)
• Assignment Group
• Category (Incident, Change)
• Contact Type (Incident, Request)
• Location
• Priority (Request, Incident, Problem, and Change)
• Risk (Change)
• SLA
• SLA Definition
• State (Change, Request, Problem)

Define fixed costs for IT Manager dashboard
Define generic industry-based fixed costs to analyze impact by channel using the IT Manager dashboard in ITSM Performance Analytics Solutions.

Before you begin
Role required: admin
About this task

Use the fixed cost model to analyze the cost for incidents and requests across channels (email, phone, self-service, walk-up, virtual agent) for cost management. For example, view current costs per channel and verify whether costs are reduced over time after implementing a solution.

Cost definitions are stored in the Fixed Cost Definitions [fixed_cost_definitions] table.

<table>
<thead>
<tr>
<th>Area</th>
<th>KPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume</td>
<td>Total number of incidents</td>
</tr>
<tr>
<td></td>
<td>Total number of requests</td>
</tr>
<tr>
<td>FCR</td>
<td>Number of incidents resolved on first assignment</td>
</tr>
<tr>
<td></td>
<td>Number of requests resolved on first assignment</td>
</tr>
<tr>
<td>MTTR</td>
<td>Average time to resolve an incident</td>
</tr>
<tr>
<td></td>
<td>Average time to resolve a request</td>
</tr>
<tr>
<td>SLA</td>
<td>% of incidents that breached SLAs</td>
</tr>
<tr>
<td></td>
<td>% of requests that breached SLAs</td>
</tr>
</tbody>
</table>

$23.4

No data available
Incident and request KPIs (continued)

<table>
<thead>
<tr>
<th>Area</th>
<th>KPI</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Average customer satisfaction score</td>
</tr>
<tr>
<td>Cost</td>
<td>Average cost to resolve an incident</td>
</tr>
<tr>
<td></td>
<td>Average cost to resolve a service request</td>
</tr>
</tbody>
</table>

Breakdown:
- Assignment group
- Agent
- Skill

Procedure
Navigating to **Fixed Costs > Define Fixed Cost** (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Description of the cost.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that contains the field for the fixed cost condition.</td>
</tr>
<tr>
<td>Filter</td>
<td>Condition for the fixed cost definition, if applicable.</td>
</tr>
<tr>
<td>Cost Value</td>
<td>Currency type and fixed cost value.</td>
</tr>
<tr>
<td>Category</td>
<td>Category of the fixed cost.</td>
</tr>
<tr>
<td></td>
<td>• Total Fully Loaded Cost</td>
</tr>
<tr>
<td></td>
<td>• Per Hour Cost</td>
</tr>
<tr>
<td>Source of the Cost</td>
<td>Source of the fixed cost.</td>
</tr>
<tr>
<td></td>
<td>• HDI</td>
</tr>
<tr>
<td></td>
<td>• ServiceNow</td>
</tr>
<tr>
<td></td>
<td>• Manual</td>
</tr>
</tbody>
</table>
### Example: Cost per Network Incident

**Fixed Cost Definitions form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>Incident in Network Category</td>
</tr>
<tr>
<td>Table</td>
<td>Incident [incident]</td>
</tr>
<tr>
<td>Filter</td>
<td>Category is Network</td>
</tr>
<tr>
<td>Cost Value</td>
<td>$15.56</td>
</tr>
<tr>
<td>Category</td>
<td>Total Fully Loaded Cost</td>
</tr>
<tr>
<td>Source of the Cost</td>
<td>HDI</td>
</tr>
<tr>
<td>Active</td>
<td>Selected</td>
</tr>
</tbody>
</table>

### IT Agent dashboard

View the open incidents, problems, and requests that belong to you and your assignment groups through personalized reports. You can also see which incidents that belong to your assignment groups exceed the Spotlight threshold.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Agent - see only those incidents, problems, and requests that concern you</td>
<td>None, but to see Spotlight reports you need the <code>pa_spotlight_viewer</code> role.</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open unassigned incidents</td>
<td>Single score</td>
<td>Incidents that belong to one of your assignment groups do not have a person assigned to them</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open requests</td>
<td>Single score</td>
<td>Open requests that belong to you or one of your groups</td>
</tr>
<tr>
<td>Critical incidents</td>
<td>Single score</td>
<td>Incidents with a Priority of 1 - Critical that belong to you or one of your groups</td>
</tr>
<tr>
<td>My open problems - Heatmap</td>
<td>Heatmap</td>
<td>Your problems by assignment group and priority</td>
</tr>
<tr>
<td>Incidents above Spotlight threshold</td>
<td>Single score</td>
<td>Incidents belonging to one of your groups that meet enough Spotlight criteria to exceed the Spotlight threshold</td>
</tr>
<tr>
<td>My open requests</td>
<td>Single score</td>
<td>Open requests that belong to you</td>
</tr>
<tr>
<td>My open incidents - Heatmap</td>
<td>Heatmap</td>
<td>Your incidents by assignment group and priority</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open incidents</td>
<td>Single score</td>
<td>Open incidents that belong to you or one of your groups</td>
</tr>
<tr>
<td>Open incidents not updated in last 7 days</td>
<td>Single score</td>
<td>Open incidents that belong to you or one of your groups and have not been updated for the last 7 days</td>
</tr>
<tr>
<td>My open requests - Heatmap</td>
<td>Heatmap</td>
<td>Your requests by assignment group and priority</td>
</tr>
<tr>
<td>Open problems</td>
<td>Single score</td>
<td>Open problems that belong to you or one of your groups</td>
</tr>
<tr>
<td>Spotlight incidents P1 - Critical</td>
<td>Single score</td>
<td>Incidents belonging to your group that exceed the Spotlight threshold and have a priority of P1 - Critical</td>
</tr>
<tr>
<td>My open problems</td>
<td>Single score</td>
<td>Open problems that belong to you</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Spotlight incidents - Unassigned</td>
<td>Single score</td>
<td>Incidents belonging to one of your groups that exceed the Spotlight threshold and have no one assigned to them</td>
</tr>
<tr>
<td>My open incidents</td>
<td>Single score</td>
<td>Open incidents that belong to you</td>
</tr>
<tr>
<td>Incidents Spotlight - List</td>
<td>List</td>
<td>A list of all incidents that one of your groups own and that exceed the Spotlight threshold</td>
</tr>
</tbody>
</table>

**ITSM Mobile Agent**

The new ITSM Mobile Agent app delivers out of the box mobile-first experiences designed for agents to triage, act on, and resolve incidents on the go. ITSM Mobile Agent improves productivity with an intuitive interface to manage all the work, view schedules, check who is on-call, respond to major incidents, and more.

Watch this three-minute video to learn about the Mobile Agent app for managing incidents. This video covers: Accessing the Incidents from the ITSM Mobile Agent app; viewing incident details and activity; editing an incident and adding comments; resolving, assigning or reassigning an incident; and viewing incident notifications.

Overview of ITSM Mobile application
Get started with ITSM Mobile agent

Access ITSM mobile agent on your mobile to manage incidents, view, and update on-call schedules.

Before you begin
Download ITSM mobile agent on an iOS platform from the Apple app Store or on an Android platform from Google Play Store.
Time required for this task: 10-15 minutes.

Procedure
1. Tap the mobile app icon on your device, and then tap the plus button to login to an instance.
2. In the instance address field, enter the instance address in one of two ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual input</td>
<td>Type the instance address in the instance address field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You do not need to include service-now.com at the end of the instance name.</td>
</tr>
<tr>
<td>Scan QR code</td>
<td>Tap the QR icon (Scan a QR code), and then scan the QR code given by your administrator.</td>
</tr>
</tbody>
</table>

3. Optional: Enter a nickname for this instance. If you have multiple instances added to the device, nicknames can help you quickly locate a Now Platform instance.
4. Tap Save and Login.
   The ITSM Agent mobile landing screen opens. You can search for incidents, change tasks and more using the search bar on top of the landing screen.

My work
Use the My work applet in the ITSM mobile agent to perform various functions from the mobile.
As an agent, you can:
• Easily access incidents, change tasks, and catalog tasks.
• Take quick actions and provide timely updates.
• Add work notes or comments, update incident details, assign incidents to other agents.
• Easily access change requests and request approvals.

From the main screen of the agent mobile app, you can directly create an incident using a single click.

Create an incident from app landing page
Create an incident directly from your agent mobile app landing page with a single tap.

Procedure
1. On your agent mobile app landing page, click on the
   
   ![Create Incident Icon](image)

   to create an incident directly from the landing screen.
2. Fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caller</td>
<td>Tap on the arrow to search and choose a caller to whom this incident should be assigned.</td>
</tr>
<tr>
<td>Urgency</td>
<td>Populate the urgency of the incident. The available options are:</td>
</tr>
<tr>
<td></td>
<td>• 1 - High</td>
</tr>
<tr>
<td></td>
<td>• 2 - Medium</td>
</tr>
<tr>
<td></td>
<td>• 3 - Low</td>
</tr>
<tr>
<td>Short description</td>
<td>Provide a brief description of the incident.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide the detailed description of the incident.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assignment group</td>
<td>Tap the arrow to search and choose an assignment group to which the incident should be assigned.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Tap the arrow to search and choose a person from the assignment group.</td>
</tr>
<tr>
<td>Service</td>
<td>Tap the arrow to search and choose the service to which the incident belongs.</td>
</tr>
<tr>
<td>Configuration item</td>
<td>Tap the arrow to choose the configuration item for the incident.</td>
</tr>
</tbody>
</table>

**My incidents**

Use the My incidents applet to work on the incidents that are assigned to you.

**About this task**

Resolve, reassign the incident, or add comments to an incident assigned to you. Add work notes, view the details of an incident, or edit an incident, all from a single screen on your mobile.

**Procedure**

1. On the ITSM mobile agent landing screen, tap **See All** on the **My incidents** applet.
   The **Assigned Incidents** screen opens with a list of incidents.
2. If you want to reduce the number of records on the screen, see **Filter records** to search for records that match specific search criteria.
3. On the **Assigned incidents** screen with the list of incidents, swipe left on an incident to open the menu.
4. On the menu, choose one of the actions to process the incident.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add comments</td>
<td>Add any additional comments or work notes about the incident in this field and tap &gt;.</td>
</tr>
<tr>
<td>Reassign</td>
<td>Use this action to reassign an incident to another agent. On the Reassign incident screen, tap the Assignment group field to change the assignment group, select the agent from the list in the Assigned to field and add any notes in the Work notes, and tap &gt; to submit.</td>
</tr>
<tr>
<td>Resolve</td>
<td>On the Resolve incident screen, tap the Resolution code field and choose a code for the resolution, add notes in the Resolution notes field, and tap &gt;.</td>
</tr>
</tbody>
</table>

5. On the Assigned incidents screen, tap a record on the list to open it and view more details.

6. On the My Incidents screen, choose one of the actions in the table as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DETAILS tab</td>
<td>Choose one to continue.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>• View the fields for details about the incident. The fields with an arrow have additional information. &lt;br&gt;• At the top right of the screen, tap the menu icon to reassign, edit, or propose the incident as a major incident. &lt;br&gt;• Add any additional comments using the Add comments button. &lt;br&gt;• Resolve the incident after adding a resolution code and notes using the Resolve button.</td>
<td></td>
</tr>
</tbody>
</table>

**ACTIVITY tab**<br>View the activity on the incident like field changes or assignment changes. Tap the add icon to perform any of the following activities on the incident.<br><br>a. **Record Video**: Record a video to be attached to the incident. <br>b. **Open Gallery**: Open your photo gallery to attach an existing image or a video to the incident. <br>c. **Take Photo**: Take a picture and attach it to the incident <br>d. **Attach File**: Attach a file from another application to the incident. <br>e. **Add Additional Comments**: Add any additional comments to the incident.  

**Note**: The comments can be made visible to the customer if you enable them using the toggle bar on the Additional Comments field. <br>  
f. **Add Work Notes**: Add your work notes on the incident. | |

**RELATED tab**<br>View the related lists of the incident, such as, child incidents, task SLAs, impacted services, and affected CIs. Tap on the arrow to view more details of these related items.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CALLS tab</td>
<td>View the list of all the calls related to an incident. Tap on any of the calls to <strong>Add participants</strong> or to <strong>Join call</strong>. Tap on the menu on top of the Conference Call page and tap <strong>End call</strong> to end the call.</td>
</tr>
</tbody>
</table>

**Filter records**

Set additional filters to limit the number of records that are displayed on a screen. Filtering records in the mobile app works like filtering with a condition builder on the Now Platform.

**Before you begin**

Role required: itil or group manager

**Procedure**

1. To further refine your search results, or to enter additional filter criteria on any list of records that is displayed, tap the filter icon.

2. On the Filters screen that appears, tap the arrow on a field to expand it.

3. From the options available, tap the check box or tap an option for your filter. For many of the filters, you can select more than one option.

4. Tap the Back icon or **DONE** to save your changes to a field. The criteria you chose displays on the Filters screen. The number of records that match your criteria also display on the top of the screen. Tap **Clear** or **RESET** to remove any filters and restore the default setting.

5. **Optional:** Repeat steps 1-4 with the Filters screen displayed to continue setting your filter criteria.

6. Tap the intersection union after you set all criteria to create **AND** conditions. Alternatively, tap the union icon to create **OR** conditions.

7. After you have added all the criteria you want, tap **DONE**. The incident records that match your filter criteria display on the screen.

**Collaboration with incidents**

Initiate and manage the collaboration for incident records from the ITSM Mobile Agent app.
Initiate a chat with the caller from an incident

Initiate a chat with the caller from an incident to discuss about the resolution of an incident.

Before you begin
Role required: itil, itil_admin, or admin

Procedure
1. Open ITSM Mobile Agent app.
2. In My work tab, tap See All.
3. Tap the incident record you want to work on.
4. Tap on **Caller**.

5. Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate chat in Slack</td>
<td>Tap on the Slack contact.</td>
</tr>
<tr>
<td>Initiate chat in Microsoft Teams</td>
<td>Tap on the Microsoft Teams contact.</td>
</tr>
</tbody>
</table>
**Note:** The Slack and the Microsoft Teams contacts display only if the caller has a valid Slack and Microsoft Teams accounts.

### Initiate a chat with the assignment group from an incident

Initiate a chat with the assignment group members from an incident to discuss about the resolution of an incident.

**Before you begin**

Role required: itil, itil_admin, or admin

**Procedure**

1. Open ITSM Mobile Agent app.
2. In **My work** tab, tap **See All**.
3. Tap the incident record you want to work on.
4. Tap on Assignment group.
5. Do one of the following:

<table>
<thead>
<tr>
<th>Assignment group</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Initiate chat in Slack</strong></td>
<td>Tap on Slack assignment group.</td>
</tr>
<tr>
<td><strong>Initiate chat in Microsoft Teams</strong></td>
<td>Tap on the Microsoft Teams assignment group.</td>
</tr>
</tbody>
</table>
Note: The Slack and the Microsoft Teams assignment group contact will be displayed only if the assignment group has a valid Slack and Microsoft Teams accounts.

You can also interact with a user from the assignment group. Tap on the assignment group, and then tap on a user and select either Slack or Microsoft Teams to initiate a conversation.

Initiate a conference call with the caller from an incident

Initiate a conference call from an incident to discuss about the resolution of an incident.

Before you begin
Role required: itil, itil_admin, or admin
Procedure

1. Open ITSM Mobile Agent app.
2. In My work tab, tap See All.
3. Tap the incident record you want to work on.
4. Tap ⬤. 

5. Tap Start call button. 

6. Provide the following details: 
   a. Conference bridge: Tap Conference bridge and select Microsoft Teams. 
   b. Users: Select the users. 
   c. Groups: Select the required group.
7. Tap **Submit**.

**Add participants to a conference call from an incident**

Add participants to an active conference call from an incident to discuss about the resolution of an incident.

**Before you begin**
Role required: itil, itil_admin, or admin

**Procedure**
1. Open ITSM Mobile Agent app.
2. In **My work** tab, tap **See All**.
3. Open the incident where the conference call is originated.
4. Tap **Collaborate**.
5. Tap on the active conference call.
6. Tap **Add participants**.
7. Provide the following details:

- **Recommended participants**: The list of participants associated with the incident will be displayed. Select the required users, and tap **Submit**.
- **Users**: Select the required users, and tap **Submit**.
- **Groups**: Select the required group, and tap **Submit**.
8. In the **Add participants** screen, click **Submit**.

**Join an active conference call from an incident**

You can join an active conference call from an incident to discuss about the resolution of an incident.

**Before you begin**

Role required: itil, itil_admin, or admin

**Procedure**

1. Open ITSM Mobile Agent app.
2. In **My work** tab, tap **See All**.
3. Open the incident where the conference call is originated.

4. Tap **Collaborate**.
5. Tap on the active conference call.
6. Tap on the conference call.
7. Tap **Join call**.

View active collaborations
As an incident manager, you can view all the active collaborations for the incidents.

**Before you begin**
Role required: itil, itil_admin, or admin
Procedure

1. Open ITSM Mobile Agent app.
2. In My work tab, tap See All.
3. Tap on an incident.
4. Tap Collaborate.
Each collaboration displays:

Assessment: ATF Assessor
State: In Progress
Caller survey user

Collaboration details:
- Slack
  Assessment: ATF Assessor
  Created: 2021-01-07 00:36:53
  # inc0010112-withpublicwithcutkevin

- Slack
  Assessment: ATF Assessor
  Created: 2021-01-07 00:32:28
  # inc0010112-withpublicwithslack

- Slack
  Assessment: ATF Assessor
  Created: 2021-01-07 00:29:16
  inc0010112-withoutkevin

- Slack
  Assessment: ATF Assessor
  Created: 2021-01-07 00:15:53

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Application: Slack/Microsoft Teams

• Collaboration title

• Incident created date and timestamp

• Channel name: Channel marked with “#” is a public channel. Any user can view the conversation. Channel that doesn’t contain a “#” is a private channel, this channel isn’t accessible to public users. Only the collaborators can view the chat conversation.
5. Swipe and tap **View** to view the conversation in the respective application.
View active and inactive participants in the conference call
You can view the participant status in an active conference call.

Before you begin
Role required: itil, itil_admin, or admin

Procedure
1. Open ITSM Mobile Agent app.
2. In My work tab, tap See All.
3. Open the incident where the conference call is originated.
4. Tap **Collaborate**.

5. Tap on the active conference call.
6. Do one of the following:

**Participant status**

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active</strong></td>
<td>Tap <strong>Active</strong> to view the active participants</td>
</tr>
<tr>
<td><strong>Inactive</strong></td>
<td>Tap <strong>Inactive</strong> to view the inactive participants</td>
</tr>
</tbody>
</table>

**End a conference call**

As a host or a user with the incident manager role, you can end the conference call.

**Before you begin**

Role required: itil, itil_admin, or admin
Procedure

1. Open ITSM Mobile Agent app.
2. In My work tab, tap See All.
3. Open the incident where the conference call is originated.
4. Tap Collaborate.
5. Tap on the active conference call.
6. Tap 

7. Tap End call.

Collaboration with incident tasks
Initiate and manage the collaboration for incident task records from the ITSM Mobile Agent app.

Initiate a conference call from an incident task
Initiate a conference call from an incident task record to discuss about the resolution of an incident.

Before you begin
Role required: itil, itil_admin, or admin

Procedure
1. Open ITSM Mobile Agent app.
2. In My work tab, tap See All.
3. Tap the incident record you want to work on.
4. Tap Related > Incident tasks.
5. Tap on the incident task record.
6. Tap ✅.

7. Tap Start call.

8. Provide the following details:

   a. **Conference bridge**: Tap Conference bridge and select Microsoft Teams
   b. **Users**: Select the users.
   c. **Groups**: Select the required group.
9. Tap **Submit**.

**Add participants to a conference call from an incident task**

Add participants to an active conference call with the caller from an incident task to discuss about the resolution of a task.

**Before you begin**

Role required: itil, itil_admin, or admin

**Procedure**

1. Open ITSM Mobile Agent app.
2. In **My work** tab, tap **See All**.
3. Tap the incident record you want to work on.
4. Tap Related > Incident tasks.
5. Tap on the incident task record.
6. Tap Collaborate > Conference calls > Active.
7. Tap on the conference call.
8. Tap Add participants, and provide the following details:
   a. Recommended participants: The list of participants associated with the incident will be displayed. Select the required users, and tap Submit.
   b. Users: Select the required users, and tap Submit.
   c. Groups: Select the required group, and tap Submit.
9. In the Add participants screen, click Submit.

Join an active conference call from an incident task
You can join an active conference call from an incident task record to discuss about the resolution of an incident.

Before you begin
Role required: itil, itil_admin, or admin

Procedure
1. Open ITSM Mobile Agent app.
2. In My work tab, tap See All.
3. Tap the incident record you want to work on.
4. Tap Related > Incident tasks.
5. Tap on the incident task record.

6. Tap **Collaborate > Conference calls > Active**.

7. Tap on the conference call.
8. Tap **Join call**.

View active and inactive participants in the conference call
You can view the participant status in an active conference call.

**Before you begin**
Role required: itil, itil_admin, or admin

**Procedure**
1. Open ITSM Mobile Agent app.
2. In **My work** tab, tap **See All**.
3. Tap the incident record you want to work on.
4. Tap Related > Incident tasks.
5. Tap on the incident task record.
6. Tap **Collaborate** > **Conference calls** > **Active**.
7. Tap on the conference call.
8. Do one of the following:

<table>
<thead>
<tr>
<th>View participant status</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>Active</td>
</tr>
</tbody>
</table>
### End a conference call

As a host or a user with the incident manager role, you can end the conference call.

#### Before you begin

**Role required:** itil, itil_admin, or admin

#### Procedure

1. Open ITSM Mobile Agent app.
2. In **My work** tab, tap **See All**.
3. Tap the incident record you want to work on.

4. Tap Related > Incident tasks.
5. Tap on the incident task record.
6. Tap **Collaborate** > **Conference calls** > **Active**.
7. Tap on the conference call.
8. Tap ❓.
9. Tap End call.

Incidents at risk

View a list of incidents at risk and work on them from your mobile.

Related information

- Process an incident at risk

Filter records

Set additional filters to limit the number of records that are displayed on a screen. Filtering records in the mobile app works like filtering with a condition builder on the Now Platform.

Before you begin

Role required: itil or group manager
### Procedure

1. To further refine your search results, or to enter additional filter criteria on any list of records that is displayed, tap the filter icon 📦.

2. On the Filters screen that appears, tap the arrow on a field to expand it.

3. From the options available, tap the check box or tap an option for your filter. For many of the filters, you can select more than one option.

4. Tap the Back icon ⬅️ or DONE to save your changes to a field.
   The criteria you chose displays on the Filters screen. The number of records that match your criteria also display on the top of the screen. Tap Clear or RESET to remove any filters and restore the default setting.

5. **Optional:** Repeat steps 1-4 with the Filters screen displayed to continue setting your filter criteria.

6. Tap the intersection union after you set all criteria to create AND conditions. Alternatively, tap the union icon ⬈️✈️ to create OR conditions.

7. After you have added all the criteria you want, tap DONE. The incident records that match your filter criteria display on the screen.

### Process an incident at risk

Work on an incident at risk from your mobile.

**Before you begin**
Role required: itil

**About this task**
Resolve, reassign the incident, or add comments to an incident assigned to you.

**Procedure**

1. On the ITSM mobile agent landing screen, tap the Incidents at risk applet. The Incidents at risk screen opens with a list of incidents.

2. If you want to reduce the number of records on the screen, see Filter records to search for records that match specific search criteria.

3. On the Incidents at risk screen with the list of incidents, swipe left on an incident to open the menu.

4. On the menu, choose one of the actions to process the incident.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add comments</td>
<td>Add any additional comments or work notes about the incident in this field and tap ➤.</td>
</tr>
<tr>
<td>Reassign</td>
<td>Use this action to reassign an incident to another agent. On the Reassign incident screen, tap the <strong>Assignment group</strong> field to change the assignment group, select the agent from the list in the <strong>Assigned to</strong> field and add any notes in the <strong>Work notes</strong> and tap ➤ to submit.</td>
</tr>
<tr>
<td>Resolve</td>
<td>On the Resolve incident screen, tap the <strong>Resolution code</strong> field and choose a code for the resolution, add notes in the <strong>Resolution notes field</strong>, and tap ➤.</td>
</tr>
</tbody>
</table>

5. On the **Incidents at risk** screen, tap a record on the list to open it and view more details.

6. On the **Incidents at risk** screen as shown in the following figure, choose one of the actions in the table as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| DETAILS tab | Choose one to continue.  
• View the fields for details about the incident. The fields with an arrow have additional information.  
• At the top right of the screen, tap the menu icon ➞ to reassign, edit, or propose the incident as a major incident.  
• Add any additional comments using the **Add comments** button.  
• Resolve the incident after adding a resolution code and notes using the **Resolve** button. |
<p>| ACTIVITY tab | View the activity on the incident like field changes or assignment changes. Tap the add icon ➕ to |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>perform any of the following activities on the incident.</td>
</tr>
<tr>
<td>a. Record Video</td>
<td>Record a video to be attached to the incident.</td>
</tr>
<tr>
<td>b. Open Gallery</td>
<td>Open your photo gallery to attach an existing image or a video to the incident.</td>
</tr>
<tr>
<td>c. Take Photo</td>
<td>Take a picture and attach it to the incident.</td>
</tr>
<tr>
<td>d. Attach File</td>
<td>Attach a file from another application to the incident.</td>
</tr>
<tr>
<td>e. Add Additional Comments</td>
<td>Add any additional comments to the incident.</td>
</tr>
<tr>
<td>f. Add Work Notes</td>
<td>Add your work notes on the incident.</td>
</tr>
</tbody>
</table>

Note: The comments can be made visible to the customer if you enable them using the toggle bar on the Additional Comments field.

| RELATED tab               | View the related lists of the incident, such as, child incidents, task SLAs, impacted services, and affected CIs. Tap on the arrow to view more details of these related items. |
| CALLS tab                 | View the list of all the calls related to an incident. Tap on any of the calls to Add participants or to Join call. Tap on the menu on top of the Conference Call page and tap End call to end the call. |

**Breached Incidents**

View a list of all the breached incidents of your group and take appropriate action on these incidents.

**Filter records**

Set additional filters to limit the number of records that are displayed on a screen. Filtering records in the mobile app works like filtering with a condition builder on the Now Platform.
Before you begin
Role required: ITIL or group manager

Procedure
1. To further refine your search results, or to enter additional filter criteria on any list of records that is displayed, tap the filter icon.
2. On the Filters screen that appears, tap the arrow on a field to expand it.
3. From the options available, tap the check box or tap an option for your filter. For many of the filters, you can select more than one option.
4. Tap the Back icon or DONE to save your changes to a field. The criteria you chose displays on the Filters screen. The number of records that match your criteria also display on the top of the screen. Tap Clear or RESET to remove any filters and restore the default setting.
5. Optional: Repeat steps 1-4 with the Filters screen displayed to continue setting your filter criteria.
6. Tap the intersection union after you set all criteria to create AND conditions. Alternatively, tap the union icon to create OR conditions.
7. After you have added all the criteria you want, tap DONE. The incident records that match your filter criteria display on the screen.

Process a breached incident
View and manage the breached incident from the mobile.

Before you begin
Role required: admin

Procedure
1. On the ITSM mobile agent landing screen, tap the Breached incident applet. The Breached incidents screen opens with a list of incidents.
2. If you want to reduce the number of records on the screen, see Filter records to search for records that match specific search criteria.
3. On the Breached incidents screen with the list of incidents, swipe left on an incident to open the menu.
4. On the menu, choose one of the actions as described in the table.
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add comments</td>
<td>Add any additional comments or work notes about the incident in this field and tap ➡️.</td>
</tr>
<tr>
<td>Reassign</td>
<td>Use this action to reassign an incident to another agent. On the Reassign incident screen, tap the <strong>Assignment group</strong> field to change the assignment group, select the agent from the list in the <strong>Assigned to</strong> field, and add any notes in the <strong>Work notes</strong>, and tap ➡️ to submit.</td>
</tr>
<tr>
<td>Resolve</td>
<td>On the Resolve incident screen, tap the <strong>Resolution code</strong> field and choose a code for the resolution, add notes in the <strong>Resolution notes</strong> field, and tap ➡️.</td>
</tr>
</tbody>
</table>

5. On the **Breached incidents** screen, tap a record on the list to open it and view more details.

6. On the **Breached incidents** screen, as shown in the following figure, choose one of the actions in the table as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DETAILS tab</td>
<td>Choose one to continue.</td>
</tr>
<tr>
<td></td>
<td>• View the fields for details about the incident. The fields with an arrow have additional information.</td>
</tr>
<tr>
<td></td>
<td>• At the top right of the screen, tap the menu icon ➕ to reassign, edit, or propose the incident as a major incident.</td>
</tr>
<tr>
<td></td>
<td>• Add any additional comments using the <strong>Add comments</strong> button.</td>
</tr>
<tr>
<td></td>
<td>• Resolve the incident after adding a resolution code and notes using the <strong>Resolve</strong> button.</td>
</tr>
<tr>
<td>ACTIVITY tab</td>
<td>View the activity on the incident like field changes or assignment changes. Tap ➕ to perform any of the following activities on the incident.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
a. **Record Video:** Record a video to be attached to the incident.
b. **Open Gallery:** Open your photo gallery to attach an existing image or a video to the incident.
c. **Take Photo:** Take a picture and attach it to the incident.
d. **Attach File:** Attach a file from another application to the incident.
e. **Add Additional Comments:** Add any additional comments to the incident.

**Note:** The comments can be made visible to the customer if you enable them using the toggle bar on the Additional Comments field.
f. **Add Work Notes:** Add your work notes on the incident.

### RELATED tab
View the related lists of the incident, such as, child incidents, task SLAs, impacted services, and affected CIs. Tap on the arrow to view more details of these related items.

### CALLS tab
View the list of all the calls related to an incident. Tap on any of the calls to **Add participants** or to **Join call**. Tap on the menu on top of the Conference Call page and tap **End call** to end the call.

### Change tasks
View and work on the change tasks assigned to you. You can view the details, activities, and other related change tasks by a single tap on the ITSM mobile agent app.

Tap on the card to access all the change tasks assigned to you.

1. You can **filter** the list according to your set criteria.
2. Swipe left to add comments to the task or close the task.
3. On the **Change Tasks** screen, tap on any task to view the details, activity and related change tasks. You can add comments or close a task from this screen.

    **Note:** Each change task card shows you the risk value of the task. For example, very high, or moderate.

**Filter records**

Set additional filters to limit the number of records that are displayed on a screen. Filtering records in the mobile app works like filtering with a condition builder on the Now Platform.

**Before you begin**

Role required: itil or group manager

**Procedure**

1. To further refine your search results, or to enter additional filter criteria on any list of records that is displayed, tap the filter icon.

2. On the Filters screen that appears, tap the arrow on a field to expand it.

3. From the options available, tap the check box or tap an option for your filter. For many of the filters, you can select more than one option.

4. Tap the Back icon or **DONE** to save your changes to a field.
   The criteria you chose displays on the Filters screen. The number of records that match your criteria also display on the top of the screen. Tap **Clear** or **RESET** to remove any filters and restore the default setting.

5. **Optional:** Repeat steps 1- 4 with the Filters screen displayed to continue setting your filter criteria.

6. Tap the intersection union after you set all criteria to create AND conditions. Alternatively, tap the union icon to create OR conditions.

7. **After you have added all the criteria you want, tap **DONE**. The incident records that match your filter criteria display on the screen.

**View catalog tasks**

View a catalog task and add comments to it as part of the catalog item fulfillment.

Tap on the card to access all the catalog tasks assigned to you.
1. You can filter the list according to your set criteria.
2. Swipe left to add comments or close the task.
3. On the Catalog tasks screen, tap on any task to view the details or activity of the catalog task. You can only add comments from this screen.

Filter records
Set additional filters to limit the number of records that are displayed on a screen. Filtering records in the mobile app works like filtering with a condition builder on the Now Platform.

Before you begin
Role required: itil or group manager

Procedure
1. To further refine your search results, or to enter additional filter criteria on any list of records that is displayed, tap the filter icon.
2. On the Filters screen that appears, tap the arrow on a field to expand it.
3. From the options available, tap the check box or tap an option for your filter. For many of the filters, you can select more than one option.
4. Tap the Back icon or DONE to save your changes to a field. The criteria you chose displays on the Filters screen. The number of records that match your criteria also display on the top of the screen. Tap Clear or RESET to remove any filters and restore the default setting.
5. Optional: Repeat steps 1-4 with the Filters screen displayed to continue setting your filter criteria.
6. Tap the intersection union after you set all criteria to create AND conditions. Alternatively, tap the union icon to create OR conditions.
7. After you have added all the criteria you want, tap DONE. The incident records that match your filter criteria display on the screen.

On-Call Scheduling
As a member of a shift, view your upcoming shifts, request time off, and accomplish daily tasks related to your schedule.

My work application in the mobile agent app has the On-Call Scheduling applet to access your upcoming shifts and time-off requests of members of your team.
### On-call schedule actions - Upcoming shifts

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap on <strong>Upcoming shifts</strong></td>
<td>View all upcoming shifts for the current month.</td>
</tr>
<tr>
<td>Swipe left on the shift card</td>
<td>Request a time-off for the shift.</td>
</tr>
<tr>
<td>Tap on the shift card</td>
<td>View details for the shift like the group, roster, start time, and end time.</td>
</tr>
<tr>
<td>Tap <strong>Request time-off</strong></td>
<td>Request a time-off for the shift.</td>
</tr>
<tr>
<td>Tap the 👆 icon.</td>
<td>Changes the view of the calendar from monthly to daily.</td>
</tr>
</tbody>
</table>

### On-call schedule - Time-off requests

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap on <strong>Time-off requests</strong></td>
<td>View a list of time-off requests divided into pending and completed requests.</td>
</tr>
<tr>
<td>Tap the filter icon</td>
<td>Filter the time-off requests.</td>
</tr>
<tr>
<td>Tap the menu icon</td>
<td>Request time off from the Time-off requests screen.</td>
</tr>
<tr>
<td>Tap a pending time-off request</td>
<td>View the details of the request.</td>
</tr>
<tr>
<td>Tap <strong>Cancel time-off</strong></td>
<td>Cancel the time-off by clicking <strong>YES</strong> on the confirmation message.</td>
</tr>
</tbody>
</table>

### On-call schedule - Who is on-call

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap on <strong>Who is on-call</strong></td>
<td>View a form that lets you select a group from a list of groups.</td>
</tr>
<tr>
<td>Tap the right arrow</td>
<td>View the list of groups that should be on-call in a schedule.</td>
</tr>
<tr>
<td>Select a group</td>
<td>Select a group from the list of groups and click the arrow to view who is on-call for the schedule.</td>
</tr>
</tbody>
</table>

### My Team

Easily access and get insights into the work of the groups you are managing.
With the My Team applet, as a group manager you can:

- Easily access unassigned incidents from your group and quickly triage work
- Act upon time-off requests submitted by your team
- Review any On-call conflicts or gaps in a schedule and plan for appropriate coverage
- Access dashboards to gain insights like MTTR, CSAT, and so on for your groups.

**My team dashboard**

As a group manager, with the My team dashboard, gain insights into the data like incidents at risk, breached incidents or overdue changes.

Tap on the sections to process the incidents.
My team dashboard

0
Incidents at risk

4
Breached incidents

29
Overdue changes

Unassigned incidents

See All

Unable to access company portal
State  New
 Caller Christen Mitchell

Unable to edit spreadsheet
State  New

On-call schedule

Upcoming shifts

Related information

Overdue changes

Overdue changes

Work on the overdue changes of your team
Procedure

1. On the My team dashboard, tap on **Overdue changes** on the applet. The **Overdue changes** screen opens with a list of the changes.

2. If you want to reduce the number of records on the screen, see **Filter records** to search for records that match specific search criteria.

3. On the **Overdue changes** screen with the list of incidents, swipe left on an incident to open the menu.

4. On the menu, choose one of the actions to process the incident.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add comments</td>
<td>Add work notes about the change in this field and tap &gt;.</td>
</tr>
<tr>
<td>Cancel change</td>
<td>Use this action to cancel the change. Provide a reason on the <strong>Reason</strong> field and tap &gt; to submit.</td>
</tr>
</tbody>
</table>

5. On the **Overdue changes** screen, tap a record on the list to open it and view more details.

6. On the **Change request** screen choose one of the actions in the table as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DETAILS tab</td>
<td>Choose one to continue.</td>
</tr>
<tr>
<td></td>
<td>• View the fields for details about the incident. The fields with an arrow have additional information.</td>
</tr>
<tr>
<td></td>
<td>• Add any additional comments using the <strong>Add comments</strong> button.</td>
</tr>
<tr>
<td></td>
<td>• Use this action to cancel the change. Provide a reason on the <strong>Reason</strong> field and tap &gt; to submit.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PLANNING tab</td>
<td>View all the planning details like the implementation plan, risk and impact analysis and backout plan for the change on this screen</td>
</tr>
<tr>
<td>Calls</td>
<td>View the list of all the calls related to an incident. Tap on any of the calls to Add participants or to Join call.</td>
</tr>
</tbody>
</table>

Unassigned incidents

Use the Unassigned incidents applet to assign, reassign, edit or promote to a major incident.

Before you begin
Role required: group manager

Procedure

1. On the My team landing screen, tap See All on the Unassigned incidents applet.
   The Unassigned Incidents screen opens with a list of incidents.
2. If you want to reduce the number of records on the screen, see Filter records to search for records that match specific search criteria.
3. On the Unassigned incidents screen with the list of incidents, swipe left on an incident to open the menu.
Unassigned incidents

- **INC0000046**
  - 3 - Moderate
  - Can't access SFA software
  - State: New
  - Caller: Bud Richman

- **INC0002002**
  - 2 - High
  - VPN not working
  - State: New
  - Caller: Tyree Courrege

- **INC0002008**
  - 3 - Moderate
  - The team file share is not accessible
  - State: New
  - Caller: Rick Berzle

- **INC0002009**
  - 1 - Critical
  - Add memory to laptop
  - State: New
  - Caller: Carol Coughlin

- **INC0002010**
  - 1 - Critical
  - Need access to sales DB
  - State: New
  - Caller: Sales Manager

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. On the menu, choose one of the actions to process the incident.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add comments</td>
<td>Add any additional comments or work notes about the incident in this field and tap &gt;.</td>
</tr>
<tr>
<td>Assign to me</td>
<td>Use this action to assign an incident to yourself.</td>
</tr>
<tr>
<td>Assign</td>
<td>On the Assign incident screen, tap the Assignment group field to change the assignment group, select the agent from the list in the Assigned to field and add any notes in the Work notes and tap &gt; to submit.</td>
</tr>
</tbody>
</table>

5. On the **Unassigned incidents** screen, tap a record on the list to open it and view more details.

6. On the **Unassigned Incidents** screen as shown in the following figure, choose one of the actions in the table as appropriate.
Unassigned incidents

1 - Critical

Add memory to laptop
State: New

Caller: Carol Coughlin

Description:
I’ve installed the editing software and the memory in my laptop is insufficient to run it effectively.

Caller:
Carol Coughlin

Category:
Hardware

Subcategory:
Memory

Service:

Configuration item:
IBM-T42-DLG

Impact:
1 - High

Urgency:
1 - High

Add comments
Assign to me

My work | My team | Major Incidents | Notification | Settings
### Details tab

Choose one to continue.

- View the fields for details about the incident. The fields with an arrow have additional information.
- At the top right of the screen, tap the menu icon to reassign, assign, edit or propose the incident as a major incident.
- Add any additional comments using the **Add comments** button.
- Use the **Assign to me** button to assign the incident to yourself.
- Once assigned to you, resolve the incident after adding a resolution code and notes using the **Resolve** button.

### Activity tab

View the activity on the incident like field changes or assignment changes. Tap the add icon to perform any of the following activities on the incident.

1. **Record Video**: Record a video to be attached to the incident.
2. **Open Gallery**: Open your photo gallery to attach an existing image or a video to the incident.
3. **Take Photo**: Take a picture and attach it to the incident.
4. **Attach File**: Attach a file from another application to the incident.
5. **Add Additional Comments**: Add any additional comments to the incident.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Work Notes</td>
<td>Add your work notes on the incident.</td>
</tr>
<tr>
<td>Related tab</td>
<td>View the related lists of the incident, such as, child incidents, task SLAs, impacted services and affected CIs. Tap on the arrow to view more details of these related items.</td>
</tr>
<tr>
<td>Calls</td>
<td>View the list of all the calls related to an incident. Tap on any of the calls to Add participants or to Join call.</td>
</tr>
</tbody>
</table>

Mobile My team On-Call Scheduling

As an On-Call Scheduling manager, view your team’s schedule and perform activities like approving time-off requests and providing coverage.

On-call schedule actions: Upcoming shifts

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap <strong>Upcoming shifts</strong></td>
<td>View all upcoming shifts for the current month.</td>
</tr>
<tr>
<td>Swipe left on the shift card</td>
<td>Request time off for this shift.</td>
</tr>
<tr>
<td>Tap the shift card</td>
<td>View details for the shift (like group, roster, start time, and end time).</td>
</tr>
<tr>
<td>Tap <strong>Request time-off</strong></td>
<td>Request a time-off for this shift by providing information on the Request time-off screen.</td>
</tr>
<tr>
<td>Tap <strong>Provide Coverage</strong></td>
<td>Provide coverage for a shift member.</td>
</tr>
</tbody>
</table>
### On-call schedule: Time-off requests

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap <strong>Time-off requests</strong></td>
<td>View a list of time-off requests divided into pending and completed requests.</td>
</tr>
<tr>
<td>Tap the filter icon</td>
<td>Filter the time-off requests using filters like End date or group.</td>
</tr>
<tr>
<td>Tap the menu icon</td>
<td>Request time off on the Time-off requests screen.</td>
</tr>
<tr>
<td>Tap a pending time-off request</td>
<td>View details of the request.</td>
</tr>
</tbody>
</table>
| Tap **Approve** or **Reject**   | Approve or reject a time-off request.  

**Note:** Add a reason for rejection of a time-off request.

### On-call schedule: Gaps and conflicts

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tap <strong>Gaps and conflicts</strong></td>
<td>View a list of all the gaps and conflicts for the shifts in your group.</td>
</tr>
<tr>
<td>Tap any day of the month</td>
<td>View all gaps and conflicts for shifts on that day.</td>
</tr>
<tr>
<td>Tap any of the shift cards</td>
<td>View gaps and conflicts for the shift.</td>
</tr>
<tr>
<td>Swipe left on any of the shift cards</td>
<td>Tap <strong>Provide coverage</strong> to provide coverage for the shift.</td>
</tr>
<tr>
<td>Tap <strong>Provide Coverage</strong></td>
<td>Provide coverage for a gap in the shift.</td>
</tr>
</tbody>
</table>

### Performance metrics

Access the performance data of your team directly from your mobile with the ITSM Agent mobile app.

As a group manager, with the My team dashboard, gain insights into the work of the groups you are managing by accessing metrics like MTTR (Mean Time To Resolution), CSAT, breached SLAs and so on.

Also view the graphical representation of the incidents raised in a week.
Major incidents

As a major incident manager you can quickly review active major incidents or proposed major incidents and act upon them.

As a major incident manager, you can also view and access the ongoing conference calls for current major incidents with the ability to start, join or end conference calls.

The major incident application contains the applets and folders as in the below table.
Major incident management applets

<table>
<thead>
<tr>
<th>Applet/Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active major incidents</td>
<td>View, filter and act upon active major incidents.</td>
</tr>
<tr>
<td>Major incident candidates</td>
<td>Review the incidents that are proposed as major incidents and add comments.</td>
</tr>
<tr>
<td>Resolved major incidents</td>
<td>View resolved major incidents and add comments.</td>
</tr>
<tr>
<td>Major incident dashboard</td>
<td>Gain insights on the major incidents worked on by your group, like number of major incidents, Mean time to identify, and mean time to resolve.</td>
</tr>
<tr>
<td>Performance metrics</td>
<td>View a non-interactive graph of major incidents opened per week.</td>
</tr>
</tbody>
</table>

Active major incidents

View a list of related incidents, details of a major incident and activities on an incident.

Before you begin
Role required: major incident manager

Procedure

1. On the Agent landing screen, tap **See All** on the **Active major incidents** applet. The **Active major incidents** screen opens with a list of major incidents.

2. If you want to reduce the number of records on the screen, see **Filter records** to search for records that match specific search criteria.

3. On the **Active major incidents** screen with the list of incidents, swipe left on an incident to open the menu.

4. Tap **Add comments** to add any additional comments or work notes about the incident in this field and tap ✉️.

5. Tap **Resolve** to resolve the major incident by adding the **Resolution code** and **Resolution notes**.
6. On the **Active major incidents** screen, tap a record on the list to open it and view more details.

7. You can also use the menu at the top of the screen for quick actions. The quick actions available for an active major incident are:
   - **Assign to someone**: Assign the major incident to someone in an appropriate assignment group.
   - **Resolve**: Add a resolution code and resolution notes and tap the ➔ to resolve the incident.
   - **Add comments**: Add any additional comments or work notes for the major incident and tap the ➔ to add these comments to the record.

8. On the **Active major incident** screen, choose one of the actions in the table as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DETAILS tab</td>
<td>View the fields for details about the incident. The fields with an arrow have additional information.</td>
</tr>
<tr>
<td>ACTIVITY tab</td>
<td>View the activity on the incident like field changes or assignment changes. Tap the add icon + to perform any of the following activities on the incident.</td>
</tr>
<tr>
<td></td>
<td><strong>A. Record Video</strong>: Record a video to be attached to the incident.</td>
</tr>
<tr>
<td></td>
<td><strong>b. Open Gallery</strong>: Open your photo gallery to attach an existing image or a video to the incident.</td>
</tr>
<tr>
<td></td>
<td><strong>C. Take Photo</strong>: Take a picture and attach it to the incident</td>
</tr>
<tr>
<td></td>
<td><strong>d. Attach File</strong>: Attach a file from another application to the incident.</td>
</tr>
<tr>
<td></td>
<td><strong>E. Add Additional Comments</strong>: Add any additional comments to the incident.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
**Note:** The comments can be made visible to the customer if you enable them using the toggle bar on the Additional Comments field.

f. **Add Work Notes:** Add your work notes on the incident.

| TASKS tab | View the list of all the tasks associated with the incident. Swipe left on an associated task to **Close task** or **Snooze** for a later time. |
| RELATED tab | View the related lists of the major incident, such as, child incidents, impacted services, outages, and affected CIs. Tap on the arrow to view more details of these related items. |

**Major incident candidates**

View a list of major incident candidates and add comments to the incidents proposed as major incidents.

**Related information**

Review and work on a major incident candidate

**Review and work on a major incident candidate**

View a list of major incident candidates and add comments to the incidents proposed as major incidents.

**Before you begin**

Role required: major incident manager

**Procedure**

1. On the Agent landing screen, tap **See All** on the Major incident candidates applet.
   The Major incident candidates screen opens with a list of major incident candidates.

2. If you want to reduce the number of records on the screen, see Filter records to search for records that match specific search criteria.

3. On the Major incident candidates screen, swipe left on an incident to view the set of quick actions.
a. Add any additional comments or work notes about the incident in this field and tap ➔.

b. Tap Reject, mention the reasons for rejection in the work notes and tap ➔ to process the rejection.

c. Tap Promote, mention a reason to promote the incident to a major incident, describe the business impact, and tap ➔.

4. On the Major incident candidates screen, tap a record on the list to open it.

5. You can also use the menu at the top of the screen for quick actions. The quick actions available for an active major incident candidate are:
   • Assign to me: Tap on this quick action to assign the major incident candidate to yourself. You can use the Reject or Promote buttons for an appropriate action.
   • Assign to someone: Assign the major incident to someone in an appropriate assignment group.
   • Resolve: Add a resolution code and resolution notes and tap the ➔ to resolve the incident.
   • Add comments: Add any additional comments or work notes for the major incident and tap the ➔ to add these comments to the record.

6. On the Major incident candidates screen, as shown in the following figure, choose one of the actions in the table as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DETAILS tab</td>
<td>View the fields for details about the incident. The fields with an arrow have additional information.</td>
</tr>
<tr>
<td>ACTIVITY tab</td>
<td>View the activity on the incident like field changes or assignment changes. Tap the add icon ➔ to perform any of the following activities on the incident.</td>
</tr>
<tr>
<td></td>
<td><strong>Record Video</strong>: Record a video to be attached to the incident.</td>
</tr>
<tr>
<td></td>
<td><strong>Open Gallery</strong>: Open your photo gallery to attach an existing image or a video to the incident.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>C. Take Photo</td>
<td>Take a picture and attach it to the incident</td>
</tr>
<tr>
<td>d. Attach File</td>
<td>Attach a file from another application to the incident.</td>
</tr>
<tr>
<td>E. Add Additional Comments</td>
<td>Add any additional comments to the incident.</td>
</tr>
<tr>
<td>Note</td>
<td>The comments can be made visible to the customer if you enable them using the toggle bar on the Additional Comments field.</td>
</tr>
<tr>
<td>f. Add Work Notes</td>
<td>Add your work notes on the incident.</td>
</tr>
<tr>
<td>RELATED LIST tab</td>
<td>View the related lists of the major incident, such as, child incidents, impacted services, outages, and affected CIs. Tap on the arrow to view more details of these related items.</td>
</tr>
</tbody>
</table>

**Major incident dashboard**

Review major incident information at a glance on your mobile.

The dashboard in the Major incidents application provides the information about the count of major incidents, mean time to identify an incident as a major incident and mean time to resolve.
Collaboration with major incidents

Initiate and manage the collaboration for the major incident records from the ITSM Mobile Agent app.

You need to add the deep linking support for ITSM Mobile Agent on the Mobile studio. For more information on adding the deep linking support, refer Add deep linking support to ITSM Mobile Agent

Initiate a chat with the caller from a major incident

Initiate a chat from a major incident record to discuss about the resolution of the issue.
Before you begin
Role required: major_incident_manager, itil, itil_admin, or admin

Procedure
1. Open ITSM Mobile Agent app.
2. Tap Major incidents tab, tap See All.
3. Tap the major incident record you want to work on.
4. Tap Caller.
5. Do one of the following:

<table>
<thead>
<tr>
<th>Major incident</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate chat in Slack</td>
<td>Tap on the Slack contact.</td>
</tr>
<tr>
<td>Initiate chat in Teams</td>
<td>Tap on the Microsoft Teams contact.</td>
</tr>
</tbody>
</table>
Initiate a chat with the assignment group from a major incident

Initiate a chat with the assignment group members from a major incident record to discuss about the resolution of the issue.

Before you begin
Role required: major_incident_manager, itil, itil_admin, or admin

Procedure
1. Open ITSM Mobile Agent app.
2. Tap Major incidents tab, tap See All.

i Note: The Slack and the Microsoft Teams contacts will be displayed only if the caller has a valid Slack and Microsoft Teams accounts.
3. Tap the major incident record you want to work on.
4. Tap Assignment group.
5. Do one of the following:

**Assignment group**

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate chat in Slack</td>
<td>Tap on Slack assignment group.</td>
</tr>
<tr>
<td>Initiate chat in Microsoft Teams</td>
<td>Tap on the Microsoft Teams assignment group.</td>
</tr>
</tbody>
</table>
Note: The Slack and the Microsoft Teams assignment group contact will be displayed only if the assignment group has a valid Slack and Microsoft Teams accounts.

You can also interact with a user from the assignment group. Tap on the assignment group, and then tap on a user and select either Slack or Microsoft Teams to initiate a conversation.

View active collaborations
As a major incident manager, you can view all the active collaborations for the major incidents.

Before you begin
Role required: major_incident_manager, itil, itil_admin, or admin
Procedure

1. Open ITSM Mobile Agent app.
2. Tap **Major incidents** tab.
3. Tap **Active collaborations**.
4. Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calls</td>
<td>View the active calls collaboration.</td>
</tr>
<tr>
<td>Option</td>
<td>Action</td>
</tr>
<tr>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Chats</td>
<td>Tap <strong>Chats</strong> to view the active chat collaborations.</td>
</tr>
</tbody>
</table>

5. Swipe and tap **View** to view the conversation in the respective application.
Each collaboration displays:

- **Application:** Slack/Microsoft Teams
- **Collaboration title**
- **Incident created date and timestamp**
- **Channel name:** Channel marked with “#” is a public channel. Any user can view the conversation. Channel that doesn’t contain a “#” is a private channel, this channel isn’t accessible to public users. Only the collaborators can view the chat conversation.
Add participants to a conference call from a major incident

Add participants to an active conference call from a major incident record to discuss about the resolution of the major incident.

Before you begin
Role required: major_incident_manager, itil, itil_admin, or admin

Procedure
1. Open ITSM Mobile Agent app.
2. In Major incidents tab.
3. Tap Active collaborations.
4. Tap on the active conference call.

5. Tap Add participants
6. Provide the following details:

   a. **Recommended participants**: The list of participants associated with the incident will be displayed. Select the required users, and tap **Submit**.

   b. **Users**: Select the required users, and tap **Submit**.

   c. **Groups**: Select the required group, and tap **Submit**.
7. In the Add participants screen, click Submit.

Join an active conference call from a major incident
You can join an active conference call from a major incident record to discuss about the resolution of the issue.

Before you begin
Role required: major_incident_manager, itil, itil_admin, or admin

Procedure
1. Open ITSM Mobile Agent app.
2. In Major incidents tab.
3. Tap Active collaborations.
## Major incidents

### Active major incidents

<table>
<thead>
<tr>
<th>Incident ID</th>
<th>Status</th>
<th>Description</th>
<th>Created</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC00010005</td>
<td>In Progress</td>
<td>Unable to downgrade Clipboard.</td>
<td>2019-09-24 08:27:49</td>
</tr>
</tbody>
</table>

### Major incident candidates

<table>
<thead>
<tr>
<th>Incident ID</th>
<th>Status</th>
<th>Description</th>
<th>Created</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC00100002</td>
<td>In Progress</td>
<td>Test</td>
<td>2020-12-29 14:55:45</td>
</tr>
</tbody>
</table>

**Active collaborations**

**Resolved major incidents**

---

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. Tap **Join call**.

![Conference call interface](image)

**End a conference call from major incident**

A host or a user with the major incident manager role can end the conference call.

**Before you begin**

Role required: major_incident_manager, itil, itil_admin, or admin
Procedure

1. Open ITSM Mobile Agent app.

2. In **Major incidents** tab.

3. Tap **Active collaborations**.

4. Tap ...
5. To end the call tap **End call** button.
Domain Separation for ITSM Mobile Agent

This is an overview of domain separation and ITSM Mobile Agent. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.
Support level: Basic

• Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.

• The application supports domain separation at run time. This includes domain separation from the user interface, cache keys, reporting, rollups, and aggregations.

• The owner of the instance must set up the application to function across multiple tenants.

Use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

Overview

The mobile platform supports domain separation for all native clients. The mobile UI design clearly indicates the domain that a record is associated with.

Before extending the domain separation functionality to mobile, the feature must be enabled on the platform web-based interface. For further information on configuration, see Domain separation setup and administration.

How domain separation works in mobile

You can use the company or account fields to display appropriate records by domain. These fields are available in tables when the domain separation plugin is enabled. Because each company or account is linked to a single domain, when you create a record, you can use these fields to specify the domain in which you want to create the record.

After the feature has been set up through the platform web-based interface, a two-part process is required to further extend the domain separation functionality on mobile. For additional information about configuring domain separation on mobile devices, contact Customer Service and Support.

Domain separated tables

• Incident [incident]

• Incident Task [incident_task]

Use cases

• An ESS user belonging to “Initech” domain, creates an incident. Only those ITIL users belonging to “Initech” domain or global domain can see this incident.

• An ITIL user belonging to a parent domain can see incidents of all its child domains as well.
• An ITIL user belonging to a specific domain can create incidents only on behalf of the domains that they have access to.

• An ITIL user can associate child incidents only of those domains that they have access to.

• If a user has access to multiple domains, the domain specified on the current record drives the functionality of that record and reference fields.

**Enable Push notification categories for ITSM Mobile Agent**

Enable push notification categories so your users can enable or disable notifications by category.

**Before you begin**
Role required: admin

**Procedure**

1. Type `sys_properties.list` in the application navigator.

2. In the system properties list, find and open the property with the name `com.glide.sg.notifications.management`.

   ![Note] If the property does not exist, click **New** and create a true | false property with the name in the previous step. After changing this property, users must log out and back in for the change to take effect.

   ![Note] After changing this property, users must log out and back in for the change to take effect.

3. In the **Value** field, enter **true**.

4. Click **Update**.
The user can enable or disable notifications by category. The categories shown in the notification preferences screen are defined in the `Notifications [sysevent_email_action]` table. The screen to the left shows all the reference categories defined on this table. The screen to the right shows the record matching the selected category.

After you have updated your system property, your users will be able to enable or disable notifications by the defined categories.
Configurable actionable notifications for ITSM Mobile Agent

With configurable actionable notifications for ITSM Mobile Agent, you can perform actions based on push notifications without having to open the ITSM Mobile Agent application.

You can associate up to three actions with a push notification. These actions must refer to an existing mobile function. The following function types of actions are supported:

- Action item
- Navigation
- URL
- Chat launcher

Process for creating actionable push notifications
Create actionable push notifications using the following process:

1. Create an actionable push notification for ITSM Mobile Agent.
2. Create a push action category.
3. Create function for each push action.
4. Map functions with push actions on the actionable push notification.
5. Create push message content.
6. Create a standard notification.

**Create an actionable push notification for ITSM Mobile Agent**

Create a push notification for various actions performed on the ITSM Mobile Agent application.

**Before you begin**
Role required: admin

**Procedure**
2. Click New.
3. In the push notification form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your push notification.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This name does not appear to users viewing the notification.</td>
</tr>
<tr>
<td>Application</td>
<td>The scoped application for your notification. This field automatically uses</td>
</tr>
<tr>
<td></td>
<td>the current application scope.</td>
</tr>
<tr>
<td>Actionable</td>
<td>Option for making a notification actionable.</td>
</tr>
<tr>
<td>Screen</td>
<td>Optional screen associated with your notification. Displays to a user when</td>
</tr>
<tr>
<td></td>
<td>they tap on the notification.</td>
</tr>
</tbody>
</table>

4. Click Save.

**Results**
The notification record is created, and the Push Action Instances related list appears on the form.

**Create a push action category**
Create a push action category if any of the pre-defined push action categories do not meet the business requirements.
Before you begin
Role required: admin

Procedure
1. Navigate to **System Mobile > Mobile Push Notifications > Push Action Categories**.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>accept-reject-back</td>
<td>Displays <strong>Accept</strong> and <strong>Reject</strong> buttons. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>Accept-Reject-fore</td>
<td>Displays <strong>Accept</strong> and <strong>Reject</strong> buttons. The app opens when the user selects an action.</td>
</tr>
<tr>
<td>accept-rejectwcomments-back</td>
<td>Displays <strong>Accept</strong> and <strong>Reject</strong> buttons. When users select the <strong>Reject</strong> option, a confirmation dialog box appears that requires the user to provide a message and click Send.</td>
</tr>
<tr>
<td>ack-escalate-ignore-back</td>
<td>Displays <strong>Acknowledge</strong>, <strong>Escalate</strong>, and <strong>Ignore</strong> buttons. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>approve-reject-back</td>
<td>Displays <strong>Approve</strong> and <strong>Reject</strong> buttons. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>approve-rejectwcomments-back</td>
<td>Displays <strong>Approve</strong> and <strong>Reject</strong> buttons. When users select the <strong>Reject</strong> option, a confirmation dialog box appears that requires the user to provide a message and click Send. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>confirm-reschedule-cancel-back</td>
<td>Displays <strong>Confirm</strong>, <strong>Reschedule</strong>, and <strong>Cancel</strong> buttons. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>joinbridge-fore</td>
<td>Displays a <strong>Join Meeting</strong> button. Tapping this button opens the app.</td>
</tr>
<tr>
<td>PromoteWComments- RejectWComments-fore</td>
<td>Displays <strong>Promote</strong> and <strong>Reject</strong> buttons. When users select either option, a confirmation dialog box appears that requires the user to provide a message and click Send.</td>
</tr>
</tbody>
</table>
### Action Description

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dialog box appears that requires the user to provide a message and click Send.</td>
<td></td>
</tr>
<tr>
<td>queuerejoin-openincident-back</td>
<td>Displays <strong>Online Check-in</strong> and <strong>Open Incident</strong> buttons. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>queuestay-queueleave-back</td>
<td>Displays <strong>Stay in Queue</strong> and <strong>Leave Queue</strong> buttons. Users can select an option without opening the app.</td>
</tr>
<tr>
<td>yes-no-back</td>
<td>Displays <strong>Yes</strong> and <strong>No</strong> buttons. Users can select an option without opening the app.</td>
</tr>
</tbody>
</table>

2. Click **New**.

3. In the push action category form, enter a name for the category in the **Name** field.

4. Click the lock icon (🔒) next to the **Actions** field.

5. Click the reference icon (🔍) to display the **Push Actions** list and select the actions for the push action category.

6. Click **Save**.

### Create a push action

Create a push action if any of the pre-defined push actions do not meet the business requirements.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Mobile > Mobile Push Notifications > Push Actions**.

2. Click **New**.

3. In the push action form, fill in the fields.
Push action form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Text your users will see in the notification for this action.</td>
</tr>
<tr>
<td>Application</td>
<td>Scoped application for this record. This field automatically populates.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the push action.</td>
</tr>
<tr>
<td>Foreground</td>
<td>When enabled, the app opens when your users select this action.</td>
</tr>
<tr>
<td>Response Type</td>
<td>Options are:</td>
</tr>
<tr>
<td></td>
<td>• Simple</td>
</tr>
<tr>
<td></td>
<td>• Text response</td>
</tr>
<tr>
<td>Placeholder Text</td>
<td>Placeholder text to your users when they initiate the actionable push.</td>
</tr>
</tbody>
</table>

4. Click Save.

Create functions for notification push actions

Create a mobile function for each function in the action category. These actions perform tasks on your instance based on what the user selects in the notification.

Before you begin
Role required: admin

Procedure

1. Navigate to System Mobile > Functions.
2. Click New to create a new function record.
3. Create a function for one of your push actions.
   When selecting a function type in the Type field, you must select one of the function types supported for actionable push notifications:
   • Action item
   • Navigation
   • URL
   • Chat launcher

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
For information on function types, and detailed steps for creating functions, see Mobile functions.

4. Create additional functions for each push action.
   For example, if you have selected ack-escalate-ignore-back as your push notification category, your notification displays the Acknowledge, Escalate, and Ignore buttons. Create a function to determine the behavior of each of these buttons.

What to do next
Map functions with push actions for actionable push notifications

Map functions with push actions for actionable push notifications
Associate functions to the actions for an actionable push notification.

Before you begin
Role required: admin

Procedure
2. Open a notification.
3. In the Push Action Instances related list, click New.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push Notification</td>
<td>Push notification associated with this push action instance. This field is automatically filled in with your push notification.</td>
</tr>
<tr>
<td>Application</td>
<td>Scoped application associated with this record. This field is automatically filled in with the current application.</td>
</tr>
<tr>
<td>Push Action</td>
<td>Push action from your push notification record. Select one of the available actions.</td>
</tr>
<tr>
<td>Button</td>
<td>Function to associate with the push action. This action triggers when a user uses the action listed in the Push Action field.</td>
</tr>
</tbody>
</table>

5. Click Submit.
Example:
This example notification uses the `accept-rejectwcomments-back` in the Category field. Clicking the preview icon (i) shows the two actions used by this category: Accept and Reject.

In the example push action instance, the Approve push action is selected in the Push Action field, and the Approve REQ /w comments function is selected in the Button field. The instance executes this function when a user taps the Approve button in the notification.

Create push message content
Create the content of the message to be displayed as a notification.

Before you begin
Role required: admin
Procedure

1. Navigate to **System Mobile > Mobile Push Notifications > Push Notifications**.
2. Open the notification.
3. Click **Create Push Message Content** in the Related Links section.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Push Notification Message Content form</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Name</td>
<td>Name of your push message content record. This name is not visible to your users.</td>
</tr>
<tr>
<td>Application</td>
<td>Scoped application associated with this record. This field is automatically filled in with the current application.</td>
</tr>
<tr>
<td>Push app</td>
<td>Mobile Agent app on which the push notification is displayed.</td>
</tr>
<tr>
<td>Push Message Generation</td>
<td>The script that generates the push notification. When you create message content, this script is automatically generated.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

Create a standard notification

Create a record to determine the information to be displayed for a notification.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to **System Notification > Push > Create Push Notification**.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Push notification form</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Name</td>
<td>Name of your notification. This name is not visible to your users.</td>
</tr>
</tbody>
</table>
3. Right-click the form header and select **Save**.
4. Configure the push message for your standard notification.
   a. Click to display the **What to Send** tab.
   b. Click the lock icon (🔒) next to the **Push Messages** field.
   c. Click the reference icon (🔍) to display the **Push Notification Messages** list.
   d. Click **New**.
   e. On the form, fill in the fields.

**Push Notification Message form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of your push notification message record. This name is not visible to your users.</td>
</tr>
<tr>
<td>Application</td>
<td>Scoped application associated with this record. This field defaults to the current application.</td>
</tr>
<tr>
<td>Push App</td>
<td>Mobile Agent app on which the push notification is displayed.</td>
</tr>
<tr>
<td>Table</td>
<td>Table containing the records relating to your notification. For example, a notification about</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>new incidents</td>
<td>new incidents would use the Incident [incident] table.</td>
</tr>
<tr>
<td>Push Message Content</td>
<td>The record for the push message content.</td>
</tr>
<tr>
<td>Message</td>
<td>Text the user sees in the push notification, for example, An incident has been assigned to you.</td>
</tr>
</tbody>
</table>

f. Click **Submit**.

5. In the **Notification** form, click **Update**.

### Collaboration Services for ITSM Mobile Agent

Collaboration services provide a way to communicate and collaborate in real time. You can directly use a collaboration tool from an incident, incident task, and major incident records.

Install the Collaboration services (sn_tcm_collab_hook), Notify (com.snc.notify), Notify connector for Microsoft Teams (com.sn.ms_teams) applications in your instance to use collaboration services on ITSM Mobile Agent.

- **Collaboration with incidents**
  
  Initiate and manage the collaboration for incident records from the ITSM Mobile Agent app.

- **Collaboration with incident tasks**
  
  Initiate and manage the collaboration for incident task records from the ITSM Mobile Agent app.

- **Collaboration with major incidents**
  
  Initiate and manage the collaboration for major incident records from the ITSM Mobile Agent app.

### Add deep linking support to ITSM Mobile Agent

Deep linking enables instances to support direct communication to a messaging application from a particular record in the system.

**Before you begin**

Role required: itil, itil_admin, or admin

**About this task**

You need to assign the deep linking support on the Mobile Studio.
Procedure

1. Log in to your instance.
2. In the Navigation filter, enter `sys_properties.list`. The entire list of properties in the System Properties [sys_properties] table appears.
3. Open the record for `glide.sg.allowed_external_deeplinks`.
4. In the form, match the following values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>glide.sg.allowed_external_deeplinks</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
</tr>
<tr>
<td>Value</td>
<td>Slack,Teams</td>
</tr>
</tbody>
</table>

5. Click **Save**.

Settings

View the information related to the settings of your ITSM Agent mobile app.

You can adjust the settings of the ITSM Agent mobile app. The following information is available in the Settings screen of your app.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance</td>
<td>Name of the app version</td>
</tr>
<tr>
<td>Version</td>
<td>Version of the app</td>
</tr>
<tr>
<td>Security</td>
<td>If the administrator has set authentication requirements, enter the secure</td>
</tr>
<tr>
<td></td>
<td>credentials in the field.</td>
</tr>
<tr>
<td>Analytics</td>
<td>Enable the analytics of the app usage</td>
</tr>
<tr>
<td>Legal</td>
<td>Read the privacy policies, Open source licence information and End user</td>
</tr>
<tr>
<td></td>
<td>licence agreement</td>
</tr>
<tr>
<td>Logout</td>
<td>Logout from the instance</td>
</tr>
</tbody>
</table>
Index

Special Characters
<feature name>
activate
409

A
activate
Change Management - Change Schedule
393
Change Schedule
393
service portfolio management plugin
1735
sla breakdowns
1841
Vendor Manager Workspace plugin
2109, 2162
actual elapsed time
1887
add
change state
459
custom business rules
1881
related tasks
531
related tasks to change schedule
531
add assignments
create from request
284
add new change state
451, 459
add state change condition
457
application
contract management
235
assess risk
547
Asset and CI management
adding depreciation to asset
41
allocate pre-allocated assets
52
consume consumable assets
50
create assets
31
create consumable assets
48
create fixed assets
44
create license assets
42
create pre-allocated assets
51
delete assets
37
depreciation with fixed assets
45
life cycle of consumables
47
set asset states and substates
43
split pre-allocated assets
53
view consumable assets
47
asset classes
40
create
40
Asset Management
Asset and CI management

asset classes

asset classes, create

calculate software licenses

counters

create a custom license type

create license calculation script

determine where software is installed

IBM PVU Process Pack

installed with

installed with Model Management

Installed with Oracle process pack

installed with Software Asset Management

license calculation types

license calculations

manage software licenses

managing software models

Oracle mapping

Oracle process pack

Oracle software counter

Oracle software license

Oracle software models

process

Software Asset Management

software discovery models

software license reconciliation

asset state

asset substate

Asset-CI mapping

map asset state

map CI install status

map fields

map hardware status

assets

delete

assignment rule

for change requests

automated conflict detection

B

Badge Reader Integration

Installed with
Benchmarks
336
dashboard
367
enable a KPI
355
enabling a KPI
356
KPI conditions
357
KPI configuration
346
KPI data
375
KPI data view
371
KPI performance trend view
372
KPI recommendations
372
opt in
344
opt out
344, 345
overview
336
roles
342
troubleshooting
376
blackout schedule
567
breakdown
sla
1884
breakdown definitions
service level management
1884
bulk CI changes
511
proposed change
510
Bulk CI changes
installed components
tables

410
business elapsed time
1887
Business percentage time
SLA Timeline
1907
business rules
1847
Change Management -
Change Schedule
397
Business schedule
SLA Timeline
1907

C
CAB agenda
604
CAB definition
591
cab meeting
cab workbench
608
CAB meeting
598
CAB meeting invitations
608
cab workbench
cab meeting
608
CAB workbench
590
cancel conflict detection
577, 579
change
378
conflict calendar
572
change conflict calendar
view
572
change conflict detection
547
change management
378, 415, 416, 459, 492
bulk CI change
507
change types
379
discovery
617
integration
616
mass update CI
507
properties
432
SAM
620

Change Management
affected CIs
505
Associate multiple CIs
505
change risk assessment
550, 551
Extend multiple CI
association
446
impacted CIs
505
ITIL
378
manage CI changes
503, 504
risk assessment
555

Change Management -
Change Schedule
business rules
397
installed with
394
properties
396
roles
395
script includes
399
tables
395

ui policies
398
ui scripts
401
change request
459
assignment rules
440
create
485
process
501
change request on hold
509
change request type
new
441
change risk assessment
547
change risk calculator
393
module
547
change schedule
create
528, 529
related tasks
531
change schedule definitions
define style rules
534
change schedules
523
landing page
523
change state
new
459
change state example
459
Change State Model
447
change state tutorial
459
change task template
contract life cycle
242
contract notification
254
create a contract
244
create terms and conditions
257
define condition check
269
installed components
business rules
239
client scripts
239
roles
238
script includes
238
tables
237
user roles
238
reject contract
256
renew contract
252
send for approval
255
software maintenance
contract
248
terms and conditions
257
Contract Management
use contract management
242
Contract Management
Overview Module
236
contract rate cards
259, 261
contracts
243
monitor
266
reports
267
conversion process
organize
1920
convert SLA
task SLA
1921
create
change request
485
change schedule
528, 529
change task template
519
SLA breakdown definitions
1884
Create a catalog request in
Agent Workspace
1705
create knowledge
use the knowledge check
box
1658
create vendor credit
from incidents
2266
from Outage form
2265
from Service Availability
form
2267
from table records
2264
from the Company form
2268
from Vendor Credit form
2262
custom business rules
add
1881
D
dashboard
major incident
data lookup rules problems 1617
define editing style rules 535
style rules 532
define assignment rule problems 1615
define CAB 591
define contract 1836
define service contract 1836
define style rules 533, 534
change schedule definitions 534
style rules table 533
detect conflicts 547
discovery change management 617
duration SLA 1860
configuration item 98
user 99
Escalation 1918
Escalation engine 1918
expense allocations 780
expense line create manually 782
delete 784
expense allocation rule 784
expense allocation rules 780
installed components business rules 778
client scripts 777
script includes 777
tables 776
user roles 777
installed with 776
scripted allocations 785
Expense Line expense allocations 781
expense lines 781
expense lines 259, 261, 775, 780
add user or asset 263
assign user or asset 264
generate
263
view
266, 779
extra coverage
1530

F
fixed assets
create
44
use depreciation
45

G
get started with SLAs
1917
group schedule
1575

H
How SLA works
1886

I
IBM
process pack
142
Process Pack
137, 138, 139, 139, 141, 143, 145, 147
PVU
137, 138, 139, 139, 141, 142, 143, 145, 147
incident
create a request
1379
incident overview
1405
incident reports
1405
incident ticketing integrations
1354
installed with
1795, 1842
Change Management - Change Schedule
394
integrate

change management
617, 620
discovery
617
SAM
620
integration
change management
616
IT Business Management
1759
IT Service Management
ITSM virtual agent
786
ITSM virtual agent
predefined topics
796, 869, 870, 889
Set-up ITSM virtual agent
795
Vendor Manager
workspace
2100, 2146
ITIL
management
1700
release
1700
ITL change management
378
ITSM Agent Workspace - Request Management
1704
ITSM Software Asset Management
74
Overview module
74

L
landing page
1833
legacy SLA field
1918
license assets
create
42
license calculations
111
calculate software licenses
111
create custom license type
115
create script
116
license calculation types
112
Locations module
214

M
Made SLA
1918
maintenance schedule
567
major incident
dashboard
1475
overview
1475
workbench
1463
major problem
categorize
1616
manage
612
cab meeting
612
manage change
378
Manage CI Changes
affected CIs
503, 504
change requests
504
dependency views
504
impacted services
503
Manage Software Licenses
create an entitlement
96
downgrade a license
102
merge software licenses
103
Managing Assets
retire assets
36
manual conflict detection
577
Mass Update CI
411
migrate
change risk assessment
557
risk assessment
557
model categories
330
create
331
create asset manually
333
delete
335edit
334
view
331
model management
business rules
214
client scripts
216
installed with
214
properties
217
script includes
218
tables
218
UI policies
219
user roles
220
models
  application
  317
bundle
  add model components
  315
bundled
  313
consumables
  312
creating new
  307, 316, 318, 318
delete
  319
fields
  308
hardware
  309
  compatible models
  310
  substitute models
  311
publish to catalog
  319
skills
  318
software
  317
modify
  schedule entry
  1555
move from 2010 engine to
  2011 engine
  1919
move to SLA plugin
  old engine
  1918

N
new
  change request type
  441
new change request type
  441
new change state
  add

451
new manufacturer
  create
  213
new SLA condition rule
  create
  SLA condition rule
  1868
define
  SLA condition class
  1868
new vendor
  create
  213
normal
  change
  379
Notification
  SLA
  1917
O
old SLA engine
  reactivate
  1926
on-call
  scheduling
  1490
On-Call roles
  1501
On-Call schedule
  create on-call schedule
  1546
on-call scheduling
  escalation settings
  1521
installed components
  tables
  1492
use notify
  1573
On-Call scheduling
  properties
  1526
On-Call Scheduling
  1491, 1499, 1580
reminder lead time
1539
shift reminder
1537

Operational status
1759

Organization Management
213
  create new manufacturer
  213
  create new vendor
  213
Locations module
214
overview
  major incident
  1475
overview dashboard
sla
1926

PA dashboard
sla
1928

plugins
1842

pre-allocated asset
  allocate
  52
  split
  53
pre-allocated assets
  create
  51
problem configuration
1613
problem management
1586
  associate a task to an outage
  2078, 2079
  creating knowledge
  1658
Problem Management
1585

prioritize problems
1617
process
  change request
  501
processing within SLA
1886
procurement
271, 274, 276, 277, 278
  activate
  273
consumable asset
303
create
291
create an asset
297
create purchase order
288
edit a catalog task
287
purchase order
  cancel
  295
  reorder
  296
purchase order line item
291
  cancel
  295
  reorder
  296
purchase order management
285
purchase order status
293
purchase orders
  expected delivery date
  294
receive assets
298, 299
receiving slip
301
receiving slip line
reserve asset
roles
service catalog
cancel request
track request
view a catalog task
workflows
Procurement
procurement overview
module
use
product catalog
activate items
create item
create vendor catalog
items
deactivate item
installed components
business rules
client scripts
roles
script includes
tables
items
link to hardware catalog
link to software catalog
publish to hardware catalog
publish to software catalog
synchronize information
vendor catalog
view vendors
Product Catalog
Product Hierarchy
properties
Change Management - Change Schedule
purchase order
create from a request
rate card
expense generation
rating summary
vendor decision matrix
related tasks
add
change schedule
related tasks to change schedule
add
release
define
scope 1699
Release 1692
release management 1686, 1691
activate 1687
release phase define 1698
remove member from shift 1545
request items
add assignment 278
purchase order 278
source 278
transfer order 278
Request Management 1700
retroactive pause
SLA 1871
risk assessment changes 555
define 551
migrate 557
roles
Change Management - Change Schedule 395
Schedule entry modify 1555
schedule time off 1530
scheduled jobs
SLA 1891
schedules 523
scheduling
on-call 1490
script includes 1845
Change Management - Change Schedule 399
security, On-Call Scheduling 1501
service 1759
Service Builder 1823
service contract 1836
service desk 1717
service desk call 1724
create call 1725
domains 1724
installed components 1721
business rules 1722
client scripts 1721
tables 1721
tasks by same company 1726
tasks by same user
1726
transfer call
1727
transfer call to request
1728
transfer call to task
1727
view calls
1728
Service Desk Call
1718
service level agreement
see SLA
service level management
breakdown definitions
1884
Service Level Management
1833
installed components
Business rules
1839
Client scripts
1839
Email notifications
1839
properties
1839
scheduled jobs
1840
Scheduled jobs
1839
Script includes
1839
tables
1839, 1839
UI actions
1839
UI policies
1839
Workflows
1839
Service level requirement
1759
service owner workspace
access
1812
use
1812
Service Owner Workspace
1779
activate plugin
1791
configure estimated spend
1821
configure offering cost
source
1821
configure spend offering
cost
1821
csat
1818
Explore
1780
installed with
1795
integrations
1802
migration dashboard
1799
performance metrics
1783
quick start tests
1796
service availability
1805
service offering survey
survey
1818
set up
1789
use
1810
view or configure metric
definitions
1803, 1804
service portfolio management
1729
activate plugin
1889
duration
1860
Notification
1917
repair
1892, 1893, 1896
repair from a form
1894
repair from a list
1895
retroactive pause
1871
retroactive start
1871
schedule
1860
scheduled job
1891
scheduled jobs
1891
Trigger
1905
Validate SLA definition
1911
SLA breakdown definitions
create
1884
sla breakdowns
1842, 1842, 1843, 1844, 1844,
1845, 1846, 1847
activate
1841
business rules
1847
client scripts
1846
installed with
1842
plugins
1842
properties
1844
script includes
1845
table
1843
ui policy
1844
SLA calculations
1891
SLA condition rule
customize
1868
extend
1868
invoke globally
1870
invoke on a specific SLA
1870
SLA condition rules
1866, 1868
SLA definition
verify
1903
SLA Definition
create
1852
SLA definitions
1851
SLA Due
1918
SLA engine
1886
SLA processing
1886
SLA properties
configure
1872
SLA stage change
SLA
Stage change
1909
SLA Timeline
1909
SLA timeline
activate
1849
use
1903
view
1904
SLA Timeline
1897
Business percentage time
1907
Determine business schedule
1907
installed components
script includes
1849
SLA stage change
1909
Validate SLA definition
1911
SLA transitions
1864
SLA workflow
SLA
1857
workflow
1857
SLACConditionBase
1866
SLACConditionSimple
1867
SLM
1833
SLM landing page
1833
software
find on network
89
installed
88
scan installations
91
Software Asset Management
76, 105, 109
activate
165
administration
205
custom product
205, 206
dashboard
199
Discovery
158
get started
170
installed with
76
migrate
211
migrate software installs
208
migration
209
overview module
75
plugin
165
properties
208
reconciliation
163
roles
157
run reconciliation
200
set up
164
setup process
87
software discovery models
159
software entitlement
179, 185
software model results
201
software models
187
using
75
Software Asset Management Foundation
156
software contracts
148
creating
148
software discovery models
118
automatic matching to an
existing model
119
create new models
120
edit
118, 192
software installations
custom patterns
168
manual override edition
193
Software License Compliance
Checker
122
using
122
Software licenses
91
add new
92
create and manage
subscription license
95
create software user license
entitlement
97
downgrade a license
102
entitle license to
configuration item
98
entitle license to user
99
entitlements
95
upgrading
100
view list of unallocated
software licenses
103
Software Licenses
creating enterprise licenses
94
upgrade and downgrade
99
solution
627, 1407, 1425, 1664, 2364
Solutions
1927
Stage change
SLA
1909
standard
change
379
standard change catalog
404, 406, 516
standard change properties
configure
517
state model
activation
388
emergency change
450
installed components
tables
391
normal change
450
standard change
450
State Model
activate
387
installed components
390
stockrooms
54
create
54
create stock rules
58
create types
delete
54, 55
stock rules
58
types
55
style rules
define
532
style rules table
define style rules
533

T

Table
1843
Task SLA
1923
tables
Change Management -
Change Schedule
395
Task SLA
table
1923
Time
time zones
1861
timeline
1904
Timeline
1897
transfer order
create from request
281
transfer orders
60
create
65
create transfer order line
66
delete
63
delete transfer order line
64

line asset tracking
70, 70, 71
return items
64
transfer assets
61
transfer process
63
Trigger
SLA
1905
tutorial
459

U

ui policies
Change Management -
Change Schedule
398
ui policy
1844
ui scripts
Change Management -
Change Schedule
401
unallocated software licenses
view
103
Use Counters for Software License Reconciliation
schedule
124
set up quick counters
130
software counter
125, 126
software counters
123, 124
view software counter
detail
134
view software counter results
130
view software counter summary
Vendor manager workspace
create vendor
2118, 2170
modify vendor
2118, 2170
vendor satisfaction survey
2123, 2175

Vendor Manager Workspace
activate plugin
2109, 2162
Analyzing indicator scores
in Vendor Manager Workspace
2151
Associate a vendor score metric model with a vendor
2192
Create an improvement initiative for a vendor
2194
domain separation
2135, 2199
Explore Vendor Manager Workspace
2148
installed with
2165
Service Credits
2108, 2161
Use Vendor Manager Workspace
2139, 2189
Vendor Manager Workspace user interface
2159

Vendor Performance
2203, 2223
activating
2222
assessment
2220
configuring
2205
create vendor record
2208

use vendor ticketing
2251, 2252, 2256, 2256, 2258, 2261
vendor activity
2216
vendor assessments set up
2218
vendor contact
2215
vendor managers
2213
vendor scorecards
2227, 2228, 2229, 2232, 2234, 2235, 2236, 2237, 2239
vendor ticketing
2250
vendor type
2207
vendor performance overview module
use
2225
Vendor Scorecards
averages by vendor type
2234
categories
2235
category metrics
2236
head to head compare
2237
history
2239
ratings
2232
vendor ticketing
2248
activate
2250
Vendor Ticketing
installed with
2250
view
1575
change conflict calendar
1067
Installed with
996
interaction management
1057
manage automatic
interactions
1061
manage interactions
manually
1063
manual
1049
queue management
1057
register badge reader
1047, 1049
remove a location
1036
scan logs
1052
security
portal access
993
service portal online check-
in
1004
set up
1042
understanding
984
use agent assist
1068
view and manage
appointments from
application navigator
1070
view and manage
appointments in Agent
Workspace
1069
view inbox
1060
view interactions
1061, 1063
view stockrooms and assets
1066
walk-up location
983
workbench
major incident
1463
Workforce Optimization
Workforce Optimization for
ITSM
1153
Workforce Optimization for
ITSM
1279
Add KPI targets for agents
1267
Add managers to a KPI
assignment group
1210
Add service channels and
queues
1199
Allocate work items
manually to agents
1240
Analyze skills for your teams
1240
Analyze the performance
trends for your teams
1269
Analyze transcripts and
sentiments for the Amazon
Connect phone channel
1249
Analyze your staff alignment
using Demand Forecast
1261
Assess the quality of
completed tasks
1273
Assist agents by joining their
chat conversations
1239
Associate Amazon Connect queues to a ServiceNow instance
1246
Channels in Workforce Optimization for ITSM
1161, 1237
Coaching in Workforce Optimization for ITSM
1171, 1270
Configure an event load order to populate event categories faster
1206
Configure KPIs for queues
1202
Configure KPIs for service channels
1201
Configure supervisor lists for service channels
1203
Create a manual adjustment for a forecast
1225
Create a schedule plan
1257
Create a shift plan
1253
Create assignment rule and groups
1200
Create KPI groups to monitor team performance
1208
Demand Forecast in Workforce Optimization for ITSM
1166
Domain Separation and Workforce Optimization for ITSM
1197
Example Channel Management for Workforce Optimization for ITSM
1162
Example Coaching Workforce Optimization for ITSM
1175
Example Teams in Workforce Optimization for ITSM
1171
Explore Workforce Optimization for ITSM
1159
Find out the number of resources you need for a shift using Workforce Optimization for ITSM
1218
Generate a preview of a schedule plan
1258
Listen in to an agent call
1248
Manage service channels and queues
1238
Manage skills using Workforce Optimization for ITSM
1276
Manage your schedule using ITSM Agent Workspace
1149
Modify forecast parameters to visualize forecast data
1223
Monitor ongoing work in service channels and queues
1237
Request Workforce Optimization for ITSM

Workforce Optimization for ITSM Reference

Workforce Optimization for ITSM
- Use extension points for skill prediction
  - 1213
Workforce Optimization for ITSM
- Workforce Optimization for ITSM Agent Workspace
  - 1147

Scheduling in Workforce Optimization for ITSM
- 1163, 1253
Scheduling Workforce Optimization for ITSM
- 1165
Set up Workforce Optimization for ITSM
- 1175
Setting up Channels in Workforce Optimization for ITSM
- 1199
Setting up skill prediction
- 1212
Setting up Teams in Workforce Optimization for ITSM
- 1208
Skills Overview in Workforce Optimization for ITSM
- 1270
Teams in Workforce Optimization for ITSM
- 1266
Teams Workforce Optimization for ITSM
- 1169
Track and analyze agents' performance
- 1241
Track and manage your teams' schedule
- 1260
Use Channels in Workforce Optimization for ITSM
- 1237
Use Workforce Optimization for ITSM
- 1228
Using Cloud Call Center with Workforce Optimization for ITSM
- 1243